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Rendering

Rendering "fills in" geometry with color, shadow, lighting effects, and so on.

Rendering shades the scene's geometry using the lighting you've set up, the materials you've
applied, and environment settings, such as background and atmosphere. You use the Render
Scene dialog on page 5878  to create renderings and save them to files. Renderings are also
displayed on the screen, in a rendered frame window on page 5885 .

TIP When you render a very large image, you might get a message that says “Error
Creating Bitmap,” or that says you are out of RAM. If this happens, turn on the Bitmap
Pager. You turn on the Bitmap Pager in Rendering Preferences on page 7560 . The Bitmap
Pager prevents a rendering from hanging because of overuse of memory. On the other
hand, it slows down the rendering process.
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NOTE 3ds Max does not append any color-space information to rendered output. If
necessary, you can apply a color space such as sRGB to output images in an
image-editing program like Adobe Photoshop.

Environments and Rendering Effects

A variety of special effects, such as film grain, depth of field, and lens simulations, are
available as rendering effects. Another set of effects, such as fog, are provided as environment
effects.

Environment settings on page 6486  let you choose a background color or image, or choose
an ambient color value for when you render without using radiosity. One category of
environment settings is the exposure controls on page 6531 , which adjust light levels for
display on a monitor.

Rendering effects on page 6381  provide a way for you to add blur or film grain to a rendering,
or to adjust its color balance.

See also:

■ Rendering Commands on page 5897

■ ActiveShade on page 5910

■ Rendering Previews on page 6220

■ Network Rendering on page 6231

■ Rendering Effects on page 6381

■ Environment and Atmosphere Effects on page 6484

Object-Level Rendering Controls

You can control rendering behavior at the object level. See Object Properties on page 245 .

Render Scene Dialog 
Rendering menu > Render

Main toolbar > Render Scene button
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Keyboard > F10

Rendering creates a 2D image or animation based on your 3D scene. It shades
the scene's geometry using the lighting you've set up, the materials you've
applied, and environment settings such as background and atmosphere.

The Render scene dialog has multiple panels. The number and name of the
panels can change, depending on the active renderer. These panels are always
present:

■ Common panel on page 5929
Contains the main controls for any renderer, such as whether to render a
still image or an animation, setting the resolution of rendered output, and
so on.

■ Renderer panel on page 5946
Contains the main controls for the current renderer.

Additional panels whose presence depends on the active renderer include:

■ Render Elements panel on page 6144
Contains the controls for rendering various image information into
individual image files. This can be useful when you work with compositing,
image-processing, or special-effects software.

■ Raytracer panel on page 6030
Contains global controls for ray-traced maps and materials.

■ Advanced Lighting panel on page 5962
Contains controls for generating radiosity and light tracer solutions, which
can provide global illumination for your scene.

■ Processing and Indirect Illumination panels
Contain special controls for the mental ray renderer on page 6039 .

At the bottom of the Render Scene dialog are controls that, like those in the
Common Parameters rollout on page 5929 , apply to all renderers. These are
described in this topic's “Interface” section, below.

TIP When you render a very large image, you might get a message that says “Error
Creating Bitmap,” or that says you are out of RAM. If this happens, turn on the
Bitmap Pager. You turn on the Bitmap Pager in Rendering Preferences on page
7560 . The Bitmap Pager prevents a rendering from hanging because of overuse of
memory. On the other hand, it slows down the rendering process.
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Choice of a Renderer

Three renderers are provided with 3ds Max. Additional renderers might be
available as third-party plug-in components. The renderers provided with 3ds
Max are:

■ Default scanline renderer on page 5949
The scanline renderer is active by default. It renders the scene in a series
of horizontal lines.

Global illumination options available for the scanline renderer include
light tracing on page 5963  and radiosity on page 5976 .

The scanline renderer can also render to textures on page 6169  (“bake”
textures), which is especially useful when preparing scenes for game
engines.

■ mental ray renderer on page 6039
The mental ray renderer created by mental images is also available. It
renders the scene in a series of square “buckets.”

The mental ray renderer provides its own method of global illumination,
and can also generate caustic lighting effects.

In the Material Editor, a variety of mental ray shaders on page 5801  provide
effects that only the mental ray renderer can display.

■ VUE file renderer on page 6143
The VUE file renderer is a special-purpose renderer that generates an ASCII
text description of the scene. A view file can include multiple frames, and
specify transforms, lighting, and changes of view.

Production and ActiveShade Renderers

In 3ds Max, there are two different types of renderings. One, called
“Production” rendering, is active by default, and is typically the one you use
for finished renderings. Production renderings can use any of the three
aforementioned renderers. The second type of rendering is called ActiveShade
on page 5910 . An ActiveShade rendering uses the default scanline renderer to
create a preview rendering that can help you see the effects of changing
lighting or materials; the rendering interactively updates as you change your
scene. ActiveShade renderings are, in general, less precise than production
renderings.

Another advantage of production renderings is that you can use different
renderers, such as the mental ray or VUE file renderer.
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To choose between production or ActiveShade renderings, use the radio buttons
described in the “Interface” section below. To change the renderer assigned
to production rendering, use the Assign Renderer rollout on page 5943 .

See also:

■ Render Scene  on page 5898

Procedures

To render a still image:

1 Activate the viewport to render.

2  Click Render Scene.

The Render Scene dialog appears, with the Common panel active.

3 On the Common Parameters rollout, check the Time Output group to
make sure the Single option is chosen.

4 In the Output Size group, set other rendering parameters or use the
defaults.

5 Click Render.

By default, the rendering appears in a rendered frame window on page
5885 .

TIP  To render a view without using the dialog, click Quick Render
on page 5909 .

To render an animation:

1 Activate the viewport to render.

2  Click Render Scene.

The Render Scene dialog appears, with the Common panel active.

3 On the Common Parameters rollout on page 5929 , go to the Time Output
group and choose a time range.
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4 In the Output Size group, set other rendering parameters or use the
defaults.

5 In the Render Output group, click Files.

6 On the Render Output File dialog on page 5892 , specify a location, name,
and a type for the animation file, and then click Save.

Typically, a dialog appears that lets you configure options for the chosen
file format. Change settings or accept the defaults, and then click OK to
continue.

The Save File check box turns on.

7 Click the Render button at the bottom of the dialog.

NOTE If you set a time range and do not specify a file to save to, the
animation is rendered only to the window. This can be a time-consuming
mistake, so an alert warns you about it.

TIP  Once you have rendered the animation this way, you can render it
again without using the dialog by clicking Quick Render.

Interface

■ Production Choose to use the active production renderer. (This is the
default.)

■ ActiveShade Choose to use ActiveShade on page 5910 .
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Render Presets drop-down list Lets you choose from among a set of preset
rendering parameters, or load or save rendering parameter settings. See Preset
Rendering Options on page 5922 .

Viewport Chooses the viewport to render. By default, this is the active
viewport. You can use this drop-down list to choose a different one. The list
contains only currently displayed viewports.

Lock View When on, locks the view to the one shown in the Viewport
list. This enables you to adjust the scene in other viewports (which become
active as you use them), and then click Render to render the viewport you
originally chose. When off, Render always renders the active viewport.

Render Renders the scene.

When ActiveShade is chosen, the name of this button changes to ActiveShade,
and clicking it opens a floating ActiveShade window on page 5910 .

If the scene you're rendering contains bitmaps that cannot be located, a
Missing External Files dialog on page 6926  appears. This dialog lets you browse
for the missing maps, or continue to render the scene without loading them.
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Rendering Progress dialog
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When you click Render, a rendering progress dialog shows the parameters
being used, and a progress bar. The rendering dialog has a Pause button to
the left of the Cancel button. When you click Pause, the rendering pauses,
and the button's label changes to Resume. Click Resume to continue with the
rendering.

NOTE The mental ray renderer does not support the Pause button. You can cancel
a mental ray rendering, but you can't pause it.

Rendered Frame Window
Rendering menu > Render > Render Scene dialog > Render > Rendered Frame
Window appears.

File menu > View Image File > Choose a file to view. > Open > Rendered Frame
Window displays the file.

The rendered frame window displays rendered output. It has controls to:

■ Save the image to a file.

■ Place a copy of the rendered image on the Windows clipboard, ready for
pasting into another graphics application.

■ Create a clone of the window. This displays a new window so you can
create another rendering and compare it with the previous one.

■ Display a new rendered frame window.

■ Enable or disable display of the red, green, and blue color channels.

■ Display the alpha channel on page 7709 .

■ Display only monochrome (gray scale).

■ Clear the image from the window.

■ Print the rendered output.

3ds Max also displays still images and image sequences in the rendered frame
window when you choose the View Image File command from the File menu.
When you view sequentially numbered image files or images in an IFL file
on page 7131 , the rendered frame window displays navigation arrows that let
you step through the images.
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Procedures

To zoom and pan in the rendered frame window:

You can zoom in and out and pan the image in the rendered frame window.
You can even do this while a scene is rendering.

1 Hold down Ctrl and then click to zoom in, right-click to zoom out.

2 Hold down Shift and then drag to pan.

If you have a three-button mouse, you can use its third button or its wheel to
zoom and pan:

1 Roll the wheel to zoom in or out.

2 Press the wheel, and drag to pan.

NOTE You can use any third-button pointing device to pan the image. To
enable this, open the Customize menu > Preferences dialog. Go to the
Viewports panel on page 7545 , and in the Mouse Control group choose the
Pan/Zoom option.
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Interface

Rendered Frame Window toolbar

Save Bitmap Allows you to save the rendered image displayed in the
rendered frame window.

Copy Bitmap Places an exact copy of the visible portion of the rendered
image on the Windows clipboard, ready for pasting into a paint program or
bitmap editing software. The image is always copied as displayed, so, for
example, if the Monochrome button on page 5888  is on, the copied data consists
of an eight-bit grayscale bitmap.

NOTE No HDR (high-dynamic-range) data is copied.

Clone Rendered Frame Window Creates another rendered frame
window containing the displayed image. This allows you to render another
image to the rendered frame window and compare it with the previous, cloned
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image. You can clone the rendered frame window any number of times. If the
image is cropped because the window is zoomed in or resized, only that part
of the image is copied to the clipboard.

Enable Red Channel Displays the red channel of the rendered image.
When turned off, the red channel is not displayed.

Enable Green Channel Displays the green channel of the rendered
image. When turned off, the green channel is not displayed.

Enable Blue Channel Displays the blue channel of the rendered image.
When turned off, the blue channel is not displayed.

Display Alpha Channel Displays the alpha channel on page 7709 .

Monochrome Displays an 8-bit grayscale of the rendered image.

Clear Clears the image from the rendered frame window.

Channel Display List Lists any channel rendered with the image. When you
choose a channel from the list, it is displayed in the rendered frame window.

For most kinds of files, only the RGB and alpha channels are available. If you
render an RPF file on page 7159  or RLA file on page 7156 , additional channels
can be present.

The rendered frame window displays nonvisual channels, such as Material
Effects or the G-Buffer, using colors it randomly assigns to distinct values.

Layer This spinner appears on the rendered frame window toolbar when
you render to the RPF on page 7159  or RLA on page 7156  file format. It lets you
see the information at different layers of the following channels:

■ Z-buffer

■ Normal

■ Non-Clamped Color

■ Coverage

■ Node Render ID
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■ Color

■ Sub-Pixel Weight

■ Sub-Pixel Mask

Layer shows no additional information for other channels. It is useful primarily
when the scene contains objects that occlude each other, and you have turned
on the Render Occluded Objects toggle for these objects. (See Object Properties
on page 245 .) Be aware that rendering occluded objects increases render time.

TIP Rendering occluded objects can help you create 3D effects when you
composite images with the Autodesk Combustion software.

Color Swatch Stores the color value of the last pixel you right-clicked. You
can drag this color swatch to other color swatches in the program. Clicking
the color swatch displays the Color Selector on page 331 , which displays more
information about the color.

You can leave the Color Selector displayed while you right-click over other
pixels in the rendered frame window. (Changing the current value in the
Color Selector changes the color swatch on the rendered frame window's
toolbar, but it does not change the color of pixels in the rendered image.)

Frame-Steps (arrows) For sequentially numbered files (such as image0005.jpg)
or IFL files, the arrows display the next or the previous file in the sequence.
Holding down Ctrl and clicking an arrow jumps to the first image or the last
image in the sequence.

Available if the rendered frame window is invoked using View Image File in
the File menu.

Pixel Data

When you right-click the rendered frame window, the color swatch is updated,
and information about the rendering and the pixel beneath the mouse is
displayed.

If you hold the right mouse button down while dragging, the information
changes with each new pixel the mouse crosses.
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The display includes the following information:

Image group

Width The width of the image in pixels.

Aspect The pixel aspect ratio.

Height The height of the image in pixels.

Gamma The gamma value carried in the bitmap file.

Type The type of image, based on color depth. For example, 64 bits (RGBA)
or 32 Bits per Channel Floating-Point (RGBA).

Pixel group

Pixel information includes the pixel location in the bitmap, in parentheses
following the Pixel group heading. The counting starts at 0. For example, in
the above illustration, the pixel in question is the 308th from the left edge
and the 141st from the top edge. Also shown in this group are channel values
for red, green, blue, alpha, and monochrome, both as 16-bit integers (0 to
65535) and as floating-point values between 0.0 and 1.0.

NOTE With high-dynamic-range images, the floating-point values can be greater
than 1.0 or less than 0.0.

Red The red component value (0 to 65535) and the floating-point value.

Green The green component value (0 to 65535) and the floating-point value.
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Blue The blue component value (0 to 65535) and the floating-point value.

Alpha The alpha component value (0 to 65535) and the floating-point value.

Mono The monochrome values of the pixel, using the same formula used
by monochrome material map channels such as bump and opacity maps.

Extra Pixel Data (G-Buffer Data) group

If the rendering is in a format, such as an RPF file on page 7159  or RLA file on
page 7156 , that contains additional channels, the informational pop-up shows
this data in the Extra Pixel Data group. The group includes all the possible
channels. If a channel was not saved, its value is displayed as "N/A," for "not
applicable."

Z Depth Displays Z-Buffer information in repeating gradients from white to
black. The gradients indicate relative depth of the object in the scene.

Material ID Displays the Effects Channel used by a material assigned to an
objects in the scene. The Effects Channel is a material property set in the
Material Editor.

Object ID Displays the G-Buffer Object Channel ID assigned to objects using
the Object Properties dialog on page 245 .

UV Coordinates Displays the range of UV mapping coordinates.

Normal Displays the orientation of normal vectors.

Non-Clamped Color Displays the "real" color value delivered to the renderer
in RGB order. The renderer uses a floating-point range of 0.0 to 1.0 to represent
the range of each color channel. Thus, 1.0 is 100%, or 65535 (real color values
can be greater than 1, but are clamped by the renderer to 1).

Coverage Displays the coverage of the surface fragment from which other
G-Buffer values (Z Depth, Normal, and so on) are obtained. Z-Coverage values
range from 0 to 255.

Node Render ID Displays an object’s G-Buffer Object channel.

Color Displays the color returned by the material shader for the fragment.

Transparency Displays transparency returned by the material shader for the
fragment.

Velocity Displays the velocity vector of the fragment relative to the screen.

Sub-Pixel Weight Displays the sub-pixel weight of a fragment. The channel
contains the fractions of the total pixel color contributed by the fragment.
The sum of all the fragments gives the final pixel color. The weight for a given
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fragment takes into account the coverage of the fragment and the transparency
of any fragments that are in front of a given fragment.

Sub-Pixel Mask Displays the sub-pixel alpha mask. This channel provides a
mask of 16 bits (4x4) per pixel, used in antialiased alpha compositing.

Render Output File Dialog
Rendering menu > Render > Render dialog > Common panel > Common
Parameters rollout > Render Output group > Click Files. > Render Output File

The Render Output File dialog lets you assign a name to the file that the
rendering will output. You can also determine the type of file to render.
Depending on your choice of file type, you can also set up options such as
compression, and color depth and quality.

See also:

■ Image File Formats on page 7116

Procedures

To name the render output file:

1 Choose Rendering > Render, and then in the Render Output group of the
Common Parameters rollout, click Files.

This opens the Render Output File dialog.

2 Use the Save In field near the top of the dialog to choose the directory
in which to save the rendered file.

3 In the File Name field, enter the name for the file to be rendered.

TIP If you enter a filename extension as well (for instance: myimage.bmp)
and then press Tab, the Setup button activates and you can click it to change
the file settings.

4 Choose the type of file you want to render from the Save As Type
drop-down list.

5 Click Save to close the Render Output File dialog.
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A dialog is displayed that lets you set the options for the file format you
chose. Adjust these settings (or leave them at their defaults), and then
click OK.

6 On the Render Scene dialog, click Render to render and save the file.

NOTE If a file of the same name already exists, you will be asked if you want
to overwrite it. Enable the check box if you want to automatically overwrite
this file without being prompted for the duration of the session.

To set up options for the render output file:

1 Choose Rendering > Render and then in the Render Output group of the
Common Parameters rollout, click Files.

The Render Output File dialog is displayed.

2 In the File Name field, enter the name for the file to be rendered.

3 Navigate the Save In field to choose the directory where you want the
rendered file to be saved.

4 Choose the type of file you want to render from the Save As Type
drop-down list, then click Save.

A dialog is displayed that lets you set the options for the file format you
chose. Adjust these settings (or leave them at their defaults), and then
click OK.

NOTE You can also view the setup dialog by clicking Setup, if this button is
available.

WARNING Make sure the file name extension in the File Name field matches
the file type in the Save As Type field. Changing the file type does not update
the file name automatically. The file options dialog depends on the type
indicated by the file name, not  the type indicated by Save As Type.

5 If the Render Output File dialog is still open, click Save.
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Interface

History Displays a list of the most recent directories searched. Whenever an
image is selected, the path used is added to the top of the history list as the
most recently used path.

The history information is saved in the 3dsmax.ini on page 51  file.

Save In Opens a navigation window to browse other directories or drives.

 Up One Level Moves you up a level in the directory structure.

 Create New Folder Lets you create a new folder while in this dialog.
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 View Menu Provides several options for how information is displayed
in the list window:

■ Thumbnails: Displays the contents of a directory as thumbnails, without
the details.

■ Tiles: Displays the contents of a directory as large icons, without the details.
If you widen the dialog, these tile across the width.

■ Small Icons: Displays the contents of a directory as small icons, tiled across
the width, without the details.

■ List: Displays the contents of a directory without the details.

■ Details: Displays the contents of a directory with full details such as size
and date.

List of files Lists the contents of the directory, in the format specified by the
View menu.

TIP When the active display format is Details, the contents of the directory are
displayed with Name, Size, Type, Date Modified, and Attributes. You can sort the
list according to a column's contents by clicking that column's label.

File name Displays the file name of the file selected in the list.

Save as type Displays all the file types that can be saved. This serves as a
filter for the list.

NOTE The choice in this field determines the file type saved, regardless of the file
name extension entered in the File Name field.

Save Sets the file information for saving upon rendering. Closes the dialog
if you haven't changed the output file type.

If you've changed the file type, clicking Save opens the Setup dialog for the
specified file type. Change the settings as necessary, and then click OK to close
both the Setup and the Output dialogs, or click Cancel to return to the Output
dialog.

Cancel Cancels the file save and closes the dialog.
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Devices Lets you choose the hardware output device, for example, a digital
video recorder. To use the device, the device, its driver, and its 3ds Max plug-in
must all be installed on your system.

Setup Displays controls for the selected file type. These vary with each
different file format. Change the settings as necessary, and then click OK or
Cancel.

Info If you highlight an existing file in the list, clicking Info displays
expanded information about the file such as frame rate, compression quality,
file size, and resolution. The information here depends on the type of
information saved with the file type.

View If you highlight an existing file in the list, clicking View displays the
file at its actual resolution. If the file is a movie, the Media Player is opened
so the file can be played.

Gamma group

To set up gamma options for the output file, Enable Gamma Correction must
be on in the Gamma panel on page 7550  of the Preferences dialog (Customize
> Preferences > Gamma). Otherwise, the Gamma controls are unavailable in
the Render Output File dialog.

■ Use Image’s Own Gamma This option is not available in this dialog.

■ Use System Default Gamma Uses the system default gamma, as set in
the Gamma panel of the Preferences dialog.

■ Override Defines a new gamma for the bitmap that differs from the
system default.
Using Override is not recommended for bitmaps that you render. It is
better to set a system default value, based on the graphic display you use,
and use this same gamma value for all your renderings.

Sequence This is not available in the Render Output File dialog.

NOTE To render a sequence of still images, choose the Active Time Segment or
define a range of frames in the Common Parameters rollout of the Render Scene
dialog. If you have selected a still image file type, each frame will append a
four-digit number to the name you have selected, incremented with each frame.

Preview When on, enables display of the image as a thumbnail.
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Image thumbnail Displays a thumbnail of the selected file. Preview must be
turned on.

Statistics Displays the resolution, color depth, file type, and number of
frames of the selected file.

Location Displays the full path for the file.

Rendering Commands
The main commands for rendering are on the main toolbar on page 7284 .
Another way to invoke some of these commands is to use the default
Rendering menu on page 7278 , which contains other commands related to
rendering.

Render Scene  on page 5898

Render Type on page 5900

Quick Render  on page 5909

Quick Render (ActiveShade)  on page 5909

ActiveShade Viewport on page 5918

Preset Rendering Options on page 5922

Render Last  on page 5924

See also:

■ Render Scene Dialog  on page 5878

■ ActiveShade on page 5910

■ ActiveShade Commands (Quad Menu) on page 5919

■ Rendering Effects on page 6381

■ Environment and Atmosphere Effects on page 6484

■ Network Rendering on page 6231
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Render Scene 

Main toolbar > Render Scene

Rendering menu > Render

Keyboard > F10

Rendering "fills in" geometry with color, shadow, lighting effects, and so on.

This command opens the Render Scene dialog on page 5878 , which lets you
set the parameters for rendering. Rendering creates a still image or an
animation. It shades the scene's geometry using the lighting you've set up,
the materials you've applied, and environment settings such as background
and atmosphere.

Rendering is multi-threaded and multi-processed on multiple-processor
configurations. A two-processor system can render in nearly half the time a
single-processor system can.

Rendering can also take place on multiple systems by using a network. See
Network Rendering on page 6231 . For the mental ray renderer, also see
Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6131 .

Missing Mapping Coordinates

If the renderer finds a parametric object that requires mapping, it automatically
sets its Generate Mapping Coordinates toggle before rendering the scene. The
toggle remains set after the rendering is done.

In the following cases, however, 3ds Max is unable to supply mapping
coordinates automatically:

■ Non-parametric objects, such as imported meshes, don't have built-in
coordinates.

■ Some third-party (plug-in) objects aren't provided with mapping
coordinates.
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In these cases, 3ds Max is unable to render the scene completely. It displays
a Missing Mapping Coordinates dialog on page 5618  that lists the objects the
renderer couldn't map. To resolve the problem apply a UVW Map modifier
on page 1849  to the objects that the dialog lists.

NOTE If a material has Show Map In Viewport set when that material is assigned
to an object, the object's Generate Mapping Coordinates toggle is set, if it was
not previously set. (The state of Show Map In Viewport is saved with each material.)

Procedures

To render a still image:

1 Activate the viewport to render.

2  Click Render Scene.

The Render Scene dialog on page 5878  appears.

3 In the Time Output group, make sure Single is on.

4 In the Output Size group, set other rendering parameters or use the
defaults.

5 Click Render.

By default, the rendering appears in a window.

TIP  To render a view without using the dialog, click Quick Render
on page 5909  or use Render Last on page 5924  (press F9).

To render an animation:

1 Activate the viewport to render.

2  Click Render Scene.

The Render Scene dialog on page 5878  appears.

3 Open the Common Parameters rollout on page 5929 . Choose a time range
in the Time Output group.
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4 In the Output Size group, set other rendering parameters or use the
defaults.

5 In the Render Output group, click Files.

6 A Render Output File dialog on page 5892  is displayed.

7 Use the file dialog to specify a name and a type for the animation file,
and then click Save.

A dialog is displayed that lets you set the options for the file format you
chose. Adjust these settings (or leave them at their defaults), and then
click OK.

On the Render Scene dialog's Common Parameters rollout, the Save File
toggle turns on.

8 Click Render.

NOTE If you set a time range and do not specify a file to save to, the
animation is rendered only to the window. This can be a time-consuming
mistake, so an alert warns you about it.

TIP  To render a view without using the dialog, click Quick Render on
page 5909  or use the Keyboard Shortcut F9  to Render Last on page 5924 .

Render Type

Main toolbar > Render Type drop-down list
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Render Type lets you render only a portion of the scene.

The Render Type list lets you specify the portion of the scene that will be
rendered.

Procedures

To render selected objects:

1 From the Render Type drop-down list at the right end of the toolbar,
choose Selected.

2 Activate the viewport to render.

3 Select the objects.

4  Click Render Scene or Quick Render (Production).

3ds Max displays a progress dialog that shows the progress of rendering
and the rendering parameter settings. To stop rendering, click Cancel in
this dialog, or press Esc.

To render a region:

1 Make the viewport active.

2 Choose Region from the list.

3  Click Render Scene or Quick Render (Production).
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A window is displayed in the active viewport, and an OK button appears
in the viewport's lower-right corner.

4 Drag in the middle of the window to move it. Drag the window's handles
to adjust its size.

To preserve the window's aspect ratio, you can hold down Ctrl while you
drag a handle.

5 Click OK.

3ds Max displays a progress dialog that shows the progress of rendering
and the rendering parameter settings. To stop rendering, click Cancel in
this dialog, or press Esc.

To render a blowup:

1 Make the viewport active.

2 Choose Blowup from the list.

3  Click Render Scene or Quick Render (Production).

A window is displayed in the active viewport and an OK button is
displayed in the viewport's lower-right corner.

4 Drag in the middle of the window to move it. Drag the window's handles
to adjust its size.

The window is constrained to the aspect ratio of the current output size.

5 Click OK.

3ds Max displays a progress dialog that shows the progress of rendering
and the rendering parameter settings. To stop rendering, click Cancel in
this dialog, or press Esc.
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Interface

View (The default.) Renders the active viewport.

Selected Renders the currently selected object or objects only, and leaves
the remainder of the rendered frame window intact.
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TIP  Use the Clear button before rendering to remove any existing image
from the window.

Region Renders a region within the active viewport, and leaves the remainder
of the rendered frame window intact. Use this option when you need to test
render a part of the scene.

TIP  Use the Clear button before rendering to remove any existing image
from the window.

NOTE Region rendering is meant to create a draft rendering of a selected area of
a view. As such, Region rendering uses only an Area filter for antialiasing, regardless
of which antialiasing is chosen in the Render Scene dialog.
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Crop Lets you specify the size of the output image using the same region
box that appears for the Region and Blowup categories .

Blowup Renders a region within the active viewport and enlarges it to fill
the output display.

A rectangular selection region appears when you render with either Blowup
or Region selected in the Render Type list. You can change the size of the
region by dragging its handles.
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Box Selected Calculates the aspect ratio of the current selection’s bounding
box, and then displays the Render Bounding Box/Selected dialog on page 5907
, which lets you specify a width and height for the rendering, and provides
the option of maintaining the aspect ratio.

Region Selected When an object or objects are selected, renders those objects
and other objects within the selection's bounding boxes, but does not change
the rendering outside the bounding boxes.
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Objects within the bounding boxes, including objects in front of or behind
the selection, are rendered.

When no objects are selected, Region Selected renders the entire frame.

Crop Selected When an object or objects are selected, renders those objects
and other objects within the selection's bounding boxes. The rendering is
cropped around the region defined by the bounding boxes.

Objects within the bounding boxes, including objects in front of or behind
the selection, are rendered.

When no objects are selected, Crop Selected renders the entire frame.

Render Bounding Box/Selected Dialog

Select objects. > Main toolbar > Choose Box Selected from the Render Type
drop-down list. > Click Quick Render (Production) > Render Bounding
Box/Selected dialog

Select objects. > Main toolbar > Choose Box Selected from the Render Type
drop-down list. > Click Render Scene, and then click Render. > Render
Bounding Box/Selected dialog.

This dialog appears when you render a scene while the Box Selected render
type is active. Box Selected renders an area that corresponds to the bounding
box of the currently active selection.
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See also:

■ Render Type on page 5900

Interface

Width and Height Let you set the size of the rendering, in pixels.

Constrain Aspect Ratio When on, constrains the original aspect ratio of the
selection's bounding box. Changing the Width value also changes Height,
and vice versa. Default=on.

Selection Aspect Ratio Displays the original aspect ratio of the selection's
bounding box.

Quick Render Flyout

Main toolbar > Quick Render flyout

The Quick Render flyout lets you choose among these buttons:

■  Quick Render (Production).
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■  Quick Render (ActiveShade)

The Quick Render buttons let you render the scene using the settings without
displaying the Render Scene dialog on page 5878 . Choosing one of these buttons
also changes which rendering settings are active in the Render Scene dialog.

By default, all the rendering options use the default scanline renderer on page
5949 . You can change the renderer assigned to Production or ActiveShade by
using the Assign Renderer rollout on page 5943  on the Render Scene dialog >
Common panel.

Quick Render (Production)

Main toolbar > Quick Render flyout > Quick Render (Production)

Keyboard > Shift+Q

The Quick Render (Production) button, available from the Quick Render
flyout on page 5908  on the main toolbar, lets you render the scene using the
current production render settings without displaying the Render Scene dialog
on page 5878 .

You assign which renderer to use for production rendering on the Assign
Renderer rollout on page 5943  of the Render Scene dialog > Common panel.

See also:

■ Quick Render (ActiveShade)  on page 5909

Quick Render (ActiveShade) 

Main toolbar > Quick Render flyout > Quick Render (ActiveShade)

Keyboard > Shift+Q (Uses the Quick Render mode currently active on the
toolbar: either Production or ActiveShade)

The Quick Render (ActiveShade) button, available from the Quick Render
flyout on page 5908 , creates an ActiveShade on page 5910  rendering in a floating
window.
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You assign which renderer to use for ActiveShade rendering on the Assign
Renderer rollout on page 5943  of the Render Scene dialog on page 5878  >
Common panel.

See also:

■ Quick Render  on page 5909

ActiveShade

main toolbar > Quick Render flyout > Quick Render (ActiveShade)

Right-click viewport label. > Views > ActiveShade

ActiveShade gives you a preview rendering that can help you see the effects
of changing lighting or materials in your scene. When you adjust lights or
materials, the ActiveShade window interactively updates the rendering.
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ActiveShade preview of material changes

Above left: Before the update

Above right: After changing the material for the fabric to a mapped material and
increasing the highlights on the material for the wood
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ActiveShade preview of lighting changes

Above left: Before moving a light in a viewport

Above right: After moving the light

There are two ActiveShade options:

■ Viewport The ActiveShade rendering appears in the active viewport.

■ Floater The ActiveShade rendering appears in its own window.

Only one ActiveShade window can be active at a time. If you choose one of
the ActiveShade commands while an ActiveShade window is already active,
you get an alert that asks whether you want to close the previous one. If the

5912 | Chapter 18   Rendering



previous ActiveShade window was docked in a viewport, the viewport reverts
to the view it previously showed.

TIP You can drag and drop materials from the Material Editor on page 5188  to
ActiveShade windows and viewports, as you can with other viewports.

NOTE  You can't make a maximized viewport an ActiveShade window, or
maximize an ActiveShade window.

ActiveShade Commands

When you right-click an ActiveShade window, the quad menu on page 7300
displays an ActiveShade menu. This menu contains a number of ActiveShade
commands on page 5919 .

ActiveShade and Object Selection

If you select an object before you invoke ActiveShade, ActiveShade is done
only for that object. This can greatly increase the speed of ActiveShade.

Similarly, once the ActiveShade window is open, the initialize and update
steps on page 7703  (whether automatic or manual) are done only for the selected
object.

In a "docked" ActiveShade viewport, you can select objects by right-clicking,
turning on Select Object in the Tools (lower-right) quadrant of the quad menu,
then clicking the object you want to select. In an ActiveShade viewport, only
one object at a time can be selected.

TIP When an object in an ActiveShade window has a mapped material, select it
before you change a map or adjust its parameters.

What ActiveShade Does and Doesn't Do

For the sake of interactivity, the ActiveShade window is limited in what it will
and won't update interactively. An ActiveShade rendering is not necessarily
the same, and in general is less precise, than a final production rendering.
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TIP When you change geometry by transforming it or modifying it, right-click
the ActiveShade window and choose Tools > Initialize from the quad menu
(lower-right quadrant). This updates the ActiveShade rendering.

■ Moving an object does not update the ActiveShade window.

■ Applying a modifier or otherwise changing object geometry does not
interactively update the ActiveShade window.

■ Reflections are rendered only in the Initialize pass.

■ Materials are displayed as RGBA data with 8 bits per channel.

■ Multiple changes to a material might lead to deterioration in image quality.
If you see this happening, right-click the ActiveShade window and choose
Tools > Initialize from the quad menu (lower-right quadrant).

■ Masks are reduced from 8x8 to 4x4 subdivisions per pixel. The mask is
corrected to 6-bit opacity (0 to 63 rather than 0 to 255). This might result
in some visual noise around object edges.

■ Because of the preceding item, filters are coarser than in full-scale
renderings, but they still have significant subpixel information.

■ There is a limitation of 16 subdivisions per pixel. Because of this, any
objects behind the sixteenth occluding object for a given pixel will be
ignored. Rendered back faces count as separate objects.

■ Reshading uses compressed normals and other direction vectors. This
should have no visible effect.

■ ActiveShade does not render atmospheric effects, rendering effects, or
ray-traced shadows (the only shadows it can render are shadow-mapped
shadows).

Procedures

To display an ActiveShade window in a viewport:

■ Right-click the viewport label, choose Views, and then ActiveShade.

NOTE  You can't make a maximized viewport an ActiveShade window,
or maximize an ActiveShade window.
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To display a free-floating ActiveShade window:

■  Choose Quick Render (ActiveShade) from the Quick Render flyout
on page 5908 .

NOTE As with Quick Render, the ActiveShade window respects the Output Size
setting in the Render Scene dialog on page 5878 . To use a different render size,
set it first in Render Scene, and then open the ActiveShade window.

To update an ActiveShade window after moving an object or changing object
geometry:

1 Right-click the ActiveShade window.

2 In the Tools (lower-right) quadrant of the quad menu, choose Initialize.

To see the toolbar in an ActiveShade viewport:

1 Click the viewport to make it active.

2 Press the Spacebar to display the toolbar.

Pressing spacebar again toggles the toolbar off, and so on.

You can also turn toolbar display on or off by right-clicking and using
the quad menu.

To change an ActiveShade viewport to another kind of viewport:

1 Turn on the toolbar in the ActiveShade viewport.

2 Right-click the toolbar.

3 In the pop-up menu, choose the type of view to display.

You can also restore the viewport to its previous status by right-clicking
the viewport and choosing View (upper-left) quad > Close.

To zoom and pan in an ActiveShade window:

You can zoom in and out and pan the image in the ActiveShade window. You
can even do this while a scene is rendering.

1 Hold down Ctrl and then click to zoom in, right-click to zoom out.

2 Hold down Shift and then drag to pan. (The window must be zoomed
in.)

ActiveShade | 5915



If you have a three-button mouse, you can use its third button or wheel to
zoom and pan:

1 Roll the wheel to zoom in or out.

2 Press the wheel, and drag to pan.

NOTE You can use any third-button pointing device to pan the image. To
enable this, choose the Pan/Zoom option on the Viewports panel on page
7545  of the Preferences dialog

Interface

Both the viewport and floating versions of the ActiveShade window have the
same controls as a rendered frame window on page 5885 . In an ActiveShade
viewport, the toolbar is off by default. In a floating ActiveShade window, the
toolbar is always visible.

TIP In an active ActiveShade viewport, you can toggle toolbar display by pressing
the Spacebar. (This is a main user interface shortcut, so the Keyboard Shortcut
Override Toggle can be either on or off.)
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TIP If you clear the image, you can redisplay it by right-clicking the ActiveShade
window and choosing Tools > Initialize or Tools > Update Shading from the
lower-right quadrant of the quad menu.

ActiveShade Floater

Main toolbar > Quick Render flyout > Quick Render (ActiveShade)

Menu bar > Rendering > ActiveShade Floater

Click ActiveShade Floater to create an ActiveShade rendering in its own
window.

Only one ActiveShade window can be visible at a time. If you change a
viewport to an ActiveShade view while a floating ActiveShade window is open,
you get a message that asks whether you want to close the floating window,
or stop the operation.
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See also:

■ ActiveShade on page 5910

■ ActiveShade Commands (Quad Menu) on page 5919

■ ActiveShade Initialize and Update on page 7703

ActiveShade Viewport

Right-click viewport label. > Views > ActiveShade

Creates an ActiveShade rendering on page 5910  that is "docked" in a viewport.

Only one ActiveShade rendering can be displayed at a time. If you try to
display a floating ActiveShade window while an ActiveShade viewport is
displayed, you get a message that asks whether you want to close the docked
ActiveShade rendering, or stop the operation. If you go ahead and close the
docked ActiveShade rendering, the viewport reverts to the view it previously
showed.

ActiveShade Commands

When you right-click an ActiveShade viewport, the quad menu on page 7300
displays an ActiveShade menu. This menu contains a number of ActiveShade
commands on page 5919 .

ActiveShade and Object Selection

If you select an object before you invoke ActiveShade, ActiveShade is done
only for that object. This can greatly increase the speed of ActiveShade.

Similarly, once the ActiveShade window is open, the initialize and update
steps on page 7703  (whether automatic or manual) are done only for the selected
object.

In a "docked" ActiveShade viewport, you can select objects by right-clicking,
turning on Select Object in the Tools (lower-right) quadrant of the quad menu,
then clicking the object you want to select. In an ActiveShade viewport, only
one object at a time can be selected.

TIP When an object in an ActiveShade window has a mapped material, select it
before you change a map or adjust its parameters.
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Procedures

To display the toolbar for the ActiveShade viewport:

■ Press the Spacebar.
The Spacebar toggles the toolbar display. In viewports, the toolbar is off
by default.

(This is a main user interface shortcut, so the Keyboard Shortcut Override
Toggle can be either on or off.)

The controls on the toolbar for an ActiveShade viewport are the same as for
a floating ActiveShade window on page 5917 .

To change the ActiveShade viewport to another kind of viewport, do one of
the following:

■ Right-click the ActiveShade viewport, and choose Close from the View
(upper-left) quadrant of the quad menu.
The viewport reverts to the view it previously showed.

■ If the toolbar is not visible, press the Spacebar to display it, then right-click
the toolbar and choose the kind of view to display.

ActiveShade Commands (Quad Menu)

When you right-click an ActiveShade window, the lower-left quadrant of the
quad menu displays a set of commands for ActiveShade on page 5910 .
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Interface

Render quadrant (upper right)

These are general-purpose commands.

Show Last Rendering Displays the last rendering in a rendered frame window
on page 5885 . Not available if no rendering has been made during this session.

Render Displays the Render Scene dialog on page 5878 . When you use the
ActiveShade quad menu, initially Render Scene is set to render the ActiveShade
window.

Render Last Repeats the last render, using the last viewport from which you
rendered.

Material/Map Browser Displays a modeless Material/Map Browser on page
5261 .

Material Editor Displays the Material Editor on page 5188 .

Tools quadrant (lower right)

These are the commands that perform ActiveShade operations.

Draw Region When on, lets you draw a rectangular region of the ActiveShade
window. While it is active, only the region is updated by interactive reshading.
This can save time, and also help you concentrate on just a portion of the
image to be rendered. Default=off.

To turn off Draw Region, click outside the rectangular region. The entire
ActiveShade window is updatable again.
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Initialize Initializes the ActiveShade window. To keep the ActiveShade
window current, you need to choose Initialize after transforming, modifying,
or otherwise changing geometry. If you have turned off Automatic
Reinitialization, you also need to choose Initialize after you update a mapped
material.

Rendering can be slow. The initialize pass is meant to take care of the most
time-consuming portions of rendering, to allow the update pass to take place
as quickly as possible. Initialization includes the following steps:

■ Evaluate the scene geometry into meshes.

■ Apply space warps.

■ Do transformations and clipping.

■ Evaluate textures and shade materials.

■ Perform optimizations to speed later processing, such as merging fragments
from the same surface that are in the same pixel.

The result of initialization is a buffer. This is a compressed rendering that, like
a G-Buffer on page 7795 , contains the rendering plus additional information
used by the second step, updating.

During the initialize pass, progress is indicated by a row of pixels (white by
default) that traverses the top edge of the ActiveShade window.

Update Updates the ActiveShade window. Updating shading takes the buffer
created by the first pass, initialization, and uses information in that buffer to
change the color of pixels when you make changes to lights and materials in
the scene.

During the update pass, progress is indicated by a row of pixels (white by
default) that descends the right edge of the ActiveShade window.

To keep the ActiveShade window current, you need to choose Update Shading
if you have previously turned off Automatic Shading Update.

Select Object (viewports only) When on, you can select an object in the
ActiveShade window by clicking. You can select only one object at a time.

When an objects is selected in the ActiveShade window, the Initialize pass
resamples textures for that object alone. This improves the window's rendering
speed, and is useful when you are adjusting texture display.

Toggle Toolbar (viewports only) Toggles display of the ActiveShade window
toolbar in viewports.

ActiveShade Commands (Quad Menu) | 5921



Keyboard shortcut: Spacebar

NOTE  The Keyboard Shortcut Override toggle on page 7646  must be on
for the spacebar to toggle the ActiveShade toolbar.

Options quadrant (lower left)

These commands control how the ActiveShade window behaves.

Act Only On Mouse Up When on, changes you make to light and material
parameters (for example, the RGB or Multiplier spinners) update the
ActiveShade window only after you release the mouse. When off, changes to
these parameters are updated immediately, as you drag the mouse. Default=on.

Turning off Act Only On Mouse Up can make the ActiveShade window more
responsive to changes, but it can also slow performance.

Auto Initialization When on, changes you make to textures (mapped
materials) automatically cause the ActiveShade window to initialize.
Default=on.

Initialization can be time consuming in complex scenes. To save time, you
can turn off Automatic Reinitialization, or use Draw Region to restrict
initialization and shading updates to only a portion of the scene.

Auto Update When on, changes you make to lighting, and materials without
maps, automatically cause an update of the ActiveReshade window. Default=on.

View quadrant (upper left)

Close Closes the ActiveShade window. If the ActiveShade window was docked
in a viewport, the viewport reverts to the view it previously displayed.

Preset Rendering Options

Render Scene dialog > Preset drop-down list (on the bottom row of controls)

Preset rendering options are available from the Rendering Presets drop-down
list, which appears at the bottom of the Render Scene dialog on page 5878 .
Some of the presets are tailored for relatively quick, preview renderings; others
are for slower but higher quality renderings. Presets are saved as RPS files.
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TIP The Render Shortcuts toolbar on page 7291  lets you quickly switch between
active presets.

In addition to the default presets that ship with 3ds Max, you can also create
your own settings. At the bottom of the preset list, two choices let you use
and create your own custom presets:

Load Preset When you choose Load Preset, 3ds Max displays a file selector
dialog that lets you choose the RPS file to load.

Each category corresponds to one panel of the Render Scene dialog. Choose
which panel's settings you want to load from the RPS file, and click Load.
Once you load a custom preset file, its name appears on the drop-down list,
along with the default choices.

IMPORTANT Even though the renderer is assigned in the Common panel of the
Render Scene dialog, renderer assignments are not loaded with the Common
category in the RPS file. The current renderer assignment has its own category in
the Select Preset Categories dialog. For example, if the current renderer is the
Default Scanline Renderer, the Select Preset Categories dialog will have a category
labeled Default Scanline Renderer.

Save Preset When you choose Save Preset, 3ds Max first displays a file selector
dialog, letting you name the RPS file. After that, the Select Preset Categories
dialog opens.
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Each category corresponds to one panel of the Render Scene dialog. Choose
which panel's settings you want to save, and then click Save. Once you save
a custom preset file, its name appears on the drop-down list, along with the
default choices.

IMPORTANT Even though the renderer is assigned in the Common panel of the
Render Scene dialog, renderer assignments are not saved with the Common
category in the RPS file. The current renderer assignment has its own category in
the Select Preset Categories dialog. For example, if the current renderer is the
Default Scanline Renderer, the Select Preset Categories dialog will have a category
labeled Default Scanline Renderer.

The RPS files that provide the default presets are in the \renderpresets subfolder
of the program folder. We recommend you save your own presets in this
subfolder as well. If you choose a different location, 3ds Max saves the full
path name. (You can also use the Configure User Paths dialog > File I/O panel
on page 7524  to specify your custom location.)

Show Last Rendering

Rendering menu > Show Last Rendering

Show Last Rendering displays the last rendered image. If no image has yet
been rendered, this command is not available.

Render Last

Keyboard > F9
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The Render Last command repeats the last render (whether a render view,
render region, render blowup, or render selected) using the last viewport from
which you rendered.

WARNING Render Last does not save to a file, even if the previous rendering did
so.

Print Size Wizard

Rendering menu > Print Size Wizard

The Print Size Wizard feature is useful when you plan to print a rendered
image. It lets you specify output size, resolution, and orientation in terms of
the printed image; that is, using a standard measuring system rather than
pixels. It also indicates the approximate uncompressed size of the image file.
You can render directly from the wizard on your computer or over a network,
or transfer the settings to the Render Scene dialog on page 5878 .

Procedures

To use the Print Size wizard:

1 Set up a scene to render.

2 From the Rendering menu, choose Print Size Wizard.

3 Choose a preset paper size, or specify a custom size in inches or
millimeters. Alternatively, specify an image size in pixels.

4 Choose or specify a DPI (dots per inch) ratio for the printed output.

5 Choose an output orientation: Portrait or Landscape.

6 When ready to render to a file, turn on Save File, click the Files button,
and use the resulting Select TIFF File dialog to specify an output image
file.

7 Do one of the following:

■ To render immediately, click Quick Render.

■ To set further rendering properties, click Render Scene.
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Interface

Paper Size group

drop-down list The Paper Size drop-down list lets you choose from several
standard print resolutions and aspect ratios. Choose one of these formats, or
leave it set to Custom to use the other controls in the Paper Size group. These
are the options you can choose from on the list:

■ Custom

■ A - 11 x 8.5 in. (at 300 dpi)

■ B - 17 x 11 in. (at 200 dpi)

■ C - 22 x 17 in. (at 150 dpi)

■ D - 34 x 22 in. (at 100 dpi)
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■ E - 44 x 34 in. (at 75 dpi)

■ A0 - 1189 x 841 mm (at 75 dpi)

■ A1 - 841 x 594 mm (at 100 dpi)

■ A2 - 594 x 420 mm (at 150 dpi)

■ A3 - 420 x 297 mm (at 200 dpi)

■ A4 - 297 x 210 mm (at 300 dpi)

■ A5 - 210 x 148 mm (at 300 dpi)

■ Letter (11 x 8.5 in. at 300 dpi)

■ Legal (14 x 8.5 in. at 300 dpi)

■ Tabloid (17 x 11 in. at 300 dpi)

TIP You can customize the Paper Size list by editing the file plugcfg\printwiz.ini
. If you choose to edit the file, first be sure to save a backup copy of the original.

Portrait/Landscape Choose Portrait for vertically oriented output or
Landscape for horizontal output. The window image provides a graphic
depiction of the orientation.

NOTE Changing between Portrait and Landscape simply switches the Width and
Height settings. The actual orientation depends on the image dimensions. For
example, if you choose Portrait, and then specify a custom size whose width is
greater than its height, the resulting orientation will be horizontal.

TIP After changing this setting, be sure to preview the image using the Show
Safe Frame on page 7377  function from the viewport right-click menu. This shows
how the output orientation corresponds to the viewport.

Choose Unit Lets you specify whether the measurement units for Paper
Width and Paper Height are in millimeters (mm) or inches.

Choose DPI Value Provides four buttons for commonly used dots-per-inch
settings: 72, 150, 300, and 600. Click one to set it in the DPI property, below.

Paper Width/Height Specifies the output width and height in mm
(millimeters) or inches, depending on which is chosen under Choose Unit.

NOTE Changing either setting also changes the corresponding Image size setting.
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Image Width/Height Specifies the output width and height in pixels.

NOTE Changing either setting also changes the corresponding Paper size setting.

DPI Specifies the output resolution in dots per inch. The easiest way to set
this is by clicking one of the buttons under Choose DPI Value. If you're using
a different resolution, set it here manually.

Only TIFF files on page 7164  support DPI information. If you render to a
different image format, you might have to later adjust the image resolution
using an image-processing application.

NOTE Changing the DPI setting also changes the Image Width/Height settings,
keeping the same aspect ratio.

Uncompressed File Size Displays the size of the rendered TIFF image file if
no compression is used.

Rendering group

Rendering directly from the Print Size Wizard allows you to output the current
frame to a disk file in TIFF format on page 7164 . This format is commonly used
in the publishing industry. To render to a different format, use the wizard's
Render Scene Dialog button.

Save File When on, the software saves the rendered image to disk when you
render. Save File is available only after you specify the output file using the
Files button. Default=off.

Files Opens the Select TIFF File dialog, which lets you specify the output file
name and location. If, during the current session, you already rendered an
image to disk using the Render Scene dialog on page 5878 , the last file name
you used appears in this field.

Save Alpha Channel When on, the software includes an eight-bit alpha
channel on page 7709  in the rendered TIFF file on page 7164 . Default=off.

Compress File When on, uses compression when saving the file.

Render Scene Dialog Opens the Render Scene dialog on page 5878  and
transfers any settings (such as image size) you've made in the Print Size Wizard.
Here you can make further changes and then render the scene.

Quick Render Renders the scene to the Rendered Frame Window on page
5885 . Also renders to a disk file if you've turned on Save File and specified a file
name.
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Common Rendering Parameters

Common Panel (Render Scene Dialog)

Rendering menu > Render > Render Scene dialog > Common panel

Main toolbar > Render Scene > Render Scene dialog > Common panel

The Render Scene dialog's Common panel contains controls that apply to any
rendering, regardless of which renderer you have chosen, and that lets you
choose renderers.

Interface

Common Parameters Rollout (Render Scene Dialog) on page 5929

Email Notifications Rollout on page 5939

Scripts Rollout (Render Scene Dialog) on page 5941

Assign Renderer Rollout on page 5943

Common Parameters Rollout (Render Scene Dialog)

Rendering menu > Render > Render Scene dialog > Common panel > Common
Parameters rollout

The Common Parameters rollout sets parameters common to all renderers.

Procedures

To set the size of the image, do one of the following:

1 In the Output Size group, click one of the preset resolution buttons.

2 In the Output Size group, choose one of the pre-formatted film or video
formats from the drop-down list.

3 In the Output Size group, choose Custom from the drop-down list, and
then adjust the Width, Height, and Aspect Ratio values manually.
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TIP Smaller images render much more quickly. For example, you can use
320 x 240 to render draft images, then change to a larger size for your final
work.

To save the rendered still image in a file:

1 In the Render Output group, click Files.

2 In the file dialog, specify a name and a type for the image file, and then
click OK.

The Save File toggle turns on.

You can later turn off Save File if you want only to view the rendering
on screen.

NOTE The file dialog has a Setup button. This displays a subdialog that lets
you choose options specific to the file type you are saving to.

To alter the pixel aspect ratio:

■ In the Output Size group of the Render Scene dialog, adjust the Pixel Aspect
Ratio to fit the requirements of your output device.
The Image Aspect Ratio field updates to show what the aspect of the
rendered image will be.

If you alter pixel aspect ratio but also render to a window or a file, the
rendered image appears distorted.

To speed up rendering time for the purpose of a test (or draft) rendering:

1 In the Options group of the Common Parameters panel, turn on Area
Lights/Shadows As Points.

2 Set any other parameters and click Render.

All area and linear lights in the scene are treated as point lights during
the rendering. This reduces rendering time, however some quality is lost.
When you are ready to render at high quality, you can simply turn off
Area Lights/Shadows As Points and render again.

NOTE Scenes with radiosity on page 5976  are not affected by the Area
Lights/Shadows As Points toggle, as area lights do not have a significant effect
on the performance of a radiosity solution.
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Interface

Common Parameters Rollout (Render Scene Dialog) | 5931



Time Output group

Select which frames you want to render.

Single Current frame only.

Active Time Segment The Active Time Segment on page 7702  is the current
range of frames as shown in the time slider.

Range All the frames between and including the two numbers you specify.

Frames Nonsequential frames separated by commas (for example, 2,5) or
ranges of frames, separated by hyphens (for example, 0-5).

■ File Number Base Specifies the base file number, from which the file
name will increment. Range= -99,999 to 99,999. Available only for Active
Time Segment and Range output.

■ Every Nth frame Regular sample of frames. For example, type 8 to render
every 8th frame. Available only for Active Time Segment and Range output.

For example, if the Range of frames is set to 0-3, Every Nth Frame is 1, and
the File Number Base is 15, the output files are file0015, file0016, file0017,
file0018.

You can specify a negative number base, as well. For example, if you're
rendering frames 50-55, and set the File Number Base to -50, the result is
file-050, file-051, file-052, file-053, file-054, file-055.

NOTE If you begin render a range of frames, but haven't assigned a file in which
to save the animation (using the Files button on page 5937 ), an alert box appears
to warn you about this. Rendering animations can take a long time, and usually
it doesn't make sense to render a range without saving all frames to a file.

Output Size group

Select one of the predefined sizes or enter another size in the Width and Height
fields (in pixels). These controls affect the image's aspect ratio on page 7718 .

Drop-down list The Output Size drop-down list lets you choose from several
standard film and video resolutions and aspect ratios. Choose one of these
formats, or leave it set to Custom to use the other controls in the Output Size
group. These are the options you can choose from on the list:

■ Custom

■ 35mm 1.316:1 Full Aperture (cine)
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■ 35mm 1.37:1 Academy (cine)

■ 35mm 1.66:1 (cine)

■ 35mm 1.75:1 (cine)

■ 35mm 1.85:1 (cine)

■ 35 MM Anamorphic (2.35:1)

■ 35 MM Anamorphic (2.35:1) (Squeezed)

■ 70mm Panavision (cine)

■ 70mm IMAX (cine)

■ VistaVision

■ 35mm (24mm X 36mm) (slide)

■ 6cm X 6cm (2 1/4" X 2 1/4") (slide)

■ 4" X 5" or 8" X 10" (slide)

■ NTSC D-1 (video)

■ NTSC DV (video)

■ PAL (video)

■ PAL DV (video)

■ HDTV (video)

NOTE The values of the Image Aspect and Width and Height buttons can change,
depending on which output format you select from this list.

Aperture Width (mm) Lets you specify an aperture width for the camera
that creates the rendered output. Changing this value changes the camera's
Lens value. This affects the relationship between the Lens and the FOV values,
but it doesn't change the camera's view of the scene.

For example, if you have a Lens setting of 43.0 mm, and you change the
Aperture Width from 36 to 50, when you close the Render Scene dialog (or
render), the camera Lens spinner has changed to 59.722, but the scene still
looks the same in the viewport and the rendering. If you use one of the preset
formats rather than Custom, the aperture width is determined by the format,
and this control is replaced by a text display.
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Width and Height Let you set the resolution of the output image by
specifying the width and the height of the image, in pixels. With Custom
format, you can set these two spinners independently. With any other format,
the two spinners are locked to the specified aspect ratio, so adjusting one alters
the other. The maximum width and height is 32,768 x 32,768 pixels.

Preset resolution buttons (320x240, 640x480, and so on) Click one of these
buttons to choose a preset resolution. You can customize these buttons:
right-click a button to display the Configure Preset dialog on page 5938 , which
lets you change the resolution specified by the button.

Image Aspect Lets you set the aspect ratio of the image. Changing this value
changes the Height value to maintain the correct dimensions for the active
resolution. When you use a standard format rather than Custom, you can't
change the aspect ratio, and this control is replaced by a text display.

In 3ds Max, the Image Aspect value is always expressed as a multiplier value.
In written descriptions of film and video, often aspect ratio is also described
as a ratio. For example, 1.33333 (the default Custom aspect ratio) is often
expressed as 4:3. This is the standard aspect ratio for broadcast video (both
NTSC on page 7863  and PAL on page 7882 ) when letterboxing is not used.
(Letterboxing shows the full width of a wide-screen film format, framed by
black regions above and below.)

When using a custom output size, the lock button to the left of Image
Aspect locks the aspect ratio. When it is on, the Image Aspect spinner is
replaced by a label, and the Width and Height spinners are locked to each
other; adjusting one alters the other to maintain the aspect-ratio value. In
addition, when the aspect ratio is locked, altering the Pixel Aspect value alters
the Height value to maintain the aspect-ratio value.

NOTE In viewports, the camera's cone changes to reflect the image aspect ratio
you set in the Render Scene dialog. This change takes place when you exit the
Render Scene dialog.

Pixel Aspect Sets the aspect ratio of the pixels for display on another device.
The image might look squashed on your display but will display correctly on
the device with differently shaped pixels. If you use one of the standard formats
rather than Custom, you can't change the pixel aspect ratio and this control
is disabled.
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 The lock button to the left of Pixel Aspect locks the pixel-aspect ratio.
When it is on, the Pixel Aspect spinner is replaced by a label, and you can't
change the value. This button is available only with the Custom format.

Images with different pixel aspects appear stretched or squashed on a monitor with
square pixels.

NOTE For standard NTSC on page 7863 , the pixel aspect ratio is 0.9. If you are
creating 16:9 (0.778) anamorphic images for NTSC, the pixel aspect ratio should
be 1.184. (As in the previous discussion of Image Aspect, this assumes the image
is not letterboxed.)

Options group

Atmospherics Renders any applied atmospheric effects, such as volume fog,
when turned on.

Effects Renders any applied rendering effects, such as Blur, when turned on.

Displacement Renders any applied displacement mapping.
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Video Color Check Checks for pixel colors that are beyond the safe NTSC
on page 7863  or PAL on page 7882  threshold and flags them or modifies them
to acceptable values.

By default, "unsafe" colors render as black pixels. You can change the color
check display by using the Rendering panel on page 7560  of the Preference
Settings dialog on page 7534 .

Render to Fields Renders to video fields on page 7777  rather than frames
when creating animations for video.

Render Hidden Geometry Renders all geometric objects in the scene, even
if they are hidden.

Area Lights/Shadows as Points Renders all area lights or shadows as if they
were emitted from point objects, speeding up rendering time.

TIP This is useful for draft renderings, as point lights render much faster than area
lights.

NOTE Scenes with radiosity on page 5976  are not affected by this toggle, as area
lights do not have a significant effect on the performance of a radiosity solution.

Force 2-Sided 2-Sided rendering on page 7697  renders both sides of all faces.
Usually, you'll want to keep this option off to speed rendering time. You may
want to turn it on if you need to render the inside as well as the outside of
objects, or if you've imported complex geometry in which the face normals
are not properly unified.

NOTE This switch does not apply to objects that use the mental ray material Arch
& Design on page 5458 . In such cases, turn on the material's Advanced Rendering
Options rollout > Back Face Culling check box on page 5486 .

Super Black Super Black rendering on page 7942  limits the darkness of
rendered geometry for video compositing. Leave off unless you're sure you
need it.

Advanced Lighting group

Use Advanced Lighting When on, the software incorporates a radiosity
solution on page 5976  or light tracing on page 5963  in the rendering.

Compute Advanced Lighting When Required When on, the software
computes radiosity when required on a per-frame basis.
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Normally, when rendering a series of frames, the software calculates radiosity
only for the first frame. If, in an animation, it might be necessary to recalculate
the advanced lighting in subsequent frames, turn this option on. For example,
a brightly painted door might open and affect the coloring of a nearby white
wall, in which case the advanced lighting should be recalculated.

Bitmap Proxies group

Displays whether 3ds Max is using full-resolution maps or bitmap proxies for
rendering. To change this setting, click the Setup button.

Setup Click to open the Global Settings and Defaults for Bitmap Proxies
dialog on page 6912 .

Render Output group

Save File When on, the software saves the rendered image or animation to
disk when you render. Save File is available only after you specify the output
file using the Files button.

Files Opens the Render Output File dialog on page 5892 , which lets you specify
the output file name, format, and location.

You can render to any of the still or animated image file formats on page 7116
that are writable.

If you render multiple frames to a still-image file format, the renderer renders
individual frame files and appends sequence numbers to each file name. You
can control this with the File Number Base setting on page 5932 .

Put Image File List(s) in Output Path(s) Turn on to create an image sequence
(IMSQ) file on page 7138 , and save it in the same directory as the rendering.
Default=off.

3ds Max creates one IMSQ file (or IFL file) per render element on page 6144 .
The files are created when you click Render or Create now. They are generated
before the actual rendering.

Image sequence files are created by the following kinds of rendering:

■ The Render Scene dialog

■ Batch rendering

■ Command-line rendering

■ MAXScript rendering
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■ ActiveShade rendering

They are not created by the following kinds of rendering:

■ The Quick Render button

■ Rendering to textures

■ Video Post rendering

■ Rendering a panorama

■ Create Now Click to create the image sequence file “by hand.” You must
first choose an output file for the rendering itself.

■ Autodesk ME Image Sequence File (.imsq) When chosen (the default),
creates an Image Sequence (IMSQ) file on page 7138 .

■ Legacy 3ds max Image File List (.ifl) When chosen, creates an Image File
List (IFL) file on page 7131  of the kind created by previous versions of 3ds
Max.

Use Device Sends the rendered output to a device such as a video recorder.
First click the Devices button to specify the device, for which an appropriate
driver must already be installed.

Rendered Frame Window Displays the rendered output in the rendered
frame window on page 5885 .

Net Render Enables network rendering on page 6231 . If this is on, when you
render you'll see the Network Job Assignment dialog on page 6279 .

Skip Existing Images When activated and Save File is on, the renderer will
skip images in a sequence that have already been rendered to disk.

Configure Preset Dialog

Main menu > Render Scene > Render Scene Dialog > Common panel >
Common Parameters rollout > Output Size group > Right-click a preset
resolution button. > Configure Preset dialog

This dialog lets you change the preset resolution on a button in the Output
Size group of the Common Parameters rollout.
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Interface

Width Sets the output width, in pixels.

Height Sets the output height, in pixels.

Pixel Aspect Sets the output pixel aspect ratio.

Get Current Settings Gets the current Width, Height, and Pixel Aspect
settings from the Output Size group, and assigns them to the spinners on this
dialog.

Email Notifications Rollout

Rendering menu > Render Scene dialog > Common panel > Email Notifications
rollout

Main toolbar > Render Scene button > Render Scene dialog > Common panel
> Email Notifications rollout

This rollout lets a rendering job send email notifications, as network rendering
does. Such notifications can be useful when you launch a lengthy render, such
as an animation, and don't care to spend all your time near the system doing
the rendering.
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Interface

Enable Notifications When on, the renderer sends an email notification
when certain events happen. Default=off.

Categories group

Notify Progress Sends emails to indicate rendering progress. An email is sent
every time the number of frames specified in Every Nth Frame has completed
rendering. Default=off.

■ Every Nth Frame The number of frames used by Notify Progress.
Default=1.

TIP If you turn on Notify Progress, almost certainly you want this value to be
greater than the default!

Notify Failures Sends an email notification only if something occurs to
prevent the completion of a rendering. Default=on.

Notify Completion Sends an email notification when a rendering job is
complete. Default=off.

Email Options group

From Enter the email address of the person who initiates the rendering job.
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To Enter the email address of the person who needs to know the rendering
status.

SMTP Server Enter the numeric IP address of the system you use as a mail
server.

Scripts Rollout (Render Scene Dialog)

Rendering menu > Render Scene dialog > Common panel > Scripts rollout

Main toolbar > Render Scene button > Render Scene dialog > Common panel
> Scripts rollout

The scripts rollout lets you specify scripts to run either prior to rendering, or
after rendering. The script to execute can be:

■ A MAXScript file (MS)

■ A macro script (MCR)

■ A batch file (BAT)

■ An executable file (EXE)

If relevant to its format, the script can have command-line arguments.

The pre-render script is executed before rendering (but after any other
MAXScript scripts that are registered using the #preRender callback
mechanism). The post-render script is executed after rendering has completed.
You can also use the “Execute Now” buttons to run the scripts “by hand.”
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Interface

Pre-Render group

Specifies a script to run before you render.

Enable When on, the script is enabled.

Execute Now Click to execute the script “by hand.”

File name field When a script is selected, this field shows its path and name.
You can edit this field.

File Click to open a file dialog and choose the pre-render script to run.

Delete File Click to remove the script.

Execute Locally (Ignored by Network Rendering) When on, the script must
run locally. If you use network rendering, the script is ignored. Default=off.

Post-Render group

Specifies a script to run after you render.

Enable When on, the script is enabled.

Execute Now Click to execute the script “by hand.”

File name field When a script is selected, this field shows its path and name.
You can edit this field.
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File Click to open a file dialog and choose the post-render script to run.

Delete File Click to remove the script.

Assign Renderer Rollout

Main toolbar > Render Scene button > Render Scene dialog > Common panel
> Assign Renderer rollout

Rendering menu > Render > Render Scene dialog > Common panel > Assign
Renderer rollout

The Assign Renderer rollout displays which renderers are assigned to the
production and ActiveShade categories, as well as the sample slots in the
Material Editor.

The Quick Render flyout on the toolbar also chooses which renderer to use:

■  The Quick Render (Production) button uses the production renderer.

■  The Quick Render (ActiveShade) button uses the ActiveShade
renderer.

These are the renderers that ship with 3ds Max:

Default Scanline Renderer Rollout on page 5949

mental ray Renderer on page 6039  (not available for ActiveShade)

VUE File Renderer on page 6143  (not available for ActiveShade)

Additional renderers might be available if you've installed them as plug-ins.
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Interface

For each rendering category, the rollout shows the name of the renderer
currently assigned, and a button that lets you change the assignment.

Choose Renderer (“...”) Click the button with the ellipsis to change the
renderer assignment. The button displays a Choose Renderer dialog on page
5944 .

■ Production Chooses the renderer used to render graphic output.

■ Material Editor Chooses the renderer used to render sample slots on
page 5208  in the Material Editor.

 By default, the sample slot renderer is locked to be the same as the
production renderer. You can turn off the lock button to assign a different
renderer for sample slots.

■ ActiveShade Chooses the ActiveShade on page 5910  renderer used to
preview the effects of lighting and material changes in the scene.
The only ActiveShade renderer that ships with 3ds Max is the default
scanline renderer.

Save as Defaults Click to save the current renderer assignments as defaults,
so they will be active the next time you restart 3ds Max.

Choose Renderer Dialog

Main toolbar > Render Scene button > Render Scene dialog > Common panel
> Assign Renderer rollout > Click a Choose Renderer (“...”) button.
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Rendering menu > Render > Render Scene dialog > Common panel > Assign
Renderer rollout > Click a Choose Renderer (“...”) button.

This dialog appears when you click one of the Choose Renderer (“...”) buttons
on the Assign Renderer rollout on page 5943 .

Procedures

To change the renderer assigned to the category you picked, do one of the
following:

1 Click to highlight another renderer's name in the list, and then click OK.

2 Double-click another renderer's name in the list

Interface

The scrollable list shows the names of renderers that you can assign, exclusive
of the renderer that is currently assigned to the rendering category you are
reassigning .
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Renderers

Renderer Panel (Render Scene Dialog)

Rendering menu > Render > Render Scene dialog > Render panel

Main toolbar > Render Scene > Render Scene dialog > Renderer panel

The Render Scene dialog's Renderer panel contains the main controls for the
active renderer. Depending on which renderer is active, additional panels can
become available.

TIP The default scanline renderer on page 5949  and the mental ray renderer on
page 6039  each have their own capabilities. In general, for each scene, you will
decide which renderer you want to use. It is a good idea to design materials with
a particular renderer in mind. The mental ray Connection rollout on page 5289  lets
you add features unique to the mental ray renderer to basic 3ds Max materials.
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Interface

When the Default Scanline Renderer Is Active

The Renderer panel contains a single rollout:

Default Scanline Renderer Rollout on page 5949

Additional panels are:

■ Advanced Lighting Panel on page 5962

■ Raytracer Panel on page 6030

■ Render Elements panel on page 6144
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When the mental ray Renderer Is Active

The renderer panel contains these rollouts:

Sampling Quality Rollout (mental ray Renderer) on page 6083

Rendering Algorithms Rollout (mental ray Renderer) on page 6118

Camera Effects Rollout (mental ray Renderer) on page 6087

Shadows and Displacement Rollout (mental ray Renderer) on page 6114

Additional panels are:

■ Indirect Illumination panel
Caustics and Global Illumination Rollout (mental ray Renderer) on page
6096

Final Gather Rollout (mental ray Renderer) on page 6104

■ Processing panel
Translator Options Rollout (mental ray Renderer) on page 6122
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Diagnostics Rollout (mental ray Renderer) on page 6129

Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6131

When the VUE File Renderer Is Active

The Renderer panel contains a single rollout:

VUE File Renderer on page 6143

Default Scanline Renderer Rollout

Main toolbar > Render Scene > Render Scene dialog > Choose Default Scanline
Renderer as the active draft or production renderer. > Renderer panel > Default
Scanline Renderer rollout

Rendering menu > Render > Render Scene dialog > Choose Default Scanline
Renderer as the active draft or production renderer. > Renderer panel > Default
Scanline Renderer rollout
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This rollout sets parameters for the default scanline renderer on page 7918 .

NOTE If your scene includes animated bitmaps, including materials, projector
lights, environments, and so on, the animation file is reloaded once per frame. If
your scene uses multiple animations, or if the animations are themselves large
files, this can slow down rendering performance.

Environment Alpha Toggle and Filtering

To control whether or not the renderer uses the environment map's alpha
channel in creating the alpha for the rendered image, choose Customize >
Preferences > Rendering on page 7560 , and then turn on Use Environment
Alpha in the Background group. If Use Environment Alpha is off (the default),
the background receives an alpha value of 0 (completely transparent). If Use
Environment Alpha is on, the alpha of the resulting image is a combination
of the scene and the background image's alpha channel. Also, when you render
to TGA files on page 7162  with premultiplied alpha on page 7900  turned off,
turning on Use Environment Alpha prevents incorrect results.

You can also control whether or not a background image is affected by the
renderer's antialiasing filter. Choose Customize > Preferences > Rendering,
and then turn on Filter Background in the Background group. Default=off.

TIP If you plan to composite 3ds Max objects in another program such as
Combustion or Photoshop, render the objects against a black background.
Otherwise, a fringe of environment or background color can appear around the
3ds Max objects.

Plate Match Filtering

This section describes the Plate Match/MAX R2 antialiasing filter (see
Antialiasing group on page 5954  for descriptions of other filtering options).

In versions of 3ds Max prior to R2.5, antialiasing affected only geometric edges,
with the filtering of bitmaps being controlled in the Bitmap Map parameters
(pyramidal, summed area, or no filtering). Current antialiasing filters affect
every aspect of the object, filtering textures along with geometric edges.

While the method used in R2.5 and subsequent versions provides superior
results, this method also produces inconsistencies when rendering objects
that are supposed to match the environment background, because the
antialiasing filters do not affect the background by default (FilterBackground=0
in the [Renderer] section of the 3dsmax.ini on page 51  file or Customize menu
> Preferences > Rendering tab > Background group > Filter Background). In
order to correctly match an object’s map to an unfiltered background image,
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you need to use the Plate Match/MAX R2 filter so the texture is not affected
by the antialiasing.

There are three ways you can render objects to blend seamlessly into a
background environment:

■ Assign a matte/shadow material on page 5538 .

■ Assign a 100% self-illuminated diffuse texture to an object using Camera
Mapping on page 1154 .

■ Assign a 100% self-illuminated diffuse texture using Environment/Screen
projection (see Coordinates Rollout (2D) on page 5620 ).
Use Plate Match/MAX R2 antialiasing when you need to match foreground
objects with an unfiltered background, or when you need to match the
antialiasing qualities of the 3ds Max 2 renderer.

Procedures

To set up an object for motion blurring:

1 Select the object to blur.

2 Right-click the object, and then choose Properties from the quad menu.

The Object Properties dialog is displayed.

3 In the Motion Blur group, click By Layer to change it to By Object.

The other Motion Blur controls are now enabled.

4 In the Motion Blur group, choose either Object or Image.

5 If you chose Image, you can adjust the Multiplier spinner. This increases
or decreases the length of the blurred object's streak.

6 Click OK.

To add motion blur when you render the animation:

1 Click Render Scene.

The Render Scene dialog appears.
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2 On the Default Scanline Renderer rollout, turn on Apply in the Object
Motion Blur group or the Image Motion Blur group.

■ For Object Motion Blur, set Duration, Duration Subdivisions, and
Samples.

■ Increase Duration to exaggerate the motion blur effect. Decrease it to
make the blur more subtle.

■ If Samples is less than Duration Subdivisions, the slices used are
selected randomly, giving a grainy look to the blur. If Samples equals
Duration Subdivisions, the blur is smooth. The smoothest blur results
from larger, equal values of these two parameters, but be aware that
this can slow down rendering by a factor of three to four.

■ For Image Motion Blur, adjust Duration and Apply to Environment
Map.

■ Increase Duration to exaggerate the streaking. Decrease it to make it
more subtle.

3 Turn on Apply to Environment map to have camera orbit movement
blur the environment map. This works only with Spherical, Cylindrical,
or Shrink-Wrapped environments.

4 Set other rendering parameters, and then click Render.
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Interface
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Options group

Mapping Turn off to ignore all mapping information to speed up rendering
for tests. Affects automatic reflections and environment maps as well as
material mapping. Default=on.

Auto Reflect/Refract and Mirrors Ignores automatic reflection/refraction
maps to speed up rendering for tests.

Shadows When off, cast shadows aren't rendered. This can speed up rendering
for tests. Default=on.

Force Wireframe Set to render all surfaces in the scene as wireframes. You
can choose the thickness of the wireframe in pixels. Default=1.

Enable SSE When on, rendering uses Streaming SIMD Extensions (SSE).
(SIMD stands for Single Instruction, Multiple Data.) Depending on the CPU
(or CPUs) of your system, SSE can improve render time. Default=off.

Antialiasing group

Antialiasing Antialiasing on page 7708  smoothes the jagged edges that occur
along the edges of diagonal and curves lines when rendering. Turn off only
when you are rendering test images and greater speed is more important than
image quality.

Turning off Antialiasing disables the Force Wireframe setting. Geometry renders
according to the material assigned it even if Force Wireframe is turned on.

Turning off Antialiasing also disables render elements on page 6144 . If you
need to render elements, be sure to leave Antialiasing on.

Filter drop-down list Lets you select a high-quality table-based filter to apply
to your rendering. Filters are the last step in antialiasing. They work at the
sub-pixel level and allow you to sharpen or soften your final output, depending
on which filter you select. Below the controls in this group, 3ds Max displays
a box with a brief description of the filter and how it is applied to your image.

TIP Render Region and Render Selected give reliable results only when rendered
with the Area filter.
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The following table describes the available antialiasing filters.

DescriptionName

Computes antialiasing using a variable-size
area filter.
This is the original 3ds Max filter.

Area

A 25-pixel filter that is sharp, but without
edge enhancement.

Blackman

A blend between sharp area and Gaussian
soften filters.

Blend

A 25-pixel reconstruction filter with a slight
edge-enhancement effect.

Catmull-Rom

A general-purpose filter. Values of 1 to 2.5
are sharp; higher values blur the image.

Cook Variable

A 25-pixel blurring filter based on a cubic
spline.

Cubic

Two-parameter filter; a trade-off of blur-
ring, ringing, and anisotropy. If the ringing

Mitchell-Netravali

value is set higher than .5 it will impact the
alpha channel of the image.

Uses the 3ds Max 2 method (no map filter-
ing) to match camera and screen maps or

Plate Match/MAX R2

matte/shadow elements to an unfiltered
background image.
See the section “Plate Match Filtering,”
above, for a discussion of how and why
you might want to use this filter.

A 9-pixel blurring filter based on a
quadratic spline.

Quadratic
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DescriptionName

A sharp nine-pixel reconstruction filter from
Nelson Max.

Sharp Quadratic

An adjustable Gaussian softening filter for
mild blurring.

Soften

A 25-pixel blurring filter optimized for
NTSC and PAL video applications.

Video

Filter Maps Turns on or off the filtering of mapped materials. Default=on.

TIP Leave Filter Maps turned on unless you are making test renderings and want
to speed up rendering time and save memory.

Filter Size Allows you to increase or decrease the amount of blur applied to
an image. This option is available only when a Soften filter has been selected
from the drop-down list. The spinner is unavailable when any other filter has
been selected.

Setting the Filter Size to 1.0 effectively disables the filter.

NOTE Some filters show additional, filter-specific parameters below the Filter Size
control.

When you render separate elements on page 6144 , you can explicitly enable
or disable the active filter, on a per-element basis.

Global SuperSampling group

Disable all Samplers Disables all supersampling on page 7942 . Default=off

NOTE SuperSampling settings are ignored by the mental ray Renderer on page
6039 , which has its own sampling method.

Enable Global Supersampler When on, applies the same supersampler to all
materials. When turned off, materials set to use the global settings are
controlled by the settings appearing in rendering dialog. All other controls in
the Global SuperSampling group of the rendering dialog will become disabled,
except for the Disable All Samplers. Default=on.

5956 | Chapter 18   Rendering



Supersample Maps Turns on or off supersampling for mapped materials.
Default=on.

TIP Leave Supersample Maps on unless you are making test renderings and want
to speed up rendering time and save memory.

Sampler drop-down list Lets you choose which supersampling method to
apply. Default=Max 2.5 Star.

The options for a supersampling method are the same as those that appear
on the SuperSampling rollout on page 5285  in the Material Editor. Some
methods offer expanded options that let you better control the quality of the
supersampling and the number of samples taken during rendering.

Object Motion Blur group

You determine which objects have object motion blur on page 7867  applied
to them by setting Object in the Motion Blur group of the Properties dialog
for that object. Object motion blur blurs the object by creating multiple
"time-slice" images of the object for each frame. It takes camera movement
into account. Object motion blur is applied during the scanline rendering
process.

Apply Turns object motion blur on or off globally for the entire scene. Any
objects that have their Object Motion Blur property set are rendered with
motion blur.

Duration Determines how long the "virtual shutter" is open. When this is
set to 1.0, the virtual shutter is open for the entire duration between one frame
and the next. Longer values produce more exaggerated effects.
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The effect of changing duration.

Samples Determines how many Duration Subdivision copies are sampled.
The maximum setting is 32.

When Samples is less than Duration, random sampling within the duration
occurs (which is why there might be a slight granular look to the motion blur).
For example, if Duration Subdivision=12 and Samples=8, there are eight
random samples out of 12 possible copies within each frame.

When Samples=Duration, there is no randomness (and if both numbers are
at their maximum value (32), you get a dense result (which costs between 3–4
times the normal rendering time for that specific object).

If you want to obtain a smooth blur effect, use the maximum settings of 32/32.
If you want to cut down rendering time, values of 12/12 will give you much
smoother results than 16/12.

Because sampling happens within the duration, the Duration value always
has to be less than or equal to Samples.

Duration Subdivisions Determines how many copies of each object are
rendered within the Duration.
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Left: Same value for Samples and Subdivisions.

Right: Samples value is less than Subdivisions.

Image Motion Blur group

You determine which objects have image motion blur on page 7814  applied
to them by setting Image in the Motion Blur group of the Properties dialog
for that object. Image motion blur blurs the object by creating a smearing
effect rather than multiple images. It takes camera movement into account.
Image motion blur is applied after scanline rendering is complete.
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The coin on the right has Image Motion Blur applied

You can’t put image motion blur on objects that change their topology.

TIP When blurred objects overlap, sometimes blurring doesn't work correctly and
there are gaps in the rendering. Because image motion blur is applied after
rendering, it can't account for object overlap. To fix this problem, render each
blurred object separately, to a different layer, and then composite the two layers
using the Alpha Compositor in Video Post.
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NOTE Image motion blur doesn't work for NURBS objects that are animated so
their tessellation ( surface approximation on page 2469 ) changes over time. This
happens when sub-objects are animated independently of the top-level NURBS
model on page 7865 . Nor does image motion blur work on any of the following:

■ Anything with an Optimize.

■ Any primitive with animated segments.

■ MeshSmooth of any type with a "Smoothness" value (under iterations)
other than 1.

■ MeshSmooth on polygons with Keep Faces Convex on.

■ Anything with Displacement Material.

In general, if you have objects with changing topology, use scene or object
motion blur rather than image motion blur.

Apply Turns image motion blur on or off globally for the entire scene. Any
objects that have their Image Motion Blur property set are rendered with
motion blur.

Duration Specifies how long the "virtual shutter" is open. When this is set
to 1.0, the virtual shutter is open for the entire duration between one frame
and the next. The higher the value, the greater the motion blur effect.

Apply to Environment Map When set, image motion blur is applied to the
environment map as well as to the objects in the scene. The effect is noticeable
when the camera orbits.

The environment map should use Environment mapping: Spherical,
Cylindrical, or Shrink-Wrap. The image motion blur effect doesn't work with
Screen-mapped environments.

Transparency When on, image motion blur works correctly with transparent
objects that overlap. Applying image motion blur to transparent objects can
increase rendering time. Default=off.

Auto Reflect/Refract Maps group

Rendering Iterations Sets the number of inter-object reflections in non-flat
automatic reflection maps. Although increasing this value can sometimes
enhance image quality, it also increases rendering time for reflections.
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Color Range Limiting group

Color Range Limiting allows you handle over-brightness by toggling between
either Clamping or Scaling color components (RGB) that are out of range (0
to 1). Typically, specular highlights can cause color components to rise above
range while using filters with negative lobes can cause color components to
be below range. You choose one of two options to control how the renderer
handles out of range color components:

■ Clamp To keep all color components in range Clamp will change any
color with a value greater than 1 down to 1 while any color below 0 will
be clamped at 0. Any value between 0 and 1 will not change. Very bright
colors tend to render as white when using Clamp since hue information
can be lost in the process.

■ Scale To keep all color components in range Scale will preserve the hue
of very bright colors by scaling all three color components so that the
maximum component has a value of 1. Be aware that this will change the
look of highlights.

Memory Management group

Conserve Memory When on, rendering uses less memory at a slight cost of
memory time. Memory saved is in the range of 15 to 25 percent. The time
cost is about four percent. Default=off.

Advanced Lighting Panel

Rendering menu > Render > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout

Main toolbar > Render Scene > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout

The Advanced Lighting rollout lets you select one of the advanced lighting
options. Two are provided with the default scanline renderer on page 5949 :

■ Light Tracer on page 5963

■ Radiosity on page 5976
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The Light Tracer provides soft-edged shadows and color bleeding for brightly-lit
scenes such as outdoor scenes. Radiosity provides physically accurate modeling
of the light in a scene.

Interface

Until you choose an advanced lighting option, the Advanced Lighting panel
displays a single rollout, Select Advanced Lighting.

List of plug-ins Choose an advanced lighting option from this drop-down
list. Default=No advanced lighting chosen.

Active When an advanced lighting option is chosen, use Active to toggle
whether the advanced lighting is used when you render your scene.
Default=On.

Light Tracer

Main toolbar > Render Scene > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout > Choose Light Tracer from the drop-down list.

Rendering menu > Render > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout > Choose Light Tracer from the drop-down list.
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Character lit by Skylight and one spotlight, and rendered with light tracing

Model by Sonny Sy — orange_3D@yahoo.com — www.geocities.com/orange_3D
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The Light Tracer provides soft-edged shadows and color bleeding for brightly-lit
scenes such as outdoor scenes. It is typically used in conjunction with a
Skylight on page 4940 . Unlike radiosity on page 5976 , the Light Tracer does not
attempt to create a physically accurate model, and can be easier to set up.

Outdoor scene lit by Skylight and rendered with light tracing

TIP While you can use light tracing for indoor scenes, radiosity is usually the better
choice in such cases.

Previewing the Effect of Light Tracing

■ To get a quick preview of the effect the Light Tracer will have, lower the
values of Rays/Sample and Filter Size.
The result will be a grainy version of the full effect.

■ Another way to get a quick preview is to make sure Adaptive Undersampling
is turned on. In this group, set the Initial Sample Spacing sampling and
the Subdivide Down To setting to the same value. In the General Settings
group, lower the value of Rays/Sample, and set Bounces equal to 0.0. This
gives a rather blotchy but fast preview of the rendering. Increase the
Rays/Sample and Filter Size values to improve the image quality.
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In general, you can get good, fairly quick results with a lower Filter Size
value as long as Rays/Sample has a high value and Adaptive Undersampling
is on.

Other Tips for Using the Light Tracer

■ To improve rendering time, use the Object Properties dialog on page 245
to disable light tracing (or radiosity solving) for objects that don't have a
great impact on the final effect.

TIP You can also use the Advanced Lighting Override material on page 5572
to alter the effect of light tracing on particular objects. For example, if you
encounter visual artefacts with a bump-mapped material, convert it to an
Advanced Lighting Override material and reduce the Indirect Light Bump Scale
value.

■ Experiment with the Adaptive Undersampling group settings, which restrict
light tracing to the areas of your scene that need it.

■ To increase the amount of color bleeding, increase the values of both
Bounces and Color Bleed. Color bleeding is usually a subtle effect.

■ If there are glass objects in the scene, increase the Bounces value to an
amount greater than 0. But be aware that this increases rendering time.

■ If the main scene lighting is a Skylight on page 4940 , and you need specular
highlights in your scene, add a second light: for example, a Directional
light that parallels the Skylight. Make sure Shadows are turned on for this
light, and on the light's Advanced Effects rollout on page 5055 , turn off
Diffuse.
If the objects with highlights don't greatly affect shadows or color bleeding,
you can leave Diffuse on for this light, and use Object Properties to exclude
the objects from light tracing.

■ Set Key filters are not taken into account when you animate Light Tracer
settings. If you wish to use Set Key to create keys for animating the Light
Tracer parameters, Shift+right-click the spinner to create those keys.

IMPORTANT If you use a texture map with the Skylight, you should use an
image-processing program to thoroughly  blur the map before using it. This
helps reduce variance and the number of rays needed for light tracing. You
can blur the map beyond recognition, and it will still look correct when used
for regathering.

5966 | Chapter 18   Rendering



Procedures

To set up a scene for the Light Tracer:

This is a typical use case.

1 Create the geometry for an outdoor scene.

2 Add a Skylight on page 4940  to illuminate it.

One or more spotlights can also work well. If you use the physically based
IES Sun or IES Sky lights, using an exposure control on page 6531  is
essential.

3 Choose Rendering > Advanced Lighting. On the Select Advanced Lighting
rollout, choose Light Tracer from the drop-down list.

Active should turn on, and the Parameters rollout for the Light Tracer
should appear.

4  Adjust the Light Tracer parameters, activate the viewport to render,
and then click Render Scene.

5 Adjust your rendering settings, and then click Render.

The scene renders with soft-edged shadows and color bleeding.
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Interface

General Settings group

Global Multiplier Controls the overall lighting level. Default=1.0.

Left: Lower Global Multiplier value
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Right: Higher Global Multiplier value

Object Multiplier Controls the level of light reflected by objects in the scene.
Default=1.0.

NOTE This setting has little effect unless Bounces is greater than or equal to 2.

Sky Lights [toggle] When on, enables regathering from the Skylights in the
scene. (A scene can contain more than one Skylight.) Default=on.

Sky Lights [amount] Scales the intensity of the Skylights. Default=1.0.

Above: Increasing the Sky Lights value

Below: Increasing the Object Multiplier value

Color Bleed Controls the strength of color bleeding. Color bleeding results
when light is interreflected among scene objects. Default=1.0.

NOTE This setting has little effect unless Bounces is greater than or equal to 2.
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Above: Excessive color bleeding

Below: Color bleeding eliminated by setting Color Bleed to 0.0

Rays/Sample The number of rays cast per sample (or pixel). Increasing this
value increases the smoothness of the effect, at a cost of render time.
Decreasing this value results in a grainier effect, but renders more quickly.
Default=250.

TIP To get a “first draft” preview of the effect of light tracing, reduce the value
of Rays/Sample and the Filter Size.

Changing the number of rays per sample

The higher the value, the less grain
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Color Filter Filters all light falling on objects. Set to a color other than white
to tint the overall effect. Default=white.

Filter Size The size, in pixels, of the filter used to reduce noise in the effect.
Default=0.5.

TIP Filter Size is especially useful when Adaptive Undersampling is turned off, and
Rays/Sample has a low value.

Changing the Filter Size value

Increasing Filter Size reduces noise in the rendering.

Extra Ambient When set to a color other than black, adds that color as extra
ambient light on objects. Default=black.

Ray Bias Ray Bias, like Ray-Trace Bias for shadows on page 7906 , adjusts the
positioning of the bounced light effects. Use it to correct rendering artifacts,
such as the banding that can occur when an object casts shadows on itself.
Default=0.03.

Bounces The number of light-ray bounces that are traced. Increasing this
value increases the amount of color bleeding. Lower values give faster results
with less accuracy, and typically produce darker images. Higher values allow
more light to flow through the scene, resulting in brighter, more accurate
images at a cost of rendering time. Default=0.

When Bounces equals 0, the Light Tracer disregards volumetric lighting.
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TIP If your scene has transparent objects such as glass, increase Bounces to be
greater than zero. Be aware that this increases rendering time.

Increasing the number of bounces increases the level of global illumination and the
amount of color bleeding in the rendering.

Cone Angle Controls the angle used for regathering. Reducing this value
can result in slightly higher contrast, especially in regions where lots of small
geometry casts shadows on a larger structure. Range=33.0 to 90.0. Default=88.0.

All rays initially cast are limited by the cone angle

Volumes [toggle] When on, the Light Tracer regathers light from volumetric
lighting effects such as Volume Light on page 6520  and Volume Fog on page
6512 . Default=on.
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For volumetric lighting to work with light tracing, Bounces must be greater
than 0.

Volumes [amount] Multiplies the amount of light regathered from volumetric
lighting effects. Increase to increase their impact on the rendered scene,
decrease to decrease their effect. Default=1.0.

Increasing the Volumes value increases the effect of volumetric lighting in the rendering.

Adaptive Undersampling group

These controls can help you speed up rendering time. They reduce the number
of light samples taken. The ideal settings for undersampling vary greatly from
scene to scene.

Undersampling initially takes samples from a grid superimposed on the pixels
of the scene. Where there is enough contrast between samples, it subdivides
that region and takes further samples, down to the minimum area specified
by Subdivide Down To. Lighting for areas not directly sampled is interpolated.
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Initial sampling uses a regular grid.

Adaptive undersampling concentrates on transition areas.

TIP If you use adaptive undersampling, try adjusting the Subdivision Contrast
value to obtain the best results. The effect of this control depends on the value of
Rays/Sample.
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Adaptive Undersampling When on, the Light Tracer uses undersampling.
When off, it samples every pixel. Turning this off can increase the detail of
the final rendering, but at a cost of rendering time. Default=on.

Initial Sample Spacing The grid spacing for the initial samples of the image.
This is measured in pixels. Default=16x16.

Initial sample spacing values

Subdivision Contrast The contrast threshold that determines when a region
should be further subdivided. Increasing this value causes less subdividing to
occur. Too low a value can cause unnecessary subdividing. Default=5.0.

Decreasing the subdivision contrast threshold can reduce noise in soft shadows and
bounced lighting.

Subdivide Down To The minimum spacing for a subdivision. Increasing this
value can improve render time at a cost of accuracy. Default=1x1.

Depending on the scene geometry, grids larger than 1x1 might still be
subdivided below this specified threshold.
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Show Samples When on, sample locations render as red dots. This shows
where the most sampling has taken place, which can help you choose the
optimal settings for undersampling. Default=off.

Modeling Global Illumination with Radiosity

Radiosity is rendering technology that realistically simulates the way in which
light interacts in an environment.

This topic provides you with a conceptual overview of what radiosity is and
how this global illumination technique relates to other rendering techniques
available in 3ds Max. This information will help you decide which technique
is most suitable for the visualization task you want to perform. By more
accurately simulating the lighting in your scene, radiosity offers you significant
benefits over standard lights:

■ Improved Image Quality: The radiosity technology of 3ds Max produces
more accurate photometric on page 7892  simulations of the lighting in
your scenes. Effects such as indirect light, soft shadows, and color bleeding
between surfaces produce images of natural realism that are not attainable
with standard scanline rendering. These images give you a better, more
predictable representation of what your designs will look like under specific
lighting conditions.

■ More Intuitive Lighting: In conjunction with radiosity techniques, 3ds
Max also provides a real-world lighting interface. Instead of specifying
lighting intensity with arbitrary values, light intensity is specified using
photometric units (lumens, candelas, and so on). In addition, the
characteristics of real-world lighting fixtures can be defined using
industry-standard Luminous Intensity Distribution files (such as IES on
page 5017 , CIBSE on page 7739 , and LTLI on page 7833 ), which are obtainable
from most lighting manufacturers. By being able to work with a real-world
lighting interface, you can intuitively set up the lighting in your scenes.
You can focus more on your design exploration than on the computer
graphic techniques required to visualize them accurately.
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Top: A scene rendered without radiosity.

Bottom: The same scene rendered with radiosity.
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Computer Graphics Rendering

The 3D models created in  3ds Max contain geometric data defined in
relationship to a 3D Cartesian coordinate system, referred to as world space
on page 7976 . The model also contains other information about the material
of each of the objects and the lighting in the scene. The image on a computer
monitor is made up of many illuminated dots, called pixels on page 7896 . The
task in creating a computer graphics image of a geometric model is to
determine the color for each pixel based on the model information and a
specific viewpoint (camera).

The color of any specific point on a surface in a model is a function of the
physical material properties of that surface and the light that illuminates it.
Two general shading algorithms: local illumination and global illumination are
used to describe how surfaces reflect and transmit light.

Local Illumination

Local illumination algorithms describe only how individual surfaces reflect
or transmit light. Given a description of light arriving at a surface, these
mathematical algorithms, called shaders in 3ds Max, predict the intensity,
color, and distribution of the light leaving that surface. In conjunction with
a material description, different shaders will determine, for example, if a surface
will appear like plastic or metal or if it will appear smooth or rough. 3ds Max
provides a robust interface for defining a wide array of different surface
materials.

After defining how an individual surface interacts with light at the local level,
the next task is to determine where the light arriving at the surface originates.
With the standard scanline rendering system on page 7918  of 3ds Max, only
the light coming directly from the light sources themselves is considered in
the shading.

For more accurate images, however, it is important to take into account not
only the light sources, but also how all the surfaces and objects in the
environment interact with the light. For example, some surfaces block light,
casting shadows on other surfaces; some surfaces are shiny, in which case we
see in them the reflections of other surfaces; some surfaces are transparent,
in which case we see other surfaces through them; and some surfaces reflect
light onto other surfaces.

Global Illumination

Rendering algorithms that take into account the ways in which light is
transferred between surfaces in the model are called global illumination
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algorithms. 3ds Max offers two global illumination algorithms as an integral
part of its production rendering system: ray-tracing and radiosity.

Before an explanation of how ray-tracing and radiosity work, it’s useful to
understand how light is distributed in the physical world. Consider, for
example, the room shown in the illustration below.

Kitchen lit by two lights

This kitchen above has two light sources. One theory of light considers the
light in terms of discrete particles called photons, that travel from the light
source until they encounter some surface in the kitchen. Depending on the
surface material, some of these photons are absorbed and others are scattered
back out into the environment. The fact that photons traveling at a particular
wavelength are absorbed while others are not is what determines the color of
the surface.

Surfaces that are very smooth reflect the photons in one direction, at an angle
equal to the angle at which they arrive at the surface, the angle of incidence.
These surfaces are known as specular surfaces, and this type of reflection is
known as specular reflection. A mirror is an example of a perfectly specular
surface. Of course, many materials display some degree of both specular and
diffuse reflection.
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Left: Specular reflection

Right: Diffuse reflection

The way in which the photons are reflected from a surface depends primarily
on the smoothness of the surface. Rough surfaces tend to reflect photons in
all directions. These are known as diffuse surfaces, and this type of reflection
is known as diffuse reflection (shown above). A wall painted with flat paint
is a good example of a diffuse surface.

The final illumination of the kitchen is determined by the interaction between
the surfaces and the billions of photons emitted from the light source. At any
given point on a surface, it is possible that photons have arrived directly from
the light source (direct illumination) or else indirectly through one or more
bounces off other surfaces (indirect illumination). If you were standing in the
kitchen, a very small number of the photons in the room would enter your
eye and stimulate the rods and cones of your retina. This stimulation would,
in effect, form an image that is perceived by your brain.

In computer graphics we replace the rods and cones of a retina with the pixels
of the computer screen. One goal of a global illumination algorithm is to
re-create, as accurately as possible, what you would see if you were standing
in a real environment. A second goal is to accomplish this task as quickly as
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possible, ideally in real time (30 images per second). Currently, no single global
illumination algorithm can accomplish both goals.

Ray-Tracing

One of the first global illumination algorithms developed is known as
ray-tracing. The ray-tracing algorithm recognizes that although billions of
photons may be traveling about the room, the photons we primarily care
about are the ones that enter the eye. The algorithm works by tracing rays
backward, from each pixel on the screen into the 3D model. In this way, we
compute only the information needed to construct the image. To create an
image using ray-tracing, the following procedure is performed for each pixel
on the computer screen.

1 A ray is traced back from the eye position, through the pixel on the
monitor, until it intersects with a surface. We know the reflectivity of
the surface from the material description, but we do not yet know the
amount of light reaching that surface.

2 To determine the total illumination, we trace a ray from the point of
intersection to each light source in the environment (shadow ray). If the
ray to a light source is not blocked by another object, the light
contribution from that source is used to calculate the color of the surface.

3 If an intersected surface is shiny or transparent, we also have to determine
what is seen in or through the surface being processed. Steps 1 and 2 are
repeated in the reflected (and, in the case of transparency, transmitted)
direction until another surface is encountered. The color at the subsequent
intersection point is calculated and factored into the original point.

4 If the second surface is also reflective or transparent, the ray-tracing
process repeats, and so on until a maximum number of iterations is
reached or until no more surfaces are intersected.
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Ray-tracing: Rays are traced from the camera through a pixel, to the geometry,
then back to their light sources.

The ray-tracing algorithm is very versatile because of the large range of lighting
effects it can model. It can accurately account for the global illumination
characteristics of direct illumination, shadows, specular reflections (for
example, mirrors), and refraction through transparent materials. The main
disadvantage of ray-tracing is that it can be very slow for environments of
even moderate complexity. In 3ds Max, ray-tracing is used selectively on
objects with ray-trace materials on page 5394  that specify ray-tracing as their
shading option. Ray-tracing can also be specified for light sources as the
method for rendering the shadows they cast.

A significant disadvantage of both ray-tracing and scanline rendering is that
these techniques do not account for one very important characteristic of global
illumination, diffuse inter-reflections. With traditional ray-tracing and scanline
rendering, only the light arriving directly from the light sources themselves
is accurately accounted for. But, as shown in the room example, not only does
light arrive at a surface from the light sources (direct lighting), it also arrives
from other surfaces (indirect lighting). If we were to ray-trace an image of the
kitchen, for example, the areas in shadow would appear black because they
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receive no direct light from the light sources. We know from experience,
however, that these areas would not be completely dark because of the light
they would receive from the surrounding walls and floor.

In scanline rendering and traditional ray-tracing (versions of 3ds Max prior
to v5), this indirect illumination is usually accounted for simply by adding
an arbitrary ambient light value that has no correlation to the physical
phenomena of indirect illumination and is constant throughout space. For
this reason, scanline and ray-traced images can often appear very flat,
particularly renderings of architectural environments, which typically contain
mostly diffuse surfaces.

Radiosity

To address this issue, researchers began investigating alternative techniques
for calculating global illumination, drawing on thermal engineering research.
In the early 1960s, engineers developed methods for simulating the radiative
heat transfer between surfaces to determine how their designs would perform
in applications such as furnaces and engines. In the mid-1980s, computer
graphics researchers began investigating the application of these techniques
for simulating light propagation.

Radiosity, as this technique is called in the computer graphics world, differs
fundamentally from ray-tracing. Rather than determining the color for each
pixel on a screen, radiosity calculates the intensity for all surfaces in the
environment. This is accomplished by first dividing the original surfaces into
a mesh of smaller surfaces known as elements. The radiosity algorithm calculates
the amount of light distributed from each mesh element to every other mesh
element. The final radiosity values are stored for each element of the mesh.
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Radiosity: A ray of light that hits a surface is reflected by multiple diffuse rays, which
can themselves illuminate other surfaces. Surfaces are subdivided to increase accuracy
of the solution.

In early versions of the radiosity algorithm, the distribution of light among
mesh elements had to be completely calculated before any useful results could
be displayed on the screen. Even though the result was view-independent,
the preprocessing took a considerable amount of time. In 1988, progressive
refinement was invented. This technique displays immediate visual results
that can progressively improve in accuracy and visual quality. In 1999, the
technique called stochastic relaxation radiosity (SRR) was invented. The SRR
algorithm forms the basis of the commercial radiosity systems provided by
Autodesk.
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An Integrated Solution

Although the ray-tracing and radiosity algorithms are very different, they are
in many ways complementary. Each technique has advantages and
disadvantages.

DisadvantagesAdvantagesLighting
Algorithm

Computationally
expensive. The

Accurately ren-
ders direct illumi-

Ray-Trac-
ing

time required tonation, shadows,
produce an imagespecular reflec-
is greatly affectedtions, and trans-

parency effects.
Memory Efficient

by the number of
light sources.
Process must be
repeated for each
view (view depen-
dent).
Doesn’t account
for diffuse inter-
reflections.

3D mesh requires
more memory

Calculates diffuse
interreflections
between surfaces.
Provides view in-
dependent solu-

Radiosity

than the original
surfaces.
Surface sampling
algorithm is moretions for fast dis-
susceptible toplay of arbitrary

views. imaging artifacts
than ray-tracing.Offers immediate

visual results. Doesn’t account
for specular reflec-
tions or trans-
parency effects.

Neither radiosity nor ray-tracing offers a complete solution for simulating all
global illumination effects. Radiosity excels at rendering diffuse-to-diffuse
inter-reflections, and ray-tracing excels at rendering specular reflections. By
integrating both techniques with a production quality scanline rendering
system, 3ds Max offers the best of both worlds. After you create a radiosity
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solution, you can render a two-dimensional view of it. In your 3ds Max scene,
ray-tracing adds effects in addition to those that radiosity provides: lights can
provide ray-traced shadows, and materials can provide ray-traced reflections
and refractions. The rendered scene combines both techniques, and appears
more realistic than either technique alone could provide.

By integrating ray-tracing and radiosity, 3ds Max offers a full range of
visualization possibilities, from fast, interactive lighting studies to images of
exceptional quality and realism.

See also:

■ How Radiosity Works in 3ds Max on page 5986

■ Radiosity  on page 5989

■ Animation with Radiosity on page 5994

■ Radiosity Controls on page 5995

■ Lighting Analysis on page 6028

■ Radiosity Preferences on page 7578

■ Advanced Lighting Override Material on page 5572

How Radiosity Works in 3ds Max

This is an overview of how radiosity works in 3ds Max:

1 Object by object, 3ds Max loads a copy of the scene into the radiosity
engine.

2 3ds Max subdivides each object according to the Global Subdivision
Settings in the Radiosity Meshing Parameters rollout, or according to the
object's individual object properties , if those differ from the global
settings.

3 3ds Max emits a certain amount of rays, based on the average scene
reflectance and number of polygons. The brightest light source will have
more rays to emit than the weakest light source.

4 These rays bounce around randomly in the scene and deposit energy on
the faces.
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5 3ds Max updates the viewports by taking all the energy from the faces
and spreading it to the closest vertex.

See the section that follows, “Refinement Steps for Radiosity,” for a more
detailed description of the solution process.

Refinement Steps for Radiosity

The radiosity process involves three stages of increasing refinement. The first
two stages occur during the primary radiosity processing, and the third stage
can be used during the final rendering.

Within each of the first two stages, you can stop and start the processing at
any time. This can be useful for evaluating interim results or increasing the
level of accuracy you desire. For example, you can interrupt the Initial Quality
stage at 50% and jump ahead to the Refine stage if you wish. However, once
you enter the Refine stage, you cannot continue further iterations of Initial
Quality unless you restart the solution.
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The stages of a radiosity solution are Initial Quality, Refine, and then Regathering.

1 Initial Quality

In the Initial Quality stage, the distribution of diffuse lighting in the
scene is calculated by essentially mimicking the behavior of real photons.
Rather than tracing the path of an essentially infinite number of photons,
statistical methods are used to choose a much smaller set of “photon
rays” whose distribution in space is representative of the actual
distribution. As with any statistical sampling process, the greater the
number of rays used in the approximation, the greater the accuracy of
the solution. During the initial quality stage, the overall appearance of
the lighting level of the scene is established. The results can be
interactively displayed in shaded viewports.
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The initial quality stage performs repeated passes, which are shown in
the dialog’s progress bar.

2 Refine Iterations (All Objects) and Refine Iterations (Selected Objects)

Because of the random nature of the sampling during the initial quality
stage, some of the smaller surfaces or mesh elements in the scene might
miss being hit by enough rays (or any rays at all). These small surfaces
remain dark, and result in the appearance of “variance” or dark spots. To
alleviate these artifacts, the Refine stage “regathers light” at every surface
element.

You can perform the Refine stage for the entire scene, or for selected
objects in the scene.

3 Regathering

Even after the Refine stage, it is still possible for visual artifacts to appear
in a scene because of the topology of the original model. These artifacts
sometimes appear as shadow or light “leaks.” To eliminate even these
model-based artifacts, a third, optional refinement stage known as Pixel
Regathering occurs at the time of image rendering. This involves a final
“regather” process for each pixel of the image. Regathering can add a
considerable amount of time to the rendering of a final image, but it also
produces the most detailed and artifact-free images possible.

One benefit of using Regathering is that it means the initial modeling
and mesh resolution don’t need to be nearly as “refined” or “tight” as
would otherwise be required.

Radiosity Workflows

The following sections describe how to set up a scene for use with radiosity.

Set Units Correctly Before Processing Radiosity

For imported geometry, you must make sure that units are consistent in your
scene before processing radiosity (for example, a wall is 8 feet high, not 8
kilometers high). Units in 3ds Max must match the units of the model because
the radiosity engine always uses an inverse square falloff for lights. Therefore,
distance is crucial.

To make sure your units are setup correctly, use the Units Setup dialog on
page 7601 . The Scene Unit is the most important unit in this dialog. This is the
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unit that 3ds Max uses for its calculations. The Display Unit is just a tool that
lets you customize how units are displayed in the user interface.

The following two scenarios show how to set unit scales after importing
geometry that has been created using different units than what is currently
set in 3ds Max:

Example 1: You import a table that was created in AutoCAD using metric
scale. The table is 9 units long, which corresponds to an actual length of 90
centimeters. When the table is imported into 3ds Max, it will measure 9 scene
units. Therefore, in the Units Setup dialog, you must set Scene Unit Scale to
1 Unit=10 centimeters. Your table is now the correct units because it is 90
centimeters long in 3ds Max model.

Example 2: You have an AutoCAD model that was created using Architectural
Units. The model is a room measuring 20’-4” long. In AutoCAD, Architectural
Units are stored as inches. Therefore, before importing the model to 3ds Max,
make sure to set the Scene Unit Scale to 1 Unit=1 inch. Once imported to 3ds
Max, the room will measure 244 units long (20’*12+4”).

TIP Use the Measure Distance tool on page 2529  to quickly check dimensions in
3ds Max.

Physically Based Workflow

Use radiosity on page 5976  to create physically based lighting simulations.
When doing so, keep in mind the following:

■ Scene dimensions: Make sure your scenes are accurately dimensioned, with
consistent units (a light bulb in a room 120 meters high would look a lot
different than it would in a room 120 inches high).

■ Lights: You should work exclusively with Photometric lights on page 4951
. You should also make sure that the light intensities are within a normal
range.

■ Natural Lighting: To simulate natural light, you should only use IES sun
on page 4969  and IES Sky on page 4973 . These provide accurate photometric
representations of sunlight and skylight based on a specified location, date
and time.

■ Material Reflectance: You should ensure that the materials you use in your
scene have a reflectance value on page 5228  within the range of the physical
materials they represent. For example, a painted white wall should have
a maximum reflectance of approximately 80%; however, a pure white color
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material (RGB:255, 255, 255) would have a reflectance of 100%. This means
that the material reflects 100% of the energy received.

■ Exposure Control: The exposure control is the equivalent of the aperture
of a camera. Make sure you enable the exposure control and set a value
that provides the final results you desire.

To process radiosity for photometric lights using a physically based workflow:

1 Ensure that your geometry is set to a physically correct scale and that the
materials have valid reflectance values.

2 Place photometric lights in your scene. The benefit of this workflow is
that it allows you to place lights in your scene the same way you would
in the real world. You can create new photometric lights or, using the
asset browser on page 6928 , drag and drop preset luminaire objects on
page 235  from the included library.

You can also refer to Common Lamp Values on page 5020 .

3 Choose Rendering > Environment to display the Environment panel on
page 6486 . Select the type of exposure control you want to use (typically
Logarithmic on page 6540 ).

4  Click Render Scene to preview the lighting. At this stage, the
radiosity will not be processed but you can quickly confirm that the direct
lighting is correct. Adjust the position of the lights if desired.

5 Choose Rendering > Advanced Lighting > Radiosity. Make sure that Active
is turned on.

6 On the Radiosity Parameters rollout, click Start to process radiosity. Once
the Radiosity calculation has been completed, you should see your results
in the viewports. The light levels are stored with the geometry and you
can interactively navigate around the model without reprocessing the
scene.

7  Click Render Scene again. The renderer will calculate the direct
lighting and shadows, and the radiosity solution (indirect lighting) will
be integrated as a modulated ambient light.
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Lighting Analysis

After you generate a radiosity solution, you can use the Lighting Analysis tool
on page 6028  to analyze the lighting levels in your scene. This dialog provides
data on material reflectance, transmittance, and luminance.

You can also interactively visualize the light levels in the scene by using the
Pseudo Color Exposure Control on page 6552 . Rendering to a rendered frame
window displays an additional rendered frame with a legend below the image.
The legend correlates lighting levels and color values.

If you need to generate a lighting report, you can use the Lighting Data
Exporter utility on page 6559  to export the luminance and illuminance data to
a 32-bit LogLUV TIFF file on page 7164  or a pair of PIC files on page 7151  (one
each for luminance and illuminance).

NOTE To obtain the most accurate quantitative analysis of lighting levels, you
should avoid using colored materials and diffuse maps.

Non-Physically Based Workflow

You don’t necessarily have to work with physically based lights and materials
in order to incorporate radiosity effects into your renderings. But there are a
number of issues that you need to consider:

■ Lights: Because the radiosity engine is physically based, Standard lights
on page 4925  are interpreted by the engine as Photometric lights on page
4951 . For example, a Standard Spot light with a multiplier value of 1.0 will
be translated as a Physically Based Spot light with an intensity value of
1500 candelas (default value). This translation value corresponds to the
Physical Scale value in the various exposure controls.
In addition, if your Standard lights use custom attenuation settings (for
example, no attenuation, manual attenuation, or linear decay), the radiosity
engine will always solve for these lights using the physically correct Inverse
Square attenuation. This means that the amount of energy that bounces
between surfaces might not be equivalent to the way the Standard lights
render.

■ Natural Lighting: To simulate natural lighting without using the physically
based workflow described above, you can only use a Direct Light on page
4932  for the Sun and Skylight on page 4940  to produce skylight on page 7931
.

■ Exposure Control: Since Standard lights are not physically based, you
should only use exposure controls for the radiosity solution. Use the
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Logarithmic Exposure Control on page 6540 , making sure to turn on Affect
Indirect Only. The Brightness and Contrast controls of the exposure control
will only affect the radiosity solution and your lights will render as usual.

To process radiosity with standard lighting:

1 Ensure that your geometry is set to a physically correct scale.

2  On the Create panel, click Lights. Create and position
standard lights on page 4925  in your scene.

3  Click Render Scene to preview the lighting. At this stage, the
radiosity will not be processed, but you can quickly confirm that the
direct lighting is correct. Adjust the position of the lights if desired.

4 Choose Rendering > Advanced Lighting > Radiosity. Make sure that Active
is turned on.

5 On the Radiosity Parameters rollout, click Start to process radiosity. Once
the Radiosity calculation has been completed, you should see your results
in the viewports.

6 In the Interactive Tools group of the Radiosity Processing rollout, click
Setup to display the Environment panel on page 6486 , where you set
exposure controls.

7 When working with non-physically based lights, always use the
Logarithmic Exposure Control on page 6540 . On the Logarithmic Exposure
Control rollout, select Affect Indirect Only. This will cause the exposure
control to affect only the results of the radiosity solution. By doing so,
you will maintain the way your direct lights render without radiosity.
Use the Brightness and Contrast controls of the exposure control to adjust
the intensity of the radiosity solution to match the lighting at an
appropriate level.

TIP You can use the thumbnail preview to adjust brightness and contrast
interactively.

8  Click Render Scene to render the scene after radiosity processing.
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Summary

The following table will help you obtain good results with radiosity.

Non Physically
Based Workflow

Physically Based
Workflow

Standard Lights on
page 4925

Photometric Lights
on page 4951

Lights

Directional Light
on page 4932  and

IES Sun on page
4969  and IES Sky
on page 4973

Daylight

Skylight on page
4940

Logarithmic on
page 6540 − turn on

AnyExposure
Control

Affect Indirect On-
ly.

Make sure your
scene is set to the
appropriate scale.

Make sure your
scene is set to the
appropriate scale.

Units

Animation with Radiosity

By default, a radiosity solution on page 5976  is calculated at the current frame.
If you are animating objects and you want to perform a radiosity solution at
every frame, select Compute Advanced Lighting When Required in the Render
Scene dialog > Render panel > Common Parameters rollout on page 5929  >
Advanced Lighting group.

Once the renderer starts processing each frame of your animation, the radiosity
solution will be computed for each frame as required. This occurs, for example,
when an object moves, or a light intensity changes. If nothing changes in the
scene from one frame to the next, the radiosity engine will not recalculate
the solution.

NOTE Due to the random statistical sampling used by the radiosity engine, there
might be some flickering between frames. If this occurs, increase the value of Initial
Quality or the number of Refine Iterations to solve the problem.
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TIP Before launching a lengthy animation with radiosity, you should process a
radiosity solution manually for a single frame to make sure the results are
acceptable.

TIP If you animate only your camera (as in an architectural walkthrough) then
you can calculate a radiosity solution for only the first frame of the animation, and
reuse it in all subsequently rendered frames by turning off Compute Advanced
Lighting When Required on the Common Parameters rollout of the Render Scene
dialog.

Avoid using the Automatic Exposure Control on page 6534  for animations.
This exposure control can change from frame to frame, creating a flickering
effect.

Object Animation

The radiosity solution is calculated for each frame if any object is animated
in the scene (the default is to calculate the current frame only). You specify
the parameters (goals/quality) you want to reach on the Advanced Lighting
panel. It is recommended to run a solution first and verify if it’s successful
before proceeding to the whole animation. These parameters will then be
reprocessed for each frame.

You go to the render dialog, Common Parameters rollout , and enable the
option Compute Advanced Lighting When Required, and then render the
scene. The radiosity is processed for the first frame and then rendered. 3ds
Max then moves to the next frame, processes radiosity, renders, and so on.

Camera Animation

If objects remain static in the scene and only the camera moves, you can solve
radiosity at frame 0, and when you render the animation, turn off Compute
Advanced Lighting When Required.

Radiosity Controls

Render Scene dialog > Choose Default Scanline Renderer as the production
renderer. > Advanced Lighting panel > Choose Radiosity.

Rendering menu > Advanced Lighting > Radiosity > Render Scene dialog >
Advanced Lighting panel > Radiosity is chosen.
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Radiosity is a technique to calculate indirect light. Specifically, radiosity
calculates the interreflections of diffuse light among all the surfaces in your
scene. To make this calculation, radiosity takes into account the lighting
you’ve set up, the materials you’ve applied, and environment settings you’ve
made.

The radiosity processing of a scene is distinct from the rendering process. You
can render without radiosity. However, to render with radiosity, you must
always calculate radiosity first.

Once a radiosity solution for a scene has been calculated, it can be used in
multiple renderings, including multiple frames of an animation. If there are
moving objects in the scene, radiosity might need to be recalculated; see
Animation with Radiosity on page 5994 .

For an overview of radiosity and how radiosity works in 3ds Max, see Radiosity
Solution on page 5976 .

For suggestions regarding workflow for using radiosity, see Radiosity
Workflows on page 5989  .

NOTE Radiosity is also known as global illumination .

IMPORTANT If the dimensions of your scene are not realistic, then radiosity will
not show realistic lighting, either.

See also:

■ Modeling Global Illumination with Radiosity on page 5976

■ How Radiosity Works in 3ds Max on page 5986

■ Radiosity  on page 5989

■ Animation with Radiosity on page 5994

■ Lighting Analysis on page 6028

■ Radiosity Preferences on page 7578

■ Advanced Lighting Override Material on page 5572
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Procedures

To set units correctly:

Follow these steps if your scene does not already use real-world units.

1  Right-click 3D Snap Toggle and on the Snaps panel, clear all the
settings. Then turn on Vertex to set vertex snap. Close the dialog.

2 Choose Tools > Measure Distance to measure some object in the scene
for which you know the size; for example, a door or window. The distance
displays in the Coordinate Display of the status bar.

3 Choose Customize > Units Setup and adjust the Scene Unit Scale.

For example, if your object measures 35 scene units long, and your model
uses US Standard measurement, then you would enter 1 for the scale,
and choose Inches from the drop-down list. This would give you an object
35 inches long.

If your object measures 90 scene units long, and your model uses Metric
measurement, then you would enter 1 for the scale, and select Centimeters
from the drop-down list. This would give you an object 90 centimeters
long.

Example: To process radiosity with photometric lighting:

1 Use a scene that has geometry set to the correct scale. For more
information, see To set units correctly on page ? .

For example, if the ceiling is 96 scene units high in the model, make sure
the units are set to US Standard (inches) and not Metric.

2  On the Create panel, click Lights.

3 Choose Create > Photometric Lights > Target Point Light.

4 Choose Photometric from the drop-down list. (The default is Standard.)

5 In the Object Type rollout, click Target Point.

6 Drag in a viewport. The initial point of the drag is the location of the
light, and the point where you release the mouse is the location of the
target.

The light is now part of the scene.
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7 Set the creation parameters.

TIP  You can use the Move transform to adjust the location of the
light or its target.

8 On the Modify panel, adjust the light's settings.

9  Click Render Scene to preview the lighting.

Make any changes you need to adjust the rendering.

10 Choose Rendering > Environment to display the Environment panel on
page 6486 .

11 Click the Environment tab to display the Environment panel on page
6486 .

12 On the Exposure Control rollout of the Environment panel, choose
Logarithmic Exposure Control from the drop-down list. Click Render
Preview. The thumbnail preview shows the effect of exposure control.

13 On the Logarithmic Exposure Control rollout on page 6540 , adjust the
settings until the scene lighting is acceptable. The thumbnail preview
updates as you adjust settings.

For example, a brightness of 65 and a contrast of 50 can be good values
for interior scenes.

14 Choose Rendering > Advanced Lighting to display the Advanced Lighting
panel. On the Select Advanced Lighting rollout, choose Radiosity as the
advanced lighting type.

The rollouts for radiosity are displayed.

15 Choose Rendering > Radiosity to display the Radiosity panel.

16 On the Radiosity Processing Parameters rollout on page 6001 , click Start
to begin processing radiosity.

17  Click Render Scene to render the scene after radiosity processing
completes.
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Example: To process radiosity with standard lighting:

Photometric lights are recommended for use with radiosity. But if you are
working on a scene that already contains standard lights, you can follow these
guidelines.

1 Create or load a scene containing the appropriate geometry for lighting.
There is no need to adjust any scale factors.

2  On the Create panel, click Lights.

Standard is the default choice of light type.

3 In the Object Type rollout, click a light type such as Target Spot.

4 Drag in a viewport. The initial point of the drag is the location of the
spotlight, and the point where you release the mouse is the location of
the target.

The light is now part of the scene.

5 Set the creation parameters for the light.

6  Click Render Scene to preview the lighting.

Make any changes you need to adjust the rendering.

7 Choose Rendering > Advanced Lighting to display the Advanced Lighting
panel. On the Select Advanced Lighting rollout, choose Radiosity as the
advanced lighting type.

The rollouts for radiosity are displayed.

8 Choose Rendering > Advanced Lighting > Radiosity to display the
Advanced Lighting panel with Radiosity chosen as the advanced lighting
type.

The rollouts for radiosity are displayed.

9 On the Radiosity Processing rollout, under Interactive Tools, click Setup
to display the Environment panel on page 6486  where you set exposure
controls.

NOTE The exposure controls allow you to control only the intensity of the
indirect lighting. 3ds Max retains the original intensity and effect for the
direct lighting.
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10 On the Exposure Control rollout of the Environment panel on page 6486
, choose Logarithmic Exposure Control from the drop-down list.

11 On the Logarithmic Exposure Control rollout on page 6540 , turn on Affect
Indirect Only.

12 On the same rollout, use the Physical Scale setting to assign the standard
light a photometric value in candelas.

13  Click Render Scene to render the scene after radiosity processing.

Interface

Radiosity controls appear as rollouts on the Advanced Lighting panel of the
Render Scene dialog. To choose radiosity, use the Select Advanced Lighting
rollout on page 5962 .
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Radiosity Processing Parameters Rollout  on page 6001

Radiosity Meshing Parameters Rollout on page 6008

Light Painting Rollout (Radiosity) on page 6014

Rendering Parameters Rollout (Radiosity) on page 6016

Statistics Rollout (Radiosity) on page 6026

Radiosity Rollouts

Radiosity Processing Parameters Rollout

Main toolbar > Render Scene > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout > Choose Radiosity from the drop-down list. >
Radiosity Processing Parameters rollout

Rendering menu > Render > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout > Choose Radiosity from the drop-down list. >
Radiosity Processing Parameters rollout

Contains the main controls for processing a radiosity solution.
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Interface

Reset All When you click Start, a copy of the 3ds Max scene is loaded into
the radiosity engine. Clicking Reset All clears all the geometry from the engine.

Reset Clears the light levels from the radiosity engine, but doesn’t clear the
geometry.

Start Starts the radiosity processing. Once the radiosity solution has reached
the percentage amount specified by Initial Quality, this button changes to
Continue.

If you click Stop before reaching the full Initial Quality percentage, then clicking
Continue causes radiosity processing to resume, until the full percentage is
reached, or you click Stop once more. You can click Stop and then Continue
more than once.
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In addition, you can calculate radiosity up to an Initial Quality less than 100
percent, then later increase the value of Initial Quality, click Continue, and
resume solving radiosity.

In either case, Continue saves time by avoiding regenerating the radiosity
solution from scratch.

Once the full Initial Quality percentage has been reached, clicking Continue
has no effect.

Stop Stops the radiosity processing. The Start menu changes to Continue.
You can later click Continue to resume radiosity processing, as described for
the Start menu.

Keyboard shortcut: Esc

Process group

The options in this group set the behavior of the first two stages of the radiosity
solution, Initial Quality and Refine.

Initial Quality Sets the quality percentage at which to stop the Initial Quality
stage, up to 100%. For example, if you specify 80%, you will get a radiosity
solution that is 80% accurate in energy distribution. A goal of 80 to 85% is
usually sufficient for good results.

During the Initial Quality stage, the radiosity engine bounces rays around the
scene and distributes energy on surfaces. Between each iteration, the engine
measures the amount of variance (noise between surfaces) that was computed.

Most of the brightness of the scene is distributed in the early iterations. The
contribution to the scene’s average brightness decreases logarithmically
between iterations. After the first few iterations, the brightness of the scene
does not increase much, but subsequent iterations reduce the variance in the
scene.
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NOTE The “quality” refers to the accuracy of energy distribution, not to the visual
quality of the solution. Even at a high Initial Quality percentage, the scene can still
show considerable variance. This variance is resolved by the subsequent stages of
the solution.

Increasing the percentage value of Initial Quality.

Increasing quality does not greatly increase the average brightness of the scene, but
it decreases the variance between different surfaces in the scene, such as the faces of
the sphere.

Refine Iterations (All Objects) Sets the number of Refine iterations to perform
for the scene as a whole. The Refine Iterations stage increases the quality of
the radiosity processing on all objects in the scene. Gathers energy from each
face in order to reduce the variance between faces using a different process
from the Initial Quality stage. This stage does not increase the brightness of
the scene, but it improves the visual quality of the solution and significantly
reduces variance between surfaces. If you don’t reach an acceptable result after
processing a certain number of Refine iterations, you can increase the number
and continue processing.

TIP If you plan to use Regathering at render time, you generally don’t need to
perform the Refine stage to get good-quality final renderings.
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NOTE After 3ds Max processes Refine Iterations, Initial Quality is disabled and you
can’t change it until you click Reset or Reset All.

Large image with no iterations has areas of uneven illumination.

Inset images: After a number of iterations, the uneven areas have been corrected.

Refine Iterations (Selected Objects) Sets the number of Refine iterations to
perform for selected objects, using the same method as Refine Iterations (All
Objects). Make an object selection and then set the number of iterations you
require. Refining selected objects rather than the entire scene can save a lot
of processing time. Typically, this option is useful for objects that have a lot
of small surfaces and show a lot of variance, such as railings or chairs or highly
subdivided walls.
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NOTE After 3ds Max processes Refine Iterations, Initial Quality is disabled and you
can’t change it until you click Reset or Reset All.

Process Refine Iterations Stored in Objects Each object has a radiosity
property called Refine Iterations. Each time you refine an object selection, the
number of steps stored with these objects is incremented.

When you reset the radiosity solution and then start it again, the steps for
each objects are refined automatically, provided this toggle is turned on. This
is useful when you are creating animations, when the radiosity needs to be
processed at every frame, and the same level of quality between frames has
to be maintained.

Update Data When Required on Start When on, the radiosity engine must
be reset and then recalculated if the solution is invalidated. In this case, the
Start menu changes to read Update & Start. When this is pressed, the radiosity
solution is reset and the calculation starts over again.

When this toggle is off, the radiosity solution does not need to be reset if it is
invalidated. You can continue processing your scene with the invalid solution.

NOTE The radiosity solution is invalidated any time an object or light is added,
removed, moved, or altered in any way.

Interactive Tools group

The options in this group help you adjust the display of the radiosity solution
in the viewport and in the rendered output. These controls take effect
immediately on an existing radiosity solution and do not require any additional
processing for you to see their effects.

Indirect Light Filtering Reduces the amount of noise between surface elements
by averaging the indirect lighting levels with the surrounding elements. A
value of 3 or 4 is usually sufficient. If you use too high a value, you risk losing
detail in the scene. Because Indirect Light Filtering is interactive, you can
readily evaluate the result and adjust it as you need.

Direct Light Filtering Reduces the amount of noise between surface elements
by averaging the direct lighting levels with the surrounding elements. A value
of 3 or 4 is usually sufficient. If you use too high a value, you risk losing detail
in the scene. Direct Light Filtering is interactive, so you can readily evaluate
the result and adjust it as you need.
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NOTE Direct Light Filtering works only when you use Shoot Direct Lights on page
6013 . If you're not using Shoot Direct Lights, everything is considered indirect
lighting.

For a 65% quality solution, increasing the Indirect Light Filtering value from 0 to 3
creates a smoother diffuse light. The results are comparable to a much higher-quality
solution.

No Exposure Control Selected  Displays the name of the current exposure
control.

(When you change the exposure control by choosing Rendering menu >
Environment, the name display in the Radiosity dialog updates automatically.)

■ Setup Click to display the Environment panel on page 6486 , where you
access the Exposure Control rollout; there, you can choose the exposure
control and set its parameters.

Display Radiosity in Viewport Toggles the display in the viewports between
radiosity and standard 3ds Max shading. You might want to do turn off
radiosity shading to increase display performance.

Default Scanline Renderer Rollout | 6007



Radiosity Meshing Parameters Rollout

Render Scene dialog > Choose Default Scanline Renderer as the active
production renderer. > Advanced Lighting panel > Select Advanced Lighting
rollout > Choose Radiosity from the drop-down list. > Radiosity Meshing
Parameters rollout

Controls the creation of a radiosity mesh and its size in world units.

In order to create the lighting of a scene, the software calculates the intensity
for discrete points in the environment by subdividing the original surfaces
into elements which are part of a radiosity mesh. This rollout allows you to
determine whether you want a mesh or not, and to specify the size of the
mesh elements in world units. For quick tests, you might want to turn off the
mesh globally. The scene will look flat, but the solution will still give you a
quick impression of the overall brightness.

The finer the mesh resolution is, the more accurate the lighting detail will be.
But there is a trade-off in time and memory.

Meshing (shown in light red) subdivides flat surfaces in the scene.
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Left: No mesh. The solution looks very flat.

Middle: Coarse mesh, every 24 inches. The lighting improves.

Right: Fine mesh, every 4 inches. The lighting reveals more subtle effects.

NOTE A tight meshing is not necessary when you use the regathering feature on
the Rendering Parameters rollout on page 6016 .
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Interface

NOTE You can override the subdivision settings in this group with the Advanced
Lighting panel on page 256  of the Object Properties dialog. This allows you to
have a different mesh resolution on some objects. For example, you might want
to have a finer mesh on an important wall surface that you know will have a lot
of detail. To display the Object Properties dialog, right-click a selected object and
choose Properties from the quad menu.
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Global Subdivision Settings group

Enabled Turns on the radiosity mesh for the entire scene. Turn off the mesh
when you want to perform quick tests.

■ Use Adaptive Subdivision Turns adaptive subdivision on and off.
Default=on.

NOTE The Mesh Settings group parameters Minimum Mesh Size, Contrast
Threshold, and Initial Meshing Size are available only when Use Adaptive
Subdivision is on.

Left: A simple box with no subdivision

Middle Left: The box faces are subdivided

Middle Right: The box faces are subdivided with a smaller Meshing Size

Right: The box faces are subdivided with Adaptive Subdivision
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Mesh Settings group

Adaptive Subdivision using the default mesh and light settings

Max Mesh Size The size of the largest faces after adaptive subdivision.
Default=36” for imperial units and 100cm for metric units.

When Use Adaptive Subdivision is turned off, Max Mesh Size sets the size of
the radiosity mesh in world units.

Min Mesh Size Faces are not divided smaller than the minimum mesh size.
Default=3” for imperial units and 10cm for metric units.

Contrast Threshold Faces that have vertex illuminations that differ by more
than the Contrast Threshold settings are subdivided. Default=75.0.

Radiosity solutions with different Contrast Threshold values. The best solution is at the
center, with Contrast Threshold=60.
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Initial Meshing Size When improving the face shape, faces that are smaller
than the Initial Meshing Size are not subdivided. The threshold for deciding
whether a face is poorly shaped also gets larger as the face size is closer to the
Initial Mesh Size. Default=12 inches (1 foot) for US Standard units and 30.5cm
for metric units.

Light Settings group

Shoot Direct Lights When adaptive subdivision or shoot direct lights is on,
the direct lighting on all of the objects in the scene is calculated analytically,
based on the following switches. Lighting is analytically computed without
modifying the object's mesh which produces lighting that is less noisy and
more pleasing to the eye. This switch is implicitly enabled when using adaptive
subdivision since it is a requirement. Default=on.

This switch is available when the Use Adaptive Subdivision switch is turned
off.

Adaptive Subdivision with light settings turned off

NOTE Lighting from lights that are not included while shooting direct light are
calculated using random sampling. These lights also are not able to affect the
adaptive subdivision of objects.
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Include Point Lights in Subdivision Controls whether point lights are used
when shooting direct lights. If this switch is off, then point lights are not
included in illumination calculated directly at vertices. Default=on.

Include Linear Lights in Subdivision Controls whether linear lights are used
when shooting direct lights. If this switch is off, then linear lights are not used
in calculating the illumination at vertices. Default=on.

Include Area Lights in Subdivision Controls whether area lights are used
when shooting direct lights. If this switch is off, then area lights are not used
in illumination calculated directly at vertices. Default=on.

Include Skylight When turned on, skylight is used when shooting direct
lights. If this switch is turned off, then skylight is not used in illumination
calculated at vertices directly. Default=off.

Include Self-Emitting Faces in Subdivision This switch controls how
self-emitting faces are used when shooting direct lights. If this switch is turned
off, then self-emitting faces are not used in illumination calculated at vertices
directly. Default=off.

Minimum Self-Emitting Size This is the minimum size that a self-emitting
face will be subdivided when calculating its illumination. Minimum size is
used rather than the number of samples to allow larger faces to be sampled
more than smaller ones. Default=6.0.

Light Painting Rollout (Radiosity)

Main toolbar > Render Scene > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout > Choose Radiosity from the drop-down list. >
Light Painting rollout

Rendering menu > Render > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout > Choose Radiosity from the drop-down list. >
Light Painting rollout

The light painting tools in this rollout allow you to touch up shadowed and
illuminated areas manually. You can use these tools to touch up shadow and
light-leak artifacts without having to do additional remodeling or radiosity
processing. Using Pick Illumination, Add Illumination, and Remove
Illumination, you can add or remove illumination on one selection set at a
time.
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To use the light painting tools, you must first select objects, and then select
a particular light painting tool: Pick Illumination, Add Illumination, or Remove
Illumination. The active button is highlighted in yellow, and when it is over
a selected object, the cursor changes to a crayon icon for the Add and Remove
Illumination tools, or to an eyedropper icon for Pick Illumination.

You can pick, add, or remove illumination through objects. For example, if
you select the floor as an object, you can work under the bookshelf, by working
through it. Once in light painting mode, you can’t select another object unless
you cancel the operation.

Interface

Intensity Specifies the intensity of the illumination in lux or candelas
depending on the units you have selected in the Customize > Units Setup
dialog on page 7601 .

Pressure Specifies the percentage of the sampled energy to be used when
you add or remove illumination.

Add Illumination Adds illumination starting at the vertex of a selected
object. 3ds Max adds illumination based on the amount in the Pressure spinner.
The pressure amount corresponds to a percentage of the sampled energy. For
example, if a wall has about 2,000 lux on it, Add Illumination adds 200 lux
to the surface of the selected object.

Remove Illumination Removes illumination starting at the vertex of a
selected object. 3ds Max removes illumination based on the amount in the
Pressure spinner. The pressure amount corresponds to a percentage of the
sampled energy. For example, if a wall has about 2,000 lux on it, Remove
Illumination removes 200 lux from the surface of the selected object.
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Pick Illumination Samples the amount of illumination from a surface
that you select. To save you from inadvertently making bright or dark spots,
Pick Illumination uses an amount of illumination relative to the surface
illumination you sample. Click the button, and move the eyedropper cursor
over the surface. When you click a surface, the amount of illumination in lux
or candelas is reflected in the Intensity spinner. For example, if you used Pick
Illumination over a wall that has 6 lux of energy, then 0.6 lux displays in the
Intensity spinner. The amount of illumination 3ds Max adds or removes on
the surface will be this value multiplied by the Pressure value.

Clear Clears all the changes you made. Processing additional radiosity
iterations or changing the filtering amount will also discard any changes to
the solution you made with the light painting tool.

Using light painting to add or remove light in a radiosity solution.

Rendering Parameters Rollout (Radiosity)

Main toolbar > Render Scene > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
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Advanced Lighting rollout > Choose Radiosity from the drop-down list. >
Rendering Parameters rollout

Rendering menu > Render > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout > Choose Radiosity from the drop-down list. >
Rendering Parameters rollout

Provides parameters that allow you to control how you want to render the
radiosity-processed scene.

By default when you render, 3ds Max first recalculates the shadows from light
objects, then it adds the result of the radiosity mesh as ambient light.

The first two options on the rollout control how the renderer treats direct
illumination. Re-Use Direct Illumination From Radiosity Solution provides a
quick render that displays colors from the radiosity mesh. Render Direct
Illumination uses the scanline renderer to provide direct illumination and
shadows. This second option is usually slower but more accurate. With Render
Direct Illumination, the radiosity solution provides only the indirect lighting.

When Render Direct Illumination is the method you choose, you can turn on
regathering to correct artifacts and shadow leaks. Regathering provides the
slowest but the best-quality rendering.

NOTE Regathering is extremely intensive for your CPU and uses a lot of RAM, so
it might not be practical for print-resolution images (for example, 4000 x 4000
pixels).
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Interface

Re-Use Direct Illumination from Radiosity Solution 3ds Max doesn’t render
direct lights, but uses the direct lighting stored in the radiosity solution. If
you turn on this option, the Regather Indirect Illumination option is disabled.
The quality of shadows in the scene depends on the mesh resolution. Capturing
fine shadow details might require a fine mesh, but in some situations this
option can speed up overall rendering time, especially for animations, because
the lights don’t have to be recalculated by the scanline renderer.

You should use this option if you are using the Assign Vertex Colors utility
on page 5849 .
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Left: Direct light only is stored in the radiosity mesh.

Middle: Indirect light only is stored in the radiosity mesh.

Right: Direct and indirect light both stored in the radiosity mesh (the shadows are
usually very coarse).

WARNING If you choose this option but haven't generated a radiosity solution,
rendering generates a completely black image.

Render Direct Illumination 3ds Max renders shadows from the lights at each
rendering frame, and then adds indirect light from the radiosity solution. This
is the default rendering mode.

Left: Direct light calculated only by the scanline renderer.

Middle: Indirect light calculated only by the radiosity mesh.

Right: Direct and indirect light combined.

Regather Indirect Illumination In addition to recalculating all the direct
lighting, 3ds Max recalculates the indirect lighting at each pixel by regathering
illumination data from the existing radiosity solution. Using this option can
produce the most accurate, artifact-free images, but it can add a considerable
amount of rendering time.
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NOTE If you know that you want to use the regathering option, then typically
you don’t need as dense a mesh for the radiosity solution. Even if you don’t
subdivide the surfaces at all and do an Initial Quality of 0%, the regathering will
work, and might provide an acceptable visual result (useful for quick tests as well).
However, accuracy and subtle details depend on the quality of the radiosity solution
stored in the mesh. The radiosity mesh is the foundation for the regathering
process.

In the following illustrations, solutions were processed with an Initial Quality
of 0%. There is a high variance between small surfaces when a dense mesh is
used. Regathering gives acceptable results regardless of mesh density. But more
subtle details appear with a denser mesh; for example, at the base of the
sculpture.

No mesh

Left: Model subdivision

Middle: Viewport result

Right: Result of regathering

Coarse mesh

Left: Model subdivision

Middle: Viewport result

Right: Result of regathering
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Fine mesh

Left: Model subdivision

Middle: Viewport result

Right: Result of regathering

Rays per Sample The number of rays 3ds Max casts for each sample. 3ds
Max casts these rays randomly in all directions to calculate (“regather”) the
indirect illumination from the scene. The more rays per sample, the more
precise the sample will be. Fewer rays per sample produce more variance,
creating a more grainy effect. Processing speed and precision are affected by
this value. Default=64.

Filter Radius (pixels) Averages each sample with its neighbors in order to
reduce the noisy effect. Default=2.5 pixels.
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NOTE Pixel radius varies according to the output resolution. For example, a 2.5
radius is OK for NTSC resolution, but it might be very large for smaller images, or
too precise for very large images.

Pixel radius of 2

Left: 10 rays per sample

Middle: 50 rays per sample

Right: 150 rays per sample

Pixel radius of 5

Left: 10 rays per sample

Middle: 50 rays per sample

Right: 150 rays per sample
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Pixel radius of 10

Left: 10 rays per sample

Middle: 50 rays per sample

Right: 150 rays per sample

Increasing the number of rays per sample can greatly increase rendering time.
The images on the right can take nearly six times as long to render as the
images on the left. Increasing the filter radius also increases render time, but
not as dramatically.

Clamp Values (cd/m^2) This control is expressed as a luminance value.
Luminance (candelas per meter squared) represents how brightly you perceive
a material. Clamp Value sets an upper limit on the luminance that will be
considered in the Regathering stage. Use it to avoid the appearance of bright
spots.
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Bright polygons in the scene can create a “sparkle” effect of bright spots.

These bright spots are artifacts not of the number of samples cast, but rather
of the presence of bright polygons in your scene. During the Initial Quality
stage, this bright energy gets bounced in random directions, leading to a
“sparkle” effect. Typically you can detect these polygons before regathering.

During the final Regathering stage, bright spots can be avoided by setting
Clamp Values somewhat below the luminance of these bright surfaces and
spots.
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Bright spots have been reduced by clamping.

TIP You can query the luminance of these surfaces by using the Lighting Analysis
tool on page 6028 .

TIP Use Render Region on page 5900  to render just the area of the bright spots to
find rapidly the right clamp value to use.

Be careful with this control: Clamp Values let you clamp any intensity, and
the rendering might become darker than it should be because you have
clamped indirect illumination that is to be expected, thus dimming the effect
of the radiosity solution.
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Adaptive Sampling group

These controls can help you speed up rendering time. They reduce the number
of light samples taken. The ideal settings for adaptive sampling vary greatly
from scene to scene.

Adaptive sampling initially takes samples from a grid superimposed on the
pixels of the scene. Where there is enough contrast between samples, it
subdivides that region and takes further samples, down to the minimum area
specified by Subdivide Down To. Lighting for areas not directly sampled is
interpolated.

TIP If you use adaptive sampling, try adjusting the Subdivision Contrast value to
obtain the best results.

Adaptive Sampling When on, the radiosity solution uses adaptive sampling.
When off, it does not. Turning off adaptive sampling can increase the detail
of the final rendering, but at a cost of rendering time. Default=off.

Initial Sample Spacing The grid spacing for initial samples of the image. This
is measured in pixels. Default=16x16.

Subdivision Contrast The contrast threshold that determines when a region
should be further subdivided. Increasing this value causes less subdividing to
occur. Reducing this value can cause unnecessary subdivide. Default=5.0.

Subdivide Down To The minimum spacing for a subdivision. Increasing this
value can improve render time at a cost of accuracy. Default=2x2.

Depending on the scene geometry, grids larger than 1x1 might still be
subdivided below this specified threshold.

Show Samples When on, sample locations render as red dots. This shows
where the most sampling has taken place, which can help you choose the
optimal settings for adaptive sampling. Default=off.

Statistics Rollout (Radiosity)

Main toolbar > Render Scene > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
Advanced Lighting rollout > Choose Radiosity from the drop-down list. >
Statistics rollout

Rendering menu > Render > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Advanced Lighting panel > Select
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Advanced Lighting rollout > Choose Radiosity from the drop-down list. >
Statistics rollout

Lists information about the radiosity processing.

Interface

Radiosity process group

Lists the current level of quality and number of refine iterations in the radiosity
process.

Solution Quality The current level of quality in the radiosity process.

Refine Iterations The number of refine iterations in the radiosity process.

Elapsed Time The time spent processing the solution since the last reset.

Scene Information group

Lists information on the radiosity processing of the scene.

Geometric Objects Lists the number of objects processed.

Light Object Lists the number of light objects processed.

NOTE Self-illuminated objects count as one light per face.

Meshing Size  Lists the size of radiosity mesh elements in world units.

NOTE Transparent, 2–sided, and translucent objects' faces are counted twice.
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Mesh Elements Lists the number of elements in the mesh processed.

Lighting Analysis

Select an object that has radiosity solution information. > Rendering menu >
Advanced Lighting > Lighting Analysis

To query light levels, analyze the data, and produce reports, use the Lighting
Analysis dialog. This dialog provides rendering data on material reflectance,
transmittance, and luminance.

For example, a lighting engineer might need to know if light fixtures in a
scene provide an even level of illumination on the walls of a building. The
engineer uses the Lighting Analysis dialog after placing the lights in the ceiling
and processing radiosity. The engineer inspects the light levels and material
reflectance in the scene and then adjusts the brightness of lights, changes
units, or reduces material reflectance.

To use the Lighting Analysis tools, a radiosity solution must be calculated and
displayed in the scene. For better feedback, use it in conjunction with the
Pseudo Color Exposure Control on page 6552 . This tool maps luminances or
illuminances to pseudo colors that show the brightness of the values 3ds Max
converts.

TIP You can also export LogLUV TIFF files on page 7164  or PIC files on page 7151
for analysis by other software; do this by using the Lighting Data Exporter utility
on page 6559 .

See also:

■ Modeling Global Illumination with Radiosity on page 5976

■ Radiosity  on page 5989

■ Radiosity Controls on page 5995

■ Radiosity Preferences on page 7578

■ Lighting Data Exporter Utility on page 6559
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Interface

Statistics group

Displays the radiosity solution lighting statistics for the object you select.

Quantity Indicates the desired photometric value:

■ Luminance The amount of energy leaving a surface.

■ Illuminance The amount of energy arriving at a surface.

Point The luminance or illuminance at the point on the object where you
clicked.

Point Reflectance The reflectance of the surface material at the point on the
object where you clicked.

Point Transmittance The transmittance of the surface material at the point
on the object where you clicked.

Object Avg The amount of light intensity for the object as a whole.

Object Min The object’s minimum luminance or illuminance value.

Object Max The object’s maximum luminance or illuminance value.

Scene Max The scene’s highest luminance or illuminance value.
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Selection Information group

Object Name The name of the selected object.

Object Area The area size of the selected object.

Point Location The X,Y,Z coordinate of the point on an object you clicked.

Raytracer Panel

Raytracer Global Parameters Rollout

Rendering menu > Raytracer Settings

Rendering menu > Render > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Raytracer panel > Raytracer
Global Parameters rollout

Main toolbar > Render Scene > Render Scene dialog > Choose Default Scanline
Renderer as the active production renderer. > Raytracer panel > Raytracer
Global Parameters rollout

Parameters in the Global Raytracer Settings dialog globally control the raytracer
itself. That is, they affect all Raytrace materials and Raytrace maps in your
scene. They also affect the generation of Advanced Ray-traced shadows on
page 7907  and Area shadows on page 7717 .

NOTE These controls adjust ray-trace settings for the scanline renderer only. The
settings of these controls have no impact on the mental ray renderer, which has
its own ray-tracing controls.
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Interface

Ray Depth Control group

Ray depth is also known as recursion depth. This is how many times a ray is
allowed to bounce before it is considered lost or trapped.
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Upper left: Ray depth is zero

Upper right: Ray depth of 2

Lower middle: Extremely high ray depth

Maximum Depth Sets the maximum recursion depth. Increasing this value
potentially increases the realism of your rendered scene, at a cost of rendering
time. You can reduce this value to reduce rendering time. Range=0 to 100.
Default=9.

Cutoff Threshold Sets a cutoff threshold for adaptive ray levels. If the
contribution of any ray to the final pixel color drops below the cutoff
threshold, the ray is terminated. Default: 0.05 (5% of the final pixel color).
This can speed up your rendering time considerably.

Color to use at Max Depth As a rule, when a ray reaches the maximum
depth, it is rendered the same color as the background environment. You can
override the color returned at maximum depth by either selecting a color, or
setting an alternative environment map. This can make the "lost" ray invisible
in the scene.
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TIP If you are having trouble with getting complex objects to render, especially
glass, specify the maximum recursion color to something obvious, like magenta,
and your background color to something that contrasts, like cyan. The chances
are that a lot of your rays are getting lost in either maximum recursion or just
being shot off into the world, totally missing anything you think they should strike.
Try rendering the scene again. If this is the problem, try reducing the Maximum
Depth value.

■ Specify Specifies what color the raytracer returns when the ray is
considered lost or trapped. Click the color swatch to change this color.

■ Background (The default.) Returns the background color when the ray
is considered lost or trapped. For Raytrace material, the background color
is the global environment background or the environment specified locally
for the material. For Raytrace map, the background color is either the global
environment background, or is set locally in the Raytracer Parameters
rollout on page 5781 .

Global Ray Antialiaser group

Controls in this group let you set global antialiasing for raytraced maps and
materials.
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Above: No antialiasing

Below: Antialiasing of reflections

TIP Turning on Supersample for a Raytraced material (in the Raytrace Basic
Parameters rollout on page 5397 ) usually provides adequate antialiasing. Use one
of the raytrace antialiasers (Fast Adaptive or Multiresolution Adaptive) when you
want to blur reflections or refractions.

On When on, uses antialiasing. Default=off.

Drop-down list Chooses which antialiasing settings to use. There are two
options:

■ Fast Adaptive Antialiaser Uses the Fast Adaptive antialiaser, regardless of
the global setting.
Click ... to open the Fast Adaptive Antialiaser dialog on page 5427 .

■ Multiresolution Adaptive Antialiaser Uses the Multiresolution Adaptive
antialiaser, regardless of the global setting.
Click ... to open the Multiresolution Adaptive Antialiaser dialog on page
5429 .
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Global Raytrace Engine Options group

These options are comparable to the local options on Extended Parameters
rollout on page 5406  and the Raytracer Controls rollout on page 5411 . Their
setting affects all Raytrace materials and Raytrace maps in the scene, unless
you set local overrides.

NOTE In versions prior to 3ds Max 5 , these controls were found on the Raytracer
Options dialog, which is no longer present.

Enable Raytracing Turns the raytracer on or off. Default=on.

Even with raytracing off, Raytrace material and Raytrace map still reflect and
refract the environment, including both the environment map for the scene,
and the environment map assigned to the Raytrace material.

Raytrace Atmospherics Turns the raytracing of atmospheric effects on or
off. Atmospheric effects include fire, fog, volume light, and so on. Default=on.

Enable Self Reflect/Refract Turns self reflection/refraction on or off.
Default=on.

Can an object reflect itself? For example, a teapot's body reflects the teapot's
handle, but a sphere will never reflect itself. If you don't need this effect, you
can improve render time by turning off this toggle.

TIP If you have a transparent object such as glass, and Enable Self Reflect/Refract
is on, you don't have to make the object 2-sided on page 7697 . The raytracer sees
back faces when exiting refractive objects.

Reflect/Refract Material IDs When on, the material reflects effects assigned
to material IDs in the renderer's G-buffer on page 7795  on or off. Default=on.

By default, Raytrace material and Raytrace map reflect effects assigned to a
material's ID, so that G-buffer effects are not lost. For example, if a raytraced
object reflects a lamp made to glow with the Video Post Glow filter (Lens
Effects Glow), the reflection glows as well.

Render objects inside raytraced objects Turns the rendering of objects inside
raytraced objects on or off. Default=on.

Render atmospherics inside raytraced objects Turns the rendering of
atmospheric effects inside raytraced objects on or off. Atmospheric effects
include fire, fog, volume light, and so on. Default=on.

Enable Color Density / Fog Effects Turns the color density and fog features
on or off.
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Acceleration Controls Click to display the Raytracing Acceleration Parameters
dialog on page 5423 , which lets you adjust settings.

Exclude Click to display the Raytrace Exclude/Include dialog on page 5424 ,
which lets you exclude objects from ray-tracing.

Show Progress Dialog When on, rendering displays a window with progress
bars titled Raytrace Engine Setup. Default=on.

Show Messages When on, displays a window, Raytrace Messages, that shows
status and progress messages from the raytrace engine. Default=off.

Using Multi-Pass Rendering Effects

Create panel > Cameras > Target button or Free button > Parameters rollout
> Multi-Pass Effect group

Multi-pass rendering effects use multiple renderings of the same frame, with
slight camera movement between each rendering. The multiple passes simulate
the blurring that film in a camera would register under certain conditions.
Two multi-pass effects are provided:

■ Depth of field on page 5143
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Multi-pass depth of field

Top: Focus is in the middle distance, near and far objects are blurred.

Bottom left: Focus on near objects, far objects are blurred.

Bottom right: Focus on far objects, near objects are blurred.

■ Motion blur on page 5147
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Above: Motion blur applied to wings of the flying dragon

Below: Multiple passes appear in successive refreshes of the rendered frame window.

TIP These effects are for the default scanline renderer. The mental ray renderer
on page 6039  has its own depth-of-field and motion blur effects. See Motion Blur
with the mental ray Renderer on page 6059  and Depth of Field with the mental
ray Renderer on page 6061 .

6038 | Chapter 18   Rendering



mental ray Renderer

The mental ray® renderer from mental images® is a general-purpose renderer
that can generate physically correct simulations of lighting effects, including
ray-traced reflections and refractions on page 6057 , caustics on page 6066 , and
global illumination on page 6072 .

NOTE mental images and mental ray are registered trademarks, and photon map
is a trademark of mental images GmbH & Co. KG, Berlin, Germany.

Scene rendered with the default 3ds Max scanline renderer
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Same scene rendered with the mental ray renderer

The second rendering, done with the mental ray renderer, shows caustics cast by
refraction through the martini glass. Caustics are also visible in the reflection on the
cocktail shaker.

The mental ray renderer in 3ds Max supports the mental ray version 2 (mi2)
and version 3 (mi3) formats. It does not support the mental ray version 1
(mi1) format.

Differences Between the mental ray Renderer and the Default Scanline
Renderer

Compared to the default 3ds Max scanline renderer, the mental ray renderer
relieves you of the need to simulate complex lighting effects "by hand" or by
generating a radiosity solution. The mental ray renderer is optimized to use
multiple processors and to take advantage of incremental changes for efficient
rendering of animations.

Unlike the default 3ds Max renderer, which renders scanlines from the top of
the image downward, the mental ray renderer renders rectangular blocks called
buckets. The order in which the buckets are rendered can vary, depending on
the method you choose. By default, mental ray uses the Hilbert method, which
picks the next bucket to render based on the cost of switching to the next
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one. Because objects can be discarded from the memory to render other objects,
it’s important to avoid having to reload the same object multiple times. This
is especially important when you have enabled placeholder objects (see the
Processing panel > Translator Options rollout on page 6122 ).

If you use distributed rendering to render a scene, it might be hard to
understand the logic behind the rendering order. In this case, the order has
been optimized to avoid sending lots of data over the network. Each CPU is
assigned a bucket as the bucket becomes available, so different buckets can
appear in the rendered image at different times. See the Renderer panel >
Sampling Quality rollout on page 6083 .

NOTE The mental ray renderer can also be run in a standalone fashion, using a
command-line interface based on the mi2 or mi3 scene description format. This
is described in the manual mental ray Programming,  which is written for
programmers writing custom shaders on page 7925 .

See also:

■ Getting Good Results with mental ray Rendering on page 6044

■ 3ds Max Materials in mental ray Renderings on page 6048

■ mental ray Concepts on page 6056

■ Enhancements to Standard Features on page 6050

Procedures

To use the mental ray renderer:

1 Choose Rendering menu > Render. The Render Scene dialog displays.

2 On the Common panel, open the Assign Renderer rollout, then click the
“...” button for the Production renderer.

A Choose Renderer dialog is displayed.

3 On the Choose Renderer dialog, click to select mental ray Renderer, and
then click OK.

TIP After you make the mental ray renderer the active production renderer,
you can click Save As Defaults to make the mental ray renderer the default
renderer for all new scenes. This can be a convenient way to avoid extra setup
time.
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Now when you render, the Render Scene dialog appears with the mental ray
controls. You can choose to render the scene with the built-in mental ray
renderer, or simply to translate the scene and save it in a .mi on page 7848  file
that you can render later, perhaps on a different system. Controls for choosing
whether to render, save to a .mi file, or both, are on the Translator Options
rollout on page 6122 .

Rendering with the mental ray Renderer

Rendering menu > Render > Render Scene dialog > Common panel > Assign
Renderer rollout > Choose mental ray Renderer as the production renderer.

Main toolbar > Render Scene > Render Scene dialog > Common panel > Assign
Renderer rollout > Choose mental ray Renderer as the production renderer.

To use the mental ray translator and renderer, you must first choose mental
ray as the production renderer, as described the "Procedures" section below.
Once you have chosen mental ray rendering, the Render Scene dialog displays
panels and rollouts that control the mental ray renderer.

Common Parameters Rollout

When you render with mental ray, controls on the Render Scene dialog >
Common panel > Common Parameters rollout remain the same, and function
just as they do with the default 3ds Max scanline renderer.

Limitations

The mental ray renderer does not support certain rendering features, as
described here.

■ Output dithering options aren't supported (in Main menu > Customize >
Preferences > Preference Settings dialog > Rendering panel > Output
Dithering group).

■ The mental ray renderer does not fully support G-buffer options in post
processing and image file output. The mental ray renderer generates all
required G-buffer channels, but does not include transparency information.
If two transparent objects overlap each other, the mental ray render
generates information only for the frontmost object.

■ When you use a bitmap as an environment (that is, as a background), the
mental ray renderer will sample it and filter it. This can result in unwanted
blurring. To prevent background blurring, render the scene against a
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solid-color background, and then composite the rendered scene with the
background image.

■ Sometimes when you render objects that have zero thickness, or an Extrude
modifier with zero thickness, the mental ray renderer generates rendering
artifacts that appear as streaks. In some cases, you can fix this by turning
on Force 2-Sided in the Render Scene dialog's Common Parameters rollout.
If the streaks persist, give the object or the Extrude modifier a nonzero
thickness.

See also:

■ Sampling Quality Rollout (mental ray Renderer) on page 6083

■ Camera Effects Rollout (mental ray Renderer) on page 6087

■ Caustics and Global Illumination Rollout (mental ray Renderer) on page
6096

■ Final Gather Rollout (mental ray Renderer) on page 6104

■ Shadows and Displacement Rollout (mental ray Renderer) on page 6114

■ Rendering Algorithms Rollout (mental ray Renderer) on page 6118

■ Translator Options Rollout (mental ray Renderer) on page 6122

■ Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6131

Procedures

To use the mental ray renderer:

1 Choose Rendering menu > Render. The Render Scene dialog displays.

2 On the Common panel, open the Assign Renderer rollout, then click the
“...” button for the Production renderer.

A Choose Renderer dialog is displayed.

3 On the Choose Renderer dialog, click to select mental ray Renderer, and
then click OK.

Now when you render, the Render Scene dialog appears with the mental ray
controls. You can choose to render the scene with the built-in mental ray
renderer, or simply to translate the scene and save it in a .mi on page 7848  file
that you can render later, perhaps on a different system. Controls for choosing
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whether to render, save to a .mi file, or both, are on the Translator Options
on page 6122  rollout.

To make the mental ray Renderer the default renderer for new scenes:

■ After you make the mental ray renderer the active production renderer,
click Save As Defaults on the Assign Renderer rollout.

Getting Good Results with mental ray Rendering

Although the mental ray renderer is relatively easy to use once you’ve set it
up correctly, there are several "gotchas" that you might encounter immediately,
especially if you’re primarily accustomed to the 3ds Max scanline renderer
and its workflow. For example, see 3ds Max Materials in mental ray Renderings
on page 6048 . Below are some basic rules of thumb for using mental ray in 3ds
Max.

Using Lights with the mental ray Renderer

When you set up a scene for rendering with the mental ray renderer, keep the
following tips in mind:

■ The Overshoot parameter for lights doesn't work when you use mental ray
to render shadow-mapped shadows. To use Overshoot, use ray-traced
shadows.

■ Excluding an object from shadow casting doesn't work when you use
mental ray to render shadow-mapped shadows. To exclude objects from
shadow casting, use ray-traced shadows. (The Exclude button is on a light's
General Parameters rollout.)

■ When you assign a map to object shadows in the light's Shadow Parameters
rollout, the mental ray renderer does not recognize the toggle for the map
(to the left of the Map button), and renders the map whether the toggle
is on or off. To stop using the map, you must click the Map button and in
the Material/Map Browser, assign NONE as the map type.

■ Using the default scanline renderer, you can set a light to have a value of
zero, with a shadow color of white, and a shadow density of −1. With these
settings, the light casts shadows but does not illuminate the scene. To get
the same effect using the mental ray renderer, the light value must not be
zero. Instead, set it to a value close to zero (for example, 0.001 or –0.001).
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■ The mental ray renderer disregards the bias parameters in the Shadow Map
Params rollout and the Ray Traced Shadow Params rollout.

■ The mental ray renderer assumes that all directional lights come from
infinity, so objects that are behind the direct light object in the 3ds Max
scene will also be illuminated.

Ray Tracing

The mental ray ray tracer is fast and provides excellent quality images, but
you have to use it correctly within 3ds Max.

The mental ray renderer does not fully support cubic maps for Reflect/Refract
maps on page 5791 . It uses them if they have already been generated by the
default scanline renderer, but it does not generate them. If Source > From File
is active and the mental ray renderer can find the six cubic maps, it uses them.
If Source > Automatic is active, or if the cubic maps cannot be found, the
mental ray renderer generates ray-traced reflections or refractions instead.

Ray Tracing Setup

On the rendering menu, Ray Tracer Settings and Raytrace Global
Include/Exclude are disabled while the mental ray renderer is active. These
controls adjust ray-trace settings for the scanline renderer only. The settings
of these controls have no impact on the mental ray renderer. The ray-tracing
controls for mental ray appear on the Renderer panel > Rendering Algorithms
rollout on page 6118 .

TIP While the mental ray renderer ignores the global inclusion or exclusion settings
for the ray tracer, you can  enable or disable ray-tracing at the local level of a
Raytrace material or map.

Ray Tracing Rules of Thumb

Let’s say you’re rendering a (lathed) wineglass, with an inner and outer surface
and a piece of geometry representing the wine. The wine geometry is just
slightly smaller than the inner surfaces of the wineglass, and capped with a
flat top. Now, you go to render the glass. After rendering the scene, however,
there’s something wrong: the inner surfaces of the glass don’t seem reflective
enough, and the wine isn’t refracting properly. What’s wrong?

What’s wrong is that you probably have the number of reflections and
refractions set too low for the number of surfaces you have. To check this, go
to the Renderer panel > Rendering Algorithms rollout on page 6118  and look
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at the Maximum Trace Depth spinners. If you haven’t changed the parameters,
then you should see Max. Reflections and Max. Refractions set to the default
of 6, and Max. Depth set to 6.

There’s the problem: you actually have six surfaces that need to be traced by
the light rays for both reflections and refractions. The way to always calculate
the number of rays needed for a scene is to take the ray-traced objects in your
scene and draw an imaginary line through them, originating at the point of
view. Then, count the number of surfaces the line intersects.

For the wineglass and wine, you need at least six reflections and refractions
that correspond to the following surfaces:

■ Near outer glass surface (“near” relative to your Camera viewpoint)

■ Near inner glass surface

■ Near wine surface

■ Far wine surface

■ Far inner glass surface

■ Far outer glass surface

Therefore, increase the value of Max. Depth to 12.

Caustics and Global Illumination

Before rendering with caustics, there are several things you need to set up in
your scene:

■ For caustics to work properly, the generating object must use a material
that contains some degree of shininess, reflectivity, or refraction. Assign
a Raytrace or other map as either a Reflection map or Refraction map before
you render caustics.

■ Most often, you’ll be using very shiny, highly reflective materials (such as
chrome and other metals), or transparent or translucent materials (such
as glass goblets or water), to generate caustics in your scene. If you’re using
a glassy material, make sure it’s double-sided to create the proper results.

■ Make sure you have object properties on page 262  set to Receive Caustics
or Generate Caustics (or both). To set up these properties, right-click an
object and choose Properties. For example, if you’re rendering a wineglass
on a tabletop, you probably want the wineglass both to generate and receive
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caustics (so that caustics are scattered within the glass itself), and the
tabletop only to receive caustics (unless it’s chrome, say, instead of wood).

■ If the rendering of your scene is washed out by light, double-check the
Multiplier settings: one in the Basic group of the Final Gather rollout on
page 6104 , and one each in the Caustics and Global Illumination (GI) groups
of the Indirect Illumination panel > Caustics And Global Illumination
rollout on page 6096 . These apply to all lights in the scene. Reducing the
Multiplier values can eliminate washout.
If a single light object is causing the problem, you can reduce the Energy
multiplier's value in that light object's mental ray Indirect Illumination
rollout on page 5060 , available on the Modifier panel.

■ To improve the quality of caustics, go to the Caustics group on page 6099
of the Caustics And Global Illumination rollout on page 6096  and increase
the Max Num. Photons Per Sample setting.

■ Be careful of the total number of photons you’re emitting: A very high
number (100,000 and above) can dramatically increase your rendering
time. Then again, for some simple scenes, you might actually be able to
set these to 1,000,000 and still render in an acceptable amount of time.

WARNING The number of photons specified for each light indicates the
number of photons that need to be stored for each light, not the number of
photons to be shot. This is an important distinction: If a light points in a
direction where there is no surface, the mental ray renderer might shoot
photons forever. In the Messages Window on page 6054 , the mental ray renderer
displays warnings that no photons are being stored. To avoid the slowdowns
related to this issue, make sure that every light points in the direction of a
surface (this is sometimes impossible to do with omni lights). Another way to
avoid this problem is to add a big sphere around your entire model.

■ In general, use an exposure control. The  mr Photographic Exposure
Control on page 6544  works particularly well for adjusting overall exposure.

Coincident Faces

When it encounters coincident faces, the mental ray renderer can produce
artifacts, because it can't decide which face is nearer the camera (neither is).
To fix this, move or scale one of the objects so faces are no longer coincident.
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Backface Culling

mental ray rendering correctly performs backface culling, and renders one-sided
faces much as the scanline renderer does.

3ds Max Materials in mental ray Renderings

For the most part, the mental ray renderer treats 3ds Max maps and materials
the same way the default scanline renderer does. The exceptions are listed
below. In general, if the mental ray renderer does not recognize a map or
material, it renders it as opaque black.

WARNING The mental ray renderer does not necessarily support maps or materials
provided as plug-ins from third-party vendors. It supports third-party maps and
materials only if the vendor has explicitly used the mental ray SDK to add support
for the mental ray format. Unless the third-party vendor clearly specifies mental
ray support, you should assume the map or material is unsupported, and will
render as black.

See also:

■ mental ray Renderer on page 6039

■ Getting Good Results with mental ray Rendering on page 6044

Issues for Reflections and Refractions

The maps used to create reflections or refractions, Flat Mirror, Raytrace,
Reflect/Refract, and Thin Wall Refraction, are supported by the mental ray
renderer. However, the mental ray renderer simply uses these maps as
indications to use its own ray-tracing method, leading to some restrictions on
which parameters are supported, as described in the sections “Materials” and
“Maps,” below.

Map Blurring

When reflections and refractions are ray traced, applying Blur (or Distortion,
in Flat Mirror) does not apply to reflections or refractions of environment
maps. In general, Blur and Distortion render differently than they do with
the default scanline renderer, and you might have to experiment with
parameter values to get a comparable rendering result.
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TIP If Blur effects are not rendering well with the mental ray renderer, try increasing
the Maximum number of samples in the Renderer panel > Sampling Quality
Rollout on page 6083 .

Materials

The mental ray renderer does not support these materials:

■ Advanced Lighting Override material

■ Lightscape material

■ Morpher material

Raytrace Material

The mental ray renderer supports all Raytrace material settings except for the
antialiasing parameters and the settings found under Rendering > Raytracer
Settings and Rendering > Raytrace Global Include/Exclude. All these options
are specific to the default scanline renderer.

TIP While the mental ray renderer ignores the global inclusion or exclusion settings
for the ray tracer, you can enable or disable ray-tracing at the local level of a
Raytrace material or map.

Maps

■ Bitmap
The mental ray renderer can't use the Progressive JPEG (.jpg) format as a
bitmap. Also, Summed Area filtering is not supported (in the Filtering
group of the Bitmap Parameters rollout).

PSD files are supported, but are translated into binary data, and because
of this, consume a lot of memory and increase render time. To reduce the
time involved, convert the PSD file to a format such as BMP.

The same is true of TIFF files. In addition, there are certain TIFF subformats
that the mental ray renderer does not support; specifically, LZW, CCIT
(fax), or JPEG compression; non-RGB color models such as CMYK, CIE, or
YCbCr; or multiple images in the same file (in this case, only the first image
is used). The mental ray renderer does support bilevel (1-bit), grayscale (4-
or 8-bit), color map (4- or 8-bits), RGB(A) (8-, 16-, or 32-bit) TIF images,
and TIF files with image strips.

■ Combustion map
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The mental ray renderer doesn't support this map.

■ Flat Mirror map
Flat Mirror is supported by the mental ray renderer, except for the First
Frame Only and Every Nth Frame parameters.

■ Raytrace map
The mental ray renderer supports all Raytrace map settings except for the
antialiasing parameters.

■ Reflect/Refract map
This map tells the mental ray renderer to use ray-traced reflections and
refractions. Most parameters are supported, but the parameters Blur Offset,
First Frame Only, Every Nth Frame, and Atmosphere Ranges are not
supported.

NOTE The mental ray renderer does not fully support cubic maps for
Reflect/Refract maps. It uses cubic maps if they have already been generated
by the default scanline renderer, but it does not generate them. If Source >
From File is active and the mental ray renderer can find the six cubic maps, it
uses them. If Source > Automatic is active, or if the cubic maps cannot be
found, the mental ray renderer generates ray-traced reflections or refractions
instead.

Enhancements to Standard Features

The primary interface to the mental ray renderer consists of rollouts on the
Render Scene dialog. To choose the mental ray renderer, use the Assign
Renderer rollout on page 5943 , as described in this procedure on page ? .

In addition, object properties, lights, and the Material Editor have additional
controls to support mental ray rendering.

Object Properties Enhancements

Several new parameters have been added to the mental ray panel on page 262
of the Object Properties dialog. These options support the mental ray indirect
illumination features of caustics on page 6066  and global illumination on page
6072 .
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Light Object Enhancements

Along with the mental ray renderer, new area light objects and new light
settings are provided.

New Light Objects

Area lights on page 7713  are a feature of the mental ray renderer. Instead of
emitting light from a point source, they emit light from a broader area around
the source. There are two mental ray area lights: mr Area Omni Light on page
4945  and mr Area Spotlight on page 4948 . Area lights create soft-edged shadows.
This can help improve the realism of your rendering.

NOTE To render soft-edged shadows, shadows must be ray-traced, not
shadow-mapped: see the Renderer panel > Shadows & Displacement Rollout on
page 6114 .

In 3ds Max, area lights are created and supported by the MAXScript scripts,
light-mentalray_areaomni.ms and light-mentalray_areaspot.ms. Both scripts are
found in the \stdplugs\stdscripts\ folder within the program install directory.
Because of this, when you create an area light, you actually create a target spot
or omni light for which the mental ray renderer uses the parameters on the
Area Light Parameters rollout. If you render with the default scanline renderer,
the light behaves like any other target spot or omni light. (You can change a
light from one type to another using the Type drop-down list on the light’s
General Parameters rollout.)

For area lights rendered with the mental ray renderer, you can still set and
use other lighting parameters, such as color, the Multiplier value, the spotlight
cone, and so on. Shadow maps are an exception. The mental ray renderer
ignores the light's local shadow map settings. Area lights always use ray-traced
shadows.

TIP You can use a MAXScript utility to convert standard 3ds Max light objects to
area lights, as described in this procedure on page ? .

New Light Settings

The mental ray Indirect Illumination rollout on page 5060  has been added to
light objects to support the mental ray renderer’s indirect illumination effects
of caustics on page 6066  and global illumination on page 6072 .

The mental ray Light Shader rollout on page 5063  has been added so you can
add mental ray light shaders to light objects.
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IMPORTANT To see the mental ray rollouts for lights, you must use mental ray
Preferences on page 7579  to enable mental ray extensions. These rollouts appear
only on the Modify panel. They don't appear on the Create panel.

Camera Enhancements

On the Parameters rollout on page 5123 , a “Depth Of Field (mental ray)” choice
has been added to the Multi-Pass Effect drop-down list to support the mental
ray renderer's depth-of-field effects. To use this, turn on both Enable in the
camera's Multi-Pass Effect group (default=off), and Depth Of Field on the
Render Scene dialog > Renderer panel > Camera Effects rollout on page 6087 .

You can also assign mental ray lens, output, and volume shaders to cameras.
These controls are also on the Render Scene dialog's Camera Effects rollout.
(This rollout also contains some contour-shading controls.)

NOTE When you use the mental ray renderer, reflected or refracted light rays do
not always respect a camera's clipping planes (set in the Clipping Planes group of
the Parameters rollout). Also, large clipping-plane values can cause poor quality
in the rendering of shadow maps. To fix this, narrow the clipping range or switch
to ray-traced shadows.

Material Editor Enhancements

The Material Editor works as it does with the default scanline renderer. Certain
materials and maps, or some of their controls, aren't supported by the mental
ray renderer; see 3ds Max Materials in mental ray Renderings on page 6048 .

By default, the Material Editor sample slots use the currently active renderer:
typically this is either the default scanline renderer or the mental ray renderer.
As of 3ds Max you assign the renderer for sample slots by using the Render
Scene dialog > Common panel > Assign Renderer rollout on page 5943 .

When mental ray extensions are enabled (using mental ray Preferences on
page 7579 ) and the mental ray renderer is active, the Material Editor displays
these additional mental ray features:

■ A mental ray Connection rollout on page 5289  lets you add mental ray
shaders to 3ds Max materials.

■ When you click a material's Type button, the Material/Map Browser displays
additional mental ray materials on page 5448 .

■ When you click a map or shader button, the Material/Map Browser displays
additional mental ray shaders on page 5801 .

6052 | Chapter 18   Rendering



Shaders are provided in shader library (MI) files on page 7848 . Some shaders
are customized for 3ds Max, some are provided by the lume library, and
most are provided by mental images libraries. Settings for the custom 3ds
Max shaders are provided in this reference. Settings for the third-party
lume and mental images shaders are provided in their own help files. This
reference links to those descriptions; see Shaders in the LumeTools
Collection on page 5807  and mental images Shader Libraries on page 5805 .

Processing Panel (mental ray Renderer)

Rendering menu > Render > Render Scene dialog > Processing panel

Main toolbar > Render Scene button > Render Scene dialog > Processing panel

Note: The Processing panel appears only when the mental ray renderer is the
currently active renderer.

The Processing panel is an additional Render Scene dialog on page 5878  panel.
It appears only when the mental ray renderer on page 6039  is active, and its
controls relate to managing how the renderer operates. It also lets you generate
diagnostic renderings in pseudo color.
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Interface

The Processing panel contains three rollouts:

Translator Options Rollout (mental ray Renderer) on page 6122

Diagnostics Rollout (mental ray Renderer) on page 6129

Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6131

mental ray Messages Window

Rendering menu > mental ray Message Window
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The mental ray Messages window displays log messages (other than debug
messages) generated by the mental ray renderer.

Interface

Example of mental ray Messages window

Three status fields appear above the messages area:

■ Num. CPUs Shows the number of CPUs in use.

■ Num. threads Shows the number of threads being rendered.

■ mental ray version Shows the current mental ray renderer version, in
detail.

The options beneath the messages area are equivalent to options on the
mental ray Preferences dialog on page 7579 .

Information When on, the mental ray renderer generates information
messages. Default=off.

This is equivalent to the preference, Show/Log Information Messages.

Progress When on, the mental ray renderer generates progress messages.
Default=off.

This is equivalent to the preference, Show/Log Progress Messages.

Debug (Output to File) When on, the mental ray renderer generates debug
messages. Default=off.
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This is equivalent to the preference, Log Debug Messages (To File).

NOTE Debug messages are never displayed by the Messages Window. They are
numerous, and would make it difficult to find or read other messages.

Open on Error When on, the Messages Window is displayed if the mental
ray renderer logs an error message. Default=off.

This is equivalent to the preference, Open Message Window On Error.

Clear Click to clear all messages from the messages area.

mental ray Concepts

These topics describe what the mental ray renderer can do, and explain how
it accomplishes these effects. For more technical detail about mental ray
capabilities, see the mental ray manual, Programming mental ray, and Rendering
with mental ray, book 1, by Thomas Driemeyer (New York: Springer Verlag,
1999).

See also:

■ Ray-Traced Reflections and Refractions with the mental ray Renderer on
page 6057

■ Shadows with the mental ray Renderer on page 6058

■ Motion Blur with the mental ray Renderer on page 6059

■ Depth of Field with the mental ray Renderer on page 6061

■ Caustic Lighting Effects on page 6066

■ Global Illumination with the mental ray Renderer on page 6072

■ mental ray Volume Shading on page 6076

■ mental ray Displacement on page 6079

■ mental ray Contour Shading on page 6080

6056 | Chapter 18   Rendering



Ray-Traced Reflections and Refractions with the
mental ray Renderer

The mental ray renderer can generate reflections and refractions by ray tracing.
Ray tracing traces the path of rays sampled from the light source. Reflections
and refractions generated this way are physically accurate.

Ray-traced reflections and Refractions

To reduce the time required to generate reflections and shadows, rays are
limited by trace depth. Trace depth limits the number of times a ray can be
reflected, refracted, or both.

You can turn off ray tracing. In this case, the mental ray renderer uses scanline
rendering only. Turning off ray tracing makes the controls for all the effects
that are specific to mental ray unavailable in the Renderer's rollouts.

Ray tracing uses one of two ray-trace acceleration methods on page 7905 .

You enable ray tracing and set trace depth in the Render Scene dialog >
Renderer panel > Rendering Algorithms rollout on page 6118 .
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Shadows with the mental ray Renderer

The mental ray renderer can generate shadows by ray tracing. Ray tracing
traces the path of rays sampled from the light source. Shadows appear where
rays have been blocked by objects. Ray-traced shadows have sharp edges.

Ray-traced shadows

Turning off caustics makes the outlines of shadows in this scene easier to see.

You can tell the mental ray renderer to use shadow maps on page 7928  instead
of ray-traced shadows. This can improve performance at a cost of accuracy.

Shadow controls are on the Render Scene Dialog > Renderer panel > Shadows
& Displacement rollout on page 6114 .

Shadow Generators and the mental ray Renderer

Light objects in 3ds Max let you choose a shadow generator: Ray Traced,
Advanced Ray Traced, Shadow Map, and so on. Because the mental ray renderer
supports only two kinds of shadow generation, ray tracing and shadow maps,
some of the 3ds Max shadow generators aren't fully supported.
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In 3ds Max, a special shadow generator type, mental ray Shadow Map, is provided
to support the mental ray renderer. If shadows are enabled (on the Shadows
& Displacement rollout on page 6114  of the Render Scene dialog) but shadow
maps are not enabled, then shadows for all lights are generated using the
mental ray ray-tracing algorithm. If shadow maps are enabled, then shadow
generation is based on each light’s choice of shadow generator:

■ mental ray Shadow Map Shadows are generated using the mental ray
shadow-map algorithm.

■ Shadow Map Settings on the Shadow Parameters rollout are translated
into a mental ray equivalent before shadows are generated. The quality of
shadows generated this way might not always meet expectations.

■ Area Shadows, Advanced Ray Traced Shadows, or Ray Traced
Shadows Shadows are generated using the mental ray ray-tracing
algorithm.

Motion Blur with the mental ray Renderer

Motion blur is a way to enhance the realism of a rendered animation by
simulating the way a real-world camera works. A camera has a shutter speed,
and if significant movement occurs during the time the shutter is open, the
image on film is blurred.
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Motion blur added to rendering of an animated wheel as it speeds up and rolls forward

To render motion blur with the mental ray renderer, you must turn on ray
tracing (the Ray Trace parameter) on the Render Scene dialog > Renderer panel
> Rendering Algorithms rollout on page 6118 .

The mental ray renderer uses a Shutter parameter to control motion blur. This
simulates the shutter speed of a camera. At 0.0, there is no motion blurring.
At 1.0, the maximum amount of motion blurring occurs. Values between zero
and one adjust the amount of motion blur. The closer to 1.0, the greater the
blurring.

You turn on motion blur and adjust shutter speed on the Render Scene Dialog
> Renderer panel > Camera Effects rollout on page 6087 .

If you render using shadow maps on page 7928 , then by default mental ray
applies motion blur to these as well. See the Render Scene dialog > Renderer
panel > Shadows & Displacement rollout on page 6114 .

TIP mental ray motion blur is not recommended for use with particle systems, as
this can increase rendering time considerably. Use a Particle MBlur map on page
5729  instead.
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NOTE Motion blur with the mental ray renderer does not always follow curving
trajectories. Increasing the value of Motion Segments can help, but this works
better for rotary motion than for traveling motion.

Depth of Field with the mental ray Renderer

Depth of field is a way to enhance the realism of a rendering by simulating
the way a real-world camera works. With a broad depth of field, all or nearly
all of a scene is in focus. With a narrow depth of field, only objects within a
certain distance from the camera are in focus.

Scene rendered using no depth of field

All apples are equally in focus.
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Same scene using depth of field to control focus

The middle apple is clearer than the other two.

To render depth-of-field effects with mental ray, ray tracing (the Ray Trace
toggle) must be enabled on the Render Scene dialog > Renderer panel >
Rendering Algorithms rollout on page 6118 . You must also enable depth of field
for the camera: in the camera's Multi-Pass Effect group, choose “Depth Of
Field (mental ray)” as the depth-of-field type. (If you choose the scanline
renderer's Depth Of Field option, the rendering that results can be out of
focus.)

The mental ray renderer uses the camera’s target distance and f-Stop parameters
to control the depth-of-field effect.

The camera's target distance determines the focus plane. The focus plane is
the distance from the camera at which the scene is completely in focus.
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Focus plane in relation to a camera

Here it is set to the middle apple, as in the previous renderings.
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Focus plane in relation to a camera
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Here it is set to the nearest apple, as in the renderings that follow.

The f-stop controls the amount of blurring at distances other than the focus
plane distance. In a real-world camera, the f-stop measures the size of the
lens’s aperture. The lower the f-stop value, the larger the aperture and the
narrower the depth of field. So increasing the f-stop value broadens the depth
of field, and decreasing the f-stop value narrows the depth of field.

Decreasing the f-stop to narrow depth of field

Focal plane set at the nearest apple, and f-stop set to 0.1.
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Increasing the f-stop to broaden depth of field

Focal plane in same location, f-stop increased to 1.0.

You set the f-Stop in the camera's Depth Of Field rollout. See Depth of Field
Parameter (mental ray Renderer) on page 5142 .

NOTE For Perspective viewports, which have no camera, the Render Scene dialog
> Renderer panel > Camera Effects rollout on page 6087  has explicit Focus Plane
and f-Stop settings.

Caustic Lighting Effects

Caustics are the effects of light cast onto an object via reflection off or
refraction through another object.
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Swimming pool rendered without caustics
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Reflective caustics added to swimming pool

To calculate caustics, the mental ray renderer uses the photon map technique
on page 7894 . (Ray tracing can’t generate accurate caustics, and they aren’t
provided by the default scanline renderer.)

You enable caustics on the Render Scene dialog > Indirect Illumination panel
> Caustics And Global Illumination rollout on page 6099 . In addition, you
must designate:

■ Which light objects can create caustics.

■ Which renderable objects can generate caustics.

■ Which renderable objects can receive caustics.

The settings for generating and receiving caustics are on the Object Properties
dialog > mental ray Panel on page 262 .
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Refractive caustics rendered with the default of Radius turned off.

Radius size is based on scene extents; specifically, 1/100 the radius of the full scene.
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Radius value explicitly set to 1.0
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Radius value increased to 2.5.

Filter type changed to Cone.
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Photon count increased to 50,000 (in Global Light Properties group) for greater detail
in the caustics.

Global Illumination with the mental ray Renderer

Global illumination enhances the realism in rendered images by simulating
all light interreflection effects in a scene (except caustics on page 6066 ). It
generates such effects as "color bleeding," where for example, a white shirt
next to a red wall appears to have a slight red tint.

The mental ray renderer offers two distinct toolsets for achieving global
illumination: photon tracing on page 6100  and final gathering on page 6104 .
The primary difference between the two is that photon tracing goes from the
light source toward the ultimate illuminated target (taking bounces into
account), and final gathering goes the opposite way: from the illuminated
surface toward the light source. You can use either of these toolsets separately,
or combine them for optimal rendered results.
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Scene rendered without global illumination
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Same scene with global illumination
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Global illumination made smoother by final gather

To calculate global illumination, the mental ray renderer uses the photon
map technique on page 7894 .

NOTE The mental ray renderer generates global illumination without requiring
you to generate a radiosity solution. A photon map is a model of global illumination
in its own right.

NOTE In order to use global illumination in mental ray, the photons must be able
to bounce among two or more surfaces. This can be accomplished by having a
single object with some concavity in its surface that’s exposed to the light source,
or at least two objects, and at least one object must be set to receive global
illumination (see mental ray Panel (Object Properties Dialog) on page 262 ).
Otherwise you’ll receive error messages and no photons will be stored.

Using a photon map can cause rendering artifacts such as dark corners and
low-frequency variations in the lighting. You can reduce or eliminate these
artifacts by turning on final gathering on page 6104 , which increases the number
of rays used to calculate global illumination.

You enable global illumination on the Render Scene dialog > Indirect
Illumination panel > Caustics And Global Illumination rollout on page 6096 ,
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and final gathering on the Final Gather rollout on page 6104 . In addition, you
must designate:

■ Which light objects can generate global illumination.

■ Which renderable objects can generate global illumination.

■ Which renderable objects can receive global illumination.

The settings for generating and receiving global illumination are on the Object
Properties dialog > mental ray Panel on page 262 . By default, all objects in
3ds Max are set to generate and receive global illumination.

mental ray Volume Shading

Volume shading shades a three-dimensional volume, rather than a surface.
Typically, volume shaders provide atmospheric effects such as mist and fog.

Model rendered with no volume effect
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Same model rendered in mist

Mist applied as a camera volume shader; realistic falloff on

There are two ways to assign a volume shader:

■ To a camera
This effectively makes the entire scene a single volume.

■ To a material
This makes a volume out of objects to which the material is applied.

Usually when you assign a volume shader to a material, you want to make
its surface transparent so the shading within the volume is visible. You
can do this with the mental images  Transmat shader .

To assign a volume shader to a camera, use the Render Scene dialog. To assign
a volume shader to a material, use the material's Volume shader component.
This component is found on the mental ray Connection rollout on page 5289
, and in the mental ray material on page 5449  itself. See the “Procedures” that
follow.
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Procedures

To apply volume shading to a camera:

1  On the Render toolbar, click Render Scene.

If the active renderer is not already the mental ray renderer, go to the
Common panel, and on the Assign Renderer rollout, click the “...” button
for the Production renderer. A Choose Renderer dialog is displayed.
Highlight “mental ray Renderer” in the list, and then click OK.

2 Click the Renderer tab to go to the Renderer panel. On the Camera Effects
rollout, find the Camera Shaders group, and click Volume.

The Material/Map Browser on page 5194  is displayed.

3 Choose a volume shader from the list in the Browser, and then click OK.

To apply volume shading to an object:

1 Choose Customize > Preferences. Go to the mental ray panel, and turn
on Enable Mental Ray Extensions.

2  On the Render toolbar, click Render Scene.

If the active renderer is not already the mental ray renderer, go to the
Common panel, and on the Assign Renderer rollout, click the “...” button
for the Production renderer. A Choose Renderer dialog is displayed.
Highlight “mental ray Renderer” in the list, and then click OK.

Leave the Render Scene dialog open, or minimize it.

3  Open the Material Editor. Use the mental ray Connection rollout
on page 5289  to assign a volume shader to the Volume component.

Another technique would be to use the mental ray material on page 5449
, and assign a shader to the Volume component.

4  Also on the mental ray Connection rollout, click to unlock the
Surface component. Click the button and use the Browser to assign the
Transmat (physics) shader to the surface.

(If you are using the mental ray material, you don't need to first unlock
the Surface component.)
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5 Apply the material to objects you wish to use as shaded volumes.

mental ray Displacement

Displacement shading with the mental ray renderer is similar to displacement
mapping on page 5391  of standard materials. One advantage of using mental
ray displacement is that the additional polygons of displaced surfaces are
stored only in the mental ray scene database, not in your 3ds Max scene, so
they do not increase the memory requirements of your scene, except at render
time. This can be a big improvement in performance over displacement
mapping with standard materials and the scanline renderer.

Procedures

To add displacement to a mental ray rendering:

1 Choose Customize > Preferences. Go to the mental ray panel, and turn
on Enable Mental Ray Extensions.

2  On the Render toolbar, click Render Scene.

If the active renderer is not already the mental ray renderer, go to the
Common panel, and on the Assign Renderer rollout, click the “...” button
for the Production renderer. A Choose Renderer dialog is displayed.
Highlight “mental ray Renderer” in the list, and then click OK.

Leave the Render Scene dialog open, or minimize it.

3  Open the Material Editor.

4  On the mental ray Connection rollout, click to unlock the
Displacement component. Click the button and use the Browser to assign
a displacement shader to the surface.

WARNING This overrides any displacement assigned to the base material as
a standard map.

Another technique would be to use the mental ray material on page 5449
, and assign a shader to the Displacement component. (If you are using
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the mental ray material, you don't need to first unlock the Displacement
component.)

5 Apply the material to objects you wish to show the displacement.

mental ray Contour Shading

Contour shading lets you render vector-based contour lines. Contours are
similar to the ink component of the Ink 'n Paint material.

Model rendered without contours
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Model with contours added to the rendering

Simple contour shader

You add contour rendering by assigning one of the contour shaders to the
Contour component of a material. (This component is found on the mental
ray Connection rollout on page 5289  and on the mental ray material's Advanced
Shaders rollout on page 5456 ). Then when you render, use the Camera Effects
rollout on page 6087  to enable contours.

On the Camera Effects rollout, additional shaders can modify the contours,
or control how they are rendered. For example, if you assign a Contour Only
shader to the Contour Output component, the rendering consists of just the
contours, and not the shaded model.

Rendering of the model's contours only

Contours Only output shader, background set to white
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NOTE Contour shading does not work with distributed bucket rendering.

Procedures

To add contours to a mental ray rendering:

1 Choose Customize > Preferences. Go to the mental ray panel, and turn
on Enable Mental Ray Extensions.

2  On the Render toolbar, click Render Scene.

If the active renderer is not already the mental ray renderer, go to the
Common panel, and on the Assign Renderer rollout, click the “...” button
for the Production renderer. A Choose Renderer dialog is displayed.
Highlight “mental ray Renderer” in the list, and then click OK.

Leave the Render Scene dialog open, or minimize it.

3  Open the Material Editor. For the materials of objects you want to
render with contours, use the mental ray Connection rollout on page
5289  to assign a shader to the Contour component.

Another technique would be to use the mental ray material on page 5449
, and assign shaders to both the Surface and Contour components.

TIP The  Simple contour shader  renders uniform lines whose color and width
you can control. The other contour shaders provide variant contour styles
with more direct user controls.

4 On the Render Scene dialog, go to the Renderer panel. On the Camera
Effects rollout, turn on Enable in the Contours group.

To simply add contour lines to a rendering, leave the shaders in the
Camera Effects rollout set to their defaults. For other options, see Camera
Effects Rollout (mental ray Renderer) on page 6087 .
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mental ray Renderer Rollouts

Sampling Quality Rollout (mental ray Renderer)

Rendering menu > Render > Render Scene dialog > Renderer panel > Sampling
Quality rollout

Main toolbar > Render Scene > Render Scene dialog > Renderer panel >
Sampling Quality rollout

Note: The Renderer panel appears only when the mental ray renderer is the
currently active renderer.

The controls in this rollout affect how the mental ray renderer performs
sampling on page 7914 .

Procedures

To use low sampling for previews:

■ Leave the Minimum and Maximum values at their default settings of 1/4
and 4, or reduce them to 1/16 and 1/4.

TIP Do not assign Minimum and Maximum the same value.

To use high sampling for final renderings:

■ Increase the Minimum and Maximum values to 4 and 16, respectively, or
to higher values.

TIP Do not assign the same value to both Minimum and Maximum.

To view the pattern of sampling:

■ On the Diagnostics rollout on page 6129 , choose Sampling Rate, then render
the scene.
Instead of rendering the image, mental ray draws a diagram that shows
the range of applied sampling values. White lines indicate edges in the
scene, where the mental ray renderer took the maximum number of
samples. If fractional sample limits are used (sampling down), lighter dots
indicate the higher value while darker dots indicate the lower value.
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To assist with analysis, View Samples also draws red lines around each
bucket, or separately rendered block.

When the Minimum and Maximum number of samples are equal, the
diagram shows all buckets as white.

Interface

Samples per Pixel group

Set the minimum and maximum sample rate.

Minimum Sets the minimum sample rate. The value represents the number
of samples per pixel. A value greater than or equal to 1 indicates that one or
more samples are computed per pixel. A fractional value indicates that one
sample is computed for every N pixels (for example, 1/4 computes a minimum
of one sample for every four pixels). Default=1/4.

Maximum Sets the maximum sample rate. If neighboring samples find a
difference in contrast that exceeds the contrast limit, the area containing the
contrast is subdivided to the depth specified by Maximum. Default=4.

The values of the Minimum and Maximum lists are "locked" together so that
the value of Minimum can't exceed the value of Maximum.
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Filter group

Filter type Determines how multiple samples are combined into a single
pixel value. Can be set to Box, Gauss, Triangle, Mitchell, or Lanczos.
Default=Box.

TIP For most scenes the Mitchell filter gives the best results.

■ Box filter: Sums all samples in the filter area with equal weight. This is the
quickest sampling method.

■ Gauss filter: Weights the samples using a Gauss (bell) curve centered on
the pixel.

■ Triangle filter: Weights the samples using a pyramid centered on the pixel.

■ Mitchell filter: Weights the samples using a curve (steeper than Gauss)
centered on the pixel.

■ Lanczos filter: Weights the samples using a curve (steeper than Gauss)
centered on the pixel, diminishing the effect of samples at the edge of the
filter area.

Width and Height Specify the size of the filtered area. Increasing the value
of Width and Height can soften the image, however it will increase rendering
time.

Default=Depends on the Filter type you choose:

■ Box filter: Width=1.0, Height=1.0

■ Gauss filter: Width=3.0, Height=3.0

■ Triangle filter: Width=2.0, Height=2.0

■ Mitchell filter: Width=4.0, Height=4.0

■ Lanczos filter: Width=4.0, Height=4.0

Spatial Contrast group

This control sets the contrast value used as thresholds to control sampling.
Spatial contrast applies to each still image.

If neighboring samples in a frame differ by more than this color, the mental
ray renderer does recursive supersampling (that is, more than one sample per
pixel), up to the depth specified by the Maximum samples per pixel on page
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6084  value. Increasing the Spatial Contrast values decreases the amount of
sampling done, and can speed the rendering of a scene at the cost of image
quality.

■ R, G, B Specify the threshold values for the red, green, and blue
components of samples. These values are normalized, and range from 0.0
to 1.0, where 0.0 indicates the color component is fully unsaturated (black,
or 0 in eight-bit encoding) and 1.0 indicates the color component is fully
saturated (white, or 255 in eight-bit encoding). Default=(0.051, 0.051,
0.051).

■ A Specifies the threshold value for the alpha component of samples. This
value is normalized, and ranges from 0.0 (fully transparent, or 0 in eight-bit
encoding) to 1.0 (fully opaque, or 255 in eight-bit encoding). Default=0.05.

■ Color swatch Click to display a Color Selector on page 331  to let you
specify the R, G, and B threshold values interactively.

Options group

Lock Samples When on, the mental ray renderer uses the same sampling
pattern for every frame of an animation. When off, the mental ray renderer
introduces a quasi-random (Monte Carlo) variation in the sample pattern from
frame to frame. Default=on.

Varying the sample pattern reduces rendering artifacts in animations.

Jitter Introduces a variation into sample locations; see Sampling on page
7914 . Turning on Jitter can help reduce aliasing. Default=off.

Bucket Width Determines the size of each bucket in pixels. Range=4 to 512
pixels. Default=48 pixels.

To render the scene, the mental ray renderer subdivides the image into
rectangular sections, or “buckets.” Using a smaller bucket size causes more
image updates to be generated during rendering. Updating the image consumes
a certain amount of CPU cycles. For scenes with little complexity, smaller
buckets can increase the rendering time, while larger buckets can make things
render faster. For more complex scenes, the reverse is true.

Bucket Order Lets you specify the method by which mental ray chooses the
next bucket. If you are using placeholders or distributed rendering, use the
default Hilbert order. Otherwise, you can choose a method based on how you
prefer to see the image appear as it renders in the rendered frame window.

■ Hilbert (best) (The default.) The next bucket chosen is the one that will
trigger the fewest data transfers.
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TIP Always use Hilbert order when you use placeholders (see the Translator
Options rollout on page 6122 ) or distributed rendering (see the Distributed
Bucket Rendering rollout on page 6131 ).

■ Spiral The buckets begin at the center of the image, and spiral outward.

■ Left to right Buckets are rendered in columns, from bottom to top, left
to right.

■ Right to left Buckets are rendered in columns, from bottom to top, right
to left.

■ Top-down Buckets are rendered in rows, from right to left, top to bottom.

■ Bottom-up Buckets are rendered in rows, from right to left, bottom to
top.

Frame Buffer Type Lets you choose the bit depth of the output frame buffer:

■ Integer (16 bits per channel) Outputs 16 bits per channel of color
information. This is the default output format.

■ Floating-Point (32 bits per channel) Outputs 32 bits per channel of color
information. This method supports high-dynamic-range imagery (HDRI).

Camera Effects Rollout (mental ray Renderer)

Rendering menu > Render > Render Scene dialog > Renderer panel > Camera
Effects rollout

Main toolbar > Render Scene > Render Scene dialog > Renderer panel > Camera
Effects rollout

Note: The Renderer panel appears only when the mental ray renderer is the
currently active renderer.

The controls in this rollout are for the camera effects depth of field on page
6061  and motion blur on page 6059 , as well as for contour shading on page 6080
and adding camera shaders.
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Procedures

To use depth of field for a Camera view:

1 On the camera’s Parameters rollout, in the Multi-Pass Effect group, turn
on Enable and choose Depth Of Field (mental ray).

2 Set the camera’s target distance to the range at which you want objects
to be clearly in focus.

For a Target camera, you can select the camera’s target object and move
it. For a Free camera, you adjust the Target Distance on the Parameters
rollout.

3 On the Camera’s Depth Of Field rollout, decrease the f-Stop value to
narrow the depth of field, or increase the f-Stop value to broaden the
depth of field.

You might need to experiment with f-Stop values to get the effect you
want.

4 Render the scene.

To use depth of field for a Perspective view:

1 On the Render Scene dialog, go to the Renderer panel > Camera Effects
rollout, and in the Depth Of Field (Perspective Views Only) group, turn
on Enable.

2 Set the Focus Plane distance to the range at which you want objects to
be clearly in focus.

3 Decrease the f-Stop value to narrow the depth of field, or increase the
f-Stop value to broaden the depth of field.

You might need to experiment with f-Stop values to get the effect you
want. If you have trouble getting good results with f-Stop, use the
drop-down list to change the method to In Focus Limits, then adjust the
Near and Far values to enclose the region of the scene you want to be
clearly in focus.

4 Render the scene.

To use motion blur:

1 Select each object you want to be blurred by motion, right-click and
choose Properties, then on the Object Properties dialog > General panel,
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make sure that in the Motion Blur group, Enable is turned on and Object
is chosen.

The mental ray renderer won't generate motion blur if Image is the chosen
type.

2 On the Render Scene dialog, go to the Renderer panel > Camera Effects
rollout, and in the Motion Blur group turn on Enable.

NOTE With the mental ray renderer, don't use Motion Blur under the
Multi-Pass Effect group of a camera's Parameters rollout.

3 Increase the Shutter value to increase the blurriness caused by motion
blur.

4 On the Render Scene dialog, go to the Rendering Algorithms rollout, and
make sure Ray Trace is turned on.

Motion blur is not rendered when the mental ray renderer uses scanlines
only.

5 Render the scene.

To render with contours:

1 Use the mental ray Connection rollout to assign a contour shader to an
object's material.

The mental ray material also lets you assign a contour shader.

2 On the Render Scene dialog > Renderer panel > Camera Effects rollout,
in the Contours group, turn on Enable.

3 Change the contour output shader if you so desire.

NOTE By default, only one contour contrast and store shader are provided
with 3ds Max. You can adjust the contour contrast shader's settings; the
contrast store shader has no parameters.

4 Render the scene.
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To change a contour output shader:

NOTE By default, only one contour contrast and store shader are provided with
3ds Max. You can adjust the contour contrast shader's settings; the contour store
shader has no parameters.

1 Click the button for the Contour Output shader.

The Material/Map Browser is displayed.

2 Choose a contour output shader from the Browser list, and then click
OK.

To assign a camera shader:

1 Click the button for a camera Lens, Output, or Volume shader.

The Material/Map Browser is displayed.

2 Choose a shader from the Browser list, and then click OK.

To adjust the settings for a contour or camera shader assigned on this rollout:

1  Open the Material Editor.

If you need to, arrange the open dialogs so you can see the Material Editor
and the Render Scene dialog at the same time.

2 Drag the shader button from the Render Scene dialog to an unused sample
slot in the Material Editor.

An Instance (Copy) Map dialog is displayed. Be sure to choose Instance, and
then click OK.

If you don't choose Instance, changes you make to the shader settings in
the Material Editor won't have any effect on the Render Scene dialog.

TIP If you forgot to choose Instance, change the shader settings as you
choose, and then drag the shader's sample slot or its Type button back to
the button in the Render Scene dialog, to update the Render Scene dialog's
copy of the shader.

The Material Editor displays the shader's parameters rollout.

3 Adjust the parameters.
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Interface

Motion Blur group

TIP mental ray motion blur is not recommended for use with particle systems, as
this can increase rendering time considerably. Use a Particle MBlur map on page
5729  instead.

NOTE Motion blur with the mental ray renderer does not always follow curving
trajectories. Increasing the value of Motion Segments can help, but this works
better for rotary motion than for traveling motion.

The Toggle (lower-right) quad of the rendering quad menu (Ctrl+Alt+right-click)
has a Motion Blur toggle for a single, selected object. You can turn on Motion
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Blur for lights and cameras: moving lights and cameras can generate motion
blur when rendered with mental ray.

Enable When on, the mental ray renderer calculates motion blur on page
6059 . Default=off.

Blur All Objects Applies motion blur to all objects, regardless of their object
property setting. Default=on.

Shutter Duration (frames) Simulates the shutter speed of a camera. At 0.0,
there is no motion blurring. The greater the Shutter Duration value, the greater
the blurring. Default=0.5.

Shutter Offset (frames) Sets the beginning of the motion-blur effect relative
to the current frame. The default value, 0.0, centers the blurring around the
current frame for a photorealistic effect. Default=–0.25.

Motion Segments Sets the number of segments for calculating motion blur.
This control is for animations. If motion blur appears to be tangential to the
actual motion of an object, increase the Motion Segments value. Larger values
result in more accurate motion blur, at a cost of rendering time. Default=1.

Time Samples When the scene uses motion blur, controls the number of
times the material is shaded during each time interval (set by Shutter Duration
on page 6092 ). Range=0 to 100. Default=5.

By default, the material is shaded only once, and then blurred. If the material
changes rapidly during the shutter interval, it might be useful to increase this
value, in order to obtain more accurate motion blur. Rapid changes in
reflections or refractions might require a higher Time Samples value.

NOTE When Rendering Algorithms rollout > Use Fast Rasterizer on page 6120  is
on, the label for this parameter changes to Time Samples (Fast Rasterizer) to
indicate that this version of Time Samples is now in effect. The default value for
the Fast Rasterizer version of Time Samples is 1, and the range is 1 to 128. If you
change the value for either version, the software remembers the changed setting
when you switch.

Contours group

These controls enable contours, and let you use shaders to adjust the results
of a contour shader. You assign the primary contour shader to the Contour
component of the mental ray Connection rollout on page 5289  or a mental
ray material (see Advanced Shaders Rollout (mental ray Material) on page 5456
).
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NOTE Contour shading does not work with distributed bucket rendering.

Enable When on enables rendering of contours. Default=off.

Click a button to change a shader assignment for adjusting contours. A default
is already assigned to the three components, as the button labels indicate.

Contour Contrast The contour contrast component can be assigned the
following shader:

LibraryShader

contourContour Contrast Function Levels

Contour Store This component stores the data on which contours are based.
It can be assigned the following shader, which has no parameters to set:

LibraryShader

contourContour Store Function

Contour Output The contour output component can be assigned one of
these shaders:

LibraryShader

contourContour Composite

contourContour Only

contourContour PS (PostScript)

To adjust the settings for a shader assigned to one of these components, drag
the shader's button to an unused Material Editor sample slot. Be sure to choose
Instance when prompted to use an instance or a copy. (If you edit a copy of
the shader, you will have to drag the sample slot back to the shader button
on the Camera Effects rollout before you see any changes take effect.)

Camera Shaders group

These controls let you assign mental ray camera shaders. Click a button to
assign a shader to that component. After a shader is assigned, its name appears

mental ray Renderer | 6093



on the button. Use the toggle on the left to temporarily disable a shader that
has been assigned.

Lens Click to assign a lens shader. This component can be assigned one of
these shaders:

LibraryShader

lumeDistortion

lumeNight

3ds MaxShader List on page 5830  (Lens)

lumeWrap Around

Output Click to assign a camera output shader. These are the output shaders
you can assign:

LibraryShader

lumeGlare Shader (mental ray) on page 5825

lumeShader List on page 5830  (Output)

Volume Click to assign a volume shader to the camera. These are the volume
shaders you can assign:

LibraryShader

lumeBeam

3ds MaxMaterial to Shader on page 5829

lumeMist

physicsParti Volume

3ds MaxShader List on page 5830  (Volume)
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LibraryShader

lumeSubmerge

NOTE You can also assign Volume shaders to the Volume component of the
mental ray Connection rollout on page 5289  and the mental ray material (see
Material Shaders Rollout (mental ray Material) on page 5449 ).

Depth of Field (Perspective Views Only) group

These controls are comparable to the depth-of-field controls for cameras. They
apply only to Perspective viewports. You can render depth-of-field effects for
either Camera or Perspective views. Depth-of-field effects don’t appear when
you render orthographic viewports.

For a Perspective view, use the controls in this group. For a Camera view,
choose “Depth Of Field (mental ray)” as the multi-pass rendering effect, then
adjust the f-Stop setting. See Depth of Field Parameter (mental ray Renderer)
on page 5142 .

Enable When on, the mental ray renderer calculates depth-of-field on page
6061  effects when rendering a Perspective view. Default=off.

[method drop-down list] Lets you choose the method for controlling
depth-of-field. Default=f-Stop.

■ f-Stop Controls depth-of-field with the f-Stop setting.

■ In Focus Limits Controls depth-of-field with the Near and Far values.

In most cases, the f-Stop method is easier to use. The In Focus Limits method
can help when the scale of objects in the scene makes it difficult to control
depth of field using the f-Stop value alone.

Focus Plane For Perspective viewports, sets the distance from the camera, in
3ds Max units, at which the scene is completely in focus. Default=100.0.

For Camera viewports, the focus plane is set by the camera's target distance.

f-Stop When f-Stop is the active method, sets the f-stop for use when you
render Perspective views. Increasing the f-stop value broadens the depth of
field, and decreasing the f-stop value narrows the depth of field. Default=1.0.

The f-Stop can have a value less than 1.0. This is not realistic in terms of an
actual camera, but it can help you adjust the depth of field for scenes whose
scale does not use realistic units.
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Near and Far When In Focus Limits is the active method, these values set
the range, in 3ds Max units, within which objects are in focus. Objects lose
focus when they are closer than the Near value or farther than the Far value.
These values are approximate, because the transition from in-focus to
out-of-focus is gradual, not abrupt.

The Near and Far values are related to each other and to the value of Focus
Plane. Changing the value of Near changes Far as well, and vice versa.
Specifically, if

H = Hyperfocal distance, the Focus Plane value at which the Far limit becomes
infinity

D = The Focus Plane distance

Dn = The Near distance

Df = The Far distance

Then

Dn = HD / (H + D)

Df = HD / (H − D)

Caustics and Global Illumination Rollout (mental
ray Renderer)

Rendering menu > Render > Render Scene dialog > Indirect Illumination panel
> Caustics and Global Illumination rollout

Main toolbar > Render Scene > Render Scene dialog > Indirect Illumination
panel > Caustics and Global Illumination rollout

Note: The Indirect Illumination panel appears only when the mental ray
renderer is the active renderer.

The controls in this rollout are for the effects of caustics on page 6066  and
global illumination on page 6072 .
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Procedures

To render with caustics:

1 Select each object you want to generate caustics, either by reflection or
refraction. Right-click and choose Properties, then on the mental ray
panel of the Object Properties dialog, turn on Generate Caustics.

Objects receive caustics by default. If you think this value might have
changed for the objects you want to receive caustics, use those objects’
Object Properties dialog to make sure Receive Caustics is turned on. Also,
to speed rendering time, you might want to turn off Receive Caustics for
those objects that don’t need to show them.

2 In the Render Scene dialog, go to the Caustics And Global Illumination
rollout and turn on Caustics.

3 Adjust the caustics parameters to get the effect you want.

4 Render the scene.

To render with global illumination:

Objects generate and receive global illumination by default. If you think these
settings might have changed for any objects in the scene, use the Object
Properties dialog to make sure the proper settings are enabled.

1 Select each object you want to generate and/or receive global illumination.
Right-click and choose Properties, then on the mental ray panel of the
Object Properties dialog, turn on Generate Global Illumination and/or
Receive Global Illumination. Also, to speed rendering time, you might
want to turn off Receive Global Illumination for those objects that don’t
need it.

2 In the Render Scene dialog, go to the Indirect Illumination panel >
Caustics And Global Illumination rollout > Global Illumination (GI)
group and turn on Enable.

3 Adjust the global illumination parameters to get the effect you want.

4 For the final rendering, turn on Final Gather as well as Global
Illumination. See Final Gather Rollout (mental ray Renderer) on page
6104 .

5 Render the scene.
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Caustics group

IMPORTANT For caustics to render, you must also make sure to set up these other
conditions in your scene:

■ At least one object must be set to generate caustics. This is off by default.

■ At least one object must be set to receive caustics. This is on by default.

■ At least one light must be set to generate caustics. This is off by default.

The settings for generating and receiving caustics are located on the Object
Properties dialog > mental ray Panel on page 262 .

Enable When on, the mental ray renderer calculates caustics effects.
Default=off.

Multiplier/color swatch Use these to control the intensity and color of the
indirect light accumulated by caustics. The defaults, 1.0 and white, produce
physically correct rendering.

This is useful for adjusting the contribution of the caustics effect, thus
improving the quality of an image.

Maximum Num. Photons per Sample Sets how many photons are used to
compute the intensity of the caustic. Increasing this value makes caustics less
noisy but also more blurry. Decreasing this value makes caustics more noisy
but less blurry. The larger the Samples value, the greater the rendering time.
Default=100.

TIP To preview a caustic, set Samples to 20, then increase the value for a final
rendering.

Maximum Sampling Radius When on, the spinner value sets the size of
photons. When off, each photon is calculated to be 1/100 of the radius of the
full scene. Maximum Sampling Radius default=off; value default=1.0.

In many cases, the default photon size (Radius=off) of 1/100 the scene size
gives useful results. In other cases, the default photon size might be too large
or too small.

When photon reflections overlap, the mental ray renderer uses sampling to
smooth them together. Increasing the number of samples increases the amount
of smoothing and can create more natural-looking caustics. When photons
have a small radius and don't overlap, the Samples setting has no effect. Low
Radius values with a large number of photons result in dotty caustics.
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Filter Sets the filter to use for sharpening caustics. Can equal Box, Cone, or
Gauss. The Box option requires less rendering time. The Cone option makes
caustics appear sharper. Default=Box.

The Gauss filter uses a Gauss (bell) curve, and can be smoother than the Cone
filter.

Filter Size Controls the sharpness of caustics when you choose Cone as the
caustic filter. This value must be greater than 1.0. Increasing the value makes
caustics more blurry. Decreasing the value makes caustics sharper, but also
slightly more noisy. Default=1.1.

Opaque Shadows when Caustics Are Enabled When on, shadows are opaque.
When off, shadows can be partially transparent. Default=on.

Opaque shadows render more quickly than transparent shadows.

Global Illumination (GI) group

These settings let you control the usage of photons by mental ray for generating
global illumination on page 6072 . By default, all objects generate and receive
global illumination. The settings for generating and receiving GI are located
on the Object Properties dialog > mental ray Panel on page 262 .

NOTE In order to render global illumination in mental ray, the photons must be
able to bounce among two or more surfaces. This can be accomplished by having
a single object with some concavity in its surface that’s exposed to the light source,
or at least two objects, and at least one object must be set to receive global
illumination (see mental ray Panel (Object Properties Dialog) on page 262 ).
Otherwise you’ll receive error messages and no photons will be stored.

Enable When on, the mental ray renderer calculates global illumination.
Default=off.

Multiplier/color swatch Use these to control the intensity and color of the
indirect light accumulated by global illumination. The defaults, 1.0 and white,
produce physically correct rendering.

This is useful for adjusting the contribution of the GI effect, thus improving
the quality of an image.

Maximum Num. Photons per Sample Sets how many photons are used to
compute the intensity of the global illumination. Increasing this value makes
global illumination less noisy but also more blurry. Decreasing this value
makes global illumination more noisy but less blurry. The larger the Samples
value, the greater the rendering time. Default=500.

6100 | Chapter 18   Rendering



TIP To preview global illumination, set Samples to 100, then increase the value
for a final rendering.

Maximum Sampling Radius When on, the spinner value sets the size of
photons. When off, each photon is calculated to be 1/10 of the radius of the
full scene. Default=off, 1.0.

In many cases, the default photon size (Maximum Sampling Radius=off) of
one-tenth the scene size gives useful results. In other cases, the default photon
size might be too large or too small.

When photons overlap, the mental ray renderer uses sampling to smooth
them together. Increasing the number of samples increases the amount of
smoothing and can create more natural-looking caustics. When photons have
a small radius and don't overlap, the Samples setting has no effect. For global
illumination, photons should overlap. To get good results, you might need
to turn on Maximum Sampling Radius and increase the photon size.

Merge Nearby Photons (saves memory) Enables reduction of the memory
footprint of the photon map. When on, use the numeric field to specify the
distance threshold below which mental ray merges photons. The result is a
smoother, less-detailed photon map that uses significantly less memory.
Default=off, 0.0.

NOTE Loading a legacy file uses the default value of 0.0. Also, using a value of
0.0 is equivalent to turning the feature off.

Optimize for Final Gather (Slower GI) If turned on before you render the
scene, the mental ray renderer computes information to speed up the
regathering process. Specifically, each photon stores additional information
about how bright its neighbors are. This is particularly useful when combining
Final Gather with Global Illumination, in which case the additional
information allows Final Gather to quickly determine how many photons
exist in a region. The fast lookup computation can take a long time, but it can
greatly reduce the total rendering time. Default=off.

The fast lookup computation can be can be stored as additional data inside a
photon map file on page 7897 , and then reused in subsequent renderings.

Volumes group

The controls in this group and the ones that follow are for the photon maps
on page 7894  used to calculate caustics and global illumination. This group
controls volumetric caustics. Volumetric caustics require a material to have a
volume shader assign to its Photon Volume component.
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Maximum Num. Photons per Sample Sets how many photons are used to
shade the volume. Default=100.

Maximum Sampling Radius When the check box is on, the spinner sets the
size of photons. When off, each photon is calculated to be one-tenth the size
of the scene extents on page 7919 . Default: check box=off; value=1.0.

This spinner is unavailable if the check box is turned off.

Photon Map group

These controls tell mental ray how to calculate the photon map for indirect
illumination.

NOTE If you've specified a photon map here, mental ray continues to use that
map instead of generating a new one. To cause the photon map file to be rebuilt,
delete the existing file.

Read/Write File When on, if the specified photon map ( PMAP on page 7897
) file does not yet exist, mental ray generates a new map file when rendering.
If the specified file does exist, mental ray loads and uses the file.

This option becomes available after you click Browse (“...”) and provide a
name for the PMAP file.

... [browse] Click to display a file selector dialog, which lets you specify a
name and path for the photon map (PMAP) file. This automatically turns on
Read/Write File.

[file name] When you have used the [...] button to specify a photon map
file, this field displays its name and path.

Delete File Click to delete the current PMAP file.

Trace Depth group

The Trace Depth controls are similar to those for calculating reflections and
refractions, but they refer to the photons used by caustics and global
illumination, rather than to rays used in diffuse reflection and refraction.

Max. Depth Limits the combination of reflection and refraction. Reflection
and refraction of a photon stop when the total number of both equals the
Maximum Depth setting. For example, if Maximum Depth equals 3 and the
trace depths each equal 2, a photon can be reflected twice and refracted once,
or vice versa, but it can’t be reflected and refracted four times. Default=5.
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Max. Reflections Sets the number of times a photon can be reflected. At 0,
no reflection occurs. At 1, the photon can be reflected once only. At 2, the
photon can be reflected twice, and so on. Default=5.

Max. Refractions Sets the number of times a photon can be refracted. At 0,
no refraction occurs. At 1, the photon can be refracted once only. At 2, the
photon can be refracted twice, and so on. Default=5.

Light Properties group

Controls in this group affect how lights behave when calculating indirect
illumination. By default, the energy and photon settings apply to all lights in
a scene. Use the mental ray Indirect Illumination rollout on page 5060  for light
objects to adjust an individual light either by multiplying the global values,
or by setting local values (using multipliers is the recommended method).

Average Caustic Photons per Light Sets the number of photons emitted by
each light for use in caustics. This is the number of photons in the photon
map on page 7894  used for caustics. Increasing this value increases the accuracy
of caustics, but also increases the amount of memory used and the length of
render time. Decreasing this value improves memory usage and render time,
and can be useful for previewing caustic effects. Default=10000.

Average GI Photons per Light Sets the number of photons emitted by each
light for use in global illumination. This is the number of photons in the
photon map used for global illumination. Increasing this value increases the
accuracy of global illumination, but also increases the amount of memory
used and the length of render time. Decreasing this value improves memory
usage and render time, and can be useful for previewing global-illumination
effects. Default=10000.

Decay Specifies how photon energy decays as it moves away from each light
source. This value is given by 1/(distance decay ), where distance is the distance
between the light source and an object, and decay is the value of this setting.
Default=2.0.

The most common values are:

■ 0.0 The energy doesn't decay, and photons can provide indirect
illumination throughout the scene.

■ 1.0 The energy decays at a linear rate, proportionally to its distance from
the light. That is, a photon's energy is 1/distance, where distance is the
distance from the light source.
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■ 2.0 (The default.) The energy decays at an inverse square rate. That is, a
photon's energy is the inverse of the square of the distance from the light
source: 1/distance 2.

In the real world, light decays at an inverse square rate (Decay=2.0), but this
gives strictly realistic results only if you provide a realistic value for the energy
of the light. Other values of Decay can help you adjust indirect illumination
without worrying about physical accuracy.

NOTE Decay values of less than 1.0 are not recommended, and can cause
rendering artifacts.

Geometry Properties group

All Objects Generate & Receive GI and Caustics When on, at rendering time,
all objects in the scene can generate and receive caustics and global
illumination, regardless of their local object properties settings. When off, an
object's local object properties determine whether it generates or receives
caustics or global illumination. Turning this on is an easy way to ensure that
caustics and global illumination are generated, though it can increase rendering
time. Default=off.

This setting does not alter the object's local object properties settings for mental
ray. When you turn off All Objects Generate & Receive GI And Caustics, the
prior object properties settings are in effect once again.

Final Gather Rollout (mental ray Renderer)

Rendering menu > Render > Render Scene dialog > Indirect Illumination panel
> Final Gather rollout

Main toolbar > Render Scene > Render Scene dialog > Indirect Illumination
panel > Final Gather rollout

Note: The Indirect Illumination panel appears only when the mental ray
renderer is the currently active renderer.

Final gathering is a technique for estimating global illumination for a given
point by either sampling a number of directions over the hemisphere over
that point (such a set of samples is called a final gather point), or by averaging
a number of nearby final gather points since final gather points are too
expensive to compute for every illuminated point. In the former case, the
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hemisphere orientation is determined by the surface normal of the triangle
on whose surface the point lies.

For diffuse scenes, final gathering often improves the quality of the global
illumination solution. Without final gathering, the global illumination on a
diffuse surface is computed by estimating the photon density (and energy)
near that point. With final gathering, many new rays are sent out to sample
the hemisphere above the point to determine the incident illumination. Some
of these rays strike diffuse surfaces, and the global illumination at those points
is then computed by the material shaders at these point, using illumination
from the photon map, if available, and from other material properties. Other
rays strike specular surfaces and do not contribute to the final gather color
(since that type of light transport is a secondary caustic). Tracing many rays
(each with a photon map lookup) is very time-consuming, so it is done only
when necessary. In most cases, interpolation and extrapolation from previous
nearby final gathers is sufficient.

Final gathering is also useful without photon tracing; this takes only
first-bounce indirect light into account but often gives good results where
complete physical accuracy is not required.

Interior rendered with final gathering only

Final gathering is useful in scenes with slow variation in the indirect
illumination, such as purely diffuse scenes. For such scenes, final gathering
eliminates photon map artifacts such as low-frequency noise and dark corners.
With final gathering, fewer photons are needed in the photon map and,
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because each final gather averages over many values of indirect illumination,
lower accuracy is sufficient.

In film production work, final gathering increasingly replaces photon mapping,
except for caustics. Without multiple-bounce effects, which are performed by
photons by default and by final gathering only if the shaders adjusts the trace
depth, tends to have far less impact on the final image than the first bounce
that final gathering supports by default. Although physical correctness is lost,
this is often sufficient for film production, and final gathering is easier to
control than photons emanating from distant light sources. However, for
accurate indoor illumination simulations and other CAD-related applications,
photon mapping is still the method of choice.

Procedures

To use an environment map as a final gather light source:

Illumination from which final gathering is derived can be provided by an
actual light source, of course, but it can also be provided by an object to which
a self-illuminated material is applied, or even an environment map. In the
latter case, follow this procedure:

1 Add a skylight on page 4940  to the scene.

2 Do either of the following:

■ On the Skylight Parameters rollout, make sure Sky Color (the default)
is chosen, click the map button (“None”) to open the Material/Map
Browser dialog and then choose a map.

■ On the Skylight Parameters rollout, choose Use Scene Environment.
Use the Environment panel on page 6486  controls to assign an
environment map.

Thereafter, rendering with final gather enabled take the skylight map
into account when calculating final gather illumination.

TIP For extra realism, use an HDR image on page 7126  as a Bitmap map
image on page 5633 .

Interface

Following are descriptions of all of the final gather parameters. For a helpful
tutorial that illustrates and further explains the most important of these, see
ms-its:3dsmax_t.chm::/WS73099cc142f4875514c01ac112a7acef16-7f05.htmInterior
Architecture Rendering Tutorial  .
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Preset Provides a quick, easy solution for final gather. The default presets
are: custom (the default choice), draft, low, medium, high, and very high.
Available only when Enable Final Gather is on.

The presets affect the following settings:

■ Initial FG Point Density
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■ Rays per FG Point

■ Interpolate Over Num. FG Points

The preset settings are defined in the text file mentalray_fg_presets.ini, found
in the \plugcfg folder in the program installation. You can modify the existing
presets and add new ones by editing this file.

Basic group

Enable Final Gather When on, the mental ray renderer uses final gathering
on page 7782  to create global illumination or to improve its quality. Default=off.

TIP Without final gathering, global illumination can appear to be patchy. But final
gathering increases rendering time. Leave Final Gather off to preview the scene,
and then turn it on for the finished rendering. (Increasing the number of photons
used to calculate global illumination can also improve global illumination.)

Multiplier/color swatch Use these to control the intensity and color of the
indirect light accumulated by final gathering. The defaults, 1.0 and white,
produce physically correct rendering.

This is useful for adjusting the contribution of the final gather effect, thus
improving the quality of an image.

Initial FG Point Density A multiplier for the density of final gather points.
Increasing this value increases the density (and thus the quantity) of final
gather points in the image. The points will therefore be closer and more
numerous. This parameter is useful for solving geometry problems; for example,
near edges or corners. Default=1.0.

TIP When adjusting final render settings it's often helpful to visualize the final
gather points; to do so, turn on Diagnostics on page 6129  and choose the Final
Gather option.

Rays per FG Point Sets how many rays are used to compute indirect
illumination in a final gather. Increasing this value makes global illumination
less noisy, but also increases rendering time. Default=250.

Interpolate Over Num. FG Points Controls the number of final gather points
that are used for an image sample. It is useful for solving noise problems and
getting smoother results.

For each final gather point, mental ray interpolates (averages) indirect light
values over the nearest N final gather points, with N specified by the value of
this parameter, as opposed to points within the specified radii as with the
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alternate method on page 6113 . Increasing the value increases the smoothness
of the result, and the required number of calculations, hence the render time
(but not as much as you might expect).

This setting is unavailable when Use Radius Interpolation Method on page
6113  is enabled.

Diffuse Bounces Sets the number of times mental ray calculates diffuse light
bounces for each diffuse ray. Default=0.

Like Maximum Reflections and Maximum Refractions, this value is subject to
the restriction of Max Depth. If you set Diffuse Bounces higher than Max
Depth, the latter setting is automatically raised to the Diffuse Bounces value
in the MI output file, but this is not reflected in the 3ds Max interface.

NOTE When Global Illumination on page 6100 is on, changing this setting has no
effect.

Weight Controls the relative contribution of the diffuse bounces to the final
gather solution. The value scales from "using no diffuse bounces" (value=0.0)
to "use full diffuse bounces" (value=1.0). Default=1.0.

Final Gather Map group

These controls tell mental ray how to calculate the final gather map for indirect
illumination. The map uses the FGM file format on page 7775 .

Read/Write File When on, the mental ray renderer saves the final gather
map to the specified FGM file, if it doesn't already exist. If the file exists, mental
ray loads it and uses the map data it contains instead of generating a new one.

Read Only (FG Freeze) Determines whether or not mental ray uses the final
gather map file as is. When off, mental ray can add new final gather points if
necessary. When on, mental ray uses only the data in the specified file, and
does not generate any new final gather points during the pre-processing stage.
It can still generate new  final gather points while rendering when using the
radius method. Available only when you've specified an FGM file. Default=off.

... [Browse] Click to display a file selector dialog, which lets you specify a
name for the final gather map (FGM) file, and the folder where it is saved.

[file name] When you have used the Save button to specify a final gather
map file, the name field displays its name and path.

Delete File Click to delete the current FGM file.
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Advanced group

Noise Filtering (Speckle Reduction) Applies a median filter using neighboring
final gather rays that are shot from the same point. This parameter lets you
choose a value from a drop-down list. The options are None, Standard, High,
Very High, and Extremely High. Default=Standard.

The practical effect of increasing the Noise Filtering value is to make the scene
illumination smoother, at a cost of render time. However, increasing filtering
can also make the illumination somewhat darker.

Noise Filtering works by eliminating stray rays that are considerably brighter
than most of the rest. For example, in a situation in which most of the rays
are within 10 percent of each others’ brightness, but a few are 50 percent
brighter than the rest, using Noise Filtering will tend to disregard the latter
rays in computing the Final Gather solution.

As a result, in low-light situations, setting Noise Filtering=None can greatly
increase the overall illumination. In the following rendered image, an interior
scene, lit only by skylight entering through the window, is very dark with
Noise Filtering set to Standard (Diffuse Bounces=1).

Noise Filtering=Standard
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In the next illustration, the same scene renders much brighter with Noise
Filtering set to None. Note, however, the unevenness of the illumuniation.

Noise Filtering=None

In cases like this, you can achieve superior results with slightly longer rendering
times by setting Noise Filtering to Standard and using a sky portal on page
4999  in the window opening, as shown in the following illlustration:

mental ray Renderer | 6111



Noise Filtering=Standard + Sky Portal

The above illustration is also improved by the realistic shadows cast by the
chair and table legs from the Sky Portal light.

Draft Mode (No Precalculations) When on, final gathering skips the
precalculation phase. This results in a rendering with artifacts, but begins
rendering more quickly, so it can useful when you want to do a series of trial
renderings. Default=off.

Trace Depth group

The Trace Depth controls are similar to those for calculating reflections and
refractions, but they refer to the light rays used by final gathering, rather than
to rays used in diffuse reflection and refraction.

Max. Depth Limits the combination of reflection and refraction. Reflection
and refraction of a light ray stop when the total number of both equals the
Maximum Depth setting. For example, if Maximum Depth equals 3 and the
trace depths each equal 2, a ray can be reflected twice and refracted once, or
vice versa, but it can’t be reflected and refracted four times. Default=5.
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Max. Reflections Sets the number of times a ray can be reflected. At 0, no
reflection occurs. At 1, the ray can be reflected once only. At 2, the ray can
be reflected twice, and so on. Default=5.

Max. Refractions Sets the number of times a ray can be refracted. At 0, no
refraction occurs. At 1, the ray can be refracted once only. At 2, the ray can
be refracted twice, and so on. Default=5.

Use Falloff (Limits Ray Distance) When on, uses the Start and Stop values
to limit the length of light rays used for regathering before using the
environment color. This can help improve regathering time, especially for
scenes that are not fully enclosed by geometry. Default=off.

■ Start Specifies the distance, in 3ds Max units, at which rays begin. You
can use this value to exclude geometry that is too close to the light source.
Default=0.0.

■ Stop Specifies the maximum length, in 3ds Max units, of a light ray. If
the ray reaches this limit without encountering a surface, then the
environment is used for shading. Default=0.0.

FG Point Interpolation group

These settings provide access to the legacy method of final gather point
interpolation.

Use Radius Interpolation Method When on, makes the remaining controls
in this group available. Also makes the Interpolate Over Num. FG Points check
box on page 6108  unavailable, indicating that these controls override that
setting.

Radius When on, sets the maximum radius within which final gathering is
applied. Reducing this value can improve quality at a cost of rendering time.
If Radii In Pixels is off, the radius is specified in world units, and defaults to
10 percent of the maximum circumference of the scene. If Radii In Pixels is
on, default=5.0 pixels.

If both Radii In Pixels and Radius are off, the maximum radius is the default
value of 10 percent of the maximum scene radius, in world units.

Radii in Pixels When on, the radii values are specified in pixels. When off,
radii units depend on the value of the Radius toggle. Default=off.

Min. Radius When on, sets the minimum radius within which final gathering
must be used. Decreasing this value can improve render quality but increase
rendering time. Unavailable unless Radius is turned on. Default=0.0. If Radii
In Pixels is on, default=0.5.
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TIP In general, increasing the point density on page 6108  is better than decreasing
Min. Radius.

TIP To minimize flickering in animations, keep the two Radius values as close to
each other as possible.

Shadows and Displacement Rollout (mental ray
Renderer)

Rendering menu > Render > Render Scene dialog > Renderer panel > Shadows
& Displacement rollout

Main toolbar > Render Scene > Render Scene dialog > Renderer panel > Shadows
& Displacement rollout

Note: The Renderer panel appears only when the mental ray renderer is the
currently active renderer.

The controls in this rollout affect shadows on page 6058  and displacement on
page 6079 .

NOTE You can disable displacement globally by turning off Displacement in the
Options group on the Common Parameters rollout on page 5929 .
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Interface

Shadows group

Enable When on, the mental ray renderer renders shadows. When off, no
shadows are rendered. Default=on.

When Enable is off, the other shadow controls are unavailable.

Mode The shadow mode can be Simple, Sort, or Segments. Default=Simple.

■ Simple Causes the mental ray renderer to call shadow shaders in a random
order.

■ Sort Causes the mental ray renderer to call shadow shaders in order,
from the object to the light. Sort applies to third-party, external shadow
shaders on page 7925 .

■ Segments Causes the mental ray renderer to call shadow shaders in order
along the light ray from the volume shaders to the segments of the light
ray between the object and the light.

TIP Choose Simple for regular shadows, Segments for volume shadows.
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Shadow Maps group

These controls specify a shadow map on page 7928  used to render shadows.
When you specify a shadow map file, the mental ray renderer uses the shadow
map instead of ray-traced shadows.

To stop using a shadow map and use ray-traced shadows, delete the map's
name from the file name field.

Enable When on, the mental ray renderer renders shadow-mapped shadows.
When off, all shadows are ray-traced. Default=on.

When Enabled is off, the other controls in this group are unavailable.

If shadows are enabled but shadow maps are not enabled, then shadows for
all lights are generated using the mental ray ray-tracing algorithm. If shadow
maps are enabled, then shadow generation is based on each light’s choice of
shadow generator:

■ mental ray Shadow Map Shadows are generated using the mental ray
shadow-map algorithm.

■ Shadow Map Settings on the Shadow Parameters rollout are translated
into a mental ray equivalent before shadows are generated. The quality of
shadows generated this way might not always meet expectations.

■ Area Shadows, Advanced Ray Traced Shadows, or Ray Traced
Shadows Shadows are generated using the mental ray ray-tracing
algorithm.

Motion Blur When on, the mental ray renderer applies motion blur on page
6059  to shadow maps. Default=on.

WARNING Turning on Motion Blur for both cameras and shadows can cause
shadows to shift position. To avoid this effect, turn on motion blur for cameras
only.

Rebuild (Do Not Re-Use Cache) When on, the renderer saves the recalculated
shadow map (.zt) file on page 7978  to the file specified by the Browse button.
Default=on.

■ Use File When on, the mental ray renderer either saves the shadow map
to a ZT file, or loads an existing file. The state of Rebuild determines
whether the ZT file is saved or loaded.
This option is unavailable until you click the ellipsis button (see following)
to provide a name for the ZT file.
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■ ... [browse] Click to display a file selector dialog, which lets you specify
a name for the shadow map ZT file and the folder where it is saved.

■ File name After you specify a shadow map file (see preceding), this field
displays its name and path.

■ Delete File Click to delete the current ZT file.

Displacement group

View Defines the space for displacement. When View is on, the Edge Length
specifies the length in pixels. When off, the Edge Length is specified in world
space units. Default=on.

Smoothing Turn off to have the mental ray renderer correctly render height
maps. Height maps can be generated by normal mapping; see Creating and
Using Normal Bump Maps on page 6182 .

When using only height maps in the scene, make sure this option is off. If
some objects in the scene use height maps while others use standard
displacement, apply smoothing on a per-object basis (see mental ray Panel
(Object Properties Dialog) on page 262 ).

When on, mental ray simply smoothes the geometry using the interpolated
normals, making the geometry look better. This result, however, cannot be
used for height map displacement because smoothing affects geometry in a
way that is incompatible with height mapping.

Edge Length Defines the smallest potential edge length due to subdivision.
The mental ray renderer stops subdividing an edge once it reaches this size.
Default=2.0 pixels.

Max. Displace Controls the maximum offset, in world units, that can be
given to a vertex when displacing it. This value can affect the bounding box
of an object. Default=20.0.

TIP If displaced geometry appears to be “clipped,” try increasing the value of
Maximum Displace.

NOTE When using placeholders (see the Translator Options rollout on page 6122
), if this value is larger than it needs to be, it can reduce performance. If you
experience slow times while displaced objects when Use Placeholder Objects is
on, try lowering the Max. Displace value.
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Max. Subdiv. Controls the extent to which mental ray can recursively
subdivide each original mesh triangle for displacement. Each subdivision
recursion potentially divides a single face into four smaller faces. Choose the
value from the drop-down list. Range=4 to 64K (65,536). Default=16K (16,384).

For example, using the default value means that mental ray can subdivide
each displaced mesh triangle into as many as 16,384 smaller triangles.

Rendering Algorithms Rollout (mental ray
Renderer)

Rendering menu > Render > Render Scene dialog > Renderer panel > Rendering
Algorithms rollout

Main toolbar > Render Scene > Render Scene dialog > Renderer panel >
Rendering Algorithms rollout

The controls in this rollout let you choose whether to render using ray-tracing,
scanline rendering, or both. You can also choose the method used to accelerate
ray-tracing.

The Trace Depth controls the number of times each ray can be reflected,
refracted, or both.

Procedures

To set trace depth for reflections and refractions:

1 Count the number of times you want an object to be reflected or refracted
in the scene.

2 On the mental ray: Rendering Algorithms rollout, set Max Reflections to
the number of reflections you want, and Max Refractions to the number
of refractions you want.

3 Set Max Depth to equal the value you chose for Max Reflections plus the
value you chose for Max Refractions.

The greater the number of reflections and refractions, the more slowly
your scene will render. On the other hand, too low a value for Max
Reflections or Max Refractions (or Max Depth, controlling both) can
make your rendering look unrealistic.
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Interface

By default, both Scanline and Ray Tracing are enabled, which lets the mental
ray renderer use the two methods in combination to render the scene. Scanline
rendering is used for direct illumination (“primary rays”) only; ray tracing is
used for indirect illumination (caustics and global illumination) as well as
reflections, refractions, and lens effects.

You can disable one or the other option, but not both. For example, if only
ray tracing is enabled and you turn it off, 3ds Max enables scanline rendering.

Scanline group

Enable When on, the renderer can use scanline rendering. When off, the
renderer uses the ray-tracing method only. Scanline rendering is faster than
ray tracing, but cannot generate reflections, refractions, shadows, depth of
field, or indirect lighting. Default=on.
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Use Fast Rasterizer (Rapid Motion Blur) When on, uses a fast rasterizer
method to generate the first generation of rays to trace. This can improve
rendering speed. Default=off.

This option works well with object motion blur, and also with scenes that
have no motion blur.

The following settings are available for the fast rasterizer:

■ Samples per Pixel Controls the number of samples per pixel used by the
fast rasterizer method. More samples result in greater smoothness, at a cost
of render time. Range=1 to 225. Default=16.

■ Shades per Pixel Controls the approximate number of shading calls per
pixel. Greater values result in more accurate renderings, at a cost of render
time. Range=0.1 to 10000 (ten thousand). Default=1.0.

NOTE mental ray provides a Time Samples setting specifically for motion blur in
the fast rasterizer. When Use Fast Rasterizer is on, the Camera Effects rollout >
Time Samples on page 6092  label changes to Time Samples (Fast Rasterizer) to
indicate that this version of Time Samples is now in effect.

Ray Tracing group

Enable When on, mental ray uses ray tracing to render reflections, refractions,
lens effects (motion blur and depth of field), and indirect lighting (caustics
and global illumination). When off, the renderer uses the scanline method
only. Ray tracing is slower but more accurate and more realistic. Default=on.

To render reflections, refractions, depth of field, and indirect lighting (caustics
and global illumination), Ray Tracing must be enabled.

Use Autovolume When on, uses the mental ray autovolume mode. This lets
you render nested or overlapping volumes such as the intersection of two
spotlight beams. Autovolume also allows a camera to move through the nested
or overlapping volumes. Default=off.

To use Autovolume, Ray Trace must be on, Scanline must be off, and the
shadow mode must be set to Segments. (You set the shadow mode on the
Shadows And Displacement rollout on page 6114 .) If these conditions aren't
met when you click to turn on Autovolume, an alert warns you about this,
and gives you the option of making the appropriate setting changes.
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Raytrace Acceleration Group

Method The drop-down list sets which algorithm to use for raytrace
acceleration on page 7905 . The other controls in this group box change,
depending on which acceleration method you choose. These are the
alternatives:

■ BSP (the default)
The BSP method has Size and Depth controls. See Ray-Trace Acceleration:
Parameters for the BSP Methods on page 6141 .

This method is the fastest on a single-processor system. Use it for
small-to-medium size scenes on a single processor. BSP is also the best
method to use when ray tracing is turned off.

■ Grid
The Grid method has Size, Depth, and Resolution controls. See Ray-Trace
Acceleration: Parameters for the Grid Method on page 6142 .

This method uses less memory than BSP. It is also faster than BSP on
multiprocessor systems.

NOTE If you attempt to render motion blur with the Grid method active, the
mental ray renderer automatically switches to the BSP method. This happens
in the MI file but is not reflected in the 3ds Max interface.

■ Large BSP
The Large BSP method has the same controls as BSP. See Ray-Trace
Acceleration: Parameters for the BSP Methods on page 6141 .

This method is a variant of the BSP method. Portions of the partitioning
tree it uses can be swapped in and out of memory. This enables mental to
render very large scenes, at a cost of ray-tracing time. Use this method for
very large ray-traced scenes, and also when Use Placeholder Objects is
turned on (see Translator Options Rollout (mental ray Renderer) on page
6122 ). Use Placeholder Objects is recommended when you are doing
distributed rendering on page 6131 .

Trace Depth group

Trace depth controls the number of times a light ray can be reflected or
refracted. At 0, no reflection or refraction occurs. Increasing these values can
increase the complexity and realism of a scene, at a cost of greater rendering
time.
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TIP In some cases, you might want to set Max. Refractions high and Max.
Reflections low. For example, you might have the camera looking through several
glasses that are lined up, so they're overlapping from the camera's point of view.
In this situation, you might want the light rays to refract twice for each glass (once
for each layer), so you'd set Max. Refractions to 2 x [number of glasses]. However,
to save rendering time, you could set Max. Reflections to 1, resulting in accurate
multi-layer refraction with a relatively fast rendering time.

Max. Depth Limits the combination of reflection and refraction. Tracing of
a ray stops when the total number of reflections and refractions reaches the
Max Depth. For example, if Max Depth equals 3 and the two trace depths
each equal the default value of 2, a ray can be reflected twice and refracted
once, or vice versa, but it can’t be reflected and refracted four times. Default=6.

Max. Reflections Sets the number of times a ray can be reflected. At 0, no
reflection occurs. At 1, the ray can be reflected once only. At 2, the ray can
be reflected twice, and so on. Default=6.

Max. Refractions Sets the number of times a ray can be refracted. At 0, no
refraction occurs. At 1, the ray can be refracted once only. At 2, the ray can
be refracted twice, and so on. Default=6.

Translator Options Rollout (mental ray Renderer)

Rendering menu > Render > Render Scene dialog > Processing panel >
Translator Options rollout

Main toolbar > Render Scene > Render Scene dialog > Processing panel >
Translator Options rollout

Note: The Processing panel appears only when the mental ray renderer is the
currently active renderer.

Controls in this rollout affect the general operation of the mental ray renderer.
They also control the mental ray translator, which can save to an MI file on
page 7848 . The translation is in mental ray version 3 (mi3) format. The translator
does not support mental ray version 1 (mi1).

See also:

■ Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6131

6122 | Chapter 18   Rendering



Procedures

To save the mental ray renderer settings:

■ When you have a set of rendering settings you want to keep, go to the
Render Scene dialog and open the Preset drop-down list at the bottom.
Choose Save Preset (at the bottom of the list), enter a file name, and click
Save. Next, use the Select Preset Categories dialog to highlight the parameter
categories to store in the preset and click Save. Thereafter you can choose
your custom setup from the Preset drop-down list.

To create a rendering from multiple passes:

1 Use the Render Type on page 5900  > Selected option to choose only a
portion of the scene to render.

2 On the Translator Options rollout, in the Render Passes group, click the
ellipsis [...] button next to Save.

3 A Save As dialog is displayed. Use it to enter a name and location for the
PASS file.

4 Click Render.

The partial rendering is saved in the PASS file you specified.

5 Repeat steps 1 through 4 until you have generated all the passes for the
rendering (or all the passes but the last).

WARNING If your scene includes an environment, render it only in the final
pass. Rendering the environment in multiple passes is time consuming, and
can lead to artifacts such as unwanted color changes to the background.
Render all passes but the last one using a default black background.

6 In the Render Passes group, click Add to add the various pass files to the
list.

7 Turn on Merge.

At this point, you might also want to turn off Save, unless you want the
final result to be saved as a PASS file as well as a rendering.

8 Click Render.

The rendering consists of all the passes merged into one.
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TIP For some purposes, you might want to create the passes, then create a new
3ds Max scene with no objects, set the rendering resolution to match the passes,
you created, then merge the passes as described in steps 7 and 8 above.

Interface

Memory Options group

Use Placeholder Objects When on, 3ds Max sends geometry to the mental
ray renderer only on demand. Initially, the mental ray scene database is
populated only with the size (bounding box) and position of objects in the
3ds Max scene. When the mental ray renderer renders a bucket that contains
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an object, the object's geometry is sent to the rendering engine only at that
point. Default=off.

This option can improve rendering speed when a large amount of the scene's
geometry is outside of the view you are rendering.

TIP When you use placeholders, 3ds Max always calculate buckets in Hilbert order.
See Sampling Quality Rollout (mental ray Renderer) on page 6083 .

When the mental ray renderer is low on memory (as defined by the Memory
Limit setting), Use Placeholder Objects enables it to increase available memory
by deleting object geometry from the scene database. This can dramatically
reduce memory usage, but with a possible cost in rendering speed.

Memory Limit The mental ray renderer keeps a count of the memory it uses
at render time. If it reaches the specified memory limit and Use Placeholder
Objects (see preceding) is on, 3ds Max discards the geometry for some objects
in order to allocate memory for other objects. If Use Placeholder Objects is
off, or if after deleting geometry more memory is still needed, the renderer
releases texture-map memory as well. Default=650 MB.

TIP If you’d like to use a different Memory Limit setting on a regular basis without
having to change the value manually every time, store the value in a rendering
preset on page 5922  and then be sure to load that preset before rendering.

Use mental ray Map Manager When on, maps are read from disk and if
necessary, translated to a format that the mental ray renderer can read. When
off, maps are accessed directly from memory, and translation is unnecessary.
Default=off.

Following is a complete list of differences between turning this option on and
off:

When on:

■ mental ray reads textures directly from disk (mental ray is able to flush
textures out of memory when memory is low). Also, textures are loaded
only if needed.

■ mental ray uses its built-in pyramid filtering system. These pyramid lookup
tables can be flushed out of memory when memory is low.

■ Texture formats not supported directly by mental ray are read by 3ds Max
and sent, before rendering begins, as binary data to mental ray.
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When off:

■ 3ds Max reads the textures from disk, and then sends individual pixel
colors to mental ray as they are needed.

NOTE 3ds Max reads the textures from disk and keeps them stored in memory
between renders. This can make renders faster, because the bitmaps don’t
need to be reloaded every time. 3ds Max will not read the texture from disk
if it was already loaded previously (for example, in a previous render, for a
Material Editor preview, or for displaying the map in a viewport).

■ Rendering uses a pyramid filter shader that is identical to the standard 3ds
Max pyramid filter system.

Turning this option on is useful for large scenes that take a lot of memory to
render. Turning it off is quicker, because textures already loaded in memory
don’t have to be reloaded by mental ray. But turning it off might use more
memory and doesn’t allow for flushing when memory is low, unless you use
the 3ds Max bitmap pager on page 7560 .

NOTE Turning the option on and off might result in very small differences between
rendered images because of the different algorithms used in the mental ray map
manager and the 3ds Max map manager.

You must turn on “Use mental ray Map Manager” when performing these
actions:

■ Using distributed bucket rendering.
See Distributed Bucket Rendering Rollout (mental ray Renderer) on page
6131 .

When rendered with distributed bucket rendering and the mental ray map
manager, images with textures can look different than when rendered with
3ds Max alone, because the filtering technique is different.

■ Exporting to an MI file.
See below.

Conserve Memory Tells the translator to be as memory efficient as it can.
This can slow down the translation process, but reduces the amount of data
being sent to the mental ray renderer. Default=off.

This option is useful when you are trying to render a huge scene and time is
not necessarily an issue. When you render to an MI file, this option can also
help reduce the size of the output file.
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When on, this toggle also tells the mental ray renderer to save frames as
temporary .map files. This allows you to render extremely large frames without
running out of random-access memory.

The location of the temporary map files is chosen in the following order:

1 If the file \[program folder]\mentalray\rayrc contains a registry entry called
_MI_REG_FBDIR, the renderer uses this directory.

The entry should have the form

registry "{_MI_REG_FBDIR}" value "<path>" end registry

where <path> is the directory you want to use.

2 If the rayrc file has no registry entry, the renderer uses the directory
specified by the TMPDIR environment variable.

3 If there is no TMPDIR environment variable, the renderer uses the
directory specified by the TEMP environment variable.

Material Override group

Material Override allows you to render a scene with all its materials replaced
by a single master material. For example, if you need to do a wireframe pass,
you can create a Wire material and then specify it here. When you render, all
surfaces will use the Wire material.

Enable When on, rendering uses the override material for all surfaces. When
off, surfaces are rendered with the material applied to them in the scene.
Default=off.

Material Click to display the Material/Map Browser on page 5194  and choose
a material to use as the override. Once you have chosen an override material,
this button displays the material name.

Export to .mi File group

These controls let you save the translated scene in a mental ray MI file on
page 7848 . Before exporting, you must specify an export file by clicking the
ellipsis [...] button.

NOTE Exporting to an MI file is not available when you render to texture on page
6169 .

Export on Render When on, saves the translated file to an MI file instead of
rendering when you click Render. Available only after you have clicked the
ellipsis [...] button to specify an MI file. Default=off.
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Un-compressed When on, the MI file is not compressed. When off, the file
is saved in a compressed format. Default=on.

Incremental (Single File) When on, exports an animation as a single MI file
that contains a definition of the first frame and descriptors of the incremental
changes from frame to frame. When off, exports each frame as a separate MI
file. Default=off.

When you export an animation, turning on Incremental can save a
considerable amount of disk space.

■ ... [browse] Click to display a file selector dialog, which lets you specify
a name for the MI file, and the folder where it is saved.

■ File name After you've used the ellipsis [...] button to specify an MI file,
this field displays its name and path.

Render Passes group

Controls in this group let you create a rendering out of multiple passes that
render portions a scene. This can be a useful way to render large scenes or
scenes that have complex effects. It can also be a way to divide the labor on
a composited (“merged”) rendering. See the “Procedures” section, above, for
more information.

NOTE You cannot render to passes when you render to texture on page 6169 .

Save When on, saves the image currently being rendered (prior to merging)
inside the specified PASS file.

■ ... [browse] Click to display a file selector dialog, which lets you specify
a name for the PASS file and the folder where it is saved.

■ File name After you have specified a PASS file, the name field displays
its name and path.

If you are rendering a time segment (that is, an animation), the PASS files are
created with sequence numbers appended to the main file name (for example,
test0000.pass, test0001.pass, and so on).

Merge When on, the PASS files specified in the list will be merged into the
final rendering.

■ List of PASS files Lists the PASS files that will be merged into the final
rendering (possibly including the pass that is currently being rendered and
saved).
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■ Add Click to add a PASS file to the list.
If you choose a PASS file with a sequence number appended to its name,
3ds Max asks if you want to use the individual file or the entire sequence.

■ Delete Click to delete the highlighted PASS file from the list.

Merge Shader Lets you choose the shader used to merge the PASS files.
Clicking the shader button displays a Material/Map Browser so you can choose
the shader (when a shader is chosen, its name appears on the button). When
the toggle is on, this shader is used for merging.

IMPORTANT No merge shaders are provided with 3ds Max. This option is provided
for users who plan to write a custom merge shader appropriate to their particular
compositing project.

Render Elements group

This toggle is for when you are rendering separate elements on page 6144 .

Render Final Image When on, renders a final, “beauty” pass in addition to
the separate elements. When off, renders only the elements. Default=off.

Mapping group

Skip Maps and Textures When on, rendering ignores maps and textures,
including projection maps, and uses only surface colors (diffuse, specular, and
so on). Default=off.

Turning off maps can be useful, and save time, when you are adjusting global
illumination.

Diagnostics Rollout (mental ray Renderer)

Rendering menu > Render > Render Scene dialog > Processing panel >
Diagnostics rollout

Main toolbar > Render Scene > Render Scene dialog > Processing panel >
Diagnostics rollout

Note: The Processing panel appears only when the mental ray renderer is the
currently active renderer.

mental ray Renderer | 6129



The tools on the Diagnostics rollout can help you understand why the mental
ray renderer is behaving in a certain way. The Sampling Rate tool, in particular,
can help explain the renderer's performance.

Each of these tools generates a rendering that is not a photorealistic view, but
a schematic representation of the functionality you have chosen to analyze.

Interface

Enable When on, the renderer renders the graphic representation for the
tool you have chosen.

Sampling Rate When chosen, renders an image that shows where samples
were collected during rendering; see Sampling (mental ray Renderer) on page
7914 . This can help you adjust the contrast and other sampling parameters.

Coordinate Space Renders an image that shows the coordinate space of
objects, the world, or camera.

■ Object Shows local coordinates (UVW). Each object has its own coordinate
space.

■ World Shows world coordinates (XYZ). The same coordinate system
applies to all objects.

■ Camera Shows camera coordinates, which appear as a rectangular grid
superimposed on the view.

Size Sets the size of the grid. Default=1.0.
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TIP To avoid busy moiré patterns in the grid, increase the value of Size.

Photon Renders the effect of a photon map in the screen. This requires that
a photon map be present (to render caustics or global illumination). If no
photon map is present, the Photon rendering looks just like the nondiagnostic
rendering of the scene: the mental ray renderer first renders the shaded scene,
then replaces it with the pseudocolor image.

■ Density Renders the photon map as it is projected into the scene. High
density is displayed in red, and lower values render in increasingly cooler
colors.

■ Irradiance Similar to the Density rendering, but shades the photons based
on their irradiance. The maximum irradiance is rendered in red, and lower
values render in increasingly cooler colors.

BSP Renders a visualization of the parameters used by the tree in the BSP
ray-trace acceleration method on page 6141 . If a message from the renderer
reports excessively large depth or size values, or if rendering seems unusually
slow, this can help you locate the problem.

■ Depth Shows the depth of the tree, with top faces in bright red, and
increasingly deep faces in increasingly cool colors.

■ Size Shows the size of leaves in the tree, with differently sized leaves
indicated by different colors.

Final Gather Renders the scene with pre-processing final-gather points
displayed as green dots, and tile-rendering (final render) final-gather points
displayed as red dots.

For animation purposes, the presence of red dots is undesirable. To resolve
this, use the Interpolate Over Num. FG Points setting on page 6108  instead of
the Radius Interpolation Method on page 6113 , or, if you prefer the latter, keep
the Min. Radius setting as close as possible to the Radius setting; that is, the
maximum radius.

Distributed Bucket Rendering Rollout (mental ray
Renderer)

Rendering menu > Render > Render Scene dialog > Processing panel >
Distributed Bucket Rendering rollout
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Main toolbar > Render Scene > Render Scene dialog > Processing panel >
Distributed Bucket Rendering rollout

Note: The Processing panel appears only when the mental ray renderer is the
currently active renderer.

Controls on this rollout are for setting up and managed distributed bucket
rendering. With distributed rendering, multiple networked systems can all
work on a mental ray rendering. Buckets are assigned to systems as they become
available.

While distributed bucket rendering can be used for offline rendering of
animation frames, as in standard network rendering, it's best suited for speeding
up the rendering of single images as you work. Especially when rendering
high-resolution still images, you can get much faster results with distributed
bucket rendering.

TIP When you use distributed bucket rendering, be sure to:

■ Turn on Use Placeholder Objects on the Translator Options rollout on
page 6122 .
When placeholder objects are enabled, geometry is sent to the renderer
only on demand.

■ Leave Bucket Order set to Hilbert on the Sampling Quality rollout on page
6083 .
With Hilbert order, the sequence of buckets to render uses the fewest
number of data transfers.

NOTE Contour shading does not work with distributed bucket rendering.

NOTE You cannot use distributed bucket rendering when you render to texture
on page 6169 .

IMPORTANT To use distributed bucket rendering, you must set up host systems
that are capable of running the mental ray renderer. There are two ways to do so:
set up satellite systems, or install mental ray standalone licensing on remote hosts.

Satellite Systems

“Satellite” processors allow any owner of a 3ds Max license to freely use up
to eight slave CPUs to render an image using distributed bucket rendering
(not counting the one, two, or four processors on the “master” system that
runs 3ds Max).
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Each satellite system must have the following files installed:

■ rayrc

■ raysat_3dsmax<X>.bat

■ raysat_3dsmax<X>.exe

■ raysat_3dsmax<X>server.exe

where <X> is the current 3ds Max version number.

You can use the 3ds Max installation program to install these files: see the
Installation Guide for more information.

In addition, information about each satellite should be stored in the
RAYHOSTS file on page 7907 . You can set up satellite systems by using the Add
button on the Distributed Bucket Rendering rollout, as described in the
“Interface” section, below.

Host Systems with SPM Licenses

When you use mental ray SPM licenses, remote hosts (that is, all systems other
than the one running 3ds Max) must have the mental ray renderer (ray.exe)
and a mental ray SPM license server running. To obtain this, you must run
the mental ray installer on all remote hosts, then configure and run the SPM
license server. Instructions about how to do so are provided with the mental
ray renderer sold by mental images.

Once the remote hosts have been configured to run a licensed instance of
ray.exe, you can use them for distributed rendering simply by naming them
in the RAYHOSTS file on page 7907 . You can add hosts to the RAYHOSTS file
using the Add button described in the “Interface” section, below, just as you
would add a satellite processor.

Batch Rendering (Using Backburner or the Command Line)

You can launch distributed bucket rendering from the command line, using
3dsmaxcmd.exe.

If you use satellite processors, you cannot use Backburner to manage distributed
bucket rendering. When host processors have SPM licenses, you can use
Backburner to manage distributed bucket rendering.

You can use the environment variable MRMAX_OFFLINE_DBR_OVERRIDE to
control whether batch rendering uses distributed bucket rendering. The state
of this variable overrides the “DBR enable” flag. If it is set to “yes,” “true,” or
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“on,” distributed bucket rendering is enabled; if it is set to “no,” “false,” or
“off,” distributed bucket rendering is disabled. All other values of this variable
are ignored.

See also:

■ Translator Options Rollout (mental ray Renderer) on page 6122

Procedures

To use mental ray distributed rendering:

1 On the Render Scene dialog, go to the Processing panel. On the
Distributed Bucket Rendering rollout, turn on Distributed Render.

NOTE The Net Render option on the Common Parameters rollout has no
effect on distributed bucket rendering.

2 Click to select the names of those satellite or host systems you want to
use for distributed rendering.

You can click All to select all the host names in the list, or None to select
none of the hosts.

3 If other host systems have maps installed on them, with exactly the same
file names and path names as on your local host, turn on Distributed
Maps.

With Distributed Maps turned on, remote renderers can use their local
copy of maps, which saves time.

4 Render the scene.

Each system renders the buckets assigned to it. The final rendering appears
on your local system, with buckets “arriving” in an indeterminate order.

Example: To use mental ray distributed bucket rendering with Backburner:

This procedure demonstrates how to multiply the number of CPUs used for
rendering without having to purchase mental ray standalone licenses, using
the 3ds Max satellite technology.

If you have a few machines with 3ds Max licensed, and many machines
without, you can use both the distributed rendering technology and
Backburner so a rendering job would use 10 CPUs per Backburner server,
thereby increasing the rendering speed.
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For the purpose of this procedure, we're using a render farm comprising three
machines named A, B, and C, each running a licensed copy of 3ds Max.

NOTE The number of machines you can use depends on the number of machines
running licensed copies of 3ds Max. You are able to use only eight external (or
satellite) CPUs per licensed copy of 3ds Max: four dual-processor machines or
eight single-processor machines (or equivalent).

1 Choose which machines (other than machines A, B, and C) will serve as
satellites, install 3ds Max on each, and write down each machine's IP
address.

2 Use the Windows Notepad program or a text editor to open the
max.rayhosts file on machine A, located in mentalray subdirectory within
the program folder.

3 In the max.rayhosts file, under the “localhost” entry enter the IP address
of each satellite CPU to be used; up to eight in all (see Figure 1).

Figure 1 - Example of a rayhost file

4 Repeat the previous step on machines B and C with the remaining IP
addresses.

5 Launch Backburner Manager on the machine submitting the job or any
other machine. Launch the Backburner Server on machines A, B, and C.

WARNING It is necessary for the machine running the Backburner Server to
have 3ds Max licensed. A mental ray standalone license will not enable you
to use the distributed bucket rendering feature, and Backburner will prompt
you with a license error.
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6 On the machine submitting the job choose mental ray as the renderer,
and then turn on Use Placeholder Objects, Use mental ray Map Manager
(see Figure 2), and the Distributed Render (see Figure 3).

Figure 2 – Translator Options
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Figure 3 – Distributed Bucket Rendering

7 Submit the job to the Backburner network rendering farm.

The job is submitted to the network rendering farm and is picked up by
machines A, B, and C. Each machine uses its internal CPU as well as its
satellite CPUs to render the job.
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Interface

Distributed Render When on, the mental ray renderer can use multiple
satellite or host systems for distributed rendering. The list specifies which
systems to use. Default=off.

NOTE The Net Render option on the Common Parameters rollout has no effect
on distributed bucket rendering.

The other distributed rendering controls are unavailable unless Distributed
Render is on.

Distributed Maps When on, specifies that all texture maps can be found on
each of the slave machines doing distributed rendering. This saves time by
avoiding the necessity for mental ray to distribute all the maps to each slave
via TCP/IP. When off, specifies that all maps used in rendering reside on the
local system; that is, the system on which you start rendering. Default=off.

If Distributed Maps is on but the maps are not found on the slaves, those maps
simply will not render on the slaves, and rendered output will be incorrect.
Also, an error message will appear in the mental ray message window.

If you are doing local rendering only, this setting has no effect.

Maps on all systems in distributed rendering must have exactly the same name
and directory path.
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[name field] Displays the RAYHOSTS file's on page 7907  name and path.

[list of hosts] After you choose a RAYHOSTS file, this list shows the host
systems available for distributed mental ray rendering. You can use this list
to choose only those hosts you want to use for this particular rendering. When
you render with Distributed Render on, the mental ray renderer uses only the
hosts whose names are highlighted in this list. Click a host name to select it.
To deselect a selected host name, click it again.

NOTE The RAYHOSTS file, and therefore the host list, can contain duplicate entries.
However, before you render you must select only processors that are not duplicates;
otherwise, at render time 3ds Max will display an error message.

If Distributed Render is on but the list of hosts is empty when you click Render,
3ds Max will not perform distributed bucket rendering.

All Highlights all system names in the hosts list.

None Clears the highlight from all system names in the hosts list.

Add Click to display an Add/Edit DBR Host dialog on page 6140 , which lets
you add a host processor to the RAYHOSTS file.

Edit Click to display the Add/Edit DBR Host dialog on page 6140 , and edit
the highlighted host processor's entry in the RAYHOSTS file. Available only
when a single list entry is highlighted.

Remove Click to remove the currently highlighted host processors from the
list and the RAYHOSTS file. Available only when one or more list entries are
highlighted.

Clicking Remove displays a Remove Selected Hosts dialog, which warns you
that the host descriptors will be removed from both locations:

To restore a host that you have removed, use the Add button once again.
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Add/Edit DBR Host Dialog

The Add/Edit DBR (Distributed Bucket Rendering) Host dialog appears when
you click Add on the Distributed Bucket Rendering rollout on page 6131 . It lets
you add a host (or “satellite”) processor to use when you render using
distributed buckets. As the text on the dialog reminds you, the new host is
added to the text of the RAYHOSTS file on page 7907 .

Interface

Port Number Lets you enter a port number for the processor. This control
is unavailable unless you turn off Use Default Port. When Use Default Port is
off, the default port value appears in this field.

Name or IP Address Enter the name or the numeric IP address of the
processor you want to add.

Use Default Port When on, 3ds Max assigns a port number to the new
processor. The Port Number control is unavailable while Use Default Port is
on. Default=on.
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Ray-Trace Acceleration Parameters

Ray-Trace Acceleration: Parameters for the BSP
Methods

Rendering menu > Render > Render Scene dialog > Renderer panel > Rendering
Algorithms rollout > Raytrace Acceleration group > Choose BSP or Large BSP
as the Raytrace Acceleration method.

Main toolbar > Render Scene > Render Scene dialog > Renderer panel >
Rendering Algorithms rollout > Raytrace Acceleration group > Choose BSP or
Large BSP as the Raytrace Acceleration method.

Note: The Processing panel appears only when the mental ray renderer is the
currently active renderer.

When you choose BSP or Large BSP as the Raytrace Acceleration method on
the Rendering Algorithms rollout on page 6118 , the parameters described here
are displayed. BSP stands for Binary Space Partitioning. BSP is the default
method. Large BSP is a variant whose partitioning tree can be swapped in and
out of memory, making it suitable for rendering very large scenes.

NOTE If the scene contains too many faces (triangles) to fit in a tree of the size
specified by the Size and Depth parameters, mental ray disregards the Size value
and creates larger leaf nodes. This can significantly slow down rendering. To avoid
this problem, increase the value of Depth.

Interface

Size Sets the maximum number of faces (triangles) in the leaf of a BSP tree.
Increasing the Size value reduces memory consumption but increases rendering
time. Default=10.

Depth Sets the maximum number of levels in the BSP tree. Increasing the
Depth value reduces rendering time, but increases memory consumption and
preprocessing time. Default=40.
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TIP For large scenes, increasing the Depth value to 50 or more can greatly improve
rendering time.

Ray-Trace Acceleration: Parameters for the Grid
Method

Rendering menu > Render > Render Scene dialog > Renderer panel > Rendering
Algorithms rollout > Raytrace Acceleration group > Choose Grid as the Raytrace
Acceleration method.

Main toolbar > Render Scene > Render Scene dialog > Renderer panel >
Rendering Algorithms rollout > Raytrace Acceleration group > Choose Grid
as the Raytrace Acceleration method.

Note: The Processing panel appears only when the mental ray renderer is the
currently active renderer.

When you choose Grid as the Raytrace Acceleration method on the Rendering
Algorithms rollout on page 6118 , the Size, Depth, and Resolution parameters
are displayed. The grid method subdivides the scene into a grid of "voxels." A
voxel is a node in the subdivided scene.

Interface

Size Sets the maximum number of triangles in a voxel. If a voxel would
contain more triangles, and the Depth setting permits it, then the voxel is
subdivided into a subgrid. Default=128.

Depth Sets the number of recursion levels. If a voxel grid contains too much
detail, it is subdivided into a subgrid, which adds one level of recursion.
Default=2.

Resolution Sets the number of grid voxels in the X, Y, and Z dimensions. If
the value is zero (the default), the mental ray renderer automatically sets a
value. Default=0 (automatic).
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VUE File Renderer

Rendering menu > Render > Render Scene dialog > Choose VUE File Renderer
as the active production renderer. > Renderer panel > VUE File Renderer rollout

The VUE File Renderer creates VUE (.vue) files. VUE files on page 7967  use an
editable ASCII format.

Procedures

To create a .vue file:

1 Use the Render Scene dialog's Current Renderer rollout to assign the VUE
File Renderer as the Production renderer.

You can't assign the VUE File Renderer to be the ActiveShade renderer.

2 Activate a camera viewport.

NOTE You must render from a camera viewport in order to include the
coordinates for the camera itself.

3 Use the VUE File Renderer's rollout to specify a file name.

4 Render the scene.

The VUE file is written to disk. The rendered frame window on page 5885
is displayed, but it doesn't display an image.

Interface

Browse (“...”) Click to display a file selector dialog and choose a name for
the VUE file to create

File name The text field displays the name of the file.
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Rendering Elements Separately

Render Elements Panel and Rollout

Main toolbar > Render Scene button > Render Scene dialog > Render Elements
panel > Render Elements rollout

Rendering menu > Render > Render Scene dialog > Render Elements panel >
Render Elements rollout

Rendering to elements lets you separate various information in the rendering
into individual image files. This can be useful when you work with some
image-processing or special-effects software. You can later do compositing
with the element renderings.

These are the elements you can choose to render separately:

■ Alpha: A grayscale representation of the alpha channel, or transparency,
of the scene. Transparent pixels appear in white (value=255) and opaque
in black (value=0). Translucent pixels appear in gray. The darker the pixel,
the more transparent it is.
The alpha channel can be useful when you composite elements.

■ Atmosphere: The atmospheric effects in the rendering.

■ Background: The background of the scene.
Other elements do not include the scene background. Include this element
if you want to use the background in compositing.

The background is not trimmed against geometry, so elements should be
composited over the background. See Compositing Rendered Elements on
page 6150 .

■ Blend: A custom combination of the previous elements.
The Blend element displays an additional Blend Element Parameters rollout
on page 6162 .

■ Diffuse: The diffuse component of the rendering.
The Diffuse element displays an additional Diffuse Texture Element rollout
on page 6168 .

■ Hair and Fur: The component of the rendering created by the Hair and
Fur modifier on page 1049 . See Hair and Fur Render Element on page 6163 .

■ Illuminance HDR Data: Generates an image containing 32–bit floating-point
data that can be used for analyzing the amount of light that falls on a

6144 | Chapter 18   Rendering



surface perpendicular to its normal. The illuminance data ignores material
characteristics such as reflectance and transmittance.

Illuminance is not related to surface properties.

For best results, render with mental ray or another renderer that supports
32–bit floating-point output and set the output format to PIC, HDR, or
EXR. If using the scanline renderer or another renderer that doesn't support
32–bit floating-point output, set the Scale Factor parameter, which acts as
a multiplier, to adjust the range of values for the output data.

■ Ink: The Ink component (borders) of Ink 'n Paint materials on page 5580 .

■ Lighting: The effect of direct and indirect lights and shadows in the scene.
The Lighting element displays an additional Lighting Texture Element
rollout on page 6163 .

■ Luminance HDR Data: Generates an image containing 32–bit floating-point
data that can be used for analyzing the perceived brightness of a surface
after light has been “absorbed” by the material of the surface. The
luminance data considers material characteristics such as reflectance and
transmittance.
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Luninance takes surface properties into account.

For best results, render with mental ray or another renderer that supports
32–bit floating-point output and set the output format to PIC, HDR, or
EXR. If using the scanline renderer or another renderer that doesn't support
32–bit floating-point output, set the Scale Factor parameter, which acts as
a multiplier, to adjust the range of values for the output data.

■ Material ID: Retains the material ID information assigned to an object.
This information is useful when you are making selections in other
image-processing or special-effects applications, such as Autodesk
Combustion. For example, you could select all of the objects with a given
material ID in Combustion. The material ID corresponds to the value you
set for the material with the material ID channel. Any given material ID
will always be represented by the same color. The correlation between a
specific material ID and a specific color is the same in Combustion. See
Material ID Channel  on page 5252 .

■ Matte: Renders a matte mask, based on selected objects, material ID channel
(effects IDs), or G-Buffer IDs.
The Matte element displays an additional Matte Texture Element rollout
on page 6164 .

■ Object ID: Retains the object ID information assigned to the object.
Roughly comparable to the material ID, the object ID information is useful
for selecting objects based on an arbitrary index value in another
image-processing or special-effects application. If you know that you will
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want to select several objects at once, at a later time, you can assign them
all the same object ID in 3ds Max. By rendering with the object ID, this
information will be available in other applications.

You assign the object ID with the Object Properties dialog > General panel
> Object Channel parameter on page 255 . A given object ID is always
represented by the same (arbitrary) color. The correlation between a specific
material ID and a specific color is the same in Combustion.

When an Object ID entry is highlighted in the element rendering list on
page 6155 , the Object ID Element rollout appears on the Render Elements
panel. This rollout lets you choose whether to base the render color of a
given object ID on the object color or the Object ID. If you choose Object
Color, the render color is the object's base color, as shown on the Create
panel > Name And Color rollout and at the top of the other command
panels, and is not based on the Object ID. If you choose Object ID, an
arbitrary color is assigned to each object based on its Object ID.

■ Paint: The Paint component (surfaces) of Ink 'n Paint materials.

■ Reflection: The reflections in the rendering.

■ Refraction: The refractions in the rendering.

■ Self-Illumination: The self-illumination component of the rendering.

■ Shadow: The shadows in the rendering. This element saves black-and-white
shadows only. See Compositing Rendered Elements on page 6150 .

NOTE The mental ray renderer does not include shadows created by global
illumination on page 6096 and final gathering on page 6104  in the Shadow render
element output.

■ Specular: The specular component of the rendering.

■ Velocity: The motion information which can be used in other applications
for things such as creating motion blur or retiming an animation.
The Velocity element displays an additional Velocity Element Parameters
rollout on page 6165 .

■ Z Depth: A grayscale representation of the Z depth, or depth within the
view, of objects within the scene. The nearest objects appear in white, and
the depth of the scene in black. Intermediate objects are in gray, the darker
the deeper the object is, within the view.
The Z Depth element displays an additional Z Element Parameters rollout
on page 6167 .
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When you render one or more elements, a normal complete rendering is also
generated. In fact, the element renderings are generated during the same
rendering pass, so rendering elements costs little extra render time.

Rendering to elements is available only when you do production rendering
with the default scanline renderer on page 5949  or the mental ray renderer on
page 6039 .

NOTE The default scanline renderer supports a maximum of 32 render elements
per scene. The mental ray renderer does not limit the number of render elements.
If you're using a third-party renderer, check the product documentation for a
possible limit on the number of render elements.

NOTE When using the default scanline renderer, Antialiasing on page 5954  must
be on in order to render elements. With Antialiasing off, rendering elements is
disabled.

Element File Names

If you have previously assigned a file name and path for the (complete)
rendering on the Render Dialog's Common Parameters rollout on page 5929 ,
the render elements feature uses this name and path as the basis for names
of the various elements. It appends an underscore (_) and then the name of
the element to the basic file name.

For example, if the render file name is "C:\render\image.jpg", when you add a
Specular render element, the default path and file name for the rendered
specular element is "C:\render\image_specular.jpg".

Similarly, when you enable output to a Combustion workspace (CWS) file
on page 7121 , the file name you assigned is the default name of the CWS file.

For example, if the render file name is "C:\image.jpg", when you enable
Combustion output, the default path and file name is "C:\image.cws".

Example

Here is a rendering of a fountain, against a checkered background, and various
elements.
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On the right is the fully rendered fountain.

On the left, from top to bottom, are diffuse, specular, shadow, and reflection elements.

Two more elements not directly related to the objects in the scene, but important
when compositing the image to other sources:

on the left is the background, on the right is the alpha channel.
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On the left is an atmosphere element, in this example, a light fog on the back side of
the fountain.

On the right is the Z-depth. The fog uses the depth of the image and objects to
determine its density. The Z-depth element contains these depth values.

Compositing Rendered Elements

In general, you can composite elements using additive composition, which
is independent of the compositing order.

The main exceptions are the background element, atmospheres, and shadows.

■ Background: The background is not trimmed against geometry, the
background should be composited under the other elements.

■ Atmosphere: The atmosphere element should be composited over all other
elements.

■ Black-and-white shadows: Black-and-white shadows should be composited
over the rest of the image (aside from the atmosphere), to dim color in the
shadowed areas. This technique does not take colored lighting into account.

In other words, the layers when you composite using black-and-white shadows
appear like this:

Top: Atmosphere

Second from top: Shadow element

Middle: Diffuse + Specular + ... (other elements)

Bottom: Background
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"Screen" Compositing for Specular and Reflection Elements

The other exception to additive composition is when specular or reflection
elements have been generated by certain material shaders. These shaders
generate specular and reflection elements you must composite differently:

■ Anisotropic

■ Multi-Layer

■ Oren-Nayar-Blinn

Shaders are assigned on a per-material basis, in the Material Editor. If you
render specular or reflection elements in a scene that uses these shaders, then
composite them with the diffuse and other foreground components (aside
from colored shadows, as described above), by overlaying them using an
operation called "Screen" in some compositing programs.

Screen compositing uses this formula to combine elements:

Background * (1 - Foreground) + Foreground

The background is multiplied by the inverse of the foreground color, and then
the foreground color is added to the result.

For more information, see the documentation for the compositing program
you use.

Procedures

To have the Render Elements dialog assign names to the rendered element
files automatically:

1 In the Render Scene dialog's Common Parameters rollout, use the Files
button to assign an output file name and file type for the (entire) rendered
scene.

2 In the Render Elements rollout, use the Add button to add elements for
rendering.

You can render elements to files without rendering the entire scene to a file,
but in this case, you have to assign the files for the elements individually or
"by hand."

To add an element for rendering:

1 Click Add.
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2 In the Render Elements dialog, do one of the following:

■ Click to highlight the name of an element, and then click OK.

■ Double-click the name of an element.
If you have assigned a file name for the entire rendering, the new
element is assigned a file name automatically. Otherwise, use the Files
button in the Selected Element Parameters group to assign an output
file name and file type for the element rendering.

3 If the element is one (such as Blend or Z Buffer) that has additional
parameters, adjust these parameters in the appropriate rollout.

To render the separate elements:

1 Add the elements you want to render.

TIP You can use the Enable button (in the Selected Element Parameters
rollout) to disable individual elements for a particular rendering pass.

2 If you haven't assigned file names automatically, use the Files button in
the Selected Element Parameters group to assign an output file name and
file type for the element rendering.

3 Make sure Elements Active (at the top of the Render Elements rollout) is
turned on, and then click Render to render the scene.

The rendered elements are also displayed on the desktop, each in its own
rendered frame window. (The rendered frame windows are displayed on
top of each other.)

To generate a Combustion™ workspace (CWS) file that contains the rendered
elements:

1 In the Output to Combustion group, turn on Enable.

If you have assigned a file name for the entire rendering, the new element
is assigned a file name automatically. Otherwise, use the Files button in
the Output to Combustion group to assign an output file name for the
CWS file.

2 If you want to change the file or pathname click ... [ellipsis].

3 Do one of the following:

■ Render the scene. The CWS file is created at the time of the rendering.

■ Create Combustion Workspace Now.
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Use this button to create a Combustion workspace at any time. You
do not have to render for the workspace to be created.

NOTE This only works if there is at least one Render Element selected
and if your Render Output file type (set on the Common panel) is AVI,
RPF, CIN, JPG, PNG, MOV, RGB, RLA, TGA, TIF, or EXR.
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Interface

Add Click to add a new element to the list. This button displays the Render
Elements dialog on page 6157 .
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Merge Click to merge the render elements from another 3ds Max scene.
Merge displays a file dialog so you can select the scene file to get the elements
from. The list of render elements in the selected file is added to the current
list.

Delete Click to delete the selected elements from the list.

Elements Active When on, clicking Render renders the separate elements.
Default=on.

Display Elements When on, each separate element is displayed in its own
rendered frame window on page 5885  when you render. When off, the elements
are rendered to files only. Default=on.

The buffers for each rendered element appear directly on top of each other.
Move one element's buffer to see another's.

Element Rendering list

This scrollable list shows the elements to render separately, and their status.
You can resize the columns in the list by clicking and dragging the border
between two columns.

Name Shows the name of the element. You can change the default name
of elements, in the Selected Element Parameters group.

To select an element, click its name in the list. Use Ctrl+click to select additional
elements, or Shift+click to select a contiguous group of additional elements.

Enabled Shows whether the element is enabled.

Filter Shows whether the active antialiasing filter is enabled for the element.

Type Shows what type of element this is.

This field is useful if you have changed the name of an element.

Output Path Shows the path and file name for the element.
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Selected Element Parameters group

These controls are for editing selected elements in the list.

Enable Turn on to enable rendering the selected elements. Turn off to disable
rendering. Default=on.

The Enabled column of the elements list shows whether or not an element is
enabled.

Enable Filtering When on, applies the active antialiasing filter on page 5954
to the rendered element. When off, the rendered element does not use the
antialiasing filter. Default=on.

The Filter column of the elements list shows whether or not the filter is enabled
for an element.

Disabling antialiasing can improve rendering time, although the rendered
element that results might appear jagged.

NOTE Turning off Enable Filter disables only general antialiasing and map filtering.
Edge blending still occurs when this switch is off.

Name Shows the name of the currently selected element. You can type in
a custom name for the element.

This control is unavailable when multiple elements are selected.

Files The text box lets you enter a path and file name for the element. Click
the Files button to display a Render Element Output File dialog, which lets
you choose a folder, file name, and file type for the element.

This control is unavailable when multiple elements are selected.

Output to Combustion group

When on, generates a Combustion Workspace (CWS) file on page 7121  that
contains the elements you are rendering. You can use this file in the
Combustion software, and you can use Combustion workspaces in the
Combustion map on page 5649 .

WARNING If you are rendering elements to composite over a background, make
sure that the file format for the Diffuse, Shadows, and Alpha elements supports
an alpha channel. The formats we recommend for this purpose are: RLA on page
7156 , RPF on page 7159 , PNG on page 7152 , or TGA on page 7162 .
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WARNING 3ds Max supports some file types that Combustion does not. For use
with Combustion, do not render elements as EPS files. If you render to this format,
the CWS file is not saved. See your Combustion documentation for more
information on supported file formats.

Enable When on, creates a CWS file that contains the elements you have
rendered.

... [ellipsis] The text box lets you enter a path and file name for the CWS
file. Click the [...] button to display a Save to Combustion dialog, which lets
you choose a folder and file name for the CWS file.

Create Combustion Workspace Now When clicked, creates a Combustion
workspace (CWS file). This button makes it possible to create a Combustion
workspace without rendering.

NOTE You must add at least one render element for this file to be created and
the Render Output type on the Common panel must be set to AVI, RPF, CIN, JPG,
PNG, MOV, RGB, RLA, TGA, TIF, or EXR.

Render Elements Dialog

Main toolbar > Render Scene button > Render Scene dialog > Render Elements
panel > Render Elements rollout > Add button > Render Elements dialog

Rendering menu > Render > Render Scene dialog > Render Elements panel >
Render Elements rollout > Add button > Render Elements dialog

This dialog appears when you click the New button in the Render Elements
rollout on page 6144 .

Procedures

To choose an element to render separately, do one of the following:

1 Click to highlight the element's name in the list, and then click OK.

2 Double-click the element's name in the list.
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Interface

The scrollable list shows the names of elements you can render separately.
These are described in Render Elements Panel and Rollout on page 6144 .

Render Element Output File Dialog

Rendering menu > Render > Render Scene dialog > Render Elements panel >
Render Elements Rollout > Selected Element Parameters group > Files button

Main toolbar > Render Scene button > Render Scene dialog > Render Elements
panel > Render Elements Rollout > Selected Element Parameters group > Files
button

The Render Element Output File dialog lets you assign a name to a file that
saves one element of the rendering. You can also determine the type of file
you render, and set up options such as compression, and color depth and
quality, depending on your choice of file type.

See also:

■ Image File Formats on page 7116

Procedures

To specify the render element output file and its settings:

1 Choose Rendering > Render, and then on the Render Elements rollout,
in the Selected Element Parameters group, click Files.

The Render Element Output File dialog is displayed.
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2 In the File Name field, enter the name for the file to be rendered.

3 Navigate the Save In field to choose the directory where you want the
rendered file to be saved.

4 In the Save As Type field, choose the type of file you want to render.

5 Click Save to open the Setup dialog for the specified output file type.

Thereafter, the Setup button becomes available on the Render Element
Output File dialog; you can click this to change the settings.

6 Change any settings as necessary, and then click OK to close the Render
Element Output File dialog. Alternatively, clicking Cancel returns you to
the Render Element Output File dialog.

7 Click Render to render and save the file.

Interface

History Displays a list of the most recent directories searched. Whenever an
image is selected, the path used is added to the top of the history list as the
most recently used path.

The history information is saved in the 3dsmax.ini on page 51  file.
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Save In Opens a drop-down list to browse other directories or drives.

Up One Level Moves to the next-highest level in the directory structure.

Create New Folder Lets you create a new folder while in this dialog.

 View Menu Provides several options for how information is displayed
in the list window:

■ Thumbnails: Displays the contents of a directory as thumbnails, without
the details.

■ Tiles: Displays the contents of a directory as large icons, without the details.
If you widen the dialog, these tile across the width.

■ Small Icons: Displays the contents of a directory as small icons, tiled across
the width, without the details.

■ List: Displays the contents of a directory without the details.

■ Details: Displays the contents of a directory with full details such as size
and date.

List of files Lists the contents of the directory, in the format specified by the
View menu.

TIP When the active display format is Details, the contents of the directory are
displayed with Name, Size, Type, Date Modified, and Attributes. You can sort the
list according to a column's contents by clicking that column's label.

File Name Displays the file name of the file selected in the list.

Save as File Type Displays all the file types that can be saved. This serves as
a filter for the list.

NOTE The choice in this field determines the file type saved, regardless of the
extension entered in the File Name field.

Save Sets the file information for saving upon rendering. Closes the dialog
if you haven't changed the output file type.

If you've changed the file type, clicking Save opens the Setup dialog for the
specified file type. Change the settings as necessary, and then click OK to close
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both the Setup and the Output dialogs, or click Cancel to return to the Output
dialog.

Cancel Cancels the selection and closes the dialog.

Devices Lets you choose the hardware output device, for example, a digital
video recorder. To use this function, the device, its driver, and its 3ds Max
plug-in must all be installed on your system.

Setup Displays controls for the selected file type. These vary with each
different file format.

NOTE The Setup button is available only after you click Save, which opens the
setup dialog, and then cancel from the setup dialog. Also, 3ds Max always uses
the Save As Type setting, even if it doesn't agree with the filename extension.

Info Displays expanded information about the file such as frame rate,
compression quality, file size, and resolution. The information here depends
on the type of information saved with the file type.

View Displays the file at its actual resolution. If the file is a movie, the Media
Player is opened so the file can be played.

Gamma group

To set up gamma options for the output file, Enable Gamma Correction must
be on in the Gamma panel on page 7550  of the Preferences dialog (Customize
> Preferences > Gamma). Otherwise, the Gamma controls are unavailable in
the Render Output File dialog.

■ Use Image’s Own Gamma This option is not available in this dialog.

■ Use System Default Gamma Uses the system default gamma, as set on
the Gamma panel of the Preferences dialog on page 7550 .

■ Override Defines a new gamma for the bitmap that differs from the
system default.
Using Override is not recommended for element bitmaps. Using the system
default gamma value ensures that all elements have consistent renderings.

Sequence This is not available in the Render Element Output File dialog.

NOTE To render a sequence of still images, choose the Active Time Segment or
define a range of frames in the Common Parameters rollout of the Render Scene
dialog. If you have selected a still image file type, each frame will append a
four-digit number to the name you have selected, incremented with each frame.
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Preview When on, enables display of the image as a thumbnail in the Image
Window.

Image Window Displays a thumbnail of the selected file, when Preview is
turned on.

Statistics Displays the resolution, color depth, file type, and number of
frames of the selected file.

Location Displays the full path for the file.

Blend Element Parameters Rollout

Main toolbar > Render Scene button > Render Scene dialog > Render Elements
panel > Render Elements rollout > Add button > Render Elements dialog >
Add Blend element to the elements list (or select an existing Blend element
in the list).

Rendering menu > Render > Render Scene dialog > Render Elements panel >
Render Elements rollout > Add button > Render Elements dialog > Add Blend
element to the elements list (or select an existing Blend element in the list).

The Blend element is a custom combination of several other elements. By
default, all elements are turned on in this rollout, and the Blend rendering is
identical to the full, normal rendering, except for the scene background. Use
the check boxes to choose your own combination of elements to appear in
the Blend rendering.

Interface

Ambient When on, include the ambient color component. Default=on.

Diffuse When on, include the diffuse color component. Default=on.

Specular When on, include the specular color component. Default=on.

Self-Illumination When on, include self-illumination. Default=on.
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Reflection When on, include reflections. Default=on.

Refraction When on, include refractions. Default=on.

Apply Atmosphere When on, include atmospheric effects. Default=on.

Apply Shadows When on, include shadows. Default=on.

Paint When on, include the Paint component of Ink 'n Paint materials on
page 5580 . Default=on.

Ink When on, include the Ink component of Ink 'n Paint materials.
Default=on.

Hair and Fur Render Element

Rendering menu > Render > Render Elements panel > Add > Render Elements
dialog > Hair and Fur

The Hair And Fur render element produces an additional image that depicts
only the elements in the scene generated by the Hair And Fur modifier on
page 1049 . This image can be used for compositing.

NOTE The Hair And Fur render element supports only the ”buffer” rendering
method on page 6388 using the default scanline and mental ray renderers. Also, to
use the render element with mental ray, be sure to turn on Render Scene dialog
> Processing panel > Render Elements group > Render Final Image.

Lighting Texture Element Rollout

Main toolbar > Render Scene button > Render Scene dialog > Render Elements
panel > Render Elements rollout > Add button > Render Elements dialog >
Add Lighting element to the elements list (or select an existing Lighting
element in the list).

Rendering menu > Render > Render Scene dialog > Render Elements panel >
Render Elements rollout > Add button > Render Elements dialog > Add Lighting
element to the elements list (or select an existing Lighting element in the list).

The lighting element contains the effects of lighting within the scene,
including color, shadows, direct and indirect light.

This rollout lets you determine which parts of the lighting are included in the
rendering.
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Interface

Direct Light On  When on, the render element includes information from
any direct lights in the scene. The light’s color and projection map should
appear.

NOTE The final color for direct lighting takes surface normals into consideration.

Indirect Light On  When on, the render element includes information from
ambient or bounced lighting in the scene.

NOTE When using radiosity, you should expect things such as color bleed.

Shadows On  When on, the render element includes shadows.

Matte Texture Element Rollout

Main toolbar > Render Scene button > Render Scene dialog > Render Elements
panel > Render Elements rollout > Add button > Render Elements dialog >
Add Matte element to the elements list (or select an existing Matte element
in the list).

Rendering menu > Render > Render Scene dialog > Render Elements panel >
Render Elements rollout > Add button > Render Elements dialog > Add Matte
element to the elements list (or select an existing Matte element in the list).

The Matte render element displays a matte mask for a selected object, material
effects channel (effect ID) on page 5252 , or G-Buffer ID on page 7795 . Each
matching element is represented with a white pixel on the mask.

For more info on matte behavior, see Matte Object on page 7846 .

WARNING The Matte render element does not work when the mental ray material
is applied to objects.
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Interface

Effect ID  Sets the material effects channel on page 5252  to include in the
Matte render element.

G-Buffer ID Sets the G-Buffer ID on page 7795  to include in the Matte render
element.

Include  Opens the Exclude/Include dialog on page 5043 , where you can
select objects in the scene to exclude or include in your Matte mask.

When including, all selected objects are rendered with white pixels.

When excluding, all pixels are white, by default. Selected objects are rendered
as black pixels.

WARNING If you use Exclude, make sure the Effect ID and G-Buffer ID parameters
are not turned on. These modes do not provide good results when used in
combination.

Velocity Element Parameters Rollout

Main toolbar > Render Scene button > Render Scene dialog > Render Elements
panel > Render Elements rollout > Add button > Render Elements dialog >
Add Velocity element to the elements list (or highlight an existing Velocity
element in the list).

Rendering menu > Render > Render Scene dialog > Render Elements panel >
Render Elements rollout > Add button > Render Elements dialog > Add Velocity
element to the elements list (or highlight an existing Velocity element in the
list).

The Velocity element generates a rendering that contains information about
the motion of objects in the frame. You can use the Velocity rendering to
generate motion blur when you use a composition application such as

Velocity Element Parameters Rollout | 6165



Combustion or Flame. There are plug-ins for compositors that generate motion
blur; for example, those created by RE:Vision Effects, Inc.

The advantages of rendering a Velocity element are that the composition
application might give you finer control over the motion blur than 3ds Max
does; you can render a “beauty” frame that does not contain motion blur;
and the Velocity element is quicker to render than using one of the 3ds Max
motion-blur effects.

Another use of the Velocity element is to re-time clips rendered in 3D. There
are specialized applications that allow you to re-time an image sequence, using
velocity data to generate more accurate inbetween frames.

In the Velocity rendering, the motion information is saved as RGB color
information:.red saves movement on the X axis, green saves Y-axis movement,
and blue saves Z-axis movement, relative to the plane of the rendered frame.

The mental ray renderer supports this element, but the mental ray Motion Blur
camera effect must be turned off. Also, some mental ray materials do not support
render elements.

Controls on the element's rollout let you improve the precision of the motion
data saved in the rendering. See the procedure, following.

Procedures

To render a velocity element for an animation sequence:

1 On the Render Scene dialog > Render Elements panel > Render Elements
rollout, click Add. In the Render Elements dialog that appears, highlight
Velocity, and then click OK.

2 Highlight the Velocity element in the Element Rendering list.

3 On the Velocity Element Parameters rollout, turn on Update, then render
several test frames. (Choose frames where object velocity appears to be
the greatest.)

4 After each test frame, make a note of the Maximum Velocity value. If
you need to do so, enter the largest of these values as the Maximum
Velocity to use.

Having a specific Maximum Velocity value will give you more accurate
velocity data.

5 Turn off Update.

Now the Maximum Velocity will remain constant.
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6 Render the animation.

Interface

Maximum Velocity Enter a Maximum Velocity value based on the result
collected by Update. Setting a Maximum Velocity increases the precision of
the motion information. See the procedure, above: Procedures on page 6166 .
Default=1.0.

Update Turn on when you render test frames, as described in the above
procedure. After each rendering, Maximum Velocity is set to the value recorded
by update. Use the largest of these values, and then turn off Update before
you render the full animation. Default=off.

NOTE The Update control does not work with mental ray distributed bucket
rendering.

Z Element Parameters Rollout

Main toolbar > Render Scene button > Render Scene dialog > Render Elements
panel > Render Elements rollout > Add button > Render Elements dialog >
Add Z Depth element to the elements list (or select an existing Z Depth element
in the list).

Rendering menu > Render > Render Scene dialog > Render Elements panel >
Render Elements rollout > Add button > Render Elements dialog > Add Z Depth
element to the elements list (or select an existing Z Depth element in the list).

The Z-depth element is a grayscale representation of the Z depth, or depth
within the view, of objects within the scene. The nearest objects appear in
white, and the depth of the scene in black. Intermediate objects are in gray.
The darker the gray, the deeper the object is, within the view.

This rollout lets you adjust what portion of the scene is shown in the Z-depth
rendering. By default, the rendering includes objects near the front of the
view (Z Min=100.0), and extends for 300 3ds Max units into the scene (Z
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Max=300.0). If your scene is deeper than 300 units, you need to increase the
value of Z Max.

You can use the Update option to let the software automatically determine
the depth extents of objects in the rendered view.

Interface

Z Min The minimum distance to include in the Z-depth rendering. This is
a value in 3ds Max units, and cannot be less than 0.0. Default=100.0

Z Max The maximum distance to include in the Z-depth rendering. This is
a value in 3ds Max units. Default=300.0

Update Lets the software automatically determine the depth range of objects
in the rendered view. When on, after completion of a rendering, the software
changes the Z Min and Z Max values to reflect what the renderer determined.
Typically, you would make a single test rendering with this on, and then turn
off the check box.

Diffuse Texture Element Rollout

Main toolbar > Render Scene button > Render Scene dialog > Render Elements
panel > Render Elements rollout > Add button > Render Elements dialog >
Add Diffuse element to the elements list (or select an existing Diffuse element
in the list).

Rendering menu > Render > Render Scene dialog > Render Elements panel >
Render Elements rollout > Add button > Render Elements dialog > Add Diffuse
element to the elements list (or select an existing Diffuse element in the list).

The Diffuse render element displays the diffuse color component of objects
in the scene.
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Interface

Lighting  When on, the diffuse render element displays the color of objects
after lighting has been applied.

When Lighting is turned off, the element displays the diffuse color of objects
before the lighting gets applied. For textured objects, this will look like a 3D
projection of the texture. However, objects with a single color will look “flat”.

Render to Texture
Make sure the default scanline renderer or the mental ray renderer is the active
renderer. > Select one or more objects. > Rendering menu > Render To Texture

Rendering to texture, or "texture baking,” allows you to create texture maps
based on an object's appearance in the rendered scene. The textures are then
“baked” into the object: that is, they become part of the object via mapping,
and can be used to display the textured object rapidly on Direct3D devices
such as graphics display cards or game engines.

You can render to textures using the mental ray renderer on page 6039

Typical Texture Baking Method

1 Set up a scene with lighting.

Banana object in a lighted room

2 Select the objects whose textures you want to bake.
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Banana object selected

3 Choose Rendering > Render To Texture.

4 A Render To Texture dialog on page 6195  appears. In this dialog, you
choose which elements on page 6174  of the rendering you want to bake.
Elements are aspects of the rendering such as diffuse color, shadows,
alpha (transparency/opacity), and so on.

In this dialog, you can also choose various display options on page 6181
for showing the baked texture in shaded viewports.

TIP If you have a Direct3D graphics display driver, you can use DirectX
viewport shaders on page 5297  to view the baked texture in shaded viewports.
They show how the baked texture will appear on DirectX devices.

5 Click Render.

After you click Render in the Render To Texture dialog, a number of things
happen. (This is a typical set of events; the dialog gives you a lot of control
over how texture baking actually occurs.)

■ The elements you chose are rendered, each to its separate bitmap file.
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Lighting map of the banana

By default, the texture type is Targa on page 7162 , and the element maps
are placed in the \images subfolder of the folder where you installed the
program.

The new textures are “flat”: In other words, they are organized according
to groups of object faces.

■ In the modifier stack, a new modifier is applied to the object. It is called
Automatic Flatten UVs. It is simply an Unwrap UVW modifier on page
1769 , automatically applied.
This modifier manages the mapping of the flattened texture to faces of the
object, and lets you adjust that mapping if necessary.

Flattened texture-mapping coordinates for the banana
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■ A Shell material on page 5570  is applied to the object. This material is a
container for both the object's original material (you don't lose those maps
and settings), and the newly created baked material, with its new textures.
The Shell material lets you access both materials and adjust their settings,
if necessary. It also lets you choose which material to view, the original
material or the texture-baked material, in shaded viewports or in renderings.

New shell material contains the banana's original material (below left) and the
baked texture (below right).

Rendered light map applied to the banana
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With the light map, banana appears lit even when lights are turned off.

That is texture baking in a nutshell.

For best results, Logarithmic exposure control is recommended for Render To
Texture.

If Linear or Automatic exposure controls are used, each object will have
different lighting levels, generating a different histogram. Each object renders
as if it had a different light level and in some cases, you may not get a rendering
at all. This happens because Linear and Automatic exposure controls are view
dependent.

Logarithmic Exposure Control is not view dependent, and will reproduce the
image correctly. See the Exposure Controls on page 6531  topic for more
information about Linear, Automatic and Logarithmic exposure controls.

See also:

■ Baked Texture Elements on page 6174

■ Target Map Slot Assignments on page 6181

■ Render to Texture Dialog on page 6195

■ Render to Texture: General Settings Rollout on page 6197

■ Render to Texture: Objects to Bake Rollout on page 6199
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■ Render to Texture: Output Rollout on page 6204

■ Render to Texture: Baked Material Rollout on page 6208

■ Render to Texture: Automatic Mapping Rollout on page 6211

■ Render to Texture: Add Texture Elements Dialog on page 6213

■ Shell Material on page 5570

■ DirectX Manager Rollout on page 5297

■ LightMap Shader Rollout on page 5598

■ Metal Bump Shader Rollout on page 5599

Baked Texture Elements

Select objects. > Rendering menu > Render to Texture > Render to Texture
dialog > Output rollout > Click Add. > Add Texture Elements dialog > Choose
elements to render.

When you render to texture or “bake” a texture, you choose one or more
elements to render. These elements save aspects of the rendered scene: its
geometry, lighting, shadows, and so on. Some texture elements can display
in shaded viewports; others require a DirectX viewport shader on page 5297
to view in 3ds Max.

When you add an element to render, it appears in a list in the Objects To
Bake on page 6199  rollout. In the list, you can disable or enable rendering of
that individual map, or select it to adjust which components it will include.

NOTE Automatically generated reflections and refractions do not work well with
rendered textures, although they are included in the Complete and Blend texture
maps.

The available element maps are described in the sections that follow.

Limitations of Composite and Blend Materials

If the object has a Composite or Blend material applied to it, only certain
elements render correctly. Which elements render correctly depend on the
renderer you are using.
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The default scanline renderer renders only these elements of a Composite or
Blend material correctly:

■ Diffuse color

■ Specular color

■ Reflections

■ Ambient color

■ Self-illumination color

■ Refractions

The mental ray renderer renders only these elements of a Composite or Blend
material correctly:

■ Lighting

■ Shadows

■ Normals

Component Options (Unique Settings)

Many element maps let you choose to include or not include components of
the rendered scene. When your element to render is highlighted in the list,
these options appear on the Selected Element Unique Settings group.

See also:

■ Render to Texture on page 6169

■ Render to Texture Dialog on page 6195

Complete Map

A complete map saves most surface properties of the rendered object;
specifically:

■ Lighting

■ Diffuse color

■ Specular color
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■ Reflections

■ Shadows

■ Ambient color

■ Self-illumination color

■ Refractions

Component Options (Selected Elements Unique Settings)

For a complete map, you can choose not to render shadows.

Specular Map

A specular map saves only the specular color of the object.

Component Options (Selected Elements Unique Settings)

For a specular map, you can choose not to render lighting or shadows.

Diffuse Map

A diffuse map saves only the diffuse color of the object.

Component Options (Selected Elements Unique Settings)

For a diffuse map, you can choose not to render lighting or shadows.

Shadows Map

A shadows map saves only the shadows cast onto the object.

Component Options (Selected Elements Unique Settings)

There are no unique settings for a shadows map.

Lighting Map

A lighting map saves only the lighting cast onto the object.
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Component Options (Selected Elements Unique Settings)

For a lighting map, you can choose not to render shadows, direct light, or
indirect light.

Normals Map

A normals map saves a color gradient that indicates the direction of normals
on the surface of the object. With a normals map, Direct3D rendering can
make simple geometry appear more complex.

With DirectX 8, you can view a normals map in shaded viewports by using
the Metal Bump Direct3D viewport shader on page 5599 .

With DirectX 9, you can view a normals map in any shaded viewport.

Component Options (Selected Elements Unique Settings)

There are two unique settings for a normals map:

Output into Normal Bump When on, assigns a Normal Bump map to the
Target Map Slot, and places the rendered Normal Bump map in the Normal
component of the Normal Bump map on page 5844 . Default=off.

Render Height Map into Alpha Channel When on, renders a grayscale height
map and assigns it to the alpha channel of the Normal map. If you are
rendering to a file type that doesn't have an alpha channel, this setting has
no effect. Default=off.

Height Map

A height map is a grayscale map that stores the relative height of the source
object when you render with normal projection. (See Creating and Using
Normal Bump Maps on page 6182 .) You can use the height map as a
displacement map on the target object. This is a way to add detail to the edges
of the low-resolution object, because edges are not affected by the normal
bump map itself.

NOTE When using a height map as a displacement map with the mental ray
renderer, be sure to use the Height Map Displacement shader on page 5828 . Also,
turn off Smoothing, either globally on page 6117  or for the individual object on
the Object Properties dialog > mental ray panel on page 262 . In addition, when
rendering with mental ray, if you're applying the height map to a standard material,
apply the map as a Displacement map on the mental ray Connection rollout on
page 5289  (unlock the map first), not on the Maps rollout.
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TIP Using a paint program such as Adobe Photoshop on a height map is possible,
but prone to error. The values in the height map depend on the shapes of both
the low-resolution and high-resolution models, and it's easy to damage the
mathematical accuracy. If you paint any changes onto the map, be careful to
preserve the faceted look, and avoid the temptation to blur away the facets. You
might try painting in Additive or Subtractive mode, to add to or subtract from the
displacement, because Normal mode will set a fixed displacement, making it
difficult for an artist to control the result.

Component Options (Selected Elements Unique Settings)

There are no unique settings for a height map.

Blend Map

A blend map is like a complete map, except that all its components, not just
shadows, are optional.

Component Options (Selected Elements Unique Settings)

For a blend map, you can choose not to render any of the following
components:

■ Lighting

■ Diffuse color

■ Specular color

■ Reflections

■ Shadows

■ Ambient color

■ Self-illumination color

■ Refractions

Alpha Map

An alpha map saves only the alpha channel of the rendered object.

Component Options (Selected Elements Unique Settings)

There are no unique settings for an alpha map.
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Ambient Occlusion (MR) Map

Use an ambient occlusion map when you want the surface information to
describe how much ambient light the surface can receive. The ambient
occlusion map considers the obstruction of the light by surface contours and
surrounding objects. By using the ambient occlusion map when rendering,
you do not need to set up special lighting, replace materials on the objects,
or use with global overrides because the ambient occlusion map already
accounts for these settings.

You can use ambient occlusion maps with or without a Projection modifier
and for many different purposes. Use them to mask layers in Adobe Photoshop,
for items such as painted edits and texture maps. Also use them as dirt maps,
or as masks for reflections or specular light.

NOTE By default, the shader used by the Ambient Occlusion bake element excludes
the low-resolution object from the ambient occlusion calculations whenever
performing projection-mapped texture baking. However, if the Projection Mapping
option Include Working Model on page 6217  is enabled, then the occlusion rays
will include the working model. In this case, projection rays also include the working
model. No undesired blank areas appear on the map, because there are no cases
where a projection ray passes though the lo-res model to hit a point on the high-res
model that is completely occluded by the low res.

NOTE This map is available only when the mental ray renderer is active.
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Original scene surrounded by rendered-to-texture ambient occlusion maps of the floor
object

Top left: Samples=8; Spread=0.8

Top right: Samples=32; Spread=0.8

Bottom left: Samples=16; Spread=0.5

Bottom right: Samples=16; Spread=0.99

Component Options (Selected Elements Unique Settings)

For an ambient occlusion map, you can set the following unique settings:

Samples  Sets the number of rays cast. More rays results in a smoother image.
Default=16.
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Spread Sets the spread of the ray, creating a cone shape. With a value of 0.0
a single point is sampled; with a value of 1.0 the entire hemisphere is sampled.
Range=0.0–1.0. Default=0.8.

NOTE You can set Spread to values greater than 1.0, but only values within the
specified range are useful.

Bright Sets the color in the map where no occlusion occurs. The default
color is white. Click the swatch to change the color.

Max distance Sets the range within which geometry is probed. A value of
0.0 samples the entire scene. For non-zero values, only objects within this
range are sampled. Default 0.0.

Dark Sets the color in the map where complete occlusion occurs. The default
color is black. Click the swatch to change the color.

NOTE Colors between the Bright and Dark values are used to indicate partial
occlusion.

Falloff Defines the amount of falloff of the ray. The greater the value, the
greater the falloff. Default=1.0.

Target Map Slot Assignments

Select objects. > Rendering menu > Render to Texture > Render to Texture
dialog > Output rollout > Target Map Slot: drop-down list > Specify how baked
textures appear in the material.

When you bake textures (render to texture), you have more control for how
the baked texture displays in shaded viewports. You set these in the Output
rollout on page 6204  of the Render To Texture dialog. Using the Target Map
Slot assignments, you can specify in detail which maps will be rendered to
which slots of the existing material.

NOTE The first time you use Render To Texture, all Target Map Slot assignments
are blank. After you set them and render the baked texture, those settings become
the default Target Map Slot settings for future modelling sessions. 3ds Max stores
the Target Map Slot assignments in the texturebake.ini  file in the plugcfg folder
within the program directory.
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Creating and Using Normal Bump Maps

Normal bump mapping is a way of adding high-resolution detail to
low-polygon objects. It is especially useful for real-time display devices such
as game engines, and it can also be used in rendered scenes and animations.

A normals map is a three-color map, unlike the grayscale maps used for regular
bump mapping (see Bump Mapping on page 5382 ). The red channel encodes
the left-right axis of normal orientation, the green channel encodes the
up-down axis of normal orientation, and the blue channel encodes vertical
depth.

Basic Workflow

3ds Max provides a number of different ways to create and use normal bump
mapping, but the most straightforward and simplest workflow involves these
steps:

1 Create a detailed, high-resolution model.

2 Create a simpler, low-resolution model.

The low-resolution model should have the general shape and outlines of
the high-resolution model, and typically it should be a bit smaller, so
that projected detail in the high-res model will appear to be above its
surface.

3 Select the low-res model.

4 Choose Rendering > Render to Texture.

The Render To Texture dialog appears.

5 On the Objects To Bake rollout, in the Projection Mapping group, click
Pick.

A selection dialog appears.

6 Choose the high-res object, and then click Add.

3ds Max applies a Projection modifier on page 1556  to the low-res object.

7 In the Projection Mapping group, turn on Enable.

NOTE At this stage, often you will click Options to display the Projection
Options dialog on page 6214 , which has a variety of settings for how to
generate the projection.

6182 | Chapter 18   Rendering



8 On the Output rollout, add a NormalsMap element (see Baked Texture
Elements on page 6174 ). Assign Bump as its target map slot.

9 In the Selected Elements Unique settings group, turn on Output Into
Normal Bump.

10 Click Render.

3ds Max renders the Normals map, which stores normals data from the
high-res object. As for other kinds of texture baking, it creates a Shell
material and applies that to the low-res object, with the Normals map
assigned as the bump component.

Components of Normal Bump Mapping

In the 3ds Max interface, controls for normal bump maps appear in three
locations:

■ The Render To Texture dialog
Specifically, normal projection controls are found on the Objects To Bake
rollout on page 6199  and the Output rollout on page 6204 .

■ The Projection modifier on page 1556
You can apply a Projection modifier yourself, or let Render To Texture do
so automatically.

■ The Normal Bump map type on page 5844
Render To Texture creates this automatically if you turn on Output Into
Normal Bump (step 9, above).

Viewing Normal Bump Maps

If your display driver uses DirectX 8, you can view normal maps in viewports
by using the Metal Bump shader on page 5599 . If your graphics driver is DirectX
9, you can view normal maps in any shaded viewport. See Direct3D Driver
Setup Dialog on page 7592 .

If your display driver is Software or OpenGL, you can't view normal maps in
viewports. However, you can still render them and use normal mapping in
renderings.

Normal Projection with Sub-Object Selections

You can associate different sub-object selections with different high-resolution
geometry. See Reference Geometry Rollout (Projection Modifier) on page 1560
.
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Troubleshooting Normal Bump Maps

Because of the variety of geometry and different situations that can arise,
normal bump maps sometimes give unexpected results. Usually there is a
workaround for the problem, or more than one. This topic describes some
situations that can arise, and ways to correct them.

Parallel Projection Loses Detail

If the projection cage is set up so projected rays run parallel to part of the
high-resolution geometry, that portion of geometry can be lost in the normal
bump map.

For example, in this scene, the normal bump map is based on a high-resolution
cylinder that has indentations at the top and bottom.
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Default cage around high-res cylinder

However, the normal bump map does not show the end indentations.
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Indentation is missing from top and bottom of the cylinder's normal bump map.

The reason is that with the default projection cage, the rays parallel the sides
of the indentation, and so details are lost.

Projection rays (shown in red) parallel the sides of the indentation.
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To correct the problem, you can move the end of the cage upward, and scale
it inward a little, so the rays don't run so nearly parallel to the side of the
indentation.

Raising and scaling the upper end of the projection cage.

When the cage is adjusted this way, the indentation appears in the normal
bump map.
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With the corrected cage, the upper indentation appears correctly in the normal bump
map.

TIP In situtations like this, another solution can be to use Break on the vertices in
the region of the low-resolution object  where detail is missing from the map. This
increases the number of vertices in the cage, and reduces the chances of geometry
being missed. If you use this method, it is likely you will need to make further
adjustments to the projection cage, as well.
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Breaking low-res vertices causes the indentations to render in the normal bump map.
However, projection now misses some areas of the geometry, so the cage needs to be
adjusted further.

Flipped Seams in Tangent Space

When you use tangent space for your normal bump map, usually the values
used for the tangents are consistent between the hardware shader, renderers,
and third-party applications. However, sometimes portions of the geometry
are flipped, relative to each other, causing discontinuities when you render
or use a hardware shader. Tangent space is the default option for normal bump
mapping, and it is the method you should use for objects that both move and
deform, such as animated characters. This problem does not arise when you
use the other coordinate spaces: world, screen, or local.

For example, in the following scene, the pants show discontinuities. They are
flipped relative to each other, as the arrows show.
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Flipped seams in rendering of pants

Left: Left side shows a discontinuous red stripe

Right: Right side shows a discontinuous blue stripe

The arrows show how the maps are misaligned.

When you render a normal bump map, you can generally see flipped areas as
showing a “flare” of reddish color to the right, and of bluish color to the left.
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Uncorrected normal bump map shows blue and red “flares.”

The solution is to use the UVW Unwrap modifier's Flip Horizontal command
for those sub-object selections that show flaring, or an excess of red areas.
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Normal bump maps corrected using Flip Horizontal

Red and blue are more evenly distributed, with blue predominating.

With the maps corrected, the full rendering, whether with 3ds Max or a
hardware renderer, looks better.
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Corrected normal maps render more smoothly, without discontinuity.

The arrows show how the maps are correctly aligned to wrap around the pant legs.

Noise when Rendering a Normal Bump Map with the mental ray
Renderer

If you use the mental ray renderer to render a normal bump map, and the
model has overlapping faces (for example, where the low-resolution and
high-resolution objects overlap in space), then the normal bump map can
show noise where the faces overlap.
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Red areas show noise from overlapping faces

The workaround is to adjust either the high-res or the low-res object so that
faces are not coincident. One way to do so is to use a Push modifier on page
1574 . After you have generated the normal map, you can turn off the Push
modifier.

TIP If another object in the scene continues to cause problems with the map
rendering, you can make it invisible to normal projection by going to its Object
Properties dialog, and in the Rendering Control group, turning off Visible To
Reflection/Refraction.
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Overlapping UV Coordinates

Overlapping UV coordinates can cause rendering errors in Render To Texture.
The problem is especially noticeable on objects that have mirrored UVs, or
symmetrical mapping. If you are working with a character or other model that
has mirrored UVs, we recommend that you follow this procedure:

1 Either add an Unwrap modifier or go into an existing Unwrap modifier
where the symmetry exists.

2 Move half of the overlapping texture coordinates on the W axis so that
they’re slightly offset from the other half.

Render To Texture will use the texture coordinates with the higher W
value.

Edit Normals Modifier Makes Normal Bump Mapping Incorrect

Don't apply an Edit Normals modifier on page 1284  to the low-res object.
Normal bump projection relies on the low-res object having standard normals,
and altering them causes normal bump maps to have unpredictable results.

Render to Texture Dialog

Rendering menu > Render To Texture > Render to Texture dialog

Rendering to texture, or “texture baking,” is controlled by this dialog. Most
of this dialog's controls are contained in its rollouts.

See also:

■ General Settings rollout on page 6197

■ Objects To Bake Rollout on page 6199

■ Output Rollout on page 6204

■ Baked Material Rollout on page 6208

■ Automatic Mapping Rollout on page 6211
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Procedures

To bake an object's texture:

There are a lot of options for rendering to textures. These are the basic overall
steps.

1 Select an object.

Ideally, the object will have a texture assigned to it, or lights and shadows
that fall on it, and so on.

2 Choose Rendering > Render To Texture.

3 In the same dialog, go to the Output rollout.

4 Click Add, and in the Add Texture Elements dialog, choose the element(s)
you want to render.

5 Set Target Map Slots, if necessary.

6 Click Render.

The elements you chose to render are rendered to files, and the baked
texture is displayed in shaded viewports.

To bake the texture of multiple objects:

1 Set up the texture-baking parameters of each object you want to bake.
This corresponds to steps 2 through 5 of the previous procedure.

2 In the Objects To Bake rollout, change All Selected to All Prepared.

3 Click Render.

Textures are rendered for all the objects you previously set up.
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Interface

Render Renders the scene, or the elements listed in the Objects To Bake
rollout.

Unwrap Only Applies the Automatic Flatten UVs modifier to all selected
objects without rendering anything.

Close Closes the dialog and saves any changes to settings you have made.

Original/Baked When set to Views, the original or baked material is displayed
in the viewports. When set to Render, the original or baked material is used
in the rendering.

Render to Texture: General Settings Rollout

Rendering menu > Render To Texture > Render to Texture dialog > General
Settings rollout

This rollout has the texture-baking controls for the current scene. It lets you
control automatic unwrapping of the baked textures, map size, render settings,
and where texture renderings are saved.

See also:

■ Render to Texture on page 6169

■ Render to Texture Dialog on page 6195

■ Render to Texture: Objects To Bake Rollout on page 6199

■ Render to Texture: Output Rollout on page 6204

■ Render to Texture: Baked Material Rollout on page 6208
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■ Render to Texture: Automatic Mapping Rollout on page 6211

Interface

Output group

Text field Specifies the folder where the rendered texture will be saved. You
can enter a different folder name in this field. Default=the \images subfolder
of the folder where you installed 3ds Max.

Click the ellipsis button to display a dialog that lets you browse to the
directory where you want the rendered texture to be saved.

Skip Existing Files Allows you to render only those maps that do not already
exist.

Rendered Frame Window When on, displays the complete map in a rendered
frame window on page 5885  as the elements are rendered. When off, does not
open the rendered frame window. Default=on.

NOTE The rendered frame window does not open when you use Render To
Texture with the mental ray renderer. Instead, 3ds Max displays a progress dialog.

Render Settings group

These controls let you choose and set up Render Presets as well as activate
network rendering.
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Drop menu Lets you choose Load Preset on page 5922 . A Render Presets Load
dialog appears where you can select an RPS file.

Setup Displays the Render Scene dialog on page 5878 , where you can adjust
production settings, draft settings, or both.

Network Render When on, you can assign the rendering task to Server
systems. If you click Render, the Network Job Assignment dialog on page 6279
displays where you can specify a server, or multiple servers, to take on the
task. Default=off.

3ds Max can use the Split Scan Lines option on page 6284  when rendering to
textures with a render farm. However, if you enable projection mapping and
turn on Sub-Object Levels, this option is unavailable.

Render to Texture: Objects to Bake Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Objects to
Bake rollout

This rollout has controls for the texture baking of individual objects. It lets
you choose which map channel the texture will use, which elements will be
rendered, and at what sizes. It also lets you control filename generation, and
assign the format of rendered texture elements.

See also:

■ Render to Texture on page 6169

■ Render To Texture Dialog on page 6195

■ Render To Texture: General Settings Rollout on page 6197

■ Render To Texture: Output Rollout on page 6204

■ Render To Texture: Baked Material Rollout on page 6208

■ Render to Texture: Automatic Mapping Rollout on page 6211
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Interface
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 Object and Output Settings group

This drop-down list lets you save presets comprising all current Render To
Texture settings, including map types and sizes, from a single object and then
load a preset onto any number of objects. Render To Texture presets use the
RTP filename extension. Presets contain all settings on the Objects to Bake
and Output on page 6204  rollouts and the Projection Options dialog on page
6214 . The only exceptions are the Object Level and Sub-Object Levels radio
buttons in the Objects To Bake rollout > Projection Mapping group and the
Use Automatic Unwrap > Channel numeric values in the Objects To Bake
rollout > Mapping Coordinates group.

Preset Use the upper part of the drop-down list to choose an existing preset
to load. The preset is applied to all objects in the objects list. The list contains
up to the last 10 maps in the order that they were loaded or saved, with the
most recent at the top.

After you choose a preset to load, a dialog appears showing you the path and
name of the file containing the preset. Confirm or deny loading the preset by
clicking Continue or Cancel, respectively.

In addition, if Projection Mapping is enabled, the dialog might contain related
messages. For example, if the target object needs a Projection modifier, the
dialog suggests that you use the Pick function to add one.

Load Object Preset Lets you load a preset that’s not on the list. The preset
is applied to all objects in the objects list. This command appears only when
the list of objects contains one or more entries.

Save Object Preset Lets you save the current settings to a preset for later
reuse.

NOTE You can save a preset only when the list of objects contains a single entry.
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Object list

List of objects Shows all selected objects. Because the dialog is modeless, you
can change the selection while it’s open, and the list updates dynamically.

■ Name column Lists the object's name.

■ Map Channel column Lists the object's current map channel setting.

■ Edge Padding column Lists the object's current edge padding setting.

Selected Object Settings group

Enable When on, the Channel and Padding controls are used for individual,
all selected, and all prepared objects. When off, only selected object texture
rendering uses these settings; “whole scene” rendering does not. Default=off.

Padding The amount, in pixels, that edges are allowed to overlap in the
flattened (“unwrapped”) texture. Default=2 pixels.

If the baked texture shows visible seams when you view it in shaded viewports
or renderings, try increasing this value.

Projection Mapping group

This group contains the controls for generating a normal bump projection.
See Creating and Using Normal Bump Maps on page 6182

Enabled When on, normal bump projection is enabled using a Projection
modifier on page 1556 . When off, the Projection modifier is not used.
Default=off.

To generate a normal map rather than a normal bump map, leave Enabled
turned off.

Modifier drop-down list When an object has been chosen, this list shows
the Projection modifier. If multiple Projection modifiers have been assigned,
their names are visible in the list as well.

Pick Click to designate the high-resolution object from which the Projection
modifier will derive normals. This opens the Add Targets dialog, which works
like the Select From Scene dialog on page 168  to let let you select one or more
objects on which to base the normal map.

Options Click to open the Projection Options dialog on page 6214 , which
contains various normal bump projection settings. When Individual is chosen
(at the bottom of the Objects To Bake rollout), the options affect the selected
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object; when All Selected or All Prepared is chosen, the options apply to all
selected or prepared objects.

Object Level When on, projects from the object level of the high-resolution
object. Default=on.

■ Put to Baked Material (The default.) When chosen, the object-level
projection is rendered in the baked material.

Sub-Object Levels When on, uses the active sub-object selection, and makes
the Mapping Coordinates group > Sub-Objects controls available. Default=on.

■ Put to Baked Material When chosen, the sub-object level projection is
rendered in the baked material.

The following options apply to sub-object rendering, when only a portion of
the geometry is being rendered to the normal bump map:

■ Full Size (The default.) When chosen, the size of the normal bump map
is the same as if all geometry were being rendered.

■ Proportional When chosen, the size of the normal bump map is fitted
to the size of sub-object selection. The Proportional Multiplier on the
Projection modifier's Reference Geometry rollout on page 1560  can change
the default size of the proportional map.

For example, consider a plane that is 4 segments x 4 segments. Each "poly" in
the plane is a separate sub-object, for a total of 16 sub-objects. If the output
Map Size is 64, the object rendering output is 64 x 64 pixels. If Full Size is
chosen, each sub-object rendering is also 64 x 64 pixels. If Proportional is
chosen, each sub-object rendering is 16 x 16 pixels. If you change Proportional
Multiplier to 2.0 in the Projection modifier, each sub-object rendering is now
32 x 32 pixels.

Mapping Coordinates group

Object These controls are for basing the rendered texture on the object level
of the source object.

■ Use Existing Channel When chosen, unwrapping uses an existing map
channel.

■ Channel When Use Existing Channel is active, lets you choose the
channel to use for unwrapping.
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■ Use Automatic Unwrap (The default.) When chosen, uses automatic
unwrapping, and applies an “Automatic Flatten UVs” (Unwrap UVW)
modifier on page 1769  to the objects whose texture is being rendered.

Sub-Objects These controls are for basing the rendered texture on a sub-object
selection of the source object.

■ Use Existing Channel When chosen, unwrapping uses an existing map
channel.

■ Channel When Use Existing Channel is active, lets you choose the
channel to use for unwrapping.

■ Use Automatic Unwrap (The default.) When chosen, uses automatic
unwrapping, and applies an “Automatic Flatten UVs” (Unwrap UVW)
modifier on page 1769  to the objects whose texture is being rendered.

Clear Unwrappers Clears the unwrap modifiers from the stack.

The radio buttons at the bottom of the rollout let you choose which objects
to bake. See Render To Texture Dialog on page 6195  for procedures.

■ Individual Allows you to select each object and choose a set of output
maps and targets for it. The list will display all selected objects.

■ All Selected (The default.) Displays all the selected objects.

■ All Prepared The list will display all visible and unfrozen objects in the
scene, selected or not, which have unwrapped mapping on them.

Render to Texture: Output Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Output
rollout.

This rollout lets you specify the elements to render and their attributes.

See also:

■ Render to Texture on page 6169

■ Render to Texture Dialog on page 6195

■ Render to Texture: General Settings Rollout on page 6197

6204 | Chapter 18   Rendering



■ Render to Texture: Objects To Bake Rollout on page 6199

■ Render to Texture: Baked Material Rollout on page 6208

■ Render to Texture: Automatic Mapping Rollout on page 6211

Interface
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Output List Shows maps names, element names, map sizes and designated
map slots.

■ File Name column Lists the name of the map that will be generated.

■ Element Name column Shows the element corresponding to the map.

■ Size column Displays the map size.

■ Target Map Slot column Shows which map slot will be occupied by the
baked texture in the material.

The output list can display entries in black, gray and blank. If a group of objects
is selected that has already has output assignments, maps that are shared by
all will appear black, maps not shared by all will appear gray. If resolutions or
target types are shared they will appear black, if not they will be blank.

Add Click to display an Add Texture Elements dialog on page 6213  to choose
one or more element types to add to the list.

See Baked Texture Elements on page 6174  for a description of the different
element choices.

Delete Click to remove the currently highlighted element from the list.

Selected Element Common Settings group

Enable When on, renders this element. When off, disables rendering of this
element. Default=on.

Name Enter the element component of the file name. Default=the name of
the element type.

File Name and Type Enter the file name of the rendered texture. Default=the
object name followed by the element name, and TGA format on page 7162 .

This field is disabled if All Selected or All Prepared is turned on in the Objects
To Bake rollout on page 6199 .

Click this button to display a file dialog you use to choose a name,
directory, and file format for the rendered texture.

NOTE The File Name and Type setting specifies the path and filename only for
the selected element. To set a folder where all baked textures will be stored, set
the path in the Output group on the General Settings rollout on page 6197 .
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Target Map Slot Display all Map Types available to the materials assigned
to the objects selected minus the ones already slated for output in the current
Render To Texture session.

If more than one object is selected the all map types common to all the selected
objects will be listed. If you choose to Create New Baked on page 6208 , then
the slots for the new baked material type will be displayed.

Element Type This read-only field displays the type of element, such as
CompleteMap, that you specified when you added the element.

By default, the element name is the same as its type, but you can change it
using the Name field. Element Type remains constant.

Element Background Lets you set the background color of the
rendered output for the highlighted element.

Use Automatic Map Size When on, sets the texture size automatically, using
the values on the General Settings rollout on page 6197 . When off, the texture
is the size specified by the following controls in this rollout. Default=off.

Width/Height Lets you specify dimensions for the texture. Range=0 to 8192.
Default=256.

NOTE Increasing texture resolution increases render time.

To force the texture to be square, often a requirement with real–time 3D
rendering engines, click the lock button next to Height.

Preset resolution buttons (128x128, ...) Click a button to specify a preset
resolution for the texture.

Selected Element Unique Settings group

The contents of the Selected Element Unique Settings group vary depending
on the active element. But the group always shows a list of toggles for various
components of a scene, and by default, all toggles are on.

The following table shows which components apply to which elements (if
the table shows “none,” the Selected Elements Unique settings group is not
displayed):

ComponentsMap Type

ShadowsComplete
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ComponentsMap Type

Lighting
Shadows

Specular

Lighting
Shadows

Diffuse

(none)Shadows

Shadows
Direct Light On

Lighting

Indirect Light On

Output into Normal Bump
Render Height Map into Alpha Channel

Normals

Lighting
Diffuse

Blend

Specular
Reflection
Shadows
Ambient
Self-Illumination
Refraction

(none)Alpha

(none)Height

For a fuller description of the rendered texture elements, see Baked Texture
Elements on page 6174 .

Render to Texture: Baked Material Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Baked
Material rollout
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Material Baking operates on the entire Render To Texture session. It is not set
per individual object.

NOTE When you use Network Rendering, the Render To Baked Material option
is disabled.

See also:

■ Render to Texture on page 6169

■ Render To Texture Dialog on page 6195

■ Render to Texture: General Settings Rollout on page 6197

■ Render to Texture: Objects To Bake Rollout on page 6199

■ Render to Texture: Output Rollout on page 6204

■ Automatic Mapping Rollout on page 6211

Interface
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Baked Material Settings group

Output Into Source When on, replaces any target map slot in the object’s
existing material. Care should be used with this option, because the material
replacement cannot be undone.

NOTE If a selected object to be rendered has a multi/sub-object material assigned
to it, the workflow will not change and the results will be as follows: output into
source will put the resulting map in all sub-material slots that match, instancing
all identical maps, if a sub-material doesn’t have the selected output type it will
be ignored; duplicate in baked will duplicate the entire Multi/Sub-Object Material
into the baked material and perform the above output; create new baked will
create a new single standard material.

Save Source (Create Shell) Makes a new Shell material and assigns it to the
object. When this option is turned on, you can then choose to either Duplicate
Source To Baked, or to Create New Baked.

Duplicate Source To Baked Makes a copy of the existing material as the
Baked material.

Create New Baked Puts a new material in the Baked Material slot. The type
of the new material is set by the drop-down list below and subsequently
determining the available Target Map Slots in the Output rollout.

Shader list Allows you to specify a shader to be used for the newly baked
texture.

Update Baked Materials Builds a Shell material for all selected objects, and
populates the baked material according to the current Render To Texture
settings.

Clear Shell Materials Removes the Shell material on page 5570  applied to the
texture-baked object, and replaces it with either the original material or the
texture-baked material.

The radio buttons below Clear Shell Materials give you a choice of which
material in the Shell material to retain:

■ Keep Source Materials When chosen, the original material replaces the
Shell material.

■ Keep Baked Materials When chosen, the baked material replace the Shell
material.
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NOTE If you have already rendered a baked texture and decide you want to render
with a different shader from the list, you must first click Clear Shell Materials and
then re-render.

Render to Files Only When turned on, the baked texture files are rendered
to the folder you've specified in the Output Path field of the General Settings
rollout on page 6197 . Default=off

Render to Texture:Automatic Mapping Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Automatic
Mapping rollout

These are options specify how Render To Texture should behave when it
automatically flattens UVs or chooses the map size of a baked texture.

See also:

■ Render to Texture on page 6169

■ Render To Texture Dialog on page 6195

■ Render to Texture: General Settings Rollout on page 6197

■ Render to Texture: Objects To Bake Rollout on page 6199

■ Render to Texture: Output Rollout on page 6204

■ Render to Texture: Baked Material Rollout on page 6208
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Interface

Automatic Unwrap Mapping group

These are options for how to flatten UVs when Use Automatic Map is chosen
in the Objects To Bake rollout's Mapping Coordinates group.

NOTE These controls are also provided by the Unwrap UVW modifier's Flatten
Mapping dialog on page 1821 .

Rotate Clusters Controls whether clusters are rotated to minimize the size
of their bounding box. For example, the bounding box of a rectangle rotated
45 degrees occupies more area than one rotated 90 degrees. Default=on.

Threshold Angle The angle used to determine the face clusters to be mapped.
Default=45.0.

As faces are gathered to be mapped, the modifier uses this parameter to
determine which faces get put in a cluster. This is the maximum angle that
can exist between faces in a cluster.

The higher this number, the larger the clusters will be, with consequently
greater distortion introduced as a result of texture faces' proportions deviating
from their geometry-equivalent faces.

Fill Holes When turned on, smaller clusters will be placed in empty spaces
within larger clusters to take the most advantage of the available mapping
space. Default=on.

Spacing Controls the amount of space between clusters. Default=0.02.

The higher this setting, the larger the gap that appears between clusters.
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Automatic Map Size group

Rendering to texture can choose a map size for you. Automatic map sizing is
enabled or disabled by a toggle on the Output rollout on page 6204 . The controls
in this group specify how to create the map, when Automatic Map Size is
enabled. Automatic map sizing computes the total surface area of all objects
in the selection, then multiplies that value by Scale, and creates a square
texture map of those dimensions.

Scale The amount by which to scale the total surface area of generated
texture. Default=0.01.

Nearest power of 2 When on, rounds the map dimensions (length and
width) to the nearest power of 2. Default=off.

Min The minimum size, in pixels, of the length and width of the
automatically sized map. Default=32.

Max The maximum size, in pixels, of the length and width of the
automatically sized map. Default=1024.

Render to Texture:Add Texture Elements Dialog

Rendering menu > Render To Texture > Render to Texture dialog > Output
rollout > Click Add to add a texture element. > Add Texture Elements dialog

This dialog lets you choose which elements will be part of a baked material.
Each element is an individual bitmap. When you display a baked texture in
shaded viewports, some elements might not display.

NOTE If the Direct3D display driver on page 7594  is active, you can use a DirectX
viewport shader on page 5297  to enhance baked texture display.
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Interface

Available Elements Lists the elements available for rendering. See Baked
Texture Elements on page 6174  for a description of the available elements. Click
an element to select it. Use Ctrl+click to select (or deselect) additional elements
individually. Use Shift+click to select a group of contiguous elements.

You can also double-click a single element name to add it to the list and close
the dialog.

Add Elements Click to add these elements to the list in the Objects To Bake
rollout on page 6199  of the Render To Texture dialog.

Render to Texture: Projection Options Dialog

Rendering menu > Render To Texture > Render to Texture dialog > Objects
To Bake rollout > Projection Mapping group > Click Options. > Projection
Options dialog
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This dialog displays options for normal bump projection.

Interface

Objects and Sources group

The text field displays the name of the projection's source object. If more than
one object is selected, it displays the source option chosen in the Render To
Texture dialog: a single object name for Individual, or “All Selected” (the
default), or “All Prepared.”
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Synch All Click to set all Render-To-Texture sources to use the active source
object and the other current Projection Options settings. This button is
available only when there is an individual source object.

Filtering Options group

Crop Alpha Removes antialiasing from the alpha channel.

Global Supersampler When the default scanline renderer is active, the text
field shows the type of global supersampling that is currently in use. When
the mental ray renderer is active, it shows the number of samples per pixel.
Default=None.

■ Setup Click to set up global sampling. When the default scanline renderer
is active, clicking Setup displays the Render dialog's Default Scanline
Renderer rollout on page 5949 , whose Global Supersampling group lets you
globally enable supersampling, and choose the supersampling method.
When the mental ray renderer is active, clicking Setup displays the Render
dialog's Sampling Quality rollout on page 6083 , which lets you adjust the
level of sampling.

Method group

These controls let you choose how to use normals from the source object.

■ Raytrace (The default.) When chosen, normals are ray-traced between
the source and target objects. The objects need to be perfectly aligned in
world space on page 7976 . When you view both high-res and low-res objects
in viewports, they must line up with each other exactly. There are no
special requirements for the mapping coordinates of the high-res objects.

■ UV Match When chosen, normals are obtained by matching the target
object's local UV coordinates to those of the source. The objects' UV
coordinates on page 7962  need to be perfectly aligned. If you look at the
objects using the Unwrap UVW modifier's Edit UVWs dialog on page 1788
, the low-res and high-res objects must be lined up with each other exactly.
The high-res object needs to have mapping coordinates on the same map
channel you are using for the low-res object.
Typically, the high-res object will have an Unwrap UVW modifier assigned
to it, but this is not required.

With this option, the high-res object does not need to be in the same
physical location as the low-res object.
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TIP You can reset the cage (on the Cage rollout on page 1563 ), because UV
Match does not use it.

Use Cage When on, bases projection on the Projection modifier's cage
sub-object. When off, uses an offset instead. Default=on.

Offset Enabled only when Use Cage is turned off. Offset is the distance above
the surface of the source object from which normals are projected. Default=10.0
units.

Resolve Hit group

The two radio buttons are for scenes that have semitransparent objects, in
which case more than one hit can be found for each ray. The remaining
controls in this group are additional projection controls.

■ Closest If there are multiple hits, use the closest object.

■ Furthest (The default.) If there are multiple hits, use the farthest object.

Hit Only Matching Material ID When on, projection is only between material
IDs that match. Turning this option on enables a single map to contain normal
bump projections from different high-res source geometry. Default=off.

Include Working Model When on, bakes from the source object if no target
object can be found. Default=off.

Turning on Include Working Model can be a quick fix when a lot of the
projected rays miss the target object (the Ray Miss Color will be apparent in
the rendered normals map). However, if the low-res object occludes the high-res
object, then Include Working Model will not have the desired effect, and the
normal map will not show high-res details that you want it to. In this case,
adjust the Projection modifier's cage.

This toggle is also useful when the high-res geometry is discontinuous (for
example, a lattice or an array of cylinders).

Ray miss check When on, bakes missed rays as well as rays that hit into the
rendered texture, using the Ray Miss Color. Default=on

■ Ray miss color This color is baked into the texture when projection fails
to hit the target geometry. Click the color swatch to display a Color Selector
on page 331  and change the color used for missed rays. Default=red.
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Normal Map Space group

There are four methods for projecting the normals:

■ World Project using world coordinates. This is useful mainly for objects
that don't move or deform; otherwise, a moving object with world-projected
normals will appear to “swim” through the texture.

■ Screen Project using screen coordinates; that is, flat projection in the Z
axis. This method is useful mainly for stationary objects seen from a single
angle only; for example, a statue seen through a window.

■ Local XYZ Project using the object's local coordinates. This method can
be used for stationary or moving objects, but not for objects that deform:
if the object deforms, the projection will appear incorrect at some frames.

■ Tangent (The default.) Project at a tangent to the target object's surface.
This is the method to use for objects that both move and deform, such as
animated characters.

Orientation

The orientation settings determines what the red and green colors will indicate
in your normal map. The orientation settings are different for the Tangent
method than for the other methods.

The correct setting for red and green depend on what kind of hardware shader
or texture will be used to view the map. Different shaders have different
requirements. The Normal Bump map has controls to flip the red and green;
the Normal Bump texture should work correctly if the map was created with
the default X and Y or Left and Right settings, but if the map was created with
different settings, change the Normal Bump settings to make the map render
correctly, instead of rendering a whole new map.

Orientation: Tangent

For the Tangent method red indicates normals that are pointed either left or
right and green indicates normals that are pointed up or down.
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As an example, if you use Tangent mode with Red set to right and Green set
to down, areas that are red in your normal map would indicate that the
normals were facing towards the right and areas that were green would indicate
that your normals were facing downwards.

The following are the possible values for the Tangent method:

■ Red Can be Left or Right. Default=Right.

■ Green Can be Up or Down. Default=Down.

Orientation: World, Screen, and LocalXYZ

For World, Screen, and LocalXYZ, red indicates that the normals are pointed
toward either a positive or negative X value, while green indicates that the
normals are pointed toward either a positive or negative Y value.

Foir example, if you use World mode with Red set to –X and Green set to –Y,
areas that are red in your normal map indicate that the normals face toward
–X, and green areas indicate that the normals face toward –Y.

The following are the possible values for World, Screen, and Local XYZ
methods:

■ Red Can be –X or +X. Default=+X.

■ Green Can be –Y or +Y. Default=+Y.

Height Map group

Min Height Sets a minimum height for displaced normals. Default=0.0 units.

Max Height Sets a maximum height for displaced normals. Default=10.0
units.

Min and Max Height eyedropper Enable the eyedropper to pick the
minimum or maximum height for the displaced normals by picking or dragging
in a viewport. With the button enabled, click at the desired height. You can
also drag this value until the desired result is achieved. The minimum or
maximum height value is updated based on your selection.

Buffer min Height After you render a normal bump projection, this value is
set to the minimum distance that a projection ray travelled. Default=0.0.
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Buffer max Height After you render a normal bump projection, this value
is set to the maximum distance that a projection ray travelled. Default=0.0.

If you want to use the Height Map texture element, you can render a normal
bump map to obtain the Buffer values, and then set Min Height and Max
Height accordingly, in order to get the best-looking possible Height Map.

Rendering Previews
A preview is an AVI file on page 7118  that can help you preview the animation
in your scene. The preview uses lighting but not materials, so it renders much
more quickly than a fully rendered animation.

The preview commands are on the Animation menu on page 7275 .

Make Preview on page 6220

View Preview on page 6224

Rename Preview on page 6224

Make Preview

Animation menu > Make Preview

Make Preview displays the Make Preview dialog, enabling you to create an
AVI on page 7118  file or custom file type preview of the animation in the current
viewport. You can also render a preview to a specified device.

When the preview is complete, the software starts the Media Player with the
preview _scene.avi file ready to play. (If you don't want the Media Player to
start, choose Customize > Preferences > General and, in the UI Display group,
turn off Autoplay Preview File on page 7536 .)

NOTE Do not open any other program windows that cover up the viewport while
rendering a preview. Anything that covers the viewport will be rendered into the
preview AVI file.

Procedures

To create a preview:

1 Choose Animation menu > Make Preview.
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The Make Preview dialog appears.

2 Change the preview parameters or accept the defaults, and then click
OK.

If the output type is AVI, the software renders the preview and saves it
in a file called _scene.avi, in the path specified by Configure User Paths
> File I/O on page 7524  > Preview. Immediately after rendering the preview,
the software runs Media Player with this animation loaded.

3 View the preview by clicking Play in Media Player.

If you dismiss Media Player and then want to view the preview again,
choose Animation > View Preview. This restarts Media Player with
_scene.avi.

You can save the preview under a different name, so it won't be
overwritten the next time you make a preview. To do so, use Animation
> Rename Preview on page 6224 .
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Interface

Preview Range group

Specifies the frames to be included in the preview, either the active time
segment on page 7702  or a custom range of frames.

Frame Rate group

Specifies the playback frame rate on page 7791  in frames per second. Use Every
Nth Frame to preview a regular sampling of the animation. For example, a
value of 8 includes only every eighth frame in the preview.
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Image Size group

Sets the resolution of your preview as a percentage of the current output
resolution. The output resolution is set in the Render Scene dialog. For example,
if the rendering output resolution is 640x480, and you set the Percent Of
Output spinner to 50, the preview resolution is 320x240.

NOTE The size of the preview image is limited by the size of the viewpanel region
(the region that contains the viewports). The spinner is clamped to the maximum
value that allows the preview image to still fit in the viewpanel region.

Display in Preview group

Specifies the types of objects to include in the preview. Frame Numbers prints
a frame number in the upper-left corner of each frame of the AVI file.
Background includes the assigned viewport background in the preview.

Camera View group

Specifies whether the preview should include multi-pass rendering effects on
page 6036 .

Rendering Level group

Rendering Level drop-down list Specifies the viewport rendering method
on page 7612  to use in the preview.

Output group

Specifies the preview output format.

AVI When chosen, the preview is output as an AVI file. The button to the
right displays the current AVI codec on page 7740 . Click it to adjust the assigned
codec, or choose a different codec. The quality of your output AVI file depends
on the type of codec you use and the codec settings, which vary. For the
highest visual quality, choose the highest compression quality. The higher
the compression quality, the lower the compression, and the larger the
resultant file.

Custom File Type Outputs the preview to the specified file format. When
this option is chosen, and the Create button is clicked, a file selector appears,
where you name the file and specify the output file type. For example, you
can output the preview as a Quicktime movie by specifying a file name with
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a .mov extension. If you specify a single-image format, such as .tga, the preview
is output as a series of sequentially numbered files.

Use Device Lets you output the preview to an external device, such as a
digital recorder. The button at right displays the name of the currently assigned
device. Click it to either change the settings of the device, or assign a different
device.

Render Viewport This list shows the names of the currently visible viewports,
letting you choose which viewport to render from within the Make Preview
dialog. Default=active viewport.

View Preview

Animation menu > View Preview

View Preview displays the Windows-standard Media Player to view the current
preview file.

When you use Make Preview, 3ds Max stores the output preview in a file called
_scene.avi by default. View Preview loads this file. If you want to keep the
preview file, use Rename Preview to save it under another file name, otherwise,
the next Make Preview will overwrite _scene.avi.

The Media Player has its own Help system.

Rename Preview

Animation menu > Rename Preview

Rename Preview renames the _scene.avi preview file.

When you use Make Preview, 3ds Max stores the output preview in a file called
_scene.avi by default. View Preview loads this file. If you want to keep the
preview file, use Rename Preview to save it under another file name; otherwise,
the next Make Preview will overwrite _scene.avi.

Procedures

To rename the preview file:

1 Choose Animation > Rename Preview.

2 Specify a folder and a name for the preview file.
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3 Click Save.

Panorama Exporter Utility
Rendering menu > Panorama Exporter

Utilities panel > Utilities rollout > More button > Utilities dialog > Panorama
Exporter

The Panorama Exporter is a rendering utility that lets you create and then
view 360 degree spherical panoramas.

NOTE You need at least one camera in your scene to use the Panorama Exporter.

Panorama Exporter creates a 360-degree spherical rendering.
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Interface

The Panorama Exporter rollout has two buttons, which let you create or view
a panoramic rendering.

Render Opens the Render Setup dialog on page 6226  for the Panorama
Exporter.

Viewer  Opens the Panorama Exporter viewer on page 6229 .

Panorama Exporter Render Setup Dialog

Rendering menu > Panoramic Exporter > Render button

Utilities panel > Utilities rollout > More button > Utilities dialog > Panorama
Exporter > Render button

The Panorama Exporter Render Setup dialog is a modal on page 7849  version
of the Render Scene dialog on page 5878  especially configured for generating
panoramic output.

NOTE You need at least one camera in your scene to use the Panorama Exporter.

TIP For best results, high resolutions might be necessary. We recommend a
resolution of 2048x1024 or higher unless you're working on drafts.

Interface

This topic covers the main rollout parameters. Additional rollouts might be
available depending on the current renderer. For more information, see Render
Scene dialog on page 5878 .
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Output Size group

Choose one of the predefined sizes or enter another size in the Width and
Height fields (in pixels). These controls affect the image's aspect ratio on page
7718 .

Width and Height Lets you set the resolution of the output image by
specifying the width and the height of the image, in pixels.

Preset resolution buttons (512x256, 1024x512, and so on) Click one of these
buttons to choose a preset resolution.

Aperture Width Lets you specify an aperture width for the camera that creates
the rendered output. Changing this value changes the camera's Lens value.
This affects the relationship between the Lens and the FOV values, but it
doesn't change the camera's view of the scene.

For example, if you have a Lens setting of 43.0 mm, and you change the
Aperture Width from 36 to 50, when you close the Render Scene dialog (or
render), the camera Lens spinner has changed to 59.722, but the scene still
looks the same in the viewport and the rendering. If you use one of the preset
formats rather than Custom, the aperture width is determined by the format,
and this control is replaced by a text display.
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Options group

Atmospherics Renders any applied atmospheric effects, such as volume fog,
when turned on.

Render Hidden Geometry  Renders all geometric objects in the scene, even
if they are hidden.

Effects Renders any applied rendering effects, such as Blur, when turned on.

Area/Linear Lights as Point Lights Renders all area or linear lights as if they
were point lights, speeding up rendering time.

Displacement Renders any applied displacement mapping.

Force 2-Sided 2-sided rendering on page 7697  renders both sides of all faces.
Usually, you'll want to keep this option off to speed rendering time. You might
want to turn it on if you need to render the inside as well as the outside of
objects, or if you've imported complex geometry in which the face normals
are not properly unified. Default=off.

Video Color Check Checks for pixel colors that are beyond the safe NTSC
on page 7863  or PAL on page 7882  threshold and flags them or modifies them
to acceptable values.

By default, "unsafe" colors render as black pixels. You can change the color
check display by using the Rendering panel on page 7560  of the Preference
Settings dialog on page 7534 .

TIP This is useful for draft renderings, as point lights render much faster than area
lights.

NOTE Scenes with radiosity on page 5976  are not affected by this toggle, as area
lights do not have a significant effect on the performance of a radiosity solution.

Super Black Super Black rendering on page 7942  limits the darkness of
rendered geometry for video compositing.

TIP Leave this off unless you're sure you need it.

Advanced Lighting group

Use Advanced Lighting When on, the software incorporates a radiosity
solution on page 5976  or light tracing on page 5963  in the rendering.

Compute Advanced Lighting When Required When on, 3ds Max computes
radiosity when required on a per-frame basis.
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Normally, when rendering a series of frames, 3ds Max calculates radiosity only
for the first frame. If, in an animation, it might be necessary to recalculate the
advanced lighting in subsequent frames, turn this option on. For example, a
brightly painted door might open and affect the coloring of a nearby white
wall, in which case the advanced lighting should be recalculated.

Render Output group

Save File Saves the rendered panorama to disk. This is unavailable until you
have defined a file name by clicking the Files button.

Files Lets you specify the name, location, and file type for the rendered
panorama file.

Rendered Frame Window Enables or disables the panorama exporter’s
rendering display.

Display Viewer When on, the Panorama Exporter viewer on page 6229  opens
upon rendering the panoramic rendering.

Viewport Chooses the camera viewport to render. When you render a
panorama, this drop-down list shows only the cameras in the scene.

Render Click to render the panorama.

Cancel Click to cancel the rendering.

Close Click to close the dialog, saving any changes you've made.

Panorama Exporter Viewer

Renderingmenu > Panoramic Exporter > Viewer button

Utilities panel > Utilities rollout > Panorama Exporter > Viewer button

The Panorama Exporter viewer lets you navigate a rendered panorama. You
can use the viewer to export the panorama rendering with a cylindrical,
spherical, or QuickTime VR format.
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NOTE Exporting to QTVR format requires that QuickTime® 5 or higher be installed
on your system. You can download the latest version from
http://www.apple.com/quicktime/download. For QTVR export, you must choose
the “Recommended Install” rather than a custom or minimal installation. In
particular, your installation must include these components:

■ QuickTime Authoring

■ QuickTime Internet Extras

■ QuickTime Essentials

Procedures

To navigate a rendered panorama:

1 Hold down the left button to rotate the camera around the panorama.

If you move the mouse, the camera rotates in that direction until you
move the mouse again. (The view of the panorama moves in the opposite
direction from the mouse and camera.)

2 Hold down the middle button and move the mouse up and down to
zoom in and out.

3 Hold down the right button and move the mouse to rotate the camera
around the panorama.

With the right button, you must drag the mouse to see any movement,
and the view of the panorama moves in the same direction as the mouse.

To export a rendered panorama:

1 Open a rendered panorama in the Panorama Exporter Viewer.

2 Click File > Export.

Choose Cylinder, Sphere, or QuickTimeVR to set the format for your
exported file.

A dialog opens, prompting you to enter the name, location, and type of file.
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Network Rendering
Network rendering is a means of mass-processing multiple rendering tasks or
jobs. In order to facilitate network rendering, Autodesk BackburnerTM is
installed with 3ds Max. The Backburner software is responsible for coordinating
how job assignments are processed.

You can perform network rendering with both the default scanline and mental
ray renderers. In its most efficient form, network rendering uses multiple
computers, connected over a network, to perform rendering tasks; typically
the rendering of animations with hundreds or thousands of frames. Even a
small network of three or four PCs can save substantial rendering time and
help you meet deadlines.

However, network rendering can be equally useful if you have only a single
PC and need to render a number of images. You can assign the jobs that need
to be rendered and Backburner can manage the rendering of each job while
you're away from the computer. Commonly, jobs are assigned submitted just
before you leave the office. when you arrive the next morning, all your
rendering are waiting for you to review.

Network rendering is designed to render whatever is set up in your scene; that
is, it will render the viewport, part of a viewport, camera view, and so on, as
saved in the scene file. You can also pass batch-rendering tasks to Backburner
from the Batch Render tool on page 6352 . You can queue up tasks from any
number of cameras in a scene. Each task can load a save scene state or use a
particular rendering preset.

The requirements and procedures presented here assume you are the
administrator of a closed network set up exclusively for network rendering.
In practice, you can use the network for file sharing and other purposes, but
if conflicts arise, you might need to cancel those uses. The easiest network to
set up, operate, and maintain is one dedicated to rendering.

NOTE For specific information about setting up network rendering on a single
system, refer to Basic Procedure 1: Single-System Network Rendering on page
6234 .

If you're a system administrator for a more complex network, you can use the
information in this file as a guideline. The basic approach is the same for any
network.

IMPORTANT It is strongly recommended that you follow these procedures for
setting up and running network rendering. Do not attempt network rendering
without reading the instructions that follow.

Network Rendering | 6231



The links on this page are ordered like chapters in a manual: a sequence of
major topics containing more specific nested topics. Links marked Next Step
indicate the next topic in the sequence. Moving from one topic to the next
takes you through the necessary steps to set up your network for rendering.

NOTE Network rendering functions are also available from MAXScript. See
“Network Render Interface” and “Interface: NetRender” in the MAXScript
Reference.

About Backburner

Network rendering is performed by software named Backburner. Functionality
is primarily the same as in previous versions of 3ds Max with the addition of
the following:

■ The Batch Render tool on page 6352  can pass a queue of rendering tasks to
the Network Job Assignment dialog. When submitted, Backburner manages
the rendering of all the active tasks and

■ You can now assign various servers to groups in Backburner. From the
Network Job Assignment dialog you can choose a group as the current set
of servers.

Backburner Documentation

The following table summarizes the Backburner Documentation set.

See:For Information About:

This Network Rendering section.Using Autodesk Backburner with 3ds Max

Autodesk Backburner User’s Guide (Go to
Start > Programs > Autodesk > Autodesk
3ds Max 2008 [32- or 64-bit] > Help)

Autodesk Backburner User Interface (Man-
ager, Server, and Monitor), Troubleshoot-
ing, and Administering Autodesk Backburn-
er

Autodesk Backburner Installation Guide (Go
to Start > Programs > Autodesk > Autodesk
3ds Max 2008 [32- or 64-bit] > Help)

Autodesk Backburner Configuration
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3ds Max Install Guide (Click the Documen-
tation link on the Autodesk 3ds Max 2008
Install DVD 1.)

Installing Autodesk Backburner with 3ds
Max

About Mental Ray

Network rendering with the mental ray Renderer

The mental ray renderer supports network rendering via Backburner and the
command line. The steps for setting up and submitting jobs are exactly the
same as those you'd use for the scanline renderer. No additional licensing or
fees are necessary.

Next Step

How Network Rendering Works on page 6246

See also:

■ Checking Requirements on page 6259

■ Setting Up for Network Rendering on page 6261

■ Basic Procedures for Network Rendering on page 6233

■ Network Job Assignment Dialog on page 6279

■ The Queue Monitor Application  on page 6321

■ Installing Network Services on page 6302

■ Batch Rendering on page 6347

■ Troubleshooting Guide on page 6253

Basic Procedures for Network Rendering

This topic contains basic procedures to follow when network rendering with
3ds Max. The following conditions are assumed:

■ 3ds Max has been installed on all machines to use as rendering servers.
Note: You needn't license the software on machines to be used only as
rendering servers.
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■ All network communications and protocols are installed and operating
correctly.

■ The computers run Windows XP Pro, Windows 2000, or NT 4.0. Limitations
of other operating systems could cause network rendering to be unreliable.

■ All of the computers have names that start with letters. Machine names
that start with a number will fail.

■ You haven't previous attempted network rendering. If you have already
attempted network rendering and want to return to the original state,
delete everything in the \Program Files\Autodesk\Backburner\Network folder
except nrres.dat.

■ Manager and Server have not been installed as services.

Summary of Procedures

■ Procedure 1 - Use this procedure for configuring a single system to render
jobs to itself; in other words, to perform batch rendering that is managed
by Backburner.

■ Procedure 2 - Use this procedure for configuring a Backburner Manager
system to render to one or more Backburner Server systems. The Manager
system will not be involved in the rendering tasks.

■ Procedure 3 - Use this procedure for configuring the Backburner Manager
and Backburner Server systems to render tasks together.

Special Consideration for Procedures 2 and 3

To use a render farm, you must output a frame sequence in a still-image file
format; for example, a series of BMP files. You cannot render animated file
formats such as AVI or MOV to multiple systems. You must render animated
files to a single system. When rendering to an animated file format, the Use
All Servers check box in the Network Job Assignment dialog is unavailable.

Basic Procedure 1: Single-System Network Rendering

This procedure describes usage of network rendering on a single computer.
The main advantage to this method over standard rendering is that you can
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submit multiple rendering jobs for the computer to render. In effect, this lets
you perform batch rendering.

1  Go to Start menu > Programs > Autodesk > Backburner and choose
the Manager menu item.

This starts Manager and creates the backburner.xml file in the
Backburner\Network folder.

When you run Manager for the first time, you will see the Backburner
Manager General Properties dialog, shown below.

Backburner Manager General Properties dialog.
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2 Click OK to accept the default settings.

The Backburner Manager dialog displays.

3  Go to Start menu > Programs > Autodesk > Backburner and choose
the Server menu item.

This starts Server and creates the server data that is stored in the
backburner.xml file.

You will see the Backburner Server General Properties dialog, shown
below, when you run Server for the first time.

Backburner Server General Properties dialog.

4 Click OK to accept the default settings.

The Backburner Server dialog displays. After a few moments, messages
appear in both the Server and Manager windows indicating that the Server
has successfully registered with the Manager.

5 Start 3ds Max and load the first scene you want to render.

6  From the Rendering menu, choose Render, or click the toolbar
Render Scene button.
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7 Set the rendering parameters and specify an output file name. In the
Render Output group on the Common tab, turn on Net Render, and then
click the Render button.

The Network Job Assignment dialog appears.

Network Job Assignment dialog showing the server station that is also running
Manager.

8 Enter a job name (it's a good idea to change the default name) and then
click the Connect button.

The name of your computer (that is, the Server) appears in the Server
window to the right. It has a green dot next to it meaning that it is a
Server system that is ready to start rendering.

Basic Procedures for Network Rendering | 6237



9 Click the Server name to highlight it in the list window, and then click
the Submit button.

The Manager submits the job to the Server, both running only on this
system, and the Server begins rendering each still frame or the animation.

10 To render additional jobs, load each into 3ds Max, and then repeat steps
6-9.

You can submit as many jobs as you like. The software will queue the
jobs up and render them in the order that you submitted them.

Basic Procedure 2: Network Rendering from Server (not Manager)

When rendering across a network, you first assign one machine to be Manager,
and then any number of others as Servers. In this procedure, you won't use
the Manager as a rendering Server.

1  Go to Start menu > Programs > Autodesk > Backburner and choose
the Manager menu item.

This starts Manager and creates the backburner.xml file in the
Backburner\Network folder.

When you run Manager for the first time, you will see the Backburner
Manager General Properties dialog, shown below; this is normal.
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Backburner Manager General Properties dialog.

2 Click OK to accept the default settings.

The Backburner Manager dialog displays.

3 Move to a Server system.

4  Go to Start menu > Programs > Autodesk > Backburner and choose
the Server menu item.

This starts Server and creates the server data that is stored in the
backburner.xml file.
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You will see the Backburner Server General Properties dialog box, shown
below, when you run Server for the first time.

Backburner Server General Properties dialog.

5 Click OK to accept the default settings.

The Backburner Server dialog displays. After a few moments, messages
appear in both the Server and Manager windows indicating that the Server
has successfully registered with the Manager.

6 Repeat steps 3-5 on all the Server systems you intend to make available
for your rendering jobs.

7 Return to the Manager system, start 3ds Max, and load the first scene
you want to render.

8  From the Rendering menu, choose Render, or click the toolbar
Render Scene button.

9 Set the rendering parameters and specify an output path and file name.

6240 | Chapter 18   Rendering



TIP So that the Servers can find the output path, specify the path in the
Render Output File dialog starting with Save In > My Network Places. Then
navigate to the output folder, specify a file name and output format (Save
As Type), and click Save.

10 In the Render Output group, turn on Net Render, and then click the
Render button.

The Network Job Assignment dialog appears.

Network Job Assignment dialog showing all the server stations. The manager
station is excluded.

11 Enter a job name (it's a good idea to change the default name) and then
click the Connect button.
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The names of all Servers appear in the Server window to the right. Those
with green dots next to their names are ready to start rendering.

By default, all the Servers that are listed will take part in the rendering
job. To assign a specific Server to render a job, first turn off Use All Servers
in the Options group, and then highlight the server(s) that you want to
render the job.

12 Click the Submit button.

The Manager submits the job to the Servers, which begin rendering .

At this point, you can load and submit additional scenes. When the first
job is complete, the next job will automatically begin rendering on the
Servers.

Basic Procedure 3: Network Rendering from Manager and Servers

When rendering across a network, you first assign one machine to be Manager,
and then any number of others as Servers. In this procedure, you'll use the
Manager computer as a rendering Server as well.

1  Go to Start menu > Programs > Autodesk > Backburner and choose
the Manager menu item.

This starts Manager and creates the backburner.xml file in the
Backburner\Network folder.

When you run Manager for the first time, you will see the Backburner
Manager General Properties dialog, shown below; this is normal.
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Backburner Manager General Properties dialog.

2 Click OK to accept the default settings.

The Backburner Manager dialog displays.

3  On the same computer, go to Start menu > Programs > Autodesk
> Backburner and choose the Server menu item.

This starts Server and creates the server data that is stored in the
backburner.xml file.

You will see the Backburner Server General Properties dialog box, shown
below, when you run Server for the first time.
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Backburner Server General Properties dialog.

4 Click OK to accept the default settings.

The Backburner Server dialog displays. After a few moments, messages
appear in both the Server and Manager windows indicating that the Server
has successfully registered with the Manager.

5 Repeat steps 3-4 on all the Server systems you intend to make available
for your rendering jobs.

6 Return to the Manager system, start 3ds Max, and load the first scene
you want to render.

7  From the Rendering menu, choose Render, or click the toolbar
Render Scene button.

8 Set the rendering parameters and specify an output path and file name.

TIP So that the Servers can find the output path, specify the path in the
Render Output File dialog starting with Save In > My Network Places. Then
navigate to the output folder, specify a file name and output format (Save
As Type), and click Save.
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9 In the Render Output group, turn on Net Render, and then click the
Render button.

The Network Job Assignment dialog appears.

Network Job Assignment dialog showing all the server station plus the manager
station that is running Server.

10 Enter a job name (it's a good idea to change the default name) and then
click the Connect button.

The names of all Servers appear in the Server window to the right. Those
with green dots next to their names are ready to start rendering.

By default, all the Servers that are listed will take part in the rendering
job. To assign a specific Server to render a job, first turn off Use All Servers
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in the Options group, and then highlight the server that you want to
render the job.

11 Click the Submit button.

The Manager submits the job to the Servers, which begin rendering .

At this point, you can load and submit additional scenes. When the first
job is complete, the next job will automatically begin rendering on the
Servers.

How Network Rendering Works

Rendering networks are sometimes called “render farms.”

In the software, one computer is set up as the network Manager. The Manager
"farms out" or distributes the work to rendering Servers. You can also have
the same computer function simultaneously as both Manager and Server, so
computing cycles don't go to waste.

Once rendering is under way, the Queue Monitor program lets you directly
monitor and control the operation of the network rendering workload. The
Queue Monitor allows you to edit job settings as well as to activate, deactivate,
and reorder both jobs and servers involved in your render farm.

Important: When rendering using a render farm, it is recommended to render
with single-frame formats such as BMP or PNG. Movie file formats such as
AVI output all frames into a single file which cannot be split between different
servers to take advantage of network rendering.

How Work Is Divided

The software breaks up the task of network rendering among the rendering
Servers, assigning one frame at a time to each Server. The completed output
of the Servers accumulates in a common, shared directory.

Rendered frame files can also be written to a local directory on each machine,
if the same path defines the directory. Frame files are sequentially numbered,
making them easy to assemble later.

The Manager takes a number of different factors into account in determining
how to assign frames and jobs, always striving for the most efficient usage of
the rendering network. An idle rendering Server is automatically detected by
the Manager and is considered for job or frame assignment. If a Server goes
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off-line for some reason, the Manager reclaims the Server's current frame and
reassigns the frame to the next available rendering Server.

The Basic Process

Following is a step-by-step description of the sequence of events when you
use network rendering:

1 The user submits a job to the network Manager.

2 On the submitting machine, the MAX file gets zipped up. If the user
turned on Include Maps, all maps and XRefs are also zipped up.

3 Once the file is zipped up, the ZIP file is copied to the Manager machine's
Backburner\Network\Jobs\<jobname> folder. In the folder is an XML file
describing the job itself, specifying frame size, output filename, frame
range, render settings, etc.

4 Once the Manager receives the ZIP and XML files, it looks to see which
servers are sitting idle and can render jobs. It assigns the job to four servers
at a time. (This is the Max Concurrent Assignments setting on the
Manager General Properties dialog. See Starting Network Rendering on
page 6248  ).

5 Each Server machine receives the ZIP and XML files into the
Backburner\Network\jobtemp folder.

6 The MAX file gets unzipped, along with the maps and XRefs if they were
included.

7 3ds Max is launched and loads the MAX file. If the maps and XRefs were
not included, the software searches for them as they are defined in the
MAX file. For instance, if an XRef is in d:\foo\xref.max, the Server will look
for xref.max in d:\foo\ on the local machine. If there are additional map
paths set in the 3dsmax.ini on page 51  file on the rendering server, it
will search in those paths as well. If it does not find the maps and XRefs,
the server fails for that particular job.

This is why it is important to use UNC paths for all maps and XRefs in
your scene file, so that all render servers can find them. However, if the
maps and XRefs were included, then 3ds Max will get the ones that were
unzipped into the \jobtemp folder.

8 When a frame is finished rendering, 3ds Max on the Server saves the
frame to the location specified via the Render Scene dialog before you
submitted it.
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9 Once a Server successfully renders one frame, the Manager assigns a block
of frames to the server to render; it might assign 20 consecutive frames.
This minimizes the amount of communication needed between the Server
and Manager.

10 The Server continues rendering frames for the job until the job is done.

11 The Server then closes 3ds Max, and goes idle. If the queue contains
additional jobs, the Server picks up the next job and starts the process
all over again.

You can use this explanation to help determine the basic requirements
for your network rendering setup, based on the type of usage. If your
frames render quickly, you'll need a fast file server machine to handle
the constant output from a number of different rendering servers. The
same holds true of your scene uses a large quantity of map files that are
stored in a central location. If you typically render large files, rendering
will take longer, and most of the bandwidth will be required at the start,
when the files are distributed to the rendering servers.

Next Step

Checking Requirements on page 6259

Starting Network Rendering

Once you've set up the network rendering system and software on page 6272 ,
there are two steps to starting a network rendering session:

■ Start the Manager program on one machine and the Server program on
every other machine in the network. See Basic Procedures for Network
Rendering on page 6233 . The machine being used as a manager can also be
used as a rendering server.

■ Start a rendering job from the software on a networked machine with an
authorized copy of 3ds Max.

The Manager and Server programs need to be started and left running during
a network rendering session. Either program remains in operation until you
shut it down or shut down the machine.
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When you've set up the Manager and Server network services, you're ready to
submit an animation to the network rendering queue. There are two stages
to starting network rendering:

■ In the Render dialog, set all desired rendering parameters, including
resolution and rendered output file type, and render the scene. In 3ds Max,
you can render from the Render Scene dialog on page 5878 , or the Render
To Texture dialog on page 6195 .

■ In the Render dialog, set all desired rendering parameters, including
resolution and rendered output file type, and render the scene.

■ Turn on Net Render, found in the Render Output, Render Settings or Output
groups, and then click Render to open the Network Job Assignment dialog
on page 6279 , which lets you make final decisions about the job and submit
your animation to the rendering servers.

Next Step

Network Rendering Manager  on page 6308

Network Rendering Server on page 6315

Procedures

These procedures explain how to start and submit a network rendering job in
3ds Max.

This procedure explains how to render a job over the network, once the
Backburner Manager and Server are running. (See the Autodesk Backburner
Installation Guide for information on setting up the Backburner Manager and
Server.)

To start the Manager program:

1 Run the Manager program from the Start menu > Programs > Autodesk
> Backburner folder.

The first time you run the Manager after installation or after deleting the
backburner.xml file, the Manager Properties dialog appears. In most cases,
you can accept the default settings and click OK to continue.

Thereafter, when you start the Manager, its window appears and the
"Starting Network Manager" message is displayed in the window. The
machine is now running the Manager in Desktop mode. You can leave
this window open to see messages relating to what the Manager and
Servers are doing as they appear, or you can minimize it, whereupon it
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resides in the taskbar tray. To reopen the window when minimized, click
its icon in the taskbar tray.

NOTE If you're running Windows 2000 and have the NetBEUI protocol
installed, and you have unplugged your network cable, when you start the
manager, you'll see an error message, "Error starting network subsystem,
cannot start manager." If this happens, reconnect the network cable and try
again.

2 Alternatively, you can run the Manager as a service, as described in
“Setting Up Backburner Manager as a Windows Service” in the Autodesk
Backburner Installation Guide. Once set up, the Manager automatically starts
when you boot the system and it's always available.

To start the Server program:

1 Run the Server program from the Start menu > Programs > Autodesk >
Backburner folder.

The first time you run the Server after installation or after deleting the
backburner.xml file, the Server Properties dialog appears. By default,
Automatic Search is turned on, and the subnet mask is set to
255.255.255.0. This should work with most networks. Alternatively, turn
off Automatic Search and enter the manager name or its IP address in
the Manager Name or IP Address field.

Thereafter, when you start the Server, its window appears and the "Starting
Backburner Server" message is displayed in the log window. After a few
seconds you should also see the "Registration to (manager IP address)
accepted" message in the Server window. This message indicates that the
server has found the manager and is correctly communicating with it. If
you do not see the "Registration to ..." message in the Server window, see
“Troubleshooting Backburner” in the Autodesk Backburner User’s Guide.

The machine is now running as a rendering Server in Desktop mode. You
can leave this window open to see other messages as they appear, or you
can minimize it to the taskbar tray. To reopen the window when
minimized, click its icon in the taskbar tray.

2 Alternatively, you can run the Server as a service, as described in Network
Rendering Server on page 7862 . Just running the Manager as a service, once
it's installed and started, it's always available, even after rebooting.
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To start a network rendering job:

1 Start the Backburner Manager and Backburner Server.

2 Start the software on a machine with an authorized copy of the program.

3 Open the scene you want to render.

4 Choose Rendering menu > Render to display the Render Scene dialog.

You can also render from the Execute Video Post dialog or the Render To
Texture dialog.

5  In the Render Output group, click the ellipsis button to display the
Render Output File dialog.

6 In the File Name field, enter the Universal Naming Convention (UNC)
on page 7961  name of the output directory, followed by the name of the
output file. For example:

\\machine1\project1\images\output.tga

As an alternative to entering the UNC name from the keyboard, you can
go to Save In > My Network Places and navigate to the machine and
shared directory where you want the servers to write the rendered frames.
After selecting the machine and shared directory in the Map Network
Drive dialog, enter the output file name (for example, output.tga), and
then click OK. The software automatically converts the shared directory
to the UNC format.

If the output directory is mounted, enter the name and extension of the
output file and choose the drive mounted for the output directory from
the Save In list.

7 Click OK to display the Setup Options dialog for the file format type you
have selected.

8 Make the desired settings and click OK.

9 Click OK again to return to the Render Scene dialog.

Save File is turned on once you assign an output file.

10 After setting any other rendering parameters, turn on Render Output
group > Net Render and click Render.

The Network Job Assignment dialog appears.

If you use Video Post, set the file location with an Add Image Output
Event. After you click Execute Sequence, be sure to turn on Net Render
before you click Render.
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To submit a network rendering job:

1 Start the Backburner Manager and Backburner Server.

2 In the Network Job Assignment dialog, make sure the Automatic Search
option is on, and then click Connect.

In most cases, the software detects the Manager machine and displays
its attached Servers in the Server list. If auto-detect fails, turn off Automatic
Search and manually enter the name or IP address of the network machine
acting as the Manager, and then click Connect.

All rendering Servers running under the network Manager should be
listed with green dots next to them. Even if a server is running an
interactive session of the software, it will still render an assigned job by
launching a second copy of the software.

3 By default, the job will use all available Servers. To use only specific
Servers, turn off Use All Servers and choose the machines you want to
use from the Server list.

4 Click Submit.

The job is submitted to the Manager, which then distributes the job to
the machines assigned in the Network Job Assignment dialog. Network
rendering begins.

When network rendering begins on a rendering Server, the Rendering
dialog appears on machines running serverapp.exe. If a machine is running
the service version, no dialog appears.
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Troubleshooting Guide

This is a guide to solving common problems associated with network rendering.
Solutions to these problems vary, depending on whether you are using the
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network rendering programs as installed Windows Services, or running them
in Desktop mode. Also see “Troubleshooting Backburner” in the Autodesk
Backburner User’s Guide.

PROBLEM:When I try to assign a job in the Network Job Assignment
dialog, some of the servers display a gray or yellow icon.

SUGGESTION

Regardless of their state in the Network Job Assignment dialog, servers can
always be assigned new jobs.

The gray icon means that the server is currently not available to render a job.
This state can occur for several reasons, including:

■ The server has not been correctly started. (See “Setting Up Backburner
Server” in the Autodesk Backburner Installation Guide.)

■ The server has been disallowed for the current time period in the Properties
dialog of the Monitor. (See “Setting the Availability for Rendering Nodes”
in the Autodesk Backburner User’s Guide.)

■ The server has experienced abnormal termination.
If you've checked for and corrected these conditions and the servers are
still unavailable, stop running Server on each of the problem machines,
and restart the service after a few seconds. This "purges" the server and
may solve the problem. Then click Refresh in the Network Job Assignment
dialog to display the most recent information about the server.

The yellow icon means that the server is busy rendering another job. If the
server should not be busy, verify that the queue is clear of jobs by opening
the Queue Monitor and connecting to the Manager. If the queue is clear of
rendering jobs and the server is still flagged as busy, stop running server on
each of the problem machines, and restart the service after a few seconds.

PROBLEM:When I submit a job to be rendered, the server fails.

SUGGESTION

Servers can fail for a variety of reasons during a network render job. Many of
these reasons are covered in “Troubleshooting” in the Autodesk Backburner
User’s Guide. One reason that is specific to 3ds Max which can cause a server
to fail is the presence of a scene which does not contain texture coordinates.
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All errors are recorded in the appropriate log file. You can learn more about
log files in “Configuring Backburner Log Files” in the Autodesk Backburner User’s
Guide.

Here are some of the error messages related to 3ds Max, along with a likely
cause, that you will see in the Errors tab of the Queue Monitor when a failed
server is selected:

ERR: ----- Render Error:

ERR: D:\MAPS\3DS.CEL [where this is the location of a map in the submitted
scene]

The Server could not find 3ds.cel in the local path specified, which means that
the path to this map is not been correct for network rendering. To fix the
problem, do one of the following:

■ If all maps are being shared from a single directory, make sure the directory
is correctly shared with full permissions. See Sharing a Directory on page
6275 .

■ Make sure that you have used either the full UNC path name for the
bitmaps or that the maps directory has been mounted to the same drive
letter on each machine. In this case, verify that particular path has been
added to the Configure User Paths dialog > External Files panel on page
7526  of every server's local version of the software or that the particular path
was used when assigning bitmaps in the scene to be rendered.

■ Verify the bitmaps still reside in the shared directory.

■ Add an Alternate Map Path on the Network Job Assignment dialog that
points to the folder containing the missing map.

ERR: Object (UVW 1): Sphere01 requires texture coordinates and may not
render correctly

Open the scene and make sure the errant object is assigned texture coordinates.
This can be as simple as adding a UVW Map modifier to the object.

ERR: Frame error

Texture coordinates must be applied to the specified object to render it on
the server.

ERR: Load Error: Missing DLL'S

Following this error, you will also receive a listing of each of the missing DLLs
in the scene. Files needed by the server are not available to render the job.
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Make sure that all the plug-in DLLs used in a job reside on each of the servers
rendering the job.

ERR: Job not found. Ok if just deleted

When you delete a job, the Manager sends out a notification to all clients
(Monitors) telling that the job has changed. This is the same message sent
when the job completes, gets suspended, resumed, etc. The monitors in turn
request the job status from the manager. The manager doesn’t find the job (it
was just deleted) and returns this error to the monitor.

ERR: Targa - The device is not ready. (0x15)

ERR: Frame error

The server could not write the output file. "Targa" represents the file output
type, and will change depending on the output file type you selected. This
problem can occur for several reasons:- If you are running the Backburner
Server as an installed Windows 2000/XP service, make sure that the user
account that the service is logged to has adequate permissions. Administrative
permissions are recommended.

■ Check to make sure the target output directory is shared, with both read
and write permissions.

■ Verify that the path for saving file output in the Render Scene dialog is set
to a valid UNC path name.

■ Verify that the path for saving file output in the Render Scene dialog (or
the Output Event dialog in Video Post) is set to a valid UNC path name.

■ If you are writing to a shared directory mounted locally on each server,
verify that the directory is mounted to the same drive letter on each server,
and that the file output path is set for that drive letter.

PROBLEM:The Server fails to render a frame and displays the
following error:

Rebooting 3ds Max by force due to load timeout.

SUGGESTION

The Server has exceeded either the Wait For 3ds Max To Load or Wait For 3ds
Max To Render value. This is usually caused by attempting to render large
files over the network. Increase these values in the Advanced Settings dialog
on page 6296 .
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PROBLEM: I cannot assign more than one server to a job in the
Network Job Assignment dialog.

If the output of a network-rendering job is an AVI or MOV file, or a single
user device, the job can be assigned to a single server only. The Network Job
Assignment dialog changes, depending on the file output type of a job. For
example, if you are network rendering to one of the file formats above, the
All and None buttons do not appear and the dialog title bar contains the word
"Single."

If a job that has an AVI or MOV file output type is stopped for any reason (to
deactivate it, or because a machine goes down), re-rendering the file restarts
at the first frame. Frames cannot be appended later to these file types.

SUGGESTION

To take advantage of the distributed power of network rendering we suggest
you first render to a series of Targa files. Then use the Targa files as either an
animated background in an empty 3ds Max scene, or as an image input event
in Video Post and render the sequence out to the desired output type (for
example, AVI).

PROBLEM:When I click the Render button on the Render Scene
dialog, I get an error dialog stating:

Error Retrieving Configuration File

This error usually is the result of a corrupt installation of the Backburner
applications which caused an errant registry setting.

SUGGESTION

Try reinstalling the Backburner components of the program or manually edit
the system registry.

Editing the registry:

1 Choose Start > Run.

2 Enter RegEdit and click OK

3 Browse to HKEY_LOCAL_MACHINE > SOFTWARE > Autodesk >
Backburner > 2007.1

4 Check the CfgPath entry. Make sure the value is set to c:\Program
Files\Autodesk\Backburner\Network\nrapi.conf.
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5 Close the Registry Editor.

PROBLEM: Backburner not found message when clicking Render
button:

Cannot network render. Backburner not found or not installed.

This error dialog appears because the path to Backburner is either not set
properly in the Path environment variable or Backburner is missing altogether.

SUGGESTION

Verify that the Path variable is set properly and make sure you've installed the
latest version of Backburner.

PROBLEM: Clicking Render button results in Backburner plugin error:

Error creating 3ds Max plugin instance for Backburner.

The path to 3ds Max is not set in the PlugPath section of the
\Backburner\Network\nrapi.conf file.

SUGGESTION

Verify the presence of the \Backburner\Network\nrapi.conf file and check the
PlugPath. It should look like this:

PlugPath=C:/Program Files/Autodesk/Backburner/

PROBLEM:The manager and server windows display strange, garbled
text:

Your error message includes @#$$#@.

This error occurs if the nrres.dat file is missing or damaged. This file is located
in: C:\Program Files\Autodesk\Backburner\Network

SUGGESTION

Copy the nrres.dat file from another system that is not exhibiting the problem,
or reinstall Backburner.
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System Setup

Checking Requirements

Checking Requirements

Setting up even a small render farm can require a substantial amount of time.
As a first step, verify that your proposed network meets the basic requirements.
You should also be acquainted with the software required to render over the
network.

Hardware Requirements

■ One machine on the network must have the software set up and authorized.
This system is used to submit network rendering jobs.

■ One machine runs a network manager to communicate with rendering
servers. You can set up any machine in the network for this purpose. No
authorization is required if this machine will not run as a 3ds Max
Workstation.

■ To install the software, at least one machine needs a DVD-ROM drive
mounted for access over the network. Instructions for setting up the
network-rendering software are found in the Setting Up Rendering Software
on page 6272  section.

■ Other machines operate as rendering servers. No authorization is required
on these machines.
Rendering servers should meet the minimum requirements for running
the software. To improve rendering performance, use machines with faster
processors, additional memory, and more swap space. A rendering server
does not require a monitor while rendering, although it's helpful to have
one for setup. Display adapters and accelerators make no difference in
rendering performance.

Network Requirements

For operating system requirements, see “Backburner Component Requirements”
in the Autodesk Backburner User’s Guide. You must also be connected over a
network with TCP/IP protocol properly installed. See Instructions for
configuring TCP/IP for network rendering on page 6264 .
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Software Requirements

One authorized copy of the software is the minimum requirement. With this
one copy, you can set up the software on multiple machines for the purpose
of network rendering. Later topics provide explicit details for doing a custom
setup on each machine. During this setup, programs required to render over
a network are installed and registered.

Four separate programs interact to accomplish network rendering. The
following descriptions identify these programs and provide an overview of
their use.

■ 3dsmax.exe
3ds Max is used to launch job assignments. You submit a network rendering
job from the Render Scene, Render to Texture or Execute Video Post dialog.
The application is also used by the rendering servers to render the job.

■ manager.exe
When run, this application sets up one computer as a network manager.
Alternatively, you can run Manager as a service by installing managersvc.exe.
See Installing Network Services on page 6302 .

The manager program manages communication with the rendering servers
during a network rendering job. This can be set up on any machine in the
network. However, if large files are to be submitted and many rendering
servers are going to be used, a fast computer with a large amount of disk
space is the best choice. In almost all network-rendering scenarios, you
only have a single manager running on the entire network.

■ server.exe
When run, this application sets up the computer it's run on to be used as
a rendering server. Alternatively, you can run Server as a service by
installing serversvc.exe. See Installing Network Services on page 6302 .

The server program sends its local IP address to the Manager program,
which in turn registers the Server so it will be available for network
rendering a job assignment. When the server receives a job from the
network manager, it launches a local copy of the software to perform the
rendering. The server then sends the completed frame to a target directory
and begins rendering the next frame sent to it by the manager. The server
shuts down the 3dsmax.exe 3dsviz.exe process when it is no longer needed.

■ monitor.exe
This standalone program, named Queue Monitor, provides a Windows
interface that lets you monitor and schedule network rendering. Since the
Queue Monitor is a standalone program, you can start it at any time from
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any computer in your network. The only requirement is that you establish
a TCP/IP connection with the computer running the manager.

You can load Queue Monitor on each rendering server and use it to monitor
rendering progress locally. You can also connect with Queue Monitor
remotely using Windows NT Remote Access.

Setting Up for Network Rendering

Whenever different groups need to cooperate on a project, accurate
communication and common procedures are essential. A rendering farm is
such a project.

Network setup can be difficult to configure, but you only need to do it once.
Take your time to get the right setup. Read each topic in order and complete
the steps described.

These instructions are for creating a new network dedicated specifically to
network rendering. If you are configuring network rendering for an existing
network or for a network that will be used for other purposes, these instructions
are intended as a reference example only.

Next Step

Setting Up TCP/IP on page 6261

See also:

■ Setting Up Rendering Software on page 6272

■ Setting Up Directories on page 6273

■ Initial Setup for Manager and Server Programs on page 6300

Setting Up TCP/IP

The software uses the standard network protocol, TCP/IP, for network
rendering. TCP/IP is a two-part acronym. TCP (Transport Control Protocol)
communicates data between applications. IP (Internet Protocol) communicates
data between an application and the physical network. Each computer in your
rendering network needs to be configured for this protocol.

System Setup | 6261



Before continuing, be sure that:

■ You have administrative privileges on each machine.

■ The network is operational, with network adapter cards installed in each
machine.

The TCP/IP protocol requires a device, called a network adapter or Network
Interface Controller (NIC), to bind with in order to communicate with other
machines. Typically, the network adapter is a network card, but if you are
linked to the Internet by modem, a dial-up adapter (the modem) is used.

TCP/IP uses IP addresses to identify the computers on a network. For
convenience, you can assign real names to computers. An IP address is a serial
number of four integers separated by periods, for example, 192.100.100.1.

IP addresses can be fixed (as in the example above) or automatic, supplied
dynamically each time you connect to the network by a system known as
DHCP (Dynamic Host Configuration Protocol).

The software uses the NIC number, which can be thought of a unique serial
number assigned to each network card, to identify each machine in the
network. This allows the use of DHCP since the IP address usually changes
when a machine using DHCP is rebooted.

In some cases, you may want to specify a fixed IP address, for example:

■ When you have more than one Manager running on the same network,
each with its own set of dedicated Servers, you need to specify which
Manager to use. DHCP can be used in this case, but you will have to specify
the Manager name instead of its IP address.

■ The second case is when the Server or Queue Monitor is outside the local
network (as in the case of a WAN or a multi-segmented network connected
through a router). In this case, Servers connected to the same network can
still use DHCP, provided the Manager has a fixed name and IP address.

■ If your network is set peer-to-peer without an NT server (as is the case with
most home networks), it is easier to set the machines with permanent,
fixed IP addresses.

■ Finally, you can use batch rendering on page 6347  without being connected
to a network. In that case, you will need to set up a fixed TCP/IP address
and configure the Microsoft Loopback adapter.

In the case of fixed addresses, it is important that IP addresses be properly
assigned. In this step, you make up a list of machine names and their
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corresponding IP addresses to use during TCP/IP configuration. The list will
also be used when installing the software’s rendering services.

Using the Manager name is particularly useful when its IP address is assigned
dynamically via DHCP, and can change from session to session.

On a closed network, you don't have to worry much about conflicts with the
IP addresses of other network domains. However, the addresses need to follow
a consistent pattern and each must be unique within your network.

WARNING On an open network, such as those in many large corporations, do
not  alter IP addresses in any way. In such cases, to avoid potentially disastrous
consequences, always work with your system administrator to make IP address
changes.

Procedures

To create machine names and IP addresses:

■ Create a list of machine names and IP addresses.
Unless you have specific needs for later compatibility with another network,
use the following list as a model.

Since the Manager machine can also act as a server, start naming your
servers to match their IP addresses as shown in the list below. Remember,
any one machine can act as a manager under network rendering. Like an
IP address, each name must be unique. Also keep in mind that you must
not use the numbers 0 or 255 in the last group (or octet) of an IP address
as they are reserved.

WARNING Machine names should not  start with numbers or have spaces or
underscores in them, as those will result in illegal names in TCP/IP. This will cause
unexpected behavior in the network rendering system.

IP AddressMachine Name

192.100.100.1server001

192.100.100.2server002

192.100.100.3server003

......
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IP AddressMachine Name

192.100.100.254server254

Configuring TCP/IP

From the previous step, Setting Up TCP/IP on page 6261 , you should have a
list of machine names and IP addresses. With that list, go to each machine
and follow these procedures.

On an open network, such as those in many large corporations, do not alter
IP addresses, machine names, workgroup names, or domain names in any
way. In such cases, to avoid potentially disastrous consequences, always work
with your system administrator to make IP address changes.

Procedures

Some of the following procedures are for Windows XP Professional ; others
are for Windows 2000. Find your operating system at the end of the procedure
heading and follow that set of instructions.

NOTE During the writing of these procedures, Windows XP was set to display a
Classic Windows interface.

To assign a name and workgroup or domain (Windows 2000):

1 From the Windows taskbar, open Start menu > Settings > Control Panel
> System.

This displays the System Properties dialog.

2 Click the Network Identification tab, and then click the Properties button
to display the Identification Changes dialog.

If you've already assigned a name to the computer, the name should
appear in the Computer Name field on the Network Identification tab.
Check this name against your list.
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3 To change the name, in the Computer Name field, enter a name for the
machine.

■ The first character of a valid machine/host name must not be a
numeral.

■ Do not use underscores or spaces in the machine/host name.

4 In the Member Of group, enter either a workgroup or domain name,
depending on how your network is going to be set up.

Workgroup An organizational unit that is used to group computers that
don't belong to a domain. If you are setting up a simple network for the
purpose of Network Rendering, use the Workgroup option.

Domain A more complex way of grouping servers that share a common
security policy and user account database. A domain requires you to set
up a Primary Domain controller. You should select the Domain option
only if your Network Administrator has a Domain already set up and
functioning correctly.

To assign a name and workgroup or domain (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Control Panel
> System.

This displays the System Properties dialog.

2 Click the Computer Name tab, and then click the Change button to
display the Computer Name Change dialog.

If you've already assigned a name to the computer, the name should
appear in the Computer Name field on the Computer Name tab. Check
this name against your list.

3 To change the name, in the Computer Name field, enter a name for the
machine.

■ The first character of a valid machine/host name must not be a
numeral.

■ Do not use underscores or spaces in the machine/host name.

4 In the Member Of group, enter either a workgroup or domain name,
depending on how your network is going to be set up.

Workgroup An organizational unit that is used to group computers that
don't belong to a domain. If you are setting up a simple network for the
purpose of Network Rendering, use the Workgroup option.
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Domain A more complex way of grouping servers that share a common
security policy and user account database. A domain requires you to set
up a Primary Domain controller. You should select the Domain option
only if your Network Administrator has a Domain already set up and
functioning correctly.

To add the TCP/IP protocol (Windows 2000):

1 From the Windows taskbar, open Start menu > Settings > Network and
Dial-up Connections > Local Area Connection.

This opens the Local Area Connection Status dialog.

2 Click the Properties button.

This opens the Local Area Connection Properties dialog.

3 Check the list for "Internet Protocol (TCP/IP)".

If you find this listing, TCP/IP is installed on this machine. Go on to
either of these procedures in the current topic:

■ To configure TCP/IP in DHCP mode on page ?

■ To configure TCP/IP with fixed IP addresses on page ?
If TCP/IP is not installed, make sure none of the list items is
highlighted (click in a blank area of the list), and complete the
remaining steps in this procedure.

4 Click the Install button.

This opens the Select Network Component Type dialog.

5 In the list, click Protocol, and then click the Add button.

6 In the Select Network Protocol dialog, select Internet Protocol (TCP/IP),
and then click OK.

A message appears: "Do you want to use DHCP?". Consult your system
administrator to see if your network is DHCP-compatible; if it is, click
"Yes". If you are unsure, click "No" and proceed to set your workstations
with fixed IP addresses.

TCP/IP is added to the list of installed protocols.

7 Click the Close button.
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To add the TCP/IP protocol (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Network
Connections.

This opens the Network Connections dialog.

2 Right-click Local Area Connection and click the Properties button.

This opens the Local Area Connection Properties dialog.

3 Check the list for "Internet Protocol (TCP/IP)".

If you find this listing, TCP/IP is installed on this machine. Go on to
either of these procedures in the current topic:

■ To configure TCP/IP in DHCP mode on page ?

■ To configure TCP/IP with fixed IP addresses on page ?
If TCP/IP is not installed, make sure none of the list items is
highlighted (click in a blank area of the list), and complete the
remaining steps in this procedure.

4 Click the Install button.

This opens the Select Network Component Type dialog.

5 In the list, click Protocol, and then click the Add button.

6 In the Select Network Protocol dialog, select Internet Protocol (TCP/IP),
and then click OK.

A message appears: "Do you want to use DHCP?". Consult your system
administrator to see if your network is DHCP-compatible; if it is, click
"Yes". If you are unsure, click "No" and proceed to set your workstations
with fixed IP addresses.

TCP/IP is added to the list of installed protocols.

7 Click the Close button.

To configure TCP/IP in DHCP mode (Windows 2000):

1 From the Windows taskbar, open Start menu > Settings > Network and
Dial-up Connections > Local Area Connection.

This opens the Local Area Connection Status dialog.

2 Click the Properties button.

This opens the Local Area Connection Properties dialog. You should see
your network adapter card listed as "Connect Using" at the top of this
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dialog. If your adapter is not listed, follow the instructions in Windows
2000 documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties.

The Internet Protocol (TCP/IP) Properties dialog appears.

4 Make sure the option "Obtain an IP address automatically" is chosen.

5 Click OK to close each dialog in turn.

Windows 2000 finishes configuring the software.

6 Reboot the computer to complete the configuration.

7 Repeat all the steps on this page on every machine in your network.

To configure TCP/IP in DHCP mode (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Network
Connections.

This opens the Network Connections dialog.

2 Right-click Local Area Connection and click the Properties button.

This opens the Local Area Connection Properties dialog. You should see
your network adapter card listed as "Connect Using" at the top of this
dialog. If your adapter is not listed, follow the instructions in Windows
XP documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties.

The Internet Protocol (TCP/IP) Properties dialog appears.

4 Make sure the option "Obtain an IP address automatically" is chosen.

5 Click OK to close each dialog in turn.

Windows XP finishes configuring the software.

6 Reboot the computer to complete the configuration.

7 Repeat all the steps on this page on every machine in your network.

To configure TCP/IP with fixed IP addresses (Windows 2000):

1 From the Windows taskbar, open Start menu > Settings > Network and
Dial-up Connections > Local Area Connection.

This opens the Local Area Connection Status dialog.

2 Click the Properties button.
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This opens the Local Area Connection Properties dialog. You should see
your network adapter card listed as "Connect Using" at the top of this
dialog. If your adapter is not listed, follow the instructions in Windows
2000 documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties.

The Internet Protocol (TCP/IP) Properties dialog appears.

4 Choose “Use The Following IP Address”.

5 In the box for IP Address, enter the address for that machine.

Check your list to make sure the entry is correct.

6 In the box for Subnet Mask, type these numbers (these are the same for
every machine):

255.255.255.0

If you are on a large corporate network, this subnet mask might be
different. In this case, use the mask that your network administrator
specified. Also, change the network mask when setting up a server to
connect to a manager as well as in the Network Job Assignment dialog
to match the subnet mask in order for Automatic Search to work.

7 Click OK to close each dialog in turn.

Windows 2000 finishes configuring the software.

8 Reboot the computer to complete the configuration.

9 Repeat all the steps on this page on every machine in your network.

Remember that each machine needs to have a unique IP Address and
machine name so no conflicts arise.

To configure TCP/IP with fixed IP addresses (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Network
Connections.

This opens the Network Connections dialog.

2 Right-click Local Area Connection and click the Properties button.

This opens the Local Area Connection Properties dialog. You should see
your network adapter card listed as "Connect Using" at the top of this
dialog. If your adapter is not listed, follow the instructions in Windows
2000 documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties.
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The Internet Protocol (TCP/IP) Properties dialog appears.

4 Choose “Use The Following IP Address”.

5 In the box for IP Address, enter the address for that machine.

Check your list to make sure the entry is correct.

6 In the box for Subnet Mask, type these numbers (these are the same for
every machine):

255.255.255.0

If you are on a large corporate network, this subnet mask might be
different. In this case, use the mask that your network administrator
specified. Also, change the network mask when setting up a server to
connect to a manager as well as in the Network Job Assignment dialog
to match the subnet mask in order for Automatic Search to work.

7 Click OK to close each dialog in turn.

Windows XP finishes configuring the software.

8 Reboot the computer to complete the configuration.

9 Repeat all the steps on this page on every machine in your network.

Remember that each machine needs to have a unique IP Address and
machine name so no conflicts arise.

Creating a Special User Account

If you run the Server as a Service, you should create a special user account,
which gives the Server the right to access other machines on the network for
necessary maps, xrefs and output directories. This account must be identical
across all rendering server machines.

By assigning a user to the rendering Server service, you configure the rendering
server to operate with the permissions and access rights of that user account.
Without this assignment, the rendering server operates with system
permissions, which do not let the server service access map, xref, image, or
output directories on other machines.

NOTE These steps require you to have administrative privileges on every machine
where you set up this account.

For the following procedures, Windows XP was set to display a Classic Windows
interface.
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Procedures

To create a new user (Windows 2000 and XP):

1 From the Start menu, select Settings > Control Panel > Administrative
Tools > Computer Management.

2 In the Computer Management dialog, go to System Tools > Local Users
and Groups > Users.

3 In the right-hand pane, right click in a blank area and choose New User
to display the New User dialog. If the New User option is unavailable,
you don't have the required administrative privileges.

4 In the New User dialog, do the following:

■ Enter a user name for the new account in the Username text box. This
can be any name, but it should be the same across all network
rendering machines.

■ Enter a password for the new account in the Password and Confirm
Password boxes. Like the user name, this password needs to be the
same for all rendering servers.

■ Turn off “User Must Change Password At Next Logon” and turn on
“Password Never Expires”.
This will bypass errors when you assign this special user account to
the rendering service.

■ Click Create to create the new user and password.
When the network is part of a domain it is a good idea to have your
network administrator create a special user account on the domain.
This user account would have read/write access to the network servers
where maps, xrefs and frames are stored.

■ Click Close.

5 Do not close Administrative Tools.

To assign a user to a rendering service (Windows 2000 and XP):

Do the following on every computer used as a rendering server:

1 Make sure each server system is set up with the Network Rendering Server
on page 6315  running as a service.

2 From the Administrative Tools windows, choose Services to display the
Services dialog.
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3 From the Service list, right-click the Backburner Server item.

4 Choose Properties to display the Properties dialog.

5 On the Log On tab, choose This Account and enter the name of the new
user you created for the special user account.

If a user account was created on the domain, you would enter [domain
name]\[user name] as This Account, or you can browse the domain for
the user.

6 In Password and Confirm Password fields, enter the password for the
special user account.

7 Click OK to exit the Properties dialog.

8 If the service is started, stop it by right-clicking the item and choosing
Stop.

9 Right-click the item and choose Start to restart the service with the newly
assigned user.

NOTE If you did not turn off “User Must Change Password At Next Logon”
when setting up the new account, you will encounter errors. You will need
to re-login the newly assigned user so you can first change the password.
Once the password is changed, the Backburner Server should start.

10 Close the Services dialog

Setting Up Rendering Software

When you've configured the computers on your rendering network for TCP/IP,
you're ready to load the software.

You need to install 3ds Max on each system you plan to use for network
rendering. After you've installed 3ds Max on all the systems, at least one of
them needs to be authorized. This is the copy of the software that you will
run interactively and is used to submit jobs for network rendering.

Refer to the Installation Guide for details about installing 3ds Max.

NOTE A system using the scanline renderer, that is intended to act a dedicated
rendering server, does not require authorization for 3ds Max.
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Setting Up Directories

During network rendering, common directories (directories that are shared
across the network) allow access to files needed by all the rendering servers.
You can organize, share, and (if necessary) mount these directories.

There are two types of common directories:

■ Map directories One or more directories where maps and images are
stored. These can be both project-specific and general locations.

■ Output directory A single directory where completed frames are sent
from each rendering server, also called the target directory. You specify
this directory for each job. This can also be a local directory on each
machine.

The network rendering system uses the Universal Naming Convention (UNC)
to identify directories and files. UNC names begin with a double backslash
and do not include a drive letter. This is the convention:

\\machine_name\directory\subdirectory\filename

IMPORTANT To simplify network rendering, use UNC names whenever possible
within a 3ds Max scene, even if the directory is on the local machine.

TIP When entering UNC names, omit the \\ before the computer name until
you've entered the entire path and file name. This eliminates search delays when
entering UNC path names into file selection dialogs.

Some networks require drive letters instead of UNC names. Directories on
such networks can be mounted as drive letters and shared over the network.
See Mounting a Directory on page 6276 .

Organizing Directories

Correctly organizing directories is critical to the success of your rendering
farm. Every element in a scene needs to be available to each server for a
complete rendering. The goal is to give every machine in your network the
same "picture" of where files are located. Follow these rules when organizing
your directories:

■ Share directories on page 6275  to make them available to the network.

■ Use UNC file specification when assigning maps files and output directories,
even when the directory is on a local machine.
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Creating Map Directories

As you assign materials in a scene, the software stores the complete path to
each map you use. The program searches for that particular location. If
necessary, the program continues to look through the directory containing
the scene file and its subdirectories.

Maps, specific to a project, should be kept in a dedicated directory that has
been set up for that project. You can create subdirectories below this directory
to organize files. This directory needs to be shared using Windows Explorer.

Maps for general use, such as texture libraries, can be organized as you choose.
The computers containing such libraries need to be on the network, and the
directories need to be shared.

Creating a Common Output Directory

A common output directory is a single directory on one hard disk where
rendered frames accumulate during network rendering. When creating a
common output directory, follow these guidelines:

■ Decide on a machine to accept final output. It should have enough disk
space to store the largest completed animation file you're likely to render.

■ Create or choose a directory for final output.

■ Share that directory as a resource available to the network.

Creating a Local Output Directory

A local output directory lets you use available storage on each rendering server.
Rendered frame files are sequentially numbered when assigned by the network
manager. When you collect the finished frames, they automatically sort in
the proper order. When creating a local output directory, follow these
guidelines:

■ Use the same path and name for all local directories. For example, use
\3dsmax_files\images\.

■ Use the same path and name for all local directories. For example, use
\Program Files\Autodesk VIZ 2008\images.

■ Specify this path for the output directory when you start network rendering.
All rendering servers will then send their output to this local directory.
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On any one rendering job, use either a common or local output directory.
They cannot be mixed.

See also:

■ Mounting a Directory on page 6276

■ Using Configure User Paths on page 6277

Sharing a Directory

You share a directory from the machine where the directory is located. This
gives other machines on your network access to that directory. The instructions
below are general. See your Windows Vista, Windows XP, or Windows 2000
documentation for details.

Next Step

Initial Setup for Manager and Server Programs on page 6300

See also:

■ Mounting a Directory on page 6276

■ Using Configure User Paths on page 6277

Procedures

To share a directory:

1 Go to the machine that contains the directory you want to share.

2 In Windows Explorer, right-click the directory to share, and then choose
Sharing from the right-click menu.

3 If using Windows XP or Windows 2000, on the Sharing tab, choose the
Share This Folder option.

4 If using Windows NT4, on the Sharing tab, select the Shared As option.

5 Use the default Share Name.

6 Click Permissions and make sure permissions are set to Everyone/Full
Control. Click OK to exit the Permissions dialog.
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7 Click OK to accept the changes.

NOTE If you plan to use more than 10 rendering servers, both the output
path and location of all scene maps should be on a system running Windows
XP or Windows 2000 Server, as both Windows XP Professional and Windows
2000 Professional have a limit of 10 simultaneous connections.

Mounting a Directory

You can mount a directory to a drive letter as an alternative to using UNC
names on page 7961 . In mixed UNIX/XP/2000 networks, for example, you
might need to mount the output directory.

For network rendering, you mount (or map) the directory on all machines in
the network. This gives all rendering servers access to the shared directory.

Before beginning this setup, choose a common drive letter for all servers to
mount. If you have other drives mounted, you might need to switch
assignments to free the drive letter for this mount.

If a Map or Target directory is on a rendering server, mount the directory on
this machine like all the others, even if the directory is on the local disk.

When using a mounted directory, be sure that the directory to be mounted
is correctly shared. When assigning bitmaps, always use the path with the
common drive letter.

The steps below are general. See your Windows XP or 2000 documentation
for more details.

NOTE During the writing of these procedures, Windows XP was set to display a
Classic Windows interface.

See also:

■ Sharing a Directory on page 6275

■ Using Configure User Paths on page 6277
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Procedures

To map a directory to a drive letter (Windows 2000 or XP):

1 In Windows Explorer, choose Tools > Map Network Drive to display the
Map Network Drive dialog.

2 Set the Drive drop-down menu value to the common drive letter you've
chosen.

3 In Folder, enter the exact location of the output directory, using UNC
convention.

You can also map a directory to a drive letter by choosing the machine
and shared directory with the Browse button in the Map Network Drive
dialog.

4 Click Finish to complete the mount.

NOTE If the drive maps to a server on a large corporate network, you may
be required to enter your user name and password to gain access.

Using Configure User Paths

Render-only machines do not require any form of authorization. However,
you cannot use unauthorized versions of the software to access the Configure
User Paths dialog on page 7520  to specify alternative locations for servers to
search for bitmap files.

If you do not want to concern yourself with configuring paths on render-only
machines (servers), then turn on the Use Alternate Map Path or Include Maps
option on the Network Job Assignment dialog on page 6279 .

The Use Alternate Map Paths option lets you specify an alternate folder where
the rendering server can look for bitmaps if they are not found in the primary
bitmap path.

If using Include Maps, network rendering will take care of making copies of
the bitmaps and send them to the server assigned for rendering. When the
rendering job is done, the copies are erased from the server hard drive. The
files are placed in a \network\serverjob subdirectory of the software.

If a server cannot find a bitmap image in the path specified in the file, it then
searches the paths listed in its own Bitmaps panel. Only after searching in all
locations will the server fail due to missing maps. If you have followed
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instructions in the previous topics ( Setting Up Directories on page 6273 , Sharing
a Directory on page 6275 , and Mounting a Directory on page 6276 ), then you
know that a common map directory on the network is the best way to proceed.
Use the following steps to properly configure your paths on the machine
running the authorized copy of the software and on the servers meant for
render-only purposes.

See also:

■ Sharing a Directory on page 6275

■ Mounting a Directory on page 6276

Procedures

To add bitmap paths to the External Files panel from within the software:

1 Run the software on a machine running an authorized copy of the
program.

2 Choose Customize > Configure User Paths to open the Configure User
Paths dialog, and then click the External Files tab, if necessary.

3 Use the Add button to specify the paths ( UNC on page 7961  or mounted)
to every directory on the network where bitmap files are stored for
rendering. Make sure you use UNC or mounted directories, even if the
maps are on the local drive.

4 Click OK.

To add bitmap paths to render-only machines using the initialization file:

Use the following steps if you do not want to authorize the software on the
server machine(s).

1 Install the 3ds Max core software on the server station(s).

2 Copy the 3dsmax.ini on page 51  file from your authorized 3ds Max
workstation to the program directory of each of your server(s).

If you followed the previous procedure, the copied initialization file contains
information about UNC or mounted directories that stores the required bitmap
files.
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NOTE To prevent mishaps, it is usually a good idea to edit the INI file once it is
copied to the server. Remember that the server machine can be configured
differently than your 3ds Max workstation: The drive letter, program directory,
and subdirectories may be different. Use a word processor to edit all entries under
the [Directories] section to match entries of the server machine.

For example:

[Directories]

Fonts=d:\3dsmax\fonts

Scenes=d:\3dsmax\scenes

Import=d:\3dsmax\meshes

Export=d:\3dsmax\meshes

...

Network Job Assignment Dialog

Rendering menu > Render > Render Scene dialog > Turn on Net Render (Render
Output group) > Render

Rendering menu > Render To Texture > Render To Texture dialog > Turn on
Net Render (Render Settings group) > Render

Rendering menu > Video Post > Set up a sequence with an Image Output Event
> Turn on Net Render (Output group) > Render

Use the Network Job Assignment dialog to name rendering jobs, specify the
computers that will participate in the rendering, and submit jobs to the
rendering servers.

You can submit as many jobs as you like in a single session. Open each file
you want to render and submit it following the standard procedure. Each job
is placed behind the last one submitted. If you submit a job in which the
frame output name is the same as another job in the queue, a warning dialog
asks you if you want to overwrite the output frames from the other job.

You can divide the work of rendering a single image among any number of
rendering servers. This is particularly useful when rendering a single, extremely
high-resolution image intended for print. To use this feature, turn on the
Split Scan Lines option on page 6284 .
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Procedures

To use the Network Job Assignment dialog:

The Network Job Assignment dialog is accessible when you turn on the Net
Render toggle. The Net Render toggle can be accessed from three different
dialogs used for rendering.

1 Rendering menu > Render > Render Scene dialog > Render Output group

2 Rendering menu > Render To Texture > Render Scene dialog > Render
Settings group

3 Video Post dialog > Execute Sequence > Execute Video Post dialog >
Output group

4  In the Render Scene dialog > Render Output group, click the ellipsis
button and then specify an output file name and path using Universal
Naming Convention (UNC) on page 7961 . The easiest way to specify a
UNC path is to start with Save In > My Network Places.

5 Turn on Net Render.

6 Click the Render button.

The Network Job Assignment dialog appears.

7 In the Network Job Assignment dialog, specify a job name.

By default, this is the file name of the current scene. Click the plus (+)
button next to the Job Name field to increment the job name. Unlike the
plus button in the file dialogs, this button does not automatically launch
the job.

NOTE The software does not let you submit multiple jobs with the same
name.

8 Determine whether to find the Manager automatically or manually. By
default, the software searches automatically for the Manager using a
network mask that you specify in the dialog. Alternatively, turn on Manual
Search and enter the name or IP address of the computer running the
Manager program.

9 Click Connect to continue.

You see a listing of all servers available for network rendering. Each server
is marked with a colored icon to denote its current status:

Green Running and not rendering any jobs.
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Yellow Rendering another job. You can assign jobs to busy servers, and
the jobs will be rendered in the order received.

Red Failed. Try rebooting the server or see Troubleshooting on page
6253  for more information on failed servers.

Gray Absent. Verify that the Server is currently running and that it has
not been "Disallowed" in the Week Schedule. See “Scheduling the
Availability of a Render Node Using the Backburner Monitor” in the
Autodesk Backburner User’s Reference.

If a rendering Server is running on a workstation that also has an
interactive session of the software, you can still select that machine for
rendering. A second copy of the software is launched to execute the
network render.

You can view statistics of a particular Server by right-clicking its name
and choosing Properties.

10 Determine whether you will use the selected server, all servers, or a group
of servers.

11 Click Submit to send the job to the rendering queue.
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Interface

Job Name Provides a field for you to name the job (mandatory). The + button
beside the field adds incremental numbering (Job01, Job02, and so on).

NOTE The software does not let you submit multiple jobs with the same name.

Description Enter an optional description of the job.

Enter Subnet Mask/Enter Manager Name or IP Address group

Enter Manager Name or IP Address When Automatic Search is turned off,
enter the name of the Network Manager on page 7861  machine or its IP address.
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Enter Subnet Mask When Automatic Search is on, enter a subnet mask for
automatic search. For information on using subnet masks.

Connect/Disconnect Connects to the network Manager. The software
preserves the connection as a global setting so that you need to change it only
when you want to specify an alternative Manager. If connected to the network
manager, click Disconnect to disconnect from the current manager so you
can choose a different manager.

Automatic Search Determines whether the software connects to a specific
manager or searches for one using a subnet mask when you click Connect.
When off, the software attempts to connect to the manager you specify in
this group. When on, it searches the network for a manager using the specified
subnet mask.

Refresh Updates the Server and Job lists.

By default, all servers are used for the job. When the Options group > Use All
Servers check box is turned off, you can choose one or more servers to render
the job. If rendering to a multiple-frame file format, such as an AVI or MOV
file, you can choose only one server.

Priority group

Priority Specifies a priority ranking for the job. The lower this setting, the
higher the job priority. Default=50.

For example, consider a job with priority 1 (Job B) that is submitted to a
network manager that's already rendering a job with priority 2 (Job A). Because
Job B has a higher priority, Job A will be suspended and Job B rendered. When
Job B is finished, the software will resume rendering Job A.

If two or more jobs have the same priority, they're executed in order of
submission.

Critical Sends the job to the head of the queue, preempting the existing jobs.
If a server is currently rendering and a critical job is sent to the queue, the
server will stop rendering its current job and begin rendering the new, critical
job. When finished with the critical job, the server returns to the next job it
has been assigned in the queue.

Dependencies Opens the Job Dependencies dialog on page 6289 , which you
can use to specify existing jobs that must finish before the current job can
start.
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Options group

Enabled Notifications Lets the software send rendering-related messages via
email. When this is on, its Define button becomes available. For information,
see the Notifications dialog on page 6291  topic.

Define Opens the Notifications dialog, which lets you set notifications
parameters.

Split Scan Lines Lets you subdivide the rendering of each frame among the
rendering servers. This is useful when rendering a single, extremely
high-resolution image intended for printing. For information, see the Strips
Setup dialog on page 6293  topic.

When Split Scan Lines is on, its Define button becomes available.

NOTE This feature does not support Render Elements. Also, it's unavailable when
rendering to textures with projection mapping enabled and Sub-Object Levels on.

Define Opens the Strips Setup dialog, which lets you set parameters for the
Split Scan Lines option.

Ignore Scene Path When off, the server attempts to copy the scene file from
the manager to the server. If the manager is running on Windows 2000
Professional, only 10 servers will copy the file from the manager; any machines
over the limit 10 will use TCP/IP to retrieve the file. When turned on, the
servers get the file via TCP/IP only. Default=off.

Rendered Frame Window During rendering, displays the rendered frame
window on all servers running serverapp.exe (not serversvc.exe). Default=on.

Include Maps Archives the scene, with all of its maps, any inserted Xrefs
and their maps, into a proprietary-format compressed file. The compressed
file is sent to each Server, where it is uncompressed into a temporary directory
named serverjob in the \network subdirectory of the program and rendered.
Default=off.

Use this feature if you have access only to Servers that exist over the Internet
or if you have a slow network setup. It is not meant for heavy production use.
However, if you don't use it, you must first ensure that all network servers
have access to all map and Xref paths referred to in the scene.

Initially Suspended Adds the named job to the queue in an inactive state.
The job is not started until you activate it manually from the Backburner
Monitor. See “Monitoring and Managing Jobs” in the Autodesk Backburner User’s
Guide.
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Server Usage Group

You choose between using all available servers, all servers in a group, or selected
servers. See “Configuring Server Groups” in the Autodesk Backburner User’s Guide
for an explanation of how to set up server groups. In a 3ds Max setup it can
be useful to set up servers in groups. For example, during busy times you can
assign high priority jobs to a group of high performance servers.

Use Selected Uses only the servers that you have highlighted in the Server
list.

Use Group Uses all of the servers in a group.

TIP Note that the servers are assigned to a group in the Autodesk Backburner
monitor.

Group drop-down list Choose the group of servers that you want to use for
your render.

Use All Servers Uses all Servers in the active Server group for rendering the
job. Available only after you submit a multi-frame rendering job.

Path File Group

Use Alternate Path File Allows you to specify an alternate path file in the
MXP format that rendering servers can use to find bitmaps that are not found
on the primary map paths. When on, you can manually enter the path and
file name in the field below the check box, or click the ellipsis button and
browse to the MXP file.

NOTE Create MXP files with Configure User Paths on page 7520 .

Status group

Displays text messages describing the current status of the job assignment.

Server list

The Server list, located on the upper-right side of the Network Job Assignment
dialog, displays all network rendering servers on page 7862  registered with the
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network manager after you connect to the manager. There are two types of
tabs in the Server list:

■ All Servers Lists all of the available servers that can be used for your
render. When this tab and Use All Servers are enabled, all servers will be
used to render the job.

■ [group name] Lists all of the servers assigned to a group. When this tab
and Use Group are enabled, all servers listed on the tab will be used to
render the job.

NOTE If a server is unavailable it will be skipped and the next available server will
be used.

If more groups are available than can fit in the space above the list, arrow
buttons for scrolling the group list horizontally appear above the list's top-right
corner. Click these arrow buttons to scroll the list left or right to view
additional group tabs.

By default, each Server is marked with a colored status icon:

■ Green Running and not rendering any jobs.

■ Yellow Rendering another job. You can assign jobs to busy Servers, and
the jobs will be rendered in the order received.

■ Red Failed. Try rebooting the Server or see Troubleshooting on page 6253
for more information on failed Servers.

■ Gray Absent. Verify that the network Server is currently running and
that it has not been "Disallowed" in the Backburner Monitor. See
“Launching the Backburner Monitor” in the Autodesk Backburner User’s Guide
for information on viewing activities in the monitor.

NOTE You can change the height of the server list window relative to the job list
window below it by dragging the partition vertically.

Server list right-click menu

By default, servers are listed by name only. To see more information about a
server, right-click its name in the list. A menu appears with these options:

Properties Displays the Server Properties dialog, which shows aspects of the
server hardware and operating system, including memory and disk space.

6286 | Chapter 18   Rendering



All Server Details This toggle, when on, displays all details about each server
to the right of its name. When off, restores the last saved set of partial server
details unless the last saved set was All Server Details, in which case it restores
the default set: name only. See the following item for the list of available
details.

NOTE You can see more details by scrolling the list with the horizontal scroll bar
at the bottom, or by widening the dialog by dragging its right side with the mouse.

Partial Server Details Opens the Set Server Property Tabs dialog, which lets
you specify which details are shown in the Server list. The dialog provides
check boxes for turning on and off the display of these details:

■ Status: See Server list on page 6285  for status details.

■ Number of CPUs

■ Total Physical Memory - in bytes

■ Operating System

■ Work Disk Space - in megabytes

■ Historical Performance Index - see note below

■ Handle - a hexadecimal identification number for the machine

■ User - current user name

NOTE The Historical Performance Index value, listed under the Perf. Index heading
in the Server list window, offers information on the relative speed of the listed
servers. The fastest machine is rated at 1.0, while the other servers are rated as
fractions of the fastest. A machine whose average is twice as long would receive
a .50 index. Each machine is rated by measuring the time it takes to complete
each frame, and the accumulated time is divided by the number of frames, resulting
in the average time per frame, in seconds.

Several factors can affect a machine's performance. CPU power isn't necessarily
a concern when large file transfers are involved. For example, if a certain job
uses several map files from a centralized server, the performance of the network
throughput plays a much larger part than CPU performance, as most machines
will spend the majority of the time reading maps. On the other hand, if the
machine has all maps locally it will have a huge advantage (local access versus
network access) regardless of which CPU it is using. The performance index
provides you with information regarding your servers' rendering performance
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to help analyze your network rendering setup and better distribute the
workload.

Job list

The job list, located on the lower-right side of the Network Job Assignment
dialog, displays all jobs submitted to the network manager. Also shown are
each job's priority, status, and output file path.

To change job settings and manage jobs, use the Backburner Monitor. See
“Modifying Job Settings” and “Monitoring and Managing Jobs” in the Autodesk
Backburner User’s Guide.

Advanced Opens the Advanced Settings dialog on page 6296 , where you can
make settings for Per-Job Timeouts, TCP port number, Pre-Render MAXScripts
and Job Handling.

Submit Click Submit to exit this dialog and send the current job to the
Network Manager, which places it in the queue for rendering.

When you submit a rendering job, if the output file name to be used by the
job is the same as that used by an existing job, you're asked if you want to
overwrite the existing file(s). Also, if the name of the submitted job replicates
one already in the rendering queue, an alert notifies you; click OK, change
the job name, and submit it again.

NOTE Submitting a job creates a folder for the job on the manager machine in
the \Program Files\Autodesk\Backburner\Network\jobs\  folder. In that folder is a
compressed file with a .maz  extension containing the scene file. You can extract
the scene from the command prompt using the maxunzip.exe  program, found
in the 3ds Max program directory. For example, to extract a file named testfile.maz
, assuming the program is installed in a folder named \3ds Max 2008\ , open the
command prompt, navigate to the \Program
Files\Autodesk\Backburner\Network\jobs  folder, and enter this: “\Program
Files\Autodesk\3ds Max 2008\maxunzip” testfile.maz . You must specify the
.maz  file-name extension; otherwise you'll get an error message.

Cancel Discards changes and exits the dialog.

6288 | Chapter 18   Rendering



Job Dependencies Dialog

Rendering menu > Render > Render Scene dialog > Turn on Net Render (Render
Output group) > Render > Network Job Assignment dialog > Connect to a
Manager. > Priority group > Dependencies

Rendering menu > Render To Texture > Render To Texture dialog > Turn on
Net Render (Render Settings group) > Render > Network Job Assignment dialog
> Connect to a Manager. > Priority group > Dependencies

Rendering menu > Video Post > Set up a sequence with an Image Output Event
> Turn on Net Render (Output group) > Render > Network Job Assignment
dialog > Connect to a Manager. > Priority group > Dependencies

This dialog lets you specify jobs that shouldn't begin rendering until other
jobs finish. Use the two lists and the Add and Remove buttons to build a list
of jobs that must finish rendering before the current job can start.
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Interface

Existing Jobs list Lists all previously submitted jobs. To specify a dependency
for the current job, add one or more of these to the Jobs Your Job Depends
On list.

Add Select one or more jobs your job is to depend on, and then click Add
to add them to the Jobs Your Job Depends On list.

Add All Adds all jobs in the Existing Jobs list to the Jobs Your Job Depends
On list.

Remove Removes highlighted jobs from the Jobs Your Job Depends On list.

Remove All Removes all jobs from the Jobs Your Job Depends On list.
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Jobs Your Job Depends On list Lists all previously submitted jobs. To specify
a dependency for the current job, add one or more of these to the Jobs Your
Job Depends On list.

Notifications Dialog

Rendering menu > Render > Render Scene dialog > Turn on Net Render (Render
Output group) > Render > Network Job Assignment dialog > Options group >
Turn on Enabled Notifications. > Define

Rendering menu > Render To Texture > Render To Texture dialog > Turn on
Net Render (Render Settings group) > Render > Network Job Assignment dialog
> Options group > Turn on Enabled Notifications. > Define

Rendering menu > Video Post > Set up a sequence with an Image Output Event
> Turn on Net Render (Output group) > Render > Network Job Assignment
dialog > Options group > Turn on Enabled Notifications. > Define

This dialog lets a network rendering job send notifications via email. Such
notifications can be useful when you launch a lengthy render, such as an
animation, and don't care to spend all your time near the network manager
system.

See also:

■ “Configuring Backburner Log Files” in the Autodesk Backburner User’s Guide
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Interface

Categories group

Notify Progress Triggers a notification to indicate rendering progress. A
notification is triggered every time the number of frames specified in Every
Nth Frame has completed rendering. Default=off.

Every Nth Frame The number of frames used by Notify Progress. Default=1.

Notify Failures Sends an email notification only if something occurs to
prevent the completion of a rendering. Default=on.

Notify Completion Sends an email notification when a rendering job is
complete. Default=on.
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Email Options group

Send Email Notifies via email.

Include Summary Includes a summary of the network rendering progress
with the notification email. Available only when Send Email is turned on.

From Enter the email address of the person who initiates the rendering job.

To Enter the email address of the person who needs to know the rendering
status.

SMTP Server Enter the numeric IP address of the system you use as a mail
server.

Strips Setup Dialog

Rendering menu > Render > Render Scene dialog > Common tab > Turn on
Net Render (Render Output group) > Render > Network Job Assignment dialog
> Options group > Turn on Split Scan Lines. > Define

The Strips Setup dialog lets you specify how to split up the rendering of a
single, large image among several different servers on the network. The software
automatically subdivides the rendering based on settings you provide, and
then fits the pieces together into the final image.

NOTE A version of this feature was known as Region Net Render in previous
versions of the software.

Procedures

To render a large image with a networked render farm:

1 Set up a scene to render.

2 Set up your system for network rendering on page 6231 .

3 From the Rendering menu, choose Render.

The Render Scene dialog appears, with the Common tab active.

4 In the Output Size group, specify the size to render.

5 In the Render Output group, specify an output file name and location,
and turn on Net Render.

6 Click the Render button.
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The Network Job Assignment dialog appears.

7 In the Options group, turn on Split Scan Lines, and then click Define.

The Strips Setup dialog appears. The dialog displays the output resolution,
and lets you determine how to split up the rendering job by specifying
the number of horizontal strips into which the image will be subdivided.

8 Specify the vertical size of each strip in pixels or as a percentage of the
total image height, or set the number of strips. Changing one also changes
the other.

9 Set the overlap in pixels or as a percentage.

Using overlap isn't always necessary, but if you notice anomalies where
the strips meet, increase this value.

10 Connect to the manager, specify a job name, choose one or more servers
on which to render, and then click Submit.

The job is sent to the network rendering manager, which supervises the
network rendering job. The job consists of first rendering each slice, and
then combining, or “stitching,” the slices into the final image.

11 Monitor the job via the Backburner Monitor. See “Monitoring and
Managing Jobs” in the Autodesk Backburner User’s Guide.

Rendering and stitching passes are designated “Slice Pass” and “Stitch
Pass,” respectively. When all slices are finished, the job status will be
Complete.
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Interface

Output Resolution This read-only field displays the horizontal and vertical
resolution of the final image, in pixels.

Strip Height Sets the height of each horizontal strip in pixels or as a
percentage of the total height. Default=10 percent of the total image height,
in pixels.

This setting is interdependent with and inversely proportional to the Number
Of Strips setting; increase one, and the software decreases the other.

Number of Strips Sets the number of horizontal strips to be rendered by the
available servers. Default=10.

The value determines the maximum number of machines to which the job
can be farmed out. For example, if you use the default setting of 10 strips, the
job can be performed by 10 machines at most. In that case, assuming equal
performance of all 10, rendering would take approximately one-tenth the
time required by one machine.
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TIP For optimal results with render farms that comprise machines of different
speeds, use a value high enough that the job can be completed most efficiently.
For example, consider a two-server network with one machine four times as fast
as the other. If you set Number Of Strips to 2, the job won't be finished until the
slower machine renders its half of the final image. But if you set Number Of Strips
to 4, the faster machine can render three of the strips while the slower machine
renders one, effectively halving the total render time.

This setting is interdependent with and inversely proportional to the Strip
Height setting; increase one, and the software decreases the other.

Overlap Set the amount by which each strip overlaps the adjoining one(s).
You can set this in pixels or as a percentage of the final image height.

A certain amount of overlap is necessary to compensate for image artifacts
created by antialiasing and render effects. If you notice anomalies where the
image slices meet, try increasing the Overlap setting.

Pixels/Percentage Determines whether the Strip Height and Overlap settings
represent pixels or a percentage of the final image height. Choosing a different
option automatically changes the two values accordingly.

Delete Temporary Images Upon Completion Deletes the “slice” images after
the final image is created. Default=off.

Advanced Settings Dialog

Rendering menu > Render > Render Scene dialog > Turn on Net Render (Render
Output group). > Render > Network Job Assignment dialog > Advanced

Rendering menu > Render To Texture > Render To Texture dialog > Turn on
Net Render (Render Settings group) > Render > Network Job Assignment dialog
> Advanced

Rendering menu > Video Post > Set up a sequence with an Image Output Event
> Turn on Net Render (Output group) > Render > Network Job Assignment
dialog > Advanced

The Advanced Settings dialog lets you set job timeouts on a per-job basis,
assign the TCP port number, specify pre-render scripts and affect job handling
and archive settings.
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Interface

Per Job Timouts Group

Enable Turns on the ability to set timeouts on a per-job basis. The remaining
settings in this group become available only when Enable is turned on.

Wait for MAX to Load Specifies the amount of time after a job is submitted
that the Manager waits for a server to report that it received the frame and is
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rendering. If this value is exceeded, an error message is logged for a failed
frame, and the frame is assigned to a different server.

Wait for MAX to Render Specifies the amount of time the manager waits
between when a server reports that it has started and finished rendering a
frame. If a server exceeds the specified value, it is flagged as "failed" by the
manager, and no more frames from that job are sent to it.

Wait for MAX to Unload When a job is complete, the manager tells the server
to unload the software, then waits for a reply from the server saying 3ds Max
is down and it's ready for a new job. This spinner specifies the amount of time
the Manager will wait for the Server to reply to this notification. If a server
exceeds the specified value, it is flagged as "failed" by the manager, and no
more frames are sent to it.

Connection to Manager group

Use this setting to specify the Manager for this job.

TCP Port Number Specifies the port number of the Manager to which this
job is to report.

Submit Job As radio button Specifies which platform your scene is rendered
on. Use this button when you want to render your scene on a different platform
(either 32- or 64-bit) from the platform where you created your scene. This is
particularly useful in situations where you are working on a given platform
which differs from the platform of the render farm. The most consistent results
are achieved when you submit jobs are created and rendered on the same
platform.

NOTE This is an advanced option provided to accommodate specific render farm
configurations. By default this option is set to the most compatible platform that
avoids rendering to platforms where data-loss may result.

Server Assignment Limit

Enable Limit Sets the maximum number of servers that will be allocated for
a specific job. This limit can be overridden with the Use Server Limit field in
the Backburner Manager General Properties dialog , so that the administrator
of a render farm can control job sharing globally.

MAX server count Specifies the number of servers.

6298 | Chapter 18   Rendering



Job Handling group

Enable Task Blocking Allows the job to override the task blocking set in the
Manager. Some jobs will have their frames processed more efficiently if task
blocking is turned off. Default=on.

Override Global Settings This switch lets you override job archiving settings
made in the Backburner Manager General Properties dialog. It lets you set the
archive settings for the job about to be submitted. When Override Global
Settings is turned on, the following three switches become active. Default=off.

NOTE Any setting made while Override Global Settings is turned on, remains
active from one 3ds Max session to the next. For example, if you choose to leave
jobs in the queue, submit the job and exit 3ds Max, the setting will be active when
you choose to submit jobs in the future.

Leave It In The Queue This switch tells the network manager to leave the
job in the queue without deleting it or archiving it.

You might use this switch if you are submitting a job that might need to be
re-rendered at a higher resolution without making any other changes to the
scene.

Archive It When turned on, the job is archived when the rendering is
complete. Default=on.

Archiving is useful when you submit a final version of the scene and you know
that there won't be any more changes to the scene. Before submitting the job,
you set the job to archive upon completion.

Delete It Upon completion, the job is deleted from the queue when this
switch is turned on.

If the scene you're network rendering is just a test shot and you're just doing
a quick test of the scene, you don't really want to keep the job in the queue
once it's completed. Before submitting the job, turn on this switch.

Defaults Returns all settings to their defaults.

OK Accepts any changes and closes the dialog.

Cancel Closes the dialog without saving changes.

Network Job Assignment Dialog | 6299



Manager and Server

Initial Setup for Manager and Server Programs

The files necessary for network rendering are copied to the Backburner root
directory when you install the software. Two of these files, manager.exe and
server.exe, require initialization before they can be run. Set up the Manager
program first, then the Server. When you're finished, you can start network
rendering. After setup, you can run both Manager and Server as services by
installing managersvc.exe and serversvc.exe, respectively.

You need to initialize only one machine as network Manager. This can be any
machine on the network, and can be used on a machine running the Server,
3ds Max, or both.

You need to initialize every machine used as a rendering Server. This is done
once to establish the connection between the rendering Server and the network
Manager.

The Manager and Server programs can be run in application mode as explained
in the procedures that follow, or as Windows 2000 or XP services, in which
case they run in the background and provide less feedback on the progression
of the rendering job. To learn more about installing these programs as services,
see Installing Network Services on page 6302 .

Initialization is done only once for each service. Each initialization process
creates or updates the following:

■ A subdirectory called \Network under the Backburner root directory,
containing several further subdirectories, including \Jobs, \Servers, and
\ServerJob. By default, the Backburner directory is called Backburner, and is
found in the \Program Files\Autodesk\ directory.

■ A file with initialization parameters (backburner.xml).

■ A log file that keeps track of what the services do (backburner.log).

Next Step

Starting Network Rendering on page 6248
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Procedures

To initialize the Manager program:

■  Run the Manager program from the Start menu > Programs >
Autodesk > Backburner menu.
The first time you launch the Manager, it creates the backburner.xml file,
which stores the manager configuration settings.

The Backburner Manager General Properties dialog also appears the first time
you run Manager. In most cases, you can safely proceed by accepting the
default settings and clicking OK. Thereafter, you can modify the configuration
settings by choosing Edit menu > General Settings to open the General
Properties dialog. For the new settings to take effect, you need to close the
manager and restart it.

The settings in the General Properties dialog are described in depth in
Backburner Manager General Properties Dialog on page 6311 .

To initialize the Server program:

1  Run the Network Rendering Server program from the Start menu
> Programs > Autodesk > Backburner menu.

The first time you run Server, its General Properties dialog appears.

2 By default, the Subnet Mask field is set to 255.255.255.0 with the
Automatic Search option turned on. In most cases, you should leave this
option on. The software detects the machine acting as the manager.

At this point, do not make any other changes in the software’s Backburner
Server General Properties dialog. Settings in the this dialog are described
in detail in Backburner Server General Properties Dialog on page 6319 .

3 Click OK on the Backburner Server General Properties dialog to save the
current configuration.

4 The Server starts, and attempts to connect to a Manager automatically.
If no Manager is found on the network, the Server times out and reports
that the Manager is not responding.

5 If the Server eventually fails to connect to the Manager:

■ Check the subnet mask setting in your TCP/IP network configuration.
If it is set to something other than 255.255.255.0, in the Server
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application, go to Edit menu > General Settings, in the dialog, set the
subnet mask to match it and click OK. You will need to shut down
the Server application and restart it for the changes to take effect.

■ If you do not want the Server to connect automatically or the Server
will not connect automatically to the Manager, go to Edit menu >
General Settings and turn off Automatic Search. Click in the Manager
Name Or IP Address field and enter the name or IP address of the
workstation running Manager, and then click OK. You will need to
shut down the Server application and restart it for the changes to take
effect.
This updates the  backburner.xml  on page 6307  file, which now stores
the Server configuration settings. The next time the Server is run, the
application is launched and the configuration settings are used.

This completes Server initialization.

Installing Network Services

To install the network Manager and network Server as network services under
Windows 2000 or XP, start by doing the following:

1 Run the Application versions of the Manager and Server to properly
configure the applications and make your rendering network operational.

2 Use your network in production so you are sure it is running reliably.

Do not proceed unless these conditions are met.

Installing the network Manager and rendering Servers as Windows 2000 or
XP services allows background rendering and is convenient, but it also means
that you have less information on the rendering server’s screen about problems
when they occur. This is why your network needs to be running smoothly
before taking this step. Running the Manager and Server as services does not
change the information shown in the Queue Monitor.

In the procedures that follow, the Manager and Server services are installed
and registered under Windows 2000 or XP. This installation replaces the use
of application mode (running the Manager and Server manually each time
you want to use them). The services are started automatically every time you
boot the computer, but can also be set for manual startup. The \Network
subdirectory and initialization and LOG files from application mode remain
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in place, but the services operate under Windows 2000 or XP instead of in a
separate process.

You can run the Manager and Server as services directly from a Command
Prompt window or the Run dialog using the -i switch (install as a service).
Then go to Services and start the Manager and/or Server, or reboot.

To remove the Manager or Server once it has been installed as a service, you
must run the program directly from a Command Prompt window or the Run
dialog using the -r switch (remove service).

See also:

■ Creating a Special User Account on page 6270

Procedures

To set up the Manager as a service:

1 Go to the machine on which you will install the Manager as a service.

2 Open a Command Prompt window and change the directory to the
program’s root directory (for example, \Program Files\Autodesk\Backburner\.

3 Type managersvc -i

The following message should be displayed:

Backburner Manager ... Service Installed

4 Go to Windows Control Panel > Administrative Tools > Services,
right-click Backburner Manager, and choose Start.

If you choose Properties from the right-click menu, you can also set users,
passwords, and other parameters.

To set up the Server as a service:

1 Go to the machine on which you will install the Server as a service.

2 Open a Command Prompt window and change the directory to the
Backburner root directory.

3 Type serversvc -i

The following message should be displayed:

Backburner Server ... Service Installed
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4 Go to Windows Control Panel > Administrative Tools > Services,
right-click Backburner Server, and choose Start.

If you choose Properties from the right-click menu, you can also set users,
passwords, and other parameters.

5 Repeat these steps on every machine on which you want to set up Server
as a service.

Logging Properties Dialog

Windows Start menu > Programs > Autodesk > Backburner > Manager or Server
> Edit menu > Log Settings

The Logging Properties dialog lets you specify the types of messages that appear
in the list window on the Manager or Server window and those that are sent
to a log file. Each type of log message is explained below.

Log Message Types

Error

Fatal errors that halt a server's rendering of a job. These errors are preceded
by a red "ERR" in the Manager or Server list window, and include the following:

■ Failed Renderings and Frame Errors (caused by missing bitmaps, missing
texture coordinates, invalid output directory, etc.)

■ Manager not found

■ Error registering server(s)

■ Error writing output file

■ Error Starting 3ds Max

■ Loading timeouts

NOTE You can see a more detailed explanation for server failure in the Queue
Monitor's Server list window.
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Warning

Non-fatal warning information. These errors are preceded by a brown "WRN"
in the Manager or Server list window, and include the following:

■ Manager and/or Servers shutting down

■ Server(s) flagged as failed

■ Loading timeout set too low

■ Rendering timeout set too low

Info

General information about the current status of the Manager or Server. These
errors are preceded by a aqua "INF" in the Manager or Server list window, and
include the following:

■ Booting Network Manager/Server

■ Connection to Server(s)

■ Registration to Manager

■ Job Submitted

■ Job Received

■ Frame Complete

Debug and Debug Extended

Detailed information about TCP/IP packets and the current state of the
Manager and Server. Debug Extended provides a more verbose listing than
Debug. When in doubt, use both. These messages are preceded by a blue "DBG"
in the Manager or Server list window, and include the following:

■ TCP/IP Packets sent and received

■ TCP/IP Packet collection

■ Command Line Arguments used to launch 3ds Max

■ Frames Assigned

■ Log files creation and sent
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■ Assignment Threads

Interface

Log To Screen group

The Log To Screen options determine which types of messages are displayed
in the list window of the Manager or Server window.

Turn on each type of message that you want to be displayed. Error, Warning,
and Info are on by default.

Log To File group

The Log To File options determine which messages saved to log files. These
are the same messages that appear on the screen. Turn on any of the following
categories to save it in a log file. When any one of these categories is turned
on, a manager.log file or server.log file is created in your \network directory.
Error, Warning, and Info are on by default.

Buffer Limit Specifies the maximum size of the buffer holding the messages.

Clear Log Clears the buffer holding the messages in the list window.
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Clear Log File Deletes the associated manager.log and/or server.log file.

WARNING Log files are cleared only when you click the Clear Log File button.
When categories are enabled for either or both log files, the files will continue to
grow in size each time you render.

The backburner.xml File

When you run the Manager, Server, or Queue Monitor application, or access
the Network Job Assignment dialog, the software creates or updates an
initialization file named backburner.xml in the \Network subdirectory of the
Backburner directory.

You can change most of the settings in the backburner.xml file using the
Manager Properties dialog on page 6311  and Server Properties dialog on page
6319 .

You can change the parameters listed here only by editing the XML file in a
text editing application, such as Notepad. Do so only if you are experiencing
network problems with the network renderer.

Make sure the Manager and Server applications are shut down (or services
uninstalled) before editing the backburner.xml file. The changes will take place
when the Manager and/or Server are restarted.

backburner.xml

■ MaxBlockSize Located under the <GeneralCfg> heading, this value is the
maximum size of a data packet sent when transferring large blocks, such
as projects. For slow connections like modems, it uses a smaller packet
size, for example, 1024.

■ Acknowledgment Timeout Located under the <TimerCfg> heading as
AckTimeout, this value is the amount of time (in seconds) that the system
will wait for an acknowledgment of commands (like Ping) sent back and
forth between the Manager and Server. Default=20 seconds.

■ Acknowledgment Retries Located under the <TimerCfg> heading as
AckRetries, this value determines how many times the sender retries if no
acknowledgment is received. The default is six tries. After that, the machine
is considered down and is put off-line.
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Network Rendering Manager 

Windows Start menu > Programs > Autodesk > Backburner > Manager

The application version of the network rendering Manager provides a graphical
user interface for control and monitoring purposes. It runs as a foreground
process on your desktop, and remains active unless specifically shut down.
Its components include a menu bar, list window, and status bar.

Once you initially set up the Manager using the application version, you can
run it as a service from then on. The service version provides no user interface,
but once it's installed as a service and started, it's always available when the
system is booted. Whichever version you use, you can monitor and control
the rendering queue and system with the Queue Monitor on page 6321 .

To start the Manager service, execute the following from a Command Prompt
window or the Start menu > Run function:

“[drive letter]:\Program Files\Autodesk\Backburner\managersvc.exe” -i

Replace "[drive letter]" with the letter of the drive the software is installed on.
If you used a different install path, change the command line accordingly.

Then either reboot the computer or go to Control Panel > Administrative
Tools > Services and start the service. Thereafter the service will remain resident
and active, even surviving reboots.

NOTE When you run the Manager program, you might see this warning message:
Job share not defined. This happens if neither the program folder nor the drive
on which it resides is shared on page 6275 . Normally, the servers copy files to be
network rendered from the source machine using standard Windows file-copy
routines, which require sharing to be in effect. If sharing is not in effect, the
manager issues the warning, and then the servers use TCP/IP to copy the files. To
avoid getting the warning message, you can implement sharing, but it's not really
necessary.

To remove the manager service from memory, execute the following from a
Command Prompt window or the Start menu > Run function:

“[drive letter]:\Program Files\Autodesk\Backburner\managersvc.exe” -r

6308 | Chapter 18   Rendering



TIP You can run multiple Managers on the same network. This is especially useful
when using many rendering Servers, to lessen the burden on individual Managers.
When using multiple Managers, it is best to turn off Automatic Search on the
rendering servers and specify a Manager to which to connect, otherwise the
rendering servers will connect to the first Manager they find.

Interface

Menu bar

The menu bar provides access to the functions available in the Network
Rendering Manager application.

File menu

Close Closes the window and minimizes the application to the taskbar tray.
The application remains active when you close it with this menu item or the
close box (X) in the upper-right corner.

Shutdown Quits the application and removes it from memory.

Edit menu

General Settings Opens the Backburner Manager General Properties dialog
on page 6311 .

Log Settings Opens the Backburner Manager Logging Properties dialog on
page 6304 , which lets you filter the types of messages to appear in the list
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window, and specify whether the messages are sent to the list window or a
log file.

View menu

Status Bar Toggles the display of the status bar, which appears at the bottom
of the Server window. When on, a check mark appears next to this menu item.
Default=on.

Font Size Lets you choose the size of text that appears in the list window.
Choices range from Smallest to Largest.

Autoscroll List Toggles automatic scrolling of the list window. When on,
new items that appear in the list window cause previous contents to scroll up.
When off, you must scroll the window manually to see the latest entries after
it fills up. Default=on.

Help menu

About Manager Displays information about the Manager program, including
version and copyright.

List Window

This area of the Manager interface lists different types of information regarding
the current status of the Manager. Depending on the selections made in the
Logging Properties dialog on page 6304 , messages are displayed alerting the
user, for example, to the following:

■ Connection and registration between the Manager and Server(s)

■ New job assignments

■ Which machine is the queue controller (that is, running Queue Monitor)

■ Frames assigned/rendered

■ Acknowledge packets sent between the Manager and Server(s)

■ Manager/Server(s) shutting down

■ Any rendering errors encountered
This information can be filtered using the Logging Properties dialog on
page 6304 .
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Manager General Properties Dialog

Windows Start menu > Programs > Autodesk > Backburner > Manager > Edit
menu > General Settings > General Properties dialog

The Manager Properties dialog contains the configuration settings for the
Network Manager. The default settings should work in most cases, but certain
situations may require adjustments. The information specified in the Manager
Properties dialog is written to and contained in backburner.xml (in the \Network
subdirectory). If you run the Manager and the backburner.xml file does not
exist, you're prompted to configure it with this dialog. When configuration
is complete, click OK to run the Manager.
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Interface

TCP/IP group

The two spinners in the TCP/IP group box specify the port numbers to be used
by the software. These numbers must be unique to the software, but every
Server must have the same number.

Manager Port Specifies the port number used by the network Manager.

Server Port Specifies the port number used by the network Server(s).

NOTE Port numbers are like extensions for different users of the same phone
number. They represent two channels of communication between the Server and
the Manager. Only a trained network administrator should change these settings.
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General group

Max(imum) Concurrent Assignments Specifies the number of jobs the
Manager sends out at once. This number is dependent upon the speed of the
processor on the Manager machine, the size of the jobs being sent out, and
the speed of the network system. Generally, a default value of 4 is adequate.
You may want to decrease the value in case the jobs are huge and you have
a modest setup. Similarly, you may want to increase this value if you have a
high-end setup and the jobs are small. Be aware that too high a value may
result in an increased number of timeouts because the jobs are sent faster than
the Servers can handle them. In such a case, decrease the value or leave it at
the default.

User Server Limit Sets the maximum number of servers that will be allocated
for a specific job. This feature overrides the server limit settings in the 3ds
Max Advanced Settings Dialog on page 6296 .

Task Error Limit Defines the number of times a server will retry a task before
suspending the task. This option is available only in the Manager General
Properties dialog.

Failed Servers group

This option allows the Manager to automatically restart Servers that have
failed jobs.

Restart Failed Servers Activate to enable automatic Server restarting. If this
option is turned off, the Server will not attempt to render the job again after
the first failure. Default=on.

Number of Retries Specifies the number of times the Manager attempts to
restart a failed Server. Default=3. Range=1 to 1024.

Seconds Between Retries The time, in seconds, between each retry.
Default=30.

NOTE The state of a Server is kept on a per-job basis. If Restarts Failed Servers is
turned on, the Manager keeps track of when a Server fails a particular job. The
Manager regularly goes through the list of Servers for that job, checking for failures.
If one is found, the Manager checks how long it has been since it failed. If the time
elapsed is greater than the specified Seconds Between Retries, the Manager
decreases the Number of Retries by one and resets the failed flag from the Server.

If a Server fails repeatedly on a specific job (failures are monitored on a per-job
basis), the failure count reaches the specified Number of Retries, and the
Manager stops trying to restart that Server for that particular job. If, on the
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other hand, a Server restarts and completes a frame, it is flagged as active and
resumes rendering until the job is complete.

Direct Access To Jobs Path group

Job paths can be useful when dealing with situations where it's not conducive
to have jobs placed on the manager system. Such situations might be as follows:

■ You have a lack of drive space on the C: drive where Backburner is installed.
Drive D: has plenty of space so you set up a folder called MyJobs where jobs
will be placed when submitted. Enter a UNC path such as
\\machinename\MyJobs.

■ You're running a large render farm that causes a lot of network traffic on
the manager system that you use concurrently to build models. To alleviate
the traffic, you set up a shared job folder, backburnerJobs for example, on
a file server that is separate from the manager system. The UNC job path
would be set to \\fileserver\backburnerJobs and jobs you submit will be placed
on the file server.

Use Jobs Path Turning on this switch allows you to define the location of
jobs to be somewhere other than on the manager machine. This tells the
render servers to get the job files from the new location, therefore minimizing
the file I/O traffic on the manager.

Win32 Path Enter the path where jobs are located into this field or click the
Browse button to the right to search your system for the job location.

Unix Path This field functions the same as the Win32 path except you can
enter a Unix path structure.

Default Job Handling group

The settings in the Default Job Handling group allow a user to archive a
completed job to a specified location after x number of days, delete a completed
job after x number of days or just leave the job indefinitely in the queue.

Using these controls lets you maintain the job queue, clearing completed jobs
that can cause excess overhead and stress to the manager system, thus
instigating performance problems. The archiving functionality allows you to
automatically store files used for completed jobs.

NOTE These settings can be overridden from the Advanced Settings dialog on
page 6296  accessed from the Network Job Assignment dialog on page 6279 .

Do Nothing When turned on, a completed job is left in the queue.
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Use this switch if you are submitting a job that may need to be re-rendered
at a higher resolution without making any other changes to the scene.

Delete It Upon completion, the job is deleted from the queue when this
switch is turned on.

If the scene you're rendering is just a test shot and you're just doing a quick
test of the scene, you don't really want to keep the job in the queue once it's
completed.

Delete After ... Day(s) Upon completion, the job is kept in the queue for
the specified number of days. Once the number of days are exceeded, the job
is then deleted from the queue.

Archive It When turned on, the job is archived when the rendering is
complete. Default=on.

Archiving is useful when you submit a final version of the scene and you know
that there won't be any further changes.

Archive After ... Day(s) Upon completion, the job is kept in the queue for
the specified number of days. Once the number of days are exceeded, the job
is archived.

Network Rendering Server

Windows Start menu > Programs > Autodesk > Backburner > Server

The application version of the network rendering Server provides a graphical
user interface for control and monitoring purposes. It runs as a foreground
process on your desktop, and remains active unless specifically shut down.
Its components include a menu bar, list window, and status bar.

Once you initially set up the server using the application version, you can run
it as a service from then on. The service version provides no user interface,
but once it's installed as a service and started, it's always available when you
boot the system. Whichever version you use, you can monitor and control
the rendering queue and system with the Queue Monitor on page 6321 .

To start the server service, execute the following from a Command Prompt
window or the Start menu > Run function:

“[drive letter]:\Program Files\Autodesk\Backburner\serversvc.exe” -i

Replace "[drive letter]" with the letter of the drive the software is installed on.
If you used a different install path, change the command line accordingly.
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Then either reboot the computer or go to Control Panel > Administrative
Tools > Services and start the service. Thereafter the service will remain resident
and active, even surviving reboots.

NOTE In order for the rendering servers to be able to save the frames to the
specified location, set the logon for the installed service to a user name and
password that exists on the network. Also, that user name must have sufficient
read/write permissions to get the required bitmaps and xrefs for the scene to
render as well as write the frames to specified location.

To remove the server service from memory, execute the following from a
Command Prompt window or the Start menu > Run function:

“[drive letter]:\Program Files\Autodesk\Backburner\serversvc.exe” -r

Procedures

To start/stop the server service upon logoff/logon:

If you work on a computer that's part of a render farm, you probably don't
want the computer to be available for rendering while you're using it. By
following this procedure, you can have the computer automatically turn off
the server service while you're logged on, and turn it back on when you log
off.

1 Install the Backburner Server as a service that starts automatically at
startup, as described above. This is the default setup for the server service.

You'll start by creating two batch files.

2 Open a text editor such as Notepad and enter the following line:

net start backburner_srv_200

3 Save this as a text file named Netstart_BB_Server.bat.

4 Create a new file containing the following line:

net stop backburner_srv_200

5 Save this as a text file named Netstop_BB_Server.bat.

Next, you'll to edit the logon and logoff policy for the system.

6 Go to the Windows Start menu, choose the Run command, and enter
gpedit.msc.

The Group Policy dialog appears. It lets you edit and manage the Group
Policy for the system.
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7 In the dialog, expand User Configuration > Windows Settings, and then
click Scripts (Logon/Logoff).

The right-hand pane lists Logon and Logoff.

8 In the right pane, right-click Logon and choose Properties.

9 In the Properties dialog, click Add, click Browse, and browse to the
Netstop_BB_Server.bat file you created. Click OK twice to close the Logon
Properties dialog.

10 Similarly, open the Properties dialog for Logoff and specify the
Netstart_BB_Server.bat file.

11 Close the Group Policy dialog.

You have now set up the system to stop the Backburner service at any
user logon, and to start it at any user logoff.

Interface

Menu bar

The menu bar provides access to the functions available in the Network
Rendering Server application.
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File menu

Close Closes the window and minimizes the application to the taskbar tray.
The application remains active when you close it with this menu item or the
close box (X) in the upper-right corner.

Shutdown Quits the application and removes it from memory.

Edit menu

General Settings Opens the Network Server General Properties dialog on
page 6319 .

Log Settings Opens the Network Server Logging Properties dialog on page
6304 , which lets you filter the types of messages to appear in the list window,
and specify whether the messages will be sent to the list window, a log file,
or both.

View menu

Status Bar Toggles the display of the status bar, which appears at the bottom
of the Server window. When on, a check mark appears next to this menu item.
Default=on.

Font Size Lets you choose the size of text that appears in the list window.
Choices range from Smallest to Largest.

Autoscroll List Toggles automatic scrolling of the list window. When on,
new items that appear in the list window cause previous contents to scroll up.
When off, you must scroll the window manually to see the latest entries after
it fills up. Default=on.

Help menu

About Server Displays information about the Server program, including
version and copyright.

List Window

This area of the Server interface lists different types of information regarding
the current status of Server. Depending on the selections made in the Logging
Properties dialog on page 6304 , messages are displayed alerting the user, for
example, to the following:

■ Connection and registration between the Manager and Server(s)
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■ New job assignments

■ Frames assigned/rendered

■ Acknowledge packets sent between the Manager and Server(s)

■ Manager/Server(s) shutting down

■ Any rendering errors encountered
This information can be filtered using the Logging Properties dialog on
page 6304 .

Server General Properties Dialog

Windows Start menu > Programs > Autodesk > Backburner > Server > Edit
menu > General Settings > General Properties dialog

The Server General Properties dialog contains configuration settings for the
Network Rendering Servers. The default settings in this dialog work in most
cases, but certain situations may require adjustment of these settings, mostly
the Manager or IP settings in case the Automatic detection fails. The
information specified in the Server Properties dialog is contained in the
backburner.xml file (in the \Network subdirectory). If you run Server and the
backburner.xml file does not exist or does not contain information pertinent
to the Server, the backburner.xml file is created or updated.
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Interface

TCP/IP group

Manager Port Specifies the port number used by the Network Manager.

Server Port Specifies the port number used by the Network Server(s).

These settings specify the port number to be used by the software. These
numbers must be unique to the software, but every Server must have the same
number.

NOTE Port numbers are like extensions for different users of the same phone
number. They represent two channels of communication between the Server and
the Manager. Only a trained network administrator should change these settings.

Automatic Search When on, starting the Server searches for a Manager using
the default subnet mask of 255.255.255.0. In most cases, you should leave
this option on. The software will detect the machine acting as a Manager. The
Server may fail to detect a Manager if the network subnet mask (in the
Windows TCP/IP Network Configuration dialog) is set to some other value
than the standard 255.255.255.0.

If that is the case, change the subnet mask setting in the Server General
Properties dialog to match the system setting. Start the Server again and it
should detect the Manager. When multiple Managers are running on the same
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network, you may want to turn off Automatic Search and specify which
Manager the Server should connect to. Otherwise, the Server connects to the
first Manager it finds.

Enter Subnet Mask/Manager Name or IP Address With Automatic Search
turned on, specifies the subnet mask used to search for the Manager. With
Automatic Search turned off, specifies the IP address or DNS name of the
Manager to which to connect. Use the Manager system's name or IP address
when multiple Managers are running on the same subnet. Use the Manager
system's IP address to avoid any problems or conflicts caused by improper
implementation of the Domain Name System.

Queue Monitor

The Queue Monitor Application 

Windows Start menu > Programs > Autodesk > Backburner > Monitor

The Queue Monitor application (monitor.exe) lets you manage, view, and receive
status updates about all jobs currently submitted to the network rendering
queue. This executable file is copied to the Backburner root directory during
setup, and is available from the Start menu.

NOTE In previous versions of 3ds Max, this program was called Queue Manager
.

Queue Monitor helps you adapt to changing needs and priorities. Jobs can be
activated, deactivated, reordered, and removed, and servers can be unassigned
to free up resources on workstations, or brought back online as they become
available again.

You can run Queue Monitor from any computer connected to the rendering
network. Once started, you can connect to any available network Manager.
You can launch as many Queue Monitors as you want from anywhere on your
network and connect to a Manager machine. All except the first Queue Monitor
connecting to the Manager appear in "read only" mode. If there is already a
Queue Monitor connected to the Manager, subsequent connections alert you
that you are in read-only mode, and "Read Only" appears in the title bar. In
read-only mode, you can view network render activity, but cannot change
anything in the queue unless you obtain queue control on page 6325 .
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To view all current jobs in the rendering queue, you first connect to the
Manager that all of the servers are "talking to." To do this, you can either
connect automatically to the Manager by searching with a subnet mask, or
connect to a specific Manager by supplying the IP address or machine name
of the machine where you started the Manager.

See also:

■ Viewing Jobs and Servers with the Queue Monitor on page 6339

■ Activating and Deactivating Jobs in the Queue on page 6343

■ Activating and Deactivating Servers in the Queue on page 6344

■ Managing Jobs in the Queue on page 6345

Procedures

To view all current jobs in the rendering queue:

1  On the Queue Monitor toolbar, click the Connect button.

The Connect To Manager dialog appears.

2 After you connect to a Manager once, the dialog remembers the Manager
information and you can just click OK to connect to the same Manager.

If this is the first time you're connecting, or you're connecting to a
different Manager, and you're using Automatic Search, just click OK. If
you're not using Automatic Search, you need to specify the Manager to
connect to. In the text field, enter the name or IP address of a network
Manager. This is the same information you specified in the Server General
Properties dialog on page 6319 .

3 Click OK.

The Queue Monitor connects to the network Manager and activates its
various display windows.

To suspend a job:

As requirements change, you can temporarily deactivate an active or pending
job in the rendering queue, or reverse the process and restart jobs that are
inactive.
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When you suspend a job, the Servers assigned to the job either drop the frame
they are rendering or finish writing the frame, depending on where they are
in the rendering process. The next pending job becomes active and begins to
render.

NOTE You can activate or deactivate multiple jobs at the same time.

1 Select one or more active or pending jobs in the Job list.

2 Do one of the following:

■  Click the Suspend button on the toolbar.

■ Choose Suspend from the Jobs menu.

■ Right-click a highlighted job name in the Job list to display a pop-up
menu, and then choose Suspend.

 If necessary, use Refresh to view the new queue status.

To activate a suspended job:

1 Select the suspended job (denoted by a gray movie-frame icon).

 The Activate button on the toolbar becomes active.

2 Click Activate, or use the menu bar or right-click menu.

The job becomes either Started or pending in the queue (Active),
depending on whether or not another job is currently rendering.
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Interface

The Queue Monitor user interface comprises a menu bar, a toolbar, a status
display, and four windows: job list, job information, server tree view (or
hierarchical list), and server list.

Menu bar

The menu bar includes these menus and functions:

Manager menu

Use to control aspects of the Queue Monitor and the network Manager.

Connect Connects to a Manager using the Connect To Manager dialog. In
the dialog, turn on Auto Search to search for a Manager using the specified
subnet mask, or turn off Auto Search to search for a Manager using a specific
Manager name or IP address. Click OK to perform the search, or Cancel to
exit without connecting.

If the Manager is found, current Servers and jobs appear in their respective
lists in the Queue Monitor. If the Manager cannot be found, an alert appears.

Disconnect Disconnects from the current Manager. Available only after a
connection is made.
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Auto-Connect When this switch is turned on, you can automatically connect
to a manager without the Connect To Manager dialog appearing. Whatever
setting have been made in the Connect To Manager dialog will be used.

Request Queue Control Lets you gain control over the rendering queue.
Available only when Queue Monitor is running on two or more machines in
the network, and your copy was not the first one run.

When you request queue control, a dialog appears on the controlling machine
informing that user of the request. The dialog counts down 10 seconds, and
if no response is made during that time, or the OK button is clicked, control
transfers to the requesting Queue Monitor, which then informs the requestor
of the transfer. If the request is denied, the requesting user is informed of that
fact.

Request Client List Displays a dialog listing the rendering servers on the
network, and showing which is the controller (i.e., the active Queue Monitor)
and the user name. Use this to determine which server is currently controlling
the queue.

Auto-Refresh When on, Queue Monitor automatically updates the
information in its windows every 20 seconds, or whenever information changes
if information changes less frequently. When off, to update the windows you
must click the toolbar Refresh button on page 6328 . Default=on.

Unless you are the only person managing the queue, we recommend leaving
Auto-Refresh on. The danger of turning it off is the possibility of getting out
of sync with the state of the queue. For instance, if another person deletes a
job and you decide to edit that job, when you finish editing that job, the
Manager will send you an error message saying the job no longer exists.

Module Info Report Choosing this command opens the Module Info Report
dialog on page 6332 . For troubleshooting purposes, this command lets you
generate a delimited file that shows you the version and location of Backburner
plug-ins and the Backburner application itself for each network rendering
system.

Properties Opens a window that displays information about the current
setup of the machine that is running the network Manager, including job and
server statistics, the Manager's system configuration, and TCP/IP statistics.

Exit Quits the Queue Monitor program.

Queue Monitor | 6325



Jobs menu

Use to obtain information about rendering jobs. Most Jobs menu functions
are available only when at least one job is highlighted in the Job list, and
many require that only one job be highlighted.

These commands are also available by right-clicking a job in the job list.

Edit Settings Opens the Job Settings dialog on page 6334 , with settings for
job-related functions such as frame range and output size.

Change Priority Opens the Change Job Priority dialog, which lets you set a
new priority or set the job to be critical.

If you change a job's priority so that a different job moves to the beginning
of the list, the software pauses the current job and begins rendering the newly
elevated job.

Clone Job Makes an identical copy of the highlighted job and adds it to the
end of the list.

Dependencies Opens the Job Dependencies dialog on page 6289 , which you
can use to specify existing jobs that must finish before the current job can
start.

Report Opens the Job Report dialog on page 6340  for generating text files
containing job reports.

Column Chooser Opens the Job Columns dialog, with additional columns
you can drag into the Job list title row. As you drag a column over the title
row, arrows appear indicating where the column will be inserted.

To remove a column, right-click its title and then choose Remove This Column.
You cannot remove the Job or Order column.

Activate Starts a suspended job or jobs.

Suspend Pauses an active job or jobs.

Restart Job Starts a job over at the first frame set in Job Settings.

Archive Job Archives a job currently stored in the queue. Archived jobs are
removed from the Job queue and stored in the Job Archives.

Job Archives Accesses the Job Archives where jobs are stored after clicking
the Archive Jobs command or if they're assigned to automatically archive
upon completion. Choosing this command opens the Job Archive dialog on
page 6342  where you can choose to Delete, Activate or Refresh jobs.

Delete Removes the highlighted job or jobs from the queue.
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Servers menu

Use to control and obtain information about job servers.

These commands are also available by right-clicking a server in the server list.

Assign to Selected Jobs Assigns the highlighted servers or servers to the
highlighted job or jobs.

Remove from Selected Jobs Removes the highlighted job or jobs from the
highlighted servers or servers.

Remove from Selected Group Removes the highlighted server or servers
from the highlighted group in the tree view.

Column Chooser Opens the Server Columns dialog, with additional columns
you can drag into the Server list title row. As you drag a column over the title
row, arrows appear indicating where the column will be inserted.

To remove a column, right-click its title and then choose Remove This Column.
You cannot remove the Job or the Order column.

Week Schedule Opens the Week Schedule dialog on page 6345  for the
highlighted server, for defining when the server is available to render jobs.

Delete Server Lets you remove the current server from the server list, making
it unavailable for rendering jobs.

Properties Opens a window that displays information about the current
setup of the machine that is running the network Manager, including job and
server statistics, the Manager's system configuration, and TCP/IP statistics.

Reset Server Index Lets you set the Performance parameter back to 0. Use
this if you've changed the server setup (for instance, you've added memory
or substituted a faster machine) and want to reevaluate the servers' relative
performance during a rendering job.

View menu

Toolbar Toggles display of the Queue Monitor toolbar.

Status Bar Toggles display of the Queue Monitor status bar. When on, the
status bar appears at the bottom of the Queue Monitor window and displays
status prompts on page 6332 .

Save View... Saves the current window view with column and filter settings.

Load View... Loads a saved view.
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Help menu

About Queue Monitor Displays information about the Queue Monitor
program, including version and copyright.

Toolbar

Contains buttons for performing various common Queue Monitor functions.

Connect See Connect on page 6324 .

Disconnect See Disconnect on page 6324 .

Refresh Forces the Queue Monitor to update the information shown
in its windows.

The software automatically refreshes the windows every 10 seconds when
information is changing.

Delete Removes the highlighted job or jobs from the queue.

Activate Starts a suspended job or jobs.

Suspend Pauses an active job or jobs.

Assign Server Assigns the highlighted servers or servers to the
highlighted job or jobs.

Remove Server Removes the highlighted job or jobs from the
highlighted servers or servers.
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Job List

The Job List window lists all current jobs, along with progress and status.
Additionally, a status icon before each job's name provides a graphical
indication of its status. See Viewing Jobs and Servers with the Queue Monitor
on page 6339 .

Right-click a job name to access the Jobs menu on page 6326 .

Click a column title to sort the list by the column contents (alternating clicks
sort in ascending and descending order). Right-click a column title to access
a menu that lets you sort the column, specify its alignment, remove the column
(if it's optional), access the Column Chooser for adding optional columns,
and display only the default columns.

Job Information Window

The Job Information window contains tabs for viewing information about
different aspects of a single highlighted job in the Job List window. If no job
is highlighted or multiple jobs are highlighted, this window is blank.

You can sort and filter columns in the Job Information Window. Click 
in the column you wish to filter and select the Column Filter options.

Job Summary Lists important job-related information, including Job Options
settings and Output settings.

Task Summary Lists frames in the job (under “Task ID”), along with each
frame's status, rendering time, rendering server, and date and time of
assignment.
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Right-click the frame you wish to view under “Task ID” to view its output file.
This is available only for completed tasks.

Job Details Lists the job's rendering parameters, scene statistics, and gamma
settings.

Errors Lists each frame for which an error occurred, which server registered
the error, and a description of the error, including missing maps, missing
texture coordinates, and invalid output directories.

Server Tree View

This window presents a hierarchical list of all Server groups, lets you create,
delete, and rename global and local Server groups, and see which Servers can
render your job.

Server groups are logical combinations of Servers that you can use to easily
assign specific Servers to render a job. Global groups are available to all
machines in the rendering network, while local groups are available only on
the computer on which they are created. To create a global or local Server
group, right-click any item in the Server Tree view, and choose Create Global
Group or Create Local Group. After you choose either command, the new
group appears in its respective category with the name New Global/Local
Group; at this point, you can rename it by typing a new name.

After you define a group, its name shows up as a tab in the Server list in the
Network Job Assignment dialog on page 6279 . Only global groups appear on
machines other than the one on which they're created.

To remove a Server group, right-click its name in the Server Tree view and
choose Delete Group. To rename a Server group, right-click its name in the
Server Tree view, choose Rename Group, and then enter a new name.

Following is a list of default list entries in the view. Click the item for the
described result.

All Servers Shows all Servers assigned to the current manager.

Global Groups Click the + icon next to this entry, if it exists, to display global
Server groups. To see the Servers in a global group, click the group name.

Local Groups Click the + icon next to this entry, if it exists, to display local
Server groups. To see the Servers in a local group, click the group name.

Plugins Shows which applications can be controlled with the render network.
Click the + icon next to this entry, if it exists, to display applications available
on the render network. To see the Servers that have a particular rendering
application installed, click the renderer name.
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Server List

The Server List window shows all Servers in the current group (selected in the
Server Tree view). For each listed server, the windows displays, by default, its
status, the job it's currently rendering (if any), and the last message it sent to
the Manager. Additional, optional details can be shown using the Column
Chooser command.

Click a column title to sort the list by the column contents (alternating clicks
sort in ascending and descending order). Right-click a column title to access
a menu that lets you sort the column, specify its alignment, remove the column
(if it's optional), access the Column Chooser for adding optional columns,
and display only the default columns.

You can sort and filter columns in the Server List Window. Click  in the
column you wish to filter and select the Column Filter options.

A status icon before each server's name provides a graphical indication of its
status. See Viewing Jobs and Servers with the Queue Monitor on page 6339 .

Right-click a server name to access the Servers menu on page 6327 .
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Status Prompt

Visible at the bottom of the Queue Monitor window, the status prompt
provides a non-interactive display of activity in the Queue Monitor and
provides help information on the command over which the mouse cursor is
positioned.

Module Info Report Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > Jobs menu > Report

You can generate delimited ASCII reports containing detailed statistics about
the version and location of Backburner plug-ins and the Backburner application
itself for each network rendering system.
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Interface

Header group

Specifies the type of header to include in the report file, in addition to the
body information.

Long Adds a heading to the report.

Short Includes only the column titles in the report.

Record Delimitation group

Specifies the type of delimiter used between the fields. For example, if you use
a tab delimiter, the report will import correctly into Microsoft's Excel or Access
applications.

Tab Inserts a tab between fields in the report.

Space Inserts a space between fields in the report.

Comma Inserts a comma between fields in the report.

Use Quotes Brackets each field with double quotes.

Output File group

(Text Field) Specifies the report's file name. You can specify a complete path,
if you want. By default, the path is the directory containing the monitor.exe
file.
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TIP If you use a shortcut icon to launch Queue Monitor, you can specify the path
for your report's output file in the Start In field in the Properties dialog for the
shortcut.

Browse Displays a file selector where you can specify a file path for the
report.

Queue Monitor: Job Settings Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > Jobs menu > Edit Settings

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > right-click menu > Edit Settings

NOTE This topic covers the 3ds Max-specific aspects of the Queue Monitor on
page 6321 .

Use the Job Settings dialog to change job-related settings such as frame range,
output size, and output directory, without having to use the Render Scene
dialog and resubmit the job.

You can change job settings for a job while it's suspended or while it's
rendering. By default in either case, after you click OK to exit the dialog, the
rendering job restarts from the first frame. You can turn this feature off with
the Restart Job option.

Most settings are either toggle switches or editable from the keyboard. To
change a toggle setting, double-click its entry (in the right-hand column). If
a setting is editable, its value turns green when you click it. To change an
editable setting, click it to get the keyboard cursor, and then enter a new value
from the keyboard. If you double-click the value when it's green, it highlights,
and anything you type replaces it.

NOTE Your machine must have control of the network for this Job Settings Dialog
to be accessible.
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Interface
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Job Name group

The job name cannot be changed from this dialog.

Job Description Displays a brief description of the job. Editable from
keyboard.

Restart Job When on (Yes), changing one or more job settings in the middle
of a rendering job causes the job to restart at the first frame in the range, so
all frames are rendered with the same settings. When off (No), the job
continues rendering without restarting. Toggled by double-clicking the entry.
Default=No.

You might want to turn this off if you're rendering an animation test and
change a relatively minor setting, such as Video Color Check, in the middle
of a job. For final renderings, you should always restart a job from the
beginning after changing job settings.

Override Global Blocking Tasks This setting corresponds with the Override
Global Settings as set in the Advanced Setting dialog on page 6296 . Default=Yes.

Enable Blocking Tasks A Yes/No toggle that controls task blocking as set in
the Advanced Setting dialog. When set to Yes, the task blocking set in the
Manager General Properties dialog is active. Toggled by double-clicking the
entry. Default=Yes.

Use All Available Servers Uses all servers in the active Server group for
rendering the job.

3ds Max General Settings group

Frame Sequence This toggle setting alternates between Frames and Range,
and, by default, uses the Range and Frames settings in the Render Scene dialog
on page 5878 . When set to Range, the job uses the First/Last Frame and Every
Nth settings; when set to Frames, the job uses the Frames setting. Toggled by
double-clicking the entry. Default=Range.

First Frame Displays the first frame in the range to be rendered. Defaults to
the first frame as submitted. Editable from keyboard.

Last Frame Displays the last frame in the range to be rendered. Defaults to
the last frame as submitted. Editable from keyboard.

Every Nth Regular sample of frames. For example, enter 8 to render every
8th frame. Editable from keyboard.
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Frames Non-sequential frames separated by commas (for example, 2,5) or
ranges of frames separated by hyphens (for example, 0-5). Editable from
keyboard.

Width/Height Lets you set the resolution of the output image by specifying
the width and the height of the image, in pixels. Defaults to the output size
as submitted. Editable from keyboard.

Render Options group

These settings are the same as those found in the Render Scene dialog >
Options group on page 5935 , with several additions:

Skip Existing Frames When on, the software checks the output path for
existing rendered frames, and doesn't render them again. When off, starting
or restarting a job always begins rendering with the first frame, overwriting
any existing frames. Toggled by double-clicking the entry. Default=No.

Display RFW Displays the rendered frame window on all servers during
rendering. Toggled by double-clicking the entry. Default=Yes.

Gamma Correction When enabled, lets you defines a new gamma for the
bitmap, using the Input/Output Gamma settings. Toggled by double-clicking
the entry. Default=Disabled.

Input/Output Gamma Change system input and output gamma settings for
processing bitmaps. See Gamma Preferences Settings on page 7550  > Bitmap
Files group. Editable from keyboard.

Pixel Aspect Ratio Sets the shape of the pixels for display on another device.
The image may look squashed on your display but will display correctly on
the device with differently shaped pixels. Editable from keyboard.

Render Elements When enabled, renders any render elements on page 6157
in the scene. Toggled by double-clicking the entry. Default=Enabled.

Video Color Check Checks for pixel colors that are beyond the safe NTSC or
PAL threshold. Toggled by double-clicking the entry. Default=No.

Two Sided 2-Sided rendering renders both sides of all faces. Toggled by
double-clicking the entry. Default=No.

Render Hidden Renders all geometric objects in the scene, even if they are
hidden. Toggled by double-clicking the entry. Default=No.

Render Atmosphere Renders any applied atmospheric effects, such as volume
fog, when set to Yes. Toggled by double-clicking the entry. Default=Yes.
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Super Black Limits the darkness of rendered geometry for video compositing.
Toggled by double-clicking the entry. Default=No.

Dither 256 Intersperses pixels when rendering to an eight-bit image format
for a greater apparent color range. Toggled by double-clicking the entry.
Default=Yes.

Dither True Color Intersperses pixels when rendering to a 24-bit (or higher)
image format for a greater apparent color range. Toggled by double-clicking
the entry. Default=Yes.

Render Fields Renders to video fields rather than frames when creating
animations for video. Toggled by double-clicking the entry. Default=No.

Displacements Any displacement mapping is rendered. Toggled by
double-clicking the entry. Default=Yes.

Scene Effects Any applied rendering effects, such as Blur, are rendered when
turned set to Yes. Toggled by double-clicking the entry. Default=Yes.

Multithread Causes the software to treat the rendering task as separate
threads. This option works with multiprocessor systems. Toggled by
double-clicking the entry. Default=Yes.

Field Order Selects the field on page 7777  order of rendered images when the
Render Fields option is turned on. Default=Odd.

Some video devices require that the even field be first, other video devices
require that the odd field be first. Determine the correct field order for your
video device. If the video output of your device is strobing or appears jittery,
it may be due to incorrect field order. Try changing this parameter and
re-rendering your animation.

Alternate Paths group

Comparable to setting the alternate paths in the Network Job Assignment
dialog on page 6279 .

Alt Bitmap Path Lets you enter an alternate path where the servers search
for bitmaps. Editable from keyboard.

Alt XRef Path Lets you enter an alternate path where the servers search for
XRefs. Editable from keyboard.

Timeouts group

These settings are covered in Advanced Settings Dialog on page 6296 .
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Notifications group

These settings are covered in Notifications Dialog on page 6291 .

Viewing Jobs and Servers with the Queue Monitor

All rendering jobs submitted to the network rendering queue are shown in
the Job list window, located on the upper-left side of the Queue Monitor
dialog, immediately below the toolbar. Below it is the Server list window,
which shows all servers attached to the manager and their status.

Interface

Each job is denoted by an icon reflecting its current status. The servers are
also denoted by specific icons that reflect their current status.

Job Icons

Job is started and has rendered one or more frames. The job is either
currently rendering or is awaiting an available server.

Job is active, but has not yet rendered any frames.

Job is suspended.

The job was submitted as suspended or was suspended with the Queue Monitor.
Suspended jobs must be manually reactivated to give them a started or active
status.

Job is in an error condition.

In the Queue Monitor, check the Errors tab in job information window, to
the right of the jobs list, for details regarding the error, such as missing bitmaps,
plug-ins, texture coordinates. See Troubleshooting on page 6253 .

Job is completed.

All frames in the sequence have been rendered successfully. You may delete
this job from the queue if you want.
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Server Icons

A bar through the server icon indicates that it's assigned to the currently
highlighted job or jobs.

Server is active.

The server is rendering the current started job.

Server is absent.

The server is assigned to the rendering task but is not currently rendering.
This can occur, for example, when the server is turned off or is not running
the Server application.

Server is in an error condition.

Check the Server list Job Status column in the Queue Monitor for details
regarding the error, such as missing bitmaps, plug-ins, texture coordinates.
See Troubleshooting on page 6253 .

Server is idle.

The server can be assigned the highlighted job with the toolbar Assign Server
button.

Job Report Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > Jobs menu > Report

You can generate ASCII reports containing detailed statistics about a particular
job selected in the Job Queue list.

See also:

■ Week Schedule Dialog on page 6345
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Interface

Header group

Specifies the type of header to include in the report file, in addition to the
body information.

Long Includes information above the body of information, including Job
Name, Submitted by, Frame Start/End, Output Width/Height, Pixel Aspect
Ratio, and Image Aspect Ratio.

Short Includes only the column titles in the report.

Record Delimitation group

Specifies the type of delimiter used between the fields. For example, if you use
a tab delimiter, the report will import correctly into Microsoft's Excel or Access
applications.

Tab Inserts a tab between fields in the report.

Space Inserts a space between fields in the report.

Comma Inserts a comma between fields in the report.

Use Quotes Brackets each field with double quotes.

Output File group

(Text Field) Specifies the report's file name. You can specify a complete path,
if you want. By default, the path is the directory containing the monitor.exe
file.
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TIP If you use a shortcut icon to launch Queue Monitor, you can specify the path
for your report's output file in the Start In field in the Properties dialog for the
shortcut.

Browse Displays a file selector where you can specify a file path for the
report.

Job Archives Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > Jobs menu > Job Archives

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > right-click menu > Job Archives

Use the Job Archives dialog to delete, activate and refresh jobs that have been
archived. Jobs are placed here when you select a job from the Job list on the
Queue Monitor and click the Archive Job command. This brings up the
Backburner Job Archives dialog Jobs are also placed in the Job Archives if you
set them to automatically archive when the rendering is completed.

Interface

This dialog consists of a toolbar and list of archived jobs.

Toolbar

The Job Archives toolbar has three commands.
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Delete Deletes a selected job from the archive. You are warned and must
accept confirmation before the deletion to occurs. This button is active only
when a job is selected.

Activate When you select a job from the list, you can click the Activate
button. When a job is activated, it is removed from the Job Archives and
placed back in the Job list in the Queue Monitor on page 6321 . Then you can
choose to Edit Settings on page 6334  and restart the job.

Refresh Forces the Job Archives dialog to update the information shown in
the job list

Job List

The Job List shows the Job Name, Owner, Description, Type (render plugin),
original Submission date, and Completion date. Unlike other lists in the Queue
Monitor, you cannot add or remove columns. You can make multiple selections
of jobs by holding down either the SHIFT or CTRL keys.

Activating and Deactivating Jobs in the Queue

As requirements change, you can deactivate an active or pending job in the
rendering queue, or reverse the process and restart jobs that are inactive.

When you deactivate a job, the servers assigned to the job either drop the
frame they are rendering or finish writing the frame, depending on where
they are in the rendering process. The next pending job becomes active and
begins to render.

You can reactivate a suspended job, or a job that was submitted as Initially
Suspended from the Network Job Assignment dialog.

Procedures

To deactivate a job:

1 Select a started or active job in the Job list.

2 Do one of the following:

■ Click the Suspend button on the toolbar (the red light-bulb icon).

■ Choose Jobs menu > Suspend.

■ Right-click the job name to display a pop-up menu, and then choose
Suspend.
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If necessary, click the toolbar Refresh button to view the new queue
status.

To activate a suspended job:

1 Select the inactive job (denoted by a gray box).

The Activate button on the toolbar becomes active.

2 Click Activate, or use the menu bar or right-click menu.

The job becomes either started or active in the queue, depending on
whether or not another job is currently rendering and whether or not
any of the job's frames have already rendered.

Activating and Deactivating Servers in the Queue

When prioritizing jobs and dividing up the network render load, you might
need to pull individual servers off one job and place them on another.

When you remove a server from the current rendering job, and the server is
assigned to another started or active job, it is used by that job. If the server
has no further job assignments, it stops rendering.

You can assign machines that become available for network rendering to any
job.

You can tell whether a server is assigned to a particular job by highlighting
the job in the Queue Monitor > Job list and looking at the server's icon in the
Server list. If a horizontal bar appears through the server icon, then it is
assigned to the job; if no bar appears, then it isn't assigned to the job.

Alternatively, just highlight the job and then click Selected Job in the Server
Tree view, to list only servers assigned to that job.

Next Step

Managing Jobs in the Queue on page 6345

Procedures

To remove a server or servers from the highlighted rendering job or jobs:

■ Highlight the server in the Server list and click the Remove Server icon on
the toolbar.
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To assign an unassigned server or servers to highlighted rendering job(s), do
one of the following:

1 Highlight the unassigned server(s) in the servers list and choose Assign
To Selected Jobs from the Servers menu.

2 Right-click the server name in the queue list to display the pop-up menu
and choose Assign To Selected Jobs.

Managing Jobs in the Queue

Reordering lets you change the job order in the queue to meet changing
deadlines or priorities. You can delete jobs from the queue at any time.

Procedures

To re-order a job in the queue:

1 In the Job list window of the Queue Monitor, right-click the job to move.

2 Choose Change Priority, and use the Change Job Priority dialog to set a
new Priority value.

NOTE You can reorder multiple jobs at the same time. They will end up with
the same priority.

To delete a single job from the job queue, do one of the following:

1 Highlight the job and then click Delete on the toolbar.

2 Use the right-click menu > Delete command.

You can delete multiple jobs by first highlighting the jobs by using the CTRL
or SHIFT keys and then clicking the Delete button or Jobs menu > Delete.

Week Schedule Dialog

Queue Monitor > Highlight a Server and right-click. > Week Schedule

Queue Monitor > Highlight a Server. > Servers menu > Week Schedule
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By default, all servers are available at all times. Using the Queue Monitor's
Week Schedule feature, you can arrange the hours during which each server
is available for network rendering.

You can specify certain hours for any day of the week. This is useful, for
example, if the server is used as a modeling workstation during normal business
hours and you do not want it being used as a network render server during
this time.

Procedures

To schedule a set of active hours for a server or servers:

1 In Queue Monitor's Server list, right-click a Server and choose Week
Schedule, or select one or more Servers and choose Servers menu > Week
Schedule.

2 In the dialog that appears, select a time using one of the following
methods:

■ Select a one-hour block for network rendering by clicking one of the
top buttons.

■ Select an entire day by clicking a side button.

■ Select the entire week by clicking the large top-left button.
The selection is shown in white.
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3 Click the Allow button. The selection is shown in green. (By default, all
hours are allowed).

4 To apply the time selection to the selected Server, click OK.

To schedule hours when servers are unavailable:

1 In Queue Monitor's Server list, right-click a Server and choose Week
Schedule, or select a Server and choose Servers menu > Week Schedule.

2 In the dialog that appears, select a time using one of the following
methods:

■ Select a one-hour block for network rendering by clicking one of the
top buttons.

■ Select an entire day by clicking a side button.

■ Select the entire week by clicking the large top-left button.
The selection is shown in white.

3 Click the Disallow button. The selection is shown in red.

4 To apply the time selection to the selected Server, click OK.

Batch Rendering
“Batch rendering” is a term used to describe the process of rendering a series
of tasks or jobs that have been assigned to a queue. Batch rendering is useful
when you need to render images without supervision or when you want to
render a number of test studies showing different day or night lighting, or for
producing shadow studies of various sun angles. Batch rendering can also be
used when you want to see how your project looks from different camera
viewpoints.

Several methods for setting up batch rendering are available in 3ds Max. These
methods entail using the Batch Render tool on page 6352  or network rendering
on page 6231  with Backburner, or a combination of the two.

The three available methods for setting up batch rendering are as follows:

■ Build a queue of camera tasks that are managed by the Batch Render tool.
If you have a MAX file that contains one or more cameras and saved scene
states on page 7185 , you can set up a camera queue to render different camera
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viewpoints. Each camera can be set to automatically load a scene state to
give you several visualizations of your model.

■ Set up a series of jobs as network rendering assignments to be coordinated
by Backburner.
If you have a number of separate scenes that are part of a single project or
part of several projects, use network rendering even if you're rendering to
a single computer. Use this method also if you have scenes that don't have
a camera set up and you want to render a Perspective, Front, Left or Right
viewport view.

■ Use the Batch Render tool to set up a queue of camera tasks to render
different views and pass them to Backburner for rendering management.
The Batch Render tool has an option to send each camera task in the batch
render list as a separate network rendering job. Use this method if you
want to split the rendering of the different views among multiple
computers.

See also:

■ Batch Rendering - Batch Render Dialog on page 6352

Quick Start Batch Rendering

The following provides bare-bone steps on how to set up and use the
Backburner Manager and Server utilities to perform batch rendering.

If your system is already properly configured for TCP/IP protocols (for example,
your computer has an internet connection), information in this topic will
help you get started with batch rendering in a few basic steps.

Procedures

To render in batch mode:

You need Windows XP (Home or Professional) Service Pack 1 (or higher) or
Windows 2000 Service Pack 4.

NOTE Backburner rendering is not supported under Windows 95, 98 or ME.

1 Run the Backburner Manager and Server applications from the Start menu,
in the same program group as 3ds Max.
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2 Start 3ds Max, and load the first scene you want to batch render.

3 Open the Render Scene dialog and adjust the various rendering parameters
for the way you want to render the scene, including active viewport, file
output, etc.

4 Turn on Net Render in the Render Output group, and then click Render.

5 In the resulting Network Job Assignment dialog on page 6279 , click the
Connect button.

6 Click the Submit button.

NOTE Each job should have a unique output file name and/or path to avoid
overwriting output files. If you get an alert dialog that says, "Another job is
using the same output name…," you can click the No button, click Cancel
to exit the Network Job Assignment dialog, and then change the output
name and/or path. Otherwise, you can click the Yes button and let the job
overwrite the frames from the other job in the queue.

7 Load the next scene you want rendered, and then repeat steps 4 through
7.

Once you’ve submitted all rendering jobs, you can exit 3ds Max, if you want.
If power is lost before all jobs are rendered (either by accident or by intentional
powering down of your computer), when you restart the Backburner Manager
and Server programs, the rendering process will resume where it left off.

Using Backburner for Batch Rendering

Using Backburner for batch rendering is a simple matter of starting the
software, running the Backburner Manager and Server programs, specifying
the scenes you want rendered, and then proceeding with the rendering. In
this case, Backburner coordinates a series of rendering tasks that are network
rendered on a single computer.

The process is very similar to rendering over a network. With network
rendering, the scenes you submit to the rendering queue are called 'jobs'. The
following steps show how to submit multiple jobs to the rendering queue.

Your system has to be properly configured in the TCP/IP protocol (see “Setting
Up TCP/IP on Windows-Based Backburner Components” in the Autodesk
Backburner Installation Guide) to perform Backburner batch rendering. If you do
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not have a network card or if you are not connected to the internet, then you
may need to configure TCP/IP with the Microsoft Loop Back Adapter.

NOTE  Batch rendering by means of Backburner differs from batch rendering
with the Batch Render tool on page 6352 . However, you can use the Batch Render
tool to create a queue of rendering tasks and then pass the tasks to Backburner
to coordinate the rendering process.

Network Files

When Backburner Manager begins a job, a series of files are created in the
\network\jobs folder of your Backburner folder. Among other things, this means
that you can shut down your computer completely (either on purpose or by
accidental power failure), and when you next start Backburner Manager and
Server, they’ll pick up where they left off and continue with your rendering
queue.

NOTE The exception to the above rule is when rendering multiframe file formats,
such as AVI and MOV. Due to limitations in these file formats, if you stop in the
middle of rendering one of these files, when you begin rendering again, the entire
file will have to be rendered from the beginning.

Procedures

To batch render several jobs:

1 Start 3ds Max.

2 Start Backburner Manager.

The Backburner Manager window appears. Its window displays the words:
“Starting Network Manager.”

3 Start Backburner Server.

The Backburner Server window appears. Its window displays the words:
“Starting Backburner Server,” followed by additional startup messages.

4 In 3ds Max, load the first scene you want rendered.

5 Activate the viewport you want rendered, and click the Render Scene
button on the toolbar.

6 Set up the various rendering parameters as you would if you were
rendering only this scene.

7 In the Render Output group, turn on Net Render.
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8 Click Render.

To assign network jobs:

At this point, the Network Job Assignment dialog on page 6279  appears. Its
main purpose is submit the current job to the Backburner Manager with all
its render settings, including job name and net rendering specifics. The
Backburner Manager then takes over and begins the rendering process.

1 In the Job Name field, either accept the default name (the name of the
scene), or specify a new one.

2 Click the Connect button to connect the software to the Manager. After
a moment, your TCP/IP address appears in the field over the window,
and the Server appears in the window.

3 Click the server in the window so that its icon displays a green circle with
an arrow through it.

4 Click the Submit button.

NOTE Each job should have a unique output file name and/or path to avoid
overwriting output files. If you get an alert dialog that says, "Another job is
using the same output name…," you can click the No button, click Cancel
to exit the Network Job Assignment dialog, and then change the output
name and/or path. Otherwise, you can click the Yes button and let the job
overwrite the frames from the other job in the queue.

5 The Job Assignment dialog goes away, and the rendering begins. The
Manager reports: “Job (job name) submitted.” The Server reports that it
has received the job, and then begins reporting each frame it’s completed.

6 At this point, you can open the next scene to be rendered, and then
repeat the steps, beginning with step 4 in the previous procedure.

Once you’ve submitted the jobs you want rendered, you can exit 3ds Max (do
not shut down the Backburner Manager or Server), or you can begin working
on a new scene, or editing an old scene. Keep in mind, however, that your
processor is spending most of its time working on rendering, so your computer
will slower than usual.

If you need to monitor the batch render processes, you can use the Backburner
monitor for that purpose. (See “Understanding the Backburner Monitor” in
the Autodesk Backburner User’s Guide.)
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Batch Rendering - Batch Render Dialog

Rendering menu > Batch Render

The Batch Render tool offers you an efficient, visual approach to setting up a
sequence of different tasks or scene states to render automatically. From the
Batch Render dialog, you control the following:

■ Image resolution, pixel aspect ratio or time sequence if it differs from the
default rendering settings found on the Render Scene dialog on page 5878
.

■ Whether to render a specific camera view or the active viewport.

■ Which camera view to render.

■ The output path where rendered images get stored.

■ Which scene state on page 7185  is restored prior to rendering.

■ Which rendering preset on page 5922  is used per rendered view.

■ Whether all the batch rendering tasks should be sent to Backburner for
network rendering on page 6231  by multiple systems for even faster
rendering.

■ Exporting the batch rendering tasks and all parameters set in the Batch
Render dialog to a BAT file for later command line rendering on page 6361
.

NOTE The Batch Rendering dialog is for rendering different aspects of the same
scene, such as views from different cameras. To batch-render a number of different
scenes, use Backburner on page 6349  or command-line rendering on page 6361 .

Batch Render Completed

If a problem is encountered by the Batch Renderer, you will be notified by
means of the Batch Render Completed dialog. This is an error dialog that
appears and notifies you about which batch renders did not complete and, if
possible, provides a description of why the failure occurred.
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If the cause of the error cannot be identified, then the error entry will simply
state Failed. The most common causes for failure are:

■ Missing texture maps for materials that are assigned to objects in the scene.
This shows up as Failed. Missing External File. Once the texture map is found
or map paths are properly set, this error will not occur.

■ Missing UVW coordinates for objects that have texture mapped materials
assigned to them. This is reported as Failed. Missing Map Coordinates on Object
and can be alleviated by making sure new objects are created with the
Generate Mapping Coords switch turned on and by assigning a UVW Map
modifier to the object that is not displaying its texture mapping.

Procedures

To use the Batch Render tool:

1 Open or create a MAX scene.

2 Choose Rendering menu > Batch Render.

The Batch Render dialog opens.

3 On the Batch Render dialog, click the Add button.

This adds your first rendering task to the batch render queue.

By default, the Camera parameter is set to Viewport, which means that
the task will render the active viewport. To change to a set view, make
sure the scene contains at least one camera, and then choose the camera
view to render from the Camera drop-down list on page 6358 .

Batch Rendering - Batch Render Dialog | 6353



4 Review the Selected Batch Render Parameters settings and, if necessary,
turn on Override Preset and then change the Frame Start, Frame End,
Width, Height, and Pixel Aspect settings.

5 Click the Output Path button to set a drive location, file name and file
format for the rendered image.

6 If you've saved any scene states with the model, you can choose which
one is loaded during the rendering operation by opening the Scene State
drop list.

7 Repeat steps 3 through 6 to continue adding rendering tasks to the batch
render queue, as necessary.

8 When all your tasks are set, click the Render button.

To use the Batch Render tool with Backburner:

Before attempting to use the Batch Render tool with Backburner for network
rendering, make sure the Backburner Manager is running on your managing
workstation and that Backburner Server is running on all the other workstations
that will receive the rendering assignments. For more information on setting
up Backburner Network Rendering, refer to Network Rendering on page 6231 .

1 Set up a series of rendering tasks in the Batch Render queue as documented
in the previous procedure.

2 Turn on Net Render and then click the Render button.

The Network Job Assignment dialog opens.

3 Enter a subnet mask, or, with Automatic Search off, enter the Manager
name or IP address, and then click Connect.

The available rendering servers show up in the list on the right side of
the Network Job Assignment dialog.

4 Click the Submit button to send all the Batch Render camera tasks to
Backburner for network rendering to all the workstations that are running
Backburner Server.

If you are running the Backburner Queue Monitor, you'll see all the
camera tasks listed as rendering jobs in the Job section of the Queue
Monitor.
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Interface

Add Adds a new rendering task to the queue, using the default settings. By
default, a new task is set to render the active viewport. To set it to render a
particular camera, choose the camera from the Camera drop-down list on
page 6358 .

Duplicate Adds a copy of the highlighted rendering task to the queue.

All rendering parameters that were part of the original task are duplicated for
the new task.

Delete Deletes the highlighted rendering task.
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No warning appears to confirm deletion and you cannot undo a deletion.

[Task Queue] This is a listing of all the camera tasks that have been chosen
for batch rendering. The task queue consists of eight columns that show all
the parameters that have been set for a particular camera task. You can control
which tasks are rendered by toggling the check boxes in the list.

Selected Batch Render Parameter group

By default, any tasks you've designated for batch rendering use the current
Time Output and Output Size parameters from the Render Scene dialog on
page 5878 .

For example, if the Output Size settings on the Render Scene dialog shows
that you have a Time Output settings of Single and an of 800 width and 600
height, when you add a camera, its Selected Batch Render Parameters will
mimic those settings. Likewise, if the Render Scene dialog has a Time Output
set to Range and frame 0 to 25, the Frame Start and Frame End settings on
the Batch Render dialog will default to those Time Output settings.

This group gives you access to changing those default parameters.

Override Preset When on, you can override any of the default settings for
the highlighted task via the Frame Start, Frame End, Width, Height, and Pixel
Aspect settings. Default=off.

Frame Start The first frame to be rendered for the highlighted task. The
default setting for this parameter matches the Time Output group settings on
the Common panel of the Render Scene dialog.

Frame End The last frame to be rendered for the highlighted task. Its default
state also matches the Time Output group settings on the Common panel of
the Render Scene dialog.

The default Frame Start and Frame End parameters correspond to the Render
Scene dialog parameters as follows:

Batch Render dialog
Frame Start/End

Render Scene dialog
>Time Output

Defaults to the frame set
by the time slider.

Single
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Batch Render dialog
Frame Start/End

Render Scene dialog
>Time Output

Defaults to 0 (zero) and
the last frame of the anima-

Active Time Segment

tion as set in the Time
Configuration dialog on
page 7359 .

Defaults to the range of
frames specified, such as 0
(zero) To 14 or 6 To 11.

Range

The Frame Start and End settings also conform to the current time
configuration format; i.e. Frames, SMPTE, Frame:Ticks, or MM:SS:Ticks.

Width Allows you to specify a new image width setting if Override Preset is
on. If Override Preset is off, this value matches the width set on the Render
Scene dialog.

Height Allows you to specify a new image height setting if the Override
Preset is on. If Override Preset is off, this value matches the height set on the
Render Scene dialog.

Pixel Aspect Sets the aspect ratio of the pixels for display on another device.
The image might look squashed on your display but will display correctly on
the device with differently shaped pixels. By default, this mimics the value
set on the Render Scene dialog.

Name Lets you change the default name of the highlighted task. The default
naming structure for camera tasks uses “View” plus an incremented view
number, such as View01 or View02. If you want, you can change the task's
name to something more descriptive.

NOTE After changing the name, you must press Enter for the change to register.

NOTE If you're rendering elements on page 6144  as part of the batch, the task
name is appended to each rendered element's specified file name. For example,
if the task name is View01  and the render element output file name is
Test_Diffuse.tga , then the batch-rendered element output becomes
Test_Diffuse_View01.tga .

If you're rendering an element without specifying a file name for the element,
the batch renderer appends the element type to the batch output file name.
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For example, if the batch output file name is MyBatch.png, and you're rendering
an Atmosphere element, then the element output name becomes
MyBatch_Atmosphere.png.

Output Path The ellipsis (...) button opens the Render Output File dialog
on page 5892  where you can specify the output path, file name and file format
for the rendered image of the selected camera task.

Once set, the output path and file name appears in the output path field and
the file name appears in the Output Path column of the task queue.

X [Clear Output Path] Removes the output path and file name from the
Output Path field and task queue.

Camera This drop-down list shows any cameras in the scene.

By default, a task is set to render the active viewport, as indicated by the
“Viewport” entry in the Camera column of the task queue. You can use this
list choose a camera from any in the scene for the highlighted task. The new
camera is shown in the Camera column of the task queue.

To set the highlighted task to render the active viewport, choose the dashed
line (-------------------------) from the top of the drop-down list.

Choose the dashed line to render the active viewport.

NOTE Choosing a camera changes only the camera the task uses. It does not
change the name of the task.

Scene State This drop-down list displays the scene states on page 7185 , if
any, that you can assign to the highlighted task. If no scene state is active
then current scene settings are used.

Preset Lets you choose a render preset for the highlighted task. If no render
preset is active and there is no override, then the current render settings are
used.

If you choose Load Preset from the drop-down list, the Render Presets Load
dialog opens.

Net Render When on, opens the Network Job Assignment dialog on page
6279  when you click the Render button.
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Each camera task in the Batch Render dialog is passed to the Network Job
Assignment dialog as an individual rendering job instead of a single job. By
default, the Network Job Assignment dialog uses the name of the MAX file as
its job name, and it then appends the name of the camera task. For example,
if you have a scene named Athena_High_Rise and camera tasks for three
cameras, the jobs will look like this in the monitor: Athena_High_Rise Camera02
View01, Athena_High_Rise Camera01 View02 and Athena_High_Rise Camera01
View03.

Export to .bat Creates a batch file for command line rendering. This button
opens the Batch Render Export To Batch File dialog where you can specify a
drive location and name for the batch file that is saved.

Render Starts the batch rendering process or opens the Network Job
Assignment dialog if Net Render is turned on.

Batch Render Tool - Batch Render Warning Dialog

Rendering menu > Batch Render > Click Render to render tasks that do not
have an output path set.

Rendering menu > Batch Render > Click Render to render tasks that could
overwrite previously saved files.

The Batch Render Warning dialog informs you of certain conditions you may
have overlooked while assigning the rendering tasks. The dialog that displays
is context-sensitive, meaning that the warning will indicate when either of
these two conditions exist:

■ When you risk overwriting an existing file or if you have not specified an
output path and output file name.

■ When the output path that was specified has been renamed or no longer
exists.

Interface

Task Queue

Both formats of the Batch Render Warning dialog include the Task Queue
columns that are shown in the in the Batch Render dialog. The key difference
is the exception of the check boxes that let you specify which cameras are use
in the render. This Task Queue only shows the cameras that may overwrite a
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saved file, or do not have a path/file name set for output, or if they show an
output path that is invalid.

Missing Output Path/Filename or File Overwrite

This version of the Batch Render Warning dialog appears if you click the
Render button on the Batch Render dialog and one or more of the tasks to be
rendered does not include an output path/file name. The dialog also appears
if there is a chance you will overwrite a previously rendered image.

OK Allows you to continue with the batch rendering tasks even though there
are some tasks without an output path/file name or some files could be
overwritten. Tasks without an output path/file name are not automatically
saved and only appear in the rendered frame window on page 5885 .

Cancel Cancels the batch rendering.

Invalid Output Path

This version of the Batch Render Warning dialog only appears if you are
rendering to a file that has invalid output paths. For example, if you're
rendering a client's model and they've set their own output paths.
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Update Path Allows you to browse to a new directory and reassign the output
path for all the entries in the Task Queue. The specified output file name
remains the same.

NOTE If you don't want to assign the same path to all the cameras shown in the
dialog, you should Cancel and set the correct paths for each camera from the
Batch Render dialog.

Continue Allows you to continue with the batch rendering tasks even though
there are some tasks without an output path. Tasks without an output path
are not automatically saved and only appear in the rendered frame window
on page 5885 .

Cancel Cancels the batch rendering.

Command-Line Rendering
The command-line rendering tool lets you perform batch rendering jobs
without having to manipulate parameters by hand in a MAX file. Simple,
“one-shot” rendering jobs can be submitted from the Start > Run dialog. More
elaborate, batched jobs can be rendered through the use of text files; for
example, MyRender.bat or MyRender.xml. The ability to edit text files is what
provides the power to this tool. You can quickly make changes to your
rendering parameters, or output formats, simply by opening your text editor
and editing the batch settings.

Command-line rendering is provided by the 3dsmaxcmd.exe program, found
in your program install folder.
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You can submit command-line rendering jobs that are rendered on a single
workstation, or you can take advantage of network rendering on page 6231
and let the Backburner utility manage the jobs across multiple systems.

The Batch Render tool on page 6352  is another way to quickly create BAT files
that can be used with the command-line rendering. The Batch Render tool
lets you create a queue of camera tasks with specific output parameters,
rendering presets or automatic loading of scene states. Once your queue is
complete, you can export the tasks to a BAT file that is stored in the \scenes
folder.

WARNING Command-line rendering is a professional feature and can perform
destructive operations. You will not see messages or warning dialogs informing
you about potential mistakes, such as overwriting an existing frame on your drive.

See also:

■ Command-Line Rendering Switches on page 6365

Procedures

To view the 3dsmaxcmd  help file:

The 3dsmaxcmd.exe  file contains a built-in help system that you can access
from a command prompt.

1 Open a command prompt window (for example, Windows Start > Run
> enter CMD).

2 Enter the following: “c:\program files\autodesk\3dsmax9\3dsmaxcmd”
-?  and press Enter.

The list of switches and options will scroll on to the window.

To view a list of sample command lines with descriptions of what they do:

The 3dsmaxcmd.exe  file also has an extensive list of sample text strings that
describe many of the most common scenarios you'd use command-line
rendering to accomplish.

1 Open a command prompt window.

2 Enter the following: “c:\program files\autodesk\3dsmax9\3dsmaxcmd”
-x  and press Enter.
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Setting up the simplest rendering:

In its simplest form, just a render command using all the settings that are
stored with a scene, would look like this:

1 Open a command prompt window.

2 Enter the following: “c:\program files\autodesk\3dsmax9\3dsmaxcmd”
“c:\program files\autodesk\3dsmax9\scenes\myscene.max”  and press
Enter.

Example: Rendering to a JPG file at 800x600 resolution:

Perhaps the last time you rendered your scene, you had the output resolution
set to 320x240 and rendered a BMP file. Re-rendering the scene using different
output settings is fast and efficient with command-line rendering.

1 Open a command prompt window.

2 Enter the following:

“c:\program files\autodesk\3dsmax9\3dsmaxcmd”
-outputName:“c:\program
files\autodesk\3dsmax9\renderoutput\myImage.jpg” -w 800 -h 600
“c:\program files\autodesk\3dsmax9\scenes\myscene.max”

and press Enter.

NOTE The specified output path must already exist. If it doesn't, the image
doesn't render and you get an error message.

Network rendering from the command line:

If you have your system networked and have access to other systems, you can
take advantage of network rendering.

NOTE A command-line job cannot be run on a system already running the
Backburner server.

1 Open a command prompt window.

2 Enter the following:

“c:\program files\autodesk\3dsmax9\3dsmaxcmd” -submit “c:\program
files\autodesk\3dsmax9\scenes\myscene.max”

and press Enter.
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Example: Rendering from a text file:

Command-line rendering gives you the ability to set a series of common
switches that can be quickly re-used for rendering a single job from Start >
Run, or for rendering a group of scenes specified in a BAT file. You can build
your text file using any text editor.

NOTE A TXT file can specify only a single scene to render. For multiple scenes,
use a BAT file.

1 Open your text editor.

2 Enter your list of commands, such as:

-bitmapPath=\\mapServer\maps\myMaps

-cam=myCamera

-width=800

-height=600

-vfb=true

-frames=all

-force2Sided=true

3 Once all the switches are entered, save the files as a TXT file, such as
myrender.txt.

4 To render the scene, open the Windows Start > Run dialog.

5 Enter the following:

“c:\program files\autodesk\3dsmax9\3dsmaxcmd” @c:\myrender.txt
-o=“c:\program files\autodesk\3dsmax9\renderoutput\myImage.tga”
“c:\program files\autodesk\3dsmax9\scenes\myscene.max”

and click OK.

Using a TXT file that contains your favorite settings, in conjunction with
a command line that specifies the output file format and scene of your
choice, gives you the flexibility to re-use the TXT file without having to
edit it each time you want to render. You can create several TXT files
with settings for different stages of scene development, such as
testrender.txt or finalrender.txt.

Example: Rendering from a BAT file:

If you want to render several scenes in a batch process, you can create a BAT
file containing all the scenes and switches needed to get the results you want.
Just like a text file, you can build your BAT file using any text editor. For this
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example, let's say you have three scenes, in various stages, and you want each
rendered using different settings.

1 Open your text editor.

2 On the first line, enter the following text. This example assumes that the
scene is far from finished, but that you want to test a chunk of animation.

“c:\program files\autodesk\3dsmax9\3dsmaxcmd” -o=“c:\program
files\autodesk\3dsmax9\renderoutput\scene1.jpg” -w=320 -h=240
-frame=1-33 “c:\program files\autodesk\3dsmax9\scenes\scene1.max”

The second scene is almost ready, but you need to test the look of some
materials and do a video color check:

“c:\program files\autodesk\3dsmax9\3dsmaxcmd” -o=“c:\program
files\autodesk\3dsmax9\renderoutput\scene2.jpg” -w=640 -h=480
-force2Sided=true -videoColorCheck=true “c:\program
files\autodesk\3dsmax9\scenes\scene2.max”

The last scene is complete, and you want to render a higher-resolution
image using settings you've saved in a TXT file that you always use for
final renderings:

“c:\program files\autodesk\3dsmax9\3dsmaxcmd” @c:\finalrender.txt
-o=“c:\program files\autodesk\3dsmax9\renderoutput\scene3.jpg”
“c:\program files\autodesk\3dsmax9\scenes\scene3.max”

3 After entering these three command lines, save your file as a BAT file.

4 From the Windows Start > Run dialog, browse to the BAT file and click
Open.

5 Click OK to start rendering.

Command-Line Rendering Switches

In order to use command-line rendering, you should be familiar with DOS
and understand the structure of command lines.

Command-Line Switches

You can use the following switches after 3dsmaxcmd  on the command line
of a command prompt window, or as entries in a text file. The following tables
show switches and their effects.

NOTE Switches are not case sensitive.

Command-Line Rendering Switches | 6365



At Verbosity level 5, the output message from command-line rendering includes
both a timestamp and a date stamp. The timestamp is separated from the
main message by a semicolon, and the elapsed time message is separated from
the Frame Completed message by a semicolon. This lets you pipe the message
to a file, and then open it in a spreadsheet program with appropriate columns
by setting the delimiter character.

Separators

Many switches are displayed in the following charts with trailing colons, such
as -w: or -h:. The use of a colon separator is optional, and can be replaced with
a space or an equal sign (=). Therefore, command lines such as:

“c:\program files\autodesk\3dsmax9\3dsmaxcmd” -outputName:“c:\program
files\autodesk\3dsmax9\renderoutput\myImage.jpg” -w:640 -h:480
“c:\program files\autodesk\3dsmax9\scenes\myscene.max”

“c:\program files\autodesk\3dsmax9\3dsmaxcmd” -outputName “c:\program
files\autodesk\3dsmax9\renderoutput\myImage.jpg” -w 640 -h 480
“c:\program files\autodesk\3dsmax9\scenes\myscene.max”

“c:\program files\autodesk\3dsmax9\3dsmaxcmd”
-outputName=“c:\program
files\autodesk\3dsmax9\renderoutput\myImage.jpg” -w=640 -h=480
“c:\program files\autodesk\3dsmax9\scenes\myscene.max”

will give you the same results. The use of the equal sign can give your
command-line files more of an INI file appearance.

NOTE The switch -submit:[manager_name]  is the only case where a colon is
necessary.

On/Off Command-Line Switches

Many of the switches you'll use are simple on/off toggles, such as the -rfw:
and -renderFields: switches. If you prefer, instead of using a 1 or 0 to designate
their states, you can use True or False. For example, to render a scene to a
specified file type and display the Rendered Frame Window, your command
line might look like this;

“c:\program files\autodesk\3dsmax9\3dsmaxcmd”
-outputName=“c:\program
files\autodesk\3dsmax9\renderoutput\myImage.jpg” -rfw=true “c:\program
files\autodesk\3dsmax9\scenes\myscene.max”
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Basic Options

EffectSwitch

Displays a list of these switches in
the DOS window.

-?

Shows a list of example command
lines.

-x

Sets the verbosity level, where # is
an integer from 0 (least verbose)
to 5 (most verbose).

-v:#

Points to a separate file containing
command-line options.

@command_file
or -cmdFile:com-
mand_file

Uses a render preset file where
<filename> is the name of the pre-
set file.

-preset:<file-
name> or -
rps:<filename>

Loads the specified scene state file
before rendering the image.

-sceneS-
tate:<scene-
state-name>

Renders all enabled tasks in the
Batch Render dialog.

-batchRender

Renders batch renders in the file
named batch-render-name.

-batchRen-
der:<batch-ren-
der-name>

Uses a pre-render script where
<filename> is the name of the
script file.

-preRender-
Script:<file-
name> or -
script:<filename>
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EffectSwitch

Uses a post-render script where
<filename> is the name of the
script file.

-postRender-
Script:<file-
name>

Root location for job data folders.-workPath:<path-
name>

Path configuration file (MXP for-
mat).

-pathFile:<path-
name>

(obsolete) Provides an extra
bitmap path. Multiple paths can

-bitmap-
Path:<path-
name> be entered and UNC naming con-

ventions can be used.

(obsolete) Lets you specify extra
XRef paths. Multiple paths can be

-xrefPath:<path-
name>

entered and UNC naming conven-
tions can be used.

Split render: number of strips,
overlap amount.

-split:<strips,
overlap>

Split render: number of strips,
overlap amount, strip number

-strip:<strips,
overlap, strip>

(starting with 1). This is similar to
the -split switch, but lets you ren-
der a specific, individual strip.

NOTE The strip value has no ef-
fect when submitting the job to
Backburner. The job will still ren-
der all strips. Split and Stitch func-
tionality is intended for local ren-
dering only.

Stitches strips (see above), combin-
ing them into a single image:

-stitch:<strips,
overlap>
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EffectSwitch

number of strips, overlap amount.
Stitch functionality is intended for
local rendering only.

Specifies a date format to be used
in message timestamp, at verbosi-

-dateFor-
mat:<datefor-
mat> ty level 5. Defaults to locale-depen-

dent format. For details, use the
3dsmaxcmd 3dsvizcmd -x option.

Specifies a time format to be used
in message timestamp, at verbosi-

-timeFor-
mat:<timefor-
mat> ty level 5. Defaults to locale-depen-

dent format and 24–hour clock.
For details, use the 3dsmaxcmd -x
option.

Render Parameters

NOTE Any command-line switches that are on/off toggles can be switched by
entering either 1 , 0 , on  or off .

EffectSwitch

Sets an output file name
and format.

-outputName:<file-
name> or -o:<filename>

Specifies a camera name.-camera:<string> or -
cam:<string>

Sets the output width in
pixels.

-width:<integer> or -
w:<integer>

Sets the output height in
pixels.

-height:<integer> or -
h:<integer>

Sets the pixel aspect ratio.-pixelAspect:<number>
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EffectSwitch

Sets the rendering se-
quence start frame.

-start:<integer>

Sets the rendering se-
quence end frame.

-end<integer>

Sets the Every Nth Frame
value.

-nthFrame<integer>

Lets you specify a frame
list; for example, (1,3,5-12)
or all.

-frames<string>

Indicates that this is a still-
frame render; no frame
suffix will be added.

-stillFrame or -sf

Image-sequence file cre-
ation: 0=none; 1=.imsq;
2=.ifl

-imageSequence-
File:<0/1/2>

Toggles gamma correction.
“1”=On, “0”=Off.

-gammaCorrec-
tion:<1/0>

Sets the Input Gamma val-
ue.

-gammaValueIn:<num-
ber>

Sets the Output Gamma
value.

-gammaValueOut:<num-
ber>

If an error is encountered,
the software attempts to
continue rendering.

-continueOnError

Turns Video Post on page
6571  on or off for the job.

-videopostJob:<1/0>
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Render Flags

EffectSwitch

Toggles the Rendered
Frame Window. “1”=On,
“0”=Off.

-showRFW:<1/0> or -
rfw:<1/0>

Toggles Skip Existing Im-
ages. “1”=On, “0”=Off.

-skipRendered-
Frames:<1/0>

Toggles Video Color
Check. “1”=On, “0”=Off.

-videoColorCheck:<1/0>

Toggles Force 2-Sided.
“1”=On, “0”=Off.

-force2Sided:<1/0>

Toggles Render Hidden.
“1”=On, “0”=Off.

-renderHidden:<1/0>

Toggles Atmospherics.
“1”=On, “0”=Off.

-atmospherics:<1/0>

Toggles Super Black.
“1”=On, “0”=Off.

-superBlack:<1/0>

Toggles Render Fields.
“1”=On, “0”=Off.

-renderFields:<1/0>

Toggles Field Order. De-
fault=”Odd”.

-fieldOrder:even or odd

Toggles Displacement
Mapping. “1”=On,
“0”=Off.

-displacements:<1/0>

Toggles Render Effects.
“1”=On, “0”=Off.

-effects:<1/0>
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EffectSwitch

Toggles area lights/shad-
ows. “1”=On, “0”=Off.

-useAreaLights:<1/0>

Toggles use advanced
lighting. “1”=On,
“0”=Off.

-useAdvLight:<1/0>

Toggles compute ad-
vanced lighting. “1”=On,
“0”=Off.

-computeAdv-
Light:<1/0>

Toggles Output Dithering
(paletted). “1”=On,
“0”=Off.

-ditherPaletted:<1/0>

Toggles Output Dithering
(true-color). “1”=On,
“0”=Off.

-ditherTrueColor:<1/0>

Toggles render elements
(true-color). “1”=On,
“0”=Off.

-renderElements:<1/0>

Backburner Job Submission

These switches concern submitting a rendering job for network rendering. For
further information, see Network Rendering on page 6231 . Also, for a different
method of network rendering via the command line, see Backburner
Command Line Control on page 6378 .

EffectSwitch

Submits the scene, <filename>
to a specific manager system for
network rendering.

NOTE This is the only switch
that requires a colon separator.

-submit[:manag-
er_name] or -
s[:manager_name]
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EffectSwitch

Specifies a manager port num-
ber.

-port:<integer>

Lets you specify a network mask
other than 255.255.255.0.

-netmask:<string>

Lets you specify a job name to
render.

-jobName:<string>

Sets job priority.-priority<integer>

Toggles initially suspended.
“1”=Yes, “0”=No.

-suspended:<1/0>

Writes all job settings to an XML
file. The file uses the same name

-writeJobFile

as the MAX file, so, for example,
test.max produces test.xml.

Reads all job settings from an
XML file.

-readJobFile:<file-
name>

The amount of time to wait for
3ds Max to load, in minutes.
Default=20.

-waitLoad:<inte-
ger>

The amount of time to wait for
3ds Max to render, in minutes.
Default=600.

-waitRender:<inte-
ger>

The amount of time to wait for
3ds Max to unload, in minutes.
Default=10.

-waitUnload:<inte-
ger>

The platform (either 32– or
64–bit) that your scene will be

–platform:32 or
64

rendered on. Use this switch
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EffectSwitch

when you want to render your
scene on a different platform
from the platform where you
created your scene.

Bitmap Parameters

EffectSwitch

Sets the type of BMP file being
rendered. “2”=paletted,
“8”=true 24-bit.

-BMP_TYPE:2 or 8

Sets the JPG quality value.
Ranges from 1 to 100.

-JPEG_QUALITY:1
to 100

Sets the JPG smoothing value.
Ranges from 1 to 100.

-JPEG_SMOOTH-
ING:1 to 100

Sets the color depth for TGA
files.

-TARGA_COL-
ORDEPTH:16, 24
or 32

Toggles TGA Compression.
“1”=On, “0”=Off.

-TARGA_COM-
PRESSED:<1/0>

Toggles TGA Alpha Split.
“1”=On, “0”=Off.

-TARGA_ALPHAS-
PLIT:<1/0>

Toggles TGA Pre-Multiplied Al-
pha. “1”=On, “0”=Off.

-TARGA_PREMUL-
TALPHA:<1/0>

Sets the TIF type. “0”=mono,
“1”=color, “2”=logl, “3”=logluv,
“4”=16–bit color.

-TIF_TYPE:<0/1/2/3/4>
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EffectSwitch

Toggles TIF file alpha. “1”=On,
“0”=Off.

-TIF_ALPHA:<1/0>

Toggles TIF Compression.
“1”=On, “0”=Off.

-TIF_COMPRES-
SION:<1/0>

Sets the dots-per-inch value for
TIF files.

-TIF_DPI:<num-
ber>

For each of the following -RLA_xxxx switches, there is a corresponding
-RPF_xxxx option.

EffectSwitch

Sets the RLA color
bitdepth.

-RLA_COLORDEPTH:8, 16 or
32

Toggles RLA Alpha.
“1”=On, “0”=Off.

-RLA_ALPHA:<1/0>:

Toggles RLA Premulti-
plied Alpha. “1”=On,
“0”=Off.

-RLA_PREMULTALPHA:<1/0>

Lets you specify an
RLA description (in
quotes).

-RLA_DESCRIPTION:<string>

Lets you specify an
RLA author name (in
quotes).

-RLA_AUTHOR:<string>

Toggles RLA Z-Depth
Channel. “1”=On,
“0”=Off.

-RLA_ZDEPTHCHAN-
NEL:<1/0>
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EffectSwitch

Toggles RLA Material
Effects Channel.
“1”=On, “0”=Off.

-RLA_MTLIDCHANNEL:<1/0>

Toggles RLA Object
Channel. “1”=On,
“0”=Off.

-RLA_OBJECTIDCHAN-
NEL:<1/0>

Toggles RLA UV Coor-
dinates Channel.
“1”=On, “0”=Off.

-RLA_UVCHANNEL:<1/0>

Toggles RLA Surface
Normals Channel.
“1”=On, “0”=Off.

-RLA_NORMALCHAN-
NEL:<1/0>

Toggles RLA Non-
Clamped Color

-RLA_NONCLAMPEDCOLOR-
CHANNEL:<1/0>

Channel. “1”=On,
“0”=Off.

Toggles RLA Cover-
age Channel.
“1”=On, “0”=Off.

-RLA_COVERAGECHAN-
NEL:<1/0>

The following -RPF_xxxx switches do not have corresponding -RLA_xxxx options.

EffectSwitch

Turns on RPF Node
Render ID Channel.

-RPF_NODERENDERID-
CHANNEL

Turns on RPF Color
Channel.

-RPF_COLORCHANNEL

Turns on RPF Trans-
parency Channel.

-RPF_TRANSPCHANNEL
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EffectSwitch

Turns on RPF Velocity
Channel.

-RPF_VELOCCHANNEL

Turns on RPF Sub-Pixel
Weight Channel.

-RPF_WEIGHTCHAN-
NEL<1/0>

Turns on RPF Sub-Pixel
Mask Channel.

-RPF_MASKCHANNEL

EffectSwitch

EXR use exponent
on/off

-EXR_USEEXPONENT

EXR exponent value
(decimal)

-EXR_EXPONENT

EXR premultiplied alpha
on/off

-EXR_PREMULTALPHA

EXR save alpha compo-
nent on/off

-EXR_ALPHA

EXR save red compo-
nent on/off

-EXR_RED

EXR save green compo-
nent on/off

-EXR_GREEN

EXR save blue compo-
nent on/off

-EXR_BLUE

EXR bit depth: 0=8–bit
integers; 1=half float;
2=float

-EXR_BITDEPTH
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EffectSwitch

EXR use number of
frame digits on/off

-EXR_USEFRAMENUMDIG-
ITS

EXR number of frame
digits (integer)

-EXR_FRAMENUMDIGITS

EXR compression type:
0=no compression;

-EXR_COMPRESSIONTYPE

1=RLE; 2=ZIP (1 scan-
line); 3=ZIP (16 scan-
lines); 4=PIZ

EXR use RealPix RGB da-
ta on/off

-EXR_USEREALPIX

Backburner Command Line Control

The Backburner command line plug-in allows you to submit batch, executable,
or script files to Backburner as “custom” jobs. This cmdjob.exe tool, found in
the Backburner program folder, provides more flexibility in running custom
jobs than is offered by the 3ds Max 3dsmaxcmd.exe plug-in.

For a list of the command-line switches that you can use with the Backburner
command line plug-in, see Command-Line Rendering Switches on page 6365
. Some examples of how these commands can be used with 3ds Max are listed
below.

NOTE In order to use command-line rendering, you should be familiar with DOS
and understand the structure of command lines.

Examples of a CmdJob Usage

Please see the online version of the User Reference for details.

See also:

■ Command-Line Rendering on page 6361
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Effects and Environments

A variety of special effects, such as film grain, depth of field, and lens simulations, are available
as rendering effects on page 6381 . Another set of effects, such as fog, are provided as
environment effects on page 6484 .

The fog environment effect adds atmosphere to a street scene.

In 3ds Max, rendering effects and environments are both accessed from a single Environment
and Effects dialog on page 6380 .

19

6379



Environment and Effects Dialog
Rendering menu > Environment

Rendering > Effects

You apply effects and environments by using the Environment and Effects
dialog.

Interface

The Environment and Effects dialog has two panels, described in the following
topics:

Effects Panel and Rollout on page 6383
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Environment Panel on page 6486

Rendering Effects
Rendering Effects enable you to add post-production effects without having
to render the scene to see the results. Through the Effects panel on page 6383
on the Environment and Effects dialog, you can add various effects and view
them prior to final rendering of an image or animation.

Render Effects let you work interactively. As you adjust an effect's parameters,
the rendered frame window on page 5885  is updated with the final output
image of both the scene geometry and the applied effects. You can also choose
to continually work with an effect and then update the effect manually.

The following topics explain each Render Effect in detail.

Hair and Fur Render Effect on page 6386

Lens Effects Rendering Effects on page 6391

Blur Rendering Effect on page 6461

Brightness and Contrast Rendering Effect on page 6470

Color Balance Rendering Effect on page 6472

Depth of Field Rendering Effect on page 6480

File Output Rendering Effect on page 6473

Film Grain Rendering Effect on page 6476

Motion Blur Rendering Effect on page 6478

Rendering Effects and 32–bit Floating-Point Output

Most rendering effects in 3ds Max are not compatible with 32-bit floating-point
output, such as that provided optionally by the mental ray renderer (see
Frame Buffer Type on page 6087 ). If you render using one or more unsupported
effects, the following dialog appears:
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You can choose to continue rendering without the unsupported effects, or
cancel the render.

The only supported effects are File Output and Color Balance; the rest (shown
in the dialog above) are unsupported.

Rendering Effects Command

Rendering menu > Effects > Environment and Effects dialog > Effects panel

Effects displays the Effects panel on page 6383  on the Environment and Effects
dialog, which lets you set parameters for post-rendering effects.

From this panel, you can select and assign a class of plug-in called Render
Effect, which is a post-rendering image-processing effect. This lets you apply
image processing without using Video Post.

Render Effects have the added advantage of allowing animated parameters
and references to scene objects. You can also adjust and view the effects
interactively.
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Effects Panel and Rollout

Rendering menu > Effects > Environment and Effects dialog > Effects panel

You can use the Effects panel to:

■ Assign a Render Effects plug-in.

■ Apply image processing without using Video Post.

■ Adjust and view effects interactively.

■ Animate parameters and references to scene objects.

Interface

The Effects panel has one main rollout, Effects, with the following options:
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Effects Displays a list of selected effects.

Name Displays the name of the selected effect. Edit this field to rename the
effect.

Add Displays a dialog listing all available rendering effects. Select the effect
you want added to the window list, and then click OK.

Delete Removes a highlighted effect from the window and from the scene.

Active Specifies whether the selected effect is active in the scene. On by
default; you can deactivate an effect without actually removing it by selecting
it in the window and turning off Active.

Move Up Moves the highlighted effect up in the window list.

Move Down Moves the highlighted effect down in the window list.

Merge Merges rendering effects from scene (.max) files. Clicking Merge
displays a file dialog from which you can choose a .max file. A dialog then
appears listing all rendering effects in that scene.

Preview group

Effects When All is chosen, all of the active effects are applied to the preview.
When Current is chosen, only the highlighted effects are applied to the
preview.

Interactive When on, changes occur interactively in the rendered frame
window on page 5885  as you adjust the parameters of an effect. When Interactive
is not activated, you can click one of the update buttons to preview the effect.

Show Original/Show Effects toggle Click Show Original to display the
original rendered image without any of the effects applied. Click Show Effects
to display the rendered image with the effects.

Update Scene Updates the rendered frame window with all changes made
in Rendering Effects as well as any changes made to the scene itself.

Update Effect Manually updates the preview rendered frame window when
Interactive is not on. What is shown in the rendered frame window is only
an update of any changes made in Rendering Effects. Any changes made to
the scene itself will not be rendered.
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Merging Effects

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Merge

The Merge button on the Effects panel on page 6383  lets you merge effects
from other 3ds Max (.max) scene files.

See also:

■ Merge on page 6854

■ Replace on page 6866

■ Merge Animation on page 6859

Procedures

To merge an atmospheric effect:

1 Choose Rendering menu > Effects to display the Effects panel.

2 On the Effects rollout, click Merge.

A Merge Effect dialog appears for file selection.

3 Select a .max scene.

A Merge Atmospheric Effects dialog lists the effects in the specified file.

4 Select one or more of the effects, and then click OK to merge them into
the scene.

Only atmospheric effects appear in the merge list, but when an effect is
merged, any lights or gizmos bound to the effect are merged as well.
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To resolve conflicts when merged effects have the same name:

■ If an effect of the same type and name already exists in the scene, an alert
appears. Choose from among these options:

■ Name field Allows you to rename the incoming effect.

■ Merge Results in two effects in the scene with the same name.

■ Delete Old Removes the existing effect in the scene.

■ Apply To All Duplicates Performs the same action on all subsequent
matching effects.

Hair and Fur Render Effect

Rendering menu > Effects > Environment And Effects dialog > Effects panel
> Add > Add Effect dialog > Hair and Fur

Hair and Fur modifier > Tools rollout > Render Settings button

To render hair, the scene must contain a Hair And Fur render effect. The render
effect is automatically added to the scene the first time you apply the Hair
And Fur modifier to an object, or 3ds Max adds one (with default values) at
render time if an active Hair And Fur modifier is applied to an object. If for
some reason the render effect doesn't exist in the scene, you can add one by
clicking the Render Settings button. This opens the Environment And Effects
dialog and adds a Hair And Fur render effect. You can change the settings, or
simply accept the default settings by closing the dialog after it opens.
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Interface
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Hair Rendering Options group

Hairs Sets the method to be used for rendering hair:

■ buffer (The default) Procedural hair generated by Hair at render time
based on the modifier parameters. Buffer hair is generated by a special
renderer within Hair and offers the benefit of being able to create millions
of hairs with minimal memory requirements. Only one hair is in memory
at a time. Also, using Buffer render offers a variety of compositing options
(described below).

■ geometry Creates actual geometry for the rendered hair at render time.
This geometry is assigned the material ID set by the Hair And Fur modifier
> Geom Mat ID parameter on page 1097 .

NOTE “Geometry” hair derives its texture from the growth object, not from
any maps applied via the Material Parameters rollout.
Compositing options aren't available with “geometry” hair.

The “geometry” option works with both the default scanline renderer and
the mental ray renderer.

■ mr prim Hair is generated by a procedural mental ray shader that
generates mental ray curve primitives directly into the mental ray rendering
stream at render time.
Choose this option only when you are rendering hair with the mental ray
renderer on page 6039 .

mr Voxel Resolution Available only for the “geometry” and “mr prim” Hairs
options. At render time, hair boundaries are subdivided into volume cubes or
“voxels.” 3ds Max calculates which hairs are in each voxel, and when a ray
enters a voxel, it calculates for those hairs. This allows unneeded voxels to be
removed from memory during calculation.

With “geometry” rendering, voxels are used only for calculating instanced
hairs.

This value gives the resolution of the subdivision. For example, a value of 3
subdivides the volume into 3 x 3 x 3 voxels, for a total of 27. The higher this
value, the more efficient calculations can be. Default=5.

Lighting

■ native (The default.) Uses standard 3ds Max calculations for light falloff.
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■ emulation Performs a simpler internal calculation for light falloff within
the buffer render. It applies only to the buffer hair rendering itself, not the
3ds Max scene. This mode omits features such as illumination textures on
the hair, and light falloff calculation might be slightly inaccurate, but
rendering is somewhat faster.

Raytrace the Reflections/Refractions Available only for the “buffer” Hairs
option. When on, reflections and refractions are ray-traced. When off, they
are calculated as usual. Turning this option on can increase realism at the cost
of render time. Default=off.

Motion Blur group

In order to render motion-blurred hairs, Motion Blur must be enabled for the
growth object.

Duration The number of frames over which motion blur is calculated for
each frame.

Interval The point in the duration at which the “snapshot” of the hair is
captured, before blurring. The choices are “start”, “middle”, and “end”. The
default is “middle”, which causes blurring to occur at the start and end of the
duration.

Buffer Rendering Options group

This setting applies only to the ”buffer” rendering method on page 6388 .

Oversampling Controls the level of antialiasing applied to the Hair “buffer”
render. The available choices are “draft”, “low”, “medium”, “high”, and
“maximum”. The “draft” setting uses no antialiasing; “high” is suitable for
most final renders; in extreme cases, use “maximum”. The higher the
Oversampling level, the greater the memory requirements and render time.
Default=”low.”

Composite Method group

This option lets you choose the method by which Hair composites hair with
the rest of the scene. Compositing options are available only with the “buffer”
rendering method.

■ None Renders the hair only, with occlusion. The resulting image is ready
to composite.

■ Off Renders hair shadows but not the hair.
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■ Normal (The default.) Does standard rendering and composites the
occluded hair with the rest of the scene in the rendered frame window.
Because of the occlusion, hair will not appear behind (through) transparent
objects.

■ GBuffer Buffer-rendered hair appears behind most transparent objects.
Transparent refractive objects aren't supported.

Occlusion Objects group

This setting lets you choose which objects will occlude hair in the scene; that
is, if the object is closer to the camera than part of the hair array, the hairs
behind it won't render. By default, all objects in the scene occlude hair behind
them.

■ Auto (The default.) All renderable objects in the scene occlude hair behind
them.

■ All All objects in the scene, including non-renderable objects, occlude
hair behind them.

■ Custom Lets you specify the objects that will occlude hair. Choosing this
option makes the buttons on the right slide of the list available. If you
choose Custom but don't specify any occlusion objects, no objects will
occlude the hair; that is, the hair will appear in front of all objects, whether
or not it's closer to the camera than the objects.

List The list of custom occlusion objects. To edit this list, choose Custom
and then use the buttons on the right side of the list.

Add Adds a single object to the list. Click Add and then in a viewport, click
the object to add.

Add List Adds multiple objects to the list. Click Add List and then in a
viewport, click each object to add in turn. To finish, right-click the viewport
or click Add List again to turn it off.

Replace To replace an object in the list, highlight its name in the list, click
Replace, and then in a viewport click the replacement object.

Delete To remove an object from the list, highlight its name in the list and
then click Delete.
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Lighting group

These settings control the illumination of hair and shadow-casting from hair
by supported lights in the scene.

The following light types are not supported when rendering hair with the
“buffer” method: Skylight, mr Area Omni, mr Area Spot, IES Sun, IES Sky, mr
Sky and mr Sun. However, mr Area Omni, mr Area Spot, mr Sky, and mr Sun
are supported for hair when you use the “mr prim” method and the mental
ray renderer.

NOTE For the purposes of rendering shadows in hair, Direct lights are treated as
point (omni) lights.

Shadow Density Specifies the relative darkness of the shadows. At the default,
highest value, 100.0, shadows are darkest. At the lowest value, 0.0, shadows
are fully transparent, so they don't render. Range=0.0 to 100.0. Default=100.0.

Use all lights at render time When on, causes all supported lights in the
scene to illuminate and cast shadows from hair when the scene is rendered.
(Shadows are cast only from lights whose Shadows toggle is on.) When off,
for a light to cast shadows from hair, you explicitly must add hair properties.
In either case, shadow maps for hair use the settings from the Hair Light
Attr(ibutes) rollout on page 5076  Default=on.

NOTE These settings apply only to “buffer”-rendered hair (the default type, set
in the Hair Rendering Options group, as described above).

Add hair properties Adds the Hair Light Attr(ibutes) rollout on page 5076  to
selected lights in the scene. If you want to assign hair-specific shadow
properties on a per-light basis, this rollout is necessary. Available only when
at least one supported light is selected.

When Use All Lights At Render Time is off, only lights with hair properties
can illuminate hair.

Remove hair properties Removes the Hair Light Attr(ibutes) rollout on page
5076  from selected lights in the scene. Available only when at least one light
with hair properties added is selected.

Lens Effects Rendering Effects

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects
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Lens flares added as lens effects

Lens Effects is a system used to create real-life effects commonly associated
with a camera. These effects include Glow on page 6397 , Ring on page 6404 ,
Ray on page 6414 , Auto Secondary on page 6421 , Manual Secondary on page
6429 , Star on page 6436 , and Streak on page 6443 .

Procedures

To add an effect:

1 Select the desired effect from the list on the left side of the Lens Effects
Parameters rollout.

2 Click the (>) arrow button to move it into the column on the right.

To delete an applied effect:

1 Select the effect from the list on the right side of the Lens Effects
Parameters rollout.

2 Click the (<) arrow button to remove it from the list.
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Interface

Lens Effects Parameters rollout

The Lens Effects system allows you to apply effects to your rendered image
by choosing a particular effect from the list on the left and adding it to the
list on the right. Each effect has its own rollout of parameters, but all effects
share two panels of global parameters.
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Lens Effects Globals rollout, Parameters panel

Load Displays the Load Lens Effects file dialog that enables you to open an
LZV file. The LZV file format contains information saved from a previous
configuration of Lens Effects. This allows you to load and use Lens Effects that
have been saved from previous sessions of the software.

Save Displays the Save Lens Effects file dialog that enables you to save an
LZV file. The LZV file format contains information saved from a previous
configuration of Lens Effects. This allows you to save several types of Lens
Effects and use them in multiple 3ds Max scenes.

NOTE Saving an effect as an LZV file will only save the attributes of the effect on
the frame that it is saved at. The LZV file format doesn’t save the animation keys
of an animated parameter.

Size Affects the size of the overall Lens Effect. This value is a percentage of
the size of the rendered frame.

Intensity Controls the overall brightness and opacity of the Lens Effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.
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Seed Gives the random number generator in Lens Effects a different starting
point, which creates a slightly different Lens Effect without changing any
settings. Using Seed guarantees a different Lens Effect, even if the differences
are very small. For example, if you set up a Ray effect, you will get slightly
different rays in the lens flare if you adjust the seed value.

Angle Affects the amount that the Lens Effect rotates from its default
position, as the position of the effect changes relative to the camera.

Squeeze Squeezes the size of the overall Lens Effect, either horizontally or
vertically to compensate for different frame aspect ratios. Positive values stretch
the effect horizontally, and negative values stretch it vertically. The value is
a percentage of the size of the flare. Range=100 to -100.

Lights group

Allows you to choose lights to apply Lens Effects to.

Pick Light Enables you to select a light directly through the viewports. You
can also select a light by pressing H to open the Pick Object dialog.

Remove Light Removes a selected light.

Drop-down list Provides quick access to lights that you have added to the
Lens Effect.
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Lens Effects Globals rollout, Scene panel

Affect Alpha Specifies whether or not the Lens Effect affects the alpha channel
of an image when the image is rendered in a 32-bit file format. The alpha
channel is an extra 8 bits of color (256 colors) that indicate transparency in
an image. Alpha channels are used to composite one image seamlessly over
the top of another. If you want to composite a Lens Effect, or an image that
contains a Lens Effect, over the top of another image, enable this option. If
you are not rendering to a 32-bit file, do not enable this option.

Affect Z Buffer Stores an object's distance from the camera. The Z-Buffer is
useful for optical effects. When this option is enabled, the linear distance of
the Lens Effect is recorded, and can be used in special effects that make use
of the Z-Buffer.

Distance Affects Allows distance from the camera or viewport to affect the
size and/or the intensity of the effect.

Off-Center Affects Allows an effect that is off-center from the camera or
viewport to affect the size and/or the intensity of the effect.

Direction Affects Allows direction of spot lights with respect to the camera
or viewport to affect the size and/or the intensity of the effect.
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The size and intensity of the effect are at a maximum when the light is pointed
at the camera (or viewport).

Occlusion group

Occlusion is used to determine when a Lens Effect will be affected by an object
that comes between the effect and the camera. By using two spinners to
determine occlusion you can have scene objects realistically affect the look
of your effect. The outer radius will determine when another scene object will
begin to occlude and the inner radius will determine when the scene object
will cause the effect to reach maximum occlusion.

Inner Radius Sets the inner radius around the effect that another scene object
must intersect in order to completely occlude the effect.

Outer Radius Sets the outer radius around the effect that another scene object
must intersect in order to begin to occlude the effect.

Size Decreases the size of the effect when being occluded.

Intensity Decreases the intensity of the effect when being occluded.

Affected by Atmosphere Allows Atmospheric Effects to occlude Lens Effects.

Glow Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Glow, and click the (>) arrow
button.
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Adding glow to the light

Glow lets you add a glowing aura around any assigned object. For example,
for an exploding particle system, adding a glow to the particles makes them
seem as though they are brighter and hotter.

WARNING This effect is not supported by the mental ray renderer on page 6039
.
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Interface

Glow Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is often necessary to name them to make sure that when you change
parameters you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated.

Size Determines the size of the effect.
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Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Glow Behind Gives the effect the ability to be displayed behind objects in
your scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated
the effect will be squeezed according to Lens Effects Globals under the
Parameters panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are
applying the effect to and the color or mapping set in the Radial Color or
Circular Color parameters. A value of 0 uses only the values set in the Radial
Color and Circular Color parameters while a value of 100 uses only the light
or objects source color. Any value between 0 and 100 will render a mix between
the source color and the effect’s color parameters.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as Gradient or Cellular to determine the radial
color.

Falloff Curve Displays the Radial Falloff dialog on page 6455  in which you
can set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.

Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.

Mix Mixes colors set in Radial Color and colors set in Circular Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Circular Color. Any value between
0 and 100 will mix between the two values.

6400 | Chapter 19   Effects and Environments



Falloff Curve Displays the Circular Falloff dialog on page 6450  in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6458 . Using the Radial
Size dialog you can create points on a line and move those points along a
graph to determine where the effect should be placed around the light or
object. You can also use a map to determine where the effect should be placed.
A check box is used to activate the map.

Glow Element rollout, Options panel
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Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that
have a corresponding G-Buffer on page 7795  (or Object) ID. The G-Buffer is a
geometry buffer and can be defined when you right-click any object and select
Properties from the menu. Then, set the Object Channel ID under the G-Buffer
ID controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5252  assigned to it. Assign the Material
ID channel in the Material Editor, using the Material ID channel flyout on
page 5254 . The Lens Effect will be applied only to areas of the geometry where
that particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255).
The software keeps track of these "hot" areas which tend to show up when
your scene contains bright metallic highlights or explosions. This spinner lets
you determine the lowest pixel value that the Lens Effect is applied to. Pure
white has a pixel value of 1. When this spinner is set to 1, any pixels with a
value above 255 will be glowed. You can invert this value by clicking the I
button to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle
of the surface normal to the camera. A value of 0 is coplanar, or parallel to
the screen. A value of 90 is normal, or perpendicular to the screen. If you set
Surf Norm to 45, only surfaces with normal angles greater than 45 degrees
will be glowed. You can invert this value by clicking the I button to the right
of the spinner. This parameter can be animated.
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Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.

Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner
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Hue Filters the source objects by their hue. Select the hue by clicking the
color swatch next to the spinner. You can choose hue values from 0 to 255.
The spinner beside the Hue color swatch lets you enter a variance level so that
the glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.

Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6453 . Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Ring Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Ring, and click the (>) arrow
button.
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Adding a ring to the light

The ring is a circular color band that surrounds the center of the source object.

WARNING This effect is not supported by the mental ray renderer on page 6039
.
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Interface

Ring Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is often necessary to name them to make sure that when you change
parameters you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated. Default = on.

Size Determines the size of the effect.
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Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Plane Sets the location of the effect along the axis of the effect which extends
from the center of the effect through the center of the screen.

Thickness Determines the thickness, in pixels, of the effect.

Glow Behind Gives the effect the ability to be displayed behind objects in
your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated
the effect will be squeezed according to Lens Effects Globals under the
Parameters panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are
applying the effect to with the color or mapping set in the Radial Color or
Circular Color parameters. A value of 0 uses only the values set in the Radial
Color and Circular Color parameters while a value of 100 uses only the light
or objects source color. Any value between 0 and 100 will render a mix between
the source color and the effect’s color parameters.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as gradient or cellular to determine the radial
color.
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Ring using radial colors as seen in lower left inset

Falloff Curve Displays the Radial Falloff dialog on page 6455  in which you
can set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff.

Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.
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Ring using circular colors as seen in lower right inset

Mix Mixes colors set in Radial Color and colors set in Circular Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Circular Color. Any value between
0 and 100 will mix between the two values.
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Ring using radial and circular colors mixed 50/50

Falloff Curve Displays the Circular Falloff dialog on page 6450  in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6458 . Using the Radial
Size dialog you can create points on a line and move those points along a
graph to determine where the effect should be placed around the light or
object. You can also use a map to determine where the effect should be placed.
A check box is used to activate the map.
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Ring Element rollout, Options panel

Apply Element To

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that
have a corresponding G-Buffer on page 7795  (or Object) ID. The G-Buffer is a
geometry buffer and can be defined when you right-click any object and select
Properties from the menu. Then, set the Object Channel ID under the G-Buffer
ID controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5252  assigned to it. Assign the Material
ID channel in the Material Editor, using the Material ID channel flyout on
page 5254 . The Lens Effect will be applied only to areas of the geometry where
that particular ID channel is present.
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TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255).
The software keeps track of these "hot" areas which tend to show up when
your scene contains bright metallic highlights or explosions. This spinner lets
you determine the lowest pixel value that the Lens Effect is applied to. Pure
white has a pixel value of 1. When this spinner is set to 1, any pixels with a
value above 255 will be glowed. You can invert this value by clicking the I
button to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle
of the surface normal to the camera. A value of 0 is coplanar, or parallel to
the screen. A value of 90 is normal, or perpendicular to the screen. If you set
Surf Norm to 45, only surfaces with normal angles greater than 45 degrees
will be glowed. You can invert this value by clicking the I button to the right
of the spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.

Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.
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All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the
color swatch next to the spinner. You can choose hue values from 0 to 255.
The spinner beside the Hue color swatch lets you enter a variance level so that
the glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.

Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6453 . Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.
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Ray Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Ray, and click the (>) arrow
button.

Adding rays to the light

Rays are bright lines that radiate from the center of the source object, providing
the illusion of extreme brightness for the object. Rays let you emulate scratches
in the lens elements of a camera.
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Interface

Ray Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is often necessary to name them to make sure that when you change
parameters you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated. Default = on.
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Size Determines the size of the effect.

Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Num Specifies the overall number of rays that appear in the lens flare. Rays
are randomly spaced around the radius.

Angle Specifies the angle for the rays. You can enter both positive and
negative values so, when animated, the rays rotate in a clockwise or
counterclockwise direction.

Sharp Specifies the overall sharpness of the rays. Higher numbers produce
crisp, clean, and clear rays. Lower numbers produce more of a secondary glow
look. Range=0 to 10.

Glow Behind Gives the effect the ability to be displayed behind objects in
your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated,
the effect will be squeezed according to Lens Effects Globals under the
Parameters panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are
applying the effect to and the color or mapping set in the Radial Color or
Circular Color parameters. A value of 0 uses only the values set in the Radial
Color and Circular Color parameters while a value of 100 uses only the light
or objects source color. Any value between 0 and 100 will render a mix between
the source color and the effect’s color parameters.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as Gradient or Cellular to determine the radial
color.

Falloff Curve Displays the Radial Falloff dialog on page 6455  in which you
can set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.

6416 | Chapter 19   Effects and Environments



Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.

Mix Allows you to mix between colors set in Radial Color and colors set in
Circular Color. Setting the spinner at 0 will only use values set in Radial Color
while setting the spinner at 100 will only use values set in Circular Color. Any
value between 0 and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6450  in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6458 . Using the Radial
Size dialog you can create points on a line and move those points along a
graph to determine where the effect should be placed around the light or
object. You can also use a map to determine where the effect should be placed.
A check box is used to activate the map.
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Ray Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that
have a corresponding G-Buffer on page 7795  (or Object) ID. The G-Buffer is a
geometry buffer and can be defined when you right-click any object and select
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Properties from the menu. Then, set the Object Channel ID under the G-Buffer
ID controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5252  assigned to it. Assign the Material
ID channel in the Material Editor, using the Material ID channel flyout on
page 5254 . The Lens Effect will be applied only to areas of the geometry where
that particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255).
The software keeps track of these "hot" areas which tend to show up when
your scene contains bright metallic highlights or explosions. This spinner lets
you determine the lowest pixel value that the Lens Effect is applied to. Pure
white has a pixel value of 1. When this spinner is set to 1, any pixels with a
value above 255 will be glowed. You can invert this value by clicking the I
button to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle
of the surface normal to the camera. A value of 0 is coplanar, or parallel to
the screen. A value of 90 is normal, or perpendicular to the screen. If you set
Surf Norm to 45, only surfaces with normal angles greater than 45 degrees
will be glowed. You can invert this value by clicking the I button to the right
of the spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.
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Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Edge filter applied to rays emanating from object

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.
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Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the
color swatch next to the spinner. You can choose hue values from 0 to 255.
The spinner beside the Hue color swatch lets you enter a variance level so that
the glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.

Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6453 . Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Auto Secondary Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Auto Secondary, and click
the (>) arrow button.
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Adding secondary flares to the light

Secondary flares are the small circles you would normally see coming out from
the source of the lens flare along an axis relative to the camera position. These
are caused by light refracting off the different lens elements in the camera. As
the camera position changes relative to the source object, the secondary flares
move.
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Interface

Auto Secondary Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it
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is necessary to name them to make sure that when you change parameters
you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated. Default = on.

Min Controls the minimum size of secondary flares in the current set. This
number is defined as a percentage of the overall image.

Max Controls the maximum size of secondary flares in the current set. This
number is defined as a percentage of the overall image.

Axis Defines the overall length of the axis the automatic secondary flares
will be distributed along. Increasing the value creates more space between the
flares, while decreasing the value creates less space between the flares. You
can set the axis from 0 to 10 degrees.

Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Qty Controls the number of secondary flares that appear in the current set
of flares.

Use Source Color Mixes the source color of the light or object you are
applying the effect to with the color or mapping set in the Radial Color or
Circular Color parameters. A value of 0 uses only the values set in the Radial
Color and Circular Color parameters while a value of 100 uses only the light
or objects source color. Any value between 0 and 100 will render a mix between
the source color and the effect’s color parameters.

Sides Controls the shape of the secondary flares for the current set. The
default is circular, but you can choose from 3- to 8-sided secondary flares.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Presets (drop-down list) Displays a list of preset values that can be selected
and applied to the rendered scene.

Squeeze Determines whether the effect will be squeezed. When activated,
the effect will be squeezed according to Lens Effects Globals under the
Parameters panel in the Squeeze spinner.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
Each color swatch has a percentage spinner that determines at what point
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that color should stop and the next should start. You can also use bitmaps
such as gradient or cellular to determine the radial color.

Falloff Curve Displays the Radial Falloff dialog on page 6455  in which you
can set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.

Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.

Mix Allows you to mix between colors set in Radial Color and colors set in
Circular Color. Setting the spinner at 0 will only use values set in Radial Color
while setting the spinner at 100 will only use values set in Circular Color. Any
value between 0 and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6450  in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6458 . Using the Radial
Size dialog you can create points on a line and move those points along a
graph to determine where the effect should be placed around the light or
object. You can also use a map to determine where the effect should be placed.
A check box is used to activate the map.
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Auto Secondary Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that
have a corresponding G-Buffer on page 7795  (or Object) ID. The G-Buffer is a
geometry buffer and can be defined when you right-click any object and select
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Properties from the menu. Then, set the Object Channel ID under the G-Buffer
ID controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5252  assigned to it. Assign the Material
ID channel in the Material Editor, using the Material ID channel flyout on
page 5254 . The Lens Effect will be applied only to areas of the geometry where
that particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255).
The software keeps track of these "hot" areas which tend to show up when
your scene contains bright metallic highlights or explosions. This spinner lets
you determine the lowest pixel value that the Lens Effect is applied to. Pure
white has a pixel value of 1. When this spinner is set to 1, any pixels with a
value above 255 will be glowed. You can invert this value by clicking the I
button to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle
of the surface normal to the camera. A value of 0 is coplanar, or parallel to
the screen. A value of 90 is normal, or perpendicular to the screen. If you set
Surf Norm to 45, only surfaces with normal angles greater than 45 degrees
will be glowed. You can invert this value by clicking the I button to the right
of the spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.
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Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the
color swatch next to the spinner. You can choose hue values from 0 to 255.
The spinner beside the Hue color swatch lets you enter a variance level so that
the glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.
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Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6453 . Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Manual Secondary Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Manual Secondary, and click
the (>) arrow button.

Manual secondary flares are additional secondary flares that are individually
added to the lens flare. These can be used in addition to, or in place of auto
secondary flares on page 6421 .

You use Manual Secondary flares when you want to add unique flares that
you don't want repeated.
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Interface

Manual Secondary Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it
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is necessary to name them to make sure that when you change parameters
you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated. Default = on.

Size Determines the size of the effect.

Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Plane Controls the distance, in degrees, between the flare source and the
manual secondary flare. By default, the flare plane exists at the center of the
chosen node source. Positive values place the flare in front of the source, while
negative values place the flare behind the flare source.

Use Source Color Mixes the source color of the light or object you are
applying the effect to and the color or mapping set in the Radial Color or
Circular Color parameters. A value of 0 uses only the values set in the Radial
Color and Circular Color parameters while a value of 100 uses only the light
or objects source color. Any value between 0 and 100 will render a mix between
the source color and the effect’s color parameters.

Sides Controls the shape of the secondary flares for the current set. The
default is circular, but you can choose from 3- to 8-sided secondary flares.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Presets (drop-down list) Displays a list of preset values that can be selected
and applied to the rendered scene.

Squeeze Determines whether the effect will be squeezed. When activated,
the effect will be squeezed according to Lens Effects Globals under the
Parameters panel in the Squeeze spinner.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as gradient or cellular to determine the radial
color.

Falloff Curve Displays the Radial Falloff dialog on page 6455  in which you
can set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.

Lens Effects Rendering Effects | 6431



You can also use a map to determine the falloff when a light is used as a Lens
Effects source.

Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.

Mix Mixes colors set in Radial Color and colors set in Circular Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Circular Color. Any value between
0 and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6450  in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6458 . Using the Radial
Size dialog you can create points on a line and move those points along a
graph to determine where the effect should be placed around the light or
object. You can also use a map to determine where the effect should be placed.
A check box is used to activate the map.
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Manual Secondary Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that
have a corresponding G-Buffer on page 7795  (or Object) ID. The G-Buffer is a
geometry buffer and can be defined when you right-click any object and select
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Properties from the menu. Then, set the Object Channel ID under the G-Buffer
ID controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5252  assigned to it. Assign the Material
ID channel in the Material Editor, using the Material ID channel flyout on
page 5254 . The Lens Effect will be applied only to areas of the geometry where
that particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255).
The software keeps track of these "hot" areas which tend to show up when
your scene contains bright metallic highlights or explosions. This spinner lets
you determine the lowest pixel value that the Lens Effect is applied to. Pure
white has a pixel value of 1. When this spinner is set to 1, any pixels with a
value above 255 will be glowed. You can invert this value by clicking the I
button to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle
of the surface normal to the camera. A value of 0 is coplanar, or parallel to
the screen. A value of 90 is normal, or perpendicular to the screen. If you set
Surf Norm to 45, only surfaces with normal angles greater than 45 degrees
will be glowed. You can invert this value by clicking the I button to the right
of the spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.
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Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the
color swatch next to the spinner. You can choose hue values from 0 to 255.
The spinner beside the Hue color swatch lets you enter a variance level so that
the glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.
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Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6453 . Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Star Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Star, and click the (>) arrow
button.

Adding a star to the light

A Star is larger than a Ray effect on page 6414  and is composed of 0 to 30 spokes,
instead of hundreds like a ray.
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Interface

Star Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects, you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is necessary to name them to make sure that when you change parameters
you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated.
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Size Determines the size of the effect.

Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Width Specifies the width of the individual spokes, as a percentage of the
overall frame.

Angle Sets the starting angle in degrees in which the star spokes point. You
can enter both positive and negative values so, when animated, the star spokes
rotate in a clockwise or counterclockwise direction.

Taper Controls the taper of the individual spokes of the star. Taper widens
or narrows the tips of the individual star points. Low numbers create a sharp
point, while high numbers flare the points.

Sharp Specifies the overall sharpness of the star. Higher numbers produce
crisp, clean, and clear stars. Lower numbers produce more of a secondary glow
look. Range=0 to 10.

Qty Specifies the number of spokes in the star effect. The default is 6. Spokes
are spaced at equidistant points about the center of the flare.

Glow Behind Gives the effect the ability to be displayed behind objects in
your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated,
the effect will be squeezed according to Lens Effects Globals under the
Parameters panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are
applying the effect to and the color or mapping set in the Radial Color or
Circular Color parameters. A value of 0 uses only the values set in the Radial
Color and Circular Color parameters while a value of 100 uses only the light
or objects source color. Any value between 0 and 100 will render a mix between
the source color and the effect’s color parameters.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as gradient or cellular to determine the radial
color.

6438 | Chapter 19   Effects and Environments



Falloff Curve Displays the Radial Falloff dialog on page 6455  in which you
can set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.

Section Color group

Selection Color determines the color of the effect by using three different color
swatches that are matched to the three sections of the effect. A map can also
be used to determine section color.

Mix Mixes colors set in Radial Color and colors set in Section Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Section Color. Any value between 0
and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6450  in which you
can set weights for the colors used in Section Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6458 . Using the Radial
Size dialog you can create points on a line and move those points along a
graph to determine where the effect should be placed around the light or
object. You can also use a map to determine where the effect should be placed.
A check box is used to activate the map.
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Star Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that
have a corresponding G-Buffer on page 7795  (or Object) ID. The G-Buffer is a
geometry buffer and can be defined when you right-click any object and select
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Properties from the menu. Then, set the Object Channel ID under the G-Buffer
ID controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5252  assigned to it. Assign the Material
ID channel in the Material Editor, using the Material ID channel flyout on
page 5254 . The Lens Effect will be applied only to areas of the geometry where
that particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255).
The software keeps track of these "hot" areas which tend to show up when
your scene contains bright metallic highlights or explosions. This spinner lets
you determine the lowest pixel value that the Lens Effect is applied to. Pure
white has a pixel value of 1. When this spinner is set to 1, any pixels with a
value above 255 will be glowed. You can invert this value by clicking the I
button to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle
of the surface normal to the camera. A value of 0 is coplanar, or parallel to
the screen. A value of 90 is normal, or perpendicular to the screen. If you set
Surf Norm to 45, only surfaces with normal angles greater than 45 degrees
will be glowed. You can invert this value by clicking the I button to the right
of the spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.
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Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the
color swatch next to the spinner. You can choose hue values from 0 to 255.
The spinner beside the Hue color swatch lets you enter a variance level so that
the glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.
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Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6453 . Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Streak Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Streak, and click the (>) arrow
button.

Adding a streak to the light

A streak is a wide band that runs through the center of the source object. In
real camera work, it is produced when using anamorphic lenses to film a scene.
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Interface

Streak Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects, you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is necessary to name them to make sure that when you change parameters
you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated.

Size Determines the size of the effect.
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Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Width Specifies the width of the streak, as a percentage of the frame.

Angle Specifies the angle for the streak. You can enter both positive and
negative values so, when animated, the streak rotates in a clockwise or
counterclockwise direction.

Taper Controls the taper of the individual spokes of the streak. Taper widens
or narrows the tips of the individual streak points. Low numbers create a sharp
point, while high numbers flare the points.

Sharp Specifies the overall sharpness of the streak. Higher numbers produce
crisp, clean, and clear streaks. Lower numbers produce more of a secondary
glow look. Range=0 to 10.

Glow Behind Gives the effect the ability to be displayed behind objects in
your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated,
the effect will be squeezed according to Lens Effects Globals under the
Parameters panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are
applying the effect to and the color or mapping set in the Radial Color or
Circular Color parameters. A value of 0 uses only the values set in the Radial
Color and Circular Color parameters while a value of 100 uses only the light
or objects source color. Any value between 0 and 100 will render a mix between
the source color and the effect’s color parameters.

Radial Color group

Falloff Curve Displays the Radial Falloff dialog on page 6455  in which you
can set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.
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Section Color group

Section Color determines the color of the effect by using three different color
swatches that are matched to the three sections of the effect. A map can also
be used to determine section color.

Mix Mixes colors set in Radial Color and colors set in Section Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Section Color. Any value between 0
and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6450  in which you
can set weights for the colors used in Section Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6458 . Using the Radial
Size dialog you can create points on a line and move those points along a
graph to determine where the effect should be placed around the light or
object. You can also use a map to determine where the effect should be placed.
A check box is used to activate the map.
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Streak Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to objects that have a corresponding Object ID
channel.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that
have a corresponding G-Buffer on page 7795  (or Object) ID. The G-Buffer is a
geometry buffer and can be defined when you right-click any object and select
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Properties from the menu. Then, set the Object Channel ID under the G-Buffer
ID controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5252  assigned to it. Assign the Material
ID channel in the Material Editor, using the Material ID channel flyout on
page 5254 . The Lens Effect will be applied only to areas of the geometry where
that particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255).
The software keeps track of these "hot" areas which tend to show up when
your scene contains bright metallic highlights or explosions. This spinner lets
you determine the lowest pixel value that the Lens Effect is applied to. Pure
white has a pixel value of 1. When this spinner is set to 1, any pixels with a
value above 255 will be glowed. You can invert this value by clicking the I
button to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle
of the surface normal to the camera. A value of 0 is coplanar, or parallel to
the screen. A value of 90 is normal, or perpendicular to the screen. If you set
Surf Norm to 45, only surfaces with normal angles greater than 45 degrees
will be glowed. You can invert this value by clicking the I button to the right
of the spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.
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Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the
color swatch next to the spinner. You can choose hue values from 0 to 255.
The spinner beside the Hue color swatch lets you enter a variance level so that
the glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.
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Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6453 . Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Lens Effects Dialogs

Circular Falloff Graph (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>)
arrow button. > Parameters tab of the rollout for that effect > Falloff Curve
(under the Circular or Section Color group)

The Circular Falloff graph allows you to add weight to a particular color applied
to your Lens Effect. By weighting the colors that you apply you can choose
to display more of one color than another. You can also make the transition
of colors gradual from one color to the next or you can create a sharp edge to
the transition.
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Rings with different Circular Falloff settings

The Circular Falloff graph has controls at the top for creating and moving
points on a curve on the graph below. The curve represents the range of colors
you have selected in the Circular Color group box to apply to the current Lens
Effect. When you open the graph you will notice that there is already a line
with a point on each end which represents the linear transition from one
color to the next. By placing points along the curve, you can drag these points
to increase or decrease a colors intensity or to eliminate it altogether.
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Buttons are available at the bottom of the graph that allow you to change the
display of the graph. You can also manually enter a horizontal or vertical
position by entering a value into the two entry boxes.

Interface

Move Moves selected points in any direction. Click and hold the Move
button to display the flyout where you can select a button to move in any
direction, move only in the horizontal direction, or move only in the vertical
direction. The Move function remains active until you click another button.
The button is yellow while it is active.

Scale Point Scales a point vertically. Click once to enable Scale Point. The
Scale Point function remains active until you click another button. The button
is yellow while it is active.

Add Point Allows you to add points anywhere along the Circular Falloff
curve. Click and hold the Add Point button to display the flyout from which
you can choose a button to add either a Corner Point or a Bezier-Smooth
Point. Click once to enable Add Point. The Add Point function remains active
until you click another button. The button is yellow while it is active.

Delete Point Deletes selected points.

Horizontal Position Allows you to manually enter a horizontal position value
for a selected point.

Vertical Position Allows you to manually enter a vertical position value for
a selected point.

Pan Allows you to click and drag the Circular Falloff graph window to move
it left and right or up and down. Click once to enable panning. Pan remains
active until you click another button. The button is yellow while it is active.
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Zoom Extents Fits the curve within the graph window both vertically and
horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the graph window
so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Circular Falloff
graph window so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Circular Falloff graph window.

Zoom Vertically Scales the length of the Circular Falloff graph window.

Zoom Zooms in and out of the entire Circular Falloff graph window.

Zoom Region Allows you to drag a region in the Circular Falloff graph
window and scale that region to fill the window.

Radial Density Dialog (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>)
arrow button. > Options tab of the rollout for that effect > Radial Density
(under the Additional Effects group)

The Radial Density dialog allows you to add weight to any additional effect
applied to the Lens Effect. By weighting the density of the additional effect
that you apply you can choose particular areas in the effect to display more
of the additional effect or to eliminate it altogether. You can also use Radial
Density to gradually fade the additional effect from maximum density down
to zero or you can create a sharp edge to the transition.

Object with different Ray effects due to different Radial Density settings
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The Radial Density dialog has controls at the top for creating and moving
Points on a curve on the graph below. The curve represents the density of the
additional effect being applied to the Lens Effect. When you open the dialog
you will notice that there is already a line with a Point on each end which
represents the density of the effect. The default falloff is a fade from a density
value of 1 starting from the center of the effect toward the outer edges which
has a value of 0. This produces an effect with more density being rendered at
the center of the effect and a gradual fading out to no density at the edges.
By placing Points along the curve, you can drag these points to increase or
decrease the density of an additional effect or eliminate it in some areas
altogether.

Buttons are available at the bottom of the dialog that allow you to change the
display of the dialog. You can also manually enter a horizontal or vertical
position by entering a value into the two entry boxes.

Interface

Move Moves selected points in any direction. Click and hold the Move
button to display the flyout where you can select a button to move in any
direction, move only in the horizontal direction, or move only in the vertical
direction. The Move function remains active until you click another button.
The button is yellow while it is active.

Scale Point Vertically scales a point up or down. Click once to enable Scale
Point. The Scale Point function remains active until you click another button.
The button is yellow while it is active.

Add Point Allows you to add points anywhere along the Radial Density
curve. Click and hold the Add Point button to display the flyout where you
can select a button to add either a Corner Point or a Bezier Point. Click once

6454 | Chapter 19   Effects and Environments



to enable Add Point. The Add Point function remains active until you click
another button. The button is yellow while it is active.

Delete Point Deletes selected points.

Horizontal Position Allows you to manually enter a horizontal position value
for a selected point.

Vertical Position Allows you to manually enter a vertical position value for
a selected point.

Pan Allows you to click and drag the Radial Density dialog window to move
it left and right or up and down. Click once to enable panning. Pan remains
active until you click another button. The button is yellow while it is active.

Zoom Extents Fits the curve within the dialog window both vertically and
horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the dialog
window so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Radial Density
dialog window so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Radial Density dialog window.

Zoom Vertically Scales the length of the Radial Density dialog window.

Zoom Zooms in and out of the entire Radial Density dialog window.

Zoom Region Allows you to drag a region in the Radial Density dialog
window and scale that region to fill the window.

Radial Falloff Dialog (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>)
arrow button. > Parameters tab of the rollout for that effect > Falloff Curve
(under the Radial Color group)

The Radial Falloff dialog allows you to add weight to a particular color applied
to your Lens Effect. By weighting the colors that you apply you can choose
to display more of one color than another. You can also make the transition
of colors gradual from one color to the next or you can create a sharp edge to
the transition.
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Rings with different Radial Falloff settings

The Radial Falloff graph has controls at the top for creating and moving Points
on a curve on the graph below. The curve represents the range of colors you
have selected in the Radial Color group box to apply to the current Lens Effect.
When you open the dialog you will notice that there is already a line with a
Point on each end which represents the linear transition from one color to
the next. The default falloff is a fade from one color at a value of one to the
other color which ends at a value of zero. This produces an effect with more
intensity on the first color and a considerable fading out of the second color.
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By placing Points along the curve, you can drag these points to increase or
decrease a colors intensity or to eliminate it altogether.

Buttons are available at the bottom of the dialog that allow you to change the
display of the dialog. You can also manually enter a horizontal or vertical
position by entering a value into the two entry boxes.

Interface

Move Moves selected points in any direction. Click and hold the Move
button to display the flyout where you can select a button to move in any
direction, move only in the horizontal direction, or move only in the vertical
direction. The Move function remains active until you click another button.
The button is yellow while it is active.

Scale Point Vertically scales a point up or down. Click once to enable Scale
Point. The Scale Point function remains active until you click another button.
The button is yellow while it is active.

Add Point Allows you to add points anywhere along the Circular Falloff
curve. Click and hold the Add Point button to display the flyout where you
can select a button to add either a Corner Point or a Bezier Point. Click once
to enable Add Point. The Add Point function remains active until you click
another button. The button is yellow while it is active.

Delete Point Deletes selected points.

Horizontal Position Allows you to manually enter a horizontal position value
for a selected point.

Vertical Position Allows you to manually enter a vertical position value for
a selected point.
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Pan Allows you to click and drag the Radial Falloff graph to move it left and
right or up and down. Click once to enable panning. Pan remains active until
you click another button. The button is yellow while it is active.

Zoom Extents Fits the curve within the dialog window both vertically and
horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the dialog
window so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Radial Falloff graph
so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Radial Falloff graph.

Zoom Vertically Scales the length of the Radial Falloff graph.

Zoom Zooms in and out of the entire Radial Falloff graph.

Zoom Region Allows you to drag a region in the Radial Falloff graph and
scale that region to fill the window.

Radial Size Dialog (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>)
arrow button. > Parameters tab of the rollout for that effect > Falloff Curve
(under the Radial Size group)

The Radial Size dialog gives you the ability to determine the size of your Lens
Effect. The Radial Size dialog displays a curve with a point on each end which
represents the Radial Size of your Lens Effect. The default position of the curve
is one which means the Lens Effect will have the same radius around the
center of the effect.
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Objects with different Radial Sizes settings applied to Glow

By adding and moving points along the curve you can make areas of the effect
extend further by moving a point above a value of one on the graph. You can
also diminish areas of the effect by moving a point between one and zero on
the graph. Finally, you can eliminate areas of the effect by moving a point
below zero on the graph.
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Buttons are available at the bottom of the dialog that allow you to change the
display of the dialog. You can also manually enter a horizontal or vertical
position by entering a value in the two entry boxes.

Interface

Move Moves selected points in any direction. Click and hold the Move
button to display the flyout where you can select a button to move in any
direction, move only in the horizontal direction, or move only in the vertical
direction. The Move function remains active until you click another button.
The button is yellow while it is active.

Scale Point Vertically scales a point up or down. Click once to enable Scale
Point. The Scale Point function remains active until you click another button.
The button is yellow while it is active.

Add Point Allows you to add points anywhere along the Radial Size curve.
Click and hold the Add Point button to display the flyout where you can select
a button to add either a Corner Point or a Bezier Point. Click once to enable
Add Point. The Add Point function remains active until you click another
button. The button is yellow while it is active.

Delete Point Deletes selected points.

Horizontal Position Allows you to manually enter a horizontal position value
for a selected point.

Vertical Position Allows you to manually enter a vertical position value for
a selected point.

Pan Allows you to click and drag the Radial Size graph to move it left and
right or up and down. Click once to enable panning. Pan remains active until
you click another button. The button is yellow while it is active.

6460 | Chapter 19   Effects and Environments



Zoom Extents Fits the curve within the dialog window both vertically and
horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the dialog
window so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Radial Size graph
so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Radial Size graph.

Zoom Vertically Scales the length of the Radial Size graph.

Zoom Zooms in and out of the entire Radial Size graph.

Zoom Region Allows you to drag a region in the Radial Size graph and scale
that region to fill the window.

Blur Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Blur

The Blur effect allows you to blur your image in three different methods:
Uniform, Directional, and Radial. Blur works on individual pixels according
to selections made in the Pixel Selections panel. You can blur an entire image,
non-background scene elements, by luminance value, or by using a map mask.
Blur can give your animation added realism by rendering the illusion of object
or camera movement.
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Object before and after adding midrange Blur effect.
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Interface

Blur Parameters rollout, Blur Type panel

Uniform Applies the Blur effect evenly across the entire rendered image.

Pixel Radius Determines the intensity of the Blur effect. Increasing the value
increases the number of surrounding pixels that each pixel will use to compute
its blur. The more pixels used means a greater blur for the image.

Affect Alpha Applies the Uniform Blur effect to the alpha channel when
turned on.

Directional Applies the Blur effect in any direction according to the
Directional parameters. The U Pixel Radius and Trail blur the pixels horizontally
while the V Pixel Radius and Trail blur the pixels vertically. Rotation is used
to rotate the axis of the horizontal and vertical blurring.

U Pixel Radius Determines the horizontal intensity of the Blur effect.
Increasing the value increases the number of surrounding pixels that each
pixel will use to compute its blur. The more pixels used means a greater
horizontal blur for the image.

Blur Rendering Effect | 6463



U Trail Adds “direction” to your blur by weighting more blur to either side
of the U axis. This adds a streaking effect and creates the illusion that your
objects or your camera are rapidly moving in a particular direction.

V Pixel Radius Determines the vertical intensity of the Blur effect. Increasing
the value increases the number of surrounding pixels that each pixel will use
to compute its blur, and creates a greater vertical blur for the image.

V Trail Adds “direction” to your blur by weighting more blur to either side
of the V axis. This adds a streaking effect and creates the illusion that your
objects or your camera are rapidly moving in a particular direction.

Rotation Rotates the axis of the U and V pixels that will be blurred by the
U and V Pixel Radius spinners. By using Rotation with the U and V Pixel Radius
spinners you can have the Blur effect applied to any direction in your rendered
image. When rotation is 0, U corresponds to the image’s X axis and V
corresponds to the image’s Y axis.

Affect Alpha Applies the Directional Blur effect to the Alpha channel when
turned on.

Radial Applies the Blur effect radially. Using the Radial parameters you can
define a point within your rendered image to use as the center of the Radial
Blur. You can use an object as the center or an arbitrary location set by the X
and Y Origin spinners. The Blur effect will apply the least amount of blur to
the center origin of the effect and gradually increase the blur to the pixels
further away from the center. This can be used to simulate motion blur caused
by camera zoom.

Pixel Radius Determines the intensity of the Radius Blur effect. Increasing
the value increases the number of surrounding pixels that each pixel will use
to compute its blur. The more pixels used means a greater blur for the image.

Trail Adds “direction” to your blur by weighting more or less blur toward
the center of the Blur effect. This adds a streaking effect and creates the illusion
that your objects or your camera are rapidly moving in a particular direction.

X/Y Origin Specifies the center of the blur, in pixels, with respect to the
dimensions of the rendered output.

None Lets you specify an object whose center serves as the center of the blur
effect. Click this, select an object, and then turn on Use Object Center. The
object name appears on the button.

Clear Removes the object name from the button above.

Use Object Center When on, the object specified by the None button (tooltip:
Pick an object to center on.) serves as the center of the blur effect. If no object
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is specified and Use Object Center is on, no blur is added to the rendered
image.

Affect Alpha Applies the Radial Blur effect to the Alpha channel when turned
on.
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Blur Parameters rollout, Pixel Selections panel

6466 | Chapter 19   Effects and Environments



Whole Image Affects the entire rendered image when chosen. This is useful
when the Blur effect dims your rendered image. By using Brighten and Blend
you can maintain the original colors of the scene.

Brighten Brightens the entire image.

Blend Blends the Blur effect and the Whole Image parameters with the
original rendered image. This can be used to create a soft-focus effect.

Non-Background Affects everything but the background image or animation
when chosen. This is useful when the Blur effect has dimmed your scene
objects but not the background. By Using Brighten, Blend, and Feather Radius,
you can maintain the original colors of the scene.

Brighten Brightens the rendered image except for the background image or
animation.

Blend Blends the Blur effect and the Non-Background parameters with the
original rendered image.

Feather Radius Feathers the Blur effect applied to the Non-Background
elements of your scene. When using Non-Background as a Pixel Selection you
will notice that the scene objects have a hard edge to their blur since the
objects are being blurred but the background is not. Use the spinner to feather
the blur and eliminate the hard edge of the effect.

Luminance Affects any pixels that have luminance values that fall between
it’s Min and Max spinners.

Brighten Brightens pixels that fall between the Minimum and Maximum
luminance values.

Blend Blends the Blur effect and the Luminance parameters with the original
rendered image.

Min Sets the minimum luminance value necessary for each pixel in order
for the Blur effect to be applied to the pixel.

Max Sets the maximum luminance value a pixel can have in order for the
Blur effect to be applied to the pixel.

Feather Radius Feathers the Blur effect applied to pixels that fall between
the Minimum and Maximum luminance values. When using Luminance as
a Pixel Selection the Blur effect can create a hard edge on the effect. Use the
spinner to feather the blur and eliminate the hard edge of the effect.

Map Mask Applies the Blur effect according to the channel selected and
mask applied through the Material/Map Browser. After selecting a mask you
must select a channel from the Channel list. Blur then examines the mask
and channel according to the values set in the Minimum and Maximum
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spinners. Any pixels in the mask that are of the selected channel and between
the Min and Max values will have the Blur effect applied. This is useful for
blurring selected portions of a scene such as a winter morning as seen through
a frost covered window.

Channel Selects a channel that the Blur effect will be applied to. After
selecting a particular channel, use the minimum and maximum spinners to
determine the value a mask pixel must have in order to have the effect applied
to it.

Brighten Brightens the portions of the image that the Blur effect is applied
to.

Blend Blends the Map Mask Blur effect with the original rendered image.

Min The minimum value (RGB, Alpha, or Luminance) a pixel must have in
order to have the Blur effect applied to it.

Max The maximum value (RGB, Alpha, or Luminance) a pixel can have for
the Blur effect to be applied to it.

Feather Radius Feathers the Blur effect applied to pixels that fall between
the Minimum and Maximum channel values. When using map mask as a
Pixel Selection, the Blur effect can create a hard edge on the effect. Use the
spinner to feather the blur and eliminate the hard edge of the effect.

Object ID Applies the Blur effect to an object or part of an object with a
specific Object ID (in the G-Buffer on page 7795 ), if the object matches the
Filter settings. To add or replace an Object ID, use the spinners or enter a value
in the ID text box and then click the appropriate button.

Min Lum The minimum luminance value a pixel must have in order to have
the Blur effect applied to it.

Max Lum The maximum luminance value a pixel can have for the Blur effect
to be applied to it.

Brighten Brightens the portion of the image that the Blur effect is applied
to.

Blend Blends the Object ID Blur effect with the original rendered image.

F. Radius Feathers the Blur effect applied to pixels that fall between the
Minimum and Maximum luminance values. When using Luminance as a Pixel
Selection, the Blur effect can create a hard edge on the effect. Use the spinner
to feather the blur and eliminate the hard edge of the effect.

Material ID Applies the Blur effect to a material or part of a material with a
specific Material Effects Channel on page 5252 , if the material matches the
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Filter settings. To add or replace a Material Effects channel, use the spinners
or enter a value in the ID text box and then click the appropriate button.

Min Lum The minimum luminance value a pixel must have in order to have
the Blur effect applied to it.

Max Lum The maximum luminance value a pixel can have for the Blur effect
to be applied to it.

Brighten Brightens the portion of the image that the Blur effect is applied
to.

Blend Blends the Material Blur effect with the original rendered image.

F. Radius Feathers the Blur effect applied to pixels that fall between the
Minimum and Maximum luminance values. When using Luminance as a Pixel
Selection, the Blur effect can create a hard edge on the effect. Use the spinner
to feather the blur and eliminate the hard edge of the effect.

General Settings group

Feather Falloff control curve

The Feather falloff curve allows you to determine the feather falloff off the
Blur effect based on a graph. You can add points to the graph to create a falloff
curve, and adjust the interpolation in those points.

Blur Rendering Effect | 6469



Move Lets you move the points on the graph. This button is a flyout,
providing free movement (the default), horizontal, and vertical movement.

Scale Point Lets you scale the points on the graph. This moves each selected
point vertically, in proportion to its previous value. Click a point to scale, or
draw a selection rectangle around several contiguous points to select them,
and then drag any point in the selection to scale them all.

Add Point Lets you create additional points on the falloff curve. This button
is a flyout, providing linear points (the default) and Bezier points with handle.

Delete Point Removes points from the graph.

Brightening These radio buttons let you select additive or multiplicative
brightening. Additive brightening is brighter and more distinct than
multiplicative brightening. Additive brightening is useful when you use blur
in combination with a Glow effect on page 6397 . Multiplicative brightening
provides a soft highlight to the Blur effect.

Brighten Curve Lets you edit the brightening curve in the Feather Falloff
curve graph.

Blend Curve Lets you edit the blend curve in the Feather Falloff curve graph.

Brightness and Contrast Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Brightness and Contrast
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Above: Original rendering is too dark.

Below: Increasing both brightness and contrast improves clarity of the rendering.

Brightness and Contrast allows you to adjust the contrast and brightness of
an image. This can be used to match rendered scene objects with background
images or animations.

Interface

The Brightness and Contrast Parameters rollout contains the following
parameters.

Brightness Increases or decreases all color components (red, green, and blue).
Range=0 to 1.0.
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Contrast Compresses or expands the latitude between maximum black and
maximum white. Range=0 to 1.0.

Ignore Background Applies the effect to everything in your 3ds Max scene
except the background.

Color Balance Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Color Balance

The Color Balance Effect allows you to manipulate additive/subtractive color
tinting through independent control of RGB channels.

Above: Color balance effect used to correct the color cast.

Below: Original rendering has a yellow cast.
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Interface

The Color Balance Parameters rollout contains the following parameters:

Cyan/Red Adjusts the red channel.

Magenta/Green Adjusts the green channel.

Yellow/Blue Adjusts the blue channel.

Preserve Luminosity When on, retains the luminosity of the image while
correcting the color.

Ignore Background When on, allows you to image correct a model without
affecting the background.

File Output Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > File Output

File Output allows you to take a “snapshot” of a rendering before some or all
of the other Render Effects are applied, depending on the placement of File
Output in the Render Effects stack. You can save different channels such as
Luminance, Depth, or Alpha to a separate file while rendering an animation.

You can also use File Output to convert an RGB image into a different channel
and send that image channel back into the Render Effects stack. The rest of
the effects can then be applied to that channel.
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Interface

Destination group

Files Opens a dialog so you can save the rendered image or animation to
disk.

The rendered output can be a still image or an animation, in one of the
following file formats:

AVI File on page 7118  (AVI)

BMP Image file on page 7120  (BMP)

Encapsulated PostScript on page 7124  format (EPS, PS)
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JPEG File on page 7139  (JPG)

Kodak Cineon on page 7120  (CIN)

MOV QuickTime file on page 7140  (MOV)

PNG Image File on page 7152  (PNG)

RLA Image File on page 7156  (RLA)

RPF Image File on page 7159  (RPF)

SGI Image File Format on page 7161  (RGB)

Targa Image File on page 7162  (TGA, VDA, ICB, UST)

TIF Image File on page 7164  (TIF)

Devices Opens a dialog so you can send the rendered output to a device
such as a video recorder.

Clear Clears any file or device selected in the Destination group box.

Driver group

These buttons are available only when you choose a device as the image source.

About Provides information on the source of the image-handler software
used to bring the image into the software.

Setup Displays a setup dialog specific to the plug-in. Some plug-ins may not
use this button.

Parameters group

Channel Lets you choose which channel you wish to save or send back in
to the Render Effects stack. Choose Whole Image, Luminance, Depth, or Alpha
to display more options in the Parameters group box.

Affect Source Bitmap When activated, this will take in an image with any
effects previously applied, convert it to the channel selected, and send it back
into the stack for the rest of the effects to be applied. Your rendered image
will be saved in the channel selected. This parameter is not available to the
Whole Image channel.

Active Turns the File Output feature on and off. Unlike the Active check box
available in the Render Effects rollout, this check box is animatable allowing
you to save only desired portions of a rendered scene.
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Depth Parameters

When Depth is selected as a channel, new parameters are available for
determining what parts of the scene should be rendered into the Depth channel
image.

Copy After choosing a camera with the None button, click Copy to use the
camera’s clipping planes to determine which part of the scene should be
rendered into the Depth channel image file.

None Enables you to select a camera to use for copying clipping planes.
Click the none button to activate it. The None button will turn green until a
camera has been selected in the viewport. The camera’s name will then be
displayed on the button instead of None.

Near Z Specifies the beginning distance from the camera that should be used
in determining where to start rendering the scene’s geometry in the depth
channel image file.

Far Z Specifies the ending distance from the camera that should be used in
determining where to stop rendering the scene’s geometry in the depth channel
image file.

Fit Entire Scene Makes all other Depth parameters unavailable and will
render the entire viewport’s scene geometry in the Depth channel image file,
automatically calculating the near and far Z required.

Film Grain Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Film Grain

Film Grain is used to recreate the look of film grain in your rendered scene.
Film Grain also allows you to match film grain from source material used as
a background, such as an AVI, to the rendered scene created in the software.
When applied, Film Grain automatically randomizes to create the look of
moving frames.
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Before and after applying Film Grain to a scene
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Interface

The Film Grain Parameters rollout contains the following controls.

Grain Sets the amount of grain added to your image. Range=0 to 1.0.

Ignore Background Masks the background so that grain is applied only to
geometry and effects in the scene. Choose this option when you use film
(which already contains grain) as the background image.

Motion Blur Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Motion Blur
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Motion blur enhances the movement of the sword.

Motion Blur applies an image motion blur on page 7814  to your rendered scene
by blurring moving objects or the entire scene. Motion blur can enhance the
realism of a rendered animation by simulating the way a real-world camera
works. A camera has a shutter speed, and if significant movement of objects
in the scene, or of the camera itself, occurs during the time the shutter is open,
the image on film is blurred.

NOTE In addition, you must set motion-blur characteristics for objects to be
blurred using the Object Properties dialog on page 255 .

Motion Blur Rendering Effect | 6479



Interface

The Motion Blur Parameters rollout contains the following controls.

Work with transparency When on, motion blur is applied to objects behind
transparent objects. When off, objects behind transparent objects receive no
motion blur. Turning off this toggle can improve rendering speed. Default=on.

Duration Specifies how long the "virtual shutter" is open. When this is set
to 1.0, the virtual shutter is open for the entire duration between one frame
and the next. The higher the value, the greater the motion blur effect.
Default=1.0.

Depth of Field Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Depth of Field
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Depth of field emphasizes the scooter.

The Depth-of-Field effect simulates the natural blurring of foreground and
background scene elements when viewed through a camera lens. Depth of
Field works by separating the scene in Z order into foreground, background,
and in-focus images. The foreground and background images are then blurred
according to the values set in the Depth of Field effect parameters and the
final image is composited from the processed originals.

NOTE When additional Render Effects are being applied to an image or animation,
the Depth-of-Field effect should be the last effect to be rendered. The order of the
rendered effects is listed in the Effects tab of the Environment and Effects dialog.

TIP To minimize sampling artifacts in out-of-focus areas with the default scanline
renderer, try using the Blend filter in the Antialiasing group of the Render Scene
dialog on page 5878  (on the Renderer panel).
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Before and after applying Depth of Field effect to scene.
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Interface

The Depth of Field Parameters rollout contains the following parameters.

Affect Alpha Affects the alpha channel of the final rendering when on.

Cameras group

Pick Cam Enables you to interactively select from the viewport which camera
you want the Depth of Field effect applied to.
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Remove Deletes the camera currently selected in the drop-down list.

Camera Selection List Lists all of the cameras to be used in the effect. You
can use this list to highlight a specific camera and remove it from the list using
the Remove button.

Focal Point group

Pick Node Enables you to select an object to use as the focal node. When
activated you can select an object directly from the viewports to use as the
focal node. You can also press H to display the Pick Object dialog, which lets
you select a focal node from a list of objects in the scene.

Remove Removes the object selected as the Focal Node.

Use Camera Specifies that the focal length from the camera selected in the
Camera Selection list be used to determine the focal point.

Focal Parameters group

Custom Uses the values set in the Focal Parameters group box to determine
the properties of the Depth of Field effect.

Use Camera Uses the values from the camera highlighted in the Camera
Selection list to determine focal range, limit, and blur.

Horiz Focal Loss Determines the amount of blur along the horizontal axis
when Custom has been chosen.

Vert Focal Loss Controls the amount of blur along the vertical axis when
Custom has been chosen.

Focal Range Sets the Z distance, in units, to either side of the focal point in
which the image will remain in focus when Custom has been chosen.

Focal Limit Sets the Z distance, in units, to either side of the focal point
where blur will reach its maximum as specified by the Loss spinners when
Custom has been chosen.

Environment and Atmosphere Effects
Rendering menu > Environment > Environment and Effects dialog >
Environment panel

Environment displays the Environment panel on page 6486 , which is used for
setting up atmospheric and background effects.
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You can use the environment functions to:

■ Set and animate the background color.

■ Use an image in the background of the rendered scene (screen environment)
or use texture maps as spherical, cylindrical, or shrink-wrap environments.

■ Set and animate the ambient light on page 7710 .

■ Use atmospheric plug-ins, such as volumetric light, in the scene.

■ Apply exposure controls to renderings.

Atmospheres

Atmospheres are plug-in on page 7896  components that create lighting effects
such as fog, fire, and so on.

Fire Environment Effect on page 6493

Fog Environment Effect on page 6506

Volume Fog Environment Effect on page 6512

Volume Light Environment Effect on page 6520

See Environment dialog on page 6486  for all environment parameters.

Exposure Controls

One of the limitations of rendering perceptually accurate images is the limited
dynamic range of computer monitors. Dynamic range is the ratio of the highest
to lowest intensity a monitor can produce. In a dark room this ratio is
approximately 100 to 1. In a bright room, this drops to approximately 30 to
1. Real environments can have dynamic ranges of 10,000 to 1, or larger.

Exposure Controls on page 6531  map light-energy values to colors in a process
known as tone mapping. They affect the brightness and contrast of both
rendered images and viewport displays. They don’t affect the actual lighting
levels in the scene, but only how those levels are mapped to a valid display
range.

■ Automatic Exposure Control on page 6534

■ Logarithmic Exposure Control on page 6540

■ Linear Exposure Control on page 6537

■ mr Photographic Exposure Control on page 6544
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■ Pseudo Color Exposure Control on page 6552

Environment Panel

Rendering menu > Environment > Environment and Effects dialog >
Environment panel

Use the Environment panel to:

■ Set and animate the background color.

■ Use an image in the background of the viewport and rendered scene (screen
environment) or use texture maps as spherical, cylindrical, or shrink-wrap
environments.

■ Set and animate the tint and ambient light on page 7710  globally.

■ Use atmospheric plug-ins, such as volumetric light, in the scene.
Atmospheres are plug-in components on page 7896  that create light effects
such as fire on page 6493 , fog on page 6506 , volume fog on page 6512 , and
volume light on page 6520 .

■ Apply exposure controls on page 6531  to renderings.

Procedures

To access environment functions, do one of the following:

1 Choose Rendering > Environment.

2 On the Environment and Effects dialog, click the Environment tab.

To set the background color:

1 Choose Rendering > Environment.

The Environment panel appears.

2 In the Background group, click the color swatch.

A Color Selector on page 331  appears.

3 Use the Color Selector to change the background color.

The Renderer now uses this color as a background.
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To choose an environment map:

1 Display the Material Editor.

You adjust the map's parameters with the Material Editor.

2 Choose Rendering > Environment.

3 Under Background on the Environment panel, do one of the following:

■ Click the Environment Map button. The Material/Map Browser
appears. Choose a map type from the list.

■ Drag a map to the Environment Map button. You can do this from a
map displayed in one of the Material Editor's sample slots, or from
any map button that has been assigned, either in the Material Editor
or from a projection light, and so on.
Drag a bitmap from the Material Editor's map preview to the
Environment Map button.

On the Environment panel, the name of the Environment Map button changes
to show the type of map you chose, and Use Map turns on.

After you have set up the map, you can later turn off Use Map to test rendering
the scene without the mapped background.

You have set up the environment map, but to assign a bitmap or adjust map
parameters, you need to use the Material Editor.

You can also create a standalone map in the Material Editor first, and then
choose it with the Material/Map Browser.

To put the map in the Material Editor:

■ Drag the Environment Map button to a sample slot.
The map is now in the Material Editor where you can adjust it by changing
its parameters.

To change the color and tint of global lighting:

1 Choose Rendering > Environment.

2 Click the color swatch labeled Tint.

A Color Selector on page 331  appears.

3 Use the color selector to set the tint applied to all lighting except ambient
light.
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4 Use the Level spinner to multiply the overall lighting of the scene.

Shaded viewports update to show global lighting changes.

5 Close the Environment dialog.

3ds Max uses the global lighting parameters when you render the scene.

To change the color of ambient light:

TIP You don't need to adjust ambient light if you are using radiosity on page 5976
.

1 Choose Rendering > Environment.

2 Click the color swatch labeled Ambient.

A Color Selector on page 331  appears.

3 Use the color selector to set the ambient color.

Shaded viewports update to show ambient color changes.

3ds Max also uses the new ambient color when you render the scene.

The color of ambient light tints the scene. For most renderings, the color
of ambient light should be black.

4 Close the Environment dialog.

To change the intensity of ambient light:

TIP You don't need to adjust ambient light if you are using radiosity on page 5976
.

1 Choose Rendering > Environment.

2 Click the color swatch labeled Ambient Light.

A Color Selector on page 331  appears.

3 Change the Value setting (the V component of the ambient light's HSV
description) to increase or decrease intensity.

Shaded viewports update to show changes in the ambient light intensity.

4 Close the Color Selector.

The intensity of ambient light affects contrast as well as overall
illumination (the higher the intensity of ambient light, the lower the
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contrast). This is because ambient light is completely diffuse, so the angle
of incidence is equal for all faces. Ambient light alone cannot show depth.

NOTE 3ds Max has a default ambient light setting. You can change the
default by using the Rendering panel of the Preference Settings dialog.

To add an atmospheric effect:

1 Choose Rendering > Environment.

The Environment and Effects dialog is displayed, with the Environment
panel visible.

2 Under Atmosphere on the Environment panel, click Add.

The Add Atmospheric Effect dialog appears.

3 Choose the kind of effect you want to use, and then click OK.

The effect has now been added. Use the Atmosphere rollout to adjust
parameters.

Interface

Common Parameters rollout

Background group

Color Sets the color for the scene background. Click the color swatch, then
select the color you want in the Color Selector. You can animate the color
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effect by changing the background color at a nonzero frame with the Auto
Key button on.

Environment Map The button for Environment Map on page 7768  displays
the name of the map, or “None” if none has been assigned. The map must
use Environmental mapping coordinates on page 7838  (spherical, cylindrical,
shrink wrap, and screen).

To assign an environment map, click the button and use the Material/Map
Browser to choose a map, or drag a map from a sample slot or map button in
the Material Editor (or anywhere else in the software; for example, a Projector
Map button) and drop the map on the Environment Map button. A dialog
asks if you want the environment map to be a copy (independent) or an
instance of the source map.

NOTE If your scene includes animated bitmaps, including materials, projector
lights, environments, and so on, the animation file is reloaded once per frame.
Rendering performance slows down when your scene uses multiple animations,
or the animations are themselves large files.

To adjust the environment map's parameters, for example to assign a bitmap
or change the coordinate settings, open the Material Editor, drag the
Environment Map button, and drop it over an unused sample window.

Use Map Uses a map for the background rather than the background color.

Global Lighting group

Tint Tints all lights in the scene (except for ambient light) if this color is
anything other than white. Click the color swatch to display the Color Selector,
on which you can choose the tint color. You can animate the tint color by
changing it at a nonzero frame with the Auto Key button on.

Level Multiplies all lights in the scene. A Level of 1.0 preserves the original,
individual light settings. Increasing the Level raises the lighting for the overall
scene, and decreasing the Level lowers the overall lighting. This parameter is
animatable. Default=1.0.

Ambient Sets the color for the ambient light. Click the color swatch, and
choose the color you want in the Color Selector. You can animate the light
effect by changing the ambient light color at a nonzero frame with the Auto
Key button on.
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Atmosphere rollout

Effects Shows the queue of effects that were added. The effects are evaluated
in linear order within the scene during rendering. Depending on the selected
effect, the Environment dialog adds the appropriate rollout for the effect's
parameters.

Name Gives a custom name to effects in the list.

For example, you might have different custom settings for different kinds of
fire, that you could name Spark and Fireball.

Add Displays the Add Atmospheric Effect dialog (all currently installed
atmospheric effects). Select an effect and click OK to assign an effect to the
list.
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Delete Deletes a selected atmospheric effect from the list.

Active Sets the on/off state for the individual effects in the list. This is a
convenient way to isolate effects within a list of complicated atmospheric
functions.

Move Up / Move Down Moves the selected item in the list up or down to
change the order in which the atmospheric effects are applied.

Merge Merges effects from other 3ds Max scene files.

When you click Merge, the Merge Atmospheric Effects dialog appears. Choose
a 3ds Max scene, and then click Open. The Merge Atmospheric Effects dialog
then lists the effects in the scene that can be merged. Select one or more of
the effects, and then click OK to merge them into the scene.

The list shows the names of the atmospheric effects only, but when you merge
an effect, the lights or gizmos bound to that effect are merged as well. If one
of these objects you’re merging has the same name as one already in the scene,
an alert appears giving you the following choices:

■ You can rename the incoming object by changing its name in the editable
field.
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■ You can Merge the incoming object without renaming, resulting in two
objects in the scene with the same name.

■ You can delete the existing object in the scene by selecting the Delete Old
button.

■ You can select Apply To All Duplicates, which performs the same action
to all subsequent matching objects.

NOTE To control whether or not the renderer uses the environment map's
alpha channel in creating the alpha for the rendered image, choose Customize
> Preferences > Rendering, and then turn on Use Environment Alpha in the
Background Antialiasing group.

If Use Environment Alpha is turned off (the default) the background receives
an alpha of 0 (completely transparent). If Use Environment Alpha is turned
on, the alpha of the resulting image is a combination of the scene and
background image's alpha. Also, when writing TGA files with Pre-Multiplied
Alpha set to off, turning on Use Environment Alpha prevents incorrect results.
Note that only background images with alpha channels or black backgrounds
are supported when compositing in other programs such as Photoshop®.

NOTE To control whether or not a background image is affected by the renderer's
antialiasing filter, choose Customize > Preferences > Rendering and then turn on
Filter Background in the Background Antialiasing group. Default=off.

Fire Environment Effect

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Atmosphere rollout > Add > Fire Effect
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Scene using fire

Use Fire to produce animated fire, smoke, and explosion effects. Possible uses
for Fire effects include campfires, torches, fireballs, clouds, and nebula.

NOTE In earlier versions of 3ds Max, Fire was known as the "Combustion effect."

You can add any number of fire effects to a scene. The order of effects is
important because effects near the bottom of the list are layered in front of
effects near the top of the list.

Each effect has its own parameters. When you select a fire effect in the Effects
list, its parameters appear in the Environment dialog.

Fire renders only in Camera or Perspective views. Orthographic or User views
don’t render Fire effects.

TIP Fire doesn't support completely transparent objects. Set the transparency of
Fire objects accordingly. Use visibility rather than transparency to make Fire objects
disappear.
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NOTE The Fire effect does not cast any light or shadows in the scene. To simulate
illumination, you must also create lights. To cast shadows, you need to go to the
Shadows Parameters rollout on page 5046  of your lights, and turn on Atmosphere
Shadows.

Procedures

To create fire effects:

1 Create one or more atmospheric apparatus objects to locate the fire effect
in your scene.

2 Define one or more fire atmospheric effects on the Environment panel.

3 Assign atmospheric apparatus objects to the fire effects.

Sample fire effects

Example: To create a campfire:

1 Click Helpers on the Create panel and choose Atmospheric Apparatus
on page 6560  from the subcategory list.

2 Click Sphere Gizmo. Drag the cursor in the Top viewport to define an
apparatus radius of about 20 units. Turn on the Hemisphere check box
in Sphere Gizmo Parameters.

3 Click Non-Uniform Scale. Click Yes in the Warning dialog (this warning
doesn't apply to atmospheric gizmos), and scale the apparatus 250 percent
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along its local Z axis only. You can then model logs, embers, and rocks
around the base of the apparatus.

4 Open the Modify panel of the Sphere Gizmo. On the Atmosphere rollout,
click Add and choose Fire from the Add Atmosphere dialog.

5 Highlight Fire in the Atmospheres list under the Atmospheres & Effects
rollout. Click Setup.

6 Set the following parameters under Shape and Characteristics:

■ Flame Type=Tendril

■ Stretch=0.8

■ Flame Size=18.0

■ Flame Density=30.0

7 Turn on Auto Key and advance to the end of the animation.

8 Set the following parameters under Motion:

■ Phase=300.0

■ Drift=200.0

The Fire effect doesn’t cast any light in the scene. If you want to simulate
illumination from the fire effect, you must create lights as well.

Example model with fire
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Interface
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You create a fire apparatus, or "gizmo," to position the effect in your scene
and to define the maximum boundaries of the effect. The apparatus is a Helper
object found in the Atmospheric Apparatus subcategory.

There are three kinds of apparatus: BoxGizmo on page 6561 , SphereGizmo on
page 6567 , and CylGizmo on page 6564 .

You can move, rotate, and scale the apparatus, but you cannot apply modifiers.

Using non-uniform scale is a good way to change the shape of the apparatus
for effects. (You will see a warning when you use this transform. Because you
don't modify atmospheric apparatus, you can safely ignore the warning.)

Fire Parameters rollout

You must assign an atmospheric apparatus to a fire effect before you can render
the effect. Use buttons in the Gizmos area to manage the list of apparatus
objects.

Gizmos group

Gizmo for the fire in the scene shown at the beginning of this topic

6498 | Chapter 19   Effects and Environments



Pick Gizmo Click to enter Pick mode and click an atmospheric apparatus in
the scene. The apparatus displays the fire effect when you render. The name
of the apparatus is added to the apparatus list.

Multiple apparatus objects can display the same fire effect. For example, torches
on a wall can all use the same effect. Assign a different seed to each apparatus
to vary the effect.

You can assign single apparatus to multiple fire effects. For example, one
apparatus can display both a fireball and a tendril flame effect.

You can choose multiple gizmos. Click Pick Gizmo and press H. This opens
the Pick Object dialog, which lets you choose multiple objects from the list.

Remove Gizmo Removes the gizmo selected in the gizmo list. The gizmo
remains in your scene but it no longer displays the fire effect.

Gizmo List Lists apparatus objects assigned to the fire effect.

Colors group

You can set three color properties for a fire effect using the color swatches
under Colors. Click a color swatch to display the software’s Color Selector on
page 331 .

Inner Color Sets the color of the densest part of the effect. For a typical fire,
this color represents the hottest part of the flame.

Outer Color Sets the color of the sparsest part of the effect. For a typical fire,
this color represents the cooler, dissipating edge of the flame.

The fire effect is colored using a gradient between the inner and outer colors.
The dense areas of the effect use the inner color and gradually blend to the
outer color near the edges of the effect.

Smoke Color Sets the color of smoke for use with the Explosion option.

If you turn on Explosion and Smoke, the inner and outer colors animate to
the smoke color. If you turn off Explosion or Smoke, the smoke color is
ignored.

Shape group

You control the shape, scale, and pattern of flames within the fire effect using
controls under Shape.

Two options set the direction and general shape of flames.
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Tendril Creates directional pointed flames with veins along their center. The
flames orient along the local Z axis of the fire apparatus. Tendril creates
campfire-like flames.

Fireball Creates round puffy flames. Fireballs are well suited for explosions.

Comparing Tendril to Fireball

Above=Tendril, Below=Fireball

Stretch Scales flames along the Z axis of the apparatus. Stretch works best
with Tendril flames, but you can use it to give Fireballs an oval shape.

Values less than 1.0 compress flames, making them shorter and thicker.

Values greater than 1.0 stretch flames, making them long and skinny.

You can combine Stretch with non-uniform scaling of the apparatus. Use
non-uniform scale to change the boundary of the effect and scale the shape
of the flames.
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Use the Stretch parameter to scale only the flames inside the apparatus. You
can also use Stretch values to reverse the effect that scaling the apparatus had
on the flames.

Effect of changing Stretch

Value=0.5, 1.0, 3.0

Non-uniform scaling of an apparatus

Stretch=0.5, 1.0, 3.0

Regularity Modifies how the flames fill the apparatus. Range=1.0 to 0.0.

A value of 1.0 completely fills the apparatus. The effect fades near the edges
of the apparatus, but the overall shape is still very noticeable.

A value of 0.0 produces a very irregular effect that might occasionally reach
the boundary of the apparatus, but usually gets trimmed back and is smaller.
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Effect of changing Regularity

Value=0.2, 0.5, 1.0

Characteristics group

You set the size and appearance of flames using parameters under
Characteristics. All of these parameters depend on the apparatus size and are
interdependent on each other. Changing one parameter affects the behavior
of the other three.

Flame Size Sets the size of individual flames inside the apparatus. The size
of the apparatus affects the flame size. A larger apparatus requires a larger
flame size. Use a range from 15.0 to 30.0 for the best results.

Large values work best for Fireballs.

Small values work best for Tendrils.

If the flame size is very small, you might need to increase Samples to see
individual flames.

Effect of changing Flame Size
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Value=15.0, 30.0, 50.0

Radius of apparatus=30.0

Flame Detail Controls the amount of color change and edge sharpness seen
within each flame. Range=0.0 to 10.0.

Low values produce smooth, fuzzy flames and render faster.

High values produce patterned, sharp flames and render slower.

Use higher detail values for large flame sizes. If the detail value is greater than
4, you might need to increase Samples to capture the detail.

Effect of changing Flame Detail

Value=1.0, 2.0, 5.0

Density Sets the opacity and brightness of the fire effect. The size of the
apparatus affects the density. A large apparatus with the same density as a
small apparatus appears more opaque and brighter because of its larger size.

Low values make the effect less opaque and use more of the outer color. High
values make the effect more opaque and brighten the effect by gradually
replacing the inner color with white. The higher the value, the more white
the center of the effect is.

If you turn on Explosion, Density animates from 0.0 at the start of the
explosion to the set density value at the peak of the explosion.

Fire Environment Effect | 6503



Effect of changing Flame Density

Value=10, 60, 120

Samples Sets the rate at which the effect is sampled. Higher values produce
more accurate results but take longer to render.

You might consider raising the samples value under the following conditions:

■ Flame Size is small.

■ Flame Detail is greater than 4.

■ Any time you see color banding in the effect. The chance of color banding
increases if a flat surface intersects the fire effect.

NOTE 100 percent transparent objects that intersect the effect become partially
visible. To use particles with Fire, consider using 3D particles instead of
opacity-mapped particles.

Motion group

Use the parameters in the Motion group to animate the churning and rise of
flames.

Phase Controls the rate of change for the fire effect. Turn on Auto Key and
change the phase value at different times.

Phase value can have several meanings, depending on the state of the
Explosion check box.

■ If you clear Explosion, Phase controls the churning of the fire. The faster
the value changes, the more furiously the fire burns. If the Phase function
curve is a line, you get a steady burning fire.
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■ If you turn on Explosion, Phase controls the churning of the fire and the
explosion timing, using values between 0.0 to 300.0. The Phase function
curve for a typical explosion starts steep and flattens out.

Phase values control explosion timing in the following way:

Explosion EffectValue

Explosion begins and builds to peak density
at 100.

0–100

Explosion burns. Effect turns to smoke if
Smoke is turned on.

100–200

Explosion clears and is completely gone at
300.

200–300

No effect.> 300

Phase Function Curve Sample

Explosion effect at Phase=50, 100, 150, 200, and 250
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Drift Sets how flames are rendered along the Z axis of the fire apparatus. The
value is the amount of rise in units.

Low values give a slow-burning cool fire.

High values give a fast-burning hot fire.

For the best fire effects, drift should be a multiple of the height of the fire
apparatus.

You can also animate the location and size of the fire apparatus and most of
the fire parameters. For example, a fire effect can animate color, size, and
density.

Explosion group

Use the parameters in the Explosion group to automatically animate
explosions.

Explosion Animates size, density, and color automatically based on the
animation of the Phase value.

Smoke Controls whether or not the explosion creates smoke.

When on, fire colors change to smoke between Phase values 100 to 200. Smoke
clears between Phase values 200 to 300. When off, fire colors remain at full
density between Phase values 100 to 200. Fire fades away between Phase values
200 to 300.

Fury Varies the churning effect of the Phase parameter.

Values greater than 1.0 cause faster churning. Values less than 1.0 cause slower
churning.

Set Up Explosion Displays the Set Up Explosion Phase Curve dialog. You
enter a start time and end time, and then click OK. The Phase value animates
automatically for a typical explosion effect.

Fog Environment Effect

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Atmosphere rollout > Add > Fog
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Fog added to a scene

This command provides fog and smoke atmospheric effects. This plug-in on
page 7896  provides effects such as fog which causes objects to appear to fade
as they increase in distance from the camera (standard fog), or layered fog
that envelops all or parts of objects in a blanket of mist.

Fog renders only in Camera or Perspective views. Orthographic or User views
don’t render Fog effects.

Procedures

To use standard fog:

1 Create a Camera view of your scene.

2 In the camera's creation parameters, turn on Show in the Environment
Ranges group.

Standard fog is based on the camera's environment range values.

3 Set Adjust Near Range and Far Range to include the objects you want to
fog in your rendering.
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As a general guideline, set Far Range just beyond the objects, and Near
Range to intersect the object geometry closest to the camera.

4 Choose Rendering > Environment.

5 Under Atmosphere on the Environment panel, click Add.

The Add Atmospheric Effect dialog is displayed.

6 Choose Fog, and then click OK.

7 Make sure you choose Standard as the type of fog.

To use layered fog:

1 Create a Camera or Perspective view of your scene.

2 Choose Rendering > Environment.

3 Under Atmosphere on the Environment panel, click Add.

The Add Atmospheric Effect dialog is displayed.

4 Choose Fog, and then click OK.

5 Choose Layered as the fog type.

6 Set the parameters for layered fog.

You can have multiple fog layers in the scene by adding multiple Fog
entries to the list and choosing Layered.
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Interface

The Fog Parameters rollout appears when you select Fog under Effects in the
Environment dialog. The Fog Parameters rollout has the following controls.

Fog group

Color Sets the color for the fog. Click the color swatch, and then select the
color you want in the Color Selector on page 331 . You can animate the color
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effect by changing the fog color at a nonzero frame with the Auto Key button
on.

Environment Color Map Derives the fog color from a map. You can map the
background and the fog color, you can animate the procedural map parameters
in Track View or Material Editor, and you can opacity-map the fog.

The large button displays the name of the color map, or None if no map is
assigned. The map must use Environmental mapping coordinates on page
7838  (spherical, cylindrical, shrinkwrap, and screen).

To assign the map you can drag a map from a Sample slot or Map button in
the Material Editor (or anywhere else in the software; for example, a projector
map button) and drop it on the Environment Color Map button. A dialog
asks if you want the environment map to be a copy (independent) or an
instance of the source map.

Clicking the Environment Color Map button displays the Material/Map
Browser, where you can choose a map type from the list. To adjust the
environment map's parameters, open the Material Editor and drag the
Environment Color Map button over an unused sample slot.

Use Map Toggles the effect of this map on or off.

Environment Opacity Map Alters the density of the fog.

You assign the opacity map, edit it, and toggle its effect in the same way as
the Environment Color Map.

Fog Background Applies the fog function to the background of the scene.

Type When you choose Standard it uses the parameters in the Standard
section and when you choose Layered is selected it uses the parameters in the
Layered section.

Standard Enables the Standard group.

Layered Enables the Layered group.

Standard group

Thins and thickens the fog based on the distance from the camera.

Exponential Increases density exponentially with distance. When turned
off, density increases linearly with distance. Activate this check box only when
you want to render transparent objects in volume fog.
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TIP If you turn on Exponential, this increases the Step Size value to avoid banding.

Near % Sets the density of the fog at the Near Range (Camera Environment
Range parameter).

Far % Sets the density of the fog at the Far Range (Camera Environment
Range parameter).

Layered group

Thins and thickens the fog between an upper and lower limit. You can have
multiple layers of fog by adding multiple fog entries to the list. Because you
can animate all the fog parameters, you can also animate fog rising and falling,
changing density and color, and add horizon on page 7809  noise.

Top Sets the upper extent (in world units) of the fog layer.

Bottom Sets the lower extent (in world units) of the fog layer.

Density Sets the overall density of the fog.

Falloff (Top/Bottom/None) Adds an exponential falloff effect so that the
density is reduced to 0 at either the Top or Bottom of the fog extent.

Horizon Noise Turns on the horizon noise system. Horizon Noise perturbs
just the horizon of the fog layer to add realism.

Size Scale factor applied to the noise. Larger scale values make the fog tendrils
larger. Default=20.

TIP If you want tendrils to really pop out, try making the density greater than
100.

Angle Determines the affected angle off the horizon line. For example, if
the angle is set to 5 (a reasonable value), then starting at 5 degrees below the
horizon, the fog will begin to break up.

This effect is mirrored above and below the horizon, which can produce strange
results when the height of the fog layer traverses the horizon. Typically you'd
want the fog to be either above or below the actual camera horizon. (You can
use the horizon line in the camera parameters as an aid to help you position
this.)

Phase Animating this parameter animates the noise. If Phase is moving in
the positive direction, then the fog tendrils will drift upward (and deform at
the same time). If your fog is above the horizon you may want to animate
Phase in the negative direction to make the tendrils fall downward.
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Volume Fog Environment Effect

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Atmosphere rollout > Add > Volume Fog

Volume fog added to a scene

Volume Fog provides a fog effect in which the fog density is not constant
through 3D space. This plug-in on page 7896  provides effects such as puffy,
cloudy fog that appears to drift and break up in the wind.

Volume Fog renders only in Camera or Perspective views. Orthographic or
User views don’t render Volume Fog effects.

Procedures

To use volume fog:

1 Create a Camera or Perspective view of your scene.

2 Choose Rendering > Environment.

3 Under Atmosphere on the Environment panel, click Add.
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The Add Atmospheric Effect dialog is displayed.

4 Choose Volume Fog, and then click OK.

5 Set the parameters for volume fog.

NOTE If there are no objects in your scene, rendering shows only a solid fog
color. Also, with no objects and Fog Background turned on, volume fog
obscures the background.

To create a volume fog gizmo:

Volume fog gizmo surrounds the scene.

1 In the Helpers category of the Create panel, choose Atmospheric Apparatus
from the pop-up menu.

2 Click one of the buttons to choose a gizmo shape: SphereGizmo,
CylGizmo, or BoxGizmo.

3 Drag the mouse in the viewport to create the gizmo.

You create Gizmos in much the same way as their matching geometry
types. Drag the mouse to create the initial dimensions. The Sphere gizmo
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has an additional Hemisphere check box that turns the sphere into a
hemisphere.

In addition, each gizmo has a Seed spinner and a New Seed button.
Different seed values generate different patterns. Clicking the New Seed
button randomly generates a new seed value for you.

To assign volume fog to a gizmo from an apparatus modify panel:

1 Open the Modify panel of an apparatus.

2 Open the Atmospheres & Effects rollout.

3 Click Add.

4 Select Volume Fog from the Add Atmospheres dialog and click OK.

5 Highlight Volume Fog from the Atmospheres list and click setup to adjust
the Volume Fog parameters.

To assign a gizmo to volume fog from the Environment panel:

1 On the Volume Fog Parameters rollout, click the Pick Gizmo button.

2 Click a gizmo in the viewport.

The name of the gizmo appears in the list field at right.

When you render, the volume fog will be confined to the shape of the
gizmo.

To remove an assigned gizmo:

1 In the Environment dialog, go to the Volume Fog Parameters rollout

2 Select the gizmo name from the pop-up list.

3 Click Remove Gizmo.

This action doesn’t delete the gizmo from the scene, but simply unbinds
it from the fog effect.
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Interface

The Volume Fog Parameters rollout appears when you select Volume Fog
under Effects in the Environment dialog. The Volume Fog Parameters rollout
has the following controls.
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Gizmos group

By default, volume fog fills the entire scene. However, you can choose a gizmo
(an atmospheric apparatus) to contain the fog. The gizmo can be a sphere, a
box, a cylinder, or some combination of these.

Pick Gizmo Click to enter Pick mode and click an atmospheric apparatus in
the scene. The apparatus contains the volume fog when you render. The name
of the apparatus is added to the apparatus list.

Multiple apparatus objects can display the same fog effect.

You can pick multiple gizmos. Click Pick Gizmo and then press H. This opens
the Pick Object dialog, which lets you choose multiple objects from a list.

Changing the dimensions of a gizmo changes the region that fog affects, but
doesn't change the scale of the fog and its noise. For example, reducing the
radius of a spherical gizmo crops the fog, and moving the gizmo changes the
fog's appearance.

Remove Gizmo Removes a gizmo from the volume fog effect. Select the
gizmo in the list, and then click Remove Gizmo.

Soften Gizmo Edges Feathers the edges of the volume fog effect. The higher
the value, the softer the edges. Range=0 to 1.0.

TIP Don't set this value to 0. At 0, Soften Gizmo Edges can cause aliased edges.

Volume group

Color Sets the color for the fog. Click the color swatch, and then select the
color you want in the Color Selector on page 331 .

You can animate the color effect by changing the fog color at a nonzero frame
with Auto Key on.

Exponential Increases density exponentially with distance. When turned
off, density increases linearly with distance. Activate this check box only when
you want to render transparent objects in volume fog.

TIP If you turn on Exponential, increase the Step Size value to avoid banding.

Density Controls the fog density. Range=0 to 20 (anything over that tends
to obliterate the scene).
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Left: Original scene

Right: Increased fog density

Step Size Determines the granularity of the fog sampling; the "fineness" of
the fog. A large step size creates coarse (and to some extent, aliased) fog.

Max Steps Limits the amount of sampling so that computing the fog doesn't
take forever (literally). This is especially useful when the fog is of low density.

When both Step Size and Max Steps have low values, aliasing results.

Fog Background Applies the fog function to the background of the scene.

Volume Fog Environment Effect | 6517



Noise group

Left: Original scene

Right: Noise added to the fog

Noise options for volume fog are comparable to the noise options for materials.

Type Choose one of three types of noise to apply.

Regular The standard noise pattern.

Fractal An iterative fractal noise pattern.

Turbulence An iterative turbulence pattern.

Invert Reverses the noise effect. Dense fog becomes translucent and vice
versa.

Noise Threshold Limits the noise effect. Range=0 to 1.0. When the noise
value is above the Low threshold and below the High threshold, the dynamic
range stretches to fill 0-1. This makes for a smaller discontinuity (First order
instead of 0 order) at the threshold transition, and thus produces less potential
aliasing on page 7708 .

High Sets the high threshold.

Low Sets the low threshold.
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Left: Fog with noise

Right: Changing uniformity creates "blobby" fog

Uniformity Ranges from -1 to 1 and acts like a high-pass filter. The smaller
the value, the more transparent the volume is with discrete blobs of smoke.
Around -0.3 or so your image begins to look like specks of dust. Because the
fog becomes thinner as this parameter gets smaller, you'll probably need to
increase the density or the volume will start to disappear.

Levels Sets the number of times the noise is iteratively applied. Range=1 to
6, including fractional values. Enabled only for Fractal noise or Turbulence.

Size Determines the size of the tendrils of smoke or fog. Smaller values give
smaller tendrils.
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Left: Fog with noise

Right: Decreasing the size

Phase Controls the speed of the wind. If you have Wind Strength also set
to greater than 0, the fog volume animates in accordance with the wind
direction. With no Wind Strength, the fog churns in place. Because there's an
animation track for phase, you can use the Function Curve editor to define
precisely how you want your wind "gusts" to occur.

Wind moves the fog volume in the specified direction over time. Wind is tied
to the phase parameter so as the phase changes, the wind moves. If Phase isn’t
animated there will be no wind.

Wind Strength Controls how fast the smoke moves away from the wind
direction, relative to phase. As mentioned above, if the phase is not animated
then the smoke won’t move, regardless of the wind strength. By having the
phase animate slowly with a large wind strength, the fog moves more than it
is churns.

Alternatively, if the phase changes rapidly while the wind strength is relatively
small, the fog will churn fast and drift slowly. If you want the fog to just churn
in place, animate the phase but keep wind strength at 0.

Wind from the Defines the direction the wind is coming from.

Volume Light Environment Effect

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Atmosphere rollout > Add > Volume Light
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Volumetric light used in a complex environment with shadows and noise.

Volume Light provides light effects based on the interaction of lights with
atmosphere (fog, smoke, and so on).

This plug-in on page 7896  provides effects such as radial glows for omni lights
on page 7870 , conical glows for spotlights, and parallel beams of fog for
directional lights. Objects within the light volume can cast shadows within
the spotlight's cone, if using shadow maps as a shadow generator.

A simplified example where the light cone is clearly visible on the right.

Volume Light renders only in Camera and Perspective views. Orthographic
or User views don’t render Volume Light effects.
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Procedures

To use Volume Light:

1 Create a scene with lights.

2 Create a Camera or Perspective view of your scene.

TIP Avoid making the view axis parallel to the cone of a spotlight. This tends
to create only a washed-out scene, possibly with rendering artifacts.

3 Choose Rendering > Environment.

4 On the Environment panel, under Atmosphere , click Add.

The Add Atmospheric Effect dialog is displayed.

5 Choose Volume Light, and then click OK.

6 Click Pick Light, and then select a light in a viewport to add the light to
the list of volume lights.

You can also use the Pick Object dialog to select multiple lights from a
list. Click Pick Light, and then press H to open the dialog.

7 Set the parameters for volume light.

To add a light to the list:

1 Click Pick Light.

2 Click the light in a viewport.

To remove a light from the list:

1 Open the list of volume lights.

2 Choose the light you want to remove the volume light effect from.

3 Click Remove Light.

To assign volume light to a light through the Modify panel:

1 Open the Modify panel of a light.

2 Open the Atmospheres & Effects rollout.

3 Click Add.
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4 Select Volume Light from the Add Atmosphere or Effect dialog and click
OK.

5 Highlight Volume Light from the Atmospheres & Effects list and click
setup to adjust the Volume Light parameters.

NOTE Volume Lights don’t support negative multiplier values.
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Interface

The Volume Light Parameters rollout appears when you select Volume Light
under Effects in the Environment dialog. It has the following controls.
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Lights group

Pick Light Click the light that you want to enable for volume light in any
viewport.

You can pick multiple lights. Click Pick Light and then press H. This opens
the Pick Object dialog, which lets you choose multiple lights from a list.

Remove Light Deletes a light from the list.

Volume group

Fog Color Sets the color for the fog that makes up the volume of the light.
Click the color swatch, and then choose the color you want in the Color
Selector on page 331 .

You can animate the color effect by changing the fog color at a nonzero frame
with the Auto Key button on.

Unlike the other fog effects, this fog color combines with the color of the
light. Possibly the best effect is to use white fog and then color it with a colored
light.

Attenuation Color Attenuates volume light over distance. The volume light
ramps from the Fog Color to the Attenuation color over the light's Near and
Far attenuation distances. Clicking the color swatch displays a color selector
so you can change the attenuation color.

Attenuation Color interacts with Fog Color. For example, if your fog color is
red and your attenuation color is green, in the rendering your fog will shade
to purple. Typically the attenuation color should be very dark and
neutral—black is a good choice.

Use Attenuation Color Makes attenuation color active.

Exponential Increases density exponentially with distance. When turned
off, density increases linearly with distance. Activate this check box only when
you want to render transparent objects in volume fog.

Density Sets the density of the fog. The denser the fog, the more the light
reflects off it inside the volume. Densities of 2 to 6 percent probably make the
most realistic fog volumes.
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Left: Original scene

Right: Increasing the density

Max Light% Represents the maximum glow effect that you can achieve
(defaults to 90 percent). By turning this down, you can limit the brightness
of the glow so that it doesn't get denser and denser as it gets farther away from
the light and "whites out."

NOTE When your scene includes transparent objects inside a volume light, set
Max Light to 100 percent.

Min Light% Similar to an ambient light on page 7710  setting. If Min Light%
is greater than 0, areas outside the light volume will glow also. Note that this
means areas of open space (where the light ray can travel forever) will end up
the same as the fog color (just as with normal fog).

Without objects behind the fog, the scene will always be as bright as the fog
color if the Min Light% is greater than 0 (no matter what the actual value is).
This is because the fog goes to infinity and is accumulated infinitely. If you're
going to use min light% values greater than 0, you should make sure that you
enclose your scene by geometry.

Atten. Mult. (Attenuation Multiplier) Adjusts the effect of the attenuation
color.

Filter Shadows Allows you to get better quality volume-light rendering by
increasing the sampling rate (at the cost of some increased rendering time).
These are the options:
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Low The image buffer is not filtered but directly sampled instead. This option
is fine for 8-bit images, AVI on page 7118  files, and so on.

Medium Adjacent pixels are sampled and averaged. This produces a very
significant improvement in cases where you’re getting banding types of
artifacts. It is slower than Low.

High Adjacent pixels and the diagonal pixels are sampled, and each are given
different weights. This is the slowest method and provides somewhat better
quality than Medium.

Use Light Smp Range Blurs the shadows cast in the volume based on the
Sample Range value in the light's shadow parameters. Because increasing the
Smp Range value blurs the shadow cast by the light, this makes shadows in
the fog better match cast shadows, and helps prevent aliasing in the fog
shadows.

TIP With the Use Light Smp Range option, the higher the light's Smp Range value,
the slower the rendering. However, with this option you can usually get good
results with a lower Sample Volume % setting (such as 4), which reduces rendering
time.

Sample Volume % Controls the rate at which the volume is sampled. Ranges
1 through 10,000 (where 1 is the lowest quality and 10,000 is the highest
quality).

Auto Controls the Sample Volume % parameter automatically and disables
the spinner (this is the default). The preset sampling rates are as follows:

low=8; medium=25; high=50

Because the parameter ranges up to 100 there's still room to set it higher.
Increasing the Sample Volume % parameter definitely slows things down, but
in some cases you may want to increase it (for extremely high sample quality).
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Left: Original scene

Right: Increasing sample volume to improve quality

Attenuation group

The controls in this section are contingent upon the settings of the Start Range
and End Range attenuation on page 7719  parameters for the individual light.

NOTE Rendering Volume Light at some angles can introduce aliasing problems.
To eliminate aliasing problems, activate the Near and Far Attenuation settings in
the light object that the Volume Light applied to.

Start % Sets the start attenuation of the light effect, relative to the actual
light parameter's attenuation. It defaults to 100 percent, which means that it
starts attenuating at the Start Range point. When you reduce this parameter,
it starts attenuating the light at a reduced percentage of the actual Start Range
value that is, closer to the light itself.

Because you usually want a smooth falloff on page 7811 , you can keep this
value at 0, and no matter what the light's actual Start Range, you'll always get
a smooth glow without hotspots on page 7811 .

End % Sets the end attenuation of the lighting effect, relative to the actual
light parameter's attenuation. By setting this lower than 100 percent, you can
have a glowing attenuating light that casts light much farther than it actually
glows. Default=100.

6528 | Chapter 19   Effects and Environments



Left: Original scene

Right: Attenuation limits the range of the light.

Noise group

Noise On Turns the noise on and off. When noise is on there is a slight
increase in render time.

Amount The percentage of noise applied to the fog. If the amount is 0, there
is no noise. If the amount is 1, the fog becomes pure noise.

Left: Original scene

Right: Noise added
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Link To Light Links the noise effect to its light object, rather than to world
coordinates.

Usually you want noise to look like fog or dust motes in the atmosphere, in
which case, as the light moves, the noise should remain with the world
coordinates. For certain special effects, however, you might want the noise
linked to the light's coordinates. In these cases, turn on Link to Light.

Type Choose one of three types of noise to apply.

■ Regular The standard noise pattern.

■ Fractal An iterative fractal noise pattern.

■ Turbulence An iterative turbulence pattern.

Invert Reverses the noise effect. Dense fog becomes translucent and vice
versa.

Noise Threshold Limits the noise effect. When the noise value is above the
Low threshold and below the High threshold, the dynamic range stretches to
fill 0-1. This makes for a smaller discontinuity (first order instead of 0 order)
at the threshold transition and thus produces less potential aliasing on page
7708 .

■ High Sets the high threshold. Range=0 to 1.0.

■ Low Sets the low threshold. Range=0 to 1.0.

Uniformity Acts like a high-pass filter: the smaller the value, the more the
volume is transparent with discrete blobs of smoke. By around -0.3 or so your
image begins to look like specks of dust. Because the fog becomes thinner as
this parameter gets smaller, you'll probably need to increase the density or
the volume will start to disappear. Range=-1 to 1

Levels Sets the number of times the noise is iteratively applied. This parameter
is animatable. Enabled only for Fractal noise or Turbulence. Range=1 to 6,
including fractional values.

Size Determines the size of the tendrils of smoke or fog. Smaller values give
smaller tendrils.
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Left: Volume light with noise

Right: Reducing the size value

Phase Controls the speed of the wind. If you have Wind Strength also set
to greater than 0, the fog volume animates in accordance with the wind
direction. With no Wind Strength, the fog churns in place. Because there's an
animation track for phase, you can use the Function Curve editor to define
precisely how you want your wind "gusts" to happen.

Wind moves the fog volume in the specified direction over time. Wind is tied
to the phase parameter so as the phase changes, the wind moves. If Phase isn’t
animated there will be no wind.

Wind Strength Controls how fast the smoke moves away from the wind
direction, relative to phase. As mentioned above, if the phase is not animated
then the smoke won’t move, regardless of the wind strength. By having the
phase animate slowly with a large wind strength, the fog moves more than it
churns.

Alternatively, if the phase changes rapidly while the wind strength is relatively
small, the fog will churn fast and drift slowly. If you want the fog to just churn
in place, animate the phase but keep wind strength at 0.

Wind from the Defines the direction the wind is coming from.

Exposure Controls

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout
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Exposure controls are plug-in components that adjust the output levels and
color range of a rendering, as if you were adjusting film exposure. This process
is known as tone mapping. These controls are especially useful for renderings
that use radiosity on page 5976 , and when dealing with high-dynamic-range
(HDR) imagery.

Exposure control compensates for the limited dynamic range of monitors.
Monitors have a dynamic range of about two orders of magnitude. The
brightest color that appears on a display is about 100 times brighter than the
dimmest. The eye, by comparison, can perceive a dynamic range of about 16
orders of magnitude. The brightest color we can perceive is about 10
million-billion times brighter than the dimmest. Exposure control adjusts
colors so they better simulate the eye's great dynamic range, while still fitting
within the color range that can be rendered.

The exposure controls included with 3ds Max are:

■ Automatic Exposure Control on page 6534  samples the rendered image and
builds a histogram to give good color separation across the entire dynamic
range of the rendering. It can enhance some lighting effects that would
otherwise be too dim to see.

■ Linear Exposure Control on page 6537  samples the rendering and uses the
average brightness of the scene to map physical values to RGB values.
Linear Exposure Control is best for scenes with a fairly low dynamic range.

■ Logarithmic Exposure Control on page 6540  uses brightness, contrast, and
whether the scene is outdoors in daylight to map physical values to RGB
values. Logarithmic Exposure Control is better for scenes with a very high
dynamic range.

■  mr Photographic Exposure Control on page 6544  gives you
camera-like controls including shutter speed, aperture, and film speed, as
well as image control over highlights, midtones, and shadows.

■ Pseudo Color Exposure Control on page 6552  is actually a lighting analysis
tool. It maps luminances to pseudo colors that show the brightness of the
values being converted.

IMPORTANT The mental ray renderer on page 6039  supports only the Logarithmic,
mr Photographic, and Pseudo Color exposure controls.
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Left: Linear exposure control maps intensity evenly.

Right: Logarithmic exposure control maps most intensities to low and mid tones.

Tips:

■ If the primary lighting from your scene comes from standard lights (rather
than photometric lights), use the Logarithmic exposure control and turn
on Affect Indirect Only.

■ Use Automatic exposure control for rendering still images. This method
is also useful for first-draft renderings.

■ Use Logarithmic exposure control for animations with a moving camera.
(Automatic and Linear exposure control with a moving camera can cause
excessive flickering.)

■ For rendering high-dynamic-range images with mental ray, use the mr
Photographic exposure control.

■ For outdoor scenes that use the Daylight system, turn on the Exterior toggle
to prevent overexposure.

Exposure and Attenuation for Standard Lights

When you use standard lights that are not attenuated, renderings tend to have
a low dynamic range, because light intensities don't vary greatly across the
scene. In this situation, adjusting light values might be all you need to do to
get a good rendering.

On the other hand, when lights are attenuated the illumination might be too
bright on near surfaces or too dim on distant surfaces. In this situation, the
Automatic exposure control can help, because it adjusts the larger dynamic
range of the (simulated) physical scene, into the smaller dynamic range of the
display.
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Interface

Drop-down list Choose the exposure control to use.

Active When on, the exposure control is used in rendering. When off, the
exposure control is not applied.

Process Background and Environment Maps When on, the scene background
and environment maps are subjected to exposure control. When off, they are
not.

Preview thumbnail The thumbnail displays a preview of the rendered scene
with the active exposure control applied. Once a preview has been rendered,
it updates interactively when you changed exposure control settings.

Render Preview Click to render the preview thumbnail.

Automatic Exposure Control

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout > Choose Automatic Exposure
Control from the list. > Automatic Exposure Control rollout
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Auto exposure can affect the lighting of the whole image.

Automatic Exposure Control samples the rendered image and builds a
histogram to give good color separation across the entire dynamic range of
the rendering. It can enhance some lighting effects that would otherwise be
too dim to see.

NOTE Automatic Exposure Control should not be used in animations, because
every frame will have a different histogram, causing your animation to flicker.

IMPORTANT The mental ray renderer on page 6039  does not support the
Automatic exposure control.

See also:

■ Environment Panel on page 6486
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Interface

Brightness Adjusts the brightness of the converted colors. Range=0 to 200.
Default=50.

This parameter is animatable.

Contrast Adjusts the contrast of the converted colors. Range=0 to 100.
Default=50.

This parameter is animatable.

Exposure Value Adjusts the overall brightness of the rendering. Range=-5.0
to 5.0; Negative values make the image darker, and positive values make it
brighter. Default=0.0.

The exposure value is comparable to the exposure compensation setting in
cameras with automatic exposure. This parameter is animatable.

Physical Scale Sets a physical scale for exposure control to use with lights
that are not physically based. The result is an adjustment of the rendering
that approximates the eye's response to the scene.

Each standard light's Multiplier on page 7859  is multiplied by the Physical Scale
value to give a light intensity value in candelas. For example, with the default
Physical Scale of 1500, a standard omni light is treated by the renderer and
radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is
also factored into reflections, refractions, and self-illumination.

TIP You need to set the Physical Scale when you use ray-tracing with self
illumination. Set this value to the equivalent of the brightest light source in the
scene. This will set the appropriate conversion scale for reflections, self-illumination,
and all other non-physically based elements a material offers. In some cases, an
object might reflect or emit more light than the brightest light object in the scene;
in this case, use the object's Luminance value as the Physical Scale.
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Range=0.0 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a
"candle"). A 100-Watt (W) incandescent light bulb is approximately 139
candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the
same bulb with a reflector is about 4500 cd because the light flux is
concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value.

This parameter is animatable.

Color correction check box and color swatch When the check box is turned
on, color correction shifts all colors so the color displayed in the color swatch
appears as white. Default=off.

Clicking the color swatch displays a Color Selector on page 331  so you can
choose the color to adapt to.

You can use this control to simulate how the eye adjusts to lighting. For
example, even when the light in a room has a yellow hue from an incandescent
light bulb, we will continue to perceive objects that we know to be white,
such as printed pages, as white.

TIP For the best results, use a very pale color correction color, such as a pale blue
or pale yellow.

Desaturate Low Levels When on, renders dimly lit colors as if the light were
too dim for the eye to distinguish between colors. When on, renders even
dimly lit colors. Default=off.

Desaturate Low Levels simulates the eye's response to dim lighting. In dim
lighting, the eye does not perceive colors and sees tones of gray instead.

The effect of this setting is not apparent except at very low light levels, below
5.62 footcandles (lumens per square foot). When the illuminance is less than
0.00562 footcandles, the scene is completely gray.

NOTE 1 footcandle (fc) equals 10.76 lux (lumens per square meter).

Linear Exposure Control

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout > Choose Linear Exposure
Control from the list. > Linear Exposure Control rollout
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Linear Exposure Control samples the rendered image and uses the average
brightness of the scene to map physical values to RGB values. Linear Exposure
Control is best used for scenes with a fairly low dynamic range.

NOTE Linear Exposure Control should not be used in animations, because every
frame will have a different histogram, causing your animation to flicker.

IMPORTANT The mental ray renderer on page 6039  does not support the Linear
exposure control.

See also:

■ Environment Panel on page 6486

Interface

Brightness Adjusts the brightness of the converted colors. Range=0 to 200.
Default=50.

This parameter is animatable.

Contrast Adjusts the contrast of the converted colors. Range=0 to 100.
Default=50.

This parameter is animatable.

Exposure Value Adjusts the overall brightness of the rendering. Range= -5.0
to 5.0. Negative values make the image darker, and positive values make it
brighter. Default=0.0.

The exposure value can be thought of as an exposure compensation setting
in cameras with automatic exposure control.

This parameter is animatable.

6538 | Chapter 19   Effects and Environments



Physical Scale Sets a physical scale for exposure control to use with lights
that are not physically based. The result is an adjustment of the rendering
that approximates the eye's response to the scene.

Each standard light's Multiplier on page 7859  is multiplied by the Physical Scale
value to give a light intensity value in candelas. For example, with the default
Physical Scale of 1500, a standard omni light is treated by the renderer and
radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is
also factored into reflections, refractions, and self-illumination.

TIP You need to set the Physical Scale when you use ray-tracing with self
illumination. Set this value to the equivalent of the brightest light source in the
scene. This will set the appropriate conversion scale for reflections, self-illumination,
and all other non-physically based elements a material offers. In some cases, an
object might reflect or emit more light than the brightest light object in the scene;
in this case, use the object's Luminance value as the Physical Scale.

Range=0.0 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a
"candle"). A 100-Watt (W) incandescent light bulb is approximately 139
candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the
same bulb with a reflector is about 4500 cd because the light flux is
concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value.

This parameter is animatable.

Color Correction check box and color swatch When the check box is turned
on, color correction shifts all colors so the color displayed in the color swatch
appears as white. Default=off.

Clicking the color swatch displays a Color Selector on page 331  so you can
choose the color to adapt to.

You can use this control to simulate how the eye adjusts to lighting. For
example, even when the light in a room has a yellow hue from an incandescent
light bulb, we will continue to perceive objects that we know to be white,
such as printed pages, as white.

TIP For the best results, use a very pale color correction color, such as a pale blue
or pale yellow.

Desaturate Low Levels When on, renders dimly lit colors as if the light were
too dim for the eye to distinguish between colors. When on, renders even
dimly lit colors. Default=off.
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Desaturate Low Levels simulates the eye's response to dim lighting. In dim
lighting, the eye does not perceive colors and sees tones of gray instead.

The effect of this setting is not apparent except at very low light levels, below
5.62 footcandles (lumens per square foot). When the illuminance is less than
0.00562 footcandles, the scene is completely gray.

NOTE 1 footcandle (fc) equals 10.76 lux (lumens per square meter).

Logarithmic Exposure Control

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout > Choose Logarithmic Exposure
Control from the list. > Logarithmic Exposure Control rollout

Logarithmic Exposure Control uses brightness, contrast, and whether the
scene is outdoors in daylight to map physical values to RGB values. You can
use it with either the default scanline renderer on page 5949  and the mental
ray renderer on page 6039 . Logarithmic Exposure Control is best for scenes with
a very high dynamic range.

Left: The intensity of an IES Sun light completely overexposes a scene.

Right: Logarithmic exposure control corrects the overexposure.

Logarithmic Exposure Control is the best type of exposure control for
animations because it doesn’t use histograms.

TIP If you're rendering to texture on page 6169 , use the Logarithmic exposure
control, not the Automatic or Linear control.

See also:

■ Environment Panel on page 6486
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Interface

Brightness Adjusts the brightness of the converted colors. Range=0 to 200.
Default=50.

This parameter is animatable.

Contrast Adjusts the contrast of the converted colors. Range=0 to 100.
Default=50.

This parameter is animatable.

Mid Tones Adjusts the mid-tone values of the converted colors. Range=0.01
to 20.0. Default=1.0.

This parameter is animatable.

Adjusting the value of mid tones

Physical Scale Sets a physical scale for exposure control to use with lights
that are not physically based. The result is an adjustment of the rendering
that approximates the eye's response to the scene.

Each standard light's Multiplier on page 7859  is multiplied by the Physical Scale
value to give a light intensity value in candelas. For example, with the default
Physical Scale of 1500, a standard omni light is treated by the renderer and
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radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is
also factored into reflections, refractions, and self-illumination.

TIP You need to set the Physical Scale when you use ray-tracing with self
illumination. Set this value to the equivalent of the brightest light source in the
scene. This will set the appropriate conversion scale for reflections, self-illumination,
and all other non-physically based elements a material offers. In some cases, an
object might reflect or emit more light than the brightest light object in the scene;
in this case, use the object's Luminance value as the Physical Scale.

NOTE The mental ray renderer treats Physical Scale in the same way the scanline
renderer does in terms of its effect on reflections and refractions. Physical Scale
does affect the appearance of self-illuminated materials.

Range=0.0 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a
"candle"). A 100-Watt (W) incandescent light bulb is approximately 139
candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the
same bulb with a reflector is about 4500 cd because the light flux is
concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value.

This parameter is animatable.

Color Correction check box and color swatch When the check box is turned
on, color correction shifts all colors so the color displayed in the color swatch
appears as white. Default=off.

Clicking the color swatch displays a Color Selector on page 331  so you can
choose the color to adapt to.

You can use this control to simulate how the eye adjusts to lighting. For
example, even when the light in a room has a yellow hue from an incandescent
light bulb, we will continue to perceive objects that we know to be white,
such as printed pages, as white.

TIP For the best results, use a very pale color correction color, such as a pale blue
or pale yellow.
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Color correction can remove the color “cast” that comes from a light source.

Desaturate Low Levels When on, renders dimly lit colors as if the light were
too dim for the eye to distinguish between colors. When off, renders even
dimly lit colors. Default=off.

Desaturate Low Levels simulates the eye's response to dim lighting. In dim
lighting, the eye does not perceive colors and sees tones of gray instead.

The effect of this setting is not apparent except at very low light levels, below
5.62 footcandles (lumens per square foot). When the illuminance is less than
0.00562 footcandles, the scene is completely gray.

NOTE 1 footcandle (fc) equals 10.76 lux (lumens per square meter).

Affect Indirect Only When on, Logarithmic Exposure control is applied only
to areas of indirect lighting. Default=off.

Turn on this toggle when the primary lighting for your scene comes from
standard lights rather than photometric lights. When you use standard lights
and turn on Affect Indirect Only, radiosity and exposure control yield results
similar to the default scanline renderer. When you use standard lights but
leave Affect Indirect Only off, radiosity and exposure control yield results that
can be quite different from the default scanline renderer.

In general, you don’t need to turn on Affect Indirect Only when the primary
lighting for your scene comes from photometric lights.

Exterior daylight When on, converts colors for an outdoor scene. Default=off.
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The exterior daylight setting compensates for the extreme intensity of an IES sun light.

 mr Photographic Exposure Control

Set mental ray as the renderer. > Rendering menu > Environment >
Environment and Effects dialog > Environment panel > Exposure Control
rollout > Choose mr Photographic Exposure Control from the list. > mr
Photographic Exposure Control rollout

The mr Photographic Exposure Control lets you modify rendered output with
camera-like controls: either a general exposure value or specific shutter speed,
aperture, and film speed settings. It also gives you image-control settings
including separate values for highlights, midtones, and shadows. It’s intended
for high-dynamic-range scenes rendered with the mental ray renderer on
page 6039 .
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Interface

TIP To see a definition of any numeric parameter on this rollout, hover the mouse
cursor over the parameter’s spinner.

Exposure group

This group comprises a drop-down list of exposure presets plus a choice of
Exposure Value or Photographic Exposure and associated parameters. Choosing
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one method makes the other’s setting or settings unavailable, but they still
change based on adjustments you make to the available method. For example,
when Exposure Value is active, adjusting its value also changes the
Photographic Exposure > Shutter Speed setting.

Preset Choose from the available options based on setting and lighting
conditions. The presets affect all of the remaining settings in this group.

Exposure Value (EV) Choose this option to specify a single Exposure Value
setting that corresponds to a combination of the three Photographic Exposure
values (see following). Each increment or decrement in the EV value
corresponds to halving or doubling, respectively, the effective exposure, as
expressed in the resultant change in the Shutter Speed value. Thus, higher
values yield darker images, and lower values yield brighter images.

For example, as shown above, the combination of a shutter speed of 1/125 of
a second, f/16, and ISO 100 results in an EV of 15. The same EV results from
halving the shutter speed to 1/250 second and doubling the aperture size to
f/11.

Photographic Exposure Lets you set the exposure using standard
camera-oriented controls. These controls affect exposure only: Shutter Speed
has no effect on motion blur; Aperture doesn’t influence depth of field; and
Film Speed has no effect on graininess.

■ Shutter Speed The duration, in fractions of a second, that the “shutter”
is open. The higher this value, the greater the exposure.

■ Aperture The size of the opening of the “camera iris,” expressed as a
ratio. The higher this value, the lower the exposure.

■ Film Speed (ISO) The sensitivity of the “camera film,” expressed as an
index. The higher this value, the greater the exposure.

Image Control group

Use these controls to adjust the relative brightness or highlights, midtones,
and shadows in the rendered image. The combination of these three settings
is depicted in the graph on the right side of the rollout. Additional controls
available here let you adjust color saturation, whitepoint, and vignetting.
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Rendering with default settings (with final gathering)

Highlights (Burn) Controls the level of the brightest areas of the image.
Higher values yield brighter highlights, while lower values darken the
highlights.
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Darkened (burnt-in) highlights

Midtones Controls the level of the areas of the image whose brightness lies
between the highlights and the shadows. Higher values yield brighter midtones,
while lower values darken the midtones.
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Elevated midtones

Shadows Controls the level of the darkest areas of the image. Lower values
yield lighter shadows, while higher values darken the shadows.
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Lightened shadows

Color Saturation Controls the intensity of colors in the rendered image.
Higher values result in more intense colors.
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Color Saturation=2.0

Whitepoint Specifies the main color temperature of the light sources. This
is similar to white balance controls on digital cameras. For daylighting, a value
of 6500 is recommended, for incandescent lighting, a value of 3700 is
recommended.

For example, photographs taken indoors might be lit by incandescent lights,
which are relatively orange compared to daylight. Defining "white" as daylight
will give unacceptable results when attempting to color-correct a photograph
taken with incandescent lighting.

Vignetting Reduces the image brightness in the image periphery compared
to the image center, resulting in a circular fully exposed area in the center,
with darker edges.
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Vignetting=25.0

Gamma/LUT Settings This group comprises text showing the status of the
current Gamma/LUT settings, and a Setup button that opens the Preference
Settings dialog to the Gamma and LUT panel on page 7550  so you can change
the settings.

Pseudo Color Exposure Control

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout > Choose Pseudo Color
Exposure Control from the list. > Pseudo Color Exposure Control rollout

Pseudo Color Exposure Control is actually a lighting analysis tool that provides
you with an intuitive way of visualizing and evaluating the lighting levels in
your scenes. It maps luminance on page 7833  or illuminance on page 7813
values to pseudo colors that show the brightness of the values being converted.
From darkest to brightest, the rendering shows blue, cyan, green, yellow,
orange, and red. (Alternatively, you can choose a grayscale where the brightest
values are white, and the darkest are black.) The rendering includes the colored
or grayscale spectrum bar as a legend for the image.
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After rendering the scene with pseudo color, 3ds Max displays a rendered
frame window on page 5885  labeled “Illuminance,” with a legend of illuminance
values below the rendered image.

NOTE The Illuminance frame is not displayed if antialiasing is turned off.

NOTE You can use the Pseudo Color exposure control with the mental ray renderer
on page 6039 .

Pseudo color exposure of a scene with radiosity. Areas in red are overlit, areas in blue
are underlit, and areas in green have a good lighting level.

In the rendered frame window labeled “illuminance,” a legend appears below
the image.

If you render a scene using this exposure control, the software creates a special
render element on page 6157  named Illuminance that helps obtain accurate
luminance and illuminance data.

TIP If you get a file write error when you try to render a pseudo color image,
check the path and file name of the Illuminance element, or the permissions of
the PNG file that saves the illuminance data.
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Three spheres at an equal distance from a light source. The sphere on the left has a
matte material, the sphere in the middle is glossy, and the sphere on the right is glossy
but has a much darker color.

A display of illuminance shows that it is the same for all three spheres.

A display of luminance shows that the two spheres on the left reflect about the same
amount of light, but the darker sphere on the right reflects little light except for its
highlight.
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See also:

■ Environment Panel on page 6486

Interface

Display Type group

Quantity Chooses the value being measured.

■ Illuminance (the default) displays values of light incident on surfaces.

■ Luminance displays values of light reflected off surfaces.

Style Chooses the way to display values.

■ Colored (the default) shows a spectrum.

■ Grayscale shows gray tones that range from white to black.
The spectrum bar displays the values the rendering will use.
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Pseudo color display style:

Left: Grayscale

Right: Colored scale

Scale Chooses the technique used to map values.

■ Logarithmic (the default) uses a logarithmic scale.

■ Linear uses a linear scale.
The Logarithmic scale is useful when the illumination of the surfaces of
interest is low compared to the maximum illumination in the scene.

Left: Linear scale

Right: Logarithmic scale

Display Range group

Minimum (Min.) Sets the lowest value to measure and represent in the
rendering. Values at this quantity or below it all map to the leftmost display
color (or grayscale level).

Maximum (Max.) Sets the highest value to measure and represent in the
rendering. Values at this quantity or above it all map to the rightmost display
color (or grayscale value).
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Physical Scale Sets a physical scale for exposure control to use with lights
that are not physically based. The result is an adjustment of the rendering
that approximates the eye's response to the scene.

Changing the value of Physical Scale is an optional step. Use it as a last resort
when the materials or maps are not rendering correctly. Changing this setting
will not affect anything in the scene unless your scene has an Ambient Color
different than black. If you do adjust it, set the Physical Scale value to the
equivalent of the brightest light source in the scene.

The software multiplies each standard light's Multiplier on page 7859  by the
Physical Scale value to produce a light intensity value in candelas. For example,
with the default Physical Scale of 1500, a standard omni light is treated by
the renderer and radiosity as a photometric isotropic light of 1500 candelas.
Physical Scale is also factored into reflections, refractions, and self-illumination.

TIP When you use ray-tracing with self illumination, set Physical Scale to the
equivalent of the brightest light source in the scene. This sets the appropriate
conversion scale for reflections, self-illumination, and all other non-physically based
elements a material offers. In some cases, an object might reflect or emit more
light than the brightest light object in the scene; in this case, use the object's
Luminance value as the Physical Scale.

Range=0.0 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a
"candle"). A 100-Watt (W) incandescent light bulb is approximately 139
candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the
same bulb with a reflector is about 4500 cd because the light flux is
concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value.

This parameter is animatable.
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Adjusting the range to analyze:

Above: Correct range for a scene

Middle: Too narrow a range

Below: Too great a range

Narrowing the range to focus on a single object

General Guidelines for Physical Scale Values

■ If you use only Photometric lights on page 4951 , IES Sun on page 4969 , and
IES Sky on page 4973 , the Physical Scale value is disregarded, and you don't
need to change it.

■ If you use Standard lights on page 4925 , the Physical Scale value acts as a
conversion scale that the radiosity engine uses to calculate energy. Set it
to the equivalent of the brightest light source in the scene. This will set
the appropriate conversion scale for reflections, self-illumination, and all
other non-physically based elements a 3ds Max material offers.
However, if you use the Affect Indirect Only flag in the Logarithmic
Exposure Control on page 6540 , you don’t need to worry about the physical
scale setting.

Spectrum bar Shows the spectrum-to-intensity mapping. The numbers below
the spectrum range from the Minimum to the Maximum settings.

When rendering with pseudo color, the spectrum bar is displayed beneath
the pseudo color image, labeled either Luminance or Illuminance.
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Lighting Data Exporter Utility

Utilities panel > Utilities rollout > Lighting Data Export

The Lighting Data Exporter renders the active viewport to images that include
luminance on page 7833  and illuminance on page 7813  data that can be used
for lighting analysis.

The Lighting Data Exporter does not render the files unless you have applied
an exposure control on page 6531  to the scene.

You can render to either the TIFF file on page 7164  format. If you export to a
TIFF file, the utility renders a single image file that has separate channels for
luminance and illuminance (the file is of the 32-bit SGI LogLUV image type).

You can also render to the PIC file on page 7151  format. If you export to a PIC
file, the utility renders two images: one containing luminance data, and the
other containing illuminance data (see the description of the File Name button,
below).

Interface

File Name Click the button to specify a file name for the rendering.

When you export to the PIC format, the Lighting Data Exporter renders two
files. It appends the string “_Illuminance” to the name of one file, and
“_Luminance” to the other. For example, if you type house as the file name,
the exporter renders to house_illuminance.pic and house_luminance.pic.

Image Size group

Width Sets the output width, in pixels. Default=640.
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Height Sets the output height, in pixels. Default=480.

Export Click to render luminance and illuminance data.

WARNING Unlike the renderer, if you click Export more than once, this overwrites
previously rendered files.

Atmospheric Apparatus

Create panel > Helpers > Atmospheric Apparatus (from drop-down list)

You can create three types of atmospheric apparatuses, or gizmos on page 7800
: box, cylinder, and sphere. These gizmos contain the fog or fire effect in your
scene.

BoxGizmo Helper on page 6561

CylGizmo Helper on page 6564

SphereGizmo Helper on page 6567

See also:

■ Fire Environment Effect on page 6493

■ Fog Environment Effect on page 6506

■ Volume Light Environment Effect on page 6520

Add Atmosphere Dialog

Select Atmospheric Apparatus object. > Modify panel > Atmospheres & Effects
rollout > Add button

The Add Atmosphere dialog lets you associate an atmosphere with the
Atmospheric Apparatus on page 6560 .
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Interface

List of atmospheres Displays the atmospheres that you can associate with
the apparatus.

New or existing group

These radio buttons choose between new or existing atmospheres.

New Lists only new atmospheres.

Existing Lists only atmospheres that have been already assigned to other
apparatuses in the scene.

Adding an existing atmosphere creates a new atmosphere whose settings are
initially identical to the previous one.

BoxGizmo Helper

Create panel > Helpers > Atmospheric Apparatus (from drop-down list) >
BoxGizmo

Create menu > Helpers > Atmospherics > BoxGizmo
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BoxGizmo lets you create a box-shaped gizmo in your scene. Clicking the
BoxGizmo button displays the Box Gizmo Parameters rollout.

Box gizmo with volume fog

Procedures

To create the BoxGizmo:

1 Drag in a viewport to define the initial length and width, then release
the mouse and drag vertically to set the initial height.

2 Click to end BoxGizmo creation.

To add a new atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel, on the Atmospheres & Effects rollout, click Add.
This displays the Add Atmosphere dialog on page 6560 .

3 Choose an atmosphere from the list.

4 Click OK.
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This associates a new atmosphere with the apparatus.

To add an existing atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel, on the Atmospheres & Effects rollout, click Add.
This displays the Add Atmosphere dialog on page 6560 .

3 In the dialog, choose Existing.

4 Choose an atmosphere from the list.

5 Click OK.

This creates a duplicate atmosphere for the apparatus. Its settings are
initially identical to the atmosphere you chose. You can adjust them
using Setup.

Interface

Name and Color rollout

The Name and Color rollout on page 7423  lets you rename objects and change
their wireframe color.

Box Gizmo Parameters rollout

Length, Width, and Height Set the dimensions of the box gizmo.
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Seed Sets a base value used to generate the atmospheric effect. Each apparatus
in the scene should have a different seed. If more than one apparatus uses the
same seed and same atmospheric effect, they will produce nearly identical
results.

New Seed Click to generate a random number automatically and place it
in the seed field.

Atmospheres & Effects rollout

The Atmospheres & Effects rollout, available from the Modify panel, allows
you to add and set up atmospheres directly to the gizmo.

Add Displays the Add Atmosphere dialog on page 6560  from which you can
add an atmosphere to the BoxGizmo.

Delete Deletes a highlighted atmospheric effect.

Setup Displays the Environment panel on page 6486 , where you can edit the
highlighted effect.

CylGizmo Helper

Create panel > Helpers > Atmospheric Apparatus (from drop-down list) >
CylGizmo

Create menu > Helpers > Atmospherics > Cylinder Gizmo
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CylGizmo lets you create a cylinder-shaped gizmo in your scene. Clicking the
CylGizmo button displays the Cylinder Gizmo Parameters rollout.

Cylinder gizmo with volume fog

Procedures

To create the CylGizmo:

1 Drag in a viewport to define the initial radius, then release the mouse
and drag vertically to set the initial height.

2 Click to end CylGizmo creation.

To add a new atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel on the Atmospheres & Effects rollout, click Add. This
displays the Add Atmosphere dialog on page 6560 .

3 Choose an atmosphere from the list.

4 Click OK.
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This associates a new atmosphere with the apparatus.

To add an existing atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel on the Atmospheres & Effects rollout, click Add. This
displays the Add Atmosphere dialog on page 6560 .

3 In the dialog, choose Existing.

4 Choose an atmosphere from the list.

5 Click OK.

This creates a duplicate atmosphere for the apparatus. Its settings are
initially identical to the atmosphere you chose. You can adjust them
using Setup.

Interface

Name and Color rollout

The Name and Color rollout on page 7423  lets you rename objects and change
their wireframe color.

Cylinder Gizmo Parameters rollout

Radius and Height Set the dimensions of the cylinder gizmo.

Seed Sets a base value used to generate the atmospheric effect. Each apparatus
in the scene should have a different seed. If more than one apparatus uses the
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same seed and same atmospheric effect, they will produce nearly identical
results.

New Seed Click to generate a random number automatically and place it
in the seed field.

Atmospheres & Effects rollout

The Atmospheres & Effects rollout, available from the Modify panel, allows
you to add and set up atmospheres directly to the gizmo.

Add Displays the Add Atmosphere dialog on page 6560  from which you can
add an Atmosphere to the CylGizmo.

Delete Deletes a highlighted atmospheric effect.

Setup Displays the Environment panel on page 6486 , where you can edit the
highlighted effect.

SphereGizmo Helper

Create panel > Helpers > Atmospheric Apparatus (from drop-down list) >
SphereGizmo

Create menu > Helpers > Atmospherics > Sphere Gizmo

SphereGizmo lets you create a sphere- or hemisphere-shaped gizmo in your
scene. Clicking the SphereGizmo button displays the Sphere Gizmo Parameters
rollout.
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Sphere gizmo with volume fog

Procedures

To create the SphereGizmo:

1 Drag in any viewport to define the initial radius.

2 Adjust the radius with the spinner.

To add a new atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel on the Atmospheres & Effects rollout, click Add. This
displays the Add Atmosphere dialog on page 6560 .

3 Choose an atmosphere from the list.

4 Click OK.

This associates a new atmosphere with the apparatus.
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To add an existing atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel on the Atmospheres & Effects rollout, click Add. This
displays the Add Atmosphere dialog on page 6560 .

3 In the dialog, choose Existing.

4 Choose an atmosphere from the list.

5 Click OK.

This creates a duplicate atmosphere for the apparatus. Its settings are
initially identical to the atmosphere you chose. You can adjust them
using Setup.

Interface

Name and Color rollout

The Name and Color rollout on page 7423  lets you rename objects and change
their wireframe color.

Sphere Gizmo Parameters rollout

Radius Sets the radius of the default sphere.

Hemisphere When turned on, the bottom half of the SphereGizmo is
discarded, creating a hemisphere.

Seed Sets a base value used to generate the atmospheric effect. Each apparatus
in the scene should have a different seed. If more than one apparatus uses the
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same seed and same atmospheric effect, they will produce nearly identical
results.

New Seed Click to generate a random number automatically and place it
in the seed field.

Atmospheres & Effects rollout

The Atmospheres & Effects rollout, available from the Modify panel, allows
you to add and set up atmospheres effects directly to the gizmo.

Add Displays the Add Atmosphere dialog on page 5074  from which you can
add an Atmosphere to the SphereGizmo.

Delete Deletes a highlighted atmospheric effect.

Setup Displays the Environment panel on page 6486 , where you can edit the
highlighted effect.
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Video Post

Video Post, available from the Rendering menu, lets you combine (composite) and render
output of various types of events, including the current scene, bitmap images, image-processing
functions, and so on.

20
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A video post queue can include scene geometry, background images, effects, and masks for compositing
them.
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The result of video post: a composited frame

Video Post is a self-contained, modeless dialog, similar in appearance to Track View. The
edit window of the dialog shows when each event occurs in the finished video. Each event
is associated with a track that has a range bar.

The Video Post dialog contains the following window components:

Video Post Queue on page 6573 : Shows the sequence of post-production events.

Video Post Status Bar/View Controls on page 6575 : Shows information about the active Video
Post controls and lets you control the display of tracks in the event tracks area.

Video Post Toolbar on page 6596 : Provides Video Post commands.

Video Post Queue
Rendering menu > Video Post > Video Post window > Video Post Queue

Video Post Queue provides a hierarchical list of the images, scenes, and events
to be composited.
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The Video Post queue in the Video Post dialog is similar to other hierarchical
lists in the Track View and Material Editor. In Video Post, the list items are
images, scenes, animations on page 7711 , or external processes that together
make up the queue. The items in the queue are called events.

The order that the events appear in the queue is the order in which they are
executed, from top to bottom. Consequently, to correctly composite an image,
the background bitmap must appear before, or above, the image that is to
overlay it.

There is always at least one item in the queue (a placeholder labeled Queue).
It is the queue's parent event.

The queue can be linear, but some kinds of events, such as Image Layer,
combine other events and become their parent.

Procedures

To add an event to the queue:

■ Click an event button.
When you add an event, a dialog displays where you can specify settings
for that event. The settings offered on the dialog depend on the type of
event; some events have different kinds of subtypes.

In general, the new event appears at the end of the queue - but some kinds
of events require that you first select one or more events in the queue. An
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event button is unavailable if the selection in the queue (or the absence
of one) is not legal input to the button's type of event.

To highlight an event already in the queue, click its icon, label, or range-bar
area.

To delete any event in the queue:

■ Select the event and press the Delete key.
You can delete both enabled and disabled events, which are unavailable.

To switch the positions of two events in the queue:

1 Highlight both events.

2  Click Swap.

This operation might not be allowed if the result would be impossible to
execute. At the top level of the queue, you can almost always swap events;
at lower levels, an event's output must be legal input to its parent event.

To edit an event in the queue, do one of the following:

1 Select the event and click Edit Current Event on page 6598 .

2 Double-click the event name.

3 Double-click the event's range-bar area in the edit window.

Use one of the second two methods for disabled events.

Video Post Status Bar / View Controls
Rendering menu > Video Post > Video Post Status Bar

The Video Post Status Bar contains an area for prompt and status information
and for buttons to control the display of tracks in the event tracks area.

Interface

Prompt Line
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Displays instructions for using the currently selected function.

Status (Start, End, Frames,Width, Height)

Displays the Start frame and End frame for the current event, the total number
of frames and the output resolution of the entire queue.

S/E Shows start and end frames of the selected track. If no track is selected,
shows the start and end frames of the entire queue.

F Shows the total frames in the selected track or for the entire queue.

W/H Shows the width and height of the image that results from the rendering
of all the events in the queue.

Pan

 Lets you drag horizontally in the event tracks area to shift the view left
and right.

Zoom Extents

 Adjusts the size of the event-track area horizontally so that all the frames
of the longest track bar are visible.

Use Zoom Extents to quickly reset the display to show all frames after zooming
in on a selection of frames with the Zoom Time button.

Zoom Time

 Displays a greater or lesser number of frames in the event tracks area,
allowing you to scale or zoom the display. The time ruler displays the current
time display unit.

Drag horizontally in the event tracks area to zoom time.

Drag right to display fewer frames in the track area (zoom in).

Drag left to display more frames in the track area (zoom out).
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Zoom Region

 Magnifies a region that you define by dragging a rectangle in the event
tracks area.

Troubleshooting Video Post
While Video Post offers many useful functions and creative effects, invariably
you will set up a queue that looks like it should work or even appears to render
correctly only to give you an animation that does not include the desired
effect. Here are some troubleshooting tips to reference when a queue just isn't
doing what you expect.

There are two key things that can cause a Video Post queue to fail. The first
is incorrect ordering and nesting of events in the queue. The second is faulty
positioning and/or overlapping of the range bars.

When you come up again a problem, especially if you're attempting to set up
a very complex queue, the best way to diagnose the problem is to create a new
queue that should only result in the effect that is failing. If you can get the
simplified queue to work, you can compare it to the structure of the failing
queue to see what might be out of order.

Here are two very common scenarios that look like they should work but
ultimately don't give you the result you expected. These examples are shown
in their simplified state, but could very easily be buried in more complex
queues.

■ The object simply disappears instead of fading out.
The first example illustrates a problem where you expect the scene to render
for fifteen frames before fading to black to finish the animation. However,
at frame sixteen, the scene abruptly goes black.
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This queue shows all the correct events in the proper order in the queue.
The problem is the timing and positioning of the range bars. The most
likely cause of this problem is using the Abut Selection on page 6607  when
it's not necessary. In order for the Fade event to work properly, it needs to
overlap the animation for the amount of time you want to fade to occur.
You need to take into account the number of frames where the scene
actually fades.

To fix this queue, you have to decide how many frames over which the
fade will occur. Let's say you want the scene to fade to black over ten
frames. You would need to drag the right end of the Perspective event
range bar ten frames to the right to overlap the Fade event.

■ The object glows during rendering, but not in the animation.
This second example is even more misleading than the first. The infuriating
thing about this problem is that while the scene is rendering, the object
in the scene shows the glow effect. When the resultant animation is played
back, the Glow effect is not present.
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Once again, this queue shows all the correct events, but the problem here
is the ordering of the events in the queue. This problem is commonly
caused when an event is selected while other events are being added. In
this case, the Perspective event was select when the Lens Effects Glow and
output events were added.

There are two ways to create this queue to give you the correct results. You
can recreate the queue and add each event so there is no nesting, or you
remove the current output event and add it again, making sure no other
events are selected. The following images show the two ways this queue
could be set up to successfully show the glowing object.
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Useful Video Post Procedures
Rendering menu > Video Post

There are some tasks that you will use Video Post for more than others. This
primer describes some of the more common sequences you'll find yourself
using Video Post to create. The procedures are outlined in their simplest forms.

The following procedures are outlined:

■ Make an object glow on page ?

■ Create an animation from a series of still images on page ?

■ Render a scene with a starfield on page ?

■ Set up a simple cross fade between two images on page ?

■ Resize a series of images on page ?

■ Composite two image sequences on page ?

■ Render a scene over an image sequence or an animation on page ?

■ Join two animations – end to end on page ?

■ Switch between views on page ?

■ Render a scene in reverse on page ?
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Procedures

Example: Make an object glow:

One of the most common things you'll want to do with the Glow filter is
make an object glow. Here's how to do it in its simplest form.

1 In the Perspective viewport, create a Sphere with a radius of about 30.

2 Choose Rendering > Video Post.

3  Click Add Scene Event on page 6607  and set the view to Perspective.

Click OK to close the Add Scene Event dialog.

4  Click Add Image Filter Event on page 6620  and choose Lens Effects
Glow from the Filter Plug-In list.

Click OK to close the Add Image Filter Event dialog.

5  Click Add Image Output Event on page 6627  and then click Files.

6 Set the output file format to BMP Image File and enter a filename like
MyGlow.

Click Save when you've set the name and format

7 Click OK to accept the default setting on the BMP configuration dialog.

Then click OK to close the Add Image Output Event dialog.

8 Right-click the Sphere to bring up the Quad Menus and select Properties.

9 Set the Object Channel in the G-Buffer group to 1 and click OK.

10  Click the Execute Sequence button on page 6601 .

11 Click Render on the Execute Video Post dialog.

You'll see the a glowing sphere in the render window.
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Example: Create an animation from a series of still images:

Another common process you'll use Video Post to achieve is taking a series of
still images you've rendered and convert them to an animation. To accomplish
this task, you need an IFL file on page 7131 .

1 Use the IFL Manager Utility on page 7136  to create an IFL file containing
the sequentially number image files you want to process.

2 Choose Rendering > Video Post.

3  Click Add Image Input Event on page 6613  and then click Files.

Choose the IFL file you created at step 1 and then click Open to close the
selection dialog.

4 Click OK to close the Add Input Image Event dialog.

5  Click Add Image Output Event on page 6627  and then click Files.

6 Set the output file format to AVI File on page 7118  and enter a filename
like MyAnimation.

Click Save when you've set the name and format

7 Select a codec on page 7740  from the Video Compression dialog and click
OK.

Then click OK to close the Add Image Output Event dialog.
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8  Click the Execute Sequence button on page 6601 .

9 Click Render on the Execute Video Post dialog.

The final product is an animation.

Example: Render a scene with a starfield:

At some time, you'll want to create a night scene that requires a starry sky.
The key thing to remember when creating a star field is adding a camera to
the scene. The Starfield filter only works with a camera. Here are the steps to
set that up.

1 In the Top viewport, create a Sphere with a radius of about 30 and a
Target Camera.

Place the camera to one side and have it pointing at the center of the
sphere.

2 Right-click in the Perspective viewport and press C to change the viewport
display to Camera01.

3 Choose Rendering > Video Post.

4  Click Add Scene Event on page 6607  and make sure the view is set
to Camera01.

Click OK to close the Add Scene Event dialog.

5  Click Add Image Filter Event on page 6620  and choose Starfield from
the Filter Plug-In list.
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6 Click the Setup button to open the Stars Control dialog. Make sure Source
Camera (at the top) is set to Camera01, and then click OK.

7 Click OK to close the Add Image Filter Event dialog.

8  Click Add Image Output Event on page 6627  and then click Files.

9 Set the output file format to BMP Image File and enter a filename like
MyStarfield.

Click Save when you've set the name and format

10 Click OK to accept the default setting on the BMP configuration dialog.

Then click OK to close the Add Image Output Event dialog.

11  Click the Execute Sequence button on page 6601 .

12 Set the time output to Single and click Render on the Execute Video Post
dialog.

The final product is a rendered image of a sphere against a starry
background.

Set up a simple cross fade between two images:

Sometimes you want to transition from one view or animation to another.
This set of steps with show you how to set up a cross fade from one image to
another. For this example the complete cross fade will occur over 20 frames
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displaying the first image for five frames, cross fade for ten frame and then
display the second image for the last five frames.

The resulting animation produced by this process could be used as an Image
Input Event for a different Video Post sequence.

1 Choose Rendering > Video Post.

2  Click Add Image Input Event on page 6613  and then click Files.

Choose your first image and click Open and then click OK to close the
Add Image Input Event dialog.

3  Click Add Image Input Event again and click Files.

Choose your second image and click Open and then click OK to close
the Add Image Input Event dialog.

4  Click Add Image Output Event on page 6627  and then click Files.

5 Set the output file format to MOV File and enter a filename like MyXFade.

Click Save when you've set the name and format

6 Click OK to accept the default setting on the Compression Settings dialog.

Then click OK to close the Add Image Output Event dialog.

7 Select the first Image Input Event and then hold down the Ctrl key while
selecting the second Image Input Event.

Both events will highlight in gold.

8  Click Add Image Layer Event on page 6623  and choose Cross Fade
Transition from the list of compositors and transitions.

Click OK to close the Add Image Layer Event dialog. Notice how the
Image Layer Event becomes the parent of the two Image Input Events.

9  Click Zoom Extents to view the entire set of tracks.

10 On the Queue track bar, click and drag the right-hand end of the range-bar
to frame 20.

This adjusts all the tracks.
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11 Select the Cross Fade Transition event and drag the left-hand end of the
range-bar to frame 5 and then drag the right-hand end of the range-bar
to frame 15.

This sets the period in time when the cross fade occurs.

12 Select the track for the first Image Input Event and the right-hand end
of the range-bar to frame 8.

By setting the end to frame 8 instead of 5, you'll have three frames during
which the first image will fade to black.

13 Select the track for the second Image Input Event and the left-hand end
of the range-bar to frame 12.

Similarly, setting this end to frame 12 ensures that the second image will
fade in over three frames and display in full color for the last five frame
of the transition.

14  Click the Execute Sequence button on page 6601 .

15 Click Render on the Execute Video Post dialog.

Example: Resize a series of images:

Perhaps you've rendered a series of still images but it turns out they were at
the wrong resolution. You might normally think you have to re-render the
entire scene again which will tie up all the systems to do the same work they
just completed. Video Post can be used to resize the images without having
to use all the systems.

1 Use the IFL Manager Utility on page 7136  to create an IFL file containing
the sequentially number image files you want to resize.
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2 Choose Rendering > Video Post.

3  Click Add Image Input Event on page 6613  and then click Files.

Choose the IFL file you created at step 1 and then click Open to close the
selection dialog.

4 Click OK to close the Add Input Image Event dialog.

5  Click Add Image Output Event on page 6627  and then click Files.

6 Set the output file format for the new set of still images to TGA and enter
a filename like MyResize.

Click Save when you've set the name and format

7 Click OK to accept the default setting on the Targa Image Control dialog.

Then click OK to close the Add Image Output Event dialog.

8  Click the Execute Sequence button on page 6601 .

9 On the Execute Video Post dialog, set the new output resolution you
want for the images and then click Render.

When the rendering is complete, you will have a new series of resized
images that have a name prefix of MyResize. So, if there were ten images
listed in the IFL file, there will be ten new images named MyResize0000.tga
through MyResize0009.tga stored in your image folder.
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Example: Composite two image sequences:

Compositing two sets of images together is one of the “workhorse” operations
of Video Post. This is commonly done when a project is nearing completion
and it lets you combine all the images your artists have been rendering.

1 Use the IFL Manager Utility on page 7136  to create an IFL file for each set
of images sequences you want to composite.

2 Choose Rendering > Video Post.

3  Click Add Image Input Event on page 6613  and then click Files.

Choose your first IFL file and click Open and then click OK to close the
Add Image Input Event dialog.

4  Click Add Image Input Event again and click Files.

Choose your second IFL file and click Open and then click OK to close
the Add Image Input Event dialog.

5  Click Add Image Output Event on page 6627  and then click Files.

6 Set the output file format to MOV File and enter a filename like
MyComposite.

Click Save when you've set the name and format

7 Click OK to accept the default setting on the Compression Settings dialog.

Then click OK to close the Add Image Output Event dialog.

8 Select the first Image Input Event and then hold down the Ctrl key while
selecting the second Image Input Event.

Both events will highlight in gold.

9  Click Add Image Layer Event on page 6623  and choose Alpha
Compositor on page 6707  from the list of compositors and transitions.

Click OK to close the Add Image Layer Event dialog. Notice how the
Image Layer Event becomes the parent of the two Image Input Events.

10  Click the Execute Sequence button on page 6601 .

11 Click Render on the Execute Video Post dialog.
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Example: Render a scene over an image sequence or an animation:

This process in similar to the last one except you might have an animation
or series of still images you want to use as the background for your existing
scene.

1 Use the IFL Manager Utility on page 7136  to create an IFL file for the set
of images that will be the background for your current scene.

2 Choose Rendering > Video Post.

3  Click Add Image Input Event on page 6613  and then click Files.

Choose your IFL file or animation and click Open and then click OK to
close the Add Image Input Event dialog.

4  Click Add Scene Event on page 6607  and set the view to Perspective
or a Camera you have in the scene.

Click OK to close the Add Scene Event dialog.

5  Click Add Image Output Event on page 6627  and then click Files.

6 Set the output file format to AVI File and enter a filename like MyScene.

Click Save when you've set the name and format

7 Select a codec on page 7740  from the Video Compression dialog and click
OK.

Then click OK to close the Add Image Output Event dialog.
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8 Select the first Image Input Event and then hold down the Ctrl key while
selecting the Scene Event.

Both events will highlight in gold.

9  Click Add Image Layer Event on page 6623  and choose Pseudo Alpha
on page 6709  from the list of compositors and transitions.

Click OK to close the Add Image Layer Event dialog. Notice how the
Image Layer Event becomes the parent of the two Image Input Events.

10  Click the Execute Sequence button on page 6601 .

11 Click Render on the Execute Video Post dialog.

Notice that the Image Input Event in this example is only ten frames
long. Normally, you'd choose a set of background images that equals the
number of frames in your scene. When this sequence is executed, as is,
the images in the IFL file will only appear for the first ten frames and
then disappear.

12 Select the Image Input Event just under the Pseudo Alpha layer event.

13  Add a Loop Event and set the number of times to 4.

The Image Input Event becomes further nested in the queue. If you want,
you can use the default Loop setting or change it to Ping Pong then click
OK to close the Add Loop Event dialog.

14  Click the Execute Sequence button again and render the scene.
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Join two animations—end to end:

If you're working in a production environment, you probably do not work on
an entire animation by yourself. Instead, you might work on one part while
other artists are working on other parts. At the end of the project, everyone's
animations need to be joined together.

1 Choose Rendering > Video Post.

2  Click Add Image Input Event on page 6613  and then click Files.

Choose your first animation file and click Open and then click OK to
close the Add Image Input Event dialog.

3  Click Add Image Input Event again and click Files.

Choose the next animation file and click Open and then click OK to close
the Add Image Input Event dialog.

4 Repeat the last step for any other animations that need to be joined.

5  Click Add Image Output Event on page 6627  and then click Files.

6 Set the output file format to MOV File and enter a filename like MyFinal.

Click Save when you've set the name and format

7 Click OK to accept the default setting on the Compression Settings dialog.

Then click OK to close the Add Image Output Event dialog.

Useful Video Post Procedures | 6591



8 Select the first Image Input Event and then hold down the Ctrl key while
selecting the second Image Input Event.

Both events will highlight in gold.

9  Click the Abut Selected button on page 6607 .

10 Repeat the last two step with subsequent Image Input Events.

11  Click Zoom Extents to view the entire set of tracks.

12 Select the Image Output Event and drag the right end of the range-bar
to match the total number of frames in the queue.

13  Click the Execute Sequence button on page 6601 .

14 Click Render on the Execute Video Post dialog.

Switch between views:

It's not often that a final scene shows views from only one viewpoint. Either
the camera moves or there are multiple cameras from which images are
rendered. This sequence shows you how to switch from one camera view to
another.

1 In the Perspective viewport, create a Box with a length of 15, a width of
30 and a height of 15.

2 In the Top viewport, create two Target Cameras pointing at the box from
different angles.
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3 Right-click the viewport label in the Left viewport and choose Views >
Camera01.

4 Right-click viewport label in the Perspective viewport and choose Views
> Camera02.

5 Choose Rendering > Video Post.

6  Click Add Scene Event on page 6607  and set the view to Camera01.

Click OK to close the Add Scene Event dialog.

7  Click Add Scene Event again and set the view to Camera02.

Click OK to close the Add Scene Event dialog.

8 Select the first Scene Event and then hold down the Ctrl key while
selecting the second Scene Event.

Both events will highlight in gold.

9  Click the Abut Selected button on page 6607 .

10 Click in an empty part of the queue to deselect the two Scene Events.

11  Click Add Image Output Event on page 6627  and then click Files.

12 Set the output file format to MOV File and enter a filename like MyViews.

Click Save when you've set the name and format

13 Click OK to accept the default setting on the Compression Settings dialog.

Then click OK to close the Add Image Output Event dialog.

14  Click the Execute Sequence button on page 6601 .

15 Click Render on the Execute Video Post dialog.
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Render a scene in reverse:

It's not commonly done but when you need to render a scene in reverse you
could spend hours trying to accomplish it. Video Post makes it easy.

1 Choose Rendering > Video Post.

2  Click Add Scene Event on page 6607  and set the view to Perspective
or a camera in the scene.

3 In the Scene Range group, turn off Lock To Video Post Range and set the
Scene Start value to the last frame of animation.

4 Turn off Lock Range Bar To Scene Range and set the Scene End value to
0.
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5 Click OK to close the Add Input Image Event dialog.

6  Click Add Image Output Event on page 6627  and then click Files.

7 Set the output file format to AVI File and enter a filename like MyReverse.

Click Save when you've set the name and format

8 Select a codec on page 7740  from the Video Compression dialog and click
OK.

Then click OK to close the Add Image Output Event dialog.

9  Click the Execute Sequence button on page 6601 .
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10 Click Render on the Execute Video Post dialog.

Video Post Toolbar
Rendering menu > Video Post toolbar

The Video Post Toolbar contains tools for handling Video Post files ( VPX files
on page 7967 ) and for managing the individual events displayed in the Video
Post queue and event tracks area.

New Sequence 

Rendering menu > Video Post > Video Post toolbar > New Sequence

The New Sequence button creates a new Video Post sequence by clearing
existing events from the queue.

You'll be prompted to confirm the deletion of any entries in the current queue.

Procedures

To create a new Video Post file:

■  Click New Sequence.
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WARNING This command erases all the current Video Post data.

Use New Sequence after you have saved to a different Video Post (VPX) file.
Choosing Video Post from the Rendering menu displays the Video Post data
(if any) saved with your 3ds Max scene.

Open Sequence 

Rendering menu > Video Post > Video Post toolbar > Open Sequence

The Open Sequence button opens a Video Post sequence stored on disk.

Video Post sequences contain all the information relating to the queue and
all associated settings and references. VPX files on page 7967  have the file
extension .vpx and are stored by default in the \3dsmax\vpost folder.

Procedures

To open an existing Video Post file:

■  Click Open Sequence.
Use the file selection dialog that appears to choose the VPX file you want
to execute or edit.

To import an existing Video Post sequence:

You can also use Open Sequence to import the Video Post queue from a 3ds
Max scene (MAX file).

1  Click Open Sequence.

2 On the Open Sequence dialog, change the Files Of Type setting to All
Files (*.*)

3 Browse to the folder where you store your MAX files.

4 Select the MAX file that contains the Video Post sequence you want to
execute or edit and click Open.

Video Post loads only the Video Post data from the existing .max file,
leaving your current scene unchanged.
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Save Sequence 

Rendering menu > Video Post > Video Post toolbar > Save Sequence

The Save Sequence button saves the current Video Post sequence to disk.

All of the Video Post configuration data, the queue events themselves, and
any queue event external data are saved in the MAX file. You can also save
the Video Post sequence to a separate file for sharing with other 3ds Max users.

Video Post sequence files contain all the information relating to the queue
and all associated settings and references. VPX files on page 7967  have the file
extension .vpx and are stored by default in the \3dsmax\vpost folder.

Procedures

To save the active Video Post data:

■  Click Save Sequence.
A file selection dialog appears to let you enter a name for the new Video
Post file.

By default, Save Sequence stores the VPX file to the \3dsmax\vpost
subdirectory. You can change the default path to another directory via the
Configure User Paths dialog > File I/O panel on page 7524 .

Edit Current Event 

Rendering menu > Video Post > Video Post window > Select an event. > Video
Post toolbar > Edit Current Event

The Edit Current Event button displays a dialog that lets you edit the properties
of the selected event. The dialog depends on the type of event you've selected.
The controls in the edit dialogs are the same as those in the dialog you use to
add that type of event.

The top field in each event dialog is an editable label field. If the field is left
blank, the event uses its assigned label. If you enter an event name, the Video
Post Queue displays your event name in the field.

You can edit the following types of events:
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Add Scene Event  on page 6607

Add Image Input Event  on page 6613

Add Image Filter Event  on page 6620

Add Image Layer Event  on page 6623

Add Image Output Event  on page 6627

Add External Event  on page 6630

Add Loop Event  on page 6633

Procedures

To edit an event in the queue, do one of the following:

1  Select the event and then click the Edit Current Event button.

2 Double-click the event name.

3 Double-click the event's range-bar area in the edit window.

Use the second or third method above withdisabled events.

Delete Current Event 

Rendering menu > Video Post > Video Post window > Select an event. > Video
Post toolbar > Delete Current Event

The Delete Current Event button deletes the selected event from the Video
Post Queue.

You'll be asked to confirm event deletion.

Procedures

To delete any event in the queue:

■  Select the event and press the Delete key.
You can delete both enabled and disabled events, which are unavailable.
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Swap Events 

Rendering menu > Video Post > Video Post window > Select two events. >
Video Post toolbar > Swap Events

The Swap Events button switches the position of two selected events in the
queue.

This is useful if you have images in the wrong order for compositing. The
background image has to be first and the foreground image with the alpha
channel on page 7709  has to be second.

Procedures

To switch the positions of two events in the queue:

1 Highlight both events.

2  Click Swap.

Swap Events might not be allowed if the result would be impossible to execute.

In this sample queue, the two top level events, Front and Fade, could be
swapped. You can almost always swap events at the top level.
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However, at lower levels, where events start getting nested, the output of a
lower level event must be valid input to its parent event. In the sample queue,
the output of the Loop Once event would not be recognized by the Fade event,
so the Swap Events button remains inactive and you cannot swap them.

Execute Sequence 

Rendering menu > Video Post > Video Post toolbar > Execute Sequence

You execute the Video Post queue as the final step in creating a post-produced
video. Execution is different from rendering because rendering is done for
scenes only and you can use Video Post to composite images and animations
without including the current 3ds Max scene.

Although the Execute Video Post controls are similar to those in the Render
Scene dialog, the setting are independent, and do not affect each other.

During execution, you can move or close the rendered frame window, but
you can't use the rest of 3ds Max until the execution is completed or cancelled.

The rendering time for the last rendered frame in the Video Post sequence is
displayed in the prompt line of the main 3ds Max window.

Procedures

To execute the queue:

1  Click Execute Sequence.

An Execute Video Post dialog appears.

2 Set the time range and output size, and then click Render to create the
video.

3 When execution is done, click Close to dismiss the Video Post progress
dialog if it is still open.
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Interface

Time Output group

Select the frames to execute:

Single Current frame only.

You can execute a single frame only if it falls within the current range.

Range All the frames between and including the two numbers.

Every Nth frame Regular sample of frames. For example, enter 8 to execute
every 8th frame.

Output Size group

Format Choose Custom or a standard film or video format from the list. For
Custom, you can set the aperture width of the camera, the rendering output
resolution, and the image aspect ratio or pixel aspect ratio. When you choose
a standard format, the aperture width and aspect ratios are locked, but you
can change the resolution.

Width/Height Specify the width and height of the image, in pixels. For
Custom, you can set these two spinners independently. For other formats,
the two spinners are locked to the specified aspect ratio, so changing one
changes the other.

Resolution Buttons Specifies a preset resolution. Right-click a button to
display a subdialog on page 6603  that lets you change the resolution specified
by that button.
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Image Aspect Sets the aspect ratio of the image. As you alter the Image
Aspect, you also alter the Height value to maintain the correct aspect ratio.
For standard formats, the image aspect ratio is locked, and this spinner is
replaced by a text display.

If you lock the Image Aspect (by clicking the Lock button), Width and Height
are locked to each other, so that changing one changes the other to maintain
the image aspect ratio, and changing the Pixel Aspect value changes the Height
value to maintain the image aspect ratio.

Pixel Aspect Sets the aspect ratio of the pixels of the image. For standard
formats, the pixel aspect ratio is determined by the format and this spinner
is replaced by a text display.

If you lock the pixel aspect ratio (by clicking the Lock button), the Pixel Aspect
spinner is replaced by a text display. The Lock button is available only for the
Custom format.

Output group

Keep Progress Dialog Forces the Video Post Progress dialog to remain
displayed when the Video Post sequence has finished executing. By default,
it closes automatically. If this option is selected, you must click the Close
button to close the dialog.

Rendered Frame Window Displays the Video Post execution in a window
on the screen.

Net Render Enables network rendering on page 7861 . If Net Render is turned
on, when you render you'll see the Network Job Assignment dialog on page
6279 .

Configure Presets

Rendering menu > Video Post > Video Post toolbar > Execute Sequence >
Right-click any Resolution button. > Configure Presets dialog

If you use the Custom format for Execute Sequence on page 6601 , you can
change the values for any preset resolution button by right-clicking the button.

If you use one of the standard formats, the Width and Height spinners are
locked to the standard's image aspect ratio, and the Aspect Ratio spinner is
replaced by a text display.

After you change these values and exit the Configure Presets dialog, you must
click the button to apply the new values to the Execute Sequence dialog.
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Interface

Width Specifies the width of the image, in pixels.

Height Specifies the height of the image, in pixels.

Aspect Ratio Sets the aspect ratio of the image. As you alter the Image Aspect
value, you also alter the Height value so that the correct aspect ratio is
maintained for the resolution.

Edit Range Bar 

Rendering menu > Video Post > Video Post toolbar > Edit Range Bar

The Edit Range Bar provides editing functions for the range bars that appear
in the event tracks area.

When Edit Range Bar is on, you can:

■ Select any event by clicking its range bar (it turns red when selected).

■ Move the range bar while maintaining its range by dragging in the middle
of the bar.

■ Change the start or end frame of the range by dragging either end of its
bar.

Procedures

To select a range bar, do one of the following:

1 Click the range bar in the event tracks area.

2 Click the associated event name or icon in the queue.
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To select multiple range bars:

1 Click a range bar.

2 Hold down Ctrl and click additional range bars.

To select multiple contiguous range bars:

1 Click a range bar.

2 Hold down Shift and click another range bar.

Both range bars you clicked and all range bars between them, if any, are
selected.

NOTE In a multiple selection, the last range bar you select becomes the
current event, displayed with red squares in its endpoints. The align
commands use the current event.

To move a range bar:

■ Click and drag the center of the range bar left or right.

To change the length of a range bar:

■ Click and drag one of range bar's endpoints left or right.
If multiple range bars are selected, dragging one endpoint changes all
selected range bars.

To change the number of frames in an event:

1 Double-click the range bar in the event tracks area or select the event and
click the Edit Current Event button.

2 Change the VP Start Time or VP End Time values.

Align Selected Left 

Rendering menu > Video Post > Video Post window > Select two or more range
bars. > Video Post toolbar > Align Selected Left

The Align Selected Left button left-aligns two or more selected range bars.
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When you select two or more range bars, the last one selected is the current
event. The end boxes of the other events are white, while the end boxes of
the current event are red. When you click Align Selected Left, the current
event stays in place, and the remaining selected events are aligned to its left
end.

Procedures

To change the number of frames in an event, do one of the following:

1 Double-click the range bar in the event tracks area.

2 Click the Edit Current Event button in the toolbar.

Align Selected Right 

Rendering menu > Video Post > Video Post window > Select two or more range
bars. > Video Post toolbar > Align Selected Right

The Align Selected Right button right-aligns two or more selected range bars.

When you select two or more range bars, the last one selected is the current
event. The end boxes of the other events are white, while the end boxes of
the current event are red. When you click Align Selected Right, the current
event stays in place, and the remaining selected events are aligned to its right
end.

Procedures

To change the number of frames in an event, do one of the following:

1 Double-click the range bar in the event tracks area.

2 Click the Edit Current Event button in the toolbar.

Make Selected Same Size 

Rendering menu > Video Post > Video Post window > Select one or more
events. > Video Post toolbar > Make Selected Same Size
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The Make Selected Same Size button makes all selected events the same size
as the current event.

When you select two or more range bars, the last one selected is the current
event. The end boxes of the other events are white, while the end boxes of
the current event are red. When you click Make Selected Same Size, the current
event stays in place, and the remaining selected events are expand or shrink
to cover the same number of frames.

Procedures

To change the number of frames in an event, do one of the following:

1 Double-click the range bar in the event tracks area.

2 Click the Edit Current Event button in the toolbar.

Abut Selected 

Rendering menu > Video Post > Video Post window > Select events in the
queue. > Video Post toolbar > Abut Selected

The Abut Selected button places the selected events end-to-end, so that when
one ends the next one starts.

The selected events are placed end-to-end according to their order in the
queue.

Add Scene Event 

Rendering menu > Video Post > Video Post window > Make sure no events
are selected in the queue. > Video Post toolbar > Add Scene

Rendering menu > Video Post > Video Post window > Select a scene from the
Video Post Queue. > Video Post toolbar > Edit Current Event

The Add Scene Event button adds the scene in the selected camera viewport
to the queue. A Scene event is a view of the current 3ds Max scene. You can
choose which view to display and how to synchronize the scene with the final
video. Like Image Input events, Scene events place an image in the queue, but
a Scene event is the current 3ds Max scene and it must be rendered when you
execute the Video Post queue. The scene is rendered exactly as it would be by
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the scanline renderer on page 7918 , with the additional options listed below.
The resulting scene image has an alpha channel on page 7709 .

You can use multiple Scene events to show two views of the same scene
simultaneously or to cut from one view to another. If you have more than
one Scene event in the queue, and they occupy the same time range, composite
them with an Image Layer event on page 6623  such as Cross Fade or Simple
Wipe. Otherwise, the second Scene Event overwrites the first even though
your system has spent the time processing both events.

Procedures

To add a Scene event:

1 Make sure no events are selected in the queue.

2  Click Add Scene.

An Add Scene Event dialog appears.

3 Choose a view to use from the View list.

4 Click Render Options to change rendering settings from the way you
have set them in the Render Scene dialog.

NOTE Unlike settings in the Execute Video Post dialog, changes you make
to the Scene event rendering options change the settings in the Render Scene
dialog, and vice versa.

5 Set the Scene Range options and click OK.

The Scene event appears at the end of the queue.

To match the scene's frames with Video Post frames:

■ Make sure Lock To Video Post Range is selected.
Lock To Video Post Range is the default. Frames in the scene match Video
Post frames and have the same frame number. That is, frame 0 in the scene
is frame 0 in the Video Post dialog, frame 15 in the scene is frame 15 in
Video Post, and so on. The range bar for the Scene event represents which
portion of the scene is selected. If the range bar covers Video Post frames
25 to 35, executing the queue renders scene frames 25 to 35. Moving the
range bar for the scene is like moving a time window within the scene.

Other Scene Range options are disabled when Lock To Video Post Range
is selected.
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To offset the scene in time:

■ Select Lock Range Bar To Scene Range.
The Scene Start control is enabled but the Scene End control remains
disabled: synchronization is controlled by the Scene Start value and the
length of the range bar.

The Scene Start value is the scene frame number where playback begins.
If Scene Start is 0, frame 0 of the scene is the first frame played back; if
Scene Start is 12, frame 12 is the first frame to play, and so on.

The range bar length determines how many frames of the scene to play.
Dragging the end point of the range bar changes the length of the playback
range. Although Scene End is unavailable, its value updates to show the
frame number of the last scene frame that will be played.

Dragging the range bar changes where the scene is played within the final
video. For example, if you set Scene Start to 5 and move the range bar to
begin at Video Post frame 20, frame 5 is played at frame 20 of the final
video, and so on.

To offset the scene and change scene playback rate:

■ Turn off Lock Range Bar To Scene Range.
With Lock Range Bar to Scene Range off, both Scene Start and Scene End
are enabled. As before, Scene Start specifies the first scene frame to play.
Scene End specifies the last scene frame to play, and the length of the range
bar determines playback speed.

If the range bar specifies the same number of Video Post frames as there
are corresponding scene frames, then playback is at the scene's playback
rate. If the range bar specifies fewer frames, the scene is sped up. If the
range bar specifies more frames, the scene is slowed down. When it
executes, Video Post automatically skips frames or adds frames to control
the speed of scene playback.

For example, if Scene Start is frame 5 and Scene End is frame 35, the range
bar represents 30 frames overall. If the range bar covers only 10 Video Post
frames, scene playback is sped up to fit 30 frames into 10 of the final video.
If on the other hand, the range bar covers 120 frames, scene playback is
stretched to slow it down.

To render the full scene backwards:

1 Turn off Lock To Video Post Range.

2 Turn off Lock Range Bar To Scene Range.
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3 Set Scene Start to the last frame in the scene.

4 Set Scene End to the first frame in the scene.

The length of the range bar also determines the playback speed of the
reversed scene.

To add scene motion blur:

1 Select Scene Motion Blur in the Scene Event dialog.

2 Set the scene motion blur parameters.

The Scene event generates motion blur by simulating a camera with an
open shutter. It interpolates and then renders movement within a frame,
to generate a series of images of the moving object, instead of the default
single image.

Interface

The Add Scene Event and Edit Scene Event dialogs have the same controls.
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View group

Label Lets you edit the event name. A unique name can make the scene
event easier to distinguish in a long list of events.

Viewport Select the viewport you want to render.

Scene Options group

Enables various rendering effects.

Render Options Displays a subset of the parameters in the Render Scene
dialog. For information on these controls, see the Common Parameters Rollout
(Render Scene Dialog) on page 5929  and Default Scanline Renderer Rollout on
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page 5949  help topics. Changes you make to the Scene Event Render Options
affect the Render Scene dialog, as well.

Scene Motion Blur Turns on the scene motion-blur on page 7919  effect for
the whole scene. This is different from object motion blur on page 7867 , which
creates motion blur for individual objects in the scene.

Scenes created with previous versions of 3ds Max that use both Object Motion
Blur and Scene Motion Blur may not render correctly, due to changes to Object
Motion Blur. Execute some test frames and adjust your blur settings if needed.

When you render with Scene Motion Blur activated, the Render Progress dialog
tells you which subsample is being rendered. The information appears in
parentheses to the right of the "Rendering Image" text. For example:

Duration Sets the virtual shutter speed for motion blur. When it's set to 1.0,
the virtual shutter is open for the entire duration between one frame and the
next. When it's set to a smaller number (for example, 0.25), the number of
subdivisions specified in the Duration Subdivision field will be rendered within
the specified portion of the frame (in this example, in the first .25 of the
duration between one frame and the next).

Duration Subdivision Determines how many sub-frame slices are rendered
within the Duration. The default is 2 slices, but you'll want at least 5 or 6 to
get a decent effect.

Dither % Sets the amount of dithering on page 7760  between blurred pixels
of overlapping frame slices. If Dither % is set to 0, no dithering occurs.

Scene Range group

Scene Start/End Sets the range of scene frames to be rendered.

Lock Range Bar to Scene Range Becomes available when you deselect Lock
To Video Post Range. When it's available, the End spinner is disabled and
locked to the Video Post range. When you change the Start spinner it
automatically updates the End spinner based on the Video Post range set for
this event.

If you turn off Lock Range Bar To Scene Range, you can change either Start
or End spinners to whatever you want. This allows you to keep your scene
range locked to its native length, and still provides flexibility for mapping an
arbitrary scene range to an arbitrary Video Post range.

Lock to Video Post Range Renders the same range of scene frames as Video
Post frames. You can set the Video Post range in the Execute Video Post dialog.
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Video Post Parameters group

VP Start Time/End Time Sets the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When this box is clear, the event is
disabled and Video Post ignores it when rendering the queue. Each event must
be disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Add Image Input Event 

Rendering menu > Video Post > Video Post window > Make sure no events
are selected in the queue. > Video Post toolbar > Add Image Input Event

Rendering menu > Video Post > Video Post window > Select an Image Input
Event. > Video Post toolbar > Edit Current Event

The Add Image Input Event adds a still or moving image to the scene. Image
Input events place an image in the queue, but unlike Scene events, the image
is either a file that was saved beforehand or a device-generated image.

The image can be in one of the following file formats:

AVI Files on page 7118

BMP Files on page 7120

CIN (Kodak Cineon) Files on page 7120

CWS (Combustion Workspace) Files on page 7121

GIF Files on page 7126

HDRI Files on page 7126

IFL Files on page 7131

MOV (QuickTime Movie) Files on page 7140

MPEG Files on page 7140

JPEG Files on page 7139

PNG Files on page 7152
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PSD Files on page 7153

RLA Files on page 7156

RPF Files on page 7159

RGB (SGI Image) Files on page 7161

TGA (Targa) Files on page 7162

TIFF Files on page 7164

YUV Files on page 7166

DDS Files on page 7122

Procedures

To add an Image Input event:

1 Make sure no events are selected in the queue.

2  Click Add Image Input Event.

An Add Image Input Event dialog appears.

3 Click Files to choose a bitmap or animation as the image, or click Devices
to choose an image-generating device.

If you click Files, a file dialog appears to let you choose the bitmap or
animation file.

If you choose Devices, a Select Image Input Device dialog appears. This
dialog has a list of installed device options.

4 Click Options to choose the size and placement of the image in the final
video frames.

An Image Input Options dialog appears.

5 Adjust other Image Input settings, and then click OK.

The Image Input event appears at the end of the queue.

TIP Think of images that share the same time range as layers, comparable
to matted film images in a compositor. Images that share a time range must
be composited with an Image Layer event on page 6623 ; otherwise, the second
image in the queue "overwrites" the first.
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To align the input image, do one of the following in the Image Input Options
dialog:

1 Choose Presets and then click one of the preset alignment buttons.

2 Choose Coordinates and then enter the X,Y coordinates for the image's
location.

The upper-left corner is (0,0) for both the input image and the output
frame. Increasing X moves the image to the right, and increasing Y moves
the image down. Negative values move the image in the opposite
direction. X and Y values specify pixels.

To set the input image size, do one of the following in the Image Input
Options dialog:

1 Choose Do Not Resize to maintain the image's original resolution.

2 Choose Resize To Fit to change the image size to match the output frame.

This can change the image resolution, causing it to be rescaled for every
frame.

3 Choose Custom Size and then enter the width and height of the image
in the output frame.

To control playback of an animated image:

1 In the Frames group of the Image Input Options dialog on page 6617 , set
the input animation frame range and speed.

2 Turn on Loop At The End if you want the animation to repeat. Turn off
Loop At The End if you want the animation to stop after playback.

This option applies only when the input animation is shorter than the
final video.

Interface

The Add Image Input Event and Edit Image Input Event dialogs have the same
controls.
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Image Input group

Label Lets you give the event a unique name. A unique name can make the
image event easier to distinguish in a long list of events.

Files Lets you choose the bitmap or animation image file.

Devices Lets you choose an installed hardware input device; for example, a
digital disk recorder.

Options Displays the Image Input Options dialog on page 6617  to allow you
to set up alignment, size, and frame range for the input image.

Cache Stores a bitmap in memory. If you are using a single-image bitmap,
you can choose this option. Video Post won't reload or scale the image for
each frame.

Image Driver group

These buttons are available only when you choose a device as the image source.

About Provides information on the source of the image-handler software
used to bring the image into 3ds Max.
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Setup Displays a setup dialog specific to the plug-in. Some plug-ins might
not use this button.

Video Post Parameters group

VP Start Time/End Time Sets the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When this box is off, the event is
disabled and Video Post ignores it when rendering the queue. Each event must
be disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Image Input Options

Rendering menu > Video Post > Video Post window > Make sure no events
are selected in the queue. > Video Post toolbar > Add Image Input Event >
Select a file for input. > Options

The Image Input Options dialog contains controls for setting the image's size
and placement relative to the frames of video output. For animated input,
you also use it to synchronize the Image Input event with the frame sequence
of video output. The same dialog appears when you click Options from the
Mask area of the Filter Event and Layer Event dialogs.

Procedures

To align the input image, do one of the following in the Image Input Options
dialog:

1 Choose Presets and then click one of the preset alignment buttons.

2 Choose Coordinates and then enter the X,Y coordinates for the image's
location.

The upper-left corner is (0,0) for both the input image and the output
frame. Increasing X moves the image to the right, and increasing Y moves
the image down. Negative values move the image in the opposite
direction. X and Y values specify pixels.
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To set the input image size, do one of the following in the Image Input
Options dialog:

1 Choose Do Not Resize to maintain the image's original resolution.

2 Choose Resize to Fit to change the image size to match the output frame.

This can change the image resolution, causing it to be rescaled for every
frame.

3 Choose Custom Size and then enter the width and height of the image
in the output frame.

To control playback of an animated image:

1 In the Frames group, set the From, To and Step values.

2 Select Loop at the End if you want the animation to repeat. Clear Loop
at the End if you want the animation to stop after playback.

This option applies only when the input animation is shorter than the
final video.
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Interface

Alignment group

Presets Positions the image according to one of the preset buttons: Top-left,
Center, Top-right, and so on. Mutually exclusive with Coordinates.

Coordinates Positions the image according to coordinates you enter. Mutually
exclusive with Presets.

Size group

Do Not Resize Retains the image's original, stored dimensions.

Resize to Fit Resizes the image to the size of the Video Post rendered image
(default).

Custom Size Resizes the image according to width and height units you
enter.
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Frames group

From/To Specifies the range of frames to use if the image input file is an
animation or video.

Step Sets the interval between the frames you want to use. For example, if
this spinner is set to 7, 3ds Max uses every seventh frame.

Loop at End Plays the frames from the beginning when the last frame is
reached. This will take effect if the frame range used is less than the Video
Post frame range.

Add Image Filter Event 

Rendering menu > Video Post > Video Post window > Make sure no events
are selected in the queue. > Video Post toolbar > Add Image Filter Event

Rendering menu > Video Post > Video Post window > Select a filter from the
Video Post Queue. > Video Post toolbar > Edit Current Event

The Add Image Filter Event provides image processing for images and scenes.
Several kinds of image filters are provided, see list below. For example, the
Negative filter inverts the colors of an image and the Fade filter fades an image
in or out over time.

An Image Filter event is usually a parent event with a single child (which can
itself be a parent with children), for example, a Scene event, an Image Input
event, a Layer event that contains Scene or Image Input events, or a Filter
event that contains Scene or Image Input events. You can also add an Image
Filter without a child event, in which case the Image Filter processes the result
of the previous events in the queue.

Available Image Filters

Contrast Filter on page 6636

Fade Filter on page 6637

Image Alpha Filter on page 6638

Lens Effects Filters on page 6639

Negative Filter on page 6640

Pseudo Alpha Filter on page 6641

Simple Wipe Filter on page 6642
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Starfield Filter on page 6643

Procedures

To add an image filter event:

1 Either select a valid child event, or make sure no event is selected in the
queue.

2  Click Add Image Filter Event.

An Add Image Filter Event dialog appears.

3 Choose the kind of filter you want from the Filter Plug-In list.

4 If the Setup button is enabled for this kind of filter, click Setup to set the
filter options.

5 Choose a mask if you want the filter to be masked or if the kind of filter
you're using requires it.

6 Adjust other Image Filter settings, and then click OK.

If you selected a child event, the Image Filter event becomes its parent.
If no event was selected, the Image Filter event appears at the end of the
queue.

To choose the mask file:

1 Click Files.

2 Use the file dialog to choose the mask file, and then click OK.

3 Choose the channel to use from the drop-down list of channels.

To position or resize the mask:

■ Click Options.
An Image Input Options dialog appears, identical to the dialog you use
with Image Input events.

If the mask is animated, you also use this dialog to specify its time range
and playback speed.
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Interface

The Add Image Filter Event and Edit Filter Event dialogs have the same
controls.

Filter Plug-In group

Label Lets you give the event a unique name. A unique name can make the
filter event easier to distinguish in a long list of events.

Filter List Lists the filter plug-ins on page 7896  you have installed.

See the separate help topics for a description of the filters that come with 3ds
Max by clicking any of the filters listed above.

About Provides version and source information specific to the plug-in.

Setup Displays a setup dialog specific to the plug-in. Some plug-ins might
not use this button.
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Mask group

Channels If you are using a bitmap as the mask file, you can use the Alpha
channel, the Red, Green, or Blue channel, Luminance, Z-Buffer, Material
Effects, or Object ID.

Files Select a file to use as a mask. The name of the selected file appears above
the Files button.

Options Displays an Image Input Options dialog on page 6617  where you
can set alignment and size, relative to the frames of video output. For animated
images, you can also synchronize the mask with the frame sequence of video
output. This is the same dialog used for Image Input Event options.

Enabled Enables the mask. If turned off, Video Post ignores any other mask
settings.

Inverted When turned on, the mask is inverted.

Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Add Image Layer Event 

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer EventRendering menu
> Video Post > Video Post window > Select a Layer Event. > Video Post toolbar
> Edit Current Event

The Add Image Layer Event adds a compositing plug-in on page 7896  to layer
the selected images in the queue.

Provides compositing plug-ins that use the previous event in the queue as a
source, and composite the next event, using the parameters of the plug-in
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compositor. The list might include plug-ins for special transformations, such
as wipes, etc.

An Image layer event is always a parent event with two children. The children
can themselves be parents with children. The children of an Image Layer event
can be Scene events, Image Input events, Layer events that contain Scene or
Image Input events, or Filter events that contain Scene or Image Input events.

Available Image Layer Event Filters

Alpha Compositor on page 6707

Cross Fade Compositor on page 6708

Pseudo Alpha Compositor on page 6709

Simple Additive Compositor on page 6710

Simple Wipe Compositor on page 6711

Procedures

To add an image layer event:

1 Make sure the two child events are in the order you want the Image Layer
event to use them.

2 Select the two events.

Click to select the first event, then hold Ctrl and click to select the second.

3  Click Add Image Layer Event.

An Add Image Layer Event dialog appears.

4 Choose the kind of layer event you want from the Layer Plug-In
drop-down list.

5 If the Setup button is enabled for this kind of layer event, click Setup to
set the options.

6 Choose a mask if you want the layer event to be masked.

7 Adjust other Image Layer settings, and then click OK.

The Image Layer event becomes the parent of the two child events you
selected.
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To choose the mask file:

1 Click Files.

2 Use the file dialog to choose the mask file, and then click OK.

3 Choose the channel to use from the drop-down list of channels.

To position or resize the mask:

■ Click Options.
An Image Input Options dialog appears, identical to the dialog you use
with Image Input events.

If the mask is animated, you also use this dialog to specify its time range
and playback speed.

Interface

The Add Layer Image Event and Edit Layer Event dialogs have the same
controls.
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Layer Plug-In group

Label Lets you give the event a unique name. A unique name can make it
easier to distinguish the layer event in a long list of events.

Layer List Selects the compositor 3ds Max uses for layering the rendered
images in the queue. Alpha is the default compositor, but you can also choose
from any others you have installed. See the separate help topics for descriptions
of the compositors that come with 3ds Max.

About Provides version or source information specific to the plug-in on
page 7896 .

Setup Displays a setup dialog specific to the plug-in. Some plug-ins might
not use this button.

Mask group

Channels If you are using a bitmap as the mask file, you can use the Alpha
channel, the Red, Green, or Blue channel, Luminance, Z-Buffer or Material
Effects channel, or Object ID.

Files Select a file to use as a mask. The name of the selected file appears above
the Files button.

Options Displays the Image Input Options dialog on page 6617  where you
can set alignment and size, relative to the frames of video output. For animated
images, you can also synchronize the mask with the frame sequence of video
output. This is the same dialog used for Image Input Event options.

Enabled Enables the mask. If turned off, Video Post ignores any other mask
settings.

Inverted When turned on, the mask is inverted.

Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.
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Add Image Output Event 

Rendering menu > Video Post > Video Post toolbar > Add Image Output Event

Rendering menu > Video Post > Video Post window > Select an Image Output
event. > Video Post toolbar > Edit Current Event

The Add Image Output Event provides controls for editing an output image
event.

Image Output events send the result of executing the Video Post queue to a
file or a device. You must add an Image Output event to the end of the queue
if you want to save the final video. Otherwise, the results are displayed in the
rendered frame window only. The Image Output event's range bar must include
the entire range of frames you want to output.

The rendered output can be a still image or an animation, in one of the
following file formats:

AVI Files on page 7118

BMP Files on page 7120

CIN (Kodak Cineon) Files on page 7120

EPS and PS (Encapsulated PostScript) Files on page 7124

HDRI Files on page 7126

JPEG Files on page 7139

PNG Files on page 7152

MOV (QuickTime Movie) Files on page 7140

RLA Files on page 7156

RPF Files on page 7159

RGB (SGI Image) Files on page 7161

TGA (Targa) Files on page 7162

TIFF Files on page 7164

You also have the option to direct the output to a VTR controller output
device. If you have multiple output image events, you can output to different
devices. This lets you monitor your queue with VTR output devices and view
your output at any level of the Video Post queue during rendering.
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Procedures

To add an image output event:

1  Click Add Image Output Event.

Image Output disregards whether any events in the queue are selected
or not.

2 Click Files to save the final video in a file, or Devices to send the video
to a device.

If you click Files, a file dialog appears to let you choose the bitmap or
animation file.

If you choose Devices, a Select Image Output Device dialog appears. This
dialog has a drop-down list of installed device options.

3 Adjust other parameters, and then click OK.

The Image Output Event appears at the end of the queue.

If you choose a device, its configuration controls are enabled:

Interface

The Add Image Output Event and Edit Output Image Event dialogs have the
same controls.
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Image File group

Label Lets you give the event a unique name. A unique name can make it
easier to distinguish the output event in a long list of events.

Files Lets you choose the output image file and its format.

Devices Lets you choose the hardware output device; for example, a digital
video recorder. The device, its driver, and its 3ds Max plug-in must all be
installed on your system to use device output.

Image Driver group

The two buttons in this area are available only when you choose a device as
the image source.

About Provides information on the source of the image-handler software
used to create the image from 3ds Max.

Setup Displays device-specific setup options.
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Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Add External Event 

Rendering menu > Video Post > Video Post toolbar > Add External Event

Rendering menu > Video Post > Video Post window > Select an External event.
> Video Post toolbar > Edit Current Event

An External event is typically a program that performs image processing. It
can also be a batch file or utility that you want to run at a specific point in
the queue, or a way to transfer images from or to the Windows clipboard.

An External event is always a child event. If you select an event in the queue
before you add the External event, the External event becomes the selected
event's child. Child events are evaluated before their parents.

Procedures

To add an external event:

1 Select an event.

2  Click Add External Event.

An Add External Event dialog appears.

3 Click Browse.

A file dialog appears.

4 Use the file dialog to choose the external program you want to execute,
and then click OK.
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5 If the external program accepts command-line options, enter these in
the Command Line Options field.

6 If you want the external program to read the current Video Post image,
turn on Write Image To Clipboard.

7 If you want Video Post to use the result of the external program, turn on
Read Image From Clipboard.

8 Click OK.

If you selected an event, the External event becomes its child. If no event
was selected, the External event appears at the end of the queue.

WARNING The image that the External event reads from the clipboard is placed
in the Video Post queue. If the external program does not do what you want, this
can erase or overwrite the result of all Video Post post-processing.

Interface

The Add External Event and Edit External Event dialogs have the same controls.
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External Event group

Label Lets you give the event a unique name. A unique name can make the
external event easier to distinguish in a long list of events.

Browse Lets you select an external program. For example, you can specify
Adobe Photoshop™ or another image-processing application.
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Command-Line Options group

For external programs that accept command-line options, lets you send
real-time data to the external program. 3ds Max parses three special commands.
When found in a string, these commands are replaced with real-time data, as
follows:

■ %f is replaced with a 4-digit frame number (for example, 0001)

■ %w is replaced with a 4-digit image width (for example, 0640)

■ %h is replaced with a 4-digit image height (for example, 0480)

For example, if the given command-line option is:

-w%w -h%h -oframe%f.tga

The string sent to the external program might be:

-w0640 -h0480 -oframe0001.tga

Write image to clipboard When on, writes the current rendered image to
the Windows clipboard for retrieval by an external application.

Read image from clipboard When on, reads the contents of the Windows
clipboard after processing by the external application. When the processed
image is saved to the clipboard, it automatically appears in Video Post. With
an automated script, it is possible to run the image through any external image
processor and get it back automatically.

Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Add Loop Event 

Rendering menu > Video Post > Video Post toolbar > Add Loop Event
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Rendering menu > Video Post > Video Post window > Select a Loop event. >
Video Post toolbar > Edit Current Event

Loop events cause other events to repeat over time in the output video. They
control sequencing, but perform no image processing.

A Loop event is always a parent event with a single child. The child itself can
be a parent with children. Any type of event can be the child of a Loop event,
including another Loop event.

The Loop event's range bar displays the original duration of the child event's
playback in color and the range of looped events in gray. You can change the
duration of the child event's playback by dragging the child's frame range or
the child's original range in the Loop event's track, but you can adjust the full
length of the loop (the gray part of the range bar) only by changing the
Number of Times parameter in the Edit Loop Event dialog.

Procedures

To add a loop event:

1 Select the child event.

2  Click Add Loop Event.

An Add Loop Event dialog appears.

3 Choose the loop settings, and then click OK.

The Loop event appears as the parent of the selected event.

The Loop event repeats the child event over the course of the Loop event's
range.

Interface

The Add Loop Event and Edit Loop Event dialogs have the same controls.
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Order group

Label Lets you give the event a unique name. A unique name can make it
easier to distinguish the loop event in a long list of events.

■ Loop (The default.) Repeats the child event by starting it over when the
child event reaches the end of its range.

■ Ping Pong Repeats the child event by playing it first forward, then
backward, then forward, and so on. The last frame of the child event is
not repeated.

Number of Times group

Specifies the number of times to repeat the loop or ping pong, in addition to
the first time that the child event is played.
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Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Filter Events

Contrast Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Contrast Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Contrast Filter.
> Video Post toolbar > Edit Current Event > Setup

The Contrast filter allows you to adjust the contrast and brightness of an
image.

Interface

Contrast Set the spinner between 0 and 1.0. This compresses or expands the
latitude between maximum black and maximum white by creating a 16-bit
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look-up table for any given gray value in the image. The computation of the
gray value depends on whether you select Absolute or Derived.

Brightness Set the spinner between 0 and 1.0. This increases or decreases all
color components (red, green, and blue).

Absolute/Derived Determines the computation of the gray value for Contrast.
Absolute uses the highest value of any of the color components. Derived uses
an average of the three color components.

Fade Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Fade Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Fade Filter. >
Video Post toolbar > Edit Current Event > Setup

The Fade filter fades an image in or out over time. The rate of the fade is
determined by the length of the Fade filter's time range.

Fade fades out to black or in from black, over time.
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Interface

In Fade in.

Out Fade out.

Image Alpha Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Image Alpha Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select an Alpha Filter.
> Video Post toolbar > Edit Current Event

The Image Alpha filter replaces the image's alpha channel with the channel
specified by the filter mask.

The filter takes whatever channel is selected in the channel options under
Mask (including g-buffer on page 7795  channel data) and applies it to the
queue's alpha channel, thereby replacing what's there.

If you don't choose a mask, this filter has no effect.

There are no setup options for this filter.

Procedures

To set an object's G-Buffer ID:

1 Select the object.

2 Right-click the object and then choose Properties on page 245  from the
popup menu.

3 In the Object Properties dialog, set G-Buffer Object Channel to a nonzero
value, and then click OK.
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The G-Buffer ID can be any positive integer.

If you give the same G-Buffer ID value to more than one object, all these
objects will be post-processed.

Lens Effects Filters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose a Lens Effects Filter from the Filter Plug-In list.

The Lens Effects filters add realistic camera flares, glows, gleams, glimmers,
and depth-of-field blurring to your scenes. Lens Effects can affect an entire
scene or can be generated around specific objects in your scene.

Lens Effects are applied through the Video Post interface. To learn about
adding scene and image filter events to the video post queue, see Add Scene
Event on page 6607 , and Add Image Filter Event on page 6620 .

Lens Effects includes the following filters:

■ Lens Effects Flare on page 6648 : Creates the optical effect that occurs when
a bright light reflects across the lens of a camera.

■ Lens Effects Focus on page 6670 : Creates a blur on objects based on their
distance from the camera. tracks an object’s distance from the camera
using a Z-Buffer. Focus uses the Z-Buffer information from the scene to
create its blurring effects.

■ Lens Effects Glow on page 6673 : Creates a glowing light around any assigned
object, such as a laser beam or the thruster on a space ship.

■ Lens Effects Highlight on page 6685 : Creates a bright cross star effect on a
designated object.

WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 7967 . To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

Procedures

Len Effects like Glow and Highlight can be set to affect specific objects in your
scene based on their G-Buffer ID on page 7795 . This lets you apply glows and
highlights to the object, or to the material, or both.
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To set an object's G-Buffer ID:

1 Select the object.

2 Right-click the object and then choose Properties from the quad menu.

3 In the Object Properties dialog, set G-Buffer Object Channel to a non-zero
value, and then click OK.

The G-Buffer ID can be any positive integer.

If you give the same G-Buffer ID value to more than one object, all these
objects will be post-processed.

Negative Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Negative Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Negative Filter.
> Video Post toolbar > Edit Current Event > Setup

The Negative filter inverts the colors in the image, making it negative like a
negative color photograph.

Effect of negative filter

When you click the Setup button in the Edit Filter Event dialog for the Negative
filter, the Video Post dialog is replaced by a modeless Negative Filter dialog
with a Blend spinner. You can turn on Auto Key, move the time slider, and
change the Blend value to create keys. (You can also use other 3ds Max
functions; for example, you can create objects.) When you've set all the keys
you want, click the OK button to return to Video Post.
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After creating keys from the Video Post filter, you'll find the track for the new
keys as a child of the Video Post track in the Track View – Curve Editor.
Specifically, in the above example, you'll find the following hierarchy in the
Curve Editor:

Interface

Blend Sets the amount of blending that occurs.

Pseudo Alpha Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Pseudo Alpha Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Contrast Filter.
> Video Post toolbar > Edit Current Event

The Edit Pseudo Alpha filter creates an alpha channel for the image based on
the image's first pixel (the upper-left corner pixel). All pixels that have the
same color as this pixel become transparent.
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Because only one pixel color becomes clear, edges of the opaque areas are
aliased. The main use for this filter is when you want to composite a bitmap
whose format does not have an alpha channel.

There is also a layer event called the Pseudo Alpha Compositor on page 6709 .

There are no setup options for this filter.

Simple Wipe Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Simple Wipe Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Simple Wipe
Filter. > Video Post toolbar > Edit Current Event > Setup

The Simple Wipe filter reveals or erases the foreground image with a wipe
transition. Unlike the Wipe Layer compositor on page 6711 , Wipe Filter wipes
across a fixed image.

Wipe reveals an image by wiping from one side to the other, over time.

This filter wipes from image to image (or from an image to black). The filtered
image stays in place, but is revealed or erased with a wipe across the image.
If you're using a Wipe as a filter event, you'll usually want to use an Alpha
Compositor as a layer event as well.

A typical queue sequence would be: Alpha Compositor (layer)

-->Image #1

-->Simple Wipe (filter)

------>Image #2
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The rate of the wipe is determined by the length of the Wipe filter's time range.
The area not covered by the image renders as black unless you use an Image
Layer event to composite the Wipe filter with another image.

Interface

Direction group

Right-pointing arrow Wipes from left to right.

Left-pointing arrow Wipes from right to left.

Mode group

Push Reveals the image.

Pop Erases the image.

Starfield Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Starfield Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Starfield Filter.
> Video Post toolbar > Edit Current Event > Setup

The Starfield filter generates a realistic starfield with optional motion blur.
The Starfield filter requires a camera view. Any motion of the stars is a result
of camera motion.
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Procedures

To use the Starfield filter:

1 Create a camera and (optionally) animate the camera's or target's position,
field of view, and roll.

2 Choose Rendering > Video Post and add a Scene Event, using the camera
for the view.

3  Select the Scene Event in the queue, click Add Image Filter, select
the Starfield filter, and click the Setup button.

4 In the Stars Control dialog, make sure that the selected camera matches
the camera used in the Scene Event.

If these don't match, the stars will not match the camera's motion. If
there is only one camera in the scene, the field will default to that camera.

5 Set the starfield parameters, then exit the Stars Control dialog and the
Edit Filter Event dialog.

6 Execute the Video Post sequence to see stars.

6644 | Chapter 20   Video Post



Interface

Source Camera group

Source Camera Lets you choose from a list of cameras in the scene. Choose
the same camera as the one being used to render the scene.

General group

Set the brightness range and size of the stars.

Dimmest Star Specifies the dimmest star. Range = 0 to 255.

Brightest Star Specifies the brightest star. Range = 0 to 255.

Linear/Logarithmic Specifies whether the range of brightness is calculated
linearly or logarithmically.
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Star Size (Pixels) Specifies the size of the stars, in pixels. Range = 0.001 to
100.

Motion Blur group

These settings control the streaking effect of the stars when the camera moves.

Use When on, the starfield uses motion blur. When off, the stars appear as
dots, no matter what the camera's motion.

Amount The percentage of the frame time that the camera "shutter" is open.
Default = 75%.

Dimming Determines how the streaked stars will dim as their trails lengthen.
The default of 40 provides a good effect for video, dimming them a bit so they
don't appear to flash.

Star Database group

These settings specify the number of stars in the starfield.

■ Random Generates the number of stars indicated by the Count spinner,
using the random number Seed to initialize the random number generator.
Seed Initializes the random number generator. By using the same Seed
value in different animations, you're guaranteed identical starfields.

Count Specifies the number of stars generated when Random is chosen.

■ Custom Reads the file specified. A provided star database, earth.stb,
contains the brightest stars in Earth's sky.

Compositing group

■ Background (The default.) Composites the stars in the background.

■ Foreground Composites the stars in the foreground.
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Lens Effects Filters

Animating Lens Effects Properties

Lens Effects lets you use Track View to control parameters which can be
animated while Video Post remains open. Any parameter with a green arrow
button next to it can be animated.

When the Auto Key button is selected, the associated spinner or variable is
displayed in Track View and can be animated. If it is not selected, the green
button turns gray to indicate the parameter can no longer be animated.

There are two ways to set Lens Effects parameters for use in animation:

■ Enable the Auto Key button, set the frame in which you want to create a
key, and set the value.

■ Use Track View.

Using Track View

To use Track View with Lens Effects, one of the Lens Effects dialogs for a
particular filter must be open when you start Track View.

NOTE If you open Track View without one of the Lens Effects dialogs being open,
the first Lens Effects object does not appear in the Track View List. If you have
more than one Lens Effects object in the scene, you will see multiple Lens Effects
objects in Track View.

When Track View is open, the Lens Effects filters you have applied are listed
under Video Post on the left side of the Track View interface. Under each filter
are the parameters which can be animated. These are displayed individually.
You can animate only the parameters you need to.

When viewing Gradients in Track View, notice that the first two flags have
only a color track associated with them. This is because they are the start and
end points of the gradient and never move. Any flags created after the first
two will also have a position track associated with them. This means that you
can animate not only the color of any flag in any gradient, but also its position
over time as well.
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If you disable the animation capabilities for a particular lens flare parameter,
the corresponding entry in Track View immediately disappears. For more
information, see Track View on page 3426 .

WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 7967 . To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

Lens Effects Flare Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup

The Lens Effects Flare dialog lets you add lens flare effects as a post process to
rendering. Flares are usually applied to lights in your scene. The lens flare will
then be generated around that object. You can control all aspects of the lens
flare in the Lens Effects Flare dialog.

Procedures

To save your flare settings, do one of the following:

You can save all of your lens flare settings to a file, so you can reload them
any time. Lens Effects Flare files are saved to an LZF file on page 7833  (.lzf).

1 Click the Reset button.

This resets Lens Effects Flare to its default settings.

2 Click the Load button.

This displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

3 Click the Save button.

This displays a Windows-standard Save As dialog in which you specify a
directory and filename.

6648 | Chapter 20   Video Post



Interface

Preview group

The large black window in the left corner is the main preview window. To the
right of this window are smaller preview windows for each part of the flare.
You can generate continual previews by clicking the Preview button under
the main preview window.

There are nine Lens Effects Flare preview windows. The main preview window
in the upper left corner of the Lens Effects dialog shows you the complete
scene. The eight smaller preview windows in the upper right corner show the
individual parts of the lens flare. Each small preview window has a check box
below the window to display the flare effect.

You might notice that an individual part of the lens flare effect might not
appear as bright in the smaller preview windows, compared to the main
preview. This is because the brightness of a lens flare in the main preview is
a result of combining the brightness of multiple effects, the total brightness
being greater than a single part.

All of the preview windows are multi-threaded to increase redraw speed and
take advantage of multi-processor systems. When you make an adjustment
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to a lens flare property and the preview window is active, the preview updates
automatically. A white line at the bottom of the main preview window
indicates that it is updating a change made within the lens flare dialog.

Preview When you click the Preview button, the window displays your flare
in the upper left corner if your flare has automatic or manual secondary
elements. If your flare does not contain these elements, the flare is centered
in the preview window. If the VP Queue button is not on, the preview displays
a generic flare to which you can make adjustments. Each time you change a
setting, the preview automatically updates. A white line appears at the bottom
of the preview window to indicate the preview is updating.

Update Redraws the entire Main Preview window, as well as the smaller
windows each time you click this button. This function is critical when you
need to view changes you have made in the Video Post queue, such as moving
the Time Slider to a different frame, changing your geometry or a light, or
changing another filter that precedes the current one in the Video Post queue.
The VP Queue button must be on to preview the contents of the Video Post
queue. In this case, clicking the Update button causes a small dialog to appear,
with an indicator showing the progress of the update.

VP Queue Displays the contents of the Video Post queue in the main preview
window. The Preview button must also be turned on. Rather than having to
test render every time you want to see the result of the effect in the scene, VP
Queue displays a final composite, combining the effect you are editing with
the contents of the Video Post queue.

NOTE If you leave the Preview and VP Queue buttons active when you exit Lens
Effects Flare, it will take several seconds to re-render the scene in the main preview
window the next time you start Lens Effects Flare.

The view in the main preview window also depends upon which lens flare
options you have set in the Preferences panel on page 6653 .

Lens Flare Properties group

Specifies global settings for the flare, such as the source for the flare(s), the
size, seed number, rotation, and so on.

Seed Gives the random number generator in Lens Effects a different starting
point, which creates slightly different lens flares without changing any settings.
Using Seed guarantees a different lens flare, even if the differences are very
small. For example, if you set up a ray effect for your lens flare, you will get
slightly different rays in the lens flare if you adjust the seed value.
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Size Affects the size of the overall lens flare. This value is a percentage of
the size of the rendered frame. Default = 30.

Other parts of the lens flare, such as glow, ring, etc., also have size adjustments,
but this size setting affects the entire lens flare, including secondary flares.
Adjusting individual sizes does not affect this size variable, or vice versa. This
parameter can be animated on page 6647 . Animating the Size parameter causes
flares to grow or diminish in size over the course of your animation.

Hue If Apply Hue Globally is selected, it controls the amount of Hue applied
to the Lens Flare effect. This parameter can be animated.

Apply Hue Globally Globally applies the Hue of the Node Source to the other
Flare effects.

Angle Affects the amount that the flare rotates from its default position, as
the position of the flare changes relative to the camera. This parameter can
be animated. The lock button to the right of the Auto Key button locks the
secondary flares so they do rotate. When the button is disabled, the secondary
flares will not rotate.

Animating the Angle parameter does not animate the manual and automatic
secondary flares unless you turn on the L button. The default behavior mimics
a camera, in which the aperture does not rotate.

Rays, stars, and streaks don't animate either unless you turn on their individual
Auto Rotate toggles.

Intensity Controls the overall brightness and opacity of the flare. Higher
values produce bright, more opaque flares, and lower values produce dim,
transparent flares. This parameter can be animated.

Squeeze Squeezes the size of the lens flare, either horizontally or vertically
to compensate for different frame aspect ratios. You can set Squeeze from 100
to -100. Positive values stretch the flare horizontally, and negative values
stretch it vertically. The value is a percentage of the size of the flare. This
parameter can be animated.

For example, if you convert a film for use on TV, applying Squeeze would
cause the lens flare to look correct on the smaller screen, and not thin and
tall, although a wide-screen 35-MM film image is much wider than a regular
TV.

Although Squeeze is a global setting, you can apply this effect to selected
portions of your flare through the Preferences panel on page 6653  so that only
the flare elements you want are distorted. The Squeeze spinner value is given
as a percentage of the size of the flare.
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Node Sources Lets you select the source object for the lens flare effect. The
source of the lens flare may be any object in the scene, but is generally a light,
such as a target spot light, or an omni light. Clicking this button displays the
Select Flare Objects dialog. You must select a source for the flare to key off.

NOTE If you select a source object, then rename the object later, you must reselect
the object to ensure the correct generation of the lens flare.

Lens Flare Effects group

Controls specific effects for the flare, such as fades, brightness, softening, and
so on.

Brighten Lets you set an overall brightness that affects the whole image.
When a bright effect, such as a lens flare, appears in an image, the whole
image should appear brighter. This effect is available only when the Brighten
option is enabled under the Render section of the Preferences panel. This
parameter can be animated on page 6647 . Animating the Brighten spinner is
an easy way to create flares that "flash" the scene as they appear.

Dist Fade Causes the effect of the lens flare to fade with its distance from
the camera. This option is used only when the Dist Fade button is turned on.
The values are in 3ds Max world units. This option is used when you want to
create the effect of flares disappearing at a certain point away from the camera.

Cent Fade Fades the secondary flares near the center of the row of flares
along the main axis of the flare. This is an effect that can be seen in many
lens flares seen through a real camera lens. This value is in 3ds Max world
units. This setting is only active when the Cent Fade button is selected.

Dist Blur Blurs the flare based on its distance from the camera. This value is
in 3ds Max world units. This parameter can be animated.

Blur Int Controls the strength of the blur when it is applied to the lens flare.
The value set in this spinner takes full effect as the flare reaches the Dist Blur
distance in your scene. Flares closer to the camera plane get a percentage of
the intensity setting. This parameter can be animated.

Soften Provides an overall softening effect for the lens flare This parameter
can be animated.

Flare Parameter tabs

Let you create and control the lens flare. Each of the nine tabs controls a
specific aspect of the lens flare.
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WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 7967 . To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

A flare is composed of eight basic parts. Each part of a flare is controlled on
its own panel in the Lens Effects Flare interface. Each part of the lens flare can
be individually activated and deactivated to create different effects.

Prefs on page 6653 : This page lets you control which parts of a lens flare are
active and how they effect the overall image.

Glow on page 6656 : A general glow centered around the source object of the
flare. You can control the color, size, shape, and other aspects of the glow.

Ring on page 6657 : A circular color band that surrounds the center of the source
object. You can control the color, size, shape, and other aspects of the ring.

A Sec on page 6659 : Auto Secondary Flares. The small circles you would normally
see coming out from the source of the lens flare. As the camera position
changes relative to the source object, the secondary flares move. The secondary
flares are automatically generated when this option is active.

M Sec on page 6660 : Manual Secondary Flares. Additional secondary flares added
to the lens flare effect. They appear in the same axis as the automatic secondary
flares and look very similar.

Rays on page 6662 : Bright lines that radiate out from the center of the source
object, providing the illusion of extreme brightness for the object.

Star on page 6664 : Bright lines that radiate out from the center of the source
object, generally composed of 6 or more spokes, (instead of hundreds, like a
ray). Stars are generally thicker and extend out farther from the center of the
source object than rays.

Streak on page 6665 : Wide horizontal bands that run through the center of the
source object.

Inferno on page 6667 : Lets you add special effects, such as explosions, to your
flare effect.

Flare Preferences

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Prefs tab
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In the Prefs panel, you can control whether or not specific parts of the lens
flare, such as the rays or the star are rendered by turning them on or off. You
can also control the axial transparency of the lens flare.

Interface

Affect Alpha Specifies whether or not the lens flare affects the alpha channel
of an image, when the image is rendered in a 32-bit file format. The alpha
channel is an extra 8 bits of color (256 colors) that indicate transparency in
an image. Alpha channels are used to composite one image seamlessly over
the top of another. If you want to composite a lens flare, or an image that
contains a lens flare, over the top of another image, enable this option. If you
are not rendering to a 32-bit file, do not enable this option.

Affect Z Buffer The Z-Buffer stores an object's distance from the camera. The
Z-Buffer is useful for optical effects such as fog. When this option is enabled,
the linear distance of the lens flare is recorded, and can be used in special
effects that make use of the Z-Buffer, for example, the Focus on page 6670
effect. To use Focus with a lens flare, enable this option.
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Occlusion Radius A radius around the center of the flare that determines
when the lens flare effect will begin to fade as it passes behind another object.
This radius is measured in pixels.

When the lens flare or scene is animated and the source of the lens flare goes
behind another object, if occlusion is enabled, the flare dies down and
disappears until the source object reappears on the other side of the hiding
object. The radius makes the flare gently fade when it is occluded, instead of
blinking out.

Motion Blur Determines whether or not an animated lens flare is rendered
using Motion Blur. Motion Blur renders multiple copies in short increments
to the same frame, which gives the illusion of a blurred object in motion.
When an object is moving rapidly across the screen, it animates more smoothly
if motion blur is turned on. Using motion blur can add considerable time to
your rendering.

You can set the amount of blur with the Motion Blur spinner. Values range
from 0 to 100, and are based on the number of samples the motion blur should
use.

Axial Transparency A standard circular transparency gradient that affects
the transparency of the lens flare secondary elements along their axis and
relative to their source. This lets your secondary elements be brighter on one
side than the other, adding extra realism to your flare effects.

Render Specifies whether or not each part of the lens flare is rendered in the
final image. Use this set of check boxes to turn parts of the lens flare on and
off.

NOTE Effects such as secondary flares are available in sets. The Render button and
Off Scene determine whether the secondary flares are present in the scene. The
individual secondary flare sets are controlled on their respective pages.

Off Scene Specifies whether or not lens flares that have their sources outside
the scene will affect the image. For example, if a lens flare source is just off
the edge of a frame, the secondary flares, and possibly the star or ring, could
still be showing on the screen. Without Off Scene, the lens flare does not
appear at all. You can turn this option on or off for each part of the flare.

Squeeze Specifies whether the Squeeze setting affects a particular part of the
lens flare. This setting depends on the Squeeze setting in the lens flare
properties.

Inferno Defines whether the inferno on page 6667  settings are active for this
portion of the lens flare.

Lens Effects Filters | 6655



Occlusion Defines the percentage of the flare part that appears when it is
occluded by another object. A value of 100 indicates that the whole object
will disappear. Lower settings cause the lens flare to wrap around the occluding
object, making it fade, but not disappear entirely. For example, if you look at
a cylinder with a bright light behind it, the light makes the cylinder appear
thinner at the brightest areas.

NOTE The Occlusion spinners work in conjunction with the Occlusion Radius
spinner in the top right of the Preferences panel.

Flare Glow Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Glow tab

The glow of a lens flare is centered around the source object of the flare. The
parameters on the Glow panel let you control each aspect of the glow.

Interface
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Size Specifies the diameter of the glow of the lens flare as a percentage of
the overall size of the frame. This value is separate from the overall size value
set in the Flare Properties on page 6648 . This parameter can be animated on
page 6647 .

Hue Specifies the gradation of color for the glow. Clicking the green arrow
button lets you animate this control. This parameter can be animated.

Hide Behind Geometry Places the glow behind the geometric forms.

Gradients Use radial, circular, transparency, and size gradients on page 6699
. Glow gradients are subtler than flare gradients, because they are glowing an
area larger than a pixel.

Flare Ring Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Ring tab

The ring is a circular color band that surrounds the center of the source object.
You set ring options on the Ring panel of the Lens Effects Flare dialog.
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Interface

Size Specifies the overall size of the ring as a percentage of the overall frame
and represents the diameter of the ring. The ring radius should be larger than
the glow radius to make the lens flare look convincing. This parameter is
separate from the overall size spinner in the Lens Flare Effects section of the
dialog. This parameter can be animated on page 6647 .

Thick Specifies the overall thickness of the ring, as a percentage of the overall
size of the frame. When the ring is fairly thick, the size of the ring is measured
to the inner radius. The thickness controls how thick the ring is from that
point outward. This parameter can be animated.

Hue Specifies the gradation of color for the ring. This parameter can be
animated.

Gradients Use radial, circular, transparency, and size gradients on page 6699
.
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Automatic Secondary Flare Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > A Sec tab

Secondary flares are the small circles you would normally see coming out from
the source of the lens flare along an axis relative to the camera position. These
are caused by light refracting off the different lens elements in the camera. As
the camera position changes relative to the source object, the secondary flares
move. These secondary flares are automatically generated when this option
is selected in the Preferences section of the dialog.

You create sets of secondary elements that share common parameters instead
of building them one at a time. Many of the controls on the A Sec panel are
for individual sets of elements, not all sets.

Interface

Min Controls the minimum size of secondary flares in the current set. This
number is defined as a percentage of the overall image. This parameter can
be animated on page 6647 .
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Max Controls the maximum size of secondary flares in the current set. This
number is defined as a percentage of the overall image. This parameter can
be animated on page 6647 .

Sets Specifies which set of secondary flares you are working with. You can
have as many sets of automatic secondary elements as you wish, each having
their own properties. By default, seven sets are available. You can scroll through
them by clicking the forward and reverse arrow icons beside the name of the
set.

To add another set to your flare, click the Add button beneath the On check
box. To delete a set, click the Del button.

Axis Defines the overall length of the axis the automatic secondary flares
will be distributed along. Increasing the value creates more space between the
flares, while decreasing the value creates less space between the flares. You
can set the axis from 0 to 5 degrees. This parameter can be animated on page
6647 .

On Defines whether a group or set of secondary flares is active or not.

Fade Determines whether or not axial fade is active for the current set of
secondary flares.

Hue Specifies the gradation of color of the secondary flares. This parameter
can be animated.

Qty Controls the number of secondary flares that appear in the current set
of flares. This parameter can be animated.

Shape Controls the shape of the secondary flares for the current set. The
default value is circular, but you can choose from 3 to 8 sided secondary flares.

Gradients Defines the gradient on page 6699  for the secondary flare.

Manual Secondary Flare Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > M Sec tab

Manual secondary flares are additional secondary flares that are individually
added to the lens flare. These can be used in addition to, or in place of
automatic secondary flares on page 6659 .

You use Manual secondary flares when you want to add unique flares that
you don't want repeated.

6660 | Chapter 20   Video Post



You can have groups of secondary flares, instead of just one set. Many of the
controls in this dialog are for a specific set of flares, not all sets.

Interface

Size Controls the size, as a percentage of the overall image, of the manual
secondary lens flare. This parameter can be animated on page 6647 .

Plane Controls the distance, in degrees, between the flare source and the
manual secondary flare. By default, the flare plane exists at the center of the
chosen node source. Positive values place the flare in front of the source, while
negative values place the flare behind the flare source. This parameter can be
animated.

TIP In live camera work, there are often one or two secondary elements behind
the light source, so you should have one or two as well.

On Turns manual secondary flares on or off. This option must be selected
in both the Manual Secondary and Preferences tabs for the manual secondary
flares to render.

Fade Specifies whether or not the current set of secondary flares has axial
fade.
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Sets Specifies which set of secondary flares you are working with. You can
have as many sets of manual secondary elements as you wish, each having
their own properties. By default, seven sets are available. You can scroll through
them by clicking the forward and reverse arrow buttons next to the name of
the set.

To add another set to your flare, click the Add button beneath the On check
box. To delete a set, click the Del button.

Hue Specifies the gradation of color of secondary flares. This parameter can
be animated.

Scale Specifies how to scale secondary flares. This parameter can be animated.

Shape This menu controls the overall shape of the secondary flares.

Gradients Defines the gradient on page 6699  for the secondary flare.

Flare Ray Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Rays tab

Rays are bright single-pixel lines that radiate from the center of the source
object, providing the illusion of extreme brightness for the object. Rays let
you emulate scratches in the lens elements of a camera.

You control the parameters for rays in the Rays panel of the Lens Effects Flare
dialog.
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Interface

Size Specifies the overall length of the rays as they radiate from the center,
as a percentage of the frame size. This parameter can be animated on page
6647 .

Angle Specifies the angle for the rays. You can enter both positive and
negative values so, when animated, the rays rotate in a clockwise or
counterclockwise direction. This parameter can be animated.

Group Forces the grouping of rays into eight equidistant groups of equal
size. Rays that are part of a group are evenly distributed within that group.
Increasing the number of rays makes each grouping more dense, and therefore
more bright.

Number Specifies the overall number of rays that appear in the lens flare.
Rays are randomly spaced around the radius. This parameter can be animated.

Auto Rotate Adds the angle specified in the Angle spinner on the Rays panel
to the angle set in the Angle spinner under Lens Flare Properties. Auto Rotate
also ensures that the rays maintain their relative position to the flare as it is
being animated.
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Hue Specifies the gradation of the color of the rays. This parameter can be
animated.

Sharp Specifies the overall sharpness of the rays. Higher numbers produce
crisp, clean, and clear rays. Lower numbers produce more of a secondary glow
look. Values range from 0 to 10. This parameter can be animated.

Gradients Defines the gradient on page 6699  for the rays.

Flare Star Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Star tab

A Star is larger than a ray effect and is composed of six or more spokes, instead
of hundreds like a ray. Stars are thicker and extend out farther from the center
of the source object than rays. You control the settings for stars on the Star
panel of the Lens Effects Flare dialog.

Interface
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Size Specifies the overall size of the star effect, as a percentage of the overall
frame. This parameter can be animated on page 6647 .

Angle Sets the starting angle in degrees in which the star spokes point. You
can enter both positive and negative values so, when animated, the star spokes
rotate in a clockwise or counterclockwise direction. This parameter can be
animated.

Random Enables random spacing of star spokes around the flare center.

Qty Specifies the number of spokes in the star effect. Default = 6.

Spokes are spaced at equidistant points about the center of the flare. This
parameter can be animated.

Width Specifies the width of the individual spokes, as a percentage of the
overall frame. This option can be animated.

Auto Rotate Adds the angle specified in the Angle spinner on the Rays panel
to the angle set in Angle spinner under Lens Flare Properties. Auto Rotate also
ensures that the stars maintain their relative position to the flare as it is being
animated.

Hue Specifies the gradation of the color of the star. This parameter can be
animated.

Sharp Specifies the overall sharpness of the star. Higher numbers produce
crisp, clean, and clear stars. Lower numbers produce more of a secondary glow
look. This parameter can be animated. Range = 0 to 10.

Taper Controls the taper of the individual spokes of the star. Taper widens
or narrows the tips of the individual star points. Low numbers create a sharp
point, while high numbers flare the points. This parameter can be animated.
Default = 0.

Gradients The gradients on page 6699  are the same for the Star effect as for
others, except for two gradients: Section Color and Section Transparency.
These options are useful when you want to create a "soft" look to the spokes.
Both gradients work from the center of each spoke to the outer edge of the
spoke.

Flare Streak Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Streak tab
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A streak is a wide horizontal band that runs through the center of the source
object. In real camera work, it is produced when using anamorphic lenses to
film a scene. You set streak options on the Streak panel of the Lens Effects
Flare dialog.

Interface

Size Specifies the overall size of the streak, as a percentage of the overall
frame. This parameter can be animated on page 6647 .

Angle Specifies the angle for the streak. You can enter both positive and
negative values so, when animated, the streak rotates in a clockwise or
counterclockwise direction. This parameter can be animated.

Axial Align Forces the streak to align itself to the axis of the secondary flares
and the lens flare itself.

Width Specifies the width of the streak, as a percentage of the frame. This
parameter can be animated.

Auto Rotate Adds the angle specified in the Angle spinner on the Streak
panel to the angle set in Angle spinner under Lens Flare Properties. Auto Rotate
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also ensures that the stars maintain their relative position to the flare as it is
being animated.

Hue Specifies the gradation of the color of the streak. This parameter can be
animated.

Sharp Specifies the overall sharpness of the streak. Higher numbers produce
crisp, clean, and clear streaks. Lower numbers produce more of a secondary
glow look. Valid values are from 0 to 10. This parameter can be animated.

Taper Controls the taper of the individual spokes of the streak. Taper widens
or narrows the tips of the individual streak points. Low numbers create a sharp
point, while high numbers flare the points. Default = 0. This parameter can
be animated.

Gradients The gradients on page 6699  are the same for the Streak effect as
for others, except for two gradients: Section Color and Section Transparency.
These options are useful when you want to create a "soft" look to the streak
spokes. Both gradients work from the center of each spoke to the outer edge
of the spoke.

Flare Inferno Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Inferno tab

Infernos let you use lens flare to create explosions, fire, and smoke effects and
add a bit of fractal noise to any part of the lens flare. This noise comes in three
types: Gaseous, Electric, and Fiery.
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Interface

You add the Inferno effect to other lens flare effects. Inferno is selected in the
Preferences panel. The lens flare effect you are adding Inferno to, such as glow,
must also be selected for Inferno to work correctly. The Inferno panel is divided
into two sections: Settings and Parameters.

Settings group

Gaseous A loose and soft pattern, often used for clouds and smoke.

Fiery Fractal patterns with bright, well-defined areas, often used for fires.

Electric Long, well-defined tendril pattern that can be used to produce arcing
electricity, when animated. By adjusting the quality of the pattern to 0, you
can create the effect of water reflection.

Lock Effect Locks the inferno effect to the lens flare. When the lens flare
moves across the screen, the inferno effect moves with it. Use this option
when you want the noise pattern to move with the flare for effects like torches.

Lock Noise Locks the inferno noise patterns into the screen. When the lens
flare is animated and moving across the screen, the noise pattern stays in one
spot and the flare moves through it. This is often used for creating plasma
trails and cloud patterns.

Motion When you animate the inferno, motion specifies how fast the inferno
patterns move in the direction set by the Direction spinner. For example, if
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you want to simulate a raging fire, you want the fractal patterns to move
upward. This parameter can be animated on page 6647 .

Direction Specifies the direction, in degrees, of the inferno effect motion.
By default, 0 is aligned in the 12 o'clock position, and works clockwise. This
parameter can be animated.

NOTE The Motion and Direction spinners control the motion of the fractal pattern
in the X and Y directions. You can control the Z direction using the Speed option
under Inferno Parameters.

Quality Specifies the overall quality of the fractal noise patterns in the inferno
effect. Higher values result in more iterations of the fractals, more detail in
the effect, and slightly longer render times. This parameter can be animated.

Reseed The number that the fractal routines use as a starting point. Set this
spinner to any number to create different fractal effects. The Reseed button
randomly selects a new number.

Parameters group

Size Specifies the overall size of the fractal patterns. Smaller numbers produce
small, grainy fractals. Higher numbers produce larger patterns. This option
can be animated.

Speed Sets the overall speed of the turbulence in the fractal patterns as they
are animated. Higher numbers produce faster turbulence in the pattern. This
parameter can be animated.

Base Specifies the brightness of the colors in the inferno effect. Higher values
result in brighter color ranges and brighter infernos. Lower values result in
dark, softer effects. The Base spinner only affects Fiery and Electric inferno
types This parameter can be animated.

Amplitude With the Base spinner, controls the maximum brightness for
each portion of the fractal inferno patterns. Higher values result in fractal
patterns with brighter colors. Lower values result in the same patterns, with
muted colors. This parameter can be animated.

Bias Shifts the colors of the effect toward one end of the color range or the
other. At a setting of 50, Bias has no effect. Above 50, the colors are brighter,
and below 50, they are darker and softer. This parameter can be animated.

Edge Controls the contrast between the light and dark areas of the fractal
patterns. High values produce a high contrast and more well-defined fractal
patterns. Low values result in less defined, subtler effects. This parameter can
be animated.
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Radial Density Controls the density of the inferno effect in a radial fashion
from the center of the effect to the edge. Wherever there is white in the
gradient, you only see inferno noise. Where the gradient is black, you can see
the underlying flare. If you set the right side of the gradient to black and the
left side to white, and apply the Inferno to the Glow effect of a flare, the
inferno effect appears toward the outer edges of the glow, while the center of
the glow is still visible.

Lens Effects Focus Filter

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Focus from
Filter Plug-In list. > Setup

The Lens Effects Focus dialog lets you blur objects based on their distance
from the camera. Focus uses the Z-Buffer information from the scene to create
its blurring effects. You can use Focus to create effects such as foreground
elements in focus and background elements out of focus.

Like Flare, Glow, and Highlight, you can load and save your focus settings for
future use. Focus settings are saved to LZO files on page 7834  (.lzo).

WARNING This filter is not supported by the mental ray renderer on page 6039 .

Procedures

To save your focus settings, do one of the following:

You can save all of your lens focus settings to a file, so you can reload them
any time. Lens Effects Focus settings are saved as LZO files.

1 Click the Reset button.

This resets Lens Effects Focus to its default settings.

2 Click the Load button.

This displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

3 Click the Save button.

This displays a Windows-standard Save As dialog in which you specify a
directory and filename.
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Interface

The Lens Effects Focus dialog contains a preview window, and an area below
to control the parameters of Focus.
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Preview group

Preview window Lets you quickly preview the Focus effect.

Preview Displays a generic scene to which you can quickly set up a Focus
effect. Appears light green when selected.

VP Queue Lets you preview the scene in the Video Post queue. Preview must
be selected for the VP Queue function to work.

Focus Control group

The settings on the left side of the panel let you select a method for blurring
your scene. The settings on the right side of the dialog let you determine how
much blurring is applied to the scene.

Scene Blur Applies the blurring effect to the entire scene, not just a portion
of it.

Radial Blur Applies the blurring effect to the entire scene in a radial fashion,
starting at the center of the frame. This is useful for emphasizing fish-eye lens
effects and effects where the edges of the frame are blurred. This type of Focus
depends on the Focal Range and Limit settings.

A scene with a radial blur is applied.

Focal Node Lets you select a specific object in the scene as the focal point
for blurring. The selected objects remains in focus, while objects outside of
the set Focal Limit are blurred.

Select Displays the Select Focal Object dialog so you can select a single 3ds
Max object to use as the focal object. The object you select can be animated
over time, which results in animated follow focus effects. You can also choose
your camera target as the focal object so its depth in the scene determines the
focus.

Affect Alpha When this option is selected, the blur effect is also applied to
the Alpha channel of the image when you render to a 32-bit format. Select
this option to composite the blurred image over another.

Horiz. Focal Loss Specifies the amount of blur applied to the image in the
horizontal (X-axis) direction. Values range from 0 to 100% focal loss. This
parameter can be animated on page 6647 .

Lock Locks the horizontal and vertical loss settings together. When selected,
the vertical focal loss is automatically updated to match your changes to the
horizontal loss.
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Vert. Focal Loss Specifies the amount of blur applied to the image in the
vertical (Y-axis) direction. Values range from 0 to 100% focal loss. This
parameter can be animated.

Focal Range Specifies how far away from the center of the image (Radial
Blur) or from the camera (Focal Object) the blur effect begins. Increasing values
move the radius of the effect farther away from the camera or the center of
the image. This parameter can be animated.

Focal Limit Specifies the distance from the center of the image (Radial Blur)
or the distance from the camera (Focal Object) at which the blur effect is at
full strength. Setting a high Focal Limit with a low Focal Range, produces a
gradual increase in the amount of blur in the scene, while setting Focal Limit
and Range close together produces a rapid blur effect over a short distance.
This parameter can be animated.

NOTE Do not set Focal Range and Focal Limit to the same value. This produces
an abrupt change from a blur to a sharp focus, producing an undesirable visual
effect.

WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 7967 . To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

Button group

Reset Resets Lens Effects Flare to its default settings.

Load Displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

Save Displays a Windows-standard Save As dialog in which you specify a
directory and filename. Lens Effects Focus settings are saved as LZO files.

Lens Effects Glow Filter

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from
Filter Plug-In list. > Setup

The Lens Effects Glow dialog lets you add a glowing aura around any assigned
object. For example, for an exploding particle system, adding a glow to the
particles makes them seem as though they are brighter and hotter.
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The Lens Effects Glow module is multi-threaded and will take advantage of
multi-processing machines.

Procedures

To save your glow settings, do one of the following:

You can save all of your lens glow settings to a file, so you can reload them
any time. Lens Effects Glow settings are saved to LZG files on page 7834  (.lzg).

1 Click the Reset button.

This resets Lens Effects Glow to its default settings.

2 Click the Load button.

This displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

3 Click the Save button.

This displays a Windows-standard Save As dialog in which you specify a
directory and filename.
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Interface

The Lens Effects Glow dialog contains a preview window, and an area below
to control the parameters of Glow.
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Preview group

Preview window Lets you quickly preview the glow effect. The preview
window is multi-threaded to take advantage of systems with multiprocessors,
and updates every time you make a change to any of the glow settings that
might affect the scene.

Preview Displays a generic scene to which you can quickly set up a Glow
effect. Appears light green when selected.

VP Queue Lets you preview the scene in the Video Post queue. Preview must
be selected for the VP Queue function to work.

Focus Control tabs

The Lens Effect Glow dialog contains four tabs:

Properties on page 6676 , Preferences on page 6680 , Gradients on page 6699 , and
Inferno on page 6682

Button group

Reset Resets Lens Effects Glow to its default settings.

Load Displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

Save Displays a Windows-standard Save As dialog in which you specify a
directory and filename. Lens Effects Glow settings are saved as LZG files.

Glow Properties

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from
Filter Plug-In list. > Setup > Properties tab

The Lens Effects Glow properties let you determine which pieces of geometry
in your scene will exhibit the effects of the glow filter, as well as how much
of a glow is applied.

Procedures

To set a material's Effects Channel ID:

1 In the Material Editor, make the material you want to be post-processed
the active material.
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2 Choose a non-zero ID from the Material Effects Channel flyout.

The Effects Channel ID can range from 1 to 15.

If you give the same Effects Channel ID value to more than one material,
all these materials will be post-processed.

NOTE For Multi/Sub-Object materials, post-processing applies at the
sub-object/sub-material level. The Effects Channel ID of the parent
Multi/Sub-Object material is ignored.

To set up an RLA file so it saves Object and Material Effects channel data:

1 Place an Image Output Event in the Video Post Queue.

2 In the Image Output Event dialog, click Files.

3 Choose the .rla file type on page 7156  and a file name, and then click
Setup.

4 In the RLA Image File Format dialog, select Object, Material Effects, and
then click OK.

5 Click OK.

When the RLA file has saved the Object and Material Effects channels,
you can use the rendered scene file as an Image Input event or a Filter or
Layer mask, and continue to use the Object or Material Effects Channel
data.
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Interface

The Properties panel is divided into two sections: Source and Filter.

Source group

Specifies the objects in the scene to which a glow is applied. You can select
more than one source option at a time.

Whole Applies a glow to the whole scene, not just a particular piece of
geometry. This makes each pixel in the scene a potential glow source. The
areas of the scene that have glow applied to them are determined by the
settings in the Filter section of the dialog.

Object ID Lets you apply the glow to an object or part of an object with a
specific Object ID (in the G-buffer on page 7795 ), if the object matches the
Filter settings. To apply an Object ID glow for an object, right-click the object
and select properties from the menu. Then, set the Object Channel ID. Set
this field to match, and Lens Effects glow will apply the glow to that object
and any other objects with the same ID. This parameter can be animated on
page 6647 .

Effects ID Lets you apply the glow to an object or part of an object with a
specific Effects ID, if the object or part of the object matches the Filter settings.
You apply a Effects ID in the Materials Editor by assigning the material to one
of the available Material Effects channels. This parameter can be animated.

The glow will be applied only to areas of the geometry where the ID is present.
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NOTE To apply different glow settings to different pieces of geometry or IDs, add
more glow entries to the video post queue. Set each glow entry to affect a different
Effect or Object ID, and set the appropriate settings. This process will call the glow
routine multiple times, increasing your rendering time. Try to keep the number
of glow routines to a minimum per frame.

Unclamped An unclamped color is brighter than pure white (255,255,255).
3ds Max keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that is glowed. Pure white has a pixel value
of 1. When this spinner is set to 1, any pixels with a value above 255 will be
glowed. You can invert this value by clicking the I button to the right of the
spinner. This parameter can be animated.

Surf Norm Glows part of an object, based on the angle of the surface normal
to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90
is normal, or perpendicular to the screen. If you set Surf Norm to 45, only
surfaces with normal angles greater than 45 degrees will be glowed. You can
invert this value by clicking the I button to the right of the spinner. This
parameter can be animated.

Mask Glows the mask channel of an image. The spinner value represents
the level of grayscale present in a Mask. When this is set, any part of the Mask
images larger than the set value will be glowed in the final image. You can
invert this value by clicking the I button to the right of the spinner. This
parameter can be animated. Range = 0 to 255.

Alpha Glows the alpha channel of an image. The transparency of an alpha
channel is interpreted opposite that of the Mask channel. This parameter can
be inverted, and can also be animated. Range = 0 to 255.

Z Buffer Hi and Lo Glows objects based on their distance (Z-Buffer distance)
from the camera. The Hi value is the maximum distance and the Lo value is
the minimum. Any objects between these two Z-Buffer distances will be glowed.
These parameters can be animated.

Filter group

Filters the Source selections to let you control how the glow is applied. For
example, you can have ten spheres in your scene, each with the same Object
ID, but different colors. If you set the Source as the Object ID of the spheres,
which selects all of the spheres, that is the only place in your scene that Glow
applies an effect.
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However, now that Glow knows where the pixels are that can be glowed, it
needs to know which ones to actually apply the Glow to. Glow uses the filter
controls to find out which source pixels to apply a glow to.

All Selects all source objects in the scene and applies a glow to them.

Edge Selects all source objects along a boundary edge and applies a glow to
them. Applying a glow along the edges of objects produces a soft halo that
exists on both inside and outside edges of your object.

Perimeter Alpha Applies a glow only to the perimeter of an object based on
its alpha channel. Selecting this option glows only the outside of an object
without any spill on the interior. Perimeter Alpha keeps all the edges clean
because it relies on the scene alpha channel for its effect.

Perimeter Applies glow effect only to the perimeter of an object based on
Edge inferencing. Although not as precise as Perimeter Alpha, you might need
to use the Perimeter option at times when the alpha channel is unavailable.

Bright Filters the source objects based on their brightness values. Only objects
with a brightness above the spinner setting are selected and glowed. This
option can be inverted. This parameter can be animated.

Hue Filters the source objects by their hue. Select the hue by clicking the
color swatch next to the spinner. The spinner beside the Hue color swatch
lets you enter a variance level so that the glow can find several different hues
in the same range as the chosen color. This parameter can be animated. Range
= 0 to 255.

Glow Preferences

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from
Filter Plug-In list. > Setup > Preferences tab

Glow Preferences define the size of the glow, its occlusion, and whether or
not it affects the Z-Buffer or alpha channels.
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Interface

The Preferences panel is divided into four sections: Scene, Distance Fade,
Effect, and Color.

Scene group

Affect Alpha Specifies whether or not the glow affects the alpha channel of
the image, when rendered to a 32-bit file format.

Affect Z Buffer Specifies whether or not the glow affects the Z-Buffer of the
image. When this option is enabled, the linear distance of the glow is recorded,
and can be used in special effects that make use of the Z-Buffer. For example,
Lens Effects Focus blurs objects based on their Z-Buffer information. To use
Focus with a glow, you must enable this option.

Distance Fade group

These controls fade the glow effect, based on its distance from the camera.
This is the same as distance fade for the lens flare.

Bright Lets you fade the brightness of the glow effect based on the distance
from the camera. This is ideal for submarine running lights and any other
effect where you want your glow to disappear into the distance. This parameter
can be animated on page 6647 .

Size Lets you fade the size of the glow effect based on the distance from the
camera. In most circumstances, you want the overall size of the glow to
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diminish as it gets farther away from the camera. This parameter can be
animated.

Lock When selected, locks the Bright and Size values together, so that the
size and brightness fading is synchronized.

Effect group

Size Sets the size of the overall glow effect. This parameter can be animated.

Softness Softens and blurs the glow effect. Values range from 0 to 100. This
control is enabled only when you use Gradients as the color method (see the
next section). Softness is only available when the Gradient option in the Color
area is selected. This parameter can be animated.

Color group

Gradient Creates the glow based on the settings in the Gradients panel.
When you use this method, you can use the Softness spinner in the Effect
area.

Pixel Creates the glow based on the pixel color of the object. This is the
default method. It is very fast.

User Lets you select a color for the glow effect. Click the color swatch to
display the Color Selector on page 331  and choose a color.

Intensity Controls the intensity or brightness of the glow effect. Values range
from 0 to 100. This control is enabled only when Pixel or User is the chosen
color method.

Glow Inferno

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from
Filter Plug-In list. > Setup > Inferno tab

The Inferno panel lets you create explosions, fire, and smoke effects by
combining the lens flare glow with black and white fractal noise.

The Glow inferno effect is like the Inferno effect in Lens Flare on page 6667 ,
but it is applied to the Glow through the R, G, and B color channels.
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Interface

The Inferno panel is divided into two sections: Settings and Parameters.

Settings group

Gaseous A loose and soft pattern, often used for clouds and smoke.

Fiery Fractal patterns with bright, well-defined areas, often used for fires.

Electric Long, well-defined tendril pattern that can be used to produce arcing
electricity, when animated. By adjusting the quality of the pattern to 0, you
can create the effect of water reflection.

Reseed The number that the fractal routines use as a starting point. Set this
spinner to any number to create different fractal effects. The Reseed button
randomly selects a new number.

Motion When you animate the inferno, motion specifies how fast the inferno
patterns move in the direction set by the Direction spinner. For example, if
you want to simulate a raging fire, you want the fractal patterns to move
upward. This parameter can be animated on page 6647 .

Direction Specifies the direction, in degrees, of the inferno effect motion.
By default, 0 is aligned in the 12 o'clock position, and works clockwise. This
parameter can be animated.
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NOTE The Motion and Direction spinners control the motion of the fractal pattern
in the X and Y directions. You can control the Z direction using the Speed option
under Inferno Parameters.

Quality Specifies the overall quality of the fractal noise patterns in the inferno
effect. Higher values result in more iterations of the fractals, more detail in
the effect, and slightly longer render times. This parameter can be animated.

Red/Green/Blue Selects the color channel to use for the Inferno effect.

Parameters group

Size Specifies the overall size of the fractal patterns. Smaller numbers produce
small, grainy fractals. Higher numbers produce larger patterns. This option
can be animated.

Speed Sets the overall speed of the turbulence in the fractal patterns as they
are animated. Higher numbers produce faster turbulence in the pattern. This
parameter can be animated.

Base Specifies the brightness of the colors in the inferno effect. Higher values
result in brighter color ranges and brighter infernos. Lower values result in
dark, softer effects. The Base spinner only affects Fiery and Electric inferno
types This parameter can be animated.

Amplitude With the Base spinner, controls the maximum brightness for
each portion of the fractal inferno patterns. Higher values result in fractal
patterns with brighter colors. Lower values result in the same patterns, with
muted colors. This parameter can be animated.

Bias Shifts the colors of the effect toward one end of the color range or the
other. At a setting of 50, Bias has no effect. Above 50, the colors are brighter,
and below 50, they are darker and softer. This parameter can be animated.

Edge Controls the contrast between the light and dark areas of the fractal
patterns. High values produce a high contrast and more well-defined fractal
patterns. Low values result in less defined, subtler effects. This parameter can
be animated.

Radial Density Controls the density of the inferno effect in a radial fashion
from the center of the effect to the edge. Wherever there is white in the
gradient, you only see inferno noise. Where the gradient is black, you can see
the underlying glow. If you set the right side of the gradient to black and the
left side to white, and apply the Inferno to the Glow effect of a flare, the
inferno effect appears toward the outer edges of the glow, while the center of
the glow is still visible.
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Lens Effects Highlight Filter

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list. > Setup

The Lens Effects Highlight dialog lets you assign bright, star-shaped highlights.
Use it on objects that have shiny materials. For example, a shiny, red car might
show highlights in bright sunlight.

Example of highlights

Another good example of an effect perfect for Highlight is the creation of
pixie dust. If you create a particle system and animate it moving in a straight
line with small four-point Highlight stars applied to each pixel, it will look a
lot like twinkling magic.

The Lens Effects Highlight module is multi-threaded and will take advantage
of multi-processing machines, making it one of, if not the fastest highlight
routines available.
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Procedures

To save your highlight settings:

You can save all of your lens highlight settings to a file, so you can reload
them any time. Lens Effects Highlight settings are saved as LZH files on page
7834  (.lzh). Do one of the following:

1 Click the Reset button.

This resets Lens Effects Highlight to its default settings.

2 Click the Load button.

This displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

3 Click the Save button.

This displays a Windows-standard Save As dialog in which you specify a
directory and filename.
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Interface

When you select Lens Effects Highlight from the Image Filter Event drop-down
list and click Setup, the Highlight dialog is displayed.
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The Lens Effects Highlight interface is almost identical to the Glow module,
with a large preview window, and tabs to control every aspect of your highlight
effects.

Preview group

Preview window Lets you quickly preview the glow effect. The preview
window is multi-threaded to take advantage of systems with multiprocessors,
and updates every time you make a change to any of the glow settings that
might affect the scene.

Preview Activates a generic cross star filter so you can quickly set up a
Highlight effect. However, as with the Glow module, it is more effective seeing
your entire scene and how your effect will interact with your geometry.

VP Queue Lets you preview the scene in the Video Post queue. Preview must
be selected for the VP Queue function to work.

Highlight Control tabs

Similar to the Glow settings, Highlight is also broken down into tabbed sections
for fine control over each aspect of the Highlight effect. The four tabs are:

Highlight Properties on page 6688

Highlight Geometry on page 6693

Highlight Preferences on page 6698

Lens Effects Gradients on page 6699

Button group

Reset Resets Lens Effects Highlight to its default settings.

Load Displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

Save Displays a Windows-standard Save As dialog in which you specify a
directory and filename. Lens Effects Highlight settings are saved as LZH files.

Highlight Properties

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list > Setup > Properties tab
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The Lens Effects Highlight properties enable you to determine which parts of
your scene will have highlights applied to them, as well as how the highlights
are to be applied.

Interface

The Properties panel is broken down into two sections: Source and Filter.

Source group

The Source section lets you select any G-Buffer data in the scene that will have
a highlight applied to it. Lens Effects Highlight will begin the process by
finding the source pixels from your scene that you want to glow.

Whole Lets you apply highlights to the whole scene, not just a particular
piece of geometry. This, in effect, makes each pixel in the scene a potential
highlight source. The areas of the scene that have highlights applied to them
are determined by the settings in the Filter section of the dialog.

Object ID The Object ID Lets you apply highlights to particular objects in
your scene that have a corresponding G-Buffer (or Object) ID. The G-Buffer
is a geometry buffer and can be defined when you right-click any 3ds Max
object and select Properties from the menu. Then, set the Object Channel ID
under the G-Buffer ID controls. This parameter can be animated on page 6647
.

Effects ID The Effects ID lets you apply the highlight to an object or part of
an object with a specific Effects ID assigned to it. Effects ID's are applied in
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the materials editor by assigning the material one of the eight Material Effects
channels that are available. See G-Buffer on page 7795 . This parameter can be
animated.

The highlights are then only applied to areas of the geometry where that
particular ID is present.

NOTE In many instances, you may want to apply different highlight settings to
different pieces of geometry or ID's. To accomplish this, add additional Lens Effects
Highlight entries to the Video Post queue. Then set each different Highlight entry
to effect a different Effect or Object ID and proceed.

Unclamped An unclamped color is brighter than pure white (255,255,255).
3ds Max keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that is highlighted. Pure white has a pixel
value of 1. When this spinner is set to 1, any pixels with a value above 255
will be glowed. You can invert this value by clicking the I button to the right
of the spinner. This parameter can be animated.

Surf Norm Highlights part of an object, based on the angle of the surface
normal to the camera. A value of 0 is coplanar, or parallel to the screen. A
value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to
45, only surfaces with normal angles greater than 45 degrees will be glowed.
You can invert this value by clicking the I button to the right of the spinner.
This parameter can be animated.

Mask Highlights the mask channel of an image. The spinner value represents
the level of grayscale present in a Mask. When this is set, any part of the Mask
images larger than the set value will be glowed in the final image. You can
invert this value by clicking the I button to the right of the spinner. This
parameter can be animated. Range = 0 to 255.

Alpha Highlights the alpha channel of an image. The transparency of an
alpha channel is interpreted opposite that of the Mask channel. Values range
from 0 to 255. This parameter can be inverted by clicking the I button to the
right of the spinner, and can also be animated.

Z Buffer Hi and Lo Highlights objects based on their distance (Z-Buffer
distance) from the camera. The Hi value is the maximum distance and the Lo
value is the minimum. Any objects between these two Z-Buffer distances will
be highlighted. These parameters can be animated.
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Filter group

Filters the Source selections to let you control how the highlight is applied.
For example, you can have ten spheres in your scene, each with the same
Object ID, but different colors. If you set the Source as the Object ID of the
spheres, which selects all of the spheres, that is the only place in your scene
that Highlight will apply an effect.

However, now that Highlight knows where the pixels are that can be
highlighted, it needs to know which ones to actually apply the highlights to.
Highlight uses the filter controls to find out which source pixels to apply the
highlight to.

All Selects all source pixels in the scene and applies a highlight to them.

Edge Selects all source pixels along a boundary edge and applies a highlight
to them. Applying a highlight along the edges of objects produces a soft halo
that exists on both inside and outside edges of your object.

Edge highlights

Perimeter Alpha Applies a highlight only to the perimeter of an object based
on its alpha channel. Selecting this option highlights only the outside of an
object without any spill on the interior. Whereas highlighting by Edge

Lens Effects Filters | 6691



produces a spill onto the object, Perimeter Alpha keeps all of the edges clean
because it relies on the scene alpha channel to derive it's effect.

Perimeter alpha highlights

Perimeter Applies highlight effect only to the perimeter of an object based
on Edge inferencing. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.
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Perimeter highlights

Bright Filters the source objects based on their brightness values. Only objects
with a brightness above the spinner setting are selected and highlighted. This
option can be inverted by clicking the I button next to the spinner. This
parameter can be animated.

Hue Filters the source objects by their hue. Select the hue by clicking the
color swatch next to the spinner. You can choose hue values from 0 to 255.
The spinner beside the Hue color swatch lets you enter a variance level so that
the glow can find several different hues in the same range as the chosen color
This parameter can be animated.

Highlight Geometry

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list > Setup > Geometry tab

The Geometry panel is where you set the initial rotation of the highlights as
well as how the elements are affected over time. The Geometry panel consists
of three areas: Effect, Vary, and Rotate.
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Interface

Effect group

Angle Controls the angle of the highlight points over the course of the
animation. This parameter can be animated on page 6647 .

Clamp Determines the number of pixels highlight must read to place a single
highlight effect. In many cases, you want to key your highlight effects off of
the brightness of objects that can produce a lot of pixels to generate from.
The end result is something that looks like stadium lights from a Monday
Night Football game, where each pixel has the highlight cross drawn on top
of it, which blurs the overall effect. When you want only one or two highlights,
use this spinner to adjust how highlight processes the chosen pixels. This
parameter can be animated.
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Clamp value of 5

Clamp value of 15
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As you can see, the Clamp value lets you maximize or minimize the overall
number of highlights drawn over the same image. This can be a tremendous
time saver.

Alt. Rays Alternates the lengths of points around the highlight. It works on
every other ray point, changing from the ray's full length to a smaller one
based on the percentage spinner beneath it. This parameter can be animated.

Alt. Rays turned off
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Alt. Rays turned on and set to 40%

Vary group

The Vary group of controls adds randomness to your Highlight effects. You
can quickly adjust your effects so that no two look alike. In many instances,
you want to avoid having your Highlights rotate in formation, and the Size
and Angle buttons control that.

Size Varies the overall size of the individual Highlights.

Angle Varies the initial orientation of the individual Highlights.

Reseed Forces Highlight to use a different random number to generate parts
of its effects.

Rotate group

These two buttons let you have your highlights automatically rotate based on
their relative position in the scene.

Distance Automatically rotates the individual highlight elements as they
recede into the distance. The faster your elements recede, the faster they will
rotate.

Pan Automatically rotates the individual Highlight elements as they move
laterally across the screen. If you have objects in your scene that are passing
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by the camera, they can be automatically rotated based on their position. The
faster your elements move across the screen, the faster they will rotate.

Highlight Preferences

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list > Setup > Preferences tab

The Preferences panel defines the size and number of points on the highlight,
occlusion settings, and whether or not it affects the Z-Buffer or alpha channels.

Interface

Scene group

Affect Alpha Determines whether or not the highlight settings affect the
alpha channel of the image when you render to a 32-bit file format.

Affect Z Buffer Determines whether or not the highlight affects the Z-Buffer
of the image. When this option is selected, the linear distance of the highlight
is recorded, and can be used in special effects that make use of the Z-Buffer.
For example, the Focus module that ships with Lens Effects blurs objects based
on their Z-Buffer information. If you want to use Focus to blur a highlight,
you must select this option. If you are not sure about whether or not to select
this option, leave it disabled, because you probably don't need it.
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Distance Fade group

Bright Lets you fade the brightness of the highlight effect based on the
distance away from the camera. This parameter can be animated on page 6647
.

Lock Locks the Bright and Size spinner values together.

Size Lets you fade the size of the highlight effect based on the distance from
the camera. In most circumstances, you want the overall size of your highlights
to diminish as they get farther from the camera. This option takes care of that
for you. This parameter can be animated.

Effect group

Size Lets you determine the overall size of the highlight effect, and is
calculated in pixels. This parameter can be animated.

Points Controls the number of points to be generated for a highlight effect.
This parameter can be animated.

Color group

Gradient Lets you create the highlight based on the settings in the Gradients
panel.

Pixel Lets you create the highlight color based on the pixel color of the
highlighted object. This is the default method for Lens Effects Highlight and
is exceptionally fast.

User Lets you select a specific color for the highlights through the standard
3ds Max Color Selector on page 331 . The color swatch shows you the currently
selected color.

Intensity Lets you control the intensity or brightness of the highlights. Values
range from 0 to 100. This spinner functions only when you are using either
the Pixel or User color methods to control the brightness of the highlight effect.
This parameter can be animated.

Lens Effects Gradients

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list > Setup > Gradients tab
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A gradient is a smooth linear transition from one color or brightness to
another, as shown below. Lens Effects use gradients to control aspects of the
lens flares, such as colors and transparency. Lens Effects use several gradient
types on page 6704 .

Lens Effects Gradients are always interpreted from left to right.

Gradient Flags

Gradients use Flags to indicate points along the gradient bar where you want
different colors or brightness values to be. The colors between the flags are
interpolated automatically by Lens Effects. Each Gradient inside Lens Effects
can contain up to 100 flags. The current flag is highlighted and green. The
position number above the gradient bar indicates the position of the current
flag, in relation to the overall length of the gradient.

A gradient always has non-moveable start and end flags. You can add up to
98 intermediate flags to alter the overall appearance of your gradients. You
can also change the color or brightness of the end flags to suit your needs.

When you place two gradient flags on top of one another, you create a sharp
break in the gradient. When a third flag is placed on top of the second flag,
a sharp edge appears in the gradient.

WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 7967 . To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

Procedures

To add an intermediate flag:

■ Click the gradient bar where you want to place the new flag.
The flag uses the color of the gradient at the point where you placed it. To
adjust the color, double-click to display the Color Selector on page 117 .
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To adjust the position of a flag:

■ Drag the flag left or right.
The gradient updates to show you the changes.

To delete a flag:

■ Drag the flag outside the gradient bar.
The flag turns red, and the mouse point changes to a down arrow pointing
to a bucket. When you let go of the mouse button, the flag is deleted.

To change a flag's properties:

1 Right-click the flag to display a menu.

2 Click Properties and change any settings you want.

Interface

Right-clicking a gradient flag and selecting Edit Properties displays the Flag
Properties dialog. To change gradient options on page 6702 , right-click the
gradient bar, not the flags.

The Flag Properties dialog lets you change the name of the flag, its color, and
its position.

Name By default, flags are named Flag #. You can enter a different name for
the current flag. The arrows to the right of the name box let you choose other
flags on the same gradient.
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Color The Color swatch lets you control the color or brightness component
of the gradient at the position where the flag is located. Click the color swatch
to display the color picker and choose a different color. The green arrow to
the left of the color swatch indicates that this flag parameter can be animated
on page 6647 .

Position Each gradient has 100 possible positions from left to right. The
number in the spinner represents the position of the flag along the gradient.
Gradients are read from left to right so a value of zero aligns the flag with the
left edge of the gradient. This flag parameter can be animated.

Gradient Options

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose a Lens Effects Filter from the Filter Plug-In list. > Setup > Gradient
tab

Each gradient in Lens Effects has a set of common options. Right-clicking the
gradient bar displays a shortcut menu with the following options.

Interface

Reset Resets the gradient back to its default parameters. This action cannot
be undone.
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Load Gradient Displays a file open dialog in which you can load a particular
gradient. Gradients are saved with a .dgr extension.

Save Gradient Displays a file save as dialog where you specify the path and
filename for the gradient.

Load UV Map Lets you load a bitmap image and use each row of pixels of
the bitmap as an animated gradient. When a bitmap is loaded into a gradient
control, Lens Effects reads the first 100 pixels across the top row of the image
(for the 100 divisions of its gradient controls) and makes them the gradient.
With each successive frame, Lens Effects reads in the next row of pixels as the
gradient. When you scrub the animation slider, you can see the gradient
change over time.

NOTE If the animation is longer than the chosen bitmap is tall, then the bitmap
pattern is repeated.

Load Bitmap Displays a 3ds Max file browser so you can select a bitmap to
use as your gradient. Unlike UV Map, the Load Bitmap option only reads the
first row of pixels for the entire animation. This is a good option when you
need to have a complex but static gradient.

Flag Mode Indicates you are using flags to set the colors of your gradient
instead of using a bitmap as the source. Flag Mode is selected by default.

Compositing Methods

The last five options on the shortcut menu are different types of compositing
methods. When you work with Color and Transparency gradient controls in
any of the Lens Effects filters, you must be aware of both the Radial and Circular
gradients. Both Lens Effects color gradients and both Transparency gradients
are "locked together" and will work together based on the compositing method
you choose to create an effect.

Each compositing method works on a pixel-by-pixel basis on the positional
value in both gradients. The compositing methods define how the colors and
brightness values are combined to form a single color. When combining the
colors, the algorithms evaluate each color channel of the color to find the end
result. This lets you create five very different looking effects with the same
two gradients.

High Value When this option is selected, the higher color or brightness value
between the two gradients is selected. For example, if you had a color with
RGB values of 255,210,255 and another with 225,240,225, the resulting color
would be 255,240,255. This option generally results in a slightly brighter lens
flare than the default settings.
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This is the most common way of using only one gradient. Set one gradient to
the color or brightness you desire, then set the other gradient to pure black.
This assures that all of the values you set in one gradient are used exclusively
to achieve the effect.

Average Calculates an average value between the colors. In the example
above, the resulting color would be 175, 225, 225. This option is good if you
want to mix gradient values and results in effects that are not as bright as
High Value.

Low Value Selects the lower color values, resulting in a less intense lens flare
and a more subtle overall effect. In the example above, the resulting color
would be 100,210,295.

Additive Adds colors values together, pushing their composite value toward
pure white, producing the brightest but most washed-out effects. Additive
compositing is good when you want to burn effects out.

Subtractive Subtracts colors values from each other, resulting in slightly
muted and less intense colors.

These compositing methods may be applied to all types of gradients, except
size gradients. The type of compositing being used for a gradient is noted
above the gradient bar.

Compositing methods are applied to every gradient. Some gradients are linked
together, so if you assign a specific compositing method to one, the
compositing method is automatically assigned to the other.

Types of Gradients

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose a Lens Effects Filter from the Filter Plug-In list. > Setup > Gradient
tab

There are two different kinds of gradients in Lens Effects, Radial and Circular.
Between the two types, you can achieve almost limitless effects.

Interface

Radial Radial gradients work from the center point to the outer edge of a
Lens Effects feature, changing color or brightness in a straight line from left
to right as you scan the gradient bar. The left edge of the gradient is aligned
with the center of the effect and the right edge is aligned with the outer edge
of the effect.
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Scheme of a radial gradient

Circular Changes colors in a circular manner, working clockwise around a
Lens Effects feature. If you mark North, East, South, and West on a circle,
these points represent the 0%, 25%, 50%, and 75% marks of the gradient.

Each parameter panel in Flare, Glow, and Highlight that utilizes gradients
contain five gradient controls. The five controls are:
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Scheme of a circular gradient

Color (Radial and Circular) Defines the colors used on page 6707  for an effect.
This is based on the RGB color system, but can also be set with HSV. Within
each set of gradient controls, there is a Radial and Circular Color gradient.
Radial Color works with Circular Color to produce the overall color for the
Lens Effects element.

Transparency (Radial and Circular) Varies the visibility of parts of the effect.
The transparency gradients only make use of brightness (or luminance) values,
which are essentially grayscale values. This black-to-white ramp of values
provides you with 256 levels of transparency for your effects. Just like the
Color gradients, both Transparency gradients are tied together to generate the
overall visibility of effect. See Gradient Options on page 6702 .

Size Varies the size of specific parts of the Lens Effect. Most size gradients
are used to affect the radius of a lens flare part, such as a glow. Like
transparency gradients, only the brightness values are used to provide you
with 256 different sizes.

The Radial Size gradient, for example, works both like a Radial and Circular
gradient. This gradient is applied in a clockwise fashion, starting at 12 o'clock.
The values in the gradient are applied from the center of the effect toward the
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outer edge, with brighter values producing bigger sizes and darker values
producing shorter sizes.

Gradient Colors

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose a lens effects filter from the Filter plug-in list. > Setup > Gradient
tab

Colors in 3ds Max are interpreted in two different ways: RGB and HSV. In
RGB (red, green, blue), you can select one of 256 shades of red, green, and
blue, giving you a palette of 16.7 million colors (24 Bit). In HSV (Hue,
Saturation, Value), you can select one of 256 hues of color, then adjust the
saturation or the value of the color. The saturation can also be considered the
blackness of a color and value can be considered the whiteness of a color.

For transparent and size gradients, you adjust the vertical whiteness slider just
to the left of the RGB and HSV sliders. The white triangle on the right side of
the vertical bar is the slider. This controls the overall value of the color in
terms of HSV. In RGB terms, it is the same as adjusting all three colors equally
at the same time. Higher values on the whiteness scale represent more
transparency, or smaller sizes.

See also:

■ Color Selector Dialog on page 331

Layer Events

Alpha Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer Event > Choose Alpha
Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select an Alpha
Compositor > Video Post toolbar > Edit Current Event
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The Alpha compositor composites the two images using the alpha channel
on page 7709  of the foreground image. The background image appears in areas
where the foreground image's alpha channel is transparent.

Procedures

To use the Alpha Compositor filters:

1 Add two Scene or Image Input events to the queue.

2 Select both events and assign an Image Layer event consisting of the
Alpha Composite Filter.

3  Select the Image Layer event and click Edit Current Event.

Cross Fade Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer Event > Choose Cross
Fade Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Cross Fade
Compositor. > Video Post toolbar > Edit Current Event

The Cross Fade compositor composites the two images over time, cross-fading
from the background image to the foreground image. The rate of the cross
fade is determined by the length of the Cross Fade Transition filter's time
range.

Cross Fade fades one image into another over time.
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There are no setup options for this compositor.

Procedures

To use the Cross Fade Compositor:

1 Add two Scene or Image Input events to the queue.

2 Select both events and assign an Image Layer event consisting of the
Cross Fade Compositor.

Pseudo Alpha Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer Event > Choose
Pseudo-Alpha Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Pseudo-Alpha
Compositor. > Video Post toolbar > Edit Current Event

The Pseudo-Alpha compositor composites a foreground image against the
background by creating an alpha channel for the foreground image based on
the foreground image's upper-left-corner pixel. All pixels in the foreground
image that use this color become transparent.

Pseudo Alpha compositing

Because only one pixel color becomes transparent, edges of the opaque areas
in the foreground image are aliased. Use this method when the foreground
image is a bitmap whose format does not have an alpha channel.

There are no setup options for this compositor.
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There is also a Pseudo Alpha filter event on page 6641 .

Procedures

To use the Pseudo Alpha Compositor:

1 Add two Scene or Image Input events to the queue.

2 Select both events and assign an Image Layer event consisting of the
Pseudo Alpha Composite Filter.

Simple Additive Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer Event > Choose Simple
Additive Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Simple Additive
Compositor. > Video Post toolbar > Edit Current Event

The Simple Additive compositor composites the two images using the second
image's intensity (HSV value) to determine transparency. Areas of full intensity
(255) are opaque; areas of zero intensity are transparent; and areas with
intermediate transparency are translucent.

Additive compositing

This layer event can be useful when the second image is a bitmap whose format
does not have an alpha channel.

There are no setup options for this compositor.
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Procedures

To use the Simple Additive Compositor:

1 Add two Scene or Image Input events to the queue.

2 Select both events and assign an Image Layer event consisting of the
Simple Additive Compositor.

Simple Wipe Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer Event > Choose Simple
Wipe Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Simple Wipe
Compositor. > Video Post toolbar > Edit Current Event

The Simple Wipe compositor reveals or erases the foreground image with a
wipe transition. Unlike the Wipe filter on page 6642 , the Wipe layer event
moves the image, sliding it in or out.

The rate of the wipe is determined by the length of the Wipe compositor's
time range.

Wipe reveals an image by wiping from one side to the other, over time.

Procedures

To use the Simple Wipe compositor:

1 Add two Scene or Image Input events to the queue.
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2 Select both events and assign an Image Layer event consisting of the
Simple Wipe Compositor.

3  Select the Image Layer event and click Edit Current Event.

4 Click Setup to display the Simple Wipe Compositor Setup dialog.

Interface

Direction group

Right-pointing arrow Wipes from left to right.

Left-pointing arrow Wipes from right to left.

Mode group

Push Reveals the image.

Pop Erases the image.
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Managing Scenes and
Projects

These topics are concerned with managing scenes, projects, and the files that make them up.

Working with AutoCAD, Revit, and AutoCAD Architecture

3ds Max contains many features designed to streamline the design visualization workflow.
See Working with Drawing Files on page 6774 . The File Link Manager on page 6783  allows you
to create a live link to a DWG file. You can then apply materials and animations in 3ds Max,
but still update your geometry if any changes are made to the original file.

File-Handling Commands

The principal commands for handling files on page 6715  are found on the default File menu
on page 7259 , as in most Windows applications.

File-Handling Utilities

Several utilities help you manage files:

■ The Asset Browser on page 6928  provides another way to find and preview files and use
them in 3ds Max scenes

■ The Bitmap / Photometric Path Editor utility on page 6938  lets you view bitmap paths or
remove them from the scene file.

■ The File Finder on page 6939  is another resource for finding 3ds Max scenes.

■ The Resource Collector on page 6942  copies or moves a scene's bitmaps into a single
directory.

■ The Fix Ambient utility on page 6944  resolves lighting issues with older versions of scene
files.
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■ The Bitmap Pager Statistics dialog on page 6947  provides information that helps you
resolve issues with scenes that require large amounts of memory for texture maps.

■ The Substitute modifier on page 1691 lets you replace linked AutoCAD Architecture objects
with native 3ds Max geometry and objects.

Geometry File Formats

You can import a variety of geometry file formats on page 6958  into a scene.

Image File Formats

You can use image file formats on page 7116  in a variety of ways: as textures for materials,
as backgrounds to viewports, as background environments, as Image Input events in Video
Post, and as images projected from a light.

External References (XRefs) to Objects and Scenes

External references on page 6729  to objects and scenes are another powerful way to manage
a project, especially when it involves multiple contributors.

RAM Player

You can preview images by using the View File command on page 6923  , or by using the
more interactive RAM Player on page 7166 .

Scene Explorer

Scene Explorer on page 7171  is a powerful tool for organizing scene elements, selecting object
based on various criteria, changing object display properties, and creating and modifying
object hierarchies.

Scene States

The Scene States on page 7193  feature provides a fast way to save different scene conditions
with various properties that can be restored at any time and rendered to produce different
interpretations of a model.

Schematic View

Schematic View on page 7197  displays the scene as a graphic schema instead of as geometry.
It gives you an alternate way to select or rename the objects in your scene, and to navigate
among modifiers. It is especially useful for viewing objects in a hierarchy.
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Layers

Layers on page 7224  are like transparent overlays on which you organize and group different
kinds of scene information. The objects you create have common properties including color,
renderability, and display.

File-Handling Commands
The main file-handling commands are on the default File menu on page 7259
. These commands are for creating, opening, and saving scenes; importing
and exporting other 3D file formats; viewing a 2D image file; displaying or
changing a scene file's properties; exiting 3ds Max and other operations.

New on page 6716

Reset on page 6717

Open on page 6718

Open Recent on page 6723

Save on page 6723

Save As on page 6724

Save Copy As on page 6726

Save Selected on page 6727

XRef Objects on page 6732

XRef Scene on page 6755

File Link Manager Utility on page 6783

Merge on page 6854

Merge Animation on page 6859

Replace on page 6866

Load Animation on page 6873

Save Animation on page 6876

Import on page 6892

Export on page 6894

Export Selected on page 6895
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Asset Tracking on page 6897

Archive on page 6918

Summary Info on page 6919

File Properties on page 6920

View Image File on page 6923

Exit on page 6926

See also:

■ Asset Browser Utility on page 6928

■ Geometry File Formats on page 6958

■ Image File Formats on page 7116

■ RAM Player on page 7166

New

File menu > New

Keyboard > Ctrl+N

New clears the contents of the current scene without changing system settings
(viewport configuration, snap settings, Material Editor, background image,
and so on). The New command also gives you the option, when you use it
while a populated scene is active, to reuse objects from the current scene in
the new one.

Procedures

To create a new scene:

1 Choose File > New or press Ctrl+N.

2 In the New Scene dialog, specify the types of objects to keep, if any.

3 Click OK.
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Interface

The New Scene dialog has the following controls:

Keep Objects and Hierarchy Keeps the objects and the hierarchical links on
page 7806  between them, but removes any animation keys on page 7824 .

NOTE If the current scene has any file links, 3ds Max performs a Bind operation
on all linked files.

Keep Objects Keeps the objects in the scene, but removes any links between
them and any animation keys.

WARNING This option should not be used when working with a scene containing
linked or imported objects.

New All (Default) Clears the contents of the current scene.

Reset

File menu > Reset

Reset clears all data and resets the program settings (viewport configuration,
snap settings, Material Editor, background image, and so on). Resetting restores
the startup defaults, saved in the file maxstart.max  , and removes any
customization you might have done during the current session.
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Resetting has the same effect as exiting and restarting 3ds Max.

TIP To change the startup defaults, start 3ds Max and make the adjustments you
would like to see at startup. Then save the file to your scenes/  directory as
maxstart.max  .

Procedures

If you have made changes since the last Save operation, a dialog prompts you
whether you want to save your changes.

To reset 3ds Max:

1 Choose File > Reset.

If you have made any changes since the last Save operation, a dialog
prompts you to save them. As further protection against data loss, a
confirmation dialog appears.

2 When asked if you really want to reset, click Yes.

Clicking No on this dialog cancels the Reset operation.

Open

File menu > Open

Keyboard > Ctrl+O

Open loads a scene file (MAX file), character file (CHR file), or VIZ Render file
( DRF File on page 6964 ) from an Open File dialog. You can also choose a
previously opened file and use command-line options on page 7254 .

The MAX file type is a complete scene file.

A CHR file is a character file saved with Save Character. For more information
on the CHR file format, see Character Assembly on page 217  and Save
Character on page 243 .

A DRF file is a scene file from VIZ Render, a rendering tool included with
AutoCAD Architecture (formerly Autodesk Architectural Desktop). The DRF
file type is similar to MAX files from previous versions of Autodesk VIZ.

If the file you're loading was created using plug-ins that are not installed, a
dialog lists them. You can still load the file, but any entities in the scene that
were created by the missing plug-ins are replaced with stand-ins; non-rendering
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boxes or placeholder modifiers. You can safely delete these from the scene,
unless you are sharing the scene with a user who has the plug-ins installed.

If the file you are loading contains bitmaps that cannot be located, a Missing
External Files dialog on page 6926  appears. This dialog lets you browse for the
missing maps, or continue opening the file without loading them.

Automatic Unit Conversion

When Respect System Units In Files is turned on in the System Unit Scale
group of the System Unit Setup dialog on page 7601 , loaded files that have a
different scene unit scale display a File Load: Units Mismatch dialog on page
7608 . This dialog lets you rescale the loaded scene to the current scene unit
scale, or change the current scene unit scale to match the one in the loaded
file. No conversion is done when loading files created in 3ds Max 1.x.

■ If you choose to match the units in the loaded file, the System Unit Scale
setting in the System Unit Setup dialog is changed to the setting in the
scene file.
This is the recommended choice, and it is the default in 3ds Max.

For example, if the current system unit scale is set to 1 unit = 1 inch, and
the incoming file was set to 1 unit = 1 foot, a sphere with a radius of 100
feet remains 100 feet.

■ If you rescale the file objects, the objects are scaled as if they had been
created using the current scene unit scale.
For example, if the current system unit scale is set to 1 unit = 1 inch, and
the incoming file was set to 1 unit = 1 foot, a sphere with a radius of 100
feet becomes 1200 inches in radius (assuming the unit display is set to
generic units).

If Respect System Units In Files is off (which is not recommended), 3ds Max
disregards the units chosen in the loaded scene file.

For example, a 100-unit radius sphere that was created in a 1 unit = 1 foot
scene becomes a 100-inch sphere in a 1 unit = 1 inch scene.

Procedures

To reopen a previously opened file:

■ From the bottom of the File menu, choose the file name.
You set the number of files listed by changing the Recent Files In File
Menu on page 7541  field on the Files panel of the Customize > Preferences
dialog.
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To start 3ds Max and open a specific file:

■ In a command prompt window, specify the file name after the executable
name. For example:
“c:\Program Files\Autodesk\3ds Max 2008\3dsmax.exe” myproject.max

To start 3ds Max and open the last file you worked on:

■ In a command prompt window, type -L after the executable name:
“c:\Program Files\Autodesk\3ds Max 2008\3dsmax.exe” −l

Interface

The Open File dialog has standard Windows file open controls. At the right,
the Thumbnail area shows a preview of the scene whose file name is
highlighted in the list on the left.

TIP You can resize the dialog by dragging an edge or a corner.

 Clicking the plus button appends a sequence number to the file name
you entered, or increments the sequence number if the name already has one,
and then opens the file of that name, if it is present.

For example, if you have highlighted a file named test00.max, clicking the +
button changes the name to test01.max and then opens that file.
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Opening an Obsolete File

When opening a scene created in an earlier version of 3ds Max, you will see
an Obsolete File dialog.

If you resave the scene, you will overwrite the file. You can still edit it using
3ds Max, but you will no longer be able to edit it in earlier versions of the
software.

Don't display this message When turned on, you will not see the Obsolete
File dialog. The dialog is also controlled by the Display Obsolete File Message
switch on the Customize > Preferences > Files panel.

NOTE If you still need to open the scene using an earlier version of 3ds Max, use
File > Save As on page 6724  and save the file using a different name. Then you will
be able to open the orginal file with the earlier version.

Open from Vault

File menu > Open from Vault

The Open From Vault command lets you open a MAX file directly from
Autodesk Vault, the data-management provider included with 3ds Max. This
allows for secure control and versioning of assets used in the digital-content
creation process without the need to use the Vault client.

NOTE Open from Vault appears on the File menu only if you installed the Vault
plug-in, an optional part of the 3ds Max software installation

See also:

■ Asset Tracking on page 6896
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Procedures

To use Open From Vault:

1 Open the File menu and choose Open From Vault.

2 If you're not logged in to a provider, you're asked to log in via the Vault
Log In dialog on page 6902 . Fill out the form and then click OK.

3 Use the Open File From Vault dialog to browse the vault and choose a
MAX file to open.

4 At this point, one of two things happens:

■ If the file is available for checkout, a dialog opens letting you know
that the file is under version control and asking you if you want to
check it out before making edits. Click Yes.

■ If another user has the file checked out, a dialog opens notifying you
of this and telling you that you won't be able to save edits. Click OK
to open the file in read-only mode. If you attempt to save this file, a
dialog appears notifying you that the scene file is read-only and will
not be overwritten.

5 If you attempt to open a different file or use the New or Reset command
while the file is checked out, a dialog appears asking if you want to check
the files back in. Enter a comment, if appropriate, and then click OK to
check the file in.

Alternatively, if you just want to create a new version on the provider,
turn on Keep Checked Out and then click OK. A new version will be
created, but the file will still be checked out to you.

Interface

NOTE If you haven't set a working folder, the following dialog appears when you
attempt to open a file from the vault:
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After you click OK, the Browse For Folder dialog opens, which you can use to
specify a working folder.

Open Recent

File menu > Open Recent

Open recent displays a list of recently opened and saved files. The list is sorted
in chronological order, with the most recent files at the top.

Procedures

To change the number of files displayed in the Open Recent list:

1 Choose Customize > Preferences > Files tab > File Handling.

2 Set a value for Recent Files In File Menu. The upper limit is 50.

Save

File menu > Save

Keyboard > Ctrl+S

Save updates the current scene by overwriting the last save of the scene. If no
scene was previously saved, this command works like Save As on page 6724 .

See also:

■ Save As on page 6724

■ Save Copy As on page 6726

Saving to an Obsolete File

When you open a file that was created with an earlier version of the software,
and then attempt to save it in a current version of 3ds Max, an alert is
displayed, warning you are about to overwrite the obsolete file.
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Choose Yes to go ahead and overwrite the original file, No to stop the Save.
If you choose No, you can use Save As on page 6724  to save the file under a
different name.

If you save to the original file name, you can still edit it using the current
version of the software, but you will no longer be able to edit it in earlier
versions of 3ds Max.

Interface

When you save a scene, you also save the program settings. When you open
the file again, it opens with the same viewport configuration, view and zoom
levels, snap and grid settings, and so on.

You can incrementally number saved files, and make automatic backup files
at specified time intervals. These options, Increment On Save and Backup On
Save, are on the Files panel on page 7541  of the Preference Settings dialog.

Save As

File menu > Save As

Save As lets you save the current scene filein MAX or CHR format under a
different file name.

A CHR file is a character file saved with Save Character. For more information
on the CHR file format, see Character Assembly on page 217  and Save
Character on page 243 .

6724 | Chapter 21   Managing Scenes and Projects



NOTE 3ds Max lets you number saved files incrementally and make automatic
backup files at specified time intervals. The options to set up Increment On Save
and Backup On Save are on the Files panel on page 7541  of the Preference Settings
dialog.

See also:

■ Save on page 6723

■ Save Copy As on page 6726

Procedures

To save a file to a different name:

1 Choose File > Save As.

2 Do one of the following:

■ Enter a name in the File Name field.

■ Click the Increment button.

Interface

The Save File As dialog has standard Windows file save controls. At the right,
the Thumbnail area shows a preview of the scene whose file name is
highlighted in the list on the left.

TIP You can resize the dialog by dragging an edge or a corner.
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 Clicking the plus button appends a sequence number to the file name
you entered, or increments the sequence number if the name already has one,
and then saves the file to that name.

For example, if you have highlighted a file named test00.max, clicking the
plus button changes the name to test01.max and then saves test01.max.

Save Copy As

File menu > Save Copy As

Save Copy As allows you to save a copy of the current scene under a different
file name. It does not change the name of the file being worked on.

IMPORTANT Save Copy As does not update the original file name as Save does,
and Save does not update the file you last saved using Saved Copy As. For example,
if you make edits to a 3ds Max scene named filename.max , then use Save Copy
As with the file name filename01.max , make additional edits, and then click
Save, your second set of edits will be saved as filename.max  but not  as
filename01.max .

See also:

■ Save on page 6723

■ Save As on page 6724

■ Auto Backup on page 7541

Procedures

To save a copy of the file to a different name:

1 Choose File > Save Copy As.

2 Browse or type the name of the file you want to create or update.

3 Click the Save button.
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Interface

Save Copy As displays a standard Windows save dialog. Save Copy As
increments the number at the end of the file name in order to propose unique
but similarly-named files each time the command is used.

Clicking the Save button saves the file to the name displayed in the File Name
text box.

TIP You can resize the dialog by dragging an edge or a corner.

 Clicking the plus button saves the file with a name ending in a number
one increment greater than that displayed in the File Name text box.

Save Selected

Select objects to save. > File menu > Save Selected

Save Selected saves the selected geometry as a scene file under a different file
name.

Identically named bitmaps with different properties are stored as different
files. Objects linked to a selected object are also saved. The following
dependencies are preserved for a Save Selected operation:

■ Ancestors of selected child objects are saved, all the way to the root of the
hierarchy.
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■ Space Warps to which selected objects are bound are saved.

■ IK follow objects to which selected objects are bound are saved.

Procedures

To save selected objects to a new file:

1 Select one or more objects.

2 Choose File > Save Selected.

3 Enter a name in the File Name field.

4 Click Save.

Set Project Folder

File menu > Set Project Folder

You can set a project folder when setting up a project, to provide a simple
way of keeping all of your files organized for a particular project. When you
open 3ds Max for the first time, the project folder defaults to the install folder,
but you can set the folder to a different location. When you set the project
folder, 3ds Max automatically creates a series of folders within it such as scenes
and renderOutput. Saving or opening files from the browser defaults to this
location.

Using a consistent project folder structure among team members is a useful
practice for both organizing and sharing files. You can also set the project
folder from the Asset Tracking Dialog on page 6897  > Paths menu.

Procedures

To set the project folder from the File menu:

1 Choose File > Set Project Folder.

2 Choose a path from the browser and click OK to set your project folder.
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Interface

Use the browser controls to navigate the disk structure to the project folder
to use, highlight the folder name, and then click OK.

Make New Folder Click this to create a folder named New Folder within the
highlighted folder. When first created, the folder name is highlighted so that
you can edit it; use the keyboard to rename the folder, or press Enter to accept
the default name.

External References (XRefs)

You can use two kinds of externally referenced files (XRefs): XRef Objects on
page 6732  and XRef Scenes on page 6755 . Using these external references allows
for a team approach to animation, where the modeling, materials, transform
controllers, and animation can be handled in separate files by different artists.
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It can also make large files much easier to deal with through the use of proxy
objects.

You access the XRef Objects and XRef Scenes commands from the File menu.

The two types of references have distinct purposes:

■ An externally referenced scene displays the entire contents of an external
MAX file in the current scene. The objects within the external file are
visible as a reference but cannot be selected. This prevents accidental
changes to the referenced scene while allowing functionality such as Snap,
AutoGrid, and Clone and Align to position local objects in context, as well
as to pick objects as the target location for the clones. If you need to move,
rotate or scale the referenced scene, you can bind it to a local object.
Transforming the object the externally referenced scene was bound to will
transform all objects in the externally referenced scene. Scene externally
referenced objects can also be used as reference coordinate system on page
896 . When changes to the externally referenced file are saved (such as
objects added, edited or deleted), an Update of Xref Scene will inherit those
changes locally.

■ Externally referenced objects appear in the scene and can be animated.
Depending on the object's XRef settings, you might or might not be able
to edit the object’s entities such as its transforms, materials, manipulators,
or modifiers. You can add modifiers and apply transform animation to the
referenced objects, but you cannot inadvertently change the model’s
structure. Referenced objects allow for the substitution of a proxy object,
so you can animate a low-polygon version of a complex model and then
render the polygon-intensive version.
You can also reference transform controllers externally in addition to
materials. This is part of the process of referencing objects, or you can also
use the special XRef controller on page 3194  or XRef material on page 5603
, respectively. By default, when referencing an object, its material and
transform controller is also referenced. Alternatively, you can create an
XRef controller or an XRef material that allows for referencing a transform
controller or a material from an external MAX file. These external references
can be assigned to any object in the scene, whether or not the object is
externally referenced.

NOTE Any atmospherics applied in an XRef object's source file will be carried
into the scene. Render Effects assigned to XRef objects are not externally
referenced.
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The use of referenced objects and scenes allows several people to work
collaboratively on the same objects as the work progresses, without having to
wait for the objects to be finalized. You can choose to have the objects update
automatically, as soon as changes are saved to the original file, or to update
manually, on demand.

There are also tools for easy conversion of scene objects into referenced objects,
and a button to merge referenced objects into the scene as normal objects.

Objects in a scene can be externally referenced, created and maintained by other users.
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XRef Objects

File menu > XRef Objects

Externally referenced objects, XRef objects, appear in your master (current)
scene, but are actually referenced from external 3ds Max files. As a result, the
source objects are protected from modifications you make to the XRef objects.
Updates or changes made to the source objects are also updated in the master
file when the source scene is reloaded. However, if an XRef object’s entities
are merged, the controls are local and can be modified. Therefore, they no
longer reference the original attributes.

For example, if you selected XRef or Ignore in the Modifiers group of the XRef
Objects dialog on page 6737 , the only entry in the modifier stack will be “XRef
Object.” You can add additional modifiers to the object, but you cannot access
the original ones unless you merge the XRef object into the scene. If you merge
the modifiers into the master scene, you can edit them in the stack. However,
changes that you make to the modifier stack in the master file have no effect
in the source file.

An externally referenced object can be animated in the master file only if its
transform controller has been merged. In other words, no animation can be
added or blended with an XRef controller. However, an offset can be added,
but it then applies to the whole animation, and the offset cannot be animated.

NOTE The XRef behavior of world-space modifiers is different than the object-space
modifiers. World-space modifiers are not externally referenced. They are always
merged.

Transforms and manipulators in your source file will be treated according to
the Merge Transforms and Merge Manipulators setting in the XRef Objects
dialog.
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Objects in a scene can be XRefs from other scenes. They can be transformed and
positioned in the scene using a local offset.

When an XRef object is loaded into the master file, it can have an XRef
material on page 5603  as well as an XRef controller on page 3194  assigned to it.
You can either merge the material and transform information or you can
maintain it as a live connection with the source file.

XRef objects can be modified or transformed in your master scene just like
any other object. XRef objects also allow the use of proxy objects to stand in
or substitute for geometry. Use XRef objects to manage the complexity of your
master scene during animation by substituting “lightweight” proxy objects
for more complex geometry.

You can create a proxy by simplifying a clone of your existing model or you
can build simple substitute objects like boxes or cylinders, or you can save a
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copy of the model in the early stages of modeling before you add the detail.
You can even use an object from another scene.

A proxy object is substituted in the scene, but the reference to the real object is always
available.

Choosing XRef Objects displays the XRef Objects dialog on page 6737 , where
you add externally referenced objects, transforms, and materials to your master
scene, and control their visibility, merge states, and other options.

If your XRef object relies on another object in the source scene, the relationship
will not be automatically preserved in the destination file. Examples of this
include objects with path constraints, atmospherics, particle arrays with object
emitters, or space warps bound to an object. To preserve the relationship
between the source objects in the master file, in the XRef Merge dialog, enable
Display Influences and select the object's influences. Objects that influence
each other must be referenced in the same record to maintain the relationship.

NOTE Render effects such as glow or flare are not carried in XRefs. To use render
effects from the source file, merge them in using the Merge buttons found in the
Environment And Effects dialog.
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Procedures

To add an XRef object:

1 Choose File > XRef Objects.

The XRef Objects dialog enables you to choose to Merge Transforms,
Merge Materials, and Merge Manipulators.

NOTE If you want to maintain externally referenced entities (transforms,
materials, manipulators, or modifiers), make sure Merge Transforms, Merge
Materials, and Merge Manipulators are off  and XRef Modifiers is selected
before you proceed to the next step.

TIP You can turn on  Include All on the XRef Objects dialog before  you click
Create XRef Record From File. This includes all objects, including influences,
transforms, and materials, and bypasses the XRef Merge dialog.

2  Click the Create XRef Record From File button in the XRef Objects
dialog. The Open File dialog appears. Choose the file you want by
highlighting it in the list, then click Open. The XRef Merge Dialog on
page 6752  appears.

If the Merge Manipulators toggle is off before you click Create XRef Record
From File, manipulators applied to XRef objects are linked to the
(externally referenced) source file. In a similar way, the Modifiers
drop-down list gives you three alternatives for how to handle object
modifiers.

If the Merge Materials toggle is off before you click Create XRef Record
From File, materials applied to XRef objects are linked to the (externally
referenced) source file. If Merge Materials is on, the materials are merged
with the master scene.

If the Merge Transforms toggle is off before you click Create XRef Record
From File, transforms applied to XRef objects are linked to the (externally
referenced) source file and cannot be keyframed in the master file. If
Merge Transforms is on, the transforms are merged with the master scene
and can be keyframed.

3 Select the objects that you’d like to appear in your master scene as XRef
objects.

You can choose as many as you want by holding down the Ctrl key and
highlighting them in the list. If the source scene has a lot of object types
you don't need to include, you can filter the list by using the List Types
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radio buttons. Use the All button to select all of the entries, the None
button to select no entries and the Invert button to highlight the opposite
of your current selection. You can also choose to display Influences and
Select Influences.

4 The XRef record appears in the upper list of the XRef Objects dialog and
has the same name as its source file. The externally referenced entities
appear in the lower list, where an entity can be either an object, a
controller, or a material. Make additional choices at this time if you like.
You can control how the objects will update (either automatically or on
demand). Updating is done at the XRef record level: all objects, transforms,
and materials from a single XRef record are updated at the same time.

To substitute an XRef object with a proxy object:

With proxy objects, you can avoid loading your detailed model in memory,
and speed up the time of test renderings.

1 Select an XRef object.

2  On the Modify panel > Proxy rollout, click the Browse button, and
use the File Open dialog to choose the file that contains the proxy.

The XRef Merge dialog appears.

3 Pick the object to use as a proxy.

When you have picked the proxy object, the Enable toggle should turn
on.

4 Turn on Use In Rendering to use the proxy object in renderings.

To add objects to an XRef record:

1 In the XRef Objects dialog, highlight an XRef record (in the top list) that
contains objects that have not already been added to the scene.

2  On the Entities List toolbar (the lower toolbar), click Add Objects.

This button is not available if all of the objects in the source file have
already been added to the XRef record.

The XRef Merge dialog appears.

3 Highlight the objects that you want to add as XRefs, and then click OK.
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The selected objects are added. Depending on the dialog settings,
transforms and materials might also be added as external references.

To change an XRef object into a scene object:

■  Highlight the XRef object in the Entities list (the lower list), and
then click Merge In Scene. The XRef object becomes a full-fledged object
in the scene, giving you access to its modifier stack.

TIP This button is also available in the upper Records list, where it merges all
entities from the highlighted source record into the master (current) scene.

XRef Objects Dialog

File menu > XRef Objects > XRef Objects dialog

The XRef Objects dialog provides the interface for loading XRef entities into
your master scene (the scene where you create the XRefs) from a source scene
(the scene file that contains the entities that you want to externally reference).
XRef entities can be XRef objects, transform controllers, materials, and
manipulators. An XRef record can be made up of one or more XRef entities.

The XRef Objects dialog is divided into the XRef Record section at the top
and the XRef Entities section at the bottom. The XRef Objects dialog provides
controls to add and remove XRef objects, controllers, and materials.

When you create XRefs, the mapping between each externally referenced item
and their source items is unique. This allows correct external referencing of
source items with identical node names. However, if you retarget an externally
referenced item by choosing a source object name that is not unique in the
source scene, 3ds Max might not map the externally referenced item to the
desired source object.
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Interface

TIP You can resize the XRef Objects dialog. This can be useful if you want to see
all of the columns in the XRef Entities list. You can also adjust the relative height
of the two lists in the dialog: Drag the horizontal line that is just above the XRef
Entities toolbar (the lower of the two toolbars).

XRef Record toolbar

Use these tools to create and update XRef records.

 Create XRef Record from File Launches an Open File dialog so you
can select the source file for your XRef record. When you a select a file, the
XRef Merge dialog on page 6752  appears.

Any transform animation assigned to the source objects can be merged along
with the XRef object, but it will not be updated with the source object.

NOTE If you want to maintain externally referenced transforms, materials, and
manipulators, make sure Merge Transforms, Merge Materials, and Merge
Manipulators in the XRef Objects dialog are off  before you click Create XRef
Record from File.
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 Remove XRef Record Deletes the highlighted XRef record(s) after you
confirm the action. All entities associated with the highlighted record(s) are
removed from the scene.

NOTE Once you have removed an XRef record, you cannot undo this action.

 Combine XRef Records Click to combine the contents of more than
one XRef record from the same source file into one record. This is useful when
you want to clean up the organization of your XRef records. Rather than
having multiple records of the same file, you can group all of the objects,
controllers, and materials from that file under the same record. This button
is available only when you highlight two records that refer to the same file
name and path; both records must have identical settings. XRef records must
refer to the same file with the same XRef entities. Combine XRef Records only
allows you to consolidate all of the entities of one file into one XRef record
entry. It does not allow you to combine the contents of different files, even
if the files have the same name.

NOTE Nested externally referenced records cannot be combined.

 Update Refreshes the contents of the selected XRef record. If the
objects, controllers, materials, or manipulators referenced have changed in
the source scene, you will see these changes in your master scene.

NOTE The changes must be saved in the source file before you see them in the
master file. If you remove externally referenced entities from the master file using
the Delete XRef Entity button, these entities will not be externally referenced when
you update the XRef record, even though they continue to exist in the source
scene.

NOTE Reloading XRef items works correctly even when an object in the source
scene has been renamed, or deleted and then re-created with the exact  same
name, including character case. However, if the source scene contains several
nodes with the same name, an XRef item corresponding to a node whose name
is not unique in the source scene might not necessarily resolve as you expect
during the update process. For best results, maintain unique names for all nodes
in the source scene.
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WARNING If you update an XRef in a scene with radiosity on page 5976 , probably
this will invalidate the radiosity solution. After you update the XRef, reset the
radiosity solution and then recalculate it.

 Merge In Scene Converts all XRef entities of the highlighted record
into native (local) entities in your master scene. The objects, controllers,
materials, and manipulators are no longer referenced from the source file but
become part of your master scene. A prompt appears so you can confirm the
action. Since a merged XRef entity becomes part of the scene and is no longer
an XRef entity, its name is removed from the XRef Entities list. This works on
a XRef record basis, so all entities belonging to the highlighted XRef record
are converted. The contents of the source file are not affected by this button.

Merging an XRef object loads the full modifier stack of the source object into
the master scene (your current scene), while maintaining any additional stack
items that were added while the object was an external reference. Thus, you
can use Merge In Scene to update an object that has been modified as an
external reference. Similarly, merging an XRef controller into the master scene
maintains any offset transformation you might have applied to the controller
in the master scene.

 Convert Selected Object(s) to XRefs Creates a source file for currently
selected objects. This means that you can select objects in the current scene,
including their transform controllers and materials, and then save them to a
separate scene file. This file is then listed as an XRef record that contains the
entities you selected.

NOTE This option can be used on both—native (local) objects or externally
referenced objects. If you use it for an object that is already an XRef object, it
creates a nested XRef. Nested XRefs still behave as you expect, but they can reduce
performance when you open a scene or render it.

 Select Selects all entities that belong to the currently highlighted
XRef record or records. To add highlighted records’ entities to the selection,
hold Ctrl while clicking Select. To remove highlighted records’ entities from
the selection, hold Alt while clicking Select.

 Select by Name Opens the Select Objects dialog on page 168 , which
lists all objects and highlights those belonging to the currently highlighted
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XRef record, as well as objects selected in the scene. Use this dialog to select
XRef objects.

 Highlight Selected Objects' XRef Records Based on the object(s)
selected in the scene, the corresponding record(s) that contain these objects
are highlighted in the XRef Objects dialog.

XRef Record list

Displays the names of the source files that contain the source objects used as
XRef objects in the current scene. These files are added using the Create XRef
Record button and removed using the Remove XRef Record button.

To see the full path of the source file, move the cursor over the name of an
XRef record. The full path is displayed in a tool tip.

If a source file itself contains external references, a plus/minus icon appears
to the left of its name. Click the icon to expand or collapse the display of
nested XRef entries. Nested XRef records that are missing and unresolved are
displayed in gray.

Right-clicking the XRef Record list displays a pop-up menu on page 6747  that
has additional options for managing the list and its records.

Enabled Turn off to disable all XRef objects referenced from the .max files
currently highlighted in the XRef Record list. Disabled external reference files
and objects are are not loaded into memory. Default=on.

Include All If you turn this on before you add an XRef record, all the objects
in the source file are included as external references. This option bypasses the
XRef Merge dialog. Default=off.

If you create an XRef record when Include All is turned off, only those entities
selected for that XRef record (in the XRef Merge dialog) will be a part of the
record: any new objects created in the source file will not be part of the record.
If Include All is turned on when you create a record, any new objects created
in the source file will be included in the XRef record when you reopen or
Update the master file. If Include All is turned on before a record is updated
(after the first XRef), all new objects will be included in the XRef, but turning
if off later will not remove them from the record.

If the source scene includes nested external references, using Include All can
cause some confusion if you are not careful about your tree of scenes. Consider
the following arrangement:

master.max (Include All) --> a.max (Include All) --> b.max
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If you later open b.max, create objects, and save it, then open master.max
without first opening and saving a.max, you won't see the new objects created
in b.max. The scene master.max is simply reading a.max, and since a.max hasn't
changed, the new objects aren't present.

Automatic Update When on, changes made to externally referenced objects,
controllers, materials, and manipulators in the source scene are automatically
updated in the master file as soon as the source file is saved. There's no need
to click Update. Default=off.

NOTE You can change the state of Enabled, Include All, and Automatic Update
after a record is created.

Merge Transforms When on, combines all objects' externally referenced
transform controllers from the source file into the master file. This means that
the transform controllers will be loaded in the master file but will then no
longer have a live connection with the source file. This is useful if you don't
require the live connection, and want to alter the transform controllers in the
master scene without losing your edits upon Update. Default=off.

To use Merge Transforms, you must turn on this option before you add the
XRef record (source) file.

Merge Materials When on, combines all externally referenced materials
from the source file into the master file. This means that the materials will be
loaded in the master file but will then no longer have a live connection with
the source file. This is useful if you don't require the live connection, and
want to alter the materials in the master scene without losing your edits upon
Update. Default=off.

To use Merge Materials, you must turn on this option before you add the XRef
record (source) file.

When Merge Materials is on and there are name conflicts between materials
in the target scene and materials in the XRef source scene (or between materials
in two XRef records), 3ds Max displays a Duplicate Name dialog on page 5272
so you can resolve the conflicts.

Merge Manipulators  When on, any manipulator on page 2552  applied to
the XRef object in the source file is combined into the scene. Manipulators
are applied to the XRef object and can be changed. However, these changes
have no effect in the XRef source file. Default=off.

To use Merge Manipulators, you must turn on this option before you add the
XRef record (source) file.
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Modifiers Determines how modifiers from the source file will be loaded into
your master file. Modifiers are not listed as XRef entities. To see an XRef
modifier on the Modify panel, you must use the Merge option. Otherwise,
you have the choice of either not merging the modifier information at all
(with the Ignore option) or merging the information with the object with the
XRef Modifiers option.

You must choose the Modifiers option before you add the XRef record (source)
file.

■ XRef Modifiers are contained within the XRef object and cannot be
changed in the master scene. When you load the external reference file,
you will see the results of the modifier but they will not be listed separately
from the object on the Modify panel. Additional modifiers can be applied
to the XRef object, and will be a part of the scene; however, they will not
be reflected back to the source file.

NOTE World-space modifers remain at the top of the modifier stack and are
not merged with XRef objects.

■ Merge Modifiers assigned to the XRef object (in the source file) are
merged into the master scene. When you load the external reference file,
you will see the changes caused by the modifier and they will appear in
the modifier stack in the Modify panel. The modifiers are copies of the
original source modifiers. Although they inherit their original state, updates
to the XRef will not overwrite changes made in the master scene. However,
these changes are not reflected in the source file.

■ Ignore Any modifiers assigned to the XRef object (in the source file) are
disregarded and the base object is brought into the master scene as an XRef
object. When you load the external reference file, the modifiers are not
applied to the object so the modifications in the source file will not be
reflected in the master file.

Although the Merge Transforms, Merge Materials, Merge Manipulators, and
Modifiers settings are disabled after you add a record, when you highlight the
record in the XRef Record list, the toggles and list field show the settings used
when the record was created.

XRef Entities toolbar

Add Objects Click to add further entities to the highlighted XRef
record. This button is available only when the highlighted XRef record contains
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objects that you have not yet referenced externally. The XRef Merge dialog
appears, with a list of the available objects. Highlight the objects to reference
externally, and then click OK.

NOTE If new objects have a relationship in the source file with objects that are
already in a record in the master file, update the record after Add Objects to refresh
the relationship. For example, if a car is referenced in a master scene, and the car
is later constrained to a new path in the source scene, adding the path with Add
Objects will not put the master car on the path. To do that, update the record.

Delete XRef Entity Click to delete the highlighted XRef. An alert
prompts you to confirm the action. All highlighted entities are removed from
the scene. You can delete XRef objects, controllers, or materials.

NOTE Deleting XRef controllers is equivalent to merging them into the master
scene. The reason for this is that nodes must have a transform controller at all
times, in order to be positioned in the scene. Deleting XRef materials is equivalent
to merging them into the master scene. This action could could impact all objects
in the master scene that use an XRef material, and could have implications difficult
to be foreseen.

Merge In Scene Merges the current selection in the XRef Entities list
into the master scene (the current scene). Use this button to change XRef
objects, controllers, or materials into objects, controllers, or materials that are
native to the current scene. The connection between the external entity from
the source scene and your master scene is broken, and the object, controller,
or material that you merged is no longer updated when the source scene
changes.

3ds Max prompts you to confirm the merge.

Since a merged XRef object becomes part of the scene and is no longer an
XRef object, its name is removed from the list.

Merging an XRef object loads the full modifier stack of the original object,
while maintaining any additional stack items that were added while the object
was an XRef object. Thus, you can use Merge to update an original object that
has been altered as an external reference. If you do this, use Convert Selected
Object(s) to XRefs to save out the “improved” original into a file, which then
can be merged back into the original source.
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NOTE It is also possible to merge into the master scene nested XRef entities. Once
they are merged, all externally referenced nesting levels are removed and the
scene entity from the lowest level source scene is merged into the master scene.
In case of XRef objects, modifiers applied in a nested source file are all merged
and present in the master scene.

List Objects When on, shows the XRef objects for the current XRef
record in the XRef Entities list.

List Materials When on, shows the XRef materials for the current
XRef record in the XRef Entities list.

List Controllers When on, shows the XRef controllers for the current
XRef record in the XRef Entities list.

NOTE You can enable any combination of the List buttons to show certain types
of entities and hide others.

Select Selects in the scene the XRef entities currently highlighted in
the XRef Entities list. To add highlighted entities to the selection, hold Ctrl
while clicking Select. To remove highlighted entities from the selection, hold
Alt while clicking Select.

Select by Name Opens the Select Objects dialog on page 168 , which
lists all objects and highlights the XRef objects selected in the XRef Entities
list, as well as any objects selected in the scene. If an XRef controller or XRef
material is highlighted in the XRef Entities list, the Select Objects dialog
highlights the object to which the XRef controller or material belongs to.

Highlight Selected Object's XRef Records When XRef objects are
selected in the scene, the XRef record to which they belong is highlighted in
the XRef Record list and the XRef objects and their XRef entities are highlighted
in the XRef Entities list.
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XRef Entities list

Displays the XRef objects, controllers, and materials that belong to the record
that is currently highlighted in the XRef Record list. If no source file is
highlighted, this list is empty.

Right-clicking the XRef Entities list displays a pop-up menu on page 6750  that
has additional options for managing the list as well as the objects, controllers,
and materials in it.

The XRef Entities list includes the following information for each XRef entity:

■ Scene Name Name of the entity in the master (current) scene. By default,
the name of the entity in the master scene is the same as the name of the
entity in the source file. If you change the name of the entity on the
command panel on page 7423 , the name will update in the XRef Entities
list.

■ Source Name Name of the entity in the source file. You cannot change
this name from the master file. If the name of the entity changes in the
source file, the XRef in the master file will become unresolved.

■ Type Whether the entity is an XRef object, controller, or material.

■ Status Usually this field displays “XRef Resolved” to indicate that the
XRef is valid. When an external reference is unresolved this field displays
“Unresolved XRef” An unresolved XRef indicates that there is no longer a
connection between the entity in your master file and the source file. This
can happen for a number of reasons. For example, the entity in the source
file might have been renamed or deleted, or the file cannot be found.

NOTE If you resolve the cross reference, the XRef will be resolved again when
you click Update.

■ Proxy Whether a proxy is enabled for the entity. You enable and disable
proxies for XRef entities on the Proxy Object rollout. Displays “–––” when
the proxy is disabled and “Enabled” when the proxy is enabled.

You can assign a proxy object using the Proxy Object rollout on page 6770
.

■ Proxy Render Whether the proxy will be used in the rendering. Displays
“–––” when the XRef object will be rendered and “Enabled” when the
proxy object will be rendered.

■ Proxy Name Name of the proxy object that will be used as the XRef
object.
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■ Proxy File Name Name of the file that contains the proxy object to use
for the XRef object.

■ Proxy Path Path of the file for the proxy object to use for the XRef object.

XRef Record List Right-Click Menu

File menu > XRef Objects > XRef Objects dialog > Right-click the list of XRef
Record list.

This contextual menu appears in the XRef Objects dialog on page 6737  when
you right-click the XRef Record list. It provides additional options for managing
the list.

Some of the options on this menu are unavailable unless you have highlighted
an XRef record.

Interface

Create XRef Record from File Launches an Open File dialog so you can select
the source file for your XRef record. When you a select a file, the XRef Merge
dialog on page 6752  appears.

Any transform animation assigned to the source objects can be merged along
with the XRef object, but it will not be updated with the source object.

NOTE If you want to maintain externally referenced transforms, materials, and
manipulators, make sure Merge Transforms, Merge Materials, and Merge
Manipulators in the XRef Objects dialog are off  before you click Create XRef
Record from File.

Remove XRef Record Deletes the highlighted XRef record(s) after you confirm
the action. All entities associated with the highlighted record(s) are removed
from the scene.

NOTE Once you have removed an XRef record, you cannot undo this action.

File Submenu

Open Opens the source file. If you have not saved changes to the (current)
master file, 3ds Max prompts you to do so.
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Browse Displays the Open File dialog that enables you to browse for a new
source file. The file you choose replaces the highlighted XRef record in the
XRef Objects dialog. Available only when a single file is highlighted.

Reveal Location in Explorer Launches Windows Explorer, open to the folder
in which the highlighted source file resides with the source file highlighted.
Available only when a single file is highlighted.

Strip Path Removes path information from the file name, saving only the
file name. The source file location is saved relative to the master file location.

WARNING If you strip the path before you have saved the master file, the record's
XRefs can become unresolved. This is because there is no location for the Untitled,
unsaved MAX scene.

Resolve Path to UNC Location If the record's file name has had its path
stripped, this option restores the full path name.

Combine XRef Records Click to combine the contents of more than one
XRef record from the same source file into one record. This is useful when
you want to clean up the organization of your XRef records. Rather than
having multiple records of the same file, you can group all of the objects,
controllers, and materials from that file under the same record. This option
is available only when you highlight two records that refer to the same file
name and path; both records must have identical settings. XRef records must
refer to the same file with the same XRef entities. Combine XRef Records only
allows you to consolidate all of the entities of one file into one XRef record
entry. It does not allow you to combine the contents of different files, even
if the files have the same name.

NOTE Nested externally referenced records cannot be combined.

Update Refreshes the contents of the selected XRef record. If the objects,
controllers, materials, or manipulators referenced have changed in the source
scene, you will see these changes in your master scene.

NOTE The changes must be saved in the source file before you see them in the
master file. If you remove externally referenced entities from the master file using
the Delete XRef Entity button, these entities will not be externally referenced when
you update the XRef record, even though they continue to exist in the source
scene.
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WARNING If you update an XRef in a scene with radiosity on page 5976 , probably
this will invalidate the radiosity solution. After you update the XRef, reset the
radiosity solution and then recalculate it.

Select Selects the entities that belong to the currently highlighted XRef
record.

Select by Name Opens the Select Objects dialog on page 168 , which lists all
objects and highlights those belonging to the currently highlighted XRef
record. Use this dialog to select XRef objects.

Highlight Selected Objects' XRefs Records Based on the object(s) selected
in the scene, the corresponding record(s) that contain these objects are
highlighted in the XRef Objects dialog on page 6737 .

Highlight All Highlights all XRef records in the XRef Record list.

Highlight Inverse Highlights all XRef records in the XRef Record list except
the currently highlighted record(s).

Highlight None Turns off highlighting for any XRef records currently
highlighted in the XRef Records list.

Hide All Unresolved Hides all unresolved XRef records in the XRef Record
list.

Select All Unresolved Highlights all unresolved XRef records in the XRef
Record list.

Merge In Scene Converts all XRef entities of the highlighted record into
native (local) entities in your master scene. The objects, controllers, materials,
and manipulators are no longer referenced from the source file but become
part of your master scene. A prompt appears so you can confirm the action.
Since a merged XRef entity becomes part of the scene and is no longer an XRef
entity, its name is removed from the XRef Entities list. This works on a XRef
record basis, so all entities belonging to the highlighted XRef record are
converted. The contents of the source file are not affected by this option.

Merging an XRef object loads the full modifier stack of the original object into
the master scene (your current scene), while maintaining any additional stack
items that were added while the object was an external reference. Thus, you
can use Merge In Scene to update an object that has been modified as an
external reference. Similarly, merging an XRef controller into the master scene
maintains any offset transformation you might have applied to the controller
in the master scene.
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Convert Selected Object(s) to XRefs Creates a source file for the currently
selected objects. This means that you can select objects in the current scene,
including their transform controllers and materials, and then save them to a
separate scene file. This file is then listed as an XRef record that contains the
entities you selected.

NOTE This option can be used on both—native (local) objects or externally
referenced objects. If you use it for an object that is already an XRef object, it
creates a nested XRef. Nested XRefs still behave as you expect, but they can reduce
performance when you open a scene or render it.

XRef Entities List Right-Click Menu

File menu > XRef Objects > XRef Objects dialog > Right-click the list of XRef
entities (objects and materials).

This contextual menu appears in the XRef Objects dialog on page 6737  when
you right-click the XRef Entities list. It provides additional options for
managing the list.

Some of the options on this menu are unavailable unless you have highlighted
an XRef entity.

Interface

Add Objects Displays the XRef Merge dialog on page 6752  so you can add
entities to the XRef Entities list.

If all entities in the source scene are already externally referenced, this choice
has no effect.

Delete XRef Entity Deletes the highlighted XRef entities from the scene.

An alert prompts you to confirm the action.

NOTE Deleting XRef controllers is equivalent to merging them into the master
scene. The reason for this is that nodes must have a transform controller at all
times, in order to be positioned in the scene. Deleting XRef materials is equivalent
to merging them into the master scene. This action could impact all objects in the
master scene that use an XRef material, and could have implications difficult to
be foreseen.

Select Selects in the scene the XRef entities currently highlighted in the
XRef Entities list.
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Select by Name Opens the Select Objects dialog on page 168 , which lists all
objects and highlights the XRef objects selected in the XRef Entities list. If an
XRef controller or XRef material is selected in the XRef Entities list, the Select
Objects dialog highlights the object to which the XRef controller or material
belongs to.

Highlight Selected Objects' XRefs When XRef objects are selected in the
scene, the XRef record to which they belong is highlighted in the XRef Record
list and the XRef objects and their XRef entities are highlighted in the XRef
Entities list.

Highlight All Highlights all XRef entities in the XRef Entities list.

Highlight Inverse Highlights all XRef entities in the XRef Entities list except
the currently highlighted XRef entities.

Highlight None Turns off highlighting for any XRef entities currently
highlighted in the XRef Entities list.

List Objects Toggles the display of XRef objects for the current XRef record
in the XRef Entities list.

List Materials Toggles the display of XRef materials for the current XRef
record in the XRef Entities list.

List Controllers Toggles the display of XRef controllers for the current XRef
record in the XRef Entities list.

The state of List Objects, List Materials, and List Controllers is the same as the
state of the toolbar buttons in the XRef Objects dialog. Changing the state in
the menu changes the button state, and vice versa.

Merge In Scene Merges the current selection in the XRef Entities list into
the master scene (the current scene). Use this option to change XRef objects
or materials into objects that are native to the current scene. The connection
between the external entity from the source scene and your master scene is
broken, and the object, controller, or material that you merged is no longer
updated when the source scene changes.

3ds Max prompts you to confirm the merge.

Since a merged XRef object becomes part of the scene and is no longer an
XRef object, its name is removed from the list.

Merging an XRef object loads the full modifier stack of the original object,
while maintaining any additional stack items that were added while the object
was an XRef object. Thus, you can use Merge to update an original object that
has been altered as an external reference. If you do this, use Convert Selected
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Object(s) to XRefs to save out the “improved” original into a file, which then
can be merged back into the original source.

NOTE It is also possible to merge into the master scene nested XRef entities. Once
they are merged, all externally referenced nesting levels are removed and the
scene entity from the lowest level source scene is merged into the master scene.
In case of XRef objects, modifiers applied in a nested source file are all merged
and present in the master scene.

Apply XRef Material(s) to Object(s) Applies the original, externally referenced
material(s) to the highlighted objects. This can be useful if you have assigned
a local material to the object (for example, to use in renderings of the master
scene) and now want to restore the object's original material. It can also restore
the externally referenced source material if the material was originally merged
into the master scene.

Apply XRef Controller(s) to Object(s) Applies the original, externally
referenced controller(s) to the highlighted objects. This can be useful if you
have assigned a local controller to the object (for example, to use in renderings
of the master scene) and now want to restore the object's original controller.
It can also restore the externally referenced source controller if the controller
was originally merged into the master scene.

Reset PRS Offset Sets the PRS transformation on page 3196 of the XRef object
to its transformation defined in the source file.

NOTE You can undo this action.

XRef Merge Dialog

File menu > XRef Objects > XRef Objects dialog > Create XRef Record From
File button > Open File > XRef Merge dialog

The XRef Merge dialog lets you choose which objects to add as XRef objects
to the scene. This behaves similarly to the Merge command on page 6854 .
Controls on this dialog are similar to those on the Selection Floater on page
171 .

The Merge dialog lets you load and save influences with or without their
dependents. In many cases, objects should be referenced with their influences,
but the display only makes you aware of the relationships, it does not force
you to externally reference them.
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When you select an item in the list window and click Influences, the object’s
influences are selected in the list window. When you select an item in the list
window and Display Influences is on, the object’s influences are shown in
blue in the list window. When you select an item in the list window and Select
Influences is on, the object’s influences are also selected in the list window.

Procedures

To show an object's influences in the XRef Merge dialog:

■ Select an object in the list window and enable Display Influences.
The influences are shown in blue.

To select an object's influences in the XRef Merge dialog, do either of the
following:

■ Select an object in the list window and click Influences.

■ Select an object in the list window and enable Select Influences.
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Interface

XRef Merge Objects list

Objects are listed according to the current Sort and List Types selections.

Influences When you select an object in the list window and then click the
Influences button, the selected object's influences are highlighted as well.

All, None, and Invert These buttons alter the pattern of selection in the list
window.

Display Influences When this is on and you select an item in the list window,
all of its influences are shown in blue. If you want to highlight these influences,
click Influences.
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Select Influences When this is on and you select an item in the list window,
all of its influences are highlighted as well.

XRef Scene

File menu > XRef Scene

An externally referenced scene, or XRef scene, appears in your current file,
but is actually loaded temporarily from another MAX file. As a result, the
source scene is protected from any modifications you might make to the XRef
scene via the master scene. Updates or changes made to the source scenes are
also updated in the master file once the changes are made and saved to the
source file.

The XRef scene feature allows team members working on the same project to
have access to each other’s work without the risk of changing the files. A
modeler can create a setting, while a second modeler might create a character.
The animator can externally reference the setting as a scene and animate the
character in the setting without being able to make changes to the setting. If
the setting file is changed, those changes will be reflected in the animator’s
scene.

Objects loaded in the master file via XRef scenes cannot be selected nor
modified, and do not appear in the Select From Scene dialog or Scene Explorer,
the modifier stack, or the Track View. You can animate them in the current
file only by using the Bind To Parent function in the XRef Scenes window.

You can snap to externally referenced scene entities. You can use Snap,
AutoGrid, and Clone and Align to position local objects in context, as well as
to pick objects as the target location for the clones. If you need to move, rotate
or scale the referenced scene, you can bind it to a local object. Transforming
the object the externally referenced scene was bound to transforms all objects
in the externally referenced scene. You can also use externally referenced
objects in the scene as the reference coordinate system on page 896 . When
you save changes to the externally referenced file (such as objects added,
edited, or deleted), updating the XRef Scene inherits those changes locally.
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Importing the whole village model into the building model as an XRef

Radiosity solution data cannot be part of an XRef if objects have duplicate
names. To solve this, change the duplicate names. Also, to reference radiosity
data externally, the Save Scene Information In MAX File switch must be on
in the Radiosity panel on page 7578  of the Preferences dialog. (It is on by
default.)

Be aware that render effects are not carried into the master scene by XRef
scenes. To use the render effects (such as glow or flare) from the XRef file,
merge them in using the Merge buttons found in the Environment And Effects
dialog.

NOTE Atmospheric effects assigned to objects in the source file are carried into
the master file when the source file is used as an XRef scene.
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Choosing XRef Scene displays the XRef Scenes dialog on page 6763 .

Overlays

Overlays allow multiple scene references without the risk of creating circular
dependencies. The scene XRef marked as overlay is loaded only into the master
scene that references it, and is not visible in other scenes that might XRef the
master file that uses the overlay. Consider two scenes that reference each
other:

Ordinarily, 3ds Max would recognize this as a circular dependency, and
disallow it. However, you can set up such a combination of XRefs by following
these steps:

1 In scene 2, XRef scene 1 and use the toggle to flag it as an overlay.

2 Save scene 2.

3 Open scene 1, and XRef scene 2.

Scene 2 is externally referenced into scene 1, without pulling scene 1 in
as a nested external reference.

The previous example is not particularly practical. But suppose you want to
mask off part of your scene so other artists who XRef the scene will not see
it. For example, you are working on a building and have XRefed a CAD file
that lays out the plumbing of the building, as well as a scene of ground terrain
that contains some XRefs to some trees. The XRef scene graph might look like
this:
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The building scene XRefs the terrain and the plumbing data. The terrain scene
XRefs the trees. You decide you are the only one who needs to see the CAD
plumbing data. The CAD plumbing data is needed only to line up where the
sinks need to be in the building, so you set up the CAD plumbing data XRef
to be an overlay. Other scenes that include the building scene won’t see the
plumbing. For example, another artist who is responsible for the lighting and
cameras sets up an XRef to the building scene. Now the XRef graph looks like
this:
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In this case, an overlay is used to simply hide data information from other
master scenes. Another use of overlays is to avoid circular XRefs. For example,
picture four artists working on a scene of a city block. Two of them are working
on individual buildings, one is working on a sky bridge that connects the two
buildings, and the fourth artist is setting up the cameras and the lights. The
graph of externally referenced scenes might look like this:
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But the artists working on Building A and the artist working on the sky bridge
need to see each other’s work to make sure everything lines up. The obvious
solution would be to externally reference each other’s scene file:
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However, 3ds Max detects a circular external reference and won’t allow this,
unless both the Building A scene and the Sky Bridge scene flag their external
reference as an Overlay.
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WARNING If you turn off the Overlay flag for an existing XRef scene, you can
cause circular external references to occur, that aren’t detected until you or another
user tries to open one of the scenes in the project.

Procedures

To add an XRef scene:

1 Choose File > XRef Scene.

2 Click the Add button. An Open File dialog appears that lets you locate
the MAX file you wish to reference. A thumbnail display is provided to
help you identify your file.

3 Click Open to bring the XRef scene into the current scene.
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4 The path and file name of the selected file appears in the XRef Files
window.

You can add as many files as you like; each one appears in the XRef Files
window.

5 Make additional choices in the XRef Scenes dialog if you want.

You can affect the display of the XRef scene, making it visible or not, or
making objects in the referenced scene appear as bounding boxes. You
can ignore the file's lights, cameras, shapes, helpers, or animation. You
can control when the file updates, either automatically or on demand.
You can have the file enabled or disabled, or you can merge it, severing
the XRef relationship and inserting the scene into your current file. You
can bind the scene to a Parent object to reposition or animate the XRef
scene.

To scale, rotate, or reposition an XRef scene:

1 Create an object in your current scene to be the parent object.

2 Choose the XRef scene from the XRef File window.

3 Click Bind (in the Parent group), and then select the parent object by
clicking it in the viewport.

4 Transform the parent object. The XRef scene will follow.

This works best if both the parent object and the XRef scene have their
pivot points positioned near the scene's origin (0,0,0).

If the XRef scene was created a large distance from the origin, you can
run into a problem. As you scale the parent object, the XRef scene will
move away from the center. To counteract this problem, you can create
a second parent object centered over the XRef scene. Then select and link
the original parent object to the centered parent object. You can then
scale the centered parent object and the XRef will not move toward or
away from the origin and use the original parent object to move the
externally referenced scene.

An alternative method for scale problems is to use the Rescale World
Units Utility on page 2599  on the original file.

XRef Scenes Dialog

File menu > XRef Scene > XRef Scenes dialog
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The XRef Scenes dialog lets you add and remove XRef scenes. It also gives you
tools to control the display of the XRef scene, options to ignore various
components of the scene, and the ability to bind to a parent object so you
can scale, rotate, or move the XRef scene.

Accessing XRef Scenes

Although XRefs are inaccessible “boxes” in the scene, they can be accessed in
various ways.

■ Cameras and lights in the XRef scenes can be accessed in the Viewports
list and assigned to viewports in the current scene.

■ Objects from the XRef scenes are included in the Summary Info dialog.

■  Objects can be snapped to or used for alignment purposes with
AutoGrid and Align.

■  AutoGrid works on XRef scene objects.

■  You can use objects from XRef scenes as target for cloning or reference
systems.

Nesting XRef Scenes

XRef scenes can be nested. That is, an XRef scene can contain other XRef
scenes, which can in turn contain other XRef scenes.

NOTE For a nested XRef scene to update automatically, all of its parent scene files
(files that include it as an XRef) must have Auto Update turned on .
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Interface

XRef File list Displays all XRef scenes in the current scene, and lets you select
them for operations. XRefs that have been disabled (by turning off Enabled)

External References (XRefs) | 6765



are listed in gray rather than black. If an XRef is listed in red, that means its
file could not be loaded. Either the file is corrupted, or the path is not pointing
to the correct directory or file name.

XRef File path field Lets you change the path or file pointed to by a selected
XRef scene. To use, choose one of the XRef scenes in the list, and then change
the information in the field. You can either directly enter a new file name or
path, or you can click the Browse button to the right of the field, and then
choose a new file from the Open File dialog. The new XRef scene that you
choose replaces the one currently highlighted in the list.

Add Displays the Open File dialog from which you can choose a MAX scene
file to be loaded into the current scene as an XRef. The selected scene appears
in the list at left, and the geometry appears in the viewports.

You can also add a scene by dragging a MAX file from the Windows Explorer
into the list, or by dragging a MAX file into a 3ds Max viewport, whereupon
you're presented with a menu with the following options: Open File, Merge
File, XRef File, and Cancel.

Convert Selected Lets you take any selected objects in your scene and create
XRefs from them. Basically, this does a Save Selected for the objects, which
are automatically cut from the MAX file and pasted into a new file. A file
dialog lets you name the new file. They remain in the current scene but are
now scene XRefs.

Remove Removes the XRef scene currently chosen in the list, and removes
it from the current scene. To use, choose one or more XRef scenes in the list,
and then click the Remove button.

Select buttons

These standard buttons change the pattern of selection in the list.

All Selects all items in the list.

None Deselects all items in the list.

Invert Inverts the current selection pattern in the list.

XRef File group

Enabled Turn this off to disable the highlighted XRef. When an XRef is
disabled, it’s listed in gray in the list, and it’s not loaded into memory.

Overlay When on, treats the referenced source scene as an overlay on page
6757 . Default=off.
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Overlays allow multiple scene references without the risk of creating circular
dependencies. The scene XRef marked as overlay is loaded only into the master
scene that references it, and is not visible in other scenes that might XRef the
master file that uses the overlay. See Overlays on page 6757  for more
information.

WARNING If you turn off the Overlay flag for an existing XRef scene, you can
cause circular XRefs to occur, that aren’t detected until you or another user tries
to open one of the scenes in the project.

Merge Click this to merge selected XRefs into the scene as real geometry. A
prompt appears so you can confirm the action. Since a merged XRef becomes
part of the scene and is no longer an XRef, its name is removed from the list.

Update File group

Determines how and when the XRef scenes are updated. These options are
applied to the selected XRefs; for example, one XRef can have automatic
updating, while another can have manual updating (using the Update Now
button).

WARNING If you update an XRef in a scene with radiosity on page 5976 , you will
likely invalidate the radiosity solution. After you update the XRef, reset the radiosity
solution and then recalculate it.

Automatic When this check box is turned on, the selected XRef scene is
automatically updated when its source scene is saved.

Update Now Click this to update a selected XRef scene when you’re not
using Automatic (or when several XRef scenes are selected and some of them
are not set to Automatic). When you click Update Now, the XRef is updated
to match the latest saved version of the source scene.

Display Options group

These options let you specify how the selected XRefs are displayed in viewports.
These options have no effect on the rendered scene.

Visible Turn on or off to display or hide the selected XRefs. This affects the
visibility of the XRef in the viewports only (not in renderings). Note, also,
that this behavior is different from the “Enabled” check box. Turning off
Visible does not remove the XRef from memory.

Box Turn this on to display the selected XRefs as bounding boxes. Turn off
to display the full geometry.
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Ignore group

This group box lets you specify categories that you do not want included with
the XRef scene. For example, if you turn on Lights, the lights in the XRef
source scene are not included in the current, target scene. You can switch
these categories on and off at any time, but if you Merge an XRef scene while
a category is turned off, that category of objects will not be merged into the
scene.

Lights Turn this on to ignore the lights.

Cameras Turn this on to ignore the cameras.

Shapes Turn this on to ignore the shapes.

Helpers Turn this on to ignore the helpers.

Animation Turn this on to ignore the animation. All animation in the scene
is disabled and the scene appears as it would at frame 0 of the source scene.

WARNING Children of an ignored object are also ignored. For example, if you
have mesh objects linked as children to a dummy object and ignore Helpers, then
the mesh objects are ignored as well.

Parent group

These controls let you position and animate XRef scenes within the current
scene by binding the XRef scene to a parent object.

Parent Name field Displays the name of the parent for the currently selected
XRef.

Bind Click this, and then pick an object in the current scene to become the
parent of the highlighted XRefs. Once an XRef is bound to a parent object,
the transforms of the parent are inherited by the XRef. Thus, you can animate
the XRef by animating the transforms of the parent.

Unbind Click to unbind the highlighted XRefs from whichever parent they’d
been bound to.

Binding XRefs to objects is similar to linking objects, as performed with the
Link/Unlink buttons on the toolbar.

If you Merge a linked XRef scene, converting it to objects in the current scene,
the objects in the XRef scene become linked children of the binding parent.
At this point, you could Unlink them (using the toolbar command), and they’ll
maintain their offset position to the parent.

Close Click to close the dialog.
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XRef Object Rollout

Select an XRef object. > Modify panel > XRef Object rollout

When you've selected an XRef object in a scene, the XRef Object rollout appears
along with the Proxy Object rollout on page 6770  on the Modify panel. The
modifier stack for the XRef object simply displays “XRef Object.”

Interface

These controls let you change the file path, file name, and object name of the
source of the XRef object.

IMPORTANT The specified file must contain an object of the specified name, or
no XRef object will appear in your scene. Instead, a small X appears as a
placeholder.

 Highlight Corresponding XRef Record in the XRef Objects Dialog Click
to open the XRef Objects dialog on page 6737 , with the selected object's record
highlighted.

File name field Displays the path and file name of the scene file containing
the source of the XRef object. You can edit this to point to a different path
and file.

File name display Displays the file name only, without the path.
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 Path button Click to display the Open File dialog from which you can
specify a different path and file name for the source file.

Object name field Displays the name of the source object pointed to in the
source file. You can edit the name field to reference another object.

Object name display Displays the name of the source object.

 Path button Click to display the XRef Merge dialog on page 6752
pointing to the scene in the XRef File Name field. Here, you can specify a
different object to be used as the XRef object.

Proxy Object Rollout

Select an XRef object. > Modify panel > Proxy Object rollout

When you've selected an XRef object in a scene, the Proxy Object rollout
appears along with the XRef Object rollout on page 6769  on the Modify panel.
Use these controls to specify a low-resolution object to replace the original
XRef object for easier handling in the viewports, and optionally for test
rendering.
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Interface

Enable When on, displays the specified proxy object in the viewports. When
off, displays the original XRef object. Note: If you turn this on when no proxy
object has been specified, the XRef object appears in the viewports as a small
X.

Use in Rendering When on, the proxy object is also displayed in the
rendering. When off, the original XRef object is rendered.

File Name field Specify the path and file name of the scene file containing
the proxy object.

 Path button Click to display the Open File dialog from which you can
specify the scene file containing the proxy object.

Object Name field Specifies the name of the proxy object in the specified
scene.

 Path button Click to display the XRef Merge dialog listing the objects
in the specified scene file. From here, you can select an object to be used as
the proxy.
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Missing XRef Paths Dialog

File menu > Open > Open a file that references other missing files.

If you load or render a scene with XRefs, but the originally specified path of
the XRef object or scene can’t be found, or if the XRef object name doesn’t
match the object name in the source file, an alert appears telling you this. The
alert works in the same way as the missing bitmap dialog, and provides you
with three options, described below.

Interface

OK Lets you open the file. The referenced scene will have placeholders, but
will not exist in the scene.

Browse Displays the Configure XRefs Paths dialog which you can use to
specify the correct file path. This lets you modify, delete, add, and change the
list position of the paths 3ds Max uses to look for missing files.

This panel is similar to the one displayed by choosing Customize > Configure
User Paths > XRefs on page 7529 .

If this problem occurs during network rendering, the dialog doesn’t appear,
but the errors are written to the network log file.

File Link

Data synchronization between drawing files created with AutoCAD, AutoCAD
Architecture (ACA), or Revit and 3ds Max is implemented using the File Link
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Manager, which keeps drawing data linked to the scenes. It is best understood
through a few simple principles:

■ Changes in AutoCAD, AutoCAD Architecture, or Revit can  change the
data viewed in 3ds Max, but changes in 3ds Max never  change the data
in AutoCAD, AutoCAD Architecture or Revit.
Creating a file link is a one-way process that supports the central role of
AutoCAD, AutoCAD Architecture or Revit in developing and keeping a
record of your core design database. Many changes made in AutoCAD,
AutoCAD Architecture, or Revit will appear in 3ds Max after a file link
reload. These include adding or removing objects, moving objects, changing
material assignments (specific to ACA and Revit drawings), and enabling
Live Section objects (specific to ACA drawings). Changes made in 3ds Max,
such as moving objects, changing material assignments, and adding lights,
will never appear in your AutoCAD, AutoCAD Architecture, or Revit
drawing.

■ Changes you can  make in AutoCAD, AutoCAD Architecture, or Revit
should  be made in AutoCAD, AutoCAD Architecture, or Revit.
Changes that you make in AutoCAD, AutoCAD Architecture, or Revit
become part of that database, whereas changes you make in 3ds Max appear
only in the renderings you produce.

■ Changes in AutoCAD, AutoCAD Architecture, or Revit aren't reflected in
3ds Max unless you choose them to be.
When you make changes to drawing files, those changes will not appear
in 3ds Max unless you use the Reload command on page 6783  on the File
Link Manager. When you reload a link in 3ds Max, you can choose to
update just the geometry from AutoCAD, AutoCAD Architecture, or Revit,
you can reload only specific objects, or (with AutoCAD Architecture and
Revit drawings) you can choose to update both the geometry and the
material assignments.

NOTE After changing your Revit project, you must export a new DWG file and
then reload that file into 3ds Max. 3ds Max cannot  link a native Revit project,
RVT file, directly.

You can transform (move, rotate, or scale) AutoCAD, AutoCAD Architecture,
or Revit objects and blocks that appear in 3ds Max, and these types of
changes are not lost upon reload. If you have moved, rotated, or scaled
linked objects and want the objects to resume the position and scale they
have in the original drawing file, use the Reset Position function on page
6820 .
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■ 3ds Max integrates linked AutoCAD, AutoCAD Architecture, or Revit data
with non-AutoCAD, AutoCAD Architecture, or Revit data.
In addition to the linked AutoCAD, AutoCAD Architecture, or Revit
geometry and material assignments, 3ds Max allows you to create or merge
into your scene many types of data from other sources, including:

■ Lighting objects for simulating light fixtures and daylight conditions.

■ Entourage objects such as surrounding buildings, terrain, trees, cars, and
people.

■ Advanced rendering material effects that simulate the rich visual variety
of any imaginable material. You can take advantage of materials that
appear on objects created in 3ds Max, and you can create your own
material effects using the Material Editor. Materials created with the
Material Editor can be assigned to any component in your scene.

■ Bitmaps for use as environment backgrounds. You can use still images
in a variety of formats, or even animated movies, as a rendering
background to create stunning photomontages that appear to place
your proposed design right into the actual location.

See also:

■ File Link Manager Utility on page 6783

■ Working with Drawing Files on page 6774

■ Resetting Transforms on Linked AutoCAD Objects on page 6820

Working with Drawing Files

You can attach any DWG file on page 7762  (or DXF file on page 7762 ) with the
File Link Manager on page 6783 . This feature allows you to work in another
design software's environment, such as AutoCAD®, Autodesk® AutoCAD
Architecture, or Autodesk Revit®  while maintaining a single design database.

NOTE For this documentation, the term “drawing” refers to DWG or DXF files
created with AutoCAD and AutoCAD Architecture, or exported from Revit.
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Creating Links to Files

You can establish, reload, and detach links to any number of linked files. You
can also edit out unnecessary information by using layers and other filters.
The File Link Manager defines which geometry is included in the scene from
the linked file, how the geometry is organized, and when it's regenerated. You
can also create links to files using the drag and drop feature. The objects that
you bring in from linked files behave just like any other object created in 3ds
Max. You can scale, rotate, and move them as well as attach modifiers and
materials.

When 3ds Max stores linked file data, you'll need to decide how the objects
from the linked files will be organized in the scene. For example, drawings
are commonly organized by layers, blocks, and objects, and 3ds Max scenes
are organized by hierarchies of objects. For translating between systems, 3ds
Max includes object types called VIZBlocks on page 7967  and Block/Style
Parents on page 7732 .

Working with VIZBlocks and Block/Style Parents

A VIZBlock and a Block/Style Parent is like a nested block; it has an
object/sub-object or parent/child hierarchy structure. In many cases, linked
drawing data initially appears as a VIZBlock or Block/Style Parent (depending
on the Derive AutoCAD Primitives By options on page 6800  you choose). Using
VIZBlocks is helpful when you're working with layering and color schemes.
You can create multiple links to the same linked file, so you can use the same
geometry in different combinations.

Dynamic Blocks in 3ds Max

Dynamic Blocks give blocks flexibility and intelligence. A dynamic block
reference can easily be changed in a drawing while you work. You can
manipulate the geometry through custom grips or custom properties.

The File Link Manager handles dynamic blocks much the same way as any
other block found in a DWG file. Dynamic block instances, even those that
have been grip-edited, display certain types of instance behavior such as
material propagation. For more detailed information about dynamic block
handling in 3ds Max, see Blocks on page 6844 .

Reloading, Binding and Detaching Links to Files

You can also reload or detach linked files. When you reload a linked file, any
changes you've made to the linked file are applied to the reloaded geometry
in your scene. Note, however, that 3ds Max won't edit or change your original
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linked file. The integrity of your other software's design database is never
compromised by the File Link Manager. Finally, if you decide to break a link
to a linked file, there are two options. You can use Bind to keep the objects
from the linked file in your scene, or you can use Detach to have them removed
along with the link. For more information, see File Link Tips on page 6777 .

NOTE Both Detach and Bind are available from the Files panel of the File Link
Manager.

ObjectDBX Objects

3ds Max supports the display and use of custom AutoCAD objects. These
custom objects are created using the ObjectDBX™ or ObjectARX® APIs.
Applications and products that work with either of these APIs can read and
write to AutoCAD drawings, and ObjectARX products can extend the available
feature set of AutoCAD.

NOTE To improve file performance, some of the ObjectDBX rules have been
updated. This means that some DXF files, ones built by non-Autodesk products
or very old DXF files, may no longer import or file link into 3ds Max.

Object Enablers

AutoCAD and AutoCAD vertical applications, such as AutoCAD Architecture
(formerly Architectural Desktop or ADT), have custom objects that are unique
to the product. In order to view them in 3ds Max, you need the appropriate
Object Enabler (OE). Object Enablers let you access, display, and manipulate
these objects in 3ds Max, as well as the other vertical applications, including
3ds Max.

When you use the File Link Manager to Attach a DWG file to your scene, you
may encounter a Proxy Objects Detected dialog. This means there are custom
objects in the drawing that require special Object Enablers before you can edit
the objects in 3ds Max.
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Do not show this message again Check this option to not display this
message the next time proxy objects are detected.

For a list of downloadable OEs, see the
http://www.autodesk.com/autocad-object-enablersAutodesk Web site

NOTE Drawings that are exported from Revit do not require Object Enablers.

File Link Tips

Here are some tips for choosing File Linking options and avoiding common
pitfalls.

Linked Data and Face-Normal Conventions

Face normals on page 7863  can be a source of confusion when linking to
AutoCAD, AutoCAD Architecture, or Revit drawing files. In 3ds Max, every
face has a front and a back, corresponding to the inside or outside surface of
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a solid object. In a cube, for example, there is seldom the need to view the
inside surface of any of the six squares that make up the cube. So for many
viewing and rendering operations, 3ds Max ignores a face if it's facing away
(that is, if its face normal is directed away) from a point of view.

When you create objects in AutoCAD, AutoCAD Architecture, or Revit, 3ds
Max generally understands which way faces should be oriented and manages
face normals accordingly. However, occasionally you may encounter linked
drawing geometry that displays correctly in AutoCAD, AutoCAD Architecture,
or Revit, but doesn't strictly respect face-normal conventions. This can make
it appear as though elements visible in the drawing file are missing or appear
“inside-out” in 3ds Max.

If this happens, try one of these four options:

■ During file link or import of the DWG file, turn on the Unify Normals
switch in either the Basic panel of the File Link Settings dialog or the
Geometry Options group of the AutoCAD DWG/DXF Import Options
dialog.

■ If the drawing is already linked or imported, assign a Normal modifier on
page 1509  to the object that is not displaying properly. Turn on the Unify
Normals switch to force all the normals to face the same direction. If the
object then appears to be “inside-out,” turn on the Flip Normals switch as
well.

■ Turn on the Force 2-Sided switch on the Render Scene dialog (to render
the faces correctly), and turn on Force 2-Sided on the Viewport
Configuration dialog (to display the faces correctly in the viewports.)

■ Apply a material with the 2–Sided switch turned on.

NOTE Using the Force 2–Sided options can result in slower performance,
particularly when rendering. Using either of the Unify Normals options is the
preferred method of handling face normals.

If you are experiencing a high volume of face normal problems in a particular
file, you should verify that the Weld switch is turned on in the File Link
Settings dialog on page 6793 , and then reload the drawing. Weld forces nearby
faces to share edges and vertices. This can still result in groups of face normals
that are flipped in 3ds Max so the Unify Normals switch should also be used.

NOTE The disadvantage of welding is that it can be time-consuming when you
attach and reload the linked file. The time penalty is much greater when 3ds Max
is creating objects that have very large numbers of individual faces.
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Linking Files with High Numbers of Linear Line Segments

Two-dimensional elements in drawing files, such as lines, polylines, circles,
and arcs, are represented as splines in 3ds Max. These splines carry much more
information at each vertex than typical AutoCAD 2D structures. Since some
drawing files contain large quantities of 2D data, exercise caution when linking
files containing a high number of discrete line segments. There are two ways
these elements can be left out of your 3ds Max scene:

■ by freezing their layers in AutoCAD, AutoCAD Architecture, or Revit before
you start 3ds Max and before each subsequent reloading process.

■ by excluding specific layers during the File Link Attach/Reload process or
Import process so you do not have to freeze layers in the drawing. This is
the preferred workflow.

If you need this type of 2D geometry in your visualization, try to use polylines
instead of connected lines to get cleaner geometry in 3ds Max and to reduce
the final size of your scene.

Linked 3D Solids Objects

3D Solids objects that you link from a drawing file into 3ds Max are tessellated;
that is, turned into mesh objects with faces. The fineness of the tessellation
is controlled by the Maximum Surface Deviation For 3D Solids setting on
page 6797 on the File Link Settings dialog. A high value results in coarser
tessellation. 3ds Max uses less memory in the scene, but poor approximations
of curved surfaces could result. For acceptable performance, keep this value
as high as possible.

TIP You can change the value of the Surface Deviation For 3D Solids control at
any time by turning on Show Reload Options on page 6792 on the Files panel of
the File Link Manager dialog, and then adjusting when you reload the file.

Linked Spline Objects

Splines are not rendered in 3ds Max unless they have rendering parameters
applied. Normally, you have to collapse a shape to an editable spline object
in order to apply rendering parameters; however, this is not possible with
spline objects from AutoCAD.

Instead, you can apply a Renderable Spline modifier on page 1580  to the spline.
This lets you set rendering properties without having to collapse to an editable
spline.
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External References and Block Names

A linked AutoCAD or AutoCAD Architecture drawing can include xrefs that
reference files but use the same block names. 3ds Max keeps the blocks distinct
by prepending xref names to block names.

In Revit, a DWG, DXF or RVT file can be linked to the project. This kind of
link is called a RVT Link on page 7913 . When the project is exported to a DWG
file, this type of link is represented in the exported drawing as an external
referenced drawing. In this case, more than one drawing file may be created,
with one referencing the other(s).

Circular References

An xref file that contains a sequence of nested references that refers back to
the xref file is considered a circular reference. 3ds Max resolves xrefs until it
detects a circular reference. For example, if you have the circular reference
A|B|C|A, 3ds Max detects and breaks the circularity between C and A. This is
consistent with the way AutoCAD and AutoCAD Architecture handle circular
xref dependencies.

Overlay External References

3ds Max treats overlay xrefs in the same way as AutoCAD when resolving
xrefs.

For more information regarding overlay xrefs, refer to your AutoCAD User
Reference.

Cloning Actively Linked Objects

If you want to clone actively linked objects, you should only use the Copy
option. Creating references or instances of actively linked objects is not
recommended, as reliability issues can arise when the instanced or referenced
object is deleted in the linked file.

When you copy actively linked objects, linked through the File Link Manager
on page 6783 , the copies are automatically converted to editable mesh or editable
spline objects. If your selection contains several objects which instance another
object, the resulting copies also instance the same object.

Compound Objects Containing Actively Linked Objects

If you use an actively linked object as part of a compound object, you should
always choose Copy when you specify how the linked object is transferred to
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the compound object. Choosing Reference or Instance can cause instability
in the software.

Attaching Actively Linked Objects to an Editable Mesh, Poly, Patch,
or Spline Object

Actively linked objects should not be attached to editable objects, as this
introduces instability to the software. Instead, make a copy of the actively
linked object, and attach the clone to the editable object.

Creating Hierarchies with Actively Linked Objects

Creating parent-child links between actively linked objects AND 3ds Max
objects can cause unpredictable results. For this reason, 3ds Max does not
allow you to link an actively linked object to a 3ds Max object. However, you
can link a 3ds Max object to an actively linked object.

The existing hierarchies of linked objects cannot be broken in 3ds Max. This
would compromise the structure of Blocks and Styles. Any changes must be
made in the original DWG file.

Similarly, actively linked objects cannot be included in the creation of Group
on page 222  or Assembly on page 227  objects in 3ds Max.

Controller Assignments

Actively linked objects should not be included in any IK animation chains,
as they will cause unpredictable results. Likewise, animation controllers should
not be applied to actively linked objects.

Assignments to avoid include:

■ HI IK Solver on page 3316

■ IK Limb Solver on page 3368

■ Spline IK Solver on page 3369

■ HD IK Solver on page 3346

■ Inherit Link Info on page 3425

■ Link Inheritance Utility on page 3297

■ Assign Controller on page 3515
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Interpreting Layer Data from AutoCAD,
AutoCAD Architecture, and Revit

3ds Max has its own Layer system that looks and operates like a simplified
version of the system you are familiar with from AutoCAD or AutoCAD
Architecture (formerly Architectural Desktop) . As in AutoCAD or AutoCAD
Architecture , you can hide and unhide layers, freeze and unfreeze them, and
change the display color for all objects on the layer.

NOTE Categories in your Revit project are similar to Layers in AutoCAD. When
you export your project to a DWG, categories are mapped to AutoCAD Layers via
the Export Layers table. For more information regarding Export Layers, refer to
your Autodesk Revit Help file.

Layer operations are accessed through the tools on the Layers toolbar, and
also on an object-by-object basis using the quad menu on page 7300 .

Unlinked objects, such as 3ds Max objects or drawing geometry that has been
bound into the scene using the Bind command, may be assigned to any layer
you choose, including layers created by the File Link Manager.

Linked objects from AutoCAD, AutoCAD Architecture, or Revit, with some
minor exceptions, will be assigned to the same layers they occupy in program
where the drawing was created.

Any changes made to the layer settings in 3ds Max (hidden/unhidden,
frozen/unfrozen, display color) affect linked objects just as they do unlinked
objects. Also, any changes you make to the layers are not reset when you reload
the drawing.

You can rename layers created by the File Link Manager. When the next reload
occurs, the renamed layer is not affected by the File Link Manager. Objects
on the renamed layer are updated; however, they remain on the same layer.
The original layer is only recreated when a new object has been created in the
DWG file. New objects are never placed on the renamed layer. You can also
delete layers imported by the File Link Manager on page 6783 ; but only if they
don't contain any objects.

You can move actively linked objects between layers in 3ds Max. When the
next reload occurs, the objects are updated; however, they are not moved back
to their original layers. You can also place non-linked objects, such as 3ds Max
objects or drawing geometry that has been bound into the scene, on any of
the imported layers.
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Objects contained in layers that are frozen in AutoCAD or AutoCAD
Architecture are not linked to 3ds Max. Objects that were originally linked to
3ds Max are removed if their layer is frozen in AutoCAD or AutoCAD
Architecture and the link is reloaded, but they are added again, upon reload,
after their layer is unfrozen in the program where the drawing is created.

NOTE This is only the case if Skip all Frozen Layers is active on the Select Layers
dialog on page 6813 . If you select the layers individually from a list, you can bring
in data on frozen layers.

See also:

■ Using Layers to Organize a Scene on page 7224

Scale Synchronization

3ds Max automatically manages the scale conversion on linked geometry and
materials. 3ds Max has its own system unit for internal representation of
geometrical scale.

If you find that any geometry is not shown at the size you intended it to be,
it is because it was created at the improper scale in the originating program.

See also:

■ Using Units on page 2504

File Link Manager Utility

Utilities panel > Utilities rollout > Click the More button. > Utilities dialog >
File Link Manager

File menu > File Link Manager

The File Link Manager utility allows you to work in either another design
software's environment (such as AutoCAD) or in 3ds Max while maintaining
a single design database. If you use AutoCAD drawings, this feature works
with drawings from AutoCAD Release 12 through AutoCAD 2005, including
the AutoCAD Mechanical/Architecture and Revit applications.

You can establish, refresh, and break links to any number of linked files. You
can also edit out unnecessary information by using layers and other filters.
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The File Link Manager defines which geometry is included in the 3ds Max
scene from the linked file, how the geometry is organized, and when it's
regenerated.

The objects that you bring in from linked files behave just like any other object
created in 3ds Max. You can scale, rotate, and move them, as well as attach
modifiers and materials.

You can also refresh or break links to linked files. When you refresh a linked
file, any changes you've made to the linked file are applied to geometry in
your scene. Note, however, that 3ds Max won't edit or change your original
linked file. The integrity of your other software's design database is never
compromised with the File Link Manager.

Finally, if you decide to break a link to a linked file, you can either keep the
objects from the linked file in your scene or have them removed along with
the link.

TIP For optimal speed when bringing a DWG file that contains a lot of text into
3ds Max, use Import on page 6979  rather than File Link.

See also:

■ File Link on page 6772

■ File Link Tips on page 6777

■ Working with AutoCAD, AutoCAD Architecture, and Revit Files on page
6817

Support of Multiple Materials on Linked ACIS Solids

3ds Max supports multiple materials per object in DWG files exported as ACIS
solids from Revit Architecture/Structure/MEP 2008 and later, as well as solid
primitives created in AutoCAD Architecture 2008 (formerly ADT) and later.
Linked solids can have Multi/Sub-Object materials on page 5558  that you can
view and manipulate in the Material Editor.

NOTE Previous versions of 3ds Max supported multiple materials for polymeshes
but only one material ID for each ACIS solid when linking a DWG file, regardless
of how many material IDs had been assigned to the solid.

6784 | Chapter 21   Managing Scenes and Projects



Process

When 3ds Max links a ACIS solid DWG file from AutoCAD or Revit
Architecture (version 2008 and later) with either the Layer, Blocks as Node
Hierarchy, Split by Material” or the Entity, Blocks as Node Hierarchy derivation
methods, multiple material IDs are read and editable as Multi/Sub-Object
materials in the Material Editor.

3ds Max reads each face of a linked ACIS solid to determine if it contains any
material IDs that it can read. If more than one material ID is read from a solid,
each material ID is translated to a material ID on file link and re-assigned to
the object.

The program creates Multi/Sub-Object materials only if more than one material
ID is found; if an ACIS solid contains only one material ID, a standard
architectural material is created and assigned instead.

NOTE 3ds Max first evaluates the linked file to find any Revit material IDs, and
then looks for AutoCAD material IDs.

NOTE If you link a DWG file with the Layer, Blocks as Node Hierarchy, Split by
Materials” derivation method, the solid is not split to reflect its materials set.

Multi/Sub-Object Material Naming

In earlier versions, 3ds Max read the material ID information from the color
ID of the AutoCAD/Revit material ID’s face. Now, 3ds Max creates a
Multi/Sub-Object material for every translated per face material ID each time
you link a DWG file that contains an AutoCAD/Revit solid.

When the program finds multiple materials assigned to an ACIS solid and
creates a Multi/Sub-Object material, it consists of instances of standard
architectural scene materials.

Naming Conflicts

Material IDs are unique within one DWG file. However, the same material ID
may appear in two different files, such as Basic Wall: Generic – 12” Masonry.
If a naming conflict arises when two scenes are merged, the program applies
the last loaded material used in the Multi/Sub-Object material.

For example, if file1.dwg and file2.dwg both contain a material named Brick,
and they are both linked, the Brick material used is the one from the second
file (file2.dwg).
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Or, if file1.dwg contains a material named Brick that is internally stored as
material ID 222 and file2.dwg contains a different material stored as ID 222,
the material used in the scene when they are linked is file2.dwg’s material.

If two solids share the same material ID, they will share the same
Multi/Sub-Object material.

Non-AutoCAD Materials

3ds Max does not link non-AutoCAD material IDs. The only non-AutoCAD
Architecture IDs it preserves are the Color IDs.

ACIS Solids

DWG ACIS solids link as solid objects in 3ds Max. You cannot separate faces
of an ACIS solid object unless you apply the Edit Poly on page 1293  or Edit
Mesh on page 1283  modifier.

TIP You can access the material ID value assigned to this face with the Edit Poly
modifier.

ACIS Solids and Materials

ACIS solid materials display in the Material Editor along with any other linked
material.

When you apply a bitmap material to an ACIS solid, it is applied to every side
of the object. For example, a brick bitmap material that you apply to a wall
object appears on both sides and all edges of the wall. If you want to apply a
material to each face ID, you can use a multi/sub object material so you can
assign sub-materials to each face ID.

When you link ACIS solids into 3ds Max, procedural textures are not supported,
only materials. For example, a brick wall in Revit may have mortar lines
procedurally drawn on it in red, but if the object is an ACIS solid, the mortar
lines, which are procedural hatches, are lost in 3ds Max.

When an ACIS object’s materials display as Multi/Sub-Object materials in the
Material Editor, each material name appears in the Material/Map Browser, for
example, Default wall or Basic Wall: Generic – 12” Masonry.

Polymesh

Polymesh DWGs link as polymesh geometry in 3ds Max. Unlike ACIS solids,
you can modify and edit any polymesh object’s face.
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Polymesh Objects and Materials

When you link a polymesh DWG file, each polymesh face is considered as a
separate entity, with one material permitted per entity, which allows it to
contain multiple materials

You can apply a bitmap material to the different faces of polymesh geometry,
unlike ACIS solids, where you would need to use a Multi/Sub-Object material
to create the same effect. For example, you can select the outside face of wall
and apply a brick bitmap material and also apply a diffuse material on the
inside wall to simulate white paint.

When you link a polymesh DWG file, every material used in the scene appears
in the Material Editor as a separate material where you can edit it.

When a polymesh object’s materials are shown in the Material Editor, each
material name appears in the Material/Map Browser, for example, Default wall
or Basic Wall: Generic – 12” Masonry.

Procedures

To link a drawing file:

You can link drawings in the form of DWG or DXF files. A DWG is the native
file format for AutoCAD and  AutoCAD Architecture, but you must first export
a DWG when working from a Revit project. The File Link Manager does not
recognize RVT files.

1 Choose File menu > File Link Manager.

2 On the Attach panel, click Files to select a file from the appropriate
directory on either your local or network system, and click Open.

3 Choose a Preset from the pull-down list, if you have one defined.

TIP If this is your first File Linking, and you have not defined any presets, you
may want to create one on the Presets panel on page 6809  of the dialog.

4 Turn on the Rescale switch and adjust the Incoming File Units, if
necessary.

5 Click Attach This File.

To reload a drawing:

Reload is most often used when your drawing or project has been changed in
AutoCAD, AutoCAD Architecture, or Revit, or if the linked drawing file has
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been moved and you have to tell the File Link Manager where to find the
drawing.

NOTE If your Revit project has been updated, remember to export a new DWG
file that can be reloaded.

1 On the Files panel of the File link Manager, click the file name in the
Linked Files list and click Reload.

Linked files that have been changed are prefaced with the  symbol.

TIP Turn on the Show Reload Options switch if you want to make changes
to the settings used to link the drawing. Otherwise, the reload process will
use the same settings you originally used when creating the link.

2 If Show Reload Options is turned on, the File Link Settings dialog on
page 6793  is displayed where you can change your settings in the Basic
and Advanced panels.

NOTE You cannot change the sorting or layer options when reloading a
drawing.

3 Click OK to reload the file.

Interface

The File Link Manager dialog contains three panels for listing linked files:

■ Attach on page 6789

■ Files on page 6790

■ Presets on page 6792

These panels let you attach files, update attachments and settings, and change
presets used by File Link. The terminology is similar to the terminology for
managing AutoCAD external references, or xrefs on page 7977 .

NOTE An xref is an AutoCAD external reference. This is different from a 3ds Max
Xref on page 7978 , which is an externally referenced file that can be a 3ds Max
object or scene.
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Attach panel

File Displays an Open dialog that you can use the browse for DWG and DXF
files that you want to link. When a file is selected, its path and name appears
in the File list.

File list The file to be attached to your scene. You can enter the file location,
or you can expand the list to display a history of the last ten attached files.

NOTE You can resize the File Link Manager dialog by dragging any corner or
edge. This is useful for viewing a file path if it's too long to fit in the file list field.

Preset Displays a list of preset settings you can choose to use when attaching
the file. Each list entry in this list represents a unique collection of attach and
reload settings. You can create additional presets in the Presets panel of the
File Link Manager dialog.

Rescale Alters the scale of the geometry from a linked file to match the
system unit scale on page 7605  in 3ds Max. When Rescale is on, you can specify
what the base units should be for the geometry in the linked file. For example,
if the length of a line in the linked file is 2 units, you can specify that these
units be considered as any of the units listed under File Units (below), such
as inches, millimeters, or parsecs.

When Rescale is on, and the units you specify are different from the system
units currently set in the 3ds Max scene, the incoming objects are scaled
appropriately. For example, if a door measures 914 units in the linked file,
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and you specify millimeters to convert from, the door will measure 36 inches
in the 3ds Max scene.

NOTE You can't change units when you reload a linked file.

NOTE By default, system units are inches in 3ds Max. Consider carefully before
changing the default system units. For more information, see Using Units on page
2504 .

Incoming File Units Displays the unit of measure found in the original
drawing file and lists the units to which you can choose to rescale the attached
file. This is only active when Rescale is on.

Select Layers to Include Displays the Select Layers dialog on page 6813 , which
you use to select the layers to import from the linked file.

Attach This File Attaches the selected file to your scene, using the settings
selected in the Preset list, if one was selected.

To cancel the File Link operation press Esc. You can do this at any time during
the process.

Cancelling the File Link operation removes every object the process has linked
to the scene until the moment you press Esc.

Close Cancels all changes to settings and closes the dialog.

Files panel
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Linked Files Lists linked files. The File Link Manager displays an icon next
to the path name of each linked file. The icon reflects the status of the linked
file, as described below:

 The linked file hasn't changed and there are no errors.

 The linked file can't be found at the specified location.

 The linked file has changed or another file has been selected by changing
the path or using the browser from this list. If you want to update your scene
with the changes in this file, you must reload on page 6791  your link.

You can change the path name by highlighting it and clicking again to enter
its location. This also displays a file browser button to the right of the file
name that you can use to locate a file. If the directory of a linked file is no
longer valid, then you must enter a new, valid path name.

Reload Refreshes the link between the file and the 3ds Max session. This
feature is useful when the file has been modified and you want to see the
changes reflected in your 3ds Max scene. If you turn on Show Reload Options,
the File Link Settings dialog on page 6793  displays when you click this button.

Changes that have been made to the base file will be applied to the objects at
the bottom of the 3ds Max modifier stack. If you have 3ds Max materials
applied to walls in a floor plan in your scene, the same materials are applied
to the walls when you reload an updated version of the linked file.

To cancel the File Link operation press Esc. You can do this at any time during
the process.

Cancelling the File Link operation removes every object the process has linked
to the scene until the moment you press Esc.

NOTE This option is available only when the file is highlighted in the Linked Files
list.

Detach Removes an existing link to a file. Detach also removes all geometry
associated with or dependent on the link.

When you click this button, you receive a warning that you're about to remove
all objects associated with the linked file. You can either proceed or cancel
the operation.

NOTE This option is available only when the file is highlighted in the Linked Files
list.
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Bind Removes the link to the file. The geometry in the scene remains
unchanged, but it's no longer linked back to the original file and, if the original
file changes, it can't be updated using Reload.

When you click this button, you receive a warning that you're about to break
the link between the objects in the current 3ds Max scene and the file.

NOTE This option is available only when the file is highlighted in the Linked Files
list.

Show Reload Options Displays the File Link Settings dialog on page 6793
when you click Reload, and uses these settings for reloading. When you turn
off this option, the File Link Manager uses the reload settings stored in the
current scene.

Close Cancels all changes to settings and closes the dialog.

Presets panel

Named Presets Lists all existing presets.

Modify Opens the File Link Settings dialog on page 6793 , letting you change
the settings of the selected preset.

New Opens the New Settings Preset dialog on page 6809 , creating a new preset
with default settings.
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NOTE New is only available when no preset is selected in the list. If a preset is
selected, this button changes to Copy.

Copy Opens the New Settings Preset dialog on page 6809 , creating a new
preset with the same settings as the currently selected preset.

NOTE Copy is only available when a preset is selected in the list. If no preset is
selected, this button changes to New.

Rename Opens the Rename Settings Preset dialog on page 6811 , letting you
change the name of the selected preset.

Delete Deletes the selected preset.

Close Cancels all changes to settings and closes the dialog.

File Link Settings Dialog

File menu > File Link Manager > Files tab > Turn on Show Reload Options. >
Click Reload.

Utilities panel > Utilities rollout > More button > File Link Manager > Files tab
> Turn on Show Reload Options. > Click Reload.

The File Link Settings dialog gives you control over the detailed aspects of
how geometry is translated from DWG or DXF files and interpreted in 3ds
Max. It also allows you to control whether only a portion of the 3ds Max
objects will be affected by subsequent reloading. The File Link Settings dialog
is displayed when Show Reload Options is turned on in the File Link Manager
dialog, or when editing a file link Preset.

The File Link Settings dialog lets you:

■ View and exclude layers in a linked file.

■ Control how geometry is converted.

■ Define how linked objects are converted to 3ds Max objects, referred to as
VIZBlocks.

The selections you make in the File Link Settings dialog can affect the amount
of memory used by 3ds Max to hold the linked data. Use the Select Layers To
Include option on page 6803  to reduce the amount of information added to
your scene.
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In some cases, it might be more efficient to create multiple links to the same
file, making different file link settings for each file.

See also:

■ File Link Tips on page 6777

Basic File Link Settings

File Link Manager > Reload a linked file with Show Reload Options turned on.
> File Link Settings dialog > Basic panel

File Link Manager > Presets panel > Highlight a preset and click Modify. > File
Link Settings dialog > Basic panel

The Basic panel of the File Link Settings dialog on page 6793  defines how 3ds
Max converts the linked file’s objects into corresponding 3ds Max objects.
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Interface

Weld nearby vertices Sets whether to weld nearby vertices of converted
objects according to the Weld Threshold setting. Welding smooths across
seams and unifies normals of objects with coincident vertices. Welding occurs
only on vertices that are part of the same object.

Weld threshold Sets the distance that determines whether vertices are
coincident. If the distance between two vertices is less than or equal to the
weld threshold, the vertices are welded together. To use the Weld Threshold,
turn on Weld.
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Auto-smooth adjacent face Assigns smoothing groups on page 7932  according
to the Smooth-angle value. Smoothing groups determine whether faces on
an object render as a smooth surface or display a seam at their edges, creating
a faceted appearance.

Smooth-angle Controls whether smoothing occurs between two adjacent
faces. If the angle between the two face normals is less than or equal to the
smooth angle, the faces are smoothed (that is, put in the same smoothing
group).

Orient normals of adjacent faces consistently Analyzes the face normals of
each object and flips normals where necessary, so they all point in a direction
that is consistent with adjoining faces. If the imported geometry isn't properly
welded, or if the AutoCAD geometry did not contain or specify normal
information, normals might be oriented in the wrong direction. Use the Edit
Mesh on page 1283  or Normal on page 1509 modifiers to flip normals.

When Unify Normals is off, normals are calculated according to the face vertex
order in the linked file. Face normals for AutoCAD solids are already unified.
Turn off Unify Normals when importing only AutoCAD solid models from
AutoCAD Architecture.

Cap closed splines Applies an Extrude modifier on page 1377  to all closed
objects, and selects the Cap Start and Cap End options of the modifier. The
Extrude modifier Amount value for a closed object with no thickness is set to
0. Capping makes closed objects with thickness appear solid and closed objects
without thickness appear flat. When Cap Closed Objects is off, the Extrude
modifier Cap Start and Cap End options for closed objects with thickness are
clear. No modifiers are applied to closed objects without thickness.

TIP Unless you chose the One-to-One sorting option, you won't immediately see
the Extrude modifier when selecting an object. To see it, look through the modifier
stack for the VIZBlock on page 7967  sub-objects. In a nested VIZBlock, the Extrude
modifiers appear at the bottom of the stack. You can then edit the Extrude modifier
parameters.

Texture Mapping The texture mapping setting can reduce the loading time
of models that have many objects with stored UVW Coordinates for texture
mapped materials.
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NOTE This setting applies only to geometry that is stored as a mesh in the scene.
Spline shapes marked as renderable have separate controls for UVW coordinate
generation; these are found on the Spline Rendering panel on page 6806 .

■ Generate Coordinates For All Objects Automatically generates UVW
coordinates for all objects when the drawing is linked.
This option tells the File Link Manager to create UVW coordinates, but
loading time is increased while the coordinate generation occurs.

■ Generate Coordinates On Demand Does not generate texture coordinates
for linked mesh objects.
Actively linked objects generate UVW coordinates on demand, so if you
assign a material to an object and the material requires texture coordinates,
the texture coordinates are silently assigned to that object. If the material
or texture map is set to display in viewport, the coordinates are assigned
as soon as the material is applied; if not, the coordinates are assigned when
the scene is rendered.

This option gives you faster loading speed, but no UVW coordinate
generation.

NOTE Objects in drawings created in AutoCAD Architecture pass texture
coordinates explicitly to 3ds Max when you attach the drawing. If you specify
on-demand coordinate generation, they might not match the coordinates that
were specified in the original drawing. The map scaling is the same, but the
texture offsets may be altered.

Curve steps For objects such as splines, the number of knot points determines
the spline's shape and curvature. The Curve steps value defines the number
of segments between knot points. A low value gives you a more linear
interpolation between the knot points; a higher number gives you a more
accurate curve.

Maximum surface deviation for 3D solids Specifies the maximum allowable
distance from the 3ds Max surface mesh to the parametric AutoCAD solid
surface. Small numbers produce more accurate surfaces with a greater number
of faces. Large numbers produce less accurate surfaces with fewer faces.

Include group

This group allows you to toggle the inclusion of specific parts of a DWG file
during the file link process.

External references Imports xrefs attached to the DWG file.
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Lights Imports lights from pre-AutoCAD 2007 DWG files.

Sun and Sky Imports Sun and Shadows position from the drawing file
(AutoCAD / AutoCAD Architecture 2008 and Revit 2008 only).

NOTE You must set mental ray as the default renderer for you to see the Sun and
Sky effect. To set mental ray as the default renderer, see Choose Renderer Dialog
on page 5944 .

Hatches Imports hatches from the DWG file.

WARNING This stores each line or dot in the hatch pattern as a separate spline
that defines the hatch; this can create a very large number of objects in your scene.

Views and Camera Imports named views from the DWG file, and converts
them to 3ds Max cameras.

NOTE Orthographic views do not translate correctly in imported DWG files.
However, there are no problems with Perspective views.

Points Imports points from the DWG file.

NOTE The imported point objects are represented in 3ds Max as Point Helper
on page 2544  objects.

UCSs (grids) Imports user coordinate systems (UCS) from the DWG file and
converts them to 3ds Max grid objects.

Advanced File Link Settings

File menu > File Link Manager > Reload a linked file with Show Reload turned
on. > File Link Settings dialog > Advanced panel

File menu > File Link Manager > Presets panel > Select an existing preset and
click Modify. > File Link Settings dialog > Advanced panel

File menu > File Link Manager > Presets panel > Create a new preset. > Select
the newly created preset and click Modify > File Link Settings dialog >
Advanced panel

Utilities panel > Utilities rollout > More button > File Link Manager > Reload
a linked file with Show Reload turned on. > File Link Settings dialog > Advanced
panel
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Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Highlight an existing preset and click Modify. > File Link Settings
dialog > Advanced panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Create a new preset. > Highlight the newly created preset and click
Modify > File Link Settings dialog > Advanced panel

The Advanced panel of the File Link Settings dialog on page 6793  controls how
the software derives AutoCAD primitives and whether 3ds Max uses the scene
material definitions when linking to or reloading the AutoCAD drawing. It
also lets you selectively reload your scene, so that you reload only specific
objects, not the entire file.
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Interface

Derive AutoCAD primitives by: Lists the options for deriving objects from
the linked DWG file. This setting is available only when modifying a preset
on page 6812 .

NOTE This applies only to standard AutoCAD primitives. Specialized objects, such
as those from AutoCAD Architecture, are handled differently.

TIP For best results, use the Layer, Blocks as Node Hierarchy  or Entity, Blocks as
Node Hierarchy  options, except in special circumstances.
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There are six options to choose from:

■ Layer, Blocks as Node Hierarchy Linked objects on a given layer in the
AutoCAD drawing that aren't in blocks are combined into a single Editable
Mesh or Editable Spline object in 3ds Max. The name of each linked object
is based on the AutoCAD object's layer. The linked object name has a
“Layer:” prefix and is followed by the layer name. For example, all AutoCAD
objects residing on the layer Walls become part of the Editable Mesh named
Layer:Walls after they are linked in 3ds Max.
Each block is linked separately as a hierarchy, with the block itself as the
parent object and its constituent parts as child objects. The child objects
of the block are combined by layer.

TIP This is usually the best option for file linking. It preserves all ADT
information, and generally maintains the same granularity as you would expect
in AutoCAD.

■ Layer, Blocks as Node Hierarchy, Split by Material This works the same
as the Layer, Blocks as Node Hierarchy option, with the following additional
functionalities: The combination of non-block objects by layer, followed
by material and support for multiple materials assigned to ACIS solid and
polymesh geometry.

■ Non-block object layer combination:

For example, take an AutoCAD file with six objects in layer A: three have
a Brick material and three have a Stone material. Using this option, this
file would be linked to in the form of two objects, or nodes, one containing
the Brick material and the other with the Stone material.

Each block is linked to separately as a hierarchy, with the block itself as
the parent object and its constituent parts as child objects. The child objects
of the block are combined by layer.

■ Multiple material support

On import, ACIS solids and polymesh geometry can support multiple
materials. For polymesh geometry, one material is supported per face. For
an ACIS solid, if the solid has more than one material associated with it,
a multi/sub object material is created that contains the materials used. If
the solid has only one material associated with it, a standard/architectural
material is assigned instead.
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NOTE Multiple material support for ACIS solids applies to DWG files imported
or file linked from Revit Architecture 2008 or AutoCAD Architecture (formerly
Architectural Desktop or ADT) 2008 and later.

NOTE This derivation method is intended for use with AutoCAD 2007 (and
later) format files. Using this method with DWG files created with previous
versions of AutoCAD could result in data loss.

■ Entity, Blocks as Node Hierarchy Every linked object not in a block is
represented as a separate object in the 3ds Max scene, without regard to
layers. The nodes are then placed on scene layers that correspond to the
drawing layers. Each block is imported separately as a hierarchy, with the
block itself as the parent object and its constituent parts as child objects.
The child objects of the block are combined by layer.
One benefit of this option is that you can apply instanced animation
controllers on page 3033  to block subcomponents and thus, by transforming
a single member, transform all members at once. For example, in a scene
containing a conference table with six chairs around it, you could move
all of the chairs simultaneously by moving a single chair.

Another advantage is that all geometry is instanced, so edited UVs and
normals and other modifications need be done only once.

NOTE This derivation method might cause unreliable material propagation
when importing drawings containing dynamic blocks. Materials might
propagate to some block instances and not to others.

WARNING This option has the potential to create an enormous number of
objects in your scene.

Multiple materials per object are supported with this option, if needed. If
the object is an ACIS solid, and has more than one material associated
with it, a multi/sub object material is created containing the materials that
can be edited in the Materials Editor. If the solid has only one material
associated with it, a standard/architectural material is assigned instead. If
the object is polymesh geometry, one material per face is supported.

NOTE Multiple material support for ACIS solids applies on the DWG files
imported or file linked from Revit Architecture 2008 or AutoCAD Architecture
(formerly Architectural Desktop or ADT) 2007 and later.

■ Layer Linked objects are combined in 3ds Max according to their layer.
Objects in each of the associated application's layers are combined into
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one object, with the exception of blocks, each of which is represented as
an individual VIZBlock (not a hierarchy). Multiple inserts of the same block
are represented using instances in the scene. Material assignments are lost
but material IDs are preserved.

■ Color Linked AutoCAD objects are combined in 3ds Max according to
their color. All objects of the same color are combined into one object,
with the exception of blocks, each of which is represented as an individual
VIZBlock (not a hierarchy). Multiple inserts of the same block are
represented using instances in the scene. Material assignments are lost but
material IDs are preserved.

NOTE Blocks can contain objects with different colors. However, when sorting,
3ds Max considers only the color of the block itself. Also, 3ds Max objects can
only display one color, unless a material is applied.

■ Entity Provides a one-to-one correspondence between AutoCAD objects
and 3ds Max objects. For each linked object or block in the imported file,
the File Link Manager creates an independent object or VIZBlock,
respectively, in the scene. Material assignments are lost but material IDs
are preserved.

WARNING This option has the potential to create an enormous number of
objects in your scene.

NOTE When working with drawings exported from Revit, it is recommended
that you do not use this setting.

■ One Object All linked objects are combined into a single VIZBlock.
Material assignments are lost but material IDs are preserved.

Select Layers to Include Displays the Select Layers dialog on page 6813 , which
you use to choose layers to import from the linked file. Available only when
reloading a linked file.

TIP Excluding unnecessary objects from linking can improve the performance of
the reload operation.

Create Helper at Drawing Origin When on, 3ds Max inserts the user
coordinate system icon as an origin point helper. 3ds Max places this helper
at the world origin of the linked file. It's a reference point for all the geometry
of the linked file. After attaching, the helper is selected, allowing you to easily

File Link | 6803



move, rotate, or scale all the geometry that was just added to the scene. Each
linked file gets a unique helper object.

This setting is available only when modifying a preset on page 6812 .

Use Extrude Modifier to Represent Thickness When on, linked objects with
thickness receive an Extrude modifier to represent the thickness value. You
can then access the parameters of this modifier and change the height
segments, capping options, and height value.

When off, objects with thickness (and closed capped objects) are converted
directly to a mesh.

This setting is available only when modifying a preset on page 6812 , and not
using the Derive option Layer, Blocks as Node Hierarchy.

Create One Scene Object for Each ADT Object AutoCAD Architecture
(formerly Architectural Desktop or ADT) objects are linked as a single object
instead of being separated into their constituent components. This means
that if you link an AutoCAD Architecture door object, the door is represented
as one object instead of three. Turning on this switch make linking faster and
the scene size is smaller.

This setting is available only when modifying a preset on page 6812 .

NOTE This switch presents several modeling concerns that you need to be aware
of.

■ Material assignments from AutoCAD Architecture are not translated during
the file link process.

■ If you want to assign materials to these objects, use Multi/Sub-Object
materials.

■ Depending on the Texture Mapping option you choose, UVW coordinates
are translated correctly.

Use Scene Material Definitions When on, 3ds Max checks the current scene
for any currently used materials with the exact same name as a material name
in the linked DWG file. If a match is found, File Link does not translate the
drawing’s material, but instead uses the material defined in the scene.

When off, the File Link Manager always uses the material definitions contained
in the DWG file, and will overwrite scene materials with the same name,
regardless of which objects the material is applied to. All material definitions
stored in the DWG file are reloaded (even when using a selective reload). If
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you make changes to a linked material, in 3ds Max, then reload, those changes
will be lost (if the switch is off).

If Use Scene Material Assignments on Reload is on at the same time as Use
Scene Material Definitions, standard/architectural materials, material
assignments, and face material IDs are left as they are.

If Use Scene Material Assignments on Reload is off at the same time as Use
Scene Material Definitions, only the material assignments and face material
IDs are updated and standard/architectural materials are not translated.

TIP When reloading a file, most of the materials from the DWG file will have
already been created in the scene by 3ds Max; they may not need to be
re-translated. If you want to update a scene material with the definition contained
in the drawing, turn this switch off.

NOTE Material name comparison is case-sensitive.

Use Scene Material Assignments on Reload When on, linked objects with
a material already assigned to them in the 3ds Max scene will not have that
material assignment changed. This is the case regardless of whether the material
was assigned automatically by the File Link Manager or manually by the user.

When off, linked objects have their material assignment “coordinated” with
the drawing, so that the two are in sync.

If Use Scene Material Definitions is on at the same time as Use Scene Material
Assignments on Reload, standard/architectural materials and material
assignments are left unchanged.

If Use Scene Material Definitions is off while Use Scene Material Assignments
on Reload is on, only standard/architectural materials are retranslated. Any
material assignments and Face Material IDs are left unchanged, so Multi/Sub
object materials are not retranslated but some sub-materials may have changed.

Selective Reload Lets you perform a partial reload of your linked file. Use a
partial reload when you know what has changed in the linked file, and want
to speed up the time it takes to reload the geometry.

The following options are available:

■ Selected in Scene Reloads only the objects currently selected in your
scene.

■ Selected in List Reloads only the objects that you choose from a named
list. This list is defined by clicking Linked Objects.
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Linked Objects Allows you to reload only objects that you choose from a
named list. The list is created from the objects linked in the file. When you
click Linked Objects, the Select Linked Object dialog on page 6815  is displayed.

Spline Rendering File Link Settings

File menu > File Link Manager > Reload a linked file with Show Reload turned
on. > File Link Settings dialog > Spline Rendering panel

File menu > File Link Manager > Presets panel > Select an existing preset and
click Modify. > File Link Settings dialog > Spline Rendering panel

File menu > File Link Manager > Presets panel > Create a new preset. > Select
the newly created preset and click Modify > File Link Settings dialog > Spline
Rendering panel

Utilities panel > Utilities rollout > More button > File Link Manager > Reload
a linked file with Show Reload turned on. > File Link Settings dialog > Spline
Rendering panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Highlight an existing preset and click Modify. > File Link Settings
dialog > Spline Rendering panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Create a new preset. > Highlight the newly created preset and click
Modify > File Link Settings dialog > Spline Rendering panel

The Spline Rendering panel of the File Link Settings dialog on page 6793
controls how shapes will appear in the scene once the DWG or DXF file is
linked. You can control the appearance of the shape, its smoothing, mapping
coordinates and if they can be rendered.
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Interface

The controls on this panel are identical in name and operation to those found
on the Rendering rollout on page 546  for splines. The values of these settings
are set for all imported shapes. Once the import is complete, you can change
the settings as necessary for each object.

Enable in Renderer When on, the shape is rendered as a 3D mesh using the
Radial or Rectangular parameters set for Renderer. In previous versions of the
program, the Renderable switch performed the same operation.

Enable in Viewport When on, the shape is displayed in the viewport as a
3D mesh using the Radial or Rectangular parameters set for Renderer. In
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previous versions of the program, the Display Render Mesh performed the
same operation.

Use Viewport settings Lets you set different rendering parameters, and
displays the mesh generated by the Viewport settings. Available only when
Enable In Viewport is on.

Generate Mapping Coords Turn this on to apply mapping coordinates.
Default=off.

3ds Max generates the mapping coordinates in the U and V dimensions. The
U coordinate wraps once around the spline; the V coordinate is mapped once
along its length. Tiling is achieved using the Tiling parameters in the applied
material. For more information, see Mapping Coordinates on page 5183 .

Real-World Map Size Controls the scaling method used for texture mapped
materials that are applied to the object. The scaling values are controlled by
the Use Real-World Scale settings found in the applied material's Coordinates
rollout on page 5620 . Default=on.

Auto Smooth If Auto Smooth is turned on, the spline is auto-smoothed using
the threshold specified by the Threshold setting below it. Auto Smooth sets
the smoothing based on the angle between spline segments. Any two adjacent
segments are put in the same smoothing group if the angle between them is
less than the threshold angle.

Threshold Specifies the threshold angle in degrees. Any two adjacent spline
segments are put in the same smoothing group if the angle between them is
less than the threshold angle.

Viewport Turn this on to specify Radial or Rectangular parameters for the
shape as it will display in the viewport when Enable in Viewport is turned on.

Renderer Turn this on to specify Radial or Rectangular parameters for the
shape as it will display when rendered or viewed in the viewport when Enable
in Viewport is turned on.

Radial Displays the 3D mesh as a cylindrical object.

Thickness Specifies the diameter of the viewport or rendered spline mesh.
Default=1.0. Range=0.0 to 100,000,000.0.
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Splines rendered at thickness of 1.0 and 5.0, respectively

Sides Sets the number of sides (or facets) for the spline mesh n the viewport
or renderer. For example, a value of 4 results in a square cross-section.

Angle Adjusts the rotational position of the cross-section in the viewport or
renderer. For example, if the spline mesh has a square cross section you can
use Angle to position a "flat" side down.

Rectangular Displays the spline's mesh shape as a rectangle.

Length Specifies the size of the cross–section along the local Y axis.

Width Specifies the size of the cross–section along the local X axis.

Angle Adjusts the rotational position of the cross-section in the viewport or
renderer. For example, if you have a square cross-section you can use Angle
to position a "flat" side down.

Aspect Sets the aspect ratio for rectangular cross-sections. The Lock check
box lets you lock the aspect ratio. When Lock is turned on, Width is locked
to Length that results in a constant ratio of Width to Length.

New Settings Preset Dialog

File menu > File Link Manager > Presets panel > Copy or New

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Copy or New

The New Settings Preset dialog creates a new preset in the File Link Manager
on page 6783 . The settings of the new preset either use default values (if you
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clicked New), or they inherit the values of a selected preset (if you clicked
Copy).

After creating the preset, you can change its settings by clicking Modify.

Procedures

To create a new preset:

1 On the Presets panel of the File Link Manager, click New.

NOTE New is available only if no named presets are highlighted.

2 On the New Settings Preset dialog, enter a name for your preset, and click
OK.

A new preset is created with default settings.

To copy a preset:

1 On the Presets panel of the File Link Manager, choose a named preset.

2 Click Copy.

NOTE Copy is available only if a named preset is highlighted.

3 In the New Settings Preset dialog, rename the preset, and click OK.

A new preset is created with the same settings as the selected preset.

NOTE If you do not rename the preset, it will cancel the command.
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Interface

New Name The name of your preset.

Format The file type for the preset.

Rename Settings Preset Dialog

File menu > File Link Manager > Presets panel > Click a preset > Rename

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Click a preset > Rename

The Rename Settings Preset dialog lets you rename your preset.

NOTE You cannot use names beginning with 'Preset', so names like “Preset 1” or
“Preset with Welding” are not allowed.

Interface
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New Name The name of your preset.

Format The file type for the preset.

NOTE By default, presets can be created only for AutoCAD file types (DWG, DXF).
Other file types might be available, depending on the third-party plug-ins you
have installed.

Preset Editing

File menu > File Link Manager > Presets panel > Click a preset > Modify

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Click a preset > Modify

After you've created a preset, you can use this function to adjust its settings.
For instance, you might want to make sure Weld is on, or perhaps to include
lights or views (cameras).

Procedures

To edit or modify a preset:

1 On the Presets panel of the File Link Manager, choose a named preset.

2 Click Modify.

The File Link Settings dialog on page 6793  is displayed.

3 From the Basic, Advanced and Spline Rendering panels, make the settings
you want associated with the preset and click Save.

Differences Between Layers and Blocks in
AutoCAD and 3ds Max

AutoCAD has special handling for objects in the block definition that are
associated with layer 0. When a block contains objects on layer 0, and those
objects have a color property of "ByLayer" or "ByBlock", the color of the object
is determined either by the color of the block or by the layer assigned to the
block reference on page 7731  in AutoCAD . When blocks are nested, this color
system can get complex.
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Select Layers Dialog

File menu > File Link Manager > Files panel > Reload button > File Link Settings
dialog > Advanced panel > Select Layers to Include button

Utilities panel > Utilities rollout > More button > File Link Manager > Files
panel > Reload button > File Link Settings dialog > Advanced panel > Select
Layers to Include button

This dialog lets you toggle a layer's include/exclude status and choose other
options, as described in this topic.

NOTE You toggle the include/exclude status of a layer by clicking anywhere on
a row in the list of layers. The dialog lists included layers with a check mark to the
left of the layer name. This list of included layers is retained for subsequent reloads
of the linked file. For informational purposes, the property icons display the state
of the layers' properties, but you can't change their status in this dialog.

See also:

■ Layer Properties Dialog on page 7237

Interface
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Skip all frozen layers Excludes all layers frozen in the linked file. All active
files are included.

Select from list Lets you select individual active layers to include/exclude.
A check mark beside the layer name indicates the layer is selected.

All Includes all layers in the linked file by selecting all of them. You can then
deselect just the layers you want to exclude.

None Excludes all layers in the linked file by deselecting all of them. You
can then select just the layers you want to include from importing.

Invert Reverses the current selection of layers in the linked file.

Resolve External Reference File Dialog

The Resolve External Reference File dialog is displayed when 3ds Max can't
find the externally referenced files it needs in an attached DWG file.

See also:

■ File Link Tips on page 6777

Interface
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Xref Stored File Name Displays the external reference path stored in the
attached drawing.

Referenced by Displays the path of the attached drawing.

As Block Name Displays the name of the block reference in the attached
drawing. The block name is usually the same as the xref name, but it can be
different.

File Name for File Link When 3ds Max can't locate the linked file, use this
field to enter another path and file name. 3ds Max verifies that the file exists
at that location and reports its status in the lower left of the dialog.

Browse Lets you use the file system to find another file for the link. Choosing
a file this way enters file path and name in the File Name For File Link field.

All Xref Files group

Controls whether and how 3ds Max resolves external references from File
Link.

Prompt Only if File Cannot be Found Searches for the externally referenced
file and all unresolved external references from File Link in the attached
drawing by using the stored file name in the locations listed in this dialog
and in the order they appear.

Do Not Resolve any Xrefs Doesn't resolve this externally referenced file or
any other unresolved external references from File Link in the attached
drawing. However, any external references from File Link resolved before you
turn on Do Not Resolve Any Xrefs will still be resolved.

OK Resolves this externally referenced file.

Don't Resolve This File Doesn't resolve this externally referenced file, but
will prompt for any other external references from File Link to resolve.

Select Linked Objects Dialog

File menu > File Link Manager > Files panel > Select file to reload. > Reload
button > File Link Settings dialog > Advanced panel > Turn on Selective Reload.
> Linked Objects

Utilities panel > Utilities rollout > More button > File Link Manager > Files
panel > Select file to reload. > Reload button > File Link Settings dialog >
Advanced panel > Turn on Selective Reload. > Linked Objects
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The Select Linked Objects dialog displays the linked objects associated with
the selected linked file, including VIZBlocks on page 7967 , lights, and cameras.
You use this dialog when reloading a linked file so that you can include/exclude
specific objects from the reloading process. You might want to do this in order
to reload only the objects which have changed.

Interface

List of Objects Lists the VIZBlocks, cameras, and lights associated with the
selected linked file. A check mark beside the object name indicates the object
is selected; an X mark indicates the object is deselected.

All Selects all linked objects in the linked file. You can then deselect specific
linked objects by clicking their rows.

None Deselects all linked objects in the linked file. You can then select
specific linked objects by clicking their rows.

Invert Reverses the current selection of linked objects in the linked file.
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Working with AutoCAD,AutoCAD Architecture,
and Revit Files

3ds Max produces rich visualizations based on your drawing design data. In
order to produce high-quality visualizations, you need to add and adjust many
design variables that affect the visual impact of your design, but don't really
belong in your core AutoCAD, AutoCAD Architecture, or Revit data. You may
want to test your design under different lighting conditions, experiment with
different texture and material effects, animate components, or move through
a space. 3ds Max allows you to enhance your design with this “extra” data
while maintaining the integrity of the underlying AutoCAD, AutoCAD
Architecture, or Revit design.

Using the File Link Manager on page 6783 , 3ds Max maintains a live data link
to AutoCAD, AutoCAD Architecture, or drawings exported from Revit that
allows you to use the linked object data in your 3ds Max scene. You can
perform various operations on this linked data in 3ds Max for visualization
purposes, but nothing you do in 3ds Max will change the base data you see
in the source application. The data link allows you to periodically refresh your
3ds Max scene with revised drawing data.
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If a live data link is not important to you, the DWG/DXF Import functionality
processes drawings, exported from Revit, in the same intelligent way as the
File Link Manager. You just don't have the benefit of the live data link.

See also:

■ Using Layers to Organize a Scene on page 7224

■ File Link on page 6772

■ Interpreting Layer Data from AutoCAD, AutoCAD Architecture, and Revit
on page 6782

AutoCAD Geometry in 3ds Max

The basis of your model in 3ds Max is the geometry of the objects, blocks,
and other entities that are transferred through the file linking functionality.
In many cases, these objects behave just like the editable meshes and splines
you create in 3ds Max. But because the link to the source drawing plays such
a central role in your workflow, 3ds Max has special rules and tools for
handling linked AutoCAD geometry.

When you are working with linked objects and blocks from AutoCAD, you
will find that these are composed as groups of related objects in 3ds Max.
These groups are organized hierarchically below a 3ds Max VIZBlock object.
VIZBlocks are special objects created by the file linking functionality that are
used to contain other file linked objects in a group. VIZBlocks don't contain
any geometry directly, so for example it is meaningless to apply modifiers to
them. However, they do reference the components below them so that
transforms applied to a VIZBlock will be applied to all the component objects
it contains.

See also:

■ Styles on page 6850

■ Instanced Objects on page 6843

■ Blocks on page 6844
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AutoCAD Entities and Blocks in 3ds Max

AutoCAD blocks in 3ds Max are treated similarly to AutoCAD objects, though
the rules for propagation of transforms are slightly different to mirror the
behavior of blocks in AutoCAD.

As with AutoCAD objects, linked AutoCAD blocks, of any type, and externally
referenced drawings appear in 3ds Max as objects hierarchically grouped below
a VIZBlock to reflect the structure of the block or xref in AutoCAD.

When non-nested blocks, of any type, are linked to a scene, the naming for
the incoming block instances are based on the original block definition in the
form of Block: block_name where block_name is the actual name of the block
definition. For example, if you link a drawing containing a series of blocks
named office chair, their name will show as Block: office chair in 3ds Max.

Nested blocks in AutoCAD will be analogously nested in 3ds Max under nested
VIZBlocks. The grouping and naming follows the parent-child structure of xref
drawing name:block name:nested block name:entity.

NOTE Entities that lie on layer 0 of an AutoCAD block definition will appear as
Layer:0  in 3ds Max, even though they may appear to reside on a different layer
when they are inserted in AutoCAD.

With linked AutoCAD Architecture objects, material assignments to linked
AutoCAD blocks can propagate automatically to all other instances of those
block components in the 3ds Max scene, depending on how Propagate
Materials To Instances on page 5232  is set. Modifiers applied to block
components, however, propagate automatically to all other block instances,
regardless of how Propagate Materials To Instances is set.

If you transform (move, rotate, or scale) the top-level VIZBlock that contains
a block reference, all the components of that block will be transformed together
and no other VIZBlocks will be affected. If, however, you transform a block
component, including a nested VIZBlock, that transformation will automatically
propagate to all other instances of that block in the scene. This mirrors the
behavior of blocks in AutoCAD when reference-editing a block definition.

See also:

■ Blocks on page 6844
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Resetting Transforms on Linked AutoCAD Objects

Select a linked AutoCAD object. > Modify panel > Linked Geometry rollout >
Reset Position

You can move, rotate, or scale linked AutoCAD objects in 3ds Max, and these
transformations will remain intact even after the linked AutoCAD drawing
has been reloaded. But you can choose to eliminate the transforms on an
object-by-object basis using the Reset Position function, available on the
Modifier panel.

NOTE The Reset Position functionality is only available for linked files. It is not
available when you Import a DWG file, or when you have bound a linked file.

Every linked AutoCAD object and component has a Reset Position function
associated with it. Clicking this button automatically resets all transformations
that have been applied to this object or component in 3ds Max, so that the
component resumes the location, rotation, and scale it held in the linked
AutoCAD drawing when it was last reloaded.

WARNING Transforms applied to block components are applied to all instances
of that component in all other linked block insertions in the 3ds Max scene.
Resetting the transformation of any  instance will reset all  of them.

To reset the transforms applied to a linked AutoCAD object:

1 Select a linked object in your scene.

2 On the Command panel, click the Modify tab to display the Modify
panel.

The name of the linked object appears at the top of the Modify panel,
and the modifiers that have been added to the object (if any) are shown
on the modifier stack.

3 At the bottom of the list of applied modifiers, click either Linked Geometry,
VIZBlock, or Block/Style Parent, whichever appears, if it is not already
highlighted.

A Linked Geometry rollout appears at the bottom of the Modify panel.

4 Click the Reset Position button

The linked object reverts back to its original location, rotation, and scale
in the linked AutoCAD drawing.
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NOTE When Reset Position is applied to a linked object that has been animated
(in other words, has transform keys for different frames) only the transform for
frame 0 is reset.

See also:

■ File Link on page 6772

Interface

Reset Position Resets the selected object's transforms to those of the original
AutoCAD object when the drawing was last reloaded.

Restrictions on Editing AutoCAD Geometry

Many operations that are allowed on mesh, spline, or shape objects in 3ds
Max are not allowed on linked AutoCAD geometry, and other operations
behave differently.

The following operations are not allowed on linked geometry:

■ Deletion

■ Altering the parent-child hierarchy

■ Collapsing the linked geometry into an editable mesh or an editable spline

If you must perform any of these operations, you must either do them in
AutoCAD or else bind the drawing data to 3ds Max, which breaks the link
back to AutoCAD.

Applying Modifiers to Linked AutoCAD Geometry

You can apply modifiers to linked AutoCAD geometry and these modifiers
will persist when you reload the geometry. This can be a very powerful way
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to intelligently manage your design intent, but it can also lead to some
unexpected results, especially when using topology-dependent modifiers.

“Topology-dependent” simply means that the modifier is relying on the
particular arrangement and number of faces and vertices that comprise the
mesh representation of the object. It is common, for example, for the modifier
to cause an action to be performed on the nth element it encounters, say the
“twelfth” face or the “fourth through the twentieth” vertex. It is easy to
perform edits on the base object in AutoCAD that would cause the definition
of the nth element to change, which would result in the modifier yielding
unexpected results when the drawing is reloaded in 3ds Max.

Not all modifiers are topology-dependent. When you attempt to use a
topology-dependent modifier on linked AutoCAD geometry, a warning dialog
is displayed that gives you an opportunity to continue or abort the operation.

When you use modifiers on linked AutoCAD objects and blocks, remember
that the VIZBlock object you see in 3ds Max does not contain any geometry
directly; applying modifiers to VIZBlocks will never have any visible effect.
Instead, apply modifiers to the component objects below the VIZBlock in the
3ds Max object hierarchy.

Copying Actively Linked Objects

You can copy actively linked objects in 3ds Max; the copies are automatically
converted to editable mesh objects. If your selection contains several objects
that instance another object, the resulting copies also instance the same object.

However, it is recommended that you do not instance or reference actively
linked objects, as this can introduce instability to the scene.

See also:

■ Using Modifiers on page 1015

AutoCAD Architecture Files

DWG files from AutoCAD Architecture (formerly Architectural Desktop or
ADT) often contain additional information, such as special objects, material
definitions, and styles. 3ds Max is thoroughly compatible with AutoCAD
Architecture, and it recognizes all of these specialized objects and definitions
during the file link process.
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AutoCAD Architecture Objects in 3ds Max

Each instance of an AutoCAD Architecture (formerly Architectural Desktop
or ADT) object is represented by multiple objects in 3ds Max. Whenever the
file link process detects a useful distinction between elements of an AutoCAD
Architecture object, it automatically separates, names, and groups the elements
in 3ds Max to make them easier to work with. The new objects created in 3ds
Max through file linking are grouped together hierarchically below a special
object called a VIZBlock, allowing you to deal with individual objects in the
hierarchy or with all of them as a group. You can view this hierarchy, but you
cannot change it in 3ds Max. You can only change the hierarchy indirectly
by editing the objects in AutoCAD Architecture, and then reloading them
into 3ds Max using the File Link Manager on page 6783 .

Criteria for Subdividing AutoCAD Architecture Objects

The File Link Manager divides an AutoCAD Architecture object into multiple
objects in 3ds Max if it detects distinctions based on the following features:

■ Component name

■ Component subtype (for example, in sectioned bodies)

■ Layer

■ Material assignment

So, for example, if a window object in AutoCAD Architecture contained a
mullion component, but a portion of the component had a different material
assignment than the rest of it, the mullion component would appear as two
separate objects when linked into 3ds Max. The objects will be linked together
with all the other components of the window, but you could modify the
material properties of the two mullion objects separately. If you changed the
material assignments in AutoCAD Architecture so that the entire mullion
component only had one material assignment, then when you reloaded the
drawing in 3ds Max there would only be one mullion object present.

NOTE Material assignment and Layer are two of the properties used to separate
one component from another. When these are changed in the AutoCAD
Architecture drawing, new objects are created in 3ds Max, or geometry may move
from one object to another. In either case, some scene properties are changed,
such as assigned material or scene layer.
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3ds Max organizes and names file linked objects to reflect their structure in
AutoCAD Architecture, using a parent-child hierarchy. The parent object will
be a VIZBlock named object class <style>, and this VIZBlock will have one or
more child objects named object class <style name> component1, object class
<style name> component2, and so forth. Objects that originate in an xref drawing
in AutoCAD Architecture are grouped together under a VIZBlock that is named
for the xref drawing.

The following table lists some examples of the naming conventions of
AutoCAD Architecture objects that are file linked in 3ds Max.

RemarksName in 3ds Max

A VIZBlock containing one or
more objects found in draw-

Xref:Draw-
ing1XRef:5701

ing1.dwg, which is an xref in
the linked AutoCAD Architec-
ture drawing.

A VIZBlock for an object of
class=Window and style=Picture-

Window <Picture-
Arched>

Arched. There will one or more
components that belong to
this object instance, which will
be child objects with the
VIZBlock as their parent.

A component to the object,
named Frame.

Window <Picture-
Arched> Frame

NOTE It is possible for instances of the same AutoCAD Architecture object to
subdivide differently into 3ds Max objects. AutoCAD Architecture objects are
considered instances of the same object if their type, style name, and component
name are exact matches, and this will affect their instancing behavior for 3ds Max
functions such as substitution as well as material propagation.

See also:

■ Instanced Objects, Elements, Blocks and Styles on page 6842

■ Styles on page 6850
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Materials and Linked AutoCAD Architecture
Objects

Materials in 3ds Max are vital to making your visualizations compelling and
realistic. The native material attributes that 3ds Max relies on are those that
tell it how to render the surface of an object given certain lighting conditions.
Those material properties that are so central to architectural visualization (that
convey surface coloring, surface texture, transparency, and so forth) are only
one of many sets of properties covered in an AutoCAD Architecture (formerly
Architectural Desktop or ADT) material definition. To make your work more
efficient, the rendering material properties stored and assigned in AutoCAD
Architecture are designed to flow transparently to 3ds Max through the File
Link Manager on page 6783 .

See also:

■ Propagate Materials to Instances on page 5232

Assigning Materials to Linked AutoCAD
Architecture Objects

Material assignments exhibit special behavior on linked AutoCAD Architecture
objects and blocks, and the behavior is controlled by the Propagate Materials
To Instances toggle on page 5232 .

In the default state, assigning a material to any component of any linked
AutoCAD Architecture object or block is equivalent to assigning the same
material to every instance of that component of that object or block
throughout your scene.

As an example, let's say you have multiple instances of a block named
Telephone in your AutoCAD Architecture drawing, which consists of two
nested blocks named Handset and Base. If you assign a material to one Handset
anywhere in your scene, all the Handsets in all the Telephones throughout
the scene will receive that material.

If you want to keep materials from propagating between instances in your
scene, turn off the Propagate Materials To Instances toggle on page 5232 .
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See also:

■ Instanced Objects on page 6843

■ Blocks on page 6844

Making Changes to AutoCAD Architecture
Materials

AutoCAD Architecture (formerly Architectural Desktop) object components
frequently appear in 3ds Max carrying rendering material assignments that
were made in AutoCAD Architecture. You can use these materials, adjust them,
or replace them with new rendering materials for use in 3ds Max. If you modify
or replace the materials in 3ds Max, or if they change in the linked AutoCAD
Architecture drawing, you can choose either to retain the current material in
3ds Max or else to revise the material assigned in 3ds Max with the current
material in AutoCAD Architecture when you use the File Link Manager on
page 6783  to reload the linked drawing.

NOTE When 3ds Max encounters additional material references among xref files
that use a material name that is already in use, it compares the properties of the
two material definitions in an attempt to determine whether they really represent
identical materials. If the two materials appear to be the same material being used
in different drawings, 3ds Max will use only one of the material definitions for all
objects assigned either material. But if 3ds Max determines that this is merely a
naming conflict between two different materials, it will slightly modify the name
of one of the materials and keep the materials and their assignments distinct.

Legacy Materials in AutoCAD Architecture

Longtime users of AutoCAD may be familiar with an older form of material
creation and assignment associated with the RMAT command in AutoCAD
that is still present in AutoCAD Architecture. Materials developed in this way
can be viewed in AutoCAD Architecture and rendered with the legacy AutoCAD
renderer. Any assignments of these materials to geometry in AutoCAD
Architecture that is made through the RMAT command or its Material dialog
in AutoCAD Architecture will be ignored in 3ds Max.

In theory, RMAT materials could be assigned to AutoCAD Architecture objects
(not AutoCAD objects) by incorporating them into AutoCAD Architecture
material definitions, and using these material definitions in edits to AutoCAD
Architecture styles or object overrides. Materials created and assigned in this
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way would appear in 3ds Max assigned to the linked AutoCAD Architecture
objects. However, this practice is not recommended because the native 3ds
Max Architectural materials have more complete information on the surface
characteristics of objects, and are easier to create and share. In other words,
you work faster, share easier, and get better results using native 3ds Max
rendering materials in both AutoCAD Architecture and 3ds Max.

See also:

■ Material Editor, Materials, and Maps  on page 5163

UVW Mapping in AutoCAD Architecture Objects

An important consideration in how many materials render is how they are
“mapped” to the surfaces of the objects they are assigned to. This is especially
important for materials that use bitmaps on page 7730  to define the diffuse
color of a material, or the bump and cutout special effects. As an example,
you may have scanned a picture of wood grain for use in a material, but when
the material is applied to an object, how large should the image of the wood
grain be? Which way do you want the grain to run, and how do you want the
grain to wrap around the corners of a three-dimensional object?

How two-dimensional maps are applied to three-dimensional surfaces is
represented by mapping coordinates on page 7838 , which are stored as UVW
coordinates on page 7962 . In cases where mapping coordinates are likely to be
important to the rendered appearance of an object, AutoCAD Architecture
(formerly Architectural Desktop) assigns UVW coordinates to object
components. 3ds Max translates these coordinates and stores them in the
object mesh that is displayed and rendered in the 3ds Max scene. You can
adjust these coordinates in 3ds Max using the UVW Xform modifier on page
1872 , or you can redefine them all at once using the UVW Map modifier on
page 1849 .

IMPORTANT Make sure that Rescale is turned on in the Attach Panel of the File
Link Manager dialog. Otherwise, if the units do not match, the UVW coordinates
will be incorrectly scaled when linked to 3ds Max.

Drawings Exported from Revit

The Export function in Autodesk Revit lets you export models to DWG or DXF
file formats. In Revit 6.1 and 7.0, the exported drawing entities contain
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additional information, “Revit data,” such as their originating Category, Family,
Type, and Material.

The File Link Manager on page 6783  and DWG/DXF Import functionality looks
for and processes this additional information. When “Revit data” is found
with an object, the object is treated differently by the import/file link process.
The primary differences are:

■ object naming conventions

■ scene organization of incoming geometry (how the objects are combined)

■ parent-child hierarchy of scene objects

■ possible automatic material assignments

IMPORTANT 3ds Max cannot directly import (or link) a native Revit project (RVT).
You must first export a DWG or DXF file from Revit before you can import the
model into 3ds Max. The imported or linked file will contain scene objects that
correspond directly to individual Revit objects. In addition, most materials are
translated and assigned to the objects, giving Revit customers a head start toward
better visualization and faster rendering of their models.

See also:

■ Revit Elements in 3ds Max on page 6828

■ Materials and Linked Revit Objects on page 6837

Revit Elements in 3ds Max

Whenever you use the File Link Manager or DWG/DXF Import functionality,
3ds Max detects a useful distinction between categories of a Revit elements.
It automatically separates names and groups the elements in 3ds Max to make
them easier to work with. The new objects created in 3ds Max through file
linking are grouped together hierarchically below a special object called a
Block/Style Parent on page 7732 , allowing you to deal with individual objects
in the hierarchy or with all of them as a group. This hierarchy is similar to
the one created when AutoCAD Architecture objects are linked.

You can view this hierarchy, but you cannot change it in 3ds Max. You can
change the hierarchy only indirectly by editing the elements in Revit, exporting
an updated DWG, and then reloading the drawing.
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Criteria for Subdividing Revit Elements

The File Link Manager organizes Revit elements into multiple 3ds Max objects
based on the following classification of elements:

■ Categories Categories are the most general class of element. They are
subdivided into model categories and annotation categories. Model categories
include doors, windows, walls, and furniture. Annotation categories include
dimensions, grids, levels, and text notes.

■ Families Families are classes of elements within a category that group
elements with a common set of parameters (properties), identical use, and
similar graphical representation. Different elements within a family may
have different values of some or all properties, but the set of
properties—their names and meaning—is the same.
For example, six-panel colonial doors are one family, although the doors
that compose the family come in different sizes and materials. Most families
are component family files, which means you can load them into your
project or create them from family templates. You can determine the set
of properties and the graphical representation of the family. Other families
are called system families and are not available for loading or creating in
Revit. Autodesk Revit predefines the set of properties and the graphical
representation of system families; they include walls, dimensions, ceilings,
roofs, floors, and levels.

Besides being a class of elements, families are also a template that allows
you to generate new types of items that belong to this family.

■ Types Types, also called a family types, are a class of elements within a
family that have the exact same values for all type properties. For example,
all 32x78 six-panel doors belong to one type, while all 24x80 six-panel
doors belong to another type. Like a family, a type is also a template that
generates new instances of this type.

■ Instances Instances are the actual items that have specific locations in
the building (model instances) or on a drawing sheet (annotation
instances).

3ds Max organizes and names file linked objects to reflect their structure in
Revit, using a parent-child hierarchy. The parent object is a Block/Style Parent
named category <family : type>, and the Block/Style Parent has one or more
child objects named category <family : type> subcategory1, category <family : type>
subcategory2, and so forth.

For example, if a single-flush door object in Revit is linked to 3ds Max, it will
have a parent-child hierarchy displayed as a parent object, Doors <Single-Flush
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: 34” x 80”>, with three children, (2) Doors <Single-Flush : 34” x 80”>
Frame/Mullion and a Doors <Single-Flush : 34” x 80”> Panel. The objects will be
linked together with all the other components of the door, but you could
modify the material properties of the two frame/mullion objects separately.
If you changed the material assignments in Revit so that the entire
frame/mullion component only had one material assignment, then when you
reloaded the drawing in 3ds Max there would only be one frame/mullion
object present.

When working in Revit, you also have the ability to link AutoCAD drawings
or other Revit projects to your current project. This is comparable to using
exrefs in AutoCAD. Objects that originate as a linked drawing in Revit are
grouped together as Linked Geometry that is named for the linked drawing.
In this case, the parent object is named Import Symbol <drawing.dwg> and its
children are named Import Symbol <drawing.dwg> subcategory1, Import Symbol
<drawing.dwg> subcategory2, etc. The subcategories are derived from the layers
that the objects reside on in the drawing.

The following table lists some examples of the naming conventions of Revit
objects that are imported or file linked in 3ds Max.

RemarksImported/File
Linked Name

A Block/Style Parent for an
object of catagory=Door,

Door <Single-Flush :
34” x 80”>

family=Single-Flush and
type=34” x 80”. This parent
object has one or more com-
ponents, that are child objects
displayed as Linked Geometry.

A component to an object
named, Window <Casement

Window <Casement
with Trim : 24” x
48”> Frame/Mullion with Trim : 24” x 48”>. This is

a child object and is displayed
as Linked Geometry. In Revit,
the Frame/Mullion is a subcat-
egory of Windows.

A Block/Style Parent object
named, Casework <Base Cabi-

Casework <Base
Cabinet-4 Drawers :
18”> net-4 Drawers : 18”> and the
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RemarksImported/File
Linked Name

Casework <Base
Cabinet-4 Drawers :
18”>

two, child components, Case-
work <Base Cabinet-4 Drawers
: 18”> and Casework <Base

Casework <Base
Cabinet-4 Drawers :
18”> Cabinet

Cabinet-4 Drawers : 18”>
Cabinet

This object is Linked Geome-
try containing one or more

Import Symbol
<drawing1.dwg>

components found in draw-
ing1.dwg, which is a drawing
that is linked to the Revit
drawing. This linkage is com-
parable to an xref in Auto-
CAD.

NOTE It is possible for instances of the same Revit element to subdivide differently
into 3ds Max objects. Revit elements are considered instances of the same element
if their category, family, and type name are exact matches, and this will affect
their instancing behavior for 3ds Max functions such as material propagation.

Revit Cameras and Views

In order to navigate a Revit drawing more efficiently, you might have set up
a series of 3D views by means of placing cameras at different viewpoints around
the drawing. The File Link Manager and Import functions of 3ds Max allow
camera views to be treated as 3ds Max cameras.

You must meet two conditions in order for 3ds Max to understand Revit
camera views.

■ A camera view must be active before you export the DWG file from Revit.

NOTE Only the active camera view is exported.

■ You have to make sure you've turned on the Views (cameras) switch in the
Basic File Link Settings dialog on page 6794 .

When the drawing is linked to 3ds Max, that camera and its target appear in
the scene named Camera:viewname and Camera:viewname.Target.
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Light Sources

Drawing files, exported from Revit, can contain light sources, however, they
do not export with the DWG or DXF files. What does get exported is the 3D
mesh geometry representing the light fixture. Therefore, when you import or
link the drawing to 3ds Max, the light object is strictly geometry, not an actual
light source like a spotlight or omni light that you can adjust.

These pieces of geometry are still useful in that you can use them as reference
points for placing and aligning lights you add in 3ds Max.

DXF Files

Along with the ability to export DWG files, Revit can also export to the DXF
file format. The only difference is in how they handle drawings that are linked
(RVT links) to the Revit drawing.

When exporting to DXF, the linked drawings are automatically bound to the
drawing. Therefore, while exporting to a DWG honors the linked drawings
and treats them as AutoCAD xrefs, an exported DXF file will not have xrefs.
Instead, the linked drawings are converted to blocks.

The resulting scene organization will be slightly different when linking or
importing a DXF as opposed to a DWG, but only when RVT links are present
in the drawing.

See also:

■ Instanced Objects, Elements, Blocks and Styles on page 6842

■ Styles on page 6850

Suggested Settings and Workflow

Suggested Settings for Revit Projects

The File Link Manager and DWG/DXF Importer have many settings that you
can adjust so you get the best results when linking or importing a drawing
that you've exported from Revit. In this section, you'll find some recommended
settings that you can use when linking or importing your DWG files. These
settings are found on the Basic File Link Settings dialog on page 6794 , the
Advanced File Link Settings dialog on page 6798 , the Spline Rendering File Link
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Settings dialog on page 6806 , and the AutoCAD DWG/DXF Import Options
dialog on page 6979 .

Use the Revit Preset

3ds Max includes a preset named “Revit” that you can use when using File
Link to link a drawing that is exported from Revit. The Revit preset has many
of the following suggested settings turned on by default. Or, you can use the
Revit preset as a basis for your own customized Revit preset containing the
settings you prefer.

The Revit preset can be assigned from the Preset list on the Attach panel of
the File Link Manager on page 6783 . You can edit the preset on page 6812  by
choosing the Revit preset shown on the Presets panel of the File link Manager.

If you plan on creating your own presets or modifying the Revit preset, use
these settings to streamline the file linking process.

Turn on Weld and set a Weld Threshold

■ Weld and Weld Threshold are found on the Basic panel of the File Link
Settings dialog or in the Geometry Options group of the AutoCAD
DWG/DXF Import Options dialog.

When Revit exports model geometry to a DWG file, objects are translated as
multiple surface meshes. For example, a single wall is made up of 6 or more
AutoCAD entities; each a polyface mesh with vertices that overlap their
neighbors. When the meshes get linked to 3ds Max, the File Link Manager or
DWG/DXF Importer recombines them back to a single object. However, when
the meshes are recombined, their vertices are not welded, so you end up with
a larger and less elegant model than expected. By turning on the Weld option
and setting an appropriate Weld Threshold (like 0.1" or smaller), coincident
vertices are welded together and the file structure is more efficient.

NOTE This is particularly important if you plan to do radiosity rendering because
gaps in the model can cause leaks that greatly increase the rendering time.

Turn on Views (cameras)

■ Views (cameras) is found in the Include group on the Basic panel of the
File Link Settings dialog and the AutoCAD DWG/DXF Import Options
dialog.
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If you've set up one or more cameras in your Revit project, the File Link
Manager or DWG/DXF Importer will recognize and link a camera when the
Views (cameras) option is turned on. There is, however, a catch. Before you
export a DWG from Revit, the camera view must be active and only the active
camera will be exported.

Avoid Entity and Entity, Blocks as Node Hierarchy

■ On the Advanced File Link Settings dialog, when choosing a Derive
AutoCAD Primitives By option, avoid Entity and Entity, Block as Node
Hierarchy.

Elements are occasionally missing Revit embedded data. When this data is
missing, the objects are "derived" according to the Derive AutoCAD Primitives
By setting. Deriving by either of the Entity choices will not, generally, give
you the end result you want and could result in a scene in 3ds Max that
contains a vast number of individual objects. In particular, these settings can
cause issues with railing balusters.

Use Layer, Blocks as Node Hierarchy

■ On the Advanced File Link Settings dialog, use Layer, Block as Node
Hierarchy, when choosing a Derive AutoCAD Primitives By option.

The Layer, Blocks as Node Hierarchy derive by option, often gives the best
results for linking DWG files, especially when the Revit project has other
drawings, RVT links on page 7913 , linked to it. Combining by Layer (node
hierarchies or not) is the preferred setting. RVT links get exported to the DWG
as xrefs. If you want the File Link Manager to preserve color and material
assignments of those objects, Layer, Blocks as Node Hierarchy is the setting
to use.

Turn on Material Definitions and Assignments

■ The Use Scene Material Definitions and Use Scene Material Assignments
on Reload switches are on the Advanced File Link Settings dialog.

These two switches are quite important when you've got materials assigned
in your Revit project.

When the Use Scene Material Definitions switch is turned on, 3ds Max checks
the scene for any currently used materials matching the exact same name as
a material name in the linked DWG file. If a match is found, File Link does
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not translate the drawing’s material, and instead uses the material defined in
the scene.

When turned off, the File Link Manager always uses the material definitions
contained in the DWG file, and will overwrite scene materials with the same
name, regardless of which objects the material is applied to. In addition,
material definitions are always reloaded from the DWG file, so if you make
changes to a linked material, then reload, those changes will be lost.

If the Use Scene Material Assignments on Reload switch is turned on, linked
objects with a material already assigned to them in the 3ds Max scene will
not have that material assignment changed. When turned off, linked objects
have their material assignment ‘coordinated’ with the drawing, so that the
two are in-sync.

Determine how you want Splines Handled

■ The settings on the Spline Rendering File Link Settings dialog control how
shapes and splines are linked or imported into 3ds Max.

In your original project, you may have used 2D lines to represent joints
between sidewalk pavers or as mullions separating sections of a curtain wall.
The settings on the Spline Rendering panel let you use those lines more
advantageously.

When you turn on Enable In Renderer and/or Enable In Viewport, lines are
visible when you render the scene or are treated as selectable objects in the
scene. You can also adjust the appearance of lines by having them display as
radial or rectangular geometry.

TIP Using the Sweep modifier on page 1709  with 2D splines or shapes lets choose
a cross-sectional shape that is swept along the spline resulting in much more scene
detail.

Suggested Workflow for Revit to 3ds Max Projects

Most of the work you do on your Revit project will be done in Revit. The initial
design, layout and modeling all occurs from within the Revit program. 3ds
Max comes into play when you're ready to produce some higher end renderings
and perhaps add some final details.
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Following is a basic description of the expected workflow between Revit and
3ds Max:

1 You've completed most of the design work in Revit and you're ready to
add finishing touches and create some presentation renderings.

2 From Revit, export a DWG file.

Exporting to a DWG file is necessary because the File Link Manager cannot
accept the “native” Revit project (RVT) files.

3 Start 3ds Max and use the File Link Manager to link the DWG file.

Link the drawing using presets that include the linking settings you want
as described in the Suggested Settings for Revit Projects on page 6832
section.

4 Adjust materials or make final modifications in 3ds Max in preparation
for rendering.

Depending on the results at this stage, you may find that the Revit project
needs to be changed and updated.

5 In Revit, makes changes to the project like moving walls, adding new
doors and windows or adding/removing objects.

For structural changes like adjusting walls, doors, windows, etc., it's best
to make these changes in Revit because those changes need to be included
in the originating project. File Link is a one way link so any changes you
can make in Revit, should be made in Revit. Otherwise, you'd have to
remember to make the same changes in both 3ds Max and Revit.

6 When the changes are completed, export another DWG file with the
same name as the original DWG file you exported in step 2.

If you give a new name to the exported DWG, the File Link Manager will
not show that the currently linked file has been updated.

7 In 3ds Max, open the File Link Manager and review the Files panel. Select
the updated file link and click the Reload button — Turn on Show Reload
Options if you want to change link settings.

The changed model reloads to 3ds Max and changes made to the model
in 3ds Max prior to the reload are retained.

The  symbol means the DWG file has been updated.
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Materials and Linked Revit Objects

When you export a DWG or DXF from Revit projects, materials are translated
into a format that 3ds Max can understand. Revit creates materials in the same
format as used by AutoCAD Architecture, VIZ Render and 3ds Max. There are
two kinds of materials associated with the Revit project; AccuRender materials
and Revit materials. When a Revit material references an AccuRender material,
the AccuRender material’s parameters are used; otherwise, the Revit material
parameters are used.

There is an important caveat to this. AccuRender materials that reference a
bitmap file are translated in 3ds Max without any problems, while AccuRender
materials that are considered “procedural” are only translated at the most
basic level.

Therefore, an AccuRender material that uses a bitmap image in the base texture
definition will provide a more accurate translation to 3ds Max.

NOTE There are some limitations on what is translated between Revit/AccuRender
materials and 3ds Max materials because there is not a one-to-one correlation
between the two material definitions.

Material Assignments

The Revit DWG Exporter puts embedded information on each object it exports.
Amongst this information are identifiers specifying material assignments.
Revit creates the same kind of material definitions used by AutoCAD
Architecture, VIZ Render and 3ds Max. When imported or linked, 3ds Max
uses this information to translate and maintain the material assignment to
the resulting scene object.

Because the material identifier is embedded, if you opened the DWG in
AutoCAD, you would not see the applied materials.

Revit offers many options for specifying a material to an object or class of
objects. Likewise, there are many ways where material assignments can be
overridden. The results you see in the 3ds Max scene, in terms of how the
materials are applied, match what you see in the Revit model.

The exception to the rule would be if many of the materials are AccuRender
procedural materials. In these cases, you will see only the diffuse color.
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Texture Coordinates

Material textures on imported or linked objects have the same appearance as
within Revit or AccuRender. Of course, the exception to this rule is when
AccuRender procedural textures are used.

When materials from Revit are viewed in the 3ds Max Material Editor, you'll
notice that some settings are not translated or they are not set as you're used
to seeing in 3ds Max. For example, if the texture map of a flooring material
has a rotation of 45 degrees in the Revit project, the rotation setting does not
translate when the model is linked/imported to 3ds Max. The rotation for the
texture map is set to zero in the 3ds Max Material Editor.

Map Scaling

The scale of material textures is of primary importance. The File Link Manager
or DWG/DXF Importer attempts to read and translate the offset and tiling of
the materials so the texture maps appear in 3ds Max as they do in Revit.

However, map scaling may differ because the Tile Size settings in Revit are
measured in decimal feet or meters even if your Project Units are set to Decimal
Inches or Millimeters. Once the model is linked or imported to 3ds Max, you
can turn on Use Real-World Scale and match the Tile Size settings. The main
thing is to pay attention to the Tile Size settings when you create the material
in Revit.

As a example, let's say you've created a material in Revit that uses a brick
texture map with an X: Tile Size set to 20 and a Y: Tile Size set to 16. If you
open that material in the 3ds Max Material Editor, you will find that the Width
and Height Size settings are automatically set to 20' and 16' respectively. The
texture mapping will always be scaled correctly in the scene. How a material
is displayed in the Material Editor depends on whether Use Real-World Scale
is turned on or off.

See also:

■ Applying Materials to Linked Revit Objects on page 6839

■ Editing Revit Materials in 3ds Max on page 6839

■ UVW Mapping on Revit Objects on page 6841

■ Propagate Materials to Instances on page 5232
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Applying Materials to Linked Revit Objects

As with models that are imported or linked from AutoCAD Architecture, there
are special behaviors exhibited with materials assigned to linked Revit objects.
The behavior is controlled by the Propagate Materials To Instances toggle on
page 5232 .

When applying materials to a linked drawing in 3ds Max, family and type
plays an important role in material management. Assigning a material to any
component of any linked Revit object is equivalent to assigning the same
material to every instance of that component in every object with the same
family and type throughout your scene.

As an example, say you have multiple instances of a Doors <Single-Flush : 34”
x 80”> door in your drawing, which consists of three components: two
Frame/Mullion components representing the inside and outside trim and a
Panel component. If you assign a material to one Panel component anywhere
in your 3ds Max scene, all the Panels for all the Doors of that family and type
throughout the scene will receive the new material.

If you want to keep materials from propagating between instances in your
scene, turn off the Propagate Materials To Instances toggle on page 5232  from
the Material Editor's Options menu.

See also:

■ Instanced Objects on page 6843

■ Blocks on page 6844

Editing Revit Materials in 3ds Max

Once a drawing is linked or imported to 3ds Max, you can modify or replace
the materials. The File Link Manager maintains a list of materials that it links
to 3ds Max. If you change the properties of an assigned material while working
in 3ds Max, the new properties can get overwritten the next time you reload
an updated drawing, exported from Revit.

During a File Link reload, if the Show Reload Options switch is turned on,
you can control how materials are handled by using the Use Scene Material
Definitions or Use Scene Material Assignments on Reload options.
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AccuRender Materials

AccuRender materials consist of one or more base materials. For each base
material you can set attributes such as color, reflectivity, transparency, index
of refraction, bump maps, and image maps.

The Procedures list displays the simple materials that combine to form your
final material definition and the rules for combining them. For simple
materials, there is only one item in the list: Base. For complex materials, a tree
indicates how the components combine. For example, the marble procedure
consists of a Base material and a Vein material. While the Base material is
considered a 'procedure', it is translated because it's at the bottom level of the
material. The Vein material is ignored.

AccuRender materials that are applied to objects in the Revit drawing are
translated when you link or import the drawing to 3ds Max. If the texture
used for the material is a digital bitmap like a BMP or JPG file, the texture will
be included with the material.

However, if the texture being used is one of the Procedures, the texture is not
translated when the drawing is brought into 3ds Max. In these cases, you will
see only the diffuse color.

See also:

■ Material Editor, Materials, and Maps  on page 5163

Procedures

To retain material settings made in 3ds Max during a reload:

1 On the Files panel of the File Link Manager, make sure the Show Reload
Options switch is active.

2 Select the updated DWG file from the Linked Files list and click Reload.

3 Open the Advanced tab and turn on Use Scene Material Definitions and
then click OK.

The updated DWG file is reloaded and Revit materials retain the setting
changes you made in 3ds Max.
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UVW Mapping on Revit Elements

An important consideration in how many materials render is how they are
“mapped” to the surfaces of the objects they are assigned to. This is especially
important for materials that use bitmaps on page 7730  to define the diffuse
color of a material, or the bump and cutout special effects. As an example,
you may have scanned a picture of wood grain for use in a material, but when
the material is applied to an object, how large should the image of the wood
grain be? Which way do you want the grain to run, and how do you want the
grain to wrap around the corners of a three-dimensional object?

How two-dimensional maps are applied to three-dimensional surfaces is
represented by mapping coordinates on page 7838 , which are stored as UVW
coordinates on page 7962 . Revit assigns UVW coordinates to object components,
so in cases where mapping coordinates are important to the rendered
appearance of an object, 3ds Max translates these coordinates and stores them
in the object mesh that is displayed and rendered in the 3ds Max scene.

Using Revit Materials on 3ds Max Geometry

After you've linked a DWG file that has been exported from Revit, you may
find that some of the materials that were created in Revit could be used on
new geometry you're adding while working on the model in 3ds Max. Reusing
a material is often easier than creating a brand new one.

For example, let's say a wall element in the Revit project has a brick material
that you'd like to use on an object you added to the model while working in
3ds Max. If you simply apply the material to the new object, you'll find that
the texture map does not show as it does on the wall that came from Revit.
This is because UVW coordinates of the new object are not set up to coordinate
with the Tiling parameters of the Revit material.

When using Revit materials with objects created in 3ds Max, there are really
two things to keep in mind;

■ All materials from Revit use real-world scaling.

■ Real-world scaling must be active for objects you've created in 3ds Max.
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There are a few way to make sure your 3ds Max objects are using real-world
scale.

■ If you're working with a primitive object, like a box or cylinder, make sure
Real-World Map Size is active.

■ For more complex objects, apply a UVW Map modifier on page 1849  and
make sure Real-World Map Size is active.

■ Assign the object a MapScaler modifier on page 1443 .

Instanced Objects, Elements, Blocks and Styles

The primary structural entities you will find in a model or project that is
linked/imported to 3ds Max from AutoCAD, AutoCAD Architecture, or Revit
are style-based objects on page 6850  (in ADT models), family elements (in Revit
projects) or blocks on page 6844  (in both ADT and AutoCAD files). Each
style-based object, family element, or block will most likely have many
instances on page 6843  in the 3ds Max scene.

■ Instances are multiple occurrences of objects such as style-based objects  or
blocks that are clone instances. When you link a model or drawing that
contains instanced objects to 3ds Max, those objects remain instances of
one another.

■ Family Elements in a Revit project represent different items of a building
and are separated into two general categories; Model and Annotation. The
Model category includes such elements as walls, doors, windows and stairs
while the Annotation category includes dimensions, text notes and section
tags. When a DWG is exported from Revit and linked to 3ds Max, elements
appear in the Modifier panel as Block/Style Parents on page 7732 , meaning
you've selected the element at its topmost level, or as Linked Geometry
on page 7828 , meaning one of the element's subcomponents.

■ Blocks are reusable objects made in AutoCAD or Architectural Desktop.
Blocks are made of one or more objects that can be inserted into a scene
at different locations, scales and orientations. Blocks can also be an
amalgam of other blocks. A block that is made of other blocks is referred
to as a nested block. Once linked to 3ds Max, blocks appear in the Modifier
panel as VIZBlocks, meaning you've selected the block at its topmost level,
or as Linked Geometry, meaning one of the block's subcomponents.
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NOTE If you use one of the “node hierarchy” Derive By settings, you will see
Block/Style Parent objects in the Modifier panel and not VIZBlocks.

■ AutoCAD Architecture style-based objects are complex objects like Doors
and Windows whose components rely on style definitions to control how
they appear in the scene. For example, style definitions for a door set the
type of door, the door thickness, the materials assigned to the various
components, and so forth. Altering the style definitions changes the
appearance of the object in the scene.

See also:

■ Object Properties on page 245

Instanced Objects

Instanced objects are AutoCAD, Revit, or AutoCAD Architecture objects or
blocks that you can drag and drop into 3ds Max.

Modifiers and materials that are applied and assigned to an instanced object
propagate throughout all instances of the object. For example, if all the doors
in a scene have glass panes and you change the glass material of one door, all
the doors of the same style will adopt that material. Propagation of materials
can be controlled by toggling Propagate Materials To Instances on page 5232 .

Once you link a model to 3ds Max, instanced objects can be transformed
(moved, rotated, or scaled). If you don't like the way an object is transformed,
you can use the Undo command or Reset Transform button on page 6820  on
the Modify panel.

Family Elements

When modifiers and materials are assigned to family elements that are
imported or linked to 3ds Max, they propagate throughout all instances of
the element if their family and type match exactly. For instance, one particular
part of your model shows a room with three doors. Two of the doors are Doors
<Single-Flush : 32” x 80”> and the third is a Doors <Single-Flush : 36” x 80”>. If
you change the panel material of one of the Doors <Single-Flush : 32” x 80”>
doors, the panel of the other Doors <Single-Flush : 32” x 80”> door will also
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change because their family, Doors, and type, Single-Flush : 32” x 80”, are
identical.

Propagation of materials can be controlled by toggling the Auto Material
Propagation Toggle on page 5232 .

Blocks

The concept of blocks originated in AutoCAD. Blocks allow you to combine
one or more objects into a single reusable object. As you work in AutoCAD or
AutoCAD Architecture, you can insert blocks repeatedly in the drawing at
various locations, orientations, and scales. If you change a block, the changes
propagate automatically to all instances of that block throughout the drawing.

You then link the DWG file to 3ds Max, where your goal is to beautify the
scene in preparation for rendering. Some of those preparations include such
procedures as selecting a block instance so you can apply or adjust a material,
applying texture mapping coordinates, unifying or flipping normals, and
setting rendering properties. These procedures affect all other block instances
in the scene.

The structure of nested blocks, blocks that are made from multiple sub-blocks,
is maintained when you link an AutoCAD or AutoCAD Architecture drawing
to 3ds Max. For example, if the block Desk1 is made using several blocks, Desk,
Chair and Return, you will be able to select any of Desk1's sub-blocks to alter
their rendering properties or materials. You can only access rendering properties
for block components that appear as Linked Geometry on the Modifier panel.
Blocks or sub-blocks, that appear as VIZBlocks in the Modify panel, do not
have rendering properties because they are not renderable.

NOTE A change to the drawing in AutoCAD or AutoCAD Architecture is reflected
in 3ds Max when you reload the linked model. Changes made in 3ds Max do not
propagate back to AutoCAD or AutoCAD Architecture.

Block and Modifying Linked Geometry

Linked objects show up as linked geometry objects in the modifier stack. These
objects don't allow access to sub-object levels where minor editing can occur
at Vertex or Face levels. You must first add an Edit Mesh modifier to the object
in order to access sub-object levels where you can perform operations like
welding vertices or deleting faces. If you add a modifier to a block, the modifier
is applied to all instances of that block. Likewise, any sub-object level editing
to the originally selected block propagates to all other instances.
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NOTE Any modifiers you apply to a block or block component in 3ds Max are
preserved if you reload the file with the File Link Manager on page 6783 .

If you move, rotate, or scale blocks or block components in 3ds Max, their
new transform is preserved even if the linked model is reloaded from AutoCAD.
Transforms applied to linked geometry in 3ds Max are relative to the transforms
applied to the same objects in AutoCAD. Further, the transform propagates
to all instances of that block or component. For example, if you move the
Chair component of Desk1, the Chair component of all Desk1s in the scene will
be moved. If the transform is undesirable, you can use the Reset Transform
button on page 6820  on the Modify panel to put the block or component back
to its original position.

When a modifier is applied to a block or block component, it propagates
throughout all instances of the block or block component in the scene.

Limitations of Blocks

Blocks have some limitations when you link a drawing to 3ds Max.

■ You cannot change the structure of actively linked blocks or their
components in 3ds Max. In order to delete a block or component, you will
have to bind the file, breaking the link.

■ You cannot change the color of linked blocks or their components. Their
color is set by layer when they're built in AutoCAD or AutoCAD
Architecture.

■ You can only access rendering properties for block components that appear
as Linked Geometry on the Modifier panel. Blocks or sub-blocks, that
appear as VIZBlocks in the Modify panel, do not have rendering properties
because they are not renderable.

■ You cannot collapse on page 1023  the modifier stack of an actively linked
on page 7701 object.

■ Layer assignments of linked geometry cannot be changed in 3ds Max if
an object is actively linked. Layers can be reassigned if the model is bound.

■ Cloning a block or block component is not possible if it is actively linked.
You cannot select a block and use Shift+drag to duplicate it. This is also
true for tools like Array, Mirror, and the Spacing Tool. Once a block or
block component is bound, you can clone it.

File Link | 6845



Blocks and Materials

When assigning a material in 3ds Max to an instance of a block or block
component, all the instances of that block or component are assigned the
same material automatically. This is called automatic material propagation. This
feature helps align 3ds Max behavior with that of AutoCAD Architecture.

If you find that a material you've assigned to a block or block component is
not what you wanted, you can undo the material assignment by choosing
Edit menu > Undo or pressing Ctrl+Z. If you undo a material assignment, the
undo will propagate to all instances of the objects to which you assigned the
material.

NOTE When assigning a material to a block or block component, you are not
prompted to accept or cancel the material propagation. You can only control
propagation of materials by toggling Propagate Materials To Instances on page
5232 .

For more information about working with materials and assigning materials
to blocks in 3ds Max, see the  Material Editor, Materials, and Maps  on page
5163  topic.

Multi-View Blocks (MVBlocks)

3ds Max accommodates both AutoCAD blocks and AutoCAD Architecture
multi-view blocks through the file linking functionality, and for the most part
the two block types behave similarly in 3ds Max with some exceptions.

The structure of AutoCAD Architecture multi-view blocks is expressed
differently than AutoCAD blocks in 3ds Max. Rather than peer into the internal
structures of multi-view blocks, as is done with AutoCAD blocks, 3ds Max
relies on the multi-view block's own ability to draw its own 3D view, much
as it does in the AutoCAD Architecture Object Viewer. Because of this, you
will notice that multi-view blocks never exhibit nesting in their object structure
when they are file linked into 3ds Max.

Behavior of instanced AutoCAD Architecture multi-view objects is different
from that of AutoCAD blocks as well. Multiple instances of multi-view blocks
require more memory in 3ds Max than do multiple instances of AutoCAD
blocks. But multiple instances of multi-view blocks are better behaved when
being cut by live section objects than their AutoCAD counterparts.
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Dynamic Blocks

The File Link Manager handles dynamic blocks the same way as other blocks
found in a DWG file. When linked to a scene, the naming for the incoming
dynamic block instances are based on the original dynamic block definition
in the form of Block: block_name where block_name is the actual name of the
dynamic block definition.

Dynamic block instances, even those that have been grip-edited, display certain
types of instance behavior such as material propagation, if the setting is
activated from the Material Editor Options menu on page 5225 . Below is a table
showing instance behavior of dynamic blocks.

BehaviorProperty

Modifiers applied to one component
are applied to the same component in

Modifiers

other instances, but only when those
instances have the same grip property
values.

When material propagation is turned
on, materials are applied to all block

Materials

instances. When turned off, materials
are applied only to the current selec-
tion set.

NOTE If you use the Entity, Blocks as
Node Hierarchy Derive By setting for
drawings containing dynamic blocks,
materials may propagate to some
block instances and not to others.

Changes to node properties are not
propagated to block instances.

Node Prop-
erties

Transforms, like move, rotate and
scale, of one component will affect

Transforms
(on compo-
nents) that same component in other block

instance only when those instances
have the same grip property values.
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Keep in mind that elements of a dynamic block can be turned on and off by
certain grip-edit operations depending on the way the dynamic block is
defined. When one instance has a component and another doesn't, instance
behaviors cannot occur between them because they are treated as instances
of one another.

Modifier behavior of Dynamic Blocks during a File Link Reload

There is no change in modifier behavior for dynamic blocks that have not
been grip-edited between one Reload and the next. All properties (materials,
modifiers, node properties) are preserved. Dynamic blocks that have been
grip-edited preserve their node name, node properties, scene-applied transform,
and materials, but may lose applied modifiers and/or may inherit modifiers.
This table shows the behavior of modifiers during a File Link Reload before
and after dynamic block editing.

The Block
Insert ...

... shows this modifier
behavior upon Reload.

... has
unique pa-

... has
unique pa-

rameter val-rameter val-
ues after it
was edited.

ues before it
was edited.

Modifiers are pre-
served.

YesYes

Applied modifiers may
be lost, and it may in-

NoYes

herit modifiers from
the instance(s) it now
matches.

Applied modifiers are
lost.

YesNo

Applied modifiers may
be lost, and it may in-

NoNo

herit modifiers from
the instance(s) it now
matches.
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Blocks and Interactive Selection and Navigation

Once blocks and block components are linked to 3ds Max, you can begin
adjusting their materials and properties. In a drawing for a small apartment,
blocks are pretty easy to locate because the drawing is not very congested.
You can simply select a block or one of its components in the viewport and
alter it.

With complex drawings, finding the block or block instance you want can
pose a problem. For example, a common block you might add to a drawing
is a table. If you're designing a corporate headquarters that makes use of several
different types of tables, finding the one you want to change becomes more
difficult. There are several ways for you to find and select a block more precisely
in 3ds Max.

■ One way is by means of the block's name. When you link a drawing to
3ds Max, file linking creates a name such as Block: ConferenceTable. The first
part of the name identifies the object's type, Block. The second part of the
name indicates the block name, ConferenceTable. With this sort of naming
breakdown, you can easily find a block using the Select From Scene dialog
on page 168 .

■ Another selection method uses the Layer or Color setting you made for
your block when you created it in AutoCAD Architecture. Because layer
and color data is also linked to 3ds Max, you can select entire groupings
of blocks using Select By Color or Select By Layer.

■ Finally, you can select blocks by the type of material that's applied to them.
Take care when selecting blocks this way because the material assigned to
the block may also be assigned to other objects in the scene.
Once you’ve selected a block or set of block instances, you can isolate them
from the remainder of the model to work on them more efficiently.

To select a block by color:

1 Choose Edit menu > Select By > Color.

2 Select a block in the scene.

All blocks that share that color are selected.

To select blocks by name:

1 Choose Edit menu > Select By > Name, or press the H key to open the
Select From Scene dialog on page 168 .
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2 While holding down the Ctrl key, select blocks with common names.

You can also enter the block name in the name field at the top of the
dialog.

3 Click Select.

All blocks that share the specified name are selected.

To select blocks by layer:

1 Choose Edit menu > Select By > Layer.

2 Select a block in the scene.

All the blocks sharing that layer are selected.

To isolate selected objects:

1 Using one of the previous selection methods, select some blocks.

2 Choose Tools menu > Isolate Selection.

This hides all objects except for the selected blocks. A dialog is opens,
indicating that isolation mode is active.

Styles

Styles are sets of parameters that you can assign to objects in AutoCAD
Architecture to determine their appearance. This means an AutoCAD
Architecture object references a style in order to determine certain aspects of
its appearance. For example, a door style determines the type of door
represented in the drawing, such as single or double hung, bifold or hinged,
solid core or glass pane. You can assign one style to more than one object,
and you can modify the parameters of that style to change all the objects that
have the same style assigned to them.

For more information about how to work with styles in AutoCAD Architecture,
refer to the AutoCAD Architecture Reference.

A style is made up of components. Each component defines dimensions and
display properties per view. For example, the hatch pattern defined for
component1 in Plan view can be different from the hatch pattern for the same
component in Model view. Styles are grouped in categories that mirror the
categories of AutoCAD Architecture objects. You perform model management,
such as creating and deleting styles and style-components in AutoCAD
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Architecture, and reload the modified scene into 3ds Max using the File Link
Manager utility on page 6783 .

When a model is linked to 3ds Max from AutoCAD Architecture, styles play
an important role in assigning render materials and texture coordinates to
AutoCAD Architecture object components described by style components.
Components of an AutoCAD Architecture object often have predefined
materials in their style definitions. This means that if you have many instances
of an object in your drawing, you can quickly replace materials on all the
objects without having to select each instance of the object.

'Style-based objects' is a more common term for AutoCAD Architecture objects
that reference styles.

Limitations of Styles

Styles-based AutoCAD Architecture objects do have some limitations when a
model is linked to 3ds Max.

■ Changes to styles and their components performed in 3ds Max will not
propagate back into AutoCAD Architecture.

■ You cannot use any transform commands (Move, Rotate, or Scale) to clone
an object that has an actively linked style. You have to make that type of
change in AutoCAD Architecture.

■ The structure of a style-based object in 3ds Max cannot be changed. You
cannot add components to or delete them from a linked object.

■ Objects on frozen layers in AutoCAD Architecture will not be displayed
when the model is linked to 3ds Max.

NOTE This is not the case when Skip All Frozen Layers is turned off in your File
Link settings.

Styles and Materials

The primary purpose of linking a model from AutoCAD Architecture to 3ds
Max is preparing the scene for presentation to your clients and rendering.
AEC Objects are made up of components that have default architectural
materials assigned through their styles. You can select components from the
Select From Scene dialog on page 168  or the  Scene Explorer on page 7171  , and
you can assign new materials or alter the existing material in the Material
Editor.
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For example, a door that is assigned the “Hinged – Single – Full Lite” style is
made up of five components in AutoCAD Architecture: the Frame, Panel, Stop,
Glass, and Muntins. Each component has a material assigned to it. For instance,
the default material assigned to the Panel component of this type of door is
“finish carpentry.wood.mahogany.” To change the Panel material in 3ds Max,
you can select the Panel component and drag a new material to it from the
Material Editor.

Because the Panel material is part of the door's style, your new material
automatically propagates to any other door in the scene that is assigned the
“Hinged – Single – Full Lite” style.

NOTE If you need to apply a material to individual objects, or object selections,
rather than to all objects of the same style, you can use the command Propagate
Materials To Instances on page 5232 .

For more information about working with materials and assigning materials
to objects in 3ds Max, see Materials on page 5163 .

Styles and Interactive Selection and Navigation

Architectural drawings range from simple sketches to highly complex floor
plans, so finding different components of a drawing can be difficult. Style-based
objects from AutoCAD Architecture all have styles associated with them. So
if you link a drawing to 3ds Max, objects with styles will be associated with
them both in AutoCAD Architecture and in 3ds Max. Furthermore, in 3ds
Max, the name of the object will contain the AutoCAD Architecture object
category name (Door, for example), style name (Double Hinged) and
component name (Panel).

You make most object and component selections in 3ds Max by selecting
objects in the viewports. However, in complex models where objects and
components may be spread across multiple layers or located in congested
areas, style definitions help streamline the selection of reusable components
in a drawing.

Once objects and components are selected, you can also isolate them from
the remainder of the model to work on them more efficiently.

To select objects by style:

The Select Similar command has the same function in 3ds Max as it does in
AutoCAD Architecture.

1 In a scene imported or linked from AutoCAD Architecture, select an object
that contains the style of interest.
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2 Choose Edit menu > Select Similar.

All objects or components that share that style, as defined in AutoCAD
Architecture, are selected.

To select objects or components by color:

1 Choose Edit menu > Select By > Color.

2 Select an object in the scene.

All objects or components that share that color are selected.

To select objects or components by name:

1 Choose Edit menu > Select By > Name, or press the H key to open the
Select From Scene dialog.

Alternatively, you could use the  Scene Explorer on page 7171 , accessed
from the Tools menu. While functionally similar to the Select From Scene
dialog, the Scene Explorer is modeless and can remain open while you're
working.

2 While holding down the Ctrl key, select objects or components with
common names.

You can also enter the object or component name in the name field at
the top of the dialog.

3 Click Select.

All objects or components that share the specified name are selected.

To select objects or components by layer:

1 Choose Edit menu > Select By > Layer.

2 Select an object in the scene.

All objects or components that share that layer are selected.

To isolate selected objects:

1 Using one of the previous selection methods, select some objects.

2 Choose Tools menu > Isolate Selected.

All objects are hidden except for the selected objects or components. A
dialog appears indicating that isolation mode is active.
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Merge

File menu > Merge

Merge allows you to load objects from saved scene files into the current scene.
You can also use Merge to combine an entire scene with another. This behaves
similarly to the XRef Merge dialog on page 6752 .

The Merge dialog lets you load and save influences on page 7816  with or without
their dependents. In many cases, objects should be referenced with their
influences, but the display only makes you aware of the relationships, it does
not force you to externally reference them.

When you select an item in the list window and click Influences, the object’s
influences are selected in the list window. When you select an item in the list
window and Display Influences is on, the object’s influences are shown in
blue in the list window. When you select an item in the list window and Select
Influences is on, the object’s influences are also selected in the list window.

Automatic Unit Conversion

When Respect System Units in Files is on in the Units Setup dialog on page
7601 , in the System Unit Scale group, merged objects from a file with a different
scene unit scale are scaled to maintain their correct size in the new scene. No
conversion is done when merging files created in 3ds Max 1.x.

NOTE If Respect System Units is off (which is not recommended), a 100-foot
radius sphere that was created in a 1 unit = 1 foot scene becomes a 100-inch
sphere in a 1 unit = 1 inch scene.

Resolving Name Conflicts

Object Name Conflicts

When one or more incoming objects have the same name as objects in the
scene, an alert gives you the following options:

Merge Merges the incoming object using the name in the field at the right.
To avoid having two objects with the same name, type a new name before
proceeding.

Skip Does not merge the incoming object.

Delete Old Deletes the existing object before merging the incoming one.
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Apply to All Duplicates Treats all subsequent incoming objects with duplicate
names the same way you specified for the current object. No further alerts
will appear. This option is not available if you renamed the current object.

Cancel Cancels the merge operation.

Material Name Conflicts

When one or more materials assigned to incoming objects have the same
name as materials in the scene, an alert gives you the following options:

Rename Merged Material Defines the name for incoming material.

Use Merged Material Assigns the characteristics of the incoming materials
to the same-named scene materials.

Use Scene Material Assigns the characteristics of the scene materials to the
same-named incoming materials.

NOTE Only top-level material names (not sub-materials) are checked for duplicates.

Auto Rename Merged Material Automatically renames the incoming
materials to new names. Uses Material number names based on the next
available Material number.

Apply to All Duplicates Treats all subsequent incoming Materials with
duplicate names the same way you specified for the current object.

Parent Name Conflicts

When you merge an object that’s linked to a parent object in a source scene,
and an object of the same name as the original parent exists in the current
scene, the Merge File dialog on page 6858  opens, giving you the option to
re-create the same hierarchy.

See also:

■ Merge Animation on page 6859

■ Merging Effects  on page 6385

■ Open on page 6718

■ Replace on page 6866
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Procedures

To merge items:

This is the general procedure. Detailed steps follow.

1 Choose File > Merge.

2 Select a file from which to merge items.

3 Choose a group or an item to merge.

To specify object types to list, do any of the following:

1 Display or hide the subtree. If the subtree is not displayed, you can sort
items in the list alphabetically or by type or color.

2 Select the object types that you want displayed in the list box.

3 Click All or None to select or clear all of the object types.

To select objects to merge, do any of the following:

1 Enter the name of an item, or use wildcard characters to specify multiple
items that share a set of characters in their names.

2 Click to select single objects.

3 Press Ctrl and click to add and remove single objects from the selection.

4 Press Shift and click to select all objects between the previously selected
object and the current object.

5 Click All or None to select or deselect the entire list.

6 Click and drag to select items to merge from the list on the left.

Interface

Use the Merge File dialog to open the scene file to merge. This opens the Merge
dialog, whose controls are similar to those on the Selection Floater on page
171 .
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Merge Objects list

Objects are listed according to the current Sort and List Types selections.

All/None/Invert These buttons alter the pattern of selection in the list
window.

Influences When you select an object in the list window and then click the
Influences button, the selected object's influences are highlighted as well.

Display Influences When this is on and you select an item in the list window,
all of its influences are shown in blue. If you want to highlight these influences,
click Influences.

Select Influences When this is on and you select an item in the list window,
all of its influences are highlighted as well.
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Merge File Dialog

File menu > Merge > Choose a file to merge. > Choose objects to merge.

When you merge an object that’s linked to a parent object in a source scene,
and an object of the same name as the original parent exists in the current
scene, you can re-create the same hierarchy using this dialog.

Interface

If you merge an object that’s linked to a parent object in a source scene, and
an object of the same name as the original parent exists in the current scene,
a dialog appears asking if you want to link the incoming object to the existing
parent object.

Yes Reparents the specified object and continues prompting for all subsequent
merging objects that might need reparenting.

Yes To All Reparents the specified object and all subsequent merging objects
that need reparenting.

No Merges the specified object without reparenting, but continues to prompt
for subsequent objects.
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No To All Doesn’t reparent any of the incoming objects. When an object is
merged without reparenting, it becomes a child of the world.

This feature can also be used to reconnect parent objects to children in the
scene.

Merge Animation

[Available only as a CUI action]

Merge Animation merges (transfers) animation data from one object to another.
Animation data can be transferred from one scene to another, or between
objects in the same scene. Animation data from several objects can be merged
at the same time.

IMPORTANT The Merge Animation command is available only as a Customize
User Interface on page 7489  action; to use it you must first add it explicitly to the
user interface. For transferring animation data between scenes, we highly
recommend that you use, instead of Merge Animation, the Save Animation and
Load Animation functions. See Saving and Loading Animation on page 6870 .

Within the Merge Animation dialog, objects eligible for transferring or
receiving animation data are called nodes. Source nodes refer to objects from
which animation data can be transferred, while current nodes can receive
animation data. Merge nodes are source nodes that have been mapped to
(matched up with) current nodes in the Merge Animation dialog in preparation
for merging.

In order for a particular attribute's animation data to be transferred from a
merge node, the corresponding current node must have the same attribute.
For example, if a merge node has an animated Bend modifier applied to it,
the current node must also have a Bend modifier applied to it for the animation
data to transfer successfully.

The Merge Animation feature is ideal for transferring animation data between
similar hierarchies, such as character structures. In character creation, it is a
common practice to name bones for different characters with the character
name plus a suffix or prefix that describes the bone. For example, you might
have one character called Alien with bones named Alien_Pelvis,
Alien_LeftHand, etc. Another character called Chef would have bones named
Chef_Pelvis, Chef_LeftHand, etc. The Merge Animation dialog can
automatically filter prefixes and suffixes so you can quickly map the merge
nodes for complex hierarchies.
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NOTE If you plan to merge animation data to and from characters, the process
will be much easier if you use the same bone-name prefixes or suffixes for each
character.

See also:

■ Merge on page 6854

■ Merging Effects  on page 6385

■ Replace on page 6866

Procedures

To replace the animation in the current scene with the animation from another
scene:

1 Load the scene that will receive the merged animation data.

2 Choose File menu > Merge Animation.

3 In the Merge Animation dialog, click Source File to choose the file from
which to merge animation data. The objects appear under Source Nodes
in the Object Mapping rollout.

4 On the Object Mapping rollout, drag and drop the source nodes to the
Merge Nodes column, matching them with the appropriate current nodes.

5 In the Source Time Range group, choose Replace Animation.

6 Specify the source node attributes that will be merged.

7 Click Merge Animation to merge the animation data from the merge
nodes to the current nodes.

To insert animation data from one character to another:

The Source Objects and Current Objects entry fields allow you to enter wildcard
expressions to filter prefixes and suffixes of node names. The filtered text is
ignored by the Auto Name Mapping tool, so complex structures of
similarly-named nodes can be mapped quickly. This feature is handy for
transferring an animation between character structures, providing the source
and current nodes have been named with the same conventions.

1 Load the file with the character to which animation data will be merged.

2 Choose File menu > Merge Animation.
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3 Click Source File and choose the animation source file.

4 In the Merge Animation dialog, under Source Objects, use a wildcard
expression to specify multiple items that share a set of characters in their
names. For example, if the character bones are named Skater_Head,
Skater_RFoot, and so on, enter Skater* under Source Objects.

5 Click Refresh for Source Objects.

6 Under Current Objects, use a wildcard expression to filter the current
nodes' prefix or suffix. Click Refresh.

7 Click Auto Name Mapping.

Source nodes are placed in the Merge Nodes column, corresponding with
current nodes with the same prefix or suffix.

8 Specify whether to replace or paste animation data from the source file.
If pasting animation data, the frame times for the merge nodes are added
to the current nodes.

9 Specify the source node attributes that will be merged.

10 Click Merge Animation to merge animation data from merge nodes to
corresponding current nodes.

To insert animation from one character assembly to another:

For character assemblies on page 217 , the Insert Animation feature can be
used to merge animation data.

1 Load the file into which the animation data will be merged.

2 Select the character assembly node.

3 On the Modify panel, click Insert Animation. Select the source file from
which animation data will be merged.

4 Follow the previous procedure from step 4.

To merge animation data from objects in the same scene:

1 Choose File menu > Merge Animation.

2 Click Source Object, and choose the object from which animation data
will be transferred. This object and its hierarchy appear under Source
Nodes in the Object Mapping rollout.
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3 On the Object Mapping rollout, drag and drop source nodes to the Merge
Nodes column, matching them with the appropriate current nodes.

4 Specify whether to replace or paste animation data from the source file.
If pasting animation data, the frame times for the merge nodes are added
to the current nodes.

5 Specify the source node attributes that will be merged.

6 Click Merge Animation to merge the animation data from the merge
nodes to the current nodes.

Interface

The Merge Animation dialog has the following controls.

Source Objects group

Source File Click to select a source file containing the animation data.
Animation data from this file will be merged into the current scene. All objects
in the scene are displayed under Source Nodes in the Object Mapping rollout.

Source Object Selects a source object from within the current scene. If a
source object is selected, the Source File selection is ignored.

Merge Animation Merges the animation data based on settings on this dialog.
Before animation data can be merged, Merge Nodes must be listed for their
corresponding Current Nodes on the Object Mapping rollout. The progress
bar at the bottom of the dialog shows the progress of the merge operation.
After merging, this dialog remains on-screen so you can check whether the
merge was performed properly before closing the dialog.
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Undo Last Merge Undoes the last merge. If the merge was not performed
properly, you can change settings and try again.

Source Time Range group

Replace Animation Completely replaces existing animation data in the
current scene with the animation data from the source file.

Paste to Existing Animation Appends the source file animation data to the
existing animation data based on the following time parameters.

Match Source File Time Sets the source time range to match the active time
segment in the source file.

Start Time Start Time and End Time set the frame range to merge from the
source file. Start Time sets the first frame in the range.

End Time Sets the end frame number to merge from the source file.

Insert Animation to Frame Sets the start time in the current scene. Animation
data will be pasted into the current scene starting at this frame. Any existing
animation data in the current scene prior to this frame will remain the same.

Relative Animation data pasted into the scene will change the current scene
objects relative to their current status. For example, if an object in the source
file is animated to move from the XYZ position 0,0,0 to 12,0,0, the object
receiving the animation data in the current scene will start at its current
position and move 12 units along the X axis.

Absolute Animation data pasted into the scene will replace the current
animation data. For example, if an object in the source file is animated to
move from the XYZ position 0,0,0 to 12,0,0, the object receiving the animation
data in the current scene will start at exactly 0,0,0 and animate to 12,0,0.

Main Attributes group

Specify the source file attributes whose animation data will be merged. Current
nodes must have the same attributes as merge nodes for the attribute animation
data to be merged.

Transform Enables selection of Position, Rotation and Scale animation data
for merging.

IK Merges animation data of IK chains created with IK solvers.

Position Merges Position transform animation data.

Rotation Merges Rotation transform animation data.
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Scale Merges Scale transform animation data.

Modifiers Merges animation data of modifiers. In order for animation data
of a modifier to be transferred, the current object must already have the same
modifier applied to it.

More Attributes group

Selects additional attributes to be merged from the source file.

Custom Attributes Merges animation data of any custom attributes on source
objects.

Add New Defs Adds custom attribute definitions to the current object if it
doesn't have the same definitions as the source object.

Base Objects Merges animation data of parameters at the object base level.
For example, if a sphere's Radius parameter is animated, checking this option
will merge the Radius animation data. This option will also merge animation
data at an object's sub-object level, such as the animation of vertices on a
spline or Editable Mesh object.

Materials/Maps Merges animation data of materials and/or maps.

Visibility Tracks Merges animation data of visibility tracks.
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Object Mapping rollout

Sets up a one-to-one correspondence (mapping) between source objects and
current objects. Animation data on objects in the Merge Nodes column will
be merged to the corresponding object in the Current Nodes column.

To move objects to the Merge Nodes column, drag them from the Source
Nodes column, or use Auto Name Mapping to automatically map objects with
the same names or partial names.

Source Objects Allows you to specify wildcard expressions for filtering source
objects. Click Refresh to view objects specified by the wildcard expression.

Refresh Refreshes the display based on wildcard expressions entered in the
Source Objects field.

Source Nodes Displays the object selected with the Source Object option,
and all its children. Objects with keyframed animation are listed in red, and
objects with procedural controllers (such as a Noise or Expression controller)
are listed in green. The display can be limited with wildcard expressions entered
in the Source Objects field.

Current Objects Allows you to specify wildcard expressions for filtering
current objects. Click Refresh to view objects selected by the wildcard
expression.
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Refresh Refreshes the display based on wildcard expressions entered in the
Current Objects field.

Current Nodes Displays objects in the current scene. Animated objects are
listed in red. Display can be limited by wildcard expressions in the Current
Objects field.

Merge Nodes Lists the current objects that will receive animation data from
the corresponding object under Current Nodes. To place an object in the
Merge Nodes column, drag and drop the item from Source Nodes, or use Auto
Name Mapping to automatically map objects with the same or similar names.

Move Up Moves the selected Merge Node up one row.

Clear Selected Clears selected entries under Merge Nodes.

Move Down Moves the selected Merge Node down one row.

Auto Name Mapping Automatically maps source objects to the Merge Nodes
column, matching names with current objects. The mapping process filters
any wildcard expressions entered in the Source Objects and Current Objects
fields. If no wildcard expressions are entered, source objects are mapped only
to current objects with identical names.

Display Options group

Show Animated Only Displays animated objects only.

Indent Sets the number of characters by which child objects are indented
in the display.

Load Mapping Loads a previously saved .mnm file. This type of file can be
loaded and saved only on the Merge Animation dialog.

Save Mapping Saves the current mapping in an .mnm file. The name of the
source file and the mapping of source and current objects are saved. This type
of file can be loaded only with the Load Mapping option on the Merge
Animation dialog.

Replace

File menu > Replace

Replace lets you substitute the geometry of one or more objects in a scene by
merging objects with duplicate names. Use Replace when you want to work
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with less complex geometry to set up your scene and animation, and then
replace it with more detailed geometry before rendering.

■ When you replace an object in your scene, you replace its geometry,
including its modifiers, but not its transforms, space warps, hierarchy, or
materials.

■ To replace the object with all its characteristics, use Merge on page 6854 .

■ If the object that you're replacing has instances in the scene, all of the
instances are replaced with the new object.

■ All objects in the scene with the same name as the incoming object are
replaced by that object. If you have more than one object in the scene
with the same name as the incoming object, all of those objects are
replaced.

See also:

■ Merging Effects  on page 6385

■ Merge Animation on page 6859

Procedures

To replace items:

1 Choose File > Replace to display the Replace File dialog.

To see more than one file type at a time, choose the All Files file type.

2 Select a file from which to choose replacement items.

3 On the Replace dialog for that file, choose a group or a replacement item.
(See the following procedure.)

An alert asks if you want to replace the materials along with the objects.

■ If yes, the materials from the incoming objects replace the current
materials.

■ If no, only the geometry is replaced, while the material assigned to
the original object is retained.
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To select objects to replace, do one of the following:

1 Enter the name of an item, or use wildcard characters to specify multiple
items that share a set of characters in their names.

2 Click to select single objects.

3 Press Ctrl and click to add and remove single objects from the selection.

4 Press Shift and click to select all objects between the previously selected
object and the current object.

5 Click All or None to select or deselect the entire list.

Interface

When you choose replace, a standard file selector dialog is displayed. Use the
file selector to choose the scene file with the replacement objects. After you
click Open, the Replace dialog is displayed.

TIP In the file selector, you can see more than one file type at a time by choosing
the All Files file type.
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In the Replace dialog, select the objects to replace. Either enter the object
name or select the object from the list.

All Selects all objects in the list.

None Deselects all objects in the list.

Invert Inverts the current list selection.

Display Subtree Displays object hierarchies in an indented format.

When this option is off, the Sort group is enabled.

Select Subtree When this option is on, all items indented below the selected
one are also selected.

Case Sensitive When on, distinguishes between upper and lower case in
object names.

Sort group

These are options for sorting the object list. If the Display Subtree check box
is on, these options are not available.

Alphabetical Sorts from A at the top to Z at the bottom.

By Type Sorts by category, using the same order as the check boxes in List
Types.

By Color Sorts by object wireframe color.

List Types group

Determines which object types are displayed in the list: geometry, shapes,
lights, cameras, helpers, space warps, or bone objects.

All Turns on all check boxes in the group.

None Turns off all check boxes in the group.

Invert Inverts the current state of the check boxes.
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Saving and Loading Animation

You can save and load animation data for any number of objects separately
from the actual scene via Load Animation and Save Animation commands
available on the File menu. These commands use two file types:

■ XAF (XML Animation File) contains the animation data.

■ XMM (XML Animation Map File) contains mapping information: how the
incoming animation data is assigned to objects in the current scene.

Mapping is quite flexible: as long as data is comparable, it can be assigned.
For example, each key for both position and rotation animation contains
three numbers, so you could, if you wanted, assign incoming position data
to a current object's rotation track, or vice versa.

See also:

■ Save Animation on page 6876

■ Load Animation on page 6873

■ Map Animation Dialog on page 6879

Procedures

To use the Save Animation and Load Animation commands:

You start by saving animation data from the current scene.

1 Select any number of objects in your scene that contain animation. The
animation can be of any type: procedural, manually keyframed, IK, and
so on.

The frame range from which the animation is saved is the same for all
objects, so make sure you select only objects from which you want to
save the same frame range.

NOTE Using this method, you can save animation only from selected objects.
Alternatively, you can save animation from specific tracks in Track View; see
Hierarchy Right-Click Menu on page 3461 .

2 From the File menu, choose Save Animation on page 6876 .

3 Set the save parameters.
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By default, the command saves all keys from animated tracks for selected
objects, including motion derived from constraints. For example, if an
object rotates because a LookAt constraint is applied to its Rotation track,
then when you save its animation with Include Constraints on, the
software generates rotation keys based on the constrained motion. It does
not save the actual constraint.

If you turn on Segment, you can then set a frame range from which to
save animation.

4 Specify a file name and then click Save, or click the + button next to Save
to increment the file name and save under the new file name.

If the selected objects contain no savable animation, the message “No
animation tracks to save” appears. If this happens, create animation to
save or change the Save Animation parameters as needed.

Next, you load the animation data.

5 Set up or load a new scene and then select any objects that are to receive
the loaded animation.

NOTE Using this method, you can load animation only to selected objects.
Alternatively, you can load animation to specific tracks in Track View; see
Hierarchy Right-Click Menu on page 3461 .

6 From the File menu, choose Load Animation on page 6873 .

7 Find and highlight the XAF file from which to load animation.

8 Click Load Motion. If the objects you're loading animation to are the
same as those you saved the animation from, the animation loads and
is mapped automatically. If mapping is required, you're given the
opportunity to set it up. Or, if you've already set up mapping for the
scene and incoming animation data, choose a mapping (XMM) file from
the Motion Mapping/Retargeting drop-down list and then click Get
Mapping. Otherwise, click Edit Mapping.

Clicking Edit Mapping opens the Map Animation dialog on page 6879 ,
which contains three lists: from left to right, Current, Mapped, and
Incoming. The Current list shows selected objects in the scene and their
animation tracks; the Incoming list shows animation tracks in the XAF
file, and the Mapped list shows, for each track in the Current list, the
animation track in the Incoming list that will map to it. In certain cases,
such as with objects that have the same name, some tracks are mapped
automatically and appear in the Mapped column as soon as you open
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the dialog. The tracks that are already mapped are shown in gray in the
Current and Incoming columns.

9 To map a pair of tracks manually, click a track in the Current list and
another in the Incoming list, and then click the left-arrow (<-) button to
the left of the Incoming list.

This places the name of the incoming track in the Mapped list, opposite
the Current-list track to which it is assigned.

10 To remove a mapping assignment, click its entry in the Mapped list, and
then click the -> button.

11 Continue setting up the mapping assignments as needed. When you're
finished, click Save Mapping or Save Mapping As, and then specify a file
name to save.

After you save the mapping file, the Load Motion button becomes
available, and you can proceed with loading the animation.

12 Click Load Motion.

The animation data is loaded and assigned to the selected objects, and
any animation keys appear on the track bar.

To retarget an incoming animation:

This is a continuation of the previous procedure, and explains the basic
workflow of node retargeting. Retargeting means to scale the animation so it
matches the objects onto which you are mapping the motion. You can use
this feature any time you need to transfer an animation between two objects
or rigs of different sizes and proportions. For example, an animation of a cat
stretching could be retargeted to a bigger dog model, resulting in a scaled
animation to fit the dog's skeleton.

Once your track-mapping assignments are complete, the Retargetable Nodes
list on the Retargeting rollout displays the mappings available for retargeting.

For steps that describe retargeting a character rig, see To retarget one character
onto another on page ? .

1 First, in the Scale Origin group, choose the Incoming and Current objects
to use as the origin and basis for scaling.

For example, when retargeting a rig, you would use each rig's root object.

2 Next, in the Derive Scale Between Chains group, chose comparable IK or
FK chains from the Incoming and Current models to obtain a Scale Factor
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that proportionally retargets the incoming animation onto the current
model.

3 Click Set to apply the retargeting.

4 If different portions of the model are differently proportioned, you might
need to repeat steps 2 and 3 for different selections of mapped tracks.
You might also need to use the FK Retargeting Extent group to account
for the different proportions. See Retargeting Rollout on page 6886  for
more details.

5 When you're finished, save your mapping to preserve the retargeted data,
and then click Load Motion to apply the animation to the currently
selected objects.

Retargeting is essentially a “by hand” process. You might need to try
different settings to get the result you need. You can remove retargeting
by highlighting a mapped track in the Retargetable Nodes list, and then
clicking Clear.

6 Close the Map Animation dialog.

Load Animation

Select one or more objects. > File menu > Load Animation

Track View > Hierarchy/Controller window > Highlight one or more tracks >
Right-click. > Load Animation

Load Animation lets you load animation from an XAF (XML Animation File)
file to objects in your scene. Part of the animation-loading process is mapping
the animation; that is, specifying which objects in the scene are to receive the
loaded animation tracks.

For a procedure that outlines the basic method of saving and loading
animation, see To use the Save Animation and Load Animation commands
on page ? .

See also:

■ Saving and Loading Animation on page 6870

■ Save Animation on page 6876

■ Map Animation Dialog on page 6879
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Interface

[file controls] The controls in the upper-left corner of the dialog are standard
file-browsing controls.

Load Into Active Layer Loads the animation file into the active layer.
Default=off.

This option makes it easier to load an animation file to an object that has had
Animation Layers on page 3089  enabled (or disabled) subsequent to saving the
animation files. Remapping is necessary in this case because enabling or
disabling Animation Layers causes the full controller names to change. For
example, if a sphere's X position track before enabling Animation Layers is
Sphere01\Transform\Position\X Position, then after enabling Animation
Layers it might change to Sphere01\Transform\Position\Base Layer\X Position
(the layer name is inserted into the controller name).

Whether Load Into Active Layer is on or off, when you load animation to an
object after changing its Animation Layers status, the software prompts you
to create a map file. If Load Into Active Layer is on, when you click Yes to
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create the map file, the Map Animation dialog opens showing only the active
layer's tracks in the Current list, and the tracks are already mapped correctly
in the Mapped list. All you need to do is save the mapping, and then load the
motion.

If Load Into Active Layer is off, clicking Yes to create the map file opens the
Map Animation dialog showing all animation tracks in all layers, and you
need to use the Map Animation controls to map the tracks before saving the
mapping and loading the motion.

Relative/Absolute Determines how incoming animation affects existing
values. Relative starts the loaded motion at the current values of the selected
objects in the scene. Absolute sets the values of objects in the scene the scene
to those of the motion; so, for example, it would move a character to a new
location and start the animation there. Default=Relative.

Replace/Insert Determines how existing keys are treated when the animation
is loaded. Replace overwrites the keys in the scene with the incoming motion,
starting at the chosen frame. Insert inserts the motion at the chosen frame
and moves any subsequent, existing keys to the end of the incoming motion.
Default=Insert.

At Frame The frame at which the incoming animation is applied. Default=0.

Load Motion If mapping information is available, loads the animation from
the file specified in the File Name field and applies it to current objects
according to the mapping information. If no mapping has been specified,
you're given the opportunity to create a map file. If you then click Yes, the
Map Animation dialog on page 6879  opens, but if you click No, no animation
is loaded.

Cancel Closes the dialog without loading any animation.

Motion Mapping/Retargeting group

File Shows the current mapping file, or “Default” if no mapping file has been
chosen. Choose a mapping file from the drop-down list.

The list contains the most recently loaded mapping files. If the file you want
to use isn't available in the list, use the Get Mapping button.

TIP If the paths in the drop-down list are too long to see the file name itself, you
can resize the dialog to make the dialog and the list wider.

Get Mapping Lets you browse to load a mapping file. Use this if the file
doesn't appear in the Use Mapping drop-down list. The file then appears in
the list for easy reloading.
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Edit Mapping Opens the Map Animation dialog on page 6879  for setting up
animation assignments between incoming tracks and existing tracks. Available
only after an animation (XAF) file has been chosen.

User Data group

The User Data list shows any user data present in the XAF file specified in the
File Name field. User data can be created via the Save Animation dialog, or by
editing the XAF file directly.

Save Animation

Select one or more animated objects. > File menu > Save Animation

Track View > Hierarchy/Controller window > Highlight one or more tracks >
Right-click. > Save Animation

Save Animation lets you store animation from your scene to disk in the XML
Animation File (XAF) format. The XAF file format lets you save and load
animation for any number of objects separately from the actual scene.

For a procedure that outlines the basic method of saving and loading
animation, see To use the Save Animation and Load Animation commands
on page ? .

See also:

■ Saving and Loading Animation on page 6870

■ Load Animation on page 6873

■ Map Animation Dialog on page 6879

Interface

To use Save Animation, select the objects from which to save animation data,
and then choose Save Animation from the File menu. Settings in the Save
XML Animation dialog apply only to objects that are selected when you save
the animation.
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File controls The controls in the upper-left corner of the dialog are standard
file-browsing controls.

Animated Tracks Saves only animated tracks. This is on by default, and
should generally be left on.

■ Include Constraints When on, includes motion derived from constraints.
For example, if an object rotates because a LookAt constraint is applied to
its Rotation track, then when you save its animation with Include
Constraints on, the software generates rotation keys based on the
constrained motion. It does not save the actual constraint. When off,
animation accomplished only by constraints, such as the Link constraint,
is not saved. Default=on.

NOTE This doesn't apply to constraints such as the Path constraint on page
3222 . Because this constraint assigns the animation directly to the constrained
object, rather than deriving it from the constraining object, Save Animation
saves path-constrained animation even if Include Constraints is off.
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Keyable Tracks When on, saves only keyable on page 3486  tracks with
controllers, as defined in Track View. Turning this on allows keyless animation
tracks to be saved. Default=off.

If both Animated Tracks and Keyable Tracks are on, any tracks that contain
animation but are not keyable won't be saved. You can use this option to
avoid saving tracks that aren't relevant to the scene into which you're loading
the animation. For example, if you want to save constraint data, but not data
from a LookAt constraint (because LookAt tends to be specific to the scene),
you can turn off Keyable for the LookAt track, and then save with Keyable
Tracks on.

NOTE Animated Tracks overrides Keyable Tracks. If a track is keyable but doesn't
contain any animation data, and Animated Tracks is on, the track won't be saved
even if Keyable Tracks is on.

NOTE Tracks without controllers, such as nonanimated creation-parameter tracks,
won't be saved even if Keyable Tracks is on. To save a nonanimated
creation-parameter track, add a controller, turn off Animated Tracks, and turn on
Keyable Tracks.

Segment Lets you save a specific frame range, as opposed to the entire
animation. Default=off.

■ Active Time Range Click to set the From and To fields to the
currently active time range. Available only when Segment is on.

■ Objects Time Range Click to set the From and To fields to the time
range that corresponds to the keys of the currently selected objects.
Available only when Segment is on.

■ From Sets the starting frame for the range to save. Available only when
Segment is on.

■ From/To Sets the ending frame for the range to save. Available only when
Segment is on.

Key Per Frame Saves an animation key per frame, thus “baking” the
animation to keyframes.

This can be useful if you are applying a procedural animation, such as a
dynamics simulation, to an object that won't be participating in a dynamics
simulation in the target scene.
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+ Increments the number at the end of the file name and saves the animation
file with the new name. If the file name doesn't currently end with a number
of two or more digits, clicking + appends “01” to the file name (before the
extension), and then saves the file.

Save Saves the animation using the current file name.

Cancel Closes the dialog without saving any animation.

User Data group

These controls let you enter user attributes and names. This could simply be
notes about the animation file, or they could be actual data for use by custom
plug-ins and utilities.

To enter user data, type a value in the Attribute field, press Tab and type a
value in the Value field, and then press Enter to add the attribute and value
to the list below. These values are saved with the XAF file and can be viewed
with the Load Animation dialog.

Attribute Enter an attribute name.

Value Enter an attribute value. This can be any combination of alphanumeric
characters. To add the attribute and value to the file, press Enter while the
cursor is in this field.

Delete User Data Deletes the highlighted attribute from the list along
with its corresponding value.

Attribute list Shows all attributes and values in the file. To change a value,
click the corresponding attribute in the list to highlight it and place it in the
Attribute and Value fields, edit the Value field, and then press Enter. You can
also edit the Attribute field, but this creates a new entry.

To remove an attribute, highlight its name in the list and then click Delete
User Data.

Map Animation Dialog

File menu > Load Animation > Open dialog > Edit Mapping

File menu > Load Animation > Open dialog > Load Motion > XML Animation
dialog > Click Yes.
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The Map Animation dialog lets you assign incoming animation tracks when
using the Load Animation on page 6873  command. The dialog is resizable and
contains three rollouts: for setting up basic parameters, doing the actual
mapping, and doing retargeting.

For a procedure that outlines the basic method of saving and loading
animation, see To use the Save Animation and Load Animation commands
on page ? .

See also:

■ Saving and Loading Animation on page 6870

■ Save Animation on page 6876

■ Load Animation on page 6873

Interface

Most controls on this dialog are contained in three rollouts:

Motion Mapping Parameters Rollout on page 6882

Map Track to Track Rollout on page 6885
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Retargeting Rollout on page 6886

Motion File Shows the path and name of the current animation (XAF) file.

■ New Click to display a file dialog and specify a new animation file to
load.
With this option, you don't need to return to the Load Animation dialog.

Map File Shows the path and name of the current map (XMM) file.

■ New Click to display a file dialog and specify a new map file to load.
With this option, you don't need to return to the Load Animation dialog.

Save Mapping Click to save the current mapping assignments to an XMM
file. If a file name is already displayed in the Map File field, it is overwritten;
otherwise, 3ds Max displays a file dialog so you can enter a name for the new
file.

Save Mapping As Click to save the current mapping assignments to an XMM
file using a different file name. This displays the Save XML Animation map
file dialog.

Load Motion Click to load the animation from the XAF file, and maps the
animation tracks as specified.

This button is available only when the Map File field contains a valid map
file name.

Replace / Insert These options determine how existing keys are treated when
you load an animation. Replace overwrites the current scene's keys (if any)
with the incoming motion, starting at the chosen frame. Insert inserts the
motion at the chosen frame and moves any existing keys to the end of the
incoming motion. Default=Insert.

■ At Frame The frame at which the incoming animation is written (Replace)
or inserted. Default=0.

Relative/Absolute These options determine how incoming animation affects
existing values. Relative starts the loaded motion at the current values of the
selected objects in the scene. Absolute sets the values of objects in the scene
to those of the incoming motion. For example, when you load a character
animation, Relative starts the animation from the character's current position,
while Absolute first moves the character to the position of the character in
the scene from which the animation was saved. Default=Relative.

Saving and Loading Animation | 6881



Motion Mapping Parameters Rollout

File menu > Load Animation > Open dialog > Edit Mapping

File menu > Load Animation > Open dialog > Load Motion > XML Animation
dialog > Click Yes.

This rollout provides controls for automatically mapping animation tracks
and for filtering tracks to reduce clutter.

Interface

Map Nodes group

These controls let you perform automatic mapping by name or hierarchical
order. Mapping is done first by node (object) name, and then within each
node's hierarchy by controller (track) name.

The default method of automatic mapping is Exact Name for both nodes and
controller. When you first open the Map Animation dialog, any node/controller
pairs whose names match exactly are automatically mapped. To change the
mapping, remove any existing assignments in the Mapped list (highlight them
and then click the -> button), and then choose an alternate method.

Exact Name This maps node to node, by name. If the names do not match
exactly, the tracks will not map, and the status line will report how many
nodes did not map

Closest Name Finds a match in the object names, and uses the Controller
options (described below) to confirm the match.

For example, if the incoming is R Toe 01 and the choice in the Current list is
between Right Index Toe and R Toe Helper, it will look at the controller structure
and compare by name, or type or order, and try to determine which node is
the closest to the incoming. When the choice is close like this, the status line
reports that there was another close match, and highlight the close, but
unmapped, nodes in the incoming list in red.

Hierarchy This option turns off the above options. It matches by node order;
for example, Bone01>Bone02>Bone03 would map to Leg>Calf>Foot, if Controller
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is set to Order and the leg is mapped to Bone01. The Hierarchy option ignores
the names.

Controller Determines how automatic mapping is performed within nodes:

■ Exact Name (The default.) Matches controllers by name, regardless of
order. This applies specifically to lists, morph channels, maps, custom
attributes, and any other tracks that are listed by a user-defined name that
might be reordered for some reason.

■ Order This maps by controller order only, regardless of name or type,
and it turns the other options off. For example, it will map the first
controller in a list to the first controller in a list. If necessary, it “bakes”
the animation by creating per-frame keys.
If any controllers are not mappable (for example, a Bezier controller getting
mapped into a script), the status line will report the error and highlight
the node that couldn’t map in the incoming list.

Type When on, allows mapping only between controllers of the same type.
It prevents mapping between two controllers of different types. For example,
a controller such as Noise and its parameters will map only to another Noise
controller. Default=off.

Filters group

The Filters options are similar to those available in Track View: they enable
viewing only certain types of tracks. Filtering is can be a help with large,
complex animation setups, because it lets you focus on tracks of specific
interest and ignore the rest.

The following information describes the action of filters that are on. Unless
otherwise specified, when a filter is off, the track type it applies to is hidden.
In some cases, a track will not be hidden because a different filter that is on
permits display of that track.

NOTE The Incoming list contains only animation tracks that were saved in the
XAF file, so it cannot display unavailable tracks. For example, if you don't animate
an object's creation parameters, toggling the Base Objects switch won't change
the Incoming list contents.

Current/Incoming Determines whether the filters are applied to the Current
list or the Incoming list.
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Lock When the Lock button is on, the filters are applied to both lists.
Default=locked.

 When the Lock button is off, only one of these is active at a time, and
3ds Max remembers different sets of on/off values for the filtering parameters.

Animated Tracks Displays tracks that contain animation keys.

Include Constraints Displays constraint tracks, even if they are not animated.

Keyable Tracks Displays tracks that are set to keyable, regardless of whether
they contain animation.

Unmapped Tracks When on, hides mapped tracks. When off, all tracks are
displayed.

Visibility Tracks Displays visibility tracks.

Note Tracks Displays note tracks. When a note track is mapped, the notes
are added to an existing note track in the current scene.

Custom Attributes Displays custom attribute tracks.

Controller Types Displays controller types (names) in the list. For example,
the Position X track reads “Position X: Bezier Float.”

IK Controllers Displays any IK controllers.

Modifiers Displays animatable modifier tracks.

NOTE In order for modifier tracks to display in the Current column, the Base
Objects filter must also be on.

Base Objects Displays creation-parameter tracks for parametric objects such
as Box and Sphere.

Map Parameters Shows map tracks, such as Tiling for Bitmaps and Mix
Amount for Mix maps.

Material Parameters Shows tracks for materials; for example, animated
Diffuse color values, Opacity, and so on.

Expose World Transforms Displays tracks for world transforms. These let
you map all transform animation between two objects using a single track,
named Exposed World Transform.
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Transforms Enables or disables display of all transforms other than the
exposed world transforms. The toggles that follow control display of individual
transforms:

■ Position/X/Y/Z The Position check box lets you toggle display of all
Position tracks, while the X/Y/Z check boxes let you toggle display of the
track for each axis.

■ Rotation/X/Y/Z The Rotation check box lets you toggle display of all
Rotation tracks, while the X/Y/Z check boxes let you toggle display of the
track for each axis.

■ Scale/X/Y/Z The Scale check box lets you toggle display of all Scale tracks,
while the X/Y/Z check boxes let you toggle display of the track for each
axis.

Map Track to Track Rollout

File menu > Load Animation > Open dialog > Edit Mapping

File menu > Load Animation > Open dialog > Load Motion > XML Animation
dialog > Click Yes.

This rollout comprises three list windows. The left (Current) and right
(Incoming) show node/controller hierarchies, as in Track View.

Because the Map Nodes group functions apply to highlighted tracks, you can
use standard highlighting methods. Click to highlight an entry, Ctrl+click to
highlight multiple entries, and Shift+click to highlight a range. Also, in the
Current and Incoming windows, you can right-click to open a menu that lets
you highlight all tracks (Select All), invert the current highlighting (Select
Invert), and turn off highlighting for all tracks (Select None).

In addition, you can use the right-click menu to expand and collapse any
track with a - or + icon next to its name.
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Interface

Current[list Shows animation tracks for selected objects in the scene, using
the same hierarchical display as Track View. Unassigned tracks use black
characters, while assigned tracks use gray characters.

Status This read-only field shows the number of controllers and the number
of nodes mapped.

Mapped list Shows tracks that have been mapped.

<- Assigns the highlighted animation track in the Incoming list to the
highlighted animation track in the Current list. The assignment then appears
in the Mapped list, opposite the corresponding Current list entry.

If the two tracks don't contain comparable data, nothing happens when you
click the button.

-> Removes the highlighted Mapped list entry.

Incoming list Shows animation tracks in the loaded XAF file, using the same
hierarchical display as Track View. Unassigned tracks use black characters,
while assigned tracks use gray characters.

Retargeting Rollout

File menu > Load Animation > Open dialog > Edit Mapping

File menu > Load Animation > Open dialog > Load Motion > XML Animation
dialog > Click Yes.

When you map an animation from one rig or object onto another, use this
rollout to establish retarget references between the incoming nodes in regards
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to their scale dependency. Retargeting means to scale the animation so it
matches the objects onto which you are mapping the motion. You need to
retarget only when the size or proportions of the incoming model differ from
the size or proportions of the current model.

Retargeting applies to any kind of animation, from matching fight
choreographies, to changing a weather balloon's fly-through trajectory over
hills and valleys. The down side of this is that essentially you have to set up
the scaling relationships by hand; the good news is that the steps are fairly
straightforward, and that once you have retargeted, the settings are reusable
for all animation mapped between the same two sets of objects.

While retargeting is a general-purpose feature, it is especially useful for
transferring animation from one character to another, when the characters
are of different sizes, and possibly of different proportions (for example, a
human model to a gorilla, or vice versa). You can transfer IK animation onto
an FK rig, or vice versa. There are some rules of thumb when you work with
mapping character animation:

■ In a walk cycle, the root of a character moves, and all other movement is
typically rotation.
Because of this, usually you want to map the root motion and the rotation
tracks, and leave the others alone.

The exception to this is when arms or other parts (tentacles?) are animated
by IK. When IK is present, you need to take the additional step of mapping
and retargeting the IK goals.

■ The legs need to reach the “ground,” and feet should not slide.
Because of this, use the legs as the basis of recalculating the scale for the
target character.

■ Characters are usually symmetrical.
Because of this, usually retargeting one limb does the trick for both.

If a character's limbs are not symmetrical, retarget each of them individually.
If the current model uses forward kinematics, then use the FK Retargeting
Extent controls as well.

Procedures

To retarget one character onto another:

This procedure is not a detailed procedure, but an overall workflow. It assumes
you have already saved the incoming character's animation, then loaded it
onto the current character, as described in To use the Save Animation and
Load Animation commands on page ? .
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NOTE If the animation you are saving is unkeyed world-space animation (as
opposed to IK or FK), turn off Animated Tracks when you save.

1 On the Map Track To Track rollout on page 6885 , map the motion tracks
of the incoming character's root to the current character's root.

For example, if you are retargeting a Biped on page 4069  onto another,
you would map the incoming Biped object's position and rotation tracks
onto the current Biped.

2 Map the rotation tracks of the incoming character's limbs onto the current
character's limbs.

There is one exception here: if a hand (for example) is going to use IK in
the current scene, either don't map it at all, so you can animate it later,
or if you are mapping from an FK model to an IK model, map the Exposed
World Transform to transfer the incoming FK trajectories to current IK
controls.

3 Go to the Retargeting rollout.

4 In the Scale Origin group, choose both the Incoming and Current root
objects.

If the characters are symmetrical and have the same proportions, you
can now choose all the mapped tracks in the Retargetable Nodes list. If
the characters are not symmetrical, or their proportions are different,
then you need to take further steps.

5 In the Derive Scale Between Chains group, choose the Start and End
nodes of both Incoming and Current chains to correspond to either the
left or right leg of the character: for example, Thigh to Toe.

Read the Scale Factor that is set on the basis of the two chains.

6 Click Set to retarget the highlighted mapped tracks.

If the two current legs are not the same length, repeat step 5 for the other
leg, then choose that leg's Foot (or Toe) node, turn on Enabled in the FK
Retargeting Extent group, and choose the top of the leg (for example,
Thigh) as the parent to use. Click Set.

7 Save the retargeted mapping file.

8 Click Load Motion to animate the current character, and then close the
Map Animation dialog.
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Interface

Retargetable Nodes list This list shows the tracks that have been mapped
using the Map Track To Track rollout on page 6885 . Each of these mappings
can be retargeted.

The fields in this list are as follows:

■ Current Mapped Node Shows the node-to-node mapping, as in
“CurrentObject->IncomingObject.”

■ R When a mapping has been retargeted, this field shows an “X.”

■ Scale (X,Y,Z) Shows the current scaling factor for each dimension of the
current node.

■ Absolute When a mapping uses absolute scaling, this field shows an “X.”

■ Scale Origin (Incoming,Current) Shows the incoming and current scale
origins for this mapping. If the mapping hasn't been retargetted, this field
shows “Scene Root , Scene Root.”

■ Incoming Chain (Start,End) If the mapping has been retargeted, shows
the incoming chain used to calculate scale.

■ Current Chain (Start,End) If the mapping has been retargeted, shows the
current chain used to calculate scale.

■ FK Extent If a mapped track's FK extents have been recalculated, shows
the parent node used in the recalculation.
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Find Enter a name to search for a particular object, then press Enter. 3ds Max
highlights matching entries in the list.

Filter Retargeted Nodes When on, the list shows only those mappings that
have been retargeted. When off, all mappings are listed. Default=off.

Mapped Node Shows the currently highlighted mapped node. If more than
one list entry is highlighted, shows “—Multiple—.”

Scale group

■ Absolute When chosen, scaling for the currently highlighted mappings
is absolute, and based on the XYZ settings in this group alone.

■ Multiply Derived Scale (The default.) When chosen, scaling for the
selected mappings is based on both the XYZ settings in this group, and
calculations from the Derive Scale Between Chains group and the FK
Retargeting Extent group (if that is used).

X/Y/Z You can use these fields to explicitly set the scaling factor for the
currently highlighted mappings.

Scale Origin group

Incoming Choose the incoming object from which to derive the scaling
origin. This is a drop-down list obtained from the list of incoming nodes.

Current Click to display a Select dialog and chose the current object from
which to derive the scaling origin. The dialog shows all currently selected
objects.

Typically, you set these two to be the incoming root node and current root
node, whose motion tracks are already mapped.

Derive Scale Between Chains group

Resulting Scale Factor Displays the scale factor derived from the Scale Origin
and Incoming/Current Chain settings. Check this value to see that it matches
the apparent difference in proportion between the objects or characters you
are retargeting.

Incoming Chain These controls set the incoming IK or FK chain to use in
calculating the Scale Factor.

■ Start Choose the start of the incoming chain. This is a drop-down list
obtained from the list of incoming nodes.
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When retargeting character animation, typically you choose the top of the
incoming character's leg; for example, the thigh.

■ End Choose the end of the incoming chain. This is a drop-down list that
is restricted to children of the incoming Start object.
When retargeting character animation, typically you choose the end of
the incoming character's leg; for example, the toe.

Current Chain These controls set the incoming IK or FK chain to use in
calculating the Scale Factor.

■ Start Click to display a Select dialog and choose the start of the current
chain. The dialog shows all currently selected objects.
When retargeting character animation, typically you choose the top of the
current character's leg (using the same side as you used for the incoming
chain).

■ End Choose the end of the current chain. This is a drop-down list that
is restricted to children of the current Start object.
When retargeting character animation, typically you choose the end of
the current character's leg.

If a character's legs are symmetrical, which is usually the case, you only need
to calculate the retargeting scale for one leg, and then Set that value to both.
If the character's legs are not symmetrical, you need to calculate values for
both legs, and also use the FK Extents controls (described below).

FK Retargeting Extent group

When the current model uses IK, 3ds Max knows the extent to retarget because
it is defined by the IK solution. But if the current model uses FK, you should
specify the extent of retargeting. For example, mapping rotation animation
from a long leg to a short leg with different link lengths requires that the short
leg’s foot be chosen to retarget so it ends up meeting the floor in the same
way the long leg does. In order for 3ds Max to know how far up the chain
from the foot to do the retargeting, the parent of the desired chain (for
example, the thigh) must be specified. By defining the two chains to compare,
3ds Max can adjust the resulting rotations such that the feet don't slide.

When a character's limbs are not symmetrical, you can also use these controls
to keep rotations proportional. First, highlight the current child (for example,
a foot or toe) in the Retargetable Nodes list. Turn on Enabled, and then use
the drop-down list to choose the upper parent (for example, the thigh) of the
limb you are retargeting. Finally, click Set.
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Enabled Turn on to enable retargeting extents. Default=off.

Parent Node Choose the current upper parent of the limb you are retargeting.
This drop-down list is restricted to parents of the currently highlighted current
object.

Get Click to set controls in the Scale, Derive Scale Between Chains, and FK
Retargeting Extents groups based on the currently highlighted mapping in
the list.

If multiple mappings are selected, Get fetches the first highlighted mapping
in the list.

Set Click to apply the current Scale Factor to the mappings that are currently
highlighted in the list.

Clear Click to clear retargeting values from the mappings that are currently
highlighted in the list.

Import

File menu > Import

Import loads or merges geometry files that are not 3ds Max scene files. See
the following procedure for a complete list of file types you can import.

Procedures

To import a file:

1 Choose File menu > Import.
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2 Choose an import file type from the Files Of Type list in the file selector
dialog. To see more than one file type at a time, choose the All Files file
type.

■ 3D Studio Mesh (3DS) on page 6969

■ 3D Studio Project (PRJ) on page 6971

■ 3D Studio Shape (SHP) on page 6974

■ Adobe Illustrator (AI) on page 6975

■ AutoCAD (DWG) on page 6979

■ AutoCAD (DXF) on page 7006

■ Autodesk Inventor (IPT, IAM) on page 7008

■ Initial Graphics Exchange Standard (IGES) on page 7023

■ FiLMBOX (FBX) on page 7019

■ LandXML /DEM /DDF (DEM, XML, DDF) on page 7046

■ Lightscape Solution (LS), Lightscape Preparation (LP), and Lightscape
View (VW) on page 7050

■ Motion Analysis Hierarchical Translation-Rotation (HTR) on page 7054

■ Motion Analysis TRC (TRC) on page 7056

■ Stereolithography (STL) on page 7073

■ VRML (WRL, WRZ) on page 7082

■ VIZ Material XML Import (XML)

NOTE This applies the imported material directly to selected objects. See
Material XML Exporter Utility on page 5185  for information on creating
this file type.

3 Select a file to import.

4 For some file types, a second dialog appears, with options specific to that
file type. Choose the import options you want.
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Export

File menu > Export

Export converts and exports 3ds Max scenes in various formats. See the
following procedure for a complete list of file types you can export.

See also:

■ Export Selected on page 6895

Procedures

To export a file:

1 Choose File menu > Export.

2 Choose an export file type from the Files Of Type list in the file selector
dialog:

■ 3D Studio (3DS) on page 6972

■ Adobe Illustrator (AI) on page 6976

■ ASCII Scene Export (ASE) on page 6977

■ Lightscape Material (ATR) on page 7048

■ Lightscape Blocks (BLK) on page 7048

■ Lightscape Parameter (DF) on page 7048

■ Publish to DWF on page 7013

■ AutoCAD (DWG) on page 7003

■ AutoCAD (DXF) on page 7006

■ Autodesk (FBX, DAE) on page 7019

■ Motion Analysis HTR File (HTR) on page 7058

■ IGES (IGS) on page 7027

■ Lightscape Layers (LAY) on page 7048

■ Lightscape Preparation File (LP) on page 7048

■ JSR-184 (M3G) on page 7030
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■ Wavefront Material (MTL) on page 7078

■ Wavefront Object (OBJ) on page 7079

■ StereoLitho (STL) on page 7076

■ Lightscape View (VW) on page 7048

■ Shockwave 3D Scene Export (W3D) on page 7061

■ VRML97 (WRL) on page 7083

3 Enter a name in the File Name field.

4 Depending on the file type you choose, you might be presented with
options available for that export choice. If a second dialog appears, choose
the export options you want.

Export Selected

Select one or more objects. > File menu > Export Selected

Export Selected exports selected geometry in a variety of formats. For details,
see Export on page 6894 .

When you choose Export Selected, a file dialog appears, from which you can
choose a type of format from the Save as type list. The list of formats available
with Export Selected is a subset of the Export list.

Procedures

To export selected objects to a file:

1 Select one or more objects.

2 Choose File menu > Export Selected.

3 Enter a name in the File Name field.

4 From the Save As Type drop-down list, choose a file format.

5 Click the Save button.
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Asset Tracking

The Asset Tracking feature provides direct access within 3ds Max to asset
tracking systems (ATS), also known as providers. You use asset tracking systems
to share files such as scene files and bitmaps used in materials with other
members of your development team.

Asset tracking provides full support for the Autodesk Vault data-management
solution, and basic version-control support for other providers, such as Perforce
and Microsoft SourceSafe. In general, asset tracking supports version-control
providers that are capable of integrating into Microsoft Visual Studio,
sometimes referred to as MSSCC support. This topic assumes usage of Autodesk
Vault.

NOTE When you have Vault installed, you can open files directly from the Vault
database with the File menu command Open from Vault on page 6721 . This
command mimics the File Open process, but browses the vault instead of the file
system. In addition to opening the scene file, it downloads or updates any
dependent scene files, such as bitmaps and XRefs. You see Open from Vault in the
File menu only if you have installed the Vault add-in.

Asset Tracking with Autodesk Vault

The 3ds Max Vault add-in works with 3ds Max by adding data-management
tools to the interface. Through the Vault add-in, you can add files to a vault,
and check files out and in. The add-in works with many different types of files
including MAX and image files. The recommended method for performing
Vault operations depends upon your working environment.

When you work on a file that is checked out of the vault, you work on a local
copy of the file and not the original. At no point do you ever work on the
actual vaulted file. When you check a modified file back into the vault, the
modifications are available as the latest version in the vault. All past versions
of a file are maintained in the vault.

See also:

■ ms-its:3dsmax_t.chm::/WS73099cc142f4875514c01ac112a7acef16-7535.htmUsing
Asset Tracking tutorial  for an overview of the asset tracking workflow.

■ Asset Tracking Dialog on page 6897

■ Open from Vault on page 6721

■ Prompts Dialog on page 6914
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■ Asset Tracking Dialog Icons on page 6916

System Administrators See also

The Autodesk 3ds Max Install Guide for a full list of install and configuration
documents for both Vault 5 and Vault 2008.

Asset Tracking Dialog

File menu > Asset Tracking

With the Asset Tracking dialog, you can check files in and out, add files to
the Asset Tracking System (ATS), get different versions of files, etc., all from
3ds Max without the need to use separate client software. Another important
function of the Asset Tracking dialog is for repathing; locating missing files.
For example, if you move bitmap files used by materials in your scene to the
same folder as the scene file, the bitmaps will be loaded when you open the
scene file, but the materials will still use the original, no-longer-valid path for
the bitmap files, and the Asset Tracking dialog will show the files as missing.
To resolve the incorrect paths, you can use the tools available from the Paths
menu.

Asset tracking provides full support for the Autodesk Vault data-management
solution, and basic version-control support for other providers, such as Perforce
and Microsoft SourceSafe. In general, asset tracking supports version-control
providers that are capable of integrating into Microsoft Visual Studio,
sometimes referred to as MSSCC support. This topic assumes usage of Autodesk
Vault.

The Asset Tracking dialog provides the principal functionality for working
with the Vault data-management solution from within 3ds Max, but you can
also work directly with Vault using the Vault Explorer client software, which
is included with 3ds Max. To run Vault Explorer, go to Windows Start menu
> Autodesk > Autodesk Data Management and choose Autodesk Vault Explorer.
To learn more about using Vault Explorer, open the Autodesk Vault Explorer
Help menu and choose Autodesk Vault Help Topics, or simply press F1 while
the Vault Explorer window is active.

See also:

■ Asset Tracking on page 6896
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Filtering Files

You can configure individual asset-tracking-system providers via the provider
configuration file, ATSProviders.xml, which resides in \plugcfg in the program
install folder. 3ds Max reads this file, but doesn't write to it.

The primary configuration function is filtering. Filters define criteria the
software uses to determine whether a file should be excluded from a provider’s
control. If a file is determined to be excluded from a provider, the file is never
sent to the provider for status check or any other action. This feature is useful
when using multiple providers within the same pipeline or if your studio still
uses file servers for certain file types.

When a file is excluded, its icon is grayed out and its status message indicates
that it is excluded. You can also toggle the display of excluded files in the
dialog window with the Display Excluded Files option on page 6910 .

A example filter file, \plugcfg\ATSProviders_Example.xml is included with the
software, in the program install folder. The file includes comments, so you
can load it into a text editor to see how it works and edit it. If you're using
Autodesk Vault as your provider, you can rename the provider field (in the
<Provider> section, near the beginning of the file) to Autodesk Vault, as follows:

Change:

<Name>Sample Provider Name Example</Name>

to:

<Name>Autodesk Vault</Name>

One of the effects of the example file is to exclude FX files, as shown in the
following illustration:

Procedures

If you are using Vault as your asset management system, you will need to
login into the Vault the first time you access it, otherwise you will not be able
to check files in and out.
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To start and login into the Vault from 3ds Max:

1 In 3ds Max choose File > Asset Tracking.

2 Select the version of Autodesk Vault that you want to login to from the
Autodesk Vault Version box.

3 In the Asset Tracking dialog choose Server > Log in.

4 In the Log in dialog box enter the following:

User Name The name for the vault ac-
count. Default= Administrator

The password associated with
the vault account. De-
fault=<left blank>

Password

The name of the computer
on which the vault server is

Server

installed. Use “localhost” if
the server is installed on the
same machine as the client.
See your system administra-
tor if this does not work.

The name of a vault database
located on the specified serv-

Database

er. The default is “Vault”.
Click the browse button to
select from a list of available
databases on the server. De-
fault=Vault

NOTE Enable Use this settings next session if you want to be automatically
logged in future sessions.

Click OK when you have entered values in all fields.
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NOTE Your system administrator may provide you with your own account
values which you will use instead of the defaults. If you are experiencing
problems, speak with your system administrator.

To set up a local working folder when using Vault:

When you are working with files in Autodesk Vault you need to have a working
folder set up. The working folder houses your files while you are working on
them (between checking files out of the vault and checking them back in to
the Vault). The working folder can be a folder on your local machine or a
folder on the network. Typically a system administrator will set up the working
folder on the network. For information on setting up working folders (shared
working folders) on the network see Managing_Your Data_5_Vault_3dsmax.pdf
for information on how to manage data in a Vault setup with 3ds Max.

NOTE If your system administrator has enforced a network working folder, you
may receive a message notifying you of this. You will not need to set your working
folder, though you may need to map the drive location that has been set up for
your working folder. For further information, speak with your system administrator.

1 In 3ds Max choose Server > Login and login on page 6902  to the Vault.

NOTE Make sure the version of Vault that you want to work with is selected
in the Autodesk Vault Version box.

2 Choose Server > Options.

3 Browse to the folder that you want to use and click OK to confirm.

To coordinate local files with Vault files:

For optimal coordination between your files and those in the Vault, you need
to maintain a one-to-one correspondence between the folder structure in the
database and the structure in your working folder and its subdirectories.
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Create a local folder structure for Vault files and then use Options to map the
top of the local structure to the top of the Vault structure (i.e., Vault($)).

1 Create a working folder on a local drive to contain all files to be
coordinated with other users via the Vault. For example, you could call
the working folder My_Vault.

2 Open the Asset Tracking dialog and log in to the tracking database if
necessary.

3 On the Asset Tracking dialog, choose Server menu > Options.

4 On the Vault Options dialog, click the Change button and then use the
Browse For Folder dialog to choose the folder you created in step 1.

TIP You can also use the Browse For Folder dialog to create this folder.

Now, when you open a file from the Vault on page 6721 , the folder
structure in which the file resides in the Vault is replicated in your local
folder, if necessary. Likewise, when you add a file to the Vault, the local
structure is replicated in the Vault, if necessary. For example, if you open
a character mesh from Vault($)\max_files\characters\ and the file uses a
bitmap stored inVault($)\max_files\characters\face_maps\, the character
mesh is stored locally in My_Vault\max_files\characters\ and the map file
is stored locally in My_Vault\max_files\characters\face_maps\.

Interface
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Menu bar

The menu bar provides access to most Asset Tracking functions. Most of the
menu functions are also available from the right-click menu available in the
dialog window.

NOTE If you highlight and then Ctrl+right-click one or more assets all of which
reside in the same directory, a version of the Windows Explorer context menu
opens. This lets you perform such functions as cutting or copying the file, or
sending it to the desktop as a shortcut for easy access.

Server menu

Log in Displays the Vault Log In dialog. Enter your user name, password,
server name, and database, and then click OK. After entering a server name,
you can click the ellipsis (...) button display all available databases and choose
one from the dialog.

You can log in automatically in future sessions without having to use the
Vault Log In dialog if you turn on “Use these settings next session.” This also
turns on Options > “Log in using saved settings.”

The login settings are stored in the file plugcfg\ATSVaultLogin.ini in the program
install folder.

Log out Logs you out of the database.

Options Opens the Vault Options dialog, where you can view the working
folder and specify a new one (click the Change button). Available only when
logged in.
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IMPORTANT The working folder is a folder on your local drive that mirrors the
top-level folder of the provider database structure. For further information, see
this procedure on page ? .

You can log in automatically in future sessions, bypassing the Vault Log In
dialog, if you turn on “Log in using saved settings.” This also turns on Vault
Log In > “Use these settings next session.”

Launch Provider Opens the database client program. This is the same as
running the program from the Start menu. It doesn't necessarily open to the
same database you're using in 3ds Max.

File menu

Most of the File menu commands are available only when you're logged in.

Checkout Lets you check out the highlighted assets in the Asset Tracking
dialog list of assets, if the assets are available for checking out. This opens a
dialog that lets you confirm the checkout, specify whether to replace the local
copies with the checked-out version, and enter a comment.

If you enter a comment, it's copied to the Working Comment dialog on page
6904 .

TIP Always be sure to check out an asset before modifying it, even if you have a
writable version on a local drive. This prevents other users from modifying the file
at the same time, and lets you maintain strict version control over the asset.

Checkin Lets you check in the highlighted assets in the Asset Tracking dialog
list of assets. This opens a dialog that lets you confirm the checkin, specify
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whether to keep the assets checked out, and enter a comment. Also, if the
assets have been edited but not saved locally, you're prompted to save first.

Checking in an asset increments the current version number of the asset as
stored in the database, and saves the current Comment text along with the
asset.

Undo Checkout Reverses a checkout, setting the highlighted assets' status
to checked in, without saving any changes.

Add Files Lets you add files in the scene, such as bitmaps used in materials,
to the provider database. To add a file, load it (such as a scene file) or add it
to the scene (such as a bitmap used in a material), highlight it in the Asset
Tracking dialog, and then use Add Files.

You can add multiple files at the same time.

NOTE You cannot add a file that doesn't exist on a local drive, such as an unsaved
scene file. Also, you cannot add a file that's not in the working folder, as specified
via Options on page 6902 . For best results, before adding a file, make sure it exists
in a local folder within a structure that mirrors the one in the Vault. For details,
see this procedure on page ? .

Get Latest Downloads the most recent (highest-numbered) version of the
highlighted asset from the database. Use this when a teammate has updated
an asset such as a bitmap.

History Opens a History dialog from which you can get any version of the
highlighted asset. When the dialog opens, highlight the version to get by
clicking it and then click Get Version. You can also right-click the asset and
choose Get Version from the context menu.

Properties Opens a read-only dialog that shows information about the
highlighted asset such as vault and local locations, versions, and check-out
status.

Get From Provider Lets you copy files from the database to the local working
folder. Use the Get Files dialog to navigate to the folder from which to get
files, highlight any number of files, and then click Open. The highlighted files
and any dependent files, such as bitmaps and XRefs, are copied to the local
folder, using the same folder hierarchy as that of the database.

Working Comment Opens a dialog that containing a common text buffer
for the current session.

When you check out a file, any comment you enter in the Asset Tracking
dialog is copied to the Working Comment dialog. You can edit this text at
any point during the session. When you check a file back in, all Working
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Comment text appears in the Asset Tracking dialog; you can edit it as necessary
without affecting the original text before completing the check in. The
checked-in comments remain with that version of the file in the Vault.

Browse Lets you browse the local directories for missing files such as bitmaps.
Use the Browse dialog to find the file, and then click Open.

View Image File Opens a window showing the highlighted image file. The
file must be present in a local directory.

Reveal In Explorer Opens a Windows Explorer dialog showing the location
of the highlighted asset.

Custom Dependencies Opens a dialog that lets you specify files to be
dependents of the current scene; files that aren't necessarily present in the
current scene but should be associated with it. On the Custom Dependencies
dialog, click the Add button and then use the Add Custom Dependencies file
browser to open dependent files.

The Custom Dependencies function lets you associate files that aren’t true
scene dependencies. A true dependent file is required for rendering, animation,
exporting, etc. A custom dependency might be reference art work, a text file
with scene documentation or tasks to accomplish, custom scripts, etc. Basically,
any collection of files that should “travel along” with the scene.

One potential use for a custom dependency is as a way to perform simple
project management. For example, you could add a file called GameTitle-A.txt
as a custom dependency to any scene file associated with GameTitle-A. You
could then instruct the provider client, such as Vault Explorer, to display all
files that are dependent on GameTitle-A.txt, which would give you a list of files
associated with that project.

Refresh Reloads the asset listing from the local scene and updates the window
contents.

Paths menu

The tools on this menu help you resolve file-path issues such as missing files.
They include functionality also available in the Bitmap/Photometric Path
Editor Utility on page 6938 , but their integration into the Asset Tracking dialog
helps speed the workflow of managing scene assets.

Highlight Editable Assets Highlights all assets whose paths can be affected
by the remaining commands on this menu.

For example, if your scene materials use bitmaps from a number of different
folders, you could copy all the bitmaps to a common directory within your
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working folder, use Highlight Editable Assets to highlight all the bitmap assets,
and then use Set Path (see following) to designate the common directory.

Set Path Opens a dialog for editing the scene's record of the highlighted
asset's or assets' path and, in the case of a single asset, the file name. Both
versions of the dialog include drop-down history lists for reverting to a previous
path or file name.

The primary function for this command is to change the path pointed to by
3ds Max for existing assets whose locations have changed. However, for output
files such as rendered images and render elements, you can also use Set Path
to create and use new output directories. If you change an output path to one
that doesn't exist, you're prompted to confirm that you want to create the
folder(s). if you confirm, the output paths are changed in all appropriate
locations, such as the Render Scene dialog.

The version of the dialog that appears depends on the number of highlighted
assets:

■ If a single asset is highlighted, you can change the path and the file name.
The following dialog appears.

To change the path, edit the Path field or use the ellipsis [...] button to
browse for a new path. This changes the path only.

To revert to a previous path, choose it from the drop-down list.

To change the file name, edit the File field or choose a name from the
drop-down history list. Note that this changes only the name of the asset
file as pointed to in the scene; it doesn't change the actual asset file name.
Use this to update the scene if the asset file name has changed.

■ If multiple assets are highlighted, you can change the path but not file
names. The following dialog appears.
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The dialog shows the portion of the current path that the highlighted
assets and lets you specify a new one, either by editing the Specify Path
field contents or by clicking the ellipsis [...] button and browsing to a
different path.

For example, if two assets are highlighted, and one asset's path is
c:\max_files\maps1\ while the other's is c:\max_files\maps2\, the Specify Path
field will show c:\max_files\. Changing this changes the complete path for
all highlighted assets. Of course, they must all be present there for the
program to find them.

To revert to a previous path, choose it from the drop-down list.

To change only the portion of the path that all highlighted assets have in
common, use Retarget Common Root (see following).

Retarget Common Root Lets you change only the part of the path that all
highlighted assets have in common. This command opens a version of the
Specify Assets path dialog that shows the common path prefix for the
highlighted assets and lets you specify a new one, either by editing the Specify
New Common Path Prefix field contents or by clicking the ellipsis [...] button
and browsing to a different path. Use Retarget Common Root for repathing
multiple files, particularly those in different directories within the common
root.
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For example, if all maps were originally in various subdirectories within
c:\maps\ and the entire subdirectory structure was moved to d:\resources\maps\,
you could repath all files simultaneously using Retarget Common Root.

To revert to a previous path, choose it from the drop-down list.

If you change the common root for output files to a path that doesn't exist,
you're prompted to confirm that you want to create the folder(s). if you
confirm, the output paths are changed in all appropriate locations, such as
the Render Scene dialog.

Strip Path Strips all path information from the highlighted assets, leaving
only the file names.

Stripped path information is saved in the Set Paths dialog drop-down list. To
restore stripped paths, highlight the assets, choose Paths menu > Set Paths,
and then choose the desired path to restore from the drop-down list.

Make Path Absolute Gives the complete path of the found asset file. This is
useful when a relative path is displayed and you want to see the entire path.

Make Path Relative to Project Folder This takes the current path of the found
asset file and makes it relative to your project folder on page 6728 .

Resolve Path to UNC Location Resolves highlighted paths that point to
mapped drives to Universal Naming Convention (UNC) format on page 7961
.

Set Project Folder See Set Project Folder on page 6728 .

Configure User Paths Opens the Configure User Paths dialog on page 7520 ,
which you can use to resolve locations for support files such as bitmaps.

NOTE This option makes it simple to share files between different users, even if
you are not using the same project folder. If user A loads a file from user B and
they do not have the same project folder, this will not be a problem.

Preferences Use this submenu to toggle these options:

■ Convert file paths to UNC When on, paths shown in the Asset Tracking
dialog for any added assets present on a mapped drive use Universal
Naming Convention (UNC) format on page 7961 . When off, each path starts
with the mapped drive letter (e.g., w:\).
This switch is linked to the Convert file paths to UNC on page 7542  switch
on the Preferences dialog > Files panel. Toggling either one toggles both.
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NOTE This switch affects only newly added paths. Toggling it has no effect
on existing paths. For example, if you add an asset from a mapped drive with
the switch on, turning it off does not change the path to the mapped version.

■ Convert local file paths to Relative When on, converts the file paths of
all newly added assets in a scene so that they are relative to the project
folder. Default=off.
This switch is linked to the Convert local paths to Relative on page 7543
switch on the Preferences dialog > Files panel. Toggling either one toggles
both.

Proxies menu

The Proxy system lets you determine how 3ds Max should create and use
proxy versions of bitmaps incorporated in materials. Proxies are intended for
use primarily in the viewports when building and editing scenes to reduce
the amount of memory required by the bitmapped textures, but you can also
use them at render time.

Enable Proxy System Toggles the Proxy system globally. When on, 3ds Max
replaces all bitmaps used in materials with proxies as specified on the Bitmap
Proxies dialog on page 6912 . When off, the original bitmaps are used.

Global Settings Opens the Bitmap Proxies dialog on page 6912 .

Set Proxy Resolution Opens the Per-Bitmap version of the Bitmap Proxies
dialog on page 6912  for setting the resolution for proxies of only those bitmap
assets highlighted in the Asset Tracking dialog. Available only when one or
more bitmap assets are highlighted.

Generate Selected/Stale Proxies Generates the proxy image files as specified.
When one or more image assets are highlighted in the Asset Tracking dialog
list, the command is Generate Selected Proxies, and applies only to those
assets. When no asset is highlighted, the command is Generate Stale Proxies,
and applies to all assets whose settings, such as proxy resolution, have changed
since the previous generation, as well as any assets whose proxies are missing.

Options menu

Disable Asset Tracking Turns off asset-tracking functionality. Choosing this
command logs you out of the database and makes most asset-tracking functions
unavailable. To restore asset tracking, turn off Disable Asset Tracking and then
log back in.
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Prompts Opens the Prompts dialog on page 6914 , which lets you toggle two
different options for each of various actions in the Asset Tracking dialog:
actions and prompts.

Auto Login Logs you in to the Vault, if necessary, whenever you cause a
MAX scene file to be present in memory; for example when you load or save
a scene. You can bypass the Vault Log In dialog If you've turned on Options
dialog > “Log in using saved settings” or Vault Log In > “Use these settings
next session.”

Display Excluded Files Displays files that are set to Excluded status. When
off, these files aren't shown in the dialog window. For information about
excluding files, see Filtering Files on page 6898 . You can also set output files
to Excluded status; see following.

Exclude Output Files Sets output files such as rendered images to Excluded
status; you can prevent the dialog from displaying such files by turning off
Display Excluded Files (see preceding).

Tree View Displays a simplified, hierarchical listing of the assets in the
current scene. You can expand and collapse hierarchy branches by clicking
the + and - icons to the left of the branch names.

Table View Displays listing of the assets in the current scene in tabular format
along with the full path and for the local version of each asset. The branches
are hierarchical, but cannot be expanded or collapsed.

Toolbar

Refresh Reloads the asset listing from the local scene and updates the window
contents.

Status Log Opens a read-only window showing all status messages received
from the Vault during the current session.

Tree View Displays a simplified, hierarchical listing of the assets in the
current scene without path or status information. You can expand and collapse
hierarchy branches by clicking the + and - icons to the left of the branch
names.

Table View Displays listing of the assets in the current scene in tabular format
along with the full path and status for the local version of each asset. The
branches are hierarchical, but cannot be expanded or collapsed.
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Folders

[folders] If the system administrator created files folders in Autodesk Vault,
they appear in the Asset Tracking dialog and help you maintain organization
of files.

[library folders] If your system administrator set library folders up in Autodesk
Vault, they appear in the Asset Tracking dialog. The system administrator sets
these folders up on the network and they can act as multiple network
workspaces for a team. Your team can use them to organize different types of
files. For example, you may have a library folder for materials, for maps, for
animations, and so on. Since these library folders are stored on the network,
files that are shared between team members can reside on the network at all
times, rather than on a user's local workspace. Library folders can also be used
to protect files because the system administrator can set up read/write
permissions so that only certain users can make changes to files. See your
system administrator for further details.

NOTE A regular folder looks the same as a library folder from the Asset Tracking
dialog. Different icons distinguish the two types of folders inside Autodesk Vault.

[window]

Left: Asset Tracking dialog window in Tree View

Rightt: Asset Tracking dialog window in Table View

The Asset Tracking dialog window lists all assets in the current scene in a tree
or table view, depending on the current setting. Listed assets include the scene
file, any images used by the scene in materials, etc., XRefs, and photometric
files. By default, output files such as rendered images also appear in the window
listing; you can turn off on page 6910  display of these if you wish.

Also shown are icons for each assets showing the type of asset (3ds Max scene
file, map branch, etc.) and status, as appropriate. Most status icons are
documented in the Vault Explorer Help > Autodesk Vault Explorer Icon
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Reference topic. For a reference to the most common icons, see Asset Tracking
Dialog Icons on page 6916 .

NOTE No status icons appear if you don't have any version-control provider
installed.

In general, status errors can be resolved by being careful to coordinate the
local folder/file structure with that of the Vault, as described in the above
procedure.

You can access most dialog commands by right-clicking an asset in the window;
the commands applicable to the asset are available in the context menu. These
commands are the same as those documented above.

Global Settings and Defaults for Bitmap Proxies
Dialog

Render Scene dialog > Common panel > Common Parameters rollout > Bitmap
Proxies group > Setup

Asset Tracking dialog > Proxies menu > Global Settings

Asset Tracking dialog > Highlight bitmap asset(s). > Proxies menu > Set Proxy
Resolution

Asset Tracking dialog > Right-click a bitmap asset. > Set Proxy Resolution

This dialog lets you determine how 3ds Max should create and use proxy
versions of bitmaps incorporated in materials. Proxies are intended for use
primarily in the viewports when building and editing scenes to reduce the
amount of memory required by the bitmapped textures, but you can also use
them at render time.

NOTE When you open this dialog using either of the Set Proxy Resolution
commands cited at the top of this topic, the title changes to Per-Bitmap Resolution
for Bitmap Proxies, the Enable Proxy System check box changes to Use Global
Settings, and you can set only the proxy resolution on page 6913 .
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Interface

Proxy Resolution group

The label and function of the first check box on the dialog depends on whether
you invoked it with Setup/Global Settings command or Set Proxy Resolution:

■ Enable Proxy System Toggles usage of the proxy system. When off, 3ds
Max uses only the original, full-resolution maps. Available only on the
Global version of the dialog (see note on page 6912 ).

■ Use Global Settings When on, the proxy system applies the same settings
to all bitmaps subject to proxy substitution, as set via the Global version
of the dialog (see note on page 6912 ). When off, use the Downscale Map
... setting (see following) to specify resolution only for bitmaps highlighted
before invoking Set Proxy Resolution. Available only on the Per-Bitmap
version of the dialog.

Downscale map to ... original size. Use the drop-down list to choose the
fraction to which the proxy system reduces the bitmap(s): Full (no reduction),
Half, Third, Quarter, or Eighth. The greater the reduction, the greater the
memory savings and speed improvement, especially in a scene with many
maps, but the less recognizable the map.

Proxy System group

These settings are available only when you open the dialog using the Setup
or Global Settings commands cited at the top of this topic.
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Use proxy only if the original map's largest dimension is greater than ...
pixels. Lets you indicate that bitmaps smaller than the size you specify are
not to be reduced. Downscaling smaller maps isn't particularly efficient or
useful.

To ensure that the system creates proxies for all bitmaps, set this to 0.

Render Mode Lets you determine whether to use the proxies at render time.
The options, available from the drop-down list, are self-descriptive:

■ Render with Proxies (High Performance, Low Memory)

■ Render with Full Resolution Images and Keep them In Memory (High
Performance, High Memory)

■ Render with Full Resolution Images and Free them from Memory (Low
Performance, Low Memory)

Proxy Cache Folder This read-only field displays the path in which 3ds Max
stores proxy bitmap files. To change the path, go to Configure User Paths >
File I/O on page 7524  and edit the BitmapProxies entry.

OK, Generate Proxies Now Generates proxy bitmaps as specified by the
dialog settings and closes the dialog.

OK, Generate Proxies Later Saves the dialog settings and closes the dialog
but does not generate proxy bitmaps. You must generate the proxies manually
using the Generate Selected/Stale Proxies command on page 6909  from the
Asset Tracking dialog.

Cancel Closes the dialog without saving any changed settings.

Prompts Dialog

File menu > Asset Tracking > Asset Tracking dialog > Options menu > Prompts

The Prompts dialog lets you specify what happens when you perform a number
of different functions via the Asset Tracking dialog on page 6897 . For each
message, you can choose an action and toggle the prompt using a right-click
menu. If you turn off the prompt, the option you set on the top part of the
menu takes place automatically.
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Procedures

To set prompts for asset tracking:

1 From the Asset Tracking dialog > Options menu, choose Prompts.

2 Right-click the message to set prompts for.

The right-click menu shows check marks next to the active settings. For
each message, you have two options:

■ Yes/No or Ok/Cancel

■ Prompt/No Prompt

3 Change the options to suit your preferences.

For example, if you know that you always want to keep files checked out
that you add to the vault, set the option “When adding files, keep files
checked out?” to Yes and No Prompt.

The changed settings are saved with the program.
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Asset Tracking Dialog Icons

The Asset Tracking dialog on page 6897  uses a number of icons to indicate the
status of assets listed in the dialog window. The following table lists these
icons and describes their functions:

MeaningIcon

If no icon is displayed, the file is under ver-
sion control, but you do not have a local
copy of the file on your computer.

File is under version control and available
to be checked out. The version in your
working folder is the same as in the
provider. Also referred to as the Latest Ver-
sion.

File is under version control and available
to be checked out, but the local version is
newer than the latest version. This typically
means that your local file was changed
without checking it out.

File is under version control and available
to be checked out, but the local copy is out
of date.

File is checked out to you and the local ver-
sion is the latest.

File is checked out to you and the local copy
is newer than the latest version. This typical-
ly means that you made changes to the file
since it was checked out but have not
checked it back in.
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MeaningIcon

File is checked out by someone else, and
the local copy is the same as on the
provider. Also referred to as the Latest Ver-
sion.

File is checked out to someone else, but the
local copy is newer than the latest version.

File is checked out to someone else, but the
local copy is older than the latest version.

File is checked out by someone else in a
setup where the working folder is shared
and the local copy is the same as on the
provider.

File is checked out by someone else in a
setup where the working folder is shared
on the network, but the local copy is newer
than the latest version.

File is checked out by someone else in a
setup where the working folder is shared
on the network, and the local copy is older
than the latest version.

Status for the file could not be obtained.
This typically means you are not logged into
the provider.

The file is not under version control.
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MeaningIcon

You are not logged in to the provider.

You are logged in to the provider.

Archive

File menu > Archive

Archive creates a compressed archive file or a text file listing the scene bitmaps
and their path names.

3ds Max automatically finds the files referenced in the scene and creates the
archive file in the executables folder. During the archiving process, a log
window is displayed.

Compressed archive files are created using an external program. You specify
the name and location of the archive program on page 7541  you want to use
in the Files tab of the Preferences dialog.

Procedures

To set up an external archive program:

1 Choose Customize > Preferences.

2 Click the Files tab to display the Files panel.

3 In the Archive System group, enter the full path and executable file name,
and any command-line option you want for your external archive program
in the Program field.

To archive a file:

1 Choose File > Archive > Archive.

2 Enter a name for the archive in the File Name field.

Include the appropriate file extension (for example .zip).
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3 Choose a file type: 3ds Max Archive or List Of Files.

■ To create an archive file, choose 3ds Max Archive in the Save As Type
list. The archive file contains the scene plus all bitmaps used for the
scene, including Video Post bitmaps.

■ To create a text file, choose List Of Files (*.txt) in the Save As Type
list. The resulting file is an ASCII list of scene files.

Summary Info

File menu > Summary Info

Summary Info displays statistics about the current scene.

Interface

The Summary Info dialog includes the following information:

Scene Totals Number of objects in your scene listed by type.

Mesh Totals Total number of vertices and faces in the scene.

Memory Usage Physical and virtual memory used and available.

Rendering Time spent rendering the last frame, animation, and video post.
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Description Lets you enter notes about the scene. Information that you add
to the Comments field on the File Properties dialog on page 6920  will appear
in the Description field and vice-versa.

Summary Info Lists materials in the scene. The information is sorted by
category and includes object name, assigned material name, type of material,
object vertex and face counts, and so on. Materials are listed at the bottom of
the list. Bitmaps used by the materials are listed with the materials.
Environmental and atmospheric maps are listed separately. The Other Maps
category lists all other maps used in the scene, such as Displace maps, and
any maps assigned by third-party plug-ins.

Video Post maps are not included.

The buttons at the bottom of the Summary Info dialog have the following
functions:

Save to File Saves the contents of the dialog and descriptive text to a .txt
(text) file.

Plug-In Info Displays a subdialog with information about the plug-ins on
page 7896  used in the scene. By default, the subdialog shows the name and a
brief description of each plug-in.

Show Details Shows information about all of the classes supported by each
plug-in.

Show Used Only Restricts the view to only those plug-ins that have been
used in the scene.

File Properties

File menu > File Properties

File Properties allows you to enter information about a scene that can later be
read by Windows NT 4.0 or later and Windows 98 or later, using a program
such as Windows Explorer to view the properties of the scene file.

This information can also be used to locate scene files with the File Finder
utility on page 6939 .

The Properties dialog comprises three tabs:

■ The Summary panel displays predefined fields that are commonly used.

■ The Contents panel displays scene information available after the scene
had been saved.
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■ The Custom panel enables you to create new fields that can also be used
by the File Finder utility.

Interface

Summary panel

Summary provides fields for entering information related to the saved scene.
Many commonly used fields are available from the Summary tab. If there is
a field you would like that is not represented in the Summary tab you can use
the Custom tab to define new fields for information.

Title Enter the title of your scene or animation here.
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Subject Enter the subject of your scene or animation here.

Author Enter the author of your scene or animation here.

Manager Enter the manager of your scene or animation here.

Company Enter the name of your company here.

Category Enter the category of your scene or animation here.

Keywords Enter keywords that identify your scene here.

Comments Enter personal comments here. Information that you add to the
Description field on the Summary Info dialog on page 6919  will appear in the
Comments field and vice-versa.

Contents panel

When a scene is saved, a summary list of everything contained in the scene
is generated and displayed in the Contents tab. If a scene has not been saved,
the Contents tab remains empty.

NOTE There is currently a bug in Windows NT 4.0 that causes the information in
the Contents tab to look garbled when you view a MAX file in Windows Explorer.
The problem has been corrected in Windows 98. Although the information looks
garbled, it is internally correct and the File Finder utility can still read it.

Custom panel

The Custom panel lets you create custom fields. Custom is useful when there
is more information that needs to be entered into the properties of a scene
but there is no field or no room in the Summary panel.

Name Enter the name of a custom field. You can manually enter anything
you want into the Name field. A drop-down list provides commonly used field
types.

Type Specifies the type of information to be entered into the Value field:
choose from Text, Date, Number, and Yes or No. This dictates the type of
information to be entered into the Value field.

Value Enter the data here.

Add Adds the Custom properties entered into the Name, Type, and Value
fields to the Properties list.

Delete Removes a selected Custom property from the Properties list.

Properties Displays all Custom properties entered into the scene.
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View Image File

File menu > View Image File

Choose and view still images, numbered image sequences, images in an IFL
file on page 7131 , or animation files using options in the View File dialog. Still
images and numbered image sequences appear in the rendered frame window
on page 5885 .

If you choose an IFL file in the file dialog, the Info button displays the contents
of the text file in Windows Notepad.

You can zoom in and out and pan the image, even while a scene is rendering.
If you have a wheel mouse, you can use its third-button/wheel to zoom and
pan. See the following procedures.

If you choose an animation file ( AVI on page 7118  or QuickTime MOV on
page 7140 ), the software starts the Windows Media Player so that you can play
it. The Media Player has its own Help system.

Procedures

To view a file:

1 Choose File > View Image File.

2 Choose a file type from the Files of Type list.

3 Choose a file to view.

NOTE The View File dialog uses the last location where a file was chosen,
rather than the default Images path defined on the Configure User Paths
dialog.

To zoom in the rendered frame window:

■ Press Ctrl and click.

To zoom out in the rendered frame window:

■ Press Ctrl and right-click.

To pan the rendered frame window:

■ Press Shift and drag.
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To use a wheel mouse to zoom and pan:

1 Roll the wheel to zoom in or out.

2 To pan, while zoomed in, press the wheel button and drag. (You can use
any third-button device to pan the image.)

NOTE You must select the Pan/Zoom option on page 7541  in the Preferences
dialog > Viewports page > Mouse Control group in order to use the third
button for panning and zooming.

Interface
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History Whenever an image is selected, the path used is added to the top of
the history list as the most recently used path.

File selections from other areas of the interface, such as Views > Viewport
Background, are stored here also. The history information is saved in the
3dsmax.ini on page 51  file.

Look In Browses drives and directories.

File Name Displays the name of the selected file.

Files of type Selects the type of files to list in the directory window.

Devices Lets you choose the hardware output device, for example, a digital
video recorder. To use the output device, the device, along with its driver, and
its plug-in must all be installed on your system.

Setup This is unavailable in View Image File.

This option is available only in file dialogs like the Render Output File dialog
or the Viewport Background dialog. Displays a dialog to specify image attributes
for saved files or, in the Select Background Image dialog, the arguments for
creating an IFL file.

Info Displays image information.

View View the selected image or animation.

Gamma group

Selects the type of gamma to be used for the selected file. Available only when
Enable Gamma Selection is turned on in the Gamma panel on page 7550 .

Use Image’s Own Gamma Uses the gamma of the incoming bitmap.

Use System Default Gamma Ignores the image’s own gamma and uses the
system default gamma instead, as set in the Gamma panel on page 7550 .

Override Defines a new gamma for the bitmap that is neither the image’s
own, nor the system default.

Sequence This is unavailable in View Image File. This option is available in
the Views > Viewport Background > Files > Select Background Image dialog
on page 97 . It is used in conjunction with Setup to create IFL files.

Preview Toggle the image preview display.

Preview Window Displays the selected image.

Displays file statistics and the file's full directory path.
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Exit

File menu > Exit

Exit closes 3ds Max. If you have unsaved work, you'll be asked if you want to
save it.

Procedures

To exit the program:

1 Choose File > Exit.

2 Click the Yes, No, or Cancel button.

If you click Yes the scene is saved, if you click No the scene is not saved,
if you click Cancel the Exit operation is canceled.

NOTE You can also click the Close button (the X) in the upper-right corner
of the 3ds Max window to exit.

Missing External Files Dialog

This dialog appears when you attempt to open or render a scene with bitmaps
on page 7730  or photometric files ( IES on page 5017 , CIBSE on page 7739 , LTLI
on page 7833 ) whose path is no longer current. This can happen if the bitmaps
have been moved or deleted, or if the scene has been placed on a system with
a different drive mapping than the system on which it was created.

See also:

■ External Path Configuration on page 7526

■ Bitmap / Photometric Path Editor Dialog on page 6953

Interface

Two slightly different versions of the dialog exist: One appears when you load
a scene that references missing files, and the other appears when you attempt
to render such a scene.
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Top: This dialog appears at load time.

Bottom: This dialog appears at render time.

Top: This dialog appears at load time.

Bottom: This dialog appears at render time.

List of external files Lists the bitmaps or photometric files that cannot be
located, along with their path names.

Continue Opens or renders the file anyway, without loading the missing
bitmaps or photometric files.
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If you continue rendering the scene, the bitmaps do not appear, or the lights
assigned missing photometric files will render using the default isotropic
distribution.

Cancel Cancels the render. This button appears only at render time.

Browse Displays a Configure External File  Paths dialog, to let you add the
missing files' paths to the search sequence. This dialog has the same controls
as the Configure User Paths dialog > Configure External Files Paths panel on
page 7526  .

Don't Display This Message at Render Time Appears only when loading a
scene with missing files. When on, the program does not display this dialog
if you render the scene without resolving the missing files.

Don't Display This Message Appears only at render time. When on, the
software does not display the dialog the next time external files cannot be
found.

File-Handling Utilities

Asset Browser Utility

Utilities panel > Utilities rollout > Asset Browser button

The Asset Browser provides access from your desktop to design content on
the World Wide Web. From within the Browser you can browse the Internet
for texture samples and product models. This includes bitmap textures (BMP,
JPG, GIF, TIF, and TGA), or geometry files (MAX, DWG, and so on). You can
drag these samples and models into your scene for immediate visualization
and presentation. You can use the Ctrl key to drag geometry into predefined
locations. You can also use the Asset Browser to browse thumbnail displays
of bitmap textures and geometry files on your hard disk or shared network
drives. Then you can either view them or drag them into your scene or into
valid map buttons or slots.

NOTE The thumbnail display of a geometry file is a bitmap representation of a
view of the geometry. Since the thumbnail display is not a vector-based
representation, you can't rotate it or perform zooms on it.

You can drag most graphic images that are embedded in a Web page into your
scene. The exception is images or regions of a Web page that are tagged as
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hyperlinks or other HTML controls (such as when a bitmap is tagged as a
button with hypertext links).

IMPORTANT Downloaded content might be subject to use restrictions or license
of site owner. User is responsible for obtaining all content license rights.

Drag and Drop

You can assign files represented by the thumbnail images by dragging the
thumbnails over various parts of the Asset Browser or the 3ds Max user
interface. There are three basic methods of using drag in the Asset Browser :

Local Drag and Drop: You can drag thumbnails to the directory tree, and you
can copy or move files from one directory to another. As the default, when
you drag to a folder within the same partition or device, you perform a move.
If you drag beyond the current partition or device (to another drive, for
example), you perform a copy. If you hold down the Ctrl key, you perform a
copy regardless of the destination. If you hold down the Shift key, you perform
a move. You can manipulate bitmap and scene thumbnails in this way.

Bitmap Drag and Drop: You can drag the thumbnails that represent bitmap
files to any bitmap or map slot in the interface or onto any object in a viewport.
You can also drag the thumbnails into the viewport background. When you
drag a bitmap onto an object, the program creates a new standard material
with the bitmap as the diffuse map and assigns the material to that object.

Scene Drag and Drop: You can drag the thumbnails representing .max scene
files directly over an active viewport to merge the scene with the current scene.
When you drag the thumbnail over the active viewport and release the mouse,
the objects in the file appear attached to the mouse. Place them where you
want them, and then click the mouse. Choose from the menu whether you
want to open the file, merge the file to the current scene, or XRef the file. To
cancel, you can select from the menu, or right-click. If you hold down the
Ctrl key, and drag the thumbnail over the active viewport, when you release
the mouse button the objects in the dragged file will snap into their old
location in their original file.

TIP When you drop scene files into your current scene, you can use AutoGrid on
page 2513  to position the geometry file on an object.
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Procedures

To drag scene files from the World Wide Web:

1 In the Address bar, enter the URL of the scene files on the World Wide
Web.

2 Select the thumbnail of the scene file with your mouse and drag it over
the active viewport.

The Internet Download dialog on page 6950  appears.

3 If you want objects placed in the viewport automatically, then in the
Options group, turn off Place Objects When Download Completes.

4 If you skipped step 3 (that is, if Place Objects When Download Completes
is still on), then when you release the mouse, the objects in the file appear
attached to the mouse. Place them where you want them, and then click
the mouse. Choose from the menu whether you want to open the file,
merge the file to the current scene, or XRef the file. To cancel, you can
select from the menu, or right-click. If you hold down the Ctrl key when
you drag the thumbnail, the objects in the file are placed at the world
space origin of the current scene.

To drag thumbnails to the directory tree:

1 In the Asset Browser directory tree, make sure the place you want to copy
or move the thumbnail to is visible.

2 Select the thumbnail with your mouse and drag it to the directory tree
destination.

3 As a default, if you drag to a folder within the same partition or device,
a move is performed. If you drag beyond the current partition or device
(to another drive, for example), a copy is performed. If you hold the Ctrl
key down, a copy is performed, regardless of the destination. If you hold
the Shift key down, a move is performed.

To drag bitmaps onto a map slot in the Material Editor:

1 Open the Material Editor and click the Maps rollout.

2 Open the Asset Browser and select the thumbnail of a bitmap with your
mouse.

3 Drag the thumbnail to the map button of your choice on the Material
Editor Maps rollout.
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This assigns the bitmap as a map type for use in the Material Editor.

To drag a bitmap onto an object in a viewport:

1 Select a thumbnail of the bitmap with your mouse and drag it onto an
object in a viewport.

NOTE If you miss the object, the bitmap becomes the viewport background
image.

The Bitmap Viewport Drop dialog is displayed:

A viewport background Puts the bitmap into the viewport as a
background.

An environment map Includes the bitmap when you render the
viewport.

2 A new standard material is created. The bitmap is assigned to its diffuse
component, and the new material is applied to that object.

To drag scene files from a local or shared disk:

1 From the Asset Browser's menu bar, choose Filter and then a geometry
filter such as All Geometry, Importable Files, or 3ds Max Files.

2 Select the thumbnail of the geometry file with your mouse and drag it
over a viewport.
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3 When you drag the thumbnail over the active viewport and release the
mouse, the merged objects appear attached to the mouse. Place them
where you want them, and then click the mouse. Choose from the menu
whether you want to open the file, merge the file to the current scene,
or XRef the file. To cancel, you can select from the menu, or right-click.
If you hold down the Ctrl key when you drag the thumbnail, the objects
in the file are placed at the world space origin of the current scene.

Interface

When you first start the Asset Browser, a window appears displaying the home
page that is installed locally on your computer system.

NOTE You can't change the home page on page 6936  for the Asset Browser.

Each subsequent time that you start the Asset Browser, it displays what was
displayed last in the previous Asset Browser session.

The Asset Browser window contains:

■ A menu bar on page 6932 .

■ A toolbar on page 6936 .

■ An address bar on page 6937 .

■ A pane on the left displaying your computer system's directory hierarchy.

■ A pane on the right displaying a Web page, thumbnails, or an Explorer
view of file names.

At the bottom of the window, there is also a tabbed favorites bar on page 6937
(by default, it first contains a Startup button) and a status bar on page 6935 .

Asset Browser menu bar

Contains the menus for the Asset Browser.

File menu

Contains commands for managing files.

Preferences Displays the Preferences dialog on page 6948 , with which you
can manage the cache directory and control drag-and-drop operations.

Properties Displays information about the file of the selected thumbnail.
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Show Image Displays the currently selected bitmap thumbnail in a rendered
frame window on page 5885 . You can also double-click a thumbnail. This does
not work for geometry thumbnails.

Print Prints the page displayed in the Web pane. Print is available only when
a Web page is displayed.

Exit Closes the Asset Browser window.

Filter menu

Filters the display of thumbnails according to the category or file type you
select.

All images Displays thumbnails of all supported bitmap files, such as BMP,
JPG, GIF, TIF, and TGA.

All geometry Displays thumbnails of all supported geometry files, such as
DWG and MAX.

All in cache Displays thumbnails of all images stored in your cache directory.
When turned on, the left pane displaying the directory tree goes away, and
the thumbnails you see might be in various directories. Because the thumbnails
point to the correct directories, you can still use them to access the files and
display or drag them to areas in the 3ds Max user interface.

IMPORTANT If a file has been subsequently renamed, deleted, or moved from
the directory it was in when its thumbnail was first created, then the thumbnail
represents only the thumbnail bitmap itself. If you assign that image to a map slot
in the software, you'll be assigning the thumbnail bitmap rather than the original
image.

All files (*.*) Displays thumbnails for all files.

See the following topics for information on the file types listed on the Filter
menu:

AutoCAD DWG Files on page 7762

IGES Files on page 7812

AVI Animation File on page 7118

BMP Image File on page 7120

Kodak Cineon on page 7120

CWS (Combustion Workspace) Files on page 7121

GIF Image File on page 7126
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Radiance Image File (HDRI) on page 7126

IFL Image File on page 7131

JPEG File on page 7139

PNG Image File on page 7152

Adobe PSD File Reader on page 7153

MOV QuickTime File on page 7140

MPEG Files on page 7140

SGI's Image File Format on page 7161

RLA Image File on page 7156

RPF Image File on page 7159

Targa Image File on page 7162

TIF Image File on page 7164

YUV Image File on page 7166

Thumbnails menu

Sorts and sets the size of the displayed thumbnails.

Create Thumbnails Creates thumbnails for bitmap and geometry files.

Sort by Name Sorts by file names.

Sort by Type Sorts by file extensions.

Sort by Size Sorts by file size.

Sort by Date Sorts by file creation date.

Large (200X200) Sets the size to large (200 by 200 pixels).

Medium (100X100) Sets the size to medium (100 by 100 pixels).

Small (50X50) Sets the size to small (50 by 50 pixels).

Display menu

Controls the display of:

■ The left pane, where the directory tree displays your computer system's
folders.
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■ The right pane, which can display files as thumbnails (a Thumbnail pane),
or Web pages (a Web pane).

■ The Favorites and status bars located at the bottom of the Asset Browser
window.

■ Any available manufacturer data in the Product Information dialog that
appears over the right pane.

Directory Tree Turns the directory tree in the left pane on or off. The
directory tree displays the available directories on your system. You can
navigate and select the directories where you want to view images. When you
select and enter a directory containing valid bitmaps, the Browser displays
their thumbnails in the Thumbnail pane to the right. Right-clicking in the
directory tree pane displays a menu allowing you to change directories, delete
directories, and add a directory to your Favorites list.

TIP To refresh the contents of the directory tree, press Shift+F5.

Favorites Bar Turns the Favorites bar on or off. The Favorites bar is located
at the bottom of the Asset Browser window.

Status Bar Turns the status bar on or off. The status bar is located at the
bottom of the Asset Browser window.

Thumbnail Pane Displays valid bitmaps and geometry files of a selected
directory as thumbnails in the right pane.

Thumbnail bitmaps for MAXScript files (.ms, .mcr, and .mse), dropScript files
(.ds), and zipped script files (.mzp) display in the Thumbnail pane. By
right-clicking the thumbnail, you can view the file, look at its properties, run
the script, or open it in the Web Pane. By double-clicking the thumbnails for
.ms, .mcr, and .ds files, you can open them in the MAXScript editor window.
Double-clicking .mzp files will open them in the associated zip utility.

Explorer Pane Displays valid bitmaps and geometry files of a selected
directory as file name icons in the right pane. This is similar to how Windows
displays file name icons in the Explorer.

Web Pane If there's a file named maxindex.htm  in the selected directory,
the program displays it as a Web page in the right pane. You can use the .htm
file to display selected bitmaps as a Web page. Also if you enter a URL in the
address bar, the program displays the page in this pane.
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Favorites menu

Adds and deletes Web sites and path names to the Favorites menu and the
Favorites bar.

Add to Favorites Displays the Favorite Location dialog on page 6952 .

Delete All Favorites Removes all Web site and path name shortcuts from the
Favorites menu and the Favorites bar.

Browse menu

Allows you to refresh thumbnails and Web pages, to move forward and
backward between recently viewed Web pages, to return to your home page,
and to stop loading a Web page.

Refresh For a Thumbnail pane, rereads the directory and redraws the
thumbnails. For a Web pane, rereads the URL and redisplays the Web page.

Forward For a Web pane, displays a Web page you viewed before clicking
the Back button.

Back Returns to the last Web page viewed in the Web pane.

Home Returns to the local copy of the home page that is installed on your
computer system. This is the page that displays when you first start the Asset
Browser.

Stop Stops loading a Web page. Use this button when a page you're trying
to view takes too long to load.

Toolbar

The buttons on the toolbar provide some of the same functions as the menu
items on the menu bar.

Back to previous page Returns to the last Web page viewed in the Web
pane.

Forward to next page Displays a Web page you viewed before clicking
Back to previous page.

Stop Stops loading a Web page. Use this button when a page you're
trying to view takes too long to load.
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Refresh content For a Thumbnail pane, rereads the directory and
redraws the thumbnails. For a Web pane, rereads the URL and redisplays the
Web page.

Homepage Returns to local copy of the Browser home page that is
installed on your computer system. This is the page that displays when you
first start the Asset Browser.

Add to Favorites Bar Displays the Favorite Location dialog that allows
you to add Web sites and path names to the Favorites menu and the Favorites
bar. When you want to open that page or view the files from a path name,
you can click the appropriate shortcut button from the Favorites bar, or click
the appropriate menu item from the Favorites menu

Address Displays the current path name or URL. Clicking the history arrow
at the right end of the address bar displays a list of recently viewed sites. You
can select one of these to return to that site.

Favorites Bar

The Favorites bar is at the bottom of the Asset Browser window. It displays
tabbed buttons for the startup page and for any shortcuts to directories and
Web pages that you added to your favorites list. Right-clicking over a favorites
tab that you've added displays a menu that you can use to modify on page
6952  or delete the favorites.

Startup Returns to the directory or Web page where the Asset Browser started
in the current session.

Status Bar

The status bar is under the Favorites bar at the bottom of the Asset Browser
window. The bar is divided into three sections. The first section displays a
progress meter when the program loads thumbnails. The second section
displays the current filter selection (such as "All in cache"). The third section
displays messages, file names, or Web page shortcut labels when you move
your cursor over such items.
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Bitmap/Photometric Path Editor Utility

Utilities panel > Utilities rollout > More button > Utilities dialog >
Bitmap/Photometric Path Editor

The Bitmap/Photometric Path Editor lets you change or remove the paths of
bitmaps on page 7730  and photometric distribution files (IES) used in the scene.
It also lets you see which objects use a resource in question.

By default, 3ds Max stores a path with the name of the files it references. This
can be a problem when you share scenes among different users. Another user
might have the same scene and resources, in the same directory structure, but
on a different disk drive; this will cause the scene to "lose" the resources.

Removing paths from resource references eliminates this problem. When paths
are not saved with the resource file, they are searched for in these directories:

1 The directory of the current scene.

2 The paths listed in the External Files panel on page 7526 , starting at the
top of the list.

Removing paths from bitmap and photometric references can be useful for
network rendering on page 6231  as well.

See also:

■ Asset Browser Utility on page 6928

■ Configure Paths on page 7519

■ Resource Collector Utility on page 6942
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Interface

Edit Resources Click to display the Bitmap/Photometric Path Editor dialog
on page 6953 . Most of this utility's functionality is provided by this dialog.

Include Materials Editor When on, the Bitmap Path Editor dialog shows
materials in the Material Editor, as well as those assigned to objects in the
scene. Default=on.

Include Material Library When on, the Bitmap Path Editor dialog shows
materials in the current material library, as well as those assigned to objects
in the scene. Default=off.

Close Click to close this utility.

MAX File Finder Utility

Utilities panel > Utilities rollout > More button > Utilities dialog >MAX File
Finder

Run maxfind.exe in the 3ds Max root directory.

The MAX File Finder utility lets you search for MAX files containing specific
properties, for example:

■ Search the hard drive for all MAX files containing the "Pink Carpet"
material.

■ Search the 3ds Max program directory and below for all MAX files using
the raymtl.dlt plug-in.
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■ Search the c:\Program Files\Autodesk\VIZ2008 directory and below for all
MAX files using the raymtl.dlt plug-in.

The utility comes in two formats: a standard utility, and a standalone
executable. Both work identically.

File Finder demonstrates how to read a MAX file's properties from an external
application. These properties include predetermined data such as object and
plug-in names, plus information you provide via the File menu > Properties
dialog. You can also view this data from outside the software with Windows
Explorer or an equivalent program by viewing a file's properties.

TIP You can combine this tool with the powers of the Properties dialogs. If you
have a team of animators, you can have the individual animators use the File menu
> Properties dialog to create Categories, Keywords and Comments that you can
search for using the File Finder. They can also use the Contents and Custom Tabs
as well. All are searchable using the Finder.

You can also create similar structures at the Object level. The Object Properties
dialog on page 245  has a User Defined tab to enter any properties you like,
and use that to organize your projects.
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Interface

File menu

Reset Clears the list box of any files previously found.

Exit Exits the application

Help menu

About Displays something fun to play with while Finder is searching for
files. The search continues in the background while this dialog is active.
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Program window

Search Text Specifies the text to search for. If you leave the field empty, all
files that contain the specified property will be found.

File Spec Specifies which file types to search through. The predefined file
type is *.max. You can enter a different file type, such as *.dwg. To search
through all files, use *.*.

The currently selected item in this list is restored the next time you run Finder.

Property Specifies the property you want to search for. Use All to search for
any property.

Start Activates the search. During a search, the button title switches to
Cancel. Click Cancel to abort the search.

Browse Specifies the directory for the search, using the standard Windows
Browse for Folder dialog.

Include Subfolders When on, Finder searches the current directory and all
subdirectories. When off, only the current directory is searched.

File List Lists all files that were found and match the current search criteria.

Double-click a found file in this list to display the property viewer for the file.
The information presented in this dialog is the same that is displayed with
File menu > Properties inside the software. Use the << and >> buttons to step
to the previous or the next file in the found list.

While in the property viewer, the search continues in the background.

Resource Collector Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Resource
Collector

The Resource Collector gathers the resource files used by a scene ( bitmaps on
page 7730 , photometric distribution files (IES), and optionally, the scene itself
into a single directory.

WARNING The Resource Collector does not collect maps used for displacement
mapping or as light projections.

See also:

■ Bitmap/Photometric Path Editor Utility on page 6938
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Interface

Output Path Displays the current output path. This can be changed using
the Browse button.

Browse Click to display a Windows file dialog that lets you choose the output
path.

Resource Options group

Collect Bitmaps/Photometric Files When on, the Resource Collector places
the scene's bitmaps, and photometric files, in the output directory. Default=on.

Include MAX File When on, the Resource Collector places the scene itself
(the .max file) in the output directory. Default=off.

Compress Files When on, compresses the files into a ZIP file, saved in the
output directory. Default=off.
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Copy or Move Choose Copy to make a copy of the files in the output
directory. Choose Move to move the files (they are deleted from the directory
in which they originally were saved). Default=Copy.

Update Materials When on, updates material paths. Default=off.

Begin Click to collect the resource files according to the settings above this
button.

Fix Ambient Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Fix Ambient

The Fix Ambient utility solves a compatibility problem that sometimes occurs
when you use 3ds Max to open files from earlier versions of 3ds Max or
Autodesk VIZ .

In 3ds Max, the ambient on page 7710  and diffuse on page 7759  color channels
are locked for standard materials. However, this was not always the case with
earlier versions of 3ds Max and Autodesk VIZ . As a result, files might render
differently than expected.

The Fix Ambient utility looks for standard materials in the current scene whose
ambient and diffuse colors are different, presenting you with the option to
copy the diffuse color to the ambient color channel. This will ensure that your
renderings are consistent with earlier versions of products.
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Interface

Find All  The utility searches the entire scene for materials with different
ambient and diffuse colors.

Find Selected  The utility searches the current selection for materials with
different ambient and diffuse colors.

Help  Opens the help file to this topic.

Different Ambient and Diffuse Materials

This dialog appears after clicking Find All or Find Selected.
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Status Message  This area displays a message indicating whether your scene
(or selection) has materials with different ambient and diffuse values.
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Material List  Lists all of the materials with different ambient and diffuse
values.

Fix Selected  Locks the ambient and diffuse channel for the materials selected
in the dialog.

Cancel  Closes the dialog without making any changes.

Bitmap Pager Statistics Dialog

Customize menu > Customize User Interface > Category: All Commands or
Render > Action: Bitmap Pager Statistics Toggle > Assign to hotkey, menu, etc.

The Bitmap Pager Statistics dialog provides information to help you resolve
issues with scenes that require large amounts of memory for texture maps. It
is intended for advanced users to debug scenes and help shorten render times.

By default, the dialog is not available in the interface; it must be added as a
hotkey, menu item, or toolbar button via Customize User Interface on page
7489  functionality.

Interface
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The read-only dialog shows statistics in four categories:

■ Memory Usage

■ Number of Pages

■ Activity

■ Memory Limit

Asset Browser Subdialogs

Preferences Dialog (Asset Browser)

Utilities panel > Utilities rollout > Asset Browser button > File menu >
Preferences

Contains the settings with which you can manage the Asset Browser's cache
directory and control drag and drop operations.
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Interface

Cache Directory group

Provides settings and controls for the cache directory.

Browse Displays the Choose Cache Directory dialog where you can specify
a new directory to use for your cache. The adjacent text box displays the path
of the cache directory where the thumbnail images are stored. You can change
the path either by editing the field or choosing a directory from the pane
below the Folders field.

NOTE When you change directories, you're asked if you want to clear the cache
from the previous directory. If you choose to do so, the program erases all
thumbnail files from the cache directory you were using previously.

Delete Files Removes all thumbnail files from your cache directory.

Maximum Disk Space Sets the maximum size of the cache directory. When
you exit Asset Browser, the program selects the size of the cache directory. If
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it's over the maximum size, the program deletes the oldest thumbnail files
until the total size is 50 percent of the Maximum Disk Space setting.

Drag and Drop group

Provides controls for importing or linking files after dragging and dropping
them into a viewport.

Show the merge/import/XREF dialog Displays the merge/import/XREF dialog
after you drop a file into a viewport.

Always merge/import the file Imports the file without prompting for
confirmation after you drop it into a viewport.

Always XREF the file Links the file as an XREF without prompting for
confirmation after you drop it into a viewport.

Ask me each time Displays a popup menu to confirm importing or linking
after you drop a file into a viewport.

Internet Download Dialog

Utilities panel > Utilities rollout > Asset Browser button > Address bar > Enter
URL of geometry files on World Wide Web. > Drag thumbnail over active
viewport.

Menu bar > Tools > Asset Browser > Address bar > Enter URL of geometry files
on World Wide Web. > Drag thumbnail over active viewport.

When you drag geometry files from the World Wide Web using the Asset
Browser, the Internet Download dialog appears. How long this dialog remains
on-screen depends on the size of the file you're downloading.
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Interface

Download Information group

Displays the URL of the download, the pathname of the file being saved, and
a meter indicating the bytes downloaded.

Uniform Resource Locator (URL) Displays the URL and file name that you're
downloading.

Saved as Local File Displays the pathname of the file being saved as a result
of the download.

Options group

Specifies whether or not to place the objects when the download is complete.
If you leave this option selected, 3ds Max allows you to position the mouse
at the location of your choice.
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Favorite Location Dialog

Utilities panel > Utilities rollout > Asset Browser button > Favorites menu >
Add to Favorites

Menu bar > Tools > Asset Browser > Favorites menu > Add to Favorites

The Favorite Location dialog allows you to add Web sites and path names to
the Asset Browser Favorites menu and Favorites bar. When you want to open
that page or view the files from a pathname, you can click the appropriate
shortcut button from the Favorites bar, or click the appropriate menu item
from the Favorites menu.

Interface

Custom Label

The button displays the Load Custom Icon dialog. Use this dialog to select an
icon file to associate with the Web site or path name you're adding to the
Favorites. You must use icon files that have an .ico extension.

The text box adjacent to the button displays the URL of the Web page, or the
path name that you're adding to the Favorites. You can edit this to wording
of your choice. The unedited URL or pathname displays in the label below
the Custom Label group.
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Add to favorites pull down menu When you turn this on, Web site or
path-name shortcuts are added to the Favorites menu. When this box is not
selected, the Web site or path-name shortcuts are added only to the Favorites
bar.

Bitmap Path Editor Subdialogs

Bitmap / Photometric Path Editor Dialog

Utilities panel > Utilities rollout > More button > Utilities dialog >
Bitmap/Photometric Paths > Edit Resources button

This dialog is the main part of the interface to the Bitmap / Photometric Path
Editor utility on page 6938 .

See also:

■ Asset Browser Utility on page 6928

■ Missing Files Dialog on page 6926

■ Resource Collector Utility on page 6942

Procedures

To correct the path name for a missing map:

You must first locate the missing bitmap or photometric files. The Windows
Search program can help you with this.

1 On the Bitmap / Photometric Path Editor dialog, click Select Missing Files.

2 Click to select a single missing file in the list.

If a group of missing files are in the same directory, you can leave all of
them selected.

3 Click Strip Selected Paths.

4 Click Set Path.

5 Enter the correct path in the New Path field, or click the "..." button to
browse to the correct path in a Windows file dialog.
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The Bitmap/Photometric Path Editor updates the selected maps' path to
use the new path.

Interface

List of maps and photometric files Shows all bitmaps and photometric files
( IES on page 5017 , CIBSE on page 7739 , LTLI on page 7833 ) used in the scene,
along with their current path.

When no file is selected in the list, the only controls available in the dialog
are Close, Select Missing Maps, and Strip All Paths.

Close Click to close the dialog.

Info Click to display a Resource Information dialog on page 6955 .

This button is available only when a single file is selected in the list.

Double-clicking a name in the list is another way to display the Resource
Information dialog.

Copy Files Copies the selected files to a directory you choose. This button
displays a Windows file dialog that lets you choose the destination directory.

Select Missing Files Highlights the names of missing files in the list.

Find Files Click to search for the maps or photometric files in the current
selection. This button displays an alert that shows how many files are findable,
how many files are missing.
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Strip Selected Paths Click to strip the path from the selected files. An alert
appears to warn you that the scene will lose this information.

Strip All Paths Click to strip the path from all files in the list. An alert appears
to warn you that the scene will lose this information.

Set Path Click to apply the New Path field to the selected files.

If the New Path field is identical to the selected file or files, clicking Set Path
clears New Path.

New Path Lets you enter a path for the currently selected file or files.
Default=The path of the currently selected file, or none if multiple files with
differing paths are selected.

"..." button (To the right of the New Path field.) Displays a Windows file
dialog to let you browse for a path.

Resource Information Dialog

Utilities panel > Utilities rollout > More button > Utilities dialog >
Bitmap/Photometric Path Editor > Edit Resources button > Select a single
bitmap or photometric file name. > Info button

Utilities panel > Utilities rollout > More button > Utilities dialog >
Bitmap/Photometric Path Editor > Edit Resources button > Double-click a
bitmap or photometric file name.

The Resource Information dialog displays information about where a bitmap
is used in other materials or photometric distribution files and shows an image
of the bitmap.
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Interface

Referenced by Nodes Lists the objects ("nodes") that are assigned materials
that use this bitmap or use a given photometric distribution file on page 4951
.

Close Closes the dialog.

View Bitmap Displays a rendered frame window on page 5885  that shows the
bitmap. This button is unavailable if the file is a photometric file, and it has
no effect if the map is missing.

Internet Access
The Asset Browser on page 49  can locate locally or network-stored materials,
textures, geometry, and other 3D assets that can be easily dragged and dropped
into the 3ds Max workspace. The Browser can also access the Internet to do
the same.

The Asset Browser provides embedded Web browser functionality, so you can
go directly to the Internet to capture 2D and 3D content for use in 3ds Max.
For example, a visit to any of several manufacturers' sites, such as
www.formica.com, can yield flooring, countertop, or other samples in bitmap
form. Provided a site encourages such use of its content (and most do), these
thumbnails can be dragged into 3ds Max with a single mouse movement and
dropped onto objects in a scene for instantaneous "what if" visualizations of
different textures and treatments. They can also be saved for later use.
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2D and 3D geometry can also be captured off the Internet and put to
immediate use in 3ds Max scenes. You can also use the Asset Browser with
topographical maps, detailed aerial and satellite photos, and any design data
in MAX or STL form. In this way, you are assured instant access to the latest
design content, free from leading vendors around the world, without leaving
your desktop.

For Web Content Providers

Any Web page that uses standard HTML source code can easily be enhanced
so that 3ds Max users can access it for content. Making bitmap textures (.BMP,
.JPG, .GIF, .TIF, etc.) available for downloading requires no special HTML
coding, but there are guidelines you should follow for optimum utility to 3ds
Max users. Making geometry files (.max) available to 3ds Max user requires
some simple modifications to your HTML source code.

See also:

■ i-drop Indicator on page 6957

i-drop Indicator

In order to support the World Wide Web as a primary source of product
information, Autodesk has introduced the i-drop™ Indicator. This enables
manufacturers and design professionals to publish and acquire design data
using standard Web pages.

The i-drop Indicator is used to transfer content from the World Wide Web by
means of a drag-and-drop operation. The content can be any type of file (such
as a geometry or a raster file) that the content producer has made available
and that the application will accept.

For example, imagine that you are a lighting designer and require a specific
fixture to embed within your 3ds Max scene. Now imagine that a lighting
company such as ERCO has a Web site containing a library of their fixtures
online. You can browse this library, then drag and drop the appropriate fixture
into your scene. You don't need to download the file and then insert it. Now
you can drag any MAX file from an i-drop-enabled web site and drop its
geometry directly into your Autodesk product.

In addition to geometry, you can drag and drop photometric data, cost
information, materials, and so on.
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An i-drop object in a Web page is an open gateway between the content
provider's server and the Autodesk software user's desktop. Web pages that
contain i-drop objects can be designed to look and behave exactly like standard
Web pages in a standard Web browser. You simply drag the i-drop object from
the provider's Web page and drop it onto a desktop or into an application.

The desktop or application is the i-drop target. The i-drop target requests the
data in one or more specific clipboard formats and receives the content. This
is called being "i-drop aware." i-drop can also deliver data in any of the system
default clipboard formats. What the application gets depends on what
clipboard format it requires. For example, if the user drags to the desktop, the
desktop takes a file. If the user drags to a text editor, the text editor takes
textual data. What the desktop or application takes is independent of i-drop.

For more information, see http://idrop.autodesk.com.

Geometry File Formats
The Import on page 6892  and Export on page 6894  commands on the File menu
on page 7259  let you share 3D geometry with other 3D modeling programs.
The software can import and export a variety of file formats.

3ds Max can also open DRF Files on page 6964 , which are created in VIZ Render,
a rendering tool packaged with AutoCAD Architecture.

See also:

■ Asset Browser Utility on page 6928

■ Internet Access on page 6956

■ i-drop Indicator on page 6957

Compatible File Formats

MAX Files (from Autodesk VIZ) on page 6961

VIZ Render (DRF) Files on page 6964

Importable File Formats

Importing 3DS Files on page 6969

Importing PRJ Files on page 6971
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Importing SHP Files on page 6974

Importing Adobe Illustrator 88 Files on page 6975

Importing AutoCAD Drawing Files on page 6979

Importing DXF Files on page 7006

FBX Files on page 7019

Importing Autodesk Inventor Files on page 7008

Importing IGES Files on page 7023

Importing LandXML/DEM Models on page 7044

Importing Lightscape Files on page 7050

Importing HTR/HTR2 Files on page 7054

Importing TRC Files on page 7056

Importing STL Files on page 7073

Importing VRML Files on page 7082

Wavefront (OBJ, MTL) Files on page 7077

Exportable File Formats

Exporting 3D DWF Files on page 7013

Exporting to 3DS on page 6972

Exporting to Adobe Illustrator on page 6976

Exporting to ASCII on page 6977

Exporting AutoCAD DWG Files on page 7003

Exporting to DXF Files on page 7006

FBX Files on page 7019

Exporting IGES Files on page 7027

JSR-184 Files on page 7030

Exporting Lightscape Files on page 7048

Exporting HTR/HTR2 Files on page 7058

Exporting to Shockwave 3D on page 7061

Exporting to STL on page 7076
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Exporting to VRML97 on page 7083

Exporting Wavefront Object (OBJ) Files on page 7079

Exporting Wavefront Material (MTL) Files on page 7078

Importing Geometry

When you import geometry, using the Import command on the File menu,
in most cases a dialog is displayed that asks whether you want the imported
geometry to be added to the scene, or to replace the scene entirely. For
example:

Merge objects with current scene Merges imported data with the current
scene.

Completely replace current scene Completely replaces the current scene
with the imported data.

In general, once you respond to this dialog, a second dialog with
geometry-specific options is displayed, as described in the topics that follow.
(For some geometry formats, only one dialog appears, and these options are
merged with the geometry-specific options.)
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Working with MAX Files from Autodesk VIZ

Although they share the same file type, 3ds Max files and Autodesk VIZ files
are quite a bit different. This topic describes some of the differences, and
recommends ways to obtain the desired results from your files.

See also:

■ Working with Drawing Files on page 6774

Defaults

3ds Max ships with several market-specific defaults sets. If you are working
on design visualization types of files, you should load the DesignVIZ default
settings. For more information on how to do this, see Market-Specific Defaults
on page 7486 .

Objects

AEC objects (walls, doors, windows, etc.) in an Autodesk VIZ file retain all
their original properties as AEC objects when opened in 3ds Max. Autodesk
VIZ models can also contain File Link created objects that appear as VIZBlocks
or Linked Geometry.

File Linked VIZBlocks in 3ds Max

A VIZBlock is a compound object similar to a nested AutoCAD or Architectural
Desktop block. If a drawing containing nested blocks is file linked to Autodesk
VIZ, the block objects display in the Modify panel as VIZBlocks.

3ds Max recognizes VIZBlocks when you open a MAX file created in Autodesk
VIZ. You can access the sub-object hierarchy, rename sub-object components
and even extract sub-objects of the VIZBlock. You are also allowed to add
modifiers on top of the sub-objects. You cannot attach objects to a VIZBlock
as you could in Autodesk VIZ.
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The VIZBlock user interface on the Modify panel

NOTE VIZBlocks can contain both mesh and spline geometry. This can cause
some confusion when applying modifiers like Edit Mesh. If a spline component is
closed, it will be converted to a mesh with no extrusion. If a spline is not closed,
it will disappear and leave behind stray vertices in the mesh.

VIZBlocks are assigned a special controller called a LinkTM controller. If a
sub-object component is extracted and converted to an Editable Mesh or
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Editable Spline, the LinkTM controller is replaced with a PRS controller.
Likewise, if an entire VIZBlock is converted to an Editable Mesh or Spline, the
LinkTM controller for the node is replaced with a PRS controller.

When using Track View, sub-object components of VIZBlock do not display.
Data pertaining to the LinkTM controller is not displayed, however, you can
access the PRS subcontroller.

While working on VIZBlocks, it is very possible that the you might lose
portions of the original data organization of the scene, for example, when a
sub-object component is extracted from an instanced VIZBlock, the extracted
object is not instanced the same number of times.

File Linked Geometry in 3ds Max

This file linked object type appears in Autodesk VIZ when you use the Entity
Combine-By option or if you extract a component from a VIZBlock. These
objects display in the Modify panel as Linked Geometry. If a linked geometry
object is moved, rotated, or scaled, you can use the Reset Position option.

The Linked Geometry user interface on the Modify panel

3ds Max recognizes Linked Geometry objects when you open a MAX file
created in Autodesk VIZ. Since Linked Geometry objects offer no parameters
on the Modify panel, you have to modify these objects by converting them
to Editable Mesh or Splines or applying modifiers on top of them.
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Linked Geometry objects are also assigned a LinkTM controller. If the object
is converted to an Editable Mesh or Editable Spline, the LinkTM controller is
replaced with a PRS controller.

File Link Reloading

If you plan on working on an Autodesk VIZ scene in 3ds Max, you should
download the latest service pack for the product. The latest service pack
includes functionality that makes 3ds Max more compatible with Autodesk
VIZ.

Materials

In 3ds Max, the ambient on page 7710  and diffuse on page 7759  color channels
are locked for standard materials, however this is not the case in Autodesk
VIZ. As a result, MAX files from Autodesk VIZ may render differently in 3ds
Max.

To solve this issue, use the Fix Ambient utility on page 6944 .

Missing Maps

Many times, when you open a MAX file from Autodesk VIZ , you will be
presented with a Missing External Files dialog on page 6926 . To locate the
missing files, click Browse and then add the appropriate Autodesk VIZ
directories to the Configure External File Paths dialog on page 7526 .

VIZ Render (DRF) Files

DRF is the file format for VIZ Render, a rendering tool included with AutoCAD
Architecture. The DRF file type is similar to MAX files from previous versions
of Autodesk VIZ.

This file format is available only when you use the File menu > Open on page
6718  command. All DRF files must be saved as MAX files in 3ds Max. Likewise,
DRF files cannot be imported or merged into 3ds Max scenes.

NOTE You can open DRF files using drag-and-drop functionality.

Saving DRF Files

DRF files must be saved as MAX files in 3ds Max.
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IMPORTANT Once you save a DRF file in 3ds Max, it becomes a MAX file and
you can no longer open it  in VIZ Render.

Defaults

3ds Max ships with several market-specific defaults sets. If you are working
on design visualization types of files, you should load the DesignVIZ default
settings. For more information on how to do this, see Market-Specific Defaults
on page 7486 .

Units

In VIZ Render, you can only use meters as your system unit. However, 3ds
Max lets you define your own system unit, and how units are displayed. For
more information on units, see Using Units on page 2504  and Units Setup
Dialog on page 7601 .

Missing Maps

Many times, when you open a DRF file, you will be presented with the Missing
External Files dialog on page 6926 . To locate the missing files, add the
appropriate VIZ Render directories to the Configure User Paths dialog >
External Files panel on page 7526 .

Handling Linked Geometry in 3ds Max

Linked objects show up as Linked Geometry objects on the Modify panel.
These objects don't allow access to sub-object levels where minor editing can
occur. If a linked geometry object is moved, rotated or scaled you do have the
option to Reset Position.
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Linked Geometry user interface on the Modify panel.

3ds Max recognizes Linked Geometry objects when you open a MAX file
created in VIZ Render. Since linked geometry objects offer no parameters on
the Modify panel, you must first add an Edit Mesh modifier to the object or
collapse the linked geometry object to an Editable Mesh in order to access
sub-object levels. If you add a modifier to linked geometry, the modifier is
applied to all instances of that object.

Linked Geometry objects are assigned a special LinkTM controller. If a the
object is converted to an Editable Mesh, Poly, NURBS or Editable Spline, the
LinkTM controller is replaced with a PRS controller.

Substituted Objects

There is no substitution modifier in 3ds Max. However, if you open a DRF file
with substituted objects, 3ds Max will recognize the substitutions and will
add the substituted objects into the scene.

User Interface Changes

Some of the user interface elements in 3ds Max are not where you would
expect them if you are coming from VIZ Render. For example, the viewport
controls on page 7366  are in the bottom-right corner, instead of the top-left.

For more information on the user interface, see User Interface on page 7251 .
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Render Presets

The Render Presets in 3ds Max are very different from the presets in VIZ Render.
For more information on using them, see Preset Rendering Options on page
5922 .

Working with DRF Files in 3ds Max

Saving DRF Files

DRF files must be saved as MAX files in 3ds Max.

IMPORTANT Once you save a DRF file in 3ds Max, it becomes a MAX file and
you can no longer open it in VIZ Render.

Defaults

3ds Max ships with several market-specific defaults sets. If you are working
on design visualization types of files, you should load the DesignVIZ default
settings. For more information on how to do this, see Market-Specific Defaults
on page 7486 .

Units

In VIZ Render, you can only use meters as your system unit. However, 3ds
Max lets you define your own system unit, and how units are displayed. For
more information on units, see Using Units on page 2504  and Units Setup
Dialog on page 7601 .

Missing Maps

Many times, when you open a DRF file, you will be presented with the Missing
External Files dialog on page 6926 . To locate the missing files, add the
appropriate VIZ Render directories to the Configure User Paths dialog >
External Files panel on page 7526 .

Handling Linked Geometry in 3ds Max

Linked objects show up as Linked Geometry objects on the Modify panel.
These objects don't allow access to sub-object levels where minor editing can
occur. If a linked geometry object is moved, rotated or scaled you do have the
option to Reset Position.
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Linked Geometry user interface on the Modify panel.

3ds Max recognizes Linked Geometry objects when you open a MAX file
created in VIZ Render. Since linked geometry objects offer no parameters on
the Modify panel, you must first add an Edit Mesh modifier to the object or
collapse the linked geometry object to an Editable Mesh in order to access
sub-object levels. If you add a modifier to linked geometry, the modifier is
applied to all instances of that object.

Linked Geometry objects are assigned a special LinkTM controller. If a the
object is converted to an Editable Mesh, Poly, NURBS or Editable Spline, the
LinkTM controller is replaced with a PRS controller.

Substituted Objects

There is no substitution modifier in 3ds Max. However, if you open a DRF file
with substituted objects, 3ds Max will recognize the substitutions and will
add the substituted objects into the scene.

User Interface Changes

Some of the user interface elements in 3ds Max are not where you would
expect them if you are coming from VIZ Render. For example, the viewport
controls on page 7366  are in the bottom-right corner, instead of the top-left.

For more information on the user interface, see User Interface on page 7251 .

6968 | Chapter 21   Managing Scenes and Projects



Render Presets

The Render Presets in 3ds Max are very different from the presets in VIZ Render.
For more information on using them, see Preset Rendering Options on page
5922 .

3D Studio Mesh (3DS, PRJ) Files

Importing 3DS Files

File menu > Import > Select File To Import dialog > Files Of Type > 3D Studio
(*.3DS)

3DS is the 3D Studio® (DOS) mesh-file format. You can import 3DS files into
3ds Max.

When you import a 3DS file, you can merge the imported objects with the
current scene or replace the current scene completely. If you choose to merge
the objects with the current scene, you are asked whether you want to reset
the length of the animation in the scene to the length of the imported file (if
the imported file contains animation).

When you import a 3DS file, the following information is imported:

■ Backgrounds (solid, gradient, and bitmap).

■ Fog, Layered Fog, and Distance Cue.

■ Ambient light level.

■ Subtractive transparency is converted to 3ds Max "Filter" transparency and
the filter color is set equal to the diffuse color.

■ Transparency falloff settings.

■ All map channels that are enabled. Map channels that are turned off in
the 3DS file do not import into 3ds Max.

■ All map parameters, including UV transforms, Negative, Mirror, and
Rotation. Some Map parameters such as Blur, Luma, RGB, and Alpha work
much differently in 3ds Max. These values are converted to new values
that produce a similar affect.

■ Mask bitmaps are imported as 3ds Max mask textures.

3D Studio Mesh (3DS, PRJ) Files | 6969



■ When materials with both Texture 1 and Texture 2 are imported, a
composite texture is created and added to the Standard material's Diffuse
channel.

■ Reflection maps, auto-cubics, and mirrors.

■ Automatic reflection map Nth frame and Map Size settings.

■ SXP translation for Marble and Noise materials.

■ 3DS/DOS R4 IK joint parameters.

■ 3D Surfer patch data.

When you import a PRJ file, all of the above items are imported, plus shapes.

When you import a 3DS file, the following information is not imported:

■ Morph keys.

■ Keyframer instances.

■ Map channels that are turned off.

■ Custom .cub-format cubic maps.

■ Decal transparency using the RGB color of the upper-left pixel of the map.

Interface
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Merge objects with current scene Merges imported data with the current
scene.

Completely replace current scene Completely replaces the current scene
with the imported data.

Convert units When turned on, the software assumes units in the imported
file to be in inches, and converts them to the current system of units. When
turned off, the software assumes the units in the imported file match the
current scene unit and doesn't convert the units.

Importing PRJ Files

File menu > Import > Select File To Import dialog > Files Of Type > 3D Studio
Project (*.3DS,*.PRJ)

PRJ is the 3D Studio (DOS) project-file format.

When you import a PRJ file, you can merge the imported objects with the
current scene or replace the current scene completely. If you choose to merge
the objects with the current scene, you'll be asked whether you want to reset
the length of the animation in the scene to the length of the imported file (if
the imported file contains animation).

You'll also be asked how you want the software to handle shapes on page 7929
in the incoming file: to make them into a single object or multiple objects.

Interface

When you import a PRJ file, you first see a 3DS Import dialog on page 6969 .
This is identical to the dialog you see when you import a 3DS file. When you
have set the options and clicked OK in the 3DS Import dialog, you then see
a Shape Import dialog.
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When importing PRJ files, the software converts polygons to shape objects.
You choose an option in the Shape Import dialog to set how the shape objects
are created:

Import Shapes Turn on this option if you don't want to import shapes from
a .prj file.

Single Object All polygons in the .prj file are converted to Bezier splines and
placed inside a single composite shape object.

Multiple Objects Each polygon in the .prj file is converted to a Bezier spline
and placed inside an independent shape object.

Exporting to 3DS

File menu > Export > Select File To Export dialog > Save As Type > 3D Studio
(*.3DS)

3DS is the 3D Studio (DOS) mesh file format. You can export 3ds Max files to
this format.

When you export a 3DS file, the following information is exported:

■ Position, Rotation and Scale animation. If the controller is a TCB controller,
the TCB, Ease In, and Ease Out values are also saved. If the controller is
any other type of key controller, the keys are saved but the tangent
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information is lost. If the controller is not a key controller, only the object's
transformation at frame 0 is saved.

■ Basic material color/parameters from the Standard material.

■ Single maps with their amount, offsets, scales, etc.

■ Auto-cubics and Mirrors.

■ Target cameras, target spotlights and omni lights.

■ Most "static" parameters for cameras and lights, and animation tracks for
Roll, Falloff, Hotspot, and FOV.

When you export a 3DS file, the following information is not exported:

■ Composite and procedural maps.

■ Grouped object transformations. There's no concept of group hierarchy
in the 3D Editor. Groups export to the Keyframer because the Keyframer
understands hierarchies.

■ Global shadow parameters.

When you export a 3DS file, the following occur:

■ All non-mesh geometry, such as procedural primitives and patches, is
collapsed to meshes before export.

■ Objects are exported as they exist on the frame 3ds Max displays at export
time.
If you want to output morph targets, go to each frame and export the
target to a different file name.

■ Meshes are saved with edge display information and smoothing groups.

■ 3ds Max instances are saved as Keyframe instances.

■ Modifier and morph animation is frozen at the current frame, collapsed,
and exported as a simple mesh.
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Interface

When you choose 3DS as the export file format, enter a file name, and click
Save, an Export Scene To .3DS File dialog is displayed. This dialog has a single
option:

Preserve MAX's Texture Coordinates When on, preserves mapping
coordinates. When off, mapping information is discarded. Default=on.

Importing SHP Files

File menu > Import > Select File To Import dialog > Files Of Type > 3D Studio
Shape (*.SHP)

SHP is the 3D Studio (DOS) shape file format. You can import these files into
3ds Max.

A .shp file contains polygons created in the 2D Shaper in 3D Studio.

When importing an SHP file that contains multiple shapes, the software gives
you the option to either merge them all into one object or make multiple
incoming objects.

The shape importer looks at the vectors on incoming splines, and if they're
collinear within a couple of percentage points, it changes the angle to a
smoothed Bezier (otherwise, it's a Bezier corner).

Interface

When you import an SHP file, you first see a 3DS Import dialog on page 6969
. This is identical to the dialog you see when you import a 3DS file. When you
have set the options and clicked OK in the 3DS Import dialog, you then see
a Shape Import dialog.
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Import Shapes When on, imports the shape objects. When off, does not
import them. Default=on.

Import Shapes As group

Single Object (The default.) When chosen, imports all shapes in the SHP
file as a single editable spline object on page 590 .

Multiple Objects When chosen, imports each shape in the SHP file as an
individual editable spline object.

Importing Adobe Illustrator 88 Files

File menu > Import > Select File To Import dialog > Files Of Type > Adobe
Illustrator (*.AI)

You can import Adobe Illustrator (AI88) files into 3ds Max.
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Interface

When importing AI88 files, the software converts polygons to shape objects.
You choose an option in the Shape Import dialog to set how the shape objects
are created:

Single Object All polygons in the .ai file are converted to Bezier splines and
placed inside a single composite shape object.

Multiple Objects Each polygon in the .ai file is converted to a Bezier spline
and placed inside an independent shape object.

Exporting to Adobe Illustrator

File menu > Export > Select File To Export dialog > Save As Type > Adobe
Illustrator (*.AI)

You can export shapes that can be converted to Bezier splines on page 7726 .
The software exports these shapes in 2D only. It uses only the X and Y
coordinates of the shape's local coordinate system, discarding the Z coordinates.

Procedures

To export a file to Adobe Illustrator:

1 Select one or more shape objects.

2 Choose File menu > Export.
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3 Select Adobe Illustrator (*.AI) as the file format.

4 Enter a file name, and click Save.

Exporting to ASCII

File menu > Export > ASCII Scene Export (*.ASE)

When you choose ASCII Scene Export (*.ase) as the Save As type, the exported
file is an ASCII representation of your scene. A dialog lets you specify which
scene components are included, and how they're output. This is helpful if you
are writing a program that requires you to parse the ASCII file.

Interface

Output Options group

Provides check boxes to specify which general options are included in the
ASCII file.

Mesh Definition Exports the definition of each mesh, including vertex and
face information for geometric objects. In addition, turning this on enables
the items in the Mesh Options group box, described below.
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Materials Includes the material description. If a material is not assigned to
an object, its wireframe color is exported. All levels of a material tree are
included, so this can produce a lot of text.

Transform Animation Keys Includes the transform animation data for the
objects. If the object is a target camera or spotlight, this will include target
animation data.

Animated Mesh Exports a complete mesh definition of every n frames. The
frequency is specified by the Controller Output spinner, described below. Each
block contains the same information specified in the Mesh Options group
box, described below. Turning this on can result in a huge file, even for small
scenes.

Animated Camera/Light Settings Exports the animation data for cameras
and lights, such as color, intensity, falloff, map bias, etc. Outputs a block every
n frames, as specified by the Controller Output spinner.

Inverse Kinematics Joints Exports the IK joint settings in the Hierarchy
branch.

Mesh Options group

These items are enabled only when Mesh Definition is turned on in the Output
Options group box.

Mesh Normals Exports the face and vertex normals. The normal of the face
is listed first, followed by the normals of the three vertices supporting the
face. Turning this on results in a much larger file.

Mapping Coordinates Exports a list of mapping vertices and faces, according
to the TVert and TVFace structures described in the 3ds Max Software
Development Kit. If an object uses face mapping, a face map list is exported
containing UVW coordinates for each face.

Vertex Colors Exports vertex colors.

Object Types group

The items here let you specify which category of object you want included in
the output. You can include geometric objects, shapes, cameras, lights, and
helper objects.

Static Output group

Frame # Lets you specify which frame of the animation will be used to export
all static data, whether or not you output controller animation data.
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Precision group

Decimals Lets you specify the precision (the number of digits after the
decimal) of the values exported to the ASCII file.

Controller Output group

Use Keys Exports key values. If the controller doesn't use keys, then the Force
Sample method is used. In the case of transform controllers, the Use Keys
option works only if all of the transform controllers are either Linear/TCB or
Bezier. If one of the transform tracks uses a different type of controller, then
the Force Sample method is used for all transform tracks.

Force Sample Samples controller values based on the frequency specified in
the Frames per Sample Controller.

Frames per Sample group

Controllers Specifies the frequency, in frames, with which to sample
controller values for export.

Animated Objects Specifies the frequency, in frames, with which to output
animation settings and mesh definitions.

AutoCAD (DWG) Files

Importing AutoCAD Drawing Files

File menu > Import > AutoCAD Drawing (*.DWG, *.DXF)

In most cases, when using the same data with two or more different Autodesk
products, it's preferable to use the File Link Manager on page 6783  to connect
to drawing files; this lets you maintain a “live” link between the applications.
However, if you prefer you can also use the Import command to bind to the
drawing file immediately.

When you import a drawing file, 3ds Max converts a subset of the AutoCAD,
AutoCAD Architecture (formerly Architectural Desktop), or Revit objects to
corresponding 3ds Max objects.

After you select a drawing file to import, the AutoCAD DWG/DXF Import
Options dialog is displayed. After choosing options and proceeding with the
import, you are presented with editable meshes, editable splines, and PRS
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controllers. Each nested block maintain its parent-child hierarchy and is
imported as “Block/Style Parent”. In addition, if a single drawing object creates
both mesh and spline geometry, you will find objects referred to as “Linked
Geometry” in the scene. Block/Style Parent and Linked Geometry objects
appear in the modifier stack on the Modify panel.

NOTE If you import multiple drawings, the importer merges the drawings together.

If you are using AutoSurf or AutoCAD Designer, use the AutoCAD command
3DSOUT to export mechanical models to 3ds Max. You can also explode the
mechanical models and then import the resulting file, but some data will not
appear in the AutoCAD drawing file.

IMPORTANT AutoCAD and its vertical applications, such as AutoCAD Architecture
(formerly ADT), have custom objects that are unique to the product. In order to
view them in 3ds Max, you need the appropriate Object Enabler (OE). Object
Enablers let you access, display, and manipulate these objects in AutoCAD, as well
as the other vertical applications, including 3ds Max. For a list of downloadable
OEs, see the http://www.autodesk.com/autocad-object-enablersAutodesk Web site

Legacy DWG Importer

The current DWG import utility contains many improvements, including
enhanced DWG compatibility and greater user control and customizability;
however, some features were lost from the DWG Importer found in previous
versions of the software. For this reason, 3ds Max retains the legacy DWG
Import functionality on page 6998 .

Support of Multiple Materials on Imported ACIS Solids

3ds Max supports multiple materials per object in DWG files exported as ACIS
solids from Revit Architecture/Structure/MEP 2008 and later, as well as solid
primitives created in AutoCAD Architecture 2008 (formerly ADT) and later.
Imported solids can have Multi/Sub-Object materials on page 5558  that you
can view and manipulate in the Material Editor.

NOTE Previous versions of 3ds Max supported multiple materials for polymeshes
but only one material ID for each ACIS solid when importing a DWG file, regardless
of how many material IDs had been assigned to the solid.

NOTE Legacy AutoCAD DWG import does not support multiple materials on ACIS
solids.
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Process

When 3ds Max imports a DWG file from AutoCAD or Revit Architecture
(version 2008 and later) with either the Layer, Blocks as Node Hierarchy, Split
by Material” or the Entity, Blocks as Node Hierarchy derivation methods,
multiple material IDs are readable and editable as Multi/Sub-Object materials
in the Material Editor.

3ds Max reads each face of an imported AutoCAD/Revit solid to determine if
it contains any material IDs that can be imported. If the program reads more
than one material ID from a solid, it translates each material ID on import
and re-assigns it to the object.

The program creates Multi/Sub-Object materials only if it finds more than one
material ID; if an ACIS solid contains only one material ID, 3ds Max creates
and assigns a standard/architectural material instead.

NOTE 3ds Max first evaluates the imported file to find any Revit material IDs, and
then looks for AutoCAD material IDs.

NOTE If you import a DWG file with the Layer, Blocks as Node Hierarchy, Split by
Materials derivation method, it does not split the solid to reflect its materials set.

Multi/Sub-Object Material Naming

In earlier versions, 3ds Max read the material ID information from the color
ID of the AutoCAD/Revit material ID’s face. Now, it creates a Multi/Sub object
material for every translated per face material ID each time you import a DWG
file that contains an AutoCAD/Revit solid.

When the program finds multiple materials assigned to an ACIS solid and
creates a Multi/Sub-Object material, the Multi/Sub-Object material consists
of instances of standard architectural scene materials.

Naming Conflicts

Material IDs are unique within one DWG file. However, the same material ID
may appear in two different files, such as Basic Wall: Generic – 12” Masonry.
If a naming conflict arises when two scenes are merged, the program applies
the last loaded material used in the Multi/Sub object material.

For example, if you import two files, file1.dwg and file2.dwg, and they both
contain a material named Brick; the Brick material used is the one from the
second file (file2.dwg).
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Or, if file1.dwg contains a material named Brick that is internally stored as
material ID 222 and file2.dwg contains a different material stored as ID 222,
the material used in the scene when they are imported is file2.dwg’s material.

If two solids share the same material ID, they will share the same
Multi/Sub-Object material.

Non-AutoCAD Materials

3ds Max does not import non-AutoCAD material IDs. The only non-AutoCAD
Architecture IDs it preserves are Color IDs.

ACIS Solids

DWG ACIS solids import as solid objects in 3ds Max. You cannot separate
faces of an ACIS solid object unless you apply the Edit Poly on page 1293  or
Edit Mesh on page 1283  modifier.

TIP You can access the material ID value assigned to this face with the Edit Poly
modifier.

ACIS Solids and Materials

ACIS solid materials display in the Material Editor, along with any other
imported materials.

When you apply a bitmap material to an ACIS solid, it is applied to every side
of the object. For example, a brick bitmap material that you apply to a wall
object appears on both sides and all edges of the wall. If you want to apply a
material to each face ID, you can use a Multi/Sub Object material so you can
assign sub-materials to each face ID.

When you import ACIS solids into 3ds Max, procedural textures are not
imported, only materials For example, a brick wall in Revit may have mortar
lines procedurally drawn on it in red, but if the object is an ACIS solid, the
mortar lines, which are procedural hatches, are lost in 3ds Max

When an ACIS object’s materials are shown as a Multi/Sub-Object material in
the Material Editor, each material name appears in the Material/Map Browser,
for example, Default wall or Basic Wall: Generic – 12” Masonry.

Polymesh

Polymesh DWGs import as polymesh geometry in 3ds Max. Unlike ACIS solids,
you can modify and edit any face of a polymesh object.

6982 | Chapter 21   Managing Scenes and Projects



Polymesh Objects and Materials

When you import a polymesh DWG file, 3ds Max considers each polymesh
face as a separate entity, with one material permitted per entity, which allows
it to contain multiple materials.

You can apply a bitmap material to the different faces of polymesh geometry,
unlike ACIS solids, where you would need to use a Multi/Sub-Object material
to create the same effect. For example, you can select the outside face of wall
and apply a brick bitmap material and also apply a diffuse material on the
inside wall to simulate white paint.

When you import a polymesh DWG file, every material used in the scene
appears in the Material Editor as a separate material, where you can edit it.

When the Material Editor shows a polymesh object’s materials, each material
name appears in the Material/Map Browser, for example, Default wall or Basic
Wall: Generic – 12” Masonry.

Procedures

To import a DWG or DXF file:

1 Choose File menu > Import.

2 Choose AutoCAD Drawing (*.DWG, *.DXF) in the Files of Type list.

3 Specify the file to import and click Open.

4 Set options in the AutoCAD DWG/DXF Import Options dialog.

5 Click OK to perform the import.

Interface

The Import Options dialog contains three panels, documented in the following
topics:

DWG/DXF Import: Geometry Panel on page 6984

DWG/DXF Import: Layers Panel on page 6993

DWG/DXF Import: Spline Rendering Panel on page 6995

A Note on Large-Scale Drawings

If you attempt to import geometry that is created very far from the origin or
contains a very large bounding box in tools like AutoCAD, the 3ds Max
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viewports and transform tools do not respond properly. When you use them,
the cursor does not move smoothly.

For example, if you have a file that is a mile wide, but your system units are
millimeters, you have a scene width of 1.6 million units, which is too great a
value. If you change your system unit to feet, this is less taxing on the system.

If any side of the scene's bounding box measures larger than   1,000,000 system
units, you will see the following dialog:

DWG/DXF Import: Geometry Panel

File menu > Import > AutoCAD Drawing (*.DWG, *.DXF) > Geometry panel

The Geometry panel of the Import Options dialog controls how the software
derives AutoCAD primitives and whether 3ds Max uses the scene material
definitions when linking to or reloading the AutoCAD drawing. It also presents
options for geometry translation and for toggling inclusion of certain elements
in the DWG or DXF file.
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Interface
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Model Scale group

Incoming file units This drop-down list lets you specify the base units in the
incoming file. Available only when Rescale is on.

Rescale Allows rescaling the incoming geometry by a factor corresponding
to the most common unit type used. The importer tries to detect the units of
the DWG file being imported, compares those units with the 3ds Max system
units, and then provides the appropriate conversion factor.

For example, if a drawing file is built in millimeters and 3ds Max has its System
Units set to inches, the AutoCAD DWG/DXF Import Options dialog
automatically has Rescale on and the Incoming File Units set to millimeters.

When there is a scale disparity, It's generally advisable to rescale an incoming
drawing to more realistic units to account for the precision limitations of 3ds
Max compared to AutoCAD. For instance, if you import an airport designed
in millimeters in AutoCAD, set Incoming File Units to Feet or Meters. For
further information, see A Note on Large-Scale Drawings on page 6983 .

NOTE If the units are unspecified in the drawing, the drop-down list is blank. In
this case, if you click OK to perform the import with Rescale on, you are prompted
to select a value for Incoming File Units, and are then returned to the AutoCAD
DWG/DXF Import Options dialog.

Resulting model size Incoming geometry is evaluated to determine its
bounding box size. This field displays the scene extents based on three factors:

■ Incoming file units

■ System units in 3ds Max

■ Display units in 3ds Max

NOTE If the software cannot determine the size, the field shows “(Drawing Extents
Not Known)”.

Derive AutoCAD Primitives By group

This group box contains options for translating the geometry in the DWG or
DXF file to 3ds Max format.
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[derivation method] Choose the method for deriving imported AutoCAD
primitives from this drop-down list. The options are as follows:

■ Layer, Blocks as Node Hierarchy All objects on a given layer in the
AutoCAD drawing that aren't in blocks are combined into a single Editable
Mesh or Editable Spline object when imported into 3ds Max. The name
of each imported object is based on the AutoCAD object's layer. The
imported object name has a “Layer:” prefix and is followed by the layer
name. For example, all AutoCAD objects residing on the layer Walls become
part of the Editable Mesh named Layer:Walls after they are imported to
3ds Max.
Each block is imported separately as a hierarchy, with the block itself as
the parent object and its constituent parts as child objects. The child objects
of the block are combined by layer.

■ Layer, Blocks as Node Hierarchy, Split by Material This works the same
as the Layer, Blocks as Node Hierarchy option, with the following additional
functionalities: the combination of non-block objects by layer, followed
by material and support for multiple materials assigned to ACIS solid and
polymesh geometry.

■ Non-block layer combination

For example, take an AutoCAD file with six objects in layer A: three have
a Brick material and three have a Stone material. Using this option, this
file would be imported in the form of two objects, or nodes, one containing
the Brick material and the other with the Stone material.

Each block is imported separately as a hierarchy, with the block itself as
the parent object and its constituent parts as child objects. The child objects
of the block are combined by layer.

■ Multiple material support

On import, ACIS solids and polymesh geometry can support multiple
materials. For polymesh geometry, one material is supported per face. For
an ACIS solid, if the solid has more than one material associated with it,
a multi/sub object material is created that contains the materials used. If
the solid has only one material associated with it, a standard/architectural
material is assigned instead.

NOTE Multiple material support for ACIS solids applies to DWG files imported
or file linked from Revit Architecture 2008 or AutoCAD Architecture (formerly
Architectural Desktop or ADT) 2007 and later.
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NOTE This derivation method is intended for use with AutoCAD 2007 (and
later) format files. Using this method with DWG files created with previous
versions of AutoCAD may result in data loss.

■ Entity, Blocks as Node Hierarchy Every imported object not in a block is
represented as a separate object in the 3ds Max scene, without regard to
layers. The nodes are then placed on scene layers that correspond to the
drawing layers. Each block is imported separately as a hierarchy, with the
block itself as the parent object and its constituent parts as child objects.
The child objects of the block are combined by layer.
One benefit of this option is that you can apply instanced animation
controllers on page 3033  to block subcomponents and thus, by transforming
a single member, transform all members at once. For example, in a scene
containing a conference table with six chairs around it, you could move
all of the chairs simultaneously by moving a single chair.

Another advantage is that all geometry is instanced, so edited UVs and
normals and other modifications need be done only once.

Multiple materials per object are supported with this option, if needed. If
the object is an ACIS solid, and has more than one material associated
with it, a multi/sub object material is created containing the materials that
can be edited in the Materials Editor. If the solid has only one material
associated with it, a standard/architectural material is assigned instead. If
the object is a Polymesh, one material per face is supported.

NOTE Multiple material support for ACIS solids applies on the DWG files
imported or file linked from Revit Architecture 2008 or AutoCAD Architecture
(formerly Architectural Desktop or ADT) 2007 and later.

NOTE This derivation method setting might cause unreliable material
propagation when importing drawings containing dynamic blocks. Materials
may propagate to some block instances and not to others.

WARNING This option has the potential to create an enormous number of
objects in your scene.

■ Layer Imported objects are combined in 3ds Max according to their layer.
Objects in each of the associated application's layers are combined into
one object, with the exception of blocks, each of which is represented as
an individual VIZBlock (not a hierarchy). Multiple inserts of the same block
are represented using instances in the scene. Material assignments are lost
but material IDs are preserved.
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■ Color Imported AutoCAD objects are combined in 3ds Max according
to their color. All objects of the same color are combined into one object,
with the exception of blocks, each of which is represented as an individual
VIZBlock (not a hierarchy). Multiple inserts of the same block are
represented using instances in the scene. Material assignments are lost but
material IDs are preserved.

NOTE Blocks can contain objects with different colors. However, when sorting,
3ds Max considers only the color of the block itself. Also, 3ds Max objects can
only display one color, unless a material is applied.

■ Entity Provides a one-to-one correspondence between AutoCAD objects
and 3ds Max objects. For each imported object or block in the imported
file, the importer creates an independent object or VIZBlock, respectively,
in the scene. Material assignments are lost but material IDs are preserved.

WARNING This option has the potential to create an enormous number of
objects in your scene.

NOTE When working with drawings exported from Revit, it is recommended
that you do not use this setting.

■ One Object All imported objects are combined into a single VIZBlock.
Material assignments are lost but material IDs are preserved.

Use Extrude modifier to represent thickness When on, objects with thickness
receive an Extrude modifier to represent the thickness value. You can then
access the parameters of this modifier and change the height segments, capping
options, and height value. Unavailable with the Layer, Blocks As Node
Hierarchy option.

When off, objects with thickness (and closed capped objects) are converted
directly to mesh objects.

Create one scene object for each ADT object AutoCAD Architecture (formerly
Architectural Desktop or ADT) objects are imported as a single object instead
of being separated into their constituent components. This means that if you
import an ADT door object, the door is represented as one object instead of
three (frame, step, door). Turning on this switch makes importing faster and
the scene size smaller.

AutoCAD (DWG) Files | 6989



NOTE This switch presents several modeling concerns that you should be aware
of:

■ Material assignments from ADT are not translated during the import
process..

■ If you want to assign materials to these objects, use Multi/Sub-Object
materials. The assigned material IDs match the color indices specified in
ADT (red=1, white=7, etc.).

■ Depending on the Texture Mapping option you choose, UVW coordinates
are translated correctly.

Use scene material definitions When on, 3ds Max checks the current scene
for any currently used materials with the exact same name as a material name
in the incoming DWG file. If a match is found, the importer does not translate
the drawing's material, but instead uses the material defined in the scene.

When off, the File Link Manager always uses the material definitions contained
in the DWG file, and will overwrite scene materials with the same name,
regardless of which objects the material is applied to. All material definitions
stored in the DWG file are reloaded (even when using a selective reload). If
you make changes to a linked material, in Autodesk VIZ, then reload, those
changes will be lost (if the switch is off).

Geometry Options group

Weld nearby vertices Sets whether coincident vertices of converted objects
are welded, according to the Weld Threshold setting. Welding smoothes across
seams and unifies normals of objects with coincident vertices.

Weld threshold Sets the distance that determines whether vertices are
coincident. If the distance between two vertices is less than or equal to the
Weld Threshold, the vertices are welded together.

Auto-smooth adjacent faces Assigns smoothing groups on page 7932  according
to the Smooth Angle value. Smoothing groups determine whether faces on
an object render as a smooth surface or display a seam at their edges, creating
a faceted appearance.

Smooth-angle Controls whether smoothing occurs between two adjacent
faces. If the angle between the two face normals is less than or equal to the
smooth angle, the faces are smoothed.

Orient normals of adjacent faces consistently Analyzes the face normals of
each object and flips normals to make their directions consistent. If the
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imported geometry is not properly welded, or if the software can’t determine
the object's center, normals might be oriented in the wrong direction. Use
the Edit Mesh or Normal modifiers to flip normals.

When this option is off, the software calculates normals according to the face
vertex order in the drawing file. Face normals for solid objects are already
unified. Make sure this option is off when importing drawings containing
solid objects.

You should also make sure this option is off when working with AutoCAD
Architecture files.

AutoCAD solids will never have their normals unified, regardless of the setting
of this import toggle. Solids generate faces and normals correctly.

Cap closed splines Applies an Extrude modifier to all closed objects, and
turns on the Cap Start and Cap End options of the modifier. The Extrude
modifier Amount value for a closed entity with no thickness is set to 0. Capping
makes closed entities with thickness appear solid and closed entities without
thickness appear flat. When Cap Closed Objects is turned off, the Extrude
modifier Cap Start and Cap End options for closed entities with thickness are
turned off. No modifiers are applied to closed entities without thickness, except
for Circle, Trace, and Solid.

NOTE If Use Extrude Modifier to Represent Thickness on page 6989  is off, the
software does not  apply an Extrude modifier to closed objects.

Texture mapping The texture mapping settings affect the loading time of
models that have many objects with stored UVW Coordinates for texture
mapped materials.

NOTE This setting only applies to geometry that is stored as a mesh in the scene.
Spline shapes marked as renderable have separate controls for UVW coordinate
generation on the Spline Rendering panel.

■ No mapping coordinates When No Mapping Coordinates is used, the
software not generate texture coordinates for the mesh objects that are
imported.
When drawings are imported, objects are added to the scene as Editable
Mesh objects that do not have UVW coordinate assignments. Before
assigning materials to imported objects, you'll need to apply a UVW Map
modifier on page 1849  to add texture coordinates. When you then apply
the material and the material or texture map is set to Show Map in
Viewport, the texture map is displayed if the viewport is set to Smooth +
Highlights. If the UVW Map modifier is not applied, the object turns gray
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and you'll see a Missing Map Coordinates dialog on page 5618  when you
render the scene.

This option gives you faster loading speed, but no UVW coordinate
generation.

■ Generate coordinates for all objects This option forces all objects to have
UVW coordinates generated when the drawing is imported.
This option tells the DWG/DXF Importer to create UVW coordinates, but
loading time is increased while the coordinate generation occurs.

Curve steps Adjusts how smoothly an arc or curve appears when the drawing
is imported. Larger numbers result in smoother curves. Default=10.

Maximum surface deviation for 3D solids Specifies the maximum allowable
distance from the 3ds Max surface mesh to the parametric 3D solid surface.
Small numbers produce more accurate surfaces with a greater number of faces.
Large numbers produce less accurate surfaces with fewer faces. In most cases,
the default value suffices. Default=1.0.

Imported 3D solid with different Surface Deviation settings

Top: Surface Deviation=10.0

Center: Surface Deviation=1.0 (the default)

Bottom: Surface Deviation=0.1
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Include group

This group allows you to toggle the inclusion of specific parts of a drawing
file during the import process.

External References (xrefs) Imports xrefs attached to the drawing file.

Lights Imports lights from pre-AutoCAD 2007 drawing files.

Sun and Sky Imports Sun and Shadows position from the drawing file
(AutoCAD / AutoCAD Architecture 2008 and Revit 2008 only).

NOTE You must set mental ray as the default renderer for you to see the Sun and
Sky effect. To set mental ray as the default renderer, see Choose Renderer Dialog
on page 5944 .

Hatches Imports hatches from the drawing file.

WARNING This stores each line or dot in the hatch pattern as a separate
component of the VIZBlock that defines the hatch; this can create a very large
number of objects in your scene.

Views and Cameras Imports named views and cameras from the drawing
file, and converts named views to 3ds Max cameras.

NOTE Orthographic views do not translate correctly in imported DWG files.
However, there are no problems with Perspective views.

Points Imports points from the drawing file.

NOTE The imported point objects are represented in 3ds Max as Point Helper
objects.

UCSs (grids) Imports user coordinate systems (UCS) from the drawing file
and converts them to 3ds Max grid objects.

DWG/DXF Import: Layers Panel

File menu > Import > AutoCAD Drawing (*.DWG, *.DXF) > Layers panel

The Layers panel of the Import Options dialog lets you choose specific layers
for importing from the DWG or DXF file.
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Interface

Layers panel

This interface is very similar to the Layer Manager on page 7227 . Layer names
remain the same as specified in the drawing file.

Skip all Frozen Layers Excludes the import of objects on frozen layers.

Select from List Allows you to choose specific layers to import. A check mark
beside the layer name indicates the layer will be imported. Click the layer to
toggle the check mark.

All The All button is only active when Select From List is turned on. It quickly
lets you select all the layers in the list.
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None The None button is only active when Select From List is turned on. It
deselects any layers you've selected.

Invert The Invert button is only active when Select From List is turned on.
Clicking this button reverses the selection set: currently selected layers are
unselected and unselected layers are selected.

[layer list] This field displays all the layers that make up the drawing and
shows their status such as hidden/displayed or frozen/unfrozen.

DWG/DXF Import: Spline Rendering Panel

File menu > Import > AutoCAD Drawing (*.DWG, *.DXF) > Spline Rendering
panel

The Spline Rendering panel of the Import Options dialog lets you determine
how spline objects imported from DWG and DXF files are displayed in the
viewports and how they're treated by the 3ds Max renderer.

Interface

Spline Rendering panel

The controls on this panel are identical in name and operation to those found
on the Rendering rollout of editable spline on page 590  and Edit Spline on
page 1376  objects. The values of these settings apply to all imported shapes.
Once the import is complete, you can change the settings as necessary for
each object with the Modify panel controls.
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Enable In Renderer When on, the shape is rendered as a 3D mesh using the
Radial or Rectangular parameters set for Renderer.
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Enable In Viewport When on, the shape is displayed in the viewport as a
3D mesh using the Radial or Rectangular parameters set for Renderer.

Use Viewport settings Lets you set different rendering parameters, and
displays the mesh generated by the Viewport settings. Available only when
Enable in Viewport is turned on.

Generate Mapping Coords Turn this on to apply mapping coordinates.
Default=off.

3ds Max generates the mapping coordinates in the U and V dimensions. The
U coordinate wraps once around the spline; the V coordinate is mapped once
along its length. Tiling is achieved using the Tiling parameters in the applied
material. For more information, see Mapping Coordinates on page 5183 .

Real-World Map Size Controls the scaling method used for texture mapped
materials that are applied to the object. The scaling values are controlled by
the Use Real-World Scale settings found in the applied material's Coordinates
rollout on page 5620 . Default=on.

Auto Smooth If Auto Smooth is turned on, the spline is automatically
smoothed using the threshold specified by the Threshold setting below it.
Auto Smooth sets the smoothing based on the angle between spline segments.
Any two adjacent segments are put in the same smoothing group if the angle
between them is less than the threshold angle.

Threshold Specifies the threshold angle for smoothing, in degrees. Any two
adjacent spline segments are put in the same smoothing group if the angle
between them is less than the threshold angle.

Viewport Choose this to specify Radial or Rectangular parameters for the
shape as it will display in the viewport. Available only when Enable in Viewport
and Use Viewport Settings are on.

Renderer Choose this to specify Radial or Rectangular parameters for the
shape as it will display when rendered or viewed in the viewport when Enable
in Viewport is turned on.

Radial Displays the 3D mesh as a cylindrical object.

Thickness Specifies the diameter of the viewport or rendered spline mesh.
Default=1.0. Range=0.0 to 100,000,000.0.

AutoCAD (DWG) Files | 6997



Splines rendered at thickness of 1.0 and 5.0, respectively

Sides Sets the number of sides (or facets) for the spline mesh n the viewport
or renderer. For example, a value of 4 results in a square cross section.

Angle Adjusts the rotational position of the cross-section in the viewport or
renderer. For example, if the spline mesh has a square cross section you can
use Angle to position a "flat" side down.

Rectangular Displays the spline's mesh shape as a rectangle.

Length Specifies the size of the cross–section along the local Y axis.

Width Specifies the size of the cross–section along the local X axis.

Angle Adjusts the rotational position of the cross-section in the viewport or
renderer. For example, if you have a square cross-section you can use Angle
to position a "flat" side down.

Aspect Sets the aspect ratio for rectangular cross-sections. The Lock check
box lets you lock the aspect ratio. When Lock is turned on, Width is locked
to Length that results in a constant ratio of Width to Length.

Legacy AutoCAD Import

File menu > Import > Legacy AutoCAD (*.DWG)

The new AutoCAD DWG/DXF Import Options dialog on page 6979  contains
many improvements, including enhanced DWG compatibility and greater
user control and customizability; however, some things were also lost from
the DWG Import found in previous versions of the software. For this reason,
3ds Max retains the legacy DWG Import functionality.
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Differences Between New and Legacy DWG Import

Features Unique to the new DWG Import System

■ Support for AutoCAD, AutoCAD Architecture and Revit Sun and Shadows
information.

■ Support for AutoCAD Architecture mapped UV textures on objects.

■ Support of multiple materials on ACIS solids from files imported or linked
from Revit Architecture 2008 or AutoCAD Architecture (formerly
Architectural Desktop or ADT) 2007 and later.

■ Support for all ObjectARX custom objects (ignored by the Legacy importer).

■ Specialized support for AutoCAD Architecture and Revit objects, including
style/component grouping and naming, style associations for material and
modifier propagation, and material translation and assignment.

■ Specialized support for AEC Civil contour objects (translated into a Terrain
object).

■ Support for Raster objects.

■ Support for axonometric named views (translated into cameras with the
Orthogonal toggle turned on). Both importers can translate perspective
views.

■ Support for attached drawing xrefs.

■ Support for DXF files.

■ Rescaling to imported drawings created with units that differ from the 3ds
Max system units.

■ Ability to skip frozen layers, or to select specific layers to import (or exclude)
from a list.

■ Ability to set shape rendering parameters before importing to 3ds Max.

■ Ability to maintain layer assignments from the drawing file.

Features Unique to the Legacy DWG Import System

■ AutoCAD primitives are translated into 3ds Max primitives.

■ Support for Text (though not MText).
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■ Imported blocks are represented as groups.

Interface

Derive Objects By group

Layer Names each 3ds Max object based on the object layers specified in the
drawing file. The layer name is followed by a number for each object from
that layer. For example, an object on the layer BASE becomes BASE.01. If
Convert To Single Objects is turned on, objects on the same layer become a
single 3ds Max object.

Color Derives the name of each 3ds Max object based on the object's layer
color in the drawing. The AutoCAD color number is followed by a number
for each object using that layer color. For example, objects on a layer that is
set to the color red (Color number 001) become COLOR001.01. Colors assigned
by object are ignored in favor of colors assigned by layer. If Convert To Single
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Objects is turned on, objects assigned the same layer color become a single
3ds Max object.

Entity Names each 3ds Max object based on the object type. The object type
name is followed by a number for each object converted. For example, a Line
object becomes Line.01. Drawings can contain thousands of entities, so
deriving objects by entity can create many 3ds Maxobjects.

General Options group

Convert to Single Objects Combines multiple objects in the drawing file
into a single 3ds Max object. Objects are combined according to the current
Derive Objects By setting and their 3ds Max object type. Explicit mesh objects
are combined. Shapes with no Z axis extrusion are combined, as are shapes
with the same Z axis extrusion amount. Shapes with differing amounts of Z
axis extrusion are assigned an Extrude modifier and are not combined.

Convert Blocks to Groups Places all objects in a block entity into a 3ds Max
group that uses the name of the block entity and the number .01. For example,
a block entity named CHAIR becomes a collection of 3ds Max objects inside
a group named [CHAIR.01].

Multiple insertions of the block entity are converted to instances of the 3ds
Max group. For example, a second insertion of the block, CHAIR, becomes an
instance of [CHAIR.01] named [CHAIR.02].

When Convert Blocks To Groups is turned off, block definitions are ignored
and block insertions are treated as separate objects, similar to exploding blocks
in AutoCAD.

Skip Off and Frozen Layers Excludes the import of objects on layers that are
hidden or frozen.

Skip Hatches and Points Excludes the import of hatch patterns and point
objects.

Hatch patterns are made of many short line segments and points. Importing
all the objects in hatch patterns can overload your 3ds Max scene.

NOTE Hatch patterns are stored in drawings as anonymous blocks. Skip Hatches
And Points skips any other anonymous blocks in the drawing file. Hatch patterns
created in AutoCAD R14 are skipped regardless of this setting.

Group Common Objects Puts imported objects into a common group, based
on how they are derived. In other words, the group would include all objects
on a common layer, or color, and so on.
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Geometry Options group

Weld Sets whether coincident vertices of converted objects are welded
according to the Weld Threshold setting. Welding smoothes across seams and
unifies normals of objects with coincident vertices. To use the Weld option,
first turn on Convert To Single Objects, because welding occurs only for vertices
that are part of the same object.

Weld Threshold Sets the distance that determines whether vertices are
coincident. If the distance between two vertices is less than or equal to the
Weld Threshold setting, the vertices are welded together.

Auto-Smooth Assigns smoothing groups according to the Smooth Angle
setting. Smoothing groups determine whether faces on an object render as a
smooth surface or display a seam at their edges, creating a faceted appearance.

Smooth Angle Controls whether smoothing occurs between two adjacent
faces. If the angle between the two face normals is less than or equal to the
Smooth Angle setting, the faces are smoothed.

Unify Normals Analyzes the face normals of each object and flips normals
where necessary, so they all point out from the center of an object. If the
imported geometry is not properly welded, or if the software can't determine
the object's center, normals might be oriented in the wrong direction. Use
the Edit Mesh or Normal modifiers to flip normals.

When Unify Normals is turned off, normals are calculated according to the
face vertex order in the drawing file. Face normals for 3D Solids are already
unified. Turn off Unify Normals when importing 3D Solid models.

Cap Closed Entities Applies an Extrude modifier to all closed entities, and
turns on the Cap Start and Cap End options of the modifier. The Extrude
modifier Amount value for a closed entity with no thickness is set to 0. Capping
makes closed entities with thickness appear solid and closed entities without
thickness appear flat. When Cap Closed Entities is turned off, the Extrude
modifier Cap Start and Cap End options for closed entities with thickness are
turned off. No modifiers are applied to closed entities without thickness, except
for Circle, Trace, and Solid.

AutoCAD 3D Solids Group

Surface Deviation Specifies the maximum allowable distance from the 3ds
Max surface mesh to the parametric 3D solid surface. Small numbers produce
more accurate surfaces with a greater number of faces. Large numbers produce
less accurate surfaces with fewer faces.
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Exporting AutoCAD DWG Files

File menu > Export > AutoCAD (*.DWG)

When you export an AutoCAD drawing file, you convert your 3ds Max objects
into AutoCAD objects. Because AutoCAD doesn't support animation, the
exporter produces objects in a static state defined by the current frame set by
the time slider.

If you used layers, instances, or colors to organize objects in the scene, that
structure is maintained when the model is exported.

Exported objects with modifiers assigned to them are affected by the current
state of the modifier. For instance, if the Taper modifier assigned to a box is
turned off, the exported scene shows a non-tapered box.

NOTE Layers created in 3ds Max are not exported to AutoCAD.

NOTE Exporting to an AutoCAD R14 drawing file is not supported. If you are
working with AutoCAD R14, export to 3DS or DXF file format.

What to Expect When Opening the DWG File

When you open an exported drawing in AutoCAD, you are presented with
an isometric (3/4) view looking toward the positive XY direction instead of a
Front elevation view.
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The isometric view of an exported model opened in AutoCAD

The exporter also sets two AutoCAD system variables:

■ INSUNITS, Insert Units, sets the drawing-unit value for blocks or images
inserted from AutoCAD Design Center. Therefore, if you have the units of
a model in 3ds Max set to millimeters, INSUNITS will be set to 4.

■ MEASUREMENT sets the drawing units either to English or Metric.

See also:

■ Exporting to DXF Files on page 7006

Procedures

To export a DWG file:

1 Choose File menu > Export.

2 From the Files Of Type drop-down list, choose AutoCAD (*.DWG).

3 Specify a file name to export.
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4 Set options in the Export to AutoCAD File dialog (described below).

Interface

Export version

Export version 3ds Max allows you to export to AutoCAD 2007, AutoCAD
2004, or AutoCAD 2000.

The next option lets you choose to export everything in the current scene or
only selected objects:

■ Entire Scene All objects in the scene are exported. This is the default
setting.

■ Selected Objects Only selected objects are exported. Choosing this is
equivalent to using File > Export Selected on page 6895 .

Geometry Options group

Convert Instances To Blocks Converts instances to AutoCAD block insertions.
The block definition uses the same name as the first instance converted. When
turned off, each instance is converted as a separate AutoCAD object. References
are always exported as separate objects.

Skip Hidden Objects Toggles export of hidden objects. When on, hidden
objects are not exported.

Ignore Extrude Capping When on, exports shapes with Extrude modifiers
as 2D AutoCAD objects with a thickness property, and ignores the state of the
Cap Start and Cap End parameters. When off, shapes with Extrude modifiers
that also have Cap Start or Cap End on are exported as polyface 3D meshes.
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Extruded circles, donuts, and rectangle objects export as AutoCAD circles,
donuts, and trace objects with a thickness property.

AutoCAD Interchange (DXF) Files

Importing DXF Files

File menu > Import > Select File To Import dialog > Files Of Type > AutoCAD
(*.DXF)

If using a DWG file is not an option, the DXF file format is the next best
method of getting design data to and from 3ds Max. Most commonly, DXF
files are used to import and export modeling data to and from CAD programs
that have support for DXF but not DWG files.

When you import an DXF file, the software converts a subset of AutoCAD
objects to corresponding 3ds Max objects. Importing DXF files employs the
same methods as importing DWG files. For more information, see Importing
AutoCAD Drawing Files on page 6979 .

Exporting to DXF Files

File menu > Export > Select File To Export dialog > Save As Type > AutoCAD
(*.DXF)

DXF files are used to import and export objects to and from AutoCAD (and
other programs that support this file format).

NOTE The DXF Exporter can export only mesh data. Therefore, all shapes and
splines on page 7929  are exported as mesh objects. Consequently, any open splines
(which cannot be converted to mesh objects) in your scene will not be exported.

See also:

■ Exporting AutoCAD DWG Files on page 7003
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Interface

Export version

Export version list Lets you choose the AutoCAD version to export. You can
export to AutoCAD 2007, AutoCAD 2004, AutoCAD 2000, or AutoCAD R12
DXF format.

■ Entire Scene (The default.) All objects in the scene are exported.

■ Selected Objects When chosen, only the selected objects are exported.
Choosing this option is comparable to using File > Export Selected on
page 6895 .

Geometry Options group

Convert Instances To Blocks Converts instances to AutoCAD block insertions.
The block definition uses the same name as the first instance converted. When
turned off, each instance is converted as a separate AutoCAD object. References
are always exported as separate objects.

Skip Hidden Objects Exports hidden objects. When turned off, hidden objects
are not exported.

Ignore Extrude Capping When turned on, exports shapes with Extrude
modifiers as 2D AutoCAD objects with a thickness property, and ignores the
state of the Cap Start and Cap End parameters. When turned off, shapes with
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Extrude modifiers that also have Cap Start or Cap End turned on, are exported
as polyface 3D meshes. Extruded Circles, Donuts, and Rectangles export as
AutoCAD Circles, Donuts and Traces with a thickness property.

Autodesk Inventor Files

Importing Autodesk Inventor Files

File menu > Import > Select File To Import dialog > Files Of Type > Autodesk
Inventor (*.IPT, *.IAM)

IPT and IAM are the native Autodesk Inventor® file formats for parts (IPT) and
assemblies (IAM). You can now import both file formats into 3ds Max without
having to copy scripts from the install CD.

The components of models that you import into 3ds Max retain their object
naming as assigned in Autodesk Inventor and appear as editable meshes on
page 1990 . Once imported, you can edit the model just as you would any other
type of object that you construct. You can apply modifiers, alter materials,
add lighting and cameras, create animations, etc.

Requirements and Limitations

In order to be able to import models that originate from Autodesk Inventor,
Inventor 8, or later, is required to be installed along with 3ds Max on the
system.

At this time, there are some limitations to the Inventor Importer. They are as
follows:

■ Camera animation paths are not converted to 3ds Max cameras so any
animation you've set up in Inventor is lost during import.

■ Any lighting from brightness and ambience settings created in the Inventor
file are not imported. You will have to relight the scene once the import
is complete.

■ A model that is set up with constraints to limit the movement of parts will
lose those constraints upon import. You will need to use inverse kinematics
(IK) on page 3299  to restore the constraints.
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■ Dragging and dropping an Inventor file into 3ds Max uses the settings last
set on the Inventor File Import dialog with the except for Mesh Resolution,
which always resets to 0.

■ 3ds Max uses the last version of Inventor that was opened to set the Import
version. For instance, let's say you have both Inventor 8 and Inventor 10
on your system. If the last version of Inventor you ran was Inventor 8, you
cannot import Inventor 10 files. Inventor 8 must be closed and Inventor
10 opened, at least once, in order for you to successfully import Inventor
10 files.

Material Handling

Materials and material assignments made to the original Inventor model are
retained and imported along with the geometry. Materials are imported as
Architectural materials on page 5431  or if a single object has several materials
assigned to it, they are imported as a Multi/Sub-Object material on page 5558
.

Procedures

To import an IAM or IPT file:

1 Choose File menu > Import.

2 Choose Autodesk Inventor (*.IPT, *.IAM) in the Files of Type list.

3 Specify a file name to import.

4 Set options in the Autodesk Inventor File Import dialog.
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Interface

Merge / Replace Options group

Merge With Current Scene Incoming geometry is merged with any existing
geometry that is already present in the scene. This setting is useful if you have
several separate files that contains components that you want to combine
into a single model.

Completely Replace Current Scene The file you're importing will completely
replace any existing geometry that is in the current scene. If your current
scene has not been saved, you are given the opportunity to save your changes
to the current scene before the import process continues. Default=on.
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Material Options group

Import Inventor Materials When turned on, all Inventor materials and
texture maps are translated and imported into the scene. If turned off, no
materials are imported with the model.

Assign Material IDs Lets you control whether material IDs are assigned to
objects that are imported from Inventor. You can assign different materials
to different surfaces of the same object while working in Inventor. When these
objects are imported to 3ds Max, material IDs are assigned to the faces of single
objects to which multiple materials are applied.

For example, you've created a single object that represents a knob that has a
threaded shaft and you've applied a black, plastic material to the knob and a
silver, metal material to the threaded shaft. If Assign Material IDs is turned
on when you import the model into 3ds Max, the faces of the object that have
the plastic material are assigned material ID #1 and the faces that have the
metal material are assigned material ID #2. If you choose to try different
materials while working in 3ds Max, you can quickly make sub-object
selections on page 160  based on the material IDs or apply a Multi/Sub-Object
material on page 5558  that contains materials that correspond to the IDs assigned
to the faces.

Mesh Resolution group

Mesh Resolution This slider lets you determine the degree of refinement
applied to mesh objects by the importation process. When set to 0 (zero), the
geometry is imported as it appears in Autodesk Inventor. When set less than
zero, the mesh is optimized with fewer faces thus reducing detail. If the mesh
resolution is set higher than zero, the mesh is tessellated with more faces,
giving you greater detail.

The mesh resolution slider is always set to 0 when you initiate an import.
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Left: Mesh Resolution=–7.

Center: Mesh Resolution=0.

Right: Mesh Resolution=+7.

NOTE The option to adjust mesh resolution is available only for models imported
from Autodesk Inventor 10 or later.

Inventor File Vertical Direction group

This option determines the model's orientation upon import. You can choose
which axis of the Inventor model is vertical.

X Axis The X axis of the model, as seen in Inventor, is rotated so it is vertical
when the model is imported.

Y Axis The model is imported with the Y axis oriented as the vertical axis.

Z Axis The imported model is rotated so its Z axis is the vertical axis.
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Left: Vertical axis set to X.

Center: Vertical axis set to Y.

Right: Vertical axis set to Z.

DWF Files

Exporting 3D DWF Files

File menu > Publish to DWF

File menu > Export > Publish to DWF

With 3D DWF publishing, you can export Design Web Format™ (.DWF™) files
of your three-dimensional models with nearly the same visual fidelity as in
rendered scenes. DWF files are relatively small files that you can easily share
with team members who might not have 3ds Max. It also provides a fast way
to view models without having to spend time animating and rendering them
because you can use the Orbit feature in the viewer to fly around the model.
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For example, a DWF file of your scene can allow you and others to quickly
view an interactive model as well as the properties of each object.

Recipients of 3D DWF files can view and print them using Autodesk® Design
Review, which is an optional part of the 3ds Max install program. For more
information about using the viewer, see the Autodesk Design Review help
system.

Feature Support with 3D DWF Export

■ 2D and 3D splines. The Enable In Viewport setting on the Rendering
rollout on page 546  does not need to be enabled in order to export splines.

■ 3D geometry

■ Texture-mapped materials with a diffuse map channel, UV mapping
channels, and material IDs

NOTE Materials that have Use Real-World Scale on page 5609  enabled display
more accurately in the Autodesk Design Review program.

■ Procedural materials, but only as a rough, low-resolution approximation.
Real-World Map Size should be off for objects with procedural materials.

■ Materials that have transparency are correctly exported and their opacity
values are recognized by the Autodesk Design Review program. Even when
you orbit the view, objects that pass behind other objects with transparent
materials are still visible.

Limitations of 3D DWF Export

Materials and Environments

■ Environment backgrounds do not export; the Design Review program uses
its own background color setting.

■ Environmental effects such as fog do not export.

■ Materials using reflection maps such as Flat Mirror do not produce
reflections when exported.

■ Two-sided materials are not supported. However, you can get around this
by turning on Force 2-Sided on the Render Scene dialog.
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NOTE Turning on Force 2-Sided affects the entire scene. This can slow down
the performance of Design Review because it has to process the two-sided
display of everything in scene.

■ Materials from third-party suppliers and mental ray materials are not
exported.
Objects that have unsupported materials display in their diffuse colors in
the viewer. AutoCAD Architecture materials are displayed in their ambient
color.

■ Export doesn’t support all material parameters, even with supported
materials. Therefore, materials you export to Design Review might not
look as they do in a rendered image.

Lights

■ You cannot export scene lighting.

Cameras and Animation

■ Named camera views are exported. The exporter creates a DWF view for
each camera in the scene. You can choose these views from the Views
panel in the Autodesk Design Review program, but the cameras are not
otherwise visible as objects in the scene.

■ Animations are not supported, however, the frame at the time of the export
is published.

Procedures

To export a 3D DWF file:

1 Set up the scene in the active viewport as you want it displayed in the
Autodesk Design Review program.

If you want to publish particular objects or layers, make a selection set
of those objects. Hide those objects or layers you do not want published.

NOTE You can also isolate objects in the viewer you want to hide or make
transparent.

TIP If you have a camera in the scene and want that view exported, make
sure the Camera viewport is active when you publish the DWF file.
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2 Choose File menu > Export.

3 Choose Publish To DWF (*.DWF) from the Save as type list in the file
selector dialog.

4 Specify a file name to export.

5 Click Save.

6 Use the DWF Publish Options dialog to make the desired settings, and
then click OK.

7 If you turn on Save Log file but do not want the existing log file to be
overwritten, enter a new name or specify a different folder.
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Interface
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Grouping Options group

Group by Object When on, objects are listed on the Navigator Pane in Design
Review by object name or group name.

Group by Layer When on, objects are grouped on the Navigator Pane of
Design Review by their respective layers.

Publishing Options group

Publish Object Properties When on, object property data is exported and
displayed in Design Review and reported in the log file if Save Log File is
enabled. The displayed properties are name, layer name, face count, vertex
count, and whether the object is frozen or hidden.

Publish Materials Exports objects with their assigned materials in Design
Review. When off, exports objects in their basic object colors. Material names
are not exported.

Publish Selected Objects Only Exports only objects that are selected when
you export.

Publish Hidden Objects Hidden objects are exported and displayed in the
viewer. When off, objects that are hidden or on layers that are hidden do not
appear. Hidden objects are listed in the log file if Save Log File is enabled.

NOTE Frozen objects and frozen layers are exported.

General group

Show DWF in a Viewer When on, Autodesk Design Review automatically
opens the exported DWF file. When off, you must run Design Review and
open the file manually.

Rescale Bitmaps When on, bitmap textures are automatically rescaled in the
DWF file to the size set for pixels for Maximum Resolution. When using large
texture files, turn this on to reduce the DWF file size.

NOTE This setting has no effect when Publish Materials is off.

Maximum Resolution (pixels)  Sets the maximum length, in pixels, of the
longest edge of all the bitmap images that are used as textures.

NOTE All bitmap images exported to the DWF file are compressed to JPG on
page 7139  format in order to create small DWF files.
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Use Default DWF Lights Lets you control whether Design Review adds its
own default lighting. When turned off, the scene is displayed without lights
in the viewer, which can result in the scene objects being flat shaded making
them appear two dimensional. Turn Use Default DWF Lights off if the scene
contains lights that are already baked into textures with Render to Texture
on page 6169 , otherwise it is recommended that DWF lights are used.
Default=on.

NOTE When exporting a scene with all the lighting baked into the texture maps
after using Render to Texture, if Use Default DWF Lights is turned on the scene
may actually appear darker in Design Review, and the built-in DWF lights will cause
the scene lighting to change as you orbit around the objects in the scene. With it
turned off, the lighting will be constant as you move through the scene.

Save Log File  When enabled, 3ds Max creates a text file with the .log file
extension that lists objects, their layers, face and vertex counts that are
exported as well as the time and date of the export. Objects that were not
selected or hidden are also listed as not as not being exported. The log file is
overwritten each time a DWF file is created unless the log file name or file
location is changed. Default=on.

FBX Files

File menu > Import/Export > [Files of type]=Autodesk (*.FBX, *.DAE)

FBX is the file format native to Autodesk MotionBuilder, a system used for
the creation, editing, and blending of motion capture and keyframe animation.
You can import and export files in this format with 3ds Max.

Softimage and Maya can also use the FBX format, making it a bridge among
the four applications.

NOTE The FBX importer/exporter also supports the Collada (DAE) file format.

Interface

For the current version of the 3ds Max FBX Plug-in Guide, click the Help
button on the FBX Importer/Exporter dialog.

The FBX plug-in changes often, with the result that Autodesk updates it more
frequently than it does this program. Be sure to check regularly for updated
versions by clicking the Check For Web Updates button on the dialog.
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IGES Files

Overview of IGES in 3ds Max

The Initial Graphics Exchange Specification (IGES) is an ANSI standard that
defines a neutral form for the exchange of information among dissimilar
computer-aided design (CAD), computer-aided manufacturing (CAM), and
computer visualization systems. The software implements the IGES standard
for translating files between 3ds Max and IGES file formats used by the
mechanical engineering and entertainment industries. Using the IGES
import/export feature, you can read in and write out native NURBS on page
7864  data between 3ds Max and programs such as Mechanical Desktop release
3.0, Maya™, Pro/ENGINEER®, SOFTIMAGE®, CATIA®, and others. For complete
details on the IGES standard, see The Initial Graphics Exchange Specification
(IGES) Version 5.3.

What IGES Translates

The ideal file translation preserves the appearance and functionality of objects
(called entities in IGES) contained in a file. This process has limits. You should
be aware that some 3ds Max objects are not supported or not fully supported
by IGES. Similarly, be aware that some IGES entities are not supported by the
software. For example, you can't translate animation data and mapping
coordinates, as these elements are not supported by IGES.

As with all translations, concepts that can be expressed succinctly in one
language might not have exact equivalents in another language; conversely,
concepts common to two languages might be expressed differently by each.

Even when the objects you translate don't have an equivalent in the target
system, a one-time translation to or from IGES might not pose a serious
problem. However, data loss can become a concern if you maintain objects
that will be repeatedly translated in and out of different formats through IGES.
By becoming familiar with the details of the systems and the IGES translators
you use, you can learn to structure files to minimize information loss.

WARNING The conversion of objects during translation is not fully symmetrical.
If you import an IGES file that you created by exporting to IGES, the resulting
objects might not be identical to the original.
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NURBS

When you import an IGES file into the software, IGES meshes are converted
to NURBS on page 2152  surfaces, rather than to 3ds Max mesh objects. An IGES
file with multiple meshes imports as a single NURBS model. Each IGES mesh
is a surface sub-object within the model.

Each surface sub-object based on an IGES mesh is initially a rigid surface on
page 2172 . To edit the surface and its CVs on page 7750 , you must first make
the rigid surface independent. The following procedure explains how to do
this.

Future Compatibility

The group that maintains and updates the IGES standard, the IGES/PDES
(Product Data Exchange Standard) consortium, attempts to keep IGES upwardly
compatible. It's likely that files generated by the software will be compatible
with future versions of IGES.

See also:

■ 3ds Max to IGES Export Table on page 7028

■ Exporting IGES Files on page 7027

■ IGES Log Files on page 7022

■ IGES to 3ds Max Import Table on page 7025

■ Importing IGES Files on page 7023

Procedures

To make rigid imported NURBS surfaces independent:

1 Select the object.

2  Go to the Modify panel.

3 In the Modifier Stack rollout, choose Surface as the sub-object level.

4 Select the surface sub-object you want to edit.

5 In the Surface Common rollout, click Make Independent.

IGES Files | 7021



NOTE Making rigid imported NURBS surfaces independent can take a long
time if there are complicated surfaces in the file, or if the file is large. Avoid
selecting all surfaces and then clicking Make Independent. Rather, save your
file immediately after successfully importing it, and then use Make
Independent with care.

IGES Log Files

During the translation process, the software creates log files containing detailed
information about the processing of the model. This information includes
error messages and entity-mapping statistics. You can use this log file to
understand what occurred during the translation.

The software places log files in the directory where the IGES file is either
imported from or exported to. The log file name has the prefix name of the
3ds Max file name, with the extension of .xli (input) for import, and .xlo
(output) for export.

The log file provides the following information:

■ Name of the file processed.

■ Number and severity of errors encountered, a description of them, and an
explanation of what can be done, or what was done to the data in error.
(The software attempts to fix many errors itself.)

■ Summary of entities processed.

■ List of the entity types encountered and those created.

See also:

■ Overview of IGES in 3ds Max on page 7020

■ 3ds Max to IGES Export Table on page 7028

■ Exporting IGES Files on page 7027

■ IGES to 3ds Max Import Table on page 7025

■ Importing IGES Files on page 7023
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Importing IGES Files

File menu > Import > IGES (*.IGE, *.IGS, *.IGES)

IGES files are used to import and export NURBS objects to and from 3ds Max
(and other programs that support this file format). For more information, see
Overview of IGES in 3ds Max on page 7020 .

In some cases, when you import an IGES file, the translation doesn't produce
exact replicas. To understand what happens to each entity when it's translated,
review the IGES import table on page 7025 .

3ds Max imports an object containing multiple surfaces as a single NURBS
object. To work with a single surface of the object, detach it in sub-object
NURBS and work with only that object. This releases the rest of the object
from memory. For more information, see NURBS on page 7021 .

When you import IGES files, 3ds Max creates a log file containing detailed
information about the processing of the model. The name of the file has the
form of filename.xli. For more information, see IGES Log files on page 7022 .

NOTE 3ds Max creates and uses a few temporary files during translation.
Temporary files can be large. If there has been a computer or IGES translation
failure and temporary files remain on your system, they might need to be removed
to free up disk space. For storage of these temporary files in Windows, 3ds Max
uses the directory specified by the TEMP environment variable, or the current
directory if TEMP is not set.

See also:

■ 3ds Max to IGES Export Table on page 7028

■ Exporting IGES Files on page 7027

■ IGES Log Files on page 7022

■ IGES to 3ds Max Import Table on page 7025

■ Importing IGES Files on page 7023

Procedures

To import an IGES file:

1 Choose File menu > Import.
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2 Specify the IGES file to import from the file selector dialog.

You can choose IGES (*.IGE, *.IGS, *.IGES) from the Files Of Type list to
display only IGES files.

3 From the IGES Import dialog, select Merge Objects With Current Scene
or Completely Replace Scene.

4 To review the translation process, read the .xli log file with your preferred
text editor.

Interface

IGES Import

The IGES Import dialog has the following controls:

Merge objects with current scene Merges imported data with the current
scene.

Completely replace scene Completely replaces the current scene with the
imported data.
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IGES to 3ds Max Import Table

The following table lists IGES entities and the 3ds Max objects they translate
to when you import them. Any IGES entities not listed here do not import.

3ds MaxIGES entity nameIGES entity number

Arc ShapeCircular Arc100

Spline ShapeComposite Curve102

Spline ShapeConic Arc104

Spline ShapeCopious Data106

NURBS Surface (unbound-
ed converts to construction
plane)

Plane108

Spline ShapeLine110

NURBS CurveParametric Spline Curve112

NURBS SurfaceParametric Spline Surface114

Point HelperPoint116

NURBS SurfaceRuled Surface118

NURBS SurfaceSurface of Revolution120

NURBS SurfaceTabulated Surface122

NURBS CurveRational B-spline Curve126

NURBS SurfaceRational B-spline Surface128
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3ds MaxIGES entity nameIGES entity number

NURBS CurveOffset Curve130

NURBS SurfaceOffset Surface140

NURBS SurfaceBoundary Curve141

NURBS SurfaceCurve on Parametric Sur-
face

142

NURBS SurfaceTrimmed Parametric Sur-
face

144

NURBS SurfaceBounded Surface143

NURBS SurfaceSolid186

InstanceSubfigure Definition308

NURBS ObjectGroup402

Notes

The 3ds Max objects translated from IGES can have surface sub-objects.

IGES import supports name and color mappings to 3ds Max names and colors.

When you import IGES files, names are mapped by using the level name
followed by a colon, and then the object name.

See also:

■ 3ds Max to IGES Export Table on page 7028

■ Exporting IGES Files on page 7027

■ IGES Log Files on page 7022

■ IGES to 3ds Max Import Table on page 7025

■ Importing IGES Files on page 7023
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Exporting IGES Files

File menu > Export > IGES (*.IGS)

IGES files are used to import and export objects to and from 3ds Max (and
other programs that support this file format). For more information, see
Overview of IGES in 3ds Max on page 7020 .

In some cases, when you export 3ds Max objects to an IGES file, the translation
doesn't produce exact replicas. To understand what happens to each object
when it's translated, review the IGES export table on page 7028 .

When you export IGES files, 3ds Max creates a log file containing detailed
information about the processing of the model. The name of the file has the
form of filename.xlo. For more information, see IGES Log files on page 7022 .

NOTE If there are modifiers applied to surfaces in your scene, it's best to collapse
the stack before exporting to IGES. When 3ds Max exports to an IGES file, it skips
any surface that has any modifiers applied.

See also:

■ 3ds Max to IGES Export Table on page 7028

■ IGES Log Files on page 7022

■ IGES to 3ds Max Import Table on page 7025

■ Importing IGES Files on page 7023

■ Overview of IGES in 3ds Max on page 7020

Procedures

To export an IGES file:

1 Select the objects to export.

2 Choose File menu > Export.

3 Choose IGES (*.IGS) from the Save as type list in the file selector dialog.

4 Specify a file name to export.

5 Click Save.
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6 From the IGES Export dialog, select Export Hidden Objects or Export
Selected Objects Only.

7 To review the translation process, read the .xlo log file with your preferred
text editor.

Interface

IGES Export

The IGES Export dialog has the following controls:

Export Hidden Objects Exports objects that are currently hidden in the 3ds
Max scene.

Export Selected Objects Only Exports only objects that are currently selected.

3ds Max to IGES Export Table

The following table lists 3ds Max objects and the IGES ID and IGES Type they
translate to when you export them. Any 3ds Max objects not listed here do
not export.
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NOTE The convention for denoting the type of IGES entity is the numerical
construction type:form. For example, 214:2 is the IGES entity number 214, form
2. Form numbers can also be signed (given a positive or negative value).

IGES entity numberIGES entity name3ds Max object

128Rational B-spline SurfaceSurface

143Bounded SurfaceNURBS Surface

143/144Bounded SurfaceTrimmed Surface

126Rational B-spline CurveCurve

116PointPoint

402:7GroupGroup

308Subfigure DefinitionInstance

408Subfigure Definition(s)Instance(s)

Notes

When 3ds Max exports IGES, it supports name and color mappings to IGES
names and colors.

Since IGES requires unique names per element, 3ds Max will append a unique
identifier to multiple objects with the same name.

See also:

■ Exporting IGES Files on page 7027

■ IGES Log Files on page 7022

■ IGES to 3ds Max Import Table on page 7025

■ Importing IGES Files on page 7023

■ Overview of IGES in 3ds Max on page 7020
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JSR-184 Files

File menu > Export > JSR-184 (*.M3G)

3ds Max provides support for developing mobile games using the JSR-184
format. JSR-184 is a Java standard used to create 3D applications for mobile
phones. Once you have exported your scene to JSR-184 format, you can preview
the animation using the JSR-184 Standalone Player on page 7042 .

Procedures

To export an M3G file:

1 Choose File menu > Export.

2 Choose JSR–184 (*.M3G) in the Files Of Type list.

3 Specify a file name to export, and then click Save. This opens the JSR-184
dialog, displaying the scene hierarchy for your 3ds Max scene. By default,
all of the elements in your scene are also listed for export in the JSR-184
scene.

NOTE If you wish to export a particular object in your scene, use File > Export

Selected, or delete the objects you do not wish to export by clicking 
. If an object is a descendant within an hierarchy, it will be exported with its
hierarchy. The same applies for objects in a group.

4 Modify the parameters of objects exported to JSR–184. See JSR-184 Object
Parameters on page 7033  for more info.

5 Click Export.

6 Preview your exported JSR-184 scene in the JSR-184 Standalone Player
on page 7042 .

7030 | Chapter 21   Managing Scenes and Projects



Interface

The 3ds Max scene hierarchy is shown on the left of the dialog, and the
hierarchy of the JSR-184 scene to be exported is displayed on the right. Object
parameters for the JSR–184 scene are displayed on the far right-hand side of
the JSR-184 Export dialog. The exported m3g file contains all of the objects
and parameters included in the JSR-184 scene. Many of the parameters for the
objects in the JSR-184 scene can be modified prior to exporting the file. See
JSR-184 Object Parameters on page 7033  for more details.

Menu options:

 New JSR-184 Scene Creates an empty JSR-184 scene

 Add 3ds Max Scene Adds all objects that can be converted to the
JSR-184 format to the JSR-184 scene.
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 Add World Object Adds a World Object to the JSR-184 scene file.
A World Object contains sub-object hierarchies and has two special sub-objects:
Active Camera and Background.

 Add Group Adds an empty Group. Use this option to group objects
in your scene without the need to create a World Object.

 Convert Mesh to Sprite3D Converts a selected 3ds Max plane object
into a JSR-184 Sprite3D object. If you do not select this option, by default all
plane objects are converted to JSR-184 mesh objects.

 Texture Tool All the textures of objects in your 3ds Max scene are
placed in the Material Table level of JSR184 image file. Use the JSR-184 Texture
Tool on page 7038  to edit texture properties.

 Remove Object Removes the selected object from the JSR-184 scene.

Export Settings:

Authoring Message This message is required by the JSR-184 file format
standard and is usually reserved for entering copyright notice information.
This message is stored in the header portion of the M3G file.

Project Root Sets the location of the root of the project. If you do not enter
a path in this field, all external references within the M3G file are loaded from
the same location as the current file.

Show Hidden Objects Shows all the hidden objects in the 3ds Max scene
hierarchy.

Compress M3G File Compresses all the data in the exported M3G file.

Auto Assign User IDs Automatically assigns unique User ID values to all
exported objects.
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See also:

■ JSR-184 Object Parameters on page 7033

■ JSR-184 Texture Tool on page 7038

■ JSR-184 Log Files on page 7040

■ JSR-184 Standalone Player on page 7042

JSR-184 Object Parameters

File menu > Export > JSR-184 (*.M3G).

The JSR-184 data file is represented as the root object of your scene. Many of
the parameters of objects in the JSR-184 data file can be adjusted to optimize
the output of your scene. You can preview your exported scene using the
JSR-184 Standalone Player on page 7042 .

NOTE All editable parameters are displayed in italic .

The JSR-184 Data File

Material Table

Material Table is a special object that contains all the materials and textures
used in the JSR-184 scene. The Material Table has a two-level structure: the
3ds Max material name is the first level and its associated textures comprise
the second level. The Material Table is represented as [Material Table] in the
JSR-184 scene tree.

The 3ds Max level displays the following parameters:

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Layers: Sets the rendering layer for the JSR-184 Appearance Object. When
rendering a World, Group, or Mesh, submeshes and sprites are rendered
in the order of ascending layers.

The texture level displays the following parameters:

■ Approx.Object Size: Shows the object size with sub-objects.
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■ User-defined ID: Displays the user ID for the object.

■ Blending: Specifies how to combine the filtered texture color with the
incoming fragment color in a texturing unit. This is equivalent to the
texture environment mode in OpenGL. Options are Add, Blend, Decal,
Modulate, and Replace.

■ WrappingS and WrappingT: The Repeat and Clamp texture wrapping
modes define the treatment of coordinate values that are outside the [0,1]
range.

■ Level Filter: Sets the texture filtering. Options are Nearest, Linear, and Base
Level.

■ Image Filter: Sets the image filtering. Options are Nearest, Linear, and Base
Level.

World

World is a special Group node that is a top-level container for scene graphs.
A World Object is represented as <<World>> in the JSR-184 scene tree. Every
world object has three sub-objects: [Background], [Active Camera], and
[Ambient Light]. A World object has the following parameters:

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Enable Rendering: Sets the picking enable flag of this node. The effective
rendering enable status for this node is the logical AND of the enable flags
on this node and all of its ancestors. This means that the World node is
disabled if any of its ancestors are disabled. The status of the World node
has an effect only if all its ancestors are enabled. If the effective status is
set to True, this node is enabled. If it is False, it is disabled.

■ Enable Picking: Sets the picking enable flag of this node. The effective
rendering enable status for this node is the logical AND of the enable flags
on this node and all of its ancestors. This means that the World node is
disabled if any of its ancestors are disabled. The status of the World node
has an effect only if all its ancestors are enabled. Options are True and
False.

■ Alpha Factor: Allows groups of mesh objects to fade in and out
conveniently, provided that certain preconditions related to their
appearance are met. The Alpha Factor is defined for each node, and its
value is between 0 and 255.
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■ Scope: Allows the scene graph nodes to form conceptual groups
independent of the scene graph hierarchy. By default, all objects are visible
to all cameras and lit by all light sources. The scope is an integer bitmask
set to -1 by default.

Background

Every world object has two sub-objects: [Background] and [Active Camera].
The only parameter available for the Active Camera is selecting an active
camera from sub-objects of the current World Object. Background parameters
are listed below:

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Image Mode X and Image Mode Y: Sets the background image repeat mode
for the X and Y directions. Image mode can be set to either Border or
Repeat.

■ Depth Clear Enabled: Enables or disables depth buffer clearing. If depth
buffer clearing is enabled, the portion of the depth buffer that corresponds
to the viewport is cleared to the maximum depth value. Set this parameter
to True to enable depth buffer clearing. Set it to False to disable.

■ Color Clear Enabled: Enables or disables color buffer clearing. If color buffer
clearing is enabled, the portion of the color buffer that corresponds to the
viewport is cleared with the background image and/or the background
color. Set this parameter to True to enable color buffer clearing. Set it to
False to disable.

Group

Group is a scene graph node that stores an unordered set of nodes as its
children. A Group object is represented as <<Group>> in the JSR-184 scene
tree.

NOTE Since most JSR-184 objects cannot contain any sub-objects, the JSR-184
exporter uses the Group object to represent the 3ds Max hierarchy. In this case,
the Group object is assigned a name such as <<ObjectName Group>>, where
ObjectName is the name of the 3ds Max object with sub-objects. Parameters
available for Group objects are the same as parameters for World objects.
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Camera

Camera is a scene graph node that defines the position of the viewer in the
scene and the projection from 3D to 2D. A Camera object is assigned the same
name as its counterpart in the original 3ds Max scene.

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Scope: Allows scene graph nodes to form conceptual groups independent
of the scene graph hierarchy. The default scope is -1, implying that all
nodes are in the same scope. By default, all objects are visible to all cameras
and are lit by all light sources.

■ Projection Type: Sets the projection mode for the Camera. Options are
Parallel and Perspective.

Ambient Light

Ambient light represents the ambient light color from the 3ds Max
environment setting. Ambient light parameters are the same as Light
parameters.

Light

Light is a scene graph node that represents different kinds of light sources. A
Light object is assigned the same name as its counterpart in the original 3ds
Max scene.

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Enable Rendering: Sets the light to On or Off. Options are True and False.

■ Scope: Allows scene graph nodes to form conceptual groups independent
of the scene graph hierarchy. The default scope is -1, implying that all
nodes are in the same scope. By default, all objects are visible to all cameras
and are lit by all light sources.

Sprite3D

Sprite3D is a scene graph node that represents a 2–dimensional image with a
3D position. The only way to create a Sprite3D object is to convert a
two-polygon 3ds Max mesh object. A Sprite3D object is named “Sprite,
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ObjectName,” where ObjectName is the name of the corresponding 3ds Max
mesh object.

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Enable Rendering: Sets the rendering enable flag of this node. The effective
rendering enable status for this node is the logical AND of the enable flags
on this node and all of its ancestors. This means that this node is disabled
if any of its ancestors are disabled. The status of this node has an effect
only if all its ancestors are enabled. If the effective status is set to True, this
node is enabled. If it is False, it is disabled.

■ Scope: Allows scene graph nodes to form conceptual groups independent
of the scene graph hierarchy. The default scope is –1, implying that all
nodes are in the same scope. By default, all objects are visible to all cameras
and are lit by all light sources.

Mesh

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Scope: Allows scene graph nodes to form conceptual groups independent
of the scene graph hierarchy. The default scope is –1, implying that all
nodes are in the same scope. By default, all objects are visible to all cameras
and are lit by all light sources.

■ Projection Type: Sets the projection mode for the Camera. Options are
Parallel and Perspective.

Morphing Mesh

Morphing mesh is a scene graph node that represents a vertex-morphing
polygon mesh. A morphing mesh object is assigned the same name as its
counterpart in the original 3ds Max scene. Morphing mesh parameters are
the same as mesh object parameters.

NOTE Morphing animation is not supported. A Morphing mesh is exported with
morph targets. If you wish to export a morphing mesh animation, set animated
weights to morph targets during playback.
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Skinned Mesh

Skinned Mesh is a scene graph node that represents a skeletally-animated
polygon mesh. A skinned mesh object in the JSR-184 scene is assigned the
same name as its counterpart in the original 3ds Max scene. Skinned mesh
parameters are the same as Mesh Object parameters.

NOTE Biped meshes are not supported.

JSR-184 Texture Tool

File menu > Export > JSR-184 (*.M3G). > Name your file and click OK. > Select
a texture in your scene. > Click the Texture Tool button to edit the texture
properties.

You can edit the parameters that are exported for the textures in your JSR-184
scene. The Texture Tool dialog displays a preview of the texture with its current
settings. When you select different options, the preview is updated to reflect
the changes. You can modify the parameters described in this topic.

NOTE If the image is not a texture, then you can choose any palette in the Image
Format group.
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Interface

Image Width group

The JSR-184 format requires that texture sizes use the “power of two rule,”
and supports texture sizes less than or equal to 2562. You can select either 2,
4, 8, 16, 32, 64, 128, or 256.

If you want to modify the image width of all of the textures in your JSR-184
scene, turn on Apply To All; otherwise, the changes affect only the selected
texture.

Image Height group

These are the same options as Image Width: you can select either 2, 4, 8, 16,
32, 64, 128, or 256.

If you want to modify the image height of all of the textures in your JSR-184
scene, turn on Apply To All; otherwise, the changes affect only the selected
texture.

Image Format Group

Changes the color model of all textures in your JSR-184 scene.
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If you want to modify the image format of all of the textures in your JSR-184
scene, turn on Apply To All; otherwise, the changes affect only the selected
texture.

■ RGB 24 bit (16.7 Million of colors) Changes the color model to RGB color.

■ Grayscale 8 bit (256 grayscales ) Changes the color model to grayscale.

■ Optimized Palette (256 colors adaptive palette) Changes the color model
to a limited 256-color palette.
The Optimized Palette option is available only when the Save To External
File option is on. This palette does not support an alpha channel.

Save to External File When on, saves the texture as an external file (in
PNG format) in the same directory as the M3G file. If you do not select
this option, the texture is saved as part of the M3G file only.

Alpha Channel When on, saves the alpha channel with the texture.

JSR-184 Log Files

File menu > Export > JSR-184 (*.M3G).

When you export an M3G file, the JSR-184 Export feature creates a log file.
This log file is an HTML file, saved in the same directory as the M3G file. The
table contains an entry for all the objects exported to the M3G file format.

■ Object # Indicates the root object value. When multiple root objects
exist in the M3G file, this value is used by the JSR-184 Load object to load
the correct object.

■ Object Name Contains the name of the corresponding 3ds Max object.

■ Object Type Indicates the type of saved object.

■ User ID Displays the User ID for the object.

■ Object Size Shows the object size (in kilobytes) for the object.

■ Comments Displays additional information such as errors and
warnings.
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Below is a sample of a simple log file:

CommentsObject SizeUser IDObject
Type

Object
Name

Object #

1610Vertex Ar-
ray

890Vertex Ar-
ray

480Vertex
Buffer

2130Triangle
Strip Array

300Material

330Appearance

780MeshBox01

660Group

890CameraCamera01

900LightOmni01

260Group

500Light

400Background

580World0
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JSR-184 Standalone Player

Start menu > Programs > Autodesk > Autodesk 3ds Max 2008 [installed version]
> JSR184 Viewer

Once you have exported your 3ds Max scene to JSR-184 format, you can
preview how the animation is displayed on various mobile screens.

Interface

File menu

■ Open Opens an M3G file for viewing in the JSR-184 player.

■ Reopen Displays a list of recently opened files. The list displays the most
recently opened files at the top.

■ Exit Closes the JSR-184 viewer window.
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Tools menu

■ Handsets Allows you to add or edit phone profiles. You can modify the
vendor, model, screen width, screen height, and screen color depth.

NOTE You can also modify the handset profiles directly in the terminals.xml
file in the c:\Program Files\Autodesk\3ds Max 9\JSR  directory.

Player controls

The player is controlled by the following buttons on the toolbar:

■  Opens the Choose Objects for Rendering dialog. This dialog allows
you to select the JSR-184 world object in the scene hierarchy in the event
that there are multiple world objects in the JSR-184 data file.

■  Steps one frame backward through the animation.

■  Plays the animation.

■  Stops the animation and returns to the first frame.

■  Pauses the animation.

■  Steps one frame forward in the animation.

Phone Profiles Displays the phone profiles defined in the Tools > Handsets
dialog.

Use Free Camera Switches to viewing the scene from the free camera. The
camera is controlled by the following keyboard shortcuts:

Rotate LeftLeft Arrow
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Rotate RightRight Arrow

Rotate UpUp Arrow

Rotate DownDown Arrow

Move LeftA

Move RightD

Move BackwardS

Move ForwardW

Move camera to defaultHome

LandXML (XML, DEM) Files

Importing LandXML/DEM Models

LandXML/DEM Model Import lets you import land development data into
3ds Max. Civil engineering data, from XML, DEM (digital elevation model),
or DDF files, is used to create a 3ds Max model.
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The LandXML/DEM Model Import dialog on page 7046  allows for
interoperability with Autodesk products such as Land Development Desktop
3, Land Development Desktop 2005, Civil 3D™, and CAiCE Visual PE. Once
imported, the models are ready for high-quality photorealistic rendering and
animations.

LandXML File Types

There are three file types you can import with the LandXML/DEM Model
Import dialog: XML, DEM, and DDF.

■ XML is the most robust file type for LandXML import. In addition to surface
elevation data, XML files can also contain Alignment (road) and Parcel
data.

■ The DEM (digital elevation model) file type is the most commonly available
large area surface data type supplied by the USGS and other government
and private organizations. DEM files contain only surface data.

■ The DDF file type is an SDTS (spatial data transfer standard) format grid
surface. DDF files are very similar to DEM files; however, DDF information
is shared across multiple files.
The LandXML/DEM Model Import utility searches for the key DDF file in
the selected directory, which is identified by the following pattern: xxxxCEzz,
where xxxx is usually numeric and zz typically 'L0'.

Like DEM files, DDF files only contain surface data.
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LandXML/DEM Model Import Dialog

File menu > Import > Select File to Import dialog > Files of Type >
LandXML/DEM (*.DEM, *.XML, *.DDF)

In the LandXML/DEM Model Generator, you determine which parts of your
land development data are imported to 3ds Max. 3ds Max then creates separate
objects for each of the land features, including terrain surfaces, road
alignments, and parcels.

Interface

Object List Lists the terrain surfaces, alignment data, and parcel data in the
file to be imported. You can toggle the import of individual objects or entire
groups with their corresponding check boxes.

Three types of civil engineering data stored in LandXML files are supported:

■ Surfaces 3D TIN ground and finished surface model. Terrain surface data
is imported to 3ds Max as an editable mesh.

■ Alignments 2D road centerlines. Alignment data is imported to 3ds Max
as a Shape object.
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NOTE DEM and DDF files do not contain Alignment data.

■ Parcels 2D legal parcel or lot boundaries. Parcel data is imported to 3ds
Max as a Shape object.

NOTE DEM and DDF files do not contain Parcel data.

NOTE 2D Alignment and Parcel shapes are created on top of the highest terrain
surface.

File Data group

The File Data group displays information about the file to be imported,
including date of creation, author, the application used to create the file, and
the units.

Object Creation Options group

The Object Creation Options group lets you set the import properties for
selected objects.

Color The color of the object when it is imported into 3ds Max. To change
this setting, click the color swatch and select a new color from the Color
Selector.

Smooth Surface Applies smoothing to the geometry, based on the Smoothing
Angle setting. Edges between faces that have an angle between them that is
greater than the specified smoothing angle will appear faceted in the scene.
Edges between faces that are below or equal to the specified angle are
smoothed.

NOTE This option is only available for terrain surface objects.

Smoothing Angle Determines the size of the smoothing angle.

NOTE This option is only available for terrain surface objects.

Model Creation Options group

Set Scene Units from file Changes the 3ds Max Scene Unit to match the
units of the incoming file.
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NOTE This setting is only available when the 3ds Max scene is empty. If there is
geometry in your scene, this setting is not available.

The units setting of the incoming file is displayed in the drop-down list.

Vertical Exaggeration Scale Artificially exaggerates the terrain surface to
enhance subtle details by applying a scale factors to the vertical dimensions.

TIP This can be useful for very flat surface models.

Exporting Lightscape Files

You can export your 3ds Max scenes to Lightscape. Lightscape is a visualization
application that uses radiosity and ray tracing to create accurate lighting for
3D models.

NOTE This feature is being retired. For more detailed information about Lightscape
export and import, you can refer to the 3ds Max 8 reference. You can download
the v8 reference from the Autodesk Web site: go to www.autodesk.com, choose
Support, pick the product Autodesk 3ds Max, and then choose Documentation.

You can export several Lightscape file formats from 3ds Max. The Lightscape
Preparation (*.lp) file is the main format Lightscape uses. Other Lightscape file
formats save selected portions of the information in the LP file. These are the
additional Lightscape file formats:

■ View file (*.vw): Exports the active view, or selected camera views.

■ Block file (*.blk): Exports materials, lights, and geometry. Blocks in a block
file can be selectively loaded into Lightscape.

■ Material file (*.atr): Exports materials.

■ Layer file (*.lay): Exports layers.

■ Parameter file (*.df): Exports processing parameters.

Overall Workflow for Exporting a Lightscape Preparation (LP) File

1 Select the object to be exported.

2 Open the Export Lightscape Preparation File dialog.
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3 If your scene uses standard lights, set the units and scale, and then set
the light conversion method.

4 If you are exporting an animation, select the frames to be exported.

5 If your scene uses daylight, set the daylight parameters.

6 Select the cameras to be exported.

7 Export the file on page ? .

Procedures

To export a Lightscape file:

1 Choose File > Export.

The Select File To Export Dialog is displayed.

2 Use the Save As Type list to choose which kind of Lightscape file format
you are exporting.

3 Use the Save In list to navigate to the appropriate directory.

4 In the File Name field, enter the name of the file that you want to create,
and then click Save.
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To get version information about the Lightscape exporter:

1 Export one of the Lightscape file types.

A dialog with options for that file type is displayed.

2 Click About.

An About dialog is displayed. The dialog shows the version of the
Lightscape exporter.

Importing Lightscape Files

Just as you can export a Lightscape Preparation (LP) file, you can also import
one into 3ds Max. You can also import Lightscape Solution (LS) and Lightscape
View (VW) files.

NOTE This feature is being retired. For more detailed information about Lightscape
export and import, you can refer to the 3ds Max 8 reference. You can download
the v8 reference from the Autodesk Web site: go to www.autodesk.com, choose
Support, pick the product Autodesk 3ds Max, and then choose Documentation.

The steps to import a Lightscape file include:

■ Accessing the import dialog.

■ Choosing to replace the current scene.

■ Choosing how to group the imported objects.

■ (LS files.) Specifying a prefix for imported Lightscape objects.

■ (LS files.) Choosing which Lightscape objects to import.

■ (LS files.) Choosing the conditions for importing Lightscape lights.

■ (LS files.) Choosing the radiosity mapping settings.

NOTE The Lightscape importer does not convert Lightscape layers into 3ds Max
scene layers, because it was written before that feature was implemented.

Procedures

To import a Lightscape (LS, VW, or LP) file:

1 Choose File > Import.
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The Select File To Import dialog is displayed.

2 Choose Lightscape (*.LS, *.VW, *.LP) from the Files Of Type drop-down
list.

3 Use the dialog's controls to browse to the directory that contains the file
you want to use. Highlight the name of that file, and then click Open.

Depending on the type of file you chose, an Import Lightscape Preparation
dialog or an Import Lightscape Solution dialog is displayed.

No dialog is displayed when you import a Lightscape view (VW) file.

To replace the current scene:

When you import a Lightscape Solution or Preparation file, you can choose
to add the imported objects to the current scene, or to replace entire scene.

1 In the Import Lightscape Preparation dialog, turn on Replace Current
Scene.

2 In the Import Lightscape Solution dialog, turn on Replace Scene Contents.

To group imported objects:

■ In the Import Lightscape Preparation or the Import Lightscape Solution
dialog, use the controls in the Entity Grouping group to choose how
imported Lightscape objects are grouped.
See each dialog's description for details about these options.

To get version information about the Lightscape file importer:

1 Access the Import Lightscape Solution dialog.

2 Click About.

An About Lightscape LS File Import dialog is displayed. This shows the
version of the importer that is currently installed.

Lightscape Materials Utility

Utilities panel > Click More. > Utilities dialog > Choose Lightscape Materials.
> Lightscape Materials rollout
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With the Lightscape Materials utility, you can add the Lightscape material
on page 5579  to multiple objects, and remove the Lightscape radiosity material
from multiple objects.

Interface

Selected Object group

Displays the name of the currently selected object. If no objects are selected,
displays None Selected. If more than one object is selected, displays Multiple
Selected.

Add to All Click to add a Lightscape material to all materials used by all
objects in the scene.
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An object's previous material, if any, becomes the Lightscape material's base
material. If a material is already using a Lightscape material, it remains
unchanged.

You set the new Lightscape material's values in the Radiosity Mapping group,
described below.

Add to Selected Clicking to add a Lightscape material to all materials used
by the current selection.

An object's previous material, if any, becomes the Lightscape material's base
material. If a material is already using a Lightscape material, it remains
unchanged.

You set the new Lightscape material's values in the Radiosity Mapping group,
described below.

Remove from All Click to remove the Lightscape material from all materials
used by all objects in the scene.

Each material's base material becomes the top-level material. If a material is
not using a Lightscape material, it remains unchanged.

Remove from Selected Click to remove the Lightscape material from all
materials used by the current selection.

Each material's base material becomes the top-level material. If a material is
not using a Lightscape material, it remains unchanged.

These parameters are used only when you add the Lightscape materials. They
set the initial values of the new Lightscape material.

Radiosity Mapping group

Brightness Controls the brightness of the displayed image on your monitor.
The setting of this control does not affect the actual lighting levels in the
model. Default=50.0.

Contrast Controls the contrast between light and dark regions in the model.
Default=50.0.

Ambient Light Controls the amount of 3ds Max ambient light that will be
mixed in with the radiosity calculations. If the value is 0.0, none of the 3ds
Max ambient light is used. If the value is 1.0, the full 3ds Max ambient light
is added into the radiosity calculations. Default=0.0.

Daylight Determines whether you want natural daylight to be used in the
calculation. Default=on.

Exterior Scene Used for exterior daylight simulations. Default=off.
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Motion Analysis Files (HTR/HTR2,TRC)

Importing HTR/HTR2 Files

File menu > Import > Motion Analysis HTR File (*.HTR)

The Motion Analysis HTR (Hierarchical Translation-Rotation) motion capture
file format is an alternative to the BVH on page 7726  format because it provides
flexibility in data types and ordering. It also has a complete base pose
specification, which consists of indicating the starting point for both rotations
and translations.

The stored data is grouped by segments; all motions from the first segment
are read, then those from the next segment, and so on.

The HTR format contains four sections: Header, Segment Names & Hierarchy,
Base Position, and the motion data section.

NOTE All section titles are displayed between square brackets ([]).

NOTE Comments within the HTR file are denoted by a hash mark (#).

The header section contains global parameter information:

■ file type

■ data type

■ file version

■ number of segments

■ number of frames

■ data frame rate

■ Euler rotation order

■ calibration units

■ rotation units

■ global axis of gravity

■ bone length axis

■ scale factor
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HTR2 is nearly identical to HTR, except that the data from the motion section
is organized differently in order to better suit a streaming data input (a
sample-major ordering is used to present the motion information).

On import, 3ds Max constructs a FK hierarchy rig from the incoming data.
The resulting bone skeleton is linked to a dummy object named after the HTR
file.

Interface

Skeleton group

Create Choose this option to build a new bone skeleton from the incoming
data. Default=on.

Segment Size Set this value to modify the scale factor for the weight and
height of all bones from the motion capture data. Only available if Create is
active.

NOTE This does not change the skeleton's scale.

End Effectors Toggle this option to import end effectors on page 7767  from
the incoming data, if they exist. Only available if Create is active.

Apply Choose this option to map the incoming data onto the children of
the selected skeleton root in your scene.

Keyframe Options group

Base Position  When on, imports only the keys of the base pose.

Animation When on, imports all animation keys. Default=on.
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Rotation Controller group

Euler/TCB Choose one of the two rotation controllers on page 3076  to apply
to the imported data.

Time Options group

These options (except Set Frame Rate) are only functional if the Animation
option in the Keyframe Options group is enabled.

All/Range Choose between using the entire animation range from the motion
capture file, or a defined portion.

From/To These values represent the start and end frames of the defined
range. Only available if Range is active.

Offset Sets the number of inserted empty frames before the imported
animation starts.

NOTE This does not affect the Base Position setting (in the Keyframe Options
group), which sets a key at frame 0.

Set Frame Rate When on, the frame rate on page 7791  from the HTR file
overwrites the current one in the Time Configuration dialog on page 7359 .

Scale group

Global Sets the size of the resulting skeleton.

NOTE The scale value within 3ds Max remains 100.

Ok Proceeds with HTR/HTR2 import, using the current settings.

Cancel Cancels HTR/HTR2 import.

Importing TRC Files

File menu > Import > Motion Analysis TRC File (*.TRC)

The Motion Analysis TRC motion capture file format represents the raw form
(in ASCII) of tracking output. It contains a header section and a motion section.

All tracking markers stored in a TRC file contain global positioning data and
do not share parent-child relationships among themselves.
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On import, 3ds Max converts the incoming data as either spheres or points,
which are named according to the markers names.

You can convert an imported TRC motion into CSM format on page 3740 using
the MACUtilities utility on page 3740  in order to map it onto a biped.

Interface

Cloud group

Create Choose this option to build a new set of marker objects. Default=on.

Apply Choose this option to map the incoming data onto the marker children
of the selected root in your scene.

NOTE The marker objects must be named to match the imported data.

Options group

Selected Items Only Imports the motion data only relative to the selected
objects in your scene. Available only if the Apply option (in the Cloud group)
is active.

Root Node Includes a root dummy on file import. Available only if the
Create option (in the Cloud group) is active.

Geometry group

These settings are available only if the Create option (in the Cloud group) is
active.
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Sphere/Point Choose between creating spheres or point helpers to illustrate
markers.

Size Sets the sphere diameter or point size, based on your choice above.

Time Options group

All/Range Choose between using the entire animation range from the motion
capture file, or a defined portion.

To/From These values represent the start and end frames of the defined
range. Only available if Range is active.

Offset Sets the number of inserted empty frames before the imported
animation starts.

Set Frame Rate When on, the frame rate on page 7791  from the TRC file
overwrites the current one in the Time Configuration dialog on page 7359 .

Scale group

Global Sets the size of the resulting skeleton.

NOTE The scale value within 3ds Max remains 100.

Ok Proceeds with TRC import, using the current settings.

Cancel Cancels TRC import.

Exporting HTR/HTR2 Files

File menu > Export > Motion Analysis HTR File (*.HTR)

The Motion Analysis HTR (Hierarchical Translation-Rotation) motion capture
file format is an alternative to the BVH on page 7726  format because it provides
flexibility in data types and ordering. It also has a complete base pose
specification, which consists of indicating the starting point for both rotations
and translations.

The stored data is grouped by segments; all motions from the first segment
are read, then those from the next segment, and so on.

The HTR format contains four sections: Header, Segment Names & Hierarchy,
Base Position, and the motion data section.
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NOTE All section titles are displayed between square brackets ([]).

NOTE Comments within the HTR file are denoted by a hash mark (#).

The header section contains global parameter information:

■ file type

■ data type

■ file version

■ number of segments

■ number of frames

■ data frame rate

■ Euler rotation order

■ calibration units

■ rotation units

■ global axis of gravity

■ bone length axis

■ scale factor

HTR2 is nearly identical to HTR, except that the data from the motion section
is organized differently in order to better suit a streaming data input (a
sample-major ordering is used to present the motion information).

On export, the root object is named after your file name.

NOTE To have a successful export, you have to select the root of the desired
skeleton.

NOTE You can only export one bone hierarchy at a time.
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Interface

Base Position group

Saved Pose Choose this option to use the skeleton's pose at frame 0 as base
position data. Default=on.

Current Pose Choose this option to use the skeleton's pose at the current
frame as base position data.

Options group

Export Animation Enable to export all animation keys. Otherwise, only the
base position is exported.

Parent Transforms Enable to include the root object's animation data in the
export file.

Time Options group

These options are only functional if the Export Animation option in the
Options group is enabled.

Slider/Range Choose between using your scene's time slider on page 7312
range or a defined portion.

From/To These values represent the start and end frames of the defined
range.

Offset The exported animation starts after the number of frames set by this
value.
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Scale group

Global Sets the bone length scale factor in the export file.

Ok Proceeds with HTR/HTR2 export, using the current settings.

Cancel Cancels HTR/HTR2 export.

Exporting to Shockwave 3D

You can set up 3D scenes and animations in 3ds Max, and then export them
in Shockwave 3D (W3D) format for use in interactive presentations in
Macromedia Director. To start this process, choose File menu > Export, and
choose Shockwave 3D Scene Export (*.W3D) as the file type. Choosing this
format opens the Shockwave 3D Scene Export Options dialog on page 7062 .

The Shockwave exporter in 3ds Max offers significant differences from the
3ds Max exporter previously available from Macromedia. When you prepare
a scene for exporting to Director, please be aware of the following:

■ Bones require special consideration when being exported to Shockwave
3D format. See “Exporting Bones” below.

■ Hidden objects are not exported. However, bones are exported whether
hidden or not.

■ The exporter supports specular lighting for light sources with Specular
turned on in the General Parameters rollout > Affect Surfaces group.

■ Some types of mapping distort or disappear on export. Whenever possible,
use Multi/Sub-Object materials rather than maps.

Exporting Bones

The exporter supports character animation using bones and the Skin modifier,
or a character studio® biped with the Physique® modifier. Bones are exported
not as geometry, but as Shockwave 3D bones.

If the bones deform a mesh with the Skin modifier, the scene must be arranged
in a specific manner to cause the bones and mesh to export properly:

■ All bones for each mesh object must be linked, and linked contiguously.
In other words, each bone must link to another bone, with one bone acting
as the root for the entire hierarchy.
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■ You'll get the best results if all bones are created in the same viewport, and
bones are created individually (not copied or mirrored).

■ All vertices in the skinned mesh must be assigned to at least one bone,
even if they constitute a part of the mesh that isn't animated. Otherwise,
the mesh will distort on export.

■ You must group the bones and the skinned mesh with the Group menu
> Group command prior to export. If you have more than one set of bones
with skinned meshes, create a separate group for each.

■ You can also export animation on IK chains and dummy objects. These
objects must be grouped with the skin and bones to export correctly.

For more tips on working with bones animation and the Shockwave 3D
Exporter, visit the
http://www.macromedia.com/support/director/work_3d/models_use_in_sw/models_use_in_sw07.htmlMacromedia
Web site . Also, search the Macromedia site for “bones shockwave export”
(without the quotes).

Shockwave 3D Scene Export Options Dialog

File menu > Export > Select File To Export dialog > Save As Type > Shockwave
3D Scene Export (*.W3D)

This dialog appears when you choose the Shockwave 3D format as the export
format for your scene.
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Interface

Resources to Export group

Scenegraph hierarchy Controls whether or not the parent-child hierarchy
between all geometry, light, group, and camera resources is written to the
Shockwave 3D file. This option should always be selected when exporting an
entire scene from 3ds Max. The Shockwave 3D scenegraph contains:

■ Information on parent-child relationships.

■ Information about what resources each scene element uses (for example,
the model resource used by a model in the scenegraph).

■ Controls for any modifiers associated with the geometry resources.
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■ Information about any cameras, lights, and groups in the scene. Shockwave
3D treats cameras, lights, and groups as less important resources, and stores
information about them only in the scenegraph.

The scenegraph hierarchy is the glue that binds most of the scene assets in
the Shockwave 3D file. If this option is turned off, only shader, texture, model,
and motion resources will be written to the W3D file, and all the other
information that specifies how objects exist in the scene, how the scene is
laid out, how the scene is lit, and how the scene is viewed will be missing. For
this reason, turn this option off only when exporting libraries of animations
or texture maps.

NOTE The exporter will remember this setting from one export to the next. Be
sure to turn on this option again before trying to export an entire scene. If you
do not, the result will be unusable (except as an object and texture library).

Geometry resources Exports all meshes and their associated bones to the
Shockwave 3D file. If this option is turned off, the preview window will be
completely black. All other designated resources will be written to the W3D
file.

Animations Writes out the animation on all objects supported by the exporter
to the Shockwave 3D file. The preview window is useful in quickly showing
which animations the exporter is capturing.

By default, the Shockwave 3D Exporter captures the animation of all objects
in the scene in every frame. This data is compressed into a streaming format
as the file is written. There may be times, however, when you only want to
capture part of an animation, or sample it more coarsely than once a frame.
If this option is cleared, the full scene will be displayed in the preview window
without any animations.
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NOTE 3ds Max supports direct animation of cameras and lights. If you animate
a camera or light, that animation will be exported, but an extra geometry node
will be inserted into the scene during the export process. This geometry node has
the animation of the camera or light applied to it, and the camera or light is made
a child of this extra node.

The exporter does this because the Shockwave 3D runtime engine supports
keyframes only on geometric nodes. The extra node that the exporter creates
is named "Dummy Animation Node xyz", where xyz is the name of the
animated camera or light. This dummy geometry node also has a dummy
material applied to it named Dummy Material, and the geometry is invisible.

Lingo™ programmers should note that the camera or lights transform is now
relative to the dummy geometry node, that is, its parent.

IMPORTANT Animation export compression collapses non-bone-based hierarchies
(simple linked hierarchies in 3ds Max), so only animation assigned to the root
exports properly. For example, in a simple head animation where the eyes and
eyelids are linked to the skull, the skull movements export but the eye and eyelid
animations do not. Because 3ds Max groups do not collapse on export, you should
link each element of your chain, and then group each element with its parent
starting from the bottom of the chain and working to the top. Arrange each group's
pivot point, and then animate only the group objects, and not their contained
elements.

Material resources Exports all basic materials associated with all objects
supported by the exporter to the Shockwave 3D file. Materials represent the
most basic properties that can be assigned to a surface, such as diffuse color,
opacity, and specular color.

We strongly recommend that you leave this option on when exporting any
geometry, shader, or texture map resources. Turn this option off only when
exporting just the animation in a scene; otherwise, the W3D file will not work
correctly with Director.

Texture map resources Exports all texture maps associated with all objects
supported by the exporter to the Shockwave 3D file. Texture maps in
Shockwave 3D are bitmap images or 2D procedural maps, such as Tile and
Gradient Ramp. All bitmap images used in 3ds Max are transformed by
Shockwave 3D into streaming JPEG images.
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NOTE The terms "Texture," "Map," and "Texture Map" are used interchangeably.
If this option is turned off, models will be untextured when first loaded into
Director, because they will have no texture information (despite their being visible
and fully shaded in the preview window). Once textures are assigned to the proper
shaders with Lingo, the models will look properly textured.

Shaders Exports all shaders in the Shockwave 3D file. Shaders are the
highest-level entities that describe surface properties. They bear no relationship
to the shaders used in 3ds Max. Shockwave 3D does not distinguish among
Blinn, Phong, Anisotropic, or any other shader algorithm that determines the
rendered look of materials and maps. Only Gouraud shading, which is most
closely emulated by the standard shaders in 3ds Max, is supported. Shockwave
3D shaders are primarily pointers to texture map resources on page 7065  and
material resources on page 7065 .

NOTE The Shaders option should be used in conjunction with the Texture Map
Resources and Material Resources options. If this option is turned off, models will
be invisible when first loaded into Director, because they will have no shading
information (despite their being visible and fully shaded in the preview window).
Once shaders are assigned to the models with Lingo (Director's scripting language),
the models will become visible and look properly shaded.

Enable Toon and SDS When turned off, this option prevents the writing of
geometry data used by some of the more advanced Shockwave 3D technologies,
and thus reduces the overall file size.

If turned off, Toon and Subdivision Surfaces (SDS) data is not included in the
export file, which means that the Toon and Subdivision Surfaces modifiers
cannot be applied to the model in Director. A model missing this geometry
data can be used with all other Shockwave 3D technologies, however. Leave
this option turned on unless it is expedient to reduce the size of the W3D file.

NOTE There is no way to tell if a W3D file was exported with this option enabled
or disabled until you try to apply the Toon or SDS modifiers in Director. For this
reason, if you turn off this option, use a special naming convention to indicate
that a model doesn't have the Toon or SDS data in it.

Light resources Exports all lights in the scene to the Shockwave 3D file.

Turning this option off doesn't do anything unless the scenegraph hierarchy
option is also turned off. The only time you should turn this option off is
when exporting just the animation, geometry, or texture data in a scene.
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Camera Determines the viewpoint used for the scene in Director. This option
defaults to Active Viewport, but if any cameras exist in the scene, you can
choose one from the drop-down list.

NOTE In order to preview or export an animated camera, you must select that
camera from the list. Selecting Active Viewport with an animated camera will not
export that camera's animation.

Compression Settings group

The Shockwave 3D file contains all scene assets in a proprietary compressed
and streaming format. You can control the order in which data streams with
the user properties. The amount of compression of the scene assets is set by
three controls: Geometry Quality, Texture Quality, and Animation Quality.
The controls have values that range from 0.1 to 100.0, with higher values
giving less compression and better quality (a more faithful representation of
the original model).

A value of 100 means that the scene assets will be represented at the best
quality possible, but with some degree of compression still present. It does
not represent the value at which compression does not occur. Also, the
compression controls do not have a linear scale, so a setting of 20.0 doesn't
necessarily mean that the quality level of the resulting data is twice as good
as that produced with a setting of 10.0.

Geometry quality Controls how much the scene geometry data (such as
vertex positions and normals and texture coordinates) is compressed. The
default of 25.0 generally produces a good compromise between data accuracy
and space savings.

Texture quality Controls the compression of textures (images) in the scene.

Animation quality Controls the compression of animation data in the scene.
Higher compression levels (lower quality) tend to remove the finer motions
authored in the scene, especially motion-capture data, while occasionally
introducing small noise artifacts.

NOTE You might need to use larger values of the Animation Sampling Interval
control on page 7068  (below) along with greater values of this setting to minimize
the file space consumed by animation while still maintaining acceptable motions.

Texture Size Limits group

The Texture Size Limits setting lets you reduce the size of the W3D file by
limiting the size of the texture maps in the export.
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The reduced size of the texture maps will usually look fine on the model,
because the model's UVW texture coordinates will have already taken into
account the non-square dimensions of the image. Use the smaller settings if,
after tuning the compression settings and simplifying the scene in 3ds Max,
the W3D file is still too large. If the scene contains no textures, or only small
textures, limiting the texture size will not help to reduce the size of the W3D
file.

No limits on texture size Exports all texture maps in the scene at the full
resolution of the image as used in 3ds Max. For example, a 2048 X 4096-pixel
image will be written to the W3D file at these dimensions (compressed, of
course).

512 by 512 pixels maximum Exports the texture maps so that no image
exceeds 512 X 512 pixels. A 2048 X 4096-pixel image will be scaled to a 512
X 512-pixel image; a 128 X 1024-pixel image will be scaled to a 128 X 512-pixel
image.

256 by 256 pixels maximum Exports the texture maps so that no image
exceeds 256 X 256 pixels. A 2048 X 4096-pixel image will be scaled to 256 X
256 pixels; a 128 X 1024-pixel image will be scaled to 128 X 256 pixels.

Animation Options group

The Animation Options group contains the controls to change how an
animation is captured.

Sampling interval This setting is used to capture object animation once every
specified number of frames.

Range These Start and End controls indicate which frames of the scene
animations are to be captured. By default, these values are set to capture the
entire animation interval specified in 3ds Max, sampling all animations in
the scene every frame.

Export Controls

Author Check Opens a window displaying warning messages about possible
problems found converting the scene to the W3D file format. If no errors are
found, the window is blank.

These messages, which do not necessarily indicate problems with the scene,
can be useful in debugging problems such as why the scene looks different in
the preview window than it does in 3ds Max. If the scene uses any 3ds Max
features that are not supported by the exporter, they will be listed here.
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Analyze Opens the Shockwave 3D File Analysis window on page 7071 ,
displaying a graphic breakdown of the data in the W3D file.

Preview Opens the Shockwave 3D Export Preview window on page 7069 ,
showing the scene as it will be exported.

File Opens the Choose Export File dialog, which lets you specify the name
and location of the file to be exported. When you click Save, you're returned
to the Export Options dialog; the file name and path you specified appear in
the field next to the File button.

NOTE Clicking the Save button does not save the W3D file; you must click the
Export button to create the file.

Export Exports the Shockwave 3D file, using the path and name specified
next to the File button.

View after export After you export a file, this option lets you view it in the
Preview window on page 7069 .

Shockwave 3D Export Preview

File menu > Export > Select File To Export dialog > Save As Type > Shockwave
3D Scene Export (*.W3D) > Preview

This window displays the scene as it has been captured by the Shockwave 3D
Exporter. This view lets you quickly identify scene elements that are not
supported by the Shockwave 3D Exporter.
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In many cases the export preview window will display scene resources you
had decided not to export. Remember that this window displays the scene as
captured by the exporter and not necessarily how it is written to the W3D
format. Only those scene assets indicated under the export options and
supported by the exporter will be written to the W3D file.

Export with a User, Top, Front, or Right viewport active in 3ds Max, and the
scene will be viewed through an orthographic camera. Export with a Perspective
or Camera viewport active in 3ds Max, and the scene will be viewed through
a perspective camera.

NOTE When navigating a scene, keep in mind that only the parts of models that
are in front of the camera will be rendered. Parts of models that penetrate the
camera plane and are behind the camera will not render, resulting in visual artifacts
("black holes" or "tearing") in the model. This is particularly noticeable when you
dolly an orthographic camera forward, because the lack of perspective effects does
not hide models as the camera passes them. Dolly the camera back, and any visual
artifacts should disappear.

You can navigate the export preview window using the following controls.
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Rotation

■ Drag (move the mouse with the left button held down)=orbit

■ Y+drag=rotating the camera with "Y-up" (particularly useful if the scene
was created in the "Y-up" environment)

■ Shift+drag=roll; vertical movement is ignored

Dolly

■ Ctrl+drag=dolly

■ Ctrl+Shift+drag=dolly faster

Pan

■ Spacebar+drag=pan

■ Shift+Spacebar+drag=constrain the movement to be either horizontal or
vertical, depending on the initial direction when you start dragging

Shockwave 3D File Analysis Window

File menu > Export > Select File To Export dialog > Save As Type > Shockwave
3D Scene Export (*.W3D) > Analyze

This window provides a graphic breakdown of the data in the W3D file. Click
OK to close the window.
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Interface

Pie Chart Graphic display of the proportion of the file used by all of the
W3D file data types. Refer to the color-coded Categories list, which gives a
percentage and an absolute size in kilobytes of each asset:

■ Geometry (in the initial load segment, if a model has a zero priority in
the sw3d_stream_priority user property, or in the streamable portion of
the file, if a model has a non-zero streaming priority)

■ Shaders (only in the initial load segment)

■ Textures (in the initial load segment, if the model that uses the texture
has a zero priority in the sw3d_texture_stream_priority user property, or
in the streamable portion of the file, if a model has a non-zero streaming
priority)

■ Materials (only in the initial load segment)

■ Lights (only in the initial load segment)

■ Animations  (only in the initial load segment)
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NOTE Large animations can greatly lengthen the time it takes to see the start
of a Shockwave 3D animation, because they must fully download before any
of the scene can becomes visible.

■ Nodes or scenegraph hierarchy data (only in the initial load segment)

■ Unknown includes, for example, streaming priorities, names, and block
sizes.

File Organization Graphic display of the size of the entire file and its initial
load segment (ILS) portion. The ILS, in orange, consists of all the data that
must be loaded before Shockwave will display the scene (scenegraph data,
animations, shaders, and any textures or geometry with a streaming priority
of zero). The rest of the file, in light blue, represents all of the streamable data
with a non-zero streaming priority. This data will continue to load and fill
out the detail of the scene as the download proceeds.

Runtime Texture Information Approximate texture memory that will be
required at run time to display the textures in the scene. Scenes requiring
more than a few megabytes of texture memory will require accelerated graphics
cards to display textures at their full resolution.

Stereolithography (STL) Files

Importing STL Files

File menu > Import > StereoLitho (*.STL)

An STL file saves object data in a format used for stereolithography. STL files
have a filename extension of .stl. There is an ASCII STL format as well as a
binary STL format. You can choose which to create when you export a 3ds
Max scene.

STL files are generally used for purposes of rapid prototyping. A variety of
methods use the STL format to construct prototypes. For example, many STL
machines use a liquid polymer and harden it in small slices, creating a solid
plastic model. Other STL machines use metal powder to create a model in
steel. Still other machines use a special wax.

You can import and export STL files. See Exporting to STL on page 7076 .
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Name Enter a name for the 3D Studio object created from the STL file. Default
is the file name (without extension) or the name saved internally in the STL
file.

Weld Vertices group

Welds coincident vertices in the STL file into single vertices in the 3D Studio
mesh.

Weld Threshold Determines the size of the area which vertices must occupy
to be welded. Vertices with distances equal to or less than this value are welded
into a single vertex.

Weld Turns on the Weld Vertices function. In most cases, you should leave
this box turned on because unwelded objects can't be unified or smoothed.

Use Threshold If on, STL import uses the standard 3D Studio welding method.
This can be a very slow process.

Quick Weld If on, STL import uses a welding algorithm optimized for the
STL format. This is up to thirty times faster than standard 3D Studio welding,
and is highly recommended.

Auto-Smooth group

Auto-Smooth Applies smoothing groups on page 7932  to the geometry based
on the smoothing angle set by the smooth angle spinner. Edges between faces
that have an angle between them that is greater than the specified smoothing
angle will appear faceted in the rendered image. Edges between faces that are
below the specified angle are smoothed

Smooth Angle Determines the size of the smoothing angle.

Auto-Smooth Turns on the Auto-Smooth function.

Miscellaneous group

Remove Double Faces Removes one of the pair wherever two faces are
occupying the same location. Recommended.

Unify Normals Forces the normals on page 7863  of all faces on each object
to face the same way (usually out). If, when you render your scene, the face
normals are pointing in the wrong direction, use the Normal modifier to flip
them. For best results, leave this box turned on.
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Exporting to STL

File menu > Export > StereoLitho (*.STL)

An STL file saves object data in a format used for stereolithography. STL files
have a file-name extension of .stl. There is an ASCII STL format as well as a
binary STL format. You can choose which to create when you export a 3ds
Max scene.

STL files are generally used for purposes of rapid prototyping. A variety of
methods use the STL format to construct prototypes. For example, many STL
machines use a liquid polymer and harden it in small slices, creating a solid
plastic model. Other STL machines use metal powder to create a model in
steel. Still other machines use a special wax.

An STL object must define a complete and closed surface. You can check
whether the geometry you want to export satisfies this criterion by using the
STL Check modifier on page 1678 .

You can also import STL files. See Importing STL Files on page 7073 .

7076 | Chapter 21   Managing Scenes and Projects



Interface

Object Name Enter a name for the object you want to save in STL format.

Binary/ASCII Choose whether the STL output file will be binary or ASCII
(character) data. ASCII STL files are much larger than binary STL files.

Selected Only Exports only objects that you selected in the scene.

Wavefront (OBJ, MTL) Files

3ds Max can import and export the text-based (ASCII) Wavefront formats OBJ
and MTL. An OBJ file contains geometry descriptions. A MTL file is also text
based, and contains material descriptions that supplement the OBJ file.

See also:

■ Exporting Wavefront Material (MTL) Files on page 7078

■ Exporting Wavefront Object (OBJ) Files on page 7079
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Exporting Wavefront Material (MTL) Files

File menu > Export > Wavefront Material (*.MTL)

The ASCII-based MTL format makes it possible to exchange graphical data
between many applications. The MTL format uses floating-point numbers to
define each material's ambient, diffuse, and specular colors, as well as alpha
and shininess values. Optionally, the MTL files can also specify texture-map
filenames.

Interface

Source Choose whether to export only materials used in the current scene,
or the entire material library.

Export maps When on, any map files used in exported materials are referred
to in the exported MTL file. File paths are not included, so map files must be
available upon subsequent importing.

File group

# of Digits Specifies the number of decimal places for exporting color values
such as ambient and diffuse in floating-point format.

Compress numbers When on, trailing zeroes are eliminated from decimal
fractions. This makes the exported file smaller without sacrificing any precision,
but can cause compatibility issues when importing with certain programs. If
you're unable to import a MTL file, make sure this option is off and export
again.
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Exporting Wavefront Object (OBJ) Files

File menu > Export > Wavefront Object (*.OBJ)

The ASCII-based OBJ format makes it possible to exchange graphical data
between many applications. Both polygons and freeform geometries such as
curves are supported with these format. You can export 3ds Max files to this
format.

Feature Support with OBJ Export

Mesh Geometry

■ When exporting mesh geometry, you can export triangles, polygons, or
quadrilaterals.

■ Normals are exported by default.

Groups

■ If you choose to group by object, then the exported information will be
organized by object. This information will be available when you import
the file so that you can choose certain objects to import rather than the
entire file.

■ If you select to group by material, then the exported information will be
organized by materials. When importing, you can select to only important
elements that are associated with a particular material.

See also:

■ Wavefront (OBJ, MTL) Files on page 7077

Wavefront (OBJ, MTL) Files | 7079



Interface

Group and Material group

Group by Lets you group the information in the OBJ file by object, material,
or by using defaults. The choice you make will be important when you want
to import the file. For example, it may be useful to group by material if you
have several objects that use the same material.

Use materials Determines whether the materials that are associated with the
object are also exported to the OBJ file.
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Create material library Determines whether a separate library is created to
store the information about the materials. This creates a MTL library in the
same directory as the OBJ file, first prompting for information with the MTL
Export dialog on page 7078 .

Geometry group

Rotate model Exports the geometry to match its orientation in 3ds Max.

Faces Choose whether the mesh faces are stored as triangles, quadrangles,
or polygons.

Texture coordinates When on, the texture coordinates are stored with the
exported file. When you import the file in another application you will be
able to use this information if it is supported.

Normals When on, the normal information on page 7863  for the mesh is
stored.

Smooth groups When on, the information about color transition between
groups is stored. See Viewing and Changing Smoothing on page 343 .

Vertex scale Determines the scaling for the contents of the OBJ file. The
default value of 1.0 means the exported file will have the same scaling as the
source file.

File group

# of Digits The precision of the exported vertex data, as expressed by the
number of decimal places.

Compress numbers When on, trailing zeroes are eliminated from decimal
fractions. This makes the exported file smaller without sacrificing any precision,
but can cause compatibility issues when importing with certain programs. If
you're unable to import an OBJ file, make sure this option is off and export
again.

Relative vertex numbers Causes face vertex indices in exported files to be
expressed as relative (i.e., negative) numbers. This can cause compatibility
issues when importing with certain programs. If you're unable to import an
OBJ file, make sure this option is off and export again.

Cancel Cancels the OBJ export.
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VRML Files

Importing VRML Files

File menu > Import > Select File To Import dialog > Files Of Type > VRML
(*.WRL, *.WRZ)

You can import VRML 1.0, VRBL, and VRML 2.0/VRML 97 files into 3ds Max.
3ds Max imports geometry, materials (including diffuse texture maps), lights,
perspective cameras and viewpoints, transformations, and grouping nodes
created by other VRML tools. Once they are in the scene file, you can edit,
modify, and animate these objects.

3ds Max also imports basic transform animations, such as position, rotation,
and scale. Also included are animated color and light. These correspond to
the basic animation that is exported by the VRML 1.0/VRBL and VRML97
exporters. Helper objects are not created upon import. Lighting effects are
somewhat simplified from the full VRML lighting model.

■ VRML97 files don't indicate the duration of an animation. If you import
animation from a VRML97 file, you might want to set the animation length
in 3ds Max manually.

■ More elaborate forms of animation and simulation, including Script nodes,
MovieTexture nodes, and sensor nodes, are not supported.

■ The VRML 1.0 WWW Inline works only if the URL refers to a local file
residing in the same folder as the .WRL file. Internet URLs are not
supported.
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Interface

Reset Scene Deletes any existing scene upon import. If you turn off this
option, the imported VRML world is merged into the 3ds Max scene.

Turn to 3DS Coordinates Rotates the imported VRML world from Y, which
is "up" in VRML, to Z, which is "up" in 3ds Max. If you turn off this option,
VRML X, Y, and Z coordinates are imported without change.

Create Primitives Converts the VRML Box/Cube, Cone, Cylinder, and Sphere
nodes to corresponding 3ds Max primitives, if possible. If the VRML object
has a texture on it, or if only part of the VRML object is to be created, a general
triangular mesh object will be created instead. If you turn off this option, 3ds
Max will convert these objects to triangular mesh objects.

Exporting to VRML97

File menu > Export > Select File To Export dialog > Save As Type > VRML97
(*.WRL)

3ds Max scenes can be exported to VRML97 file format.

See also:

■ VRML97 Export on page 7089
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Procedures

To export a file to VRML97:

1 Choose File menu > Export.

2 Choose VRML97 (WRL) as the file format.

3 Enter a file name, and click Save.

4 In the VRML97 Exporter dialog, set options as described below.
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Interface
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Generate group

Turning on any of these options increases the size of the VRML97 file generated
by the export process.

Normals Generates real normals for objects. Some browsers need normals
to do smoothing properly. Check this box if you are exporting geometry that
uses smoothing groups in 3ds Max, to see the correct shading. Default=off.

Coordinate Interpolators Exports animation effects that involve actual
modifications of the mesh objects, and not just move, rotate, and scale.
Examples include the Taper, Bend, and Twist modifiers, and space warps. This
option can generate large files, because the exporter has to calculate the
position of every vertex for this kind of animation.

If your animations aren't exporting correctly, try exporting with this option
chosen. An example of animation motion requiring Coordinate Interpolators
is a stick figure made up of simple rectangular boxes that have bones Linked
to the boxes as a skeleton. Even though these boxes move through space
without any noticeable shape morphing, their motion will not be exported
without the use of Coordinate Interpolators, because their motion isn't derived
from simple transforms. Any animation achieved using the modifier stack or
object parameters needs Coordinate Interpolators. This includes animated
XForm modifiers.

Certain types of animations are not possible with Coordinate Interpolators;
for example, when the mesh being animated changes size between frames.
An example of this is animating the number of segments in a sphere. 3ds Max
warns you if it detects this type of animation on export.

Indentation Indents the VRML97 source code so it is easy to read. Default=on.

Export Hidden Objects Exports hidden objects. Default=off.

Primitives Exports VRML97 primitives, which reduces the file size because
these primitives are described very simply (for example, a sphere is described
by its radius). To see how many polygons are in the scene, turn off this box
to export 3ds Max primitives, which have an indexed face set for each object.
Default=on.

Flip-Book Exports the scene to multiple files. The sample rate is set in the
in the Flip-Book section of the Sample Rates dialog. The file name you specify
becomes the base for the sequence of files. For example, if you specify the file
name test.wrl, choose one file per animation frame, and have five frames, 3ds
Max exports the following:

test.txt contains general info, start/stop times, and number of frames.
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test0.wrl through test4.wrl are snapshots of the animation in frames 0 through
4.

Color Per Vertex Exports the vertex colors of geometry. If this is turned on,
the Color Per Vertex Source lets you choose the source of the vertex color.

Polygons Type

Determines how geometric faces are written out as VRML97 IndexedFaceSet
nodes.

Ngons Writes faces with as many edges as possible.

Quads Writes quadrilateral faces where possible (otherwise triangles).

Triangles Writes only triangular faces.

Visible Edges Breaks faces at internal edges that are marked as being visible.

Initial View

Sets the entry camera for the scene and controls what first appears in the
browser. If there are no cameras in the scene, the scene appears with a default
viewpoint (which may give only a partial view).

All scenes should have at least one camera, so you can control how the scene
initially renders. Add more cameras to the scene than you might ordinarily
use, so the viewer can switch between cameras if his VRML97 browser allows
it. This lets you set up your scene with pre-installed vantage points. Otherwise,
if the world is very large, it can overpower the viewer’s system and make
navigation difficult. Some browsers animate camera moves, so the extra
cameras can make viewing the scene more pleasant.

Initial Navigation Info

Specifies the Navigation Info helper object on page 7098  to use when the world
loads in the browser.

Initial Background

Specifies the Background helper object on page 7109  to use when the world
loads in the browser.
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Initial Fog

Specifies the Fog helper object on page 7099  to use when the world loads in
the browser.

Digits of Precision

Sets the number of decimal points used for calculating dimensions. The default
of 4 is usually sufficient. Set this number greater than 4 if parts of your world
were created 100,000 units away from the center of the scene. Setting the
value to 3 reduces the file size.

Show Progress Bar

Gives you the option to view a progress bar as the scene is exported.

Vertex Color Source group

Lets you choose the source for the vertex color when Color Per Vertex is turned
on.

Use Max's Exports the current vertex color of the object defined in the scene.

Calculate on Export Calculates the diffuse color at the vertices during export,
based on the current lighting and the objects’ materials.

Bitmap URL Prefix group

Lets you specify a URL prefix for bitmaps assigned to objects in the scene. You
must keep all your texture bitmaps in either the same directory as the WRL
file or in one other location, which you specify here. If your maps are stored
in other locations, you will have to manually search for the map in the WRL
and change its location. Not all browsers will display error messages if the
maps aren’t found on the WWW server.

Use Prefix Enables the prefix mechanism. If this box is turned off, image
maps must be in the same location as the WRL file.

Prefix Adds the prefix you enter here to the names of all assigned bitmaps.
The name can be a full URL (beginning with HTTP), or it can be a relative
path (a subdirectory of the location of the VRML97 file). For example, if you
enter "Maps" for the prefix, when the browser opens a VRML97 file that has
a texture map assigned to it, it will look for the subdirectory "Maps." “Maps”
must be a directory that is directly under the directory where the VRML97 file
resides.
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Use forward slashes (not backslashes) to enter longer paths; for example:
Myfiles/maps.

Sample Rate

Displays a dialog that lets you specify sample rates for controller-based and
coordinate-interpolated animation, as well as the Flip-Book output rates.
Setting sample rates lets you trade off between animation fidelity and file size.
The default values give good results in most cases. For the greatest animation
precision, use a lower number (a higher sampling rate).

World Info

Lets you enter information about the world. This has no effect on the visual
appearance or behavior of the world. Some browsers can display what you
enter in the Title field, for example, in the browser window’s title bar. You
can use the Info field to provide author, version, and copyright information.

VRML97 Export

Vrmlexp.dle is for creating and exporting scenes in the VRML97 format.
VRMLEXP exports .wrl files, which can be viewed in any VRML97 browser.

Make sure that you have the most current version of your VRML browser and
check its documentation to insure that it supports VRML97.

This documentation covers:

VRML97 Helper Objects on page 7093

Exporting to VRML97 on page 7083

VRML97 Tips on page 7090

VRML97 Specification on page 7093

Procedures

To create VRML97 files:

1 Create the objects that make up the scene.

2 In the Create panel, choose Helpers.

3 Use the tools in the VRML97 Helpers on page 7093  to add actions and
triggers and prepare the scene.
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4 Choose File > Export and export the scene in the VRML97 format.

5 Open the VRML97 file in the browser and test it.

Interface

The VRML97 exporter supports the following:

Lights All VRML97 light types: direct, omni, and spot.

Cameras Free and targeted cameras.

Primitives Sphere, cone, box, and cylinder primitive objects. These objects
export as VRML97 primitive objects. This helps reduce the size of VRML97
files.

Animation All position, rotation, and scale animation on objects, as well as
animated hierarchies, inverse kinematics, and all controller types. Select
Coordinate Interpolators on page 7083  in the Export dialog to export animated
meshes, such as an animated Bend modifier or character studio Physique
animations.

VRML97 Tips

The following tips will help you make your work look as good as possible and
display and move as fast as possible.

Geometry

Use small texture maps, and use them sparingly. Keep the polygon count of
your objects down to achieve good performance. A complete scene with a
maximum of 5,000 to 10,000 polygons is manageable for most computers.
The Level of Detail on page 7103  helper lets you manage the polygon count
of objects in the scene. You can also use the software’s Optimize modifier to
simplify objects before exporting them to VRML97.

Use primitives whenever possible. For example, a scene containing only a
sphere exports to a VRML97 file of about 400 bytes, but if you apply an edit
mesh modifier and move one vertex on the sphere, the VRML97 file is about
7,400 bytes.

Use Show Statistics on page 2493  to keep track of the number of faces in your
scene.

7090 | Chapter 21   Managing Scenes and Projects



Call your VRML97 .wrl files from a standard HTML page and constrain the
viewer to a limited window on the screen using the embed command. This
decreases the number of pixels that must be rendered on every frame and
makes the VRML97 environment more responsive. Many users use high
resolution (800x600 or more), so the number of pixels during rendering and
navigation can be large and the video display may slow down. Frames may
be dropped as the browser attempts to keep up its real-time rendering, and
navigating the scene will become "chunky.” Use the embed command to avoid
this, for example, <embed SRC=myworld.wrl WIDTH=300 HEIGHT=200>

Hide faces on an object in the software, then export the object. The hidden
faces appear as a hole in the object. While the VRML97 plug-in can export
hidden objects, it does not export hidden faces. Hide faces that you know will
never be visible in the scene, such as the backs of objects or the bottom faces
of objects resting on a surface.

Use instances to reduce file size for objects that have the same geometry.

Whenever you use a Mirror transform, use the Reset Transform utility
immediately afterward. You can also use a Normal modifier immediately
followed by Unify Normals. VRML97 does not allow mirror transforms
(negative scales). The Reset Transform utility modifies the data in the actual
mesh object to create the mirroring effect.

Don’t change units when modeling for VRML97. To model in meters, keep
the units set to the default and use one world unit as one meter.

Animation

Beware of large file sizes when you use transform animation and
coordinate-interpolated animation. The VRML97 plug-in exports transform
animation (move, rotate, and scale), and coordinate-interpolated animation.
For example, you can animate modifiers such as Taper and Bend and you can
animate changing parameters, such as increasing or decreasing the radius of
a sphere.

When scenes using the Inherit Links function are exported to VRML97, child
objects always inherit their parents’ transforms. Inverse kinematics export
correctly to VRML97 with the exception of the Inherit Links function, which
determines whether child objects inherit the transforms of parent objects.

Always use TCB controllers for VRBL animations. These controllers provide
precise control and generate the smallest possible file size. Other kinds of
controllers, such as the default Bezier controller, create larger VRML97 files
that do not perform as well.
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Make sure your animations never change the face or vertex count over time.
VRML97 can not add or delete faces or vertices over time.
CoordinateInterpolators support morphing a mesh only, not changing the
number of vertices or faces.

To trigger an animation that is not on an object at the top-level of the
software’s linking hierarchy, use a TimeSensor helper object. If you trigger
an animation directly from a TouchSensor or ProximitySensor, without a
TimeSensor, you can animate only top-level objects. Animating from
TimeSensors does not have this limitation.

Turn off the Generate Primitives toggle in the Export dialog if you animate
the parameters of primitives (like the radius of a sphere), and want the
animation exported with CoordinateInterpolators. This applies to box, sphere,
cylinder and cone primitives only.

Materials

You can export only standard and multi/sub-object materials, and only the
following components of the material:

■ Diffuse, ambient, and specular color

■ One texture map, which must be in the Diffuse channel
Use JPEG or PNG format for your maps, because they are recognized by all
VRML97-compliant browsers and generally create the smallest files. (Some
older browsers may recognize GIF format and not PNG.) Multi/sub-object
materials export colors and textures. If an object has a multi/sub-object
material with textures, it exports as separate objects in VRML97, since
VRML97 does not support more than one texture map per object. Texture
maps slow down the browser and increase download time. Use them
sparingly.

■ Shininess (but not shininess strength)

■ Opacity

■ Wire frame

Make sure that all large flat surfaces have enough vertices in them that a few
vertices can be seen from all reasonable vantage points in your scene. Some
browsers cannot display textures on an object where all of its vertices are
outside the current viewport.

If you have several lights in you scene, lower the default multiplier value on
all the lights in the scene. Lights can oversaturate the scene and make all your
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geometry wash out toward white. Always add at least one camera and one
light to a scene exported to VRML97.

Helper Objects

Insert VRML helper objects into your scene in the top viewport. You can insert
VRML helper objects in any view, but if you insert them in the top viewport,
they appear properly oriented in the front viewport.

VRML97 Specification

You can find the complete VRML97 specification at
http://www.web3d.org/x3d/vrml/index.html.

This document describes the entire VRML97 language and provides technical
details on the behavior of exported VRML97 worlds.

VRML97 Helper Objects

Create panel > Helpers > VRML97 > Object Type rollout

The VRML97 helpers let you create online 3D scenes and interaction using
Virtual Reality Markup Language. Insert a VRML 97 Helper into the scene by
clicking and dragging at the desired location.

NOTE Some helper objects (for example, Billboard and Level Of Detail) are
position-sensitive, so be careful how and where you insert them. Usually, you have
the most control by creating the helper object in the Top viewport.

Anchor VRML97 Helper on page 7094

ProxSensor VRML97 Helper on page 7096

NavInfo VRML97 Helper on page 7098

Fog VRML97 Helper on page 7099

Sound VRML97 Helper on page 7100

LOD VRML97 Helper on page 7103

TouchSensor VRML97 Helper on page 7105

TimeSensor VRML97 Helper on page 7107
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Background VRML97 Helper on page 7109

AudioClip VRML97 Helper on page 7112

Billboard VRML97 Helper on page 7114

Inline VRML97 Helper on page 7115

Anchor VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Anchor

The Anchor rollout lets you specify a click-to-play trigger in the scene. This
trigger will be linked to a currently existing object in the scene. This allows
you to add links to other HTML pages, VRML97 worlds, or alternate cameras
in your VRML97 world.

Procedures

To set up an Anchor to jump to another VRML world:

1 Add an Anchor helper object by clicking the Anchor button and then
dragging in the Top viewport to create its icon.

2 Pick a Trigger Object in the scene that will be the object the viewer clicks
while browsing.

3 Choose Hyperlink Jump and designate a URL to jump to.

4 When the user clicks the Trigger Object geometry, the browser will replace
the current scene with the designated URL.

7094 | Chapter 21   Managing Scenes and Projects



Interface

The Anchor rollout contains the following options:

Pick Trigger Object Specifies the geometry that will be the trigger for this
anchor. Click this button, then select the geometry.
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Description Lets you enter a text description or message that will appear in
the browser's status bar when the mouse is over an object that has an Anchor
action defined for it.

Hyperlink Jump Creates an Anchor that jumps to a URL.

URL Specifies the location for Hyperlink Jump. Use your Bookmarks list, or
enter a location manually. If the URL points to another VRML97 world (a .
wrl file) you can append "#CameraName" to the end of the URL to have the
browser use the viewpoint named "CameraName" as the initial view.

Bookmarks Lets you select a URL location from a list of bookmarks. Click
Import List to import the list of bookmarks defined in your browser, or
manually enter new URLs into the list.

Parameter Lets you specify additional browser parameters for the hyperlink
jump. See the VRML97 specification on page 7093  for the uses of this field.

Set Camera Creates an Anchor that jumps to a given camera in the current
VRML97 world.

Camera Specifies the name of the camera for Set Camera.

Icon Size Determines the size of the helper in the scene.

ProxSensor VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > ProxSensor

The ProxSensor helper creates a VRML97 ProximitySensor node. This lets you
set up a rectangular region in space, so that entering the region in a VRML97
browser starts a set of objects animating.

Procedures

To create a Proximity Sensor object:

1 Add a Proximity Sensor object by clicking the ProxSensor button and
then click-dragging in the Top viewport to create its icon.

2 Select the geometry, camera, or sound to control.

When the user navigates inside the box, the specified objects animate or
the sound plays.
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Interface

The Prox Sensor rollout contains the following options:

Length/Width/Height Specifies the dimensions of the bounding box that
triggers the action.

Enable Activates the Proximity Sensor. When this check box is turned off,
the sensor has no effect, even if objects have been selected.

Pick Action Objects Specifies the objects in the scene to control with this
helper. The objects can be animated geometry, cameras, lights, or AudioClips.
Click this button then click the objects in the viewports.

Delete Deletes an object from the list of picked objects.
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NavInfo VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > NavInfo

The NavInfo helper lets you create a VRML97 NavigationInfo node. This tells
the browser how to navigate around the VRML97 world.

Procedures

To create a NavInfo helper:

1 Add a NavInfo helper by clicking the NavInfo button and then
click-dragging in the Top viewport to create its icon.

2 Use the controls to adjust the behavior of the helper.

Interface

The NavigationInfo rollout contains the following options:
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Type Specifies the type of movement (Walk, Examine, Fly, and None) for
navigating the world. Implementation of these movement types may vary
from browser to browser.

Headlight Places a directional light at the viewpoint. The light always points
in the direction the user is looking.

TIP Don’t use this option if you have lights in the scene.

Visibility Limit Sets the far clipping plane. Any geometry beyond this point
is invisible. The smaller this value is, the closer the clipping plane is to the
camera. The larger this value is, the more of your scene is visible to the camera.
A value of 0 turns off the effect, making everything in the scene visible. Use
this option to show just part of large scenes.

Speed Determines the speed of navigation in units per second. Use this
option to allow the user to travel faster, if you’re building a large world (like
a cityscape), and slower, if you’re building a small world (like a room).

Avatar Size Specifies the user's physical dimensions in the world, to detect
collision distance and follow terrain.

Collision Specifies the allowable distance between the user's position and
any collision geometry before a collision is detected. For example, you can set
this so that a collision is detected one unit in front of a wall.

Terrain Specifies the height above the surface to maintain when following
terrain.

Step Height Specifies the highest object that can be "stepped over." If an
object like a staircase has steps that are lower than this value, the user can go
up.

Icon Size Adjusts the size of the helper object in the viewports.

Fog VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Fog

The Fog helper lets you specify the color and range of fog in your VRML97
world. You can simulate atmospheric effects by blending objects with a color
based on the objects' distances from the viewer. For the best visual results, the
background (which is unaffected by the fog) should be the same color as the
fog.
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Procedures

To create a VRML 97 Fog helper:

1 Add a Fog helper by clicking the Fog button, then click-drag in the Top
viewport to create its icon.

2 Use the controls to adjust the type of fog in your VRML environment.

Interface

The Fog rollout contains the following options:

Type Specifies the fog type (linear or exponential). Linear means that the
amount of blending is a linear function of the distance, resulting in a
depth-cueing effect. Exponential uses an exponential increase in blending,
resulting in a more natural fog appearance.

Color Lets you select the fog color from the Color Selector dialog.

Visibility Range Specifies the distance from the viewer at which objects are
totally obscured by the fog. The smaller this value is, the closer the fog is to
the camera, and the less your scene is visible. The larger this value is, the more
of your scene is visible to the camera. A value of 0 turns off the effect, making
everything in the scene visible. A value of 0 means that there is no fog effect.

Icon Size Adjusts the size of the helper object in the viewports.

Sound VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Sound
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The Sound helper lets you place 3D (spatial) or ambient sounds in a scene.
The sound may be located at a point and emit sound in a spherical or ellipsoid
pattern. The ellipsoid is pointed in a particular direction and may be shaped
to provide more or less directional focus from the location of the sound. The
sound node may also be used to describe an ambient sound that tapers off at
a specified distance from the sound node.

The red ellipsoid of the helper represents the outermost range for which the
sound can be heard. The blue ellipsoid represents the range of the maximum
strength of the sound. The area between the red and blue ellipsoids represents
a falloff area in which the volume varies in intensity. The helper's arrow points
in the direction toward which the sound is emanating.

NOTE The Sound helper object must be linked to an existing audio clip in the
scene. Therefore, you must have an AudioClip on page 7112  helper object in the
scene in order for the Sound helper to play.

Procedures

To create a Sound helper object:

1 Add a Sound helper by clicking the Sound button, then click-drag in the
Top viewport to create its icon.

2 Press Pick Audio Clip and select an AudioClip helper object in the scene.

3 Rotate the icon to determine the direction in which the sound is
emanated.

4 Use the controls to adjust the range and strength of the playback sound.
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Interface

The Sound rollout contains the following options:

Intensity Sets the loudness of the sound. 1.0 is full volume.

Priority Sets the relative importance of the sound, if you have more than
one sound in the scene and the browser cannot play all of them. 0 is least
important. 1 is most important.

Spatialize Makes the sound 3D. A spatial sound has a particular source
location in the scene. If this box is turned off, the sound is ambient.

Min Back/Front, Max Back/Front Displays red and blue ellipsoids that allow
you to set the area of the sound effect. Inside the blue ellipsoid, the sound is
at full volume. Outside the red ellipsoid, the sound is inaudible. Between the
blue and red ellipsoids is a falloff area in which the volume varies in intensity.

Pick Audio Clip Lets you choose an audio clip. Click this button, then click
an AudioClip helper object. The audio clip must already be in the scene and
have a sound file associated with it.
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Icon Size Determines the size of the helper in the scene.

LOD VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > LOD

The Level of Detail (LOD) helper lets you specify objects with varying face
counts that are appropriate for different viewing distances. Browsers display
the less detailed objects when the viewer is far away from them and substitute
the more detailed objects at closer ranges.

Use LOD objects to speed up rendering of scenes in which highly detailed
objects are often far away from the viewer.

Objects used for LOD do not have to be of the same type or size, so you can
accomplish a crude form of morphing by using different objects as the LOD
components. For example, a tree might seem to grow if taller trees with more
limbs are substituted as the viewer gets closer.

Procedures

To create a Level of Detail helper object:

1 Create the objects to which you want to add level of detail.

2 Click the LOD button.

3 Click and drag in the scene to create a helper object.

4 Add the objects to the list with Pick Objects.

5 Use the Hide and Unhide commands, or the H key, to help pick the
objects and add them to the LOD list.

6 Select the objects in the list and use the Distance spinner to set the
distance.

To create all the objects and the LOD helper object at exactly the same
coordinates:

1 Create the LOD helper object.

2 You can use Snap and create the helper object at the origin (0,0,0
coordinates), or use the Keyboard Entry rollout for a Standard Primitive
to specify an exact object origin.
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3 Create the object with the most detail at the same coordinates. Name it
(for example, hicapsule).

4 Choose Edit/Clone.

In the Clone Options dialog, choose Copy and name the new object (for
example, medcapsule).

5 Repeat step 3 to create the other objects (for example, locapsule).

For the medium and low resolution objects, apply an Optimize modifier
to reduce the face count.

For primitives, you can reduce the face count by changing the creation
parameters in the modifier stack.

Interface

The Level of Detail rollout contains the following options:

Pick Objects Selects objects of different face counts to substitute for the LOD
helper object. Create all the objects and the LOD helper object at exactly the
same coordinates.
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Distance Sets the distance from the camera at which the user sees the selected
object. The distance specified for the object appears next to the object name.
For example:

hicapsule - 100 medcapsule - 300 locapsule − 500

Hicapsule is displayed when the distance between it and the camera is within
100 units. The lower resolution object (medcapsule) is displayed when the
camera is between 100 and 300 units. The lowest resolution object (locapsule)
is displayed when the camera is beyond 300 units. The greatest distance (500
in this case) is not actually used, but must be supplied.

Delete Deletes the selected object from the list.

Icon Size Sets the size of the LOD helper object.

TouchSensor VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > TouchSensor

The TouchSensor helper lets you set up an object so that selecting it in a
VRML97 browser starts a set of objects animating.

Procedures

To set up an object as a TouchSensor trigger:

1 Add a Touch Sensor object by clicking the Touch Sensor button and then
click-dragging in the Top viewport to create its icon.

2 Select the geometry to control.

When the user clicks the trigger geometry, the geometry, camera or light
animates, or the sound plays.
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Interface

The Touch Sensor rollout contains the following options:

Pick Trigger Object Specifies the geometry that will be the trigger for this
TouchSensor. Click this button, then select the geometry.

Enable Activates the Touch Sensor. When this box is turned off, the sensor
has no effect, even if objects have been selected.

Pick Action Objects Specifies the objects in the scene to control with this
helper.

Delete Deletes an object from the list of picked objects.

Icon Size Determines the size of the Touch Sensor helper in the scene.
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TimeSensor VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > TimeSensor

The TimeSensor helper lets you add time-based animation controls, such as
the start and end frames for a particular object's animation, and looping. Use
this helper to split up an object's animation keys over several triggers, to
automatically start an animation upon loading the .wrl file, or to make
animation endlessly loop.

Procedures

To assign an object to a TimeSensor helper:

1 Add a Time Sensor object by clicking the Time Sensor button and then
click-dragging in the Top viewport to create its icon.

2 Press Pick Objects and select the (animated) geometry to control.

3 Use the controls to adjust the start and end times of the animation, and
to loop the animation.
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Interface

The Time Sensor rollout contains the following options:

Loop Repeats the animation from the start-time frame to the stop-time
frame.

Start on World Load Starts the animation so that it will be running when
the file is loaded into the browser.

NOTE This option is only available when Loop is turned on. Otherwise, the
animation will start and stop at the specified times.

Start Time/Stop Time Specifies the range of frames to play.
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NOTE If the start time is after the end time, the animation will play from the
earliest frame to the last frame. It will not play the animation backward.

Pick Objects Lets you select the objects to control with this TimeSensor.

Delete Deletes an object from the list of picked objects.

Icon Size Adjusts the size of the helper object in the viewports.

Background VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Background

The Background button displays the Sky Color, Ground Color, and Images
rollouts. Use these rollouts to specify colors and images for the sky and ground
in your VRML97 world.

Procedures

To create a Background helper object:

1 Add a Background helper object by clicking the Background button, then
click-drag in the Top viewport.

2 Use the controls to adjust the colors and layout of the background.
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Interface

Sky Colors rollout

Lets you provide a colored background to the world’s sky using a gradient of
up to three colors. The sky is an infinite sphere that encloses the objects of
the scene.

Number of Colors Specifies whether the sky is one solid color or a gradient
of two or three colors.

Color One/Two/Three Lets you select the colors from the Color Selector.
Color One is the base color.
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Angle Specifies the angle at which Color Two and Color Three merge with
the base color, in degrees from the North pole of the sky (straight up from the
viewer).

Icon Size Adjusts the size of the helper object in the viewports.

Ground Colors rollout

Lets you provide a colored background to the world’s ground plane using a
gradient of up to three colors. The ground appears inside the sky sphere and
below the objects of the scene.

Number of Colors Specifies whether the ground is one solid color or a
gradient of two or three colors.

Color One/Two/Three Lets you select the colors from the Color Selector.
Color One is the base color.
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Angle Specifies the angle at which Color Two and Color Three merge with
the base color, in degrees from the South pole of the sky (straight down from
the viewer).

Images rollout

Lets you specify a set of images that define a background panorama between
the ground/sky backdrop and the objects in the scene. The panorama consists
of six images, each of which is mapped onto a face of an infinitely large cube
centered in the local coordinate system.

Image URLs Specifies the location/file names of the images to use. The images
can be JPEG files or PNG files with or without transparency. Some browsers
also support GIF files.

See the VRML97 specification on page 7093  for diagrams of the typical image
configuration.

AudioClip VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > AudioClip

The AudioClip rollout lets you specify the name and characteristics of an audio
file that can be used by the Sound helper.
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Procedures

To create an AudioClip helper:

1 Press the AudioClip button, and click-drag in the Top viewport to create
the helper.

2 Enter the location of the sound file (.wav or .mid) you want to use in the
URL text box.

Interface

The rollout contains the following options:

URL Specifies the location/file name of the sound to use. Either.wav
(waveform) or .mid (MIDI) files can be used, but MIDI sound files may not be
spatialized. Some browsers do not support MIDI.

Description Lets you enter a text description of the sound, which is displayed
by some browsers.

Pitch Sets the relative pitch of the sound. 1.0 is normal pitch, and 0.5 is one
octave lower than normal.

Loop Repeats the sound.
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Start on World Load Starts playing the sound as soon as the world is loaded
into the browser.

Icon Size Determines the size of the AudioClip helper in the scene.

Billboard VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Billboard

The Billboard helper lets you create geometry that is camera-aligned in the
VRML97 browser. The objects always align to the viewpoint in the VRML97
browser.

Any geometry linked to the Billboard helper will rotate about the local Z axis
of the helper object to face the viewer. Since it rotates about the location of
the Billboard, it is best to center the Billboard on the object that you will link
to it.

The direction of the negative Y axis of the object, which will be its front, is
aligned with the negative Y axis of the helper, and will be the Billboard surface
that always faces the viewer. This is the side usually seen from the default
camera position.

Procedures

To create a Billboard helper object:

1 Press the Billboard button and click-drag in the Top viewport to create
the helper.

2 Link object(s) to the billboard to keep them aligned with the camera.

Interface

The Billboard rollout contains the following option:
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Screen Alignment Keeps the geometry linked to the Billboard helper aligned,
even when the viewer elevates, pitches, and rolls.

Icon Size Determines the size of the Billboard helper in the scene.

Inline VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Inline

The Inline helper lets you reference another VRML97 file that is included in
your world when you load it into your VRML97 browser. These inline objects
are like instance objects, but they function at the browser level.

Procedures

To create an Inline helper object:

1 Click the Inline button.

2 Click and drag in one of the viewports.

You can modify the helper object with the tools in the VRML Inline
rollout.

Interface

If you create the objects in the scene to be inserted off-center (away from the
origin), they will appear in the browser off-center as well. Align the original
scene and the scene to be inserted correctly, in relation to the origin.
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The VRML Inline rollout contains the following options:

Insert URL Specifies the URL of the .wrl files to insert in place of the helper
object. The URL must be another VRML97 file.

Bookmarks Displays a dialog that lets you select a location from a list of
bookmarks. Click Import List to import the list of bookmarks defined in your
browser. Most browsers store bookmarks in a file called bookmark.htm.

Bounding Box Specifies whether an explicit bounding box size will be
exported. If you select “Use Icon Size,” the diameter of the icon will be written
into the VRML97 file for the width, length, and height of the bounding box;
the actual contents of the inline file should fit within that bounding box. If
you select “Calculate in Browser,” no bounding box size is exported and the
VRML browser will determine the size of the inline geometry.

Icon Size Sets the size of the helper object. You can transform this object
like any other object in the software. The scene that replaces the helper object
will be moved, rotated, or scaled in the same manner. The size shown is the
radius of the icon.

Image File Formats
Image files, also known as bitmaps, have a variety of uses in 3ds Max scenes.
You can use bitmaps as textures for materials, as backgrounds to viewports,
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as  environment maps, as Image Input events in Video Post, or as images
projected from a light.

An image file can be a single still image, or a sequence of images that form a
video sequence or animation. When you assign an animation for use as a
bitmap, then the image changes over time when you render the 3ds Max
scene.

NOTE Bitmaps are reloaded automatically after they have been changed and
resaved by a graphic editing program. See the Reload Textures On Change toggle
in File Preferences on page 7541 .

When you render a scene, you can render a still image or an animation. You
can render to most of the formats listed below. Some of the formats support
various options. If there are output options, these appear in a dialog that is
described along with the image file's format.

These are the image file formats supported by 3ds Max:

AVI Files on page 7118

BMP Files on page 7120

CIN (Kodak Cineon) Files on page 7120

CWS (Combustion Workspace) Files on page 7121

DDS Files on page 7122

EPS and PS (Encapsulated PostScript) Files on page 7124

GIF Files on page 7126

HDRI Files on page 7126

IFL Files on page 7131

IMSQ Files on page 7138

JPEG Files on page 7139

MOV (QuickTime Movie) Files on page 7140

MPEG Files on page 7140

OpenEXR Files on page 7141

PIC Files on page 7151

PNG Files on page 7152

PSD Files on page 7153
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RLA Files on page 7156

RPF Files on page 7159

RGB (SGI Image) Files on page 7161

TGA (Targa) Files on page 7162

TIFF Files on page 7164

YUV Files on page 7166

NOTE To save loading time, if a map with the same name is in two different
locations (in two different paths), it is loaded only once. This poses a problem only
if your scene includes two maps that have different content but the same name.
In this case, only the first map encountered will appear in the scene.

AVI Files

The AVI (Audio-Video Interleaved) format is the Windows standard for movie
files. The .avi file-name extension indicates a Windows AVI movie file.

3ds Max creates an AVI created when you make a preview animation on page
6220 . You can also render your final output to an AVI file. Although 3ds Max
produces its highest-quality output by rendering single-frame TGA files or
rendering directly to a digital disk recorder, you can still get good results
rendering AVI files.

AVI files can be used as input to 3ds Max in several ways, for example:

■ As animated materials in the Material Editor

■ As viewport backgrounds for rotoscoping

■ As input images for compositing in Video Post

Interface

When AVI is the chosen output format, clicking Render or Setup on the
Render Output File dialog on page 5892  displays the Video Compression dialog.
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Compressor Use the drop-down list to choose the codec on page 7740
(compressor/decompressor) you want to use to compress the file. You can use
any codec that's installed on your system.

Alternatively, you can render uncompressed frames and then use an external
application to compress the animation. Video-file compression is a complex
subject, with many aspects to consider.

Compression Quality Available only for certain codecs. When available, use
the slider to specify the quality you want. The higher you set the quality, the
larger the file size will be.

Keyframe Rate Available only for certain codecs. When available, use this
setting to specify the interval between the delta keyframes used to compare
one frame with another and generate in-between frames. Too large an interval
will create loss of quality in the AVI file as a whole.

Setup Available only for certain codecs. Click this button to see any
additional options that are specific to the codec. These are vendor specific
and vary from codec to codec.
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BMP Files

BMP files are still-image bitmap files in the Windows bitmap (.bmp) format.

Interface

When BMP is chosen as the output format, clicking Render or Setup on the
Render Output File dialog on page 5892  displays the BMP Compression dialog.

8 Bit Optimized palette (256 Colors) Choose to render a smaller, 8-bit color
file.

RGB 24 bit (16.7 Million Colors) Choose to render a larger, true color (24-bit)
file.

CIN (Kodak Cineon) Files

A file format that stores a single frame of a motion picture or video data stream.
Each frame is saved as cineon version 4.5 with a CIN file-name extension. The
file contains no user-defined data such as a thumbnail, and supports 10-bit
log, and three colors per pixel. Alpha channels are not supported.

Interface

When CIN is chosen as the output format, clicking Render or Setup on the
Render Output File dialog on page 5892  displays the Cineon Image File Format
dialog.
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Printing Density Adjustment Represents the transfer function from printing
density (10-bit log) to 16-bit linear with the white point mapped to a maximum
code value of 65535.

Conversion of logarithmic printing density to a linear representation requires
both a scaling and an anti-log operation. With 16-bits linear, it is possible to
maintain the full printing density range. The 90% white card at code value
685 is mapped to maximum code value of 65535.

The White Pt and Black Pt spinners let you adjust the 90% white code and
the 2% black code.

CWS (Combustion Workspace) Files

The file format for the Combustion™ software from Autodesk. CWS is a
resolution-independent, vector/raster file format.

You can use CWS files in conjunction with the Combustion map on page 5649
. You can't use a CWS file as a general-purpose bitmap. You can also generate
a CWS file by using the Render Elements option on page 6144  when you render
a scene.

IMPORTANT Only Combustion 2.1 and later formats are supported. Maps in the
Combustion 1 format are not supported in 3ds Max.
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DDS Files

The DirectDraw® Surface (DDS) file format is used to store textures and cubic
environment maps, both with and without mipmap levels. This format can
store uncompressed and compressed pixel formats, and is the preferred file
format for storing DXTn compressed data. Microsoft® is the developer of this
file format.

You can use DDS files as texture maps.

With Direct3D 9, you can render to the DDS format. (With DX8 or DX9, DDS
files can be rendered using the Metal Bump shader on page 5599 , as well.) If
your system does not support DX9, you can use DDS files as textures, but you
can't render them.

Interface
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Surface/Volume Format group

DDS supports a variety of output formats, which vary in the number of pixels
allocated to the red, green, and blue (RGB) channels, to the optional alpha
channel (transparency), and to possible unused bits. There is also a set of
compressed formats.

■ A8 R8 G8 B8 32 bits per pixel: 8 bits each for the RGB and alpha channels.

■ A1 R5 G5 B5 16 bits per pixel: 5 bits each for the RGB channels, and one
bit for the alpha channel.

■ A4 R4 G4 B4 16 bits per pixel: 4 bits each for the RGB and alpha channels.

■ R8 G8 B8 24 bits per pixel: 8 bits each for the RGB channels; no alpha.

■ R5 G6 B5 16 bits per pixel: 5 bits each for the R and B channels, 6 bits
for the G channel; no alpha.

■ A2 R10 G10 B10 32 bits per pixel: 10 bits each for the RGB channels; 2
bits for the alpha channel.

■ X8 R8 G8 B8 32 bits per pixel: 8 bits each for the RGB channels; 8 bits
unused; no alpha.

■ X1 R5 G5 B5 16 bits per pixel: 5 bits each for the RGB channels; 1 bit
unused; no alpha.

■ R3 G3 B2 8 bits per pixel: 3 each for the R and G channels, 2 bits for the
B channel; no alpha.

■ A8 R3 G3 B2 16 bits per pixel: 3 each for the R and G channels, 2 bits for
the B channel; 8 bits for the alpha channel

■ X4 R4 G4 B4 16 bits per pixel: 4 each for the RGB channels and 4 unused
bits.

■ A16 B16 G16 R16 64 bits per pixel: 16 bits each for the RGB and alpha
channels.

■ A16 B16 G16 R16F 64-bit floating-point format using 16 bits each
for each channel: alpha, blue, green, red.

■ A32 B32 G32 R32F 128-bit floating-point format using 32 bits
each for each channel: alpha, blue, green, red.

■ DXT1 Compressed format with 1-bit alpha.
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■ DXT2 Compressed format with 4-bit premultiplied alpha on page 7900 .

■ DXT3 Compressed format with 4-bit alpha, no premultiplication.

■ DXT4 Compressed format with interpolated premultiplied alpha.

■ DXT5 Compressed format with interpolated alpha but no
premultiplication.

Generate Mipmaps When on, mipmaps are generated for the image.
Default=off.

Mipmaps are a set of lower-detail bitmaps. The first is half the size of the
original image, the next is half the size of that, and so on down to a single
pixel. (You can think of them as being arranged like a pyramid.) They are used
to optimize display time and reduce aliasing on page 7708  when the texture is
to be displayed at less than full size. For example, if your original DDS image
is 512 x 512 pixels, but the area in which it would be displayed is only 100
pixels square, the display device would interpolate between the 128 x 128
mipmap and the 64 x 64 mipmap.

EPS and PS (Encapsulated PostScript) Files

3ds Max can render images to Encapsulated PostScript format files, which
have the .eps or .ps extension.

PostScript is an Adobe page-description language for encoding graphics images.
It is supported by many printing devices and is widely used in desktop
publishing and graphic design as a means of porting images from one platform
to another. You can not view PostScript files with 3ds Max or use them as
bitmaps in materials or environments.

Interface

When PostScript is the chosen output format, clicking Render or Setup on the
Render Output File dialog on page 5892  displays the EPS File Output Options
dialog.
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Units Select inches or millimeters.

Image Orientation Select portrait (tall) or landscape (wide).

Data Format Select binary or ASCII.

File Type Select color or grayscale.

Preview Check to generate a thumbnail image so that file browsers can
preview the contents of the PostScript file.

Page Size Set width and height measurements.

Resolution Set width and height resolution in dots per inch (dpi).
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GIF Files

GIF is an 8-bit (256-color) format developed by Informix for the CompuServe®

information service. It was originally designed to minimize file transfer times
over telephone lines.

GIF is supported only as an input file format. You can use GIF files as
general-purpose bitmaps, but you can't render to a GIF file.

HDRI Files

HDRI is a file format used for high-dynamic-range images. Most cameras don't
have the capability to capture the dynamic range (the gamut of luminances
between dark and bright regions) that is present in the real world. However,
the range can be recovered by taking a series of pictures of the same subject
with different exposure settings, and combining them into one image file.

This type of image is called a high dynamic range image (HDRI) or radiance map.
HDRI files have an .hdr extension and radiance maps have a .pic extension.
The file actually contains all the data from all the pictures, so a wide luminance
range is present, from bright, white highlights to the darkest black.

HDR files are particularly useful as backgrounds for compositing, and as
reflection maps on composited objects. When using a HDR image as a skylight,
use the parameters in the Exposure group to control the brightness of the
scene.

Procedures

To use a HDR image as a background, or as a diffuse or reflection map:

1 In the Material Editor, choose Bitmap as the map type.

2 On the Select Bitmap Image File dialog, under Files Of Type, choose
Radiance Image File (HDRI). Open the HDR file you would want to use.

The HDRI Load Settings dialog appears, with the image displayed in its
preview window.

3 On the HDRI Load Settings dialog, look at the Measured Min/Max values
to see the luminance range for the image.

4 Turn on Black Point.
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5 Adjust the Black Point and White Point values until the red lines on the
histogram encompass the majority of the graph, and the preview image
is satisfactory.

TIP For the Internal Storage option, use the default choice of 16 bit/chan
Linear (48bpp) unless you have a specific reason for doing otherwise.

6 When you have finished adjusting values, note the Linear White Point
value, and click OK to accept the settings.

7 In the Material Editor, expand the Output rollout. Set the RGB Level to
the same value as the Linear White Point value on the HDRI Load Settings
dialog.

The result is a map with a wide range of deep blacks and very white
highlights. If such an image is used as both a background in the rendering
and a reflection map on an object, the object will appear to be extremely
shiny and reflective.

Interface

HDR Load Settings dialog

When you open a HDR file as a bitmap, the HDR Load Settings dialog appears.
This dialog allows you to specify the luminance range to use from the image,
and the method for storing the data.
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Histogram This graph shows the image's luminance values in a logarithmic
scale. The red lines indicate the current Black Point and White Point values.

The graph is visible only for luminance levels with substantial representation
in the image. In other words, if a luminance level only applies to one or two
pixels in the image, there will be no corresponding graph line on the
histogram. Compare with Measured Min/Max, which gives the entire range
of luminance levels in the image.

In general, the resulting image will have the most dramatic effect when the
histogram is used to set the Black Point and White Point range values, rather
than using the full range expressed by Measured Min/Max.
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Exposure group

Black Point When this option is turned on, you can set the luminance value
that you would like to be treated as the darkest color, or “black”. The value
can be set as a logarithm (Log) or as a linear value (Linear). All values below
this value will be clamped to black. When this option is turned off, the lowest
possible value is used as the Black Point.

Measured Min/Max Displays the actual minimum and maximum luminance
values in the image, expressed as both the logarithmic and linear values. Using
these values for the Black Point and White Point will result in the image's full
luminance range being used. However, the histogram might show that the
majority of the luminance levels fall into a much smaller range.

White Point Sets the luminance value that you would like to be considered
the brightest color, or “white”, either as a logarithm (Log) or linear value
(Linear). All luminance values in the image that are above this value will be
clamped to white. White pixel values inside HDR files can be much larger
than a Linear value of 1.

The image's extended luminance range is used only when the White Point's
Linear value is set above 1.0. In other words, setting White Point at or below
a Linear value of 1.0 will not use any of the HDR image's special luminance
properties, and will give results similar to other bitmap formats such as TIF
and JPG.

Log Sets the Black Point or White Point as a logarithmic value ranging from
–128 to 127. Changing this value changes the Linear parameter to the
corresponding value.

Linear Sets the Black Point or White Point as a linear value ranging from 0
to over 1 trillion. Changing this value changes the Log parameter to the
corresponding value.

Preview window Displays the selected HDR image.

Internal Storage group

Real Pixels (32 bpp) Compresses the luminance selections into a color space
with 32 bits per pixel. Premultiplied Alpha and Motion Blur do not work with
this option.

Def Exposure When on, the image will load as is without applying any
changes to the colors. When off, you can use the parameters in the Exposure
group to remap colors. Available only with the Real Pixels option.

HDRI Files | 7129



16 bit/chan Linear (48 bpp) Compresses the luminance selections into 16–bit
color space, at 48 bits per pixel. This is the recommended setting. To
decompress the luminance for use in the scene, set the RGB Level on the
image's Output rollout on page 5612  to the same value as the linear white value
on this dialog.

8 bit/chan Linear (24 bpp) Compresses the luminance selections into 8–bit
color space, at 24 bits per pixel. This compression method uses less memory
than other methods, but it is generally not adequate to display the range of
luminance in a HDR image, and can result in banding or other artifacts.

Display scaled colors by When on, this value scales the preview image's
luminance value by the specified amount.

L Locks the preview luminance scale to the white linear value. When off,
you can change the value manually. Default=on.

Mark White clamp Masks the white-clamped values in the preview window
with the color indicated by the color swatch. Click the color swatch to change
this color.

Mark Black clamp When Black Point is on, this option masks the
black-clamped values in the preview window with the color indicated by the
color swatch. Click the color swatch to change this color.

HDRI Save Settings dialog

3ds Max can render and save images with 32-bit floating-point channels.
Among the useful applications for this type of imagery are:

■ Compositing: Using 16–bit images in a compositing pipeline can quickly
become a problem as colors are manipulated. For example, banding may
appear.

■ HDR images are not bound to a specific range (e.g., 0-255 or 0-65535);
they have a dynamic range. As such, high-contrast and physically accurate
values can be stored in 32-bit floating-point pixels.

■ Because of their large range of values, HDR images can easily be modified,
and effects can be reapplied long after rendering, without affecting the
quality of the image. For example, changing the
contrast/brightness/exposure of a 16-bit image could cause banding, which
would require re-rendering the image. However, the same operation on
an HDR image should not affect its quality.
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Clicking Save or Setup in the Render Output File dialog on page 5892  displays
the HDR Save Settings dialog.

The dialog lets you choose the source of the values used for output:

■ Higher dynamic range and color precision than existing 8- and 10-bit
image file formats.

■ Support for 16-bit floating-point pixels. The pixel format, called "half," is
compatible with the half data type in NVIDIA's Cg graphics language and
is supported natively on their new GeForce FX and Quadro FX 3D graphics
solutions.

■ Multiple lossless image compression algorithms. Some of the included
codecs can achieve 2:1 lossless compression ratios on images with film
grain.

■ Extensibility. New compression codecs and image types can easily be added
by extending the C++ classes included in the OpenEXR software
distribution. New image attributes (strings, vectors, integers, etc.) can be
added to OpenEXR image headers without affecting backward compatibility
with existing OpenEXR applications.

IFL Files

An IFL (Image File List) file is an ASCII file that constructs an animation by
listing single-frame bitmap files to be used for each rendered frame. When
you assign an IFL file as a bitmap, rendering steps through each specified
frame, resulting in an animated map.

IFL Files | 7131



(In a similar way, if you assign an AVI file or MOV file as a bitmap, rendering
steps through each frame of the animation.)

For example, if you assign a 10-frame animation of a blinking red "Danger"
sign to a material's diffuse component, apply the material to a cube, and then
render a 30-frame animation, the cube displays the blinking red Danger
animation three times.

The .ifl file lists the bitmap files to be used with each frame. You can append
an optional numeric argument to each file name to specify the number of
frames of rendered animation on which it is used. For example:

The IFL file listed above specifies sand.tga to be used for the first 20 frames,
pebble.tga to be used for the next 40 frames, stone.tif to be used for 20 frames,
and boulder.tif to be used for 20 frames.

TIP Specify only the file names in your IFL files. The file paths can be derived from
the map paths established in your preferences. See External Path Configuration
on page 7526 . IFL files with path names can be used only on the system on which
you create them.

See also:

■ Image File List Control Dialog on page 7134

■ IFL Manager Utility on page 7136

Sequentially Numbered Files

You can use incrementally numbered bitmap files (for example, frame001.bmp,
frame002.bmp, and so on) to construct an IFL file. Either use the IFL Manager
Utility on page 7136 , or use the Sequence check box in a file selector dialog, as
described in the following procedures.

Notes

■ If the IFL generator has a name conflict with an existing IFL file, it will
increment the new file's name to avoid overwriting the existing file.

■ If the IFL generator has any problems with write access while trying to
create the IFL file, the process will fail and the IFL file won't be created.
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Therefore, automatic IFL generation won't work when reading bitmaps
from a CD-ROM. You need to copy them to a directory on your hard disk
first. Likewise, automatic IFL generation won't work on network drives to
which you don't have write access.

Procedures

To construct an IFL file from sequentially numbered files:

1 In the file selector dialog, navigate to a directory that has a sequence of
incrementally numbered bitmaps.

2 Choose the name of one of the sequential files (for example, image01.bmp).

The Sequence check box becomes available.

3 Turn on the Sequence check box.

The Setup button becomes available.

4 Click Setup to display the Image File List Control dialog on page 7134 .

5 In the Image File List Control dialog, choose the options you want, and
then click OK.

TIP Use the Browse button to set the Target Path to a directory on your hard
disk. Do not set this path to a CD-ROM drive, because you cannot save the
file there.

The Image File List (IFL) file is saved to the target directory.

6 In the file selector dialog, click OK.

This assigns the newly created IFL file as the bitmap.

Example: To select a set of still images as a viewport background:

1 Activate the viewport where you want the animated background.

2 Choose Views menu > Viewport Background.

3 In the Background Source group, click Files.

A Viewport Background dialog is displayed.

4 On Select Background Image dialog, use the Look In field to navigate to
the directory containing the files you want to use for the sequence.

If necessary, change the file type to match the file name extension of the
sequence, or choose All Formats.
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NOTE The Select Background Image File dialog uses the last location where
a bitmap was chosen, rather than the default bitmap path defined in
Customize menu > Configure User Paths.

5 Construct an IFL file as described in the previous procedure.

6 On the Select Background Image dialog, click OK.

The IFL file now provides the background for the viewport.

TIP The viewport background does not render. To render the IFL file's
animation, assign the IFL file as a rendering environment. (See the following
procedure.)

To render the frames in an IFL file as a movie (AVI or MOV format):

1 Choose Rendering > Environment.

2 On the Environment dialog, click Environment Map.

3 On the Material/Map Browser, choose Bitmap, and then click OK.

4 On the Select Bitmap Image File dialog, choose the IFL file, and then click
OK.

5  Click Time Configuration, and use the Time Configuration dialog
to make the animation length match the number of frames specified in
the IFL file.

6 Render a viewport to a movie-format file.

TIP The aspect ratio of the rendered movie should match the aspect ratio of
the frames in the IFL file.

Image File List Control Dialog

Views menu > Viewport Background > Select Background Image dialog >
Choose a directory with sequentially numbered files. > Sequence > Setup >
Image File List Control dialog

The Image File List Control dialog provides controls for creating an Image
File List (IFL file) on page 7131 , which lists sequential still image files for
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rendering into backgrounds or materials. It is particularly useful if you are
choosing a sequence of files that are on a CD-ROM, because you can redirect
the IFL file to a different directory on your hard disk.

This dialog duplicates the functionality found in the IFL Manager utility on
page 7136 .

Interface

Target Path Sets the directory where the IFL file is saved.

Browse Use this to navigate to the correct directory.

Options Sets additional options for creating the IFL file.

Start Frame Determines which file in the sequence will be the first frame.
Use this when you have a sequence but you don’t want to start with the first
image in the sequence.

End Frame Determines which file will be the last frame listed in the IFL list.

Nth Frame Skips frames in the image file list. Use this to match the length
of the sequence to the length of the animation.

Multiplier Increases the frames in the image file list. Each frame in the file
list can be repeated by this value to stretch out the length of the sequence.

Include Image Path Includes the path in the image file list.
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IFL Manager Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > IFL Manager

The IFL Manager utility generates an image file list (IFL) file on page 7131  from
an image file you choose from a numbered file sequence.

NOTE You can also generate an IFL file in a file selector dialog by selecting a
numbered bitmap, turning on Sequence, and then clicking Setup to display an
Image File List Control dialog on page 7134 .

See also:

■ Image File List Control Dialog on page 7134

Procedures

To use the IFL Manager utility:

1 Open the IFL Manager.

2 Click the Select button to display a file selector.

3 Select any of the sequentially numbered image files that you want
included in the list, and click Open.

The prefix name of the file appears in the Working File Prefix group box,
and the spinners in the IFL Manager panel become enabled.

4 Set the Start spinner to specify the first numbered file in the sequence.
For example, set this to 5 to begin with file tree0005.jpg.

5 Set the End spinner to specify the last numbered file in the sequence.
The Start and End spinners default to the first and last number in the
existing numbered files.

NOTE You can invert the Start and End values (setting the greater value in
Start and the lesser in End) to create a reversed list in the .ifl  file.

6 Click Create to display a file dialog where you can name and then save
your IFL file.

7 Click the Edit button to display a file dialog where you can choose an
IFL file, which then appears in the Windows Notepad.
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Interface

Working File Prefix group

After you use the Select button to select a sequentially numbered file, the
prefix name of the file appears here. For example, if the files are tree0000.jpg,
tree0001.jpg, tree0002.jpg, and so on, the title in this group box would be tree.

Spinners group

Start Displays the number of the first image file in the selected sequence.
Increase to specify a different starting image for the IFL file.

End Displays the number of the last image file in the selected sequence.
Decrease to specify a lower ending image for the IFL file.

Every nth Set to a number greater than 1 to skip a specified number of images
in the list.

Multiplier Adds a multiplier after each file in the IFL list. If you set to 3, each
image is used three times before the next image in the list is used.

IFL Files | 7137



Button set

Select Displays a file dialog that lets you select a file in a sequential list. The
number appended to the file doesn't matter, as long as the prefix and file
name extension are the same. After selecting the file, the spinners in the IFL
Manager are enabled.

Create Displays a file dialog where you can name and save your IFL file.

Edit Displays a file dialog where you can select an IFL file. The selected file
is then displayed in the Windows Notepad editor.

Close Closes the utility.

IMSQ Files

The Autodesk ME Image Sequence (IMSQ) format is an XML file used by the
Autodesk products Cleaner and Toxik. You generate IMSQ files in the Render
Output group of the Render Scene Dialog's Common Parameters rollout on
page 5929  by turning on Put Image File List(s) In Output Path(s) and then
clicking Create Now. The IMSQ file stores information about the rendering,
including:

■ The name of the rendering file

■ The format of the rendering file

■ The range of frames
(Nonsequential frame sequences, such as 1, 7, 12–19, are not supported.)

■ The frame rate

■ The pixel aspect ratio

■ The output type, aperture width, and resolution (width x height)

■ The render element type and name

■ The camera name (when rendering a Camera view)

3ds Max generates a separate IMSQ file for each render element.
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JPEG Files

JPEG (.jpeg or .jpg) files follow the standards set by the Joint Photography
Experts Group. These files use a variable compression method that is called
lossy compression because of the loss of image quality as you increase the
compression. However, the JPEG compression scheme is extremely good and
you can sometimes compress the file up to 200:1 without severe loss of image
quality. JPEG is consequently a popular format for posting image files on the
Internet for minimum file size and minimum download time.

Interface

When JPEG is the chosen output format, clicking Render or Setup in the
Render Output File dialog on page 5892  displays the JPEG Image Control dialog.

Quality Move the slider to the level of quality you want: the higher the
quality, the larger the file size. In general, files compressed with the slider set
to Best have compression ratios between 5:1 and 15:1.
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File Size Move the slider to the size of file you want: the larger the file, the
higher the quality.

Smoothing Move the slider to the level of smoothing you want: the higher
the level of smoothing, the larger the file size.

MOV (QuickTime Movie) Files

QuickTime® is a standard file format created by Apple® for storing common
digital media types such as audio and video. When you choose QuickTime
(*.mov) as the Save as Type, your animation is saved as a .mov file.

You can export animations to .mov for both rendering and previews. You can
also export audio if an audio track is present in Track View. To preview an
existing .mov file, you must have movieplayer.exe included in your environment
path. You can download the QuickTime movie player from
http://www.apple.com/quicktime/download.

NOTE The plug-in does not allow for the direct import of audio from a QuickTime
file.

Interface

When you create a new QuickTime file or choose Setup for an existing one,
you see a dialog that is typically titled Compression Settings. This dialog is
provided by the QuickTime codec on page 7740  installed with your system,
and can change depending on the version of QuickTime you've installed.

MPEG Files

The MPEG format is a standard for movie files. MPEG stands for Moving
Picture Experts Group. MPEG files can have a .mpg or .mpeg file name
extension.

MPEG is supported only as an input file format. You can use MPEG files as
texture maps.
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OpenEXR Files

3ds Max can both read on page 7147  and write on page 7142  image files in the
OpenEXR format. OpenEXR is both an image file format and a general
open-source API for reading and writing such files.

The best place to look for information on OpenEXR itself is
http://www.openexr.com/the official Website . The following is taken directly
from the OpenEXR home page:

OpenEXR is a high dynamic-range (HDR) image file format developed by
Industrial Light & Magic for use in computer imaging applications.

OpenEXR is used by ILM on all motion pictures currently in production. The
first movies to employ OpenEXR were Harry Potter and the Sorcerer's Stone,
Men in Black II, Gangs of New York, and Signs. Since then, OpenEXR has
become ILM's main image file format.

OpenEXR's features include:

■ Higher dynamic range and color precision than existing 8- and 10-bit
image file formats.

■ Support for 16-bit floating-point, 32-bit floating-point, and 32-bit integer
pixels. The 16-bit floating-point format, called "half," is compatible with
the half data type in NVIDIA's Cg graphics language and is supported
natively on their new GeForce FX and Quadro FX 3D graphics solutions.

■ Multiple lossless image compression algorithms. Some of the included
codecs can achieve 2:1 lossless compression ratios on images with film
grain.

■ Extensibility. New compression codecs and image types can easily be added
by extending the C++ classes included in the OpenEXR software
distribution. New image attributes (strings, vectors, integers, etc.) can be
added to OpenEXR image headers without affecting backward compatibility
with existing OpenEXR applications.

The OpenEXR Bitmap I/O software goes beyond the “standard” OpenEXR
format, taking advantage of the flexibility of the format itself. It can write
channels and attributes as well as general RGBA data in formats that many
OpenEXR file importers cannot understand, due to implementation limits as
well as limits to the current set of standards. The full-latitude 32-bit floating
point RGBA files that the output function can write is one example. While
the OpenEXR API itself fully supports this capability, and these files are written
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using the standard set of OpenEXR libraries, most software only reads the
16-bit “half” floating point RGBA files that are considered standard EXR files.

Configuration File Usage

Most bitmap I/O plug-ins, including those integrated into 3ds Max, store their
configuration information in a binary CFG file that cannot be edited. To allow
external scripting support as well as ordinary preferences, the OpenEXR
software uses a standard INI file format to store its configuration data. The
file is named openexr.ini and is found in the plugcfg folder in the program
directory. The file is generated automatically the first time you edit the
OpenEXR configuration settings, and is updated each time you modify an
EXR loader. It is a standard text file and can be modified with any text editor.

When the INI file is written, it automatically generates a companion “help”
text file named openexr_ini_help.txt. This file contains the valid ranges for
various INI settings, as well as the various text strings used to specify
compression type and bit depth. This file is just a guide; editing it has no
effect, and it is overwritten whenever the INI file is updated.

To restore the default settings after editing the INI file, simply delete the
openexr.ini file and a new one with the original defaults will be generated the
next time you edit the configuration settings.

See also:

■ Saving OpenEXR Files on page 7142

■ Opening OpenEXR Files on page 7147

Saving OpenEXR Files

Render Scene dialog > Common panel > Common Parameters rollout > Render
Output group > Click Files. > Enter file name and set type to OpenEXR Image
File > Click Save. > OpenEXR Configuration dialog

Rendered Frame Window > Click Save Bitmap. > Enter file name and set type
to OpenEXR Image File > Click Save. > OpenEXR Configuration dialog

Use the OpenEXR Configuration dialog dialog to set output parameters for
OpenEXR files. You can specify the format for saving the RGBA data as well
as which of the four standard channels should be saved. An option is available
to use RealPixel unclamped color information for Render Output saving. Also
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available are color transforms to be applied, file compression type, and
additional attributes.

Interface

Compression Type Lets you choose the method of file compression. The
OpenEXR API provides for three general types of lossless compression,
including two different methods of Zip compression. For most images without
a lot of grain, the two Zip compression methods seem to work best, while the
PIZ compression algorithm is better suited to grainy images. The following
options are available:

■ None Disables all compression.

■ Run Length Encoding (RLE) A basic form of compression comparable to
that used by standard Targa files.

■ Zip (per scanline) Zip-style compression applied to individual scanlines.

■ Zip (16 scanline blocks) Zip-style compression applied to blocks of 16
scanlines at time. This tends to be the most effective style of compression
to use with rendered images that do not have film grain applied.

■ PIZ ( wavelet compression ) Uses a combined wavelet/Huffman
compression. This form of compression is best for grainy images.

Standard Channels group

The standard channels in an image are: red, green, blue, and alpha
(transparency). This group lets you choose the general type of OpenEXR file
to save, as well as which of the four channels to save with the file. The most
widely supported format is Half Float - 64 bpp format. This stores each channel
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of the image in a separate slice in the file using half-type 16-bit floating-point
data. The OpenEXR distribution has features that allow easy implementation
of reading and writing this type of file, and it is considered a standard OpenEXR
file.

Format Choose one of the following from the drop-down list:

■ Integer - 32 bpp This non-standard OpenEXR format contains only a
single 32–bit integer channel. It uses a packedIntRGBA image type in order
to support old-style bit depths, such as 32–bit Targa files. Only this plug-in
can read this format.

■ Half Float - 64 bpp This 16-bit-per-channel “half-float” format is standard
OpenEXR. Any software that supports OpenEXR can use this format.

■ Float - 128 bpp The 32-bit-per-channel “full-float” format is encoded
using standard OpenEXR channel tags. Most OpenEXR implementations
will have no problems reading this format.

R/G/B/Alpha Let you specify the channels to save: red, green, blue, and
alpha.

Use RealPixel RGB Data When on, compresses the essential data of
floating-point color into 32 bits. For technical information, see
http://sparks.discreet.com/knowledgebase/webhelp/html/idx_R_structure_realpixel.htmStructure
RealPixel .

NOTE Image motion blur is not applied to the RealPixel RGBA data by the renderer.
If you are using Image motion blur, you will not be able to save RealPixel
unclamped color data.

Exponent Enables and sets the power function exponent to use. This is
effectively a gamma curve, but the exponent is presented in an inverse manner
from typical gamma. The default value is what exrdisplay expects for input.

Pre-Multiply Alpha When on, the software uses premultiplied alpha on page
7900  when saving the file. Pre-multiplying saves computation time if you later
use this image in compositing.

Plugin About Opens a dialog that shows information about the OpenEXR
plug-in.

Extra Channels and Attributes Opens a sub-dialog on page 7145  that lets you
specify additional information to save with the OpenEXR image file.

OK Accepts any changes and closes the dialog.
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Cancel Discards any changes and closes the dialog.

Extra Channels and Attributes

To specify an extra attribute or channel to be included in the saved OpenEXR
file, click the corresponding + button and then choose the attribute or channel
from the list. To delete an attribute or channel, highlight it in the list and
then click the corresponding X button.

General Notes on Extended Attributes and Channels

Please note the following:

■ You can view the extended information via the File Info button on page
7150  on the input dialog.

■ A default File Tag string is provided when you add an attribute/channel.
You can change the file tag by highlighting the entry in the list and then
editing the File Tag field immediately below the list. You can also enable
and disable the attribute/channel with the check box to the left of the File
Tag field.

NOTE Each saved attribute or channel must have a unique file tag. If you
specify multiple instances of a file tag, only the first attribute or channel with
that file tag is used.
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■ All the current attributes are String type attributes that are stored in the
header for the file, and can be read in plain text via the exrheader.exe utility
(available from http://www.openexr.com/the official Website  > Downloads
page).

■ Attributes and channels are stored in the file in alphabetical order according
to the ASCII file tag.

■ While this plug-in can write most of the 3ds Max G-Buffer on page 7795
channels, there is no software that can utilize them yet.

■ Attributes and channels are identified by plain-text (ASCII) strings. There
can be only one instance of a string tag in any file. Attributes are data that
is stored per frame, not per pixel, and they are embedded in the file's
header. Channels are data that is stored per pixel. In order to maximize
flexibility with other software, this plug-in lets you edit the file tags. You
should only do this if you know the tag required by some other software;
otherwise it is best to leave the file tags at their default values.

■ Channels that create multiple “slices” in the EXR file require multiple file
tags. In this case, the file tag in the user interface comprises several sub-tags
denoted by square brackets. For example, the Normal channel generates
three slices in the EXR file: one for the Normal vector x data, 1 for y, and
1 for z. In this instance, the tag string in the user interface would read
[NX][NY][NZ], and generate slices with the file tags "NX", "NY", and "NZ".
The file tag is used by software that is reading the EXR file to identify the
intended use of the channel data. Even standard image channels are
encoded this way, with the tags "R", "G", "B", and "A" used to denote red,
green, blue, and alpha channels respectively.

Extended Attributes

Comment A general-purpose comment string defined by the user. To define
the comment, highlight the Comment entry in the list and then edit the
Comments field immediately below the list.

Computer Name The name of the computer the image was saved from. In
the case of standard render output during a net render, this is the machine
that rendered the frame.

System Time The UTC (GMT) system time and date when the file was written.

Local Time The local time and date (corrected for the time zone) when the
file was written.
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Version OpenExr The plug-in version, OpenEXR API version, and ZLib
version in plain text form.

Version 3dsMax The release version of 3ds Max itself, the API number, and
the SDK revision used when the build of 3ds Max was compiled. This also
reports whether the file was generated using 3ds Max or Autodesk VIZ.

Extended Channels

Z-Buffer The standard buffer depth channel. (16-bit or 32-bit floating point)

Object ID The object ID from the Object Properties dialog on page 245 .
(32-bit unsigned integer)

Material ID The material effects channel number on page 5252 . (32-bit
unsigned integer)

Node Render ID A unique object ID set by the renderer. All objects in the
scene have a unique Render ID, though the value stored varies from renderer
to renderer. (32-bit unsigned integer)

UV Coords The UV coordinates for the object. Only one UV channel is stored.
(two slices, 16-bit or 32-bit floating point)

Velocity The 2D velocity vector for the pixel in screen space. (two slices,
16-bit or 32-bit floating point)

Normal The surface normal. (three slices, 16-bit or 32-bit floating point)

Coverage The pixel coverage of the foremost object in the pixel. (32-bit
unsigned integer, 16-bit floating point, or 32-bit floating point)

Opening OpenEXR Files

Any command that opens an image file, such as View Image File > Specify an
EXR file. > Click Open. > OpenEXR Configuration dialog

This version of the OpenEXR Configuration dialog appears whenever you
open an EXR file. It lets you specify various color transformations to be applied
to the loaded image, designate the internal storage format to use, and preview
the loaded image with the color transforms applied. There is also a histogram
for viewing the brightness distribution in the image and adjusting the white
and black points interactively.
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Interface

Histogram

To view the histogram, click the Preview button. The histogram displays a
detailed bar graph of the distribution of brightness throughout the image.
The horizontal axis of the histogram defines the luminance value, and the
vertical axis indicates the percentage of the image covered by pixels of that
brightness. Histogram features are:

■ The histogram supports several display modes, which you can choose by
right-clicking the histogram display window. The menu lets you choose
between linear and logarithmic display, automatic or manual x-axis scaling,
y-axis scale options, and which channel is graphed: luminance, red, green,
or blue. The menu entries X-Axis Scale and Y-Axis Scale are simply labels,
and are thus unavailable for choosing.
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■ The vertical scale slider on the left side of the histogram lets you adjust
the automatically computed vertical scale.

■ To modify the luminance “window,” set X-Axis Scale to Manual and adjust
the minimum and maximum values in the numeric fields below either
end of the graph.

■ The background coloration indicates several pieces of information:

■ The area between the black and white points is shaded gray.

■ The area below 1.0 (low dynamic range) is a lighter shade of gray than
the area with luminance greater than 1.0, the high dynamic range
region.

■ The background of the region outside the currently selected
blackpoint/whitepoint region is tinted pink.

■ The vertical dotted lines indicate integer spacing (for example,
1...2...3...4). To see these, the maximum luminance value must be
greater than 1.0.

■ You can drag whitepoint/blackpoint markers in the histogram to place
them visually. The hot-spot is two pixels to either side of the marker line.
White point selection is tested first, so if the two lines are right next to
each other, the white point will be selected.

■ You can set the display itself to linear or logarithmic mode. Logarithmic
display remaps all values greater than 1.0 to a logarithmic curve. The dotted
spacing indicators are supplemented by heavier dotted lines that indicate
when the scale has changed by a factor of 10. This is useful for most HDR
images, as the HDR data is usually spread out over a wide range.

■ Setting X-Axis Scale to Auto mode causes the histogram to encompass the
entire spectrum of the image. If you switch back and forth, previous
manually set values are preserved and restored.

File Loading Parameters group

Storage Buffer Format Specifies the format in which the image data is stored
within 3ds Max. The base types are variations on 8-bits-per-channel and
16-bits-per-channel integer formats. There are two forms of each: one with
alpha (RGBA) and one without alpha (RGB). If you are loading an image with
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an alpha channel but don't require the alpha data, choose the RGB version
to save some memory. If you choose a storage type that supports alpha, but
load an image without alpha, no memory is allocated for the alpha channel;
the loader detects the situation and reverts to the alpha channel-free storage
option with equivalent RGB bit depth.

The options supports the HDR bitmap storage options. This allows storage of
the high-dynamic-range data within 3ds Max in three different HDR formats:
24- and 32-bit LogLUV formats and 32-bit RealPixel format.

EXR files loaded using these storage modes are suitable for use as environment
maps for reflections and skylight.

Color Transform Because EXR images often contain values brighter than
“white,” it is often desirable to change the luminance range in the source
image over which black to white occurs; that is, to remap the color data. When
Color Transform is on, you can adjust these luminance and general brightness
controls:

Exponent The exponent to apply when loading the file

Black Point Where black should be in the luminance range of the image

White Point The white point

RGB Level A standard multiplier for the RGB data

RGB Offset An additive offset for the RGB data

Preview The Preview window provides for interactive previewing of
color-transform options for loading EXR files. After choosing an EXR file to
open, click Preview to enable the preview window. The image file is loaded
into the preview window, and from then on any changes to the Color
Transform options update the thumbnail in real time.

The preview window ignores the aspect ratio of the image to make the most
of the small screen space available.

Plugin About Opens a dialog that shows information about the OpenEXR
plug-in.

File Info Opens the File Information dialog on page 7151 , which lets you view
file statistics plus any attributes and channels stored in the file.

OK Accepts any changes, closes the dialog, and opens the image file.

Cancel Discards any changes and closes the dialog without loading the image
file.
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File Information dialog

This read-only dialog displays basic file statistics including date, time, size,
and resolution, plus any attributes and channel information stored with the
file. See Extra Channels and Attributes on page 7145 .

PIC Files

3ds Max can import and export Radiance Picture (PIC) files. The PIC file is a
lighting-analysis format used for the same purpose as LogLUV TIFF files on
page 7164 . The PIC format differs from the LogLUV TIFF format by creating
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separate files for luminance on page 7833  and illuminance on page 7813  channel
data (the LogLUV TIFF format creates one file containing both channels).

One way to create PIC files is with the Lighting Data Exporter utility on page
6559 . You specify a file name by clicking the File Name button. When you click
Export, the Lighting Data Exporter renders two files. The string “_Illuminance”
is appended to the name of one file, and “_luminance” is appended to the
other. For example, if you type house as the file name, the exporter renders
to house_illuminance.pic and house_luminance.pic.

You can also open and save high-dynamic-range images in the PIC format
using the Radiance Image File format in input and output file browsers in 3ds
Max. For further information, see HDRI Files on page 7126 .

See also:

■ Radiosity  on page 5989

PNG Files

PNG (Portable Network Graphics) is a still-image file format developed for use
with the Internet and World Wide Web.

Interface

Clicking Render or Setup in the Render Output File dialog on page 5892  displays
the PNG Configuration dialog.

7152 | Chapter 21   Managing Scenes and Projects



Optimized palette (256) Choose to render a smaller, 8-bit color file.

RGB 24 bit (16.7 Million) Choose to render a true color (24-bit) file.

RGB 48 bit (281 Trillion) Choose to render a 48-bit color file.

Grayscale 8 bit (256) Choose to render a grayscale image with 256 shades.

Grayscale 16 bit (65,536) Choose to render a grayscale image with 65,536
shades.

Alpha Channel Turn on to save the alpha channel with the file.

Interlaced Turn on to make the file interlaced for faster display in Web
browsers.

PSD Files

PSD is the file-name extension for graphics files native to Adobe Photoshop.
This image format supports multiple layers of images superimposed to get the
final image. Each layer can have any number of channels (R, G, B, Mask, and
so on). It is a powerful file format because multiple layers can contribute to a
variety of special effects.
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Adobe provides many different modes of superimposing layers, including
normal, darken, lighten, difference, multiply, screen, dissolve, hard light, hue,
saturation, color, luminosity, overlay, and soft light.

You can use PSD files as bitmaps, viewport backgrounds, and so on. You can't
render to a PSD file.

3ds Max supports Photoshop 6.0 format, and allows you to use image layers
as bitmaps, as well as the entire composited graphic.

Limitations

Bits Per Channel Photoshop supports images with 1, 8, and 16 bits per
channel (1-, 24-, and 48-bit RGB images, respectively). 3ds Max supports PSD
images with 8 or 16 bits per channel. (In practice, there are very few images
with 1 bit per channel.) While Photoshop can load images with 16 bits per
channel, layers are always 8 bits per channel.

Modes 3ds Max supports .psd files saved in the following modes:

■ RGB

■ Grayscale

3ds Max doesn't support the following Photoshop modes:

■ Indexed Color

■ Bitmap

■ Duotone

■ CMYK Color

■ Lab Color

■ Multichannel

Non-Image Layers Layers other than image layers (for example, text layers)
are not supported. In Photoshop, you can “rasterize” a non-image layer to
make it an image.

Compositing Options Compositing options between image layers, which
require processing by Photoshop, are not supported.
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Interface

When you open a PSD file as a bitmap, a dialog appears that lets you choose
how to use the image.

Collapsed Layers displays the entire image.

Collapsed Layers (The default.) Uses the entire composited image.

Individual Layer Uses a single layer of the image. When you choose this, the
dialog shows a list of the layers, with a thumbnail of each, and the layer names.
Click a layer to choose it, then click OK.
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Individual Layer displays list of layers to choose from.

Full Frame When on, uses the entire layer as the bitmap. When off, uses
only that portion of the layer occupied by image data. Default=on.

RLA Files

The RLA format is a popular SGI format that supports the ability to include
arbitrary image channels. While setting up a file for output, if you select RLA
Image File from the list and click the Setup button, you'll go to the RLA setup
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dialog. Once there, you can specify what channels (and what format) you
want to write out to the file.

See also:

■ RPF Files on page 7159

Interface

When RLA is the chosen output format, clicking Render or Setup on the
Render Output File dialog on page 5892  displays the RLA Image File Format
dialog.

Standard Channels group

The standard channels are RGB color and the alpha (transparency) channel.

Bits per Channel Choose 8, 16, or 32 Floating Point as the number of bits
per channel. Default=8.

Store Alpha Channel Choose whether to save the alpha channel. Default=on.

Premultiply Alpha When on, premultiplies the alpha channel. Default=on.

Premultiplying saves computation time if you later use this image in
compositing. For more information, see Premultiplied Alpha on page 7900 .

Optional Channels group

For output RLA files, there are eight additional channels that you can generate
(and view in the rendered frame window):
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Z Depth Displays Z-Buffer information in repeating gradients from white to
black. The gradients indicate relative depth of the object in the scene.

Material ID Displays the Effects channel used by materials assigned to objects
in the scene. The Effects channel is a material property set in the Material
Editor and used during Video Post compositing. Each Effects Channel ID is
displayed using a different random color.

Object ID Displays the G-Buffer on page 7795  Object Channel ID assigned to
objects using the Object Properties dialog. The G-Buffer ID is used during
Video Post compositing. Each G-Buffer ID is displayed using a different random
color.

UV Coordinates Displays the range of UV mapping coordinates as a color
gradient. This channel shows where mapping seams might occur.

NOTE UV Coordinates will not be displayed on objects that have the UVW Map
Modifier applied unless a map has been applied that uses the coordinates.

Normal Displays the orientation of normal vectors as a grayscale gradient.
Light gray surfaces have normals pointing toward the view. Dark gray surfaces
have normals pointing away from the view.

Non-Clamped Color Displays areas in the image where colors exceeded the
valid color range and were corrected. The areas appear as bright saturated
colors usually around specular highlights.

Coverage This saves the coverage of the surface fragment from which other
G-buffer values (Z Depth, Normal, and so on) are obtained. Z-Coverage values
range from 0 to 255. To see Z Coverage, render to an RLA file after first
checking Z Coverage in the Setup subdialog, then choose Z-Coverage in the
rendered frame window's Viewing Channel drop-down list.

The Z-Coverage feature is provided primarily for developers, and should aid
in the antialiasing of Z-buffers.

Descriptive Information group

This information is saved with the file.

Description You can enter descriptive text here.

Author You can enter your name here.
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RPF Files

RPF (Rich Pixel Format) is the format that supports the ability to include
arbitrary image channels. While setting up a file for output, if you select RPF
Image File from the list, you'll go to the RPF setup dialog. Once there, you can
specify what channels you want to write out to the file.

RPF files replace RLA files as the format of choice for rendering animations
requiring further post-production or effects work. Many channels available
in RPF files are exclusive to this format.

TIP When you create a scene you plan to render as an RPF file for use with the
Autodesk Combustion™ product, turn on Render Occluded Objects (on the
Object Properties dialog on page 245  ) for objects in the scene. This is important
if you want to use the Combustion G-Buffer Extract feature. When Render Occluded
Objects is enabled and you extract an object in Combustion, the objects behind
it are drawn correctly. If Render Occluded Objects is disabled (the default), objects
behind the extracted object appear with black holes where they were occluded.

Interface

When RPF is the chosen output format, clicking Render or Setup on the
Render Output File dialog on page 5892  displays the RPF Image File Format
dialog.

Standard Channels group

The standard channels are RGB color and the alpha (transparency) channel.
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Bits per Channel Choose 8, 16, or 32 Floating Point as the number of bits
per channel. Default=8.

Store Alpha Channel Choose whether to save the alpha channel. Default=on.

Premultiply Alpha When on, premultiplies the alpha channel. Default=on.

Premultiplying saves computation time if you later use this image in
compositing. See Premultiplied Alpha on page 7900  for more information.

Optional Channels group

For output RPF files, there are additional channels that you can generate (and
view in the rendered frame window):

Z Depth Saves Z-Buffer information in repeating gradients from white to
black. The gradients indicate relative depth of the object in the scene.

Material ID Displays the Effects channel used by materials assigned to objects
in the scene. The Effects channel is a material property set in the Material
Editor and used during Video Post compositing. Each Effects Channel ID is
displayed using a different random color.

Object ID Displays the G-Buffer on page 7795  Object Channel ID assigned to
objects using the Object Properties dialog. The G-Buffer ID is used during
Video Post compositing. Each G-Buffer ID is displayed using a different random
color.

UV Coordinates Saves the range of UV mapping coordinates as a color
gradient. This channel shows where mapping seams might occur.

NOTE UV Coordinates will not be displayed on objects that have the UVW Map
Modifier applied unless a map has been applied that uses the coordinates.

Normal Saves the orientation of normal vectors as a grayscale gradient. Light
gray surfaces have normals pointing toward the view. Dark gray surfaces have
normals pointing away from the view.

Non-Clamped Color Saves areas in the image where colors exceeded the
valid color range and were corrected. The areas appear as bright saturated
colors usually around specular highlights.

Coverage Saves the coverage of the surface fragment from which other
G-buffer values (Z Depth, Normal, and so on) are obtained. Z-Coverage values
range from 0 to 255. To see Z Coverage, render to an RLA file after first
checking Z Coverage in the Setup subdialog, then choose Z-Coverage in the
rendered frame window's Viewing Channel drop-down list.
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The Z-Coverage feature is provided primarily for developers, and should aid
in the antialiasing of Z-buffers.

Node Render ID Saves each object as a solid color according to its G-Buffer
Object channel (found under Object Properties).

Color Saves the color returned by the material shader for the fragment. This
channel displays any transparent fragment as a solid color.

Transparency Saves transparency returned by the material shader for the
fragment. Any fragment with any degree of transparency will be rendered as
a solid gray object.

Velocity Saves the velocity vector of the fragment relative to the screen in
screen coordinates.

Sub-Pixel weight Saves the sub-pixel weight of a fragment. The channel
contains the fractions of the total pixel color contributed by the fragment.
The sum of all the fragments gives the final pixel color. The weight for a given
fragment takes into account the coverage of the fragment and the transparency
of any fragments that are in front of a given fragment.

Sub-Pixel Mask Saves the sub-pixel alpha mask. This channel provides a
mask of 16 bits (4x4) per pixel, used in antialiased alpha compositing. This
mask is especially useful with the Combustion compositing product.

Descriptive Information group

This information is saved with the file.

Description You can enter descriptive text here.

Author You can enter your name here.

RGB (SGI Image) Files

The SGI™ Image File format is a bitmap file type created by Silicon Graphics®.
SGI Image File support in 3ds Max lets you load and save files in both 8- and
16-bit color depth, with alpha channels, and RLE Compression.

Interface

Clicking Render or Setup in the Render Output File dialog on page 5892  displays
the RGB Image File Format dialog.
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Channel Bit Depth group

8 Bit Saves the RGB file as 8-bit color.

16 Bit Saves the RGB file as 16-bit color.

Use Alpha toggle

Use Alpha Saves Alpha channels with the RGB file.

TGA (Targa) Files

The Targa (TGA) format was developed by Truevision for their video boards.
The format supports 32-bit true color; that is, 24-bit color plus an alpha
channel, and is typically used as a true color format.

Targa files are widely used to render still images and to render sequences of
still images to video tape.

Some Targa files created by other applications have different file-name
extensions. 3ds Max can render the .vda, .icb, and .vst variants as well as .tga.

Interface

Clicking Render or Setup in the Render Output File dialog on page 5892  displays
the Targa Image Control dialog.

7162 | Chapter 21   Managing Scenes and Projects



When you render to a Targa file, you have the following options:

Image Attributes group

Bits-Per-Pixel Choose the color depth: 16-bit, 24-bit, or 32-bit.

Compress Applies lossless compression to the file.

Alpha Split Creates a separate file for the alpha channel. The file name created
for the alpha-channel file starts with a_ and then appends the full file name.
For example, if you check this box and render the file greek004.tga, 3ds Max
creates the file a_greek004.tga for the alpha channel. (Sometimes the name
will be longer than 8 characters.)

Pre-Multiplied Alpha When on, pre-multiplies the alpha channel.
Pre-multiplying saves computation time if you later use this image in
compositing. See Premultiplied Alpha on page 7900 .

Additional Information group

Author Name, Job Name/ID, Comments These fields are available for you
to add information about the file.
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NOTE To control whether or not the renderer uses the environment map's alpha
channel in creating the alpha for the rendered image, choose Customize >
Preferences > Rendering, and then turn on Use Environment Alpha in the
Background Antialiasing group.

If Use Environment Alpha is turned off (the default) the background receives
an alpha of 0 (completely transparent). If Use Environment Alpha is turned
on, the alpha of the resulting image is a combination of the scene and
background image's alpha. Also, when writing TGA files with Pre-Multiplied
Alpha set to off, turning on Use Environment Alpha prevents incorrect results.
Note that only background images with alpha channels or black backgrounds
are supported when compositing in other programs such as Photoshop.

TIFF Files

TIFF (Tagged Image File Format) is a multiplatform bitmap on page 7730  format
originating on the Macintosh® and in desktop-publishing applications. TIFF
is a common choice if you plan to send your output to a print service bureau
or import the image into a page-layout program.

There are several classes of TIFF files, each varying in the color depth and color
palette that they support.

You can render TIFF files with alpha, luminance on page 7833 , and UV color
coordinate information, which describes illuminance on page 7813 . You also
have the option to render a compressed image. Luminance and illuminance
data are rendered by the Lighting Data Exporter utility on page 6559 .

Interface

To open the TIF Image Control dialog, click Save or Setup on the Render
Output File dialog on page 5892 .
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When you render to a TIFF file, you have the following options:

Monochrome Creates an 8-bit grayscale image.

Color Creates a 24-bit color image (no alpha channel).

Image Type group

Lets you choose the method for saving image information:

■ 8-bit Greyscale Creates an 8-bit grayscale image.

■ 8-bit Color Creates an 8-bit color image.

■ 16-bit Color Creates a 16-bit color image.

■ 16-bit SGI LogL Creates a color image that includes a logarithmic
encoding of the luminance channel.

■ 32-bit SGI LogLUV Creates a color image that includes a logarithmic
encoding of the luminance channel and UV color coordinate information.

Store Alpha Channel When on, stores the alpha channel along with other
image data. Alpha data adds 8 bits per pixel to the image type you selected.

Compression Type group

Lets you render a compressed TIFF file. Default=No Compression.

■ No Compression Does not compress the rendered image.
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■ Packbits Uses the TIFF Packbits algorithm to compress the file.

Dots Per Inch Sets the dots per inch (dpi) for the saved image. This setting
does not change the resolution of the final image, but can affect the way it
prints in documents.

YUV Files

YUV files are still-image graphics files in the Abekas Digital Disk format.

YUV is supported only as an input file format. You can use YUV files as
general-purpose bitmaps, but you can't render to a YUV file.

RAM Player
Rendering menu > RAM Player

The RAM Player loads a frame sequence into RAM and plays it back at selected
frame rates. The RAM Player has a channel A and a channel B. Two different
sequences can be loaded into the channels to play back together, giving you
the ability to compare them.

Clicking and dragging in the channel display window allows you to set the
A/B divider between the two channels. The right mouse button “scrubs” the
animation through all of its frames. Hold the right mouse button and move
the mouse left to move the animation back to the first frame. Move the mouse
right to advance the animation to its end.

For best RAM Player performance, Gamma should not be enabled in Customize
> Preferences > Gamma.
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Interface

Channel A/B

Open Channel Displays an Open File dialog that lets you select a file to load
into the channel. After you have selected a file, the RAM Player Configuration
dialog on page 7170  appears that allows you to set height, width, and memory
usage for that channel.

Open Last Rendered Image Loads the last rendered image into the channel.
Nothing is displayed if there is no last rendered image available.

Close Channel Unloads the image in the channel and frees up your memory.

Save Channel Displays a Save File dialog that lets you save the animation
or image from the respective channel. You can save the animation as a .avi
file or a numbered sequence of images.

NOTE The RAM Players converts everything it loads into 24-bit RGB which means
that some information may be lost when it is loaded. This may affect a file saved
in the RAM Player.

Channel A When selected, this button will show the file loaded into channel
A. Split screen markers are displayed if both channels are enabled. The split
screen markers are represented by two triangles. These markers indicate where
channel A ends and channel B begins. You can move the divider using the
left mouse button.

Channel B When selected, this button will show the file loaded into channel
B. Split screen markers are displayed if both channels are enabled. The split
screen markers are represented by two triangles. These markers indicate where
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channel A ends and channel B begins. You can move the divider using the
left mouse button.

Horizontal/Vertical Split Screen Toggles between the view of the two channels
side-by-side or one on top of the other.

Frame Controls

First Frame Automatically returns the RAM Player to the first frame of the
animation. If the RAM Player is at the first frame, First Frame returns the
animation to the last frame.

Previous Frame Backs up the RAM Player to the previous frame in the
animation. If the RAM Player is at the last frame, Previous Frame returns the
animation to the first frame.

Playback Reverse Plays the frames in the animation in reverse order. The
flyout contains an option to play the animation once and then stop.

Playback Forward Plays the frames in the animation in rendered order. The
flyout contains an option to play the animation once and then stop.

Next Frame Advances the RAM Player to the next frame in the animation.

Last Frame Automatically places the RAM Player at the last frame of the
animation.

Frame Rate Control Sets the desired frame rate in frames per second. When
playing back a movie, you see the frame rate displayed in the title bar of the
RAM Player. You can select a predefined frame rate or type in your own frame
rate value.

Color Selector Ctrl+right-clicking the mouse in the display window displays
the color of the pixel in the color selector swatch. Stop the animation to get
a correct pixel reading. The RGB of the pixel is also displayed in the title bar
of the RAM player.

Double Buffer Selecting Double Buffer ensures that the two frames in
channels A and B are synchronized. Enabling this function has a substantial
impact on the maximum frame rate.
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RAM Player Keyboard Shortcuts

The following keyboard shortcuts are available for the RAM Player.

Keyboard ShortcutRAM Player Function

HomeGo To Start Frame

EndGo To End Frame

Left ArrowGo To Previous Frame

Right ArrowGo To Next Frame

Up ArrowPlayback Reverse

Down ArrowPlayback Forward

Esc or Ctrl+CStop Playback

SpacebarToggle Playback or Stop

AToggle Channel A On/Off

BToggle Channel B On/Off

Ctrl+AOpen File in Channel A

Ctrl+BOpen File in Channel B

Alt+AOpen Last Rendered Image in Channel A

Alt+BOpen Last Rendered Image in Channel B

Ctrl+left mouse button or right mouse
button

Scrub Animation
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RAM Player Configuration Dialog

Rendering menu > RAM Player > Load a file into either channel. > RAM Player
Configuration dialog

The RAM Player Configuration dialog contains controls for resolution, frames,
memory usage, and alpha channel for playing back animations.

Interface

Resolution group

Width Defines the width at which the file is loaded.

Height Defines the height at which the file is loaded.

Lock Aspect Ratio When turned on, Lock Aspect Ratio forces the file to load
at the same aspect ratio, regardless of the Width and Height values you enter.

If you change the Width of the file, the Height adjusts according to the file's
original aspect ratio. Adjusting the Height does the same to the Width value.

Filter Input When turned on, Filter Input filters the image or animation so
that it best maintains the quality of the original file. When turned off, filtering
does not occur, and the image or animation could be distorted.
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Frames group

Start Frame Specifies a certain frame in an animation where you want the
RAM Player to begin loading. A value of 1 would start the animation at its
rendered beginning. A value of 5 would start the animation on frame five and
any frame before that would not be loaded.

Num Frames Specifies the total number of frames to be loaded into the RAM
Player.

Memory Usage group

Maximum Lets you configure the maximum amount of memory to use for
the RAM player. This value includes both channels.

Alpha group

Load Into Other Channels When turned on, this option loads a grayscale
alpha channel into the other channel. This allows you to wipe between an
RGB channel of the animation and the alpha channel of the animation.

 Scene Explorer
Menu bar > Tools > New Scene Explorer

Menu bar > Tools > Open Explorer: [name of most recently used explorer]

Menu bar > Tools > Saved Scene Explorers > Choose a saved scene explorer.

Scene Explorer provides a modeless dialog for viewing, sorting, filtering and
selecting objects in 3ds Max, as well as additional functionality for renaming,
deleting, hiding, and freezing objects, creating and modifying object
hierarchies, and editing object properties en masse.

When working on a new scene, you open the Scene Explorer dialog with the
Tools menu > New Scene Explorer command. Each subsequent invocation of
this command opens a separate, additional Scene Explorer dialog. All scene
explorers persist in the scene, even if closed. You can open the most recently
used scene explorer with the Tools menu > Open Explorer command, or any
scene explorer with the Tools menu > Saved Explorer submenu.

TIP In a new scene, the keyboard shortcut Alt+Ctrl+O (letter O) creates a new
scene explorer. But when one or more scene explorers exist in the scene, the same
shortcut opens the most recently used explorer.
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All active scene explorers are saved and loaded with the scene. To save and
load scene explorers separately, and delete and rename them, use the Manage
Scene Explorer dialog on page 7182 .

The Scene Explorer interface consists of a menu bar, two toolbars, and a table
view of objects in the scene, with a row for each object and a column for each
displayed object property. The default layout displays object name, color,
number of faces, and certain display properties, but you can easily customize
it to show only the properties you want. You can save customized Scene
Explorer setups, and set any custom setup to be the default view.

Scene Explorer Features

Following are some of the notable features of Scene Explorer:

■ Customize the dialog by setting any configuration of columns, hidden
and displayed categories, etc.

■ Open as many separate instances of the dialog as you like, each with a
different configuration.

■ Save and load different configurations.

■ Set any configuration as the default.

■ Scene Explorer setup saved with your MAX scene file.

■ Create custom columns such as an editable Radius field with MAXScript.

■ Create and edit object hierarchies by dragging and dropping.

■ Sort on single or multiple columns.

■ Change object settings en masse.

■ Powerful, sophisticated search features.
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See also:

■ Using Scene Explorer on page 7173

■ Scene Explorer Menus on page 7178

■ Scene Explorer Toolbars on page 7179

■ Manage Scene Explorer on page 7182

■ Advanced Search Dialog on page 7183

Using Scene Explorer

This topic includes procedures for using functionality in the Scene Explorer
window on page 7171 .

To highlight objects in Scene Explorer:

■ Optionally, set the filters to show only object types you’re interested in.
Next, do any of the following:

■ From the keyboard, enter enough characters to distinguish the object
or objects you want to select from the rest. For example, if the scene
contains several spheres and several boxes, you can highlight all the
spheres simply by typing S (assuming the spheres still have their default
names).

TIP The Scene Explorer dialog always opens with the keyboard focus in
the Find field, so in general you don’t need to click the field before entering
a search phrase.

■ Use the mouse:

■ To highlight a single item, click its name.

■ To highlight multiple contiguous list entries, drag vertically in any
column. Alternatively, click the first item and then Shift+click the
last.

■ To highlight non-contiguous items, hold down the Ctrl key as you
click.
To remove highlighting from an item, Ctrl+click it.

Using Scene Explorer | 7173



■ On the upper toolbar, click Select All, Select None, or (after making
a selection), Select Invert.

■ If any named selection sets on page 179  exist, choose one from the
Selection Set drop-down list on the upper toolbar.

■ Use the Advanced Search function on page 7183 : From the Scene Explorer
> Select Menu, choose Search, set any number of Boolean search terms,
and then click Select.

To edit properties for multiple objects:

1 Highlight several objects, as described in the preceding procedure.

2 Change a property for any of the highlighted objects. For example, turn
on Hidden, or change an object name.

All highlighted objects receive the changed value or property.

TIP You can toggle an on/off-type property, such as Hidden, by clicking
anywhere in the cell, not just in the check box.

NOTE Clicking a highlighted item’s row doesn’t remove highlighting from
other highlighted rows.

To coordinate selection between the scene and Scene Explorer:

Do any of the following:

■ Make a selection in Scene Explorer, and then right-click a selected item in
the list and choose Select In Scene.

■ On the Scene Explorer > Select menu, turn on Sync Selection. When this
is on, selecting an object in the viewport highlights it in Scene Explorer
and vice-versa.

■ Make a selection in the viewport, and then right-click any cell in Scene
Explorer and choose Pull Selection from Scene.

To delete objects from the scene:

■ Highlight one or more items in Scene Explorer, and then right-click a
highlighted item in the list and choose Delete From Scene.
The objects are deleted from Scene Explorer and the scene.
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TIP To undo such a deletion with the keyboard shortcut Ctrl+Z, first change
the focus from Scene Explorer to the main application by activating a viewport
or clicking the command panel.

To edit hierarchies with Scene Explorer:

■ To link one object to another (child to parent), drag an object’s icon (to
the left of its name) to another object. The first object will become a child
of the second object. When a yellow arrow appears to the left of the target
object, release the mouse button.

■ To unlink a child object from its parent, drag the object’s icon to the Scene
Root node at the top of the list.

To remove a column from the table:

1 Drag the column heading downward until the mouse cursor changes to
an X icon.

2 Release the mouse button.

To add columns to the table:

1 Right-click a column heading and then choose Column Chooser from
the context menu.

This opens the Column Chooser dialog.

TIP Another way to access Column Chooser is from the Display menu.

2 Drag a column heading from the Chooser dialog to one of the Scene
Explorer column headings.

The new column is inserted to the left of the existing column.

3 Continue adding columns as desired. When finished, close the Column
Chooser.

To sort the list based on a column or columns:

1 Click a column heading.

This performs a single-level sort based on the column contents, in
ascending order, as indicated by up arrow on the right side of the heading.
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For example, clicking the Name column sorts the table in ASCII order,
starting with punctuation, then numbers, then letters.

NOTE Object hierarchies remain together when the list is sorted. Child objects
at the same level are sorted only with respect to one another, not objects on
other hierarchical levels.

2 To reverse the sort order, click the same column heading again.

Alternatively, right-click a column heading and choose Sort Ascending
or Sort Descending. You can sort any number of different columns this
way to perform a multi-level sort. For example, you could sort by type,
and then, within that sort, by whether the objects are hidden.

To rearrange columns:

■ Drag a column heading on top of another one. This moves the column to
the left of the target column.

To resize a column:

■ Drag the divider on the right side of the column heading.
Alternatively, to auto-resize a column, double-click the divider on the right
side of the heading.

To edit multiple items:

1 Make sure the value or values you want to change are exposed in the
Scene Explorer interface. If not, add them with the Column Chooser on
page ? .

2 Highlight multiple list entries.

3 Change a value for one of the entries.

Scene Explorer sets the same value for all of the highlighted entries.

To rename an object:

This method applies to editing any text field, such as the custom Radius field
demonstrated in the next procedure.

1 Select the object in the list by clicking its name (or the field you want to
edit). Alternatively, select multiple list entries. The editing is applied to
all highlighted entries.
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2 Do any of the following:

■ Press F2.
This highlights the object name.

■ Double-click an entry.
This places an insert cursor where you double-click.

NOTE You need not double-click a highlighted entry. If you double-click
a non-highlighted entry, you can edit it immediately, and the edit affects
only that entry. If you double-click a highlighted entry and edit it, the
edit affects all highlighted entries.

■ Wait a moment and then drag over the part of the name you want
to replace.
This highlights only the text over which you drag.

3 Edit the name using the keyboard. When finished, press Enter or Tab, or
click a different part of the dialog.

Example: To customize Scene Explorer:

With some knowledge of MAXScript, you can add custom fields to Scene
Explorer that lets you view and edit object properties of your choice. In this
example, you’ll add an editable Radius column that applies to object primitives
such as Sphere, Cylinder, and Teapot.

1 Open a text editor and enter the following (you can copy and paste this
listing):

showinterface sceneexplorermanager

function getter node=(return getuserprop node "user")

function setter node value=(setuserprop node "user" value)

sceneexplorermanager.addproperty "User" getter setter

function getrad node=(if isProperty node "radius" then return

node.radius)

function setrad node value=(if isProperty node "radius" then

node.radius=value as float)

sceneexplorermanager.addproperty "Radius" getrad setrad

2 Save the file in text format in the Scripts folder in your program
installation. Use the file name radius.ms.

3 In 3ds Max, create some teapots and spheres.
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4 From the MAXScript, choose Run Script, and then find and highlight the
script file from step 2 and open it.

This adds a new item to the Column Chooser.

5 Open a new Scene Explorer window, right-click a column heading, and
choose Column Chooser.

6 Scroll down to the bottom of the Column Chooser dialog, and then drag
the Radius item to one of the current column headings.

The new Radius column shows and lets you edit the Radius values for
the teapots and spheres. You can now, for example, highlight several of
the objects by dragging in the Radius column, press F2 to edit the first
item you clicked on, and enter a new value; this sets all highlighted items
to the new Radius value.

Scene Explorer Menus

Scene Explorer on page 7171  > Menu bar

The principal Scene Explorer menus are available on the dialog menu bar. In
addition, several context menus are available by right-clicking different
user-interface elements on the dialog.

Interface

Select menu

Select All Highlights all objects in the list.

Select None Removes highlighting from all objects in the list.

Select Invert Highlights objects that weren’t highlighted and vice-versa.

Select Children When on, highlighting a parent object also highlights its
children.

Select Influences When on and you highlight an object with influences on
page 7816 , the influencing objects also highlight.

Choosing this command turns off Select Dependents, if on.

Select Dependents When on and you highlight an object that influences
another, the object’s dependents on page 7755  also highlight.

Choosing this command turns off Select Influences, if on.
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Find Case Sensitive When on, searching with the Find field results in only
exact matches with the case in the search phrase.

Find Using Regular Expressions When on, you can use
http://www.google.com/search?sourceid=navclient&ie=UTF-8&rls=GGIF,GGIF:2006-22,GGIF:en&q=%22regular+expression%22regular
expressions  in the Find field.

For example, to highlight all items that do not start with upper-case “A”, turn
on Find Case Sensitive and Find Using Regular Expressions, and use this search
term: [^A]. Or to highlight all items that start with “sph” and end with “1”,
turn on Find Using Regular Expressions, and use this search term: sph.*1.
Similarly, to find all light targets, use .*Target.

Sync Selection When on, selecting an object in the viewport highlights it
in Scene Explorer and vice-versa.

Search Opens the Advanced Search dialog on page 7183 , which lets you set
up and use complex Boolean search terms.

Display menu

Object Types The submenu choices are All, None, and Invert; these are the
same as the buttons at the right end of the Display toolbar on page 7180 . Also
available on the submenu is the Hide Toolbar command, which toggles display
of the Display toolbar.

Children Displays linked objects as parent-child hierarchies, with the children
as expandable branches below their parent objects. When off, lists all objects
in the specified sort order with no regard to hierarchies.

Influences When on and you highlight an object with influences on page
7816 , contents of any text-based fields of the influential objects appear in blue.

Column Chooser Opens the Column Chooser dialog, which lets you add
columns by dragging new column headings to the existing column headings.

Scene Explorer Toolbars

Scene Explorer on page 7171  > Upper (main) and lower (Display) toolbars

Interface

main toolbar
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Find Entering a search phrase here highlights search results in the list in real
time. By default, Scene Explorer uses a simple text-search method, but you
can alternatively use regular expressions by turning on Select Menu > Find
Using Regular Expressions.

View Use the drop-down list to choose a different scene explorer, or click in
the text field to edit the name of the current explorer.

Selection Set If any object-level named selection sets on page 146  exist in
the scene, use this list to choose one. This selects all objects in the set.

Select All Highlights all objects.

Select None Removes highlighting from all objects.

Select Invert Toggles all highlighting; highlights non-highlighted
objects and vice-versa.

Sync Selection When on, selecting an object in the viewport
highlights it in Scene Explorer and vice-versa.

Lock Cell Editing When on, prevents you from changing any names,
settings, etc. All selection functionality remains intact.

Display toolbar

Use these controls to determine the type of objects that are displayed in the
dialog list.

The first part of the Display toolbar consists of a row of buttons that toggle
display of the different list types. When on (pushed in, orange background),
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a button enables display of its list type; when off (pulled out, gray background),
Scene Explorer doesn’t list that type of object. The list types are:

■  Display Geometry

■  Display Shapes

■  Display Lights

■  Display Cameras

■  Display Helpers

■  Display Space Warps

■  Display Groups

■  Display Object XRefs

■ Display Bones

Display All Turns on all display filters; that is, display of all object
types is enabled.
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Display None Turns off all display filters; that is, display of all object
types is disabled.

Invert Display Toggles display of all object types; those that were
enabled are disabled, and vice-versa.

Manage Scene Explorer

Tools menu > Manage Scene Explorer

Use the Manage Scene Explorer dialog to save and load custom scene explorers,
delete and rename existing instances, and set your favorite scene explorer as
the default.

Interface

When you first open the Manage Scene Explorer dialog, it lists all current
scene explorers. To highlight one or more list items, use standard mouse-based
methods, including clicking, dragging, and Ctrl+clicking.
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Load Opens a file dialog named Load Scene Explorer. Highlight an INI file
and then click Open.

If the file isn’t a valid saved Scene Explorer file, you receive an error message
and nothing is loaded.

Save Lets you save the highlighted scene explorer as an INI file. Available
only when a single scene explorer is highlighted.

TIP The default folder for saving scene explorers is the \plugcfg folder, but because
it already contains a number of INI files, if you use this feature much you might
want to create a dedicated folder for saving scene explorers.

Delete Eliminates all highlighted Scene Explorer instances from memory.
This is not undoable.

Rename Opens a small Rename Scene Explorer dialog, with the name
highlighted in an editable field. Available only when a single scene explorer
is highlighted.

Set as Default Makes the configuration of the highlighted scene explorer
the default configuration, so when you add a new scene explorer the software
uses this configuration. Available only when a single scene explorer is
highlighted.

Advanced Search Dialog

Scene Explorer on page 7171  > Select menu > Search

The Advanced Search dialog lets you select objects using combinations of
search phrases to specify Boolean searches. For example, you can use Advanced
Search to highlight only hidden non-geometry objects of a specific color whose
name begins with “S”.

Procedures

To use the Advanced Search dialog in Scene Explorer:

1 From the Property drop-down list, choose a property for your search.

This choice determines the available options in the Condition and
Reference Value lists.

2 Choose the Condition.
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For example, if you set Property=Name, then you could choose
Condition=Substring Match to be able to search for a text string anywhere
in the object names.

3 Set the Reference Value. With some properties, such as Name, you need
to enter the value from the keyboard. With others, such as Type and
Color, you need to use the mouse to choose the Reference Value from a
list.

4 Click Add.

This adds the search term to the dialog list.

5 Add enough search terms to create the search you want to perform.

For example, if you want to find all objects other than Helper objects
whose name begins with “House”, your search would look like this:

TIP

If you add a search term and then later decide you don’t want to use it,
highlight it in the list and then click Remove.

6 When you’ve set up the search you want, click Select.

This closes the Advanced Search dialog and highlights all list items that
meet the search criteria.

Interface

Use the dialog controls to specify one or more search phrases and then initiate
the search. Successful search results must meet all specified criteria.
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Property Choose the desired property to search for from the drop-down list.

Condition Based on the Property choice, choose an available condition.

Reference Value Enter a search term or choose one from the drop-down list,
depending on the Property choice.

Add Click to add the search phrase to the list.

Remove Deletes the highlighted search phrase from the list.

[list of search phrases] When you click Add, the current combination of
search conditions (the search phrase) is added to this list.

Select Closes the dialog and performs the search, highlighting all objects in
the Scene Explorer list that satisfy the combination of search conditions.

Cancel Closes the dialog without performing a search.

Scene States
Tools menu > Manage Scene States

Right-click to open the quad menu. > Display (upper-right) quadrant > Manage
Scene States

The Scene States feature provides a fast way to save different scene conditions
with various lighting, camera, material, environment, and object properties
that can be restored at any time and rendered to produce numerous
interpretations of a model. You save and restore scene states with the Manage
Scene States dialog on page 7188 , which makes it a convenient way to quickly
compare how different parameter settings affect how each scene looks. Because
scene states are saved with the MAX file, they are easily accessible to everyone
on a design team.
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Scene states also allow you to experiment with different scene setups without
having to save the entire MAX file each time a change is made. This means
you don't need to open and close files in order to render different conditions
of the same model. As well, scene states do not add to the size of the file.

When you save a scene state, you can choose which aspects of the scene to
record:

■ Light Properties Light parameters such as color, intensity, and shadow
settings are recorded with the scene for each light or luminaire.

■ Light Transforms Transforms such as position, orientation, and scale are
recorded for each light.

■ Object Properties Current Object Properties values are recorded for each
object. This includes settings for Advanced Lighting and mental ray.

■ Camera Transforms Camera transform modes such as position, orientation
and scale are recorded for each camera.

■ Camera Properties Camera parameters such as FOV and depth of field,
including any corrections made by the Camera Correction modifier on
page 5160  are recorded for each camera.

■ Layer Properties Records the settings for each layer in the Layer Properties
dialog at the time the scene state is saved.

■ Layer Assignment Records each object's layer assignment.

■ Materials All materials and material assignments used in the scene are
recorded.

■ Environment Records these Environment and Atmosphere Effects on
page 6484  settings: Background, Ambient, and Tint colors; Global Lighting
> Level; Environment Map; Environment Map on/off state; Exposure
Control rollout settings.

Tips for Managing Scene States

■ When first becoming familiar with scene states, minimize changes to make
it easier to keep track of what each scene state contains.

■ Saving all scene aspects in a scene state allows you more flexibility when
restoring. When you include all the parts of the scene, you can choose to
restore all or just a few of the aspects that were originally saved.
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■ Additions made to a scene after a scene state has been saved affect how
the restored scene will render. For example, say you already have a scene
state named Omni that contains omni lights. You then decide to save
another scene state named Free Spot that contains a free spot light. When
you restore the Omni scene state, the scene will contain both the omni
lights and the free spot light.

If you decide to add other lights to the scene that you don't want to render
with the existing lights, you need to remember to turn off the new lights
and overwrite any existing scenes that have Light Properties saved. See
Saving Changes to an Existing Scene State on page ?  on how to overwrite
an existing scene state.

■ Use descriptive names for scene states. If scene state names are too long
to see in the dialog, resize the Manage Scene States dialog or use the scroll
bar at the bottom of the dialog.
If you select individual parts to be saved with a scene state, it is useful to
note in the scene state name which parts are recorded.

■ If the scene contains more than one camera, restore the desired scene state
first, then change the viewport to the desired camera view.

Scene State Limitations

■ Even though you can select multiple scene states from the Manage Scene
State dialog, only one scene state can be restored at a time.

■ The currently restored scene state name is not displayed in the user
interface. It's helpful to save rendered scenes by their scene state name as
a reference.

■ Materials must be reopened in the Material Editor after a scene state
containing objects with material assignments is restored.

■ If part of a scene state is later deleted or hidden, a warning does not display
when the scene state is restored indicating that there are missing parts or
that the scene will not be restored as it was when originally recorded.

■ Likewise, if you delete one or more scene states from the Manage Scene
States dialog, you are not presented with a warning that you are about to
delete them. However, you can restore deleted scene states with Undo.

■ Viewport configurations are not saved as part of the scene state. Therefore,
you cannot use scene states to control which viewport is active or whether
viewports are minimized or maximized.
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Scene States and Batch Render

Scene states do not store viewport layouts, such as which camera view is active,
so you can use the Batch Render tool on page 6352  to coordinate rendering
from any camera that is saved with the model. With each camera task that
you assign to the batch render tool, you can specify a saved scene state that
will be automatically loaded and rendered.

See also:

■ Manage Scene States Dialog on page 7188

■ Batch Rendering on page 6347

■ Batch Rendering - Batch Render Dialog on page 6352

Manage Scene States Dialog

Tools menu > Manage Scene States

Right-click to open the quad menu. > Display (upper-right quadrant) > Manage
Scene States

The Manage Scene States dialog is a modeless dialog where you can select,
save, rename, and delete scene states on page 7185 .

Procedures

To save a scene state:

1 Set up the scene in the viewport.

TIP It is best to first render the scene to see if it is set up the way you want
before saving it. If it isn't, make the desired changes and render again before
proceeding to the next step.

2 Right-click in a viewport and choose Save Scene State from the quad
menu.

3 In the Save Scene State dialog, highlight the parts you want saved in the
scene state, then enter a descriptive name. For descriptions of these parts,
see Managing Scene States on page 7185 .

4 Click the Save button. This saves the scene state to the MAX file.
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To restore a scene state:

1 Right-click in a viewport and choose Restore Scene State from the quad
menu.

2 Choose the scene state to restore from the flyout list.

3 Highlight the parts you want restored with the scene state. Only the parts
that were originally saved with the scene state are listed.

4 Click Restore.

The scene state is restored in the viewport.

To rename a scene state:

1 Right-click in a viewport and choose Manage Scene States from the quad
menu.

2 In the scene state list, highlight the scene state you want to rename.

3 Click the Rename button.

4 In the Rename Scene State dialog, enter a new name for the scene state.

5 Click OK. The new name is displayed in the scene state list.

To delete a scene state:

1 Right click in a viewport and choose Manage Scene States from the quad
menu.

2 In the scene state list, highlight the scene state you want to delete.

3 Click the Delete button. The scene state is deleted from the MAX file.

NOTE You can undo to restore the deleted scene state.

To save changes to an existing scene state:

1 In the Manage Scene States dialog, highlight the scene state you want to
overwrite.

2 Click the Save button.

The Scene State Manager displays a message confirming if you want to
overwrite the scene state.

3 Click OK.
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Interface

The dialog lists all the scene states that are saved in the MAX file.

Save Opens the Save Scene State dialog on page 7191  where you enter a name
for the current scene state. To select a continuous range of parts, drag or
Shift+click. To make a noncontinuous selection, use Ctrl+click.

Restore Opens the Restore Scene State dialog on page 7192  for the selected
scene state.

Rename Opens the Rename Scene State dialog on page 7193  for the selected
scene.

Delete Deletes the highlighted scene state(s) without first warning you if
you are sure you want to delete the scene. To select a continuous range of
entries, drag or Shift+click. To select noncontinuous entries, use Ctrl+click.

Close Closes the Manage Scene States dialog.
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Save Scene State

Enter a Scene State name A text field where you enter a descriptive name
for the scene state.

Select Parts Lists the parts you can save in the scene state. By default, all
parts are highlighted except for Materials and Environment. When you make
a different selection set, it is “sticky,” which means the next time the dialog
is displayed, the parts you highlighted previously are highlighted.

Save Saves the scene state with the name you supplied and the parts you
selected. The scene state is saved in the MAX file.

Cancel Closes the dialog without saving the scene state.
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Restore Scene State

Enter a Scene State name Displays the scene name that was selected in the
Manage Scene States dialog. Use the drop-down list to select a different scene
state to restore.

Select Parts Displays a list of scene parts from which you can restore for the
scene state. To highlight a continuous range of parts, drag or Shift+click. To
highlight noncontinuous items, use Ctrl+click.

Restore Click to restore the scene state in the active viewport.

Cancel Closes the dialog without restoring the selected scene state.
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Rename Scene State

Enter a Scene State Name Enter a new name in the Name field for the
highlighted scene state. Click OK to accept the change or Cancel to close the
dialog without renaming the scene state.

Schematic View 
Menu bar > Graph Editors > New Schematic View

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic
view.

Main toolbar > Schematic View button

The Schematic View is a node-based scene graph that gives you access to object
properties, materials, controllers, modifiers, hierarchy, and non-visible scene
relationships such as wired parameters and instancing.

Here, you can view, create, and edit relationships between objects. You can
create hierarchies, assign controllers, materials, modifiers, or constraints.
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You can use the Schematic View Display floater to control what entities and
relationships you want to see and work with. Use Schematic View to navigate
complex hierarchies or scenes with large numbers of objects. Use Schematic
View to understand and explore the structure of files you didn't create yourself.

One powerful feature is the list view. You can see the nodes in a text list which
you can sort by criteria. The list views can be used to navigate extremely
complex scenes quickly. You can use the relationship or instance viewer within
Schematic View to see light inclusions or parameter wirings within the scene.
You can control the display of instances or see a list of object occurrences.

Schematic View also allows for background image or grid, and automatic
arrangement of nodes based on physical scene placement. This makes arranging
nodes for character rigs easier.

Choose between a variety of arrangement selections so you can auto-arrange,
or work in a free mode. The layout of the nodes is saved with the named
Schematic View window. You can load a background image as a template for
laying out the nodes in the window.

Schematic View Features

Here are some of the notable features of Schematic View:

■ Layouts are saved with the named Schematic View file.
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■ Text remains readable during window navigation.

■ Schematic View includes tools for displaying and arranging nodes including
a free mode.

■ You can use a background image or grid in the Schematic View window.

■ You can see and edit wired parameters.

■ A modeless display floater lets you turn on and off node display by category.

■ The Relationship List Viewer enables quick navigation and selection of
nodes. Relationships displayed includes Lights inclusion/exclusion, all
parameter wires, constraints, controllers, and modifier relationships such
as path deform paths and morph targets

■ You can copy and instance controllers.

■ You can assign controller types.

■ Schematic View offers extensive MAXScript exposure.

■ Ability to drill down to more properties (such as static values and custom
attributes).

How the Components of Schematic View Behave

Everything displayed in the Schematic View window is shown as a box with
a name. There are various conventions to indicate different states regarding
these objects.

Schematic View  | 7195



Solid End Signifies that the entity is arranged.

Open end Signifies that the entity is free.

Red Border Signifies that the entity is animated.

End Arrow Signifies that the entity shares a relationship with
another entity.

White Fill Signifies that the entity is selected in the Schematic
View window.

White Border  Signifies that the entity is selected in the viewport.

Up Arrow Collapses the entity it springs from and all child entities
thereof up into the parent entity

Down Arrow Expands the next child entity down from the entity
that the arrow springs from.

Overlap Schematic View will prevent newly visible nodes from
overlapping with existing nodes. This applies to free mode: make an object,
free it, make another object and it will fall on top but to the right of the
original object so both can be accessed and moved.

Instances Schematic View will bold the text of instanced entities, for nodes
this will show up on the base object entity. In the example illustrated, Box02
and Box03 are instances.
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See also:

■ New Schematic View on page 7219

■ Delete Schematic View on page 7220

■ Saved Schematic Views on page 7220

■ Schematic View Selection Right-Click Menu on page 7220

Procedures

See Using Schematic View on page 7197

Interface

See the following topics describing the Schematic View user interface.

Schematic View Menus on page 7201

Schematic View List Views on page 7205

Schematic View Preferences Dialog  on page 7207

Schematic View Toolbars on page 7213

Schematic View Display Floater on page 7217

Using Schematic View

This topic includes procedures for using functionality in the Schematic View
window on page 7193 .

To create hierarchies with Schematic View:

1 Select the objects you want to work with in the viewport.

2 Use Zoom Extents Selected to display these objects in the Schematic View
window.
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3  On the Schematic View toolbar, click the Connect button.

4 In the Schematic View window, drag from the child object to the parent.
A dotted line follows your cursor. Click to set the linkage.

 If you are in Hierarchy mode, the children will arrange themselves
into an indented list under the parent as you create linkages.

To assign controllers with Schematic View:

1 On the Schematic View toolbar, click Display.

The Display floater appears. It lets you control what you see in the
Schematic View window.

2 On the Display floater, in the Relationships group, click Controllers. In
the Entities group, click Controllers as well.

The buttons indent to show they are active. The Transforms now appear
in the Schematic View window.

3 In the Schematic View window, select the transform of the object you
want to assign a controller to.

4 Right-click the transform, from on the Tools quad, choose Assign
Controller.

5 Choose the controller you want to apply from the list, then click OK.

To wire parameters with Schematic View:

1 Using the Display Floater, turn on Param Wires in the Relationships
group.

2 In the Schematic View window, select one of the objects you want to
wire.

3 Right-click the selected object and choose Wire Parameters.

4 In the pop up that appears select the component you want to wire, either
a Transform or an Object parameter, for instance.

5 Drag to the other object you want to wire to.

6 Again in the pop up that appears, select the component you need to wire
to.
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7 The Wire Parameters dialog appears. Make the necessary selections and
connect the wires.

8 Once the wiring is established you can edit the wiring by double-clicking
the wire in Schematic View.

To save a Schematic View layout:

1 When you have a layout you like, name the layout using the Schematic
View name field in the toolbar, just to the right of the Preferences button.

2 Close the Schematic View window.

3 To load the saved view, go to Graph Editors > Saved Schematic View and
choose the schematic view from the history list.

To add a background image:

1 On the Schematic View Options menu, choose Preferences.

2 In the Background Image group, click the File: button to launch the File
Browser.

3 In the Browse Images for Input dialog, find and highlight the bitmap you
want to use, then click Open.

4 On the Schematic View Preferences dialog, in the Background group,
turn on Show Image.

The Background bitmap show up in the Schematic View window.

TIP Turn on Lock Zoom Pan, if you want to zoom in or pan the background
image.

To navigate complex scenes:

Complex scenes can be navigated quickly by using the list viewer combined
with the pan or zoom to selected option. For example suppose you need to
locate all the bones within a certain character.

1 Open Schematic View

2 Press H on the keyboard and enter the name of the object you're looking
for in the Select Objects field. Press Enter to select the object by name.

3  In the window navigation tools group, click Zoom Selected.
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The Schematic View window now clearly shows the object node.

4 On the List Views menu, choose Show Occurrences.

The List viewer displays the Object Occurrences dialog.

This is a sortable list. You can click the header title to sort by it.

NOTE Object Occurrence is being used as an example here. You can use any
of the List View menu choices to display a list of objects based on a certain
relationship.

5  On the Options menu choose Pan to Selected. Now click through
the nodes in the list.

The Schematic View window updates to display each node as you click.

This method makes navigation of very complex scenes much more
convenient. Also when working with lists such as relationships or
instances you have the additional ability to detach the relationship or
make the instance unique.

To arrange the nodes in Schematic View to match the viewport:

It can be useful sometimes to arrange the nodes in the Schematic View the
same as in the viewport. There is a script that can do this for you. In this
example we'll use the bones of a character rig.

1 Using Windows Explorer, copy
\3dsmax\scripts\maxscripttools\macro_schematicviewtools.mcr into
\3dsmax\ui\macroscripts.

2 Restart 3ds Max.

3 On the Customize menu, choose Customize User Interface.

4 Click the Quads tab, then choose the Schematic View category from the
drop-down list on the right

5 Drag the action named Project into Schematic View in the Schematic
View quad menu (any quad you like).

6 Drag the Spacing Tool item into Schematic View’s quad menu.

7 On the Graph Editors menu, choose New Schematic View.

8 In any viewport (other than Perspective or User), select the bones of the
rig that you want to arrange.
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9 In the Schematic View window, right-click and choose Project Into
Schematic View from the quad menu.

A new Schematic View named Projection shows the selected bones
arranged as in the viewport.

TIP If the components appear on top of one another, right-click again and
choose Spacing Tool from the quad menu. Drag the spacing slider to the
right to add space between the objects. If necessary manually reposition
components as needed.

Schematic View Menus

Menu bar > Graph Editors > New Schematic View > Menu bar

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic
view. > Menu bar

Main toolbar > Schematic View button > Menu bar

Edit menu

Connect Activates the connect tool. The connect tool in Schematic View
can be used to create any relationship or constraint, are can be used to assign
modifiers.

Unlink Selected Disconnects the selected entities.

Delete Removes entities from Schematic View and from the scene.
Disconnects selected relationships.

Assign Controller Lets you assign controllers to transform nodes. Only
available when controller entities are selected. Opens the standard assign
controller dialog.

Wire Parameters Lets you wire parameters using Schematic View. This is
active only when entities are selected. This launches the standard Wire
Parameters dialog.

Object Properties Displays the Object Properties dialog on page 245  for the
selected nodes. Has no effect when no node is selected.
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Select menu

Select Tool Activates the Select tool when in Always Arrange mode and Select
and Move tool when not.

Select All Selects all entities in the current Schematic View.

Select None Deselects all entities in the current Schematic View.

Select Invert Deselects selected entities and selects unselected entities in the
current Schematic View.

Select Children Selects all children of currently selected entities.

Deselect Children Deselects children of all selected entities. Parent and child
must be selected for child to become unselected.

Select to Scene Selects in viewport all nodes that are selected in Schematic
View.

Select from Scene Selects in Schematic View all nodes that are selected in
viewport.

Sync Selection When on, selecting objects in Schematic View also selects
them in the viewport, and vice-versa.

List Views menu

See Schematic View List Views on page 7205 .

Layout menu

Align Lets you define the following alignment options for selected entities
in the Schematic View window:

■ Left Aligns selected entities to the left edge of the selection, leaving
vertical positioning intact.

■ Right Aligns selected entities to the right edge of the selection, leaving
vertical positioning intact.

■ Top Aligns selected entities to the top edge of the selection, leaving
horizontal positioning intact.

■ Bottom Aligns selected entities to the bottom edge of the selection,
leaving horizontal positioning intact.

■ Center Horizontal Aligns selected entities to the horizontal center of the
selection, leaving vertical positioning intact.
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■ Center Vertical Aligns selected entities to the vertical center of the
selection, leaving horizontal positioning intact.

Arrange Children Arranges the display of children based on set arrangement
rules (align options) below the selected parent.

Arrange Selected Arranges the display of children based on set arrangement
rules (align options) below the selected parent.

Free Selected Frees all selected entities from arrangement rules, tags them
with a hole icon on their left end and leaves them in place. Use this to freely
arrange selected objects.

Free All Frees all entities from arrangement rules, tags them with a hole icon
on their left end and leaves them in place. Use this to freely arrange all objects.

Shrink Selected Hides all selected entities’ boxes, keeping arrangement and
relationships visible.

UnShrink Selected Makes all selected shrunk entities visible.

UnShrink All Makes all shrunk entities visible.

Toggle Shrink When on, shrinking entities works normally. When off, shrunk
entities are fully visible, but not unshrunk. Default=on.

Options Menu

Always Arrange Causes Schematic View always to arrange all entities based
on the chosen arrangement preference. Displays a pop-up warning before
doing so. Choosing this activates the toolbar button.

Hierarchy Mode Sets Schematic View to display entities as a hierarchy instead
of reference graph. Children appear indented below the parent. Switching
between Hierarchy and Reference mode is nondestructive.

Reference Mode Sets Schematic View to display entities as a reference graph
instead of hierarchy. Switching between Hierarchy and Reference mode is
nondestructive.
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Move Children Sets Schematic View to move all children of parent being
moved. When this mode is on, the toolbar button is activated.

Preferences Opens the Schematic View Preferences Dialog  on page 7207 ,
which lets you control what displays in the window by filtering for categories
and setting display options.

Display menu

Display Floater Displays or hides the Display Floater which controls what is
displayed in the Schematic View window.

Hide Selected Performs the action of hiding whatever is selected in the
Schematic View window.

Unhide All Reveals any hidden items.

Expand Selected Displays all child entities of selected entity.

Collapse Selected Hides all children of selected entity, leaving the selected
entity visible.

View Menu

Pan Activates the Pan tool, which lets you move horizontally and vertically
in the window by dragging the mouse.

Pan to Selected Centers selected entities in the window. If no entity is
selected, centers all entities in the window.

Zoom Activates the zoom tool. Lets you move closer to or further from the
Schematic display by dragging the mouse.

Zoom Region Lets you zoom to a specific area by dragging a rectangle in the
window.
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Zoom Extents Zooms the window so all the nodes in the Schematic View
are visible.

Zoom Extents Selected Zooms the window so that all selected nodes are
visible in the display.

Show Grid Displays a grid in the background of the Schematic View window.
Default=on.

Show Background Displays an image in the background of the Schematic
View window. Set the image via Preferences on page 7207 .

Refresh View Redraws the contents of the Schematic View window with all
changes made to it or with changes made in the scene.

Schematic View List Views

Menu bar > Graph Editors > New Schematic View > Menu bar

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic
view. > Menu bar

Main toolbar > Schematic View button > Menu bar

Schematic View supports several list views that display objects and their
relationships in a list. These include list views for instances, object occurrences,
and relationships. Use these lists to quickly edit your parameter wiring, detach
relationships, or make instances unique. Use the List options to synchronize
the list with the viewport or the node display in the Schematic View window.

Interface

List view displaying relationships
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All Relationships Opens or redraws List View with all relationships of
currently displayed Schematic View entities.

Selected Relationships Opens or redraws List View with all relationships of
currently selected Schematic View entities.

All Instances Opens or redraws List View with all instances of currently
displayed Schematic View entities.

Selected Instances Opens or redraws List View with all instances of currently
selected Schematic View entities.

Show Occurrences  Opens or redraws List View with all entities that share
a property or relationship type with currently selected entities

All Animated Controllers Opens or redraws List View with all entities that
have or share animated controllers.

Make Unique In the All Instances and Selected Instances views, this makes
the selected entity a copy and takes it out of the list.

Detach In the All Relationships and Selected Relationships views, eliminates
the selected relationship and takes it out of the list.

Options Menu in the List View Dialogs

Options for list view let you synchronize the list selection with the viewport
and the Schematic View window.

Sync selection When this is turned on, Schematic View selection corresponds
to selections made in the list.

Pan to Selected When this is turned on, Schematic View pans to put the
entity selected in the list into the center of the Schematic View within the
existing zoom factor. For Instances and Occurrences this will be single entities,
for Relationships it will be two entities.

Zoom to Selected When this is turned on, Schematic View zooms extents
around the entity selected in the list. For Instances and Occurrences this will
be single entities, for Relationships it will be two entities

Respect display When this is turned on, the List View will only show entities
turned on for display by the Display Floater.
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Schematic View Preferences Dialog 

Schematic View on page 7193  > toolbar > Preferences button

Schematic View on page 7193  > Options menu > Preferences

The Schematic View Preferences dialog controls what is shown and what is
hidden based on categories. You can filter the objects appearing in the
Schematic View window, so you see only what you need to.

You can add a grid or background image into your Schematic View window.
Here you can also choose the arrangement method and determine the
synchronization between viewport selection and Schematic view window
selection. You can also set the style for the node connections. By selecting the
appropriate filters in this dialog you can make working with Schematic View
more controllable.
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Interface

Include in Calculation group

Schematic View can traverse the entire scene, including materials, maps,
controllers, and so on. The Include In Calculation settings control which scene
components Schematic View will know about. The Display Floater then
controls what is displayed. So, if you don’t Include Materials, you can’t display
materials. If you don’t include controllers, you can't display controllers,
constraints, or parameter-wiring relationships.

If you have a huge scene and are interested only in using Schematic View for
selection, you can turn everything off except Base Objects. If you are interested
only in materials, you can turn off controllers, modifiers, and so on.
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Base Objects Turns on and off the display of the base objects. Use this to
remove clutter in the Schematic View window.

Modifier Stack Turns on and off the display of modifier nodes.

Materials/Maps Turns on and off the display of material nodes in the
Schematic View window. Hide the materials when you are animating and
don’t need to see them, display them when you want to select materials or
make changes to the material of various objects.

NOTE Schematic View does not support the ability to manipulate maps. You can
not paste a map from one material to another.

Controllers When this is turned on, controller data is included in the display.
When this is turned off Controllers, Constraints and Param Wires relationship
and entity buttons are unavailable in the Display floater. When this is on,
you can assign controllers or wire parameters using the tools quad of the
Schematic View right-click menu.

Static Values When this is turned on, unanimated scene parameters are
included in the Schematic View display. Turn this off to prevent the window
from filling up with everything seen in Track View.

Master Point Controller  When this is on, sub-object animation controllers
are included in the Schematic View display. This button prevents the window
from filling up with too many controllers in cases in which sub–object
animation is present.

Skin Details When this is turned on four controllers for each bone in the
Skin modifier are included in the Schematic View display (when Modifiers
and Controllers are also included). This button prevents the window from
stretching out around too many Skin controllers with normal use of the Skin
modifier.

Include Only group

Selected Objects Filters the display of selected objects. Check this box if you
have a lot of objects and only want Schematic View to display the viewport
selection.

Visible Objects Limits the display in Schematic View to the visible objects.
Hide objects you don’t need to display, then check this box to contain clutter
in Schematic View.

Animated Objects  When this is turned on, then only objects that have keys
and their parents will be included in the Schematic View display.
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Hide By Category group

These toggles control the display of objects and their children, by category.
The categories are:

■ Geometry Hides or displays geometric objects and their children.

■ Shapes Hides or displays shape objects and their children.

■ Lights Hides or displays lights and their children.

■ Cameras Hides or displays cameras and their children.

■ Helpers Hides or displays helper objects and their children.

■ Space Warps Hides or displays space warp objects and their children.

■ Bone Objects Hides or displays bone objects and their children.

Be aware that if you have a hierarchy linked to a helper such as a dummy,
and you hide the dummy, you’ll also hide the children.

Link Style group

Bezier Lines Displays the reference lines with arrowheads as Bezier curves.

Straight Lines  Displays the reference lines as straight lines instead of Bezier
curves.

Circuit Lines Displays the reference lines as orthogonal lines instead of curves.
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None  When this is chosen, link relationships will not appear in the
Schematic View display.

Grid group

This group controls the display and use of a grid in the Schematic View.

Show Grid Displays a grid in the background of the Schematic View window.

Snap to Grid When this is on, all moved entities and children of those
entities will snap their upper left corners to the nearest grid point. Entities
not snapped to a grid point when snap is enabled will not snap until they are
subsequently moved.

Grid Spacing: Sets the spacing units of the Schematic View grid. This uses
the standard that entities are 20 grid units high and 100 grid units long.

Arrange Method group

Arranging always takes place within the confines of the positive X and negative
Y space which is delineated by the darker grid lines.

Stacked When this is turned on, arranging via Always Arrange, Arrange
Children or Arrange Selected will result in the hierarchies being stacked below
a width that is determined by the extents of the highest entities in the view.

Horizontal When this is turned on arranging using Always Arrange, Arrange
Children or Arrange Selected will result in the hierarchies being distributed
along and below the y=0 line. Arranging always takes place within the confines
of the positive X and negative Y space.

Vertical When this is turned on arranging using Always Arrange, Arrange
Children or Arrange Selected will result in the hierarchies being distributed
along and to the right of the x=0 line. Arranging always takes place within
the confines of the positive X and negative Y space.

Sync Selection group

Viewports When this is chosen, node entities selected in Schematic View
will have their corresponding nodes selected in the viewports. Likewise, nodes
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selected in the viewports will have their corresponding entities selected in
Schematic View.

Everything When this is chosen, all entities selected in Schematic View will
have their corresponding entities selected in the appropriate places in the
interface, given that those places are open. For instance, selecting a material
in Schematic View will select it in the material editor if it is open and the
material is present, selecting a modifier in Schematic View will select it in the
stack is the Modify panel is open. Likewise, entities selected in the scene will
have their corresponding entities selected in Schematic View.

None When this is chosen, changes in the viewport selection do not affect
the Schematic View display, and selection changes in the Schematic View
display do not affect the viewport selection.

Background Image group

Show Image When on, the background bitmap (if one is chosen) is displayed.
When off, it is not displayed.

By default, the background image displays at screen resolution at the current
zoom factor of Schematic View.

Lock Zoom/Pan When this is turned on, zooming and panning resizes the
background image accordingly. When turned off, the bitmap will remain or
revert to actual pixels at screen resolution.

File button Click to choose an image file for the background of Schematic
View.

When no background image has been chosen, this button displays “None.”
If an image has been chosen, it shows the name of the bitmap file.

Preferences group

Double Buffer Allows for double buffer display to control viewport
performance.

Zoom About Mouse Pointer When this is turned on you can zoom into
wherever you place your cursor. You can also zoom with the zoom wheel, or
hold Ctrl and press the middle mouse button.

Pan to Added Nodes When this is turned on the Schematic View window
will alter itself to accommodate new objects or nodes as they are added to the
scene. When this is turned off the view is unchanged. Leave this off and turn
off Auto arrange, and Schematic view will not disturb the layout of the nodes.
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Use Wireframe Color Uses the wireframe color to shade the node in the
Schematic View window.

Display Layout Warning When this is on, Schematic View will show a layout
warning when Always Arrange is first turned on.

Only Update On Focus When this is turned on, Schematic View only updates
with additions or changes to the scene when it is given focus. This lets you
avoid constant redraws when making changes in the viewport to the scene
objects.

Move Children When this is turned off you can move the parent without
affecting the children. When this is turned on, moving a parent also moves
the children.

Show Tooltips Toggles the display of tooltips when the cursor is over the
node in the Schematic View window.

Snap Floaters Enables floating dialogs (Display and List) to snap to the edges
of the Schematic View window.

Relative Floaters Enables floating dialogs to move and resize as the Schematic
View window is moved and resized.

Schematic View Toolbars

Menu bar > Graph Editors > New Schematic View > Top and bottom toolbars

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic
view. > Top and bottom toolbars

Main toolbar > Schematic View button > Top and bottom toolbars

The Schematic View toolbar at the top of the window contains the following
buttons:

Display Floater Displays or hides the Display Floater. Active button
means floater is open, inactive button means it’s hidden.

Select Lets you select objects in the Schematic View window and in
the viewport. Selecting objects in the Schematic View window turns the node
yellow. Selecting the objects in the viewport, outlines their Schematic View
representation box in white, but doesn’t select it in the Schematic view
window. If you want to the selection in Schematic view passed into the
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viewport use the Sync Selection button. Whatever is selected in Schematic
view will become selected in the viewport as well.

Connect Lets you create hierarchies. Just as you link objects in the
viewports, you can create linkages in Schematic View. Click the child and
connect to the parent. You also use this to add modifiers to objects, and to
wire parameters.

Unlink Selected Unlinks whatever is selected in the Schematic View
window.

Delete Objects Deletes whatever is selected in Schematic View. The
deleted selection disappears in the viewport and the Schematic View window.

Hierarchy Mode Shows the parent/child relationships in a cascading
display. The parents are to the left and up, the children are indented toward
the right and down.

References Mode Shows relationships based on instances and
references rather than hierarchy. Use this to view materials and modifiers.

Always Arrange Sets Schematic View to always arrange all entities
based on arrangement preference (alignment options). Displays a pop-up
warning before doing so. When this mode is on it activates the toolbar button.

Arrange Children Arranges the display of children based on set
arrangement rules (align options) below the selected parent.

Arrange Selected Arranges the display of children based on set
arrangement rules (align options) below the selected parent.

Free All Frees all entities from arrangement rules, tags them with a
hole icon on their left end and leaves them in place. Use this to freely arrange
all objects.
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Free Selected Frees all selected entities from arrangement rules, tags
them with a hole icon on their left end and leaves them in place. Use this to
freely arrange selected objects.

Move Children Sets Schematic View to move all children of parent
being moved. When this mode is on, the toolbar button is activated.

Expand Selected Reveals the display of all child entities of selected
entity.

Collapse Selected Hides the display of all children of selected entity,
leaving the selected entity visible.

Preferences Displays the Schematic View Preferences dialog. This lets
you control what is displayed and hidden in the Schematic View window by
category. Various options are here to filter and control the display within the
Schematic View window. See Schematic View Preferences Dialog  on page 7207
.

Schematic View Name field Use this field to give the particular configuration
of Schematic View a name. Simply typing the name and hitting enter will add
the named view to the list of Saved Schematic View windows available from
the Graph Editors menu.

Bookmark Name field Let's you define a selection of entities in the Schematic
View window as a bookmark, so you can easier return to them in a complex
scene with many objects.

Go to Bookmark Zooms and pans the Schematic View window so the
bookmarked selection is displayed.

Delete Bookmark Removes the bookmark name that is displayed in
the Bookmark name field.
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Buttons on the Lower Toolbar

Zoom Selected Viewport Object Zooms in on whatever is selected in
the viewport. You can also type in the name in the text field next to this
button.

Selected Object text entry window Lets you type in the name of the object
you are looking for. Then click the Zoom Selected Viewport Objects button
and that object will appear in the Schematic View window selected.

Prompt Area Provides a one-line instruction to tell you how to use the
highlighted tool or button or provides you with details such as how many
objects are currently selected.

Pan Lets you move horizontally or vertically in the window. You can
also achieve the same effect by using the scroll bars at the right and bottom
of the Schematic View window, or by using the middle mouse button.

Zoom Lets you move closer to or further from the Schematic display.
When you first open your Schematic View window you will spend a moment
zooming and panning to gain the appropriate view of the objects in the display.
The display of the nodes changes as you move in or out.

You can also zoom by holding Ctrl and pressing the middle mouse button. To
zoom at the cursor, turn on Zoom About Mouse Point in the Schematic View
Settings dialog, accessed by click the Preferences button.

Zoom Region Lets you draw a zoom window on the area of the
Schematic view you want to see up close.

Zoom Extents Zooms the window back so all the nodes in the
Schematic View are visible.

Zoom Extents Selected Zooms the window back so that all the selected
nodes are visible in the display.
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Pan to Selected Pans the window to include the selected objects, within
the same zoom factor, so that all selected entities are visible within current
extents of the window.

Schematic View Display Floater

The Display Floater controls by category what is displayed in the Schematic
View window. The Schematic View Preferences dialog also filters that display
of the window. Use these to manage the clutter of the window, and the
performance speed. Note that unless you display the correct entity and
relationship, you will not be able to perform certain operations. If you want
to wire parameters, for instance, you must have Param Wires turned on. If
you want to wire the parameters of a material, you must also have Materials
chosen.
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Interface

Relationships group

Lets you choose which of the following relationships you want to display or
create: Constraints, Controllers, Parameter wiring, Light inclusion and
Modifiers.

Entities group

Selects which types of entities are displayed or edited:

Base Objects When active, all base object entities will display as children of
the node entities. When Sync Selection is on and the Modifier stack is open,
clicking on a base object will activate that level of the object’s stack.

Modifier Stack When active, all modifiers in the object’s stack will display
as children, beginning with the Modified Object base entity. Modifiers can
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be copied, instanced or moved between objects by using the Connect tool.
For example, connecting XForm to Box01, will display the Attach Modifier
dialog where you can choose between Copy, Move or Instance. Deleting the
modifier from the Schematic View will also remove it from the object’s stack
in the Modify panel.

Materials When active, all materials and maps assigned to the objects will
display as children of the objects. Materials can be instanced between objects
by using the Connect tool on the Schematic View toolbar. For example, drag
material Default1 to Box01 . Double clicking on a material will bring up the
Material editor if the Material is already in an sample material slot.

Controllers When this is active, all controllers other than position, rotation
and scale will display as children of the objects’ transform controller, which
also displays. Controllers can be added to objects only when this is active.
Controllers can be copied or instanced between objects by using the Connect
tool. For example dragging PositionXYZ from Box01 to Position List for Box02, for
instance, will open the Attach Controller dialog, where you can choose to
Copy, Move or Instance this controller.

PRS Lets you choose to display any combination of the three transform types
(position, rotation or scale).

Expand When turned on, entities that are activated will be displayed in
Schematic View. When turned off, only the triangle child indicator on the
bottom of the nodes will display. This toggle only applies at activation time,
it will not expand or contract entities that are already displayed.

Focus When this is turned on, only those entities that are related to others
and have their relationships displayed will be filled with their color, all others
will be displayed unshaded.

Schematic View Commands

New Schematic View

Menu bar > Graph Editors > New Schematic View

New Schematic View creates a new Schematic View window on page 7193 . You
might want to create multiple Schematic view windows filtered in different
ways that you recall for quick access to multiple objects. Name the new
schematic view using the Schematic View name field.
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Delete Schematic View

Select a schematic view. > Menu bar > Graph Editors > Schematic View > Delete
Schematic View

Delete Schematic View opens the Delete Schematic View dialog. This dialog
displays all saved schematic views. Choose the view to be deleted from the
list, and then click the OK button.

For information on the Schematic View buttons and controls, see Schematic
View on page 7193 .

Saved Schematic Views

Graph Editors menu > Saved Schematic Views > Schematic views by name

Saved Schematic Views displays a list of schematic views by name that were
previously created by New Schematic View on page 7219 .

Schematic View Selection Right-Click Menu

Schematic View on page 7193  > Select any node. > Right-click.

The Schematic View right-click menu contains controls for selecting,
displaying, and manipulating selections of nodes. It gives you quick access to
List Views, Display Floater and lets you switch between Reference and Hierarchy
Mode quickly.
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Interface

Select quadrant

Select Tool  Activates the Select tool when Always Arrange is turned on.
Activates the Select and Move tool when Always Arrange is off.

Select All Choose Select All to select everything in the window.

TIP Hold down the Ctrl key to add to selections, and the Alt key to subtract from
them.

Select None  Choose Select None to deselect everything.

Select Invert Deselects selected entities and selects all other entities in the
current Schematic View.

Select Children Selects all children of the current selection.

Deselect Children Deselects children of all selected entities. Parent and child
must be selected for child to become unselected.
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Sync Selection Synchronizes the selection in the Schematic View window
with the viewport. Whatever you have selected in the Schematic View window
becomes selected in the viewport. Whatever you select in the viewport becomes
selected in Schematic View. It’s a two-way street.

Layout quadrant

Free All Frees all entities from arrangement rules, tags them with a hole icon
on their left end and leaves them in place. Use this to freely arrange all objects.

Free Selected Frees all selected entities from arrangement rules, tags them
with a hole icon on their left end and leaves them in place. Use this to freely
arrange selected objects.

Arrange Selected  Arranges the display of the selection based on the
arrangement preferences.

Arrange Children Arranges the display of children based on set arrangement
rules (align options) below the selected parent.

Unhide All Displays all the nodes in the scene. If the resulting Schematic
View is too cluttered to work with, try using Preferences to remove what you
don’t need to see. Or make individual selections and hide upstream or
downstream to unclutter the display.

Hide Selected Hides the selection in the Schematic View window.

Expand Selected Reveals the display of all child entities of selected entity.

Contract Selected Hides the display of all children of selected entity, leaving
the selected entity visible.

Edit quadrant

Connect Tool Activates the connect tool. This tool in Schematic View can
be used to create many Schematic View relationships such as parent, constraint,
copy modifier, copy controller, or copy material.

Unlink Selected  Disconnects the selected entities

Delete Selected Deletes entities from Schematic View and from the scene.
This also can be used to disconnect selected relationships.

Assign Controller Displays the Assign controller dialog. This is available only
when controller entities are selected.

Wire Parameters Let's you wire parameters using Schematic View. This is
active only when entities are selected. This launches the standard Wire
Parameters dialog.
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Edit Properties Displays the Object Properties dialog for the selected objects.

Options quadrant

Shrink Hides all selected entities’ boxes, keeps arrangement and relationships
visible.

Toggle Shrink Changes the state of entity shrinkage. Shrunken entities
become unshrunken, and the other way around.

Unshrink All Makes all shrunken entities visible.

Unshrink Selected Makes all selected shrunken entities visible.

Shrink Selected  Hides all selected entities’ boxes, keeps arrangement and
relationships visible.

List Views

Selected Occurrences  Opens or redraws List View with all entities that share
a property or relationship type with currently selected entities

Selected Instances Opens or redraws List View with all instances of currently
selected Schematic View entities.

All Instances Opens or redraws List View with all instances of currently
displayed Schematic View entities.

Selected Relationships Opens or redraws List View with all relationships of
currently selected Schematic Vie entities.

All Relationships Opens or redraws List View with all relationships of
currently displayed Schematic View entities.

Display Floater Opens the Display floater and activates the corresponding
toolbar button.

Move Children  Sets Schematic View to move all children of parent being
moved. When this mode is on, the toolbar button is activated.

Reference Mode  Sets Schematic View to display entities as a reference graph
instead of hierarchy. Switching between Hierarchy and Reference mode is
nondestructive.

Hierarchy Mode  Sets Schematic View to display entities as a hierarchy instead
of reference graph. Children appear indented below the parent. Switching
between Hierarchy and Reference mode is nondestructive.
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Always Arrange  Sets Schematic View to always arrange all entities based on
the chosen arrangement preference. Displays a pop-up warning before doing
so. Choosing this activates the toolbar button.

Using Layers to Organize a Scene
Layers are like transparent overlays on which you organize and group different
kinds of scene information. The objects you create have common properties
including color, renderability, and display. An object can assume these
properties from the layer on which you create it. Using layers makes it easier
to manage the information in your scenes. Layers are used primarily to control
the visibility of objects in your scene, however they also controls the color of
objects' wireframe and the frozen  on page 152  and hidden state of objects,
as well as their radiosity properties.

For example, you might want to set up a layer that will contain detailed,
custom furniture. To do this, you create a layer and set Viewport Display to
Bounding Box. Then you set the object's display properties to ByLayer (in the
Object Properties dialog on page 245 ). This will keep the viewport display
quick. Then, whenever you want to import new furniture, switch to this layer.
You don't need to set up your viewport display every time you import new
furniture. Also, if you don't want to render the furniture, you can turn off that
layer's Renderable property.

NOTE When you link an AutoCAD file into 3ds Max, any layers that are frozen
(and all objects that reside on these layers) are not imported.

NOTE Objects can be hidden and frozen on a per-object basis; however, an object
residing on a hidden or frozen layer will always  adopt the hide/freeze state of its
layer.

TIP If you set lights' render control to ByLayer (in the General panel of the
Preferences dialog), you can use the Render column in the Layer Manager to
quickly turn lights on or off in your scene.
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Layers can help organize the contents of a scene.

Layer-Object Relationships

The Layer Manager on page 7227  displays layers, as well as their associated
objects. This makes it very easy to organize, and make changes to objects in
a scene. With the Layer Manager, you can adjust property settings at either
the layer level, or individually for each object. Each property can be toggled
between various states, including the ByLayer state on page 7737 . When an
object’s property is set to ByLayer, the object inherits that setting from the
layer it is associated with.

NOTE The Hide and Freeze states of an object cannot be set to ByObject. Objects
can  be hidden or frozen on a per-object basis; however, they will always  follow
the behavior of their layer when it is hidden or frozen.

Special Layer 0

When you begin a new scene, 3ds Max creates a special layer named 0 (default).
By default, objects on layer 0 have their visibility settings on, renderability is
on, and viewport display is set. You can’t delete or rename layer 0.

If you haven’t created any layers, 3ds Max places objects  you create on layer
0 by default. After you create objects, you can reassign them to different layers,
including those residing on layer 0.
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Display Properties

In the Layer Properties dialog on page 7237 , you can specify layer visibility
individually for each viewport. If you don’t want to display a certain layer,
you can hide that layer. 3ds Max hides the layer in the viewport, but not in
any output rendered image of the scene.

NOTE For hidden geometry to render, Render Hidden Geometry must be turned
on in the Render Scene dialog > Common Parameters rollout on page 5929 .

You can specify layers to display objects shaded on page 7370 , in wireframe
mode on page 7973 , as a bounding box on page 7736 , or as whatever is set on
the Viewport Properties menu on page 7370 . Using this method, you can have
different objects displayed differently in the same scene.

You can display layers in See-Through mode on page 7240 . See-Through mode
temporarily displays selected objects in translucent form so you can see through
them without applying special materials. You can toggle See-Through mode
for all objects per layer.

NOTE You can control whether newly created objects adopt the default layer
settings on a per-object basis by using Default To By Layer For New Nodes in the
General Preferences panel on page 7534 .

You can also Freeze, Hide, or Isolate the layer of a selected object using the
corresponding command in the display quadrant of the quad menu.

Layer Names

You can create and name a layer for each conceptual grouping (such as walls
or terrain) and assign common properties to those layers. By grouping objects
into layers, you can control their display and make changes quickly and
efficiently. When you name layers, you can use names of variable length up
to 255 characters. These names can contain letters, digits, blank spaces, and
the special characters dollar sign ($), hyphen (-), and underscore (_).

NOTE Any layers from a linked AutoCAD file are automatically imported to 3ds
Max. 3ds Max names the converted layers based on the layer names from the
AutoCAD drawing.

See also:

■ Layer List  on page 7245

■ Layer Manager  on page 7227

7226 | Chapter 21   Managing Scenes and Projects



■ Layer Properties Dialog on page 7237

Layer Manager 

Main toolbar > Layer Manager

Layers toolbar > Layer Manager

Tools menu > Layer Manager

The Layer Manager, available from the main toolbar, is a modeless dialog
where you can create and delete layers. You can also view and edit the settings
for all of the layers in your scene, as well as the objects associated with them.
You can specify the name, visibility, renderability,  color, and objects' and
layers' inclusion in the radiosity solution  from this dialog.

Objects are organized by layer in the dialog, in an expandable list. By clicking
‘+’ or ‘-‘, you can expand or collapse (respectively) the object list for each layer.
You can also sort the layers by clicking any of the column heads.

 Another useful tool is the ability to open the Object Properties dialog
on page 245  and Layer Properties dialog on page 7237  for one or more
highlighted objects or layers directly from the Layer Manager by clicking the
corresponding icon.

NOTE You can change the property settings for each layer or object by clicking
the corresponding icon in the dialog. With each click, the icons cycle through the
various states of the property, including Off (  ) and By Layer on page 7737  (

 ), and, in the Render, Color, and Radiosity columns, By Object. When a
property is set to By Layer, the object inherits the property setting from its
associated layer.

Procedures

To create a new layer:

When you create new layers, 3ds Max names them sequentially by default:
Layer01, Layer02, and so on. After creating a layer, you can rename it. 3ds
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Max assigns a random color to all new layers. You can accept the default
settings or specify other colors.

1  On the main toolbar, click Layer Manager.

2  In the Layer Manager, click Create New Layer.

3ds Max displays a new layer in the list with the temporary name Layer01.

3 Click the Layer to enter a new name.

4 To create more than one layer, click New again and enter the new layer
name.

TIP If an existing layer is highlighted when you create a new layer, the new
layer inherits the properties of the highlighted layer. You can modify the
properties of the new layer, if necessary, as illustrated in the following
procedures.

To make a layer current:

1  On the main toolbar, click Layer Manager.

2  In the Layer Manager dialog, click the second column next to the layer
name.

 A check box appears indicating that the layer is current.

NOTE The current layer is also displayed in the title bar of the Layer Manager.

To make a layer current (alternate method):

■ On the Layers toolbar > Layer List, select a layer.
The highlighted layer becomes the current layer.

To hide a layer:

1  On the Layers toolbar, click Layer Manager.

2 In the Layer Manager, select the layers you want to hide.
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3  In the Hide column, click Off to turn Hide on for the highlighted
layer(s).

 The hide icon displays.

TIP  You can hide all  layers by clicking Hide/Unhide All Layers on the
Layer Manager toolbar.

To freeze a layer:

Freezing layers is useful when you want to edit objects associated with
particular layers but also want to view, without editing, objects on other layers.
You can't edit or select objects on a frozen layer; however, the objects are still
visible if the layer is on. You can make a frozen layer current, and you can
add new objects to the frozen layer.

1  On the main toolbar, click Layer Manager.

2 In the Layer Manager, highlight the layers you want to freeze.

3  In the Freeze column, click Off to turn Freeze on for the highlighted
layer(s).

 The Freeze icon displays.

TIP  You can freeze all  layers by clicking Freeze/Unfreeze All Layers on
the Layer Manager toolbar.

To assign a color to a layer:

You can assign a color to a layer using the Layer Manager dialog. For example,
you can assign the color red to a layer named HVAC to help you identify the
mechanical equipment in your scene.

1  On the main toolbar, click Layer Manager.

2 In the Layer Manager, select a layer and click the Color icon.

3 In the Layer Color dialog, select a color, and then click OK.
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To rename a layer:

You might want to rename a layer to better define how it's used in your scene.
You can rename a layer at any time during a 3ds Max session. However, you
can't rename Layer 0.

1  On the main toolbar, click Layer Manager.

2 In the Layer Manager, select a layer to rename.

3 Click the layer’s name again and enter a new name.

To delete a layer:

You can delete an empty layer at any time during a 3ds Max session. However,
you can't delete the current layer, Layer 0, or a layer that contains objects.

1  On the main toolbar, click Layer Manager.

2  In the Layer Manager, select one or more layers, and then click Delete
Empty Layer.

To open the Object Properties dialog for an object selection:

1  On the main toolbar, click Layer Manager.

2 Highlight one or more objects in the Layer Manager.

3  Click the Object Properties icon to open the Object Properties dialog
on page 245  for the highlighted objects.

To open the Layer Properties dialog for a layer selection:

1  On the main toolbar, click Layer Manager.

2 Highlight one or more layers in the Layer Manager.

3  Click the Layer Properties icon to open the Layer Properties dialog on
page 7237  for the highlighted layers.
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Interface

Title Bar

The title bar displays the word “Layer” followed by the name of the active
Layer. For example, if Layer02 is the active layer, the title bar will read Layer:
Layer02.

Layer Manager toolbar

Create New Layer Creates a new layer containing any selected objects.

The new layer's name is generated automatically ("Layer01", "Layer02", etc.)
but you can change it by clicking the label.

NOTE The new layer becomes the current layer.
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Delete Highlighted Empty Layers Deletes highlighted layers if they are
empty.

NOTE This button is not available if any of the following items are in your selection
set: nothing, the current layer, objects, Layer 0, or non-empty layers.

Add Selected Objects to Highlighted Layer Moves currently selected
objects into the highlighted layer.

NOTE This button is not available if nothing is selected or if more than one layer
is highlighted.

Select Highlighted Objects and Layers Selects all of highlighted objects,
as well as all objects contained in any highlighted layers.

NOTE This button is not available if nothing is highlighted.

Highlight Selected Objects' Layers Highlights layers containing the
currently selected objects and automatically scrolls so that highlighted layers
are visible in the layer manager.

NOTE This button is not available if nothing is highlighted.

Hide/Unhide All Layers Toggles the display of all layers.

TIP This is most useful if you hide all layers and then display only the layers you
want to work on.

Freeze/Unfreeze All Layers Toggles the frozen state of all layers.

TIP This is most useful if you freeze all layers and then unfreeze only the layers
you want to work on.

List of layers

Displays layers, their associated objects, and their properties. To expand or
collapse the object list for each layer, click ‘+’ or ‘-’, respectively. To modify a
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property, click its icon. To select all layers quickly, right-click and choose
Highlight All. To open the Object/Layer Properties dialog, click on the icon
next to the layer or object.

Each property has a unique icon to indicate that it is turned on, while all

properties share the same icon for the off (  ) and By Layer (  ) states.

NOTE By Layer is available only at the object level, in the Render, Color, and
Radiosity columns.

TIP You can sort the layers by any of their properties by clicking the column name.

Layers Displays the names of the layers/objects. Click a name to select the
layer, or to rename the layer.

NOTE  Clicking the layer icon opens the Layer Properties dialog on page 7237
for all highlighted layers.

 Clicking the object icon opens the Object Properties dialog on page 245  for
all highlighted objects.

Current Layer Toggle The unlabeled column to the right of the layer name
indicates the current layer and lets you make a different layer current.

 A check mark appears next to the current layer. Click the check box next
to another layer name to make it current.

Hide Hides and unhides layers. When a layer is hidden, it's invisible.
You might want to hide layers that contain construction or reference
information.

Freeze Freezes layers. You can't select or edit objects on a frozen layer.
Freezing a layer is useful if you want to view information on a layer for
reference but don't want to edit objects on that layer.

Render When on, objects appear in the rendered scene. Non-rendering
objects don't cast shadows or affect the visual component of the rendered
scene. Like dummy objects, non-rendering objects can manipulate other
objects in the scene.

Shape objects on page 536  have the Render option turned on by default. In
addition, they have a Renderable check box in their creation parameters.
When both check boxes are on, the shape is renderable. If either check boxes
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are off, the shape isn’t renderable. If you apply a modifier that converts the
shape into a mesh object, such as a Lathe on page 1430  or Extrude on page
1377  modifier, the shape automatically becomes renderable regardless of the
state of its local Renderable check box.

For shapes, the Renderable toggle in the Object Properties dialog on page 245
affects the main object, so it also affects all instances of and references to the
shape.

Color Changes the color associated with the highlighted layers. You can
select another color by clicking the color swatch to display either the Object
Color dialog on page 327  (for objects), or the Layer Color dialog (for layers).

You can set an object’s color independently, or turn on ByLayer in the Object
Color dialog to use the associated layer’s color.

Radiosity When on, objects are included in the radiosity solution on
page 5976 . Objects not included in the radiosity solution do not contribute to
indirect illumination. If these objects are lights, only their direct contribution
will be used for rendering.

NOTE Removing objects from the radiosity solution can significantly decrease
radiosity processing and rendering time, however it does sacrifice some accuracy
in the solution. It can be useful for creating quick test renders.
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Layer Manager Right-Click Menu

A standard popup menu is displayed over the Layer Manager by right-clicking
anywhere in the Layer Manager dialog. The menu contains a variety of layer
management and focus operations.

Some of the operations involve highlighted items or selected objects in your
scene. If the right-click is on a non-highlighted row, the highlight switches
to that row and the subsequent operation applies to the newly highlighted
item. If the right-click is on a highlighted row (or a group of highlighted rows),
all of the highlights are preserved and the subsequent operation applies to all
of the highlighted items.

NOTE To apply an operation to a group of objects or layers, you must hold Ctrl
when you right-click. If you have highlighted a group of objects and right-click
on one of them (without holding Ctrl), the selection group is cleared and only
that object will be highlighted.

Rename Initiates text editing mode for the highlighted layer's name. Unique
names are enforced. If a non-unique name is typed in, a modal dialog pops
up, stating “Invalid Layer Name. Layer names must be unique.”
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NOTE Rename is available only for layers; objects cannot be renamed in the Layer
Manager. Likewise, Rename is only available when a single layer is highlighted.

Cut Stores references to highlighted objects in memory so they can be pasted
into another layer.

Cut is only available when objects are highlighted; if there are no objects
highlighted or if a layer is part of a multiple selection, it is not available.

NOTE Objects are not actually cut from their assigned layer until they are pasted
to another one.

TIP If you cut a layer, 3ds Max cuts all objects in the layer.

Paste Moves cut objects into the highlighted layer.

Paste is available only when a single layer is highlighted and one or more
objects have been cut.

Collapse All Closes all expanded layers, hiding the object lists.

Expand All Expands all layers, displaying the objects within each.

Create New Layer Creates a new layer containing any currently selected
objects.

The new layer becomes the current layer. Its name is generated automatically
("Layer01", "Layer02", etc.) but can be changed by clicking its label.

Delete Deletes any empty highlighted layer.

NOTE This does not delete objects. Likewise, this command is not available when
your selection includes Layer0, any objects, or any layer containing objects.

Add Selected Objects Places objects currently selected in your scene into
the highlighted layer.

NOTE This command is available only when a single layer is highlighted.

Select Selects all of the currently highlighted objects or layers in the Layer
Manager.

NOTE If you use this command on a layer, all objects in that layer are selected.

Highlight Selected Objects' Layers Highlights all layers that contain objects
in the current scene selection.

Highlight All Layers Highlights all of the layers in your scene.
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NOTE This command does not highlight any objects.

Layer Properties Opens the Layer Properties dialog on page 7237  for the
currently highlighted layers.

Object Properties Opens the Object Properties dialog on page 245  for the
currently highlighted objects.

Layer Properties Dialog

Main toolbar > Layer Manager > Select one or more layers. > Click Layer icon.

Layer Manager > Right-click a layer. > Layer Properties

The Layer Properties dialog is similar to the Object Properties dialog on page
245 . Here, you can change the rendering, motion blur, and display settings of
one or more selected layers. In addition, you can also change the advanced
lighting settings or hide/freeze one or more selected layers.
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Layer Information group

Controls layer information for objects on the selected layer.

Name Displays the selected layer name, which you can edit. The name can
contain up to 255 characters, including letters, digits, blank spaces, and the
special characters dollar sign ($), hyphen (-), and underscore (_).

Active Color Displays the color of the selected layer. You can select another
color by clicking the color to display the Layer Color dialog, which is identical
to the Object Color dialog on page 327 , except that it doesn't have the By
Layer/By Object toggle.

Display Controls the display of the objects on the selected layer.

Viewport Displays the objects on the selected layer using the current settings
under Views on the viewport right-click menu on page 7370 .

Bounding Box Displays the objects on the selected layer as a bounding box
on page 7736 .

Wireframe Displays the objects on the selected layer in wireframe mode on
page 7973 .

Shaded Displays the objects on the selected layer in Smooth+Highlight
mode on page 7370 .
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General panel

Interactivity group

Hide Hides the selected layer.

Freeze Freezes the selected layer.

Display Properties group

Provides controls that alter the display of objects on the selected layer.

See-Through Makes objects on the selected layer translucent in viewports.
This setting has no effect on rendering, it simply lets you see what's behind
an object in a crowded scene, and especially to adjust the position of objects
behind or inside the See-Through object.

Display As Box Toggles the display of objects on the selected layers, including
3D objects and 2D shapes as bounding boxes on page 7736 . Produces minimum
geometric complexity.
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Backface Cull For objects on the selected layer, toggles the display of faces
with normals on page 7863  pointing away from view. When on, you see through
the wireframe to the back faces. Applies only to Wireframe viewport display.

Edges Only For objects on the selected layer, toggles the display of face edges.
When set, only faces appear. When off, all mesh geometry appears. Applies
only to Wireframe viewport display.

Vertex Ticks Displays the vertices in objects on the selected layer as tick
marks.

If the current selection has no displayed tick marks, the check box is clear. If
some of the vertices in the current selection display tick marks, the check box
contains a gray X. If all vertices in the current selection display tick marks,
the check box contains a black X.

Trajectory Toggles trajectory on page 7955  display for objects on the selected
layer. You can display an object's trajectory wherever you are in 3ds Max.

Ignore Extents When turned on, objects on the selected layer are ignored
when you use the display control Zoom Extents on page 7387 .

Show Frozen in Gray When on, the object turns gray in viewports when
you freeze it. When off, viewports display the object with its usual color or
texture even when it is frozen.

Vertex Colors Affects editable mesh objects on page 1990  on the selected
layer. Displays the assigned vertex colors on page 245  in the viewport. You
assign vertex colors at the vertex or face sub-object levels.

Shaded Affects editable mesh objects on page 1990  on the selected layer.
When on, if the editable mesh has vertex colors, shaded viewports use vertex
colors to shade the mesh. When off, colors are unshaded.

Rendering Control group

Controls rendering settings for objects on the selected layer.

Visibility Controls the rendered visibility of the object. At 1.0, the object is
fully visible. At 0.0, the object is completely invisible when rendered.
Default=1.0.

Renderable Makes objects on the selected layer appear or disappear from
the rendered scene. For more information, see Renderable on page 7233 .

NOTE This has the same functionality as the Render toggle in the layer list on
page 7245 .
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Inherit Visibility Causes objects on the selected layer to inherit the visibility
of their parents (as determined by the parent's Visibility track in Track View).
When a group parent is assigned a visibility track, Inherit Visibility is
automatically turned on for all children in the group. Transparent materials
and hidden objects have no effect on this function.

Visible to Camera When on, the object is visible to cameras in the scene.
When off, cameras do not view this object.

Visible to Reflection/Refraction When on, the object is used in calculating
reflections and refractions. When off, the object does not appear in reflections
or refractions.

Receive Shadows When on, objects on the selected layer can receive shadows.

Cast Shadows When on, objects on the selected layer can cast shadows.

Apply Atmospherics When on, atmospheric effects are applied to the object.
When off atmospheric effects do not change the rendered appearance of this
object.

Render Occluded Objects Allows special effects to affect objects in the scene
that are occluded by this object. The special effects, typically applied by
plug-ins on page 7896  such as Glow on page 6397 , use G-Buffer on page 7795
layers to access occluded objects. Turning on this control makes the object
transparent for the purposes of special effects. This makes no difference when
you render to most image files. When you render to either the RLA on page
7156  or RPF on page 7159  file format, however, occluded objects appear with
the effect applied on their designated G-buffer layer.

Motion Blur group

Controls motion blur for objects on the selected layer.

Multiplier Affects the length of the motion blur streak.

Enabled When on, enables motion blur for this object. When off, motion
blur is disabled regardless of the other blur settings. Default=on.

None Turns off the state of motion blur for objects on the selected layer.

Object Object motion blur on page 7867  provides a time-slice blur effect for
objects on the selected layer.

Image Image motion blur on page 7814  blurs the image of each object on
the selected layer, based on the velocity of each pixel.
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Adv. Lighting panel

Radiosity Properties group

Exclude from Radiosity Processing When on, objects on a selected layer are
included in the radiosity solution. Objects not included in the radiosity solution
do not contribute to indirect illumination. If these objects are lights, their
direct contribution will only be used for rendering.

NOTE This has the same functionality as the Radiosity toggle in the Layer List.

Cast Shadows Determines whether objects on the selected layer will cast
shadows.

Receive Illumination Determines whether objects on the selected layer will
receive illumination.

Diffuse (reflective & translucent) When on, objects on the selected layer are
treated as diffuse (rough) in the radiosity process.
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Specular (reflective & transparent) When on, objects on a selected layer are
treated as specular (smooth) in the radiosity process.

Exclude from Regathering When on, objects on a selected layer are excluded
from the regathering process of the radiosity solution.

For more information on the Radiosity Properties group, see Radiosity Control
Panel on page 5995 .

Object Subdivision Properties group

Use Global Subdivision Settings When on, the object's meshing settings
correspond to the global subdivision settings on the Radiosity Control Panel.
When off, you can change the meshing settings for each object. Default=on.

■ Subdivide When on, a radiosity mesh is created for the objects regardless
of the global meshing state. The subdivision that is performed is determined
by the Use Adaptive Subdivision switch. When off, the settings in the Mesh
Settings group are unavailable. Default=on.

■ Use Adaptive Subdivision Turns adaptive subdivision on and off.
Default=on.

NOTE The Mesh Settings group parameters Contrast Threshold, Min Mesh
Size, and Initial Mesh Size are available only when Use Adaptive Subdivision is
turned on.

Mesh Settings group

Max Mesh Size The size of the largest faces after adaptive subdivision.
Default=36” for imperial units and 100cm for metric units.

When Use Adaptive Subdivision is turned off, Max Mesh Size sets the size of
the radiosity mesh in world units.

Min Mesh Size Faces are not divided smaller than the minimum mesh size.
Default=3” for imperial units and 10cm for metric units.

Contrast Threshold Faces that have vertex illuminations that differ by more
than the Contrast Threshold settings are subdivided. Default=75.0.

Initial Mesh Size When improving the face shape, faces that are smaller than
the Initial Mesh Size are not subdivided. The threshold for deciding whether
a face is poorly shaped also gets larger as the face size is closer to the Initial
Mesh Size. Default=12” for imperial units and 30cm for metric units.
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Layer List 

Layers toolbar > Layer List

The Layer List, available from the Layers toolbar on page 7289 , displays layer
names and their properties. You can control the properties of layers by clicking
the property icons. You can make a layer current by simply selecting it from
the list.

The controls available in the Layer List are a subset of the controls available
in the Layer Manager. For more information, see Layer Manager  on page 7227
.

TIP The Layer List is most useful in conjunction with the other tools available on
the Layers toolbar on page 7289 .

See also:

■ Using Layers to Organize a Scene on page 7224

Procedures

To make a layer current:

1 Click Layers toolbar > Layer List to display the list.

2 Click in the first (left) column next to the layer you want to make current.

A check mark appears next to the current layer.

3 Click the layer list again to collapse it.

4 Select the layer you want to make current from the list.

It is now the current layer.

To change the layer of a selected object:

1 Click Layers toolbar > Layer List to display the list.

2 Select the desired destination layer to make it current.

3  On the Layers toolbar, click Add Selected Objects to Current Layer.
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To change a layer's properties:

1 Click Layers toolbar > Layer List to display the list.

2 Click the layer property icon that you want to set.

You can change the following properties from the layer list: hide/unhide,
freeze/unfreeze, renderable/non-renderable, and color.

3 Click the Layer List again to collapse it.

Interface

You can change the following properties from the layer list: hide/unhide,
freeze/unfreeze, renderable/non-renderable, and color.

Unlike the Layer Manager, where one icon is used for all Off states, the 'Off'
icons for each property on the Layer List are unique.

The following are the On and Off icons for each toggled property in the Layer
List:

OffOnProperty

 (Visible) (Hidden)Hide/Unhide

 (Editable) (Frozen)Freeze/Unfreeze

 (Non-renderable) (Renderable)Renderable/Non-Render-
able

Create New Layer 

Layers toolbar > Create New Layer

Layers toolbar > Layer Manager > Create New Layer

Create New Layer creates a new layer the layer containing the currently selected
objects. The new layer's name is automatically generated (“Layer01”, “Layer02”,
etc.) but may be changed in the Layer Manager on page 7227 .
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Add Selection to Current Layer 

Layers toolbar > Add Selection to Current Layer

Add Selection to Current Layer moves the current object selection to the
current layer.

Select Objects in Current Layer 

Layers toolbar > Select Objects in Current Layer

Select Objects in Current Layer selects all of the objects contained in the
current layer.

Set Current Layer to Selection's Layer 

Layers toolbar > Set Current Layer to Selection's Layer

Set Current Layer to Selection's Layer changes the current layer to the layer
which contains the currently selected objects.

NOTE This button is not available if your selection includes objects that reside on
different layers.
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Utilities

List of Available Utilities
The table of contents for this reference lists utilities alongside the features they
support. Here is a consolidated, alphabetical list.

Asset Browser Utility on page 6928

Assign Vertex Colors Utility on page 5849

Bitmap/Photometric Path Editor Utility on page 6938

Camera Match Utility on page 5152

Camera Tracker Utility on page 3742

Channel Info Utility on page 5858

Clean MultiMaterial Utility on page 5864

Collapse Utility on page 1931

Color Clipboard Utility on page 337

COM/DCOM Server Control Utility on page 7488

Dynamics Utility on page 3775

File Link Manager Utility on page 6783

Fix Ambient Utility on page 6944

Follow/Bank Utility on page 3719

IFL Manager Utility on page 7136

Instance Duplicate Maps Utility on page 5869
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Level of Detail Utility on page 2494

Lighting Data Exporter Utility on page 6559

Lightscape Materials Utility on page 7051

Link Inheritance (Selected) Utility on page 3297

MACUtilities Utility on page 3740

Material XML Exporter Utility on page 5185

MAX File Finder Utility on page 6939

MAXScript Utility on page 14

Measure Utility on page 2597

Motion Capture Utility on page 3721

Panorama Exporter Utility on page 6225

reactor Utility on page 3803

Rescale World Units Utility on page 2599

Reset Utility on page 886

Resource Collector Utility on page 6942

Shape Check Utility on page 541

Skin Utilities on page 3798

Strokes Utility on page 7643

Surface Approximation Utility on page 2480

UVW Remove Utility on page 5188

Visual MAXScript Utility (See MAXScript Reference) on page 7471

See also:

■ Track View Utilities on page 3542
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User Interface

The 3ds Max user interface provides multiple ways to achieve the same goals. You can hide,
float on page 7761  or dock on page 7761 , resize and rearrange the user interface elements into
your own personal design. For more information, see Customizing the User Interface on page
7475 .

See the topics referenced below for detailed information on the major elements of the user
interface.

See also:

■ Menu Bar on page 7257

■ Toolbars on page 7283

■ Quad Menu on page 7300

■ Status Bar Controls on page 7308

■ Animation and Time Controls on page 7342

■ Viewport Controls on page 7366

■ Viewport Navigation on page 7378

■ Command Panel on page 7422

■ MAXScript Interface on page 7280

Additional Keyboard Commands
This topic describes some commands that are provided only as customizable
actions. You can assign them to a keyboard shortcut, a menu, or a button by
using the Customize User Interface dialog on page 7489 .
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See also:

■ Keyboard Shortcuts on page 7645

■ Unwrap UVW Shortcuts on page 1807

Keyable Property

Keyable Property Toggle

Default key: None

In Track View, if you select any track or group of tracks, this command turns
the keyable property on page 3486  on or off. If a selected track is not keyable,
its children (sub-animations), if any, are toggled. For example, if you select a
transform controller track, this command toggles the keyable property of all
position, rotation, and scale tracks. If you select an object's track, its transform,
parameter, and material tracks are all toggled. If the object is part of a
hierarchy, all its child objects' tracks are also toggled.

This action can be undone.

Set Key

Clear Set Key Mode Buffer

Default key: None

While in Set Key mode, if you transform an object but haven't yet clicked Set
Key, this shortcut undoes the transformation and restores the viewport to
show the animation that existed before the change.

Another way to accomplish this is to move the time slider or to turn on Play.

Transforms

Create Position Lock Key and Create Rotation Lock Key

Default keys: None

A lock key is a key with Linear interpolation. If you create the lock key while
an existing key is selected, it changes that key's interpolation from Smooth
to Linear. (Different types of interpolation are described in Bezier Controllers
on page 3063 .) You can create a lock key for position or for rotation.
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Lock keys are useful when you want an object to be stationary, but smooth
interpolation is causing it to "wobble" on its stationary spot.

Position to Zero

Default key: None

Like its counterparts on the Animation quad menu on page 7306 , this shortcut
restores the object's position to the initial “frozen” pose (0,0,0).

NOTE Position To Zero works only if you have previously invoked Freeze Transform
or Freeze Rotation from the Animation quad menu.

Viewport Navigation

Pan Viewport

Default key: I (the letter “i”)

Pans the active viewport, centering it on the current location of the cursor.

You can use this shortcut while another command, such as Move, is active.

This action can be undone, using Shift+Z.

Toggling Dialogs
In most cases, you can close a dialog with the same command used to open
it. This applies to any combination of input methods, including menu, toolbar
button, and keyboard shortcuts. For example, you can open the Render Scene
dialog by choosing Rendering > Render, and then close it by pressing F10
(default keyboard shortcut). If a dialog is available from a menu, a check mark
appears next to the respective command while it's open.

If a dialog is minimized, invoking its command opens the dialog, and invoking
it a second time closes the dialog.

In addition, the keyboard shortcut Ctrl+~ (tilde) toggles display of any open
dialogs, in most cases.

The dialogs affected by this functionality are:

■ Asset Browser

■ Bone Tools
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■ Channel Info Editor

■ Clone and Align dialog

■ Display Floater

■ Environment and Effects dialog

■ Grid and Snap Settings dialog

■ Layer Manager

■ Light Lister

■ Material Editor

■ Material/Map Browser (modeless version)

■ mental ray Messages Window

■ Parameter Collector

■ Parameter Editor

■ Rename Objects

■ Render dialog

■ Render to Texture

■ Rigid Body Property editor

■ Selection Floater

■ Spacing Tool

■ Transform Type-In

■ Video Post

The one exception is Particle View, which is toggled by its keyboard shortcut
(6), but is not toggled by the Modify panel > Particle View button.

Starting 3ds Max from the Command Line
You can start the program from the command line in a Command Prompt
window, or include the command line in a batch file. There are a number of
switches that you can use on the command line.
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To start 3ds Max from the command line:

1 Open a Command Prompt window.

2 Change directory to the 3ds Max root directory, if this directory is not
in your PATH statement.

3 Type 3dsmax to start the program. Optionally, add a command-line
switch (see below).

Command-Line Switches

You can use the following switches after 3dsmax on the command line.

EffectSwitch

Starts program using othercui.cui instead
of maxstart.cui .

-c other-
cui

Causes Track View to use a double-
buffered display, which is smoother than

-d

the single-buffered display but uses more
system resources.

Makes background white (instead of gray)
in the following dialogs: Track View, RAM

-g

Player, Video Post, Loft, and Falloff Curve.
Useful for screen captures when using a
display mode less than 24 bits deep, for
avoiding background patterns.

Allows choice of graphics drivers: Software,
Open GL, Direct3D, and Custom.

-h

Starts program using otherfile.ini instead
of 3dsmax.ini .

-i other-
file

Loads the last .max  file automatically.-l

Open maximized.-ma
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EffectSwitch

Open minimized.-mi

Disables network mode.-n

Starts program using otherfile.ini instead
of plugin.ini.

-p other-
file

Starts program "quietly," without the
splash screen.

-q

Starts program in server mode.-s

Opens utility.-u

Loads a display driver. See details follow-
ing, under "Using the −V Option."

NOTE It is not possible to select which
version of Direct3D you will use with this
switch.

-v

Writes version number to file. See details
following, under "Using the −Z Option."

-z

Starts the program and opens a file called
anyscene.max.

anyscene

A space must separate the program executable name and the command-line
switch.

Examples:

3dsmax −l

3dsmax −i otherfile

3dsmax anyscene

3dsmax −c MaxCustom
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See also:

■ Startup Files and Defaults on page 50

■ Saving and Loading Custom User Interfaces on page 7513

■ Graphics Driver Setup Dialog on page 7582

■ Running Scripts from the Command Line on page 7472

Using the -V Option

You use the -V option to load a different display driver at startup. This option
overrides the setting in 3dsmax.ini .

Follow the -V with one of these letters for the driver you want to use:

s: Loads the software driver.

o: Loads the OpenGL driver.

d: Loads the Direct3D driver.

n: Loads a null driver.

For example, if you ordinarily run OpenGL and want to switch to the software
driver for a session, you would type: 3dsmax  −vs

Using the -Z Option

If you call product support, the representative might ask you to run this option
to determine the exact version of your software. This option only writes to a
file; it does not start 3ds Max.

Follow the -Z with a file name:

3dsmax −z id.txt

The file (in this example, id.txt) is written to the 3ds Max root directory.

Menu Bar

The menu bar is located directly under the main window’s title bar. The title
of each menu indicates the purpose of the commands on the menu. Each
menu uses standard Microsoft Windows conventions.
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File Menu on page 7259

Edit Menu on page 7260

Tools Menu on page 7260

Group Menu on page 7262

Views Menu on page 7262

Create Menu on page 7263

Modifiers Menu on page 7270

reactor Menu on page 7275

Animation Menu on page 7275

Graph Editors Menu on page 7278

Rendering Menu on page 7278

Customize Menu on page 7279

MAXScript Interface on page 7280

Help Menu on page 7281

Interface

When you click a menu name, a number of commands are listed below it.

As an alternative to using your mouse (or other pointing device), each menu
name includes an underlined character. Pressing that character key while
holding down the Alt key opens the menu, unless that particular key
combination is assigned to a keyboard shortcut. Some commands and
subheadings in the open menu have an underlined character as well. While
the menu is open, pressing that character key invokes the command. While
navigating menus with the keyboard, you can also use the arrow keys to move
the highlighting and the Enter key to activate a command or open a submenu.

An ellipsis (…) after a command name indicates a dialog will appear.

A right-pointing triangle after a command name indicates that a submenu
will appear.

If a command has a keyboard shortcut, the menu displays it to the right of
the command name.

If a menu command is an on/off toggle, a check mark indicates its status: If
a check mark is present, the command is active.
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File Menu

Menu bar > File

The File menu contains commands for managing files.

New on page 6716

Reset on page 6717

Open on page 6718

Open from Vault on page 6721

Open Recent on page 6723

Save on page 6723

Save As on page 6724

Save Copy As on page 6726

Save Selected on page 6727

Set Project Folder on page 6728

XRef Objects on page 6732

XRef Scene on page 6755

File Link Manager Utility on page 6783

Merge on page 6854

Merge Animation on page 6859

Replace on page 6866

Load Animation on page 6873

Save Animation on page 6876

Import on page 6892

Export on page 6894

Export Selected on page 6895

Publish to DWF on page 7013

Asset Tracking on page 6897

Archive on page 6918

Summary Info on page 6919
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File Properties on page 6920

View Image File on page 6923

Exit on page 6926

File dialogs (such as Open, Save, Save As) uniformly remember the previous
path you used, and default to that location.

Edit Menu

Menu bar > Edit

The Edit menu contains commands for selecting and editing objects in a scene.

Undo/Redo  on page 202

Hold/Fetch on page 204

Delete on page 205

Clone on page 965

Move on page 888

Rotate on page 889

Scale on page 891

Transform Type-In on page 874

Select All on page 189

Select None on page 189

Select Invert on page 190

Select By on page 191

Region  on page 197

Edit Named Selection Sets on page 186

Object Properties on page 245

Tools Menu

Menu bar > Tools
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The Tools menu displays dialogs that help you change or manage objects,
especially collections of objects, in your 3ds Max scene.

Open Scene Explorer on page 7171  (when a scene explorer exists)

New Scene Explorer on page 7171

Manage Scene Explorer on page 7182

Saved Scene Explorers on page 7171  (when one or more scene explorers exist)

Selection Floater on page 171

Display Floater on page 7458

Layer Manager  on page 7227

Light Lister on page 4920

Manage Scene States on page 7185

Mirror on page 911

Array  on page 915

Align  on page 938

Quick Align  on page 944

Snapshot  on page 921

Spacing Tool  on page 925

Clone and Align on page 933

Normal Align  on page 945

Align Camera  on page 950

Align to View  on page 951

Place Highlight  on page 948

Isolate Selection on page 159

Rename Objects on page 266

Assign Vertex Colors on page 5849

Color Clipboard on page 337

Camera Match on page 5152

Grab Viewport on page 85

Measure Distance on page 2529
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Channel Info on page 5858

Group Menu

Menu bar > Group

The Group menu contains functions for grouping and ungrouping objects in
the scene.

Group on page 222

Ungroup on page 224

Open Group on page 223

Close Group on page 223

Attach Group on page 226

Detach Group on page 225

Explode Group on page 225

Assembly on page 226

See also:

■ Using Groups on page 206

■ Using Assemblies on page 209

Views Menu

Menu bar > Views

This menu contains commands for setting up and controlling viewports. Some
of the commands found on this menu can also be accessed when you
right-click a viewport label.

Undo View Change / Redo View Change on page 87

Save Active View on page 88

Restore Active View on page 88

Grid Commands on page 2564

Viewport Dialog on page 89
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Update Background Image on page 102

Reset Background Transform on page 103

Show Transform Gizmo on page 103

Show Ghosting on page 104

Show Key Times on page 105

Shade Selected on page 107

Show Dependencies on page 108

Create Camera From View on page 109

Add Default Lights to Scene on page 111

Redraw All Views on page 113

Global Viewport Rendering Setting on page 114

Update During Spinner Drag on page 115

Adaptive Degradation  on page 83

Diagnose Video Hardware on page 115

Expert Mode on page 116

NOTE The following commands, also influencing viewport behavior, are accessed
from a different menu:

Viewport Configuration on page 7610

Units Setup Dialog on page 7601

Grid and Snap Settings on page 2577

Create Menu

Menu bar > Create

The Create menu provides a way to create geometry, lights, cameras, and
helper objects on page 2530 . It is organized into various submenus.

See also:

■ Create Panel  on page 7423
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Interface

Standard Primitives

Box on page 350

Cone on page 353

Sphere on page 356

GeoSphere on page 361

Cylinder on page 364

Tube on page 367

Torus on page 370

Pyramid on page 374

Teapot on page 377

Plane on page 380

Extended Primitives

Hedra on page 385

Torus Knot on page 389

Chamfer Box on page 393

Chamfer Cylinder on page 396

Oil Tank on page 399

Capsule on page 402

Spindle on page 405

L-Extrusion on page 409

Gengon on page 411

C-Extrusion on page 414

RingWave on page 417

Hose on page 425

Prism on page 423
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AEC Objects

Foliage on page 439

Railing on page 447

Wall on page 456

Pivot Door on page 510

Sliding Door on page 512

BiFold Door on page 514

Straight Stair on page 488

L-Type Stair on page 473

U-Type Stair on page 495

Spiral Stair on page 480

Awning Window on page 523

Casement Window on page 526

Fixed Window on page 528

Pivoted Window on page 530

Sliding Window on page 534

Projected Window on page 532

Compound

Morph on page 639

Scatter on page 647

Conform on page 660

Connect on page 668

BlobMesh on page 674

ShapeMerge on page 681

Boolean on page 686

Terrain on page 703

Loft on page 715

Mesher on page 767
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ProBoolean on page 774

ProCutter on page 792

Particles

Particle Flow Source on page 2748

Spray on page 2938

Snow on page 2942

Blizzard on page 2951

PArray on page 2964

PCloud on page 2956

Super Spray on page 2947

Patch Grids

Quad Patch on page 1984

Tri Patch on page 1987

NURBS

CV Surface on page 2195

Point Surface on page 2192

CV Curve on page 2208

Point Curve on page 2201

Dynamics

Damper on page 811

Spring on page 820

Shapes

Line on page 551

Rectangle on page 555

Circle on page 557

Ellipse on page 559
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Arc on page 560

Donut on page 564

NGon on page 565

Star on page 567

Text on page 569

Helix on page 574

Section on page 576

Extended Shapes

WRectangle on page 580

Channel on page 583

Angle on page 585

Tee on page 587

Wide Flange on page 588

Lights

Standard Lights >

Target Spotlight on page 4927

Free Spotlight on page 4930

Target Directional on page 4932

Directional on page 4935

Omni on page 4938

Skylight on page 4940

mr Area Spot on page 4948

mr Area Omni on page 4945

Photometric Lights >

Target Point on page 4955

Free Point on page 4958

Target Linear on page 4960
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Free Linear on page 4963

Free Area on page 4967

Target Area on page 4964

Presets on page 4953

Daylight System on page 5024

Cameras

Free Camera on page 5116

Target Camera on page 5118

Create Camera From View on page 109

Helpers

Dummy on page 2531

Expose Transform on page 2532

Grid on page 2538

Point on page 2544

Tape Measure on page 2546

Protractor on page 2549

Compass on page 2551

Camera Point on page 5158

Delegate on page 4730

Crowd on page 4738

Atmospherics >

Box Gizmo on page 6561

Cylinder Gizmo on page 6564

Sphere Gizmo on page 6567

Manipulators >

Slider on page 2559

Plane Angle on page 2556
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Cone Angle on page 2552

Particle Flow >

Speed by Icon on page 2796

Find Target on page 2891

Space Warps

Forces >

Motor on page 2614

Push on page 2609

Drag on page 2624

Vortex on page 2619

Path Follow on page 2635

PBomb on page 2629

Displace on page 2645

Gravity on page 2639

Wind on page 2642

Deflectors >

PDynaFlect on page 2656

POmniFlect on page 2650

SDynaFlect on page 2663

SOmniFlect on page 2661

SDeflector on page 2669

UDynaFlect on page 2666

UOmniFlect on page 2664

UDeflector on page 2672

Deflector on page 2675

Geometric/Deformable >

FFD (Box) on page 2678

FFD (Cyl) on page 2685
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Wave on page 2695

Ripple on page 2699

Displace on page 2645

Conform on page 2703

Bomb on page 2707

Modifier-Based >

Bend on page 2711

Noise on page 2711

Skew on page 2711

Taper on page 2711

Twist on page 2711

Stretch on page 2711

Particles and Dynamics >

Vector Field on page 4837

Systems

Bones IK Chain on page 831

Biped on page 4069

Daylight System on page 5024

Modifiers Menu

Menu bar > Modifiers

The Modifiers menu provides a way to apply frequently used modifiers quickly.
It is organized into submenus. The availability of items on this menu depends
on the current selection. If a modifier doesn't apply to currently selected
objects, it is unavailable in the menu.

See also:

■ Modify Panel  on page 7425

■ Modifier Stack Controls on page 7427
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■ List of Available Modifiers on page 1011

Interface

Selection Modifiers

Mesh Select on page 1455

Poly Select on page 1541

Patch Select on page 1520

Spline Select on page 1673

Volume Select on page 1910

FFD Select on page 1395

Select by Channel on page 1587

Patch/Spline Editing

Edit Patch on page 1290

Edit Spline on page 1376

Cross Section on page 1259

Surface on page 1695

Delete Patch on page 1267

Delete Spline on page 1269

Lathe on page 1430

Normalize Spline on page 1511

Fillet/Chamfer on page 1396

Trim/Extend on page 1746

Renderable Spline on page 1580

 Sweep  on page 1709

Mesh Editing

Cap Holes on page 1159

Delete Mesh on page 1266

Edit Mesh on page 1283
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Edit Normals on page 1284

Extrude on page 1377

Face Extrude on page 1381

MultiRes on page 1493

Normal Modifier on page 1509

Optimize on page 1515

Smooth on page 1665

STL Check on page 1678

Symmetry on page 1735

Tessellate on page 1743

Vertex Paint on page 1876

Vertex Weld on page 1874

Conversion

Turn to Mesh on page 1756

Turn to Patch on page 1758

Turn to Poly on page 1761

Animation Modifiers

Skin on page 1600

Morpher on page 1473

Flex on page 1400

Melt on page 1451

Linked XForm on page 1440

PatchDeform on page 1525

PatchDeform (WSM) on page 1123

PathDeform on page 1528

PathDeform (WSM) on page 1123

SurfDeform on page 1707

SurfDeform (WSM) on page 1132

SplineIK Control on page 1670
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UV Coordinates

UVW Map on page 1849

UVW Mapping Add on page 1871

UVW Mapping Clear on page 1871

UVW XForm on page 1872

Map Scaler (WSM) on page 1120

Unwrap UVW on page 1769

Camera Map (WSM) on page 1043

Camera Map on page 1154

Cache Tools

Point Cache on page 1533

Point Cache (WSM) on page 1129

Subdivision Surfaces

TurboSmooth on page 1750

MeshSmooth on page 1460

HSDS Modifier on page 1420

Free Form Deformers

FFD 2x2x2 on page 1383

FFD 3x3x3 on page 1383

FFD 4x4x4 on page 1383

FFD Box on page 1389

FFD Cylinder on page 1389

Parametric Deformers

Bend on page 1139

Taper on page 1739

Twist on page 1765

Noise on page 1501

Stretch on page 1681

Squeeze on page 1676
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Push on page 1574

Relax on page 1575

Ripple on page 1583

Wave on page 1918

Skew on page 1596

Slice on page 1658

Shell on page 1588

Spherify on page 1668

Affect Region on page 1133

Lattice on page 1435

Mirror on page 1471

Displace on page 1274

XForm on page 1922

Preserve on page 1550

Surface

Material on page 1445

Material by Element on page 1448

Disp Approx on page 1270

Displace Mesh (WSM) on page 1045

NURBS Editing

Surface Select on page 1513

SurfDeform on page 1707

DispApprox on page 1270

Radiosity Modifiers

Subdivide (WSM) on page 1129

Subdivide on page 1688

Cameras

Camera Correction on page 5160
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reactor Menu

Menu bar > Reactor

The reactor menu provides a set of commands related to the reactor dynamics
software, which is build into 3ds Max.

For more info on reactor, see reactor on page 3803 .

Animation Menu

Menu bar > Animation

The Animation menu provides a set of commands related to animation,
constraints and controllers, and inverse-kinematics solvers.

Also present here are controls for custom attributes and parameter wiring, as
well as for creating, viewing, and renaming animation previews.

Interface

IK Solvers

HI Solver on page 3316

HD Solver on page 3346

IK Limb Solver on page 3368

Spline IK Solver  on page 3369

Constraints

Attachment Constraint on page 3213

Surface Constraint on page 3218

Path Constraint on page 3222

Position Constraint on page 3228

Link Constraint on page 3233

LookAt Constraint on page 3237

Orientation Constraint on page 3244

Transform Controllers

Link Constraint on page 3233
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Position/Rotation/Scale on page 3145

Script on page 3186

Position Controllers

Audio  on page 3060

Bezier on page 3063

Expression on page 3079

Linear on page 3118

Motion Capture on page 3128

Noise on page 1501

Quaternion (TCB) on page 3183

Reaction on page 3147

Spring on page 3178

Script on page 3173

XYZ on page 3144

Attachment Constraint on page 3213

Path Constraint on page 3222

Position Constraint on page 3228

Surface Constraint on page 3218

Rotation Controllers

Audio  on page 3060

Euler XYZ on page 3076

Linear on page 3118

Motion Capture on page 3128

Noise on page 3139

Quaternion (TCB) on page 3183

Reaction on page 3147

Script on page 3173

Smooth on page 3178

LookAt Constraint on page 3237
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Orientation Constraint on page 3244

Scale Controllers

Audio  on page 3060

Bezier on page 3063

Expression on page 3079

Linear on page 3118

Motion Capture on page 3128

Noise on page 3139

Quaternion (TCB) on page 3183

Reaction on page 3147

Script on page 3173

XYZ on page 3171

Parameter Editor on page 267

Parameter Collector on page 285

Wire Parameters

Wire Parameters on page 3247

Parameter Wire Dialog on page 3249

Animation Layers on page 3089

Reaction Manager on page 3153

Bone Tools on page 845

Set as Skin Pose on page 244

Assume Skin Pose on page 244

Skin Pose Mode on page 244

Make Preview on page 6220

View Preview on page 6224
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Rename Preview on page 6224

Toggle Limits Toggles all Limit controllers on page 3106  in the current scene.
If all Limit controllers are off, Toggle Limits turns them on, and if all are on,
it turns them off. If some are on and the rest are off, Toggle Limits turns them
all on.

Delete Selected Animation on page 7307

Graph Editors Menu

Menu bar > Graph Editors

The Graph Editors menu gives you access to graphic sub-windows for managing
a scene and its hierarchies and animation.

Interface

Track View – Curve Editor on page 3441

Track View – Dope Sheet on page 3442

New Track View on page 3608

Delete Track View on page 3609

Saved Track Views on page 3610

New Schematic View on page 7219

Delete Schematic View on page 7220

Saved Schematic Views on page 7220

Particle View on page 2730

Motion Mixer... on page 3621

Rendering Menu

Menu bar > Rendering

The Rendering menu contains commands for rendering scenes, setting up
environmental and render effects, compositing scenes with Video Post, and
accessing the RAM Player.
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Render on page 5878

Environment on page 6484

Effects on page 6383

Advanced Lighting >

■ Light Tracer on page 5963

■ Radiosity on page 5995

■ Exposure Control on page 6531

■ Lighting Analysis on page 6028

Render to Texture on page 6169

Batch Render on page 6352

Raytracer Settings on page 6030

Raytrace Global Include/Exclude on page 5424

mental ray Message Window on page 6054

ActiveShade Floater on page 5917

ActiveShade Viewport on page 5918

Material Editor on page 5188

Material/Map Browser on page 5194

Video Post on page 6571

Show Last Rendering on page 5924

Panorama Exporter on page 6225

Print Size Wizard on page 5925

RAM Player on page 7166

Customize Menu

Menu bar > Customize

The Customize menu contains commands for customizing the 3ds Max user
interface (UI).

Customize User Interface on page 7489
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Load Custom UI Scheme on page 7515

Save Custom UI Scheme on page 7516

Revert to Startup Layout on page 7519

Custom UI and Defaults Switcher on page 7483

Show UI on page 7480

Lock UI Layout on page 7481

Configure Paths on page 7519

Units Setup on page 7601

Grid and Snap Settings on page 2577

Viewport Configuration on page 7610

Plug-In Manager on page 7482

Preferences on page 7534

You can create a custom user interface layout, including custom keyboard
shortcuts, colors, menus, and quad menus. You can load or save all of these
things individually in the Customize User Interface dialog, or you can load
or save all of them at once, using schemes. Schemes allow you to load all
customized features of the UI at one time.

You can hide, float or dock on page 7761 , resize, and rearrange some UI
elements into your own personal design. You can also lock the UI once you’ve
got it set. Tools are provided in the Customize menu to load and save these
custom UI files, or to revert to the startup user interface.

System preferences such as keyboard shortcuts, viewport configuration, units
setup, grid and snap settings, and many important default settings, are also
on the Customize menu.

TIP You can access many of these commands with keyboard shortcuts or right-click
options. For example, you can display the Grid and Snap Settings dialog by
right-clicking the Snaps buttons on the main toolbar; you can display the Viewport
Configuration dialog by right-clicking the viewport label, and then choosing
Configure.

MAXScript Interface

Menu bar > MAXScript
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Utilities panel > MAXScript

MAXScript on page 14  is the software's built-in scripting language. Its main
interface, the MAXScript menu, contains the following commands for creating
and working with scripts:

New Script on page 7468

Open Script on page 7469

Run Script on page 7469

MAXScript Listener on page 7469

Macro Recorder on page 7470

Visual MAXScript Editor on page 7471

MAXScript Debugger Dialog on page 7472

In addition, the status bar on page 7308  contains a MAXScript Mini Listener
on page 7309 , and MAXScript functionality is also available from the Utilities
panel on page 7463 .

For detailed information about MAXScript, open the MAXScript Reference,
available from Help menu > MAXScript Reference.

Help Menu

Menu bar > Help

The Help menu provides access to the 3ds Max online help systems.

Welcome Screen Displays the Welcome Screen dialog that opens by default
when you first run 3ds Max.

User Reference Opens the 3ds Max User Reference online.

MAXScript Reference Displays the MAXScript Reference online. See About
MAXScript on page 14 .

Tutorials Displays the online tutorials for 3ds Max.

Data Exchange Solutions Opens your Web browser to a page about software
for exchanging data among applications.

Customer Involvement Program When activated, lets Autodesk collect
anonymous information about your usage of 3ds Max to help us improve the
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software. No personal information is collected. Choose whether or not to
participate, and then click OK.

Subscription e-Learning Catalog Opens your Web browser to a page about
electronic learning content for subscribers.

Create Support Request Opens your Web browser to a page about obtaining
technical support.

View Support Requests Opens your Web browser to a page about existing
requests for technical support.

Edit Subscription Center Profile Opens your Web browser to a page that lets
you edit your subscription profile.

Hotkey Map Displays the Hotkey Map.

Additional Help Displays a dialog that lets you choose to display the help
for installed third-party plug-ins and for add-on products from Autodesk.

By default, this command looks for additional help files in the \help
subdirectory. That location might have changed if you've edited plug-in path
settings. See 3rd Party Plug-Ins Path Configuration on page 7532 .

3ds Max on the Web Displays a submenu whose options display a Web page
with additional information.

■ Online Support Displays the Autodesk 3ds Max Support site.

■ Updates Displays the 3ds Max Downloads section of the Support And
Services site.

■ Resources Displays the Autodesk 3ds Max Resources page.

■ Partners Displays the Autodesk 3ds Max Partners page.

■ Training Displays the Autodesk Media And Entertainment Training page.

Activate 3ds Max Starts the 3ds Max registration wizard, which lets you enter
a new license authorization code. For example, you need to reauthorize 3ds
Max if you're changing from a trial license to a permanent license.

License Borrowing If you are using a network-licensed version of 3ds Max,
use this choice to borrow or return a license. For details, see the AutoCAD
License Borrowing help, which is available as the file acad_brw.chm, installed
in the \program files\common files\autodesk shared\enu folder on your local drive
(typically, drive C:).

About 3ds Max Displays copyright and license information about your copy
of 3ds Max.
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See also:

■ Using the 3ds Max Help on page 7647

■ Copyrights and Trademarks on page ?

Toolbars
Many of the commands in 3ds Max are available as buttons on various toolbars.
By default, two toolbars are displayed : the main toolbar on page 7284  and the
reactor on page 7290  toolbar. By default, the main toolbar is docked at the top
of the interface. You can, however, place the toolbars wherever you want. See
Customizing the User Interface on page 7475  for more information.

Several additional toolbars are hidden by default: Axis Constraints on page
7288 , Layers on page 7289 , Extras on page 7290 , Render Shortcuts on page 7291 ,
Brush Presets on page 7293 , and Snaps on page 7292 . To turn any of them on,
right-click a blank area of the main toolbar and choose the toolbar's name
from the list. You can use this method to turn any toolbar on or off.

See Customize Display Right-Click Menu on page 7479  for more information.

See also:

■ Main Toolbar on page 7284

■ Constraints Toolbar on page 7288

■ Layers Toolbar on page 7289

■ reactor Toolbar on page 7290

■ Extras Toolbar on page 7290

■ Render Shortcuts Toolbar on page 7291

■ Snaps Toolbar on page 7292

■ Animation Layers Toolbar on page 7293

■ Brush Presets Toolbar on page 7293
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Main Toolbar

The main toolbar in its “floating” form.

The main toolbar provides quick access to tools and dialogs for many of the
most common tasks in 3ds Max.

NOTE Right-clicking the move, rotate, or scale buttons opens the Transform
Type-In dialog on page 874 .

Undo/Redo  on page 202

Select and Link  on page 3268

Unlink Selection  on page 3269

Bind to Space Warp  on page 2609
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Selection Filter List on page 176

Select Object  on page 167

 Select From Scene  on page 168

Selection Region Flyout on page 174

Window/Crossing Selection Toggle  on page 201

Select and Move  on page 888
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Select and Rotate  on page 889

Select and Scale on page 891

Reference Coordinate System on page 896

Use Center Flyout on page 904

Select And Manipulate  on page 2529

Keyboard Shortcut Override Toggle  on page 7646

2D Snap, 2.5D Snap, 3D Snap on page 2568

Angle Snap Toggle  on page 2570

Percent Snap Toggle  on page 2571
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Spinner Snap Toggle  on page 2572

Edit Named Selection Sets on page 186

Named Selection Sets on page 179

Mirror on page 911

Align Flyout on page 938

Layer Manager  on page 7227

Curve Editor (Open) on page 3441

Schematic View (Open) on page 7193
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Material Editor  on page 5188

Render Scene Dialog  on page 5878

Render Type on page 5900

Quick Render flyout:

■ Quick Render  on page 5909

■ Quick Render (ActiveShade)  on page 5909

Quick Render on page 5909

Axis Constraints Toolbar

Right-click unused area of any toolbar > Axis Constraints

The axis constraint buttons and flyouts appear on the Axis Constraints toolbar.
See Using the Axis Constraints on page 884 .

NOTE The default UI does not display this toolbar: to see it, right-click an empty
portion of any toolbar, and choose Axis Constraints from the menu.

 Restrict to X

 Restrict to Y

 Restrict to Z
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Restrict to Plane flyout

 Restrict to XY Plane

 Restrict to YZ Plane

 Restrict to ZX Plane

Snaps Use Axis Constraints Toggle on page 2592

Layers Toolbar

Right-click any toolbar > Layers

The Layers toolbar simplifies interaction with the layer system in 3ds Max,
allowing you to easily organize the layers in your scene. Most of these
operations are available from the Layer Manager on page 7227 , however the
Layers toolbar provides shortcuts to several common actions, as well as the
advantage of being able to work directly in the viewports.

NOTE The default UI does not display this toolbar; to see it, right-click an empty
portion of any toolbar, and choose Layers from the menu.

The Layers toolbar provides the following controls:

Layer Manager  on page 7227

Layer List  on page 7245

Create New Layer  on page 7246
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Add Selection to Current Layer  on page 7247

Select Objects in Current Layer  on page 7247

Set Current Layer to Selection's Layer  on page 7247

See also:

■ Using Layers to Organize a Scene on page 7224

reactor Toolbar

The reactor toolbar provides quick access to many of the objects and commands
for the reactor dynamics toolset. For more information, see reactor on page
3803 .

NOTE The default UI does not display this toolbar; to see it, right-click an empty
part of any toolbar, and then choose reactor from the menu. When activated, the
reactor toolbar is docked on the left side of your interface by default.

For more information, see Customize Display Right-Click Menu on page 7479
and Customizing the User Interface on page 7475 .

Extras Toolbar

The Extras toolbar contains several miscellaneous tools for working with your
3ds Max scene.

NOTE The default UI does not display this toolbar; to open it, right-click an empty
portion of any toolbar, and choose Extras from the menu.
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AutoGrid  on page 2513

Array  on page 911

Preset Rendering Options on page 5922

Render Shortcuts Toolbar

Right-click the unused (gray) portion of the main toolbar or another toolbar.
> Render Shortcuts

The Render Shortcuts toolbar lets you assign settings to three custom preset
buttons. You can then use these buttons to switch among various render
presets.

Procedures

To define the presets for a button:

1 Choose one of the default shortcuts from the Presets drop-down list, or
use Load to load the presets from an RPS file.

The Select Preset Categories dialog appears. See Preset Rendering Options
on page 5922 .

2 Choose the categories you want, and then click Save.

The preset render settings are now active.

3 Shift+click the button you want to define.

3ds Max assigns the presets to the file that corresponds to the button:
a.rps, b.rps, or c.rps.
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To use a saved preset:

1 Click one of the buttons you defined.

The button's name appears in the field above the drop-down list: “a,”
“b,” or “c.”

If the button has not yet been defined, clicking it has no effect, and no
name appears in the preset field.

2  On the main toolbar, click Quick Render.

The scene is rendered using the presets you chose.

Interface

Render Preset Slot A, B, and C Click a button to make its presets active.

If you haven't assigned presets to a button, clicking it has no effect. If presets
are assigned, then after you click the button, its name appears in the field
above the drop-down list: “a,” “b,” or “c.”

After assignment, each button has its own render preset (RPS) file: a.rps, b.rps,
and c.rps. These are saved in the \renderpresets folder in the 3ds Max root
directory. The active preset status is not saved with the MAX scene, but it is
saved in the 3dsmax.ini on page 51  file.

Render Presets drop-down list Lets you choose from among a set of preset
rendering parameters, or load or save rendering parameter settings. See Preset
Rendering Options on page 5922 .

This list is the same as the one that appears at the bottom of the Render Scene
dialog on page 5878 .

Snaps Toolbar

Right-click unused area of any toolbar. > Snaps

The Snaps toolbar provides access to the most common Snaps settings.
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To toggle display of the Snaps toolbar, right-click an empty area of the main
toolbar, such as the section under the Reference Coordinate System drop-down,
and choose Snaps. For details on the button functions, see Standard Snaps
on page 2582  and Snap Options on page 2587 .

Animation Layers Toolbar

Right-click unused area of any toolbar. > Animation Layers

The animation layers toolbar provides quick access to commands related to
the Layer controller, such as enabling, adding, and collapsing layers. Some of
these commands are also accessible through the Layer Controller dialog on
page 3087 . For more information, see Animation Layers on page 3089 .

Brush Presets Toolbar

Right-click unused area of any toolbar. > Brush Presets

The Brush Presets toolbar gives you quick access to up to 50 different brush
settings for use with the following paint-oriented tools:

■ Paint Deformation on page 2125  (Edit/Editable Poly)

■ Paint Soft Selection on page 1930  (Edit/Editable Poly)

■ VertexPaint modifier on page 1876

■ Skin modifier on page 1600

You can also use the toolbar to create new presets and to open the Brush
Preset Manager on page 7296 , which lets you edit presets, and save and load
groups of presets. The current group of presets is saved when you quit 3ds
Max and is restored the next time you start the program.
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NOTE Only one set of presets is available at a time. The Brush Presets feature
stores context-specific features, such as the VertexPaint color, but a given preset
has the same size (or size range) in every  context. Other context-independent
settings are Strength and Mirror options (set via the Painter Options dialog on
page 1907 .

Procedures

To use the Brush Presets toolbar:

1 Access any of the brush tools listed above.

The tool starts with a default brush.

2 Right-click an empty area on a toolbar, such as the main toolbar below
the Named Selection Sets drop-down list, and choose Brush Presets.

This opens the Brush Presets toolbar.

3 Do either of the following:

■ Click any of the presets to use it instead of the default brush.

■  Change brush settings and click Add New Preset to add a new
button with the current settings.

4 Paint with the brush.
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5 If you change brush settings with a preset brush active, the preset will
remember the changes between sessions. Common setting changes such
as Size will apply to use of the brush with any tool.

6  To change a preset's name, copy it, delete it from the toolbar, or
save or load all brush presets, click Brush Preset Manager on page 7296 .

Interface

The Brush Preset toolbar controls are available only when a brush tool such
as Paint Deformation on page 2125  is active.

Brush Preset Manager Opens the Brush Preset Manager on page 7296
dialog, which lets you add, duplicate, rename, delete, save, and load brush
presets.

Add New Preset Adds a new preset with the current brush settings to
the toolbar, first prompting you for a name for the brush. If you attempt to
exceed the maximum number of brush presets (50), a dialog alerts you.

[brush presets] Each preset is available on a button with a grayscale bitmap
showing its shape and relative size. Click a preset to activate it and use its
settings. Each preset contains all settings pertinent to the current tool, such
as Mode for Paint Deformation brushes. You can see a preset name by hovering
the mouse cursor over it; the tooltip that appears shows its name.

To deactivate a preset, click its preset again on the toolbar. Its settings remain
active, but changing the settings no longer modify the preset.

By default, the toolbar contains five brush presets, but you can add up to a
total of 50. To activate and use a preset, click its button on the toolbar. The
program remembers any changes you make to the brush settings while a preset
is active and automatically restores these at the start of the following session.

The button image updates automatically to reflect changes to the size (by
default, up to 40.0) and the falloff, which is depicted as a gradient on the
button image. Set the falloff with the Painter Options dialog on page 1907 .
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NOTE Changing a value for a setting the preset has in common with other
contexts, such as Size, changes it for all contexts. For example, if you set a preset
brush's size to 11.6, the brush will be that size when used with any other tool.

Brush Preset Manager

Brush Presets toolbar on page 7293  > Activate a brush tool. > Brush Preset
Manager

The Brush Preset Manager lists all brush presets, showing the context-specific
settings and lets you change contexts. It also lets you rename, add, copy, and
delete presets, and set the range for the depiction of brush sizes on the toolbar.
Lastly, it lets you save and load custom collections of brush presets using the
BPR file format.

The Brush Presets feature recognizes four contexts:

■ VertexPaint modifier on page 1876

■ Paint Deformation on page 2125  (Edit/Editable Poly)

■ Paint Soft Selection on page 1930  (Edit/Editable Poly)

■ Skin modifier on page 1600

Procedures

To use the Brush Preset Manager:

1 Access any of the brush tools listed above.

The tool starts with a default brush.

2 Right-click an empty area on a toolbar, such as the main toolbar below
the Named Selection Sets drop-down list, and choose Brush Presets.
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This opens the Brush Presets toolbar.

3  On the toolbar, click Brush Preset Manager.

Interface
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Context Choose the context for the settings in the list window. The Brush
Presets feature recognizes four contexts and shows the current context as
active:

■ VertexPaint (modifier) on page 1876

■ PaintDeform (Paint Deformation; Edit/Editable Poly) on page 2125

■ PaintSoftSel (Paint Soft Selection; Edit/Editable Poly) on page 1930

■ Paint Skin Weights (Skin modifier) on page 1600

Icon Size Min/Max Sets the range of the brush size depicted on the toolbar.
Changing the actual brush size between the minimum and maximum settings
changes the image of the brush as depicted on its button to show its size
relative to the other presets. Changes to the brush size outside these limits are
not reflected on the toolbar buttons.

Add Adds a new preset to the list, using the current brush settings. When
you click Add, you're prompted to enter a name for the new preset. Edit the
name and then click OK to create the new preset. The new preset appears
highlighted at the end of the list and the toolbar.

NOTE If 50 presets already exist, you won't be able to add any new ones.

Duplicate Adds a copy of the highlighted preset to the list. When you click
Duplicate, you're prompted to enter a name for the new preset. Edit the name
and then click OK to create the new, duplicate preset. The preset appears
highlighted at the end of the list and the toolbar.

NOTE If 50 presets already exist, you won't be able to add any new ones via
duplication.

Delete Deletes the brush preset highlighted in the list from both the list and
the toolbar.

Load Lets you load a saved Preset (BPR) file. Click Load to open the Load
Brush Preset File dialog, click a BPR file to load, and then click Open. The
loaded Preset file replaces the current presets.

Save Lets you save a custom Preset (BPR) file, containing all current brush
presets. Click Save to open the Save Brush Preset File dialog, specify a BPR file
to save, and then click Save. You can then load the Preset file into 3ds Max
at any time.
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[presets list] Shows all presets in a scrollable list. Each list entry shows a
small version of the button image, the preset name, ranges for Strength and
Size, Mirror and Mode settings, and other settings depending on the context.

To rename a button preset, double-click its name and then edit or enter a new
one. Other settings are available from the applicable rollout and the Painter
Options dialog on page 1907 . For example, you can set the brush strength and
size on the applicable rollout, but to set the range, which is used by a
pressure-sensitive input device such as a pen and tablet, you must use the
Painter Options dialog. Mirror options are also available only from this dialog.

The list shows the following general and contextual information:

■ General (all contexts):

■ Strength (with range)

■ Size (with range)

■ Mirror on/off (with axis and offset, if on)

■ Falloff values (set via the Painter Options graph, displayed as a gradient
in the button image)

■ VertexPaint on page 1876

■ Mode (brush state: Paint, Erase, Blur Brush)

■ Color

■ Opacity

■ BlurStrength (if Mode=Blur Brush)

■ PaintDeform on page 2125

■ Mode (brush state: Push/Pull, Relax, Revert)

■ Axis (if brush is Push/Pull)

■ Push/Pull Value (if brush is Push/Pull)

■ PaintSoftSel on page 1930

■ Mode (brush state: Paint, Blur, Revert)

■ Selection Value
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■ Paint Skin Weights (Skin modifier) on page 1600

■ Mode (Paint, Blend [Paint Blend Weights=on])

Right-Click Menu for Scripted Toolbar Buttons

Any toolbar > Right-click a button that is implemented by a script. > Pop-up
button menu

When you right-click a toolbar button that is implemented by a macro script,
a pop-up menu appears.

Edit Button Appearance Displays the Edit Macro Button dialog, which lets
you change the button's appearance and its tooltip. This is documented in
the MAXScript Reference: see  Customizing MacroScript Buttons .

Delete Button Deletes the button from the toolbar.

NOTE There is no Undo for Delete Button, although Customize > Revert To Startup
Layout will restore the toolbar to its original appearance.

Edit Macro Script Opens a MAXScript Editor window, which lets you edit
the button's script.

Customize Opens the Toolbars panel on page 7492  of the Customize User
Interface dialog, which lets you customize the contents of the current toolbar
(or any other toolbar).

Quad Menu
When you click the right mouse button anywhere in an active viewport, except
on the viewport label (see Viewport Right-Click Menu on page 7370 ), a quad
menu is displayed at the location of the mouse cursor. The quad menu can
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display up to four quadrant areas with various commands. These commands
can be customized on the Quads panel on page 7496  of the Customize User
Interface dialog on page 7489 .

The quad menu allows you to find and activate most commands without
having to travel back and forth between the viewport and rollouts on the
command panel.

The two right quadrants of the default quad menu display generic commands,
which are shared between all objects. The two left quadrants contain
context-specific commands, such as mesh tools and light commands. Each of
these menus provides convenient access to functions found in the command
panel. You can also repeat your last quad menu command by clicking the title
of the quadrant.

The quad menu contents depend on what is selected, as well as any
customization options you may have selected in the Quads panel of the
Customize UI dialog. The menus are set up to display only the commands
that are available for the current selection; therefore, selecting different types
of objects displays different commands in the quadrants. Consequently, if no
object is selected, all of the object-specific commands will be hidden. If all of
the commands for one quadrant are hidden, the quadrant will not be displayed.

Cascading menus display submenus in the same manner as a right-click menu.
The menu item that contains submenus is highlighted when expanded. The
submenus are highlighted when you move the mouse cursor over them.

Some of the selections in the quad menu have a small icon next to them in
the quad menu. Clicking this icon opens a dialog where you can set parameters
for the command.

To close the menu, right-click anywhere on the screen or move the mouse
cursor away from the menu and click the left mouse button. To reselect the
last selected command, click in the title of the quadrant of the last menu item.
The last menu item selected is highlighted when the quadrant is displayed.

Additional, specialized quad menus become available when you are working
in ActiveShade on page 5910 , the Edit UVWs dialog on page 1788 , or when you
press any combination of Shift, Ctrl, or Alt while right-clicking in any standard
viewport. For more information, see Additional Quad Menus on page 7304 .

Interface

The following are the default commands for the right-click menu. You can
add, edit, or remove any of these commands in the Quads panel on page 7496
of the Customize User Interface dialog.
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Default quad menu for an editable mesh object at the
Vertex sub-object level

Transform quadrant

These options are available from the Transform quadrant:

Move Lets you move objects. This is the same as clicking Select And Move
on page 888  on the main toolbar.

You can open the Transform Type-In on page 874  by clicking the icon to the
right of Move on this menu.
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Rotate Lets you rotate objects. This is the same as clicking Select And Rotate
on page 889  on the main toolbar.

You can open the Transform Type-In on page 874  by clicking the icon to the
right of Rotate on this menu.

Scale Lets you scale objects. This is the same as clicking Select And Scale on
page 892  on the main toolbar. If one of the other Select And Scale flyout on
page 891  buttons is active on the maintoolbar, that tool becomes active when
you click Scale on the quad menu.

You can open the Transform Type-In on page 874  by clicking the icon to the
right of Scale on this menu.

Select Lets you select objects.

Select Similar Automatically selects objects similar to the current selection.
See Select Similar on page 190

Clone Lets you clone objects. This is the same as choosing Clone on page
965  from the Edit menu.

Object Properties Opens the Object Properties dialog on page 245  for a
selected object. This command is available only if an object is selected when
you open the quad menu.

Curve Editor Opens and displays the selected object at the top of the Track
View Hierarchy. This command is visible only if an object is selected when
you open the quad menu.

Dope Sheet Opens and displays the Dope Sheet on page 3442 .

Wire Parameters Starts a wire parameter on page 3247  from the selected
object. This command is available only if an object is selected when you open
the quad menu.

Convert To This submenu lets you convert the selected object to an editable
mesh on page 1990 , an editable patch on page 1934 , an editable spline on page
590 , a NURBS surface on page 2190 , or an editable poly on page 2038 . This
command is available only if an object is selected when you open the quad
menu.

Display quadrant

These options are available from the Display quadrant:

Isolate Selection The Isolate Selection tool on page 159  lets you edit your
selection while hiding the rest of the scene.
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TIP You can use this iteratively to delve into a large selection set.

Isolate Selection's Layer Isolates the layer of the selected object.

Unfreeze All Unfreezes all frozen objects.

Freeze Selection Freezes the selected objects. Frozen objects are visible in
the viewports, but cannot be manipulated.

Freeze Selection's Layer Freezes the layer of the selected object.

Unhide by Name Displays a version of the Select From Scene dialog on page
168  you can use to choose objects from a list to unhide.

NOTE You cannot unhide an object on a hidden layer. If you select and object
on a hidden layer, a dialog will prompt you to unhide the layer first.

Unhide All Unhides all hidden objects.

Hide Unselected Hides all visible objects that are not selected. Hidden objects
still exist in the scene, but do not appear in the viewports or in rendered
images.

Hide Selection Hides the selected objects.

Hide Selection's Layer Hides the layer of the selected object.

Save Scene State Opens the Save Scene State dialog where you enter a name
for the current scene and select the options you want saved with the scene.

Manage Scene States Opens the Manage Scene States dialog. This is a
modeless dialog where you can select, save, restore, rename, and delete scene
states. See Manage Scene States Dialog on page 7188 .

Tools quadrants

The two quadrants on the left side of the default quad menu are called Tools
1 and Tools 2. These quadrants contain commands specific to various
geometries and modifiers such as: lights, editable geometries, and cameras.
These quadrants appear only if one of the corresponding geometries or
modifiers is selected when you open the quad menu.

Additional Quad Menus

Several specialized quad menus are available when you are working in certain
modes, such as ActiveShade on page 5910 , Edit UVWs on page 1788 , Track View
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on page 3426 , or when you press any combination of Shift, Ctrl, or Alt while
right-clicking any standard viewport.

The ActiveShade quad menu provides many useful commands such as Render,
Draw Region, Update, as well as access to the Material Editor on page 5188 .
Similarly, the Unwrap UVW quad menu contains many common UVW
commands.

You can create or edit any of these menus from the quad set list in the Quads
panel on page 7496 , on the Customize User Interface dialog; however, they
cannot be deleted.

These are the additional quad menus and their default settings:

Biped Appears when you right-click any selected biped on page 4069  part.
The two left-hand quadrants, Tools 1 and Tools 2, provide quick access to
many commonly used biped tools, including Track Selection rollout commands
and Layers rollout commands.

ActiveShade Appears when you right-click an ActiveShade viewport or
window on page 5910 . This menu provides quick access to many of the
commonly used actions in ActiveShade, including Draw Region, Initialize,
and Update, as well as access to the Material Editor.

Unwrap UVW Appears when you right-click an Edit UVWs dialog. This menu
provides quick access to many of the commonly used UVW actions.

Track View Key Appears when you right-click any Track View dialog. This
menu provides quick access to common key actions, such as Move, Add, Scale,
and Reduce Keys.

Shift+right-click Provides access to snap options and settings. See Grid and
Snap Settings dialog on page 2578 .

Alt+right-click Provides several animation tools, letting you set the coordinate
system, set and assume skin poses, and set key frames.

Ctrl+right-click Provides several modeling tools that let you create and edit
many geometries, including standard primitives and editable geometries.

Shift+Alt+right-click Contains many reactor commands. For more information,
see reactor on page 3803 .

Shift+Ctrl+right-click Available for assignment. Use the Quads panel to
customize it.

Ctrl+Alt+right-click Provides several lighting and rendering commands. The
default actions let you render your scene, access render effects and
environmental effects, and toggle object properties for the current selection.
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Shift+Ctrl+Alt+right-click Available for assignment. Use the Customize menu
> Customize User Interface > Quads panel to customize this menu.

There is also a Track View quad menu on page 3492  that appears only while
you are using Track View.

Animation Quad Menu

Alt+right-click a viewport. > Animation quad menu

The Alt+right-click quad menu has commands to assist in animation.

See also:

■ Additional Keyboard Commands on page 7251

Interface

Coordinates quadrant

Lets you change the active reference coordinate system on page 896 .

Set quadrant

Keyframe Sets a key at the current frame. Set Key or Auto Key do not need
to be on.
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Show Trajectories Toggle Toggles the display of trajectories on page 3045 .

Reaction Manager Opens the Reaction Manager dialog on page 3153 .

Delete Selected Animation Deletes any existing animation keys for all selected
objects, as well as any sub-object animation. Each object remains in its state
at the frame in which you use this command.

Pose quadrant

Set Pref Angles For a hierarchy with history-independent (HI) IK applied to
it, sets the preferred angle for each bone in the chain.

Assume Pref Angles For a hierarchy with history-independent (HI) IK applied
to it, copies the X, Y, and Z preferred angle channels of each bone and places
them into its FK rotation subcontroller.

Set as Skin Pose Stores the selected objects' current position, rotation, and
scale as the skin pose. See Skin Pose Commands on page 244 .

Assume Skin Pose Causes the selected objects to take on the stored skin pose.
See Skin Pose Commands on page 244 .

Transform quadrant

Commands in this quadrant are meant primarily as aids to character animation.
Use the Freeze commands to set the character's initial pose. Then you can
later use the “to Zero” options to return to that initial pose.

Freeze Transform Sets the object's transform values to zero without actually
moving the object.

Freeze Rotation Sets the object's rotation value to zero without actually
moving the object.

Transform to Zero Transforms the object back to the zero pose established
by Freeze Transform.

Transform To Zero works only if you have previously invoked Freeze Transform
or Freeze Rotation.

NOTE There is also a Position To Zero command, which returns the object to the
zero position only (no rotation). You can use Position To Zero by creating a
keyboard shortcut for it. See Additional Keyboard Commands on page 7251 .

Rotation to Zero Transforms the object back to the zero rotation established
by Freeze Rotation.
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Rotation To Zero works only if you have previously invoked Freeze Transform
or Freeze Rotation.

Status Bar Controls
The 3ds Max window contains an area at the bottom for prompt and status
information about your scene and the active command. There is a coordinate
display area in which you can type transform values, and on the left, a two-line
interface to the MAXScript Listener.

See also

Animation and Time Controls on page 7342

Viewport Navigation on page 7378

Time Slider and Track Bar

Time Slider on page 7312

Show Curves  Click to display a version of the Track View Curve
Editor on page 3441  in place of the time slider and track bar.

When curves are displayed, you can click the Close button at upper left to
return to a view of the time slider and track bar.

Track Bar on page 7315

Status Bar

MAXScript Mini Listener on page 7309

Status Line  on page 7312
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Selection Lock Toggle  on page 7324

Relative/Absolute Transform Type-In on page 874

Coordinate Display on page 7325

Grid Setting Display  on page 7327

Prompt Line  on page 7309

Time Tag on page 7328

Prompt Line

Status bar > Prompt line

The prompt line, located at the bottom of the window under the status line
, provides ongoing feedback, based on the current cursor position and the
current program activity. When you don’t know what to do next, look down
here for instructions.

Depending on what you are doing, the prompt line displays instructions that
tell you what the program expects or what you can do next. For example,
when you click the Move button, the prompt line reads "Click and drag to
select and move objects."

Tooltips are also displayed on the prompt line as your cursor passes over icons
in any toolbar and the status bar.

MAXScript Mini Listener

Click the tag bar, to the left of the status and prompt lines, and drag it to the
right to display the MAXScript Mini Listener.

The MAXScript Mini Listener is a single-line view of the contents of the
MAXScript Listener window on page 7469 .

The MAXScript Listener window is divided into two panes: one pink, and one
white. The pink pane is the MacroRecorder pane. When the MacroRecorder
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is enabled, everything that is recorded is displayed in the pink pane. The pink
line in the Mini Listener shows the latest entry into the MacroRecorder pane.

The white pane is the Scripter window where you can create scripts. The last
line you type in the white area of the Listener will appear in the white are of
the Mini Listener. Use the arrow keys to scroll the display in the Mini Listener.

You can type directly into the white area of the Mini Listener, and the
command executes in the viewports.

Right-click either of the Mini Listener lines to open the floating MAXScript
Listener window. It will also display a list of the last 20 commands recorded.
You can choose any of these commands and press Enter to execute them.

For more information about the MAXScript Listener window, as well as about
creating scripts, see the MAXScript Reference: choose Help > MAXScript
Reference.

Procedures

Example: To create a sphere using the Mini Listener:

1 Click the tag bar at the left end of the status bar, and drag it to the right
to expand the Mini Listener.

2 In the Scripter (white, lower) line, type sphere radius: 50 and press Enter.

A sphere appears in the viewports.

Example: To redo a command using the Mini Listener:

1 Click the tag bar at the left side of the status bar, and drag it to the right
to expand the Mini Listener.

2 Right-click the Mini Listener and choose Open Listener Window.

3 From the MacroRecorder menu, choose Enable.

4 Using the command panel, create a sphere in the perspective viewport.

5 Convert the sphere to an Editable Mesh.

6 Delete the sphere.

7 Make a box.

8 Right-click the MacroRecorder (pink, upper) line and choose macros.run
"Modifier Stack" "Convert_to_Mesh" from the list. The box has been collapsed
to an editable mesh.
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Example: To make a script and add it to a toolbar:

For this very simple example, you’ll make a script that collapses an object to
an editable mesh, and then create a toolbar icon to run the script.

1 Right-click the Mini Listener, and choose Open Listener Window.

2 From the MacroRecorder menu, choose Enable. Close the listener window.

3 Create a box in the Perspective viewport.

4 Right-click the box and choose Convert to: > Editable Mesh from the
quad menu.

5 Left-click in the MacroRecorder line.

The MacroRecorder line goes blank because the cursor goes to the last
line.

6 Press the upper-arrow key on the keyboard to move up the list of recorded
command scripts.

7 Click and highlight the macros.run "Modifier Stack" "Convert_to_Mesh" line.

Highlight the command script as you would highlight a line of text in a
text editor by clicking at the start of the line and dragging along the entire
length.

8 Click and drag the highlighted script from the Mini Listener to a toolbar.

Interface

MacroRecorder Line The pink, upper line displays the last thing recorded
by the MacroRecorder. If the MacroRecorder is not enabled, nothing will
appear in this line.

Scripter Line The white, lower line displays the last entry typed into the
Scripter window. You can type directly into this line and execute the
commands in the viewports

History List Right-clicking either of the Mini Listener lines displays a history
of the last twenty commands recorded by the Macro Recorder (provided it has
been enabled). Click any of these commands to execute them in the viewports.
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Open Listener Window Right-clicking either of the Mini Listener lines
displays a dialog that allows you to open the MAXScript Listener window.
You can also open the Listener using the Utilities panel > MAXScript rollout.
You can display the Listener window in a viewport by right-clicking the
viewport label, then choosing Views > Extended > MAXScript Listener.

Status Line

Status bar > Status line

The status line displays the number and type of object or objects selected. The
status line is located at the bottom of the screen, just above the prompt line
on page 7309 .

If multiple objects are selected and all are of the same type, the number and
type of the objects are displayed: "2 cameras, 3 lights" for example. If multiple
objects of different types are selected, the status line displays the number plus
the word "objects": "6 objects" for example.

Time Slider

Status line > Time Slider

The time slider shows the current frame and lets you move to any frame in
the active time segment on page 7702 . Right-clicking the slider bar opens the
Create Key dialog on page 3017 , which lets you create position, rotation, or
scale keys without using the Auto Key button.

When you are in Auto Key on page 7344  mode, you can right-click and drag
the time slider to create a key that has the source at the initial time slider
position, and the destination at the subsequent time slider position.

In Set Key mode on page 7347 , holding down the right mouse button and
dragging the time slider allows you to move a pose in time without losing it
in the viewport.

To move one frame back or forward, click the arrow on the left or right side
of the time slider, respectively. Or simply place your cursor anywhere on the
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time line, click and the time slider will jump to your cursor position. In Key
Mode on page 7358 , clicking an arrow jumps to the adjacent key.

The Track View Key window displays a time slider as well. The movement of
the two time slider is synchronized. Moving the time slider in the Track View
window also moves the time slider below the viewports, and vice-versa.

Procedures

To move to a specific frame in the animation, do one of the following:

1 Drag (scrub) the time slider right or left until the frame number is
displayed on the time slider.

2  Type the frame number into the current
frame field in the time controls, and then press Enter.

To move ahead or back a frame or a key at a time, do one of the following:

By default, Key Mode on page 7358  is off, and these controls move a frame at
a time. To move by keys, click the Key Mode Toggle button; this turns on Key
Mode. When Key Mode is on, the button looks like this:

1 Click the < or > button at either end of the time slider.

2 Press the < or > key on the keyboard.

3  When Key Mode is off, click the Next Frame or Previous Frame
button in the time controls.

4  When Key Mode is on, click the Next Key or Previous Key
button in the time controls.

To move ahead or back many frames at a time:

■ Click in the empty track to either side of the time slider. The time slider
will jump to your cursor position. This is a faster way of moving in time
than dragging the time slider.
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To move to the first or last frame of the active time segment:

■  Use the time control buttons Go To Start or Go To End.

To display SMPTE time code on the time slider:

■  Click Time Configuration in the time controls, and then under Time
Display, choose SMPTE.

To display subframes on the time slider:

■  Click Time Configuration in the time controls, and then under Time
Display choose Frames:TICKS or MM:SS:TICKS.
Each frame is divided into subframes.

To use the time slider to adjust animation, do one of the following:

1 To copy a pose from one frame to another, with Auto Key on or off, and
Set Key off, right-click the time slider and drag to a new location.

The Create Key dialog appears with Source Time set to the frame you
were on when you right-clicked, and Destination Time set to the frame
to which you moved the time slider. Toggle the Position, Rotation, and
Scale check boxes as necessary and then click OK to create a key at the
destination frame for the pose at the source frame.

2 In Set Key mode, if you have posed your character on the wrong frame,
right-click and drag the time slider. The pose is moved in time to the new
time slider position. Click the Set Key button to set the keys.

To scrub the animation with the mouse but without dragging:

1 Go to Customize > Customize User Interface. On the Keyboard panel,
click in the Action list and then press T to jump to the T section. Scroll
down to find Time Slider Capture Toggle and click it.

2 Click the Hotkey field and then press a keyboard combination to assign
as a keyboard shortcut; for instance, Ctrl+T. Click the Assign button.

3 Close the Customize User Interface dialog and then press your hotkey
for Time Slider Capture Toggle.
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4 Move the mouse left and right without pressing any buttons.

The time slider moves in tandem with the mouse.

5 To exit this mode, press the hotkey again or click any mouse button.

Interface

By default, the active time segment is from frame 0 to frame 100. The slider
displays time in frames, SMPTE numbers on page 7933 , or other measurements,
depending on the current setting in the Time Configuration dialog on page
7359 .

The slider bar displays the current frame, followed by a slash (/), followed by
the total frames in the active time segment. For example 25/100 means frame
25 of 100 frames. The current frame also appears in the current frame field.
If animation on page 7711  exists in the scene, it's played back as you drag the
time slider.

The buttons on either side of the time slider bar move one frame to the left
and one frame to the right, like the Previous Frame and Next Frame buttons
in the time controls. If Key Mode  on page 7358  is on, these buttons duplicate
the Previous Key and Next Key buttons.

Key Mode can jump to all the keys or only the transform keys, depending on
the Key steps setting in the Time Configuration dialog.

TIP Right-click the slider bar to open the Create Key dialog. This lets you create
Position, Rotation, or Scale keys without using the Auto Key button. It also lets
you copy keys easily from one frame to another.

Track Bar

The track bar is located below the viewports, between the time slider and the
status bar.

The track bar provides a timeline showing the frame numbers (or appropriate
display units). It provides a quick alternative to Track View for moving,
copying, and deleting keys, and changing key properties. Select an object to
view its animation keys on the track bar. The track bar also displays keys for
multiple selected objects.
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The displayed keys use color coding, so you can easily determine what kind
of key exists at that frame. Position, rotation and scale keys are red, green,
and blue, respectively, and non-transformational keys such as modifier
parameters are gray. You can customize the colors in the Customize User
Interface dialog on page 7489 , and depends on the selected/unselected state of
the key. The frame indicator is a similar bar displayed in blue.

A key on the track bar can represent any number of animated parameters for
the selected objects. Transformations, modifiers, and animated material
parameters can all have keys at a particular frame.

To display a list of all keyed values for a key on the track bar, right-click the
key. Choose a key type from the right-click menu to display its key properties
dialog. Delete keys and filter the track bar display using options on the
right-click menu.

The track bar right-click menu contains a submenu that lists any procedural
controllers (list controllers, expression, reactors, springs, noise, and so on)
assigned to the current object selection. If you select one of the controllers
from the submenu, the properties dialog for that controller displays in a
modeless dialog.

The track bar can display a waveform (.wav file) that has already been assigned
to the sound object in Track View. To display this feature, right-click the track
bar and choose Configure > Show Sound Track. If no waveform is currently
assigned to the sound object or if you are using a third-party sound object
plug-in that is not compatible with the waveform display, this part of the
track bar is unavailable.

You can modify the active time segment on page 7702  by pressing Ctrl and Alt
while dragging the track bar. Hold the left mouse button to slide the start of
the range, the right mouse button to slide the end of the range, and the middle
mouse button to change both the start and end frames together. A tooltip at
the cursor and a status bar message will indicate the range you are setting.

NOTE While the Auto Key button is depressed, the time slider background is
highlighted red, to indicate that 3ds Max is in automatic keyframing mode.
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 You can expand the track bar to show curves. Click the Open Mini-Curve
Editor button at the left end of the track bar. The time slider and track bar are
replaced with the controller and key windows, and Track View toolbars. You
can resize the track bar window by dragging the border between the menu
bar and the toolbars (do this in an empty toolbar area).

Track bar displaying curves

Procedures

To select keys on the track bar:

1 Click a key to select it.

2 Drag a window around a selection of keys to region-select multiple keys.

If the track bar right-click menu > Configure > Show Selection Range
option is on, when you select multiple keys, the range of the selected
keys is shown in the selection range bar at the bottom of the track bar.
You can then scale the selected keys proportionally by dragging either
end of the selection range bar, or move the keys by dragging the center
of the bar.
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To move or clone keys on the track bar:

While keys are moved or cloned, small lines on the track bar mark the original
position of the keys. All keys at a particular frame are moved simultaneously
using the following procedures.

1 Drag a key selection to move it in time.

2 Hold down Shift, then drag a key(s) to clone keys.

3 Right-click to abort a move or clone operation.

To move a single key from a frame with multiple keys:

If, for example, a frame has both a transform key and a material key for the
selected object, and only the transform key must move, display the Transform
Properties dialog and use the Time parameter to move the transform key.

1 Right-click a key on the track bar and choose a key on the pop-up window
key list.

A Key Properties dialog is displayed.

2 Change the Time parameter in the Key Properties dialog.

The key slides along the track bar to a new location.

To delete keys on the track bar:

1 Make a key selection on the track bar and press Delete.

All selected keys are deleted.

2 Make a key selection on the track bar, right-click anywhere on the track
bar to display the track bar menu, and then choose Delete Selected Keys
on the pop-up window.

All selected keys are deleted.

To delete a single key type on a frame with multiple keys:

An object can have many keys for different animated parameters at a particular
frame. Use this procedure to delete a key for a single parameter.

1 Right-click over a selected or unselected key on the track bar.

A pop-up window displays.

2 Move the mouse over Delete Key, then choose a key to delete in the
submenu.
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To change the length of the active time segment:

You can change the animation length using track bar.

■ Hold Ctrl+Alt and drag on the track bar:

■ With the left mouse button to change the active time segment's start frame.

■ With the right mouse button to change the active time segment end frame.

■ With the center mouse button to change the active time segment start and
end frames simultaneously.

To hide or show the track bar:

■ Choose Customize > Show UI > Show Track Bar.
This menu item is a toggle: a check mark shows that the track bar is
currently displayed.

To show curves on the track bar:

■  Click the Open Mini Curve Editor button at the left hand side of the
track bar.
The track bar keys are replaced with a menu bar, toolbars and the controller
and key windows.

Interface

Track Bar

■ Make an object selection in the viewports to display the object’s keys on
the track bar.
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■ Selected transformation keys are white; unselected keys are other colors.

■ Drag from an empty area of the track bar to region-select keys.

■ Drag a key to move it in time.

■ Hold Shift and drag a key to clone it.

■ Hold Ctrl+Alt and drag the track bar to change the active time segment,
that is, the animation range displayed on the track bar.
Dragging with the left mouse button will change the start of the range,
dragging with the right mouse button will change the end of the range,
and dragging with the middle mouse button will change both the start
and the end of the range.

■ Right-click to abort a move or clone operation.

■ During a move or clone operation, short, vertical, gray lines represent the
original key locations.

■ The cursor changes to a cross when over unselected keys.

■ The cursor changes to a two-sided arrow over selected keys, signifying a
move operation is possible.

■ Right-click anywhere on the track bar to display the track bar right-click
menu. Right-click over a key to access its keyed values from the right-click
menu, as well as other track bar-related commands.

■  Click the Open Mini Curve Editor button to expand the track bar.
When the track bar is expanded it displays the Track View menu, toolbars,
controller and key windows. You can hide or unhide UI Elements such as
scroll bars as well when this is expanded.

Track bar menu

Right-click a key on the track bar to display the track bar menu.
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List Displays the object name and key type for all keys at the current position.
Choose any of the keys in the list at the top of the track bar menu to display
a key properties dialog. For more information on this dialog, see Key Info
(Basic) on page 3052  and Key Info (Advanced) on page 3056 .

■ A key with a check next to the name indicates the key is shared with other
instances in the list. Two selected objects might share the same Twist
modifier, for example.

■ The list displays keys for all selected objects. If there are more than 10 keys,
then the list turns to a submenu under Key Properties in the track bar
menu.

■ If there is no key properties dialog for a key type, the key is unavailable.

Controller Properties Displays a submenu that contains a list of all of the
procedural controllers (list controllers, expression controllers, reactors, springs,
noise, and so on) assigned to the object selection.

If you choose one of the controllers from the submenu, the properties dialog
for that controller displays in a modeless dialog.

Delete Key Displays a submenu identical to the key properties list at the top
of the track bar menu. Choose a key type or choose All to delete one or all of
the keys.

All Deletes all keys at the current position.
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Keys do not need to be selected on the track bar in order to use Delete Key.
Keys are deleted from the track bar key over which you right-clicked.

Delete selected keys Deletes the keys selected on the track bar. If no keys
are selected, this option is unavailable.

Filter

Filter Displays a Filter submenu. Choose a filter to filter the track bar display;
showing only transformation keys, for example.

Right-click anywhere on the track bar, place the cursor over Filter in the track
bar menu to display the Filter submenu, then choose filter settings. The settings
determine which keys appear on the track bar.

The upper section of the Filter submenu lets you choose one of the following:

■ All Keys Displays all keys.

■ All Transform Keys Displays only keys for position, rotation and scale.

■ Current Transform Displays only keys that use the currently selected
transform: position, rotation or scale.

■ Object Displays object modifier keys. Excludes transformation and
material keys.

■ Material Displays material keys for the material assigned to the selected
objects.

The lower section of the Filter submenu lets you toggle each of the following,
for any combination of these filter options:

Keyable Tracks Only Controls the display of keyable tracks on the track bar.

Parameter Collector Keys Filters keys related to the Parameter Collector on
page 285 .
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List Controller – Active Only This filter lets you see only the keys on the
active control in a List Controller. Otherwise, you see all the keys on all the
controls.

List Controller – Hide Weights This filter hides the weight parameter keys
of a List Controller from the track bar.

Layer Controller – Active Only This filter lets you see only the keys of the
active Layer controller on page 3089  . Otherwise, you see all the keys of all
Layer controllers.

Layer Controller – Hide Weights This filter hides the weight parameter keys
of a Layer controller on page 3089  from the track bar.

Configure

Configure Displays a submenu that lets you change the track bar display
and behavior.

The Configure options are:

■ Show Frame Numbers Displays frame numbers in the track bar.

■ Show Selection Range Displays a selection range bar below the track bar,
whenever multiple keys are selected.
You can scale all selected keys by dragging either end of the selection range.
This lets you change the length of an animation segment while maintaining
the relative distance between animation keys. You can also move the
selected keys in time by dragging the selection range bar.

■ Show Sound Track Displays the waveform (.wav file) that is assigned to
the sound object in Track View.

■ Snap to Frames Keys snap to frame numbers when moved. If turned off,
you can place keys between frames.

Go to Time Moves the time slider to the cursor position.

Right-click anywhere on the track bar, and then click Go To Time.
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Selection Lock Toggle 

Status bar > Selection Lock Toggle

Keyboard > SPACEBAR

Selection Lock Toggle toggles selection locking on and off. Lock selections so
you don’t inadvertently select something else in a complex scene.

When your selection is locked, you can drag the mouse anywhere on screen
without losing your selection. The cursor displays the current selection icon.
When you want to deselect or alter your selection, click Lock Selection again
to turn off locked selection mode.

When you want to select something and you can’t, it's frequently because
you have locked your selection.

This button is off by default.

 Click to turn it on (it turns yellow). When Lock Selection is on, you can
click anywhere in a viewport and the program interprets it as clicking the
selected object(s). This is useful when you want to keep objects selected while
you make a different viewport active or when the selection is tiny, or crowded
and difficult to select.

Procedures

To transform an object without touching it:

1 Use the Selection Floater from the Tools menu, the Select By Name button
on the main  toolbar or press the H key to select the object by name.

2 Click the transform button  (move, rotate, or scale) from the main toolbar
.

3  On the status bar, turn on the Selection Lock toggle or press the
Spacebar to lock the selection set.

4 Press and drag anywhere in the viewport.

The object transforms even though you are not touching it.
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To avoid accidentally canceling a selection:

1 Make your object selection.

2 Click the Selection Lock toggle on the status line, or press Spacebar to
turn on Locked Selection mode.

To exit sub-object selection mode, do one of the following:

1 In the Modifier Stack display, choose the object level.

2 Open another command panel. This turns off Sub-Object selection.

If you've turned off Sub-Object selection and object selection is still not
restored, one of the following may be true:

3 Your selection is locked. Turn off the Selection Lock toggle on the status
line.

4 You've set the Selection Filter in the toolbar to a specific category of
object, so you can't select any of the other categories. To fix this, choose
All in the Selection Filter list.

Coordinate Display

Status bar > Coordinate Display area

The Coordinate Display area shows the position of the cursor or the status of
a transform, and allows entry of new transform values.

The information in these fields varies, depending on what you are doing:

■ When you are simply moving the mouse in a viewport, these fields show
the current cursor location in absolute world coordinates on page 7975 .

■ While you are creating an object, these fields also show the current cursor
location in absolute world coordinates.

■ While you are transforming an object by dragging in a viewport, these
fields always show coordinates relative to the object's coordinates before
the transformation was started.
While you are transforming an object, these fields change to spinners on
page 41 , and you can type values directly in them, as described below in
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“Using the Coordinate Display for Transform Type-In.” This is an easy
alternative to using the Transform Type-In dialog on page 874 .

■ While a transform button is active and a single object is selected, but you
are not dragging the object, these fields show the absolute coordinates for
the current transform. See “Interface,” below.

■ While a transform button is active and multiple objects are selected, these
fields are blank.

■ When no object is selected and the cursor is not over the active viewport,
these fields are blank.

See also:

■ Units Setup Dialog on page 7601

Procedures

To display the position of the mouse in feet or metric units:

1 Choose Customize > Units Setup.

2 Turn on one of the main categories (Metric, US Standard, Custom, or
Generic Units) and choose from the drop-down list.

The coordinate display is now in labeled units.

Example: To move the position of an object to the center of the world:

1 Select an object in the viewport.

2 Right-click and choose Move from the quad menu

3 Select the value in the x coordinate field, then enter 0. Press Tab.

4 Type 0 in the Y coordinate field, and press Tab.

5 Type 0 in the Z coordinate field.

TIP Right-clicking the spinner arrows for a coordinate sets the value to zero.

Interface
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When you are transforming an object, you can type coordinates directly in
the Coordinate Display fields. You can do this in two modes, Absolute or
Offset.

■  Absolute sets the exact coordinates of the object in world space.

■  Offset transforms the object relative to its existing coordinates.

Click the Absolute or Offset button to toggle between the modes:

While you are typing in the Coordinate Display fields (X,Y,Z), you can use
the Tab key to move from one coordinate field to another.

When you transform an object, the information shown by these fields depends
on the type of transform:

■ Move displays the offset XYZ coordinates based on the current coordinate
system. For example, if you're moving an object and you're constrained to
the X axis, only the X readout will change, displaying the offset of the
move along the local X axis.

■ Rotate displays the offset angle in degrees about the axis or axes the
rotation is performed around. This is dependent on both the axis coordinate
system, and the local/center toggle button.

■ Scale displays the offset XYZ scale in percentages.

You can get the absolute as well as offset information through the Transform
Type-In dialog on page 874  available from the Tools menu or by right-clicking
a transform button that has been selected on the toolbar.

Grid Setting Display

Status bar > Grid Setting Display

The grid setting display shows the size of one grid square.

This value is constant in the active viewport. It does not change if you zoom
in very close or zoom out very far.
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Procedures

To change the size of one grid square:

1 Right-click the Snap Toggle on the main toolbar to display the Grid and
Snap Settings dialog. Alternately, you can choose Customize menu > Grid
and Snap Settings.

2 On the Home Grid tab, in the Grid Dimensions group, change the Grid
Spacing value.

The new value is displayed in the grid setting display.

3 Close the dialog by clicking the X at the upper right corner of the Grid
and Snap Setting dialog.

Time Tag

Status bar > Add Time Tag

Time tags are text labels that you can assign to any point in time in your
animation.

They let you easily jump to any point in your animation by selecting its tag
name. The tags can be locked to be relative to other time tags so that the
movement of one time tag will update the time position of another.

The time tags are not attached to keyframes. They are simply a way to name
events that occur in your animation and navigate to them. If you move your
keyframes, you will need to update your time tags accordingly.

Interface

Left-click or right-click the Time Tag box to display a menu with the following
items:

Add Tag Displays the Add Time Tag dialog on page 7329  that lets you define
a tag name for the current location in time.

Edit Tag Displays the Edit Time Tag dialog on page 7331  that lets you rename,
delete, or edit any defined tag.

The remainder of the menu displays frame numbers and their tag names.
Choose a tag name to jump to the spot in time defined by the tag.
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Add Time Tag Dialog 

Status bar > Click in the Time Tag box. > Add Tag

Use the Add Time Tag dialog to define a time tag on page 7328  for the current
spot in time.

Procedures

To use time tags:

1 Move to the spot in time where you want to add a tag.

2 Click in the Time Tag box, and choose Add Tag from the menu.

3 In the Add Time Tag dialog, enter the name of the tag. Choose whether
to lock it to time and whether to make it relative to another tag, and click
OK.

The name of the tag appears in the tag slot, and will reappear whenever
you go to that spot in time.

To jump to a defined tag, click the Time Tag slot and choose the tag name
from the list.

To rename, delete, or change the properties of a tag, click the Time Tag
field and choose Edit Tag on page 7331 .
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Interface

Tag Time Displays the current frame, to which the tag will be assigned.

Tag Name Enter the name of the tag. You can create a long tag name in this
field, but the tag slot will display only 15 characters.

Lock Time Locks the tag to the current frame, regardless of subsequent scaling
of time.

For example, with Lock Time off, if you have a tag named "Forty" at frame 40,
and you scale time up 200 percent, the Forty tag will be at frame 80. If Lock
Time is on, the Forty tag remains at frame 40.

Relative To Lets you assign another tag to which the current tag will maintain
a relative offset.

For example, if you have a tag at frame 10 called First and you create a second
tag at frame 30 called Second, if you move the position of First to frame 25,
Second will move to frame 45 to maintain the 20-frame offset between the
two tags.

This is a one-way offset. If you change the time position of the second tag in
the example, the first tag is not affected. Circular dependencies are not allowed:
you can't have First relative to Second and Second relative to First.
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Edit Time Tag Dialog 

Status bar > Click in the Time Tag box > Edit Tag

Use the Edit Time Tag dialog to alter the properties of any of the defined time
tags on page 7328 .

Procedures

To edit a time tag:

1 Click in the Time Tag box and choose Edit Tag from the menu.

2 Choose the time tag you want to edit from the list.

3 Use controls in the Edit Time Tag dialog to rename it, or move it in time
relative to another time tag.
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Interface

All of the current tags, along with their associated frame numbers, appear in
the window at the top of the Edit Time dialog. Select the tag to edit, then
adjust the controls below the window.

Tag Name Use this field to rename the selected tag. You can create a long
tag name in this field, but the tag slot will display only 15 characters.

Time Lets you change the time where the tag is assigned.

Lock Time Locks the tag to the current frame, regardless of subsequent scaling
of time. For example, with Lock Time off, if you have a tag named Forty at
frame 40, and you scale time up 200 percent, the Forty tag will be at frame
80. If Lock Time is on, the Forty tag remains at frame 40.
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Relative To Lets you assign another tag to which the current tag will maintain
a relative offset. For example, if you have a tag at frame 10 called First and
you create a second tag at frame 30 called Second, if you move the position
of First to frame 25, Second will be moved to frame 45 to maintain the 20-frame
offset between the two tags.

This is a one-way offset. If you changed the time position of the second tag
in the previous example, the first tag is not affected. In addition, circular
dependencies are not allowed. You can't have First relative to Second and
Second relative to First.

Delete Tag Deletes the selected tag.

Communication Center 

Communication Center is an in-product notification system that keeps you
up-to-date on service pack availability and provides information for Autodesk®

Subscription Program members. Communication Center can supply you with
extension availability, product tips and tricks, and product support
information.

You have the option to have important information notices arrive
automatically at specified intervals or you can check for updates on demand.

When new updates are available, the Communication Center icon displays
with a yellow exclamation mark and a bubble alert will display unless you
have the option turned off. When you click the icon, the Communication
Center is displayed, allowing you to download the latest updates.
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See also:

■ Using Communication Center on page 7335

■ Configuring Communication Center  on page 7336

■ Refreshing the Content on page 7341

■ Receive New Information Notifications  on page 7342

7334 | Chapter 23   User Interface



Using Communication Center

Status bar > Communication Center

Communication Center provides the following types of announcements
regarding 3ds Max.

■ General Product Information Stay informed about Autodesk company
news and product announcements; give your feedback directly to Autodesk.

■ Product Support Information Get breaking news from the Product Support
team at Autodesk.

■ Subscription Information and Extension Announcements Receive
announcements and subscription program news if you are an Autodesk
subscription member (available in countries/regions where Autodesk
subscriptions are offered).

■ Articles and Tips Be notified when new articles and tips are available on
Autodesk Web sites.

■ Product update availability Be notified when updates to 3ds Max are
available.

Welcome Wizard

When you begin using Communication Center, you can use the Welcome
wizard to set your country/region, how often you want to check for updates
and the information channels you want displayed.

To configure Communication Center, refer to Configuring Communication
Center  on page 7336

Communication Center Online Privacy

Communication Center is an interactive feature that must be connected to
the Internet to deliver content and information. Each time Communication
Center is connected, it sends information to Autodesk so that the correct
information can be returned. All information is sent anonymously to maintain
your privacy.

The following information is sent to Autodesk:

■ Product Name The name of the product in which you are using
Communication Center
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■ Product Release Number The version of the product.

■ Product Language The language version of your product.

■ Country/Region The country/region that was specified in the
Communication Center settings.

■ Your Subscription Contract Number The information sent to Autodesk
if you entered it in the Error Report dialog box.

Autodesk compiles statistics using the information sent from Communications
Center to monitor how it is being used and how it can be improved. Autodesk
will maintain information provided by or collected from you in accordance
with Autodesk’s published privacy policy, which is available online
http://www.autodesk.com/privacyat this location .

Configuring Communication Center 

Status bar > Click the Communication Center button. > Settings

After starting 3ds Max, you can configure Communication Center from the
Welcome wizard to specify the information you want to receive and how often
a check is made to see if new information is available.
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Communication Center Welcome Wizard

Procedures

To configure Communication Center the first time:

1  Click the Communication Center button located on the status bar.

2 On the Communication Center Welcome dialog, click the link to specify
your country and preferred update frequency or click the Settings button.

The Configuration Settings dialog is displayed showing the Settings panel.

3 Use the Configuration Settings dialog to specify your country, how often
to check for updates, and whether you want to use bubble notification.
Click OK.
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The Welcome dialog re-displays showing a check mark in the first
configuration step.

4 Click the second link to connect to the Internet and download any
available information.

You'll see a Communication Center Status dialog showing your download
progress. Once the latest updates and announcements are downloaded,
you're returned to the Welcome dialog.

5 Click the last link to open the Channels panel of the Configuration
Settings dialog where you can specify which information channels you
wish to view. Once the channels are set, click OK.

The Communication Center dialog now shows the channels you've
selected.

At any time after your initial configuration of the Communication Center,
you can customize your options by clicking the Settings button again or by
right-clicking the Communication Center icon.

Interface

The Configuration Settings dialog has two panels: Settings and Channels.
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Settings panel

Country Lets you specify your country so Communication Center can provide
information for your location.

Check For New Content Lets you specify how often Communication Center
should synchronize with the servers at Autodesk, Inc.

To have the software check for content automatically at regular intervals,
choose Daily, Weekly, or Monthly. If you prefer to check manually for new
information, choose On Demand.
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Bubble Notification When on, update notices display as bubble messages
above the status bar when a new announcement is received.

Channels panel

Channels Choose the type of information Communication Center should
download.
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Refreshing the Content

Status bar > Click the Communication Center button. > Refresh Content

The Communication Center will automatically check for updated information
at the intervals you specified when you configured the settings. If you chose
Daily, Weekly or Monthly, the content is checked automatically. If you chose
On Demand, content is checked only when you click the Refresh Content
button.

To check for new content:

1  Click the Communication Center button located on the status bar.

Note the Last Updated information at the bottom.

2 On the Communication Center dialog, click the Refresh Content button.

You'll see a Communication Center Status dialog showing your download
progress. Once any latest updates and announcements are downloaded,
you're returned to the Communication Center dialog and you can see
that the Last Updated status is changed.
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Receive New Information Notifications 

Whenever new information is available, Communication Center notifies you
by displaying a bubble message above the status bar. If you have bubble
notification turned off, the Communication Center button also changes to
show that new information is available.

Click the link on the bubble message to open the Communication Center
dialog or if you've closed the bubble message, you can click the
Communication Center button.

If you prefer not to be notified by the Communication Center icon, you can
turn off Enable Bubble Notification on the Configuration Settings dialog.

See also:

■ Configuring Communication Center  on page 7336

Animation and Time Controls
Between the status bar and the viewport navigation controls are the animation
controls, along with the time controls for animation playback within viewports.
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Animation Controls

 on page 7344  and Set Key Animation Mode on page
7347

Default In/Out Tangents For New Keys on page 7351

Go To Start  on page 7354

Previous Frame/Key  on page 7355

Play/Stop  on page 7355

Next Frame/Key  on page 7357

Go To End  on page 7357

Current Frame (Go To Frame)  on page 7358

Time Controls

Key Mode  on page 7358

Time Configuration  on page 7359
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Auto Key Animation Mode

Status bar > Time controls > Auto Key (Toggle Auto Key Mode)

Keyboard > N

The Auto Key button turns the keyframing mode on page 7824  called Auto Key
on or off. All movement, rotation, and scale changes are keyframed while the
Auto key button is on. When it's off, these changes are applied to frame 0.

You can also keyframe by using Set Key mode on page 7347 , which allows you
to selectively add keyframes using the Set Keys button.

The Auto Key button is red when it’s on. The active viewport is also outlined
in red when the Auto Key mode is on; the time slider turns red as well. This
serves to remind you that you are in Animate mode, and that you are setting
keyframes with your actions.

WARNING Be sure to turn off Auto Key after keyframing, or you will inadvertently
create unwanted animation. Use Undo to remove the unwanted animation. Be
careful; it’s easy to forget.

Within an existing animation, you can create keyframes for transforms without
the use of the Auto Key button by right-clicking the time slider and then
setting the source and destination time. For example, you can use this function
to copy an existing Move key to a later frame, so an object pauses its motion
momentarily (to keep the object still, you must use linear or step interpolation).
You can also set keyframes for other animatable parameters in Track View and
the Motion panel without using Auto Key.

See also:

■ Using Auto Key Mode   on page 3007

■ Set Key Animation on page 7347

■ Using Set Key Mode  on page 3010
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Procedures

To animate an object using Auto Key:

1  Turn on the  Auto Key button.

The Auto Key button, the time slider, and the highlight border around
the active viewport all turn red.

2 Drag the time slider to a time other than 0.

3 Do one of the following:

■ Move, scale, or rotate an object.

■ Change an animatable parameter.

For example, assume you start with a cylinder that has not been animated
yet and therefore has no keys. You then turn on the Auto Key button,
and on frame 20 you rotate the cylinder 90 degrees about its Y axis. This
action creates Rotation keys at frames 0 and 20. The key at frame 0 stores
the original orientation of the cylinder, while the key at frame 20 stores
the animated rotation of 90 degrees. When you play the animation in
the viewport, the cylinder rotates 90 degrees about its Y axis over 20
frames.

4  Turn off the Auto Key button when you are done.

Example: To animate an object between three points using Auto Key:

1  Turn on the Auto Key button.

2 Drag the time slider (to frame 25, for example).

3 Move the object from point A to point B.

A Move key is created at frames 0 and 25. The establishing key at frame
0 describes the object's position at point A. The key at frame 25 describes
the object's position at point B.

4 Drag the time slider (to frame 50, for example).

5 Move the object from point B to point C.

A Move key is created at frame 50 that describes the object's position at
point C.
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6  Click the Playback button.

The object moves from point A to point B over frames 0 to 25, then
proceeds to point C over frames 26 to 50.

7  The Playback button turns into a Stop button. Click it to stop
playback.

The position of the object in between the keyframes is determined by
the interpolation type used by the controller. Right-click the keys in the
track bar and select the transform key to see the controls for adjusting
the timing of the in-betweens.

8  Turn off the Auto Key button.

To remove the animation from a scene and start again:

1 Choose File menu > New.

If the scene has been modified, you are asked if you want to save it. After
you make that decision, a New Scene dialog is displayed.

2 In the New Scene dialog, turn on Keep Objects And Hierarchy and click
OK.

All the objects remain in the scene but all keyframes have been removed.

3 To remove the animation from just certain objects, delete their keys in
Track View.

Example: To animate a deformation curve of a loft object:

1  Turn on the Auto Key button.

2 Set a current frame with the time slider.

3 Select one or more control points in the deformation curve of a loft object.

4 Use the Move Control Point or Scale Control Point buttons to transform
the control points.
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To animate a hierarchy with IK interactively:

1 Select any hierarchy that does not already have an IK Solver applied.

2 Click IK on the Hierarchy panel.

3  Turn on the Auto Key button.

4 On the Inverse Kinematics rollout, turn on Interactive IK.

5 Select and move objects in the IK structure on different frames.

NOTE This will work on linked hierarchies and bones that do not already
have an HI, HD, or Limb Solver applied. This technique allows you to animate
hierarchies using IK methods on page 3299  without applying any IK solver
on page 3307 .

Set Key Animation Mode

Set Key Animation Mode allows you to create keys for selected objects
individual tracks using a combination of the Set Keys button and Key Filters.
Unlike the traditional method of 3ds Max animation, Set Key mode gives you
control over what you key and when. It allows you to pose a character (or
transform any object)  and then if you like it, use that pose  to create keys. If
you move to another point in time without keying, your pose  is discarded.
It also works with object parameters.

You can try out different values and then when you have what you like use
it to create keys. Combine this with keyable tracks in the Curve Editor to create
keys on just the object parameters you want to key.

Set Key Workflow

To animate something using Set Key mode, you first turn on Set Key Mode.
You can then select the object you want to animate and use the Key Filters
button to set which tracks you want to keyframe. You can also use Show
Keyable icons in Track View edit windows to make individual tracks keyable
or not. With all this setup work completed you can create keys by clicking the
Set Key button (the large button with the key) or using Keyboard shortcut (K).
Move ahead in time, then make changes to your character  (transforms or
parameter changes) and click Set Keys to use those changes to create keys.
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If you do not click the Set Keys button and move to another frame the object
changes will be lost, as if you had never made them. This is fundamentally
different behavior from Auto Key mode, where you would need to use undo
to lose the changes you made. Use the right mouse button on the time slider
to drag a pose  to a different point in time.

For faster workflow you can define keyboard shortcuts for the Key Filters and
Show Keyable tools by going to Customize menu > Customize User Interface
and assigning keystroke combinations in the Main UI group.

Procedures

To animate using Set Key mode:

1  Turn on Set Key mode.

2 Select the objects you want to keyframe, and then right-click and choose
Curve Editor.

3  On the Track View toolbar, click Show Keyable Icons, then use the
keyable icons in the controller window to define which tracks will be
keyed.

 A red key means the track will be keyed. Click a key to toggle keyable
status.

4  Click Key Filters and then turn on the tracks you want
to keyframe. By default, Position Rotation, Scale, and IK Parameters are
on. For this example, turn off Rotation and Scale.

5 Go to a frame at which you want to set a key.

6 Move an object.

7  Click the Set Keys button.

 The Set Key button flashes red to show that it has set a key, and a
key appears on the track bar.

Repeat this process, moving the time slider and setting keys.
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To keyframe all parameters using Set Key mode:

1  Turn on Set Key mode.

2 In the viewport, select the objects to which you want to add keyframes.

3  Click Key Filters and then turn on the Key All.

4 Move the time slider to the frame where you wish to set keys

5  Click the Set Keys button.

Keys will be added to all keyable parameters.

To move a pose in time without update:

1 Turn on Set Key.

2 Move to a particular frame (let's say frame 20).

3 Pose your character .

4 Move your cursor over the time slider, then press the right mouse button
down and drag.

The time slider moves, but the pose does not jump . The pose  is
maintained and transferred to the new point in time.

5 When you are at the appropriate frame, set the pose keys by clicking Set
Keys.

Interface

 Set Key Turns on Set Key Mode.

 Set Keys Click this to set a key. This button will create a key on tracks
for the selection set. It checks that the tracks are keyable, and that Key filters
allow the tracks to be keyed. If both these are satisfied, a key is set. Set Keys
also sets keys in Auto Key mode, and in Layout mode (the mode when neither
Auto Key nor Set Key is turned on). Keyboard shortcut default for this
command is K.
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 Key Filters Displays the Set Key Filters dialog where you
can define which type of tracks will be allowed or disallowed keys.

Selection List Gives quick access to named selection sets on page 179  and
track sets on page 3594  while working with Set Key. Lets you easily swap among
different selection sets and track sets.

NOTE Choosing a selection set from the list does not select objects in the
viewports. To accomplish this, use the Named Selection Sets on page 179  feature.

NOTE Selection set names appear between braces (example: {Biped Arms}) while
track set names appear between square brackets (example: [Throw Baseball]).

Set Key Filters dialog Turn on the tracks you want to key. Default=Position,
Rotation, Scale and IK Parameters.

The following options are available:

■ All  allows for a quick way to key all tracks. When All is turned on, the
other toggles are unavailable. Clicking Set Keys with the All filter turned
on will result in a key placed on all keyable tracks.

■ Position  allows for position keys to be created.
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■ Rotation  allows for rotation keys to be created.

■ Scale  allows scale keys to be created.

■ IK Parameters  allows inverse kinematic parameters to be keyframed.

■ Object Parameters  allows object parameters to be keyframed.

■ Custom Attributes  allows custom attributes to be keyframed.

■ Modifiers  allows modifiers to be keyframed. Note that you should turn
on Object parameters when you turn on modifiers, so you can keyframe
gizmos.

■ Materials  allows material properties to be keyframed.

■ Other allows for other parameters that don't fall in the above categories
to be keyframed using the Set Key technique. This includes such things as
helper properties and look-at controller tracks for target cameras and lights.

WARNING If you turn on Object Parameters, all the object parameters of an object
will then receive keys, unless you have turned off the tracks using Keyable on the
Controller menu of Track View – Curve Editor. The same advice applies to Materials.

TIP You can also set keys on spinners by holding down the Shift key and
right-clicking a spinner.

Default In/Out Tangents For New Keys

Status bar > Animation controls > Default In/Out Tangents For New Keys
flyout
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This flyout provides a quick way to set a default tangent type on page 3054  for
new animation keys created with Set Key Mode on page 7347  or Auto Key
Mode on page 7344 . You can also access the tangent types on page 3054  from
the Key Info (Basic) rollout on page 3052  and the Curve Editor's Key Tangency
toolbar on page 3495 .

NOTE Changing tangent types does not affect existing keyframes, only new ones.

On each new set keyframe, the Key Tangent flyouts on the Key Info (Basic)
rollout updates with the current default tangent type.

When you set a default tangent type, both the in and out tangents are set to
match that type. If you set different in and out tangents via the Controller
Defaults group of the Animation Preferences panel on page 7564 , the current
flyout icon changes to a question mark.

NOTE Setting a default tangent type stores it in the 3dsmax.ini on page 51
file, from which it is restored after a scene reset or session change.

See also:

■ Specifying Default Controllers on page 3034

Procedures

Example: To set a default tangent type:

1 Create a sphere.

2  Turn on Auto Key, go to frame 10, and move the sphere on
all three axes.

3 Right-click the sphere. From the quad menu, choose Curve Editor.
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The position curve with Flat
tangent.

4 Choose the Linear tangent type (second icon from the top) from the
Default In/Out Tangents For New Keys flyout.

5 Go to frame 20 and move the sphere elsewhere in your scene.

The curve starts curvy at frame 10 but straightens out near frame 20. Its
interpolation transitions from an Flat out tangent to a Linear in tangent.

Default In/Out Tangents For New Keys | 7353



The position curve going from Flat to Linear tangents

6 Go to frame 30 and move the sphere again.

The curve interpolation from frame 20 to 30 is straight because both keys
have tangents set to Linear.

The position curve going from Flat to Linear to Linear tangents

Go To Start 

Status bar > Time controls > Go To Start

Keyboard > HOME
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Go To Start moves the time slider to the first frame of the active time segment
on page 7702 . The active time segment is set in the Start Time and End Time
fields of the Time Configuration dialog on page 7359 .

Previous Frame/Key 

Status bar > Time controls > Previous Frame

Keyboard > , (comma)

Previous Frame moves the time slider on page 7312  back one frame.

 If Key Mode on page 7358  is on, the time slider moves to the previous
keyframe on page 7824 . Keyframe options are set in the Key Steps group of the
Time Configuration dialog on page 7359 .

If Time Configuration dialog > Use TrackBar is on, Previous Key jumps to the
previous key of any kind. If Use TrackBar is off, Previous Key jumps to the
previous transform key, ignoring any other type of keys.

Play/Stop 

Status bar > Time controls > Play

Status bar > Time controls > Stop

Keyboard > /(to play); Esc (to stop)

The Play button plays the animation in the active viewport. If you click another
viewport to make it active, the animation continues playing in that viewport.
When the animation is playing, the Play button becomes a Stop button. The
Play button is a flyout for playing only the animation of selected objects.

TIP You can play the animation in all the viewports simultaneously by turning
off Active Viewport Only in the Time Configuration dialog on page 7359 .

Procedures

To play the animation in the viewport:

1 Activate the viewport where you want to play the animation.
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2  Click the Play button.

The animation plays in the viewport. The Play button becomes a Stop
button.

3  Click Stop to end the playback.

The speed of the animation playback is determined by the settings in the
Time Configuration dialog, the complexity of the scene and the speed
of the graphics card and processor.

To play the animation looped backward:

1  Click the Time Configuration button on the status bar.

2 In Time Configuration dialog > Playback group, turn off Real Time.

The Direction buttons are now available.

3 Turn on Reverse and click OK.

4  Click the Play button.

The animation plays backward.

5 To play the animation front-to-back and then back-to-front in a
continuous loop, turn on Ping-Pong as the Direction.

To play the animation of a selected object only:

1 In a viewport, select a single animated object or a set of animated objects.

2  Click Play Selected on the Play/Stop flyout.

Only the selection is animated in the viewport.

3 To end playback, click the Stop button or press Esc.

Interface

The Play/Stop flyout contains two buttons. Both buttons become a Stop button
when in use.
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Play Plays the animation in the currently active viewport.

Play Selected Plays the animation for selected objects only in the
currently active viewport.

Stop Animation Replaces the Play button when an animation is
playing. Click to stop the playback.

Stop Animation (Selected) Replaces the Play Selected button when
an animation is playing. Click to stop the playback.

Next Frame/Key 

Status bar > Time controls > Next Frame

Keyboard > . (period)

Next Frame moves the time slider on page 7312  ahead one frame.

 If Key Mode on page 7358  is on, the time slider moves to the next
keyframe on page 7824 . Keyframe options are set in the Key Steps group of the
Time Configuration dialog on page 7359 .

If Time Configuration dialog > Use TrackBar is on, Next Key jumps to the next
key of any kind. If Use TrackBar is off, Next Key jumps to the next transform
key, ignoring any other type of keys.

Go To End 

Status bar > Time controls > Go To End

Keyboard > END

Go To End moves the time slider on page 7312  to the last frame of the active
time segment on page 7702 . The active time segment is set in the Start Time
and End Time fields of the Time Configuration dialog on page 7359 .
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Current Frame (Go To Frame) 

Status bar > Time controls > Current Frame (and Go To Frame)

Current Frame displays the current frame number, indicating the position of
the time slider on page 7312 . You can also enter a frame number in this field
to go to that frame.

Procedures

To move to a particular frame, do one of the following:

1 To go to the specified frame, type the frame number and press Enter.

2 Move the time slider and observe the frame number updating on the
time slider.

3 To change the value in the frame number field, click or drag the spinner.

Key Mode 

Status bar > Time controls > Key Mode

Key Mode lets you jump directly between keyframes on page 7824  in your
animation. By default, Key Mode uses the keys visible in the track bar below
the time slider. Other options are available on the Time Configuration dialog
on page 7359  in the Key Steps group.

When the Auto Key button on and you change an object’s creation parameters
or performed a transform on page 7958 , or change a material or modifier applied
to that object, the software automatically creates a keyframe.

Key Mode can respect all keyframes, or you can restrict it to move only to
transform keys via the Key Steps options on the Time Configuration dialog.
When Key Steps > Use TrackBar is on, Key Mode jumps to keyframes of any
type. When Use TrackBar is off, Key Mode respects only transform keys.
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Procedures

To use Key Mode:

1  Turn on Key Mode.

 The button turns blue when key mode is active.

2  Use the Previous Key on page 7355  and Next Key on page 7357
buttons to move from one keyframe to the next.

If you are not jumping to the keys, be sure the object is selected in the
viewport.

If you are still not jumping to the keys, configure Key Mode to Use
TrackBar, as described in the following procedure.

To configure Key Mode:

1  Click Time Configuration, or right-click any animation-control
button, including Key Mode.

The Time Configuration dialog opens.

2 Choose options in the Key Steps group.

If you turn on Use TrackBar and turn Key Mode on, then clicking Next
Key advances to the next key for the selected object. This will respect
every type of key that appears in the track bar. If you turn Use TrackBar
off, only transform keys are used by key mode.

Time Configuration 

Status bar > Time controls > Time Configuration > Time Configuration dialog

The Time Configuration dialog provides settings for frame rate, time display,
playback, and animation on page 7711 . You use this dialog to change the length
of your animation, or stretch or rescale it. You also use it to set the start and
end frames of the active time segment on page 7702  and your animation.
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See also:

■ Setting Time Segments on page 3021

Procedures

To define the active time segment:

1  Click Time Configuration.

2 In the Time Configuration dialog > Animation group, set Start Time to
specify the beginning of your active time segment.

3 Do one of the following:

■ Set End Time to specify the end of your active time segment.

■ Set Length to specify the amount of time in the active time segment
and automatically set the correct End Time.
You can enter positive or negative values in any spinner, but you must
use the same format used by the time display.

You can change the active time segment without affecting the keys
you've created. For example, if you have keys scattered over a range
of 1000 frames, you can narrow your active time segment to work on
only frames 150 to 300. You can only work on the 150 frames in the
active segment, but the remainder of the animation stays intact.
Returning the active segment from 0 to 1000 restores access and
playback of all the keys.

Changing the active time segment has the following effects: it restricts
the range of time you can use with the time slider, and it restricts the
range of time displayed when using the animation playback buttons.

The default setting for the active time segment runs from frames 0 to
100, but you can set it to any range.

To stretch out your existing animation over a longer time:

1 In the Time Configuration dialog > Animation group, click Re-scale Time.

2 Change the value in Length to be the number of frames you want the
action to fill.

3 Click OK.

The animation is rescaled to the new number of frames.
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This also works to compress animations into a shorter space of time. To
avoid losing frames during the rescaling, see “To use sub-frame animation”
in this set of procedures.

To add frames onto your existing animation:

This procedure adds new frames to the end of your animation, without
affecting your existing work.

1 In the Time Configuration dialog > Animation group > End Time field,
enter the number of the last frame of the animation.

For example, if your existing animation is 100 frames long and you want
to add 50 frames, enter 150.

2 Click OK.

The number you entered is now the new length of the animation, shown
on the time slider.

To move to an exact time in your animation:

■ In the Time Configuration dialog > Animation group, enter the frame
number in the Current Time field, and press Enter.
The viewport updates to this frame.

To set the frame rate of your animation:

In the Time Configuration dialog > Frame Rate group, do one of the following:

1 Choose one of the standard frame rates such as PAL or NTSC.

2 Choose Custom, and specify a frame rate in the FPS (frames-per-second)
field.

To configure viewport playback:

■ In the Time Configuration > Playback group, turn on or off the Real Time
and Active Viewport Only boxes.

To play your animation in reverse or back and forth:

1 In the Time Configuration > Playback group, turn off the Real Time.

2 Choose the direction of the animation playback by selecting Forward,
Reverse, or Ping-Pong.
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3 Play the animation in the viewport using the Play button or the / key.

To play your animation only once:

1 In the Time Configuration > Playback group, turn off Loop.

2 Choose the direction of the animation playback by selecting Forward,
Reverse or Ping-Pong.

3 Play the animation in the viewport using the Play button or the / key.

The animation will play once and stop.

To play your animation in multiple viewports:

1 In the Time Configuration > Playback group, turn off Active Viewport
Only. Click OK.

2 Play your animation.

The animation now plays in all four viewports.

To use sub-frame animation:

1 In the Time Configuration > Time Display group, turn on FRAME:TICKS
or MM:SS:TICKS. Click OK.

2 Move the time slider to set keyframes in between keys.

TIP Use this when you scale an animation down from a longer length to
insure that you won’t lose any keys. You can then move the keys to frames
and revert to frames without ticks.

To play an animation with sound:

■ In the Time Configuration > Playback group, be sure you have Real Time
turned on. If Real Time is not on, the sound will not play back during the
animation.

Interface

These are the controls for the Time Configuration dialog. You can display this
dialog by right-clicking any of the time control buttons to the right of the
Auto Key button.

7362 | Chapter 23   User Interface



Frame Rate group

These four option buttons, labeled NTSC on page 7863 , Film, PAL on page 7882
, and Custom let you set the frame rate on page 7791  in frames-per-second
(FPS). The first three buttons force the standard FPS for that choice. The Custom
button lets you specify your own FPS by adjusting the spinner.

FPS (Frames Per Second) Sets the frame rate of your animation in Frames
per Second. Use frame rates of 30 fps for video, 24 for film, and lower rates
for web and media animations.
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Time Display group

Specifies the method for displaying time in the time slider and throughout
the program. Choices are Frames or in minutes, seconds and ticks.

Specifies the method for displaying time in the time slider and throughout
the program (in frames, in SMPTE, in frames and ticks on page 7948 , or in
minutes, seconds, and ticks).

For example, if the time slider is at frame 35, and the Frame Rate is set to 30
fps, the time slider would display the following numbers for the different Time
Display settings:

■ Frames: 35

■ SMPTE: 0:1:5

■ FRAME: TICKS: 35:0

■ MM:SS: TICKS: 0:1:800

SMPTE is the Society of Motion Picture Technical Engineers standard used to measure
time for video and television production.

Playback group

Real Time Real Time on page 7908  causes viewport playback to skip frames
to keep up with the current Frame Rate setting. A choice of five playback
speeds is available: 1x is normal speed, 1/2x is half speed, and so on. The speed
settings affect only the playback in the viewports.

These speed settings can also be used with the Motion Capture utility on page
3721 .

When Real Time is off, viewport playback occurs as rapidly as possible and
displays all frames.

Active Viewport Only Causes playback to occur only in the active viewport.
When off, all viewports display animation.

Loop Controls whether the animation playback occurs only once, or
repeatedly. When on, playback repeats until you stop it by clicking an
animation control button or the time slider channel. When off, the animation
plays once and then stops. Clicking Play rewinds to the first frame and plays
again.

Direction Set the animation to play forward, reverse, or ping-pong (forward
and then reverse, repeating). This affects only the playback in the interactive
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renderer. It does not apply when rendering to any image output file. These
options are available only when Real Time is off.

These settings can be recalled by saving to a maxstart.max  file.

Animation group

Start Time/End Time Sets the active time segment on page 7702  displayed in
the time slider. Choose any time segment before or after frame 0. For example,
you can set an active time segment from -50 to 250.

Length Displays the number of frames in the active time segment. If you
make this greater than the total frames in the active segment, the End Time
field increases accordingly.

Frame Count The number of frames that will render. Always the length plus
one.

Current Time Specifies the current frame for the time slider. As you adjust
this, the time slider moves accordingly and the viewport updates.

Re-scale Time Stretches or shrinks the animation for the active time segment
to fit into the new time segment you specify. Relocates the position of all
keys on page 7824  in all tracks. As a result, the animation plays over a greater
or lesser number of frames, making it faster or slower.

Key Steps group

Controls in this group let you configure the method used when you turn on
Key Mode on page 7358 .

Use TrackBar Allows key mode to honor all keys in the track bar. This includes
any parameter animation in addition to transform keys.

To make the following controls available, turn off Use TrackBar.

Selected Objects Only Considers only the transforms on page 7958  of selected
objects when you use Key Steps mode. If you turn this off, the transforms of
all (unhidden) objects in the scene are considered. Default=on.

Use Current Transform Disables Position, Rotation, and Scale and uses the
current transform in Key Mode. For example, if the Rotate button is selected
in the toolbar, you stop at each rotation key. If none of the three transform
buttons are on, Key Mode considers all transforms.

To make the following control available, turn off Use Current Transform.

Position, Rotation, Scale Specifies which transforms are used by Key Mode.
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Clear Use Current Transform to make the Position, Rotation, and Scale check
boxes available.

Viewport Controls
When you start 3ds Max, the main screen contains four equal-sized viewports.
The one in the lower right is a perspective view, and the others correspond
to the three views: top, front, left. By default, the Perspective viewport displays
your scene in Smooth + Highlights on page 7376  mode, and the other three
show wireframe on page 7973  views.

You can choose different views to display in these four viewports as well as
different layouts from the viewport right-click menu on page 7370 .

See also:

■ Viewport Configuration on page 7610

■ Viewport Right-Click Menu on page 7370

Viewport Layouts

You can choose from other layouts different from the default configuration.
To choose a different layout, right-click the viewport label and choose
Configure. Click the Layout tab of the Viewport Configuration dialog to see
and choose the alternative layouts.
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Typical viewport layout

NOTE The viewport layout is saved with your MAX file.

TIP You can change the default viewport layout by saving a maxstart.max  file
with the desired viewport configuration and placing it in the \defaults folder on
page 7486 .

Active Viewport Borders

When four viewports are visible, one viewport, marked with a highlighted
border, is always active. This is where commands and other actions take effect.
Only one viewport at a time can be active. Other viewports are for observation
only; unless disabled, they simultaneously track actions taken in the active
viewport. When Auto Key or Set Key is on, the active viewport border changes
from yellow to red.

In general, a viewport becomes active as you work in it. You can move an
object in one viewport, and then drag the same object in another viewport
to continue the move. To activate a viewport without changing the selection,
right-click it. If you left-click a viewport, the viewport is activated and whatever
you click is selected, or, if you click an empty area, everything is deselected.
You can restore previous selections with Undo.
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Viewport Labels

Viewports are labeled in the upper-left corner. You can control many aspects
of a viewport by right-clicking the viewport label to display the viewport
right-click menu on page 7370 .

Dynamic Resizing of Viewports

You can resize the four viewports so they are of unequal proportions. To do
so, drag the intersection of two, three, or four viewports, on the splitter bars.
To return to the original layout, right-click an intersection of the dividing
lines and choose Reset Layout from the right-click menu.

The new viewport proportions are saved in the scene. However, changing the
viewport layout on page 7617  always resets them.

World-Space Tripod

The three-color world-space tripod is visible in the lower-left corner of each
viewport. The colors correspond to the three axes of world space: red=X,
green=Y, and blue=Z. The axes are labeled in these same colors. The tripod
always refers to world space, regardless of the current reference coordinate
system.

The world-space tripod is on by default. To turn off this feature, see “To turn
off the world-space tripod in all viewports” in the following procedures.

Viewport Tooltips for Object Names

When you’re working with objects in a viewport and pause the cursor over
any unselected object, a tooltip appears with the name of that object. If you
need to select something or link to something, wait until you see the tooltip
to be sure you have selected the object you want. These tooltips are disabled
when you work in sub-object mode.

Tooltips on page 7536  are on by default. To turn off this feature, see To turn
off object name tooltips on page ? , below.
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See also:

■ Viewport Navigation on page 7378

■ The 3ds Max Window on page 35

Procedures

To make a viewport active, do one of the following:

1 Click any viewport.

If you click an object in the viewport, it is selected. If you click a space
where there are no objects, any selected objects are deselected.

2 Right-click any viewport.

Right-click activates a viewport without changing the selection state of
objects. (You can also do this by left-clicking the viewport label.)

To switch between single and multiple viewports:

Activate the viewport you want to minimize or maximize, and do one of the
following:

1 On the keyboard, press the W key.

2 On the keyboard, press Alt+W.

3  Click the Maximize Viewport Toggle button in the lower-right
corner of the 3ds Max window.

To resize the viewports:

1 Drag the intersection of two, three, or four viewports to move the
horizontal and vertical splitter bars.

2 Move the intersection to any new location.

If you don't drag a corner, you can move the borders horizontally or
vertically only.

3 To reset the viewports, right-click an intersection and choose Reset Layout
from the right-click menu.
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To change the number of viewports and their arrangement:

1 Right-click any viewport label. Choose Configure from the right-click
menu.

2 On the Viewport Configuration dialog, click the Layout tab.

3 Choose a layout from the choices at the top of the dialog.

4 Assign what each viewport will display in the lower window of the dialog
by right-clicking a viewport representation and choosing from the
right-click menu.

5 Click OK to make the change.

To turn off the world-space tripod in all viewports:

1 Choose Customize menu > Preferences to display the Preferences dialog.

2 Click the Viewports tab.

3 In the Viewport Parameters group, turn off Display World Axis.

4 Click OK to make the change.

To turn off object-name tooltips:

1 Choose Customize menu > Preferences to display the Preferences dialog.

2 Click the General tab.

3 In the UI Display group, turn off Enable Viewport Tooltips.

4 Click OK to make the change.

Viewport Right-Click Menu

Right-click any viewport label. > Viewport right-click menu

The viewport right-click menu, also referred to as the Viewport Properties
menu, contains commands that let you change what is shown in the active
viewport. This is a shortcut menu. Some of the options are also available on
the Configuration dialog on page 7610 .
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You can do the following from this menu:

■ Change the view to any available viewport type (for example, Perspective,
Top, Bottom, User, Light, Camera, Grid, or Shape).
When your scene contains cameras or lights with targets, the viewport
right-click menu gives you selection options for the components. For
example, when you right-click the label of a target camera viewport, you
see two new commands, Select Camera and Select Camera Target, that let
you select the camera or target used by that view.

■ Set the type of shading displayed in the viewport (for example, Wireframe,
Smooth, or Edged Faces).

■ Set how transparency is displayed in the viewport.

■ Undo or redo a view change.

■ Turn on texture correction if your display is not configured for OpenGL
or Direct3D.

■ Disable a viewport so it doesn’t update when you work in other viewports.

■ Toggle the display of the grids, safe frame, and viewport background.

NOTE A grid object must be active before you can select it from its viewport.

■ Display the Asset Browser, Schematic View or MAXScript Listener in a
viewport.

■ Turn on Viewport Clipping. This interactively sets a near and far range for
the viewport. Geometry within the viewport clipping range is displayed.
Faces outside the range are not displayed.

TIP If the viewport right-click menu becomes disabled, you can restore it by
refreshing the UI scheme. Use Customize menu > Load Custom UI Scheme on
page 7515  to load a different CUI file, then reload the original CUI file again. The
right-click viewport menu will become available after either the new or original
UI scheme is loaded.

Procedures

To toggle display of the home grid in the active viewport, do one of the
following:

1 Choose Views menu > Grids, and click Show Home Grid.
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2 Right-click a viewport label (this activates the viewport and opens a
menu), and then click Show Grid.

3 Press G.

To change a viewport to Camera view:

This procedure requires at least one camera object in your scene. As an
alternative, to create a camera and set it to a viewport at the same time, activate
a Perspective viewport and then press Ctrl+C.

1 Right-click a viewport label.

2 Click Views.

3 Choose one of the cameras in the Views list.

This assigns the camera to the viewport and changes the label to the
camera name.

A camera viewport tracks the view through the perspective of that camera.
As you move the camera (or target) in another viewport, you see the scene
swing accordingly. If you alter the camera's field of view on page 7389 ,
you see the changes as they are applied.

TIP You can also press C as a shortcut to change any active viewport to an
existing camera view.

To change a viewport to a shape view:

This procedure requires at least one shape object in your scene.

1 Right-click a viewport label.

2 Choose Views > Shape from the menu.

To use viewport clipping:

1 Right-click a viewport label.

2 Choose Viewport Clipping on page 7611 .

The viewport displays the viewport clipping controls.

3 Move the lower slider up until the geometry is clipped in the viewport
by the near clipping plane.

4 Adjust the upper slider to clip the geometry with the far clipping plane.
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To display Schematic View in a viewport:

1 Right-click a viewport label to access the Viewport Properties menu.

2 Click Views > Schematic > New, or choose the name of the Schematic
View to display.

To display Track View in a viewport:

1 Right-click a viewport label to access the Viewport Properties menu.

2 Click Views > Track > New, or choose the name of the Schematic View
to display.

To display the Asset Browser or MAXScript Listener in a viewport:

1 Right-click any viewport label to access the Viewport Properties Views
flyout menu.

2 Click Extended > Asset Browser or MAXScript Listener.

The tool is displayed in a dedicated viewport.

To access the Layout panel, do one of the following:

1 Choose Customize menu > Viewport Configuration, then click the Layout
tab.

2 Right-click a viewport label, and choose Configure, then click the Layout
tab.

To turn on safe frame display, do one of the following:

1 Right-click a viewport label, and then choose Show Safe Frame.

2 Press Shift+F.

3 Choose Customize menu > Viewport Configuration > Safe Frames panel,
and turn on Show Safe Frames In Active View.

See Safe Frames on page 7618 .

To fix texture display problems in a viewport:

■ Right-click a viewport label, and then choose Texture Correction. This
applies only to the software display driver; OpenGL and Direct3D displays
automatically correct texture display.
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TIP If you have materials with texture maps that are not displaying in the
viewport, you need to turn on Show Map In Viewport in the Material Editor
for each material that has this problem.

To change quickly between snap options:

1 With nothing selected, hold Shift and right-click anywhere in the
viewport.

The Snaps shortcut menu is displayed.

2 Choose any of the Standard or NURBS snap options. You can also toggle
whether snaps use transform constraints.

Interface

Views Displays a secondary menu that allows you to choose another view
to display in the viewport (Front, Top, Back, etc.).

Available views included are:

■ Camera views on page 7397  (if the scene contains cameras)

■ Light views on page 7407  (if the scene contains spotlights or directional
lights)

■ Perspective on page 7384

■ User

■ Front
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■ Back

■ Top

■ Bottom

■ Left

■ Right

■ ActiveShade on page 5910

■ Track: Choose an existing Track view on page 3426 , if any, from the
submenu, or choose New to create a new one. To change a viewport when
it contains a Track view, right-click the menu bar and choose a different
view.

■ Schematic: Choose an existing Schematic view on page 7193 , if any, from
the submenu, or choose New to create a new one. To change a viewport
when it contains a Schematic view, right-click the menu bar and choose
a different view.

■ Grid on page 2538 : Choose Front, Back, Top, Bottom, Right, Left, or Display
Planes. For details, see Viewing Grid Objects on page 2511 .

■ Extended

■ Asset Browser on page 6928

■ Biped AnimationWorkbench on page 4401

■ Motion Mixer on page 3621

■ MAXScript Listener on page 7469

■ HW Standard Material

■ Shape: Automatically aligns view to the extents of a selected shape and its
local XY axes

The fastest way to change the viewport display is with keyboard shortcuts.
Press V to open the Viewports quad menu at the mouse position. You can
then choose from this menu with the mouse or use the first letter of the
viewport label as the keyboard shortcut (F for Front, for example. The exception
is K for back).
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NOTE This menu appears at the mouse cursor, but it controls the view for the
active viewport, even if the mouse cursor is over a different viewport.

Smooth+Highlights Displays the smoothness and lighting of objects. You
can also display maps on the surface of objects. See Show Standard/Hardware
Map in Viewport  on page 5254 . This happens on a map-by-map basis, but you
can display as many maps as you want simultaneously in the viewport. Maps
only display on objects that have mapping coordinates. Also Show Map In
Viewport must be turned on for each map individually in the Material Editor.

NOTE This and other shaded viewport options support self-illuminated materials
and 32 lights (depending on display mode and graphics card).

Wireframe Displays objects as edges only, as if they were made from wire.
Wire color is determined by object color (default).

Other Displays a cascading menu of other shading modes. These include:

■ Smooth Displays smoothing, but doesn’t show highlights.

■ Facets+Highlights Displays highlights, but doesn’t show smoothing.

■ Facets Shades faces, but doesn’t display smoothing or highlights.

■ Flat Renders each polygon in its raw, unshaded diffuse color, disregarding
any contribution from ambient lighting or light sources. This rendering
method is useful when it's more important to see each polygon than to
see its shading. It's also a good way to check the results of bitmaps created
with Render to Texture on page 6169 .

■ Hidden Line A wireframe mode that hides faces and vertices with normals
on page 7863  pointing away from the viewpoint, as well as any parts of
objects that are obscured by closer objects. In this display mode only, the
wireframe color is determined by the Viewports > Hidden Line Unselected
color, not the object or material color. See Colors Panel on page 7505 .

■ Lit Wireframes Displays edges as wireframe, but shows lighting.

■ Bounding Box Displays objects as a bounding box on page 7736  only.

Edged Faces Available only when the current viewport is in a shaded mode.
Displays the wireframe edges of objects along with the shaded surfaces. This
is helpful for when you want to edit meshes in a shaded display.

Edges are displayed using the object wireframe color, while surfaces use material
colors (if assigned). This lets you create contrasting colors between the shaded
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surfaces and the wireframe edges. You can switch these assignments in the
Display Color rollout on page 117 .

Transparency Sets the quality of transparency display in the selected
viewport:

■ Best Highest quality transparency display; longer redraw time.

■ Simple Less accurate transparency display, however viewport redraw is
considerably faster with Simple.

■ None Transparency is not displayed in the viewport.

NOTE The Transparency setting only affects viewport display, and does not affect
renderings.

Show Grid Turns on and off the display of the home grid. Does not affect
other grid display.

Keyboard > G

Show Background Turns on and off the display of any viewport background
image (or animation). To specify an image, choose Views menu > Viewport
Background.

TIP The keyboard shortcut for the Viewport Background dialog is Alt+B.

Show Safe Frame Turns on and off the display of safe frames on page 7965 .
You define the safe frames in the Viewport Configuration dialog (see Configure,
below). The safe frame proportions conform to the Width and Height of the
output size of your rendering image output.

Show Statistics Turns on and off the  of the entire scene and your current
selection.

Viewport Clipping Interactively sets a near and far range for the viewport.
Geometry within the viewport clipping range is displayed. Faces outside the
range are not displayed. This is useful in complex scenes where you want to
work on details that are obscured from view. Turning on viewport clipping
displays two yellow slider arrows on the edge of the viewport. Adjusting the
lower arrow sets the near range, and the upper arrow sets the far range. Tick
marks indicate the extents of the viewport. Viewport Clipping can also be
turned on and off in the Viewport Configuration dialog on page 7610 .

Texture Correction Redraws the viewport using pixel-interpolation
(perspective corrected).

Viewport Right-Click Menu | 7377



NOTE This is for the software display driver only. If you are using the OpenGL or
Direct3D display mode, texture correction is automatic.

Disable View Disables the active viewport. A disabled viewport behaves like
any other viewport while it is active. However, when you change the scene
in another viewport, the view in the disabled viewport does not change until
you activate it. Use this function to speed up screen redraws when you are
working on complex geometry.

Keyboard > D

Undo Undoes the last viewport change.

Redo Cancels the last viewport undo.

Configure Displays the Viewport Configuration dialog on page 7610 , which
contains many options for further control of the viewports.

Viewport Navigation

At the right end of the status bar are the buttons that control the display and
navigation of the viewports.

Some of the buttons change for camera and light viewports. The Field Of View
button changes for Perspective viewports.

The state of the navigation-button flyouts for all viewport types is saved in
the [Performance] section of the 3dsmax.ini on page 51  file.

Viewport Navigation Controls

The navigation controls depend on the active viewport. Perspective,
orthographic, camera, and light viewports all have specialized controls. The
term “orthographic” refers to User viewports as well as viewports like Top,
Front, and so on. The Zoom Extents All flyout and Maximize Viewport Toggle,
available in all viewports, are included with the Perspective and orthographic
viewport controls.
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Many of these controls are modal on page 7849 , meaning they stay on for
repeated use. The buttons highlights when on. To turn them off, press Esc,
right-click in a viewport, or choose another tool.

Controls Available in All Viewports

Zoom Extents All  on page 7381

Maximize Viewport Toggle  on page 7382

Perspective and Orthographic Viewport Controls

Perspective and Orthographic Viewport Controls on page 7384

Zoom Viewport  on page 7385

Zoom All  on page 7386

Zoom Extents / Zoom Extents Selected on page 7387

Field-of-View Button  on page 7389  (Perspective) or  on page 7392

Pan View  on page 7393

Walk Through on page 75

Arc Rotate, Arc Rotate Selected, Arc Rotate Sub-Object  on page 7395
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Camera Viewport Controls

Camera Viewport Controls on page 7397

Dolly Camera, Target, or Both  on page 7398

Perspective  on page 7400

Roll Camera  on page 7401

Field-of-View Button  on page 7389

Truck Camera  on page 7403

Walk Through on page 75

Orbit/Pan Camera  on page 7404

Light Viewport Controls

Light Viewport Controls on page 7407

Dolly Light, Target, or Both  on page 7409
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Light Hotspot  on page 7411

Roll Light  on page 7413

Light Falloff  on page 7415

Truck Light  on page 7417

Orbit/Pan Light  on page 7419

Controls Available in All Viewports

Zoom Extents All, Zoom Extents All Selected

Activate any viewport. > Viewport Navigation controls > Zoom Extents All
flyout

Keyboard > Shift+Ctrl+Z

The Zoom Extents All flyout is available in all viewports. The flyout has two
options:

■ Zoom Extents All centers all visible objects in all viewports. This
control is useful when you want to see every object in a scene in every
available viewport.

■  Zoom Extents All Selected centers a selected object, or set of objects,
in all viewports. This control is useful when you want to navigate to small
objects lost in a complex scene.
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Procedures

To zoom all objects in a scene:

1 Activate any viewport.

2  Click Zoom Extents All.

The viewports display all objects in the scene.

To zoom to a specific object:

1 In any viewport, select the object by clicking it, or press H to select it by
name.

2  Click Zoom Extents All Selected.

The viewports display the selected object.

Interface

Zoom Extents All Centers and magnifies views so all the visible objects
in the scene are shown in all viewports.

Zoom Extents All Selected Centers and magnifies views so just the
selected objects or sub-object selections in the scene are shown in all viewports.
If no objects are selected, the effect is the same as Zoom Extents All.

Maximize Viewport Toggle 

Activate any viewport. > Viewport navigation controls> Maximize Viewport
Toggle

Keyboard > Alt+W

Maximize Viewport Toggle switches any active viewport between its normal
size and full-screen size.

TIP The keyboard shortcut Alt+W is especially useful for quick toggles.
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Walkthrough Controls for Perspective and
Camera Viewports

Pan/Truck and Walkthrough Flyout

In Perspective and Camera viewports, this flyout offers two separate buttons:

■  Walk Through

■  Pan or Truck

The Walk Through button on page 7383  is one way to turn on walkthrough
navigation on page 75 .

The use of the Pan or Truck button depends on which kind of viewport you
are in:

■ Perspective viewports (Pan) on page 7393

■ Camera viewports (Truck Camera) on page 7403

This flyout doesn't appear for orthographic viewports or spotlight viewports.
These viewports don't provide walkthrough navigation.

Walk Through Button 

The Walk Through button is one way to begin walkthrough navigation on
page 75 . (The other is to press Up Arrow.) It is available on the Pan/Truck
And Walkthrough flyout on page 7383 .

The flyout and button don't appear for orthographic viewports or for spotlight
viewports. These don't provide walkthrough navigation.
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Perspective and Orthographic Viewport Controls

Right-click any viewport label. > Views > Choose a perspective or orthographic
view.

Right-click any viewport label. > Views > Grid > Choose any grid view.

Select a shape. > Right-click any viewport label. > Views > Shape

Keyboard > V (to open the Viewports quad menu), then P (Perspective), U
(User), F (Front), K (Back), T (Top), B (Bottom), L (Left)

Perspective, orthographic, user, grid, and shape viewports all share the same
viewport controls.

Perspective and orthographic viewport controls include the following. Two
of these controls are available in all viewports.

Zoom Viewport  on page 7385

Zoom All  on page 7386

Zoom Extents / Zoom Extents Selected on page 7387  (available in all viewports)

Field-of-View Button  on page 7389

on page 7392

Pan View  on page 7393

Arc Rotate, Arc Rotate Selected, Arc Rotate Sub-Object  on page 7395

Maximize Viewport Toggle  on page 7382  (available in all viewports)

Procedures

To undo changes to a perspective or orthographic viewport, do one of the
following:

1 Right-click the viewport label and choose Undo. The type of Undo is
specifically named on the menu (for example, Undo Zoom Extents).

2 Press Shift+Z.
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NOTE This is different from camera and light viewports, which require the
use of Undo on the main toolbar, or Ctrl+Z.

Zoom Viewport 

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Zoom

Keyboard > Alt+Z turns on Zoom ; [ zooms in; ] zooms out

Keyboard > Ctrl+Alt+middle mouse button (drag)

Roll your mouse scroll wheel.

When Zoom is active, you can adjust the view magnification by dragging in
a Perspective or orthographic viewport. By default, zooming occurs from the
center of the viewport.

TIP If you use a wheel mouse, you can turn the wheel to zoom the active viewport
in and out without first activating Zoom. The zoom center is the center of the
viewport.

Zooming takes place incrementally, based on the distance between the
viewpoint and its “virtual target,” an inaccessible hidden target used for
calculation purposes only. Use the Ctrl and Alt keys, respectively, to increase
or decrease the increments. You can move the virtual target by holding down
the Shift key during a zoom operation. Otherwise you will zoom increasingly
closer to the target, which does not move.

Procedures

To zoom a view:

1 Activate a Perspective or orthographic viewport.

2  Click Zoom.

The button highlights when it is on.
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3 Drag in a viewport to change magnification:

■ Drag upward to increase magnification.

■ Drag downward to decrease magnification.

4 To exit Zoom mode, press Esc or right-click in a viewport.

To increase zoom speed:

■ Hold down Ctrl as you drag in a viewport.

To decrease zoom speed:

■ Hold down Alt as you drag in a viewport.

To turn on an automatic zoom mode:

■ On the keyboard, hold down Ctrl+Alt, then hold down the middle mouse
button and drag in a viewport. This does not activate the Zoom button.

To zoom from the keyboard:

■ On the keyboard, press [ (left bracket) to zoom in, and ] (right bracket) to
zoom out.

Zoom All 

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Zoom All

Zoom All lets you adjust view magnification in all Perspective and orthographic
viewports at the same time.

By default, Zoom All zooms in and out of the center of the viewports.

Procedures

To zoom all views:

1 Activate a Perspective or orthographic viewport.
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2  Click Zoom All.

The button highlights when it is on.

3 Drag in a viewport to change magnification in all viewports.

■ Drag upward to increase magnification.

■ Drag downward to decrease magnification.

4 Press Esc or right-click to turn off the button.

To zoom all viewports except the Perspective viewport:

1 Click Zoom All.

2 Hold down Shift and drag in a viewport to zoom all the viewports except
the Perspective.

NOTE You can drag in a Perspective viewport, but you only see the zoom
in orthographic viewports.

Zoom Extents / Zoom Extents Selected

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Zoom Extents flyout

The Zoom Extents flyout displays the Zoom Extents button and the Zoom
Extents Selected button.

Zoom Extents centers all visible objects in an active Perspective or
orthographic viewport. This control is useful when you want to see every
object in a scene in a single viewport.
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Zoom Extents Selected centers a selected object, or set of objects, in an
active Perspective and orthographic viewport. This control is useful when you
want to navigate to small objects lost in a complex scene.

Procedures

To zoom all objects in one viewport:

1 Activate the Perspective or orthographic viewport you want to zoom.

2  Click Zoom Extents.

The viewport displays all objects in the scene.

To zoom on a specific object:

1 Activate the Perspective or orthographic viewport you want to zoom.

2 Select the object by clicking it, or press H to select it by name.

3  Click Zoom Extents Selected.

The viewport displays the selected object.

To exclude an object from Zoom Extents:

Use this procedure, for example, to ignore lights that are far away from the
other objects in the scene.

1 Click an object to select it.

2 Right-click the object and choose Properties.

3 In the Display Properties group, make sure properties are set to By Object.

4 Turn on Ignore Extents.

The object will now be excluded by Zoom Extents and Zoom Extents
Selected.
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Interface

Zoom Extents Centers and magnifies views so all the visible objects
in the scene are shown in a single viewport.

Objects can be excluded from zoom extents all if the Ignore Extents box is
turned on under Object Properties.

Zoom Extents Selected Centers and magnifies views so just the selected
objects or sub-object selections in the scene are shown in a single viewport.
If no objects are selected, the effect is the same as Zoom Extents.

Field of View Flyout 

Activate Perspective viewport. > Status bar > Viewport controls > Field of View
flyout

The Field of View flyout is available only for Perspective viewports. The flyout
has two options:

■ Field of View (FOV) on page 7389 : Adjusts the amount of the scene
that is visible in a viewport and the amount of perspective flare.

■ Zoom Region on page 7392 : Magnifies a rectangular area you drag
within a viewport.

Field-of-View Button 

Activate a Camera viewport. > Viewport controls > Field-of-View

Activate a Perspective viewport. > Viewport controls > Field-of-View (on
Field-of-View flyout)
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Field-of-View (FOV) adjusts the amount of the scene that is visible in a viewport
and the amount of perspective flare. The effect of changing FOV is similar to
changing the lens on a camera:

■ As the FOV gets larger, you see more of your scene and the perspective
becomes distorted, similar to using a wide-angle lens.

■ As the FOV gets smaller, you see less of your scene and the perspective
flattens, similar to using a telephoto lens.

Above: Narrow field of view

Below: Wide field of view

Although the effect of Field-of-View appears similar to a zoom, the perspective
is actually changing, resulting in increased or decreased distortion in the
viewport.

In a Perspective viewport, Field-of-View defines the width of your view as an
angle with its apex at your viewpoint and the ends at the sides of the view.

In a Camera viewport, Field-of-View controls the width of the area a camera
views, and represents the arc of the camera's horizon in degrees. For a selected
camera, you can adjust its FOV and Lens parameters on page 5123  directly to
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fine-tune the FOV you set in the viewport. See “To use FOV with Camera
parameters” in the following procedures.

Procedures

To adjust the field of view in a viewport:

1 Activate a Perspective or Camera viewport.

2  Click Field-of-View.

The button highlights in gold when it is on.

3 Drag in the viewport to adjust the FOV angle.

■ Dragging down widens (increases) the FOV angle, reduces lens length,
displays more of your scene, and exaggerates perspective.

■ Dragging up narrows (decreases) the FOV angle, increases lens length,
displays less of your scene, and flattens perspective.

4 To turn off the button, press Esc or right-click.

To enter an FOV value in a Perspective view:

1 Activate a Perspective viewport.

2  Right-click Field-of-View to display the Viewport Configuration
dialog.

3 Click the Rendering Method tab.

4 In the Perspective User View group, enter an angle in the FOV field.

5 Click OK to make the change.

To use FOV with Camera parameters:

1 Activate a Camera viewport.

2 Press H and select the viewport’s camera in the Select From Scene dialog
on page 168 .

3 Open the Modify panel to view the camera’s Parameters rollout.
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4 As you drag Field-of-View in the viewport, the FOV and Lens parameters
update interactively.

5 Set the FOV and Lens parameters directly, or click a button in the Stock
Lenses group.

NOTE Only the FOV value is saved with the camera. The Lens value (focal
length) is another way to express and select the FOV.

See Common Camera Parameters on page 5123 .

NOTE Using the Perspective button on page 7400  in a Camera viewport also
changes the FOV in concert with dollying the camera.

Zoom Region

Activate an orthographic viewport. > Viewport navigation controls > Zoom
Region

Activate a Perspective viewport. > Viewport navigation controls > Zoom Region
(from Field of View flyout)

Keyboard > Ctrl+W

Zoom Region magnifies a rectangular area you drag within a viewport. This
control is available only when the active viewport is an orthographic on page
7877 , Perspective on page 7891  or User-Axonometric view on page 7722 . It is not
available for Camera viewports.

Zoom Region stays active until you right-click or select another command.

Procedures

To zoom a region:

1 Activate an orthographic or Perspective viewport.

2  Click Zoom Region or press Ctrl+W.

When you zoom a region in a perspective viewport, select Zoom Region
from the Field of View flyout.
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3 Drag a rectangular region in any viewport displaying a non-camera view.

When you release, the region is magnified to fill the viewport.

NOTE When using the Zoom Region in Perspective view, the zoom rectangle
is at a fixed distance from the camera. For this reason, if you draw the
rectangle large enough, you can zoom out from the scene.

Pan View 

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Pan View

Keyboard > Ctrl+P; I pans so the cursor location becomes the center of the
viewport.

Middle mouse button > Drag in the viewport with the middle mouse button
for instant access to pan the viewport.

Pan moves the view parallel to the current viewport plane.

Pan is modal on page 7849 : it stays active until you right-click or select another
command.

To constrain panning of any viewport to a single axis, hold down the Shift
key. The pan is constrained to the axis you first move while the Shift key is
down.

To accelerate panning, hold down the Ctrl key.

You can also pan by dragging in a viewport while pressing the middle button
of a three-button mouse. This lets you pan without turning on the Pan button.

Procedures

To pan a viewport:

1  Activate a Perspective or orthographic viewport, and then click
Pan View.

2 Drag in the viewport in the direction you want to move.

3 To turn off the button, press Esc or right-click.
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To pan a non-Camera viewport:

1 Activate a Perspective or orthographic viewport.

2 Do one of the following:

■  Click Pan View.

■ Press Ctrl+P.

■ Press the middle mouse button.

3 Drag in the viewport in the direction you want to move, or use the arrow
keys.

To accelerate panning:

■ Hold down the Ctrl key as you pan.

To constrain panning to a single axis:

■ Hold down the Shift key as you pan.
The pan is constrained to the first axis you use.

If you drag vertically at first, the pan or orbit is constrained to be vertical;
if you drag horizontally at first, the constraint is horizontal.

Arc Rotate Flyout

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Arc Rotate flyout

Keyboard > Alt+middle mouse button

The Arc Rotate flyout displays the Arc Rotate button, the Arc Rotate Selected
button, and the Arc Rotate Sub-Object button. Use these to rotate your
viewpoint around the view.
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For more information on these tools, see Arc Rotate, Arc Rotate Selected, Arc
Rotate Sub-Object  on page 7395 .

Arc Rotate,Arc Rotate Selected,Arc Rotate

Sub-Object 

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Arc Rotate flyout

Keyboard > Alt+middle mouse button

The Arc Rotate buttons, on the Arc Rotate flyout on page 7394 , spin the
viewpoint freely around a center.

Three Arc Rotate variants are available: Arc Rotate, Arc Rotate Selected, and
Arc Rotate Sub-Object.

Arc Rotate is modal on page 7849 : it remains active until you right-click or
choose another command.

 Arc Rotate respects Angle Snap on page 2570 . If you turn on Angle Snap,
the Arc Rotate mouse pointer displays a magnet, and the rotation snaps by
the Viewport Arc Rotate Snap Angle setting on page 7574 .

Arc Rotation used a hidden “virtual target” as the point which is used for the
center of rotation. Holding the Ctrl key down in Arc Rotate mode has a special
behavior: It performs a rotation of the scene around the screen’s X and Y axis
(at the position of the virtual target). Move the mouse horizontally yields
rotation around world coordinates referential Z axis. User moves the mouse
vertically yields rotation around screen coordinates referential X axis. This
differs from standard Arc Rotate, when horizontal mouse movement rotates
around screen coordinates referential Y axis.

Procedures

To use Arc Rotate:

1 Activate a Perspective or orthographic viewport.

2 Click any of the three Arc Rotate buttons.

A view rotation “trackball” is displayed as a yellow circle with handles
placed at the quadrant points.
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3 Drag the mouse on and around the trackball to produce different types
of view rotations. The cursor changes to indicate what type of rotation
you are about to perform.

■ Drag the handles to keep the rotation either horizontal or vertical.
Drag horizontally on the side handles, or vertically on the top or
bottom handle.

■ Drag inside the trackball to rotate the view freely within the viewport.
The free rotation continues while dragging even if the cursor crosses
outside the trackball.

■ Drag outside the trackball to rotate the view about the depth axis that
is perpendicular to the screen. When the cursor crosses inside the
trackball during dragging, free rotation occurs. When the cursor crosses
back outside the trackball, spinning rotation is again in effect.

4 To end Arc Rotate, press Esc or right-click.

To constrain rotation to a single axis:

■ Hold down the Shift key as you rotate.
The rotation is constrained to the first axis you use.

To rotate with keyboard and mouse:

■ Hold down the Shift key as you rotate.
The rotation is constrained to the first axis you use.

Interface

Arc Rotate Uses the view center as the center of rotation. If objects
are near the edges of the viewport, they may rotate out of view.

Arc Rotate Selected Uses the center of the current selection as the
center of rotation. The selected object remains at the same position in the
viewport while the view rotates around their center.

Arc Rotate SubObject Uses the center of the current sub-object selection
as the center of rotation. The selection remains at the same position in the
viewport while the view rotates around its center.
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Camera Viewport Controls

Right-click any viewport label. > Views > Choose a camera.

Keyboard > C

A Camera viewport shows the view from a camera, looking in the direction
it's aimed.

Camera viewport controls include the following. Two of these controls are
available in all viewports.

Dolly Camera, Target, or Both  on page 7398

Perspective  on page 7400

Roll Camera  on page 7401

Zoom Extents All  on page 7381  (available in all viewports)

Field-of-View Button  on page 7389

Truck Camera  on page 7403

Orbit/Pan Camera  on page 7404

Maximize Viewport Toggle  on page 7382  (available in all viewports)

Activate a Camera view from the viewport right-click menu, under Views. If
the scene contains more than 10 cameras, the last entry in the list is "More
Cameras.” Choose this to display the Choose A View dialog, which shows the
complete list.

If a single camera is selected and you press C, the active viewport switches to
the view from that camera. If, when you press C, the scene contains more
than one camera and no camera or multiple cameras are selected, the Select
Camera dialog appears; choose a camera from the list.

Procedures

To undo changes to a Camera viewport, do one of the following:

1 Click  Undo on the main toolbar .
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2 Press Ctrl+Z.

NOTE This is different behavior from orthographic viewports, which require
the use of Views menu > Undo, or Shift+Z.

Dolly Camera,Target, or Both 

Activate a Camera viewport. > Viewport navigation controls > Dolly Camera
or Dolly Target or Dolly Camera + Target

The buttons on this flyout replace the Zoom button when a Camera viewport
is active. Use them to move the camera and/or its target along the camera's
main axis, toward or away from what the camera is pointing at.

Dollying a camera

A free camera moves along its depth axis in the direction its lens is pointing.
Unlike a target camera, its target distance remains fixed, no matter how far
you dolly.
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NOTE The three buttons of the Dolly Camera flyout are available when a target
camera viewport is active. When a free camera viewport is active, the button
appears as a flyout, but only Dolly Camera is available for this type of camera. If
you activate a target camera viewport, the three buttons are again available.

See also:

■ Dolly Light, Target, or Both  on page 7409

Procedures

To dolly a camera:

1 Activate a Camera viewport.

2 Click one of the buttons on the Dolly Camera flyout.

3 Drag to move the camera.

■ Drag up to move the camera forward along its line of sight.

■ Drag down to move the camera backward along its line of sight.

4 Press Esc or right-click to turn off the button.

Interface

 The Dolly Camera flyout consists of the following individual buttons:

Dolly Camera Moves only the camera to and from its target. If you
go past the target, the camera flips 180 degrees and moves away from its target.

Dolly Target Moves only the target to and from the camera. You see
no visual change in the camera viewport, unless you dolly the target to where
it passes through the camera to the other side, at which point the camera view
is reversed. However, changing the relative position of the target to the camera
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affects other adjustments, such as Orbit Camera, which uses the target as its
rotational pivot.

This option is available only if the viewport’s camera is a target camera.

Dolly Camera + Target Moves both the target and the camera to and
from the camera.

This option is available only if the viewport’s camera is a target camera.

Perspective 

Activate a Camera viewport. > Viewport navigation controls > Perspective

Perspective performs a combination of FOV on page 7776  and Dolly on page
7398  for target cameras and free cameras. It increases the amount of perspective
flare, while maintaining the composition of the scene.

Adjusting perspective

NOTE This button replaces the Zoom All button when a Camera viewport is active.
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TIP Hold down the Ctrl key to magnify the effect of the mouse on perspective
adjustment.

A target camera can pass through its target object while you are using
Perspective. When this happens, the FOV reaches its maximum angle of 180
degrees at the target location and cursor motion is reversed until you release
the drag.

A free camera continues moving along an infinite path but uses an implied
target position to control the FOV change rate. This implied target is defined
as a point specified by the Target Distance field in the Parameters rollout for
the free camera.

Procedures

To change perspective for a camera:

1 Activate a Camera viewport.

2  Click Perspective.

The button turns yellow when it is on.

3 Drag to change FOV and dolly simultaneously.

■ Drag up to move the camera closer to its target, widen the FOV, and
increase perspective flare.

■ Drag down to move the camera away from its target, narrow the FOV,
and decrease perspective flare.

4 Press Esc or right-click to turn off the button.

Roll Camera 

Activate a Camera viewport. > Viewport navigation controls > Roll Camera

Roll Camera rotates a target camera about its line of sight, and rotates a free
camera about its local Z axis.
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Rolling a camera

NOTE This button replaces the Zoom Extents button when a Camera viewport is
active.

Procedures

To roll a camera:

1 Activate a Camera viewport.

2  Click Roll Camera.

The button highlights when it is on.

3 Drag horizontally to roll the view.

4 Press Esc or right-click to turn off the button.
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Truck Camera 

Activate a Camera viewport. > Viewport navigation controls > Truck Camera

Truck Camera moves the camera parallel to the view plane.

Trucking a camera

For a target camera, dragging the mouse moves both the camera and its target
parallel to the Camera view.

This button replaces the Pan button when a Camera viewport is active.

Procedures

To truck a camera:

1 Activate a Camera viewport.

2  Click Truck Camera.

The button highlights when it is on.
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3 Drag to move the camera and its target.

The camera and its target move parallel to the view plane, which is
perpendicular to the camera's line of sight.

4 Press Esc or right-click to turn off the button.

To constrain trucking to a single axis:

■ Hold down the Shift key.
The truck is constrained to the first axis you move while the Shift key is
down.

To accelerate trucking:

■ Hold down the Ctrl key.

Orbit/Pan Camera 

Activate a Camera viewport. > Viewport navigation controls > Orbit Camera

Orbit Camera rotates a camera about the target. Pan Camera rotates the target
about the camera.
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Orbiting a camera

Panning a camera
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NOTE This button replaces the Arc Rotate button when a Camera viewport is
active.

You can constrain the rotation to a single axis by first pressing Shift before
beginning the rotation. The rotation is constrained to the axis you begin
rotating about.

To accelerate panning, hold down the Ctrl key before you pan.

Procedures

To pan a camera:

1 Activate a Camera viewport.

2   Click Pan Camera.

The button highlights when it is on.

3 Drag to rotate the view about the camera.

■ Dragging rotates the view freely using the world X and Y axes.

■ Press Shift and drag horizontally to lock view rotation about the world
Y axis. This produces a horizontal pan.

■ Press Shift and drag vertically to lock rotation about the world X axis.
This produces a vertical pan.

4 Press Esc or right-click to turn off the button.

To pan with the middle mouse button:

■ Hold down the middle mouse button and drag.
Pan mode is automatically switched on.

To orbit a camera:

1 Activate a Camera viewport.

2  Click Orbit Camera.
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3 Drag to rotate the view around the target.

■ Dragging rotates the view freely using the world X and Y axes.

■ Press Shift and drag horizontally to lock view rotation about the world
Y axis. This produces a horizontal orbit.

■ Press Shift and drag vertically to lock rotation about the world X axis.
This produces a vertical orbit.

4 Press Esc or right-click to turn off the button.

Interface

Orbit Camera Rotates a target camera about its target. Free cameras use the
invisible target, set to the target distance specified in the camera Parameters
rollout.

Pan Camera Rotates the target about a target camera. For a free camera,
rotates the camera about its local axes.

Light Viewport Controls

Right-click any viewport label. > Views > Choose a light.

Keyboard > $

A Light viewport shows the view from a spotlight or directional light, looking
at its target.

Light viewport controls include the following. Two of these controls are
available in all viewports.

Dolly Light, Target, or Both  on page 7409

Light Hotspot  on page 7411

Roll Light  on page 7413

Zoom Extents All  on page 7381  (available in all viewports)
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Light Falloff  on page 7415

Truck Light  on page 7417

Orbit/Pan Light  on page 7419

Maximize Viewport Toggle  on page 7382  (available in all viewports)

For photometric lights on page 4951 , the Light Hotspot control actually adjusts
the beam angle. At the beam angle, the light is 50 per cent of the maximum
intensity.

Targeted photometric lights can be used as views only when the light's
distribution is set to spotlight.

WARNING Switching to or from a light view clears the Undo/Redo lists.

Procedures

To set a Light viewport:

1 Activate the viewport you want to show the view from a spotlight or
directional light in the scene.

2 Do one of the following:

■ Press the keyboard shortcut $.

■ Right-click the Viewport label. Choose Views and then choose the
light from the Views submenu.

3 If you have more than one spotlight or directional light in the scene (and
none is selected), the Select Light dialog is displayed: choose the light
you want.

4 If there are more than 10 lights listed, the last entry is "More Lights."
Choose this to display the Choose a View dialog, which shows the
complete list.

To undo changes to a Light viewport, do one of the following:

1  Click Undo on the main toolbar.

2 Press Ctrl+Z.

NOTE This is different from orthographic viewports, which require the use
of Views menu > Undo, or Shift+Z.
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Dolly Light,Target, or Both 

Activate a Light viewport. > Viewport navigation controls > Dolly Light

Dolly Light, on the Dolly Light flyout (see below) moves the light or its target
or both along the light’s main axis, toward or away from what the light is
pointing at. A free light moves along its depth axis in the direction its lens is
pointing. On a target light, the target distance remains fixed, no matter how
far you dolly.

Dollying a light

When you dolly a light, the light source moves closer to and away from its
target. Because spotlights have conical beams, dollying a spotlight closer to
its target shrinks the area illuminated at the target. Similarly, dollying a
spotlight away from its target expands the area illuminated at the target.

The three buttons of the Dolly Light flyout are available when a target light
viewport is active. When a free light viewport is active, the button appears as
a flyout, but only Dolly Light is available for this type of light. If you activate
a target light viewport, the three buttons are again available.
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The buttons on this flyout replace the Zoom button when a Light viewport
is active.

See also:

■ Dolly Camera, Target, or Both  on page 7398

Procedures

To dolly a light:

1 Activate a Light viewport.

2  Click Dolly Light.

The button highlights when it is on.

3 Drag to move the light.

■ Drag up to move the light forward along its line of sight.

■ Drag down to move the light backward along its line of sight.

4 Press Esc or right-click to turn off the button.

Interface

 The Dolly Light flyout consists of the following buttons:

Dolly Light Moves only the light to and from its target. If you go past
the target, the light flips 180 degrees and moves away from its target.

Dolly Target Moves only the target to and from the light. You see no
visual change in the light viewport, unless you dolly the target to where it
passes through the light to the other side, at which point the light view is
reversed. However, changing the relative position of the target to the light
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affects other adjustments, such as Orbit Light, which uses the target as its
rotational pivot.

This option is available only if the viewport’s light is a target light.

Dolly Light + Target Moves both the target and the light to and from
the light.

This option is available only if the viewport’s light is a target light.

Light Hotspot 

Activate a Light viewport. > Viewport navigation controls > Light Hotspot

Light Hotspot lets you adjust the angle of a light's hotspot on page 7811 . This
button replaces the Zoom All button when a light viewport is active.

The floodlight has a narrow hotspot but a wide falloff area.
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Widening the hotspot creates a brighter light.

Click this button, then move the mouse in the light viewport to make the
cone of the hotspot narrower or wider (the hotspot cone is shown in blue,
the falloff on page 7811  cone is in gray).

Hold down the Ctrl key while moving the mouse to lock the initial angle
separation of the hotspot and falloff cones.

You can't adjust the hotspot larger than the falloff, because that would change
the falloff value. Likewise, when you reduce the falloff, it stops at the hotspot
size (in both cases, separated by the Angle Separation on page 7560 , specified
on the Rendering page of the Preferences dialog).

To override the separation of the hotspot and falloff parameters and cause the
parameters to affect each other, hold down the Shift key.

For more information on the hotspot and falloff parameters, see Spotlight
Parameters on page 5051  and Directional Parameters on page 5069 .

NOTE If the light is a photometric light on page 4951  with spotlight distribution,
this button controls the light's beam angle. At the beam angle, the light's intensity
has fallen to 50 per cent (rather than 100 per cent at the hotspot angle for a
standard light).
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Procedures

To change a light's hotspot:

1 Set up a Perspective viewport so you can see the light in 3D space.

2 Activate a Light viewport.

3 Press H to display the Select From Scene dialog on page 168 . Select the
light.

The light and its cones should be visible in the Perspective viewport.

4  Click Light Hotspot.

The button highlights when it is on.

5 Drag in the Light viewport to change the hotspot angle.

The blue hotspot cone expands and contracts as you drag.

■ Drag down to widen (increase) the hotspot angle and illuminate more
of the scene. The hotspot grows inside the falloff as its angle increases.
By default, the hotspot can be no larger than the falloff cone.

■ Hold down Shift as you drag to override the default. This lets the falloff
cone increase in size as you increase the size of the hotspot cone.

■ Drag up to narrow (decrease) the hotspot angle and illuminate less of
the scene.

■ Hold down Ctrl as you drag to lock the initial angle separation of the
hotspot and falloff cones.

6 Press Esc or right-click to turn off the button.

Roll Light 

Activate a light viewport. > Viewport navigation controls > Roll Light

Roll Light rotates the light about its own line of sight (the light's local Z axis).

Although Roll does change the light view, it affects the light object only if the
light casts a rectangular beam or is a projector on page 7903 .
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Rolling a light

Drag the mouse horizontally to roll a target light or rotate a free light about
its local Z axis.

This button replaces the Zoom Extents button when a light viewport is active.

Procedures

To roll a light:

1 Activate a Light viewport.

2  Click Roll Light.

The button highlights when it is on.

3 Drag horizontally to roll the view.

4 Press Esc or right-click to turn off the button.
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Light Falloff 

Activate a Light viewport. > Viewport navigation controls > Light Falloff

Light Falloff adjusts the angle of a light's falloff on page 7811 . This button
replaces the Zoom Region button when a light viewport is active.

The light has a narrow hotspot but a wide falloff area.
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Making the falloff even wider illuminates a larger area.

Click Light Falloff, then move the mouse in the light viewport to make the
falloff narrower or wider (the falloff extents are shown in gray, the hotspot
on page 7811  is in blue).

Hold down the Ctrl key while moving the mouse to lock the initial angle
separation of the hotspot and falloff cones.

You can't adjust the hotspot larger than the falloff, because that would change
the falloff value. Likewise, when you reduce the falloff, it stops at the hotspot
size (in both cases, separated by the angle separation on page 7560 , specified
on the Rendering page of the Preferences dialog).

To override the separation of the hotspot and falloff parameters and cause the
parameters to affect each other, hold down the Shift key.

For more information on the hotspot and falloff parameters, see Spotlight
Parameters on page 5051  and Directional Parameters on page 5069 .

7416 | Chapter 23   User Interface



Procedures

To change a light's falloff:

1 Set up a Perspective viewport so you can see the light in 3D space.

2 Activate a Light viewport.

3 Press H to display the Select Object dialog. Select the light.

The light and its cones should be visible in the Perspective viewport.

4  Click Light Falloff.

The button highlights when it is on.

5 Drag in the Light viewport to change the falloff angle.

The gray falloff cone expands and contracts as you drag.

■ Drag down to widen (increase) the falloff angle and illuminate more
of the scene.

■ Drag up to narrow (decrease) the falloff angle and illuminate less of
the scene. As its angle decreases, the falloff shrinks around the hotspot.
By default, the falloff cone can be no smaller than the hotspot cone.

■ Hold down Shift as you drag to override the default. This lets the
hotspot cone decrease in size as you decrease the size of the falloff
cone.

■ Hold down Ctrl as you drag to lock the initial angle separation of the
hotspot and falloff cones.

6 Press Esc or right-click to turn off the button.

Truck Light 

Activate a light viewport. > Viewport navigation controls > Truck Light

Truck Light moves a target light and its target parallel to the light view, and
moves a free light along its XY axis.
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Trucking a light

To constrain trucking of any viewport to a single axis, hold down the Shift
key. The truck is constrained to the first axis you move while the Shift key is
down.

To accelerate trucking, hold down the Ctrl key.

NOTE This button replaces the Pan button when a light viewport is active.

Procedures

To truck a light:

1 Activate a Light viewport.

2  Click Truck Light.

The button highlights when it is on.

3 Drag to move the light and its target.
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The camera and its target move parallel to the view plane, which is
perpendicular to the camera's line of sight.

4 Press Esc or right-click to turn off the button.

To constrain trucking to a single axis:

■ Hold down the Shift key.
The truck is constrained to the first axis you use.

Orbit/Pan Light 

Activate a light viewport. > Viewport navigation controls > Orbit/Pan Light
flyout

Orbit rotates a light about the target. Pan rotates the target about the light.

Orbiting a light
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Panning a light

To constrain panning or orbiting to a single axis, hold down the Shift key.
The pan or orbit is constrained to the axis you first move while the Shift key
is down.

To accelerate panning or orbiting, hold down the Ctrl key before you pan or
orbit.

NOTE This button replaces the Arc Rotate button when a light viewport is active.

Procedures

To orbit a light:

1 Activate a Light viewport.

2  Click Orbit Light.

The button highlights when it is on.
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3 Drag to rotate the view around the target.

■ Dragging rotates the view freely using the world X and Y axes.

■ Press Shift and drag horizontally to lock view rotation about the world
Y axis. This produces a horizontal orbit.

■ Press Shift and drag vertically to lock rotation about the world X axis.
This produces a vertical orbit.

4 Press Esc or right-click to turn off the button.

To pan a light:

1 Activate a Camera or Light viewport.

2  Click Pan Light.

The button highlights when it is on.

3 Drag to rotate the view about the camera or light.

■ Dragging rotates the view freely using the world X and Y axes.

■ Press Shift and drag horizontally to lock view rotation about the world
Y axis. This produces a horizontal pan.

■ Press Shift and drag vertically to lock rotation about the world X axis.
This produces a vertical pan.

4 Press Esc or right-click to turn off the button.

To pan with the middle mouse button:

■ Hold down the middle mouse button and drag.
Pan mode is automatically switched on.

Interface

Orbit Light Rotates the light about its target. Free lights use the invisible
target, set to the target distance specified in the Modify panel > Spotlight
Parameters or Directional Parameters rollout.
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Pan Light For a target light, rotates the target about the light. For a
free light, rotates the light about its local axes.

Command Panel
The command panel comprises six user-interface panels that give you access
to most of the modeling features of 3ds Max, as well as some animation
features, display choices, and miscellaneous utilities. Only one panel is visible
at a time. To display a different panel, you click its tab at the top of the
command panel.

These are the six panels:

■ Create panel on page 7423
Contains controls for creating objects: geometry, cameras, lights, and so
on.

■ Modify panel on page 7425
Contains controls for applying modifiers on page 7852  to objects and editing
editable objects such as meshes and patches.

■ Hierarchy panel on page 7453
Contains controls for managing links in a hierarchy, joints, and inverse
kinematics.

■ Motion panel on page 7455
Contains controls for animation controllers and trajectories.

■ Display panel on page 7457
Contains controls that let you hide and unhide objects, along with other
display options

■ Utilities panel on page 7463
Contains miscellaneous utility programs, most of which are plug-ins to
3ds Max.
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By default, the command panel appears at the right of the 3ds Max window.
You can "dock" it along other edges of the program window, or make it a
floating panel. See Customizing the User Interface on page 7475 .

Object Name and Wireframe Color

Create panel > Any object category > Name And Color rollout

Modify, Hierarchy, Motion, Display, or Utilities panel > Name field and color
swatch

The name and color fields appear at the top of all command panels other than
the Create panel. On the Create panel, the fields are contained in a rollout.
You can change an object's name or color from any of these locations.

Interface

Name (text field) Displays the name of the selected object and lets you enter
a new name from the keyboard. Available only when a single object is selected.

Color (swatch) Displays the selected object's wireframe color and lets you
select a new one. The wireframe color is the one used to display the object in
viewports. Click the color swatch to display the Object Color dialog on page
327 .

Create Panel 

Command panels > Create panel

The Create panel provides the controls for creating objects. This is the first
step in building a new scene in 3ds Max. Most likely, you will continue to add
objects throughout an entire project. For example, when it is time to render
a scene you might need to add more lights.

The Create panel groups the kinds of objects you create into seven  categories.
Each category has its own button. Within each category there can be several
different subcategories of objects. A drop-down list lets you choose among
object subcategories, and each kind of object has its own button, which you
click to begin creation.
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These are the categories of objects that the Create panel provides:

■ Geometry on page 317
Geometry is the renderable geometry of the scene. There are geometry
primitives such as Box, Sphere, Pyramid, and more advanced geometry
such as Booleans, Lofts, and particle systems .

■ Shapes on page 536
Shapes are splines or NURBS curves. They have only one local dimension,
although they can exist in 2D space, such as a Rectangle shape, or 3D
space, such as a Helix.

You can give shapes a thickness so they will render, but primarily you use
them for constructing other objects such as Lofts, or for motion trajectories.

■ Lights on page 4890
Lights illuminate the scene and improve its realism. There are several kinds
of lights, each of which models different types of lighting in the real world.

■ Cameras on page 5106
Camera objects provide a view of the scene. The advantages of cameras
over the views in the standard viewports are that cameras have controls
similar to real-world cameras, and that you can animate a camera's position.

■ Helpers on page 2503
Helper objects are aids to constructing a scene. They help you position,
measure, and animate the scene's renderable geometry.

■ Space Warps on page 2603
Space warps produce various kinds of distortions in the space surrounding
other objects. Some space warps are meant especially for use with particle
systems.

■ Systems on page 829
Systems combine objects, controllers, and hierarchies to provide geometry
associated with some kind of behavior. Also contains Sunlight and Daylight
systems that simulate sunlight in your scenes.
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Modify Panel 

Command panels > Modify panel

From the Create panel of 3ds Max, you place basic objects in your scene,
including 3D geometry, 2D shapes, lights and cameras, space warps, and
helpers. As you do this, you give each object its own set of creation parameters,
which define its geometry and other characteristics depending on the type of
object. Once placed in a scene, objects carry their creation parameters with
them. You can change these parameters on the Modify panel.

You also use the Modify panel to assign modifiers on page 7852 . Modifiers are
tools for reshaping an object. While they mold the final appearance of the
object, modifiers do not change its underlying creation parameters. See the
list of available modifiers on page 1011 .

You use the Modify panel to:

■ Change the creation parameters for existing objects .

■ Apply modifiers to adjust the geometry of an object or a set of objects.

■ Change the parameters of modifiers and select their components.

■ Delete modifiers.

■ Convert a parametric object to an editable object; see Modifier Stack
Controls on page 7427 .

NOTE Some space warps can be created as modifiers. See World Space
Modifiers (WSMs) on page 1043 .

The Modify panel stays in view until you dismiss it by clicking the tab of
another command panel. The contents of the panel with its options and
controls update when you select an object, giving you access only to what
you can modify about that object.

What you can modify depends on whether an object is classed as a geometric
primitive like a sphere, or as another kind of object, such as a light or a space
warp. Each category has its own range of possibilities. The contents of the
Modify panel are always specific to the category as well as to the selected
object. When you make a change from the Modify panel, you immediately
see the results transferred to the object.
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You can change or delete modifiers by using the Modifier Stack Controls on
page 7427 .

See also:

■ List of Available Modifiers on page 1011

Procedures

To use the Modify panel:

1 Select an object.

2  On the Command panel, click the Modify tab to display the Modify
panel.

The name of the object appears at the top of the Modify panel, and the
remainder of the panel displays settings for the object or the modifier at
the top of its stack.

3 You can now do any of the following:

■ Change the parameters for the object. As you change these parameters,
the object updates in the viewports.

■ Apply a modifier to the object.

■ Change the parameters for a modifier. As you change these parameters,
the object updates into the viewports.

■ Collapse the stack to create an editable surface such as an editable
mesh on page 1990 .

To apply a modifier from the Modify panel:

1 Select an object.

2  On the Command panel, click the Modify tab to display the Modify
panel. On the Modify panel, click the Modifier List items to open the
drop-down list of modifiers.
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3 Scroll the list to find the modifier you want. You can use any standard
method to scroll the list:

■ From the keyboard, press Up Arrow or Down Arrow to scroll one item
at a time, or press Page Up or Page Down to scroll in screen-height
increments, or use Home or End to jump to the top or bottom of the
list. The name of the chosen modifier is highlighted, and the name
appears at the top of the list.

TIP If you know the modifier name, you can jump to its section by
pressing the keyboard key corresponding to first letter of the name. To
cycle through all modifiers starting with that letter, press the key
repeatedly.

■ With the mouse, slide the scroll bar on the right side of the list, or
turn the mouse wheel.

4 Apply the modifier. If using the keyboard, press Enter to apply the
highlighted modifier. If using the mouse, simply click the modifier name
to apply it.

Modifier Stack Controls

Make selection. > Modify panel

seeThe modifier stack controls appear near the top of the Modify panel, just
below the name and color fields. The modifier stack ("stack" for short) contains
the accumulated history of an object, including its creation parameters and
the modifiers applied to it. At the bottom of the stack is the original object.
Above the object are the modifiers, in order from bottom to top. This is the
order in which modifiers are applied to the object's geometry.
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Object with two modifiers applied to it in the
stack

See also:

■ Applying Modifiers on page ?

■ Using the Modify Panel on page 1016

■ Using the Modifier Stack on page 1020

■ List of Available Modifiers on page 1011

■ World-Space Modifiers (WSMs) on page 1043

■ Object-Space Modifiers on page 1132

Instances and References in the Modifier Stack Display

In the modifier stack display, objects and modifiers appear in normal type
unless they are an instance or a reference. Here is how instances and references
appear in the stack display:

■ The name of an instanced object appears in boldface.

■ The name of a modifier appears in boldface if it is part of an instanced
pipeline.

7428 | Chapter 23   User Interface



Top: Plain object displayed in plain text

Bottom: Object instance displayed in boldface

Top: Pipeline displayed in plain text

Bottom: Pipeline instance displayed in boldface

■ If a modifier is applied to two or more pipelines, it is called an instanced
modifier. Its name appears in italic.

■ If a modifier is instanced and part of an instanced pipeline, its name appears
in boldface and italic.

Top: Instanced modifier displayed in italic
(modifier applied to two objects)

Bottom: Instanced modifier in an instanced
pipeline displayed in italic and boldface

■ A referenced object appears with a dark bar above it. Modifiers below the
bar are part of the current pipeline. Modifiers above the bar are unique to
the reference object.

NOTE You can also create instances of a reference. In this case, the modifier
above the reference bar apply to the reference and to its instances.
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■ A modifier above the reference object bar can itself be an instance and
appear in other pipelines, in which case its name would be italic (either
plain or boldface).

Top: Object reference shows a bar in the pipe

Bottom: Modifier applied to reference is not
bold, as it is unique to this reference

 The Make Unique button on page 7446  makes a pipeline or a modifier
instance unique. When you highlight the base object and then click Make
Unique, the whole pipeline becomes unique. When you highlight a bold
modifier and then click Make Unique, this also makes the pipeline unique. If
the modifier is an instanced modifier that belongs to an instanced pipeline
(it appears in boldface and italic), clicking Make Unique makes the modifier
unique but not the entire pipeline (the modifier's name is no longer italic,
but it is still bold).

See also:

■ How Instanced Modifiers Work on page 1040

■ Transforms, Modifiers, and Object Data Flow on page 1004

Most-Recently-Used Modifiers

3ds Max caches the results of evaluating most-recently-used modifiers. This
means that in general, you can see results more quickly as you move among
modifiers on the stack.

To conserve memory use, the list of most-recently-used modifiers has a fixed
length. Once the list is full, adding a new modifier removes the oldest modifier
in the list. By default, the list length is 1. You can increase it by adding an
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MRUModSize entry to the [Performance] section of the 3dsmax.ini on page
51  file. For example:

MRUModSize=10

A good rule of thumb for this value is 10, but results will vary depending on
how much main memory your system has.

Procedures

To adjust an object's creation parameters:

1 Choose the object by clicking its name in the stack.

Primitive objects have a Parameters rollout. Other kinds of objects (such
as meshes or NURBS) have a variety of rollouts.

2 Use the controls in the rollouts to adjust the object.

To apply a modifier to an object:

1 Select the object.

2 Do one of the following:

■ Choose a modifier from the Modifier List. This is a drop-down list at
the top of the Modify panel.

TIP
In many cases, multiple modifiers' names start with the same letter.
You can go directly to a particular modifier if you type the first few
letters (enough for a unique combination) in the desired modifier's
name quickly. For example, say you want to assign the Mirror modifier
to an object. Pressing M goes to Mesh Select, which isn't anywhere
near Mirror in the Modifier list, but typing MI goes directly to Mirror.

■ Choose a modifier from the Modifiers menu. This menu is organized
into sets by functionality.
Not all modifiers appear on the Modifiers menu.

■ If the modifier buttons are visible on the Modify panel and the
modifier you want is one of them, click the button.

 If the buttons are not visible but you want to use them, click
the Configure Modifier Sets button on page 7450  (below the modifier
stack display) and choose Show Buttons. A set of buttons with the
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names of modifiers appears between the modifier list and the stack
display. Click Configure Modifier Sets again, choose the set of
modifiers you want to use (for example, Free-Form Deformations),
and then click the button for the modifier you want to apply.

Rollouts are now displayed below the modifier stack display, showing
settings for the modifier. As you change these settings, the object updates
in viewports.

To remove a modifier:

■ Do one of the following:

■  Choose the modifier by clicking its name in the stack, and then
click Remove Modifier From The Stack. This button is one of the tools
beneath the display of the modifier stack.

■ Right-click the modifier's name in the stack and then choose Delete.

To turn the effect of a modifier off, do one of the following:

1  Click the light-bulb icon to the left of the modifier's name in the
stack to turn it off.

When you apply a modifier, the light-bulb icon is on by default.

2 Right-click the modifier in the stack display, and choose Off.

To turn the effect of a modifier back on, do one of the following:

1  Click the light-bulb icon to the left of the modifier's name in the
stack to turn it on.

2 Right-click the modifier in the stack display, and choose On.

To change the size of the modifier stack display:

1 Position the cursor over the shaded bar below the tool buttons beneath
the stack list.

The cursor changes to an up-and-down resize arrow (as it does on the
horizontal edges of a resizable window).
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2 Drag the bar up or down to change the size of the stack display in the
Modify panel.

To change a modifier's position in the stack:

1 Right-click the modifier's name in the stack, and choose Cut.

2 Right-click the name of the modifier you want the modifier to appear
before (that is, above), and choose Paste.

You can also drag-and-drop the modifier to a different location in the
stack.

NOTE The original object is always at the bottom of the stack, and
world-space modifiers are always at the top.

To use the modifier buttons:

■  Click Configure Modifier Sets, and choose Show Buttons.
This menu item is a toggle. It is either on or off. When you turn on Show
Buttons, the current button set appears between the drop-down modifier
list and the stack display.

See Configure Modifier Sets Dialog  on page 7450  for more information.

To turn the modified object into an editable mesh, do one of the following:

1 Right-click the modifier stack, and choose Collapse All.

A warning dialog is displayed that reminds you that the collapse operation
cannot be undone, and gives you the option of performing a Hold on
page 204  before creating the mesh.
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2 Right-click the object in a viewport, and choose Convert To > Convert
to Editable Mesh in the quad menu.

TIP You can also turn a modified object into an editable patch or editable
polygon surface. Use the quad menu to do this.

To adjust a modifier's component such as its gizmo or center point:

1  Click the plus-sign icon to display the modifier's hierarchy.

2 Choose the component you want to adjust, such as the Gizmo.

The component highlights to show it is active.

3 Adjust the component.

For example, you might use transforms to move a gizmo or a center point.

4  When done, you can click the minus-sign icon to hide the hierarchy
display. The modifier itself is highlighted again.

TIP You can also right-click the stack and use Show All Subtrees to view the
entire hierarchy, and Hide All Subtrees to view only objects and modifiers.

To go to a sub-object level for complex objects:

1  Click the plus-sign icon to display the object's hierarchy.

2 Choose the sub-object level you want to adjust.

The sub-object level highlights to show it is active.

Keyboard shortcut: Insert cycles through the different sub-object levels.

3 Adjust sub-objects.

When you add a new sub-object type, the modifier stack updates to show
the new sub-object levels. For example, when you add a point curve
sub-object to a NURBS surface, the Point and Curve sub-object levels
appear in the stack.

4 To leave the sub-object level, click to select the name of the top-level
object or a different top-level object.

TIP You can also right-click the stack and use Show All Subtrees to view the
entire hierarchy, and Hide All Subtrees to view only objects and modifiers.
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Interface

The Modifier Stack

Modifier List

The modifier list is a drop-down list that lets you choose a modifier to add to
the stack. When you choose an object-space modifier on page 1132  from this
list, it appears above the object, or above the modifier that was currently
selected in the stack. When you choose a world-space modifier on page 1043
from this list, it appears at the top of the stack.

Use Pivot Points The first item in the modifier list is the Use Pivot Points
toggle. It is unavailable unless multiple objects are selected.

When Use Pivot Points is turned on, 3ds Max uses the pivot point of each
object as the center of a modifier's operation. For example, if you bend a line
of trees around the Z axis, they all bend along their trunks.

When Use Pivot Points is turned off, 3ds Max calculates a central pivot point
for the entire selection set and modifies the selection as a whole. For example,
if you bend a line of trees around the Z axis, trees at the end of the line deform
more than those at the center where the pivot is located.
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NOTE You must turn on Use Pivot Points before you apply the modifier to multiple
objects. You can't change the setting afterward, although you can delete the
modifier and start over without deselecting the selection set.

Modifier Buttons

Between the modifier list and the stack display, you can display up to 32
buttons. The buttons are a shortcut way to add modifiers to the stack.

 To display the modifier buttons, click Configure Modifier Sets (below
the stack display) and choose Show Buttons.

 To customize the button set, click Configure Modifier Sets (below the
stack display) and choose Configure Modifier Sets on page 7450 .

When a modifier's button is visible, c licking the  button adds the modifier
to the stack. Object modifiers are applied immediately above the currently
selected object or modifier. World space modifiers are applied at the top of
the stack.
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Stack Display

The modifier stack is organized as follows:

■ At the bottom of the stack, the first entry always lists the object type. Click
this entry to display the object's creation parameters so you can adjust
them.
When you click to choose an entry in the modifier stack, its background
highlights to show that the entry is current, and that the object's or
modifier's parameters are available for adjusting, in rollouts that appear
beneath the stack display.

■ Above the object itself are entries for object modifiers. Click a modifier
entry to display the modifier's parameters so you can adjust them.
This section lets you go back to any modifier you've applied and rework
its effect on the object. You can also delete the modifier from the stack,
canceling its effect.

Reminder:3ds Max applies transforms after it applies object modifiers but
before it applies space warps or world-space modifiers.

■ The top of the stack shows which space warps and world-space modifiers
the object uses. For example, if the object were bound to a Ripple space
warp, an entry in the top section would read Ripple Binding.

 To the left of each modifier in the stack is a light-bulb icon. When
the bulb appears white, the modifier is applied to the stack below it. When
the bulb appears gray, the modifier is turned off. Click to toggle the on/off
state of the modifier.

NOTE You can also turn off the effect of modifiers in viewports but not in
renderings, or vice versa. The light-bulb icon changes to show these states as well.
See Modifier Stack Right-Click Menu on page 7440 .

 If the modifier has sub-controls such as a center or a gizmo, the
stack also shows a small plus/minus icon. Click this icon to open or close the
hierarchy.

Opening a modifier's hierarchy to access
sub-controls
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Opening a modifier's hierarchy to access
sub-controls

When the hierarchy is open, you can select a sub-control, such as a gizmo,
and then adjust it. The available sub-controls vary from modifier to modifier.

Objects that have a sub-object hierarchy, such as editable meshes on page
1990  and NURBS on page 2152 , also show a collapsible hierarchy in the modifier
stack.

To work at a sub-object level, click to open the hierarchy, then click to select
the sub-object level. Controls for that particular level or type of sub-object
appear in rollouts below the stack display.

(Certain types of sub-objects display an icon at the right of the stack, to help
you see which sub-object type you are adjusting.)

Opening an object's hierarchy to access
sub-object levels
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Opening an object's hierarchy to access
sub-object levels

Opening an object's hierarchy to access
sub-object levels

Tool Buttons

Below the stack display is a row of buttons for managing the stack.
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Pin Stack Locks the stack to the currently selected object so it remains
with that object regardless of subsequent changes in selection. The entire
Modify panel is locked to the current object as well.

Pin Stack is useful for transforming another object while keeping your place
in the modified object's stack.

Show End Result Shows the selected object as it will appear after all
modifications in the stack have taken place, regardless of your current position
in the stack. When this toggle is turned off, the object appears as modified
up to the current modifier in the stack.

Make Unique Converts an instanced modifier to a copy that's unique
to the current object. See Make Unique on page 7446 .

Remove Modifier Deletes the current modifier or unbinds the current
space warp.

Configure Modifier Sets Click to display the pop-up Modifier Sets
menu on page 7449 .

Modifier Stack Right-Click Menu

Modify panel > Modifier stack display > Right-click a modifier or object.

Some commands for managing modifiers are available by right-clicking the
modifier stack display. Some options are unavailable if they don't apply to
the current modifier. For example, Make Unique is available only if you select
an instanced modifier.

The main uses of the right-click menu for the modifier stack are:

■ Renaming modifiers

■ Rearranging modifiers with the cut, copy, and paste functions

You can cut, copy, and paste multiple modifiers at one time. You can also cut
and copy discontiguous selections of modifiers.

■ Creating instances of modifiers
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■ Collapsing the stack into a surface object such as an editable mesh

■ Controlling whether modifiers are on or off, off in viewports, or off in
renderings

Collapsing the Stack

Collapsing the stack removes modifiers from the object. Collapsing a stack
typically converts an object into an editable version of the original object
(unless the object was editable to begin with, such as a NURBS model). Collapse
To is unavailable unless you select one or more modifiers in the stack. Using
Collapse To removes all stack items from the creation parameters to and
including the uppermost selected stack item.

NOTE You can preserve custom attributes on page 7445  when collapsing the stack.

Following are suitable reasons to collapse a stack:

■ To simplify the scene geometry.

■ To discard applied modifiers, and convert the object to an editable object
while retaining the results of any applied modifiers.

■ To conserve memory.

After you collapse an object's stack, you can no longer parametrically adjust
either its creation parameters or its individual modifiers. Animation tracks
that were assigned to such parameters also disappear.

Procedures

To move one or more modifiers:

1 Select one or more modifiers in the modifier stack display.

To select multiple modifiers, click to select one modifier, then hold down
Ctrl and click to select the others. Holding down Shift selects the two
modifiers you click and all modifiers in between them.

2 Right-click and choose Cut.

3 Select a modifier above which to paste the cut modifiers. (This can also
be the object at the bottom of the stack.)

4 Right-click and choose Paste. The modifiers are pasted above the current
selection.
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To copy one or more modifiers:

1 Select one or more modifiers in the modifier stack display.

To select multiple modifiers, click to select one modifier, then hold down
Ctrl and click to select the others. Holding down Shift selects the two
modifiers you click and all modifiers in between them.

2 Right-click and choose Copy.

3 Select an item above which to paste the cut modifiers.

4 Right-click and choose Paste. The copied modifiers are pasted above the
current selection. Choose Paste Instanced to make the pasted modifiers
instances of those you copied.

To copy modifiers from one object to another:

1 Select one or more modifiers in the modifier stack display of the first
object.

To select multiple modifiers, click to select one modifier, then hold down
Ctrl and click to select the others. Holding down Shift selects the two
modifiers you click and all modifiers in between them.

2 Right-click and choose Copy.

3 Select the second object.

4 In the second object's modifier stack display, select an item above which
to paste the copied modifiers.

5 Right-click and choose Paste.

The modifiers from the first object are pasted above the current selection
in the second object. Choose Paste Instanced to make the pasted modifiers
instances of those you copied.
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Interface

Rename Lets you change the name of the modifier. For example, you might
change the name Bend to the more specific "First 45-degree bend." After
choosing Rename, enter the new name in the stack display, and then press
Enter. Pressing Esc cancels the name change.

Delete Deletes the modifier from the stack. The modifier is not available for
pasting.

Cut Cuts the modifier from the stack. The modifier is removed, but is
available for pasting.

Copy Makes a copy of the modifier that is available for pasting.

Paste Pastes the modifier into the stack. The modifier appears above the
currently selected object or modifier, unless it is a world space modifier, in
which case it is pasted at the top of the stack.

You can paste a modifier from one object into the stack of a different object.

Paste is unavailable when more than one modifier is selected in the stack.
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Paste Instanced Pastes an instance of the modifier into the stack. The
modifier instance appears above the currently selected object or modifier,
unless it is a world space modifier, in which case it is pasted at the top of the
stack.

You can paste a modifier instance from one object into the stack of a different
object.

Paste Instanced is unavailable when more than one modifier is selected in the
stack.

Make Unique Converts an instanced modifier to a copy that's unique to the
current object. This button is unavailable unless the modifier you right-clicked
is instanced. See Make Unique on page 7446 .

Collapse To Collapses a portion of the stack. Collapse To is unavailable unless
you select one or more modifiers in the stack. Using Collapse To collapses all
stack items from the object itself, up to and including the uppermost selected
stack item. If there are modifiers above the uppermost selection, they are not
changed.

The resultant object type depends on the uppermost modifier that outputs a
specific geometry type, if any. If the stack contains no such modifier, the result
is an editable mesh on page 1990 . If the collapsed portion of the stack contains
a modifier that outputs a specific geometry type, and no other such modifier
is above it, the result is that type of object. For example, if the topmost such
collapsed modifier is Edit Poly, the resultant object is Editable Poly.

Collapse All Collapses the entire stack.

The resulting stack list shows a single entry: Editable Mesh, unless any
modifiers on the stack output a different type of geometry. For example, if
the topmost such modifier is Edit Poly, the resultant object is Editable Poly.

NOTE World-space modifiers on page 1043  don't collapse along with the rest of
the stack.

Convert To This menu item appears if no modifiers are applied to the object.
Choose one of the Convert To options:

■ Editable Mesh

■ Editable Spline

■ Editable Patch

■ Editable Poly

■ NURBS
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NOTE Depending on the object type, not all Convert To options might be
available.

Preserve Custom Attributes When on, collapsing an object's modifier stack
or converting it a different format such as Editable Poly preserves any custom
attributes on page 267  present in the stack.

On Turns on the effect of modifiers in both viewports and the renderer.

 The light-bulb icon to the left of the modifier name shows "on."

Off in Viewport Turns off the currently selected modifiers in viewports only.
Allows you to work in the viewport without the effects of the modifiers. You
see the effects when you render.

 The light-bulb icon to the left of the modifier name shows "off in
viewports."

Off in Renderer Turns off the currently selected modifiers in renderings only.
The effect of the modifiers is visible in viewports but not in renderings.

 The light-bulb icon to the left of the modifier name shows "off in
Renderer."

Off Turns off the currently selected modifiers without deleting them. This
can help you see the object without the effect of its modifiers.

 The light-bulb icon to the left of the modifier name shows "off."

Make Reference If the object is an instance, converts it to a reference. This
option is available only when the base object is selected, and only when the
base object is a reference.

When you make an instanced object into a reference, a heavy, "derived object"
bar appears at the top of the stack. You can select this bar and apply modifiers
above it. Modifiers applied above the bar affect the reference object only, and
not its parent object.
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Gray bar denotes a reference object at the base
of the stack

Show All Subtrees Expands the display of every hierarchical item in the
stack display, so that all items in the stack are visible, including sub-objects.

Hide All Subtrees Hides the subtree of every hierarchical item in the stack
display, so that only objects, modifiers, and space warp bindings are visible.

Make Unique 

Modify panel > Tool buttons > Make Unique

Modify panel > Right-click an instanced modifier in the stack display. > Make
Unique

Right–click an instanced object. > Make Unique

Make Unique lets you convert an instanced object to a copy that's unique. A
object is instanced when it is cloned (Shift+Move or Shift+Rotate). If you make
changes to an instanced object the changes are also reflected in the other
instances in your scene. Making objects unique lets you adjust or change those
objects independently without affecting any other objects in the scene.

TIP If you drag a material to a unique object and see the other instanced object
updating as well, turn off Automatic Material Propagation. Go to Customize menu
> Customize UI and choose Category: Instance Manager, then drag Automatic
Material Propagation to a toolbar or assign a keyboard shortcut to it. Using this
tool will allow the unique object to act uniquely.
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Procedures

Example: To use the Make Unique options with an instanced modifier:

1 Create a cylinder with some height segments, and then use Shift+Move
to create three copies, resulting in four identical cylinders.

2 Select all four cylinders, apply the Bend modifier, and adjust the Angle
setting just enough to see the results of the bend.

You now have four cylinders with a single instance of a Bend modifier
applied to them.

3 Choose Edit menu > Hold.

This lets you return to the current state of the scene at any time without
using Undo.

4  Select two of the cylinders and click Make Unique.

5 Choose Yes in the resulting dialog.

At this point, the two selected cylinders each have unique Bend modifiers,
while the remaining two cylinders share the original Bend. You can see
this by selecting each cylinder and changing the Bend Angle setting.

6 Choose Edit menu > Fetch, and answer Yes.

7 Select two cylinders again, and click Make Unique.

8 Choose No in the resulting dialog.

The two selected cylinders now share an instance of a Bend modifier, but
it's a different instance than that shared by the other two cylinders. Again,
you can see this by selecting each of the cylinders and changing the Bend
Angle spinner. You can also turn on Show Dependencies on page 108  in
the Views menu to see the relationship between the four cylinders and
the Bend modifier.

Example: To use Make Unique with an instanced object/modifier combination:

1 Create a cylinder with some height segments.

2 Apply a Bend modifier and adjust the Angle just enough to see the results
of the bend.

3 Use Shift+Move with the Instance option to create an instanced
object/modifier combination.
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4 Change the Bend Angle setting on one of the instances to demonstrate
that the cylinders and modifiers are truly instanced.

Both cylinders bend.

5 Select one of the instances, and then, in the modifier stack choose either
the Bend modifier or the cylinder itself.

6  Click Make Unique.

When you change the Bend Angle setting or cylinder base parameters
for one of the objects, the other doesn't change.

NOTE When you instance an object/modifier combination, all duplicates are
instances of a single  master node containing the original object and modifier.
In such cases, you cannot selectively make the object or its modifier unique.
Clicking Make Unique for one or the other, makes both unique.

Interface

Make Unique Detaches objects and modifiers (and combinations)
logically from the master node of which they're instances or references.

Go to the object or modifier level in the stack for an instanced or referenced
object or modifier (respectively), and click Make Unique.

For instanced object/modifier combinations, in the modifier stack, choose
either the modifier or the object itself.

Make Unique is unavailable when a selected object is not an instance or
reference, when it doesn't contain an instanced modifier, or when all objects
in the selection don't have an instanced modifier in common.

Making New Instances

When you click Make Unique for a selection of two or more objects, a dialog
appears that asks: Do you want to make the selected items unique with respect
to each other? This gives you a choice of how you want to make the objects
unique.

■ Yes Makes the instanced modifiers assigned to the objects in the selection
unique for each object in the selection.
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■ No All instanced modifiers assigned to the objects in the selection remain
instanced across the selected objects, but become unique from other objects
not in the selection.

Modifier Sets Menu 

Modify panel > Configure Modifier Sets button

The button sets menu gives you options for managing and customizing
shortcut buttons for applying modifiers.

Procedures

To display the current button set on the Modify panel:

■  Click Configure Modifier Sets, and then choose Show Buttons to turn
on this item.
This item is a toggle. Choosing Show Buttons a second time turns off the
button display, and so on.

To configure a new modifier set:

■  Click Configure Modifier Sets, and then choose Configure Modifier
Sets on page 7450 .

To change from one button set to another:

■ Click Configure Modifier Sets, and then choose the modifier set name
from the lower part of the menu.
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Interface

Configure Modifier Sets Displays the Configure Modifier Sets dialog on
page 7450  to let you create a new, customized button set.

Show Buttons When on, buttons for the current modifier set are displayed
between the modifier list and the stack display. Default=off.

Show All Sets in List When on, the Modifier List is organized by sets. When
off, the Modifier List is organized simply into World-Space Modifiers and
Object-Space Modifiers, and is otherwise alphabetical except that the current
set appears at the top of the list. Default=off.

Saved button sets The bottom part of the Button Sets menu lists the names
of saved button sets. Choose one of these sets to make it the current button
set. The current set is displayed as buttons when Show Buttons is on. The
Modifier List drop-down is organized by sets when Show All Sets In List is on.

Configure Modifier Sets Dialog 

Modify panel > Configure Modifier Sets button > Configure Modifier Sets

This dialog lets you create custom modifier and button sets for the Modify
panel.
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Procedures

To choose a modifier and button set to edit:

■ Choose a button set from the Sets drop-down list.

To create a new modifier and button set:

1 Create a custom button set in the Modifiers group box. You use these
controls:

■ Use Total Buttons to change the number of buttons.

■ Drag a modifier from the Modifiers list to a button.

■ Highlight a button, and then double-click a modifier in the Modifiers
list. (When you assign a button by double-clicking, the highlight
moves to the next button in the Modifiers group.)

2 Enter the new set's name in the Sets edit field.

3 Click Save.

4 Click OK to leave the Configure Modifier Sets dialog.

To customize the current modifier and button set:

1 Use Total Buttons to choose the number of buttons in the set.

2 Assign buttons by dragging the names of modifiers in the dialog's
Modifiers list to buttons in the Modifiers group box.

3 Click OK.

3ds Max updates the Modifiers list. You can customize the set without
saving it, but if you save a new set under a new name, you can use it later.
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Interface

Modifiers Lists all modifiers currently available. It's organized into these
categories: Channel Info, Max Edit, Max Standard, Deformations, Max Surface,
Surface Tools, Modifiers, Radiosity, LIGHT, Max Additional, Shell, Spline Edits,
World Space Modifiers, and others. To add a modifier to the current button
set, drag the modifier's name from this list onto a button in the Modifiers
group box.

Sets This edit field and drop-down list lets you choose the modifier set to
edit. To create a new button set, enter the name in the edit field, and then
click Save.

Save Saves the current button set.

Delete Deletes the current button set.

IMPORTANT You can't undo deleting a button set.
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Total Buttons Sets the number of buttons in the button set. A button set can
have up to 32 buttons.

Modifiers group

Previews how the button set will appear on the Modify panel. Because the
box shows only 16 buttons at a time, a scroll bar on the right lets you see any
remaining buttons.

To change a button, drag the name of a modifier from the Modifiers list to a
button in this group box, or click the button (its border highlights) and then
double-click the modifier name.

Hierarchy Panel 

Command panels > Hierarchy panel

The Hierarchy panel provides access to tools to adjust the hierarchical linkage
between objects.

By linking one object to another, you create a parent-child relationship.
Transformations applied to the parent are also transmitted to the child. By
linking more objects to both parent and child objects you can create complex
hierarchies.
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Gyroscope assembled as a hierarchy.

The parent is the outer ring with handle.

The flywheel is the lowest child.

Common uses of linking are:

■ Creating complex motions.

■ Simulating jointed structures.

■ Providing the basis for inverse kinematics.

■ Setting rotational and sliding parameters for Bones.

The Hierarchy panel is divided into three areas:

Pivot  on page 3398

IK  on page 3409

Link Info on page 3424
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NOTE For important background information on hierarchies and kinematics, see
Animating with Forward Kinematics on page 3279  and Inverse Kinematics (IK) on
page 3299 .

Motion Panel 

Select an object. > Command panels > Motion panel

The Motion panel provides tools to adjust the motion of the selected object.
Key timing and easing in and out of a key are parameters that you can adjust
with tools on the Motion panel, for example. The Motion panel also provides
an alternative to Track View for assigning animation controllers.

Additional rollouts display in the Motion panel if an assigned animation
controller has parameters. If a Path constraint is assigned to the position track
of an object, then a Path Parameters rollout is added to the Motion panel. A
Link constraint displays a Link Parameters rollout, a Position XYZ controller
displays a Position XYZ Parameters rollout, and so on.

Trajectories

Click Trajectories to chart a path that an object will travel along in the
viewports. Yellow dots along the path represent frames, giving you an idea of
velocity and easing. By turning on Sub-Object Keys, keys can be moved in
space, key properties can be changed, the trajectories will reflect all the
adjustments you make. You can also convert to and from splines and collapse
transforms using trajectories.

Interface

Parameters

Provides an alternative to Track View on page 3426  for adjusting transform
controllers and key information.

Assign Controller Rollout on page 7456

PRS Parameters Rollout on page 3050

Key Info (Basic) Rollout/Dialog on page 3052

Key Info (Advanced) Rollout/Dialog on page 3056
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Trajectories

Provides tools for working with objects' trajectories.

Trajectories on page 3045

Assign Controller Rollout

Select an object. > Motion panel > Parameters > Assign Controller rollout

The Assign Controller rollout assigns and appends different transform
controllers to individual objects. You can also assign controllers in Track View.

Animation controllers on page 3058  are plug-ins that handle all of the animation
tasks in 3ds Max. For a complete list of available animation controllers, see
Assign Controller (Track View) on page 3515 .

Procedures

Example: To assign a TCB Rotation controller:

1 Select an object.

2 On the Motion panel, click Parameters, and open the Assign Controller
rollout.

3 Highlight the Rotation track in the Assign Controller list.

4  Click the Assign Controller button, choose TCB Rotation from the
Assign Rotation Controller dialog, and then click OK to close the dialog
and accept the change.

The default Euler XYZ Rotation controller is replaced with the TCB
Rotation controller.
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Interface

Assign Controller Displays the Assign Controller dialog. If no track is
highlighted, the Assign Controller button is unavailable.

Assign Controller dialog Choose a controller from a list of available
controllers in this dialog.

Depending on the type of track you've selected, the Choose Controller dialog
displays a subset of the different types of controllers. Rotation controllers, for
example, are available only for rotation tracks.

Display Panel

Command panels > Display panel

The Display panel provides access to tools that control the display of objects
in the scene.

Use the Display panel to hide and unhide on page 7806 , freeze and unfreeze
on page 7793  objects, alter their display characteristics, speed up viewport
displays, and simplify your modeling procedures.

NOTE A target is considered part of its light or camera for purposes of hiding and
unhiding.
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Display Panel Rollouts

Display Color Rollout  on page 117

Hide By Category Rollout on page 118

Hide Rollout on page 120

Freeze Rollout on page 122

Display Properties Rollout on page 124

Link Display Rollout on page 129

Display Floater

Tools menu > Display Floater

This modeless dialog contains most of the functions on the Display panel.
You can leave the Display floater up while you work in your scene, making it
easier to change viewport displays without changing the current command
panel.

Interface

The Display floater has two panels: Hide/Freeze and Object Level.

Hide/Freeze panel

NOTE These functions are also available on the Display panel on page 7457  and
from the Display quadrant on page 7303 of the default quad menu.
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Hide group

Selected Hides the selected object(s).

Unselected Hides all visible objects except the selected ones. Use this to hide
all the objects except the one you are working on.
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By Name Lets you select the objects to hide by name.

By Hit Causes any object you click in the viewport to be hidden. If you hold
the Ctrl key while selecting an object, that object and all of its children are
hidden. To exit Hide by Hit mode, right-click, press Esc, or select a different
function. This mode is automatically turned off if you hide all objects in the
scene.

Unhide group

All Unhides all hidden objects. The unhide buttons are only available when
you have specifically hidden one or more objects. They won't unhide objects
hidden by category.

By Name Displays a dialog in which you can unhide objects you select from
a list.

NOTE You cannot unhide objects on a hidden layer. If you select an object on a
hidden layer, you will be prompted to unhide the object's layer.

Freeze group

Selected Freezes the selected object(s) so they cannot move in the viewport.

Unselected Freezes all visible objects except the selected ones. Use this to
quickly freeze all the objects except the one you're working on.

By Name Lets you select the objects to freeze by name.

By Hit Causes any object you click in the viewport to be frozen. If you hold
the Ctrl key while selecting an object, that object and all of its children are
frozen. To exit Freeze By Hit mode, right-click, press Esc, or choose a different
function. This mode is automatically turned off if you freeze all objects in the
scene.

Unfreeze group

All Unfreezes all frozen objects.

By Name Displays a dialog in which you can unfreeze objects you select
from a list.

By Hit Causes any object you click in the viewport to be unfrozen. If you
hold the Ctrl key while selecting an object, that object and all of its children
are unfrozen.
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NOTE You cannot unfreeze objects on a frozen layer. If you select an object on a
frozen layer, you will be prompted to unfreeze the object's layer.

Hide Frozen Objects Toggles display of frozen objects on and off. You don’t
have to unfreeze objects to hide them; you can use Hide Frozen Objects instead
to hide or unhide frozen objects in a single step.

Object Level panel

Hide by Category group

Toggles the display of objects by their category (objects, cameras, lights, and
so on). Choose the check boxes to hide objects of that category. Use the All,
None, and Invert buttons to change the settings of the check boxes.
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NOTE These functions are also available on the Display panel on page 7457 .

Display Properties group

Provides controls that alter the display of selected objects.

NOTE These options are also available on the Display panel on page 7457  and in
the Display Properties group on page 249  of the Object Properties dialog.

Display as Box Toggles the display of selected objects, including 3D objects,
2D shapes, and particle systems, as bounding boxes on page 7736 . Produces
minimum geometric complexity.

Particle systems appear as bounding boxes when adaptive degradation takes
effect. Since particle systems naturally exist in world space, their bounding
box is always oriented parallel to the world planes.

Backface Cull Toggles the display of faces with normals on page 7863  pointing
away from view. When selected, you see through the wireframe to the back
faces.

Edges Only Toggles the display of hidden edges and polygon diagonals on
page 7757 . When on, only outside edges appear. When off, all mesh geometry
appears. Applies to Wireframe viewport display mode, as well as other modes
with Edged Faces turned on.

Vertex Ticks Displays the vertices in the selected geometry as tick marks.

If the current selection has no displayed tick marks, the check box is clear. If
some of the vertices in the current selection display tick marks, the check box
contains a gray X. If all vertices in the current selection display tick marks,
the check box contains a black X.

Trajectory Toggles trajectory display on page 7955  for the selected object so
you can display its trajectory wherever you are in the software.

See-Through When on, makes the object or selection translucent in
viewports. This setting has no effect on rendering: it simply lets you see what’s
behind or inside an object in a crowded scene, and especially to adjust the
position of objects behind or inside the see-through object. Use this when
you need to see inside an object, such as a character with bones inside.
Default=off.

You can customize the color of see-through objects by using the Colors panel
on page 7505  of the Customize > Customize User Interface dialog on page 7489
. Choose Geometry from the Elements list, and then choose See-Through.
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Keyboard shortcut (default): Alt+X

Ignore Extents Allows an object to be excluded from a zoom extents
operation. Choose this when you have lights or other distant objects that you
don’t want to use when you do a Zoom Extents on page 7387 .

Show Frozen in Gray When on, the object turns gray in viewports when
you freeze it. When off, viewports display the object with its usual color or
texture even when it is frozen. Default=on.

 Never Degrade When on, the object is not subject to adaptive
degradation on page 7704 .

Utilities Panel 

Command panels > Utilities panel

The Utilities panel gives you access to a variety of utility programs. 3ds Max
utilities are provided as plug-ins on page 7896 . 3ds Max ships with the utilities
listed below. Some utilities are available from third-party developers, so your
setup of 3ds Max might include utilities not described here. Look for
documentation describing these additional plug-ins by choosing Help >
Additional Help.

NOTE Documentation for MAXScript and Visual MAXScript is provided in a
separate help system. To access the MAXScript Reference, choose Help > MAXScript
Reference. See About MAXScript on page 14 .

See also:

■ List of Available Utilities on page 7249
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Interface

The Utilities panel contains one rollout for managing and invoking utilities.
While a utility is running, additional rollouts can appear. Some utilities use
a dialog rather than rollouts.

The Utilities rollout contains the following controls at the top:

More Displays a Utilities dialog that lists all utilities not already displayed
in buttons on the Utilities panel. Highlight a utility in the list and then click
OK to display its controls in the Utilities panel. (You can also double-click the
utility's name.)

Sets Displays a list of button sets to choose from. By default, there is only
one button set, called MAX Default. You can create custom button sets by
clicking Configure Button Sets.

Configure Button Sets Displays the Configure Button Sets dialog on page
7465 , where you can create custom button sets of up to 32 buttons.

Named utility buttons These buttons show a selection of utilities. Click one
of these buttons to run a utility. The utility's parameters can appear in rollouts
below the Utilities rollout. Some utilities use a dialog rather than rollouts.

While a utility is running, its button remains active until you click it again to
turn it off and close the utility, or when you click a different utility's button.

Many utilities have a Close button that appears at the bottom of their rollout.
This is another way to close a utility. If the utility controls appear in a dialog
rather than a rollout, closing the dialog closes the utility.
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Utilities Dialog

Utilities panel > Utilities rollout > More... button

This dialog lists all utilities that are not already displayed in current button
set of the Utility rollout.

Procedures

To run a utility shown in the Utilities dialog, do one of the following:

1 Choose a utility in the list and then click OK.

2 Double-click the utility's name.

Interface

Configure Button Sets Dialog 

Utilities panel > Utilities rollout > Configure Button Sets button
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This dialog lets you create custom button sets for the Utilities panel. Once
created, these utility sets are available from the Sets button on the Utilities
panel.

Procedures

To customize the current button set:

1 Use Total Buttons to choose the number of buttons in the set.

2 Assign buttons by dragging the names of utilities in the Utilities list to
buttons in the Utilities group box.

3 Clear buttons by dragging them to the Utilities list on the left.

4 Click OK.

3ds Max updates the Utilities rollout. You can customize the button set
without saving it, but if you save a new button set under a new name,
you will be able to use it later.

TIP Don't alter the Default button set. Create a new one instead.

To create a new button set:

1 Create a custom button set as described in the previous procedure.

2 Enter a new button set name in the Sets edit field.

3 Click Save.

To choose a button set to modify:

■ Choose a button set from the Sets drop-down list.
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Interface

Utilities List This lists all the utilities currently available to 3ds Max. It is
organized into a number of categories, including MAX STANDARD, Channel
Info, NURBS, Radiosity, Skin Tools, Strokes, MAXScript Tools, Internet
Extensions, Realviz Products, and reactor. To add a utility to the current button
set, drag the utility's name from this list to the Utilities group box.

Sets edit field and drop-down list Lets you choose the button set to modify.
By default, there is a single button set called MAX Default.

TIP Don't alter the Default button set. Create new sets as the need arises.

Save Saves the current button set.

Delete Deletes the current button set.

WARNING You can't undo the deletion of a button set.

Total Buttons Sets the number of buttons in the button set. A button set can
have up to 32 buttons.
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Utilities group

This group previews how the button set will appear in the Utilities rollout. A
scroll bar on the right lets you see other buttons when the set has more than
eight.

To change a button, drag the name of a utility from the Utilities list to a button
in this group.

MAXScript Interface
Menu bar > MAXScript

Utilities panel > MAXScript

MAXScript on page 14  is the software's built-in scripting language. Its main
interface, the MAXScript menu, contains the following commands for creating
and working with scripts:

New Script on page 7468

Open Script on page 7469

Run Script on page 7469

MAXScript Listener on page 7469

Macro Recorder on page 7470

Visual MAXScript Editor on page 7471

MAXScript Debugger Dialog on page 7472

In addition, the status bar on page 7308  contains a MAXScript Mini Listener
on page 7309 , and MAXScript functionality is also available from the Utilities
panel on page 7463 .

For detailed information about MAXScript, open the MAXScript Reference,
available from Help menu > MAXScript Reference.

New Script

MAXScript menu > New Script

Utilities panel > Click MAXScript. > MAXScript rollout > New Script
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New Script opens a new MAXScript Editor window. Use this window for writing
a new script.

For detailed information about the MAXScript utility, open the MAXScript
Reference, available from Help menu > MAXScript Reference.

Open Script

MAXScript menu > Open Script

Utilities panel > Click MAXScript. > MAXScript rollout > Open Script

Open Script opens a common file open dialog for choosing an existing script.
A new MAXScript Editor window then displays the selected script.

For detailed information about the MAXScript utility, open the MAXScript
Reference, available from Help menu > MAXScript Reference.

Run Script

MAXScript menu > Run Script

Utilities panel > Click MAXScript. > MAXScript rollout > Run Script

Run Script opens a common file open dialog for choosing an existing script.
MAXScript then reads and executes the selected script. Any output is printed
to the Listener window.

For detailed information about the MAXScript utility, open the MAXScript
Reference, available from Help menu > MAXScript Reference.

MAXScript Listener

MAXScript menu > MAXScript Listener

Mini Listener > Right-click menu > Open Listener Window

Utilities panel > Click MAXScript. > MAXScript rollout > Open Listener

Keyboard > F11

The MAXScript Listener window is an interactive interpreter for the MAXScript
language and works similar to a DOS command prompt window. You enter
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MAXScript commands in this window, and when you press Enter they are
executed immediately.

The Listener window is appropriate for performing interactive work and
developing small code fragments. Each command you execute in the Listener
is actually an expression with a result that the Listener prints out after each
execution. You can enter any MAXScript expression or sub-expression in the
Listener for evaluation, and the Listener prints out its result.

The Listener is divided into two panes. The top (pink) pane is the Macro
Recorder pane, and the bottom (white) pane is the output pane. When the
Macro Recorder is enabled, everything recorded is displayed in the Macro
Recorder pane. The output of results from scripts are displayed in the output
pane. The output of code executed in the Macro Recorder pane is always
directed to the output pane so as not to clutter the recordings. Both panes
allow you to cut-and-paste, drag-and-drop, edit, select, and execute code. You
can resize the panes by dragging the split bar between them.

The left-end of the status bar contains a resizable Mini Listener. If the Mini
Listener is not visible, drag on the vertical split bar at the left end of the status
bar to reveal the Mini Listener. The Mini Listener panes act as single-line
sliding windows for the current line in the corresponding Listener panes. The
Mini Listener panes always show what you are typing or where the edit cursor
is placed in the Listener panes. Conversely, anything you type into a Mini
Listener pane is entered into the corresponding Listener pane at the current
edit cursor position.

The MAXScript Mini Listener on the
Status Bar

You can install the Listener into any viewport by right-clicking the viewport
label, choose Views > Extended, and then MAXScript Listener.

For detailed information about the MAXScript utility, open the MAXScript
Reference, available from Help menu > MAXScript Reference.

Macro Recorder

MAXScript menu > Macro Recorder
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The MAXScript Macro Recorder captures many of the actions performed by
the user, and generates the MAXScript commands that correspond to those
actions. Output from Macro Recorder is displayed in the Macro Recorder pane
of the MAXScript Listener window. Several filtering options are available that
control what types of user actions are recorded, whether the generated
MAXScript commands contain explicit object references or are
selection-relative, and whether the generated MAXScript commands contain
absolute or relative transforms and coordinates. These options are set using
the MacroRecorder menu in the Listener window. The default option settings
are specified in the MAXScript page of the 3ds Max Preferences dialog, as
described in MAXScript Preferences on page 7574 . You can also make and
change these settings by editing the [MAXScript] section of the 3dsmax.ini
on page 51  file.

While many areas in the software generate Macro Recorder output, there are
also many areas that do not. In general, most of the buttons on the software’s
menu bar, toolbars, status bar, Create panel, and Modify panel will generate
Macro Recorder output. If the button invokes a secondary dialog, changing
settings or performing actions in the secondary dialog typically do not generate
Macro Recorder output. In the Create and Modify panels, Macro Recorder
output is typically generated if the object or modifier can be created by
MAXScript. In rare cases, the plug-ins implementing an object or modifier
have not been updated to support Macro Recorder, so that object or modifier
does not generate Macro Recorder output.

MAXScript supports text drag-and-drop onto toolbars to create Macro Script
buttons. You can select and drag text from any text window, such as the
Listener window panes or Editor window, onto any visible toolbar. The cursor
changes to an arrow with a + sign when it is permissible to drop the text.
Dropping it at that point adds a Macro Script button to the toolbar with the
dropped text as the body of the Macro Script. A typical usage of this would
be to drag text from the Macro Recorder pane onto a toolbar to make a button
that does the sequence of events just recorded.

For detailed information about the MAXScript utility, consult the MAXScript
Reference, available from Help menu > MAXScript Reference.

Visual MAXScript Utility (See MAXScript
Reference)

Utilities panel > Utilities rollout > More button > Visual MAXScript
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Visual MAXScript is a powerful interface to the 3ds Max scripting language,
making the MAXScript feature easier to learn and use. With Visual MAXScript,
you can quickly create UI elements and layouts for scripting.

For detailed information about Visual MAXScript, open the MAXScript Reference,
available from Help menu > MAXScript Reference.

MAXScript Debugger Dialog

MAXScript menu > Debugger Dialog

MAXScript Listener > Debugger menu > Debugger Dialog

MAXScript Editor > Debugger menu > Debugger Dialog

The MAXScript debugger implements the first half of a script development
and debugging environment. It allows the main thread of 3ds Max to be
suspended, the values of global and local variables to be examined and altered
while the thread is not running, MAXScript commands to be executed from
a command line, and the execution to be suspended using method calls from
inside the MAXScript code. The debugger also lets you stop or continue the
execution of the suspended code.

For detailed information about the MAXScript debugger, consult the MAXScript
Reference, available from Help menu > MAXScript Reference.

Running Scripts from the Command Line

3ds Max allows you to enter MAXScript commands directly on the command
line. When you launch 3ds Max from a DOS command line, you can have it
run a specified launch script. This can be useful for tasks such as unattended
batch-rendering. This capability uses the existing -U command line switch
that names a utility to be run when 3ds Max is started. The -U switch allows
an optional extra argument which, for MAXScript, is taken to be the name of
the launch script to run. The case (capitalization) of MAXScript must be as
shown in the following example (entered after you CD to the program
directory):

See the online User Reference to view this code sample.

This example command line would launch the 3ds Max executable , start
MAXScript, and then have it run the launch script rendercams.ms.
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The following example launch script loads two scenes, renders frames from
each of the cameras in them, and then quits 3ds Max:

See the online User Reference to view this code sample.

This example makes use of the quitMax() method to exit 3ds Max when the
script is finished. Launch scripts need not be batch scripts as in this example,
but may be used to condition 3ds Max for interactive use, for example by
loading a scene file and setting some user-interface options.

The normal startup scripts, startup.ms and those in the \scripts\startup directory,
are run before the launch script. It is also possible to install scripts into
individual scene files that run automatically when that scene is open or closed
or at certain other events.

NOTE Command line -U MAXScript startup scripts are run after  3ds Max has
completely booted and the standard scripts and startup scripts have been run.

MAXScript Command-Line Switches

The following switches work specifically with MAXScript files and functions.

EffectSwitch

Starts 3ds Max in a minimized mode –
but never allows you to open the win-
dow for interactive usage.

-mip

This switch is essentially the same as -U
MAXScript file.ms, but avoids the need

-mxs

for the .ms file. You can follow the
switch with MAXScript commands.

Comparable to the MAXScript com-
mand, setSilentMode, this switch sup-

-silent

presses all MAXScript and 3ds Max UI
dialogs so that batch scripts specified
by the –U command do not get inter-
rupted.

Opens a specified MAXScript file.-u
MAXScript
<filename>
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Examples of desired syntax usage:

See the online User Reference to view these code samples
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Customizing the User
Interface

You can rearrange the components of the 3ds Max user interface, including the menu bar,
toolbars, and command panel. You can also dynamically resize the viewport windows. You
can specify which toolbars should appear and which should be hidden, and create your own
keyboard shortcuts, custom toolbars, and quad menus. You can also customize the colors
used in the User Interface.

For procedures that tell how to rearrange and resize UI components, see Useful Customization
Techniques on page 7475 . Various other customization options are available from the Customize
menu on page 7279 .

See also:

■ Customize Display Right-Click Menu on page 7479

■ Customize User Interface Dialog on page 7489

■ Saving and Loading Custom User Interfaces on page 7513

■ Revert to Startup Layout on page 7519

■ Configure Paths on page 7519

■ Preferences on page 7534

Useful Customization Techniques
This topic offers a number of procedures for customizing the 3ds Max user
interface, including methods for rearranging and resizing UI components.
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Various other customization options are available from the Customize menu
on page 7279 .

Procedures

To switch between a single-viewport and multi-viewport layout:

1  By default, 3ds Max starts with a multi-viewport. To switch to a
single-viewport layout, activate a viewport and click the Min/Max Toggle
on page 7382 .

2  By default, 3ds Max starts with a single viewport. To switch to a
multi-viewport layout, click the Min/Max Toggle on page 7382 .

To resize the windows in a multi-viewport layout:

■ With your cursor, click the splitter bar between any two viewports, or at
the intersection of all four viewports, and drag to a new location. When
you release the mouse, the new viewport layout is defined.
The dividers are saved in the scene, but are reset when you change the
layout. This feature does not allow you to define new layouts, only to
adjust the proportions of the currently existing ones.

To reset the viewport windows to the default layout:

1 Right-click the splitter bar between the viewports.

The Reset Layout button is displayed.

2 Click this button to restore the viewports to the default multi-viewport
layout.

To rearrange the order of rollouts in the command panel:

■ Click the rollout title bar, and drag to another location on the command
panel. A thick line indicates where the rollout will be placed. When you
release the mouse button, the rollout is moved to the indicated location,
and the other rollouts are shifted appropriately.
The order of rollouts is saved in the text file rolluporder.cfg, which is located
in the \ui subdirectory.
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To float a toolbar, do one of the following:

1 Click a docked toolbar's tag bar (a narrow line displayed when the toolbar
is docked) and drag it away from its location. The toolbar is now floating;
you can reposition, resize, or dock it.

2 Right-click a docked toolbar's tag bar (a narrow line displayed when the
toolbar is docked), and then choose Float.

To float the command panel, do one of the following:

1 Right-click the blank area at the upper-right corner of the command
panel, and then choose Float.

2 Click a corner of the upper portion of the command panel and drag it
into the viewport.

TIP Use Lock UI Layout on page 7481  if you find you tend to float the
command panel accidentally.

To resize the docked command panel horizontally:

■ Move the cursor over the edge of the docked command panel that is nearest
the viewports. The cursor changes to a double arrow. Drag the cursor to
increase or decrease the width of the command panel.
The command panel grows or shrinks in column increments. Unless the
command panel is hidden, there is always at least one column. When the
command panel is docked, the columns must fit within the main 3ds Max
window.
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Multiple command panels are useful when working with objects such as particle
systems, which have many controls.

To resize the floating command panel horizontally:

■ Move the cursor over the left or right edge of the floating command panel.
The cursor changes to a double arrow. Drag the cursor to increase or
decrease the width of the command panel.
The command panel grows or shrinks in column increments. Unless the
command panel is hidden, there is always at least one column. When the
command panel is floating, you can display as many columns as you want.

To resize the floating command panel vertically:

■ Move the cursor over the top or bottom edge of the floating command
panel. The cursor changes to a double arrow. Drag the cursor to increase
or decrease the height of the command panel as you do for other windows
on the desktop.
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To dock a floating UI element, do one of the following:

1 Drag the panel by its title bar to the top, bottom, left, or right edge of
the program window. The mouse cursor and the panel outline change
shape at a docking location. Release the mouse.

2 Right-click the title bar, choose Dock from the pop-up menu, and then
choose Top, Bottom, Left, or Right.

3 Double-click the handle or title bar.

A UI element docks automatically when it approaches a "dockable"
location. The toolbars and menu bar can dock at the top or bottom, left
or right of the viewports. They can also dock on either side of the
Command panel.

To hide a panel or toolbar, do one of the following:

■ When a panel or toolbar is floating, you can hide it by clicking the X
control in the upper-right corner.

Customize Display Right-Click Menu
The Customize Display right-click menu displays when you right-click over a
blank area of a toolbar (not when the cursor is over a button). It is also available
when the cursor is immediately above, below, or to the right of the command
panel tabs: in these locations, the cursor changes to look like a stack of two
sheets of paper. In addition, the menu displays when you right-click at the
right edge of the command panel when docked, or, when floating, at the right
or left edge.

Use this menu to turn on and off the display of various user interface elements,
customize the display of toolbars, and dock or float items such as the command
panel.

Interface

The following options are displayed in all cases:

Customize Displays the Customize User Interface dialog on page 7489 , which
lets add commands and macro scripts to new and existing toolbars.

Command Panel Toggles the command panel display. By default, this is
displayed.
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Main Toolbar Toggles the main toolbar on page 7284 . By default, this is
displayed.

Axis Constraints Toggles the Axis Constraints toolbar on page 7288 . By default,
this toolbar is not displayed.

Layers Toggles the Layers toolbar on page 7289 . By default, this is not
displayed.

Reactor Toggles the reactor toolbar on page 7290 . By default, this is displayed.

Extras Toggles the Extras toolbar on page 7290 . By default, this is not
displayed.

Render Shortcuts Toggles the Render Shortcuts toolbar on page 7291 . By
default, this is not displayed.

Snaps Toggles the Snaps toolbar on page 7292 . By default, this is not displayed.

Additional Options: Docking and Floating

Depending on the cursor location when you right-click, the menu can also
display these options:

Dock Docks the active item to the specified location: Top, Bottom, Left, or
Right.

NOTE For more information on docking toolbars, see Customizing the User
Interface on page 7475 .

Float Floats the active item.

NOTE This is available only for docked items.

Show UI
Customize menu > Show UI

The Show UI submenu lets you add or remove UI (user interface) elements
from the workspace, so that you can customize your screen as you work. You
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can turn these elements on and off as you need by selecting them from the
menu, maximizing the efficiency of your workspace. The settings are stored
in the maxstart.cui  file, so they will remain after you shut down and restart
3ds Max.

When you choose a UI element from the Show UI submenu, it will be displayed
or hidden, depending on its previous state. If it was hidden when you selected
it from the menu, it will be displayed. If it was displayed when you selected
it from the menu, it will be hidden. The Show UI menu displays a check mark
next to the UI element when it is currently being displayed.

Keyboard shortcuts for turning on and off UI elements are displayed next to
their corresponding UI elements in the Show UI menu.

You can use the Show UI menu to hide or display the following UI elements:

Command Panel on page 7422

Floating Toolbars (displays Constraints Toolbar on page 7288 , Layers Toolbar
on page 7289 , and Extras Toolbar on page 7290 )

Main Toolbar on page 7284

Track Bar on page 7315

Lock UI Layout
Customize menu > Lock UI Layout

When the Lock UI Layout toggle is active, you cannot modify the user interface
layout by dragging interface elements. (You can still use the right-click menu
to do so, however.) Use this command to prevent user interface changes or
inadvertent actions, such as floating toolbars, from happening due to mouse
clicks.

TIP Use this command if you find you are inadvertently selecting and floating on
page 7761  UI elements such as the Command panel.

Procedures

To lock the UI layout:

■ Choose Lock UI Layout from the Customize menu.
You can no longer move or resize the UI elements. Use this command to
prevent user interface changes or if you find yourself accidentally floating
toolbars or the command panels on mouse clicks.
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Plug-In Manager
Customize menu > Plug-in Manager

The Plug-in Manager lets you manage plug-ins dynamically without any
initialization required. The Plug-in Manager provides a list of all plug-ins found
in the 3ds Max plug-in directories, including the plug-in description, type
(object, helper, modifier, and so on), status (loaded or deferred), size, and
path. The Plug-in Manager provides options to load any plug-in, regardless
where it resides on disk. The Plug-in Manager is similar to Summary Info on
page 6919 , but with more options.

See also:

■ 3rd Party Plug-Ins Path Configuration on page 7532

Interface

When you start the Plug-in Manager, it scans through all the plug-in paths
specified in the plugin.ini file and lists them in the Plug-in Manager dialog.
The information is divided up into columns as described below.

Tag Use the right-click menu and select Tag Selected to add a check mark
for selected plug-ins. Tagging plug-ins lets you perform right-click menu actions
on them. Thus you can tag multiple plug-ins and perform a single operation
on all of them.

Name The filename of the plug-in.
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Description A description of the plug-in.

Status Indicates whether the plug-in is loaded (green) or deferred (yellow).

Size File size of the plug-in.

Full Path The disk location of the plug-in file.

Plug-in Directories

These are the plug-in directories listed in plugin.ini. You can also configure
these paths via the 3rd Party Plug-Ins panel on page 7532  of the Configure User
Paths dialog. You can display or hide all the plug-ins in a directory by toggling
the check box.

Description Shows directory description from plugin.ini file.

Load Path The path of the plug-in directory.

Right-Click Menu

The right-click menu for the Plug-in Manager works in the list of plug-ins,
and in the blank area beneath the list. It does not work in the list of plug-in
directories. The commands apply to two possible states for the listed plug-ins:
selected (that is, highlighted) and tagged (a check mark appears to the left of
the plug-in's name).

Selected Plug-ins To load plug-ins, highlight one or more plug-ins, choose
this item, and then choose Load.

Clear Selection Removes highlighting from all items in the list.

Tagged Plug-ins To load tagged plug-ins, choose this item, and then choose
Load.

Tag Selected Tags all highlighted plug-ins.

Clear Tags Clears all tags.

Load New Plug-in Loads a plug-in from the hard drive. Use the file dialog
to locate the plug-in, and then click Open.

Refresh View Refreshes the list of plug-ins.

Custom UI and Defaults Switcher
Customize menu > Custom UI and Defaults Switcher
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Artists and designers in different industries use 3ds Max in different ways. The
Custom UI and Defaults Switcher lets you quickly change your program
defaults and UI scheme to more closely match the type of work you are doing.

The Initial settings for tool options control the default settings for various features
in 3ds Max, while the UI Schemes control how the 3ds Max interface will
look.

The dialog displays a detailed explanation for each of the four default sets and
two  UI Schemes that ship with 3ds Max. If you create your own defaults or
UI Scheme, they will also appear in the list, however you cannot edit the
general description of custom default sets or UI schemes.

See also:

■ Market-Specific Defaults on page 7486
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Interface

Initial settings for tool options This list contains different sets of default
settings for various tools in 3ds Max. Highlight the set that corresponds to
the tools you are using.

3ds Max ships with four default sets:

■ Max contains the set of default settings for general animation use without
the mental ray renderer on page 6039 .

■ Max.mentalray contains the set for general animation use with the mental
ray renderer.

■ DesignVIZ contains the set for design visualization use without the mental
ray renderer.
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■ DesignVIZ.mentalray contains the set for design visualization use with the
mental ray renderer.

Highlight any of these sets to see detailed explanations of the affected settings.

For information on creating or editing defaults sets, see Market-Specific
Defaults on page 7486 .

NOTE You must restart 3ds Max before new defaults are applied.

UI Schemes This list contains all of the UI schemes defined in the \UI folder.
3ds Max ships with two UI schemes: DefaultUI , and ModularToolbarsUI, which
has the main toolbar on page 7284  broken up into smaller toolbars. Highlight
the name of the UI scheme in the list to see a description (and image) of the
interface.

This list also contains any UI schemes you have saved with the Save Custom
UI Scheme dialog on page 7516 . However, no description or image is displayed
for these schemes.

Set Applies the selected default settings and UI scheme to 3ds Max.

NOTE You must restart 3ds Max before your defaults are applied.

Cancel Closes the dialog without applying any changes.

Market-Specific Defaults
3ds Max is used in many different professional markets, including film, design
visualization, and games. The workflow and performance requirements for
users from these markets vary tremendously. As a result, different default
settings are ideal for different types of scenes.

For example, a typical animation scene has a small number of lights; shadow
maps on page 7927  provide a fast, accurate solution to generating shadows. On
the other hand, a typical design visualization scene can contain hundreds of
lights, in which case shadow maps will cause memory issues. For this type of
scene, ray-traced shadows on page 7907  are much more appropriate.

In order to provide an efficient working environment for both project types,
3ds Max offers four sets of market-specific defaults, tailored specifically for
general animation scenes and for design visualization projects (both with and
without the use of the mental ray renderer on page 6039 ). The sets are each
located in their own sub-directories of the \defaults directory. These
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sub-directories each contain an INI file (currentdefaults.ini), which contains the
global parameter defaults, a default material library (medit.mat), which
populates the Material Editor at startup, and a startup file (maxstart.max),
which is the file that opens when 3ds Max is started or when you reset. You
can edit any of these files, and you can also create your own sets, however
each set must be in a separate sub-directory of \defaults. in addition, each file
in the directory should have the same names (currentdefaults.ini, medit.mat, and
maxstart.max). If one of these files is not present in a custom defaults directory
that you have created, 3ds Max uses the corresponding file from the
\defaults\max directory in its place.

NOTE For your protection, both of the preset default directories have a
sub-directory named \factorydefaults , which contains the original files for each
set. These can be used in the event that you have changed your defaults and are
unhappy with the results. They are also a useful starting point for creating your
own set; copy them to a new directory and edit them. It is highly recommended
that you do not edit  the files in the \factorydefaults  directories.

Default sets are assigned through the Custom UI and Defaults Switcher on
page 7483 .

Procedures

To change the current set of defaults:

1 Choose Customize menu > Customize UI And Defaults Switcher.

2 Select one of the default sets from the Initial settings for tool options list and
click Set.

3 Restart 3ds Max to load the new default parameters.

Interface

The following files should be included in your default directory. If one or
more of these files is not present in the current Default directory, 3ds Max
will use the corresponding file from \defaults\max in its place.

currentdefaults.ini

The following table describes all of the sections that can be set in a default
INI file. Any parameter with a blank or invalid value will use the hard coded
default.
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NOTE See the online User Reference  to view this table.

medit.mat

medit.mat is the default material library in your scene.

maxstart.max

The maxstart.max file is loaded when you start or reset 3ds Max.

COM/DCOM Server Control Utility
Utilities panel > Utilities rollout > More button > COM/DCOM Server Control

The COM/DCOM Server Control utility supports plug-ins and third-party
programs that use the COM (Component Object Model). The idea behind the
COM is to expose the core of 3ds Max so applications can invoke 3ds Max to
generate images.

The COM facility is intended for application developers. For more information
about applications development with 3ds Max, see the description of the COM
object interface in the help file (sdk.chm) for the 3ds Max Plug-In Software
Development Kit (SDK).

Procedures

To register 3ds Max as a DCOM server:

1 Start 3ds Max and go the Utilities panel. Click More, choose COM/DCOM
Server Control, and then click OK.

2 If the button in the COM/DCOM Server Control rollout says Register,
then click it. If it says Unregister, then do nothing, as 3ds Max is already
registered.

Now 3ds Max is registered as a DCOM server and an instance of it can
be created from any COM client.

NOTE Not all products include this utility. You can build it from the source
located in \maxsdk\samples\utility\comsrv\ . Copy the resulting comsrvui.dlu
to the 3ds Max \plugins  directory.
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It is also possible to register and unregister from the command line. There are
two command-line options that can be passed to 3ds Max:

3DSMAX -RegisterMAXRenderer

3DSMAX -UnregisterMAXRenderer

Customize User Interface Dialog
Customize menu > Customize User Interface

The Customize User Interface dialog lets you create an entirely customized
user interface, including shortcuts, quad menus, menus, toolbars, and colors.
You can also add commands and macro scripts by selecting either a text or
icon button to represent the command or script on the toolbar.

Most commands in the 3ds Max user interface appear in this dialog as action
items. An action item is simply a command that you can assign to a keyboard
shortcut, toolbar, quad menu, or menu. The Keyboard, Toolbars, Quads, and
Menus panels of this dialog show tables of action items that you can assign.
(Tables in the Colors panel list UI elements, instead.)

NOTE A few action items don't correspond to any elements in the default user
interface. See Additional Keyboard Commands on page 7251 .

Keyboard Panel on page 7489

Toolbars Panel on page 7492

Quads Panel on page 7496

Menus Panel on page 7501

Colors Panel on page 7505

See also:

■ Customizing the User Interface on page 7475

■ Saving and Loading Custom User Interfaces on page 7513

Keyboard Panel

Customize menu > Customize User Interface > Keyboard tab
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The Keyboard panel lets you create your own keyboard shortcuts. You can
assign shortcuts to most commands available in the software.

The same shortcuts can be assigned to multiple commands, as long as they
occur in different contexts. For example, in Video Post, Ctrl+S is assigned to
Add Scene Event; however, in the Main UI, it is assigned to Save File.

When you use a keyboard shortcut, the software looks for a context-specific
shortcut first, and if none is found it looks for the appropriate command in
the Main UI shortcuts.

The Keyboard Shortcut Override toggle on page 7646  must be turned on (the
default) for the context-specific shortcuts to work properly. If it is turned off,
only the Main UI keyboard shortcuts will be available.

See also:

■ Keyboard Shortcuts on page 7645

Procedures

To create a keyboard shortcut:

1 Choose Customize menu > Customize User Interface > Keyboard panel.

2 Use the Group and Category lists to find the action for which you want
to create a shortcut.

3 Click action in the Action list to highlight it.

4 In the Hotkey field, enter the keyboard shortcut you want to assign to
the action.

NOTE If the keyboard shortcut you enter is already assigned to an action,
that action's name will appear in the Assigned To field.

5 Click Assign.
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Interface

Group Displays a drop-down list that lets you select the context you want
to customize, such as Main UI, Track View, Material Editor, and so on.

Active Toggles availability of context-specific keyboard shortcuts. When this
is turned on, you can use duplicate shortcut keys between contexts within
the overall user interface. For example, A can be the shortcut for Angle Snap
toggle within the Main UI, and also a shortcut for Assign Material to Selection
when you are working in the Material Editor. When this is turned off, the
shortcuts defined for the appropriate context will not be available. Default=on.

Category Displays a drop-down list of all the available categories of user
interface actions for the selected context.

Action list Displays all the available actions and shortcuts, if defined, for the
selected group (context) and category.
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Hotkey Allows you to enter a keyboard shortcut. Once the shortcut is entered,
the Assign Button is active.

Assigned To Displays the action a shortcut is assigned to if the shortcut
you've entered is already assigned.

Assign Activates when you enter a keyboard shortcut in the Hotkey field.
When you click Assign, it transfers the shortcut information to the Action list
on the left side of the dialog.

Remove Removes all shortcuts for the selected action in the Action list on
the left side of the dialog.

Write Keyboard Chart Displays the Save File As dialog. Allows you to save
any changes you’ve made to keyboard shortcuts to a TXT file that you can
print.

Overrides Active When on, holding keys for boldface shortcuts in
the Edit Poly and Editable Poly groups overrides standard functionality. For
example, while editing an Editable Poly object at the Polygon sub-object level,
pressing and holding Shift+Ctrl+B activates the Bevel tool temporarily,
overriding the current operation.

Delay To Override The delay before which the active keyboard shortcut
overrides the current operation (see Overrides Active, preceding).

Load Displays the Load Shortcut File dialog. Allows you to load custom
shortcuts, from a KBD file into your scene.

Save Displays the Save Shortcut File As dialog. Allows you to save any changes
you’ve made to the shortcuts to a KBD file.

Reset Resets any changes you’ve made to the shortcuts to the default setup
(defaultui.kbd).

Toolbars Panel

Customize menu > Customize User Interface > Toolbars tab

The Toolbars panel lets you edit existing toolbars and create your own custom
toolbars. You can add, remove, and edit buttons on existing toolbars, or you
can delete the toolbars entirely. You can also create custom toolbars with both
3ds Max commands and scripts.
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Procedures

To create and populate a toolbar:

1 Choose Customize menu > Customize User Interface > Toolbars tab.

2 Click New.

The New Toolbar dialog appears.

3 Enter the name of the toolbar and click OK.

The new toolbar appears as a small floater. Like any floating toolbar, you
can resize it and change proportions by dragging the corners and edges.

4 Use any of these three methods to add commands to the toolbar:

■ Drag a command to the toolbar from the Customize User Interface
dialog > Action list. If the action has a default icon assigned to it (it
will appear next to the command in the action list), the icon will
appear as a button on your toolbar. If no icon is assigned to the
command, the name of the command will appear as a button on the
toolbar.

■ To copy an existing button, Ctrl+drag the button from any toolbar
onto your toolbar.

■ To move an existing button, Alt+drag the button from any toolbar
onto your toolbar.

5 If you don’t want the new toolbar to appear in the interface by default,
choose it from the drop-down list on the right side of the Customize User
Interface dialog, and then turn on the Hide check box. Thereafter you
can toggle the custom toolbar by right-clicking a blank area of any toolbar
and choosing the toolbar name from the context menu.

To add commands to a toolbar:

1 Choose Customize menu > Customize User Interface > Toolbars panel.

Alternatively, right-click the label of a toolbar and then choose Customize.

2 If necessary, open the toolbar to customize using either of the following
methods:

■ Right-click a blank area of any toolbar and choose the toolbar name
from the context menu.

■ Choose the toolbar name from the toolbars drop-down list on the
right side of the dialog and then turn off the Hide check box.
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3 Use any of these three methods to add commands to the toolbar:

■ Drag a command to the toolbar from the Customize User Interface
dialog > Action list. If the action has a default icon assigned to it (it
will appear next to the command in the action list), the icon will
appear as a button on your toolbar. If no icon is assigned to the
command, the name of the command will appear as a button on the
toolbar.

■ To copy an existing button, Ctrl+drag the button from any toolbar
onto your toolbar.

■ To move an existing button, Alt+drag the button from any toolbar
onto your toolbar.

To record a script and add it to a toolbar:

Use this method to record a series of commands into a MAXScript command
sequence and then turn the script into a toolbar button to re-invoke that
sequence at any time. No scripting knowledge is necessary.

1 Choose Customize menu > Customize User Interface > Toolbars panel.

Alternatively, right-click the label of a toolbar and then choose Customize.

2 Open a MAXScript Listener window by any of the following methods:

■ Press F11.

■ Choose MAXScript menu > MAXScript Listener.

■ Choose Utilities panel > MAXScript > MAXScript rollout > Open
Listener.

■ Right-click a viewport label, and then choose Views > Extended >
MAXScript Listener.

3 Choose MAXScript menu > Macro Recorder, or, from on the Listener
dialog, choose MacroRecorder > Enable.

4 Perform the actions you want to record.

The Macro Recorder records the actions you perform as a script in the
upper portion of the Listener dialog (pink background).

5 Highlight the lines you want in the recorded script, and then drag those
lines directly onto a toolbar.
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NOTE Your macro might require some minor editing to remove extraneous
steps or to refine the procedure.

You can edit the appearance of the text or icons on your toolbars with the
Edit Button Appearance on page 7511  command, which is available when you
right-click the toolbar button.

Interface

Group Displays a drop-down list that lets you choose the functional context
you want to customize, such as Main UI (user interface), Track View, Material
Editor, and so on.

Category Displays a drop-down list of available categories of user-interface
actions for the chosen group.
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Action list Displays all available actions for the chosen group and category.

[toolbars drop-down list] Displays all existing toolbars.

New Opens the New Toolbar dialog. Enter the name of the toolbar you want
to create and click OK. The new toolbar appears as a small floater.

Once you’ve created a new toolbar, there are three ways to add commands:

■ Drag actions from the Action Window in the Toolbars panel of the
Customize User Interface dialog onto your toolbar.

■ CTRL+drag buttons from any toolbar onto your toolbar. This creates a
copy of the button on your toolbar.

■ ALT+drag buttons from any toolbar onto your toolbar. This moves the
button from the original toolbar onto your toolbar.

Delete Deletes the toolbar item displayed in the Toolbars list.

Rename Displays the Rename Toolbar dialog. Select a toolbar from the
Toolbars list to activate the Rename button. Click Rename, change the name
of the toolbar, and click OK. The toolbar name changes in the toolbar floater.

Hide Toggles the display of the chosen toolbar in the toolbars list.

Load Displays the Load UI File dialog. Allows you to load custom user
interface files into your scene.

Save Displays the Save UI File As dialog. Allows you to save any changes
you’ve made to the user interface to a .cui file.

Reset Resets any changes you’ve made to the user interface to the default
setup (defaultUI.cui).

Quads Panel

Customize menu > Customize User Interface > Quads tab

The Quads panel lets you customize the quad menus on page 7300 . You can
create your own quad menu sets, or you can edit existing sets. In the Quads
panel, you can customize menu labels, functionality, layout, and shortcuts.
The advanced quad menu options on page 7507  let you modify the color and
behavior of the quad menu system. You can also save and load custom menu
sets.
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See also:

■ Additional Quad Menus on page 7304

Procedures

To create a new quad set:

1 Choose Customize menu > Customize User Interface > Quads tab.

2 Click New.

The New Quad Set dialog appears.

3 Enter the name of the quad set and click OK.

The new set appears in the Quad set list.

To add a command to a quad set:

1 Choose Customize menu > Customize User Interface > Quads tab.

2 Choose the quad set you want to edit from the upper-right drop-down
list.

If you want to change the name of the quad set, click Rename and enter
a new name in the Rename Quad Set dialog.

3 Select the quadrant where you want to place the command.

You can edit the name of the quadrant by changing the text in the Label
area.

4 Choose the appropriate Group and Category from the respective
drop-down lists.

5 Choose a command from the action list and drag it into the Quad Menu
window.

Use the same procedure to add menus and separators to your quad set.

To delete a quad set:

NOTE You cannot delete any of the default quad sets.

1 Choose Customize menu > Customize User Interface > Quads tab.

2 Choose the quad set you want to delete from the upper-right drop-down
list.
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3 Click Delete.

To remove a command from a quad set:

1 Choose Customize menu > Customize User Interface > Quads tab.

2 Choose the quad set you want to edit from the upper-right drop-down
list.

3 Choose the command you want to remove.

4 Press the Delete button.

Use the same procedure to remove menus and separators from your quad
set.

To move a command in a quad set:

■ Choose the command in the quad set list and drag it to a new position in
the list.
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Interface

Group Displays a drop-down list that lets you select the context you want
to customize, such as Main UI, Track View , Material Editor, and so on.

Category Displays a drop-down list of the available categories of user interface
actions for the selected context.

Action Window Displays all the available actions for the selected group and
category. To add an action to a specific quad set, select it and drag it to the
quad menu window on the right side of this dialog. Right-click an action in
this window to edit the macro script that defines the action (if there is one).

Separator Window Displays a separator line that can be used to separate
groups of menu items in a quadrant. To add a separator line to a specific quad
set, select it and drag it to the quad menu window on the right side of this
dialog.
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Menus Window Displays the names of all 3ds Max menus. To add a menu
to a specific quad set, select it and drag it to the quad menu window on the
right side of this dialog. Right-click a menu in this window to delete the menu,
rename it, or create a new, empty menu.

Quad Set List Displays the available quad sets.

Additional quad menus on page 7304  appear in this list. They can be edited,
renamed, and reorganized; however, they cannot be deleted.

New Displays the New Quad Set dialog. Enter the name of the quad set you
want to create and click OK. The new quad set appears in the Quad Set list.

Delete Deletes the item displayed in the Quad Set list.

Rename Displays the Rename Quad Set dialog. Select a quad set from the
Quad Set list to activate the Rename button. Click Rename, change the name
of the quad set, and click OK to change the name.

Quad Shortcut Allows you to define a keyboard shortcut for displaying the
quad set. Enter the shortcut and click Assign to make the change.

Show All Quads When on, a viewport right-click shows all four quad menus.
When off, a viewport right-click shows only one quad at a time.

Label Displays the label for the highlighted quadrant (shown in yellow to
the left of the Label).

Quad Menu Window Displays the menu options for the currently selected
quad menu and quad set. To add menus and commands, drag options from
the Action and Menus windows to this window.

Items included in the quad menu are displayed only when they are available.
For example, if your quad menu contains Track View Selected, the command
will display only if you have an object selected when you open the quad menu.
The quadrant will not be displayed if none of the commands are available
when you open the quad menu.

There are several actions available when you right-click any item in the quad
menu window:

Delete Menu Item Removes the selected action, separator, or menu from
the quad menu.

Edit Menu Item Name Opens the Edit Menu Item Name dialog. The
Customize Name check box must be on to edit the name. Enter the desired
name in the name text field and click OK. The item’s name is changed in the
quad menu, but not in the quad menu window.
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Flatten Sub-Menu Displays contents of selected submenu on top level of
quad. When this is selected, the menu name will be followed by the string:
[FLAT].

Edit MacroScript Opens the macro script for the selected action in a
MAXScript editor window.

Advanced Options Opens the Advanced Quad Menu Options dialog on
page 7507 .

Load Displays the Load Menu File dialog. Allows you to load custom menu
files into your scene.

Save Displays the Save Menu File As dialog. Allows you to save any changes
you’ve made to the quad menus to a MNU file.

Reset Resets any changes you’ve made to the quad menus to the default
setup (defaultui.mnu).

Menus Panel

Customize menu > Customize User Interface > Menus tab

The Menus panel lets you customize the menus in the software. You can edit
existing menus or create your own. You can customize menu labels,
functionality, and layout.

Procedures

To create a new menu:

1 Choose Customize menu > Customize User Interface > Menus tab.

2 Click New.

The New Menu dialog appears.

3 Enter the name of the menu, and click OK.

The new menu appears in the menu list.

To add a command to a menu:

1 Choose Customize menu > Customize User Interface > Menus tab.

2 Choose the menu you want to edit from the drop-down list.
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If you want to change the name of the menu, click Rename, and enter a
new name in the Rename Menu dialog.

3 Choose the appropriate Group and Category from the respective
drop-down lists.

4 Choose a command from the action list and drag it into the Menu
window.

Use the same procedure to add menus and separators to your menu.

To delete a menu:

1 Choose Customize menu > Customize User Interface > Menus tab

2 Choose the menu you want to delete from the drop-down list.

3 Click Delete.

To remove a command from a menu:

1 Choose Customize menu > Customize User Interface > Menus tab.

2 Choose the menu you want to edit from the drop-down list.

3 Choose the command you want to remove.

4 Press the Delete key.

Use the same procedure to remove menus and separators from your
menus.

To move a command in a menu:

■ Choose the command in the menu window and drag it to a new position
in the window.
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Interface

Group Displays a drop-down list that lets you select the context you want
to customize, such as: Main UI, Track View, Material Editor, and so on.

Category Displays a drop-down list of the available categories of user interface
actions for the selected context.

Action Window Displays all the available actions for the selected group and
category. To add an action to a specific menu, select it and drag it to the menu
window on the right side of this dialog. Right-click an action in this window
to edit the macro script that defines this action (if there is one).

Separator Window Displays a separator line that can be used to separate
groups of menu items. To add a separator to a specific menu, select it and drag
it to the menu window on the right side of this dialog.

Menu Window Displays the names of all menus. To add a menu to another
menu (shown in the Menu List), select and drag it to the menu window on
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the right side of this dialog. Right-click a menu in this window to delete the
menu, rename it, or create a new, empty menu.

Menu List Displays the default menus as well as any new ones you create or
load.

New Displays the New Menu dialog. Enter the name of the menu you want
to create and click OK. The new menu appears in the menu window on the
left side of the dialog as well as in the Menu List.

Delete Deletes the item displayed in the menu list window.

Rename Displays the Edit Menu Item Name dialog. Select a command in
the menu list window and click Rename. This dialog lets you specify a custom
name that will be displayed in the menu. If you precede a letter in the custom
name with the “&” (ampersand) character, that letter will be used as a menu
accelerator.

Menu Window Displays the menu options for the menu currently selected
in the menu list. To add menus and commands (actions), simply select and
drag the options from the Action and Menus windows to this window.

There are several actions available when you right-click any item in the menu
window:

Delete Menu Item Removes the selected action, separator, or menu from
the menu.

Edit Menu Item Name Opens the Edit Menu Item Name dialog. The
Customize Name check box must be on to edit the name. Enter the desired
name in the name text field and press OK. The item’s name is changed in the
menu, but not in the menu window. If you precede a letter in the custom
name with the “&” (ampersand) character, that letter will be used as a menu
accelerator.

Edit MacroScript Opens the script for the selected action in a MAXScript
editor window.

Load Displays the Load Menu File dialog. Allows you to load custom menu
files into your scene.

Save Displays the Save Menu File As dialog. Allows you to save any changes
you’ve made to the menus to a .mnu file.

Reset Resets any changes you’ve made to the menus to the default setup
(defaultui.mnu).
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Colors Panel

Customize menu > Customize User Interface > Colors tab

The Colors panel of the Customize User Interface dialog allows you to
customize the look of the software interface. You can adjust the colors for
almost every element in the interface, giving you the freedom to design your
own unique style.

The quad menu colors cannot be customized from the Color panel. To
customize quad menu colors, use the Advanced Quad Menu Options dialog
on page 7507 .

Procedures

To change an interface element color:

1 From the Elements drop-down list, choose the category of the interface
element whose color you intend to change.

2 In the list below the Elements field, highlight the element whose color
you intend to change.

The Color swatch shows the element's current color.

3 Click the Color swatch and then use the Color Selector dialog to choose
a new color. Click the Close button to set the color.

To restore the color that was active at the time that you opened the dialog,
highlight the element and click Reset.

4 Continue choosing elements and changing colors as necessary.

5 To finish and apply the color changes to the interface, close the dialog
by clicking the X button in the upper-right corner.

TIP If you change several colors and then want to restore all colors to the default
values, click the Load button and open DefaultUI.clr .

Interface

Elements Displays a drop-down list that lets you select from the various
high-level groupings: Character, Geometry, Gizmos, Viewports, and more.

[UI elements list] Displays a list of the available elements in the active
category.
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Color Displays the color for the selected category and element. Click to
display the Color Selector, where you can change the color. After choosing a
new color, click Apply Colors Now to make the change in the interface.

Reset Resets the color of the highlighted element to the value that was active
when you opened the dialog.

Intensity Sets a grayscale value for the display of the grid lines. 0 is black
and 255 is white.

This control is available only when you choose the Set By Intensity option
from the Grids element. This affects the intensity of the grid lines in the
viewports.

Invert Inverts the grayscale value for the display of grid lines. Dark gray
becomes light gray and vice versa.

This control is available only when you choose the Set By Intensity option
from the Grids element.

Scheme Allows you to choose whether the main UI colors are set to the
default Windows colors or whether they can be customized. If Use Standard
Windows Colors is active, all of the elements in the UI Appearance list are
disabled, and you are unable to customize the UI colors.

[UI appearance list] Displays all the elements in the user interface that can
be changed.

Color Displays the color for the selected UI appearance item. Click to display
the Color Selector dialog, where you can change the color. After choosing a
new color, click Apply to make the change in the interface.

Reset Restores the highlighted UI appearance item to its color when you
first opened the dialog.

Saturation Sets a saturation scale of enabled or disabled icons in the UI. The
higher the saturation, the less gray the color. See Red, Green, Blue / Hue,
Saturation, Value on page 7908 .

This control is only available when Icons: Enabled or Icons: Disabled is
highlighted in the UI Appearance list.

Value Sets the value scale of enabled or disabled icons in the UI. The higher
the value, the brighter the color. See Red, Green, Blue / Hue, Saturation, Value
on page 7908 .

This control is available only when Icons: Enabled or Icons: Disabled is
highlighted in the UI Appearance list.
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Transparency Sets the transparency value scale of enabled or disabled icons
in the UI. The higher the value, the more opaque the icon will be.

This control is only available when Icons: Enabled or Icons: Disabled is
highlighted in the UI Appearance list.

Invert Inverts the RGB value for the display of enabled or disabled icons in
the UI.

This control is only available when Icons: Enabled or Icons: Disabled is
highlighted in the UI Appearance list.

Apply Colors Now Makes any change you have entered using this dialog
active in the user interface.

Load Displays the Load Color File dialog. Allows you to load custom color
files into your scene.

Save Displays the Save Color File As dialog. Allows you to save any changes
you’ve made to the user interface colors to a CLR file.

Reset Restores any changes you’ve made to the colors to the default setup
(defaultui.clr).

Advanced Quad Menu Options

Customize menu > Customize User Interface > Quads panel > Advanced
Options

The Advanced Quad Menu Options dialog lets you customize the size and
colors of your quad menus. You can also customize other quad menu behaviors
such as repositioning, type font, and cursor behavior.

Interface

Save group

Load Lets you load a quad options (.qop) file.

Save Saves your settings to a .qop file.

Save as Startup Saves your current settings as the startup settings.
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Reset to Startup Resets options to default settings (defaultui.qop).

Colors group

The colors group allows you to customize the colors of your quad menus.

Starting Quadrant Lets you select which quadrant your cursor starts in when
you open the quad menu.

Color list The customizable elements of the quad menu are listed and
separated by quadrant. Click the color swatch to open a color selection dialog.

If the colors for a quad menu element are locked (indicated by a pressed “L”
button), each of the separate quadrants will share the same color; when you
change the color in one quadrant, it will change all of the quadrants’ colors.

You can customize each quadrant separately by turning off the lock button
for the selected quad menu element.
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Display group

Uniform Quad Width When turned on, all displayed quadrants will be the
same width. The width is determined by the widest quadrant.

Mirror Quads When turned on, text in the quad menus is justified to the
inside edge of the menu; the text in the right quadrants is left-justified, and
text in the left-quadrants is right-justified.

When turned off, all text in the quad menu is left-justified.

Vertical Margins Sets the vertical spacing between commands in the quad
menu.

Opacity Amount Sets the opacity of the quad menu.

Opacity is not available in systems running on Windows NT.

Positioning group

Reposition Quad When Off Screen Automatically repositions the quad menu
when you open it with part of the menu off the edge of the screen. The menu
is moved so that the entire menu is displayed on the screen.

Move Cursor When Repositioned Moves your cursor to the new location of
the quad menu when it is repositioned.
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When this is turned off, you must hold down the mouse button when you
right-click to display the quad menu. Once you move the cursor over the
menu, you can release the mouse button.

Return Cursor After Repositioned After you have selected an action from
the quad menu, the cursor is returned to the location on the screen where the
original right-click was made.

Fonts group

Title Font Sets the font of the quadrant titles.

Size Sets the font size of the quadrant titles.

Menu Font Sets the font of the text inside the quadrants.

Size Sets the font size of the text inside the quadrants.

Animation group

Type Sets the animation type for the quad menu from the following options:

■ None Quad menus display immediately upon right-clicking.

■ Stretch Quad menus open by expanding one quadrant at a time, in a
clockwise manner. They close similarly; contracting one quadrant at a
time, in a counterclockwise manner.
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■ Fade Quad menus open by fading in from transparent to opaque, and
close by fading out from opaque to transparent.

Steps The number of frames used to complete the animated display of the
quad menu.

As this value becomes larger, the transition (small to large, transparent to
opaque, etc.) becomes more gradual.

Pause The time between frames during the animated display of the quad
menu.

As this value becomes larger, the animated display of the quad menu slows
down.

Edit Button Appearance Dialog

Right-click any button on a custom toolbar. > Edit Button Appearance

Use this dialog to change the appearance of the selected button. You can
substitute a different icon for the button, or change to a text button instead.
You can also customize the tooltip.

Custom Icons

To make a custom icons, you need a series of four files, each beginning with
the same prefix which designates the icon group. You can create these images
in any paint program.

■ A 24x24 image for use when large icons are displayed. Suffix: _24i.bmp.

■ A 24x24 grayscale image showing the transparency of the 24x24 image,
with black pixels indicating see-through areas where the gray button
background will show through. Suffix: _24a.bmp.

■ A 16x15 image for use when small icons are displayed. Suffix: _16i.bmp.

■ A 16x15 grayscale image showing transparency of the 16x16 image. Suffix:
_16a.bmp

Each file can contain more than one icon, but if so, the icons must be arranged
in series one after the other. For example, if you want three icons to appear,
the file that ends in _24i.bmp would be 72 pixels wide and 24 pixels high, and
contain the three icons in series with no space between them.
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After you create the icon files, copy them to the UI/icons folder and restart 3ds
Max. This will enable the software to find and display the group when you
access the Edit Button Appearance dialog.

TIP Look at some of the existing .bmp  files in the UI/icons folder as a guide to
arranging custom icons in your .bmp  files.

Interface

Tooltip You can add your own tooltips to the buttons. This is the tooltip
that displays when the mouse is over the tool button. You can edit this to
describe the tool.

Text Button Lets you assign text to the button. You can enter whatever text
you like for the button.

Image Button Lets you assign an image (icon) to the button. You can use
any predefined icon that you want by selecting it from the display on the
right.

Group Displays a list of button categories. The groups of icons change with
each category selection.

Odd Only Certain icon sets, like Internal, Classic, Main toolbar and others,
are designed in pairs that show what the tool looks like when the button is
enabled, and what it looks like when disabled. When Odd Only is turned on,
only the odd numbered icons (enabled) are displayed, when Odd Only is
turned off, all of the icons, enabled and disabled, are displayed.
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Saving and Loading Custom User Interfaces
You can customize your workspace by saving and loading custom user interface
(UI) schemes.

A custom UI scheme is saved as a set of six files:

■ .cui: Stores toolbar and panel layouts.

■ .clr: Stores all color settings (except quad menu colors).

■ .mnu: Stores menu bar and quad menu contents.

■ .qop: Stores quad menu colors, layout, and behavior.

■ .kbd: Stores keyboard shortcut assignments.

■ .ui: Stores the icon scheme (Classic or 2D Black and White).

You can load and save each of these files individually from their respective
panels in the Customize User Interface dialog on page 7489 . You can also load
an entire set of UI scheme files at once with the Load Custom UI Scheme
dialog on page 7515 , and you can save the current UI scheme as a complete set
with the Save Custom UI Scheme dialog on page 7516 .

By default, two sets of UI schemes are present in the 3dsmax\UI\ folder: maxstart
and defaultUI. Upon startup, 3ds Max uses the maxstart file series if it exists; if
not, it uses the defaultui series.

WARNING Do not save over any files that begin with defaultUI , as doing so will
permanently overwrite the default UI scheme.

Procedures

To load a custom UI scheme:

1 Set up the custom UI scheme within 3ds Max using the options on the
Customize menu > Customize User Interface dialog on page 7489 .

2 Save the custom UI scheme with Customize menu > Save Custom UI
Scheme.

3 During your current 3ds Max session or any later session, choose
Customize menu > Load Custom UI Scheme.

4 In the Load Custom UI Scheme dialog, select a type of customization file
(.cui, .mnu, .clr, .kbd, .qmo, or .ui) from the Files of Type drop-down list.
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5 Choose any file with the appropriate extension. The software will search
for (and load) any other type of UI scheme file with the same base file
name.

If you choose a UI scheme for which one of the six file types is not
present, the part of the user interface for which there is no file will not
be changed.

To return to the default UI scheme:

If you start 3ds Max and its user interface has an unfamiliar layout, you can
always return to the default UI scheme.

1 Choose Customize > Load Custom UI Scheme.

2 From the Load UI File dialog that displays, choose defaultui.cui, and click
Open.

All the default UI files begin with the base file name defaultui. When you
choose defaultui.cui, all default UI scheme files will load.

To start the software with a custom user interface:

1 Arrange the user interface as you would like it to appear when you start
3ds Max.

2 Choose Customize menu > Save Custom UI Scheme, and save your custom
UI scheme with the base file name maxstart .

The next time you start 3ds Max, the software will start with the current
UI scheme.

NOTE If the Save UI Configuration On Exit option on the Customize menu
> Preferences > General tab on page 7536  is turned on (which it is by default),
the state of the user interface when you close the program will overwrite the
maxstart  UI scheme files.

To start the software with a custom user interface from the command line:

1 Save your custom UI scheme with a descriptive base file name with the
Save Custom UI Scheme dialog on page 7516 .

2 Right-click the 3ds Max icon on the Windows desktop, and choose
Properties.

3 In the Target field, change 3dsmax.exe to 3dsmax.exe -c  , followed by
the name of your .cui file.
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Example: 3dsmax.exe -c  myfile.cui. Be sure to leave a space both before
and after the -c.

If you want to move the UI scheme to a different computer, copy all the files
in the 3dsmax\UI\ folder that start with the custom UI scheme base name to
the new 3dsmax\UI\ folder. Alternately, you can add the path name to the
command line.

To save a single UI scheme file:

1 Choose Customize menu > Customize User Interface on page 7489 .

2 Access the panel for the type of user interface item you want to save.

3 On the panel, click Save.

To change the icon display from Classic to 2D Black and White:

1 Choose Customize menu > Save Custom UI Scheme, enter a filename,
and click Save.

2 On the Custom Scheme dialog, next to Icon Type, choose the type of
icon you want to display.

3 Click OK to close the dialog and save the scheme.

4 Choose Customize menu > Load Custom UI Scheme and then open the
UI scheme you just saved.

Load Custom UI Scheme

Customize menu > Load Custom UI Scheme

On the Load Custom UI Scheme dialog, you specify the base file name of the
custom UI scheme you want to load. You can select any type of UI scheme
file from the dialog, and the software will load any other type of UI scheme
files with the same base file name.

To save a custom UI scheme, use the Save Custom UI Scheme dialog on page
7516 .

For more information on saving and loading custom user interfaces, see Saving
and Loading Custom User Interfaces on page 7513 .
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You can also load a custom UI scheme with the Custom UI and Defaults
Switcher on page 7483 .

Interface

TIP You can resize the dialog by dragging an edge or a corner.

Use the Look In field to navigate to other directories. Click the folder to choose
it. The files display in the window. Display or hide the details using List or
Details buttons. If Details is turned on, you can sort by clicking the column
labels in the window.

Use the Files of type drop-down menu to search for other types of
customization files. The default is .cui, but you can also search for .clr, .mnu,
.kbd, .qop, and .ui files. When you choose a filename, all files with that base
file name will be loaded.

Save Custom UI Scheme

Customize menu > Save Custom UI Scheme

This standard Windows file save dialog lets you save your customized UI
scheme.
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This dialog works differently from other dialogs that save files. In this dialog,
after you enter a base file name and click Save, the Custom Scheme dialog
appears. On the Custom Scheme dialog, you set the types of user interface
schemes to save. A file is saved for each type of scheme you select, each with
a specific extension for that type of scheme. When you load any one of the
custom UI scheme files with the Load Custom UI Scheme dialog on page 7515
, the entire set of files with the same base file name will be loaded.

On the Save Custom UI Scheme dialog, the base name of the current UI scheme
is filled in by default. You can enter the name of the base file name in the File
Name field, or click in the list to choose an existing base file name. You can
click a file with any UI scheme extension to save to the base file name from
that file.

If you want the current UI to load automatically every time you load 3ds Max,
you can save to the base file name maxstart . Alternately, you can turn on the
Save UI Configuration On Exit option on the Customize menu > Preferences
> General tab on page 7536 . This will cause the UI scheme that is current at
the time you close 3ds Max to be saved to the base file name maxstart . This
option is on by default.

WARNING Do not save over the base file name defaultUI , as doing so will
permanently overwrite the default UI scheme files.
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For more information on saving and loading custom user interfaces, see Saving
and Loading Custom User Interfaces on page 7513 .

Interface

After you enter a file name and click Save, the Custom Scheme dialog opens,
letting you define which parts of the UI scheme will be saved.

TIP You can resize the dialog by dragging an edge or a corner.

Interface Layout (.cui) When on, saves the current toolbar and panel layout
to a .cui file with the UI Scheme base file name.

Keyboard Shortcuts (.kbd) When on, saves the current keyboard shortcuts
to a .kbd file with the UI Scheme base file name.

Menus (.mnu) When on, saves the menu layout to a .mnu file with the UI
Scheme base file name.

Quad Options (.qop) When on, saves the quad menus to a .qop file with the
UI Scheme base file name.

Colors (.clr) When on, saves the current color definitions to a .clr file with
the UI Scheme base file name.

Icon Type Selects the icon scheme for all toolbars, and saves this information
in a file with the extension .ui after the UI Scheme base file name.
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NOTE The icon scheme you choose will be saved as part of the file set, regardless
of whether the chosen icon scheme matches the current scheme displayed on
your screen.

All Turns on all of the above controls.

None Turns off all of the above controls.

OK Closes the dialog, and saves all of the selected UI Scheme files.

Cancel Closes the dialog without saving any UI Scheme files.

Revert to Startup Layout

Customize menu > Revert to Startup Layout

Revert to Startup layout automatically loads _startup.ui, which returns the user
interface to its startup settings. This temporary system file is created
automatically when you start the program. Use this option to return the UI
to startup settings.

See Load Custom UI Scheme on page 7515  for information on how to load
different UI schemes on startup.

If you have Save UI Configuration On Exit turned on in the General panel
on page 7536  of the Preferences dialog, the current UI file is overwritten when
you exit the program.

Procedures

To revert to the startup UI:

■ Choose Customize > Revert To Startup UI Layout. UI elements are
rearranged to look as they did when you started the program.

Configure Paths
Customize menu > Configure User Paths

Customize menu > Configure System Paths
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Configure Paths functionality is available in two dialogs:

■ Paths that you use to specify locations for bitmaps, scenes, etc. are found
on the Configure User Paths dialog on page 7520 . In addition, the latter
dialog now lets you save, load, and merge path-configuration files, which
makes it easier for content-creation teams to set up the same folders for
all team members to use.

■ Paths used by 3ds Max for purposes such as loading fonts and defaults are
accessible on the Configure System Paths dialog on page 7523 .

See also:

■ Asset Tracking dialog > Paths menu on page 6905

Configure User Paths

Customize menu > Configure User Paths

3ds Max uses stored paths to locate different kinds of user files, including
scenes, images, DX9 effects (FX), photometric, and MAXScript files. You use
the Configure User Paths command to display the Configure User Paths dialog
and customize these paths. This command is useful when you add new folders
to help you organize your scenes, images, plug-ins, backups, and so on.

You can save, load, and merge the paths that the Configure User Paths dialog
manages in MXP (max path) files. This makes it easy for all members of
content-creation teams to keep projects organized and work efficiently by
using the same paths.

See also:

■ Configure System Paths on page 7523

Procedures

In general, these procedures are common to all panels on the Configure User
Paths dialog. When you change a setting, it's written to the 3dsmax.ini on
page 51  file, and is effective immediately.

To modify a path:

1 Click a path entry to highlight it.
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2 Click Modify.

3 Use the Choose Directory dialog to do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Optional step (3rd Party Plug-Ins panel only): Edit the description of the
path in the Label field.

This description subsequently appears in the path list.

5 Click Use Path.

The new path takes effect immediately.

To share User paths with team members:

1 Use the Configure User Paths dialog to set up all necessary user paths.

2 Click the Save As button and then use the Save Paths To File dialog to
save the path configuration as an MXP file.

3 Make the path configuration file available to other team members.

4 Each team member then opens the Configure User Paths dialog and uses
Load or Merge to open the path configuration file.

The new path configuration is now the same on each team member's
machine.

NOTE Using Load eliminates the existing path configuration; using Merge
overwrites only paths that exist in both the current configuration and the
new one.

To share files with team members using relative paths:

1 Ensure the Convert local file paths to Relative preference is enabled.

2 As you work, all files are saved relative to your project folder.

3 Give your scene to another user.

4 The second user opens the scene on a machine with a different project
folder and now 3ds Max searches for all files related to the scene file in
the second user's project folder.
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NOTE The Convert local file path to Relative preference is set when you
create the file. For example, if I load a material into my scene with this
preference on, this material will always be treated as relative to the project
folder.

Interface

The Configure User Paths dialog comprises three panels:

■ External Files on page 7526

■ File I/O on page 7524

■ XRefs on page 7529

In addition, the dialog provides command buttons on the right side and across
the bottom:

Project Folder Lets you set the project folder on page 6728 .

Modify Lets you change the highlighted path.

Make Relative Lets you change an absolute or complete file path into a path
relative to the project folder on page 6728 .
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NOTE For relative paths within the project folder, a leading “.\” represents the
project folder path. On the other hand, one or more instances of “..\” preceding
the path indicates that the path is in a sibling folder to the project folder, as
opposed to a sub-folder. For example, if your project folder is c:\MyProject\Project1
and the asset location is c:\Resources\myresource.jpg , then the relative path from
the project folder to the resource is ..\..\Resources\myresource.jpg . If the asset
was in c:\MyProject\Resources\myresource.jpg , then the relative path would be
..\Resources\myresource.jpg .

Make Absolute Lets you make the path absolute, where a relative path is
currently being used. For example, if “.\” represents your project folder in the
path name, then when you make the path absolute the full name will be used
instead.

Move Up/Down Lets you change the highlighted path's position in the list
to alter its search priority. Available only on the External Files and XRefs
panels.

Save as Lets you save the path configuration as an MXP file for sharing with
team members.

Load Loads a path configuration from an MXP file. The loaded configuration
completely replaces the existing one.

Merge Merges a path configuration from an MXP file. The merged
configuration adds paths that exist only in the new file and replaces any
existing paths.

For example, if your File I/O panel > Scenes path is set to .\scenes (relative
path) and you merge a path configuration file in which the Scenes path is set
to the UNC path \\scene_server\max\scenes, the former path is replaced by the
latter one.

OK Exits the dialog and saves any changes.

Cancel Exits the dialog without saving changes.

Configure System Paths

Customize menu > Configure System Paths

The 3ds Max system uses paths to locate different kinds of files, including
defaults, fonts, and startup MAXScript files. You use the Configure System
Paths command to open the Configure System Paths dialog and customize
these paths.
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3ds Max saves the paths that the Configure System Paths command manages
in the 3dsmax.ini on page 51  file.

See also:

■ Configure User Paths on page 7520

Interface

The Configure System Paths dialog comprises two panels:

■ System Paths on page 7531

■ 3rd Party Plug-ins on page 7532

File I/O Path Configuration

Customize menu > Configure User Paths > Configure User Paths dialog > File
I/O panel

The File I/O panel of the Configure User Paths dialog contains most of the
file directories in which users store files.

For descriptions of the general dialog controls, see Configure User Paths on
page 7520 .

NOTE By default these paths are relative to the project folder on page 6728 .
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Procedures

To modify a file path:

1 On the Configure User Paths dialog, click File I/O, and then choose a
path entry.

2 Click Modify.

3 In the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Optional step: Enter a description of the path in the Label field.

This description subsequently appears in the path list.

5 Click Use Path.

The new path takes effect immediately.

Interface
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Animations Path for animation files, including XAF, XMM, BIP, FIG, MFE,
and so on.

Archives Path for archive files.

AutoBackup Sets the default path for automatic backup files. If you use the
Auto Backup feature on page 7541 , use either the \autoback directory, which is
specific to each running version of the software, or a directory that's not shared
by any other machine.

BitmapProxies Path for proxy bitmaps. See Global Settings and Defaults for
Bitmap Proxies Dialog on page 6912 .

Downloads Path for i-drop on page 6957  files.

Export Path for exported files.

Expressions Path for text files used by expression controllers.

Images Path for image files.

Import Path for imported files.

Materials Path for material library (MAT) files.

MaxStart Path for maxstart.max, which provides initial 3ds Max scene settings.

Photometric Path for photometric files, which define various characteristics
of Photometric lights on page 4951

Previews Path for preview renders.

RenderAssets Path for mental ray and other rendering asset files, including
shadow maps, photon maps, final gather maps, MI files, and render passes.

RenderOutput Path for rendered output.

RenderPresets Path for Render Preset files.

Scenes Path for MAX scene files.

Sounds Loads sound files.

VideoPost Loads and saves Video Post queues.

External Path Configuration

Customize menu > Configure User Paths > Configure User Paths dialog >
External Files panel
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On the External Files panel of the Configure Paths dialog, you can add or
modify path directories for bitmaps on page 7730 , DX9 effects (FX) files, on
page 7794 , and downloads; that is, files transferred from the Internet via i-drop
on page 6957 . Bitmaps are used for background images and mapped materials
on page 7840  (textures, bump maps, displacement maps, and so on).  FX files
are used by the DirectX 9 Shader material on page 5596 .

NOTE By default the paths for \Maps\fx, \Maps, and the root folder are all relative
to the root directory of 3ds Max whereas the \downloads folder is relative to the
project folder by default.

3ds Max stores the path of any file you load. When the file is reloaded, the
search order is as follows:

1 The path saved with the file.

2 The directory of the current scene.

3 The paths listed in the External Files panel, starting at the top of the list.

NOTE To save loading time, if a map with the same name is in two different
locations (paths), it is loaded only once. This poses a problem only if your
scene includes two different maps with the same name. In this case, only the
first map encountered will appear in the scene.

4 Every subdirectory under the directory of the current scene.
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For descriptions of the general dialog controls, see Configure User Paths on
page 7520 .

Procedures

To modify a file path:

1 On the External Files panel, choose a path entry.

2 Click Modify.

3 In the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Click Use Path.

The new path takes effect immediately.

To add a file's path:

1 On the External Files panel, click Add.

2 On the Choose New Bitmap Path dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

3 If you want to include subdirectories in this path, turn on Add Subpaths.

4 Click Use Path.

The new path takes effect immediately.

To delete a file's path:

1 On the External Files panel, choose a path entry.

2 Click Delete.

The path location is removed.

3 Click Cancel to restore the path.

This closes the Configure Path dialog without saving any path changes.
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To move a path up or down in the list:

1 On the External Files panel, choose a path entry.

2 Do one of the following:

■ Click Move Up to move the entry closer to the top of the list, giving
it a higher priority in the search process.

■ Click Move Down to move the entry closer to the bottom of the list,
giving it a lower priority in the search process.

XRefs Path Configuration

Customize menu > Configure User Paths > Configure User Paths dialog > XRefs
panel

On the XRefs panel of the Configure User Paths dialog, you can modify, delete,
or add to the directory locations 3ds Max searches for XRef objects and XRef
scenes. You can also use either relative or absolute paths.

You expand the default locations of external reference files by adding paths
to this panel. Use this technique to identify the directories most often used
in your scenes.

3ds Max stores the path of any external reference file you load. When the
external reference file is re-loaded, the search order is as follows:

1 The path saved with the external reference file.

2 The directory of the current scene.

3 The paths listed in the Configure User Paths dialog > XRefs panel, starting
at the top of the list.

NOTE By default, this path is relative to the project folder.

For descriptions of the general dialog controls, see Configure User Paths on
page 7520 .

Procedures

To modify an external reference file path:

1 On the XRefs panel, choose a path entry.
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2 Click Modify.

3 On the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path, and click Use Path.

To add an XRef path:

1 On the XRefs panel, click Add.

2 On the Choose New XRef Path dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

3 Click Use Path.

The new path takes effect immediately.

To delete an external reference file path:

1 On the XRefs panel, choose a path entry.

2 Click Delete.

The path location is removed.

3 Click Cancel to restore the path.

This closes the Configure User Paths dialog without saving any path
changes.

To move a path up or down in the list:

1 On the XRefs panel, choose a path entry.

2 Do one of the following:

■ Click Move Up to move the entry closer to the top of the list.

■ Click Move Down to move the entry closer to the bottom of the list.
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System Paths

This dialog is especially useful if you are programming your own scripts for
3ds Max. When you start 3ds Max, these folders will be checked and the
corresponding file will be run:

FunctionFile Type

Path for additional iconsAdditional Icons

Path for additional macrosAdditional Macros

Path for additional scriptsAdditional Scripts

Path for additional startup scriptsAdditional Startup Scripts

Path for data files related to 3ds MaxMaxData

Path for temporary filesTemp

Procedures

To modify a path:

1 Click a path entry to highlight it.

2 Click Modify.

3 Use the Choose Directory dialog to do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Click Use Path.

The new path takes effect immediately.
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3rd Party Plug-Ins Path Configuration

Customize menu > Configure System Paths > Configure System Paths dialog
> 3rd Party Plug-Ins panel

On the 3rd Party Plug-Ins panel of the Configure System Paths dialog, you
can add or modify the directory paths of  plug-ins on page 7896  supplied by
third parties and independent software developers. You can also store plug-ins
in separate directories and use this panel to add the paths of those directories.
Changing the list order specifies the search order. Put the most frequently
used plug-ins at the top.

Path information is stored in the plugin.ini file.

NOTE To change the path for standard plug-ins included with 3ds Max, use the
Configure System Paths on page 7523  function.

For descriptions of the general dialog controls, see Configure User Paths on
page 7520 .

Procedures

To modify a plug-in path:

1 On the 3rd Party Plug-Ins panel, choose a path entry.

2 Click Modify.

3 On the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Click Use Path.

The new path takes effect immediately.

To add a plug-in path:

1 On the 3rd Party Plug-Ins panel, click Add.

2 On the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.
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3 Type a description in the Label field.

4 If you want to include subdirectories in this path, turn on Add Subpaths.

5 Click Use Path.

The new path takes effect immediately.

To delete a path:

1 On the 3rd Party Plug-Ins panel, choose a path entry.

2 Click Delete.

The path location is removed.

Network Plug-In Configuration

You can include path annotations to additional INI files within the local
plugin.ini and the software will process the files as if they were part of the
original plugin.ini. This can be very helpful in settings where several systems
on a network are using the same plug-ins. The network administrator need
only maintain a single remote INI file, rather than having to update each
machine individually.

Procedures

Example: To add remote INI files to your local plugin.ini:

1 Open your local copy of plugin.ini with your preferred text editor.

2 At the bottom of the file, type [Include] and press ENTER.

3 Below [Include], type these two lines:

myremote=\\remote_dir\remote_plugin.ini

anotherdir=d:\test\extra_plugin.ini
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NOTE You can give any title to the directory ( myremote  or anotherdir,  in
this case) and the directory can be any local or remote directory. In addition,
the INI file can have any name.

4 Save plugin.ini and exit the text editor.

The next time you start the software, it will load plug-ins from the
directories defined in plugin.ini, as well as those in any remote INI file that
has been included in plugin.ini.

You can add as many remote INI files as you need, making it easy to
organize groups of plug-ins.

Preferences
Customize menu > Preferences

3ds Max offers many options for its display and operation. These options are
available on the Preference Settings dialog in a series of tabbed panels.
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The Preference Settings dialog contains the following panels:

General Preferences on page 7536

File Preferences on page 7541

Viewport Preferences on page 7545

Gamma Preferences on page 7550

Rendering Preferences on page 7560

Animation Preferences on page 7564

Inverse Kinematics Preferences on page 7568

Gizmos Preferences on page 7570

MAXScript Preferences on page 7574

Radiosity Preferences on page 7578

mental ray Preferences on page 7579
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General Preferences

Customize menu > Preferences > Preferences dialog > General tab

On the General panel of the Preference Settings dialog, you set options for
the user interface and for interactivity.

Interface on page 7537

Procedures

To set and toggle spinner snap:

1 Do one of the following:

■ Choose Customize menu > Preferences > Preference Settings dialog >
General tab.

■  Right-click the Spinner Snap button on the main toolbar.

Either method brings up the General tab. The two controls for spinner
snap are in the Spinners area of this panel.

2 Enter a value in the Spinner Snap field.

3 Turn on Use Spinner Snap.

When you exit the dialog, Spinner Snap is on.

4 As you work, use the Spinner Snap button to toggle the use of this setting.

To set the Undo level:

1 Choose Customize menu > Preferences > Preference Settings dialog >
General panel.

2 Change the value of Scene Undo Levels.

The higher the value of Undo Levels, the more system resources are
required. The default value is 20.
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Interface

Scene Undo group

Levels Sets the number of operations you can undo. You can see the operation
that will be undone by looking at Undo on the Edit menu.

Reference Coordinate System group

Constant Sets one coordinate system and transform center for Move, Rotate,
and Scale on the Main toolbar. The coordinate system displayed in the
coordinate dropdown list on page 896 , and the transform center selected from
the Use Center flyout on page 904 , are used for all transforms.

Normally, each transform switches to the coordinate system and transform
center used the last time the transform was active.
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UI Display group

Enable Viewport Tooltips Displays a tooltip when the cursor pauses over a
non-selected object in the viewports if you are not in sub-object mode. Tooltips
show the names of objects.

AutoPlay Preview File Starts the Media Player automatically at the end of a
Make Preview on page 6220 .

Display Cross Hair Cursor Displays the mouse cursor as full-viewport cross
hairs, vertical and horizontal lines extending the full extent of the active
viewport.

Each movement of the mouse is redrawn, so the cross hairs are relatively slow.
If you want to create a keyboard shortcut, find Cross Hair Cursor toggle in
Customize menu > Customize User Interface > Keyboard panel and specify
the keys to use for the shortcut. If you want to change the color of the
cross-hairs cursor, Customize menu > Customize User Interface > Colors panel
> Viewports > Cross Hair Cursor and use the color selector to change the cursor
color.

Display Topology Dependence Warning Toggles the topology dependence
warning. A warning is displayed if an object has modifiers and sub-object
selections, and you choose to edit a modifier or the base object at the bottom
of the modifier stack, which can adversely affect the object’s topology. You
can also turn off the warning on the warning dialog. Default=on.

Display Stack Collapse Warning Toggles the stack collapse warning. A warning
is displayed if you choose to collapse the modifier stack. You can also turn off
the warning on the warning dialog. Default=on.

Save UI Configuration on Exit Restores panels and toolbars to the positions
they were in the last time you used the software. Turn this off to restore panels
to the state they were in prior to turning on this option.

Use Large Toolbar Buttons Toggles between large and small toolbar buttons.

Horizontal Text in Vertical Toolbar Ensures text buttons are displayed
horizontally.

If you create a custom toolbar positioned vertically, and you're using text
rather than image buttons, you can choose to display either horizontal or
vertical text with this option.

Fixed Width Text Button Specifies the maximum width of text buttons.

You must turn on the Horizontal Text in Vertical Toolbar option, turn this
option on, and then set a maximum display size for the text button in pixels.
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For custom vertical toolbars with text buttons, this option will limit the size
of the text display.

Flyout Time Sets the pause, in milliseconds, between the mouse click and
the flyout popping up from the button. Increase this setting only if you need
an extra-long delay. Don't decrease the setting much or you may not be able
to execute button commands before the flyout takes over.

Color Selector Choose the default color selector on page 331 , or a third-party
plug-in color selector in the list. The color selector you choose here is used
throughout 3ds Max whenever you specify a color.

Plug-In Loading group

Load Plug-Ins When Used When turned on, loads plug-ins on demand, when
they are needed.

Sub-Materials group

Assign Automatically Enables the automatic creation of a Multi/Sub-Object
material when you assign a material to a selection of face sub-objects in an
editable object. Default=on.

When on, the assigned material becomes part of the new Multi/Sub-Object
material, and is assigned to the face selection. When off, the assigned material
is assigned to the entire object.

NOTE If the face selection comprises faces with different material IDs, assigned a
material to the selection with Assign Automatically turned on results in the software
assigning the first unused material ID to all selected faces, thus changing their IDs.

See also Drag and Drop Sub-Object Material Assignment on page 5216 .

Scene Selection group

Auto Window/Crossing by Direction When this is enabled, the direction
that you drag a selection area determines whether it is a window or crossing
selection on page 200 . This works for any selection area (rectangle, circle, fence,
or lasso).

You can select which direction causes a window selection and which causes
a crossing selection in the Scene Selection group. When you drag a window
selection, the selection region is displayed with a solid line, however when
you drag a crossing selection, the selection region is displayed with dashed
lines.
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Right-> Left => Crossing When you drag a selection region from right to
left, it is a crossing selection. Conversely, when you drag left to right, it is a
window selection.

Left-> Right => Crossing When you drag a selection region from left to right,
it is a crossing selection. Conversely, when you drag right to left, it is a window
selection.

Paint Selection Brush Size Sets the size of the brush used by Paint Selection
Region  on page 196 .

Spinners group

Precision Sets the number of decimal places displayed in a spinner's edit
field. Range=0 to 10 (where 0 is no decimal places).

Snap Sets the click increment and decrement values for all of the spinners
in 3ds Max.

Use Snap Toggles spinner snap on and off.

Wrap Cursor Near Spinner Limits cursor wrapping to an area close to the
spinner when you drag to adjust spinner value.

Command Panel group

Rollout Threshold Determines the number of pixels in a rollout that should
be scrollable in the command panel before the rollout is shifted into a separate
command panel column.

This option is applicable only when the command panel displays multiple
columns.

Layer Defaults group

Default to By Layer for New Nodes When on, all new objects will have their
rendering, motion blur, display, and advanced lighting properties set to By
Layer on page 7737 .

New Lights Renderable By Layer When on, the Renderable setting (found
on the Object Properties dialog on page 245 ) of new lights is determined by
the setting of the layer they are created on.
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Propagate Unhide/Unfreeze Commands to Layers? When a layer is hidden
or frozen, and you unhide or unfreeze an object in that layer, this choice
determines whether the command affects the object or its layer.

■ Propagate Unhiding or unfreezing an object in a layer unhides or
unfreezes the layer.

■ Do Not Propagate Unhiding or unfreezing an object in a hidden or frozen
layer affects only the object.

■ Ask When this option is active and you unhide or unfreeze objects, a
dialog appears asking if you want to apply the operation to the associated
layers. If you do, the associated layers are unhidden or unfrozen. Otherwise
the operation is applied only to the specified objects.

Vertex Normal Style group

Use Legacy R4 Vertex Normals By default, 3ds Max uses a new, more accurate
method for computing vertex normals from smoothing groups, which improves
the way geometry displays in viewports and in rendered output. To use the
method from older versions of the software, for compatibility, turn on this
check box.

Texture Coordinates group

Use Real-World Texture Coordinates Controls whether real-world texture
coordinates are active or if the legacy method of applying texture coordinates
is in use. When off, texture-coordinate behavior reverts to the legacy method
and texture tile values have a default value of 1, and Real-World Map Size for
primitives is off. Default=off .

When Use Real-World Texture Coordinates is on, the Use Real-World Scale
and Real-World Map Size options are also on. Use Real-World Scale is present
in the Material Editor, on the Coordinates rollout for 2D maps, and Real-World
Map Size is available for objects such as primitives and modifiers such as UVW
Map.

File Preferences

Customize menu > Preferences > Preference Settings dialog > Files tab

On the Files panel of the Preference Settings dialog, you set options relating
to file handling. You also select the program used for archiving. This is where

File Preferences | 7541



you control the options for log file maintenance. You can enable Auto Backup
in this dialog to save your work automatically at defined intervals.

Interface

File Handling group

Convert file paths to UNC When on, paths shown in the user interface for
any files present on a mapped drive use Universal Naming Convention (UNC)
format on page 7961 . When off, each path starts with the mapped drive letter
(e.g., w:\).

This check box is linked to the Convert file paths to UNC on page 7542 switch
on the Asset Tracking dialog > Paths menu. Toggling either one toggles both.
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NOTE This switch affects only newly added paths. Toggling it has no effect on
existing paths. For example, if you load an image file into a Bitmap map on page
5633  from a mapped drive with the switch on, turning it off does not change the
file path to the mapped version.

Convert local paths to Relative Converts the file paths of all newly added
assets in a scene so that they are relative to the project folder on page 6728 .
Default=off.

NOTE This is a system setting and is not saved with the scene file.

Backup on Save Creates a backup file if a file of the same name already exists.
The existing file is renamed maxback.bak and placed in the autoback directory
before the save occurs. You can edit the automatic backup settings in the
Auto Backup group on page 7544 . Default=on.

Increment on Save Creates a new copy of the file in the same directory
whenever you save the file. The name of the new file is incremented by 1
(filename01.max, filename02.max, and so on). Default=off.

Compress on Save Saves the 3ds Max file in a compressed format. Depending
on the details of the file, the compressed file can be as small as one-fifth the
size of its uncompressed equivalent. Default=off.

You can determine whether a 3ds Max file is compressed or not by bringing
up Properties for the file in Windows Explorer. On the Contents panel, under
General, you'll see whether the file is compressed or uncompressed.

Save Viewport Thumbnail Image Saves a 64-pixel thumbnail of the active
viewport when you save each MAX file. The Asset Browser reads thumbnails.
Saving thumbnails adds about 9K to each MAX file. Default=on.

Save Schematic View When on, the active schematic view is saved with the
MAX file. Default=on.

Save File Properties When on, any data entered in the File Properties dialog
on page 6920  is saved with the scene file and can be accessed with Windows
Explorer and File Finder on page 6939 . When off, the file properties information
is not stored with the file. Default=on.

Display Obsolete File Message Turns off the "Obsolete data format found -
Please resave file" alert that is displayed when you load a MAX file created in
an earlier version of 3ds Max. Default=on.

There is a matching "Do not display this message" check box in the alert itself,
and you can also turn off the alert from there.
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Reload textures on change When on, reloads bitmapped textures if the date
of the bitmap file has been updated. Default=on.

Recent Files in File Menu Sets the maximum number of recently edited MAX
files to display in the list File > Open Recent. Range=0 to 50. Default=9.

Auto Backup group

Auto Backup saves your work periodically. In the event of a power failure, if
you have not saved your work, you can load in an auto backup (autoback) file
from the autoback subdirectory in the program directory (or under \My
Documents\3dsmax\) and continue working with little lost work.

Auto Backup creates auto backup files based on a time interval. The name of
an auto backup file is AutoBackupN.max, where AutoBackup is the main part of
the name (AutoBackup is the default), and N is an integer from 1 to 99.

For example, if you've set Auto Backup to create three auto backup files at
one-minute intervals, Auto Backup will create AutoBackup1.max , and then a
minute later AutoBackup2.max , and then AutoBackup3.max. At the fourth
minute, the system overwrites AutoBackup1.max , and so on.

Enable Toggles Auto Backup.

Number of Autobak Files The number of backup files to write before
overwriting the first one. Range=1 to 99. Default=3.

Backup Interval (minutes) The number of minutes between backup file
generation. Default=5.0.

NOTE  This interval takes effect only if the scene changes; for example, if you
move an object or apply a modifier. If nothing changes, for example, if you leave
your computer for a while, then no backups are created. Also, if you save the scene
file manually, Auto Backup resets the Backup Interval timer.

Auto Backup File Name Lets you enter an alternative name for the auto
backup file. Auto backup files with a different name still have the filename
extension .max . Default=AutoBackup.

Log File Maintenance group

The following controls affect the max.log file.

Never Delete Log Determines how long the log file is maintained. When
you choose Never Delete, the max.log file remains on the hard disk and
continues to grow.
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Maintain Only...Days Resets the file to zero bytes after it reaches the number
of days specified in this field.

Maintain Only... Kbytes Resets the file to zero bytes after it reaches the
number of kilobytes specified in this field.

Errors Writes fatal errors to the max.log file instead of generating Alert dialogs.
Alerts halt network rendering for one or more servers.

Warnings Writes warning messages to the max.log file instead of generating
Alert dialogs.

Info Writes general information to the max.log file instead of generating
Alert dialogs.

Debug Writes debug messages to the max.log file instead of generating Alert
dialogs.

The type of errors covered by these four categories include maps that can't be
found, missing UV coordinates, missing output directories, full disks, missing
DLLs, disks to which you don't have access, invalid meshes, and obsolete MAX
files

Import Options group

Zoom Extents on Import Zooms all viewports to scene extents after importing
a file. If this is turned off, zoom extents isn't performed.

Archive System group

Program Specifies the name and location of the program to use for archiving.
The program must be independently installed on your system. You can add
command-line arguments to follow the executable file name. For example,
for the PKZIP program, the arguments might be:

project1.zip c:proj0?.max -o

Viewport Preferences

Customize menu > Preferences > Preference Settings dialog > Viewports tab

On the Viewports panel of the Preference Settings dialog, you set options for
viewport display and behavior.

You can also set the current Display Driver.
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See also:

■ Strokes on page 7631

■ Graphics Driver Setup Dialog on page 7582

■ Configure Driver on page 7585

Interface

Viewport Parameters group

Use Dual Planes Uses the front/back plane system when redrawing the
viewport. The selected object is manipulated in the front plane and is redrawn,
while other objects remain on the back plane and are not redrawn. This default
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setting provides the fastest redraws under normal circumstances. If your
assigned display driver doesn't support dual planes, this option is not available.

Turn off this setting to improve redraw speed if you are rotating the whole
scene or moving a camera through the scene (usually situations in which the
whole viewport needs to be redrawn anyway).

Show Vertices As Dots When on, the software displays vertices in mesh and
patch objects as small, solid-color squares, whose size you can set with the
Size parameter. When off, the vertex display is a tick mark.

Size Lets you specify the vertex size displayed in the viewports. Range=2 to
7. Default=2.

Handle Size Lets you specify the display size for handles attached to patch
vertices and spline vertices. Range=2 to 7. Default=3.

Draw Links as Lines Displays the hierarchical links on page 7806  between
parent and child objects as plain lines, rather than shapes when Display panel
> Link Display rollout > Display Link is turned on. Show Links is enabled in
the Object Properties dialog.

Backface Cull on Object Creation Determines whether to display faces with
normals on page 7863  pointing away from view. When turned on, you see
through the wireframe to the backfaces. This option applies to wireframe
viewport displays only. In most cases, you'll want this item turned on.
However, if you're modeling with NURBS surfaces, which consist of single-sided
planes, it's easier to view them from all angles when backface culling is turned
off.

■ This control affects only the created objects, and you can reverse the effect
on each object by changing the Backface Cull setting in the Object
Properties dialog for that object.You might turn off Backface Cull On Object
Creation before creating your NURBS, and then turn it on again when your
finished.

■ You can globally change the display of backface culling in the viewports
by turning on Force 2-Sided on page 7610  on the Rendering Method panel
of the Viewport Configuration dialog.

Attenuate Lights Turns the display of attenuation effects on page 7719  on or
off from start to end in the interactive viewport renderer. When turned off,
attenuated lights behave as though there was no attenuation. Default=off.

Mask Viewport to Safe Region By default, the viewport area outside the
outermost safe frame displays the contents of the viewport. When this box is
turned on, that area is left blank.
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Update Background While Playing Turns on the updating of bitmaps in the
viewport background when you play an animation. You need this capability
to check your action against a 2D rotoscoped on page 7912  background, even
if your animation plays at 1 frame per second. When turned on, an IFL file
on page 7131 , AVI file on page 7118 , or MOV file on page 7140  updates on each
frame when you click the Play button. Turn off the real-time on page 7908
switch in the Time Configuration dialog on page 7359  to use this feature.

In 3ds Max, the viewport updates not only when you click Play, but also when
you drag the time slider.

Filter Environment Backgrounds Affects the background displayed in the
viewport only when the Viewport Background dialog > Use Environment
Background switch on page 95  is on.

When you turn on Filter Environment Backgrounds, the environment
background is filtered in the viewport, resulting in an antialiased image. When
you turn it off, the background image is not filtered, resulting in an aliased,
pixelated image.

Note the following:

■ Filtering slows down the recalculation of the viewport background image
about 30 to 40 percent. Unless you really need that smooth display, it's
best to leave the option off.

■ This option doesn't affect the rendered background image, and doesn't
effect the viewport backgrounds when you turn on Use Environment
Background.

Low Res Environment Background Reduces the size of the environment
background map by half, and then magnifies it to the size needed for the
viewport. This results in a chunkier, pixelated appearance, but speeds the
rendering in the viewport by four times (because it halves the width and the
height of the original image).

TIP Unless you need fine detail in your environment background, it's best to leave
this item turned on.

Display World Axis Displays a world axis in the lower-left corner of all
viewports when turned on. Default=on.

Grid Nudge Distance Sets the nudge distance for the Nudge Grid Down and
Nudge Grid Up keys, which you can use to move selected objects into position.

Non Scaling Object Size Sets the display size of cameras, lights, and other
nonscaling objects. Default=1.
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Display Drivers group

Currently Installed Driver Displays the name of the currently installed driver.

Choose Driver Displays the Display Driver Setup dialog on page 7582 . Use
this dialog to select a different software display driver, or to switch drivers if
you installed a hardware accelerator card.

Configure Driver Displays the Configure Driver dialog on page 7585 , where
you can change the driver options for your currently selected driver.

Ghosting group

Ghosting Frames Specifies the number of ghost images that appear before
and after the current frame when you choose Show Ghosting from the Views
menu. If you display ghosts both before and after the current frame, the total
number of ghosts is twice this number.

Display Nth Frame Specifies the number of frames between the appearance
of each ghost. The smaller this number, the closer the ghost images appear to
each other.

Ghost Before Current Frame Displays only ghost images that occur before
the current frame. This makes the ghosts trail the object.

Ghost After Current Frame Displays only ghost images that occur after the
current frame.

Ghost Before and After Displays ghosts both before and after the current
frame.

Ghost in Wireframe Displays ghosts in black wireframe in shaded viewports.
When turned off, the ghosts appear as shaded objects, using the same colors
as the wireframe ghosts.

Show Frame Numbers Displays a frame number in the upper-left corner of
each frame.

Mouse Control group

Middle Button Pan/Zoom Sets the middle mouse button to pan in the
viewport if you have a three-button mouse. If you have a Microsoft
Intellimouse, you can also roll the middle wheel to zoom the viewport.

To Zoom with a three button mouse, press Ctrl+Alt and drag the center button.
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NOTE By default, the Intellimouse slows the speed of the mouse when you hold
down the wheel button. You can increase the mouse speed in the Mouse Properties
dialog in the Windows Control Panel. Choose the Wheel tab, click the Settings
button in the Wheel Button group, and turn the slider up to Fast.

Stroke Assigns command shortcuts to stroke patterns applied by dragging
with the middle mouse button. See Strokes on page 7631 .

Zoom About Mouse Point (Orthographic) When this control is turned on,
viewports zoom about the point where you click the mouse. With it turned
off, viewports zoom about the center of the view. This applies to orthographic
viewports only.

Zoom About Mouse Point (Perspective) When this control is turned on,
viewports zoom about the point where you click the mouse. With it turned
off, viewports zoom about the center of the view. This applies to perspective
viewports only.

Right Click Menu Over Selected Only Limits the right-click menu display
over a selected object. Default=off.

When this option is turned off; you can right-click anywhere in the viewports
to display a menu.

Wheel Zoom Increment Determines the sensitivity of the zoom when you
use the wheel on the mouse. Increase sensitivity up to a maximum value of
100 or reduce it to a minimum of 0.01. Default=1.0.

Gamma and LUT Preferences

Customize menu > Preferences > Preference Settings dialog > Gamma and LUT
tab

On the Gamma And LUT panel of the Preference Settings dialog, you set
options to adjust the Gamma on page 7798  and lookup-table (LUT)  values for
input and output images and for the monitor display.

Lookup-table (LUT) Correction

Lookup-table (LUT) correction provides compatibility with the same feature
used in other Autodesk Media & Entertainment products such as Combustion
and the systems suite: Inferno, Flint, Smoke, and so on. This feature allows
studios to implement a consistent way of displaying colors, assuming that
their monitors are calibrated to the same reference. Thus 3D artists can produce
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results that are closer to what the compositor expects by eliminating a variable
in the equation: the way colors are displayed on screen.

NOTE The lookup table controls available here do not affect exposure control or
lighting of the scene. While they do affect the colors of the final image, this is with
regard to the display only. By having a reference across a studio (with calibrated
monitors), using standardized lookup tables minimizes variability in rendered
output.

Also, please note that the LUT system of the systems suite is complex and
offers a variety of controls and flavors of lookup tables. This feature integrates
the View LUTs only, such as that found in Combustion, where only the
displayed images are modified.

Gamma Correction

Gamma correction compensates for the differences in color display on different
output devices, so that images look the same when viewed on different
monitors, or are used as bitmaps or in printed matter.

The calculation of “gamma” is output_intensity = input_intensity (1/gamma) .
That is, the result is the original value raised to the power of the inverse of
the gamma value. One result of this calculation is that a gamma value of 1.0
does not adjust the image at all.

Gamma = 1.0: no correction

I stands for Intensity.
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Another result of the gamma calculation is that black is not affected by the
adjustment, and neither is white (or any fully saturated color). Gamma
adjustment affects only the midtones of an image.

Left: gamma = 1.8

Right: gamma = 2.2, the standard for video

The horizontal axis represents input (the original value) and the vertical axis represents
output (the gamma-corrected value).

Computer monitors and videos don’t display color in a linear way (as in the
first illustration). Also, the brightness of a monitor tends to make an image
seem brighter than its intensity values really specify. Gamma correction fixes
this problem, and can ensure consistency between different applications or
different monitors. When you set gamma, find a value that makes middle
gray on your own monitor match a true middle (50 percent) gray.
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Changing gamma value to match a monitor's middle gray

The standard gamma value for video is 2.2. This is the theoretically correct
value, making the linear color space stored in the bitmap and used by the
renderer appear to be linear on screen.

However, because the response of photographic film isn’t linear either, users
find that this theoretically correct value looks too bright and washed out. A
common compromise is to render to a gamma of 1.7 or 1.8, making things
look more photographic; that is, as if the image had been shot on photographic
film and then developed.

We recommend that you always turn on gamma correction when you share
bitmaps between different computers, between different applications on the
same computer, or create renderings to use in printed matter.

NOTE

If the only other applications that use your renderings are also Autodesk Media
& Entertainment products, you might want to use LUT correction instead of
gamma correction.

Two common mistakes have to do with gamma correction:

■ Not applying gamma correction when it should be used. This results in
renderings or bitmaps that are too dark.

■ Inadvertantly applying gamma correction twice. This results in renderings
or bitmaps that are too bright.

See the Procedures section below for more detailed instructions.
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Procedures

To set the gamma for renderings you will use as bitmaps or in printed matter:

1 Choose Customize > Preferences.

2 Turn on Enable Gamma/LUT Correction.

3 Turn on Load Enable State With MAX Files.

This step is optional but recommended. It ensures that the gamma settings
are used with all your scenes.

4 In the Display group at the left-hand side of the panel, choose Gamma.

5 Use the Gamma spinner to adjust the Gamma value until the gray square
in the center of the display shows no contrast with the surrounding
border.
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Above: A bad gamma value

Below: A good gamma value

The value you choose can vary, depending on your system's monitor.

6 Once you have a good gamma value, change Output Gamma in the
Bitmap Files group on the right-hand side of the tab to the same value
as Display gamma.

7 Click OK.

To set the gamma for incoming bitmaps generated (or edited) by other
applications:

1 Find out whether the other application has its own gamma correction.

2 If it does, choose Customize > Preferences > Gamma And LUT. Turn on
Enable Gamma/LUT Correction, and choose an Input Gamma value that
matches the application’s.

If the file type (for example, Targa) has an embedded gamma value, you
might need to set Input Gamma to the inverse (1/gamma) of the file’s
embedded gamma, to avoid applying gamma correction twice.

3 If it does not, choose Customize > Preferences > Gamma And LUT. Turn
on Enable Gamma/LUT Correction, then in the Bitmap Files group, change
the Input Gamma to a suitable value.
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Input gamma set to a value suitable for a different application

It might take some experimentation to find the gamma value that best
adjusts the bitmaps created by the other application. The bitmap should
appear the way it does in the other application: if it appears too light or
too dark in 3ds Max, try a different Input Gamma value.

IMPORTANT If you use bitmaps from multiple applications, and these
different applications have different ideal Input Gamma values, then turn on
gamma correction, but leave Input Gamma set to 1.0. Instead, for each
bitmap you read, use the individual Select Bitmap Image File dialog to set
the gamma value appropriate to the program that created the bitmap.

Example: To use gamma correction with Adobe Photoshop:

1 In Photoshop, make sure Edit > Color Settings is set to “North America
General Purpose Defaults”, with Working Space > RGB set to “sRGB
IEC61966-2.1”.

This is the default color correction in Photoshop.

2 Also in the Photoshop Color Settings dialog, change Color Management
Policies > RGB to “Convert To Working RGB”.

3 In Photoshop, click OK and then save the bitmap file.

4 In 3ds Max, choose Customize > Preferences > Gamma And LUT.

5 On the Gamma And LUT tab, turn on Enable Gamma/LUT Correction.
In the Display group, choose Gamma, then set the gamma value to 2.2.

6 In the Materials And Colors group, turn on both Affect Color Selectors
and Affect Material Editor.

7 In the Bitmap Files group, set both Input Gamma and Output Gamma
to 2.2.
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8 Click OK to close the Preferences dialog.

Now when you use a bitmap saved by Photoshop, the colors in 3ds Max
should preserve the bitmap’s original colors.

To use gamma with video hardware:

Video devices such as video tape recorders usually have their own hardware
gamma-correction circuitry.

■ If your video device has its own hardware gamma correction, do not turn
on gamma correction in 3ds Max.

■ If your video device does not perform gamma correction automatically,
follow the preceding steps for setting Input Gamma and Output Gamma,
using values approprate to your video device. Typically these will be Input
Gamma = 0.45 and Output Gamma = 2.2.

Typical input and output gamma settings for video that has no hardware gamma
correction
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Interface

Enable Gamma/LUT Correction  Makes available the controls for adjusting
gamma or LUT correction. Turn off to disable gamma/LUT correction.
Default=off.

Load Enable State with MAX Files Loads the state of Enable Gamma/LUT
Correction with each 3ds Max file. Default=off.

When you choose Load Enable State, and load a scene file whose Enable
Gamma/LUT Correction state differs from the current state, you can make the
correction correspond with the setting in the current file or leave the setting
as is.

If you have a maxstart.max file and you choose this option, new sessions of
3ds Max use the Enable Gamma/LUT Correction state in the file. If you turn
this option, off, the file doesn't affect the state of Enable Gamma/LUT
Correction.
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Display group

Display gamma correction or lookup tables applies to viewports and the
rendered frame window on page 5885 . Use the controls in this group to load
an Autodesk View LUT or adjust gamma numerically.

Autodesk View LUT Click the Browse button and then use the Load LUT File
dialog to find and open a LUT file. Thereafter the LUT file name appears in
the text field to the right of the button.

NOTE 3ds Max does not support generation of LUT files at this time, and no LUT
files are included with the software. To create a LUT file, use a program such as
Combustion.

Gamma Adjusts the gamma display for 3ds Max. The spinner value increases
or decreases the value (lightness or darkness) of the solid gray center square.
Adjust the value until the center square is as close as possible in value to the
surrounding checkered border. Range = 0.1 to 5.0.

If you're creating bitmaps or renderings that will be sent to someone else, set
Output Gamma to match the correct Display Gamma value. This ensures that
the image will look correct at the destination site.

You can also display these gamma settings from the Gamma button in the
File Browser dialog; for example, when you are rendering a scene to an image
file.

Materials and Colors group

By default, the Gamma setting affects the viewport display and rendered
frames, but not the Color Selector or the Material Editor. These switches can
enable gamma correction for either or both of these dialogs.

Affect Color Selectors When on, the Gamma setting affects the display of
colors on the standard 3ds Max Color Selector. This setting has no effect on
the Object Color dialog.

Affect Material Editor When on, the Gamma setting affects the display of
colors on the Material Editor dialog.

Bitmap Files group

Input Gamma Adjusts bitmaps that you load (for example, texture m aps),
provided that the bitmap type doesn't override the gamma with its own gamma
value. Range = 0.1 to 5.0.
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In the case of Targa files, for example, the file's inherent gamma will override
the 3ds Max Input Gamma. In this case, set Input Gamma to the inverse
(1/gamma) of the incoming gamma correction. This avoids applying gamma
correction twice, which will make the bitmap too bright.

Output Gamma The gamma correction applied to bitmaps that you render.
Set this to match the correct Display Gamma value. Range = 0.1 to 5.0.

Rendering Preferences

Customize menu > Preferences > Preference Settings dialog > Rendering tab

On the Rendering panel of the Preference Settings dialog, you set options for
rendering, such as the default color of ambient light in rendered scenes. The
many choices available enable you to reassign the renderers used for production
and draft rendering.

Interface
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Video Color Check group

Some pixel colors are beyond the safe NTSC on page 7863  or PAL on page 7882
threshold. You can choose to flag or modify them to acceptable values.

Flag with Black Flags all illegal pixels with black to show you the illegality
of your image. This mode teaches you how to make correct colors, instead of
depending on Scale options. Scale options force a natural discontinuity in the
color values. In some cases, that discontinuity can cause visible aliasing on
page 7708 .

Scale Luma Scales the luminance to bring the color into range, and maintains
saturation. This generally makes the illegal areas appear darker than they
should be.

Scale Saturation Scales the chroma to bring the color into range, and
maintains saturation. Because this option keeps the brightness levels of the
pixels fairly equal to the unscaled ones, this is the more useful of the two scale
methods.

NTSC/PAL Determines the standard for the video color check. See NTSC
(Glossary) on page 7863  and PAL (Glossary) on page 7882 .

Output Dithering group

Sets output dithering on page 7760  for all file types.

True Color Turns dithering on or off for any true color output device. For
24-bit work, you should turn True Color on. For paletted work, you can turn
it off.

Paletted Turns dithering on or off for any 8-bit paletted device.

Field Order group

Odd/Even Selects the field order of rendered images when the Render to
Fields option is turned on in the render dialog. Some video devices require
that the even field be first, other video devices require that the odd field be
first. Determine the correct field order for your video device. If the video
output of your device is strobing or appears jittery, it may be due to incorrect
field on page 7777  order, try changing this parameter and re-rendering your
animation.
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Super Black group

Threshold Keeps the super black on page 7942  threshold above a certain level
primarily for luminance keying.

HotSpot/Falloff group

Angle Separation Locks the spotlight hotspot on page 7811  and falloff on
page 7811  cones at the angle separation defined by the spinner (degrees). This
option constrains the hotspot angle so that it can't equal the falloff and cause
aliasing artifacts.

Background group

Don't Antialias Against Background Ensures that the edges of rendered
geometry aren't antialiased against the background. The inside of the geometry
is still antialiased. Keep this control off unless you're creating sprites for game
development, or require special compositing techniques because the
background will not be rendered. In these cases, turning on this option helps
avoid generating alpha antialiasing on the outlines of the geometry.
Default=off.

NOTE You must be rendering against a black background if Don’t Antialias Against
Background is turned on.

Filter Background Controls whether or not a background image is affected
by the Renderer’s antialiasing Filter. See Plate Match /MAX R2.5/VIZ R2 Filter
Types in Default Scanline Renderer Rollout on page 5949  for detailed
information of filtering background and antialiasing.

Use Environment Alpha Controls whether or not the renderer uses the
environment map’s alpha channel in creating the alpha for the rendered
image. If Use Environment Alpha is turned off, the background is completely
transparent. If it is turned on, the alpha of the resulting image is a combination
of the scene and image’s alpha. Note that only background images with alpha
channels or black backgrounds are supported when compositing in other
programs such as Photoshop.

Default Ambient Light Color group

Click the color swatch to change the default ambient light on page 7710  color
for renderings. This color will be the darkest color for rendered shadows in
the scene.

7562 | Chapter 24   Customizing the User Interface



Output File Sequencing group

Nth Serial Numbering Specifies whether output frame files generated using
a frame-step value other than 1 are numbered sequentially (on) or according
to their true frame numbers (off).

Render Termination Alert group

Beep Beeps when the rendering has finished. You can set the frequency and
the duration.

Play Sound Plays a sound file when the rendering has finished.

Choose Sound Opens the Open Sound browser dialog, select a sound file
using the browser. You can test sound files with the Play button in the Open
Sound dialog. Press ESC to turn off the sound.

GBuffer Layers group

Maximum Number Limits the number of layers that are stored in the G-buffer
during rendering. Default=10; Range=1 to 999.

Memory requirements might dictate that you limit the number of G-buffer
layers. The RLA and RLF image formats, used for compositing, can store many
G-buffers for object Z buffer information, material ID, transparency, and so
on.

Multi-threading group

On Causes the software to treat the rendering task as separate threads. This
option works with multiprocessor systems. Each processor in your computer
handles a different thread, which makes full use of available processing power
and speeds up rendering to its maximum level. When off, 3ds Max treats a
rendering task as a single processing task and doesn't divide it up.

Bitmap Pager group

The Bitmap Pager can help with the rendering of scenes that have very large
textures, a large number of textures, or when rendering a high-resolution
image.

TIP You can access a Bitmap Pager Statistics dialog on page 6947  with useful pager
information such as memory usage: Go to Customize menu > Customize User
Interface, find the Bitmap Pager Statistics Toggle item in the Main UI list, and then
assign it as a keyboard shortcut or other UI element.
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On When turned on, the software creates a series of temporary “page” files
on the drive where it is installed for use in rendering bitmaps.

Page Size (kB) Sets the size of the bitmap page. If textures are smaller than
the page size, the system allocates only the memory required.

Bitmap Size Threshold (kB) Sets the minimum size (in kilobytes) that a
bitmap must be in order to be paged.

Memory Pool (kB) Controls the amount of memory used by the pager. All
pages remain in memory until this limit is reached. When the limit is reached,
the pager begins saving pages to disk. Pages that are not frequently used are
paged out; more frequently used pages are kept in memory.

Animation Preferences

Customize menu > Preferences > Preference Settings dialog > Animation tab

On the Animation panel of the Preference Settings dialog, you set options
relating to animation on page 7711 . Options include displaying animated
objects in wireframe viewports, the assignment of sound plug-ins, and
controller defaults.

Procedures

To change the default transform center:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Animation tab.

2 Turn off Local Center During Animate in the Animate group.

This changes the default and activates all the transform center buttons.
You can now move about the selection, coordinate center, or local pivot.

To set the key bracket display:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Animation tab.

2 Use the controls in the Key Bracket Display group to specify how you
want key brackets displayed in wireframe viewports.
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To specify default controller settings:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Animation tab.

2 Click Set Defaults in the Controller Defaults group.

The Set Controller Defaults dialog appears.

3 Choose a controller type from the list of available controllers and click
the Set button.

A dialog containing the default settings supported by the selected
controller type appears in, for example, the In and Out tangents for a
Bezier controller.

4 Make changes to the controller settings.

Once you click OK in the Set Controller Defaults dialog, the controller
defaults are changed.

Changes to the controller default settings are written to your 3dsmax.ini
file and become the defaults for all newly assigned controllers and all
new scenes.

If you decide that you want to revert to the original 3ds Max defaults for
all controllers, you can click Restore To Factory Settings.
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Interface

Key Bracket Display group

When you move to a frame, the software displays white brackets around
objects that have transform keys on page 7824  at that frame, including cameras
and lights. These key brackets only appear in wireframe viewport displays.

All Objects/Selected Objects/None Specifies which objects will display key
brackets.

Use Current Transform Displays brackets only on those frames containing
a key for the transform button on page 7958  (Move, Rotate, or Scale) currently
active in the toolbar.

If no transform button is active, a bracket appears when you're on a frame
containing any of the three transforms.

Position/Rotation/Scale Specifies which type of transform displays a bracket.
If only Rotation is turned on, brackets appear only on those frames containing
Rotation keys. These check boxes become active when Use Current Transform
is turned off.
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Animate group

Local Center During Animate Locks the center method to local on page 7830
. Turn off if you want to animate around a non-local center such as world or
selection.

MIDI Time Slider Control group

Enables use of a MIDI device to control the time slider. Choose On to use the
MIDI device specified in the MIDI Time Slider Control Setup dialog on page
7600 , which is displayed with the Setup button.

Sound Plug-In group

Assign Displays a dialog listing all sound plug-ins installed in the system.
Select a new plug-in to replace the current one.

Controller Defaults group

Sets the default values for animation controllers capable of supporting default
settings. For example, set the default values for tension, continuity and bias
in the TCB float controller.

Override Parametric Controller Range By Default When on, new parametric
controllers are active throughout the timeline, independent of their animation
range. Otherwise, they respect it and are only active within their range. Refer
to Ignore Animation Range on page 3520  and Respect Animation Range on
page 3521  for more details. Default=on.

Spring Quick Edit Toggle to increase the accuracy of all spring controllers
in the scene. To be used with the Rollback input field. Default=off.

NOTE This option is saved in the 3dsmax.ini  file as SpringsQuickEdit .

NOTE Turning on this option can impact scene performance.

Rollback Sets the number the frames a spring controller goes back before
becoming invalid. Default=6.

NOTE This option is saved in the 3dsmax.ini  file as SpringsRollingStart .

NOTE Setting a high number can impact scene performance.

Set Defaults Displays a dialog listing all controllers that can have their default
values changed. The Set button becomes available when you choose a
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controller class from the list. Highlight a controller class, click Set, edit the
default key values, and then click OK.

Restore To Factory Settings Prompts you to verify if you want to reset all
controllers to the program's default settings. If you choose Yes, the defaults
are reset for all controllers currently in the system.

Auto Key Default Frame group

On When on, using Auto Key mode to set a key at a frame other than the
start frame (0 or 1) also creates a key at the start frame. When off, no key is
created at the start frame.

[default frame] When Auto Key Default Frame is on, this setting specifies
the start frame at which 3ds Max sets a key when you use Auto Key to set a
key at a frame other than the start of the animation.

The available settings are 0 and 1. When you set the default frame to 1, 3ds
Max uses the equivalent in the current time display system, set via the Time
Display setting on page 7364  on the Time Configuration dialog. For instance,
if Time Display is set to MM:SS:TICKS, the equivalent to frame 1 is 0:0:160.

Inverse Kinematics Preferences

Customize menu > Preferences > Preference Settings dialog > Inverse Kinematics
tab

On the Inverse Kinematics panel of the Preference Settings dialog, you set
options for both applied and interactive inverse kinematics on page 7820 .

Procedures

To prevent transforming unlinked objects while working in IK mode:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Inverse Kinematics tab.

2 On the Inverse Kinematics panel, turn off the option labeled Always
Transform Children Of The World.

Single, unlinked objects are hierarchies of one object. An unlinked object
is its own root and also a child of the world, so turning off Always
Transform Children Of The World prevents you from transforming single
objects in IK mode.
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Interface

Applied IK/Interactive IK group

The threshold and iterations settings are a trade-off between accuracy and
speed. With the two groups of settings you can individually tune the behavior
of Interactive IK and Applied IK. Interactive IK provides fast, real-time response,
so you should set Interactive IK preferences for speed. Applied IK provides the
IK solution on page 7813  to match the follow objects on page 7789  very closely.
You should set applied IK preferences for accuracy.

Position Sets how close the end effector has to get to the follow object or
cursor position for the object to be considered a valid solution. The value
represents a distance in the current display unit system. Small values increase
accuracy but take longer to solve.

Rotation Sets how accurately the end effector has to match the orientation
of the follow object to be considered a valid solution. The value represents a
rotation angle in degrees. Small values increase accuracy but take longer to
solve.

Iterations Sets the maximum number of times 3ds Max repeats the IK
calculations to find a valid solution. A high iterations value increases the
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chance that 3ds Max can calculate a valid IK solution, but the calculation
takes longer to complete.

Ungrouped controls

Use Secondary Threshold Compares the second derivative of the end effector
on page 7767  to a very small threshold. If the derivative is within the threshold,
IK is terminated.

Always Transform Children Of The World Applies when IK is turned on in
both move and rotate mode. It affects only an object that's a direct child of
the world when the object is selected.

For example, if the root of an IK chain is a child of the world, and you're
manipulating an object at the end of the chain (the root object itself isn't
selected), any constraints set for the root object will be observed. However, if
you select the root object and try to move it, its constraints will be ignored.

Gizmos Preferences

Customize menu > Preferences > Preference Settings dialog > Gizmos tab

You set the display and behavior of the Transform gizmos on page 865  on the
Gizmos panel of the Preference Settings dialog.
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Interface

Transform Gizmos group

On When on, 3ds Max uses the Transform gizmo to enable more powerful
move, rotate, and scale options. When turned off, a basic tripod is displayed,
with no axis specificity.

Show Axis Labels Toggles the display of the axis labels on the Transform
gizmo.

NOTE Functionality is maintained when axis labels are turned off.

Allow Multiple Gizmos Toggles the display of more than one gizmo at a
time.

When turned off, a Transform gizmo will only be displayed for one object at
a time in a selection set.
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When turned on and when Use Pivot Point Center in the Use Center flyout
is active, each object in a selection set will have its own transform gizmo.

Size Sets the size of the Transform gizmo as a percentage of the viewport
size. Range=1 to 100.

Move Gizmo group

Relative Size (%) Sets the size of the Move gizmo, relative to the Size value
of the Transform gizmo. Range= 0.0 to 500.0.

Plane Handles group

The plane handles let you constrain object movement along combinations of
any two axes.

On Toggles the use of plane handles on the Transform gizmo.

Size Sets the size of the plane handles, as a percent of the distance from the
Offset to the tripod axis. Range=0.0 to 100.0.

Offset The percentage of the distance from the gizmo's tripod axis to the
outer extent of the Primary axis handles.

For example, 0 = no plane handles; 100 = plane handles extend as far as the
Primary axis handles.

Center Box Handle group

The center box can be used as a handle for translations constrained parallel
to a viewport.

Move in Screen Space Toggles the use of the center box handle.

Rotate Gizmo group

Relative Size (%) Sets the size of the Rotate gizmo, relative to the Size value
of the Transform gizmo. Range= 0.0 to 500.0.

Free Rotation Toggles the use of free rotation.

NOTE When this is turned off, you can only rotate an object along an axis, or
parallel to the screen (if Screen Handle is on).

Show Tripod Toggles display of an axis tripod at the pivot point. This tripod
also highlights the selected axis while rotating.
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Screen Handle Toggles display of the screen orbit, which lets you rotate an
object parallel to a viewport.

Show Pie Slice When on, a shaded pie slice acts as a visual indicator of the
direction and amount of rotation.

NOTE If you rotate more than 360°, the slice overlaps and the shading becomes
more and more intense.

Angle Data When on, numerical feedback appears during rotation, indicating
rotation values along the X, Y, and Z axes.

Rotation Method Sets the rotation method for the gizmo:

■ Linear Roll: Rotate the virtual trackball by dragging in a single direction,
tangent to the Rotate gizmo.

NOTE A tangent handle will appear to show the best direction to drag the
mouse.

■ Circular Crank: Rotate the virtual trackball by dragging around the Rotate
gizmo, in a circular manner.

■ Legacy R4: Turns off virtual trackball behavior, and uses the rotation
method from 3ds Max 4.

Planar Angle Threshold Determines when the Circular Crank rotation method
will automatically switch to Linear Roll to prevent loss of control over the
gizmo.

This occurs when a Primary axis is nearly 90 degrees to the view plane, making
it different to circle around. Any angle to the view plane that is higher than
this setting will use Crank mode, but any angle equal to or less than this
setting will always function as a Linear Roll.

Scale Gizmo group

Relative Size (%) Sets the size of the Move gizmo, relative to the Size value
of the Transform gizmo. Range= 0.0 to 500.0.

Uniform Handle Size (%) Sets the size of the handle for uniform scaling (the
distance from the transform center to the edge of the uniform handle), as a
percentage of the scale gizmo size.
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2–Axis Handle Size (%) Sets the size of the handle for non-uniform scaling
along 2–axes (the distance from the edge of the uniform handle to the edge
of the 2–axis handle), as a percentage of the scale gizmo size.

Uniform 2–Axis Scaling Forces scaling using a 2–axis plane handle to be
uniform.

Move/Rotate Transforms group

Controls the way you can move selected objects with the mouse in a non-
orthographic on page 7877  view such as Perspective on page 7891 .

Intersection Shoots a ray from the mouse point into the screen. This makes
moving objects easier, but as you move toward the horizon on page 7809 , the
object moves great distances.

Projection Projects the motion of the mouse onto the plane. This ensures
that there are no singularities at the horizon, and that motion is always smooth
and stable. However, it can become difficult to move objects when the plane
is not parallel to the screen.

Persp Sens Sets mouse sensitivity for projection transforms.

Rotation Increment Specifies the amount of rotation generated by moving
the mouse 1 pixel. Lower this value for angular rotations smaller than the
default .5 degrees. The lower this value, the more mouse movement is needed
to rotate objects.

Viewport Arc Rotate Snap Angle Sets the amount of rotation in degrees.

 Turn on Angle Snap on the main toolbar, and then use Arc Rotate on
page 7395  to rotate a viewport. The viewport rotation snaps by the value set
here. The Arc Rotate cursor displays a small magnet in the upper left to indicate
that Angle Snap is turned on.

MAXScript Preferences

Customize menu > Preferences > Preference Settings dialog > MAXScript tab

On the MAXScript panel of the Preference Settings dialog, you set MAXScript
and Macro Recorder preferences, enable or disable auto-loading of scripts, set
the initial heap size, change font style and size used in the MAXScript editor,
and manage all the settings for the Macro Recorder.
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You can also change these settings by editing the [MAXScript] section of the
3dsmax.ini file.

NOTE Two paths to support auto-startup scripts are on the Configure User Paths
dialog on page 7520  and Configure System Paths dialog on page 7523 : ..\scripts
and ..\scripts\startup . If you prefer to start scripts from a different directory, you
can change these default directories with the corresponding Customize menu
commands.

Choose Help > MAXScript Reference for details on MAXScript.

Interface

Startup group

You can start scripts automatically in two ways. You can create a file named
startup.ms that contains your startup code. MAXScript searches for this file in
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the scripts directory first, then the 3ds Max root directory, and finally the
directories specified in the Windows PATH environment variable. MAXScript
stops searching after it finds the first occurrence of startup.ms.

You can also place the script files you want auto-loaded into the \startup
directory inside the \scripts directory. MAXScript loads any script file with the
file name extension .ms or any encrypted script file with file name extension
.mse.

If you have both a startup.ms file and auto-load files in the \startup directory,
MAXScript always loads startup.ms first.

Load Startup Scripts Loads scripts automatically when 3ds Max starts.

Load/Save Scene Scripts Enables Scene Script loading and saving.

Load/Save Persistent Globals Enables load and save Persistent Globals.

MAXScript supports a limited form of variables. You declare that a particular
global is persistent and the value it contains is always saved to and restored
from scene files as they are opened and closed. In this way you can, for
example, keep direct references to objects in the scene in variables. Those
references will move across scene save and reload.

MAXScript Windows group

Font Choose a font for the MAXScript editor

Font size Choose a font size for the MAXScript editor.

Auto Open Listener On Output Opens the Listener if a script sends output
to a WindowStream value with no associated window. This would require a
MAXScript extension.

Runtime group

Use Fast Node Name Lookup When on, MAXScript indexes scene node
names in a cache, resulting in significantly faster resolution of non-wildcard
pathname values (for example, $box01) to node values. When off, the scene
nodes are enumerated as MAXScript looks for a scene node name that matches
the pathname, resulting in slower lookups.

Turn this off if you encounter an incompatibility with an existing script.

Memory group

Initial Heap Allocation (Mbytes) Sets the initial heap allocation.
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MAXScript carves its own working memory (called a heap) out of the memory
that the software allocates. You can add to the heap at any time by increasing
the value here.

Macro Recorder Group

Enable Macro Recorder Enables the Macro Recorder.

3ds Max starts with the macro recorder disabled and a minimized
Macro-Recorder pane in the MAXScript listener window.

You can also enable the Macro Recorder by turning on MAXScript > Macro
Recorder or by turning on Enable in the Macro Recorder menu on the
MAXScript Listener toolbar.

This state is stored in the 3dsmax.ini file. Turning it on once keeps it enabled
across restarts of the program.

Code Filters group

Command Panel Switchings Displays command panel switchings in the
code.

Tool Selections Displays tool selection in the code.

Menu Item Selections Displays menu selection in the code.

Code Generation group

The Code Generation parameters refer to whether or not the script emitted is
made selection-relative, if possible, or if it contains object references. By making
the script selection-relative, you can apply the recorded script to a different
selection, thereby making it more general. Absolute mode always works on
the same objects regardless of the current selection.

Explicit Scene Object Names Uses scene object names in the code.

Selection-relative Scene Object Names Makes Scene Object Names relative
in the code. Default=on.

Explicit Sub-object Sets Uses explicit sub-object sets in the code.

Selection-relative Sub-object Sets Uses selection relative sub-object sets in
the code. Default=on.

Absolute Transform Assignments Uses absolute transforms in the code.

Relative Transform Operations Uses selection relative transform operations
in the code.
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Radiosity Preferences

Customize menu > Preferences > Preference Settings dialog > Radiosity tab

On the Radiosity panel of the Preference Settings dialog, you set options for
the radiosity solution on page 5976 .

See also:

■ Modeling Global Illumination with Radiosity on page 5976

■ Radiosity Controls on page 5995

Interface

Material Editor group

Display Reflectance & Transmittance Information When on, reflectance
and transmittance values on page 5228  are displayed in the Material Editor.

NOTE In order to make this change effective, you need to close and restart the
Material Editor.
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Interactive Display group

Display Radiosity in Viewports When on, radiosity effects are displayed in
the viewports.

Radiosity Processing group

Automatically Process Refine Iterations Stored in Geometric Objects When
on, all refine iterations stored in geometric objects are automatically processed.

Start/Reset Behavior

Display Reset Warning When on, a warning message is displayed whenever
you reset the radiosity solution in your scene.

Update Data When Required on Start When on, the radiosity engine must
be reset and then recalculated if the solution is invalidated. In this case, the
Start button changes to read Update & Start. When this is pressed, the radiosity
solution is reset and the calculation starts over again.

When this toggle is off, the radiosity solution does not need to be reset if it is
invalidated. You can continue processing your scene with the invalid solution.

NOTE The radiosity solution is invalidated any time an object or light is added,
removed, moved, or altered in any way.

File Save group

Save Scene Information in MAX file (Decreases Load Time) The light levels
from the radiosity solution are always saved with the file, however when this
is on, some additional radiosity information is saved with your scene.

NOTE Having this on decreases file load time, but increases the file size.

mental ray Preferences

Customize menu > Preferences > mental ray panel
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Interface

General group

Enable mental ray Extensions When on, enables certain features that provide
additional support for the mental ray renderer. When off, these features do
not appear in the interface. Default=off .

These are the features enabled as mental ray extensions to 3ds Max:

■ mental ray Connection rollout on page 5289  for materials (Material Editor)

■ mental ray Light Shader rollout on page 5063  (Modify panel for lights)

WARNING If you have assigned shaders and adjusted their settings using the
mental ray Connection rollout, turning off Enable mental ray Extensions will lose
all these assignments and settings . The same applies to light shader assignments.

Rendering group

Show Brackets on Current Buckets Displays white selection brackets at the
corners of the bucket currently being rendered. Default=on.
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Show Visual Final Gather Progress When on, the rendered frame window
on page 5885  displays a coarse image of the final gather points as those points
are being calculated. This provides visual feedback of the final gather solution
in progress. Default=on.

If you prefer that the final render directly overwrite the previous one in the
rendered frame window for comparison purposes, turn this off.

Visual display of final gather calculation in progress

Clear Frame Window Before Rendering When on, before rendering the
rendered frame window on page 5885  turns to a gray shade by clearing every
other scanline. This makes it easier to see the progress of rendering. On the
other hand, it can make it more difficult to see the effect of small changes to
the model or the view. Default=on.

Messages group

Open Message Window on Error Whenever the mental ray renderer detects
an error, it generates an error message. When this option is on, the Messages
Window is displayed and the error message appears in it. Default=on.
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Show/Log Information Messages When on, displays informational messages
in the Messages Window. Default=off.

Show/Log Progress Messages When on, displays progress messages in the
Messages Window. Default=off.

Log Debug Messages (to file) When on, writes debug messages to the log
file, if one has been specified. Default=off.

Debug messages are never displayed in the Messages Window. The mental ray
renderer generates a large number of them, which would make the window
hard to read.

Write Messages to File When on, generates a mental ray log file on page
7832 . Default=off.

The other log file options are unavailable unless you turn on Write Messages
To File:

■ Append to File When on, appends messages to the existing file. When
off (or if the named file is not found), only new messages are written to
the file. Default=off.

■ File Click to display a file dialog that lets you choose the name and
location of the .log file.

■ File name field When you have specified a log file, this field shows its
name and its path.

Graphics Driver Setup Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Choose Driver button

(With Direct3D active) Customize menu > Preferences > Preference Settings
dialog > Viewports tab > Display Drivers group > Choose Driver button >
Direct3D Driver Setup dialog > Revert From Direct3D button

You choose and configure graphic display drivers on the Viewports panel of
the Preference Settings dialog. This topic explains driver options available on
the Display Driver Setup dialog and analyzes tradeoffs in performance.

You can also change the graphics driver when you start 3ds Max by going to
the Start menu and choosing Programs > Autodesk > Autodesk 3ds Max 2008
[installed version] > Change Graphics Mode.
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See also:

■ Configure Driver on page 7585

■ Configure Software Display Driver Dialog on page 7586

■ Configure OpenGL Dialog on page 7588

■ Configure Direct3D Dialog on page 7594

■ Direct3D Driver Setup Dialog on page 7592

Custom

Choose this if you have a custom driver installed on your system. Such custom
drivers don't use the software display driver (Heidi), OpenGL, or Direct3D. If
you don't have such a driver installed, this option is not available.

Interface

On the Display Driver Setup dialog, some options are unavailable if the
corresponding driver is not installed in the system. The currently installed
driver is listed in the Display Driver group.

NOTE The first time you launch 3ds Max Direct3D is selected be default.
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Software Display Driver

Choose this if you're using software rather than hardware acceleration. This
choice is always available.

OpenGL

Choose this option if you're using any form of hardware acceleration. The
software will use whatever driver has been installed in your operating system.

The OpenGL driver supports geometry acceleration as well as rasterization
acceleration. It offers the optimum display performance for animated
deforming meshes. It's tightly integrated into Windows NT and Windows
2000, and many 3D display cards were specifically designed to accelerate
OpenGL operations. OpenGL implementations have all of the scene data
necessary to optimize the entire 3D display process.

Because OpenGL is most efficient when run on systems with at least
rasterization acceleration, the software display driver/SZB option may work
best on systems with an ordinary 2D display card. However, with a 3D-enabled
card, you may see dramatic acceleration using the OpenGL driver.

The disadvantages of the Open GL driver are as follows:

■ All potentially visible scene data must be transferred to the driver, and this
can cause a communication bottleneck across the system bus. In particular,
this slows down the display of individual primitives (as opposed to strips
or polylines, like wireframe displays).

■ Because the OpenGL design supports a wide variety of display systems,
there is no guarantee that either incremental scene update methods (partial
window blits (Block Image Transfers) or dual planes) will work with a
particular implementation of OpenGL.

■ Because lighting and texturing are restricted to OpenGL-specified semantics,
mismatches between 3ds Max scene lighting and texturing and what
appears in an OpenGL viewport can occur. This applies especially to
attenuated lights and non-tiled texture display.)

Direct 3D

Choose this if you have a Direct3D (D3D) driver installed on your system. If
you don't have DirectX 8.1 or above installed, this option is unavailable.
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To configure the Direct3D driver, click the Advanced Direct3D button. This
button, which is available only when Direct3D is the active option, opens the
Configure Direct3D dialog on page 7594 .

To switch to a different display driver when Direct3D is the active driver, click
the Choose Driver button on the Viewports tab of the Preference Settings
dialog to open the Direct3D Driver Setup dialog on page 7592 , click Revert
From Direct3D, and then choose the new driver from the Graphics Driver
Setup dialog.

The Microsoft Direct3D API supports both rasterization and 3D scene-level
calls. It offers the optimum display performance for large modeling tasks, and
pixel and vertex shading. (3ds Max supports only D3D Version 8 or above,
which is included in DirectX 8.1.) D3D calls are accelerated if the display
hardware supports this.

Many inexpensive 3D display cards can use this driver efficiently. This driver
supports scene data culling efficiently, accelerates texture display (depending
on the specific display card), and performs perspective correction.

The driver works with high-color displays, which provide a good trade-off
between display quality and memory overhead. Incremental display update
works efficiently.

The disadvantages of the Direct3D driver are as follows:

■ The driver currently runs only under Windows 98, Windows Millennium,
Windows 2000, and Windows XP. (There is no multi-processor Windows
NT support.)

■ Dual-plane operations are slow (if available), and there can be some
additional overhead in minimizing/maximizing viewports due to the way
D3D allocates video memory.

You can download D3D drivers from this location:
http://www.microsoft.com/windows/directx/.

Configure Driver

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Configure Driver button

You configure the current display driver using the Viewports panel of the
Preference Settings dialog.
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Changes to a driver's configuration take effect immediately, and the
configuration persists between sessions. However, data downloaded to the
graphics card is not regenerated. For example, if you change the texture
resolution, the hardware continues to use the previous resolution until you
use the Material Editor to reload the texture.

The options in the driver configuration dialog vary, depending on which
driver is in use. This reference describes the options for the software display
driver on page 7586 , Direct3D driver on page 7594 , and Open GL driver on page
7588 .

If you use a custom driver, the options depend on what the driver's
manufacturer provides. See the manufacturer's documentation for further
information.

See also:

■ Graphics Driver Setup Dialog on page 7582

■ Configure Software Display Driver Dialog on page 7586

■ Configure OpenGL Dialog on page 7588

■ Configure Direct3D Dialog on page 7594

Configure Software Display Driver Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Configure Driver button (when Software Display
Driver is the current driver)

The software display driver does not require hardware acceleration.
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Interface

Redraw Scene On Window Expose Redraws the whole scene when a dialog
over the viewports is moved, resulting in smoother dragging of dialogs such
as the Material Editor or Track View.

If your 3ds Max display easily becomes messy or "corrupted," turn this option
on and then redraw viewports by choosing Views > Redraw All Views (the
default keyboard shortcut for this is the ` (accent grave) key, on the left side
of the “1” key).

Use Triangle Strips Strips the geometry, which can more than double the
display speed. In some cases, such as when topology is constantly changed,
the time taken to strip the geometry can cause a slowdown instead. In such
cases, turn off this option. Otherwise, leave it on for speed.

Download Texture Size group

64, 128, 256, 512 These buttons specify the size of the bitmaps used to map
surfaces in the viewports. The larger the size, the better the resolution but the
slower the speed. High speed produces jagged maps and slower speeds produce
smooth maps.
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NOTE When Match Bitmap Size As Closely as Possible is on, these buttons are
overridden, however they are still available. The value is still used when procedural
textures are converted to bitmaps for viewport texture display.

Match Bitmap Size as Closely as Possible To allow the viewport to show
actual texture resolutions, bitmaps are individually resized in the display. This
means that small bitmaps don’t get overexpanded and large bitmaps retain
their resolution (but potentially use a lot more video RAM).

NOTE Bitmaps can be no larger than 4000 x 4000 pixels (or they will be scaled
down to this size) and no smaller than 32 x 32 (or they will be scaled up to this
size). Default=off.

Configure OpenGL Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Configure Driver button (when OpenGL is the current
driver)

The OpenGL display driver provides options that support hardware
acceleration.
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Interface

Implementation-Specific Settings group

Redraw Scene On Window Expose Redraws the whole scene when a dialog
over the viewports is moved, resulting in smoother dragging of dialogs such
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as the Material Editor or Track View. However, redrawing takes some time.
Default=on.

If your 3ds Max display easily becomes messy or "corrupted," turn this option
on and then redraw viewports by choosing Views > Redraw All Views (the
default keyboard shortcut for this is the "1" key).

This option has two subordinate options. How you should set them depends
on how the display card handles its back buffer, which is used for refreshing
the screen. Turn on one or the other, as appropriate.

Full Screen SwapBuffers Destroys Back Buffer If, after updating the screen,
the display card destroys the back buffer only when there's a single viewport,
turn on this sub-option. The OpenGL driver redraws the scene when a single
viewport is visible, but doesn't have to redraw when multiple viewports are
visible. Default=off.

Windowed SwapBuffers Destroys Back Buffer If, after updating the screen,
the display card destroys the back buffer when multiple viewports are visible,
turn on this sub-option. Default=off.

Use Triangle Strips Strips all geometric data before sending it to the driver.
In some cases, such as when topology is constantly changed, the time taken
to strip the geometry can cause a slowdown instead. In such cases, turn off
this option. Otherwise, leave it on for speed. Default=on.

This option has one subordinate option:

Display Wireframe Objects Using Triangle Strips Default=off.

Allow Dual Plane Support Uses the front/back plane system when redrawing
the viewport. The selected object is manipulated in the front plane and is
redrawn, while other objects remain on the back plane and are not redrawn.
This default setting provides the fastest redraws under normal circumstances.
If your assigned display driver doesn't support dual planes, this option is not
available.

Turn off this setting to improve redraw speed if you are rotating the whole
scene or moving a camera through the scene (usually situations in which the
whole viewport needs to be redrawn anyway).

Use Incremental Scene Updates Redraws only those scene objects that have
changed, or that intersect a region changed by another moving object. When
turned off, the entire scene is redrawn for each new frame. Default=on.

If your 3ds Max display becomes messy or "corrupted" as a result of incremental
updates, turn this option off and then redraw viewports by choosing Views >
Redraw All Views (the default keyboard shortcut for this is the ̀  [accent grave]
key).
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Use BGRA Pixel Format When on, sends bitmaps using BGRA
(blue-green-red-alpha) ordering for pixels. This is the default order for
Windows. By default, OpenGL expects RGBA ordering. Because of this, under
default conditions, loading textures or backgrounds requires the pixels to be
reordered. OpenGL supports an extension that allows it to receive pixels in
BGRA order. This means that bitmaps can be displayed directly, without
reordering each pixel. Thus, assuming the OpenGL driver has efficient hardware
support for BGRA pixels, turning on this option makes loading textures and
background images much faster. Default=on.

Use Generalized Vertex Arrays When on, enables 3ds Max to use custom
driver code to render smoothly shaded objects. Typically this is much faster
than using standard OpenGL code, but has an effect only when the driver has
hardware-specific custom code. Default=on.

Use Wireframe Faces When on, makes wireframe display accessible to
hardware acceleration. Default=on.

This option is intended to allow display-card manufacturers to accelerate 3ds
Max wireframe displays in a way that is specific to the underlying display
hardware. Check with your display-card manufacturer to see if enabling this
option will yield faster wireframe rendering with your display card.

Appearance Preferences group

Enable Anti-Aliased Lines in Wireframe Views Draws lines slightly thicker
and much smoother. This is best used for wireframe-only views, and especially
if you're making a preview of wireframe objects.

Background Texture Size Unlike the Software Display driver, which uses
bitmaps to display viewport backgrounds directly, the OpenGL driver uses a
texture-mapped background rectangle. This allows for smoother zooms and
pans in orthographic views and can take less memory than the direct bitmap
method. However, background bitmap resolution may be lost. Increase the
resolution if you're using a maximized viewport to digitize.

Download Texture Size Lets you choose the size of the texture map that's
downloaded to the driver for texture-mapped scene objects. Larger maps look
better, but use more display card memory.

NOTE When Match Bitmap Size As Closely as Possible is on, these buttons are
overridden, however they are still available. The value is still used when procedural
textures are converted to bitmaps for viewport texture display.

Match Bitmap Size as Closely as Possible To allow the viewport to show
actual texture resolutions, bitmaps are individually resized before they are
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downloaded to the driver. This means that small bitmaps don’t get
overexpanded and large bitmaps retain their resolution (but potentially use
a lot more video RAM).

NOTE Bitmaps can be no larger than 4000 x 4000 pixels (or they will be scaled
down to this size) and no smaller than 32 x 32 (or they will be scaled up to this
size). Default=off.

Texel Lookup Specifies whether to use the nearest pixel on page 7896  or to
linearly interpolate the pixel value from the four closest texels on page 7948 .
Using the nearest pixel is faster, but using texels produces a higher-quality
display. Default=Nearest.

MipMap Lookup Specifies whether to use one version of the texture map
(None) or to interpolate between a pyramid of progressively smaller maps.
With Nearest chosen, the texel lookup is done on the map level nearest the
ideal one, and with Linear, the texel values from the two closest map levels
are interpolated. Default=None.

NOTE When both Texel and MipMap lookup are set to Linear, a true trilinear
weighting of 8 texel values is used for a single pixel display. This is very accurate
and helps eliminate aliasing, but it is time consuming if the texture-mapping
hardware is not accelerated.

Direct3D Driver Setup Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Choose Driver button (if Direct3D is the active driver)

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Choose Driver button > Graphics Driver Setup dialog
> Choose Direct3D. > Advanced Direct3D button

When using the Direct3D display driver with 3ds Max, this dialog lets you
make some basic choices for setting up the driver. Further Direct3D
configuration options are available from the Configure Direct3D dialog on
page 7594 .

To switch to a different display driver when Direct3D is the active driver, click
the Choose Driver button on the Viewports tab of the Preference Settings
dialog, click Revert From Direct3D, and then choose the new driver from the
Graphics Driver Setup dialog.
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Interface

Direct3D Version The available option is whichever version is currently
active in your system.

Direct3D Device The default option is Hardware (HAL). The Software (RefRast)
option is for use by software developers, and is unavailable unless the debug
version of DirectX is installed in your system.

Direct3D Use Flags The default option is Release. The Debug option is for
use by software developers, and is unavailable unless the debug version of
DirectX is installed in your system.

Revert from Direct3D Click this button to display the Graphics Driver Setup
dialog on page 7582 , which lets you choose a different driver.
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Configure Direct3D Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Configure Driver button (when Direct3D is the current
driver)

The Direct3D display driver provides options that support DirectX drivers.
You can download D3D drivers from this location:
http://www.microsoft.com/windows/directx/.

DirectX 10 Version

When DirectX 10 is active on your system, the dialog uses a simpler, more
straightforward interface:

The parameters are identical to those with the same names listed previously
in this topic, and one setting has been added:
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Maximum number of active lights Lets you define the number of active
lights used in the lighting calculations. Setting this too high can affect
performance.
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Interface
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Implementation-Specific Settings: Geometry group

Display All Triangle Edges When on, all triangle edges are displayed in shaded
viewports. When off, triangle edges are not displayed. Default=on.

Turning off this option can improve viewport appearance, but at a cost of
display performance.

Use Cached D3DXMeshes When on, enables 3ds Max to use custom driver
code to render smoothly shaded objects. Typically this is much faster than
using standard Direct3D code, but has an effect only when the driver has
hardware-specific custom code. Default=on.

Use Wireframe Faces When on, makes wireframe display accessible to
hardware acceleration. Default=on.

This option is intended to allow display-card manufacturers to accelerate 3ds
Max wireframe displays in a way that is specific to the underlying display
hardware. Check with your display-card manufacturer to see if enabling this
option will yield faster wireframe rendering with your display card.

Use Triangle Strips Strips all geometric data out before sending it to the
driver. In some cases, such as when topology is constantly changed, the time
taken to strip the geometry can cause a slowdown instead. In such cases, turn
off this option. Otherwise, leave it on for speed. Default=on.

This option has one subordinate option:

■ For Wireframe Objects When on, uses triangle strips for wireframe objects.
Default=off.

Implementation-Specific Settings:Window Updates group

Redraw Scene On Window Expose Redraws the whole scene when a dialog
over the viewports is moved, resulting in smoother dragging of dialogs such
as the Material Editor or Track View. However, redrawing takes some time.
Default=on.

If your 3ds Max display easily becomes messy or "corrupted," turn this option
on and then redraw viewports by choosing Views > Redraw All Views (the
default keyboard shortcut for this is the 1 key on the numeric keypad).
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This option has two subordinate options. How you should set them depends
on how the display card handles its back buffer, which is used for refreshing
the screen. Turn on one or the other, as appropriate.

■ Redraw In Maximized Viewport If, after updating the screen, the display
card destroys the back buffer only when there's a single viewport, turn on
this sub-option. The Direct3D driver redraws the scene when a single
viewport is visible, but doesn't have to redraw when multiple viewports
are visible. Default=off.

■ Redraw In UnMaximized Viewports If, after updating the screen, the
display card destroys the back buffer when multiple viewports are visible,
turn on this sub-option. Default=off.

Allow Dual Plane Support Uses the front/back plane system when redrawing
the viewport. The selected object is manipulated in the front plane and is
redrawn, while other objects remain on the back plane and are not redrawn.
This default setting provides the fastest redraws under normal circumstances.
If your assigned display driver doesn't support dual planes, this option is not
available.

Turn off this setting to improve redraw speed if you are rotating the whole
scene or moving a camera through the scene (usually situations in which the
whole viewport needs to be redrawn anyway).

Use Incremental Scene Updates Redraws only those scene objects that have
changed, or that intersect a region changed by another moving object. When
turned off, the entire scene is redrawn for each new frame. Default=on.

If your 3ds Max display becomes messy or "corrupted" as a result of incremental
updates, turn this option off and then redraw viewports by choosing Views >
Redraw All Views (the default keyboard shortcut for this is 1 on the numeric
keypad).

Appearance Preferences group

Enable Antialiased Lines in Wireframe Views Draws lines slightly thicker and
much smoother. This is best used for wireframe-only views, especially if you're
making a preview of wireframe objects.

Background Texture Size Unlike the software display driver, which uses
bitmaps to display viewport backgrounds directly, the Direct3D driver uses a
texture-mapped background rectangle. This allows for smoother zooms and
pans in orthographic views and can take less memory than the direct bitmap
method. However, background bitmap resolution may be lost. Increase the
resolution if you're using a maximized viewport to digitize.
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Match Bitmap Size as Closely as Possible Displays background at full
resolution. This allows the viewport to behave like the rendered frame window
on page 5885 , in regards to zoom and pan. Default=off.

Download Texture Size Lets you choose the size of the texture map that's
downloaded to the driver for texture-mapped scene objects. Larger maps look
better, but use more display card memory.

NOTE When Match Bitmap Size As Closely as Possible is on, these buttons are
overridden, however they are still available. The value is still used when procedural
textures are converted to bitmaps for viewport texture display.

Match Bitmap Size as Closely as Possible To allow the viewport to show
actual texture resolutions, bitmaps are individually resized before they are
downloaded to the driver. This means that small bitmaps don’t get
overexpanded and large bitmaps retain their resolution (but potentially use
a lot more video RAM).

NOTE Bitmaps can be no larger than 4000 x 4000 pixels (or they will be scaled
down to this size) and no smaller than 32 x 32 (or they will be scaled up to this
size). Default=off.

Texel Lookup Specifies whether to use the nearest pixel on page 7896 , to
linearly interpolate the pixel value from the four closest texels on page 7948 ,
or to use anisotropic filtering. Using the nearest pixel is faster, but using texels
produces a higher-quality display. The Anisotropic filter compensates for the
distortion caused by the difference in angle between the texture polygon and
the plane of the screen. Default=Nearest.

MipMap Lookup Specifies whether to use one version of the texture map
(None) or to interpolate between a pyramid of progressively smaller maps.
With Nearest chosen, the texel lookup is done on the map level nearest the
ideal one, and with Linear, the texel values from the two closest map levels
are interpolated. Default=None.

NOTE When both Texel and MipMap lookup are set to Linear, a true trilinear
weighting of 8 texel values is used for a single pixel display. This is very accurate
and helps eliminate aliasing, but it is time consuming if the texture-mapping
hardware is not accelerated.
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MIDI Time Slider Control Setup Dialog

Customize menu > Preferences > Preference Settings dialog > Animation tab
> MIDI Time Slider Control group > Setup button

With the MIDI Time Slider Control Setup dialog you can specify and set up a
MIDI device to control animation playback.

Procedures

To use a MIDI device to control the animation time slider:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Animation tab.

2 In the MIDI Time Slider Control group, choose On.

3 Click Setup.

4 Set the MIDI device options and click OK.

Interface
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Presets Specifies the type of MIDI device used. You can choose the Media
Control Station 2, which is a MIDI device containing standard VCR-style
playback buttons along with a jog wheel, or you can choose Custom, which
specifies note events in the spinners. You can also use Custom to customize
the buttons used by the Media Control Station.

Channel Specifies the channel to which your MIDI device is assigned.

Note Number group

With the controls in this group you can specify which note event triggers
which function.

Start Frame Goes to the start frame (the Rewind button in the Media Control
Station).

End Frame Goes to the end frame (the Fast-Forward button in the Media
Control Station).

Step Forward Moves one frame forward (the Fast-Forward button and Option
button in the Media Control Station).

Step Backward Moves one frame back (the Rewind button and Option button
in the Media Control Station).

Stop Stops playback (the square button).

Play Plays the animation (the arrow button).

Jog Wheel Controls the time slider with the jog wheel.

Sensitivity Controls the number of ticks that the time slider moves in
response to one unit of movement from the jog wheel. A lower value provides
more precise positioning of the time slider, while a higher value makes the
time slider move faster. If you set your time display to show ticks and set the
sensitivity to 1, you can move one tick at a time with the jog wheel.

Units Setup Dialog
Customize menu > Units Setup > Units Setup dialog

The Units Setup dialog establishes the unit display method, giving you the
choice between generic units and standard units (feet and inches, or metric)
. You can also create custom units, which are used whenever you create an
object.
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The units that you set up are used to measure geometry in your scene. In
addition to these units, the software also uses system units as an internal
mechanism. System units should only be changed before  you create your
scene or import a unitless file. Do not change the system unit in an existing
scene.

You can also set the lighting units using this dialog.

System vs. Display Units

It is important to note the distinction between System and Display units.
Display units only affect how geometry is displayed in the viewports. System
units determine the actual scale of geometry. For example, if you import a
DXF file (unitless) containing a 1 x 1 x 1 Box, 3ds Max could import the box’s
dimensions in inches or miles, depending on the System unit. This can have
a significant impact on your scene, which is why you should always set up
the system unit before you import or create geometry.

Procedures

To change units to feet and inches:

1 On the Units Setup dialog, choose US Standard.

2 Choose from among the display options on the drop-down list.

■ If you want to display measurements as feet with inches, choose how
inches should appear: fractional or decimal. Also choose, for Default
Units, Feet or Inches

■ If you choose one of the Fractional display options, choose the fraction
on the drop-down list to the right.

To enter fractions in numeric fields:

■ When you enter fractions in numeric fields, they are converted to the
correct units. For example, if units are set to Feet w/ Decimal Inches, and
Default Units is set to Feet, type 37/45 and press Enter for the result 0'9.867",
or 37/45'.

To enter a fraction and a units specifier, place the specifier after the divisor.
For example, type 17/5', but not 17'/5.
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To convert between unit types:

■ You can convert between unit types by entering any valid unit specifier,
along with the number, and then pressing Enter.
The number is converted to the current unit display type. For example, if
units are set to Meters, type 1/2 to get the result 0.5M. However, if you
type 1/2' or 6" the result is 0.152M.
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Interface

System Unit Setup Click to display the System Unit Setup dialog on page
7605  and change the system unit scale.

WARNING  Change the system unit value only before  importing or creating
geometry. Do not change the system unit in an existing scene.
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Display Unit Scale group

Choose a unit scale option (Metric, US Standard, Custom, or Generic Units)
to activate its settings.

Metric Choose this option and then choose a metric unit: Millimeters,
Centimeters, Meters, or Kilometers

US Standard Choose this option and then choose a US Standard unit. If you
choose a fractional unit, the adjoining list activates to let you select the
fractional component. The decimal units require no additional specification.

The US Standards are as follows:

■ Fractional Inches

■ Decimal Inches

■ Fractional Feet

■ Decimal Feet

■ Feet w/ Fractional Inches

■ Feet w/ Decimal Inches

For the last two items, you can specify which unit is assumed when you enter
a value in a numeric field and press Enter without including a units specifier,
such as ' for feet or " for inches.

For example, if Feet is the default, typing 5 followed by Enter results in 5 feet.
Typing 5" followed by Enter results in 0'5". If Inches is the default, typing 5
followed by Enter results in 0'5". Typing 5' followed by Enter results in 5 feet.

Custom Fill in the fields to define a custom unit of measurement.

Generic Units This is the default option (one inch) and is equal to the system
unit used by the software.

Lighting Units group

The Lighting Units group lets you choose whether light values are displayed
in American or International units.

System Unit Setup Dialog

Customize > Units Setup > Click System Unit Setup.
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This dialog appears when you click System Unit Setup in the Units Setup
dialog on page 7601 .

WARNING  You should only change the system unit value before  importing or
creating geometry. Do not change the system unit in an existing scene.

Because of the nature of digital floating-point calculations, distances that are
extremely large or extremely small can cause round-off error. Symptoms of
round-off error include trouble navigating (zooming and panning become
too fast or too slow), unwanted viewport clipping, and unexpected flipping
of normals. Here are some general guidelines to avoid these problems:

■ Make sure your scene is roughly centered around the origin (0,0,0).
Round-off error increases at large distances from the origin.

■ Make sure no significant detail in the scene is smaller than one generic
3ds Max unit.

NOTE The Rescale World Units utility on page 2599  alters the scale of world units
throughout the entire scene, or selected objects.

Procedures

To change the system unit:

1 Choose Customize menu > Units Setup.

2 Click System Unit Setup.

3 Change the System Unit Scale value, and click OK.

The system unit is immediately reset. This setting remains in effect until
you change it.
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Interface

Unit and Measurement fields Change the scale of the 3ds Max unit. The
system unit is the standard measurement throughout 3ds Max. You should
only change the system unit value before importing or creating geometry.

Respect System Units in Files When on, if you open, merge, XRef, or drag
and drop geometry from file that has different system unit settings, a File
Load: Units Mismatch dialog on page 7608  is displayed. This dialog gives you
the choice of rescaling the geometry to match the current system units, or
adopting the units used in the file. When off, the dialog is not displayed, and
the file is assumed to have the same units as the current 3ds Max session.
Default=on.

Origin Slider, Distance from Origin,Accuracy

These controls provide a system unit calculator to help you determine the
unit scale for your project. The resolution of measurement diminishes as the
distance to the origin of space increases, so you need to consider space
granularity when you choose a scale for your project. If you're modeling an
island, for example, this calculator can help you determine the smallest object
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you should model on the island. In other words, don't use a unit scale of
millimeters if you plan on modeling an island that's many miles across.

When you use the slider or the text field to enter a distance from the origin,
the Resulting Accuracy changes to show what the round-off error will be at
that distance.

These controls don't change the unit settings in 3ds Max. They don't reflect
the extents of the current scene, either.

Origin Slider Move the slider for interactive feedback of distance and
accuracy. Right-click the scale to reset the slider to 0. Dragging the slider
displays the last slider position as a small square on the scale markings.

The slider covers distances from 0 to the maximum distance that's accurate
to one system unit.

Distance from Origin Enter the maximum distance you want to use in your
project to determine the maximum accuracy, which is displayed in the
Accuracy field. Values consider current settings for system scale and unit.

NOTE When you type a distance, you must press ENTER to update the Resulting
Accuracy field. Pressing TAB simply moves focus to Resulting Accuracy, without
doing the calculation.

Resulting Accuracy Enter the minimum resolution you will use to determine
the maximum size or distance that is most practical. Values consider current
settings for system scale and unit.

For example, if units are in feet and decimal inches in Customize menu >
Units Setup, and you type (1', 1 foot) in the Accuracy field, a value of
22369620'0.0" is displayed in the Distance From Origin field. If you move an
object that's one foot across, at this distance away from the origin of space, a
round-off error will occur, and the shape of the object will be compromised.

File Load: Units Mismatch Dialog

Change the system unit scale. > Open, Merge, XRef, or drag geometry from a
file with a different unit scale.

This dialog appears when you open or merge a file that has been saved with
system unit settings that are different from those of your current 3ds Max session.
The default system unit setting is Inches.

If you open a file with the system unit set to meters, for example, you will see
this dialog.
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When this happens, you have two options:

■ Rescale the File Objects to the System Unit Scale: You can choose to rescale
the objects from the incoming file to match the current system unit. This
changes the size of the incoming geometry

■ Adopt the File's Unit Scale: This changes the system unit in your 3ds Max
installation to match that of the incoming file. This setting will persist
between the current and future 3ds Max sessions until you reset your
system unit on page 7605 . This is the default option.
Choosing File > Reset will not reset your system unit. You must either
change it using Customize > Units Setup > System Unit Setup, or manually
edit your 3dsmax.ini file.

NOTE This dialog appears only if Respect System Units In Files is turned on in the
System Unit Setup dialog on page 7605 .

Interface

Rescale the File Objects to the System Unit Scale  Objects from the file are
rescaled to the current session's system unit scale.
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NOTE Many features depend on the scale of the scene, so choosing to rescale the
file objects can have unpredictable results, particularly in scenes using radiosity.
Reset and recalculate radiosity if you have rescaled the file objects.

TIP Use the Zoom Extents All button if the geometry is no longer visible in the
viewport after rescaling.

Adopt the File's Unit Scale The system unit scale is changed to match that
of the other file. This is the default option.

Choosing Adopt The File’s Unit Scale adds two settings to your 3dsmax.ini file:
UnitType= and UnitScale=. For this reason, this change is persistent between
sessions until you reset it manually.

To get back the default System Unit Scale, you can edit your 3dsmax.ini file
and remove those settings; or go to Customize > Units Setup > System Unit
Setup and change the units back to the default scale, Inches.

TIP Objects with a UVW Unwrap may lose their texture coordinate information
when you choose this option. If this occurs, choose the Rescale option rather than
the Adopt option.

Viewport Configuration
Customize menu > Viewport Configuration

Right-click any viewport label. > Configure

The Viewport Configuration command displays the Viewport Configuration
dialog. You use controls on this dialog to set options for viewport control.

All the configuration options are saved with the MAX scene file. To configure
startup settings for your file, you can save a maxstart.max file. If this file exists,
3ds Max uses it to determine the viewport configuration and settings when
the software is loaded or reset.

Interface

Viewport configuration options are available in a series of tabbed panels on
the Viewport Configuration dialog:

Rendering Method on page 7611

Viewport Layout on page 7617
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Safe Frames on page 7618

Adaptive Degradation Options on page 7622

Regions on page 7626

Statistics on page 7628

Lighting and Shadows on page 7630

Rendering Method

Customize menu > Viewport Configuration > Viewport Configuration dialog
> Rendering Method tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Rendering Method tab

You set the rendering method for either the current viewport or all viewports
on the Rendering Method panel of the Viewport Configuration dialog.

NOTE These controls operate on all objects depicted in the viewports; you can
also control display properties on a per-object basis.

Procedures

To set the viewport rendering method:

1 Choose Customize menu > Configure > Viewport Configuration dialog
> Rendering Method tab.

2 Click to choose the desired rendering level and any options available for
that level.

3 Choose how the rendering level is to be applied to viewports:

■ Active Viewport Only applies the rendering method to the active
viewport. This choice is the default.

■ All Viewports applies the rendering method to all configured
viewports.

■ All But Active applies the rendering method to all viewports except
the active one.

TIP This option lets you work in full detail in the current view and easily set
other views to Wireframe or Bounding Box for quicker interactive display.
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To enter an FOV value in a perspective view:

1 Activate a viewport with a Perspective view.

2 Right-click the viewport label and choose Configure to display the
Viewport Configuration dialog > Rendering Method tab.

3 Enter an angle in the Field Of View field.

Interface

When you open this dialog, the settings reflect the current viewport settings.

Rendering Level group

Determines how the software displays objects.

Smooth+Highlights Renders objects with smooth shading and displays
specular highlights. To toggle quickly between Smooth+Highlights and
Wireframe, press F3.

Smooth Renders objects with smooth shading only.

Facets+Highlights Renders objects with flat shading and displays specular
highlights.

Facets Renders polygons as flat surfaces, shaded but with no smoothing or
highlights.
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Flat Renders each polygon in its raw, unshaded diffuse color, disregarding
any contribution from ambient lighting or light sources. This rendering method
is useful when it's more important to see each polygon than to see its shading.
It's also a good way to check the results of bitmaps created with Render to
Texture on page 6169 .

Hidden Line A wireframe mode that hides faces and vertices with normals
on page 7863  pointing away from the viewpoint, as well as any parts of objects
that are obscured by closer objects. In this display mode only, the wireframe
color is determined by the Viewports > Hidden Line Unselected color, not the
object or material color. See Colors Panel on page 7505 .

Lit Wireframes Renders objects as wireframes with flat shading.

Wireframe Draws objects as wireframes with no shading applied. To toggle
quickly between Wireframe and Smooth+Highlights, press F3.

Bounding Box Draws objects as bounding boxes with no shading applied.
A bounding box on page 7736  is defined as the smallest box that completely
encloses an object.

Edged Faces Available only when the current viewport is in a shaded mode,
such as Smooth, Smooth+Highlights, Facets+Highlights, or Facets. When Edged
Faces is on in these modes, the wireframe edges of objects appear along with
the shaded surfaces. This is helpful for editing meshes in a shaded display.
Press F4 to toggle Edged Faces display.

Edges are displayed using the object wireframe color, while surfaces use material
colors (if a material is assigned). This lets you create contrasting colors between
the shaded surfaces and the wireframe edges. You can switch these around in
the Display Color rollout on page 117  in the Display panel.

Transparency group

None Objects with transparency assigned appear completely opaque,
regardless of the transparency settings.

Simple Objects with transparency assigned are displayed with a “screen
door” transparency effect.

Best Objects with transparency assigned are displayed with a two-pass
transparency effect.

This option is smoother and closer to rendered transparency effects.
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Apply To group

Applies the current settings to the active viewport only, to all viewports, or
to all the viewports except the active one.

NOTE This applies to the currently active viewport only; it is not a dynamic
function.

Rendering Options group

These check boxes modify either the shading modes or the wireframe modes.
They refer to the viewport renderer on page 7966  only, not to the scanline
renderer on page 7918  or any other renderer.

Disable View Disables the Apply To viewport selection. A disabled viewport
behaves like any other viewport while active. However, when you change the
scene in another viewport, the view in the disabled viewport does not change
until you next activate it. Use this function to speed up screen redraws when
you are working on complex geometry.

Disable Textures Select to turn off display of texture maps on page 7840
assigned to objects. Turn off to show the maps assigned to objects.

Texture Correction Redraws the viewport using pixel interpolation
(perspective-corrected). The redrawn image remains until you force the
viewport to redraw for any reason. This command has an effect only when
the viewport is shaded and at least one object's map is displayed.

Z-Buffer Wireframe Objects Draws the wires ordered according to depth in
the scene. Otherwise wires may be drawn out of order to speed the viewport
display. This option is generally needed only when sub-object selections are
"hidden" by lines drawn out of order. For example, you select the front edges
of a box, but they don’t appear highlighted in red, because the white lines
from the rear may get drawn last. Activate this only if you find that selections
are obscured or if you need the viewport redrawn from back to front.

Force 2-Sided Set to render both sides of faces. See 2-Sided on page 7697 .
Turn off to render only faces with normals on page 7863  toward the viewer.
Usually, you'll want to keep this option off to speed redraw time. You might
want to turn it on if you need to see the inside as well as the outside of objects,
or if you've imported complex geometry in which the face normals are not
properly unified.

NOTE This switch has no effect when the Direct3D graphics driver on page 7582
is active. In this case, to control the visibility of backfacing faces in the viewports,
use the Display Properties > Backface Cull on page 126  switch.
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Default Lighting Turn on to use default lighting. Turn off to use the lights
created in the scene. If no lights exist in the scene, the default lighting is used
automatically, even when this check box is off. Default=on.

Sometimes the lighting you create in the scene makes the objects difficult to
see in the viewport. The default lighting displays the objects with even
illumination. You can use either one or two lights. By default, 3ds Max uses
one default light .

■ 1 Light Provides an over-the-shoulder light with 20% faster redraws at
the expense of less natural illumination.

A single default light is linked to the camera and moves when you change your
viewport point of view.

■ 2 Lights Provides more natural illumination, but slower viewport
performance.
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Two default lights are placed opposite to each other.

The key light, A, is in front of the object, on the upper-left side, while the fill light,
B, is behind on the lower-right side.

Shade Selected Faces Faces selected in the viewport are displayed in a red
semitransparent state when this is turned on, letting you see the faces you’ve
selected when the Shading Mode is Smooth+Highlighted. To toggle Shade
Selected Faces, press F2.

Use Selection Brackets Toggles the display of white selection brackets in the
viewport display. Turn this off in complex scenes when the display of multiple
selection brackets obscures the required view of selected objects.

Display Selected with Edged Faces Toggles the display of highlighted edges
for selected objects when the viewport is in a shaded mode, such as Smooth,
Smooth+Highlights, Facets+Highlights, or Facets. When on in these modes,
the wireframe edges of selected objects appear along with the shaded surfaces.
This is helpful when selecting multiple objects or small objects.

Viewport Clipping When turned on, interactively sets a near and far range
for viewport display. Two arrows at the edge of the viewport allow you to
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determine where the clipping will occur. Tick marks correspond to the extents
of the viewport, the lower tick is the near clipping plane, and the upper tick
sets the far clipping plane. This does not affect the rendering to output, only
the viewport display.

Fast View Nth Faces When turned on, speeds screen redraw by displaying
fewer faces. The Nth Faces spinner sets the number of faces that are displayed
when the Fast View mode is active. For example, a setting of 3 displays every
third face.

Perspective User View group

Field Of View Sets the field of view angle for a Perspective viewport. This
spinner is not available when any other viewport type is active. You can change
the Camera field of view in the Modify panel.

Viewport Layout

Customize menu > Viewport Configuration > Viewport Configuration dialog
> Layout tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Layout tab

You specify the division method of viewports, and assign specific types of
views to each viewport on the Layout panel of the Viewport Configuration
dialog.

The layout is saved with the .max file, so you can store different layouts in
separate scene files. Load the file you want, then merge in the contents of
other files to maintain the layout.

TIP Through MAXScript, there are commands to set the current layout to any of
the 14 available setups. You can also activate any viewport and set the view type.
This enables you to create macros and custom user interface buttons to set any
layout you choose.
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Interface

The Layout panel is arranged in two general areas. At the top are icons
representing the possible division methods. Below these is a screen
representation of the currently selected layout. Click an icon to select the
division method, which appears in the larger screen representation.

To assign specific views, click the viewport in the screen representation. Choose
a viewport type from the menu that appears.

Safe Frames

Customize menu > Viewport Configuration > Viewport Configuration dialog
> Safe Frames tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Safe Frames tab

Keyboard > SHIFT+F
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Safe frame borders show which portions of a viewport will be visible when rendered
to video.

You toggle the status of the video safe frame on page 7965  for the current
viewport and adjust its parameters on the Safe Frames panel of the Viewport
Configuration dialog.

Video Safe Frame displays a series of concentric rectangular frames in the
viewport. Use Safe Frame to see the proportions of your rendered output within
the viewport. This is particularly useful when you are rendering to output that
doesn’t match the viewport’s aspect ratio.

The primary purpose of Safe Frames is to suggest safe areas for work intended
for display on TV monitors. It is likely that the bezel will cover about 10% of
the image so you don’t want important objects or action to fall outside the
Action Safe area. High contrast titles falling outside the Title Safe area are likely
to bleed or be obstructed by the bezel of the TV screen.

When Safe Frames are displayed in the viewport and a bitmap image is assigned
as a viewport background on page 89  using either the Match Viewport or
Match Rendering Output options, the image is confined to the Live area of
the safe frames and matches the rendered background. This assumes that the
same bitmap is assigned to the Environment background using
Environment/Screen coordinates.
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You can toggle the status of safe frames on page 7965  on or off for the current
viewport, and use the Safe Frames panel of the Viewport Configuration dialog
to adjust the parameters.

When Safe Frame is displayed in the viewport and a bitmap image is assigned
as a background, and Show Background is turned on, the image is confined
to the Live area of the safe frame. If you are using a background image in your
rendering, make sure your rendering output size matches the background
image size. This will avoid distortion.

Interface

Setup group

The Safe Frames panel contains settings for the following frame types:

Live Area (yellow) The area that will actually be rendered, regardless of the
size or aspect ratio of the viewport.

Action Safe (green) The area in which it's safe to include your rendered
action. The Lock check box lets you lock the aspect ratio of the Action frame.
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When Lock is turned on, use the Both spinner to set the percentage of the
live area that's trimmed within the safe frame. When Lock is off, you can use
the Horizontal and Vertical spinners to set these parameters independently.
Default=10%.

Title Safe (cyan) The area where it's safe to include titles or other information.
When used correctly, this is smaller than the Action frame. The Lock check
box lets you lock the aspect ratio of the Title frame. When Lock is turned on,
use the Both spinner to set the percentage size of the title frame relative to
the action area. When Lock is turned off, you can use the Horizontal and
Vertical spinners to set these parameters independently. Default=20% of Live
Area.

User Safe Displays an additional safe frame that you can use for any custom
requirements. The Lock check box lets you lock the aspect ratio of the User
frame. When Lock is turned on, use the Both spinner to set the percentage
size of the user frame relative to the action area. When Lock is turned off, you
can use the Horizontal and Vertical spinners to set these parameters
independently. Default=20% of Live Area.

12-Field Grid Displays a grid of cells (or fields) in the viewport. In this case,
"fields" are cells in the grid, and not scanline fields.

The "12-field grid" is a method used by video directors to refer to specific areas
of the screen. A director might ask you to move an object two fields to the
left and four fields down. The 12-field grid is a reference for this type of
placement.

4 x 3/12 x 9 Lets you choose between two matrices of either 12 or 108 cells.

Application group

Show Safe Frames in Active View Toggles the frame displays on or off for
the current viewport. This option is duplicated by the Show Safe Frame item
in the viewport right-click menu.

Ungrouped

Default Settings Resets all values to the default values.
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Adaptive Degradation Options

 Status bar > Right-click the Adaptive Degradation button.

Customize menu > Viewport Configuration > Viewport Configuration dialog
> Adaptive Degradation tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Adaptive Degradation tab

You adjust the adaptive viewport redraw methods on the Adaptive Degradation
panel of the Viewport Configuration dialog. The adaptive degradation on
page 7704  settings are saved with your MAX scene file.

To toggle adaptive degradation, click the Adaptive Degradation button on the
prompt line, or press O .

This is handy when you're adjusting lights and want to see their effect, real
time, in a shaded viewport. Or you might be adjusting the camera and need
to see complex geometry exactly as it is.

NOTE  As of Autodesk 3ds Max 2008, this feature has been revised to
enable true adaptive degradation, so that the software degrades the display of
objects variably, based on priority settings you control. Previously, the whole scene
was degraded uniformly; with the new functionality, you get significantly better
visual feedback during compute-intensive viewport motion. This applies both to
changing the point of view and to animation of objects in the scene. The user
interface has changed accordingly.
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Example showing four degrees of adaptive degradation, depending on distance from
camera
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Interface

Adapt Object Display by Priority group

Turn on check boxes to indicate the rendering modes to step through during
necessary degradation. As the viewport redraw demands increase, the amount
of degradation increases through the active options from highest to lowest.
Objects with higher priority (based on the Prioritize Scene Objects settings)
will use the higher, more faithful display settings, while lower-priority objects,
typically smaller and/or farther from the point of view, will use the lower
display settings.

Maintain Frames Per Second Lets you set the frame rate on page 7791  in
frames per second that adaptive display will attempt to maintain. If the frame
rate drops below this, the software will increase the amount of degradation
based on the other settings on this panel.

Draw Backfaces during Degrade When on, forces the software to draw
polygons facing away from the point of view during degradation. Applies only
to wireframe views. When off, can improve performance by culling backfaces
during degradation.

Never Degrade Selected When on, selected objects are not subject to
degradation.

TIP You can use the Never Degrade object property on page 252  to specify that
3ds Max should not subject an object to degradation, regardless of its selection
status.
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Degrade to Default Lighting When on, improves performance by turning
off all viewport lights and enabling default lighting during degradation.

Never Redraw After Degrade When off, viewport display will restore as
frame rate improves, redrawing all degraded objects. If this takes too long,
turn it on. When on, objects will degrade but never redraw on mouse up,
always displaying at the most recent level of degradation.

NOTE  As viewport degradation occurs, the Adaptive Degradation button
on the status bar turns aqua, as shown here. Normally, when the degradation
stops, the color returns to gold, but when Never Redraw After Degrade is on, the
background remains aqua, even when active degradation is not happening. To
resolve this, either turn off Adaptive Degradation or turn off Never Redraw After
Degrade. Then, to redraw the screen, press ~.

Prioritize Scene Objects group

Distance from Camera/Screen Size Use this slider to specify whether the
software gives higher priority to objects based on their distance from the
camera or their screen size, regardless of distance from the camera. The two
criteria, represented by either end of the scale, are defined as follows:

■ Distance from Camera This sets the priority for each object based on its
distance from the camera or screen. The farther the object, the lower its
priority and the faster it will degrade. Higher values display closer objects
regardless of their size.

■ Screen Size The size of the bounding box in pixels. The smaller the object,
the lower its priority and the faster it will degrade. Higher values degrade
smaller objects regardless of their distance.

If you move the slider all the way to either end of the scale, the software sets
priorities based exclusively on that criterion. However, because it’s a sliding
scale, you can use both criteria on a weighted basis. For example, if you set
one end to 0.66, the other is set to 0.34, meaning that the software takes both
criteria into account in determining priorities, but gives the criterion set to
0.66 about twice as much weight as the other.

To return this parameter to its default setting (0.10/0.9), indicated by the tick
mark on the scale, right-click the slider.

Force objects displayed smaller than ... pixels to the lowest priority Objects
smaller than the specified size on the screen, in pixels, always use the lowest
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available priority setting (in the Adapt Object Display By Priority group) during
degradation.

Regions

Customize menu > Viewport Configuration > Viewport Configuration dialog
> Regions tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Regions tab

On the Regions panel of the Viewport Configuration dialog, you specify default
selection rectangle sizes for the Blowup Region and the Sub Region, and the
parameters for setting up a virtual viewport.

The rectangular selection region appears when you render with either Blowup
or Region selected in the Render Type List on page 5900 . You can change the
size of the region by dragging its handles.

The Virtual Viewport options let you zoom in on a sub-region of the current
viewport, creating a “virtual viewport” where you can perform any standard
navigation, but in a zoomed-in area. This function works only when you're
using an OpenGL driver. If you're using the software driver, these controls are
disabled.

You can use the virtual viewport on any type of viewport, but it's primarily
designed for zooming in on camera views. This lets you perform close-up
work, such as tracing, without distorting the relationship between the geometry
and a bitmap background. (See Lock Zoom/Pan in Viewport Background on
page 89  for similar functionality in orthographic views.)

Because you're actually zooming the viewport image itself, the viewport label
might be hidden from display, but you can still right-click in the upper-left
area of the viewport to display the menu. This takes advantage of zooming
features in the Open GL driver so that the software does not compute the
display change internally.

Procedures

To use the virtual viewport:

1 Make sure you're using an OpenGL driver on page 7582  for your display.

2 Activate the viewport to convert to a virtual viewport (typically a camera
viewport that is displaying a bitmap background).
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3 Choose Customize menu > Viewport Configuration and click the Regions
tab.

4 Click Use Virtual Viewport. A reduced image of the viewport displays in
the dialog, along with a white zoom rectangle representing the virtual
viewport.

5 Use the Zoom, X Offset, and Y Offset spinners to adjust the size and
position of the virtual window, or drag the white window anywhere
within the image.

6 Click OK.

The viewport is converted to a virtual viewport and displays the area of
viewport represented by the white rectangle. All viewport navigation
methods work the same, except that you're seeing only the zoomed
portion of the viewport.

7 To close the virtual viewport, go to Viewport Configuration > Region Tab
and turn off virtual viewport. You can get to the Viewport configuration
menu by right-clicking any of the viewport navigation tools or by going
to Customize menu > Viewport Configuration.

Regions | 7627



Interface

The Regions panel contains spinners for setting the four corners of the region
(in pixels), and the following options.

Virtual Viewport

Use Virtual Viewport Enables the virtual viewport. A reduced image of the
viewport appears in the dialog, along with a white zoom rectangle representing
the virtual viewport.

Zoom, X Offset, and Y Offset Adjusts the size and position of the virtual
window. You can also drag the white window anywhere within the image.

Statistics

Customize menu > Viewport Configuration > Viewport Configuration dialog
> Statistics tab
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Right-click a viewport label. > Configure > Viewport Configuration dialog >
Statistics tab

Use these controls to display statistics in the viewports concerning the number
of vertices, polygons, etc., in the scene and/or the active selection, as well as
a real-time count of the number of frames per second displayed. To toggle
display of the statistics in a viewport on the fly, right-click the viewport label
(for example, Perspective) and choose Show Statistics.

Interface

Setup group

Polygon Count Enables the polygon count display.

Triangle Count Enables the triangle count display.

Edge Count Enables the edge count display.

Vertex Count Enables the vertex count display.

Frames Per Second Enables the FPS count display.

Total Displays only the statistics for the entire scene.

Selection Displays only the statistics for the current selection.

Total + Selection Displays the statistics for the entire scene and current
selection.
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Application group

Show Statistics In Active View Enables the statistics display.

Default Settings Returns all options to the original settings.

 Lighting and Shadows

Customize menu > Viewport Configuration > Viewport Configuration dialog
> Lighting and Shadows tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Lighting and Shadows tab

The Lighting And Shadows tab sets preferences for lighting and shadow display
in shaded viewports. See  Previewing Shadows in Viewports on page 4911.

Interface

Viewport Shading Chooses the level of viewport shading. These options are
equivalent to the same options on the Display quadrant of the quad menu
for supported lights (Viewport Lighting And Shadows > Viewport Shading >

7630 | Chapter 24   Customizing the User Interface



Off, Good, or Best): changing the setting here changes the active setting on
the quad menu, and vice versa.

■ Off (Legacy, no shadows, 8 light limit) Lights viewports as in versions
of 3ds Max prior to v10. No shadows appear.

■ Good (SM2.0 Option) Displays shadows at the SM2.0 level.

■ Best (SM 3.0 Option) Displays shadows at the SM3.0 level, with opacity
mapping.

Auto Display Selected Lights When on, light from selected lights is
automatically displayed in shaded viewports. Default=off.

Cast Shadows for Default light When on, default lights display shadows
(that is, when no other light object is present in the scene). Default=on.

Override Shadow Intensity Use this to lighten (greater than 1.0) or darken
(less than 1.0) shadows in viewports. This is simply an aid to previewing
shadows: it does not affect ambient light, or any light and shadow settings
that are used when you render. Default=1.0.

Strokes
Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Mouse Control group > Stroke

Strokes are a way to assign command shortcuts to mouse or tablet drag patterns.
For many operations, strokes are more convenient than keyboard shortcuts
because they can select an object and apply a command to it.

For example, you can assign Arc Rotate to a downward stroke. When you draw
this stroke, the software changes to Arc Rotate mode. You can assign a circular
stroke to the Hide Selected command so that it both selects the objects and
then hides all the objects in the bounding extents of the stroke pattern.

You can use strokes in two ways:

■ If you have a middle mouse button, you can define and use strokes by
specifying the Stroke option for the middle mouse button in the Viewports
tab on page 7545  of the Customize menu > Preferences dialog.

■ To define and use strokes with the left mouse button, use the Strokes
utility on page 7643  and turn on Draw Strokes.
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Using the Keyboard with Strokes

The same stroke pattern can perform four different functions by holding Shift,
Alt, or Shift+Alt when drawing the stroke:

■ Drawing a vertical line is one type of stroke.

■ Holding Shift while drawing the same line is another type.

■ Holding Alt while drawing it is a third type.

■ Holding both Shift and Alt while drawing the line is a fourth type.
Holding Ctrl while drawing a stroke indicates that you want to define a
new stroke, rather than use an existing stroke.

NOTE Changes you make to the set of strokes are saved with 3ds Max and
persist from session to session.

See also:

■ Defining Strokes on page 7634

■ Reviewing and Editing Strokes on page 7638

■ Stroke Preferences Dialog on page 7640

■ Strokes Utility on page 7643

Procedures

To define and use strokes with the middle mouse button:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Viewports tab.

2 In the Mouse Control group, turn on Stroke.

You must turn on this option for all Stroke functions to work with the
middle mouse button.

3 Hold the middle mouse button and drag in a viewport to make a stroke.
If the stroke hasn't been defined, a dialog appears where you can click
Define to define the stroke. If the stroke has already been defined, the
corresponding function is executed.

See Defining Strokes on page 7634  for information on defining and editing
strokes.
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To define and use strokes with the left mouse button:

1 Choose Utilities panel > Utilities rollout > More button > Utilities dialog
> Strokes.

2 Turn on Draw Strokes.

3 Hold the left mouse button and drag in a viewport to make a stroke. If
the stroke hasn't been defined, a dialog appears where you can click
Define to define the stroke. If the stroke has already been defined, the
corresponding function is executed.

See Defining Strokes on page 7634  for information on defining and editing
strokes.

Example: To assign Object Properties to a stroke:

1 Use one of the first two procedures to activate strokes.

2 Hold down CTRL, and drag from top to bottom and then back up to the
starting point.

3 The Define Stroke dialog appears, and the name of the stroke is "HKKH."

NOTE Depending on how you drew your stroke sequence, it might be defined
by different letters. This is fine, as long as you use the same sequence to enact
the stroke after you have finished defining it.

If an alert appears, you've either drawn the stroke incorrectly, or this
stroke has already been assigned. Continue with the following steps to
replace the defined stroke.

4 Choose the Properties command from the Command To Execute list.

5 The option enabled is Single Object At Start Of Stroke, because that's the
logical choice for the Object Properties command.

6 Click OK.

7 Drag vertically down and back up over any object in the scene to display
the Object Properties dialog for that object.

Example: To assign Hide Selection to a stroke:

1 Use one of the first two procedures to activate strokes.

2 Hold down CTRL, and drag vertically from top to bottom.
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3 In the alert that appears, click Yes to redefine the stroke and display the
Define Stroke dialog.

The name of this stroke is HK.

NOTE Depending on how you drew your stroke sequence, it might be defined
by different letters. This is fine, as long as you use the same sequence to enact
the stroke after you have finished defining it.

4 Choose Hide Selection from the list.

5 Choose All Objects in the Selection Set.

6 Click OK.

7 Load a scene containing several objects, and select two or more objects.

8 Drag vertically from top to bottom in the viewport.

The selected objects are all hidden.

Defining Strokes

Hold down CTRL and the middle mouse button and drag in a viewport to
create the shape of an unused stroke. > Define Strokes dialog

Hold down the middle mouse button alone or with SHIFT, ALT, or both, and
drag in a viewport to create the shape of an unused stroke. > Define > Define
Strokes dialog

Utilities panel > Utilities rollout > More button > Utilities dialog > Strokes >
Draw Strokes > Hold down the left mouse button alone or with SHIFT, ALT,
or both, and drag in a viewport to create the shape of an unused stroke. >
Define > Define Strokes dialog

You define a stroke by creating the stroke in a viewport, then choosing the
command that the stroke defines. The next time you perform the stroke, the
command will be executed. You can define strokes to work in conjunction
with the SHIFT key, the ALT key, or both SHIFT and ALT.

You can define strokes with either the left or middle mouse button. If you
want to use your middle mouse button to define and use strokes, you must
first turn on Customize menu > Preferences > Preference Settings dialog >
Viewports tab on page 7545  > Mouse Control group > Stroke. To define and use
strokes with the left mouse button, choose Utilities panel > Utilities rollout >

7634 | Chapter 24   Customizing the User Interface



More button > Utilities dialog > Strokes on page 7643  > Draw Strokes, then
draw the strokes.

In the Define Stroke dialog, you can see how the strokes are analyzed by
examining the grid under Stroke to Define. When you complete the drawing
of a stroke, a nine-square grid is centered around the stroke and fit to its
extents. The inner segments of the grid are assigned unique letters. Where the
stroke crosses a segment, the letter associated with that segment is added to
the stroke name. Thus, the direction and the shape of the stroke matter, but
the size of the stroke has no effect.

The stroke is always centered within the grid. If you draw a stroke vertically
from top to bottom, the stroke is named HK because it crossed the segments
labeled H and K, in that order. Had you drawn the stroke from bottom to top,
it would have been named KH.

TIP You can define more than one stroke for the same command. For example,
you might assign a U-shape stroke to Undo, but find that you sometimes draw a
J shape when attempting the U. By assigning both the U and the J strokes to Undo,
you don't have to worry about missing that stroke.

The Command Should Operate On group of options is important. If the
command applies to selections, leave this option set to Single Object at Start
of Stroke, or change it to All Objects in the Selection Set. However, if the
command doesn't apply to selections, such as Arc Rotate or Activate Grid
Object, change it to No Objects Just Execute the Command.

See also:

■ Reviewing and Editing Strokes on page 7638

■ Stroke Preferences Dialog on page 7640

■ Viewport Preferences on page 7545

■ Strokes Utility on page 7643

Procedures

To define a stroke using the CTRL key:

1 Hold down the CTRL key while drawing a stroke.

2 If the stroke already exists, a message asks you if you want to replace the
old stroke. Click Yes.
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3 In the Define Stroke dialog that appears, assign the stroke.

To define a stroke by example:

1 Draw a stroke that doesn't exist.

2 A Stroke Not Found message appears. Click Define.

3 In the Define Stroke dialog that appears, assign the stroke.

Interface

Stroke to Define group

Displays the name of the stroke and displays the stroke you just drew as a
series of white Xs connected by white lines. A green X represents the start of
the stroke and a red X represents the end. The labeled grid shows you how it
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recognizes the stroke. Where the stroke crosses the labeled segments in the
grid, a letter is added to the name of the stroke.

Command to Execute group

Lists all commands to which you can assign a stroke. Select a command and
click OK to assign the stroke displayed in the grid to the selected command.
Depending on the type of command you choose in this list, various options
become available in the Command Should Operate On group.

Currently assigned to stroke Displays the name of the stroke currently
assigned to the selected command. If you pressed SHIFT or ALT when the
stroke was drawn, they're added to the name. For example: "SHIFT + HK" or
"ALT + HK."

Command Should Operate On group

Provides a number of options that specify which objects (if any) are affected
by the command. These options are enabled or disabled depending on the
type of command you've selected in the list window.

No Objects Just Execute the Command This text is displayed when you
choose a command that's not specific to selected objects (such as Arc Rotate).
When you select a command that can be applied to selected objects, the
following options become enabled:

Single Object at Start of Stroke Causes the command to act on the object
beneath the first stroke point in the active viewport.

All Objects in the Selection Set Causes the command to act on all objects
in the current selection set.

Multiple Objects Based On The Stroke Boundary group

Choosing one of the options in this group lets you use the stroke itself to
select multiple objects and then apply the command.

All Objects in Rectangle Extents Selects all objects defined by the rectangular
bounding of the stroke.

All Objects in Circular Extents Selects all objects defined by the largest circle
that fits within the rectangular bounding of the stroke.

Window/Crossing When you choose either of the previous two options,
these two options become available. Window selects only those objects entirely
within the rectangular or circular region. Crossing selects all objects within
or crossing the region.
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Current Stroke Set group Displays the name of the current stroke set, so
you can review the strokes defined in that set. You can create and save a
number of different stroke sets. See Stroke Preferences on page 7640 .

Review Click to display the Review Strokes dialog on page 7638 , in which
you can choose from a list of defined strokes and then see the stroke itself.
You cannot edit strokes this way. To view, change, and delete strokes, draw
the Review Strokes stroke (by default, a horizontal line from left to right).

Reviewing and Editing Strokes

Define Strokes dialog > Click Review.

Draw the Review Strokes stroke. By default, this is a horizontal line from left
to right.

You can view defined strokes in the Review Strokes dialog. Depending on how
you display this dialog, you can also change or delete defined strokes:

■ Click the Review button in the Define Strokes dialog on page 7634  to view
strokes, but not change or delete them.

■ Draw the Review Strokes stroke (by default, a horizontal line from left to
right) to view, change, and delete strokes. You can redefine the Review
Strokes stroke in the Review Strokes dialog.

Procedures

To change the command assigned to a stroke (or vice versa):

1 Select a command (or stroke) from the list.

2 Click Change. The Define Strokes dialog appears.

3 Select the new stroke to assign.

4 Click OK in the Define Strokes dialog to assign the selected stroke to the
command currently highlighted in the Review Strokes dialog.
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Interface

Defined Strokes

Displays a list of commands that currently have strokes assigned to them and
the name of the current stroke set.

Make Camera Active Point at a single camera (not the target), draw the
stroke, and that camera becomes active in the viewport in which you draw
the stroke.

Change Light Color You can stroke this command over one or more lights.
The color selector appears, so you can change the color of the selected lights.

Light On/Off Toggle Stroke over a light to toggle it on and off. If you stroke
over two or more lights, all the lights are set to a common state, either all on
or all off.

Set Constraints Displays a small dialog with the available axis constraints.
Double-click to change the axis constraints for the current transform mode.

Move Mode (Set Constraints) Switches to Move transform mode and displays
a small dialog with the available axis constraints. Double-click to change the
axis constraints for the current transform mode.
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Rotate Mode (Set Constraints) Switches to Select and Rotate mode and
displays a small dialog with the available axis constraints. Double-click to
change the axis constraints for the current transform mode.

Scale Mode (Set Constraints) Switches to Select and Scale mode and displays
a small dialog with the available axis constraints. Double-click to change the
axis constraints for the current transform mode.

Review Strokes Displays the Review Strokes dialog.

Stroke Preferences Displays the Stroke Preferences dialog on page 7640 .

Show As

Provides two options that specify how commands are displayed in the list.

Command Name Displays the assigned strokes by command name (for
example, Play Animation).

Stroke Name Displays the assigned strokes by their stroke name (for example,
HK).

Change Assigns a different stroke to the command, or vice versa, depending
on whether commands or strokes are displayed in the list.

NOTE This command is only available when the dialog is accessed by drawing
the Review Strokes stroke.

Delete Removes the selected command (or stroke) from the list, and the
command is no longer assigned to the stroke.

NOTE This command is only available when the dialog is accessed by drawing
the Review Strokes stroke.

Information on Selected Stroke

Displays the name and shape of the stroke selected in the list window.

Stroke Preferences Dialog

Draw the Stroke Preferences stroke. By default, this is an inverse L, drawn
vertically from bottom to top, and then horizontally from left to right.

Set up a stroke to access the Stroke Preferences dialog > Use the stroke
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With the Stroke Preferences dialog you can save sets of strokes and set other
stroke properties.

NOTE This dialog is available only by drawing its stroke (by default, an inverse L,
drawn vertically from bottom to top, and then horizontally from left to right). You
can redefine the Stroke Preferences stroke in the Review Strokes dialog on page
7638 .

NOTE By default, the Strokes Preferences dialog is available only if you assign a
stroke to it, then use the stroke to access the dialog. See the following procedure.

Procedures

To access the Strokes Preferences dialog:

1 Set up strokes for your left or middle mouse button. See Strokes on page
7631  for information how to do this.

2 To define the stroke, hold down CTRL and drag an inverted L shape (drag
vertically from bottom to top, and continue from left to right).

The name of this stroke is JGAB.

3 On the Define Strokes dialog, choose Stroke Preferences from the list.

4 Click OK to close the dialog.

5 Drag an inverted L shape to access the Strokes Preferences dialog.
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Interface

Current Stroke Set group

Displays the name and number of strokes in the current set.

■ To create a new set, enter a new name in the field and click Save.

■ To choose a different set, choose it from the list and click OK.

Save Saves the set displayed in the list.

Delete Deletes the set displayed in the list.
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Review Strokes Default Show As Order group

Specifies whether commands or strokes are initially listed in the Review Strokes
dialog.

Show Grid Time (ms)

The time it takes, in milliseconds, for the stroke analysis grid to appear in the
viewports when you complete a stroke. Set it to 0 to hide the grid. Default=300
(about 1/3 of a second); Range=0 to 2000.

Show Extents Time (ms)

The time it takes, in milliseconds, for the extents of the stroke to appear in
the viewports. Range=0 to 2000. Set it to 0 to disable this feature. Default=300
(about 1/3 of a second).

Strokes that operate on the First Point display a small X. Strokes that operate
on items in the bounding box of the stroke display the bounding box. Strokes
that operate on the circular extents display a circle that fits inside the square
bounding box of the stroke. Window selections appear solid. Crossing
selections appear dotted.

Stroke Point Size

The size, in pixels, of Xs drawn in the viewports that allow you to visualize
the stroke shape. Default=4; Range=3 to 20.

Strokes Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Strokes

The Strokes utility lets you launch commands by dragging left-button mouse
patterns in a viewport. When you launch the Strokes utility, a modeless dialog
appears containing a single Draw Strokes button. When the Draw Strokes
button is active, you can define and use strokes with the left mouse button.
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The Strokes system is also available as an option for the middle mouse button
that doesn't require the utility or the modeless dialog. This option can be
found on the Viewports tab on page 7545  of the Preferences dialog. For details,
see Strokes on page 7631 .

Procedures

Example: To define a stroke pattern for Arc Rotate:

1 On the Utilities panel, click the More button, and choose Strokes from
the list.

2 On the modeless dialog, click Draw Strokes.

3 Hold down the left mouse button and drag the mouse straight down
from top to bottom, then release the mouse button. The length of the
stroke doesn't matter, but the direction does.

A dialog appears asking you to define the pattern or continue.

4 Click Define to display the Define Stroke dialog.

5 Choose Arc Rotate from the Command To Execute list and then click
OK.

The pattern is now defined for Arc Rotate.

Example: To turn on Arc Rotate using the Strokes utility:

1 Turn on Draw Strokes in the modeless dialog.

2 In any viewport, hold down the left mouse button and drag the mouse
straight down from top to bottom. The length of the stroke doesn't matter,
but the direction does.

As you drag the mouse, small X's appear, displaying your stroke. When
you release the mouse, a 3x3 grid appears briefly, and then the program
switches to Arc Rotate mode.

If a Stroke Not Found message appears, click Continue, and then repeat
step 2.
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Keyboard Shortcuts

Keyboard shortcuts are keyboard alternatives you can use to initiate actions (commands or
tools) normally accessed with the mouse. For example, to open the Select From Scene dialog,
you can press the H key, or you can change the active viewport to a view from the bottom
by pressing B. Keyboard shortcuts let you work faster and more efficiently.

Many keyboard shortcuts are already set for most commonly used actions. Throughout this
reference, command descriptions include the default shortcut, if there is one: look for the
path annotation (with a gray background) at the top of the page.

To modify or add new shortcuts, use the Keyboard panel on page 7489  of the Customize User
Interface dialog on page 7489 . Keyboard shortcuts are separated by Groups or Categories of groups
and they organize Actions.

Groups organize the Actions for which you can set shortcuts. Default=Main UI.

Categories offer a further breakdown of the Actions in a Group to specific categories. This
lets you quickly find an Action so you can assign or adjust a shortcut.

Actions are commands or tools.

In most cases you can close a dialog with the same command used to open it. In general this
applies to any combination of input methods, including menu, toolbar button, and keyboard
shortcuts. For more information, see Toggling Dialogs on page 7253 .

Viewing the Assigned Shortcuts

To see the currently assigned keyboard shortcuts, you can create a text (TXT) file of all the
actions and their shortcuts. Go to the Keyboard panel on page 7489  of the Customize User
Interface dialog on page 7489 , and then click Write Keyboard Chart. All actions that can have
a shortcut assigned to them are listed. For actions with no default shortcut assigned, the
Shortcut column entry is blank.

If you click Reset on the Keyboard panel before you click Write Keyboard Chart, the text files
shows the default keyboard shortcut assignments. However, this loses any custom shortcuts
you might have created before.
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See also:

■ Biped Shortcuts on page 4389

■ Crowd Shortcuts on page 4730

■ Physique Shortcuts on page 4598

■ Track View Shortcuts on page 3447

■ Unwrap UVW Shortcuts on page 1807

Keyboard Shortcut Override Toggle 
Main toolbar > Keyboard Shortcut Override Toggle

The Keyboard Shortcut Override Toggle lets you toggle between using only
the "Main User Interface" shortcut keys and using both the main shortcuts
and shortcut keys for groups such as Edit/Editable Mesh, Track View, NURBS,
and so on.

When the Override toggle is off, only the Main User Interface shortcuts are
recognized. When Override is on, both Main UI and functional area shortcuts
are recognized; however, if there is a conflict between a shortcut assigned to
a feature and one assigned to the Main UI, when Override is on, the feature's
shortcut takes precedence.

You can customize keyboard shortcuts on the Keyboard panel on page 7489  of
the Customize User Interface dialog on page 7489 . The lists in the keyboard
panel show which shortcuts have been assigned to which command or feature.

See also:

■ Keyboard Shortcuts on page 7645
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Using the 3ds Max Help

The 3ds Max Help (this document) gives you information about every aspect of the software.
Each topic contains an overview discussion, typically preceded by a path annotation showing
how to access the feature in the program, and followed by a "Procedures" section with steps
for using a command or feature, and an “Interface” section detailing controls and parameters
for the user interface.

■ Path Annotation: Gives one or more sequences of steps indicating how to access the feature
in the user interface.

■ Topic Overview: Tells you the name of the feature, command, user-interface control, or
concept, and gives you a description.

■ Procedures: Contains steps for tasks that illustrate the typical use of the feature.

■ Interface: Describes the controls for this feature as they appear in the user interface, with
a description of their behaviors and settings.

Important Notes

 New features are indicated in this help by the "New" icon shown at the beginning of
this paragraph. This makes it easy to see what's new in the software as you use the reference.
You can also identify topics containing information on new features in the program using
the Index. Double-click the "new feature" entry to display a list of topics describing new
program features. Double-click the entry "changed feature" to see which existing features have
changed.

Keypresses, both individual and combination, are indicated in this document using a special
text style. For example:

■ To open the Select From Scene dialog, press H.

■ To undo the most recent action, press Ctrl+Z.
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 When you click a “book” icon on the Contents tab, the Topic pane on the right side
immediately displays the introductory or first topic in that section. This differs from previous
behavior, in which the first topic was a separate entry in the table of contents and needed
to be accessed separately from the “book” container.

The screen shots in this document show the default user interface colors. Other color sets
for the user interface are available. You can choose them, or create your own, using the
Colors tab on page 7505  in the Customize User Interface dialog on page 7489 .

See also:

■ Finding Information Fast on page 7648

■ Using the HTML Help Viewer on page 7650

■ Searching for Help Topics on page 7652

■ Help Menu on page 7281

Finding Information Fast
Use the Navigation pane in the Help Window to get to information quickly.
It contains tabs that let you use Contents, Index, or Search techniques to get
to topics you need.

Contents Tab

The Contents tab displays the main sections of this online system as book
icons. When you click a book, it expands to show the list of topics contained
within it, like chapters in hardcopy books.

To go to a topic from the Contents tab:

1 Click the Contents tab to display the Table of Contents view.

2 Click the book icon representing the area for which you want information.

The Topic pane on the right displays the introductory topic for that
section. In most cases, the topic contains an overview of the section
contents plus a list of relevant links. In some cases, the topic consists
exclusively of links to other topics in the section.
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The page icons for the book expand below representing all the topics for
the book’s feature area.

3 Click a link in the introductory topic to go to that topic.

Alternatively, you can view a list of the section’s topics and sub-sections
by clicking the + icon to the left of the book icon in the table of contents
or double-clicking the book icon or section title. This expands the section
and shows its contents.

4 Continue navigating through the table of contents until you find the
topic you want and then click its icon.

Index Panel

The index is an alphabetical listing of keywords found in the help. A single
keyword might be linked to more than one topic. Scroll through the list, or
to jump to an index entry that matches what you’re looking for, type the first
few letters of the subject in the editable field above the list.

To go to a topic from the Index panel:

1 Click the Index tab to display the Help index.

2 In the form at the top of the Index, type the subject you want, or scroll
through the alphabetical list to find the term for which you need
information.

3 Click the term, then click Display to see the topic for that term, or
double-click the term to see its topic.

The topic displays in the right pane and may show links to related topics.

Search Tab

The Search tab summons a full-text search engine that operates on a database
of every word in the help system, created when the HTML Help system was
compiled. You can use tools on the Search tab to find the help topics on page
7652  containing any word or phrase.

Favorites Tab

Use tools on the Favorites tab to create and store a set of topics you use often;
you can name them as you choose.
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Using the HTML Help Viewer
This online information system is a compiled HTML help (CHM) file; you
view it using Microsoft's HTML Help Viewer, powered by Internet Explorer.
The HTML Help Viewer is a three-pane window:

■ The Navigation pane on page 7648  is on the left side of the window. It
contains five navigational tabs, for Contents on page 7648 , Index on page
7648 , Search on page 7652 , and Favorites on page 7657 .

■ The Topic pane is on the right side of the window. It displays the selected
help topic, or the default help topic. It's the window you're reading from
right now.

■ The toolbar on page 7658  is the third pane, located below the help window
title bar.
Here are some tips on how to find more information when using the HTML
Help Viewer:

■ To link to another topic or a list of other topics, click the colored,
underlined words in the Topic pane.

■ If you use a particular help topic often, you can add it to your favorites
list on page 7657 .

■ Right-click the Contents or Favorites tab or the Topic pane for shortcut
menu commands.

Comments

Each topic in the online version of this document ends with a Comments
link. When you click Comments, the Help Viewer opens an electronic form
you can use to send us comments or requests about that topic. We'll use that
information when we revise the documentation set for a future release.

TIP Frequently check the downloads section on the 3ds Max support site for
updated releases of our online references. Access it from Help menu > 3ds Max
on the Web > Online Support.

See also:

■ Finding Information Fast on page 7648

■ Searching for Help Topics on page 7652
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■ Most of information about using the HTML Help Viewer has been supplied
directly by Microsoft. It has been made freely available for inclusion in
HTML help projects such as this one. This information has been edited
and reformatted to match that of the other online information systems
shipping with the software.

Procedures

To find a help topic:

1 In the Navigation pane, click one of the following tabs:

■ To browse through a table of contents, click the Contents tab. The
table of contents is an expandable list of important topics.

■ To see a list of index entries, click the Index tab, and then type a word
or scroll through the list. Topics are often indexed under more than
one entry.

■ To locate every occurrence of a word or phrase that may be contained
in a help file, click the Search tab, and then type the word. For details
on searching, see Searching for Help Topics on page 7652 .

2 Double-click the contents entry, index entry, or search results entry to
display the corresponding topic.

To copy a help topic:

1 In the Topic pane, right-click the topic you want to copy, and then click
Select All.

2 Right-click again, and then click Copy. This copies the topic to the
Clipboard.

3 Open the document you want to copy the topic to.

4 Position your cursor where you want the information to appear.

5 On the Edit menu, click Paste.

To copy only part of a topic:

■ Select the text you want to copy, right-click, and then click Copy.
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To print the current help topic:

■ Right-click a topic, and then click Print.
If you print from the Contents tab (by right-clicking an entry, and then
clicking Print) you will see options to print only the current topic, or the
current topic and all subtopics.

To hide or show the Navigation pane:

■ On the toolbar, click Hide or Show to close or display the Navigation pane,
which contains the Contents, Index, Search, and Favorites tabs.
If you close the Help Viewer with the Navigation pane hidden, it will
appear that way when you open the Help Viewer again.

To see where the current topic fits in the information hierarchy (contents):

■ Press Alt+C.
The Contents pane displays, with the current topic highlighted.

Searching for Help Topics
A basic search consists of the word or phrase you want to find. You can use
Boolean, wildcard, and nested expressions. You can also limit the search to
previous results, match similar words, or search topic titles only to further
define your search.

The basic rules for formulating queries are as follows:

■ Searches are not case-sensitive, so you can type your search in uppercase
or lowercase characters.

■ You may search for any combination of letters (a through z) and numbers
(0 through 9).

■ Punctuation marks such as the period, colon, semicolon, comma, and
hyphen are ignored during a search.

■ Group the elements of your search using double quotes on page 7653  or
parentheses on page 7655  to set apart each element. You cannot search for
quotation marks.
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NOTE If you are searching for a file name with an extension, you should group
the entire string in double quotes, ("filename.ext"). Otherwise, the period will
break the file name into two separate terms. The default operation between
terms is AND, so you will create the logical equivalent to "filename AND ext."

Searching for Words or Phrases: Using Wildcards

You can search for words or phrases and use wildcard expressions. Wildcard
expressions allow you to search for one or more characters using a question
mark or asterisk. The table below describes the results of these different kinds
of searches.

ResultsExampleSearch for

Topics that contain the
word "select." (You will

selectA single
word

also find its grammatical
variations, such as "selec-
tor" and "selection.")

Topics that contain the
literal phrase "new oper-

"new opera-
tor" or new
operator

A phrase

ator" and all its gram-
matical variations.With-
out the quotation
marks, the query is
equivalent to specifying
"new AND operator,"
which will find topics
containing both of the
individual words, in-
stead of the phrase.

Topics that contain the
terms "ESC," "escape,"

esc* or
80?86

Wildcard
expressions

"escalation," and so on.
The asterisk cannot be
the only character in
the term.Topics that
contain the terms
"80186," "80286,"
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ResultsExampleSearch for

"80386," and so on. The
question mark cannot
be the only character in
the term.

Turn on Match Similar Words to include minor grammatical variations for
the phrase you search.

Defining Search Terms: Using Boolean Expressions

The AND, OR, NOT, and NEAR operators enable you to precisely define your
search by creating a relationship between search terms. The following table
shows how you can use each of these operators. If no operator is specified,
AND is used. For example, the query "spacing border printing" is equivalent
to "spacing AND border AND printing."

ResultsExampleSearch for

Topics containing both
the words "dib" and
"palette."

dib AND
palette

Both terms in
the same
topic.

Topics containing ei-
ther the word "raster"

raster OR
vector

Either term in
a topic.

or the word "vector" or
both.

Topics containing the
word "OLE," but not
the word "DDE."

ole NOT
dde

The first term
without the
second term.

Topics containing the
word "user" within

user NEAR
kernel

Both terms in
the same

eight words of the
word "kernel."

topic, close
together.

NOTE The |, &, and ! characters don't work as Boolean operators (you must use
OR, AND, and NOT).
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Using Nested Expressions When Searching

Nested expressions allow you to create complex searches for information. For
example, "control AND ((active OR dde) NEAR window)" finds topics
containing the word "control" along with the words "active" and "window"
close together, or containing "control" along with the words "dde" and
"window" close together.

The basic rules for searching help topics using nested expressions are as follows:

■ You can use parentheses to nest expressions within a query. The expressions
in parentheses are evaluated before the rest of the query.

■ If a query does not contain a nested expression, it is evaluated from left
to right. For example: "Control NOT active OR dde" finds topics containing
the word "control" without the word "active," or topics containing the
word "dde." On the other hand, "control NOT (active OR dde)" finds topics
containing the word "control" without either of the words "active" or "dde."

■ You cannot nest expressions more than five levels deep.

Procedures

To go to a topic from the Search tab:

1 Click the Search tab, and then type the word or phrase you want to find.

2  To add Boolean operators to your search (not necessary if you're
searching for a single term), click the Boolean button to the right of the
text field, and then one of the operator names.

3 Click List Topics, choose the topic you want, and then click Display.

4 To sort the topic list alphabetically, click the Title column heading.

You can precisely define a search by using wildcard expressions, nested
expressions, and Boolean operators.

You can request similar word matches, search only the topic titles, or search
the results of a previous search.

You can set the Help Viewer to highlight all instances of search terms that are
found in topic files. Click the Options button, and then click Search Highlight
On.
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To highlight words in searched topics:

When searching for words in help topics, you can have each occurrence of
the word or phrase highlighted in the topics that are found.

■ To highlight all instances of a search word or phrase, click Options on the
toolbar, and then click Search Highlight On.
To turn off this option, click Options on the toolbar, and then click Search
Highlight Off. Another way to turn off highlighting without changing the
Search Highlight ... setting is to go to the Contents tab, and then click the
highlighted topic entry.

If you are viewing a long topic, only the first 500 instances of a search
word or phrase will be highlighted.

To search for words in the titles of HTML files:

1 Click the Search tab, type the word or phrase you want to find, and then
turn on Search Titles Only.

2 Click List Topics, choose the topic you want, and then click Display.

If you use this option, all HTML topic files will be searched, including
any that are not listed in the table of contents.

To find words similar to your search term:

This feature enables you to include minor grammatical variations for the
phrase you search. For example, a search on the word "add" will find "add,"
"adds," and "added."

1 Click the Search tab, type the word or phrase you want to find, and then
turn on Match Similar Words.

2 Click List Topics, choose the topic you want, and then click Display.

This feature only locates variations of the word with common suffixes.
For example, a search on the word "add" will find "added," but it will not
find "additive."

To search only the last group of topics you searched:

This feature enables you to narrow a search that results in too many topics
found. You can search through your results list from previous search by using
this option.

1 On the Search tab, turn on Search Previous Results.

2 Click List Topics, choose the topic you want, and then click Display.

7656 | Chapter 26    Using the 3ds Max Help



If you want to search through all of the files in a help system, this check
box must be off.

If you previously used this feature, the Search tab opens with this check
box turned on.

To repeat an earlier search:

■  Click the down arrow on the text-entry field and choose a previously
used search string, and then click List Topics.

Favorites Tab
Use tools on the Favorites tab to create a set of topics you use often; you can
name them as you choose.

Procedures

To create a list of favorite help topics:

1 Locate the help topic you want to make a favorite topic.

2 Click the Favorites tab, and then click Add.

To return to a favorite topic:

1 Click the Favorites tab.

2 Choose the topic, and then click Display.

To rename a topic in the Favorites list:

■ Choose the topic, and then enter a new name in the Current topic box.

To remove a favorite topic:

■ Choose the topic, and then click Remove.

Favorites Tab | 7657



HTML Help Viewer Toolbar
The Help Viewer toolbar contains the following features.

Hide/Show Click this toggle to hide the Navigation pane when it is
displaying, or show it when it's hidden.

Back/Forward Click to move to the previously viewed topic, or forward to
the following previously viewed topic.

Print Prints the current topic (if the Topic pane is active). If the table of
contents is active on the Navigation pane, you can choose to print the current
topic, or the topic and its subtopics. This is a way of printing a collection of
topics.

Options Displays the options menu:

Hide/Show Tabs Same as Hide/Show buttons, described above.

Back/Forward Same as Back/Forward buttons, described above.

Home Displays the main topic of this online system.

Stop Halts display of a topic.

Refresh Redraws the Help Viewer display.
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Internet Options Displays a dialog to change Internet Explorer (IE) settings.
Changes you make here do not affect the online reference or tutorials, but do
affect your IE browser settings. We do not recommend you use this option.

Print Same as the Print button, described above.

Search Highlight On/Off Toggles highlighting of each instance of a word or
phrase found with a search.

HTML Help Viewer Right-Click Menus
There are several commands on the shortcut menu that you can use to display
information.

DescriptionCommand

Opens all books or folders in the table of
contents. This command only works if the
Contents tab is displayed.

Right-click in the table of contents, and
then click Open All.

Closes all books or folders. This command
only works if the Contents tab is displayed.

Right-click in the table of contents, and
then click Close All.

Prints the topic.Right-click in the Topic pane, or an entry
in the table of contents, and then click
Print.

Choose to display, add, remove, or rename
a topic.

Right-click an entry in the Favorites tab.

Keyboard Shortcuts in the Help Viewer
The following keyboard shortcuts can be used for navigation in the HTML
Help Viewer, or the Contents on page 7661 , Index on page 7661 , Search on
page 7661 , or Favorites on page 7662  tabs on the Navigation pane.
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Help Viewer

PressTo

Alt+F4Close the Help Viewer.

Alt+TabSwitch between the Help Viewer and other
open windows.

Alt+ODisplay the Options menu.

Alt+O, and then press THide or show the Navigation pane.

Alt+O, and then press P, or right-click in
the Topic pane and choose Print.

Print a topic.

Alt+Left Arrow, or Alt+O, and then press
B. Or, if the Topic pane is active, press
Backspace.

Move back to the previous topic.

Alt+Right Arrow, or Alt+O, and then press
F

Move forward to the next topic (provided
you have viewed it just previously).

Alt+O, and then press OTurn on or off search highlighting.

Alt+O, and then press HReturn to the home page (help authors
can specify a home page for a help sys-
tem).

F6Switch between the Navigation and Topic
panes.

Up Arrow and Down Arrow, or Page Up
and Page Down

Scroll through a topic.

TabScroll through all the links in a topic.
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Contents Tab

PressTo

Alt+CDisplay the Contents tab.
Tip: Use this shortcut to see where a topic
fits in the information hierarchy.

Click plus sign or minus sign next to book
icon, or Left Arrow and Right Arrow

Open and close a book or folder.

Down Arrow and Up ArrowChoose a topic.

EnterDisplay the selected topic.

Index Tab

PressTo

Alt+NDisplay the Index tab.

Alt+W, and then type the wordType a keyword to search for.

Up Arrow and Down ArrowChoose a keyword in the list.

Alt+DDisplay the associated topic.

Search Tab

PressTo

Alt+SDisplay the Search tab.

Alt+W, and then type the wordType a keyword to search for.

Alt+LStart a search.
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PressTo

Alt+T, and then Up Arrow and Down ArrowChoose a topic in the results list.

Alt+DDisplay the selected topic.

Alt+U and press EnterSearch for a keyword in the result list of a
prior search.

Alt+M and press EnterSearch for words similar to the keyword.
For example, to find words like "running"
and "runs" for the keyword "run."

Alt+R and press EnterSearch through topic titles only.

Favorites Tab

PressTo

Alt+IDisplay the Favorites tab.

Alt+AAdd the currently displayed topic to the
Favorites list.

Alt+P, and then Up Arrow and Down ArrowChoose a topic in the Favorites list.

Alt+DDisplay the selected topic.

Alt+RRemove the selected topic from the list.

Notes

■ There are also shortcut menu commands on page 7659  that can be accessed
through the keyboard.

■ The Match Similar Words check box, on the Search tab, will be turned on
if you used it for your last search.
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Troubleshooting 3ds Max

This section describes a collection of problematic situations and what you can do to diagnose
and fix them. These include many common problems that are reported to Autodesk Product
Support, and the things you can try in order to resolve the problems yourself.

When starting to diagnose a problem, by yourself or with the intent of contacting Product
Support, you should take stock of the situation by answering the following questions.

■ What's changed since the last time I ran 3ds Max?

■ Has the 3ds Max display configuration been changed?

■ Was an updated video driver or new operating system service pack installed recently?

■ Has 3ds Max been running successfully without lockups or crashes?

Handling File Corruptions
Few things are more aggravating when attempting to open a scene then
encountering an Assertion Failed error, File Open Failed error, or perhaps no
error at all. The file just does not load. This typically occurs when the file is
corrupt. A number of factors can cause file corruption, including the following:

■ Some component built in another program has been imported or referenced
with an XRef.

■ The scene failed to save properly due to a power failure or system crash.

■ A poorly coded plug-in corrupted an object in the scene.
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Problems and Resolutions

Assertion Failed Errors

The assertion failed error occurs commonly when you try to load a corrupt
file. The error gives you a line number and file name where the corruption
occurred. You are then left with the options to retry or cancel.

Unfortunately, the line number and file often don't help because that isn't
necessarily where the error is actually occurring. Most people click the Retry
option a couple of times then give up, fearing they've lost many hours of
work. Don't panic yet. There are a number of things you can try before you
have to start rebuilding.

The first thing to try is keep clicking the Retry button. If there is a corruption
to the vertices of an object, you might have to parse through each vertex until
you bypass the object completely. For example, Autodesk Product Support
once received a file that returned an Assertion Failed error referencing a tab.h
file. The scene recently had an AutoCAD component imported that 3ds Max
couldn't understand. However, after the support technician clicked the Retry
button 88 times, the scene finally opened. After resaving the scene, it opened
without incident.

Merging Corrupt Files

If normal attempts to open a scene fail, another thing you can try is merging
the scene. If the file is not too corrupted, you would be able to access the
Merge dialog which shows a list of the components in the scene. This is a
good sign because, with a little effort, you can fix the file yourself. You now
need to narrow down which object, or objects, are causing the load failure.

1 Start 3ds Max.

2 Choose File menu > Merge.

3 Browse to the folder containing the model, select the model and click
the Open button.

The Merge dialog is displayed, showing all the components in the scene.
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You'll start by seeing if any of the objects or shapes in the scene are
corrupt.

4 In the List Types group, on the right, turn off everything except Geometry,
Shapes, and Groups/Assemblies.

5 Click the All button at the lower left, and then click OK.

If the objects appear in the viewports, you know the scene components
are fine and you'll have to repeat these steps with other List Types turned
on.

If the objects merge successfully, and you have to try merging in other objects,
be sure to first save what you've just merged as a basis for rebuilding the scene.
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If you receive an error message, you know one of the objects is the offending
item. Then, do as follows.

1 Reset 3ds Max.

You now have to narrow down exactly which object in the previous list
is corrupt.

2 Once again, choose File > Merge and turn off everything except Geometry,
Shapes, and Groups/Assemblies.

3 Select the first 10 objects in the list of components and click OK.

If those objects merge successfully, save the scene and repeat the Merge
operation with the next set of 10 objects. Eventually, one of the sets of
objects you try to merge will report the error message.

4 Keep refining the number of objects you are merging until you have
singled out the object that reports the error.

5 Once you've found the corrupt object, reset 3ds Max and merge all the
objects and components except for the object you've singled out.

6 After everything is merged, save the scene and rebuild the object that
was corrupt.

Granted, this can be a long process, but it's well worth it if you can salvage
most of your previous work.

Remember Backup Files

By default, the 3ds Max automatic backup on page 7544  feature is active, and
writes a backup file every five minutes while you're editing the scene for a
total of three files. The files are stored in the \autoback folder. By default, this
folder is stored in  \My Documents\3dsmax\ . Using backup files is especially
helpful if your file became corrupt due to a system crash or power outage.

1 Start 3ds Max and verify that you cannot load the scene.

2 Open Windows Explorer and browse to the \autoback folder.

3 Start by highlighting AutoBackup01.max and then copy the file (Edit >
Copy or Ctrl+C).

4 Browse to the \scenes folder, found in  \My Documents\3dsmax\ or in the
program install folder, and paste the file.

If you want, you can rename it.
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5 In 3ds Max, choose File > Open and try loading the file you just copied
from the \autoback folder.

If it opens, save the scene and rebuild what you lost in the last five
minutes.

If you'd like to adjust the Auto Backup settings, you'll find them on the Files
panel on page 7541  of the Preference Settings dialog, available via the Preferences
command on the Customize menu.

Fixing Boolean Problems
Boolean operations are a powerful addition to your modeling toolbox; however,
they can sometimes give strange or unexpected results. The Boolean button
is found on the Create panel in the Compound Objects list; it allows you to
join, subtract, intersect, and cut objects. Following is a list of problem scenarios
and steps you can follow to fix them.

TIP The ProBoolean compound object on page 774  represents a significant
improvement over the legacy Boolean compound object in a number of ways. In
most cases, it's highly recommended that you use ProBoolean rather than Boolean.

TIP Before performing a Boolean operation, you should save your scene or use
Edit > Hold. That way, you can quickly recover should anything not appear as
expected.

Problems and Resolutions

Boolean Objects Disappear

If you mistakenly perform an Intersection Boolean operation on two objects
that look like they intersect, but actually don't, you can end up in a situation
where the object completely disappears. In the Operands group, you see both
your objects listed but nothing on-screen.

1 Click the Undo button to retract the Operand B selection.

2 Right-click to exit the Boolean operation.

3 Verify that the objects intersect by checking them in two viewports, like
the Top and Left.

4 Click Boolean to turn on the operation, and click Pick Operand B.

Fixing Boolean Problems | 7667



5 Click the intersecting object.

Creases or Ridges Show in Boolean Objects

Creases or ridges might be caused by a Boolean operation between an object
that has very few faces and an object that has considerably more faces, for
example, when you subtract a complex freeform object from a simple box.

3ds Max tessellates the surface of the box so there are additional faces for the
subtraction. Unfortunately, the faces are usually generated as long, slivered
faces that sometimes overlap and form creases or ridges in the resulting scene,
when rendered.

Before attempting the Boolean operation, try these steps.

1 Select the object that has the lower face count.

In this example, it would be the box.

2 Change the Length, Width or Height Segments of the surfaces where the
subtraction will occur.

3 From the Compound Objects buttons, click Boolean.

4 Perform the subtraction as you originally wanted.

By subdividing the surface with more faces, the Boolean operation has more
faces and edges to work with. This results in fewer long, sliver-like faces that
can produce creases or ridges.

Consecutive Booleans Results in Disappearing Components

Booleans are programmed to work with two operands, Operand A and Operand
B. If you plan to join or subtract many objects from the object that you've
selected as Operand A, you must click the Boolean button after each Operand
B selection. If you don't, and simply click the Pick Operand B button and pick
the next object, the previous operation is negated and the previous Operand
B disappears.

The most efficient means to use when joining or subtracting a large number
of objects to or from a single object is to attach all the objects before attempting
the Boolean operation.

As an example, let's say you're building a metal plate that has a circle of bolt
holes. So far, you have a flat box, Operand A, and ten cylinders, Operand B,
passing through it.
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The future metal plate with circle of bolts

1 Select one of the cylinders.

2 Right-click and convert it to an Editable Poly.

This automatically opens the Modify panel.

3  From the Edit Geometry rollout, click Attach List.
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This is the little button next to Attach.

4 From the Attach List dialog, select all the other Cylinders and click the
Attach button.

All the cylinders are a single object.

5 Select the Box and make sure it has Length, Width, or Height Segs values
that are greater than 1.

See Creases or ridges show in Boolean objects on page 7668 .

6 Open the Create panel and from the drop-down menu that shows
Standard Primitives, choose Compound Objects.

7 Click the Boolean button and in the Parameters rollout > Operations
group, make sure Subtraction (A-B) is turned on.

8 On the Pick Boolean rollout, click Pick Operand B, and select the
Cylinders.
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The cylinders are subtracted to form holes in the box.

You only have to perform Boolean operations once instead of several times.
This method is far more efficient and less prone to errors. It is also very useful
for cutting rough openings for doors and windows into a wall if you're already
working with 3D geometry. Next, you'll find an example for working with 2D
spline objects.

Splines and Boolean Operations

Performing Boolean operations on splines made from the Create panel >
Shapes menu can be confusing. 2D spline shapes do not use the Boolean
operation you'd use for 3D geometry. Shapes, converted to Editable Splines,
offer Boolean functionality from the Modify panel > Geometry rollout. Unlike
Boolean operations performed on two separate pieces of 3D geometry, Boolean
operations can only be performed on single splines.

Therefore, one of two things must be done before you can perform Boolean
operations to spline shapes.

■ When originally creating the shapes, make sure Start New Shape is turned
off on the Create panel > Shapes > Object Type rollout. When turned off,
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you can create several overlapping shapes that are treated as a single shape
made up of several splines.

Start New Shape in the OFF state
(it is on, by default.)

■ If you didn't turn off Start New Shape, you'll have to attach all the spline
shapes to create a single shape comprised of multiple splines.

To illustrate the most common situation, let's say you've got three overlapping
rectangles and you want to subtract the two outer rectangles from the central
rectangle. You also forgot to turn off Start New Shape.

1 Start by selecting the central rectangle.
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2 Right-click and choose Convert To > Convert to Editable Spline from the
quad menu.

The Modify panel automatically opens.

3 In the Geometry rollout, click the Attach button and pick the two outer
rectangles.

Now, you've got a single shape made up of three sub-object splines.

Fixing Boolean Problems | 7673



4 Turn off Attach and scroll up to the Selection rollout.

5  Turn on the sub-object Spline mode, and select the central rectangle.
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6  Scroll down the Geometry rollout and click the Boolean button.
Also click the Subtraction button to the right.

7 Pick the two outer rectangles.
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The final shape after subtracting the two outer rectangles

Tips for Successful Boolean Operations

Here, you'll find some general tips that will ensure that you're Boolean
operations work the first time.

■ Add a modifier and collapse the stack.
If a set of operands never seems to produce desired results, try adding a
modifier and collapsing the stack to create an Editable Mesh or Editable
Poly. You can also collapse objects to editable meshes and polys without
first applying modifiers. If you do this, use Edit > Hold or File > Save As
on the scene; you will not be able to adjust the parameters of the existing
modifiers in the stack.

■ Create objects with more faces.
In general, create objects that have more faces than you might normally
use. For instance, increase the Height, Width, and Length segments of a
Box, especially if the other object is more complex. Try to make the face
count of both operands similar in number. With a larger number of faces,
the edges created by the Boolean operation tend to be smoother and more
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refined. Once the Boolean operation gives you the results you want, apply
the Optimize modifier to reduce the number of faces on the object.

■ Apply the STL-Check modifier.
One way to check the validity of objects that you intend to use as operands
is by applying the STL-Check modifier. This modifier is primarily used to
verify that an object is a complete and closed surface in preparation for
exporting to STL files. Because Boolean operations work best with objects
that meet the same criteria, use STL-Check on your operands. After applying
the STL-Check to an object, turn on Check. The Status group tells you if
errors are present.

Performance Issues While Running 3ds Max
Slow or sluggish performance while running 3ds Max can usually be attributed
to either a video configuration conflict or a memory allocation problem. The
hard thing about performance problems is narrowing down the culprit. Here
are some common situations that can hamper operation of 3ds Max and steps
to take to rectify them.

Problems and Resolutions

3ds Max Doesn't Start Quickly

Autodesk Product Support often encounters an increase of this situation around
the time a new version or upgrade of the software is released. The question
usually posed by the customer is, “Why does the new version take longer to
start than the last version?” There are several reasons.

■ The size of the executable that starts 3ds Max and the additional overhead
needed to load the new features of a new release can cause a slowdown.
Code in a new executable may use the system processors in a different way
than the last version so a slowdown may be noticed. The important thing
is how 3ds Max performs once it is running.

■ Each version of 3ds Max is programmed and optimized to use newer video
technology than what was previously available. If you haven't upgraded
your video card in the last year, or at least updated video drivers, there is
a very good chance 3ds Max will not start as quickly as in previous versions.
You can also try a different 3ds Max video configuration.
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■ If you have not defragmented your system recently, 3ds Max could exhibit
a slower start time. Defragmenting the system can also streamline the
loading of large files that tend to swap to virtual memory.

Files Take a Long Time to Open

The size of a file often defines how quickly it loads into 3ds Max. However, if
you notice an increase in load time from one design session to another, it
could be an indication that 3ds Max is not finding enough memory to operate
efficiently or that the file needs to be optimized.

The first thing to check is your system memory allocation. Per the 3ds Max
system requirements, you should have a minimum of 256 MB of physical
memory (RAM) and 300 MB of swap space. Recommended RAM is 1 GB with
a 2 GB swap file. Here's how to check your memory and swap-file allocations.

To check RAM and swap-file allocation on Windows 2000:

1 Right-click the My Computer icon on your desktop and choose Properties
from the menu.

This opens the System Properties dialog.

On the General panel, you should see information about your computer.
The amount of RAM should be listed on this panel.

NOTE The RAM may be displayed in kilobytes (KB) instead of megabytes
(MB).

2 Open the Advanced panel, and click the Performance Options button.

The Performance Options dialog is displayed.

3 Check the “Total Paging File Size For All Drives” setting in the Virtual
Memory group.

If you have 256 MB of RAM, you should set the Virtual Memory to
approximately three times the RAM, or 768 MB.

To check RAM and swap-file allocation on Windows XP:

1 Right-click the My Computer icon on your desktop and choose Properties
from the menu.

This opens the System Properties dialog.

On the General tab, you should see information about your computer.
The amount of RAM should be listed on this panel.
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2 Open the Advanced tab and click the Performance Settings button.

The Performance Options dialog is displayed.

3 Click the Advanced tab, and check the “Total Paging File Size For All
Drives” setting in the Virtual Memory group.

If the physical and virtual memory are set appropriately, then you'll have to
check the model. If the model does eventually open, do the following:

■ From the File menu, choose Save As and save the scene under a different
name. Then try opening the new file to see if it loads faster.

■ Review some of the objects you know have large modifier stacks.
Performance can be improved if you collapse the stacks of objects that
you've completed.

■ If the model uses XRefs, make sure the XRefs are locally accessible. If they're
located on a network server, the long load time could be due to high
network traffic.

Slow Response to Open or Drag Dialogs

This situation is exhibited when you click a command that opens a dialog,
like the Material Editor or graph window, like Track View. After you click, you
notice an appreciable time lag until the dialog or window opens. If you then
attempt to drag it to a new location, the dialog or window does not smoothly
follow your cursor.

The usual cause for this is a video driver conflict or display configuration issue
because opening or dragging a dialog causes your graphic card to refresh the
screen. Try these steps to diagnose the problem.

1 Start 3ds Max.

2 From the Customize menu, choose Preferences.

3 Open the Viewports panel and check the Current Installed Driver.

Most likely, it will be set to OpenGL or Direct3D.

4 If set to OpenGL or Direct3D, click the Choose Driver button and choose
Software.

The Software setting is a generic driver that works for all video cards. It
doesn't have any video enhancements but it's a good place to begin
diagnostics.
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NOTE If you're switching from Direct3D, you first have to use Revert From
Direct3D before choosing the Software configuration.

5 Click OK to close the Graphic Driver Setup dialog.

You will be informed that you have to restart 3ds Max for the change to
take affect.

6 Close the Preferences dialog and exit 3ds Max.

7 Restart 3ds Max.

Try opening or dragging dialogs around to see if performance has improved.
If it has, do the following:

■ If the software was originally configured for OpenGL, try configuring 3ds
Max for Direct3D and see if performance is improved. Or vice-versa.

■ Verify that your graphic card supports your preferred display configuration
choice. Some cards do not fully support OpenGL or Direct3D.

■ Visit the Web site of your graphic card manufacturer and see if they have
any newer video drivers that you can download and install.

Sluggish Command Response

Sluggish command response is closely related to the previous situation. If you
create an object such as a Box, you might notice that the cursor suddenly
slows down when you drag it into a viewport. Clicking the corners to set the
length, width and height is equally time-consuming. Once again, the likely
cause is video-related.

1 Start 3ds Max.

2 From the Customize menu, choose Preferences.

3 Open the Viewports panel and check the Current Installed Driver.

4 Make sure you have 3ds Max configured for the software display driver.

5 Click OK to close the Graphic Driver Setup dialog.

You will be informed that you have to restart 3ds Max for the change to
take effect.

6 Close the Preferences dialog and exit 3ds Max.

7 Restart 3ds Max.
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Try using the command that was giving you trouble and see if it works correctly
now.

Problems Caused by Unit Settings
The unit settings of a model can often get you into trouble. Understanding
some of the common problems can help you avoid them.

This section addresses the two most common problems that modelers
encounter.

Problems and Resolutions

Objects Disappear When the Camera Gets Close

This situation can happen when you model things on a very tiny scale and
then have to get very close to them in a Camera or Perspective viewport.
Architectural walkthrough animations are notorious for this kind of behavior.
You've got a camera moving along a path and at some point it gets too close
to a wall and you're suddenly able to see through to a room on the other side.

NOTE This problem is quite common for designers working with the metric system
when you want to use real world metric units and you change the System Unit
Scale to 1 unit=1 meter. You don't have to change the System Unit Scale to metric
to work in Metric units; just change the units.

There are two solutions that often fix this problem.

Turn on the manual viewport clipping:

You can turn on the manual viewport clipping and adjust it to see the entire
object. Viewport clipping has a Near and Far range setting, if a camera gets
closer to an object than the Near Clip value, you will see through that object.
Likewise, objects that are located beyond the Far Clip value, will be invisible
to the camera.

1 Open the problematic scene and select the camera.

2 In the Parameters rollout > Clipping Planes group, turn on Clip Manually.

3 Adjust the Near or Far Clip value, or both.

When you can see the object again, your clipping plane is set properly.
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Scale the entire scene:

If it doesn't matter what units you work in, scale the entire scene so objects
are not affected by viewport clipping.

1 Open the problematic scene and select everything.

2  On the toolbar, click Select And Uniform Scale.

3 Enlarge the entire scene.

Not only do the objects in the scene get larger but the distance between
objects increases. So, the larger you scale the scene, the further your
camera is located from the surrounding objects.

If you need to work in real world units, such as inches or meters, you should
set the scale of the scene before you begin modeling by changing the System
Unit Scale value from the default of 1 unit=1 inch to something like 1 unit=0.1
inch or even 0.01 inch.

If you change the System Unit Scale after you have begun modeling, you will
need to use the Rescale World Units utility to rescale the scene.

Zooming and Panning Are Too Fast or Slow

If zooming and panning are too fast or too slow, the most likely cause is the
System Unit Scale. 3ds Max can exhibit round-off errors when dealing with
extremely large or small distances. These round-off errors can also cause
normals to be flipped or strange viewport clipping. 3ds Max does not have
the numerical resolution to zoom infinitely from the some remote corner of
the solar system down to an ant on your doorstep.

If you're going to change the System Unit Scale, you should change it before
beginning any modeling. If you do have to set it later, it's best to rescale the
entire scene with Rescale World Units. For example, if working on a tiny scale,
like modeling coins, you might change the System Unit Scale from the default
of 1 unit=1 inch to something like 1 unit=0.1 or 0.01 inch. For larger scaled
scenes, like an airport, increase the System Unit Scale.

As a rule of thumb, keep the scale such that the smallest detail is not less than
one generic unit. If this makes the scene too big to work with comfortably
and efficiently, you can create separate scenes for models that include cameras
for "close" and "far" shots.
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User Interface Problems and Recovery
It can be frustrating when you can't find something on the user interface,
especially when you saw it a few minutes ago and now it's gone missing. Of
course, you've been so engrossed in your modeling that you forget what you
might have done to cause the button, element or dialog to disappear.

This section addresses several common user-interface situations and how you
can fix them.

Problems and Resolutions

Large Fonts and 3ds Max

While some users like to configure their systems to use large fonts, this setting
is not recommended with 3ds Max. The 3ds Max user interface was designed
to operate with your system set to small fonts. Small fonts are the default
setting for both Windows 2000 and Windows XP.

If you have your system set to use large fonts, some of the most common
anomalies you can expect while running 3ds Max are as follows:

■ Buttons might be missing from the command panels.

■ Some text-entry fields may not allow you to type in them.

■ Garbled text appears in some dialogs.

■ Text labels in dialogs and rollouts might be cut off or overlap other fields.

■ Dialogs show cascading text fields and spinners.

To remedy these problems, set your system font back to small fonts.

1 Exit 3ds Max.

2 Go to Start > Settings > Control Panel, and click Display.

You can also right-click anywhere in the open desktop and choose
Properties.

3 Open the Settings panel and click the Advanced button.
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4 In the Display group of the General panel, click the arrow to open the
Font Size list and choose:

■ Small Fonts, if running Windows 2000

■ Normal Size, if running Windows XP

5 Click OK to exit the Display Properties dialog.

You will most likely have to reboot the system for these changes to take
effect.

Lost Dialogs and Windows

3ds Max has many dialogs or windows that float when you open them. This
feature allows you to drag them anywhere on your desktop. You can greatly
improve your design efficiency by positioning dialogs out of the way of the
main 3ds Max interface, such as on a second monitor if you have dual-monitor
functionality.

However, there are times when a dialog gets lost. Either you drag it someplace
and inadvertently let go of it, or some data is written incorrectly to an
initialization file and you end up with a lost dialog.

There are a couple of ways to recover a lost dialog; both entail working with
the 3dsmax.ini file found in the location indicated by the MaxData setting on
the Configure System Paths dialog on page 7523 .

Thorough Method

In this example, let's say you've got a single monitor that's configured for
1280x1024 resolution and you've lost your Rendering Progress dialog.
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It was visible the last time you rendered, but that was awhile ago and someone
else has been using the system.

1 Open Windows Explorer and browse to the location indicated by the
MaxData setting on the Configure System Paths dialog on page 7523  .

2 Make sure 3ds Max is not running.

The 3dsmax.ini  file is constantly being updated while 3ds Max is running.
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3 Open a text editor and load 3dsmax.ini .

4 Scroll down the list of entries until you find the data block:

[RenderProgressDialogPosition]

Dimension=-425 152 379 866

A dialog's position is based off the location of the upper-left corner,
anchored by the first pair of digits. Therefore, in this example, the
upper-left corner of the dialog is -425 pixels from the left edge of the
screen and 152 pixels from the top. The second pair of digits describe the
horizontal and vertical size of the dialog, so this dialog is 379 pixels wide
and 866 pixels tall.

Since this example assumes a single monitor, configured for 1280x1024
resolution, this dialog is off-screen to the left. If the first number were
greater than 1280, the dialog would be off-screen to the right.

5 Place your cursor on the “Dimension” line and scroll over to the problem
number.

The problem number is usually the first or second, since the last two set
the width and height of the dialog.

6 Change the problem number to a value that is positive and within
1280x1024.

7 Save the 3dsmax.ini  file and start 3ds Max.

The next time you render, the Rendering Progress dialog appears appear
on-screen.

This is the preferred method, because it causes no loss to other custom
configuration settings that are stored in the 3dsmax.ini  file.

Quick Method

There are really only two reasons you'd use this method:

1 You've just installed 3ds Max and haven't made any customized settings
that get stored in the 3dsmax.ini  file.

2 You're in a hurry and don't care about the customized settings that you
have stored in the 3dsmax.ini  file.

3 Make sure 3ds Max is not running.

4 Open Windows Explorer and browse to the location indicated by the
MaxData setting on the Configure System Paths dialog on page 7523  .
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5 Delete the 3dsmax.ini  file.

6 Restart 3ds Max.

A new 3dsmax.ini  file is automatically created using default settings.

You need to be careful when using this method, because you don't necessarily
know what custom settings are saved in the 3dsmax.ini  file. Perhaps you have
3ds Max set to display the command panel on the left and you've changed
the viewport background color. Furthermore, if you have third-party plug-ins
installed, they sometimes write information to the 3dsmax.ini  file. If you
delete the file, you will losing all those settings.

If you're not sure about customized settings that are stored in the 3dsmax.ini
file, you can rename the file to something like old3ds.ini. When you restart
3ds Max, you can continue working and, at a later time, compare the two files
and copy the data you need from the old one to the new one.

Material Editor Defaults to Architectural Materials

When you open the Material Editor, you encounter Architectural Materials
instead of original Autodesk VIZ Standard materials.

3ds Max allows you to set default user interfaces. If you build architectural
models or require photorealistic rendering, you can set the user interface to
default to features more relevant to the way you work. This is a new feature
that is set from the Customize menu > Custom UI and Defaults Switcher
dialog on page 7483

The program saves this setting to the 3dsmax.ini file and you have to restart
3ds Max after using the defaults switcher.

Missing Command Panel

The command panel normally appears along the right side on the user
interface. If you start 3ds Max and notice that the command panel is missing,
there are usually three causes.

■ The command panel is turned off.

■ You floated the command panel to another monitor and attempted to
drag it to a new location. When you released the mouse button, the
command panel disappeared.

■ A custom user interface is active that places the command panel off-screen.

User Interface Problems and Recovery | 7687



All of these situations can be quickly fixed by using the following steps.

1 Start 3ds Max.

2 From the main menu, choose Customize > Revert To Startup Layout.

You're warned that all UI settings you've made during the current session
of 3ds Max will be reset.

3 Click Yes.

The original user interface is restored.

Missing Transform Gizmos

Whenever you move, rotate or scale an object, the standard, red axis tripod
is replaced by a special purpose transform gizmo. It's possible to lose the
transform gizmo, but it's easy to get it back. If you find you've lost your
transform gizmo, try these steps.

1 Start 3ds Max.

2 Press the X key.

This is the keyboard shortcut that toggles the transform gizmo on and
off.

3 Press the = key.

This keyboard shortcut increases the size of the transform gizmo. The –
key reduces the size.

4 Open the Customize > Preferences > Gizmos panel, and match your
setting to the default settings shown in the following image.
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Multiple or Missing Buttons on the Toolbars

This is another tricky situation. You open a toolbar and find that there are
duplicate buttons present or the button you expect to find is no longer there.

NOTE This is generally caused by holding the Ctrl key and dragging a button on
the toolbar.

Three Select And Move buttons.

User Interface Problems and Recovery | 7689



This is clearly a user-interface problem, so reverting to the startup layout will
fix this problem.

1 Start 3ds Max.

2 From the Customize menu, choose Revert To Startup Layout, and confirm
the change.

If you have multiple buttons and don't want to reset the entire UI, you can
remove duplicate buttons manually by doing the following:

■ Hold down the Alt key and drag the duplicate button out of the toolbar.
Click Yes when asked to confirm the deletion of the button.

If buttons are missing, use Revert To Startup Layout.

Video Driver and Display Problems
Because 3ds Max heavily relies upon the graphics card in your system, many
problems that you may encounter while using the program can be attributed
to the video. Such problems could be slow performance, refresh delays, user
interface discrepancies, and so forth.

Problems and Resolutions

Basic Troubleshooting Start Point

As a rule of thumb, before attempting to diagnose any problem with 3ds Max,
you can be more efficient in your diagnostics by resetting the display
configuration to its default value. After you first install and start 3ds Max, it
runs by default in Direct3D mode, but if you use the Start menu > Change
Graphics Mode command, you're presented with the Graphics Driver Setup
dialog:
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If you're configured for OpenGL, Direct3D, or Custom, choose the Software
driver. By configuring for the Software driver, you can disqualify the video
card or drivers if the problem you're encountering persists while running 3ds
Max.

■ Resetting the configuration from within 3ds Max.

■ Choose Customize menu > Preferences.

■ Open the Viewport panel and check your currently installed driver.
If it's not the Software driver, proceed. Otherwise, you can cancel and
begin the diagnostics elsewhere.

■ If set to OpenGL, Direct3D, or a custom driver, click the Choose Driver
button.
The Graphics Driver Setup dialog is displayed.

■ Choose Software and click OK.
You'll see a message that the changes will take effect the next time you
start 3ds Max.

■ Exit 3ds Max and restart the program.

■ Try performing the task that was giving you problems.
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■ Resetting the configuration before starting 3ds Max.

1 From the Windows Start menu, navigate to the 3ds Max submenu
and choose Change Graphics Mode.
3ds Max starts up and displays the Graphics Driver Setup dialog.

2 Choose the Software driver and try performing the task that was giving
you problems once the program opens.

If the problem does not persist, you know that you've encountered a display
problem. If this is the case, check the following with regards to your video
card:

■ Verify that the video card supports the driver you attempted to use.
Some cards don't fully support OpenGL or Direct3D.

■ You might not have the latest video drivers for the card.
Contact the board manufacturer for updated drivers.

■ If you were originally configured for OpenGL, try Direct3D, or vice
versa.
The driver for the graphics card may have better support for one driver
than other.

Direct3D Failed to Initialize Message

3ds Max supports both DirectX 8.1 and 9. When configuring the display
settings, you choose DirectX 9 and start 3ds Max only to receive a message
telling you that “Direct3D failed to initialize. Please make sure you have the
latest version of DirectX installed.”

This usually means your card doesn't support DirectX 9 or you don't have
DirectX 9 installed. Revert the Direct3D version back to DirectX 8.1 and
confirm that you are running the latest version of DirectX.

1 Choose Start > Run.

2 In the Open field, type dxdiag and click OK.

3 On the System tab, check the DirectX version.

If it shows DirectX 8.1, you need to download the newer version from
Microsoft.
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Direct3D Reports a Memory Warning

You may encounter a memory warning when starting 3ds Max if you've
configured the program to use the Direct3D driver.

This warning dialog usually appears if you have several programs, that heavily
impact the video memory of your graphics card, running and you have the
3ds Max interface maximized or stretched to cover most of the display.

Your quickest options for bypassing this warning are as follows:

■ Shut down some of the other programs that are concurrently running with
3ds Max.

■ Reduce the size of the 3ds Max interface.

■ Reconfigure 3ds Max to use a different display driver.

Dual-Monitor Configuration

Many board manufacturers are building graphic cards that support
multi-monitor configurations. The cards might advertise hardware features
like “Dual Head” or “Multi-Head” that have two monitor ports built into
them. Other manufacturers choose to handle dual configuration through
video drivers that let you configure your system display in “Wide” mode. Here
are the details of what you need to watch out for when configuring a
multi-monitor system.

■ Hardware “Dual Head” Solution
Many newer video cards offer this hardware solution for setting up a
dual-monitor system.
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After installing the card and drivers, you want to follow the manufacturer's
instructions for configuring your system. Configuration is done through
your system's Display Properties dialog > Settings panel.

You are presented with a diagram for each monitor and you can set the
resolutions independently by selecting a monitor and adjusting the screen
Area slider. You will also often find utilities included with the drivers that
enable special features for the graphics card.

The disadvantage to this configuration is that one monitor is a primary
while the other secondary, so performing some tasks can only be done on
applications positioned on the primary monitor. For instance, if you use
screen-capture software, you can have that program open on the secondary
monitor, but if you want to capture an image, you can only capture images
of applications that are located on the primary monitor.
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■ Software Driver Solution
The software solution to multi-monitor configuration is often found in
older graphic cards that fit into your PCI slots. Each board has a single port
to accept a monitor and the video drivers give you the option to configure
a single display in “Wide” mode to encompass multiple displays. Also,
because you have four PCI slots in your system, you could theoretically
drive four monitors. However, in order for these cards to operate at the
best resolutions, each card needs to have the same amount of video RAM
(vRAM) installed. So, if your had two cards and one had 32 MB of vRAM
and the other only had 8 MB, you can only configure to the highest
resolution supported by the 8 MB card.

Display configuration is normally done through the video drivers so you
have the option to configure wider screen areas. For example, instead of
configuring each display individually to 1280x1024, as described above,
you would treat both monitors as a single display and configure the screen
area to 2560x1024 pixels.

Spanning Across Monitors

Whenever, you start 3ds Max, the user interface spans across both monitors.
You find yourself constantly resizing the program to fit on one screen so you
can see the programs located on the other screen.

This is usually a problem on systems that let you configure both monitors as
one, in “Wide” mode. The utility software that loads with the graphic card
manufacturer's drivers probably has a feature that forces programs to open
across the entire expanse of the display. You can turn off this feature and
programs will open in the last position and size you gave them.

Viewport Transparency

After starting 3ds Max, the user interface appears but you can see the system
desktop through each of the viewports. This problem normally occurs if you
have the display configuration set to either OpenGL or Direct3D and your
graphics card does not completely support OpenGL or Direct3D.
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If configured for Direct3D, you might also see this problem coupled with the
“Direct3D initialization failed” message.

To remedy this problem, follow the steps outlined in Basic troubleshooting
start point on page 7690  and configure for Software. If 3ds Max opens correctly
in this mode, check the video card manufacturers for updated drivers for the
display mode you'd prefer to use.
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Glossary

This section of the Help system contains explanations of concepts and terms
used in the reference, arranged alphabetically.

2-Sided (Double Sided)

Rendering of a box with a double-sided material, and same box with a single-sided
material

In 3ds Max, faces are one-sided. The front is the side with the surface normal
on page 7863 . The back side of the face is invisible to the Renderer; meaning
the face appears to be missing when viewed from the back. Objects are usually
created with the surface normals facing outward, but it is possible to create
objects with the faces flipped or to import complex geometry in which the
face normals are not properly unified.

There are two ways to render both sides of a face. Either turn on the Force
Two Sided option in the Render dialog, or apply a two-sided material to the
geometry.

Usually, you want two sided rendering turned off since it slows rendering
time. However, if you want to render the inside as well as the outside of objects,
or if you've imported complex geometry (for example, from AutoCAD) in
which the face normals are not properly unified, you can use one of the
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methods above to render each face regardless of its normal's orientation. You
can also unify normals explicitly by using the Normal modifier on page 1509 .

2D Map
A two-dimensional image or pattern. A 2D map requires mapping coordinates
to render and appear in viewports. See 2D Maps on page 5619 .

3D DWF
From Design Web Format. A highly compressed file format that is created from
a MAX file. DWF files are easy to publish and view on the Web using the
Autodesk Design Review program, included with 3ds Max.

3D Map
A pattern generated procedurally in three dimensions. A 3D map does not
require mapping coordinates in order to render. However, a 3D map will
appear in viewports only if the object to which it is applied has mapping
coordinates. See 3D Maps on page 5698

3DS and PRJ Files
3DS is the 3D Studio R4 mesh-file format and PRJ is the 3D Studio R4 (for
DOS) project-file format. You can import both these types of files into the
software, as well as DXF and SHP files. You can export 3DS files and DXF files.

See also:

■ Importing 3DS Files on page 6969

■ Importing PRJ Files on page 6971

■ Exporting to 3DS on page 6972
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Importing PRJ and 3DS Files

When you import a 3DS file, you get the following:

■ Backgrounds (solid, gradient, and bitmap).

■ Fog, Layered Fog, and Distance Cue.

■ Ambient light level.

■ Subtractive transparency is converted to "Filter" transparency, and the filter
color is set equal to the diffuse color.

■ Transparency falloff settings.

■ All map channels that are enabled. Map channels that are turned off in
the .3ds file do not import.

■ All map parameters, including UV transforms, Negative, Mirror, and
Rotation. Some Map Parameters such as Blur, Luma, and RGB and Alpha
work much differently. These values are converted to new values that
produce a similar effect.

■ Mask bitmaps are imported as a mask texture.

■ When materials with both Texture 1 and Texture 2 are imported, a
composite texture is created and added to the Standard material's Diffuse
channel.

■ Reflection maps, auto-cubics and mirrors.

■ Automatic reflection map Nth frame and Map Size settings.

■ SXP translation for Marble and Noise materials.

■ 3DS/DOS IK joint parameters.

■ 3DSurfer patch data.

The following information is not imported from a 3DS file:

■ Morph keys

■ Keyframer instances

■ Map channels that are turned off

■ Custom .CUB-format cubic maps

■ Decal transparency using the RGB color of the upper-left pixel of the map
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When you import a PRJ file, you get all of the above, plus Shapes.

Exporting to 3DS Files

The following rules determine what is exported to the 3DS format:

■ Position, Rotation, and Scale animation. If the controller is a TCB controller,
the TCB, Ease In, and Ease Out values are also saved. If the controller is
any other type of key controller, the keys are saved but the tangent
information is lost. If the controller is not a key controller, only the object's
transformation at frame 0 is saved.

■ Basic material color/parameters from the Standard material.

■ Single maps with their amount, offsets, scales, etc.

■ Composite and procedural maps don't export.

■ Auto-cubics and Mirrors export.

■ UV mapping coordinates can be exported.
UV mapping coordinates are exported if the toggle Preserve MAX's Texture
Coordinates is turned on in the Export Scene to .3DS File dialog. See
Exporting to 3DS on page 6972 .

A vertex in a 3DS file can have only one texture coordinate. If a vertex in
the 3ds Max file has multiple mapping coordinates, it is split into multiple
3DS vertices on export, to preserve the mapping.

■ Grouped object transformations don't export to the 3D Editor because
there's no concept of group hierarchy in the 3D Editor. Groups do export
to the Keyframer because the Keyframer understands hierarchies.

■ Target cameras, target spotlights and omni lights.

■ Most "static" parameters for cameras and lights, and animation tracks for
Roll, Falloff, Hotspot, and FOV are exported. Global shadow parameters
are not exported.

■ All non-mesh geometry, such as procedural primitives and patches, are
collapsed to meshes before export.

■ Objects are exported as they exist on the frame that displays at export
time.

■ Objects are exported as they exist on the frame that displays at export
time. If you want to output morph targets, go to each frame and export
the target to a different file name.
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■ Meshes are saved with edge display information and smoothing groups.

■ Instances are saved as Keyframer instances.

Modifier and morph animation is frozen at the current frame, collapsed, and
exported as a simple mesh.

Action
Operators on page 7873  and tests on page 7948  in Particle Flow are known
collectively as actions.

Active Link

File Link Manager showing an actively linked drawing.

When you use the File Link utility to link a drawing to 3ds Max, the objects
have an active link with the original drawing in AutoCAD or Autodesk
Architectural Desktop. This means that any edit made to the drawing in
AutoCAD or Architectural Desktop can be immediately updated in 3ds Max
by reloading the link.

The red flag in the file list means the drawing has been changed in AutoCAD
or Architectural Desktop and you should click the Reload button to update
the scene in 3ds Max.

The Detach button will cause the drawing file that is linked to 3ds Max to be
removed from the scene and removed from the File Link Manager.
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Clicking the Bind button will bind the drawing to 3ds Max and sever the
active link with AutoCAD or Architectural Desktop.

Active Time Segment
The active time segment is the total range of frames that you can access using
the time slider on page 7312 .

By default, the active time segment runs from frames 0 to 100, but you can
set it to any range from the Time Configuration dialog on page 7359 . In
addition, the active time segment can include negative frame numbers, so
you can create keys before frame 0 and work in negative time.

You can change the active time segment whenever you want without affecting
the keys you've already created. You might think of it as a window in time,
specifying only that portion of your animation in which you want to work.
Thus, if you have keys scattered over a range of 1000 frames, you can narrow
your active time segment to work on only frames 200–300 without affecting
the keys outside of the segment.

Active/Inactive Footsteps

 When you first create footsteps for a biped in Footstep mode on page
4351 , they are inactive. You must activate these footsteps using the Create Keys
For Inactive Footsteps button. Active footsteps have keys to animate the biped.
Inactive footsteps have not been given keys by character studio.

 You can make active footsteps inactive by clicking Deactivate Footsteps.

Both these buttons are on the Footstep Operations rollout on page 4355 .

In the Track View – Dope Sheet editor, inactive footsteps are displayed with
a distinctive color to indicate they are inactive.

If you have upper body animation added to a biped, and you deactivate the
footsteps, then re-activate you will lose the existing upper body keys. Use
Adapt Locks on the Dynamics and Adaptation rollout to control which tracks
are affected by the create keys process.

7702 | Glossary



ActiveShade Initialize and Update
ActiveShade rendering on page 5910  is a two-step process:

■ Initialize

■ Update shading

The Initialize Pass

Rendering can be slow. The initialize pass is meant to take care of the most
time-consuming portions of rendering, to allow the update pass to take place
as quickly as possible. Initialization includes the following steps:

■ Evaluate the scene geometry into meshes.

■ Apply space warps.

■ Do transformations and clipping.

■ Evaluate textures and shade materials.

■ Perform optimizations to speed later processing, such as merging fragments
from the same surface that are in the same pixel.

The result of initialization is a buffer. This is a compressed rendering that, like
a G-Buffer on page 7795 , contains the rendering plus additional information
used by the second step, updating.

During the initialize pass, progress is indicated by a row of pixels (white by
default) that traverses the top edge of the ActiveShade window.

The Update Shading Pass

Updating shading takes the buffer created by the first pass, initialization, and
uses information in that buffer to change the color of pixels when you make
changes to lights and materials in the scene.

During the update pass, progress is indicated by a row of pixels (white by
default) that descends the right edge of the ActiveShade window.
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Adapt Locks
By default, character studio automatically adapts biped keys when you edit
footsteps in a footstep animation on page 4098 . You can avoid this adaptation
by using the Adapt Locks toggles on the Dynamics & Adaptation rollout on
page 4336 . Each toggle locks a specific track so that character studio doesn't
adapt it when you edit footsteps.

Adapt Locks applies only to footstep animation, not to freeform animation.

Adaptation
In the Motion Mixer on page 7856 , when the same clip is used more than once
on tracks, the clip versions are either instances on page 7819  or adaptations of
one another.

The same clip used more than once for one biped, or for different bipeds of
the same size, is an instance. The same clip used for different-sized bipeds is
an adaptation.

These terms are used because the Mixer adapts each loaded clip to the biped's
size. The first time a clip is loaded, the Mixer adapts the clip as needed. When
the clip is cloned or loaded again, the Mixer adapts the new clip to the biped
as needed, then compares the change to previously loaded versions to see if
it's the same. If so, the new clip and its previous versions are instances of one
another. If not, the new clip and previous versions are adaptations of one
another.

In footstep animation, the term adaptation refers to keys generated for a
footstep sequence. When you edit active footsteps, body and leg keys are
adapted automatically. By analogy, the footsteps become a kind of "gizmo"
for manipulating the keyframes of your character's animation. In most cases,
edits you make to footsteps will act upon your keys in an intuitive fashion.
See Footstep Animation on page 4098 .

Adaptive Degradation
When you turn on Adaptive Degradation  on page 83 , 3ds Max can change
the way it displays objects to keep up with the current operation. For example,
while you are zooming a viewport, some objects might change from shaded
to bounded boxes during the zoom operation, and then switch back to shaded
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display when you finish zooming. The settings on the Adaptive Degradation
panel on page 7622  of the Viewport Configuration dialog control how adaptive
degradation occurs.

When Adaptive Degradation is off, viewports retain their display settings at
all times, but operations such as zooming or animation playback cause a slow
screen refresh rate. In this state, animation playback might have to drop frames
to keep up with real-time playback.

You can set the parameters that control the trade-off between display quality
and display speed. The levels you activate determine which rendering levels
the software falls back to when it cannot maintain the desired display speed.
You can choose as many levels as you want, but for best results choose only
one or two levels.

Additive Opacity
An additive process adds two values together, such as two colors. When you
add colors in 3ds Max, the result is brighter than either of the two original
colors.
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Additive Opacity

Sphere on the right uses additive opacity.

Additive opacity brightens the colors behind the material by adding the
material's colors to the background colors. Additive opacity is good for special
effects such as light beams or smoke. You specify the use of additive opacity
on the Extended Parameters rollout on page 5312 .

Additive Opacity and the Alpha Channel

By default, additive opacity does not generate an alpha value. In other words,
the alpha value is zero, indicating no transparency. This gives correct results
with backgrounds in renderings, but if you want to composite objects with
additive opacity using video post or a compositing program, you might want
to have additive opacity render with transparency. To do so, add the following
line to the [Renderer] section of the 3dsmax.ini file, and then restart 3ds Max:

AlphaOutOnAdditive=1

To revert to the default method of rendering additive opacity, in the 3dsmax.ini
file, change the value of AlphaOutOnAdditive back to 0 (zero), and then restart
3ds Max.
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See also:

■ Subtractive Opacity on page 7941

Adjust Talent Pose 
When you animate a biped with motion capture on page 4493 , after you load
a marker file on page 7841 , you can use Adjust Talent Pose to correct the biped's
position relative to the motion-capture markers. Align the biped limbs to the
markers, then click Adjust Talent Pose to compute this offset for all the loaded
marker data. This button is on the Motion Capture rollout on page 4503 .

Affine Transformation
A geometric transformation such as move, rotation, or scale, that can alter
distances between points or angles between lines, but preserves straight lines
and the parallel relation between parallel lines. Transform operations are affine
transformations. NURBS on page 2176  are invariant under affine
transformations.

Airborne Period
In footstep animation on page 4098 , a "ballistic gait" is defined as any footstep
pattern in which there are periods with no feet on the ground, causing the
biped to become airborne, or ballistic. For example, running, hopping, and
jumping are ballistic gaits with airborne periods.
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Aliasing/Antialiasing

Pyramid is aliased on left, antialiased on right.

Aliasing is the staircase effect at the edge of a line or area of color when it's
displayed by an array of discrete pixels.

Antialiasing smoothes the staircase effect that occurs when diagonal or curved
lines or borders are drawn on raster displays consisting of square or rectangular
pixels. Antialiasing can be either on or off. Turn this off only when you're
rendering test images and want greater speed. Leave it on at all other times.

You can also turn antialiasing off for the Material Editor sample slots to speed
up redraw of the sample objects. Click the Options button in the Material
Editor and turn on the Antialias toggle on the Material Editor Options dialog.
Default=off.

NOTE To control whether or not a background image is affected by the renderer's
antialiasing filter, choose Customize > Preferences > Rendering and then turn on
Filter Background in the Background group. Default=off.
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Alpha Channel

Alpha channel shown in black, on the right

Alpha is a type of data, found in 32-bit bitmap files, that assigns transparency
to the pixels in the image.

A 24-bit truecolor file contains three channels of color information: red, green,
and blue, or RGB on page 7908 . Each channel has a particular intensity or value
at each pixel. The intensity of each channel determines the color of the pixel
in the image.

By adding a fourth, alpha channel, the file can specify the transparency, or
opacity, of each of the pixels. An alpha value of 0 is transparent, an alpha
value of 255 is opaque, and values in between are semi-transparent.
Transparency is important for compositing on page 7741  operations, such as
those in Video Post, where several images are blended together in layers.

An alpha channel is particularly useful for the partly transparent pixels around
the aliased on page 7708  edge of an object in a rendered image. These pixels
are used for compositing. An image such as the one shown above can be
composited smoothly onto a different background if an alpha channel is
produced and saved with the image.

Each channel of a truecolor bitmap file is defined by 8 bits, providing 256
levels of intensity. Thus, an RGB file is 24-bit with 256 levels each of red,
green, and blue. An RGBA file (red, green, blue, alpha) is 32-bit, with the extra
8 bits of alpha providing 256 levels of transparency.

3ds Max creates the alpha channel automatically when you render. Any
background pixels in the rendered image are fully transparent, and the alpha
channel also accounts for any other transparency that you create via materials,
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etc. You can see this in the rendered frame window on page 5885  by clicking
the Display Alpha Channel button on the toolbar: In the resulting display,
black pixels are fully transparent, white pixels are opaque, and gray pixels
show degrees of transparency. To return to the regular display, click Display
Alpha Channel again.

To output a rendered image with alpha, save in an alpha-compatible format
such as TIFF or Targa. With Targa, the default settings include saving alpha;
with TIFF, be sure to turn on the Store Alpha Channel check box.

Ambient Color
Ambient color is the color of an object where it is in shadow. This color is
what the object reflects when illuminated by ambient light rather than direct
light.

Ambient color areas in the scene will not appear any darker than the ambient
light setting on page 7710 .

You can lock a material's ambient color to its diffuse color so that changing
one automatically changes the other.

Ambient Light

Left: No ambient light

Middle: Low ambient light

Right: User-adjusted ambient light

Ambient light is the general light that illuminates the entire scene. It has a
uniform intensity and is uniformly diffuse. It has no discernible source and
no discernible direction.
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By default, there's no ambient light in a scene. If you examine the darkest
shadows on your model with the default ambient light setting, you cannot
make out the surface because it's unlit by any light. Shadows in your scene
will not appear any darker than the ambient light color, which is why you
usually keep ambient light set to black (or a very dark color).

If you use photometric lights and a radiosity solution on page 5976 , ambient
light is accurately calculated. The other advanced lighting option, light tracing
on page 5963 , also generates ambient lighting.

If you use standard lights, a good lighting test is to set your ambient lighting
to black (the default), set up all your lights, and then decide at the end if you
need to increase the ambient light.

Animated Texture
An animated texture is a material whose properties change over time. One
example of this is assigning a multi-frame bitmap (for example, an AVI file or
an IFL image-file sequence) as a map.

Animated textures can also be materials with keyframed parameters. In
addition, in the context of particle systems, a material that uses the Particle
Age map on page 5727  or the Particle MBlur map on page 5729  is considered to
be animated.

In general, when applying an animated texture to particles in Particle Flow,
be sure incorporate it in a Material Dynamic operator on page 2846 .

Animation
Animation is based on a principle of human vision. If you view a series of
related still images in quick succession, your brain perceives them as
continuous motion. Each image is called a frame.

Historically, the major difficulty in creating animations has been that the
animator must produce a large number of frames. Depending on the quality
you want, one minute of animation might require between 720 and 1800
separate still images. Creating images by hand is a big job. That's where
keyframing comes in.

Most of the frames in an animation are routine, incremental changes from
the previous frame directed toward some predefined goal. Early animation
studios quickly realized they could increase the productivity of their master
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artists by having them draw only the important frames, called keyframes.
Assistants could then figure out the frames that were required in between the
keyframes. These frames were (and still are) called tweens.

Use the software as your animation assistant. As the master animator, you
create the keyframes that record the beginning and end of each transformation.
The values at these keyframes are called keys. The software calculates the
interpolated values between each key value, resulting in tweened animation.

3ds Max is not limited to animating transformations (such as position, rotation,
and scale). It can animate just about any parameter you can access. Thus, you
can animate modifier parameters, such as a Bend or a Taper angle, material
parameters, such as the color or transparency of an object, and much more.

Early animation studios also had to employ artists to add the ink and color
to each frame. Even today, production of a cartoon usually requires hundreds
of crafts people and artists to generate the thousands of images. With 3ds
Max, the renderer takes over the job of shading and rendering each frame and
storing it as you direct. The end result is a high-quality finished animation.

The quickest way to animate is to turn on Auto-Key on page 3007  and start
transforming objects at different frames. Each time you transform an object,
you set a key. Then you can play the animation onscreen on page 7355 , or
render it to a file on page 5892 .

Animation Controllers / Transform
Controllers

All animation in the software is performed through animation controllers.
The most common animation controllers, those for move (position), rotate,
and scale, are also referred to as transform controllers.

Each animation track has its own controller, and each controller can be
different.

In the hierarchy list, the controller tracks are represented by controller icons.
The icons can appear differently depending on the controller that is assigned,
for instance a Noise Float icon differs from a Bezier Float icon. You can also
see which specific controllers are assigned to each track by turning on the
controllers display in the Track View (right-click Filters in the Track View
toolbar, and choose Controller Types from the list). The controller names
appear beside the tracks to which they're assigned.
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You can assign different controllers to the tracks, affecting the way they
respond. The Bezier Controller, assigned by default to all the Position tracks,
lets you move objects using the Select and Move transform tool, and converts
those movements into Bezier splines. You can adjust the splines in Function
Curve editing mode.

Animation Layers
When you animate a biped or other object, you can add layers of animation
above the original biped animation. This is a powerful way of making global
changes to your animation. For example, when you add a layer and rotate the
spine forward at any frame, a run cycle becomes a crouched run. The original
biped motion is kept intact and can be viewed by switching back to the original
layer.

You can view layers individually or as a composite of all the animation in all
the layers. Layers behave like a freeform animation; the object can adopt any
position.

Layers used in conjunction with Biped let you easily adjust raw motion-capture
data, which contains keys at every frame. You do this by adding a layer and
keyframing the biped.

Layer controls for Biped are on the Layers rollout on page 4322 . For other
objects, use the Animation Layers toolbar on page 7293 .

Applied IK
A type of inverse kinematics where one or more parts of the IK structure follows
another animated object exactly. After the scene is set up, Applied IK generates
transform keys for every object in the IK chain.

See Animating with Applied IK on page 3386 .

Area Lights (mental ray Renderer)
Area lights are a feature of the mental ray renderer. Instead of emitting light
from a point source, they emit light from a broader area around the source.
Area lights create soft-edged shadows. This can help improve the realism of
your rendering.
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Scene rendered with area light turned off

Shadows are ray-traced.

The yellow cube indicates the light's location.
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Scene rendered with area light turned on, showing soft shadows

The light in this rendering is a 2D (spot) area light.
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Scene rendered with a 3D (omni) area light

The light uses the default radius of 20.0.

NOTE To render soft-edged shadows, shadows must be ray-traced, not
shadow-mapped. See the Render Scene Dialog > Renderer panel > Shadows &
Displacement rollout on page 6114 .

Area lights support global illumination, caustics, and other features of the
mental ray renderer.

TIP Area lights take longer to render than point lights. If you are interested in
creating a quick test (or draft) rendering, you can use the Area Lights/Shadows
As Points toggle to speed up your rendering. This toggle is on the Render Scene
dialog > Common panel > Common Parameters rollout on page 5929 .
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Area Shadows

The shape of the shadow-casting region changes the shape of area shadows.

Area shadows simulate shadows generated by a light with area or volume.
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Aspect Ratio

Various aspect ratios

Aspect ratio describes the proportions of a still image or the frames in a movie,
expressed as the ratio of width to height, regardless of the image's resolution
on page 7911 .

Aspect ratio is usually expressed either as a ratio of width over height (for
example, 4:3) or as a real value relative to 1 (for example, 1.333). For example,
pre-1950s movies and 35 mm slides have an aspect ratio of 4:3.
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Aspect ratios are used anywhere a bitmap is created or used. For example:

■ When preparing to render, you can specify an aspect ratio for your rendered
images with the Image Aspect parameter on the Render Scene dialog on
page 5878 .

■ When setting up a viewport background on page 89 , you can specify
whether to use the viewport, bitmap or rendering output aspect ratio to
display the bitmap.

■ When you make a spotlight a projector on page 5055 , you can use the
Bitmap Fit option to match the spotlight's aspect ratio to the bitmap's, and
thus prevent the bitmap from distorting.

Attachments (IK)
In biped animation, the biped hands and feet can be linked to the world,
another object in the scene, or to the biped's own body. This linking is also
called IK attachment. Attachment can be blended: this lets you start with one
attachment and end with another. For example, if the biped is catching a ball,
you can start with the hand in body space and end with the hand in the
coordinate space of the ball.

Attenuation

Image on right rendered with attenuation

In the real world, the intensity of light diminishes over distance. Objects far
from the light source appear darker than objects near the source. This effect
is known as attenuation.
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In nature, light attenuates at an inverse square rate; that is, its intensity
diminishes in proportion to the square of the distance from the light source.
It is common for attenuation to be even greater when light is occluded by
small particles in the atmosphere, especially when there are clouds or fog
present.

Attenuation and Photometric Lights

Photometric lights always attenuate at the inverse square rate. This is one of
the reasons it is important for scenes with a radiosity solution to use real-world
dimensions and units.

Attenuation and Standard Lights

By default, standard lights don't attenuate. Consequently, an object's distance
from the light doesn't matter, and only the angle of light to the surface has
any effect on illumination unless you turn on attenuation. You can manually
control the rate of attenuation for standard lights. You can also use attenuation
with the Raytrace map. If your scene uses standard lights, you should consider
adding attenuation whenever possible, for two reasons:

■ Attenuation provides greater subtlety and realism in your lighting.

■ You can reduce rendering time, since attenuated lights don’t have to be
calculated for surfaces that are beyond the attenuation range.

For standard lights, you can explicitly set where attenuation begins and ends.
This is partly so you don't have to worry about setting up strictly realistic
distances between light objects and the objects they illuminate. More
importantly, this feature lets you fine-tune the effect of attenuation. In outdoor
scenes, attenuation can enhance the effect of distance. In an indoor setting,
attenuation is useful for low-intensity light sources such as candles.

For standard lights, you set attenuation parameters on the light's
Intensity/Color/Attenuation rollout on page 5065 . For the Raytrace map, you
set the parameters on the map's Attenuation rollout on page 5784 .

AutoGrid
AutoGrid is an option on the 3ds Max Create panel. It lets you create an object
on the surface of another object. You can turn on AutoGrid when you create
a biped, in order to position the biped on another object.
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AutoGrid can also be used when creating footsteps manually, to place footsteps
on an uneven terrain.

Avoid Behavior
In crowd animation on page 4680 , the Avoid behavior lets you specify any
object or objects that delegates must keep away from. As delegates approach
designated objects during the crowd simulation, they steer clear of them while
turning or braking as necessary. This behavior uses three different methods
to let delegates avoid each other and other objects: Steer To Avoid (the
preferred method), Repel, and Vector Field. See Obstacle Avoidance on page
4699 .

Avoidance Behavior
In crowd animation on page 4680 , avoidance behavior consists of any
combination of slowing down, turning, and stopping. See Obstacle Avoidance
on page 4699 .
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Axonometric View

Axonometric view of model

A projected view of 3-dimensional space that displays from one to three sides
of an object. The lines in an axonometric view do not converge to vanishing
points as they do in a perspective view, so lines that are parallel in 3D space
are parallel in the view. For this reason, diagonal and curved lines can appear
to be distorted.

Isometric on page 7823  and orthographic on page 7877  views are special cases
of axonometric views.

B-Spline
B-spline (basis spline) is a kind of spline generated by so-called basis functions.
The advantage of B-splines over Bezier curves on page 7726  is that the control
vertices (CVs) of a B-spline affect only their local region of the curve or surface.
B-splines also compute faster than Bezier curves.
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Balance Factor
Balance Factor positions the biped's weight anywhere along a line that extends
from the center of mass to the biped's head, affecting the degree to which the
hips or head (or both) swing away from their original vertical alignment when
the biped is bent over.

See Shifting the Biped's Balance on page 4134 .

Balance Track
Each biped added to the Motion Mixer on page 3621  is automatically assigned
a balance track. You don't place clips on this type of track as you do with
transition tracks on page 7959  and layer tracks on page 7825 . The weight curve
on page 7971  on the balance track is the only adjustable parameter.

By default, the Motion Mixer compensates for differences in upper and lower
body motion that might cause the biped to go off balance over the course of
the animation. It accomplishes this by changing the COM, pelvis and spine
animation.

When the weight curve across the balance track is set to 1.0 (the default),
balance compensation is enabled for the entire animation. You can adjust
nodes on the weight curve to disable balance compensation over all or part
of the animation. See Adjusting Biped Balance in the Mixer on page 3659 .

Ballistic Gait
A "ballistic gait" is defined as any footstep pattern in which there are airborne
periods (periods with no feet on the ground) such as a jumping or running
pattern.

Ballistic Tension
Controls the amount of spring or tension when the biped lands or takes off
from a jump or run step. See Adjusting Vertical Motion on page 4139 .
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Barycentric Coordinates
Given a triangle between points A, B, and C, each point X on the surface of
the triangle can be represented by a weighted sum of the corners:

X = a*A + b*B + c*C

where a, b, and c are numbers between 0 and 1 and a+b+c = 1.

These numbers are called the barycentric coordinates of the point X. There is
one unique set of barycentric coordinates for each point on the triangle.

Examples

The center of gravity of the triangle is given by the barycentric coordinates
(1/3, 1/3, 1/3): X = 1/3 A + 1/3 B + 1/3 C = (A+B+C)/3.

If one of the barycentric coordinates is zero, the point X must lie on the
opposite edge. For instance:

if a=0, X = b*B + c*C

where b+c=1

This means that X is on the line segment BC.

If a=1, on the other hand, then b=c=0, and X must be exactly the point A.

Behaviors
In crowd animation on page 4680 , behaviors simulate a range of activities.
Seek, avoid, path follow, surface follow, repel, orientation, scripted, space
warp, surface arrive, wall repel, wall seek, and wander are all behaviors available
in a crowd simulation.

Behaviors let you assign procedural activity types to delegates and objects
linked to delegates. You can associate any number of behaviors with each
Crowd object, and then link delegates and teams of delegates to each behavior.
A specific behavior assigned to a Crowd object belongs only to that crowd; it
cannot be assigned to any other crowds.
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Bend Links 

Bend Links Mode active (left) and Bend Links Mode inactive (right)

When you turn on Bend Links Mode (on the Bend Links rollout on page 4284
), rotating a single chain link causes the other links to bend following a natural
curvature. When Bend Links Mode is off, rotating one link rotates all its
children links by the same amount.

TIP Bend Links works well on the biped spine, neck, tail and ponytail links.
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Bezier Curve

Bezier curve and the control points and tangent vectors about each vertex

A curve modeled using a parametric polynomial technique. Bezier curves can
be defined by many vertices. Each vertex is controlled by two other points
that control the endpoint tangent vectors. Bezier curves were developed by
P. Bezier for computer modeling in automobile design.

A vertex on a Bezier Curve affects the entire curve in that area. Compare with
B-splines on page 7722 , where the control vertices (CVs) affect only their local
region of the curve or surface.

A segment on an editable spline on page 606  that has its vertices set to Bezier
or Bezier Corner is considered a Bezier Curve.

BioVision Files
The BioVision™ file format stores motion-capture information. A BVH file
contains the "actor's" skeletal and limb/joint rotation data, and uses the .bvh
file name extension.
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NOTE For the BVH file specification, see the BVH.rtf  document on the program
disc.

BIP Files
BIP files contain skeletal size and limb rotation data for bipeds. This is the
native character studio motion file format.

Biped
Biped is a 3ds Max system provided with the character studio product. It
provides the armature used to pose a character, and facilities to animate it
using either footsteps or freeform animation.

Biped Dynamics
Biped dynamics calculate a biped's airborne trajectory, the bending of its knee
or knees on landing, and the biped position so it maintains balance when the
spine is rotated. When the position or animation of the biped change,
dynamics cause the biped to adapt.

There are six parameters that affect biped dynamics. Three are in the Body
section of the Key Info rollout on page 4288 :

■ Balance Factor on page 7723

■ Dynamics Blend on page 7763

■ Ballistic Tension on page 7723

The other three are on the Dynamics & Adaptation rollout on page 4336 :

■ GravAccel on page 7804

■ Biped Dynamics

■ Spline Dynamics on page 7937
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Biped Playback 
Biped Playback on the Biped rollout on page 4253  plays the animation for all
bipeds in a scene (unless you use the Display Preferences dialog to exclude
them). This playback mode usually gives real-time playback, which you might
not get if you use the 3ds Max viewport animation Play button.

In Biped Playback mode, the biped is displayed as bones only, with no other
scene objects visible.

Birth Event
A birth event is a special type of local event on page 7831  that always comes
at the start of a particle flow on page 7787 , immediately after the global event
on page 7801 . Its first action on page 7701  is a Birth operator on page 2764  or
Birth Script operator on page 2767 . The birth event can contain any number of
additional actions, and can be succeeded by any number of additional events.
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Birth event (highlighted)
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Bitmap
A bitmap is a still image produced by a fixed matrix of colored pixels on page
7896 , like a mosaic. You can use bitmaps as textures for materials, as backgrounds
to viewports, and as rendered environments.

You can use an animation or video file as a bitmap, in which case the material
or background changes over time.

Bitmaps can be reloaded automatically after they have been changed and
resaved by a graphic editing program. See the Reload Textures On Change
toggle in Preferences Settings > Files panel on page 7541 .

3ds Max can use the following image file formats as bitmaps:

avi on page 7118

bmp on page 7120

cin on page 7120

cws on page 7121

dds on page 7122

gif on page 7126

Radiance Image File: ( hdr on page 7126 , pic)

ifl on page 7131

jpg on page 7139

mov on page 7140

mpg on page 7140

png on page 7152

psd on page 7153

rgb on page 7161

rla on page 7156

rpf on page 7159

tga on page 7162

tif on page 7164

yuv on page 7166
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NOTE 3ds Max can also render to some of these formats, but not to all of them.
See the topic for the individual image format for details.

Blend Object

NURBS blend surface

A dependent NURBS object that connects two curves or two surfaces. The
curvature of the blend is controlled by the objects it connects, and by two
tension parameters that control the "length" of effect of the tangent for each
of the "parent" objects.

Block Reference
In AutoCAD, a compound object that is inserted into a drawing and displays
the data stored in a block definition. A block reference is also sometimes
referred to as a Block Instance. Refer to the AutoCAD, Autodesk Architectural
Desktop, or Autodesk Mechanical Desktop help files for further information
regarding Blocks, Block Instances, and Block References.

Glossary | 7731



Block/Style Parent
A Block/Style Parent is closely related to a VIZBlock on page 7967  in that it is
a compound object similar to a nested AutoCAD block. Just like the VIZBlock,
it is used for organizing linked data from DWG files. When linking DWG data
to 3ds Max, you need to decide how the incoming entities are to be organized
in the scene. Objects in DWG files are commonly organized by layers, blocks,
and entities, while 3ds Max scenes are organized by parent/child hierarchies
of objects.

The main difference between a Block/Style Parent and a VIZBlock is that a
Block/Style Parent allows for a parent/child hierarchy of “components,” but
does not display any of its own geometry. A VIZBlock displays its own geometry
and lists a set of “components,” or sub-objects.

Blur / Blur Offset

Top: Blur = 1, Blur Offset = 0

Middle: Blur = 10, Blur Offset = 0

Bottom: Blur = 0.01, Blur Offset = 0.2
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The Blur and Blur Offset controls determine how a 2D map is blurred, or how
it is softened in the rendering. You can't see their effect in the viewport
renderer, only in the production renderer.

The Blur setting blurs the map based on its distance from the view. The farther
away the map is, the greater the blurring. You should always use some blurring
on your maps to avoid the type of scintillation, or aliasing that can occur
when pixel details are reduced off in the distance. This effect typically occurs
when you use detailed bitmaps viewed at a distance, and is particularly
apparent during animations. The Blur default is 1.0, which is a good setting
for most purposes.

Blur Offset blurs the map without regard to depth. That is, all the pixels in
the map are blurred equally, regardless of how close or how far they are from
the camera.

Whereas the Blur value is primarily used to avoid aliasing, Blur Offset is useful
when you want to soften, or defocus the details in a map. It's the equivalent
of blurring the bitmap in an image-processing program before applying it as
a material map.

NOTE For bump mapping on page 5382 , lower Blur and higher Blur Offset values
give better results.

Body Space
A biped limb can be put into the coordinate space of the world or an object
in the scene as well as body space. Body space moves the biped limbs when
the biped moves; if you rotate the biped's hips, the feet, in body space, move
as well.
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Boolean Operation

The fence is operand A, and the cat is operand B.

Upper left and right: A minus B

Second to upper left: B minus A

Second to lower left: Union

Lower left: Intersection

A Boolean object combines two objects by performing a Boolean operation
on them. In the software, a Boolean object is made from two overlapping
objects. The original two objects are the operands (A and B) and the Boolean
object itself is the result of the operation.

For geometry, the Boolean operations are:

■ Union: The Boolean object contains the volume of both original objects.
The intersecting or overlapping portion of the geometry is removed.

■ Intersection: The Boolean object contains only the volume that was
common to both original objects (in other words, where they overlapped).
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■ Subtraction (or difference): The Boolean object contains the volume of
one original object with the intersection volume subtracted from it.

Bound Vertex
Binding spline vertices via the Refine and Bind functions in Editable Spline
(Vertex) on page 606  is useful for connecting splines when building a spline
network for use with the Surface Modifier on page 1695 .

Bound vertices are black, allowing them to be easily distinguished from
standard vertices. You cannot move a bound vertex directly. However,
changing the segment length by scaling it or by moving a connected vertex
causes the bound vertex to shift its position in order to remain at the segment's
midpoint. You can change a bound vertex's type (right-click the vertex, and
then choose the type from the bottom of the right-click menu), and if you
convert it to a Bezier or Bezier corner, you can manipulate its handles.
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Bounding Box

Bounding box shows the extents of the model boat.

The bounding box is the smallest box that encloses the maximum dimensions
or extents on page 7773  of an object.

You can display selected objects in the scene as bounding boxes to speed up
screen redraw. Use the Object Properties dialog on page 245 .

The Align command on page 938  uses the maximum and minimum extents
of the object's bounding box to align objects.

Bulge
Physique allows you to “bulge” a mesh based on the orientation of a limb.
Bulging the mesh is used to simulate muscle contraction.
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Bulge Angle
In Physique, a bulge angle is a control that sets the limb angle where the bulge
will occur. Typically you first orient the limb, and then set the bulge angle.
After setting the bulge angle, you then deform the mesh to make it bulge.

BVH Files
BVH is the file name extension for the BioVision™ motion-capture file format.
A BVH file contains the "actor's" skeletal and limb/joint rotation data.

NOTE For the BVH file specification, see the BVH.rtf  document on the program
disc.

By Layer

By Layer icon in the Layer Manager dialog

ByLayer is a property setting available to objects listed in the Layer Manager
on page 7227 , as well as from the Object Properties dialog on page 245 . When
By Layer is set, the object inherits settings for the selected property from its
associated layer.

Center of Mass (COM)
The root object of a biped. Transforming the center of mass moves the entire
biped. The center of mass can move outside of the biped body; for example,
moving the center of mass forward can help simulate lifting a heavy object.
The center of mass uses three animation tracks to animate the biped. Two of
these tracks, Body Vertical and Body Horizontal, contain biped dynamics on
page 7727  parameters.
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Chamfer

NURBS chamfer curves

A dependent NURBS object that is a line segment connecting two curves. It
is controlled by the curves it connects, and by two length parameters that
control the distance back from the point of apparent intersection of the
"parent" curves.

character studio Marker Files
The character studio marker (CSM) file format stores motion-capture data in
ASCII (text) format. It uses positional markers rather than limb rotation data.
When you import a raw marker file, only marker position data is stored in the
motion-capture buffer. character studio uses the marker data to extract limb
rotation data to position the biped.

NOTE For the CSM file specification, see the CSM.rtf  document on the program
disc.

7738 | Glossary



CIBSE Files
The CIBSE file type is the file format for photometric data adopted by the
Chartered Institution of Building Services Engineers. It is used primarily in
Great Britain.

Clip Controller
In crowd animation on page 4680 , the GlobalMotionClip and MasterMotionClip
controllers are used to create animation for multiple objects. Birds, butterflies,
schools of fish, and bugs can be animated using these tools. Clip controllers
can be created either as block controllers in Track View, or more directly in
the Crowd helper on page 4738  controls on the Global Clip Controllers rollout
on page 4836 . Use clip controllers to animate non-biped creatures in crowds.

Clipping Planes
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Clipping planes let you exclude some of a scene's geometry to view or render
only certain portions of the scene. Each camera has a near and a far clipping
plane. Objects closer than the near clipping plane or farther than the far
clipping plane are invisible to the camera.

Clipping planes are useful for rendering selected portions of a scene that have
a lot of complex geometry. They can also help you create cutaway views.

Clipping plane settings are part of the camera's creation parameters. The
location of each clipping plane is measured along the camera's line of sight
(its local Z axis) in the current units for the scene.

Clipping planes are part of a camera’s general parameters on page 5123 .

Viewports can also have clipping planes. You set a viewport’s clipping planes
via the viewport right-click label on page 7370 .

Codec
Short for compressor/decompressor. An algorithm for compressing and
decompressing digital video data, and the software that implements that
algorithm.

Cognitive Controller
In crowd animation on page 4680 , the Cognitive Controller editor on page
4776  lets you sequence different behaviors using state diagrams, where
conditionals written in MAXScript impose changes in behavior. For example,
you can specify that a character or object is to wander aimlessly until it comes
within a certain distance of another object, whereupon it heads straight for
that object. Or you can specify that one character is to avoid another only
when the second character is avoiding the first.
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Composite

The mailbox with its shadow is composited with the wall and sidewalk to make the
finished scene.

(noun) A still image or a motion picture created by overlaying one image or
motion picture with another.

(verb) To combine still images or motion pictures by laying one over the other.

Compositing often makes use of an image's alpha channel on page 7709 .
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Compound Materials

House on right uses a compound material.

(House on left uses the default standard material).

Compound (or complex) materials let you create a material consisting of two
or more sub-materials.

The real power in using compound materials is that each sub-material can be
as complex as any standard material.

The Multi/Sub-Object compound material lets you assign different materials
to different sub-objects, at the sub-object level of your geometry.

You load or create compound materials using the Material/Map Browser.

For more information about the types of compound materials you can create,
refer to Compound Materials on page 5544 .
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Constrained Point
A NURBS Point that is dependent on either another Point, Curve, or Surface,
and whose position is either on the parent object or relative to it. The relative
cases are XYZ-relative, along a normal, or along a tangent (or set of tangents
for a surface-dependent constrained point).

Contact Object
In Particle Flow on page 2713 , in the context of the Shape Mark operator on
page 2832 , a contact object is the object that will receive the marks created by
the operator.

Containers
Containers are Track View items with multiple branches that provide a
complete definition of something in your scene.

Container items that appear in Track View include:

■ Materials definitions with all parameters, maps, and sub-materials.

■ Maps containers with all map types and map parameters.

■ Single Map containers with a single map type and its associated parameters.

■ Object containers directly below a named object item defining the creation
parameters of an unmodified object.

■ Modified Object containers holding all of the modifiers applied to an object
as well as the creation parameters.

Continuity
A property of curves, including NURBS curves. A curve is continuous if it is
unbroken.
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Continuity Level

Levels of curve continuity:

Left: C0, because of the angle at the top

Middle: C1, at the top a semicircle joins a semicircle of smaller radius

Right: C2, the difference is subtle but the right side is not semicircular and blends with
the left

The level of continuity is a way to describe curvature. A curve with an angular
cusp is C0 continuous. The curve is continuous but its derivative is not. A
curve whose curvature changes has C1 continuity. The curve and its derivative
are both continuous but its second derivative is not. A curve with
uninterrupted, unchanging curvature has C2 continuity. NURBS curves must
have at least C0 continuity; a continuity level greater than C2 is unnecessary
for most 3D computer modeling.
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Control Lattice

Control lattice surrounding the NURBS model of the fountain basin

In NURBS modeling, the lattice described by the CVs that specify a CV Curve
or CV Surface. In viewports, this appears as a dotted yellow framework when
you edit the curve or surface at the CV sub-object level. You can also choose
to display the control lattice in viewports at all times.

Control Point
In Physique, a vertex used to control the cross sections of envelopes, bulges,
and tendons.
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Control Vertex (CV)

Control vertices in the lattice surrounding a NURBS surface

In NURBS modeling, a vertex that controls a CV Curve or CV Surface. The 3D
location of each CV affects the shape of the curve or surface. CVs aren't
constrained to lie on the curve or surface. Each CV has a rational weight that
can be used to adjust the influence of the CV on the curve's or surface's shape.

Controller
Software that controls animation. Controllers handle the following functions:

■ Storing animation key values

■ Storing procedural animation settings

■ Interpolating between animation key values
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Convex Hull Property
The property of NURBS curves and surfaces whereby the control lattice
described by CVs forms a convex hull surrounding the curve or surface.

Cool
It's useful to be able to edit a material in the Material Editor and have it
immediately updated in the scene. Sometimes you want to work on a material
without affecting the scene. You want to adjust a material until you're sure
that it's what you want, and then reassign it. In other words, you want to cool
a hot material on page 7810 .

You cool a material by copying it in the Material Editor sample slots. You can
copy a material in two ways:

■ Use the Copy Material button.

■ Drag and drop to copy the material.

When you drag to copy a sample, you end up with two materials with the
same name, but one is cool while the other is hot. In the Material Editor, you
can have up to 24 materials with the same name, but every material in your
scene must have a unique name.

You can now adjust the cool material, and compare it with the hot material.
If you like the changes you've made, you can update the scene.

Coordinate Space
In character studio biped animation, the three most-used coordinate spaces
are world, object, and body space. These are often used to control the biped's
hands and feet.

Another coordinate system is used for the footstep gizmos themselves: a foot
on a footstep is in that footstep's coordinate space. If the footstep is moved,
the foot moves also. (A sliding footstep is a footstep that moves relative to the
coordinate system of the corresponding footstep gizmo.)
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CPY Files
CPY files contain postures, poses and tracks you have copied and saved on
the Copy/Paste rollout on page 4308 . You can load a CPY created with one
biped to another biped. See Copying and Pasting Postures and Poses  on page
4203  and Copying and Pasting Tracks on page 4233 .

Creation Parameters
An object’s creation parameters are settings, typically available on its
Parameters rollout, that you make when you first add the object to the scene.
You can later adjust these settings by accessing the object at the bottom of its
modifier stack. For example, a Box primitive’s creation parameters are its size
and number of segments in each of the three dimensions. You can usually
adjust an object’s size without scaling it by changing its creation parameters.

If you collapse on page 1931  an object, its creation parameters are lost, and
can no longer be adjusted.

Cross Section
In Physique, envelopes on page 7767 , bulges on page 7736 , and tendons on
page 7946  all have cross sections. Envelope cross sections can be moved and
scaled to encompass more or less of the character's skeleton. In bulges, shaping
the cross sections controls the amount of bulging and the appearance of the
bulge. In tendons, cross sections provide connections between links and the
mesh skin.

Crowd
The Crowd helper object on page 4738 , available from Create panel > Helpers,
serves as the command center for setting up and solving crowd simulations
on page 4680 . The Crowd helper object also lets you add behaviors to the scene,
choose the current behavior from a list, and modify that behavior.
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Crowd System
In crowd animation on page 4680 , a crowd system comprises the Crowd helper
on page 4738 , one or more Delegate helpers on page 4730 , a Vector Field space
warp on page 4837 , and Motion Flow mode on page 4464 . These are used in
combination to animate characters or other objects.

CSM Files
The CSM (character studio marker) file format stores motion-capture data. It
is an ASCII (text) file that uses positional markers rather than limb rotation
data. When you import a raw marker file, only marker position data is stored
in the motion-capture buffer. 3ds Max uses the marker data to extract limb
rotation data to position a biped.

NOTE For the CSM file specification, see the CSM.rtf  document on the program
disc.

Curve View
Curve View is the area of the Animation Workbench that displays function
curves for the parts of the biped. Curve View is quite similar to the Key Window
in the Track View – Curve Editor. The same navigation and key manipulation
toolbars are used in both Curve View and the Key Window. Both Curve View
and the Key Window let you add or delete, move or scale keys selected on the
curves.

Curve View differs from the Key Window in that it also displays errors found
by the Analyzer panel, functionality which is not available in the standard
Track View. Curve View doesn't use soft-selection like the Key Window, instead
it has a specialized Show Layered Edit command for the equivalent of soft
selection on biped keys.
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CV

CVs (control vertices) in the lattice surrounding a NURBS surface

Short for control vertex.

In NURBS modeling, a vertex that controls a CV Curve or CV Surface. The 3D
location of each CV affects the shape of the curve or surface. CVs aren't
constrained to lie on the curve or surface. Each CV has a rational weight that
can be used to adjust the influence of the CV on the curve's or surface's shape.

7750 | Glossary



CV Curve

NURBS CV curve

A NURBS curve defined by CVs. The CVs don't necessarily lie on the curve.
Instead, they form a control lattice that affects the curvature of the curve.
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CV Surface

NURBS CV surface

A NURBS surface defined by CVs. The CVs don't necessarily lie on the surface.
Instead, they form a control lattice that affects the curvature of the surface.

Deformable Envelope
In Physique on page 4522 , envelopes on page 7767  follow the Physique
deformation spline on page 7753  that runs through the joints in the skeleton's
hierarchy. A deformable (as opposed to rigid) envelope is one that moves the
mesh vertices it encloses as the skeleton moves.

A link can have both a deformable and a rigid envelope. When it has both,
the effect of the two is averaged, creating a less flexible skin.

In character animation, you typically use deformable envelopes; however,
some portions of the body, such as the head, might look best if they are rigid.
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NOTE Because of game-engine restrictions, if you are developing for certain
engines, you might want to use rigid envelopes exclusively.

TIP If your model consists of articulated rigid segments, such as a marionette, you
might not need to use Physique at all. Simply link each part to the corresponding
biped object.

Deformation
The effect caused by Physique on page 4522  on a mesh. Envelopes, bulges, link
parameters, and tendons all affect how a mesh deforms.

Deformation Spline
The deformation spline is created when you initialize Physique on page 4522 .
It is a continuous curve through several points. The deformation spline is a
smooth curve that runs from joint to joint.
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The deformation spline displays as a yellow curve that runs through the mesh.

The Bend, Bias, and Tension spinners can change the shape of the deformation
spline.
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The deformation spline also takes into consideration twisting and scaling of
the skeleton’s links. At the Link sub-object level on page 4644 , you take control
of the behavior of the deformation spline, and subsequently gain full control
of the skin’s behavior relative to the skeleton’s movement.

Degree
The degree of a curve is the highest exponent in the equation used to represent
it. A linear equation is degree 1, a quadratic equation degree 2. NURBS curves
typically are represented by cubic equations and have a degree of 3.

Delegates
In crowd animation on page 4680 , the Delegate helper serves as an agent for
the motion created by a Crowd object on page 4738  and its behaviors. The
Crowd object controls a delegate or delegates, whose motion can then be
imparted to a biped or other object.

In viewports, the delegate object takes the shape of a pyramid. By default, the
point of the pyramid indicates the delegate's forward direction. Delegates
cannot be rendered.

Dependent
A dependent is an object whose behavior or appearance can be influenced by
other objects. Dependents include instances on page 7818 , references on page
7910 , and objects sharing a common modifier (the same objects that appear
green when Show Dependencies is on in the View menu). Also, an object
whose motion is constrained on page 3212  by another’s is a dependent of the
constraining object.

See also:

■ Select Dependents on page 7178  in the Scene Explorer dialog
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Dependent (NURBS)
Describes a NURBS sub-object whose definition depends on other NURBS
sub-objects. For example, a Blend Curve depends on the two curves that you
select when you create it.

Depot
The depot is the section of the Particle View dialog on page 2730  that holds
the Particle Flow actions on page 2758 . In effect, it serves as a library of Particle
Flow functionality. Display of the depot can be toggled with the Particle View
menu command Display > Depot.

To add an action to the particle system, drag it from the depot to the event
display on page 2741 . To view a description of an action in the description
panel on page 7757 , click its entry in the depot.
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Description Panel
The description panel, found to the right of the depot on page 7756  in Particle
View on page 2730 , displays a text description of any action whose name you
click in the depot. Display of the depot can be toggled with the Particle View
menu command Display > Description.

Diagonal
A diagonal is a line that connects polygon vertices in editable poly and Edit
Poly objects. Its function is primarily to resolve the polygon into triangles at
render time, especially if the polygon becomes non-planar via transformation
of its vertices. Such transformation and certain other operations can,
incidentally, cause automatic rearrangement of a polygon’s diagonals.
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Diagonals on the default Cylinder primitive

Diagonals are normally invisible, but in 3ds Max they appear as dashed lines
when you use the Turn or Edit Triangulation tool. Unlike edges, diagonals
cannot be transformed, or acted upon with tools like Chamfer. This is different
from the hidden edges in editable mesh/Edit Mesh objects, which are actual
edges and can be made visible, transformed, and manipulated with any editing
tool.
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Diffuse Color

Vase has a mapped diffuse color.

The diffuse color is the color that an object reflects when illuminated by "good
lighting," that is, by direct daylight or artificial light that makes the object
easy to see.

When we describe an object's color in conversation, we usually mean its diffuse
color.

The choice of an ambient color depends on the kind of lighting: for moderate
indoor lighting it can be a darker shade of the diffuse color, but for bright
indoor lighting and for daylight, it should be the complement of the primary
(key) light source. The specular color should be either the same color as the
key light source, or a high-value low-saturation version of the diffuse color.
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Dithering

Square on the right shows dithering.

When converting an image with a palette of a greater number of colors to an
image with a palette of fewer colors, dithering is a means of simulating colors
not in the more limited palette, by mixing different-colored pixels together.

Dithering is also a method of smoothing the edges between two color regions
by mixing their pixels so the edges appear to blend together.

If you are rendering for the limited colors of an 8-bit display (256 colors), you
have the option of turning on dithering. Dithering can help prevent a banding
effect in color gradients. Dithering does increase the size of 8-bit files and can
slow the playback speed of animations. You might want to try applying maps
to the flat areas in the scene to see if that eliminates banding before you turn
on dithering.

By default, 3ds Max renders 64-bit color output. Consequently, you also have
the option of setting dithering for truecolor (24 or 32-bit color) on page 7960
. The Dither True Color option ensures that you get the best quality on
truecolor displays.
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You turn dithering on and off in the Rendering panel on page 7560  of the
Preferences dialog. You can also set dithering for scene motion blur in Video
Post. Here, dithering provides a smoothing effect between the separate images
making up the "blur." Video Post dither is set as a percentage of total dither.

Dock and Float
These terms describe manipulations to user-interface elements, such as toolbars.

You dock a toolbar, for example, when you align it with the edge of another
interface element, typically a window or panel.

You float a toolbar when you detach it from a stationary position, and
reposition it elsewhere on the desktop.

Double Support Period
In footstep animation on page 7790 , a period where both of the biped's feet
are on the ground.

Dummy Object
A dummy object is a non-rendering object that you use as an animation helper.
The primary use of the dummy helper object is to assist you in creating
complex motions and building complex hierarchies. Because dummies are
invisible in the rendered scene, they are an excellent choice for offset joints,
connectors between objects, and handles for manipulating complex hierarchies.

Breaking complex motions into simple components often makes it easier to
go back and edit your animations. For example, consider animating a bouncing
ball moving around your scene. You could animate the ball by properly
positioning it throughout the scene on many frames. The drawback is that it
would be very difficult for you to go back and adjust the height of the bounce
or the path the ball takes through the scene. You would have to edit the
motion of the ball on many frames to make even a simple change.

Using a dummy object easily solves this problem by breaking the motion into
two simple components. One component is the bounce of the ball. The other
is the path through the scene.
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DWG Files
The DWG file is the primary, native file format of drawing files created by
AutoCAD, Autodesk Architectural Desktop, and Autodesk Mechanical
Desktop®. It is a binary format used for importing and exporting on page 7003
AutoCAD drawing files.

You can also use the File Link Manager on page 6783  to create a live link
between a drawing file that can be open in AutoCAD and 3ds Max. Changes
that are made to the drawing can automatically be updated in 3ds Max without
having to reload scenes or re-import drawings.

DXF Files
DXF files are used to import and export objects to and from AutoCAD (and
other programs that support this file format).

Keep the following in mind when you are creating your DXF geometry, and
when you are deciding whether to convert by layer, color, or entity:

■ With AutoCAD Release 12, if you are using the AutoCAD Advanced
Modeling Extension (AME), use the SOLMESH command on your AME
models prior to saving the .dxf file.

■ After importing a DXF file, you might want to divide the resulting 3ds
Max file into smaller objects.

Entities that are frozen or turned off are ignored.

The successful unification of face normals depends on the welding of
coincident vertices. Sometimes, depending upon the precision of the model
as it was created in AutoCAD, the vertices may not be close enough to be
considered "coincident." They will not be welded, and the faces will not be
properly unified. In this case, increase the Weld Threshold value in the Import
DXF File dialog.

Converting by layer can result in objects consisting of many elements on
page 7766 . In certain cases, some of these elements may have all of their face
normals flipped the wrong way. You can detect this in the software by turning
off Backface Cull in the Display panel, or by rendering the objects. Use the
Normal modifier on page 1509  to correct this.

If you do not want to flip normals, you can either use 2-sided materials, or
turn on the Force 2-Sided option in the Render Scene dialog.
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If you are loading a large scene containing thousands of entities (such as 3D
faces) and have chosen to load an object by entity, the conversion can take a
long time. It also produces a huge number of objects to handle in the software.
To avoid this, organize your DXF file so that these kinds of entities are grouped
by layer, then make the conversion by layer rather than by entity.

Dynaflector
A space warp on page 7934  that lets particles affect objects in a dynamics
situation.

Three kinds of space warps are in the dynaflector category:

PDynaFlect Space Warp on page 2656

SDynaFlect Space Warp on page 2663

UDynaFlect Space Warp on page 2666

See also:

■ Omniflector on page 7871

Dynamics
Biped Dynamics on page 7727  calculate a biped's airborne trajectory, the bending
of its knee or knees on landing, and the biped position so it maintains balance
when the spine is rotated. When parameters change, dynamics cause the biped
to adapt.

Dynamics Blend
A parameter in the Body section of the Key Info rollout on page 4288 , used
with freeform animation on page 7792 . Blends between biped and spline
dynamics. Select the Body Vertical track (the vertical track of the biped's center
of mass), and use Dynamics Blend to control the amount of gravity in an
airborne period, such as in a running or jumping gait. Dynamics Blend has
no effect on a walking motion where footsteps overlap.
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Ease Curve
Ease curves vary the timing of a function curve. An unaltered function curve
charts the value of an animated parameter over time. An ease curve charts
changes to the timing of the function curve. Changing ease curve values shifts
the time of the original track left or right.

The horizontal scale of an ease curve represents normal time, just as it does
for all function curves. The vertical scale of an ease curve represents the time
scale of the function curve the ease curve is applied to. Changing the shape
of an ease curve changes the way time is interpreted by the affected function
curve.

The value of the ease curve at a particular frame is a frame value from the
original track. For example, if the ease curve is 0 at frame 0 and 10 at frame
10, the original track plays at its original speed. If the ease curve value at frame
10 increases to 20, the original track plays to frame 20 by frame 10: it has been
sped up by a factor of two.

An Ease Curve Example

Imagine you have animated a bird flying around the sky . After viewing the
animation you decide that you want to change the position of the bird so it
moves quickly at the beginning of the animation and then slows to a leisurely
pace toward the end.

You could accomplish this change by editing position keys, ranges, and
function curves but it would require more work than using an Ease curve.
Applying an Ease curve to the Position track provides a quick and easy solution.

Dragging the Ease curve causes time to compress near the beginning of the
animation and stretch out near the end. You can tell that the bird 's motion
starts out fast and then slows down by looking at the effect the Ease curve has
on the Position function curves.

See also:

■ Multiplier Curve on page 7860
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Edge
An edge is a straight or curved line that connects two vertices in a mesh object
or spline. You can modify object shapes by transforming its edges; in effect,
by doing so you're moving two vertices simultaneously.

Editable Mesh
An editable mesh on page 1990  is a type of deformable object. An editable mesh
is a trimesh: that is, it uses triangular polygons. Editable meshes are useful for
creating simple, low-polygonal objects or control meshes for MeshSmooth
and HSDS modelling. You can convert a NURBS or patch surface to an editable
mesh. Editable meshes require little memory, and are a natural method of
modeling with polygonal objects.

An actively linked object cannot be collapsed to an editable mesh. Using the
File Link Manager on page 6783 , you have to Bind the object first.

Editable Poly
An editable poly on page 2038  is a type of deformable object. An editable poly
is a polygonal mesh; that is, unlike an editable mesh, it uses more than
three-sided polygons. Editable polys are useful in that they avoid invisible
edges. For example, if you use a cut-and-slice operation with editable polys,
the program doesn't insert extra vertices along any invisible edge. You can
convert NURBS surfaces, editable meshes, splines, primitives, and patch surfaces
to editable polys.
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Element

The antler is one element of the moose head.

An element is one of two or more individual mesh objects (that is, groups of
contiguous faces) grouped together into one larger object. For example, if you
attach one box to another, you create one mesh object from the two boxes.
Each box is now an element of the object. Any function you perform on that
object affects all its elements. However, you can manipulate the elements
independently at the Element sub-object level.

Emitter
An emitter is an object that emits particles; particles are born, or first enter
the scene, at the emitter's location. By default, Particle Flow uses the source
icon on page 2748  as an emitter, but alternatively any other object in the scene
can emit particles using the Position Object operator on page 2773 .
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End Effector
In history-dependent inverse kinematics (HD IK) on page 3346 , the end effector
is the pivot point of the selected child object at the end of a kinematic chain.

The kinematic chain is a single branch of a hierarchy used for animation with
inverse kinematics (IK) on page 7820 . The chain starts with the selected child
object and travels up through ancestors until it reaches the start of the chain.
When you move the end effector, the HD IK solver then uses IK calculations
to move and rotate all other objects in the kinematic chain to react to the
object you moved.

The end effector has two transforms: one that connects it to its parent, and
another that connects it to the End Effector Parent. By default, the End Effector
Parent is none (equivalent to World); you can assign this in the Motion panel.

NOTE You can move the end effector away from the child object, which causes
the IK chain to straighten out. When you move the end effector back toward the
child object, joints in the IK chain will bend again.

See also:

■ IK Goal on page 7812

Envelopes
In Physique on page 4522 , the envelope is the primary tool for controlling skin
deformation. An envelope defines an area of influence about a single link in
the hierarchy. If the envelope is deformable on page 7752 , mesh vertices within
that envelope follow the movement of the Physique deformation spline on
page 7753 . An envelope has a pair of inner and outer bounds; the envelope's
influence is strongest at the inner bound, and falls off toward the outer bound.
By default, each envelope has four cross sections. You can reshape the cross
sections, or add new ones, to change the envelope's geometry.

In the Skin modifier on page 1600 , the envelope plays a similar role with respect
to bones. Each bone has its own envelope with two or more cross-sections
that allow you to shape the envelope to fit the surrounding mesh.

Typically, the envelopes of adjacent links or bones overlap each other. Vertices
that fall in the overlap area are weighted to produce smooth blending at joint
intersections.
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Environment Map

Above: Image uses a picture in screen coordinates as a background.

Below: Image shows spherical mapping coordinates applied using a checker map.

Texture coordinates lock a map to geometry. Environment coordinates, on
the other hand, lock a map to the world. If you move the object, the map
remains in place. If you move the view (or camera), the map changes. This
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type of mapping system is used with reflection, refraction, and environment
maps.

There are four types of environment coordinates:

■ Spherical

■ Cylindrical

■ Shrink-Wrap

■ Screen

The first three are the same as those used by the UVW Map modifier on page
1849 . If you imagine a sphere, infinite in size, surrounding your scene and
mapped with spherical mapping coordinates, you can visualize the effect you
get with spherical environment mapping. Shrink-wrap wraps the map around
a giant sphere, leaving only one singularity. Cylindrical is like a giant cylinder.

The Screen system maps the image directly to the view, with no distortion.
It's similar to planar, in that it's like a giant backdrop hung in the scene. Unlike
the other environment mapping methods, Screen is locked to the view. When
you move the camera, the map moves with it. Therefore, you can only use it
for still renderings, or animations in which the camera doesn't move.

To use a bitmap with any environmental mapping system other than Screen,
you need a high-resolution map because of the size of the virtual sphere, or
cylinder.

An environment map is not assigned in the Material Editor, because it's not
applied to the geometry of an object, but rather to the scene itself.
Environment maps appear in the background, as seen from the camera or
perspective view.

When you assign a map to the environment, it's the same as if you'd assigned
a mapped material to an object in your scene. To edit or adjust the assigned
map, you need to place it in one of the sample slots in the Material Editor.
You can do that in one of two ways:

■ Click the Get Material button in the Material Editor, and then get the map
from the scene.

■ Put the map from the Environment dialog to one of the sample slots in
the Material Editor. You can do this by dragging and dropping from the
Environment dialog map button to the sample slot.
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NOTE To control whether or not the renderer uses the environment map's alpha
channel in creating the alpha for the rendered image, choose Customize >
Preferences > Rendering, and then turn on Use Environment Alpha in the
Background Antialiasing group. If Use Environment Alpha is turned off (the default)
the background receives an alpha of 0 (completely transparent). If Use Environment
Alpha is turned on, the alpha of the resulting image is a combination of the scene
and background image's alpha. Also, when writing TGA files with Pre-Multiplied
Alpha set to off, turning on Use Environment Alpha prevents incorrect results.
Note that only background images with alpha channels or black backgrounds are
supported when compositing in other programs such as Photoshop.

Event
The event is the basic unit of organization in a Particle Flow particle diagram
on page 7885 . There are two types of events: global on page 7801  and local on
page 7831 . A birth event on page 7728  is a specialized type of local event.
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1. Global event

2. Birth event

3. Local event

Each event contains one or more actions on page 7701 , which can affect particle
behavior or appearance. You can use tests on page 7948  to send particles to
other events if the particles meet certain qualifications. A single chain of linked
events as shown in Particle View on page 2730  is known as a flow on page 7787
.
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Event Display
The event display, the main window in the Particle View on page 2730  dialog,
contains the particle diagram on page 7885 . This is where you build and edit
the particle system.
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Event Level
In Particle Flow, you can select particles at the Event level or at the Particle
level on page 7886 , using controls on the Modify panel > Selection rollout on
page 2753 . An Event-level selection can be passed to the Particle level for
processing by the particle system by means of the Selection rollout > Get From
Event Level command.

Extents

Bounding box shows the extents of the model boat.

An object's extents are its maximum dimensions in X, Y, and Z. These are the
dimensions of the rectangular bounding box on page 7736  that surrounds the
object.
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Face/Polygon
When you render a scene containing geometry, 3ds Max uses the faces and
polygons in a mesh object on page 7847  to draw the object surfaces. Essentially,
faces and polygons are planar objects that fill in the gaps between edges in
the object structure. A face typically has three sides; a polygon can have three
or more sides. You can treat a polygon as a single object while modeling, but
at render time, 3ds Max breaks down all polygons into triangular faces.

Faceted

Vase on the right uses a faceted material.

Faceted shading provides a constant shading across each facet, or co-planar
surface of the object. The result has the appearance of so-called "flat" shading,
except that it provides specular highlights.

Turn on Faceted to provide a faceted look to your geometry without having
to explicitly change the smoothing groups in the object with the Edit Mesh
modifier.
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Both Standard on page 5298  and Raytrace on page 5394  materials provide a
Faceted toggle.

NOTE This feature was known as “constant shading” in versions of 3ds Max prior
to v5 .

FFD
FFD stands for free-form deformation. It is used in computer animation for effects
like dancing cars and gas tanks. You can use it as well for modeling rounded
shapes such as chairs and sculpture.

An FFD modifier on page 1383  surrounds the selected geometry with a lattice
box or cylinder. By adjusting the control points of the lattice, you deform the
enclosed geometry.

NOTE You can use Physique on page 4522  to control an FFD space warp. Physique
actually deforms the space warp's control points, which in turn deform the model.

FGM File
An FGM file (.fgm) is a final gather map file. It is used by the mental ray
renderer on page 6039  to save the results of a final gathering pass. Generating
and saving an FGM file can speed up subsequent renderings.

Glossary | 7775



Field of View

Above: Narrow field of view

Below: Wide field of view

Field of View defines the width of your view as an angle with its apex at your
viewpoint and the ends at the sides of the view. The effect of changing FOV
is similar to changing the lens on a camera. As the FOV gets larger you see
more of your scene and the perspective becomes distorted, similar to using a
wide-angle lens. As the FOV gets smaller you see less of your scene and the
perspective flattens, similar to using a telephoto lens.

A Perspective view uses an imaginary camera with only one setting, FOV. The
FOV angle for the active Perspective view is displayed in the Rendering
Methods panel of the Viewport Configuration dialog. You can type a value
in the FOV field of the dialog to precisely set FOV for the active Perspective
view.

Use Field of View (FOV) to change the amount of the scene visible and the
amount of perspective flare applied to a Perspective or Camera view. The Field
of View button appears in the viewport navigation control panel when a
Perspective or Camera view is active.
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Fields

Two fields combine to make a single frame.

Your animations might ultimately be viewed on television monitors. Standard
video signals display animation by breaking it down within time segments
(frames). The image for each frame is split into horizontal lines (scan lines).
A special method for conveying frame information on a video signal has been
developed. This method is called field interlacing. Television monitors display
a video signal by separately scanning two portions of each frame called fields.
One field contains the odd scan lines of a frame, the other field contains the
even scan lines. Television monitors scan and display the fields of each frame
separately. The fields are alternately cycled through every other horizontal
line on the screen so that they "layer" together to form a single interlaced
image.

Render to Fields

On the Render Scene dialog, in the Common Parameters rollout on page 5929
> Options group, the Render To Fields check box sets whether the renderer
renders full frames at the specified frame rate, or renders fields at twice that
rate. When Render To Fields is on, the renderer renders an extra sub-frame
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image between every two frames, and composites each frame and the following
sub-frame into a single image with two fields. The result is a 60
fields-per-second animation suitable for play on an NTSC on page 7863
television monitor.

Field Order

When you render to fields, you also specify a field order to identify which
field comes first. The Field Order configuration setting is found in Preferences,
on the Rendering page. A frame's scan lines are numbered and each field
contains either the odd or even scan lines. The video source (for example,
broadcast transmitter, video tape recorder, or digital video recorder) determines
which group of scan lines is in each field and which group is delivered to the
display first. The fields are referred to as Field 1 (F1) and Field 2 (F2); either
could contain the odd numbered (1st, 3rd, 5th, and so on) scan lines or the
even numbered (2nd, 4th, 6th, and so on) scan lines in the frame.

Using the default setting of Odd as your Field Order preference, the software
renders the first field image (F1) to the odd scan lines. If the field order
preference is set to Even, then the first field image is rendered to the even
scan lines. For an image to display properly, the field order and the video
device field order must match.

Some video systems require odd lines to be rendered first, and others require
the even lines to be recorded first. The Field Order parameter is set to Odd by
default. If you observe incorrect strobing in your video output, change the
parameter to Even.

Figure Mode
When you work with a biped on page 4069 , you use Figure mode on page 4339
to fit the biped to the mesh or mesh objects on page 7847  that represent your
character. You should have Figure mode turned on when you attach the mesh
to the biped with Physique on page 4522 . Figure mode is also used to scale a
biped that has a mesh attached to it, to make biped "fit" adjustments after
Physique is applied, and to correct posture for motion files that need a global
posture change.

When Figure mode is turned on, the biped jumps from its animated position
to its Figure mode pose. Animation is preserved when you exit Figure mode.

The parameters on the Structure rollout on page 4343  are active only in Figure
mode, and at creation time.
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Fillet

NURBS fillet curves

A dependent NURBS object that is an arc connecting two curves. It is controlled
by the objects it connects, and by a radius parameter.
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Filter Color / Filter Opacity

Sphere on the right has a light green opacity filter color.

Filter opacity tints the colors behind the material using a specified transmission
color.

Filter opacity is the default system, because it provides a more realistic
transparency effect. When the Filter option is set in the Extended Parameters
rollout, the color used by the Filter Color swatch tints the transparency of the
material.

In life, a transparent material, such as colored glass, affects the colors behind
it not by the diffuse or ambient colors (which are reflected colors), but by the
transmission color.

The transmission color is that property of a substance that filters certain colors,
and allows others to pass. For example, a sheet of red cellophane is a filter
that blocks all light not in the red wavelength of the spectrum. By using filter
opacity, you can specify a transmission color and achieve strong, saturated
colors, no matter how transparent the material.
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Filtering (Antialiasing)
Filtering is a technique of antialiasing the bitmaps in mapped materials by
averaging pixels. The Pyramidal and Summed Area options provide two
methods of pixel averaging. Only one can be active at a time.

Both methods require approximately the same rendering time. Summed-area
filtering generally yields superior results but requires much more memory.
Pyramidal filtering requires the program to allocate memory equal to
approximately 133% of the size of the bitmap. By comparison, summed-area
filtering requires the program to allocate approximately 400% of the size of
the bitmap.

Use summed-area filtering only for smaller bitmaps, and avoid using any more
such bitmaps in a scene than necessary.

Pyramidal filtering is quite adequate for most purposes. However, because it
applies filtering as a function of distance, irregular antialiasing might occur
on detailed texture maps that are applied to a plane receding into the distance.
The effect of pyramidal filtering on extreme perspectives such as this is even
more noticeable in animations, where portions of the texture map appear to
"swim." If this occurs, turn on summed-area filtering for the material.

NOTE To control whether or not a background image is affected by the renderer's
antialiasing filter, choose Customize > Preferences > Rendering on page 7560  and
then turn on Filter Background in the Background Antialiasing group.

Filtering (Character Animation)
Filtering is the action of using selected data, rather than all data.

In the Motion Mixer on page 3621 , you use the trackgroup on page 7952  filter
to select the biped parts that will be affected by motion clips and transitions
on tracks within the trackgroup. See Filtering Mixer Tracks on page 3637 .

Filtering is also a motion-capture technique on page 4493 . Motion-capture and
marker data typically have keys at every frame. Filtering motion-capture data
reduces the number of keys, making the job of altering or personalizing the
motion data simpler. Other filtering options include footstep extraction,
applying the skeletal structure stored in the motion-capture file to the biped,
looping the data, importing a portion of the motion capture file, and selecting
tracks to load. See Filtering Motion-Capture and Marker Data on page 4496 .
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Final Gathering (mental ray Renderer)
Final gathering is an optional, additional step to calculating global
illumination on page 6072 . Using a photon map to calculate global illumination
can cause rendering artifacts such as dark corners and low-frequency variations
in the lighting. You can reduce or eliminate these artifacts by turning on final
gathering, which increases the number of rays used to calculate global
illumination.

Scene rendered with global illumination but no final gather
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Same scene with final gather used to smooth the global illumination
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Same scene with final gather but no global illumination, for comparison

Final gathering can greatly increase rendering time. It is most useful for scenes
with overall diffuse lighting, less useful for scenes with bright spots of indirect
illumination such as focused caustics.

You turn on final gathering on the Render Scene dialog > Indirect Illumination
panel > Final Gather rollout on page 6104 .
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First Vertex

First vertex of a spline

When you create a spline object, the software numbers the vertices from 1 to
the total number of vertices in the spline, according to the order of creation.
When the spline is displayed in viewports, the first vertex has a box around
it.

The first vertex is commonly used as an alignment marker when you place
two or more shapes on different path levels when lofting. If you place different
shapes on different path levels and you don't align their first vertices, the
resulting mesh object is twisted.

To avoid twisting, you can align the first vertices by rotating the splines as
necessary. Alternatively, you can change the position of a spline's first vertex
by using the Make First button in the Edit Spline modifier (at the Vertex
sub-object level).
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Flat Mirror

Flat mirror map reflects the ice-cream shop's interior.

If you want to create a flat, mirrored surface in a scene, such as a highly
polished floor, you must use a flat mirror reflection map.

Flat mirror reflection maps must be assigned to your geometry in a specific
way, and work only on flat surfaces.

When you use flat-mirror reflection maps, keep the following in mind:

The flat-mirror material must be assigned to connected, coplanar faces on a
flat surface of the object. If your flat-mirror reflection doesn't work, it's probably
because non-coplanar faces have been assigned the flat-mirror material. This
can happen during the selection process, if one or more non-coplanar faces
are included in the selection set. It can also happen if you've already assigned
the same material elsewhere on the object (coplanar faces are two or more
adjacent faces that are on the same two-dimensional plane, such as the surface
of a floor).

If you want to reflect in multiple planes of the same object, detach each plane
into a separate object before you assign the material.
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Flow
A particle system on page 7887  can contain any number of separate particle
flows. Each flow consists of an isolated chain or sequence of events on page
7770 , as depicted in Particle View on page 2730 . A flow typically contains a
global event on page 7801  and a birth event on page 7728 , and any number of
additional local events on page 7831 .

A particle system containing four separate flows
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Fluorescence

Glass on the right has a light green fluorescence.

Fluorescence is light emitted from an object when it absorbs radiation (for
example, ultraviolet light) from another source.

Raytrace materials have the ability to simulate fluorescence.
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Flyout

Example: Align flyout (main toolbar)

A flyout is an icon-based menu available from any button that has a small
black triangle in the lower-right corner. To access the flyout, click the button
and hold or drag a short distance. Then, to activate a flyout menu item, drag
to the item and release. As you drag, you can see each item's name on the
prompt line of the status bar on page 7308 .

Follow Object
You can bind an object in your hierarchy to any other object (often an object
not in the same hierarchy). This other object is called the follow object.

The bound object tries to match the position and orientation of its pivot point
to the position and orientation of the follow object's pivot point.

For example, you might want to animate a figure that always points to another
object. Bind the hand of the figure to the other object. Turn IK on and as you
move the object the hand and arm of the figure move to point at it.
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Foot States
The biped feet can be in one of four states: plant, lift, move, and touch:

■ Plant The biped foot state in full contact with the footstep.

■ Lift The biped foot state just before leaving a footstep.

■ Move The biped foot state between footsteps; an airborne period.

■ Touch The biped foot state at which a biped foot first contacts a footstep.

Footstep Animation
Biped's patented footstep-driven keyframe animation feature allows animators
to use footsteps to create broad, global brush strokes for character movement.
Once footsteps are in place, keyframes are generated automatically to produce
an initial sketch of the 3D character's motion. Throughout edits and revisions,
the original nuances of the character are preserved; Biped remembers
everything about how a character moves, and it makes all of the appropriate
adjustments if the footsteps are changed.

Footsteps Method
Footsteps provide a way to animate a biped on page 4069 . In viewports, footsteps
represent support periods in space for the biped's feet. Moving or rotating
footsteps in space is done in the viewports. The footstep position and
orientation in the viewport controls where the biped will step.

In Track View — Dope Sheet, each footstep appears as a block that represents
a support period in time for each of the biped's feet. Moving footsteps in time
is done in Track View — Dope Sheet.

TIP  To see the footsteps, you must turn on Edit Keys in the Dope Sheet.

There are three ways to create footsteps for the biped. The first way is to place
footsteps individually, one at a time. The second way is to invoke Biped's
multiple footstep creation tools to create a walk, run, or jump animation. The
third way is to extract footsteps from raw motion-capture data.
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A big advantage of the footstep method is the natural adaptation of the biped
that occurs when the footsteps are edited in time and space. Also, you can
reposition all of the footsteps to move the entire animation.

Forward Kinematics
The default method of manipulating a hierarchy uses a technique called
“forward kinematics”. The basic principles employed by this technique are:

■ Hierarchical linking from parent to child

■ Placement of pivot points to define the connecting joint between linked
objects

■ Inheritance of position, rotation, and scale transforms from parent to child

In forward kinematics, when a parent object moves, its children must follow.
If the child wants to go off on its own, the parent remains behind. For example,
in a hierarchical linkage of a human figure , when the torso (the parent) bends
over , the head (the child) moves along with it, but you can turn the head
without affecting the torso .

Forward Kinematics (Bipeds)
Using an arm to move a hand is an example of forward kinematics. Using the
hand to move the arm is an example of inverse kinematics on page 7820 . When
you use freeform animation on page 7792  to animate a biped on page 4069 , you
can use both kinds of kinematics.

By planting a hand or foot, you use another object (object space) or the world
(world space) to control IK motion. In this method, the IK Blend parameter
in the Key Info rollout on page 4288  determines how forward kinematics and
inverse kinematics are blended to interpolate intermediate positions.

Frame Rate
The frame rate of an animation is generally expressed in frames per second
(fps). This is the number of frames displayed for every second of real time.

Different recording devices output different frame rates, but the standard rates
are as follows:
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NTSC video 30 frames per second

PAL video 25 frames per second

Film 24 frames per second

You can change the frame rate for your output at any time, outputting the
correct number of frames to maintain the correct playback speed for your
animation.

For example, if you create a 90-frame animation for video, using an NTSC
frame rate of 30 frames per second, the result will be three seconds of
animation.

If you later discover you need to output to PAL video (at 25 frames per second),
you can switch to the PAL frame rate. The 90 frames are automatically
converted to 75, producing the same total animation time with a different
number of frames. You can later switch back to NTSC frame rate to restore
the original 90 frames of animation.

You can switch back and forth between frame rates at any time without losing
animation data.

Freeform Animation
character studio gives you the option to animate biped on page 4069  poses
both with and without the aid of footsteps. Freeform animation does not use
footsteps. In freeform animation, you set all the keys yourself.

Freeform Method
In freeform mode (without footsteps), you can pose every joint of your biped
on page 4069  exactly as you like using traditional keyframe methods. You can
even blend dynamically between forward kinematics and inverse kinematics
on page 7820  to introduce higher-level control in just the cases you need it to
simulate your character's particular motion.
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Freeze/Unfreeze

On the right, the trash can and streetlight are frozen.

You can freeze any selection of objects in your scene. By default, frozen objects,
whether wireframe or rendered, turn a dark gray. They remain on screen, but
can't be selected, and therefore can't be directly transformed or modified.
Freezing lets you protect objects from accidental editing and speeds up redraws.

Frozen objects are similar to hidden objects. Linked, instanced, and referenced
objects behave when frozen just as they would if unfrozen. Frozen lights and
cameras and any associated viewports continue to work as they normally do.

You can choose to have frozen objects retain their usual color or texture in
viewports. Use the Show Frozen In Gray toggle in the Object Properties dialog
on page 245 .
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Function Curve
Function curves are editable splines that represent animation values in a
line-graph format. They provide a valuable way of both visualizing and editing
your animation tracks.

Function curves appear in the Track View, and provide the best method of
viewing and editing animation tracks. With the function curve display, you
can actually see the characteristics of the animation as they change over time.
The steepness of the curve indicates the velocity of an object in the scene. If
the curve steepens, the object is accelerating. If the curve flattens out, the
object is slowing.

You can display key dots in function curves, as well as in the key editing
displays. In function curves, the key dots appear as small, black squares. The
two ways to turn on their display are to click the green icon beside the track
label, or to click the function curve itself.

There are two basic ways to edit function curves. You can either change the
position of the key dots, thereby altering the curve, or you can edit the tangents
and the values of the keys themselves.

Fusing
In NURBS curves and surfaces, fusing connects a point to a point or a CV to
a CV. (You can't fuse a CV to a point, or vice versa.) This is one way to connect
two curves or surfaces. It is also a way to change the shape of curves and
surfaces.

Fused points behave as a single point or CV until you unfuse them. Fusing
points does not combine the two point objects or CV sub-objects. They are
connected but remain distinct sub-objects that you can unfuse later.

Fused CVs behave much like a single point, but the property of multiplicity
for coincident CVs also applies. The fused CVs have proportionally more
influence on the curve, which can become more sharply curved in the fused
CVs' vicinity, or even angular if more than two CVs are fused together.

FX File
An FX file defines a DirectX 9 (DX9) shader. It is a text file created using the
Higher-Level Shading Language (HLSL) standard. The DirectX 9 Shader
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material on page 5596  can apply DX9 shaders to objects, and display them with
DX9 shading in viewports.

By default, DX9 shaders are saved in \maps\fx\ in the 3ds Max program
directory.

IMPORTANT For a DX9 shader's parameter to be visible in the DirectX 9 Shader
material's interface, the FX file must contain code to label the parameter, define
its type, and (optionally) limit its range. (A few other UI settings are also provided.)
You can find examples of files that contain this code in the above directory.

NOTE The following Web page provides a specification for the DirectX 9 Shader
material 3ds Max:
http://sparks.discreet.com/knowledgebase/techdocs/searchable/techdoc_DXMaterialFormat/DxMaterial_Effect_format.htm.

G-Buffer
G-Buffer (graphics buffer) is a type of rendering channel. Two file formats
output by 3ds Max, RLA on page 7156  and RPF on page 7159 , can incorporate
masks that are based on graphics buffer (G-Buffer) channels instead of the
more widely used RGB and alpha channels. In addition, some kinds of Filter
and Layer events as well as certain rendering effects on page 6381  can
post-process objects or materials designated by the G-Buffer.
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Main image: G-buffer used to apply a glow to lighting in a scene

Upper left: The same scene with no glow applied

Middle left: Objects selected using the G-buffer

Lower left: Glow applied to the G-buffer objects

You can set two kinds of these channels in the scene to identify and group
objects or materials for a particular post-processing effect.

■ You set an object's value (see Object Properties Dialog on page 245 ) to
identify that object to receive a particular rendering or post-processing
effect or file mask.

■ You set a material's Material Effects Channel on page 5252  value to identify
that material to receive a particular post-processing effect.

You create object-specific or material-specific post-processing by following
this general procedure:

1 Assign a particular Object Channel ID or Material Effects Channel ID to
the objects or the materials you want to be post-processed or affected by
rendering effects.
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2 In the Image Filter or Image Layer event or in each rendering effect's
Options tab, choose the channel ID that associates the event with the ID
value you assigned in the scene.

3 When you render the scene or execute the Video Post queue, 3ds Max
singles out objects or materials that have the designated ID, and performs
its post-processing only on those objects or materials.

WARNING The mental ray renderer on page 6039  does not recognize Z-depth
with G-buffers. G-buffer data is saved on a single layer. Also, the mental ray renderer
does not support the following effects:

■ Glow lens effect on page 6397  (rendering effect)

■ Ring lens effect on page 6404  (rendering effect)

■ Lens effects Focus filter on page 6670  (Video Post)

Gait Pattern
In footstep animation on page 7790 , the pattern created by a gait: walk, run,
or jump. When you create new footsteps, the timing for the footsteps is
determined by the gait you have chosen and the parameters for that gait. Gait
parameters are on the Motion panel in the Footstep Creation rollout on page
4352 .

Gait Type
In footstep animation on page 7790 , character studio can create three types of
gaits; walk, run, or jump.

■ In a walk, at least one foot is always in contact with the ground. The periods
when one or both feet are in contact with the ground are known as support
periods.

■ In running, there is a period between each support period in which the
body is airborne.

■ Jumping is a special case of running. Both feet are in contact with the
ground at the same time, or airborne at the same time.
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Gamma Correction
Gamma correction compensates for the differences in color display on different
output devices so that images look the same when viewed on different
monitors.

A gamma value of 1 corresponds to an "ideal" monitor; that is, one that has
a perfectly linear progression from white through gray to black.

Gamma = 1.0: no correction

I stands for Intensity.

However, the ideal display device doesn't exist. Computer monitors are
"nonlinear" devices. The higher the gamma value is set, the greater the degree
of nonlinearity. The standard gamma value for NTSC video is 2.2. For computer
monitors, gamma values in the range of 1.5 to 2.0 are common.
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Left: gamma = 1.8

Right: gamma = 2.2, the standard for video

The horizontal axis represents input (the original value) and the vertical axis represents
output (the gamma-corrected value).

Computer monitors and videos don’t display color in a linear way (as in the
first illustration). Also, the brightness of a monitor tends to make an image
seem brighter than its intensity values really specify. Gamma correction fixes
this problem, and can ensure consistency between different applications or
different monitors. When you set gamma, find a value that makes middle
gray on your own monitor match a true middle (50 percent) gray.

For more information, see Gamma Preferences on page 7550 .

Geometric Primitives
Simple primitive objects such as, spheres, boxes, cylinders, and so on.

Glossary | 7799



Gizmo/Center

Examples of gizmos:

Left: Gizmo for a Bend modifier

Right: Gizmo for UVW mapping

A gizmo is geometry that appears in viewports, but not in the scene. You
manipulate a gizmo to modify the scene geometry or other effects. There are
gizmos for transforms, modifiers, atmospheric apparatus, and some directly
modifiable geometry such as spotlight cones.

For modifiers, a gizmo acts like a kind of container that transfers the
modification to the object to which it's attached. You can move, scale, and
rotate the gizmo as you would any object, altering the effect of the modifier
on the object.

With bipeds on page 4052 , the footsteps in footstep animation on page 7790
are gizmos that let you edit the position of the biped's feet over time. Physique
on page 4522  uses gizmos to visually identify bulge angles.

Some modifiers with gizmos also have a Center sub-object, which can be
manipulated independently of the gizmo to specify the point about which
the deformation, etc., takes place. For example, moving the Bend modifier
center parallel to the plane of the bend effect changes the size of the bend
circle and the location of the modified object within the bend circle.
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Global Event
The first event on page 7770  in a particle flow on page 7787  is always a global
event, whose contents affect all particles in the flow; the rest are local events
on page 7831 . Although a global event has the same name as the Particle Flow
source icon, selecting the source icon in a viewport doesn't highlight the global
event, nor does highlighting a global event select the corresponding source
icon.
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Global event (highlighted)

By default, the global event contains a single Render operator on page 2872
that specifies rendering properties for all particles in the flow. You can add
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other operators here to have them act globally, such as Material, Display, and
Speed.

NOTE A global event is the only event that can be wired to another event without
using a test on page 7948 . It's almost always wired directly to a birth event on
page 7728 .

IMPORTANT When you use an operator globally, be sure not to use the same
operator locally (that is, in any other events in the system) to avoid potential
conflicts.

Global Motion Clip Controller
In crowd animation on page 4680 , a controller that contains the animation
necessary to animate a non-bipedal crowd of objects. It consists of a list of
motion clips and the logic needed to instance and blend these motion clips
for a crowd animation. The Global Motion Clip Controller is accessed via the
Crowd helper object on page 4738 .

Glossiness and Specular Level Settings

Extremes of the Glossiness and Specular Level settings (Phong shader):

Top sphere: Glossiness=100; Specular Level=100

Left sphere: Glossiness=50; Specular Level=50

Right sphere: Glossiness=0; Specular Level=0

A material's glossiness (or dullness) depends on the size and intensity of its
specular highlight. In the Material Editor, the Glossiness spinner affects the
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size of the specular area, and the Specular Level spinner affects the intensity
of the glossiness.

When the Specular Level is too high, and Glossiness is too low, you can get
harsh backlights on your surfaces. The Soften option mitigates this.

GravAccel
In footstep animation on page 7790 , the GravAccel (for gravitational
acceleration) parameter lets you scale the height of airborne periods. The
greater this value, the greater the height. If the biped appears to be going too
high, reduce this value; if the biped goes too low, increase it. Each biped has
its own Gravitational Acceleration value. The default is based on the height
of the biped.

For example, if the active unit on page 7601  is feet and the biped is 5 feet 10
inches tall, then Gravitational Acceleration equals 32, for 32 ft. per second
per second. For other biped heights, 3ds Max scales this value to fit the scene.
The Gravitational Acceleration value also changes to agree with other unit
systems, such as metric.

GravAccel is located on the Dynamics & Adaptation rollout on page 4336 .

Gravity
In footstep animation on page 7790 , character studio calculates the effect of
gravity for those periods when a biped on page 4069  is airborne (a biped
becomes airborne when it moves with a running or jumping gait). You can
use the GravAccel on page 7804  setting to scale the effect of gravity.
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Grid Object

One grid establishes the pitch of the boat, another the pitch of the ship.

A grid object is a type of helper object you can create whenever you need a
local reference grid or construction plane somewhere other than the home
grid.

You can have any number of grid objects in your scene, but only one can be
active at a time. When active, a grid object replaces the home grid in all
viewports.

You can freely move and rotate grid objects, placing them at any angle in
space, or attach them to objects and surfaces. You can also change viewports
to display a plan or top view of any active grid object.

Grid objects can be named and saved like other objects, or used once and
deleted.
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Head Object
A head object is a component of a Target Camera, Sunlight or Daylight system,
or a Tape helper. These objects comprise two components: the target that the
camera, sun, or tape points at, and the head that represents the camera, sun,
or tape. The head object always points at the center of the target.

Helper Object
3ds Max helper objects are used to help you set up an animation, but do not
render. Crowd animation on page 4680  uses two kinds of specialized helper
objects: crowd on page 4738  and delegate on page 4730 .

Hide/Unhide
You can hide any objects in your scene and you have the option to hide any
selection of objects or to hide anything except your current selection of objects.
Hidden objects differ from frozen on page 7793  objects in that they disappear
from the viewport instead of turning dark gray. If you are working on a scene
that includes many objects or you have many objects in a very tight area,
hiding some of them gives you more access to the unhidden objects and speeds
up redraws.

You can hide an object that includes a target (such as target cameras, tape
helpers, or suns) by choosing either the head on page 7806  or the target object
and then selecting hide.

Hide and Unhide are accessible from the Display panel or from the Display
quadrant of the Quad Menus.

Hierarchical Linkage
3ds Max uses a family-tree analogy to describe the relationship between objects
linked together in a hierarchy.

Parent An object that controls one or more children. A parent object is often
controlled by another superior parent object.

Child An object controlled by its parent. A child object can also be a parent
to other children. An object that doesn't have any parent is by default a child
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of the world. (The "world" is an imaginary object that acts as the root of all
other objects in the scene.)

Ancestors The parent and all of the parent's parents of a child object.

Descendents The children and all of the children's children of a parent
object.

Hierarchy The collection of all parents and children linked together in a
single structure.

Root The single parent object that is superior to all other objects in the
hierarchy. All other objects are descendents of the root object.

Subtree All of the descendents of a selected parent.

Branch A path through the hierarchy from a parent to a single descendent.

Leaf A child object that has no children of its own. The lowest object in a
branch.

Link The invisible connection between a parent and its child. The link is a
conduit for transmitting position, rotation, and scale information from parent
to child.

Pivot Defines the local center and coordinate system for each object. You
can think of links as connecting the pivot of a child object to the pivot of its
parent.
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Home Grid

Using the home grid to position houses

Grids are two-dimensional arrays of lines similar to graph paper, except that
you can adjust the spacing and other features of the grid to the needs of your
work.

Grids have these primary uses:

■ As an aid in visualizing space, scale, and distance

■ As a construction plane where you create and align objects in your scene

■ As a reference system for using snap

The home grid is the basic reference system, defined by three fixed planes on
the world coordinate axes. The home grid is visible by default when you start
the software, but can be turned off with an option in the right-click viewport
menu. You can use any view of the home grid as a construction plane or you
can create a grid object on page 7805  and use that as a construction plane
instead.
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Horizon

Horizon in the distance of a scene

The horizon of a scene is the edge of vision at the height of the camera, parallel
with the world coordinate plane. You can view the horizon in camera
viewports.

A camera is level when it and its target are the same height from the world
coordinate plane. In other words, the camera's local Z axis is parallel to the
world plane. When the camera is level, the horizon line is centered in the
viewport. As the camera tilts up, the horizon line lowers; as it tilts down, the
horizon line raises.

The horizon line can help you match the perspective of your scene to the
perspective of a still image. In general, matching perspective involves the
following steps:

■ Display the horizon line. Use it to help you adjust the camera and target
so they are level.

■ Display the image in the camera viewport. Use Views menu > Background
Image.
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■ Display the image in the camera viewport. Use Views menu > Viewport
Background.

■ Orbit the camera until the perspective of the scene roughly matches that
of the still image.

■ Adjust the camera's perspective to fine-tune the perspective match.

■ Move the camera or target to position the scene against the background.

If you raise or lower the camera, raise or lower the target by an equal amount,
in order to keep them level and maintain the horizon.

Hot

A hot material is one that is instanced in both the scene and the Material
Editor. When you get a material from an object, that material is hot. Any
changes you make to the hot material are reflected in the scene wherever that
material is applied.

To edit a material without changing the scene, you can get the hot material
from an object, then make a copy of it. The term for the copied material is
cool on page 7747 .

White triangular tabs in each corner of the Material Editor sample slots on
page 5208  show that the materials in those slots are hot.

In the Material Editor, the only time you need to select an object is when
you're assigning a material to an object. When you're adjusting a material,
object selection doesn't matter.
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Hotspot/Falloff

Hotspot and falloff cones, highlighted in red.

You've seen how a flashlight or a theater follow spot casts a circle of light.
Depending on the quality of the flashlight, or the adjustment of the follow
spot, the edge of the cast pool of light is either blurred or sharp.

In the case of a blurred pool of light, the bright circle in the center is the
hotspot, which has an even intensity. The outer extremity of the light, where
it meets the darkness, is the falloff. The difference in circumference between
the hotspot and the falloff determines the relative sharpness of the pool of
light. For example, if the hotspot and falloff are nearly the same size, the pool
of light has a sharp edge.

The hotspot angle of a spotlight must always be smaller than the falloff angle.
Put another way, the hotspot must always be inside the falloff.

You can hold down the Shift key to have the hotspot and falloff values affect
each other. If you increase the hotspot to be larger than the falloff, the falloff
is increased as well. Likewise, if you reduce the falloff to be smaller than the
hotspot, the hotspot is also reduced.
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IGES (Initial Graphics Exchange Specification)
The Initial Graphics Exchange Specification (IGES) is an ANSI standard that
defines a neutral form for the exchange of information among dissimilar
computer-aided design (CAD), computer-aided manufacturing (CAM) systems,
and computer visualization systems.

3ds Max implements the IGES standard for translating files to the software
from IGES file formats used by the mechanical engineering and entertainment
industries. Using the IGES import feature, you can read in native NURBS on
page 7864  data between 3ds Max and other programs such as Autodesk
Mechanical Desktop® (release 3.0 or later), Maya®, Pro/ENGINEER®,
SOFTIMAGE®, CATIA®, and others. For complete details on the IGES standard,
see The Initial Graphics Exchange Specification (IGES) Version 5.3.

IK Blend
In biped freeform animation on page 7792 , the IK Blend parameter determines
how forward kinematics on page 7791  and inverse kinematics on page 7820  are
blended to interpolate an intermediate position. Using an arm to move a hand
is an example of forward kinematics. Using the hand to move the arm is an
example of inverse kinematics.

This parameter is located in the IK section of the Key Info rollout on page
4288 .

IK Goal
In history-independent inverse kinematics (HI IK) on page 3316  and the IK
Limb Solver on page 3368 , the IK goal is the object associated with the end joint
of a kinematic chain. By default, its name is IK Chain01.

The kinematic chain is a single branch of a hierarchy used for animation with
inverse kinematics (IK) on page 7820 . The chain starts with the end joint and
travels up through ancestors until it reaches the start joint. When you move
the IK goal, the IK solver then uses IK calculations to move and rotate all other
objects in the kinematic chain to react to the object you moved.

NOTE You can move the IK goal away from the end joint, which causes the IK
chain to straighten out. When you move the goal back toward the end joint, joints
in the IK chain will bend again.
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See also:

■ End Effector on page 7767

IK Solution
Inverse kinematics (IK) uses a goal-directed method where the animator
positions a child object and the program calculates the position and orientation
of the parent objects. The final position of the hierarchy after all of the
calculations have been solved is referred to as the IK solution.

Applied IK requires that one or more parts of your IK structure be pinned to
animated follow objects. Once pinned, you select any object in your kinematic
chain and click the Apply IK button. The software then calculates the IK
solution for each frame of the animation and places transform keys for every
object in the IK chain.

Illuminance
Illuminance is the luminous flux on page 7833  incident on a surface of unit
area. It measures how much energy has fallen on a surface.

This quantity is useful for describing the level of illumination incident on a
surface without making the measurement dependent on the size of the surface
itself. The lux (lx) is the International System (SI) unit of illuminance. The
American System (AS) unit for illuminance is the footcandle (fc), equivalent
to 1 lumen per square foot. Illuminance is a function of the distance from the
light source. To specify the illuminance of a light, you must enter a value in
lx, and the distance at which that illuminance is measured.

Glossary | 7813



Image Motion Blur

Image motion blur has been applied to the falling coin on the right.

Motion blur can enhance the realism of a rendered animation by simulating
the way a real-world camera works. A camera has a shutter speed, and if
significant movement occurs during the time the shutter is open, the image
on film is blurred.

3ds Max provides a couple of ways to generate motion blur. Image motion
blur is one. Scene motion blur on page 7919 , a Video Post Scene Event on page
6607  effect, is another. For most purposes, image motion blur gives better results
than scene motion blur. Scene motion blur is a more exaggerated effect. You
can use both image and scene motion blur in the same rendering.

You can also apply image motion blur as a render effect on page 6478 .

(Another option, object motion blur on page 7867 , is not meant to simulate a
camera, but to improve the rendered appearance of fast-moving objects.)
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Applying image motion blur is a two-step process:

1 Turn on image motion blur for the object you want to blur, using the
Object Properties dialog on page 245 .

You cannot apply both image motion blur and object motion blur to the
same object in the same rendering.

2 Before you render, turn on image motion blur in the Default Scanline
Renderer rollout on page 5949  of the Render Scene dialog.

Tips and Limitations

Image motion blur smudges the object by creating a smearing effect, instead
of superimposing multiple images the way object motion blur does. It considers
camera movement. Image motion blur is applied after scanline rendering is
complete.

■ Because image motion blur is applied after rendering, it can't account for
object overlap. When blurred objects overlap, blurring doesn't work
correctly and there are gaps in the rendering. To fix this problem, render
each blurred object separately, to a different layer, and then composite the
two layers using the Alpha Compositor in Video Post (or another
compositing tool.
The overlap problem also applies to objects behind an object rendered
with raytrace refraction.

■ Image motion blur doesn't work with objects that change topology. This
includes NURBS objects that are animated so their tessellation ( surface
approximation on page 2469 ) changes. Regular tessellation doesn't change
in this way. This also includes Displacement mapping and Optimization.

■ Image motion blur can yield strange results with objects that have a
MeshSmooth modifier on page 1460  applied to them. If you see this
happening, turn of the MeshSmooth modifier's Keep Faces Convex toggle
(in the Settings rollout). This will fix the problem.

■ Image motion blur is not applied to reflections of objects. It is applied only
to actual geometry.
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In Place Mode 
When you play an animation of a biped character on page 4069  that travels,
you can use In Place mode to keep the biped visible in the viewports. Use this
for biped key editing, or adjusting envelopes with Physique on page 4522 . In
Place mode prevents XY movement of the biped's center of mass during
playback; motion along the Z-axis is preserved.

This control is a three-button flyout: you can also restrict X movement without
restricting Y movement, or vice versa.

The state of In Place Mode is saved with the MAX file.

The In Place flyout is located on the expanded Biped rollout on page 4253 .

Independent
Describes a NURBS object or sub-object that is not dependent on any other
object in a NURBS model. For example, a NURBS curve created using the Create
command panel does not depend on other objects.

Influence
An influence is the object that is required for the behavior or appearance of
another object to be correct. For example, take an “eye” object that should
follow the motion of a tennis ball in a match. One way to animate this is to
apply a LookAt Constraint on page 3237  to the eye, with the tennis ball as the
target. In this case the tennis ball is an influence of the eye, while the eye is
a dependent on page 7755  of the tennis ball.

See also:

■ Select Influences on page 7178  and Display Influences  on page 7179  in the
Scene Explorer dialog

■ Select Influences on page 6755  in the XRef Merge dialog
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Initial Pose
When you apply Physique on page 4522  to a skeleton, the initial pose is the
original position of the mesh relative to the skeleton. Some of the Physique
sub-object levels on page 4635  have an Initial Skeleton Pose control that
temporarily puts the mesh into its initial pose.

Initialize
In Physique on page 4522 , when you attach a mesh on page 7847  to a skeleton
such as a biped, the modifier is initialized. This process creates the links of
the deformation spline on page 7753 , the envelopes on page 7767  around the
links to control the mesh, and so on.

Inputs: Event
In Particle Flow, you create a particle diagram on page 7885  by connecting
events on page 7770  using wires on page 7971 . Each wire links an output on
page 7879  with an event input, which is the connector sticking up from the
top of an event.
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Event inputs

Instance
An instance is an interchangeable clone of the original. You can instance
objects, modifiers, controllers, materials, and maps. Changing an attribute of
an instanced item also changes the same attribute of all instances.
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Object instances are not only alike in geometry, but also share modifiers,
materials and maps, and animation controllers. When you change one instance
by applying a modifier, for example, all the other instances change with it.

Each instance has its own set of transforms, object properties and space warp
bindings; these are not shared among instances.

Within the program, instances derive from the same master object. What
you're doing is applying a single modifier to a single master object. In the
viewport, what you see as multiple objects are multiple instances of the same
definition.

If you wanted to create a school of swimming fish, you might begin by making
many instanced copies of a single fish. You could then animate the swimming
motion by applying a ripple modifier to any fish in the school. The whole
school would swim with exactly the same motions.

Instance (Motion Mixer)
The term instance has two meanings in 3ds Max. One is the standard definition
on page 7818 ; the other is specific to clips in the Motion Mixer.

In general, an instance is a completely interchangeable clone of the original
object. Modifying an instanced object is the same as modifying the original.

In the Motion Mixer on page 7856 , when the same clip is used more than once
on tracks, the clip versions are either instances or adaptations on page 7704  of
each other.

The same clip used more than once for one biped, or for different bipeds of
the same size, is an instance. The same clip used for different-sized bipeds is
an adaptation.

For example, suppose you scene contains two bipeds that are exactly the same
size, and you use the same clip in both bipeds' mixes. The clips within one
biped's mix are instances of one another, and clips within the mixes of the
two same-sized bipeds are also instances of one another. Instances have the
same number appended to the ends of their clip names in the Mixer.

Suppose you then add a third biped of a different size, and use the same clip
in that biped's mix. The new version of the clip is an adaptation of the clip
used on the first two bipeds. An incremental number is added to the end of
the clip name in the Mixer.

These terms are used because the Mixer adapts each loaded clip to the biped's
size. The first time a clip is loaded, the Mixer adapts the clip as needed, but
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no distinction is made between instances and adaptations at that point because
the clip appears only once .

When the clip is cloned or loaded again, the Mixer adapts the new clip to the
biped as needed, then compares the change to previously loaded versions. If
the change is the same, the new clip and its previous versions are instances
of one another. If not, the new clip and previous versions are adaptations of
one another.

Interactive Renderer
Another term for the Viewport Interactive Renderer on page 7966 .

Interpolation
Interpolation is the calculation of intermediate values. For example, when
you set two keyframes for a moving object, the object's position on
intermediate frames is determined by interpolation.

Inverse Kinematics
Inverse kinematics (IK) is a positioning and animation method that is built
on top of the concepts of hierarchical linking. To understand how IK works
you must first understand the principles of hierarchical linking and forward
kinematics.

Inverse kinematics starts with linking and pivot placement as its foundation
and then adds the following principles:

■ Joints are constrained with specific positional and rotational properties.

■ Position and orientation of parent objects is determined by the position
and orientation of child objects.

Because of these added constraints, IK requires greater thought about how
you link your objects and place pivots. Where many different solutions for
linking objects might be suitable for forward kinematics, there are usually just
a few good solutions for any given IK approach. The best solution depends
on consideration of both the nature of the hierarchy, and how that hierarchy
will be animated.
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Inverse kinematics is often easier to use than forward kinematics and you can
quickly create complex motions. However, you sacrifice some of your control
to the automation of the IK functions.

Inverse Kinematics (Biped)
When you work with a biped on page 4069 , you can use inverse kinematics
(IK) by moving the hands or feet in freeform animation on page 7792 . For
example, you can position an arm by moving the hand.

A biped has three inverse kinematics parameters that you can vary during the
limb's motion by setting them at each key of the arm and leg tracks. As the
limb moves through each key:

■ IK Blend Sets the motion interpolation to be a blend of forward and
inverse kinematics. This will allow you to blend swinging motions with
directed hand or foot motions. The default is 0.0, or full forward kinematics.

■ Body or Object Determines the reference coordinate space on page 7747
of the IK path. This allows you to move the IK path with your character's
body, or temporarily attach a hand or foot to follow another object or be
attached to world space. The default is Body.

■ Join to Previous IK Key Determines if the key should be part of the
previous key (with the same reference position as the previous key).

These controls are in the IK section of the Key Info rollout on page 4288 .
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Iso Line

Iso lines on a NURBS surface

Iso is short for isoparametric.

In NURBS modeling, a line of constant parameter value, similar to a contour
line. You can use iso lines to display a NURBS surface. You can also create
dependent NURBS curves based on a surface's U-dimension or V-dimension
iso lines.
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Isometric View

Isometric view of a scene

A special type of axonometric view on page 7722 , where the sides of the object
are equally inclined to the screen, producing equal foreshortening along the
edges. You can create an isometric view by rotating a User view.

Keyframe Mode
Keyframe mode is active while the Auto Key button on page 7344  is turned on.
While you are in Keyframe mode, transforming an object or sub-object, or
changing the value of an animatable parameter, creates an animation key.

WARNING When you use freeform animation on page 7792  to animate a biped,
don't use the Set Key control (the button next to Auto Key in the animation
controls). Always use the biped-specific Set Key button and other key controls on
the Key Info rollout on page 4288 .
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See also:

■ Layout Mode on page 7826

■ Keyframes/Keys on page 7824

Keyframes/Keys

The red boxes indicate keyframes, the dotted line shows the interpolated trajectory.

Keyframes record the beginning and end of each transformation of an object
or element in the scene. The values at these keyframes are called keys.

For example, if you have a box that has not been animated, no keyframes (or
keys) exist for it. If you turn on the Auto Key button, move to frame 20, and
rotate the box 90 degrees, Rotate keys are created at frames 0 and 20. The key
at frame 0 represents the orientation of the box before it was rotated, while
the key at frame 20 represents the orientation of the box after it was rotated
90 degrees. When you play the animation, the box rotates from 0 to 90 degrees
over 20 frames.
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Kinematic Chain
Inverse kinematics calculates the position and orientation of objects in a
kinematic chain.

The kinematic chain is defined as a single branch of the hierarchy that starts
with a selected child object and continues up through its ancestors until it
reaches the base of the chain. The base of the chain is either the root of the
entire hierarchy or an object that you specify as a terminator for the chain.

3ds Max automatically determines the kinematic chain when you select and
transform an object with the IK button turned on.

Knot
A value in an array or "knot vector" associated with a NURBS curve. The knots
specify the region of influence of the CVs on the curve. You can't see or directly
alter knots.

Launch Script
A launch script is a MAXScript script that you run from the command line
with the -U switch, instead of from the Utilities command panel.

You use a launch script to run batch operations in the software. For example,
you might have a batch rendering in which the script opens a sequence of
files, sets up shots in each, and renders them, all without using the user
interface.

Layer Track
A Motion Mixer track for a series of motions that do not require transitions
between them. Compare with a Transition track on page 7959 , which allows
you to stack clips on top of one another and to create automatic transitions
between them. When a biped is added to the Motion Mixer, it is automatically
assigned a Layer track. See Adding Tracks to the Mixer on page 3626 .
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Layers
Layers are like transparent overlays, and allow you to organize and group
different types of scene information. The objects you create have common
properties including color, visibility, renderability, and display. An object can
assume these properties from the layer on which you create it.

You can adjust layer properties from the Layers toolbar on page 7289  and the
Layer Manager.

See also:

■ Using Layers to Organize a Scene on page 7224

■ Layer Manager  on page 7227

■ Layer Properties Dialog on page 7237

Layers (Biped)
The Layers on page 4322  feature lets you add layers of animation above the
original biped animation. This is a powerful way to make global changes to
your character animation. For example, by adding a layer and rotating the
spine forward at any frame, a run cycle becomes a crouched run. The original
biped motion is kept intact and can be viewed by switching back to the original
layer. You can view layers individually or as a composite of the animation in
all layers. Layers behave like a freeform animation; the biped can adopt any
position.

Layers allow you to easily adjust raw motion capture data, which contains
keys at every frame. You add a layer and keyframe the biped.

Layout Mode
Layout mode is active while the Auto Key button on page 7344  and Set Key
button on page 7347  are both turned off. While you are in Layout mode, you
can transform objects and sub-objects, and change the values of animatable
parameters, without generating animation keys.
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See also:

■ Keyframe Mode on page 7823

■ Keyframes/Keys on page 7824

Lift
In footstep animation on page 7790 , the state of a foot at the frame when it is
about to lift away from a footstep.

Light Map
A light map or lighting map is a bitmap on page 7730  that stores the lighting
levels (intensity and color) falling on an object in the scene. Typically, you
create a light map by rendering to a texture (texture baking) on page 6169 .
Light maps are primarily for use in game engines, but you can also use them
to speed up renderings.

Banana object in a lighted room
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Light map of the banana

If you use the DirectX Manager on page 5297 , you can display light maps
interactively in viewports, using either the LightMap shader on page 5598  or
the Metal Bump shader on page 5599 .

See also:

■ DirectX Manager Rollout on page 5297

Linked Geometry
Linked geometry is a by-product of importing or linking a drawing file to 3ds
Max. It is a child object, or subcomponent, associated with VIZBlocks or
Block/Style Parents.

When you select a linked geometry object, it offers no parameters on the
Modify panel. You must first add an Edit Mesh modifier to the object or
collapse the linked geometry object to an editable mesh in order to access

7828 | Glossary



sub-object levels. If you add a modifier to linked geometry, the modifier is
applied to all instances of that object.

The only direct control you have over linked geometry objects is the Reset
Position option that is used to negate and basic move, rotate or scale
transforms.

Links
Links are the segments of the Physique deformation spline on page 7753 . Links
follow the hierarchy of the skeleton, such as a biped, that has been attached
to the mesh on page 7847 . Link parameters in Physique allow you to bend,
twist, change sliding behavior, and radially scale the mesh.

Listener Window
In MAXScript, the Listener Window is a command-line window that lets you
type in and execute MAXScript commands interactively. In other words, you
run the script as you go along, rather than running a pre-saved text file.

You open the listener window using the MAXScript Listener command on
the MAXScript menu or from the Utilities > MAXScript > MAXScript rollout
> Open Listener command.
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Local Coordinate System

A book in object space rests on a table in world space. The book has its own local
coordinate system.

The local coordinate system is the coordinate system that relates specifically
to the selected object.

Each object has its own local center and coordinate system as defined by the
location and orientation of the object's pivot point. The local center and
coordinate system of an object combine to define its object space.

The direction of the object's X, Y, and Z axes depend on the current transforms
of the object. Contrast with the world coordinate system.

You can see the difference between the two coordinate systems when you
unintentionally rotate an object, such as a wheel on a car model , around the
world axis instead of the object's local axis. The wheel immediately flies off
in a large arc because the center of the rotation is at the origin of the world
coordinates.
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To rotate the wheel correctly, first change the coordinate system to Local,
using the pop-up list on the toolbar. The wheel then rotates around its own
hub , which is the origin of its local coordinates.

Local Event
Particle Flow uses two types of events on page 7770 : global on page 7801  and
local. All events in a flow on page 7787  except the first are called local events,
because the actions on page 7701  they contain take effect only while particles
are in that event. The birth event on page 7728  is a special type of local event
that always comes immediately after a global event.

Lofting

A circle is lofted along a path to construct a tubular shape.

Lofting is an important method for 3D object creation. You create shape
objects to serve as a path and any number of cross-sectional shapes. The path
becomes the framework that holds the cross-sections forming your loft object.
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Once you create a loft object you can change and animate its parameters and
sub-objects:

■ Add and replace cross-section shapes or replace the path.

■ Change or animate the parameters of the path and shapes.

■ Change or animate the surface parameters of the loft object.

The lofting process first requires that you create shape objects to serve as the
path and cross-sections of your loft object.

The term lofting comes from early shipbuilding. A large framework called a
loft was built to hold the hull of a ship while it was assembled. The process
of hoisting the ribs (cross-sections) of the hull into the loft became known as
lofting.

A traditional method for building three-dimensional models of a modern
vehicle design is to draw cross-sections at a number of key points. These
cross-sections are cut out to form two-dimensional templates that are then
placed on a rail. The model builders fill in the space between the templates
to generate the surface of the model.

You create loft objects using a similar process. You first create two or more
spline objects. One of these splines will be the rail, which is referred to as the
path. The rest of the splines are the cross-sections of your object, which are
called shapes. As you arrange your shapes along the path, the software
generates a surface between the shapes.

Log File (mental ray Renderer)
The log file (.log) is an ASCII text file that contains messages generated by the
mental ray renderer. You specify a name and location for the log file, and the
"verbosity" level of the messages it contains, in the mental ray preferences
on page 7579 .

Look At Object
In the context of the Shape Facing operator on page 2822 , a Look At object is
the camera or object toward which particles face.
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LTLI Files
The LTLI file type is the file format for photometric data created by the Danish
Illuminating Laboratory. It is used primarily in Scandinavian countries.

Luminance
Luminance is the value of light reflected off a surface. It is a measure of how
bright or dark we perceive the surface.

Luminous Flux
Luminous flux is the quantity of light energy per unit time arriving, leaving,
or going through a surface. The lumen (lm) is the unit of luminous flux in
both the International System (SI) of units and in the American System (AS)
of units. If you think of light as particles (photons) moving through space,
then the luminous flux of a light beam arriving at a surface is proportional to
the number of particles hitting the surface during a time interval of 1 second.

Luminous Intensity
Luminous intensity is the light energy per unit time emitted by a point source
in a particular direction. Luminous intensity is used to describe the directional
distribution of a light source, that is, to specify how the luminous intensity
of a light source varies as a function of the outgoing direction. The Candela
(cd) is the unit of luminous intensity.

LZF Files
LZF (Lens Effects Flare) files allow you to store all of the settings for a Flare
effect in one file. The settings are also saved with the MAX file; however,
saving them to a separate file allows you to use the same Lens Effects settings
in different scenes, and also allows you to share settings with other 3ds Max
users.
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LZG Files
LZG (Lens Effects Glow) files allow you to store all of the settings for a Glow
effect in one file. The settings are also saved with the MAX file; however,
saving them to a separate file allows you to use the same Lens Effects settings
in different scenes, and also allows you to share settings with other 3ds Max
users.

LZH Files
LZH (Lens Effects Highlight) files allow you to store all of the settings for a
Highlight effect in one file. The settings are also saved with the MAX file;
however, saving them to a separate file allows you to use the same Lens Effects
settings in different scenes, and also allows you to share settings with other
3ds Max users.

LZO Files
LZO (Lens Effects Focus) files allow you to store all of the settings for a Focus
effect in one file. The settings are also saved with the MAX file; however,
saving them to a separate file allows you to use the same Lens Effects settings
in different scenes, and also allows you to share settings with other 3ds Max
users.

LZV Files
LZV files allow you to store the settings for several Lens Effects in one file.
You can save all of your settings for Glow, Ring, Ray, Auto-Secondary, Manual
Secondary, Star, and Streak effects in one file. The settings are also saved with
the MAX file; however, saving them to a separate file allows you to use the
same Lens Effects settings in different scenes, and also allows you to share
settings with other 3ds Max users.
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Map Bias

On the right, increased map bias makes the dog appear to float.

Map bias moves the shadow toward or away from the shadow-casting object
(or objects).

By default, this value is 1.0 world coordinate unit. Increasing the bias moves
the shadow away from the object, and decreasing the bias moves the shadow
closer to the object. The Map Bias value can be any positive floating-point
number.

For example, if a shadow-casting object intersects another object but its shadow
doesn't meet properly at the intersection, the bias is too high. This effect varies
with the angle of the spotlight to the object. Extremely shallow spotlight
angles usually require higher bias values.

Another purpose of bias is to avoid problems with objects that cast shadows
onto themselves. If you see streaks or moiré patterns on the surface of the
object, the bias value is too low. If you increase the bias so much that the
shadow becomes disconnected from the object, reduce the bias and increase
the shadow map Size value instead.
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Map Channel

Left: Scene uses different map channels to place different copies of the same maps in
different locations.

Right: The three maps used to create the streets and the traffic markers painted on
them

When you turn on Generate Mapping Coordinates for an object, the
coordinates use map channel 1. You can assign new map channels with new
mapping coordinates by applying a UVW Map modifier on page 1849  to the
object. Map channel values can range from 1 to 99.

A map channel associates a map with an object's mapping coordinates.
Texture-baked maps on page 6169  also use map channels.

For NURBS on page 2152  surface sub-objects, you can assign a map channel
without applying UVW Map. The surface sub-object has a different set of
mapping coordinates for each map channel you use.

A map's map channel value identifies which of an object's mapping coordinates
to use. Different map channels allow maps for the same object to use different
coordinates. For example, you might use one channel for diffuse mapping
on page 5364  and a different one for bump mapping on page 5382 . Map channels
also let different maps use different coordinates within a compound material
on page 5544 , a compositor map on page 5756 , or a multi/sub-object on page
5558  material.

Different map channels can have different U and V tiling values, different U
and V offsets, and so on. In the UVW Map modifier, you can also set different
map channels to have different mapping types (planar, cylindrical, spherical,
and so on).

If you apply a map that uses a certain map channel to an object that has no
mapping coordinates for that channel, the map doesn't appear on the object.
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When you render, a Missing Map Coordinates on page 5618  dialog appears to
warn you of the problem. The dialog lists the map channel and the object
name.

See also:

■ Coordinates Rollout (2D) on page 5620

■ Coordinates Rollout (3D) on page 5699

Mapped Material
A mapped material is a material on page 7845  that contains one or more maps
on page 5605 . Typically, it contains a bitmap on page 7730  as a Diffuse map, but
having any map or maps applied qualifies a material as mapped.

In order for a mapped material containing a 2D map on page 7698  to appear
properly in the viewports and in the rendered image, any object to which it’s
applied generally needs mapping coordinates. By default, most parametric
objects in 3ds Max already have mapping coordinates applied; you can also
use the UVW Map modifier on page 1849  (link) or Unwrap UVW modifier on
page 1769  (link) to provide mapping coordinates.

NOTE Objects with materials that contain only 3D maps on page 7698  do not
need mapping coordinates.
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Mapping Coordinates

Decoration on the vase is a map positioned by rotating the UVW Map Modifier gizmo.
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Mapping coordinates specify the placement, orientation, and scale of a map
on the geometry. Coordinates are often specified in terms of U, V, and W,
where U is the horizontal dimension, V is the vertical dimension, and W is
the optional third dimension, representing depth.

If you apply a mapped material to an object that has no mapping coordinates,
the Renderer assigns default mapping coordinates. The built-in mapping
coordinates are designed for each object type. The box mapping coordinates
place a duplicate map on each of its six sides. For the cylinder, the image is
wrapped once around its sides, and duplicates of the image are distorted at
the end caps. A sphere has the image wrapped once around the sphere, and
then gathered at the top and bottom. Shrink-wrap mapping is also spherical,
but truncates the corners of the map and joins them all at a single pole,
creating only one singularity.

3ds Max provides a number of ways to apply mapping coordinates:

■ Use the Generate Mapping Coords option in the creation parameters rollout
of any standard primitive. This option, which is on by default for most
objects, provides mapping coordinates specifically designed for each
primitive. They require additional memory, so turn the option off if you
don't need them.

■ Apply a UVW Map modifier on page 1849 . You choose from several types
of mapping coordinate systems and customize the placement of the
mapping coordinates on the object by positioning a mapping icon. In
addition, you can animate the transformations of the mapping coordinates.

■ Use special mapping coordinate controls for special objects. For example,
Loft objects provide built-in mapping options that let you apply mapping
coordinates along their length and around their perimeter.

■ Apply a Surface Mapper modifier. This world-space modifier takes a map
assigned to a NURBS on page 2152  surface and projects it onto the modified
object or objects. Surface Mapper is especially useful for seamlessly applying
a single map to a group of surface sub-objects within the same NURBS
model. You can also use it for other kinds of geometry.

There are three cases where you don't need mapping coordinates:

■ Reflection/refraction maps and environment maps
These use an environmental mapping system, in which the placement of
the map is based on the rendered view, and fixed to the world coordinates
in the scene.

■ 3D procedural maps (such as Noise or Marble)
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These are procedurally generated, based on the local axis of the object.

■ Face-mapped materials
The maps are placed based on the facets in the geometry.

Maps

Front left sphere: Marble bitmap

Front right sphere: Clouds bitmap

Back left sphere: Noise procedural map

Back right sphere: Marble procedural map

The images you assign to materials are called maps. The software provides
several different map types. They include standard bitmaps (such as .bmp, .jpg,
or .tga files) , procedural maps, such as Checker or Marble , and
image-processing systems such as compositors and masking systems.

You can assign maps to most of the components that make up a material.
Materials that contain one or more images are called mapped materials. By
assigning maps to different attributes of the materials, you can affect the color,
the opacity, the smoothness of the surface,  and much more.

Maps offer the level of realism you look for in materials. The different types
of maps you can use range from the common bitmap, to the flexible procedural
map.

For many map types, the renderer needs instructions telling it where the map
should appear on the geometry. These instructions are called mapping
coordinates on page 7838 .
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Marker Data
Data from a motion-capture device on page 4493 . Rather than limb rotational
data, marker data uses marker positions to specify limb position.

Marker Files
A file from a motion-capture device. character studio can read two marker file
formats:

■ CSM (character studio marker) on page 7738
This is the native marker file format of character studio.

■ BVH (BioVision) on page 7726

Markers
In a motion-capture session, markers are reflective objects placed on the “actor”
or “talent.” The markers enable motion-capture hardware to record the position
of various parts of the talent's body while performing motions.

Master Motion Clip Controller
In crowd animation on page 4680 , a controller (similar to the Block controller)
that consists of a list of motion clips. When instanced, these motion clips can
blend from one animation to another. The Master Motion Clip controller is
accessed via the Crowd helper on page 4738 .

Match Frame
For the purposes of combining inverse kinematic (IK) on page 7820  and forward
kinematic (FK) on page 7791  animation, this is a collection of keyframes that
allow a seamless blend between IK and FK control, or vice versa. On the IK
goal on page 7812 , this includes IK keys for:

■ Position
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■ Enabled state

■ Swivel angle

On the IK bones, a match frame includes FK keys for:

■ Rotation

■ Preferred angles

■ Scale (less frequently)

Material ID

Figure mapped using a multi/sub-object material: material IDs identify the component
sub-materials.

A surface's material ID is the value that determines which sub-material the
surface will use when you apply a Multi/Sub-Object material on page 5558  to
the object to which the surface belongs.
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Geometric primitives have default material identification number assignments,
just as they have default smoothing groups. The default material ID assignment
depends on the type of geometry. Most curved objects such as spheres have
a single material ID. Boxes have six IDs, one for each side. Cylinders have
three: ID number 1 and 2 for the two caps, and ID number 3 for the sides.
Hedra have three: one for each of their P, Q, and R axes.

When you apply a Multi/Sub-Object material, the materials will match the
Multi/Sub-Object material ID numbers to the material ID numbers on the
faces of the object. Faces keep a record of the ID number, and not of the
material name. If the material is anything but Multi/Sub-Object, the material
is assigned to the object's entire surface.

Assigning some defining material ID number to each object before they become
compound object operands can be a useful technique for being able to select
the separate pieces after they're combined.

You can use material IDs for continuous surfaces that require separate paints
or finishes. For example, a car constructed from different types of materials,
such as a colored metal body, chrome parts, glass windows, and so on.

You can use the Material modifier on page 1445  to assign material ID numbers.
Also you can reassign material IDs using the Editable Mesh > Surface Properties
rollout, or Edit Mesh modifier > Edit Surface rollout.
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Material/Map Hierarchy

Material/map hierarchy shown in the Material/Map Navigator

The Material Editor could be called the Material and Map Editor, because you
can use it to design both materials and maps, and any combination of the
two. In addition, you can create material or map hierarchies.

A material hierarchy is a material that consists of other materials (or maps).
Similarly, a map hierarchy is a map consisting of other maps. Materials that
consist of other materials are called compound materials on page 7742 . Maps
consisting of maps are compound maps.
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Materials

Spheres with variations of the standard material type (no maps used):

Green sphere: High Glossiness

Red sphere: Constant shading

Blue sphere: 60% opacity

Yellow sphere: Wireframe mode, slight self-illumination

A material is data that you assign to the surface or faces of an object so that
it appears a certain way when rendered. Materials affect the color of objects,
their glossiness , their opacity, and so on.

A standard material consists of ambient, diffuse, and specular components.
You can assign maps to the various components of a standard material.

The standard material is the default material in the six sample slots of the
Material Editor. However, you can change the type of material you're working
on by clicking the button labeled Type below the sample slots. This displays
the Material/Map Browser, and lets you select from a list of alternative material
types.

You can also change the type of material you're working on by clicking the
Get Material button below the sample slots. This displays the Material/Map
Browser, and lets you select from a list of alternative material types.
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Matte Object

Matte object reveals part of the background, making the hamburger geometry appear
to be inside the oven.

A matte object is invisible but blocks any geometry behind it. However, it
does not block the background.

For example, you might make a complex scene for the background of your
animation, render it once, then assign the resulting bitmap as a background
using only a few animated objects during the rendering of the animation. If
you then needed one of your objects to appear from behind some portion of
the background, such as a building, you would create a matte object that
matches the building. You then place the animated object behind it. The
bitmap image of the building appears, but the animated object is blocked until
it moves from behind the matte object.

Matte objects, though invisible, can cast shadows.

Matte objects can also receive shadows. When the Matte/Shadow material's
Affect Alpha check box is set, shadows cast on the matte object are applied to
the alpha channel. This lets you render maps with alpha shadows that you
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can composite later. To properly generate shadows on a matte object, turn off
the Opaque Alpha check box and then set the Affect Alpha check box.

MAXScript
MAXScript is the general-purpose scripting language for 3ds Max and related
products. While it works the same for all products, some functions are specific
to each. You can use MAXScript to automate many tasks, including modeling,
animation, material construction, and rendering. You can also use MAXScript
to add custom command-panel rollouts to the user interface.

The interface to MAXScript is on both the MAXScript menu on page 7280  and
the Utilities panel on page 7463 .

Mesh
A mesh is a type of geometric model of a three-dimensional object in which
the basic shape is made up of points, or vertices on page 7965 , connected by
edges on page 7765 . The renderable surface of the mesh object is made up of
faces or polygons on page 7774  that connect the vertices and edges. Examples
of mesh objects in 3ds Max are primitives such as Sphere and Teapot, as well
as Editable Mesh and Editable Polygon objects.

In 3ds Max you can edit a mesh by transforming, adding, and deleting the
various elements, or sub-objects: vertices, edges, faces, and polygons. You can
also apply various changes with modifiers on page 7852 .

Metaballs
A type of object that joins itself to other objects with a connecting surface.
When one metaball object moves within a certain distance of another, a
connecting surface is formed between the two. Metaballs are ideal for
simulating liquids and thick, viscous substances such as mud, soft foods, or
molten metal.

You can create metaballs with the BlobMesh compound object on page 674 .
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MFE Files
A MFE file contains a motion flow graph on page 4468  and any scripts created
for the graph. See Saving, Loading, and Appending Motion Flow Graphs on
page 4439 .

MI Files
The MI file (.mi) contains a mental ray scene description that a mental ray
renderer can use to render your 3ds Max scene. When you render with the
mental ray renderer, you can export to a text (ASCII) .mi file. (There is a binary
.mi format as well. The mental ray renderer in 3ds Max does not generate this
format.) The exporter always generates mi3 (mental ray version 3) format. It
does not support mental ray version 1 (mi1).

You specify a name and location for the .mi file on the Render Scene dialog >
Processing panel > Translator Options rollout on page 6122 .

See the mental ray manual, Programming mental ray, for a complete description
of the mental ray scene description language.

Mirroring
When working with a biped on page 4069 , the Mirror control in the Keyframing
Tools rollout on page 4301  allows you to mirror the entire biped animation.

Mix
Data in the Motion Mixer on page 3621  for a single biped. The term mix refers
to the arrangement of elements in Motion Mixer ( clips on page 7855 , transitions
on page 7958 , balance information on page 7723 ) as well as the result of the
arrangement. A mix is sometimes called a raw mix to distinguish it from a
mixdown on page 7849 .

You can save a mix to a MIX file on page 7849 .
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MIX Files
A MIX file contains data from the Motion Mixer, including information on
trackgroups on page 7952 , tracks on page 7951 , clips on page 7855 , transitions
on page 7958  and balance information on page 7723 . Compare with a mixdown
on page 7849 , which contains the same data, but in a collapsed format; the data
is no longer separated into tracks and clips.

 You can save a MIX file in the Motion Mixer by choosing Mix menu >
Save Mix File, or by clicking Save File on the Mixer rollout.

Mixdown
A mixdown is a collapsed version of data in the Motion Mixer. In general, a
mixdown contains the same data as the raw mix on page 7848 , with one
difference. During the process of computing a mixdown, any transitions
involving planted feet are corrected to prevent the feet from sliding.

After a mixdown is computed, it is placed on its own track in the Mixer. You
can turn the mixdown on and off by clicking it. When the mixdown is turned
on, the biped performs the motions in the mixdown; when it is turned off,
the biped does the motions in the raw mix. See Exporting Animation to the
Biped on page 3663 .

MNM Files
An MNM file (Marker Name file) is a character studio file format that matches
custom names in a motion-capture marker file on page 7841  with the preset
list of known, supported marker names that are recognized by bipeds. See
BVH Files on page 7737  and CSM Files on page 7749  for descriptions of how
thesse two motion-capture file formats work with MNM files.

Modal/Modeless
Modal is a command state or dialog that affects all operations. You must
change the mode or dismiss the dialog before doing any operations that don't
pertain to that mode.

Glossary | 7849



Modeless means a nonexclusive command state or dialog. You can do other
operations and commands without changing the mode or dismissing the
dialog.

For example, the Track View and Material Editor dialogs are modeless, while
the Open File dialog is modal.

Modifier Stack

Example: Modifier stack display of cylinder with two modifiers applied to it
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Example: Stack display of mesh showing its sub-object hierarchy, and Edge sub-object
level chosen

The modifier stack on page 7427  is the key to managing all aspects of object
modification. You use the stack to:

■ View and manipulate the sequence of modifiers

■ Find a particular modifier

■ Adjust a modifier's parameters

■ Select a modifier's gizmo or center

■ Activate or deactivate a modifier

■ Delete or disable a modifier

The effect of modifiers is directly related to their sequence, or order, in the
stack.

Where you put a modifier in the stack is critical, because the program applies
modifiers in their stack order, beginning at the bottom, and carries the
cumulative change upward.

By clicking any entry in the stack, you go back to the point where you made
that modification. You can then rework your decisions or discard the

Glossary | 7851



modification entirely by deleting it. You can also insert a new modifier in the
stack at that point.

Modifiers

Example: effects of the twist modifier on an object

Modifiers on page 1015 , as the name implies, modify an object's geometrical
structure, deforming it in some way. When you apply a taper modifier on
page 1739  to the end of a cylinder, for example, the vertices near the end move
closer together. Modifiers make changes in the geometry that stay in effect
until you adjust or delete the modifier.
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Morphing

Morphing makes the clock appear to melt.

Morphing is a term derived from metamorphosis, which means to change
physical shape or form.

The purpose of the morph object in 3ds Max is to create an animated object
that changes shape by morphing between two or more objects. Although it
appears that a single object is changing form, in reality the morphing process
translates the position of the vertices from their arrangement in one object
to the arrangement in another, relative to their local coordinate system.

Consequently, all objects chosen to make up a morph object must have the
same number of vertices. Typically, you achieve this by cloning an object,
and then altering the geometry of the clones without changing their vertex
count.

Motion Blending
When working with motion flow on page 4426 , transitions are used to blend
clips together. By default, a transition is calculated with a method known as
“minimum motion loss.” If optimized transitions are used, then a sophisticated
algorithm that minimizes foot sliding is used. This alternative method is
computationally expensive.
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Motion Blur

Motion blur enhances the movement of the sword.

Motion blur can enhance the realism of a rendered animation by simulating
the way a real-world camera works. A camera has a shutter speed, and if
significant movement occurs during the time the shutter is open, the image
on film is blurred.

3ds Max provides a variety of ways to apply motion blur:

■ Image Motion Blur on page 7814  applies motion blur to entire frames of an
animation.

■ Motion Blur Rendering Effect on page 6478  lets you apply image motion
blur as a rendering effect on page 6381 .

■ Multi-Pass Rendering Effect on page 5140  applies motion blur to frames by
offsetting the camera in multiple rendering passes. You can preview
multi-pass rendering effects in camera viewports.

■ Particle Motion Blur on page 2932  uses a material map to blur moving
particles in a particle system.
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■ Scene Motion Blur on page 7919  lets you apply motion blur as a Video Post
on page 6571  effect.

■ Object Motion Blur on page 7867  applies motion blur to specified moving
objects in a scene. Object motion blur is best for making fast-moving
objects appear to move more smoothly.

Motion Capture
The process of digitizing the movements of a live “actor” or “talent.” This
requires a motion-capture device.

Motion Clip
A motion clip is a sequence of motion on a biped or other objects. A motion
clip can be a BIP file, or a portion of a 3ds Max animation used in a crowd
sequence.

BIP files used in Motion Flow on page 7856  and the Motion Mixer on page
7856  are called motion clips. You can use these tools to combine several motion
clips and make a longer or different animation. A BIP motion clip can be
created by saving animation on page 4222  you have made on the biped, or by
importing motion-capture data on page 4495 .

When you create a crowd animation on page 4680  that uses motion synthesis
on page 7857  on non-biped objects, a motion clip is a portion of a 3ds Max
animation used by the synthesis. You specify that a range of frames in the
animation is to be used when the delegate meets certain criteria, such as
turning upward to exceed a certain pitch.

One animation sequence can contain all the motion clips necessary to animate
the crowd. For example, a bird animation might have three motion clips: flap,
glide, and land. You could specify that when the delegate is pitched upward,
the range of frames that animate the flap motion are used in the simulation.
Motion clips are used by the Global Motion Clip Controller on page 7803  and
the Master Motion Clip Controller on page 7841 .
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Motion Files
character studio can load these types of motion files:

■ BIP files on page 7727

■ BVH files on page 7737

■ CSM files on page 7749

Motion Flow
In Motion Flow mode on page 4426 , you combine BIP files on page 7727  to
create longer character animation. You also use motion flow along with crowd
animation on page 4680  to automatically generate crowd behavior.

One motion can transition into another. To generate a transition, character
studio uses either velocity-interpolated transitions (“minimum motion loss”),
or an algorithm to minimize sliding feet.

Motion Flow Editor
In Motion Flow mode on page 4426 , the Motion Flow Editor allows you to
manually create a transition between two clips. You set the start frame and
transition duration for both clips, and the orientation of the destination clip.

Motion Flow Scripts
When using motion flow on page 4426 , a script is a sequence of motion files
that are played to create a character’s motion. Scripts are created either
manually or automatically.

Motion Mixer
The Motion Mixer is a window where you can mix motion clips (BIP files) on
a biped. The clips are placed on various tracks on page 7951  within the mixer.
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In the Motion Mixer, you can use trackgroups on page 7952  to affect different
body parts with different clips. Each trackgroup can contain transition tracks
on page 7959  and layer tracks on page 7825 , which hold the motion clips.

Each biped in the Motion Mixer is assigned a balance track on page 7723 , which
automatically compensates for differences in balance between upper and lower
body motion.

 To make the motion in the Mixer affect the biped in the scene, you
must turn on Mixer Mode in the Biped rollout on page 4253 .

See Using the Motion Mixer on page 3621 .

Motion Synthesis
In crowd animation on page 4680 , motion synthesis is the process of animating
bipeds by combining motions (clips) automatically. Clips are added to the
Motion Flow Graph, and transitions are created between appropriate clips. In
the Crowd system, delegates are animated. During synthesis (solving the
motion), the delegates' speed and direction are analyzed by character studio.
Based on the analysis, clips are selected to animate the bipeds.
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MSP (MAXScript Package) Files
A MAXScript Package (MSP) combines the set of files that make up a scripted
tool into a single file. An MSP file can contain bitmaps, script sources, icons,
and so on.

For more information about MSP files, see the MAXScript Reference: Help
menu > MAXScript Reference

Multiplicity
In NURBS modeling, multiplicity is the property of coincident or nearly
coincident CVs that reduces the continuity level of the curve or surface. Two
coincident CVs locally increase curvature. Three coincident CVs (or more)
create an angular cusp. Fusing CVs shows the effect of multiplicity.

Effects of multiplicity:

On the left, three coincident CVs create a sharp angle.

On the right, only two coincident CVs in the same location create a gentler curve.
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Multiplier

Left: Default light multiplier of 1.0

Right: Multiplier of 5.0 causes burned colors

The Multiplier value in every light lets you increase the intensity, or brightness
of the light beyond its standard range.

Since increased Multiplier values tend to wash out, or "burn" portions of the
image, you're better off adding lights, or reducing the intensity of other lights
when you need to adjust the brightness of areas in your scene. Remember that
you can adjust the intensity of a light using its V(alue) spinner. In most cases,
it's better to adjust the V spinner than to alter the default Multiplier value.

Left: Spotlight with negative multiplier subtracts light from the scene.

Right: Multiplier of 0 and a negative density on a shadow whose color is white creates
the effect of a negative shadow.

An unusual characteristic of the Multiplier is that you can use negative values
to create negative light. You can use negative lights to further control the
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lighting in your scene. For example, you might want a darker area in the
corner of a room.

A negative Multiplier value reverses the color of the light, so a red light would
become cyan (the complementary color). In addition, the map image in a
projector light becomes a negative image.

Multiplier Curve
Multiplier curves are special function curves that you use to apply animated
value displacements to other function curves.

When you edit keys and function curves, you apply localized changes to your
animation at specific times. By applying a multiplier curve to the original
track, you affect the entire range of the original animation.

A multiplier curve shifts the value of the original track up or down. At a given
frame, the value of a multiplier curve is a scale factor applied to the value of
the original function curve.

■ The default value of a Multiplier curve is a horizontal line with a value of
1.0.

■ Values greater than 1.0 increase the value of the function curve.

■ Values below 1.0 decrease the value of the function curve.

■ Values less than 0.0 negatively scale the value of the function curve.

See also:

■ Ease Curve on page 7764

N Links
In Physique on page 4522 , by default, any number of overlapping envelopes
can influence vertices. This is specified by the N Links option on the
Vertex-Link Assignment rollout on page 4622  of the Physique Initialization
dialog, or at the Vertex sub-object level on page 4672 .

Typically, N Links is the preferred choice. For special purposes, such as
developing for a game engine that has limited support of overlap, you can
limit the number of links (with their envelopes) that can affect a vertex.
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Network Manager
The Network Manager service (Network Manager) is a service that must be
installed on at least one computer in each group of computers that will
participate in network rendering.

The Network Manager communicates with a specified group of Network
Rendering Servers to assign jobs and monitor rendering progress. The Network
Manager also handles the scheduling of jobs and the configuration of servers
through the Queue Monitor client.

It's often best to place the Network Manager on a computer that isn't in use
as a workstation and isn’t shut down regularly. The Manager Service can impact
CPU and network performance when network rendering is taking place, and
the Network Manager must be present at all times for network rendering to
work.

The ideal place to install the Network Manager is on a file server. If you have
a PC already set up as a texture-map file server, this would be an ideal place
for it.

You specify which PC is to be the Network Manager in the Network Job
Assignment dialog, a subdialog of the Render Scene and Video Post Execute
Sequence dialogs.

Network Rendering
Network Rendering is the rendering of animations using more than one
computer connected by a network.

Large and complex animations take many hours to render, even on the fastest
PCs. Network rendering allows you to use the power of other computers to
speed up the process. Any network-connected PCs that have the software
installed can participate. You can even render using computers connected
only by the Internet.

Setting up network rendering involves installing three kinds of programs:

■ The Network Manager, which should be installed on a central file-server
PC.

■ The Network Rendering Server, which must be installed on all participating
PCs.
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■ The Queue Monitor client provides a user-interface to monitor and control
network rendering. It can be installed on any of the participating PCs.

Network Rendering Server
The Network Rendering Server must be running on any computer dedicated
to rendering a job remotely.

The Server communicates with the Network Manager and starts the program
on that computer to render network processes. The Server has no user interface
itself, but you can set various options for it from the Queue Monitor client.
For example, you can specify the times of day that the Server is available to
do network rendering.

You specify which PCs are to be servers in the Job Assignment dialog on page
6279 , a subdialog of Render Scene.

Newton
In the metric system, the newton is the unit of force required to accelerate a
mass of one kilogram one meter per second. In 3ds Max, you can use the
newton in dynamic simulations with objects such as the spring on page 820
and damper on page 811 .

Node
Every object in a 3ds Max scene is represented in memory (that is, in the data
structure of the scene) as a node, which acts as a container for an object’s
geometry, its transform controllers, assigned materials and modifiers, etc.
Nodes also provide the building blocks for hierarchies, in which parent/child
relationships are created by linking objects node to node. Two tools that
display nodes are Track View and Schematic View.

”Node” is distinct from the term “object,” because the “object” refers more
narrowly to geometry: the mesh, or NURBS surface, spline, or patch, and so
on. The same instance of an object’s geometry can be shared by multiple
nodes. Each node in the scene is unique and can be identified as such by the
commands and tools 3ds Max or plug-ins implement.
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Normal

The normal of each face can point in a different direction.

A normal is a vector that defines which way a face or vertex is pointing. The
direction of the normal indicates the front, or outer surface of the face or
vertex.

You can manually flip or unify face normals to fix surface errors caused by
modeling operations or by importing meshes from other programs.

See also:

■ Normal modifier on page 1509

NTSC
NTSC (National Television Standards Committee) is the name of the video
standard used in North America, most of Central and South America, and
Japan. The frame rate is 30 frames per second (fps) or 60 fields on page 7777
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per second, with each field accounting for half the interleaved scan lines on
a television screen.

NURBS

Fountain basin modeled as a NURBS surface

NURBS (Non-Uniform Rational B-Splines) are a technique for interactively
modeling 3D curves and surfaces.

NURBS Curve
A curve object created by NURBS modeling on page 7864 . NURBS Curves can
be either Point Curves or CV Curves. You can use them as you do spline curves
in Shape objects.
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NURBS Model

Fountain modeled using NURBS surfaces

A NURBS object on page 7864  consisting of one or more sub-objects. The 3ds
Max documentation uses "NURBS model" to emphasize the final result of
NURBS modeling using a variety of sub-objects and techniques.

NURBS Surface
A surface object created by NURBS modeling on page 7864 . NURBS Surfaces
can be either Point surfaces or CV Surfaces.
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Object

An assortment of geometric primitive objects

"Object" means an object in the scene, such as primitive geometry like boxes
and spheres, more complex geometry such as Booleans, and so on. Geometric
objects are renderable. A scene can also contain non-renderable objects such
as lights, cameras , helpers, and space warps.

You add objects to a scene by selecting the Create menu or from the Create
panel.

Object Instance
In 3ds Max, an instance is a completely interchangeable clone of the original
object. Modifying an instanced object is the same as modifying the original.

Instances are not only alike in geometry, but also share modifiers and materials.
When you change one instance by applying a modifier, for example, all the
other instances change with it.
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Each instance has its own set of transforms, object properties, and space warp
bindings. These are not shared among instances.

Within 3ds Max, instances derive from the same master object. What you're
doing is applying a single modifier to a single master object. In the viewport,
what you see as multiple objects are multiple instances of the same definition.

For example, if you wanted to create a school of swimming fish, you might
begin by making many instanced copies of a single fish. You could then
animate the swimming motion by applying a Ripple modifier to any fish in
the school. The whole school would swim with exactly the same motions.

Object Motion Blur
Object motion blur applies a blur effect to make fast-moving objects appear
to move more smoothly in animations. It is a form of "temporal antialiasing."

Left: Object motion blur. Right: Object motion blur with dithering.

TIP Don't use object motion blur to simulate the blur created by a camera. For
this purpose, use image motion blur on page 7814  or scene motion blur on page
7919 .
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Applying object motion blur is a two-step process:

1 Turn on object motion blur for the object you want to blur, using the
Object Properties dialog on page 245 .

You cannot apply both image motion blur and object motion blur to the
same object in the same rendering.

2 Before you render, turn on object motion blur in the Default Scanline
Renderer rollout on page 5949  of the Render Scene dialog.

Object motion blur works by rendering multiple copies of the object in between
frames and then rendering them together. It is not affected by camera
movement.

Object Space

A book in object space rests on a table in world space.

Object space is the coordinate system unique to each object in your scene. It
tracks the location of everything applied to an object. The location of object
vertices, the placement of modifiers, mapping coordinates, and materials are
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all defined in object space. By convention, especially in discussions of texture
mapping, object-space coordinates are expressed as UVW coordinates, as
opposed to the XYZ coordinates of world space on page 7976 .

Each object has its own local center and coordinate system as defined by the
location and orientation of the object’s pivot point. The local center and
coordinate system of an object combine to define its object space.

When you choose Use Pivot Point Centers from the toolbar or Use Pivot Points
from the Modifier List, you are telling the program to use the Object Space
origin of one or more selected objects as the center of a transform or modifier
effect.

When you choose Local from the Reference Coordinate System list on page
896  (on the main toolbar), you tell the program to use a selected object’s object
space for the orientation of the active coordinate axes.

Most modifiers on page 7852  operate in object space. See Object-Space Modifiers
on page 1132 .

Object Space (Biped)
When you use freeform animation on page 7792  to animate a biped, you can
place a biped limb into the space of another object, or into world space. For
example, if the biped's hands are in the space of a ball, then wherever the ball
moves the hands move with it. If the biped's feet are in world space, then
when you move the center of mass, the feet stay planted in the same location.

Obstacle-Avoidance Behavior
In crowd animation on page 4680 , an important part of crowd behavior is
avoidance of obstacles. Think of an obstacle as anything that impedes a crowd
member's progress. Examples of obstacles include walls, telephone poles, and
fences, as well as other crowd members. Encountering such objects can cause
avoidance behavior, which consists of any combination of slowing down,
turning, and stopping.
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Object-Space Modifiers
Object space is the coordinate system unique to each object in your scene. An
object-space modifier, as opposed to a world-space modifier on page 7977 ,
directly affects an object using the object's local coordinates.

Object-space modifiers appear directly above the object in the modifier stack
on page 7850 , and their effect can depend on the order they appear in the stack.

Omnidirectional Light

Above: Top view of an omni light

Below: Perspective view of the same light
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Above: Top view of an omni light

Below: Perspective view of the same light

Omnidirectional (omni) lights are standard light objects on page 4925  that
provide a point source of illumination that shoots out in all directions. They're
easy to set up, but you can't restrict the focus of their beam. You can, however
restrict which objects are illuminated by an omni light.

When no lights exist in your scene, two invisible omni lights are turned on
by default to provide overall illumination in the scene. However, as soon as
you create your own light in the scene, the two default lights are turned off.

You can apply attenuation to omni lights.

Omniflector
A space warp on page 7934  that deflects particles. Omniflectors are also capable
of refracting particles and generating spawned particles.

Three kinds of space warps are in the omniflector category:

POmniFlect Space Warp on page 2650

SOmniFlect Space Warp on page 2661

UOmniFlect Space Warp on page 2664

See also:

■ Dynaflector on page 7763
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Opacity Falloff
Real transparent surfaces vary their opacity, depending on the angle of the
material to your point of view. For example, a bottle appears more transparent
at its center than at its edge because you're looking through more glass at its
edge.

In the Extended Parameters rollout, you can specify the falloff of the
transparency, based on the angle of the face normals to the view. If a face is
perpendicular to the viewer, the angle of its normal is 0 degrees. If the face is
edge-on to the viewer, its normal angle is 90 degrees.

Falloff is either inward or outward:

In Transparency increases as the normal angle approaches 0 degrees and
decreases as the angle approaches 90 degrees. This gives the appearance of a
hollow object such as a glass ball or bottle.

Inward opacity falloff

Top: None

Bottom: 100%

Out Transparency increases as the normal angle approaches 90 degrees and
decreases as the angle approaches 0 degrees. This gives the appearance of a
solid object such as a cloudy glass marble.
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Outward opacity falloff

Top: None

Bottom: 100%

The falloff amount never makes the object less opaque than the value of the
Opacity spinner. For example, if Opacity were set to 50, and Falloff set to In,
the inner portions would remain at 50 percent opacity, and the Amt. spinner
would change the outer edges, until they became opaque at 100.

Operand
An operand is one of a set of objects upon which an operation such as Boolean
on page 686  is to be done. The Boolean operation takes two operands: the first
operand is called operand A, and the second operand is called operand B.

Operator
In Particle Flow on page 2713 , the operator is the basic element of the particle
system; you combine operators into events on page 7770  to specify the particles'
characteristics over a given period of time. Operators let you describe particle
speed and direction, shape, surface properties, and more.

A list of all operators in Particle Flow is available in the Operators topic on
page 2761 .
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See also:

■ Test on page 7948

Operator Icon
In Particle Flow on page 2713 , adding a Find Target test on page 2891  or a Speed
By Icon operator on page 2796  to a particle system creates a special viewport
icon used by the action. This icon is known as an operator icon. In the 3ds
Max scene, an operator icon functions as a Helper object, and, in fact, you
can also add these two actions from the Create panel by choosing Helpers >
Particle Flow.

Find Target icon (top); Speed By Icon icon (bottom)
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Find Target icon (top); Speed By Icon icon (bottom)

Optical Markers
Reflective markers used by certain motion-capture equipment. In a
motion-capture session, markers are reflective objects placed on the “actor”
or “talent.” The markers enable motion-capture hardware to record the position
of various parts of the talent's body while performing motions.

Orientation Behavior
In crowd animation on page 4680 , the Orientation behavior lets you control
whether and how delegates rotate, independent of their direction of motion.
Normally, a delegate always faces in the direction it's moving. You can use
the Orientation behavior to specify limits to the delegate's rotational activity
without affecting its path, which is generated by other behaviors. Use these
settings, for example, to keep delegates facing in one direction while moving
in another.

NOTE These settings do not affect the path a delegate takes, which is produced
by other behaviors such as Seek and Avoid. Orientation influences only the direction
the delegate faces as it traverses the path.

Glossary | 7875



Origin

Origin is the 0,0,0 point where the X, Y, and Z axes intersect.

A coordinate system assigns an arbitrary point in space as the origin, and sets
each axis at that point to zero.

In the world coordinate system on page 7975 , numbers increase from the origin
to the right along the X axis, upward along the Y axis, and away from you on
the Z axis. Numbers decrease (–1, –2, –3, and so on) to the left along the X
axis, downward along the Y axis, and toward you along the Z axis. The distance
between each whole number is called a unit of measurement (a 3ds Max unit).

You can combine the measurements of all three axes to mark specific locations
in 3D space. The combined measurements are called coordinates. Thus, at the
origin, the coordinates are X=0, Y=0, Z=0, which can be expressed more simply
as the vector (0,0,0).

From the origin, the coordinates at a location 100 units to the right, 150 units
up, and 60 units away are X=100, Y=150, Z=60, or (100,150,60).
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Orthographic View

Orthographic views of a model
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Whether produced on computer or paper, most 3D design relies on 2D
representations for accurate description of objects and their positioning. Maps,
plans, cross-sections, and elevations are all examples of 2D representations.
Each of these views represents an orthographic view. In familiar terms, you
might think of these views as "flat" or "straight-on," or as "looking at right
angles."

Orthographic views are two-dimensional, each defined by two world coordinate
axes. Combinations of these axes produce three pairs of orthographic views:
top and bottom; front and back; left and right.

Orthographic views are a special case of axonometric views on page 7722 . You
can set viewports to the various orthographic views using the viewport
right-click menu on page 7370  or keyboard shortcuts on page 7645 .

Out-of-Range Types

When you specify values and keys for a controller, you are defining animation
over a range of time. You choose Out-of-Range Types to determine how the
animation continues outside a specified range. Out-of-Range choices include
holding a constant value, and various ways of repeating the animated range.

The easiest way to work with Out-of-Range Types is in the Track View Function
Curve mode.

7878 | Glossary



You use the Parameter Out-of-Range dialog to project the pattern of the key
dots in the selected track. These patterns are applied to the animation outside
the range of all keys in the track. This is why they're called out-of-range types.

By default, tracks use a constant out-of-range type. This means that the track
values before and after the range of keys remain constant. For example, in a
100-frame animation with keys up to frame 20, the X, Y, and Z values after
frame 20 remain the same for the rest of the animation. The objects in this
example do not move from frame 20 to frame 100.

Applying the Cycle out-of-range type will make the key pattern in frames 0–20
repeat cyclically for the remaining 80 frames.

Outputs: Source / Test
In Particle Flow, you create a particle diagram on page 7885  by connecting
events on page 7770  using wires on page 7971 . Each wire links an output with
an event input on page 7817 . There are two different types of outputs: ;

■ The connector sticking down from the bottom of a global event on page
7801  is a source output.

■ The connector sticking out from the side of a test on page 7948  is a test
output.
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Source output (above); test output (below)
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Overshoot

Above: No overshoot

Below: Overshoot turned on

The Overshoot option causes a spotlight to flood beyond its falloff area, and
cast light in all directions. With Overshoot turned on, the spotlight casts light
in all directions but casts shadows only within its falloff cone.
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The Overshoot control effectively turns the spotlight into a hybrid between
an Omni light and a spotlight. With Overshoot set, the spotlight casts light
in all directions as an Omni light does but still casts shadows or projections
as other spotlights do. The shadows and projections are limited to the falloff
region: outside the cone of the spotlight, Overshoot casts light but does not
cast shadows or projections.

Overshoot is useful when you want to light a large area but need to cast
shadows in only a small part of that area. Set the falloff to include the area
where shadows must appear, and then turn on Overshoot to light the rest of
the scene. This technique can reduce the size of shadow maps and thereby
improve rendering speed.

PAL
PAL (Phase Alternate Line) is the video standard used in most European
countries. The frame rate is 25 frames per second (fps) or 50 fields on page
7777  per second, with each field accounting for half the interleaved scan lines
on a television screen.

Parameter Space
NURBS objects have, in addition to their existence in 3D space, a parameter
space that includes the array of knot values. NURBS curves have a single U
dimension in parameter space. NURBS surfaces have two dimensions, U and
V, in parameter space.

Parameters Panel
The parameters panel, found to the right of the event display on page 7772  in
Particle View on page 2730 , displays the parameters of any action whose name
you click in the depot. The panel uses the same format and editing methods
as the command panel in 3ds Max. Display of the parameters panel can be
toggled with the Particle View menu command Display > Parameters.
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Parameter/Parametric

A tube is one example of a parametric object. Varying its parameters creates varying
geometry.

A parameter is a setting or value that you can change. Many objects in 3ds
Max have parameters that you can change to alter the size or shape of the
object. This type of object can be described as parametric.

Unlike physical building blocks, which have a fixed shape and size, the
geometric primitives (box, sphere, torus, and so on) are parametric; you can
change their dimensions, segment settings, and other features after you create
them. Parametric objects respond to changes in their parameters by
dynamically updating their properties.

Changing a parameter can dramatically alter the structure and appearance of
an object. For example, you can turn a cylinder into a prism by reducing the
number of sides and turning the Smooth option off. Alternately, you can turn
a cone into a four-sided pyramid using the same technique.

Objects that you merge from other scenes or from Autodesk VIZ allow you to
access parametric values. Objects in drawings that you link from Autodesk
Architectural Desktop should be edited in Architectural Desktop, then relinked
to 3ds Max with the File Link Manager on page 6783 .

You can animate almost all creation parameters for geometric primitives, and
interactively change their settings during animation playback.
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Parent Particle
A parent particle is an existing particle from which the particle system generates
spawn particles on page 7934 . You can use the Spawn test on page 2912  to create
spawn particles arbitrarily, or the Collision Spawn test on page 2885  to create
spawn particles as the result of physical interaction between a parent particle
and a deflector.

Particle Diagram
The particle diagram is the graphical depiction of the particle system on page
7887  in Particle View on page 2730 . It uses events on page 7770  and wires on
page 7971  to represent the system's elements and logic. You edit the system by
clicking actions on page 7701  and events in the diagram and changing their
values, by adding new actions and events, and by creating wires between
events.
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Particle Level
In Particle Flow, you can select particles at the Event level on page 7773  or at
the Particle level, using controls on the Modify panel > Selection rollout on
page 2753 . At the Particle level, you select particles using standard 3ds Max
methods, such as clicking or dragging a region. A Particle-level selection can

7886 | Glossary



be acted upon by the Delete operator on page 2768  and the Split Selected test
on page 2921 .

Particle System
Particle systems are objects that generate non-editable sub-objects, called
particles, for the purpose of simulating snow, rain, dust, and so on.

The particle system object generates the particles over time. You use particle
systems primarily in animations.

3ds Max provides several built-in particle systems, including Spray and Snow.
Your configuration might have other plug-in particle systems installed.

The Deflector, Gravity, and Wind space warps are for use with particle systems.
(Gravity and Wind also work with Dynamics.)

3ds Max also offers an event-driven particle system called Particle Flow on
page 2713 .

Particle System (Particle Flow)
A particle system in Particle Flow consists of all flows on page 7787  defined in
Particle View, as well as parameters defined for all Particle Flow sources on
page 2748 . In effect, it's the totality of settings in Particle Flow.

PASS File
A PASS (.pass) file saves the result of a single mental ray rendering on page
6039  pass. You can create a final rendering by merging multiple passes. The
PASS file format includes Z-buffer information to aid in merging passes.

Controls for creating and merging PASS files are on the Render Scene dialog
> Processing Panel > Translator Options rollout on page 6122 .
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Patch

Example of a patch model

A patch is a type of deformable object. A patch object is useful for creating
gently curved surfaces, and provides very detailed control for manipulating
complex geometry.

When you apply an Edit Patch modifier on page 1290  to an object or convert
it to an editable patch on page 1934  object, the software converts the object's
geometry into a collection of separate Bezier patches. Each patch is made up
of three or four vertices connected by edges, defining a surface. Patches also
have interior vertices that you can control, or let the software control for you.

You control a patch surface's shape by manipulating the vertices and edges.
The surface is the renderable geometry of the object.

Patch-Based Objects
Objects made from patches. Physique on page 4522  can work with meshes,
patches, NURBS, splines, and FFD space warps.

Path
A path is the line (or other shape) along which shapes are lofted to create 3D
Loft objects on page 715 .
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The Path constraint on page 3222  also lets you assign a line or other shape as
a motion path. A motion path is a form of trajectory on page 7955 .

Get Path (Lofting)

A circle is lofted along a path to construct a tubular shape. Get Path chooses the path
spline

You use Get Path as a loft creation method when you want the path to move
to the location of the selected shape. For example, you use this method if you
have created a shape at the exact location where you want the base of your
loft object to be. You use Get Path to create a loft at that location.

Get Path causes the path shape to move and rotate to align itself with the first
shape on the path:

■ The first vertex on the path is located at the first shape's pivot point.

■ The tangent to the first vertex on the path is aligned with the positive Z
axis of the first shape.

■ The local Z axis of the path is aligned with the local Y axis of the first
shape.
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■ The local coordinate system of the resulting loft object equals the local
coordinate system of the path after it has been aligned with the first shape.

Sometimes, aligning the tangent of the path with the positive Z axis of the
first shape does not produce the result you want. You can flip the orientation
of the path by pressing Ctrl while getting the path. Pressing Ctrl aligns the
path so that the tangent to the first vertex of the path is aligned with the
negative Z axis of the shape.

Path Follow Behavior
In crowd animation on page 4680 , the Path Follow behavior lets you direct
delegates to traverse a specified path during a crowd simulation. Delegates
can move forward or backward along paths, and when they reach the end,
they can loop back to the start or reverse direction, or even continue in the
same general direction.

If the delegate's start position isn't on the path at the start of the simulation,
it moves to the path before following the path. During the solution, character
studio intermittently displays an optional target icon to show the delegate's
immediate goal; this changes as the simulation proceeds.

Period
When you animate a biped, a freeform period is a period between footsteps
where you can animate the biped any way you want. Biped dynamics on page
7727  are suspended during this period. See Freeform Animation Between
Footsteps on page 4149 .
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Perspective View

Perspective view of the ice-cream shop

Perspective views most closely resemble human vision. Objects appear to
recede into the distance, creating a sense of depth and space. For most 3D
computer graphics, this is the view used in the final output that the client
sees onscreen or on the page.

There are three ways to create a perspective view in a viewport: perspective
view, camera view, and light view.

A perspective viewport, labeled Perspective, is one of the default viewports.
You can change any active viewport to this eye-like point of view by pressing
the keyboard shortcut P.

A camera view requires that you first create a camera object in your scene.
The camera viewport tracks the view through the perspective of that camera.
As you move the camera (or target) in another viewport, you see the scene
swing accordingly. If you alter the camera's field of view on the Modify
command panel, you see the changes as they are applied.
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The light view works much like a targeted camera view. You first create the
spotlight or directional light and then set the viewport to that light. What
you see in the viewport is the view from the light looking into the scene. This
is very useful for adjusting the correct distances of hotspot and falloff for the
light.

Phases of Leg Motion
A leg's motion has four phases, beginning with the foot on the ground. Then
the foot lifts, moves through the air, and returns to the ground again. Biped
divides this motion into four phases, as follows:

■ Touch Occurs at the leg keyframe where the leg's foot first touches the
ground and always corresponds with the start frame of a footstep in Track
View — Dope Sheet.

■ Plant Occurs after touching, and before lifting. It is always in between
the start and end frames of a footstep in Track View — Dope Sheet.

■ Lift Occurs at the keyframe where the leg's foot lifts off the ground, and
always corresponds to the end frame of each footstep in Track View —
Dope Sheet.

■ Move Occurs while the foot is in the air and is always in the intervals in
between steps in Track View — Dope Sheet. In walking, while one foot
moves, the body is supported by the other leg. In running or jumping,
while a foot moves there is a period where the body is not supported, and
moves in midair.

Photometry
When you use photometric lights on page 4951 , 3ds Max provides physically
based simulation of the propagation of light through an environment. The
results are not only highly realistic renderings, but also accurate measurements
of the distribution of light within the scene. The measurement of light is
known as photometry. This topic introduces the quantities used for defining
and measuring light.

There are several theories that describe the nature of light. For this discussion,
we define light as radiant energy capable of producing a visual sensation in a
human observer. When we design a lighting system, we’re interested in
evaluating its effect on the human visual response system. Thus photometry
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was developed to measure light, taking into account the psychophysical aspects
of the human eye/brain system. Four photometric quantities are used in the
lighting simulation system:

■ Luminous flux

■ Illuminance

■ Luminance

■ Luminous intensity

Luminous flux is the quantity of light energy per unit time arriving, leaving,
or going through a surface. The unit of luminous flux is the lumen (lm), which
is used in both the International System (SI) of Units and in the American
System (AS) of Units. If we think of light as particles (photons) moving through
space, then the luminous flux of a light beam arriving at a surface is
proportional to the number of particles hitting the surface during a time
interval of 1 second.

Illuminance is the luminous flux incident on a surface of unit area. This
quantity is useful for describing the level of illumination incident on a surface
without making the measurement dependent on the size of the surface itself.
The SI unit of illuminance is the lux (lx), which is equal to 1 lumen per square
meter. The corresponding AS unit is the footcandle (fc), equivalent to 1 lumen
per square foot.

Part of the light incident on a surface is reflected back into the environment.
The light reflected off a surface in a particular direction is called luminance,
the quantity that is converted to display colors to generate a realistic rendering
of the scene. Luminance is measured in candelas per square meter or candelas
per square inch. The candela was originally defined as the luminous intensity
emitted by a single wax candle.

Finally, luminous intensity is the light energy per unit time emitted by a point
source in a particular direction. The unit of measure of luminous intensity is
the candela. Luminous intensity is used to describe the directional distribution
of a light source, that is, to specify how the luminous intensity of a light source
varies as a function of the outgoing direction.

Because 3ds Max works with these physically based photometric values, it can
accurately simulate real-world lighting and materials.
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Photon Map
A photon map™ is a technique to generate the indirect illumination effects
of caustics on page 6066  and global illumination on page 6072  when you render
with the mental ray renderer on page 6039 . When it calculates indirect
illumination, the mental ray renderer traces photons emitted from a light.
The photon is traced through the scene, being reflected or transmitted by
objects, until it strikes a diffuse surface. When it strikes a surface, the photon
is stored in the photon map.

Generating photon maps is time-consuming. To improve performance, you
must explicitly specify:

■ Which lights emit photons for indirect illumination.

■ Which objects can generate caustics or global illumination.

■ Which objects can receive caustics or global illumination.

The settings for generating and receiving caustics are on the Object Properties
dialog > mental ray Panel on page 262 .

The photon map stores photons only for objects that can receive caustics,
global illumination, or both.

To further reduce the time required to generate a photon map, photons are
limited by the Trace Depth controls. These limit the number of times a photon
can be reflected, refracted, or both.

In animations, another way to save time is to reuse the photon-map file. If
lighting doesn't change over the course of an animation, use the Photon Map
controls on page 6102 .

The mental ray renderer saves photon maps as PMAP files on page 7897 . Photon
map controls are on the Render Scene Dialog > Indirect Illumination panel >
Caustics And Global Illumination rollout on page 6096 .

PHY Files
You can save Physique on page 4522  data to a Physique (PHY) file. This saves
data common to all objects that share a given Physique modifier.

Later, you can reload the PHY file, either to restore the data that belongs to a
particular skin or portion of skin, or to transfer the Physique of one skin (or
portion of it) to a different one.
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Physique
Physique on page 4522  is a modifier that, when applied to a mesh, allows the
movements of an underlying skeleton to seamlessly move the mesh like bones
and muscle under a human skin. Physique will work on any point-based
object, including geometric primitives, editable meshes, patch-based objects,
NURBS, and FFD space warps. It will attach to any skeleton structure, including
a biped on page 4069 , bones, splines, or any hierarchy.

NOTE For NURBS and FFDs, physique deforms the control points (control vertices),
which, in turn deform the model.

Pivot Point

Pivot point sets hand to the center of the clock face.

The transform center, or pivot point, is the spot about which a rotation takes
place, or to and from which a scale occurs.
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All objects have a pivot point. You can think of the pivot point as representing
an object's local center and local coordinate system.

The pivot point of an object is used for a number of purposes:

■ As the center for rotation and scaling when the Pivot Point transform
center is selected.

■ As the default location of a modifier center.

■ As the transform origin for linked children.

■ As the joint location for IK.

You can display and adjust the position and orientation of an object's pivot
point at any time using the Pivot functions in the Hierarchy command panel
. Adjusting an object's pivot has no effect on any children linked to that object.

Pixel
A pixel (short for Pic ture El ement) is a single point in a graphic image.
Graphics monitors display pictures by dividing the screen into thousands (or
millions) of pixels, arranged in rows and columns.

Plant
In footstep animation on page 7790 , the state of the biped foot when it is flat
on a footstep.

Plug-Ins
A plug-in is a feature or functionality supplied by an independent program
or component. Plug-ins can be supplied by third-party vendors or independent
software developers.

For example, several Video Post filter and layering plug-ins ship with 3ds Max.

The open architecture provides an API (application programming interface)
designed to make it easy for other companies to write plug-ins that extend
the core functionality of 3ds Max.
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PMAP File
A PMAP (.pmap) file is a mental ray photon-map on page 7894  file. This is a
binary file that the mental ray renderer on page 6039  uses to generate the effects
of caustics on page 6066  and global illumination on page 6072 . You specify a
name and location for the PMAP file on the Render Scene dialog > Indirect
Illumination panel > Caustics And Global Illumination rollout on page 6096 .

Point
A point in three-space, created when you use NURBS modeling to create a
Point Curve or Point Surface, or when you create an individual point
sub-object. Points that are part of a Point Curve or Point Surface are constrained
to lie on the curve or surface.

Points behave somewhat like vertices for spline objects on page 542 , but their
behavior is not identical and they are a distinct object type. Helper object
points on page 2544  are also a distinct object type. You can't use spline vertices
or helper points as NURBS points (though you can convert a spline to a NURBS
curve).
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Point Curve

NURBS point curve

A curve defined by points. The points are constrained to lie on the curve. (Or
you can think of the curve as being dependent on its point locations.) More
than one NURBS solution is possible for a Point Curve; occasionally this can
cause unexpected results.
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Point Surface

NURBS point surface

A surface defined by points. The points are constrained to lie on the surface.
(Or you can think of the surface as being dependent on its point locations.)
More than one NURBS solution is possible for a Point Surface; occasionally
this can cause unexpected results.

Poses
When you work with a biped on page 4069 , the pose is the stance of the entire
biped. You can copy and paste poses. See Copy/Paste Rollout on page 4308 .

Positional Markers
In a motion-capture session, positional markers are reflective objects placed
on the “actor” or “talent.” The markers enable motion-capture hardware to
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record the position of various parts of the talent's body while performing
motions.

Posture
When you work with a biped on page 4069 , the posture refers to the position
of selected biped parts, as opposed to the overall pose on page 7899 . You can
copy and paste postures. See Copy/Paste Rollout on page 4308 .

Precedence
You control an IK solution on page 7813  by setting joint precedence to
determine which joints contribute the most to the IK solution and which
joints contribute the least.

Joints with high precedence values are calculated first, and, therefore,
contribute more motion to the IK solution. Joints with low precedence values
are calculated last, and, therefore, contribute the least motion to the IK
solution.

Joints with equal precedence values are calculated by their order in the
hierarchy. Joints deeper in the hierarchy (closer to the end effector) are
calculated first and joints closer to the root are calculated last.

Premultiplied Alpha
There are two methods of storing alpha in a bitmap: premultiplied and
nonpremultiplied.

To composite an image that is in nonpremultiplied format, the alpha must
be multiplied by each of the R, G, and B channels before adding it to the color
of the background image. This provides the correct transparency effect, but
it must be done each time you composite. With premultiplied alpha, you store
the R, G, and B components with the alpha already multiplied in, so
compositing is more efficient.

This is not the only reason that 3ds Max stores images in the premultiplied
format. When you render an image, you typically want the edges of the objects
to be antialiased. This effect is achieved by determining the fractional coverage
of pixels on the edge of the object, and then adjusting the alpha of the pixel
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to reflect this. For example, a pixel that is 30% covered by the object will have
an alpha of 0.30.

To antialias the edges, the alpha must be premultiplied to darken these edge
pixels. (This is equivalent to compositing the image over a black image). So
it is natural, in a sense, for rendered images to have premultiplied alpha. If
you do not premultiply the alpha of a rendered image, then just looking at
the RGB you will see jaggies on the edges of objects. You would need to
composite it against black using the alpha channel whenever you wanted to
display it.

NOTE To control whether or not the renderer uses the environment map's alpha
channel in creating the alpha for the rendered image, choose Customize >
Preferences > Rendering, and then turn on Use Environment Alpha in the
Background Antialiasing group.

If Use Environment Alpha is turned off (the default), the background receives
an alpha value of 0 (completely transparent). If Use Environment Alpha is
turned on, the alpha of the resulting image is a combination of the scene and
background image's alpha channel. Also, when you render to TGA files on
page 7162  with Pre-Multiplied Alpha set to off, turning on Use Environment
Alpha prevents incorrect results.

TIP If you plan to composite objects in another program such as Combustion or
Photoshop, render the objects against a black background. Otherwise, a fringe of
environment or background color can appear around the objects.

Procedural Maps
Unlike a bitmap, which is an image produced by a fixed matrix of colored
pixels like a mosaic, a procedural map is generated by a mathematical
algorithm. Consequently, the types of controls you might find for a procedural
map will vary depending on the capabilities of the procedure.
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Three procedural maps (bricks, Perlin marble, and splat), with variations
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A procedural map can be generated in two dimensions, or in three. For
example, Wood has a grain that goes through the assigned geometry. If you
cut away part of an object with wood assigned as its texture, the grain in the
cutaway portion matches the grain on the object's exterior: it is all generated
by the same procedure.

Projector Light

Shadows created by projecting image of palm trees

By adding a map to a light, you turn it into a projector. You can assign a single
image, or you can assign an animation to create the effect of either a slide
projector or a movie projector.

You can also use projector maps to project black and white bitmaps to simulate
shadows seen through leaves or window frames, in the same way that gobos
are used in theater lighting.

You're not limited to circular projectors. Since you're usually projecting a
rectangular image, you can use a rectangular light to project it. You can use
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the Bitmap Fit option to adjust the aspect ratio of the light beam to match
that of the projected image.

When you use projection lights, it's often helpful to adjust their roll angle.
You can do this with the navigation controls or with the roll angle
manipulator on page 5042 .

Prop Bone
The CSM marker file format on page 7749  supports a prop bone in either or
both hands. There are six additional markers for the top, bottom, and middle
of the two props. If these tracks are detected, character studio creates a 3ds
Max dummy object.

The length of the prop is the average distance between the top and bottom
prop marker during animation. The prop will be oriented in the plane of the
three prop markers, and its origin will be at the bottom prop marker.

Quadtree
A quadtree is a data structure used to calculate ray-traced shadows on page
7907 .

The quadtree represents the scene from the point of view of the light. The
root node of the quadtree lists all objects that are visible in that view. If too
many objects are visible, the node generates four other nodes, each representing
a quarter of the view, each with a list of objects in that portion. This process
continues adaptively, until each node has only a small number of objects, or
the quadtree's depth limit (which can be set for each light) is reached.

Each shadow-casting light ray needs to test intersection with the objects in
only one of the leaf nodes of the quadtree. This helps speed up the ray-tracing
process. In general, increasing the maximum quadtree depth can speed up
ray-tracing at a cost of memory.

The maximum size of a quadtree is the square of two to the power of the
maximum quadtree depth. At a depth of 7, the largest quadtree has 128 x 128
leaf nodes; at a depth of 10, the largest quadtree has a size of 1028 x 1028 leaf
nodes, and so on. (On the other hand, because each successive node contains
fewer objects, the size of a node's record decreases the deeper it is in the tree.)

NOTE An omni light can generate up to ten quadtrees, so omni lights that cast
ray-traced shadows use more memory at render time than spotlights do.
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Queue Monitor
The Queue Monitor is a standalone network-administration tool that provides
a user interface to monitor and control network rendering.

The Queue Monitor can connect to any computer to which you have network
access with the appropriate security permissions, and a Network Manager
running on it. You can install the Queue Monitor separately. It will function
correctly on any Intel-based computer running Windows NT with appropriate
TCP/IP networking services, including over the Internet. In other words, you
can monitor and control network rendering services from any computer
connected to the Internet, in addition to using the Internet as a wide-area
backbone for a network rendering farm.

Radiosity
A technique to calculate indirect light to illuminate a scene. Radiosity calculates
the interreflections of diffuse light among all the surfaces in your scene. The
result is the radiosity solution on page 7905 . See Modeling Global Illumination
with Radiosity on page 5976 .

Radiosity Solution
The calculation of the radiosity on page 7905  effect in a scene. You compute
the radiosity solution as a separate step from rendering. Once the solution is
computed, it can be used for multiple renderings. See Modeling Global
Illumination with Radiosity on page 5976 .

Ray-Trace Acceleration (mental ray Renderer)
The mental ray renderer on page 6039  provides three different ray-tracing
methods of accelerating the process of ray tracing. The methods are:

■ BSP (Binary Space Partitioning). This method (the default) performs best
for most purposes.

■ Grid. This method can perform better on multiprocessor systems.
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■ Large BSP. This method can perform better with large scenes and with
distributed bucket rendering.

You set the raytrace acceleration method on the Render Scene Dialog >
Renderer panel > Rendering Algorithms rollout on page 6118 .

Ray-Trace Bias

On the right, increased map bias makes the dog appear to float.

A single parameter, Ray-Trace Bias, affects the generation of ray-traced shadows
on page 7907 . You set this parameter in the Shadow Parameters rollout.

The Ray-Traced bias control in the Shadow Parameters rollout moves the
shadow toward or away from the shadow-casting object (or objects). By default,
this value is 1 unit.

Increasing the bias moves the shadow away from the object, and decreasing
the bias moves the shadow closer to the object. The Ray-Trace Bias value can
be any positive floating-point number.

For example, if a shadow-casting object intersects another object but its shadow
doesn't meet properly at the intersection, the bias is too high. This effect varies
with the angle of the spotlight to the object. Extremely shallow spotlight
angles usually require higher bias values.

Another purpose of bias is to avoid problems with objects that cast shadows
onto themselves. If you see streaks or moiré patterns on the surface of the
object, the bias value is too low.
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Ray-Traced Shadows

Example of ray-traced shadows

Ray-traced shadows are generated by tracing the path of rays sampled from a
light source. Ray-traced shadows are more accurate than shadow-mapped
shadows on page 7927 . They always produce a hard edge.

Ray-traced shadows are more realistic for transparent and translucent objects.
Also, only ray-tracing can generate shadows for wireframe objects.

Because ray-traced shadows are calculated without a map, you don't have to
adjust resolution as you do for shadow-mapped shadows. The parameters for
ray-traced shadows adjust the shadow's position (known as ray-trace bias on
page 7906 ) and the depth of the quadtree on page 7904  used to calculate ray
tracing.

Advanced ray-traced shadows are the same as ray-traced shadows, however
they provide antialiasing on page 7708  control, letting you fine-tune how
ray-traced shadows are generated.

RAYHOSTS File
The RAYHOSTS file is a text (ASCII) file that lists the name of host systems
capable of mental ray rendering on page 6039  in a distributed network. You
turn on distributed rendering on the Render Scene dialog > Processing panel
> Distributed Bucket Rendering rollout on page 6131 .
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Each line in the RAYHOSTS file contains the name of a host system. The host
name can be followed by a semicolon and a port number of the service to
connect to. The host name with or without the port number can also be
followed by white space and a list of mental ray command-line parameters.

See the manual, Rendering with mental ray, for descriptions of the mental ray
command-line options.

When you click Add on the Distributed Bucket Rendering rollout and use the
Add/Edit DBR Hosts dialog on page 6140  to add a host or satellite processor,
this updates the RAYHOSTS file. So does clicking Remove to remove a
processor.

The RAYHOSTS file is named max.rayhosts. By default, it is located in the
\mentalray directory inside the program folder. You can change the default
location by creating an environment variable named MAX<X>_MI_ROOT,
where <X> is the 3ds Max version number, and setting the variable's value to
the path of the max.rayhosts file you want to use.

Real Time
By default, viewport animations play in real time, skipping frames where
necessary.

You can turn this off by clicking Time Configuration in the time controls,
and then turning off Real Time in the Playback group box of the Time
Configuration dialog on page 7359 .

When Real Time is turned off, all frames are displayed during playback. The
playback may appear slow, but you'll know that you're seeing every frame.

You can also speed viewport animation by minimizing your viewports to
quarter size.

Red, Green, Blue / Hue, Saturation,Value
There are two sets of color sliders in the Color Selector on page 331 : the
red/green/blue (RGB) set and the hue/saturation/value (HSV) set. You can use
either set or both to mix a particular color. As you adjust the color sliders,
their RGB and HSV numeric values appear in the spinners.

There are separate RGB and HSV spinners as light parameters on page 4890 .
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RGB Sliders

Each of the RGB sliders is a band of red, green, or blue (the primary light
colors) shaded from black to the full intensity of the color. When you move
any slider, it mixes with the values of the other two, and the result appears
in the swatch beneath the sliders.

For example, if you move the Red slider all the way to the right (value 255)
and leave the other two at the left (0), the active swatch turns red. If you then
move the Green slider all the way to the right, the swatch turns yellow. If you
move all three sliders to 0, the result is black; if all three are at 255, the result
is white; and all three at any point of equal value produce shades of gray.

HSV Sliders

If you prefer the hue/saturation/value color system, you can use the HSV
sliders to mix color. First move the Hue slider to the color band you want (if
the Value and Saturation sliders are set to low values, you don't see an
immediate result in the swatch). Move the Value slider to set the brightness,
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or intensity of the color. Move the Saturation slider to determine the purity
of the color. The higher the saturation, the less gray the color.

Reference
References are like "one-way" instances. Referenced objects are based on the
original object, as are instances, and can have their own unique modifiers.
Any modification made to the original object is passed on to its references,
but any modification made to a reference is not passed back to the original.

The one-way effect is useful, since you can maintain an original that will affect
all its references, while the references themselves can take on individual
characteristics.

If you are modeling heads, for example, you might want to keep a family
resemblance in your characters. You could model basic features on the original,
then model specifics on each reference.

In the modifier stack, a solid line separates the reference from its parent object,
so you can see that the effect of modifiers on the reference will not affect the
parent object or other references to it.

Reference Object
In Particle Flow on page 2713 , a reference object is a geometry object or
collection of objects used as particles by the Shape Instance operator on page
2825 . It can be a single object, a group, a hierarchy, or even a compound object
consisting of several elements.

Refine
In NURBS modeling, refining means to increase the number of CVs on a curve
or surface. Refining does not change the curvature of the curve or surface.
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Reinitialize 
In Physique on page 4522 , when you need to reset vertex, envelope, and other
skin parameters, click Reinitialize to display the Physique Initialization dialog
on page 4602 . Using controls in this dialog, you select which category to update,
and apply the new global settings you specify.

For example, if you've added a new bone to the hierarchy and want it included
and influenced by the Physique modifier, you'd use reinitialization. Or maybe
you've repositioned the biped structure relative to the mesh, or scaled both;
you'd need to reinitialize Physique settings to recognize those changes.

Repel Behavior
In crowd animation on page 4680 , the Repel behavior lets you specify any
object or objects (sources) that will force delegates to move away from them.
This is basically the opposite of the Seek behavior. If you want delegates to
back away from an object, as opposed to turning to face the direction they're
moving, use Repel in conjunction with the Orientation behavior.

Reservoir
The Reservoir is a storage area for clips ( BIP files on page 7727 ) used by the
Motion Mixer on page 7856 . The Reservoir contains a single entry for each clip
adaptation on page 7704  used in the Mixer. You can use the Reservoir to load
previously used clips, save adaptations to new BIP files, or view a clip's
adaptation data. See Using the Reservoir on page 3667 .

The purpose of the Reservoir is to save memory. Instead of storing the
animation and adaptation data for each clip inside the clip, it is stored in the
Reservoir. When a clip is used more than once in the Mixer, the clip
occurrences can share the data from the Reservoir, saving memory.

Resolution
The horizontal and vertical number of pixels in a 2D image. For example, a
640x480 resolution describes an image that is 640 pixels across by 480 pixels
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down. Resolution can also refer to an image’s bit depth, such as 24-bit or
32-bit.

You set the resolution of the image you are going to render on the Render
Scene dialog on page 5878 .

Rotoscoping

Boat is an object composited over video of breaking wave.

Rotoscoping is the process of bringing video frames into a scene to use as the
background for matching objects.

The way to use rotoscoping is to specify a digital disk recorder or movie file
and read the frames into the viewport using the Animation Synchronization
controls in the Viewport Background dialog. Once you've specified your source
device or file in the Viewport Background dialog, one frame of the video
displays for each scene frame by default. Remember to tun on Animate
Background as well as Show Background to have your video frames appear in
sequence in the viewport.

To produce the composited, rendered image, use Video Post or a compositing
application to composite the background image and the rendered scene
together.

Rubber-Band Mode
When you work with a biped on page 4069 , Rubber-Band mode provides a way
to proportion the arm and leg links simultaneously, by moving the link with
the Move transform, instead of using scale. Rubber-Band mode scales both
the link and its child in a single step.
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This is particularly useful when fitting a biped to a skin prior to applying the
Physique modifier on page 4522 . For example, rubber-banding the upper arm
rescales the upper and lower arm objects and moves the elbow link without
affecting the position of the shoulder or the wrist. If you've spent a lot of time
getting the fingers in the right place, you can reposition the elbow by
rubber-banding, without affecting the hands.

RVT Link
When working on Revit projects, you can import/link DWG, DXF, DGN, RVT
and image files. These files can contain 2D and 3D geometry to help in the
construction of your projects. Raster images can be imported as background
images into your Autodesk Revit project or as visual aids needed during the
creation of a model.

When you've exported the project to a DWG file, RVT links are comparable
to xrefs in an AutoCAD drawing.

For more information about the Import/Link features of Revit, refer to the
Autodesk Revit Help file.

Sample Range

Low sample range can cause jagged-edged shadows.
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Higher sample range causes soft-edged shadows.

Sample Range affects the softness of the edge of shadow-mapped shadows
on page 7927 . The sample range determines how much area within the shadow
is averaged.

Small values reduce the area that is averaged, effectively bringing the edge of
the shadow inward, producing sharper-edged shadows. Sharper edges can
cause aliasing.

Large values extend the area that is averaged, effectively bringing the edge of
the shadow outward, producing softer-edged shadows. Soft-edged shadows
have more antialiasing. The effect is somewhat like the falloff of a soft-edged
spotlight.

The default Sample Range value is 4. The Sample Range value can be any
floating-point number from 0 to 20. Values of 2 to 5 are recommended. Values
below 3 can produce coarse-edged shadows. You can reduce this effect by
increasing the map size.

Values greater than 5 can produce streaking and moiré patterns. You can
reduce this effect by increasing the map size or the Bias value.

Rendering time increases exponentially as the Sample Range value increases.

Sampling (mental ray Renderer)
Sampling is an antialiasing technique. It provides a "best guess" color for each
rendered pixel. The mental ray renderer on page 6039  first samples the scene
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color at locations within the pixel or along the pixel's edge, then uses a filter
to combine the samples into a single pixel color.

(In 3ds Max, this technique is called "supersampling." Because the mental ray
renderer performs sampling on a scene basis, in the Material Editor, you don't
need to turn on supersampling for materials rendered using mental ray.)

Scene rendered with low sampling is jagged and inaccurate.

Sampling range: 1/64 to 1/4
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Same scene rendered with higher sampling shows smooth edges.

Sampling range: 1 to 16

The mental ray renderer provides five filter methods: Box, Gauss, Triangle,
Mitchell, or Lanczos. Box, the default, is also the quickest. Mitchell is often
the most accurate. The Box filter combines samples evenly, without weighting
them. Each of the other filters uses a particular curve to weight samples before
combining them.

Curves used to weight samples (these are approximate)

You choose the sampling filter and set other sampling options on the Render
Scene dialog > Renderer panel > Sampling Quality rollout on page 6083 .

7916 | Glossary



NOTE Area lights ( Area Omni Light on page 4945  and Area Spot Light on page
4948 ) have their own sampling controls. These affect only shadows cast by the area
light. They are independent of the sampling used to render the scene as a whole.

Rendering the Sampling Rate

To help you choose a sampling filter, you can render a scene with diagnostics
enabled and Sampling Rate chosen on the Render Scene dialog > Processing
panel > Diagnostics rollout on page 6129 . The Sampling Rate diagnostic tool
gives a schematic rendering that shows how the sampling method behaves
with your scene.

Rendering with diagnostic display of the sampling rate turned on

Sampling range: 1 to 16

The intensity of each pixel indicates the number of samples collected within
it and on its lower and left edges. The brighter the pixel, the greater the number
of samples. Overall, the View Sample rendering is normalized so the brightest
pixels have the maximum number of samples. Also, red boundaries indicate
the boundaries of sampling tasks.
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Lock Samples and Animation

By default, the mental ray renderer introduces a pseudo-random (quasi Monte
Carlo) variation in the sampling pattern from frame to frame. This reduces
rendering artifacts in animations.

You can turn off the sampling variation by turning on Lock Samples on the
mental ray: Sampling Quality rollout on page 6083 .

Jittering

"Jitters" samples by introducing a variation into sample locations. Turning on
Jitter can help reduce aliasing. Default=off.

The Jitter control is also on the Sampling Quality rollout on page 6083 .

Scale Stride
In footstep animation on page 7790 , the Scale parameter lets you change the
length or width of a footstep selection (or both at once). This setting is on the
Footstep Operations rollout on page 4355 .

The selected footsteps are scaled around the first footstep in the selection.

Scanline Renderer
The scanline renderer on page 5949  is the default renderer. By default, you use
the scanline renderer when you render a scene from the Render Scene dialog
on page 5878  or from Video Post. The Material Editor also uses the scanline
renderer to display materials and maps.

The image produced by the scanline renderer displays in the rendered frame
window on page 5885 , a separate window with its own controls.

As the name implies, the scanline renderer renders the scene as a series of
horizontal lines. 3ds Max additionally provides the interactive viewport
renderer to provide a quick and simple rendered view of your scene as you
work on it. You might also have other plug-in or third-party renderers that
you've installed to work with 3ds Max.
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Scene Extents
Just as an object's extents on page 7773  are its maximum dimensions in X, Y,
and Z, the extents of a scene are its maximum dimensions in these three axes,
and define a box that encloses the entire scene.

Scene Motion Blur
Motion blur can enhance the realism of a rendered animation by simulating
the way a real-world camera works. A camera has a shutter speed, and if
significant movement occurs during the time the shutter is open, the image
on film is blurred.
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Above: Scene motion blur creates an effect of movement. (The background is blurred
because of slow camera panning.)

Below: The same scene with no blurring

3ds Max provides several ways to generate motion blur. Scene motion blur is
one. Image motion blur is another. For most purposes, image motion blur
on page 7814 or multi-pass motion blur on page 5147  give better results than
scene motion blur. Use scene motion blur whenever you want to strongly
emphasize rapid motion. You can use both image and scene motion blur in
the same rendering.

(Another option, object motion blur on page 7867 , is not meant to simulate a
camera, but to improve the rendered appearance of fast-moving objects.)
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You apply scene motion blur in Video Post on page 6571 . It is one of the options
for a Scene Event on page 6607 . In the Add or Edit Scene Event dialog, turn on
Scene Motion Blur in the Scene Options group, and then adjust the parameters.

Scene motion blur creates trails behind all moving objects by rendering the
entire scene at multiple time increments within each frame, and then creating
the frame by compositing the multiple images together.

Schematic View
Schematic View on page 7197  is a window that lets you see everything in your
scene as a node on a graph. The nodes on page 7862  are repositionable to create
custom configurations.

Use Schematic View to see and select all nodes that share a relationship, such
as a material or instanced modifier. You can perform basic operations on the
nodes such as rename, cut and paste modifiers or materials, or create
hierarchical linkages. You can use Schematic View to see and edit other
relationships such as wired parameters and constraints.

Script
A sequence of instructions used to automate a task. Scripts are typically text
files containing coded instructions for a particular application.

In 3ds Max, the MAXScript utility supports a scripting language.

MAXScript scripts have the file name extension .ms. By default, they are saved
in the scripts folder.

Script Editor Window
A text editing window provided with the MAXScript scripting system. A script
editor window can edit any kind of ASCII text file, but is particularly suited
to building and modifying MAXScript script files.

You open a script editor using the Open Script or New Script commands from
the MAXScript menu.
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Scripted Behavior
A behavior defined by MAXScript. When you use the cognitive controller on
page 4776  with crowd animation on page 4680 , you can add conditional
expressions written in MAXScript that impose changes in behavior.

Scripted Utility Panel
A scripted utility panel is a custom command-panel rollout created using the
MAXScript scripting language. They let you create a graphical user interface
to a MAXScript script.

Scripted utility panels are available through the Utilities drop-down menu in
the MAXScript rollout of the Utilities panel.

Scripts (Motion Flow)
In motion flow mode on page 4426 , a script is a list of clips (BIP files) that are
executed sequentially to animate a character. You can create scripts either
manually or automatically using crowd animation on page 4680 .

Scripting
A scripting language is a programming language embedded in a host
application, and used to automate tasks within the application. 3ds Max
provides MAXScript as its scripting language.

MAXScript controls are located on the Utilities panel.

Seed Value
In NURBS sub-objects, a location in parameter space that is used to resolve
ambiguities in some kinds of sub-object creation. The seed value is a location
on a parent object, and the location nearest to the seed value that satisfies the
creation condition is the one that the software chooses. For a curve, the seed
value is a U location in the curve's parameter space. For a surface, the seed
location is a pair of UV coordinates in the surface's parameter space.
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Seek Behavior
In crowd animation on page 4680 , the Seek behavior lets you specify any object
or objects as a stationary or moving target for delegates. Delegates move toward
the target during the crowd simulation while turning as necessary.

Segment

The arrow and highlight indicate a single segment in a spline.

The portion of a NURBS point curve between two of its control points, or the
portion of a spline between two vertices. (NURBS CV curves don't have
segments, as their control vertices don't lie on the curve.)
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Self-Illumination

The lamp on the right uses self-illumination to brighten the bulb and the glass panes.

Self-Illumination creates the illusion of incandescence by replacing any
shadows on the surface with the diffuse color. At 100 percent, the shadows
are completely replaced by the diffuse color, creating the illusion of
self-illumination.

Unless you use environmental effects, only lights illuminate your scene; they
don't appear in the rendering. You can use self-illuminated materials on objects
that represent lights to provide things like car headlights, and so on.

A self-illumination map lets you use a map to affect the intensity in different
areas of the self-illuminated surface. Like many other map types, only the
intensity of the map values affects self-illumination. White provides the most,
while black blocks the illumination completely.

It's often a good idea to design a self-illumination map to match your diffuse
map. For example, the diffuse map might have small, yellow rectangles to
represent windows, while the self-illumination map consists of matching
white rectangles against black to illuminate the yellow windows.
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TIP To have an object behave as an actual light source (for example, a spline that
models a neon light), use the scanline renderer on page 5949 , photometric lights
on page 4951  with a radiosity solution on page 5976 , and assign an Advanced
Lighting Override material on page 5572  to make the object luminous.

Shaders (mental ray Renderer)
In mental ray, a shader is a function that calculates light effects. There can be
shaders for lights, cameras (lens shaders), materials, shadows, and so on.

In 3ds Max, the mental ray translator provides the functionality of light and
camera shaders. Material shaders correspond to 3ds Max materials.

A number of shaders are provided with 3ds Max. See mental ray Shaders on
page 5801 , mental ray Connection Rollout on page 5289 , and mental ray
Materials on page 5448 .

The mental ray manual, Programming mental ray, describes how to write custom
shaders.

Shaders (Standard Materials)
For a standard material on page 5298 , the shader is the algorithm that controls
how the material responds to light. Shaders especially control how highlights
appear. They also provide a material's color components, and control its
opacity, self-illumination, and other settings. Shaders are often named for
their inventors; they can also be named for the effect they provide. See Shading
Type on page 5169 .
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Samples of different shading for a standard material

1. Anisotropic

2. Blinn

3. Metal

4. Multi-layer

5. Oren-Nayar-Blinn

6. Phong

7. Strauss

8. Translucent

For each material, one of the available shaders is always active. You choose
the shader on the material's Shader Basic Parameters rollout on page 5301 .
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The raytrace material on page 5394  uses a subset of the standard material
shaders: Anisotropic, Blinn, Metal, Oren-Nayar-Blinn, and Phong. You choose
the raytrace material's shader on the material's Raytrace Basic Parameters
rollout on page 5397 .

The other types of materials in 3ds Max don't give you a choice of shader.

Materials (and lights and cameras) used with the mental ray renderer on page
6039  can use mental ray shaders, which are not the same as the standard material
shaders. See Shaders (mental ray Renderer) on page 7925 .

Shadow Maps (Light Objects)

Example of shadow-mapped shadows

A shadow map is a bitmap that the renderer generates during a pre-rendering
pass of the scene. Shadow maps don't show the color cast by transparent or
translucent objects. On the other hand, shadow maps can have soft-edged
shadows, which ray-traced shadows cannot.

A shadow-map is projected from the direction of the spotlight. This method
provides a softer edge and can require less calculation time than ray-traced
shadows, but it's less accurate.

You can adjust the shadow map settings to achieve a sharper shadow. This
involves changing the resolution and the pixel sampling of the shadow's
bitmap. Because shadow-map shadows are only bitmaps, you need to keep in
mind their resolution in relation to your distance from the shadow, and the
detail required by the shadow. If the resolution is too low, and the camera
too close, the shadow might look more like sooty smudges.
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If shadows appear too coarse when you render them, increase the map size.
The size can range from 0 to 10,000. However, be aware that greater size
requires more memory and can take longer to generate. A 4096-line shadow
map occupies 64 MB of memory (4096 x 4096 x 4).

If you have enough RAM to hold the entire scene including shadow maps,
shadows don't affect performance, but if the renderer has to use a virtual
memory swap file, rendering time can slow considerably.

The default shadow map size is 256.

The bitmap used by shadow maps must fill the area covered by the falloff of
the spotlight. The wider the falloff, the coarser the shadow appears. Keep the
falloff as tight as possible given the requirements of your scene.

Shadow Map (mental ray Renderer)
A shadow map is a bitmap that the mental ray renderer generates during a
pre-rendering pass of the scene. Shadow maps can require less calculation
time than ray-traced shadows, but the shadows they generate can be less
accurate.

The mental ray renderer saves shadow maps as ZT files on page 7978 . Shadow
map controls are on the Render Scene dialog > Renderer panel > Shadows &
Displacement rollout on page 6114 .
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Shapes and Splines

Spline

A shape is an object made up of one or more splines. A spline is a collection
of vertices and connecting segments that form a line or curve. By adjusting
values in the vertices, you can make portions of the line curved or straight.

Shapes don't usually appear in the rendered scene. They're used for the
following purposes:

■ As the foundation for extruded objects, by applying an Extrude modifier
to the shape.

■ As the foundation for a spun object, by applying a Lathe modifier to a
shape.

■ As the components that make up a Loft object, by combining a shape as
a path, and one or more shapes as cross-sections along the path.

■ As an animation path for an object by assigning a path constraint to the
object, and then picking a shape as the path.
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■ As one method of linkage for inverse kinematic chains.

You can make shapes renderable to create tubular forms in the rendering.
Renderable shapes don't appear any different in viewports.

Shapes can also be NURBS curves on page 2152 . You can use NURBS curves in
exactly the way you use spline-based shapes. You can also use a NURBS curve
as the basis for a NURBS model that includes multiple curve and surface
sub-objects.

Get Shape (Lofting)

A circle is lofted along a path to construct a tubular shape. Get Shape chooses the
contour spline.

You use Get Shape as a loft creation method when you want the shape to
move to the location of the selected path. For example, you use this method
if you have created a path at the exact location where you want your loft
object to be. You use Get Shape to create a loft at that location.

Get Shape causes the shape to move and rotate to align itself with the current
level of the path. The exact orientation of the shape is controlled by two other
loft settings named Contour and Banking.
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The following describes the orientation of the first shape at level 0:

■ The pivot point of the shape is located on the path at the current path
level.

■ The positive Z axis of the shape is aligned with the tangent to the path at
the current path level.

■ The local Y axis of the shape is aligned with the local Z axis of the path.

Sometimes, aligning the positive Z axis of the shape with tangent of the path
does not produce the result you want. You can flip the orientation of the
shape by pressing Ctrl while getting the shape. Pressing Ctrl aligns the shape
so that the negative Z axis of the shape is aligned with the tangent to the path.

SHP Files
SHP is the 3D Studio R4 (DOS) shape-file format. You can import these files
into 3ds Max.

The .shp file contains polygons created in the 2D Shaper in 3D Studio.

When importing an SHP file that contains multiple shapes, the software gives
you the option to either merge them all into one object or make multiple
incoming objects.

The shape importer looks at the vectors on incoming splines, and if they're
collinear within a couple of percentage points, it changes the angle to a
smoothed Bezier (otherwise, it's a Bezier corner).

Skylight
In the real world, daylight does not just come from direct sunlight; it also
comes from skylight that is scattered through the atmosphere. 3ds Max offers
great realism and accuracy by calculating not only sunlight, but calculating
this scattered light as well.

In 3ds Max, the sky is modeled as a dome of infinite radius placed around the
scene. Daylight computes the illumination of a point in the scene with
reference to all directions around the point where the sky is visible. The sky
brightness is not constant over the sky dome, but rather it changes depending
upon the position of the sun.
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See also:

■ Sunlight on page 7942

■ Sunlight and Daylight Systems  on page 5024

Sliding Footstep
In footstep animation on page 7790 , changing biped foot key parameters enables
the biped feet to move or slide during a footstep period. This feature is also
available for motion-capture file import to allow the biped feet to slide or
pivot. In the viewports, a sliding footstep is displayed as a footstep with a line
through the middle.

Smoothing Groups

Left: The bottle has no smoothing.

Middle: Smoothing is assigned only to the highlighted group of faces.
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Right: The bottle is smoothed using three different smoothing groups: on the body,
the neck, and the top edge.

Smoothing groups define whether a surface is rendered with sharp edges or
smooth surfaces.

Smoothing groups are numbers assigned to the faces or patches of an object.
Each face or patch can carry any number of smoothing groups up to the
maximum of 32. If two faces or patches share an edge and share the same
smoothing group, they will render as a smooth surface. If they don't share the
same smoothing group, the edge between them will render as a corner.

You can manually change or animate the threshold values for smoothing
group assignments using such tools as Editable Poly (Polygon/Element)  on
page 2091  and the Edit Mesh modifier on page 1283 .

SMPTE
SMPTE (Society of Motion Picture and Television Engineers) is the standard
time display format for most professional animation work.

From left to right, the SMPTE format displays minutes, seconds, and frames,
delineated by colons. For example:2:16:14

represents 2 minutes, 16 seconds, and 14 frames.

As you move through time in a SMPTE display, when the seconds field
increments, the frames field recycles to 0 and starts over. For example, given
an NTSC frame rate of 30 frames per second, as you move through time, the
frames field counts from 0 to 29, at which point the seconds field increments
by 1, and the frames field begins again at 0.

As with the Frames display format, the SMPTE format lets the time slider move
at single-frame increments.

Space Warp Behavior
In crowd animation on page 4680 , the Space Warp behavior lets you assign a
space warp, such as Wind or Gravity, to one or more delegates. The Space
Warp behavior can use any space warp in the Forces category. These space
warps treat delegates on page 7755  as if they were particles.
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You can also use the Space Warp behavior to bind delegates to the Vector
Field space warp on page 4837  provided with character studio. This space warp
causes delegates to avoid an object while following its contours.

Space Warps
Space warps on page 2603  are objects that provide a variety of "force field" effects
on other objects in the scene.

Space warps themselves are not renderable. You use them to affect the
appearance of other objects, sometimes a large number of objects at the same
time. Some space warps deform object geometry by generating ripples, waves,
or explosions. Other space warps are meant specifically for use with particle
systems, and simulate natural effects such as wind blowing snow or rain about,
or a rock in the path of a waterfall.

Space warps behave somewhat like modifiers, except that a space warp
influences world space, rather than object space as geometric modifiers do.

When you create a space warp object, viewports show a representation of it.
You can transform the space warp as you do other 3ds Max objects. The
position, rotation, and scale of the space warp affect its operation.

To have an object or selection set be affected by a space warp, you bind the
object to the space warp. A space warp has no effect on objects unless the
objects are bound to it. When an object is bound to a space warp, the warp
binding appears at the top of the object's modifier stack. A space warp is always
applied after any transforms or modifiers.

When you bind a space warp to multiple objects, the space warp's set of
parameters affects all the objects equally. However, each object's distance from
the space warp or spatial orientation to the warp can change the warp's effect.
Because of this spatial effect, simply moving an object through warped space
can change the warp's effect.

You can also use multiple space warps on a single object or objects. Multiple
space warps appear in an object's stack in the order you apply them.

Spawn Particles
In Particle Flow on page 2713 , spawn particles are new particles that are
generated from existing particles ( parent particles on page 7885 ) in a process
called spawning. You can use the Spawn test on page 2912  to create spawn
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particles arbitrarily, or the Collision Spawn test on page 2885  to create spawn
particles as the result of physical interaction between a parent particle and a
deflector.

Specular Color

Changing specular color tints highlights on the shiny surface of the spacecraft.

Specular color is the color of highlights on a shiny surface. The highlights are
reflections of the lights that illuminate the surface. For a naturalistic effect,
set the specular color to the same color as the key light source, or make it a
high-value, low-saturation version of the diffuse color.

In 3ds Max, you can set the specular color to match the diffuse color. This
gives a matte effect, making the material appear less shiny.

Matching specular color to the diffuse color makes the surface less shiny.
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Speed Vary Behavior
In crowd animation on page 4680 , the Speed Vary behavior is useful for objects
whose velocity changes as they move, such as strolling tourists who might
occasionally slow down to do some sightseeing.

Splice
The term splice means to cut a sequence, insert a segment and join the cut
ends to the segment. It can also mean a simple joining of ends to a segment.

In character studio, you can splice a footstep sequence. You do this by copying
a footstep sequence, then moving it to the middle or end of another footstep
sequence and placing it there. The ends of the segments are joined
automatically to make a smooth footstep sequence.

You can use splicing to extend your footstep animation or build a cyclic
sequence.
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Spline

Top: Spline

Middle: A segment of the spline

Bottom: Vertices of the spline

A type of curve that is interpolated between two endpoints and two or more
tangent vectors. The term dates from 1756, and derives from a thin wood or
metal strip used for drafting curves in architecture and ship design.

Spline Dynamics
Spline Dynamics is a biped dynamics on page 7727  option located on the
Dynamics & Adaptation rollout on page 4336 . Choosing Spline Dynamics creates
keys for the biped's center of mass without calculating gravity or balance
(Dynamics Blend=0.0 and Balance Factor=0.0).

Glossary | 7937



Startup Script
When 3ds Max first starts, MAXScript searches for any startup script files,
which it then automatically loads and runs. This feature is useful if you have
function libraries you always use and want preloaded, or if you want to
establish custom UI settings, define scripted plug-ins, or load scripted utility
rollouts.

MAXScript first searches for .mcr (macroScript definition files) in the
ui\macroscripts directory. These macroScript definitions are not compiled at
this time; rather they are just scanned to identify the macroScripts that have
been defined.

MAXScript next searches for .ms, .mse, and .mzp files in the plug-in path
directories (defined on the Configure System Paths dialog on page 7523  and
Configure User Paths dialog on page 7520 ) and their subdirectories, and compiles
these files. The base scene and user interface have not been created at this
point, so no viewport or scene commands should be executed in these files.
These files should primarily define scripted plug-ins and utility functions.

Any utility functions used by the macroScripts defined when reading the
ui\macroscripts directory should be defined in a .ms or .mse file in one of these
directories. You can prevent a nested directory from being scanned by placing
its name in parentheses, for example "(old-versions)", allowing you to enable
and disable scripts in handy directory-based groupings.

At this point, 3ds Max creates the base scene and user interface. Any macro
scripts used by buttons in the user interface are compiled at this time.

The automatic loading of the following startup script files can be deactivated
by turning off the Auto Start MAXScript option in the MAXScript page of the
Preferences dialog, as described in MAXScript Preferences on page 7574 .

MAXScript first searches for a file named startup.ms in the following directories,
in this order:

1 The Scripts directory (defined on the Configure User Paths dialog > File
I/O panel)

2 The Startup Scripts directory (defined on the Configure System Paths
dialog)

3 The 3ds Max executable main directory

4 The Windows NT 32-bit system directory (system32)

5 The Windows 16-bit system directory (system)
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6 The Windows directory

7 The directories that are listed in the PATH environment variable

MAXScript stops searching when it finds the first occurrence of startup.ms.

MAXScript then recursively scans the Startup Scripts directory (defined on the
Configure System Paths dialog) and any nested directories for .ms, .mse, and
.mzp script files and loads them. In this pass, any script files with the name
startup.ms are ignored. You can prevent a nested directory from being scanned
by placing its name in parentheses, for example "(old-versions)", allowing you
to enable and disable scripts in handy directory-based groupings.

If you specify a script to run in the command line (-U MAXScript script_name),
the script is executed at this point. (See the MAXScript Reference topic
“Running Scripts from the Command Line”).

Sub-Object

Left: A selection of face sub-objects

Middle: A selection of edge sub-objects
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Right: A selection of vertex sub-objects

A sub-object s a subset of an object's geometry. Many objects have various
types of sub-objects that you can work with independently. For example, an
editable mesh object's on page 1990  sub-objects are vertices, edges, faces,
polygons, and elements. To access sub-objects, go to the Modifier panel. In
the modifier stack display, click the plus-sign button to display an object's
hierarchy, and then choose the sub-objects level from the hierarchy. At the
sub-objects level you can select sub-objects, transform the selections, apply
modifiers, and so on.

Many topics in the online reference deal with sub-objects. To see a list of
sub-object-related topics, search on the term “sub-object” (include the quote
marks in the keyword).

Sub-Object Level

Edge sub-objects level chosen while editing a mesh.

Some types of objects let you change to a sub-object level to edit their
component parts. For example, editable meshes on page 1990  have Vertex,
Edge, Face, Polygon, and Element sub-object levels. NURBS models on page
2152  can have Surface, Curve, Point, Surface CV, Curve CV, and Import
sub-object levels.
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You change the active sub-object level using the Modifier Stack display on
page 7427  on the Modify panel.

Subtractive Opacity

Sphere on the right uses subtractive opacity.

Subtractive opacity darkens colors behind the material by subtracting the
material's colors from the background colors.

If you simply want to reduce the apparent opacity of a material, while
maintaining the color values of its diffuse (or mapped) properties, use
subtractive opacity.

See also:

■ Additive Opacity on page 7705
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Sunlight
The Sun is modeled as a parallel light source, which makes the incident
direction of sunlight constant over all surfaces in the scene. You can specify
the direction and intensity of the sun directly. Alternatively, the direction
and intensity of the sun can be calculated based on geographical location,
time, and sky condition settings.

See also:

■ Skylight on page 7931

■ Sunlight and Daylight Systems  on page 5024

Super Black
Super Black limits the darkness of rendered geometry. This option is used for
video compositing. When compositing, you need pure black for the
background, but overlaying objects need to be less than pure black so that
you can still see exactly where they are. Also, some video systems have
problems with black that has RGB values of 0,0,0, and consider it an "illegal"
color.

Unless you're sure you need it, leave Super Black tuned off in the Render Scene
dialog.

The scanline renderer uses the value of the Super Black preference as a
threshold for the darkness of the rendered scene. For example, if you're
rendering a heavily shadowed object against a black background, although
the background will be rendered as pure black, the deepest shadows on the
object will be no darker than the intensity level specified by the Threshold
spinner (default is 15).

NOTE If the threshold spinner is set too high, it will artificially raise low-blended
values. This can ruin antialiasing effects in the renderer.

Supersampling
Supersampling is one of several antialiasing techniques that the software
performs. Textures, shadows, highlights, and raytraced reflections and
refractions all have their own preliminary antialiasing strategies. Supersampling
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is an optional additional step that provides a "best guess" color for each
rendered pixel. The supersampler's output is then passed on to the renderer,
which performs a final antialiasing pass.

See also:

■ SuperSampling Rollout on page 5285

Support Period
In footstep animation on page 7790 , the period where one or both of the biped
feet are on the ground.

Surface Arrive Behavior
In crowd animation on page 4680 , the Surface Arrive behavior is similar to the
Seek behavior: it lets you specify one or morer objects as a stationary or moving
target for delegates. The principal difference is that you can use the Approach
settings to specify an intermediate target. After reaching this location, the
delegates will then make their final approach to the ultimate target surface.
An example would be birds flying over a row of telephone poles, and then
each one dropping to land on top of a different pole.

Surface Follow Behavior
In crowd animation on page 4680 , the Surface Follow behavior moves delegates
with respect to object surfaces. Target objects can be animated. For example,
you can apply an animated Noise modifier to a patch grid to simulate a choppy
water surface, and objects guided by Surface Follow will stay on top.

Synthesis, Synthesize
Synthesizing is the process of computing (solving) motions for crowd
simulations on page 4680 . The resulting simulation is a synthesis.
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Talent Figure Mode 
When you work with motion capture on page 4493 , after you load a raw marker
file on page 7841 , you can turn on Talent Figure mode to scale the biped relative
to the markers. Calibration for the entire marker file takes place when you
exit Talent Figure mode.

Tangents
The tangent of a function curve affects the interpolated values between the
keys of an animation. Most animation controllers use fixed tangents to define
the function curve at a key location.

By default, 3ds Max assigns smooth tangents to the keys in a Position function
curve. This is the reason that an animated object moves in smooth curves
through the key frames. 3ds Max assigns smooth tangents because they usually
provide the most natural motion.

Of course, you also need a way to add some corners and abrupt turns when
you need them. The Linear controller on page 3118  uses a discontinuous tangent
that points at the preceding and following keys, producing an abrupt change
in motion at that key.

The two large flyout buttons at the bottom of the Key Info dialog provide five
different types of predefined tangent types on page 3054 , plus a sixth type that
lets you create your own custom tangents.

If you look at a single key dot and the line running through it, the line on
the left side of the key dot is the incoming tangent, and the line on the right
is the outgoing tangent. Using the tangent flyout buttons, you can assign a
different tangent type to the incoming and the outgoing lines for each key
dot.

The button on the left assigns the incoming tangent at the left side of the
selected key dot, and the button on the right assigns the outgoing tangent on
the right side of the selected key dot.

TCB (Biped)
TCB is short for Tension, Continuity, and Bias. These parameters quantify the
traditional animation technique of ease in and ease out (also known as “slow
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in and slow out”). In freeform animation on page 7792  of a biped, you can use
them to change the timing of a limb's movement from key to key.

The TCB controls are in the TCB section of the Key Info rollout on page 4288
.

TCB (Tension, Continuity, Bias)
The TCB Position controller provides Tension, Continuity, and Bias controls
of the splines of a function curve.

TCB Controllers on page 3183  also produce curve-based animation much like
the Bezier controllers on page 3063 . However, TCB controllers do not use
tangent types or adjustable tangent handles. They use numeric values to adjust
the Tension, Continuity, and Bias of the animation.

Tension Controls the amount of curvature in the animation curve.

High Tension produces a linear curve. It also has a slight Ease To and Ease
From effect.

Low Tension produces a very wide, rounded curve. It also has a slight negative
Ease To and Ease From effect.

The default value of 25 produces an even amount of curvature through the
key.

Continuity Controls the tangential property of the curve at the key. The
default setting is the only value that produces a smooth animation curve
through the key. All other values produce a discontinuity in the animation
curve causing an abrupt change in the animation.

High Continuity values create curved overshoot on both sides of the key. Low
Continuity values create a linear animation curve.

Low continuity creates a linear curve similar to high tension except without
the Ease To and Ease From side effect.

The default value of 25 creates a smooth continuous curve at the key.

Bias Controls where the animation curve occurs with respect to the key.

High Bias pushes the curve beyond the key. This produces a linear curve
coming into the key and an exaggerated curve leaving the key.

Low Bias pulls the curve before the key. This produces an exaggerated curve
coming into the key and a linear curve leaving the key.

The default value of 25 distributes the curve evenly to both sides of the key.
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Tendons
When you use Physique on page 4522 , after you adjust envelope parameters
for good mesh deformation, you can use tendons on page 4666  to control the
amount of skin stretching across multiple links. While envelopes provide
smooth skin deformations, tendons provide additional stretching in much
the same way that actual human tendons might create pulling in the wrist
(several joints away) when the fingers are moved.

Tension, Continuity, Bias (Biped)
Tension, Continuity, and Bias (TCB) are parameters that quantify the
traditional animation technique of ease in and ease out (also known as “slow
in and slow out”). In freeform animation on page 7792  of a biped, you can use
them to change the timing of a limb's movement from key to key.

The TCB controls are in the TCB section of the Key Info rollout on page 4288
.
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Terrain

Using contours to build a terrain

Creates terrain objects on page 703  from contour line data. You select editable
splines representing elevation contours and 3ds Max creates a mesh surface
over the contours. You can also create a "terraced" representation of the terrain
object so that each level of contour data is a step, resembling traditional study
models of land forms.

When you import an AutoCAD drawing file to use as contour data, 3ds Max
names each object based on the AutoCAD object's layer, color, or object type.
3ds Max appends a number after each name. For example, an AutoCAD object
on the layer BASE becomes BASE.01.
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After importing the contour data, selecting the objects and clicking the Terrain
button, 3ds Max moves all the selected objects out of the scene and into the
terrain object. Other splines in the selection are treated in the same way as
by the Move copy method. You can only use these splines as operands of the
terrain object. This is appropriate if you create splines in order to create a
terrain object and have no further use for them.

Test
The basic function of a test in Particle Flow is to determine whether particles
satisfy one or more conditions, and if so, make them available for sending to
another event. When a particle passes a test, it is said to “test True.” To send
eligible particles to another event, you must wire on page 7971  the test to that
event. Particles that don't pass the test (“test False”) remain in the event and
are repeatedly subjected to its operators and tests. Or, if the test isn't wired to
another event, all particles remain in the event.

A list of all tests in Particle Flow is available in the Tests topic on page 2877 .

See also:

■ Operator on page 7873

Texel
A texel (short for Tex ture El ement) is the base unit of a textured graphic,
which defines the surface of a three-dimensional object. The base unit of the
surface of a 3D object would be a texel, while a 2D object would consist of
pixels on page 7896 .

Ticks
Ticks are the way 3ds Max views increments of time. There are 4800 ticks in
a second, so you can actually access time down to 1/4800th of a second.

Given a standard, NTSC video frame rate, there are 30 frames in a second, and
therefore 160 ticks in each frame.

When you use the FRAME:TICKS display format, time is shown in frames and
ticks, delineated by a colon. This format lets you adjust the time slider in
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sub-frame increments of 1/160th of a frame. As you move through time, the
ticks field counts from 0 to 159, at which point the frames field increments
by one, and the ticks field returns to 0.

You can step forward or backward at single increments by clicking the
single-frame buttons among the playback buttons.

When you use the MM:SS:TICKS Display format, you see minutes (MM),
seconds (SS), and ticks, each separated by colons.

As you move through time in this display format, the ticks field counts from
0 to 4799, at which point the seconds field increments and the ticks field
returns to 0.

You can step forward or backward at single increments by clicking the
single-frame buttons on either side of the playback button.

Tile/Mirror

Left: A bitmap

Middle: Tiling the bitmap

Right: Tiling and mirroring the bitmap

Tiling and mirroring are useful for creating patterns based on a simple image.
Use them when you need wallpaper and other repetitive designs.
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The Tile option in the Material Editor is on by default, repeating the image
along the U and V directions. You can use the Tiling values to scale the map
image. Setting negative Tiling values increases the size of the image.

You can also set tiling values in the UVW Map modifier. These settings are in
addition to the tiling values you set for the map in the Material Editor. If the
map's base tiling parameter has a value of 2.0 and the UVW Map modifier has
a tiling value of 3.0 for the same axis, the net result is 2.0 x 3.0 = 6.0. To avoid
confusion about where the tiling is coming from, you may want to set the
map's tiling in its base parameters or with the UVW Map modifier, but not in
both locations.

The Mirror option is a variation on the Tile option. Tile repeats the image
side-by-side, while Mirror flips the image repeatedly.

Topology
When objects and shapes are created, each vertex and/or face is assigned a
number. These numbers are used internally to determine which vertices or
faces are selected at any given time. This numerical arrangement is called
topology.

When you select vertices or faces and apply a modifier to the selection, the
modifier stack keeps track of which faces/vertices the modifier affects. If you
later return to the selection level of the stack and change the selection, you
change the topology to which the modifier is applied.

The term topology refers to the structure of faces and vertices as well as their
numbers.

For example, by carefully setting various parameters, you could make a box
and a cylinder with the same number of vertices. You might then think you
could use the box as a morph target for the cylinder. However, because the
two objects are created with such different methods, the vertex numbers on
these objects would be ordered very differently. Morphing causes each
numbered vertex to go to its corresponding place on the morph target. In a
case such as this, with two objects with such different topology, morphing
from one to the other would cause the object to crumple or turn inside out
as it morphs.
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Topology-Dependent Modifier
Topology-dependent modifiers perform operations on explicit, topological
sub-object selections. The Edit Mesh and Mesh Select modifiers are examples
of modifiers that perform operations or selections on explicit vertex or face
numbers. When these modifiers are present in the stack, you can adversely
affect their results if you visit previous stack operations and change the
topology (the number and order of faces and vertices) being passed to them.
When you do this, a topology-dependence warning alerts you to the situation.

Touch
In footstep animation on page 7790 , the state of the biped foot on the first
frame of a footstep.

Track
A track is a linear representation of animation occurring over time. You can
think of a track as a long, straight railroad track, with the animation start time
at one end, and the finish time at the other. Keys are placed on the track at
intervals that correspond to the time along the track.

The term track is used in several areas of character studio, including the
following:

■ Each animatable object and parameter in 3ds Max and character studio
has its own animation track, which you can view and edit in Track View
on page 4158 .

■ Tools are available especially for working with biped tracks. The center of
mass is unique in that it has separate tracks for horizontal and vertical
animation, which you can select on the Motion panel > Track Selection
rollout on page 4270 . You can copy and paste tracks on page 4233  on biped
objects to other bipeds with the Copy/Paste rollout on page 4308 .

■ In the Keyframing Tools rollout on page 4301 , you can clear all animation
or just selected tracks.

■ In the Motion Mixer on page 3621 , the linear areas that hold motion clips
are called tracks. Several tracks can be stacked on top of one another to use
animation from all tracks at the same time.
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Track View
Track View provides a visual representation of animation keys, allowing you
to view, edit, copy and adjust one or several keys at a time. This is where you
control the timing of your animation, through the manipulation of keys,
curves and ranges. You can also assign animation controllers to interpolate
or control all the keys and parameters for the objects in your scene.

Track View has two windows, a Controller window and a Key window. The
Controller window shows the hierarchy of linked objects, as well as the
modifier stack and transform tracks. The Key window displays keys, curves
and ranges. Keys are color coded to show what is animated.

Track View uses two different modes. Curve Editor mode on page 3441  displays
key interpolation as curves, and allows you to edit the curves. Dope Sheet
mode on page 3442  displays the animation as a spreadsheet of keys and ranges.
Dope Sheet has two modes, Edit Key and Edit Ranges.

Trackgroup
In the Motion Mixer, motions are placed on tracks, and the tracks are organized
into trackgroups. In other words, each trackgroup is a holder for one or more
tracks. Each trackgroup can be filtered so the tracks within it affect only certain
parts of the biped, such as its arms or legs. Every biped in the Motion Mixer
can have multiple trackgroups, each with its own selection of biped parts. See
Adding Tracks to the Mixer on page 3626  and Filtering Mixer Tracks on page
3637 .

Track View Hierarchy Icons
The Track View hierarchy, as displayed in the Controller window, follows the
traditional example of organizational headings in an outline. The highest
levels of the hierarchy represent the main groupings in 3ds Max of Sound,
Environment, Materials, Render Effects, and Objects. Lower levels of the
hierarchy progress through the details of your scene, such as individual
materials, material maps, and map parameters.

Each type of item in the Track View Hierarchy List is represented by an icon.
You can use these icons to quickly identify what each item represents.
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Sound Indicate sound parameters. 3ds Max provides only one sound
source in Track View.

 Material Indicates material definitions. All branches below a material
definition are part of that material. Because a material can be composed of
multiple materials it is possible to have nested material definitions in Track
View. Icons also appear in an object's modifier branch when a material is
assigned to an object.

Map Indicates map definitions. All branches below a map definition
are part of that map. This includes values used by parametric maps and other
map definition that are part of a map tree.

Object Indicates objects in the scene. Branches below the square icon
contain linked descendents of the object. Branches below the circle icon beside
a yellow cube contain transforms and modifications applied to the object.

Modifier Indicate modified objects and Space Warp bindings. Branches
below a modifier contain the modifier's sub-objects and parameters.

Controller Indicate animation controllers. Controllers are the animation
workhorses of Track View. They contain the animated values for all parameters
and are the only item in the Hierarchy list that can have a track containing
keys. Every controller has its own individual icon. Some examples:

■  Position controller

■  Rotation controller

■  Scale controller

Certain types of controllers can contain other controllers. Examples of these
are Transform Controllers and List Controllers.
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Tracks
Every item in the Track View hierarchy has a track that displays what happens
to the item over time.

Animation track displayed in track bar below time slider

There are two types of tracks:

■ Range tracks indicate the range of time over which the animation occurs.
In 3ds Max, range display is turned off by default. To display the range,
select the keys in the track bar, then right-click and choose Configure>
Show Selection Range.

■ Range tracks indicate when items below the track are animated. A range
bar in the track displays the range of time over which the animation occurs.

■ Animation tracks contain the actual animated values for an item. Only
controller items have an animation track.

The values in an animation track are usually displayed as keys. Some controllers
don't use keys and instead display their values as a range bar or some other
graphic symbol. For example, the Wave Form item displays a sound file as a
two-channel sound wave.

Animation tracks are also the only track type that can be displayed as a
function curve.
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Trajectory

Scooter following a trajectory

Whenever an object moves through world space, you can view its trajectory.
A trajectory is the visible path the object makes because of its movement. You
can think of a trajectory as a three-dimensional function curve for the Position
track of an object.

Object trajectories appear with the following properties:

■ The trajectory curve is drawn in blue .

■ Frame increments are displayed as yellow dots on the curve.

■ Position keys are displayed as white boxes surrounding the appropriate
frame dot on the curve.

■ Selected keys are displayed in gray.

In 3ds Max trajectories are created from animated objects. You must animate
the object first in order to create the trajectory.
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The Path constraint on page 3222  lets you picks a spline in the scene to use as
a motion path for an object. The spline becomes the object's explicit trajectory.

Trajectory (Biped)
The path an object follows as it moves through space. In 3ds Max, you can
think of a trajectory as a three-dimensional function curve for the Position
track of an object.

When you animate a biped on page 4069 , you can turn on the display of its
trajectory. See Trajectory Display on page 4241 .

Transform Gizmo
A gizmo on page 7800  that is displayed in viewports and provides a visual aid
when you transform objects.

Move gizmo
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Rotate gizmo

Scale gizmo
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Transforms

Moving, rotating, and scaling a figure

When you create any object, 3ds Max records its position, rotation, and scale
information in an internal table called a transformation matrix. Subsequent
position, rotation, and scale adjustments are called transforms.

An object's actual position within the world coordinate system is always
calculated in relation to its internal, or local coordinate system, which is based
on the object's transformation matrix. The origin of the local coordinate
system is the center of the object's bounding box on page 7736 .

An object can carry any number of modifiers, but only one set of transforms.
Although you can change transform values from frame to frame, each object
always has only one position, one rotation, and one scale transform.

You can animate your transforms by turning on the Auto Key button and
then performing the transform at any frame other than frame 0. This creates
a key for that transform at the current frame.

Transition
In the Motion Mixer and in Motion Flow, a transition is a gradual change
between two motion clips. You can set the frames at which the transition
starts and ends in each clip.

To find out how to use transitions in the Motion Mixer, see Working with
Transitions on page 3646 . For information on transitions in Motion Flow, see
Customizing Transitions on page 4444 .
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Transition Track
A Motion Mixer track that allows you to stack clips on top of one another,
and to create automatic transitions between them. Transitions on these tracks
are similar to those in a Motion Flow network. Compare with a Layer track
on page 7825 , which allows cuts only between clips. See Adding Tracks to the
Mixer on page 3626 .

Translucency

Glass on the right has a light green translucency.

A translucent material transmits light, but unlike a transparent material, it
also scatters the light so those objects behind the material cannot be seen
clearly.

Raytrace materials on page 5394  can simulate translucency. A Raytrace material's
Translucency color component ignores surface normal directions, giving the
effect of light scattering.
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You can also obtain translucency effects using the Standard material's on
page 5298 Translucent shader on page 5339 .

Truecolor
Describes hardware and software that can support up to 16 million color
values. Also known as 24-bit color, or 32-bit color when saved with alpha
channel data on page 7709 .

Twist Links 

Twist Links Mode active (left) and Twist Links Mode inactive (right)

When you turn on Twist Links Mode (on the Bend Links rollout on page 4284
), a rotation in local X applied to a single chain link is incremented equally
throughout the rest of the chain. The remaining two axes (Y and Z) are not
affected by this rotation.
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Universal Naming Convention (UNC)
The 3ds Max network rendering system uses the Universal Naming Convention
(UNC) to identify directories and files. UNC names begin with a double
backslash and do not include a drive letter. This is the convention:

\\machine_name\directory\subdirectory\filename

To simplify network rendering, use UNC names whenever possible within a
3ds Max scene, even if the directory is on the local machine.

TIP When entering UNC names, leave off the \\ before the file name until you've
entered the entire path and file name. This eliminates search delays when entering
UNC path names into file selection dialogs.

Some networks require drive letters instead of UNC names. Directories on
such networks can be mounted as drive letters and shared over the network.
See Mounting a Directory on page 6276 .
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UVW Coordinates

Local UV coordinates shown on a surface

Most material maps are a 2D plane assigned to a 3D surface. Consequently,
the coordinate system used to describe the placement and transformation of
maps is different from the X, Y, and Z axis coordinates used in 3D space.
Specifically, mapping coordinates use the letters U, V, and W; the three letters
preceding X, Y, and Z in the alphabet.

The U, V, and W coordinates parallel the relative directions of X, Y, and Z
coordinates. If you look at a 2D map image, U is the equivalent of X, and
represents the horizontal direction of the map. V is the equivalent of Y, and
represents the vertical direction of the map. W is the equivalent of Z and
represents a direction perpendicular to the UV plane of the map.

You might question why you need a depth coordinate like W for a 2D plane.
One reason is because it's sometimes useful to be able to flip the orientation
of a map, relative to its geometry. To do this, you need the third coordinate.
The W coordinate also has a meaning for 3-dimensional procedural materials.
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Vector Field
In crowd animation on page 4680 , a vector field is a special type of space warp
that crowd members can use to move around irregular objects such as a curved,
concave surface. The vector field gizmo, a box-shaped lattice, is placed and
sized so that it surrounds the object to be avoided. The vectors are generated
from the lattice intersections. These vectors are, by default, perpendicular to
the surface of the object to which the field is applied; if necessary, you can
smooth them out with a blending function. The crowd members move around
the object by traveling perpendicular to the vectors.

Vector Field Space Warp
In crowd animation on page 4680 , you can use the Vector Field space warp
on page 4837  as a space warp behavior. A vector field allows crowd members
to move automatically around obstacle objects of any shape, following the
object contours. It also lets crowd members move within the confines of an
enclosed space, such as a room, while avoiding the walls. You can also use
Vector Field space warps to control particle motion.

The Vector Field space warp works by generating a number of vectors that
surround an object and are perpendicular to its surface. Crowd animation
then uses these vectors to guide delegates around the object by moving them
perpendicular to the vectors.
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Vectors and Vector Handles

Kinds of vector handles:

1. Corner

2. Smooth

3. Bezier

4. Bezier corner

Vectors are secondary control points connected to vertices on a spline or patch
object. They are also referred to as handles or vector handles.

Vector handles are visible as small green squares when you select a vertex.
However, if the Vectors filter is checked (for a patch object), handles can be
selected and transformed without selecting a vertex first. A transform cursor
appears when you move onto a vector.

Each vertex in a shape can be one of four types:

Smooth Forces the segments into a smooth curve tangent to the vertex.

Corner Allows the segments on either side of the vertex to be at any angle.

Bezier Provide handles, but forces the segments into a tangent through the
vertex.

Bezier Corner Provides handles, and allows the segments on either side of
the vertex to be any angle.
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Velocity Interpolation
One method of interpolation used in motion flow editing on page 4426 . By
default, in a transition between two motion clips, velocity is interpolated to
blend smoothly between clips. If transitions are optimized, then a sophisticated
algorithm is used that minimizes sliding feet.

Vertex
A vertex (plural form: vertices) is a single point whose sole property is its
position in 3D space, which is typically defined by values for the X axis, Y
axis, and Y axis. Vertices form the basic structure of geometric objects in 3ds
Max, including mesh objects, splines, NURBS, and patches.

Video Safe Frame

Safe frame borders show which portions of a viewport will be visible when rendered
to video.

The Video Safe Frame  provides a guide to help avoid rendering portions of
your image that might be blocked in the final output.
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For example, to ensure that no unintentional black areas are visible on a
television screen, broadcasters intentionally "overscan" the video image. The
result is that portions of an image around the edges are not visible on a typical
set. In addition, portions of images on 35mm slides can be partially covered
by the slide mounts.

You can adjust the size of the safe frame as a percentage of the outer display
rectangle with the Safe-Frame controls in the Viewport Configuration dialog.
Depending upon its size, the safe frame can be used as the equivalent of a
"title safe frame" (the area inside which it is safe to display titles), or an "action
safe frame" (the area inside which action may occur without significant loss
of information).

To view the frames, choose Show Safe Frame from the viewport right-click
menu (displayed when you right-click the viewport label). Three rectangles,
one yellow, one green, and one pale blue, appear in the camera viewport. The
outer, yellow video rectangle is the area and aspect ratio of your current display.
The middle, green rectangle is the action safe zone. The inner, pale blue
rectangle is the title safe zone.

Choose Show Safe Frame again to turn off the display.

Viewport (Interactive) Renderer
The interactive renderer, used for the viewports, is designed for speed so you
can easily manipulate your objects in a shaded environment. It's not the same
as the production renderer, which is used for your final images. Therefore, a
number of effects that are available to the production renderer will not show
up in the viewports.

When you design your materials, for example, you have four levels of visual
feedback. The lowest level is the shaded viewport. The next level is an
ActiveShade viewport (or floater). The next level is the sample slot, which uses
the production renderer to display the sample sphere. The highest level is the
rendered scene, which uses the production renderer to display the scene.

A single material can contain any number of maps.

Because viewing mapped materials slows the viewport display, it's up to you
to decide which map (if any) you want to display. To display a specific map,
you go to that map's level in the Material Editor, and then turn on its display.
(If you later go to a different map in the same material, and turn its display
on, the other map is automatically turned off.)
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VIZBlock
A VIZBlock is a compound object similar to a nested AutoCAD block. It is used
for organizing linked data from DWG files. When AutoCAD data is linked to
3ds Max, you need to decide how the AutoCAD entities are to be organized
in the scene. AutoCAD drawings are commonly organized by layers, blocks,
and entities, and 3ds Max scenes are organized by hierarchies of objects.

VPX Files
VPX (Video Post sequence) files contain all the information relating to the
queue and all associated settings and references. They have the file extension
.vpx and are stored by default in the 3ds Max \vpost folder.

All of the Video Post configuration data, queue events, and queue event
external data is saved with the MAX file also, however saving it to a separate
file allows you to use the same Video Post settings in different scenes, and
also allows you to share sequences with other 3ds Max users.

VUE File
A VUE (.vue) file is an editable ASCII file. You create a VUE file using the VUE
file renderer instead of the default scanline renderer.

A VUE file contains a sequence of frames to render. Each frame is described
by a sequence of commands, beginning with a "frame" command, which
specifies the frame number, and ending with a viewport command, which
specifies the view to render (such as "top" or "camera"). Between these two
commands, there can be any number of "transform", "light", and "spotlight"
commands.

NOTE VUE files created with 3DS DOS could also contain "morph" commands.
This is not supported in 3ds Max because the 3ds Max exporter doesn't export
morph targets.

The VUE file commands are as follows:

frame <n>

transform <object name> <transform matrix>

light <light name> <x> <y> <z> <r> <g> <b>
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spotlight <light name> <x> <y> <z> <tox> <toy> <toz> <r> <g> <b> <hot angle>
<falloff angle> <shadow flag>

top <x> <y> <z> <width>

bottom <x> <y> <z> <width>

left <x> <y> <z> <width>

right <x> <y> <z> <width>

front <x> <y> <z> <width>

back <x> <y> <z> <width>

user <x> <y> <z> <horiz> <vert> <roll> <width>

camera <x> <y> <z> <tox> <toy> <toz> <roll> <focal>

Frame Command

Begins each frame description. Has a single parameter: the frame number.

Transform Command

Transforms the specified object.

The first parameter is the name of the object. This is the name as it appears
when you use 3ds Max, but enclosed in double quotes.

The second parameter is a transform matrix. This consists of 12 real numbers:

T1 T2 T3 T4 T5 T6 T7 T8 T9 T10 T11 T12

The VUE file treats these as if they were arranged in a 4 x 4 matrix (M):

T1 T2 T3 0

T4 T5 T6 0

T7 T8 T9 0

T10 T11 T12 1

The first nine values, T1–T9, describe rotation and scaling. The last three,
T10–T12, describe a move, in world coordinates.

The VUE file renderer transforms the points of the object by
post-multiplication:| X' Y' Z' 1| = | X Y Z 1 | * M
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Omni Light Command

Controls the location and color of an Omni light.

The first parameter is the name of the light. This is the name as it appears
when you use 3ds Max, but enclosed in double quotes.

The next three parameters, <x>, <y>, <z>, are the light's location.

The next three parameters, <r>, <g>, <b>, are the light's color. The color values
are normalized to range between 0.0 and 1.0.

The last parameter, <shadow flag>, parameter is 1 if the light casts shadows,
0 otherwise.

Spotlight Command

Controls the location, color, and other characteristics of a target spotlight.

The first parameter is the name of the light. This is the name as it appears
when you use 3ds Max, but enclosed in double quotes.

The next three parameters, <x>, <y>, <z>, are the light's location.

The next three parameters, <tox>, <toy>, <toz>, are the location of the light's
target.

The next three parameters, <r>, <g>, <b>, are the light's color. The color values
are normalized to range between 0.0 and 1.0.

The <hot angle> parameter is the angle of the light's hot spot, in degrees.

The <falloff angle> parameter is the falloff angle, in degrees

The <shadow flag> parameter is 1 if the light casts shadows, 0 otherwise.

Orthogonal Viewport Commands

These commands render a particular view—top, bottom, left, right, front, or
back.

The <x>, <y>, <z> parameters are the coordinates of the center of the view.

The <width> parameter is the width of the rendered image, in world units.

User Viewport Command

Renders the user view.

The <x>, <y>, <z> parameters are the coordinates of the center of the view.
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The <horiz> parameter is the horizontal angle, in degrees.

The <vert> parameter is the vertical angle, in degrees.

The <roll> parameter is a placeholder for the roll angle—but this is an "empty,"
unused parameter that must always be zero. To use roll in a VUE file, use a
camera view instead of a user view.

The <width> parameter is the width of the rendered image, in world units.

Camera View Command

Renders a camera view.

The <x>, <y>, <z> parameters are the camera's location.

The <tox>, <toy>, <toz> parameters are the location of the camera's target.

The <roll> parameter is the camera roll angle, in degrees.

The <focal> parameter is the camera's focal length, in millimeters.

Walking Gait
One of the predefined biped gaits available in footstep animation on page
7790  (the others are running and jumping). In a walking gait, at least one foot
is always in contact with the ground.

Wall Repel Behavior
In crowd animation on page 4680 , the Wall Repel behavior uses a grid object
to repel delegates. When influenced by the Wall Repel force, delegates turn
until they're heading away from the grid. This behavior is useful for keeping
objects inside an enclosed, straight-sided enclosure, such as a room in a
building.

Wall Seek Behavior
In crowd animation on page 4680 , the Wall Seek behavior uses a grid object
to attract delegates. When influenced by the Wall Seek force, delegates turn
until they're heading toward the grid. This behavior is useful for moving
objects toward a rectangular area, such as a doorway.
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You can set the grid to attract from either side or both sides, and optionally
specify a maximum distance for attraction. You can also set the behavior to
act as though the grid extends infinitely along its plane.

Wander Behavior
In crowd animation on page 4680 , the Wander behavior imparts a random
motion to delegates, letting you simulate meandering activity in which
delegates move and turn in a haphazard manner. The behavior works by
randomly picking a new direction, and then turning and moving in that
direction. You can specify how often to pick a new direction, how far to turn,
and how fast or slow to turn while moving.

Weight Curve
In the Motion Mixer on page 7856 , weight curves define the amount of
influence a clip on page 7855  or track on page 7951  has on the mixed animation.

On a layer track on page 7825 , each clip has its own weight curve. On a
transition track on page 7959 , one curve defines the influence for the entire
track. On a balance track on page 7723 , the weight curve determines the degree
of automatic balance compensation applied to the biped motion.

Wire
Particle Flow uses wires to show connections between events in Particle View
on page 2730 . There are two types of wires: one that connects a global event
on page 7801  to a birth event on page 7728 , represented by a dashed blue line;
and one that connects a test on page 7948  to a local event on page 7831 ,
represented by a solid blue line.
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Wire from global event to birth event (above); wire from test to local event (below)

To wire a test to an event, drag from its test output, the blue dot that by default
sticks out to the left of the test, to the event's event input, which sticks out
from the top, or vice-versa. Similarly, you can wire a global event to a birth
event by dragging between the source output on the bottom of the global event
and the event input.
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 The mouse cursor resembles the first image when you can
begin this operation: the bottom portion is the top of a small square. The
cursor resembles the second image when you can complete the operation: the
square at the bottom has become an arrow.

To delete a wire, right-click it and choose Delete Wire, or click it (it highlights
in yellow) and then press the Delete key. Or, with a wire between a test and
an event, drag from either connector to a blank area of the event display on
page 7772 .

Wireframe Mode

Wireframe mode display of a director's chair and megaphone

Wireframe is a viewport setting that lets you view objects in a given viewport
as a wire mesh. This is the default setting for non-Perspective viewports. You
change this setting from the viewport right-click menu on page 7370 .

In addition, you can set the Standard and Raytrace materials to render as wires.
Use the Extended Parameters rollout to set the size of the wire, and specify its
measurement in either pixels or units.

When you use pixels, the thickness of the wire is based on the screen pixels.
Therefore, it's absolute, and remains the same, regardless of its distance from
the camera. If you use units, the thickness is based on world units, and varies
depending on the distance from the camera. It's easier to compare the effect
of pixels and units if you first adjust the camera view to give a greater sense
of distance. You can most easily do this with the Perspective viewport
navigation tool, which dollies the camera in one direction while changing
the field of view in the other.
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Workbench
The Animation Workbench is a customized version of the Track View function
curve editor designed to be used with bipeds. It contains a Curve View that
displays keys on function curves which you can edit similar to the way you
work in Track View. It also contains a set of four panels for selecting bipeds,
analyzing their motion tracks for error conditions, and fixing those tracks
individually or in groups.

The Workbench can be used to assign SubAnim controllers to multiple biped
body parts at once through the display of the Controllers window.

Workbench filters can be used to smooth, blur or boost position and rotation
curves, and can also be used to apply controllers or remove keys.

The Workbench uses many of the same toolbars found in Track View for key
manipulation and track navigation. It uses manual navigation as the default
behavior. When multiple biped body parts are selected it does not display all
curves as a default, so you can perform error analysis and correction on many
tracks without displaying all the curves simultaneously.

Workflow
A series of steps to perform a task.
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World Coordinate System

A book in object space rests on a table in world space. The table uses the world
coordinate system.

The coordinate system for world space or the model space as a whole.

World space is the universal coordinate system for all objects in the scene.
When you look at the home grid in the viewports, you see the World Space
coordinate system. World space is constant and immovable.

In the world coordinate system seen from the front, the X axis runs in a
positive direction to the right, the Z axis runs in a positive direction upward,
and the Y axis runs in a positive direction away from you.
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World Space

A book in object space rests on a table in world space.

World space is the universal coordinate system used to track objects in the
scene. When you look at the home grid in the viewports, you see the
world-space coordinate system. World space is constant and immovable. By
convention, world-space coordinates are always expressed as XYZ coordinates,
as opposed to the UVW coordinates of object space on page 7868 .

All objects in your scene are located in world space by their position, rotation,
and scale (their transforms).

Some modifiers on page 7852  operate in world space. See World-Space Modifiers
(WSMs) on page 1043 .

Space warps also operate in world space. A space warp defines an area in world
space that is affected by the space warp’s parameters. Any object that is bound
to the space warp is affected as it moves through the space warp’s area of world
space.
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World Space (Biped)
When you use freeform animation on page 7792  to animate a biped, you can
place a biped limb into the space of another object, or into world space. For
example, if the biped's feet are in world space, then when you move the center
of mass, the feet stay planted in the same location.

World-Space Modifiers (WSM)
World space is the universal coordinate system that applies to the entire scene.
A world-space modifier, as opposed to an object-space modifier on page 7870 ,
affects an object but uses world coordinates.

A world-space modifier always appears at the top of the modifier stack on
page 1020 . Its effect is independent of its order in the stack.

See also:

■ World-Space Modifiers (WSMs) on page 1043

xref (AutoCAD External Reference)
An AutoCAD external reference. An xref is a variation on a block. A block is
a collection of geometry that is identified by a unique name, is stored in the
AutoCAD symbol table, and essentially behaves as if it is a single object. Xrefs
share block characteristics, and they are similarly defined in the symbol table.
However, unlike blocks, the geometry associated with an xref definition is not
stored in the current AutoCAD drawing; it is stored in another AutoCAD
drawing file. Like a block, there can be many instances of an xref in a AutoCAD
drawing, but only one definition.

Typically, xrefs are used to display the geometry of a common base drawing
in the current AutoCAD drawing without expanding its size. This allows
changes to the reference drawing to be reflected in any host AutoCAD drawings
that refer to it.

See also:

■ XRef (3ds Max Externally Referenced File) on page 7978
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XRef (3ds Max Externally Referenced File)
An XRef in 3ds Max is an externally referenced file or object. XRefs allow
multiple animators and modelers to work on one scene at the same time
without interfering with each other's work.

There are two ways to XRef another scene:

■ XRef Scene on page 6755
The File > XRef Scene command XRefs an entire scene. For example, a
classic use of this command is to bring in a scene that appears as a “set”
for an animation you create.

■ XRef Objects on page 6732
The File > XRef Objects command XRefs individual objects or materials.
For example, you might be working on the model of a building, and fill it
with furniture created by other artists.

You can also XRef the manipulators and modifiers associated with the
objects you XRef.

ZT File
A ZT (.zt) file is a mental ray shadow map file on page 7928 . This is a binary
file that the mental ray renderer uses to accelerate the generation of shadows.
You specify a name and location for the .zt file on the Render Scene dialog >
Renderer panel > Shadows & Displacement rollout on page 6114 .
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age test 2879
AI import dialog 6960
airborne option 4352, 4365, 4369
airborne periods 4139, 7707

aliasing/antialiasing 1154, 5285, 5427, 
5429, 5950, 7560, 7708

alias against background 7560
and supersampling 5285
fast adaptive 5427
filters 1154, 5950
glossary 7708
multiresolution adaptive 5429

align 938, 945, 950–951, 1375, 2019, 
2516, 2520, 2566, 3399, 3532, 
6605–6606

align geometry dialog (edit
poly) 1375

and pivot point 3399
camera 950
dialog 938
editable mesh objects 2019
editable mesh vertices 2019
flyout 938
grid to view 2566
keys (Track View) 3532
normals 945, 2520
objects 2516
selected left (video post) 6605
selected right (video post) 6606
to view (dialog) 951
to view (toolbar) 951

all bipeds 4268
all links 4672
allow non-vertical jambs 433
alpha channel 6486, 7709
alpha compositor (video post) 6708
alpha map (baking) 6178
alternate 4359, 4365, 4369
altitude (sunlight and daylight

systems) 5032
ambient 4898, 4904, 4906, 5318, 5363, 

5397, 6486, 7710
and diffuse map lock 5318
and raytrace materials 5397
color (glossary) 7710
light 4898, 4904, 4906, 7710
lighting (rendered

environment) 6486
mapping 5363

ambient occlusion map (baking) 6179
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analysis of lighting 6028
analyze errors 4410
analyze panel 4410
analyzing 7071

Shockwave 3D files 7071
W3D files 7071

anatomy of biped 4075
anchor (VRML97 helpers) 7094
anchor patches 1935
anchors 4301
angle 585, 4477, 4511

transition editor 4477
angle of incidence 4898, 4904
angle separation 7560
angle snap 2570
angular dashpot 3862
animatable IK attachments to 3ds Max

objects 4200
animated 2825, 5266–5267, 7711

bitmap 5267
material previews 5266
reference objects (particle

flow) 2825
texture 7711

animating 33, 877, 977, 1993, 2189, 
2685, 2725, 3126, 3290, 3295, 
3316, 3346, 3368, 3383, 3386, 
4098, 4916, 5138, 5265, 6647

a biped with footsteps 4098
a tablecloth (FFD(cylinder) space

warp) 2685
attachment 3295
cameras 5138
lens effects properties (video

post) 6647
lights 4916
links 3290
materials 5265
NURBS models 2189
parameters 2725
scene 33
shift+rotate 977
shift+scale 977
sub-object geometry 1993
transforms 877
vertices 3126

with applied IK 3386
with IK solvers 3316, 3346, 3368
with interactive IK 3383

animating a quadruped 4199
animating hair 1057, 1099, 1109
animation 104, 241, 1057, 1099, 1109, 

2175, 2189, 2727, 3002–3003, 
3007, 3058, 3212, 3718, 4154, 
4222, 4224, 4336, 4426, 4545, 
5994, 6859, 6873, 6876, 6880, 
6882, 6885–6886, 7564, 7568, 
7711–7713

and particle system time
frames 2727

auto key default frame 7568
auto key mode 3007
auto key start frame 7568
combining animations 4426
concepts 3002–3003
constraints 3212
controllers 3058, 7712
dynamics & adaptation rollout 4336
expanding tracks 4154
glossary 7711
hair and fur modifier 1057, 1099, 

1109
importing and exporting 4224
importing from another scene 6859
insert animation 241
layers 7713
loading 6873
mapping 6880, 6882, 6885–6886
methods 3002
NURBS 2175
preferences settings 7564
previewing animations after attaching

Physique 4545
sample animations in this

release 4222
saving 6876
selecting and moving tracks 4154
show ghosting 104
tips (NURBS) 2189
toggle animation mode 3007
utilities 3718
with radiosity 5994
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animation controls 7342
animation layer weight 3088, 3090
animation layers 3088, 3090, 3104–

3105, 7293
animation layers toolbar 7293
animation menu 267, 285, 831, 845, 

2531, 3171, 3212, 3214, 3219, 
3222, 3229, 3238, 3244, 3247, 
3250, 3307, 3369, 6220, 6224, 
7275

bone tools 845
constraints 3171, 3212, 3214, 3219, 

3222, 3229, 3238, 3244
create bones 831
dummy 2531
IK solvers 3307, 3369
make preview 6220
parameter collector 285
parameter editor 267
previews 6220
rename preview 6224
view preview 6224
wire parameters 3247, 3250

animation mode 3010
set key 3010

animation modifiers 1132
animation quad menu 7306
animation range 3471

ignore 3471
respect 3471

animation workbench 4401
anisotropic highlights 5353
anisotropic shader 5328, 5377

anisotropy mapping 5377
basic parameters rollout 5328

ankle attach option 4077, 4343
ankle tension 4294
antialiasing 6083, 7781, 7914
append 4440

.mfe file 4440
motion flow editor 4440

append footsteps 4110, 4253
applied ik 7713

glossary 7713
applied IK 3305, 3386, 3409, 3421
apply ease curve 3583

apply ease or multiplier curve (Track
View) 3583

apply increment 4301, 4306
apply multiplier curve 3583
applying materials 5182, 5188
arc 560
arc rotate 7394–7395
arch & design material 5458, 5461, 

5471, 5473, 5493, 5507
BRDF rollout 5471
main material parameters

rollout 5461
main reference 5458
overview 5493
self illumination (glow) rollout 5473
tips & tricks 5507

architectural material 5432, 5435, 5438, 
5441

advanced lighting override
rollout 5441

and radiosity solution 5441
physical qualities rollout 5435
special effects rollout 5438
templates rollout 5432

archive 6918, 7541
file menu 6918
program (files preferences) 7541

archiving scenes 53
area light rollout 5081
area light sampling rollout 5082
area lights 4945, 4948, 7713

omni 4945
spotlight 4948

area omni light 4945
area shadows 7717
area shadows rollout 5089
area spot light 4948
arms 4077, 4090, 4343

arm link 4343
resizing 4090
turning on 4077

array 953, 981, 983, 989, 993
arraying objects 981
creating 953
creating arrays 989, 993
using the array dialog 983
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artificial light 4906
ASCII files 6977

exporting 6977
ASE files 6977
aspect ratio 5932, 7718
assemblies 227, 231–234

attach to 234
close 232
create 227
disassemble 233
explode 233
open 231

assembly 231
open 231

assembly commands 226
assembly heads helper objects 235
assembly menu 227, 233–234

assemble 227
attach 234
detach 234
disassemble 233
explode 233

asset browser 49, 6928, 6948, 6950
internet download dialog 6950
preferences 6948
using 49

asset tracking 6721, 6897, 6916
dialog 6897
icons 6916
open from vault 6721

asset tracking dialog 4222, 6897
asset tracking dialog icons 6916
asset tracking prompts 6914
assign 330, 3515, 3790, 5248, 5849, 

7456
controller (Track View) 3515
controller rollout (motion

panel) 7456
material to selection 5248
object effects dialog 3790
random colors 330
vertex colors utility 5849

assign controller rollout (character
studio) 4250

assign random colors 330
assign to link 4559, 4672

assigning 327, 3031, 5182, 5188
colors to objects 327
controllers 3031
materials 5182, 5188

associate bipeds with delegates 4762
associate objects with delegates 4755
assume skin pose 244
asterisk (in modifier stack) 1032
atmospheres and effects 5072, 6030, 

6486, 6494, 6507, 6512, 6521, 
6560

adding atmosphere 6494
and raytracing 6030
atmospheric effect 6486, 6507, 

6512, 6521
for atmospheric apparatus 6560
for lights 5072

atmospheric apparatus 6560, 6562, 
6565, 6567

BoxGizmo 6562
CylGizmo 6565
SphereGizmo 6567

attach 226, 234, 602, 606, 627, 1935, 
1968, 1971, 2019, 2031, 2226, 
3201

attach options 2031
attaching and importing 3ds Max

objects 2226
controls dialog (block

controller) 3201
editable mesh edges 2019
editable mesh vertices 2019
editable patch object 1968
object 1935, 1971
splines 602, 606, 627
to assembly 234
to groups 226

attach points/tendon 4666
attach to deforming mesh

constraint 3992
attach to group 169
attach to node 4590
attach to rigid body constraint 3989
attached links 4666
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attaching 4572, 4590
mesh to a biped using

Physique 4590
tendon to another link 4572

attachment 3214, 3295
animating 3295
constraint 3214

attachments (IK) 7719
attenuation 4898, 4904, 5065, 5785, 

7545, 7719
and lights 7545
parameters 5065
raytrace attenuation rollout 5785

attribute holder modifier 1136
attributes (custom) 267
audio controller 3060, 3198
AudioClip (VRML97 helpers) 7112
auto 4511
auto clip names 4427
auto expand 3480

animated 3480
base objects 3480
keyable 3480
materials 3480
transforms 3480
xyz components 3480

auto key 3007, 3010, 7568
and set key 3010
default frame 7568
start frame 7568

auto key default frame 7568
auto termination rollout 3423
auto timing 4359, 4365, 4369
AutoCAD 6842, 6844, 6979, 7006

blocks 6842, 6844
importing DWG and DXF files 6979
importing DXF files 7006
instanced objects 6842

AutoCAD Architecture 190, 6822–6823, 
6825, 6850

files 6822
materials 6825
objects 6823, 6850
select families or types 190
select similar 190
styles 6850

AutoCAD blocks in 3ds Max 6819
AutoCAD DWG/DXF import options

dialog 6979
AutoCAD, AutoCAD Architecture, and

Revit 6817
working with 6817

autodesk inventor files 7008
importing 7008

Autodesk Vault 6896
Autodesk VIZ files 6961
autogrid 7720
AutoGrid 2514
automatic 53, 3423, 6422, 6535, 7536, 

7541
auto archive 7541
auto backup 53, 7541
auto secondary (lens effects) 6422
auto termination (IK) 3423
automatic exposure control 6535
unit conversion 7536

automatic mapping rollout 6211
rendering to texture 6211

autoplay preview file 7536
AVI files 6220, 7118
avoidance behavior 4699, 4786, 4835, 

7721
preventing collisions 4835

awning window 523
axis constraints 884, 2578, 3424, 7288

and hierarchies 3424
and rollouts 3424
and snaps 2578

axis constraints toolbar 7288
axis order 4215, 4276
axis ordering 4401
axis tripod 103, 860, 879

and transform managers 879
and World Axis 860

axonometric views 61, 7722
azimuth (sunlight and daylight

system) 5032

B

B-spline (glossary) 7722
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backburner 6347, 6359
network rendering 6347, 6359

Backburner 6231
backburner command line control 6378
backburner.xml file 6307
backface cull on object creation 7545
backfacing - ignore 1990, 2019, 2033
background 89, 98, 102–103, 1154, 

5234, 5950, 6486, 6494, 7109, 
7371

and antialiasing 1154, 5950
color 6486, 6494
image 6486
reset background transform 103
sample slot 5234
select background image 98
update viewport image 102
viewport 7371
viewport background 89
VRML97 helpers 7109

backlight (sample slot) 5233
backup 53, 7541

auto 7541
backing up and archiving scenes 53
backup on save 7541
files 7541
recovered files 53

backward knees (creating characters
with) 4164

baked material rollout 6209
rendering to texture 6209

baking animation 2722
baking textures 6169, 6174, 6181

target map slot 6181
texture elements 6174

balance 4134, 4137
animating 4134, 4137
shifting 4134
shifting for entire footstep

animation 4134
balance factor 4134, 4137, 4288, 7723
balance parameters dialog 3674
balance track 3659
ballistic gait 4139, 7723
ballistic tension 4075, 4139, 4270, 

4288, 7723

barycentric 3044, 3062, 3126, 7724
coordinates (glossary) 7724
morph controller 3044, 3062
morph controller key info

dialog 3126
base layer 4322
basic file link settings 6794
basic key info 3052
basic parameters rollout 2967, 5310

materials 5310
PArray 2967

basics 140, 317, 321, 6772
basic building blocks 321
creating and modifying objects 317
file linking 6772
selecting objects 140

batch 6347, 6352, 6359
rendering 6347, 6352, 6359

batch file conversion (motion
capture) 4503, 4520

batch rendering 6347–6349, 6352, 6359
backburner 6347–6349, 6359
batch render dialog 6352
batch render tool 6352
cameras 6347, 6352, 6359
error dialog 6352
errors 6352
network rendering 6347, 6352, 6359
presets 6352
quick start 6348
scene states 6347, 6352, 6359
using 6349

batch rendering completed 6352
before trajectory 4268
behavior assignments and teams

dialog 4764
behavior rollout 4785
behaviors 1181, 4691, 4699, 4786, 

4791, 4795, 4799, 4801–4802, 
4804–4805, 4807, 4811, 4814, 
4817, 4820, 7721, 7724, 7869, 
7875, 7888, 7890, 7911, 7922–
7923, 7933, 7936, 7943, 7970–
7971

avoid 4786, 7721
fabric 1181
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obstacle-avoidance 4699, 7869
orientation 4791, 7875
patch-based 7888
path follow 4795, 7890
repel 4799, 7911
scripted 4801, 7922
seek 4802, 7923
space warp 4804, 7933
speed vary 4805, 7936
surface arrive 4807, 7943
surface follow 4811, 7943
wall repel 4814, 7970
wall seek 4817, 7970
wander 4820, 7971

bend 4355, 4646
bend links mode 4172, 4253, 4284, 7725
bend modifier 1139
bend parameters (links) 4563
bending 4121, 4212

center of mass track 4212
footstep path 4121

bevel 752, 1142, 1150, 1968, 2019
bevel modifier 1142
bevel profile modifier 1150
deformation 752
faces and polygons 2019
patches 1968
types of beveling 752

bevel polygons dialog 2130
bezier 3063, 3580

controllers 3063
handle control 3580

bezier curves 7726
bias 4278, 4289, 4563, 4646, 5095

mental ray shadow maps 5095
bifold door 514
billboard (VRML97 helpers) 7114
binding 606, 2609, 3302, 3347, 3410

objects 3302, 3347, 3410
to space warp 2609
vertices 606

BioVision motion capture data files 4503
BIP files 3621, 3630, 3635, 3637, 3644, 

3646, 3663, 4147, 4220, 4222, 

4229, 4261, 4264, 4461, 4503, 
4876, 7727

adding to motion mixer 3630
adjust time in motion mixer 3644
adjusting in motion mixer 3635
combining motions 4229
combining with mixer 3621
export with motion mixer 3663
filtering in motion mixer 3637
loading 4264
path 4461
saving 4147, 4261
transitions in motion mixer 3646

biped 3626, 3687, 4052, 4054, 4069, 
4073, 4075, 4077, 4079, 4097, 
4133–4134, 4158, 4192, 4226, 
4238, 4245, 4250, 4253, 4268, 
4288, 4296, 4306, 4322, 4333, 
4336, 4340, 4349, 4384–4385, 
4389, 4452, 7727–7728

add to motion mixer 3626
and physique 4054
assign controller rollout 4250
body parameters 4073, 4077
center of mass 4052
colored keys 4385
creating 4073
display options 4268
dummies 4226
dynamics 4052, 4336
dynamics parameters 4288
edit 4452
editing keys in Track View 4133
extra tails 4349
figure files (.fig) 4097
figure mode 4079
IK key colors 4385
keyboard shortcuts 4389
layer 4322
load and save layers 4333
load motion file 4253
mixer transition editor 3687
moving keys 4384
moving the head 4340
naming 4077
playback 4253, 7728
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previewing motion 4238
root object 4075
select keys based on foot states 4306
selecting pivot 4296
setting keys 4192
shifting balance 4134
structure 4079
tracks in Track View 4158
user interface 4245
working with 4069

biped apps rollout 4252
biped balance, motion mixer 3659
biped clips 3710
biped colored keys 4385

Track View 4385
biped crowds 4712
biped dynamics 7727
biped IK key colors 4385
biped links 4172

selecting and rotating 4172
biped playback 4253
biped rollout 4253
bipeds 4079, 4093–4094, 4161, 4164, 

4232, 4268, 4576, 4738
and crowd simulation 4738
correcting posture 4232
deleting 4093
linking objects to 4094
moving objects 4161
posing 4079
posing a biped 4232
rotating objects 4164
scaling after physique is

applied 4576
visible in playback 4268

bipeds dialog 3699
birth event 7728
birth operator 2764
birth script operator 2767
bitmap map 5634
bitmap pager 7563
bitmap pager statistics dialog 6947
bitmap proxies 5937
bitmap proxies dialog 6912
bitmap/photometric path editor 6938, 

6953

bitmaps 5634, 5642, 6926, 6938, 7527, 
7586, 7588, 7594, 7730

choosing 5642
display 7586, 7588, 7594
glossary 7730
Material Editor 5634, 5642
path configuration 6926, 7527
path editor 6938

blend 2296, 2348, 5546, 6162, 7731
blend curve (NURBS) 2296
blend element parameters 6162
blend material 5546
blend object (glossary) 7731
blend surface (NURBS) 2348

blend from/to 4653
blend map (baking) 6178
blend materials 6174

limitations when baking
textures 6174

blend weight 1627
blending 4547, 4551, 4600, 4672

between links 4547, 4600, 4672
envelopes 4551

blending envelope display options
dialog 4625, 4633

Blinn highlights 5355
Blinn shader basic parameters 5330
blizzard 2951
BlobMesh object 674
block 3204–3205, 3211

controller 3204–3205, 3211
block controller 3067
block controllers (Track View) 4724
block reference 7731
block/style parent 7732
blocks 5232, 6812, 6819, 6842, 6844, 

6846, 7732, 7967
and linking to 3ds Max 7732, 7967
AutoCAD 6819, 6842
AutoCAD and 3ds Max 6812
material assignment 6846
materials 6846
multi-view 6846
propagation 5232

blowup (render) 5901
blue vertices 4672
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blur 2932, 6461, 7733
and blur offset (glossary) 7733
particle motion blur 2932
rendering effect 6461

BMP files 7120
body 4075, 4077, 4270, 4298, 7733

horizontal tracks 4075, 4270
parameters (biped) 4077
space 7733
tracks 4075
turning track 4270
vertical tracks 4075, 4270

bomb space warp 2707
bone tools 845, 849, 851

bone editing 845
fin adjustment 849
object properties 851

bones 831, 844, 852, 3307, 3346, 3368, 
3376, 4093, 4268, 4533, 4535, 
4540–4541, 4597, 7061

and IK solvers 3307, 3368
bone base 4268
bone tip 4268
display 4093
exporting 7061
floating bones rollout

(Physique) 4597
linking to follow objects 3346
spline IK solver 3376
stretch factor 852
used with physique 4533, 4540
using objects as 844, 3307
using unlinked bones with

Physique 4541
Boolean controller 3072
Booleans 627, 686, 701, 774, 792, 7667, 

7734
alignment 686
and editable splines 627
Boolean objects 686, 774, 792
Boolean operation (glossary) 7734
colinear edges 686
combining objects that have

materials 701
complexity between operands 686
coplanar faces 686

face normals 686
inverted meshes 686
material IDs 686
overlapping elements 686
surface topology 686
troubleshooting problems

with 7667
with maps and materials 686

bound vertex 606, 7735
boundary conditions (and

tendons) 4666
bounding box (and envelope

creation) 4600
bounding box (glossary) 7736
bounds (inner/outer) 4547
box 350, 6562

BoxGizmo 6562
standard primitive 350

box caustics filter 6096
box method 4839
box selected 5907

render bounding box/selected
dialog 5907

branching events (particle flow) 2728
break 606, 2019

spline at selected vertex 606
vertices 2019

breathe option (links) 4563, 4646
bricks 5690
bridge dialog 2131
bridge edges dialog 2133
brightness and contrast effect 6471
browse 4511
browser 5194

material/map 5194
browsing from 3ds Max 6928
brush 1073

styling hair with a 1073
brush options 1908
brush preset manager 7296
brush presets 7293
BSP method 6141
BSP method, raytrace acceleration 7905
bubble motion rollout (PArray) 2991
bubble motion with Particle Flow 2727
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bubble notification 7342
communication center 7342

buckets, distributed rendering 6132
buffer mode 4253
build face 2019
bulge angle display properties

dialog 4629
bulge angles 4570, 4606, 4656, 7737

adding 4570
changing 4570
choosing for editing 4570
color 4656
deleting 4570
parameters 4606
setting 4570

bulge editor 4571, 4590, 4606, 4644, 
4656

bulge sub-object 4629, 4656
bulges 4566, 4568, 4571, 4600, 4602, 

7736
creating 4568
fine-tuning 4571
overview 4566
shaping 4571
workflow 4568

bump mapping 5382, 5439
bump shader (mental ray) 5814
button 167, 169, 201, 888–889, 892, 

894, 905, 907–908, 911, 925, 
933, 938, 944–945, 948, 950–951, 
2529, 2568, 2570–2572, 2609, 
3268–3269, 3532, 3538, 3576–
3577, 3591, 3603–3607, 5222, 
5239, 5244–5245, 5250, 5260–
5261, 5264–5265, 5898, 5909, 
5917, 6596–6598, 6607, 7319, 
7324, 7355, 7357–7358, 7381–
7382, 7385–7387, 7392–7393, 
7395, 7398, 7400–7401, 7403–
7404, 7409, 7411, 7413, 7415, 
7417, 7419, 7450, 7466

2.5D snap 2568
2D snap 2568
3D snap 2568
ActiveShade floater 5917
align 938

align camera 950
align to view 951
angle snap 2570
arc rotate 7395
bind to space warp 2609
button sets (utilities) 7466
clone and align tool 933
crossing 201
current frame 7358
dolly camera 7398
dolly light 7409
dolly target 7398, 7409
edit current event 6598
edit scene event (video post) 6607
full screen 7382
get material 5245
go forward to sibling 5261
go to end 7357
go to frame 7358
go to parent 5261
go to start 7355
light falloff 7415
light hotspot 7411
lock selection 3532
make unique (Material Editor) 5250
material and map type 5265
Material Editor 5222
Material Editor options 5239
maximize viewport 7382
mirror 911
new sequence 6596
next frame 7357
normal align 945
open sequence 6597
orbit/pan camera 7404
orbit/pan light 7419
pan (Track View) 3603
pan (user interface) 7393
percent snap 2571
perspective 7400
pick material from object 5264
place highlight 948
play/stop 7355
previous frame 7355
quick align 944
quick render 5909
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quick render (Production) 5909
render scene 5898
roll camera 7401
roll light 7413
save sequence 6598
scale keys 3538, 3576
scale values 3577
select and link 3268
select and manipulate 2529
select and move 888
select and rotate 889
select and uniform scale 892
select by material 5244
select by name 169
select object 167
selection center 907
selection lock 7324
sets of modifiers 7450
show curves 7319
show end result 5260
spacing tool 925
spinner snap 2572
squash 894
transform coordinate center 908
truck camera 7403
truck light 7417
unlink selection 3269
use pivot point center 905
zoom 7385
zoom (Track View) 3606
zoom all 7386
zoom extents 7387
zoom extents all 7381
zoom extents all selected 7381
zoom extents selected 7387
zoom horizontal extents 3604
zoom region 7392
zoom region (Track View) 3607
zoom selected object 3591
zoom value extents 3605

button appearance 7511
BVH files 4220, 4495, 4503, 4876, 7737
by layer 7737
bylayer 7224

C

C-Ext 414
cache operator (particle flow) 2856
CAL files 4511
calculation order (joint

precedence) 3357
calculator 38
calibrating marker files 4503
camera correction modifier 5160
camera effects rollout 6087
camera map modifier 1044, 1154

object space 1154
world space 1044

camera map per pixel map 5846
camera match 5152, 5157–5158

camera match helper 5157
camera match point 5158
camera match utility 5152
camera point 5158
CamPoint 5158

camera tracker 3742, 3748, 3750, 3753, 
3758, 3760–3761, 3764–3765, 
3768, 3771, 3774

batch track rollout 3761
camera tracker utility 3742
error thresholds rollout 3760
match move rollout 3765
motion trackers rollout 3753
move smoothing rollout 3768
movie rollout 3748
movie stepper rollout 3758
movie window 3750
object pinning rollout 3771
position data rollout 3764
requirements for camera

tracking 3748
troubleshooting 3774

camera view 7370
right-click menu 7370

camera viewports 79, 7397
cameras 30, 61, 110, 950, 5107, 5116, 

5118, 5120, 5123, 5134–5136, 
5138, 5142–5143, 5148, 7397–
7398, 7401, 7403–7404

align camera button 950
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animating 5138
camera object icons 5107
camera view 61
camera viewport controls 7397
choosing for vertical views 5107
common parameters 5123
create camera from view 110
depth of field parameters (mental ray

renderer) 5142
dolly or target 7398
free 5116
match camera to view 950
multi-pass parameters 5143, 5148
orbit/pan 5138, 7404
placing 30
roll 7401
setting lens size 5123
target 5118
truck 7403
using clipping planes to exclude

geometry 5135
using horizon to match

perspective 5136
using move and rotate to aim 5134
using transforms to aim 5134
with target 5118
zoom 5138

candela 7833
canopy mode 439
cap holes modifier 1160
cap surface 2378
capsule 403
capture viewport 85
car paint material and shader 5522
car-wheel constraint 3911
cartoon shading 5580
casement window 526
category, hiding and unhiding objects

by 156
caustics 6066, 6096
caustics (mental ray) 6044
caustics and global illumination

rollout 6096
CCB files 1902
cellular map 5701
center 882

center of mass 4052, 4075, 4134, 4158, 
4247, 4270, 7737

object 4075
selecting tracks 4158
shadow 4075
shifting balance with 4134
tracks in Track View 4270

chains (kinematic) 3366, 7825
chamfer 393, 396, 606, 2019, 2304, 7738

and editable splines 606
chamfer curve (NURBS) 2304
ChamferBox 393
ChamferCyl 396
editable mesh edges 2019
glossary 7738

chamfer dialog 2136
change of value over time 3573
changed feature 83, 114, 169, 1319, 

1533, 2053, 5255, 6984, 7622
changing 343, 3029, 3296, 4073, 4077, 

4910, 5236
biped body parameters 4073
biped name 4077
controller properties 3029
initial biped anatomy 4077
light objects 4910
link inheritance 3296
smoothing 343
video system 5236

changing biped to bones 4224
channel 583
channel (map) 7836
channel info 3798

skin utilities 3798
channel info utility 5858
character 238
character assembly 217, 221, 238, 242–

244, 6859
and parameter wiring 221
create character 238
destroy character 242
insert animation 6859
insert character 243
lock/unlock 243
save character 243
skin pose 244
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character modeling 1696
character studio 4050, 4250, 4804, 4876

assign controller rollout 4250
definition 4050
file formats 4876
space warp behavior 4804

checker map 5647
child overlap 4636
children 3407

don't affect 3407
choose directory dialog 7520, 7523
choose renderer dialog 5945
choosing 882, 3024, 3360, 3362, 5174

child-to-parent precedence 3360
colors for realism 5174
parent-to-child precedence 3362
playback speed and frame rate 3024
transform center 882

CIBSE files 7739
cineon image file format dialog 7120
circle 557
circular 6450

falloff graph 6450
circular arrays 993
circulating 5232

materials 5232
clean multimaterial utility 5864
clean remove 2076
clear UVW mapping 1871
clip 3644, 3681, 4474

ratio 3644
replace 3681
timing 3644
transition 4474

clip controllers 4724, 7739
clip frame numbers 3644

motion mixer 3644
clip mode 4427
clip properties dialog 4427, 4468, 4491
clipping planes 5123, 5135, 7740
clips 3679, 4426–4427, 4461, 4468, 4495

combining 4426
create 4427
looping with motion-capture

filtering 4495
menu 3679

move 4427
path 4461

ClipState dialog 4857
clone 965
clone and align tool 933
clone options dialog (particle

flow) 2743, 2749
cloning 590, 958, 965–966, 970, 972, 

975, 979, 1993, 5232
clone 965
materials 5232
objects 958, 979
shape sub-object selections 590
shift+move 970
shift+rotate 972
shift+scale 975
sub-object geometry 1993

cloning characters 4226
close 224, 232

assembly 232
group (group menu) 224

close curve dialog 2448, 2462
cloth 1163–1164, 1174–1176, 1178, 

1180–1181, 1187, 1219, 1228, 
1258, 3949–3950, 3957

cloth modifier 1178
cloth simulation 1163
collection 3957
collision detection 1164
dT messages during simulation 1187
effect of geometry on 1175
fabric behavior 1181
garment maker modifier 1228
how it works 1174
mesh density 1176
modifier 3950
object properties 1219
overview 1163
troubleshooting and error codes in

garment maker 1258
units of measure 1180

cloth modifier 1178, 1185
user interface 1185

clothing design 1172
CLR files 7505
cmdjob.exe 6378
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codec (glossary) 7740
cognitive controller 4779–4780, 7740

state dialog 4779
state transition dialog 4780

cognitive controller editor 4776
cognitive controllers 4708
coincident - making splines 1696
collapse 1023, 1931, 2019

collapse utility 1931
stack 1023, 1931
vertices 2019

collapse controller tool (Track
View) 3472

collapse layer 3090, 3104
collapsing 4154, 4322

animation tracks 4154
layers 4322

collections 3845, 3957, 3969, 3977, 
3981, 4308

cloth 3957
creating and deleting 4308
deforming mesh 3981
loading and saving 4308
rigid body 3845
rope 3977
soft body 3969

collision 2937
collision detection 1164, 4164

cloth 1164
collision tests (particle flow) 2881, 2885

collision 2881
collision spawn 2885

collisions 3942
storing and accessing 3942

collisions rollout 4013, 4835
color 38, 117, 327, 331, 338, 1321, 

2014, 2055, 2742, 4898, 4904, 
5035, 5065, 5174, 5236, 5270, 
5965, 6072, 6472, 7423

and light 4898, 4904, 5035
and particle view display

operator 2742
and program state 38
and realism 5174
assigning to objects 327
balance (render effect) 6472

bleeding 6072
changing vertex color 2014
color bleeding 5965
color selector 331
copying 338, 5270
display 117
illegal video colors 5236
name and color rollout 7423
object color dialog 327
parameters 5065
selecting vertices by 1321, 2055
temperature (light color) 4898

color clipboard files 1902
color clipboard utility 338
color coding 4270
color controls 5341
color modifier maps 5766
color palette 1902

vertexpaint modifier 1902
color RGB controller 3074
color selector 331, 7536
color space 5877
colors 330, 4122, 4268, 4273, 4385, 4559

assign random 330
biped IK/FK keys 4385
biped keys in Track View 4273
biped trajectories 4385
footsteps 4122
in Track View 4268
vertex type 4559

colors panel (customize UI) 7505
COM 4247
COM/DCOM server control utility 7488
combining animations 4426
combining motions 3621

motion mixer 3621
combining objects 686, 774, 792
Combustion 6152

adding workspace 6152
combustion map 5649
combustion workspace file 7121
command line 6361, 6365, 6378, 7254

rendering 6361, 6365, 6378
startup options 7254

command panel 7683
troubleshooting when missing 7683

7994 | Index



command panels 7422–7423, 7425, 
7453, 7455, 7457

create 7423
display 7457
hierarchy 7453
modify 7425
motion 7455
overview 7422

command-line options
(MAXScript) 7472

command-line options (starting 3ds
Max) 7254

command-line rendering 6361, 6365, 
6378

backburner command line 6378
batch render 6361
DOS 6365
pre-render scripts 6361, 6378

commands provided only from the
keyboard 7251

comments 2745, 2871
particle system 2745, 2871

comments on the documentation 7650
common panel 5929

render scene dialog 5929
common parameters rollout 5929
common procedures 6580

video post 6580
commonality 1034
communication center 7333, 7335–

7336, 7341–7342
bubble notification 7342
configure 7336
new information 7342
notifications 7342
refresh content 7341
settings 7336
welcome wizard 7336

compare dialog (loft objects) 765
compass helper object 2551
complete map (baking) 6175
component color - specular 7935
components 1050

hair and fur 1050
composite 5549, 5757, 7741

glossary 7741

map 5757
material 5549

composite materials 6174
limitations when baking

textures 6174
compositor 5756

compositor maps 5756
compound materials 5544, 7742

glossary 7742
kinds of 5544

compound objects 638, 641, 647, 660, 
668, 674, 681, 686, 703, 767, 
774, 792

BlobMesh 674
Boolean 686, 774, 792
conform 660
connect 668
mesher 767
morph 641
ProBoolean 774
ProCutter 792
scatter 647
ShapeMerge 681
terrain 703

compound rigid bodies 3843
concepts 6056
cone 353
cone (spotlight) 5051
cone angle manipulator 2552
cone caustics filter 6096
configuration 6233

network rendering 6233
configuration settings 6122
configure 6264, 6603, 7315, 7336, 7359, 

7450, 7466, 7520, 7523, 7545, 
7585–7586, 7588, 7594, 7610

communication center 7336
Direct3D 7594
driver 7545, 7585
key mode 7359
modifier sets 7450
OpenGL 7588
presets (video post) 6603
software display driver 7586
system paths 7523
TCP/IP (network rendering) 6264
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time 7359
track bar 7315
user paths 7520
utilities button sets 7466
viewports 7610

configure paths 7520
configure preset dialog 5938
configure system paths 7523, 7532

plug-ins path configuration 7532
configure user paths 6277, 7520, 7524, 

7527
bitmaps 6277
external files 7527
file i/o path configuration 7524
FX files 7527
using 6277

conform 660, 2703
compound object 660
space warp 2703

connect 4666
to child link 4666
to parent link 4666

connect compound object 668
connect edges dialog 2137
connect parameter to shader dialog

(mental ray) 5809
constant 7536, 7774

coordinate system 7536
facet shading 7774

constrained point 7743
glossary 7743

constraint solver 3868
constraint spaces 3850
constraints 831, 884, 1181, 3027, 3212, 

3214, 3219, 3222, 3229, 3233, 
3238, 3244, 3848–3850, 3853, 
3858, 3862, 3867–3868, 3871, 
3892, 3898, 3905, 3911, 3918, 
3983, 7288

and bones 831
and cloth 1181
angular dashpot 3862
attachment 3214
axis constraints 884, 7288
breakable 3868
car-wheel 3911

concepts 3849
constraint solver 3868
constraint spaces 3850
cooperative constraints 3867
deformable constraints 3983
hinge 3892
linear dashpot 3858
link 3233
look-at 3238
orientation 3244
path 3222
point-path 3918
point-point 3898
position 3229
prismatic 3905
rag doll 3871
simple constraints 3853
spring 3853
surface 3219

contact object (particle flow) 7743
contacting us 11
containers (glossary) 7743
continuity 2176, 4289, 4563, 4646, 

7743–7744
continuity level (glossary) 7744
NURBS concepts 2176

continuous time frame 2759
contour shading 6080

mental ray 6080
contrast filter (video post) 6636
contrast sampling thresholds 6083
control lattice (glossary) 7745
control objects (IK) 3299, 3316
control points 4556, 4571, 4606, 4636, 

4656, 4666, 7745
and bulges 4571
and envelopes 4556
rotating 4556

control vertex (CV) 7750
control vertex (glossary) 7746
controller 7746
controller menu, Track View 3471
controller toolbar, Track View 3505
controller type 3104–3105
controller window, Track View 3454
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controllers 3025, 3027, 3029, 3031, 
3034–3035, 3037, 3039, 3044, 
3058, 3060, 3062–3063, 3067, 
3072, 3074, 3076, 3080, 3106, 
3118, 3120, 3123–3124, 3126, 
3128, 3140, 3142, 3144, 3146, 
3148, 3171, 3173, 3178–3179, 
3183, 3186, 3190, 3194, 3431, 
3472, 3513–3515, 3523, 3541, 
4174, 7564

assigning 3031
audio 3060
barycentric morphing 3062
bezier 3063
block 3067
Boolean 3072
categories of 3027
changing length 3431
changing properties 3029
changing range 3431
collapsing procedural

controllers 3472
color RGB 3074
copy 3513
default settings 7564
Euler XYZ rotation 3076
expression 3080
frame duration 3431
general-purpose controllers 3035
limit 3106
linear 3118
list 3120
local euler XYZ rotation 3123
look at 3124
make unique 3523
master point 3126
morph 3044
motion capture 3128
noise 3140
on/off 3142
paste 3514
point3 XYZ 3074
position XYZ 3144
properties 3541
PRS 3146
reaction 3148

scale XYZ 3171
script 3173
slave 3067
smooth rotation 3178
specifying default 3034
TCB 3183
time duration 3431
transform script 3186
types of 3025, 3515
understanding 3027
viewing types 3027
waveform 3190
working with 3025
xref 3194

controlling 68, 70, 117, 3019, 3040–
3043, 3222, 3349

colors 3043
display performance 70
flipping on path 3222
IK precision 3349
object display 117
position 3041
rotation 3042
time 3019
transforms 3040
viewport rendering 68

controls 38, 7378, 7384, 7397, 7407
camera viewport 7397
light viewport 7407
perspective and orthographic 7384
special 38
viewport 7378

conversion modifier 1756, 1759, 1761
turn to mesh 1756
turn to patch 1759
turn to poly 1761

convert 4153–4154, 4253, 4372, 4503
between footstep and freeform

animations 4153
data in motion capture buffer 4503
from buffer 4503
to freeform 4154
to freeform/footsteps dialogs 4372

convert curve dialog 2442
convert surface dialog 2445
convert to mesh 2872

Index | 7997



converting 2754, 3740
event-level selection to particle

level 2754
TRC into CSM 3740

convex hull property (glossary) 7747
cool (glossary) 7747
cooperative constraints 3867
coordinate display (mouse

position) 7325
coordinate space 7747
coordinate system 897
coordinates 897, 5183, 5620, 5699, 

7325, 7327, 7724
absolute/offset display 7327
barycentric (glossary) 7724
coordinate display 7325
coordinate system 897
coordinates rollouts 5620, 5699
mapping 5183

copies 953, 955
creating 953
overview 955

copy 4203, 4301, 4355, 4606, 4656, 
4666, 5205

a material, map, bitmap, or
color 5205

footsteps 4355
pose 4301
poses and postures 4203
posture 4301
selected cross section 4606

copy biped animation to clip
dialog 3683

copy controller 3513
copy keys 3575
copy layer 3088, 3090
copy map dialog 5269
copy tangent handles 606
copy time (Track View) 3555
copy tracks 4233
copy/paste rollout 4308

copying 338, 627, 1935, 2735, 2743, 
2746, 3016, 3416, 3513, 3555, 
3567, 3570, 5188, 5232, 5270, 
6809

actions, events (particle flow) 2735, 
2743, 2746

and pasting items/objects 3567, 
3570

colors 338, 5270
copy controller (Track View) 3513
copy time (Track View) 3555
copy track (Track View) 3555
joint parameters 3416
materials 5188, 5232
modifiers 3513
patch surface 1935
presets 6809
splines 627
transform keys 3016

CPY files 4876
crash recovery 53
crease 4653

at link's joint 4653
at parent's joint 4653

create 4114, 4322, 4336, 4352, 4355, 
4427, 4436, 4447, 4452, 4455, 
4468, 4474, 4477, 4484, 4486, 
4600

clip 4427, 4468
envelopes 4600
footsteps 4352
keys for inactive footsteps 4114, 

4355
layer 4322
random motion 4447, 4484
script 4436, 4474
separate tracks for biped arms 4336
shared motion flow 4455, 4486
transition 4468, 4477
unified motion 4452

create assembly (assembly menu) 227
create assembly dialog 227
create biped rollout 4073
create camera from view 110
create character 238
create key dialog 3017
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create layer 3090, 3105
create material preview dialog 5270
create menu 348, 383, 439, 447, 456, 

473, 480, 488, 495, 510, 512, 
514, 523, 526, 528, 530, 532, 
534, 536, 551, 555, 557, 559–
560, 564–565, 567, 569, 574, 
576, 580, 583, 585, 587, 589, 
647, 668, 674, 681, 686, 703, 
715, 1982, 1984, 1987, 2192, 
2196, 2201, 2208, 2924, 4891, 
4925, 4927, 4930, 4933, 4936, 
4939, 4953, 4955, 4958, 4960, 
4963, 4965, 4967, 5107, 5116, 
5118, 7263

AEC objects 439, 447, 456, 473, 
480, 488, 495, 510, 512, 514, 
523, 526, 528, 530, 532, 534

cameras 5107, 5116, 5118
compound objects 647, 668, 674, 

681, 686, 715
extended primitives 383
lights 4891
NURBS 2192, 2196, 2201, 2208
particles 2924
patch grids 1982, 1984, 1987
photometric lights 4953, 4955, 

4958, 4960, 4963, 4965, 4967
shapes 536, 551, 555, 557, 559–

560, 564–565, 567, 569, 574, 
576, 580, 583, 585, 587, 589

standard lights 4925, 4927, 4930, 
4933, 4936, 4939

standard primitives 348
create method rollout 4839
create multiple footsteps 4352, 4359, 

4365, 4369
jump 4352, 4369
run 4352, 4365
walk 4352, 4359

create new layer 7246
create new map files 3101
create out of range keys 3489
create out-of-range keys utility (Track

View) 3545

create panel 319, 2503, 2603, 4891, 
4951, 5107, 7423

cameras 5107
helpers 2503
lights 4891, 4951
space warps 2603

create position lock key 3063
create rotation lock key 3063
create shape (editable patch) 1971
creating 317, 323, 346, 536, 953, 989, 

993, 2007, 2019, 2033, 2153–
2154, 2159, 2180, 2190, 2192, 
2196, 2201, 2208, 2216–2217, 
2219, 2283, 2286, 2290, 2293–
2294, 2299, 2301, 2304, 2308, 
2313, 2316, 2318, 2320, 2324, 
2327, 2332, 2336–2337, 2340, 
2344, 2346, 2348, 2355, 2358, 
2362, 2365, 2374, 2378, 2380, 
2390, 2397, 2408, 2417, 2419, 
2423, 2429–2430, 2432, 2435, 
2438, 2441, 2764, 2767, 2926, 
2928, 4073, 4109–4110, 4154, 
4467, 4524, 4544, 4568, 4572, 
4600, 4681, 5219, 5266, 6270

1-rail sweep surface 2397
2-rail sweep surface 2408
a script 4467
an object 323
animated material previews 5266
arrays 953
biped character 4073
biped skin 4524
blend surface 2348
bulges 4568
cap surface 2378
chamfer curve 2304
circular and spiral arrays 993
copies 953
crowd system 4681
curve sub-objects 2283
custom sample object 5219
CV curve on surface 2327
CV curve sub-object 2286
CV surface 2196
CV surface sub-object 2340
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dependent curve point 2432
dependent curve-curve point 2438
dependent curves 2283
dependent offset point 2430
dependent surface point 2435
dependent surface-curve point 2441
dependent surfaces 2337
editable mesh edges from

shapes 2007
editable mesh vertices 2019
extrude surface 2362
faces 2019
fillet curve 2308
fillet surface 2423
footsteps 4110
footsteps automatically 4109
freeform animations 4154
independent surfaces from NURBS

curve objects 2216
individual footsteps 4110
iso curve 2318
lathe surface 2365
linear arrays 989
mirror curve 2301
mirror surface 2358
models with NURBS 2180
multicurve trim surface 2419
multiple footsteps 4109
multiple slices 2033
multisided blend surface 2417
normal projected curve 2320
NURBS curves from splines 2217
NURBS CV curve 2208
NURBS models 2154
NURBS point curve 2201
NURBS sub-objects 2159
NURBS surfaces 2190, 2219
objects (basics) 317
offset curve 2299
offset surface 2355
particle emitter 2928
particle system 2926
particles 2764, 2767
physique links and envelopes 4600
physique modifier 4544
point curve on surface 2332

point curve sub-object 2290
point curve with curve fit 2293
point sub-objects 2153, 2429
point surface 2192
point surface sub-object 2344
primitives from the keyboard 346
ruled surface 2374
shapes 536
skin 4524
special user account (network

rendering) 6270
sub-objects 2337
surface edge curve 2336
surface offset curve 2316
surface sub-objects 2337
surface-surface intersection

curve 2313
tendons 4572
transform curve 2294
transform surface 2346
U loft surface 2380
UV loft surface 2390
vector projected curve 2324

creation method rollout 718
creation parameters 4073, 7748

glossary 7748
cross fade compositor (video post) 6708
cross section editor viewport

options 4656
cross sections 576, 580, 583, 585, 587, 

589, 1259, 1696, 4556, 4571, 
4594, 4606, 4625, 4636, 4656, 
4666, 7748

and bulges 4571
and envelopes 4556
and tendons 4666
initialization 4625
parameters 4606
view (bulge editor) 4571

cross-hairs cursor 7536
crossing selection 201
CrossSection modifier 1259
crowd 4681, 4686, 4691, 4699, 4712, 

4730, 7748
behaviors 4691, 4699
creating crowd systems 4681
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crowd object 4686
definition 7748
delegate object 4691
keyboard shortcuts 4730
with bipeds 4712

crowd animation 4680, 4729, 4738, 
4791, 4795, 4799, 4801–4802, 
4805, 4807, 4811, 4814, 4817, 
4820, 4838, 4845, 4855, 4857

and bipeds 4738
ClipState dialog 4857
motionclip parameters dialog 4855
orientation behavior 4791
path follow behavior 4795
repel behavior 4799
scripted behavior 4801
seek behavior 4802
speed vary behavior 4805
surface arrive behavior 4807
surface follow behavior 4811
synthesis dialog 4845
user interface 4729
vector field space warp 4838
wall repel behavior 4814
wall seek behavior 4817
wander behavior 4820
working with 4680

crowd behaviors 4696
path follow 4696
seek 4696
wall seek 4696

crowd helper object 4738, 7748
crowd object 4739, 4742, 4755, 4758, 

4762, 4764, 4773–4774, 4779–
4780, 4785, 4822, 4826, 4830, 
4832, 4835–4836

associate bipeds with delegates
dialog 4762

behavior assignments and teams
dialog 4764

behavior rollout 4785
collisions rollout 4835
edit multiple delegates dialog 4758
geometry rollout 4836
global clip controller 4836
icon size 4836

object/delegate associations
dialog 4755

priority rollout 4826
scatter objects dialog 4742
select behavior type dialog 4773
select delegates dialog 4774
set start frames dialog 4830
setup rollout 4739
smoothing rollout 4832
solve rollout 4822
state dialog 4779
state transition dialog 4780

crowd simulation 4705, 4776, 4786
avoid behavior 4786
cognitive controller 4776
solving 4705

crowd system 7749
CS amplitude option (links) 4563, 4646
CSM files 4220, 4495, 4502–4503, 4876, 

7749
cube method 4839
cubic morph controller 3044
CUI files 7513, 7515–7516
current bulge angle 4606, 4656
current event (video post) 6599
current frame 7312, 7358
current value editor 3489, 3549
currentdefaults.ini 7486
currently assigned links only 4672
currently installed driver 7545
curve editor 3427, 3441, 3471, 3485, 

3495, 4379
display menu 3485
modes menu 3471

curve view 7749
curves 2293, 2432, 2438, 2468, 3589, 

4058, 4394
curve approximation 2468
curve fit 2293
curve point 2432
curve-curve intersection point 2438
curve-curve point 2438
freeze non-selected 3589
function 4058, 4394

curves menu 3478
Track View 3478
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curves toolbar 3495
custom attributes 267
custom grid 2538
custom splash screen 50
custom UI and defaults switcher 7484
custom UI scheme 7513
customize 4444

transitions 4444
customize menu 2577, 7279, 7480–

7482, 7489, 7515–7516, 7519–
7520, 7523, 7534, 7610

configure system paths 7523
configure user paths 7520
customize user interface 7489
grid and snap settings 2577
load custom UI scheme 7515
lock UI layout 7481
plug-in manager 7482
preferences 7534
revert to startup UI layout 7519
save custom UI scheme 7516
show UI 7480
viewport configuration 7610

customize user interface 7475, 7481, 
7489–7490, 7492, 7496, 7501, 
7505, 7515–7516, 7519

colors 7505
keyboard shortcuts 7490
load UI scheme 7515
lock UI layout 7481
menus 7501
overview 7475
quad menus 7496
revert to startup layout 7519
save UI scheme 7516
shortcuts 7490
toolbars 7492

customizing biped characters in figure
mode 4079

customizing user interface 3611
Track View 3611

cut 2019, 2033, 3554
and slice 2019, 2033
and snaps 2033
time (Track View) 3554

cut time (Track View) 3554

cutout mapping 5440, 5446
cutting hair 1073
CV 7750
CV curve 2208, 2286, 2327, 7751

CV curve 2208
CV curve (glossary) 7751
CV curve on surface 2327
CV curve sub-object 2286

CV sub-objects 2165
CV surface 2196, 2340, 7752

CV surface 2196
CV surface (glossary) 7752
CV surface sub-object 2340

CWS file 6152
CWS file (combustion workspace) 7121
cycling 3524

animation 3524
cylinder 364, 396, 6565

chamfer 396
CylGizmo 6565
standard primitive 364

cylindrical area omni light 4945

D

damper 811, 2624
damping joint action 3355
dashpots 3858, 3862

angular 3862
linear 3858

data files 7531
path for 7531

data management 6721, 6896
asset tracking dialog 6896
open from vault 6721

daylight 4969, 4973
IES sky 4973
IES sun 4969

DDS files 7122
deactivate footsteps 4114, 4355
deactivating 6343–6344

jobs in the queue 6343
servers in the queue 6344

decay 5065
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default 1807, 2502, 2758, 3034, 3447, 
4389, 4598, 4730, 4891, 4895, 
5250, 7352, 7564, 7645

controller settings 3034, 7564
controllers 3034
heights 2502
keyboard shortcuts 1807, 2758, 

3447, 4389, 4598, 4730, 7645
lighting 4891, 4895
material settings 5250
tangent types 7352

default color 4656
default scanline rollout 5950
default tangent types 7352
defaults 50, 7484, 7486

setting 7486
setting and changing 50
switching 7484

define 4474
append 4474
inser below 4474
insert above 4474
script 4474

defining 7329, 7652
search terms (HTML help

viewer) 7652
time tags 7329

deflector space warp 2676
deflector space warps 2650, 2656, 2661, 

2663–2664, 2666, 2669, 2673, 
2676

deflector 2676
PDynaFlect 2656
POmniFlect 2650
SDeflector 2669
SDynaFlect 2663
SOmniFlect 2661
UDeflector 2673
UDynaFlect 2666
UOmniFlect 2664

deform 746–747, 749, 752, 754
deform bevel 752
deform fit 754
deform scale 746
deform teeter 749
deform twist 747

deformable bodies 3947, 3949, 3960, 
3972, 3980, 3983, 3993

cloth 3949
constraints 3983
deforming meshes 3980
ropes 3972
soft bodies 3960
soft selection 3993

deformable constraints 3983, 3986–
3987, 3989, 3992

attach to deforming mesh 3992
attach to rigid body 3989
fixing vertices 3986
keyframe points 3987

deformable envelopes 4054, 4547, 4561, 
4594, 4600, 4636, 7752

deformation 4542, 7753
deformation spline 4544, 4547, 4563, 

4644, 7753
deformations (and loft objects) 756
deforming meshes 3980–3981

collection 3981
degree 2176, 7755
degree of freedom and rotating

links 4164
delegate 4691, 4732

adjusting parameters 4691
geometry parameters rollout 4732
motion parameters rollout 4732

delegates 4686, 4712, 4730, 7755
definition 7755
helper objects 4730, 7755
using bipeds with 4712

delete 205, 1267, 1269, 2768, 3520, 
3529–3530, 3553, 3609, 4093, 
4121, 4192, 4289, 4301, 4322, 
4355, 4427, 4436, 4444, 4468, 
4474, 4477, 4570–4572, 4606, 
4656, 4666, 5197, 6599, 7220, 
7315

biped 4093
bulge angle 4606, 4656
bulge angles 4570
bulge cross sections 4571
clip/transition 4427, 4468
control points 4606
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controller 3520
cross section slice 4606
current event (video post) 6599
footsteps 4121, 4355
key 4192, 4289, 4301
keys 3529–3530, 7315
layers 4322
maps 5197
material 5197
mesh modifier 1267
operator (particle flow) 2768
patch modifier 1267
Schematic View 7220
script 4436, 4474
selected keys (track bar) 7315
spline modifier 1269
tendons 4572
time (Track View) 3553
Track View 3609
transition 4477
transitions 4444

delete keys 3431, 3530
delete selected animation 7306
delete time (Track View) 3553
delete Track View 3609
delete twist pose 4278
delete UVW mapping 1871
deleting 606, 627, 1935, 2019, 2768, 

3553, 6345
blocks of time 3553
editable mesh edges 2019
editable mesh vertices 2019
isolated editable mesh vertices 2019
jobs in the queue 6345
particles 2768
patch surfaces 1935
splines 627
vertices 606

dent map 5708
dependencies (views menu) 108
dependent 7755
dependent sub-objects 2169, 7756
depot (particle view) 2739, 7756

display of 2739
glossary 7756

depth of field 5143, 6061, 6087, 6481

description panel (particle view) 2739, 
7757

display of 2739
glossary 7757

deselect all 189
Design Web Format 7013
designing clothing (garment

maker) 1172
designing materials 5164
destination clip 4477

transition editor 4477
destination directory 4520
destroy character 242
detach 225, 234, 1375, 1935, 1968, 

2019, 2449, 4666
detach (assembly) 234
detach (group menu) 225
detach dialog (edit poly) 1375
detach dialog (NURBS

curve/surface) 2449
editable mesh vertices 2019
editable patches 1968
patch surface 1935

DGS material (mental ray) 5529
dgs material shader (mental ray) 5815
diagnostics 6130

mental ray renderer 6130
dialog 169, 331, 1627, 1821, 1823, 

1826, 1831, 1835, 1844–1845, 
2130, 2136–2137, 2141, 3548, 
3596, 3691, 3695, 4296, 4455, 
4486, 6737, 6897, 6914, 6947, 
7472

asset tracking 6897
bevel polygons 2130
bitmap pager statistics 6947
chamfer 2136
color selector 331
connect edges 2137
extrude polygons 2141
filter selected euler tracks (Track

View) 3548
flatten mapping 1821
MAXScript debugger 7472
mixer transition editor 3691
normal mapping 1823
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pelt map parameters 1826
pick nodes 3695
pivot selection 4296
prompts 6914
relax tool 1831
render UVs 1835
select objects 169
shared motion flow 4455, 4486
track sets editor 3596
unfold mapping 1844
unwrap options 1845
weight tool 1627
XRef objects 6737

dialogs 6912, 7253
bitmap proxies 6912
global settings and defaults for bitmap

proxies 6912
toggling 7253

dielectric material shader (mental
ray) 5820

different ambient and different diffuse
materials dialog 6944

diffuse 5008, 5348, 5365, 5367–5368, 
7759

diffuse color (glossary) 7759
diffuse distribution 5008
diffuse level 5348
diffuse level mapping 5367
diffuse mapping 5365
roughness mapping 5368

diffuse map (baking) 6176
diffuse parameters rollout 6168
diffuse texture element rollout 6168
direct manipulation mode 2039
Direct3D driver 7582, 7592, 7594
Direct3D driver setup dialog 7592
directional parameters 5070
directories 6273, 6275–6276

for network rendering 6273
mounting 6276
sharing 6275

DirectX 10 7594
DirectX 9 shader material 5596
DirectX 9 shaders, FX file 7794
DirectX shaders 5297, 5596, 5598
disable layer 3088, 3090

disable particle system 2724
disabling playback 4545
disassemble 233
disc (circular) area light 4948
displace 1045, 1047, 1270, 1274, 2646

disp approx modifier (OSM) 1270
displace mesh (world space) 1045
displace modifier (OSM) 1274
displace NURBS (world space) 1047
displace space warp 2646

displacement mapping 1270, 5392, 5439
displacement shading 6079

mental ray renderer 6079
display 70, 124, 171, 2221, 2224, 2511, 

2864, 4077, 4093, 4241, 4243, 
4268, 4503, 4560, 4636, 4656, 
5228, 6923, 7217, 7226, 7254, 
7323, 7325, 7327, 7458, 7536, 
7545, 7564, 7806

backface cull 7458
coordinate display 7325
cross-hairs cursor 7536
display controls for NURBS

models 2221
display driver (specifying at

startup) 7254
display floater 7458
display floater (Schematic

View) 7217
display image 6923
display operator (particle flow) 2864
display performance 70
display plane 2511
display properties rollout 124
grid settings 7327
hide/unhide (glossary) 7806
hide/unhide objects 7458
key bracket display 7564
layer properties 7226
line parameters for NURBS

surfaces 2224
marker 4503
nth frame 7545
NU scale warning 7536
options/preferences 4077, 4093, 

4243, 4268, 4560, 4636, 4656
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properties 7458
reflectance 5228
selection floaters 171
stack collapse warning 7536
topology-dependence warning 7536
track bar 7323
trajectories 4241
transmittance 5228
world axis 7545

display color rollout 117
display driver setup dialog 7582
display menu 2738, 3485

curve editor 3485
particle view 2738

display menu (Schematic View) 7204
display panel 117, 119–120, 122, 124, 

129, 7457
display color rollout 117
display properties rollout 124
freeze rollout 122
hide by category rollout 119
hide rollout 120
link display rollout 129
object display 117

display rollout 1116, 1600, 4015
hair and fur modifier 1116

display subtree 4636
display trajectories 4289
displaying 3267, 3602–3603

links 3267
selected key statistics (Track

View) 3603
selected keys 3602

distance 2526, 2529, 7536
distance from origin (accuracy

setting) 7536
measuring 2526, 2529

distributed bucket rendering
rollout 6132

distributed maps 6132
distributed rendering 6132, 7907
distribution 5232

materials 5232
dithering (glossary) 7760
divide 618, 2019, 2033

edges 2033

editable mesh edges 2019
faces 2019
segments 618

divisions 4606, 4656
docking 7761
documentation for 3ds Max 11
DOF 5143, 6481
dolly 7398, 7409

camera 7398
light 7409
target 7398, 7409

don't affect children 3407
donut 564
doors 433, 502, 510, 512, 514

bifold 514
pivot 510
sliding 512

dope sheet 3427, 3442, 3471, 3501, 4379
modes menu 3471
toolbars 3501

Dope Sheet 4122
editing footstep timing 4122

DOS 6365
command-line rendering 6365

double support 4352, 4359, 7761
double-sided 7697
double-sided material 5552
download options (asset browser) 6950
drag and drop 1016, 5214, 5216, 5269, 

6842, 6957
and copied/instanced maps 5269
and instanced objects 6842
content from web pages 6957
maps and materials 5214
modifier 1016
sub-object material

assignment 5216
with i-drop indicator 6957

drag space warp 2624
draw control points 4606
draw in profile view 4606
draw links as lines 7545
drawing aids 2501, 2596
DRF files 6964, 6967
driver setup/configuration 7582, 7586, 

7588, 7594
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dummies 2531, 4226, 7761
dummy helper object 2531
dummy object (glossary) 7761

dummy objects 3288
using 3288

duplicate name dialog (material
library) 5272

DWF 7013
exporting 7013

DWG files 6979, 7003, 7762
exporting 7003
importing 6979

DWG/DXF import options dialog 6979, 
6984, 6993, 6995

geometry panel 6984
layers panel 6993
spline rendering panel 6995

DXF files 6979, 7006, 7762
exporting 7006
importing 6979, 7006

dynaflectors 2656, 2663, 2666, 7763
dynamic names (particle flow) 2739
dynamics 1057, 1099, 1109, 2727, 4075, 

4270, 4288, 4379, 7727, 7763
and footsteps 4379
dynamics blend 4270, 4288, 7763
hair and fur modifier 1057, 1099, 

1109
options 4075

dynamics & adaptation rollout 4336
dynamics deflectors 2656, 2663, 2666
dynamics objects 810
dynamics rollout 1109

hair and fur modifier 1109
dynamics utility 3775, 3790, 3796, 5327

dynamics properties rollout (Material
Editor) 3775, 5327

edit object dialog 3790
edit object list dialog 3796

E

ease curve 3583–3585, 7764
applying 3583
deleting 3584
enable toggle 3585

glossary 7764
ease options 4293, 4477

key info rollout 4293
transition editor 4477

ease out-of-range types (Track
View) 3585

edge - definition 7765
edge count 2493, 7629
edge visibility threshold 2007
edges 2007, 2019, 2033, 7560

aligning 2019
and rendering 7560
attaching 2019
chamfer 2019
creating shapes from 2007
cut and slice 2019
deleting 2019
divide 2033
dividing 2019
extruding 2019
make planar 2019
rotating 2019
welding 2019

edit 1284, 3551, 3564, 4253, 4375, 
4379, 4444, 4452, 4474, 6598, 
6604, 6607, 6613, 6620, 6623, 
6627, 6630, 6634, 6636–6643, 
6708–6711, 6812, 7331, 7511

alpha compositor (video post) 6708
biped 4452
button appearance 7511
clip 4474
contrast filter (video post) 6636
cross fade compositor (video

post) 6708
current event (video post) 6598
external event (video post) 6630
fade filter (video post) 6637
filter event (video post) 6620
footsteps 4253, 4375
freeform 4375
ghosts 4444
image alpha filter (video post) 6638
image input event (video post) 6613
layer event (video post) 6623
lens effects filter (video post) 6639
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loop event (video post) 6634
negative filter (video post) 6640
normals 1284
output image event (video

post) 6627
preset settings 6812
pseudo alpha compositor (video

post) 6709
pseudo alpha filter (video

post) 6641
range bar (video post) 6604
ranges (Track View) 3564
scene event (video post) 6607
simple additive compositor (video

post) 6710
simple wipe compositor (video

post) 6711
simple wipe filter (video post) 6642
starfield filter (video post) 6643
tag 7331
time 3551, 4379
time tag dialog 7331
transition 4474
transitions 4444

edit commands 202, 4556, 4636
and envelopes 4556

edit curve on surface dialog 2450
edit geometry rollout 1363, 2019, 2105

edit poly modifier 1363
editable mesh 2019
editable poly 2105

edit keys 4379
edit keys (Track View) 3482, 3529, 3538
edit keys mode 3443
edit macro button dialog 7511
edit menu 181, 189–192, 198–200, 203–

205, 245, 874, 888–889, 891, 965–
966, 2734, 7260

clone 965–966
delete 205
edit named selections 181
fetch 204
hold 204
move 888
object properties 245
particle view 2734

region 198
rotate 889
scale 891
select all 189
select by 191
select by color 191
select by layer 192
select by name 191
select invert 190
select none 189
select region crossing 200
select similar 190
selection method 199
transform type-in 874
undo/redo 203

edit menu (Schematic View) 7201
edit modifiers 1027, 1283, 1293

and editable objects 1027
edit mesh modifier 1283
edit poly modifier 1293

edit multiple delegates dialog 4758
edit named selections 181
edit normals 1284

edit normals modifier 1284
edit object dialog 3790
edit object list dialog 3796
edit poly 1318–1319, 1321, 1330, 1344, 

1350, 1364, 1375, 2125, 2130–
2131, 2133, 2136–2137, 2139, 
2141–2143, 2145–2146, 2148–
2150

align geometry dialog 1375
bevel polygons dialog 2130
border 1344
bridge borders/polygons

dialog 2131
bridge edges dialog 2133
chamfer dialog 2136
connect edges dialog 2137
constraints 1364
detach dialog 1375
edge 1330
extrude edges dialog 2142
extrude polygons along spline

dialog 2139
extrude polygons dialog 2141
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extrude vertices dialog 2142
hinge from edge dialog 2143
inset polygons dialog 2145
meshsmooth selection dialog 2145
object 1319
paint deformation rollout 2125
polygon/element 1350
preserve map channels dialog 2146
preview selection 1318
relax dialog 2148
selection information 1319
sub-object constraints 1364
tessellate selection dialog 2149
vertex 1321
weld dialog 2150
weld edges dialog 2150
weld vertices dialog 2150

edit poly modifier 1293, 1308, 1363
edit geometry rollout 1363
selection rollout 1308

edit ranges 3564
edit ranges mode (Track View) 3445, 

3482
edit texture surface dialog 2453
edit time mode (Track View) 3482, 3551
edit time tag 7331
edit track set 3596
edit UVWs dialog 1788, 1799

menu bar 1799
edit wire 3250
editable mesh 1990, 1998, 2001, 2007, 

2014, 2019, 7765
aligning 2019
edge 2007
edit geometry rollout 2019
element 2014
exploding 2019
face 2014
object 1998
polygon 2014
vertex 2001

editable objects and edit modifiers 1027
editable patch 1935, 1944, 1947, 1954, 

1956, 1959, 1965, 1968, 1971
attach 1968
changing vertex type 1968

deleting vertices 1968
detach 1968
edge 1956
element 1965
geometry rollout 1968
handle 1954
object 1944
patch 1959
vector 1954
vertex 1947
visibility of 1971

editable poly 2038, 2043, 2051, 2053, 
2055, 2066, 2085, 2091, 2105, 
2107, 2118, 2123, 2125, 2130–
2131, 2133, 2136–2137, 2139, 
2141–2143, 2145–2146, 2148–
2150, 7765

bevel polygons dialog 2130
border 2085
bridge borders/polygons

dialog 2131
bridge edges dialog 2133
chamfer dialog 2136
connect edges dialog 2137
constraints 2107
edge 2066
edit geometry rollout 2105
extrude edges dialog 2142
extrude polygons along spline

dialog 2139
extrude polygons dialog 2141
extrude vertices dialog 2142
glossary 7765
hinge from edge dialog 2143
inset polygons dialog 2145
meshsmooth selection dialog 2145
object 2053
paint deformation rollout 2125
polygon/element 2091
preserve map channels dialog 2146
preview selection 2051
relax dialog 2148
selection information 2053
selection rollout 2043
sub-object constraints 2107
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subdivision displacement
rollout 2123

subdivision surface rollout 2118
tessellate selection dialog 2149
vertex 2055
weld dialog 2150
weld edges dialog 2150
weld vertices dialog 2150

editable spline 590, 602, 606, 618, 627, 
1696

and overlapping vertices 590
attaching to 618
general rollout (for object and

sub-objects) 590
identification numbers and 590
object 602
rendering options 590
segment 618
setting vertex type 606
spline 627
vertex 606
vertex area selection 590

editing 146, 466, 845, 849, 1023, 2231, 
2238, 2244, 2252, 2264, 2429, 
2741, 3052, 3551, 4121–4122, 
4126, 4352, 7331, 7638

action parameters (particle
view) 2741

active footsteps in time 4126
animation 3052
bones 845, 849
curve cv sub-objects 2238
curve sub-objects 2252
fins (bones) 849
footstep placement 4121
footsteps 4352
footsteps in time 4122
footsteps in Track View 4122
modifier stack 1023
named selection sets 146
point sub-objects 2231, 2429
strokes 7638
surface cv sub-objects 2244
surface sub-objects 2264
time (Track View) 3551
time tags 7331

wall objects 466
editing track sets 3594
editor 4776

cognitive controller 4776
edtiable patch 1940

selection rollout 1940
effects 6379–6380, 6382–6383, 6392, 

6398, 6405, 6414, 6422, 6429, 
6436, 6443, 6461, 6471–6473, 
6476, 6481

auto secondary lens effects 6422
blur lens effects 6461
brightness and contrast lens

effects 6471
color balance lens effects 6472
depth of field lens effects 6481
effects (rendering menu) 6382
effects panel 6383
environment and effects

dialog 6380
file output lens effects 6473
film grain lens effects 6476
glow lens effects 6398
lens effects 6392
manual secondary lens effects 6429
ray lens effects 6414
rings lens effects 6405
star lens effects 6436
streak lens effects 6443

elements 6144, 6174, 7766
of rendered textures 6174
rendering 6144

ellipse 559
email notification 5939, 6291

network rendering 6291
rendering 5939

emission rollout (particle view) 2751
emit start/stop values, and frame

rate 2766
emitter (particle flow) 2749, 7766
empty flow operator 2875
enable ease or multiplier curve

toggle 3585
enable layer 3090
encapsulated PostScript files 7124
end effector 4535
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end effectors 3302, 3307, 3346, 3350, 
3366, 7767

animating 3346
linking to parent 3346

entering frames 3601
entire link 4606, 4656
entities 6819

AutoCAD 6819
envelope parameters 4636
envelope sub-object 4625, 4627, 4633

exclude envelopes dialog 4627
envelopes 4054, 4544, 4547, 4551, 

4556, 4560–4562, 4627, 4636, 
7767

adjusting shapes 4551
and control points 4556
and cross sections 4556
and edit commands 4556
and weighted vertices 4054
blending types 4551
choosing default fit 4544
choosing default types 4544
copying 4551
copying to mirrored link 4556
display options 4560
exclude for selected links 4627
excluding influence 4551
overview 4547
scaling size 4551
selecting 4551
types of 4547
updating display manually 4560
using transforms with 4551
working with 4561
working with both envelope

types 4562
working with rigid 4561

environment 5397, 6484, 6486, 6532, 
7768

and raytrace materials 5397
environment map (glossary) 7768
environment panel 6486
exposure controls 6532

environment and effects dialog 6380, 
6383, 6486

effects panel 6383

environment panel 6486
environment effect 6494, 6507, 6512, 

6521
fire 6494
fog 6507
volume fog 6512
volume light 6521

environment map 6106, 6489, 7768
assigning 6489
definition 7768
final gather light source 6106

environment shader (mental ray) 5823
environments 6379–6380

environment and effects
dialog 6380

EPS files 7124
error threshold (camera tracker) 3760
errors 53, 1258

garment maker 1258
euler filter 3548
euler rotation 4164, 4215, 4276

controller 4164
Euler XYZ rotation controller 3076
euler/tangent 4215
events (particle flow) 2728, 2741, 2745, 

2871, 7770, 7772–7773, 7817, 
7831

and action sequence 2728
branching 2728
event display 2741, 2745, 7772
event level 7773
glossary 7770
inputs 7817
local 7831
notating 2871
properties 2745

events (video post) 6601
every step update script (particle

flow) 2756
exclude 3560–3561, 4917, 5043

exclude left end point (Track
View) 3560

exclude right end point (Track
View) 3561

exclude/include lights 4917, 5043
exclude envelopes dialog 4627
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exclude left end point (Track View) 3560
exclude option 4551, 4627
exclude right end point (Track

View) 3561
excluding layers 6813
excluding particles from lighting 2724
execute network rendering 6248
execute sequence (video post) 6601
exit command (file menu) 6926
expanding animation tracks 4154, 4158
expert mode 116
explicit axis keys 3038, 3146
explode 225, 233, 627, 2019, 2629, 2707

assemblies 233
editable mesh

objects/sub-objects 2019
explode angle threshold 2019
groups 225
objects into faces 2707
particle system 2629
splines 627

explode angle threshold 2019
exploding objects 2629
explosion 2629
explosions 2723
export animation 3663

motion mixer 3663
export selected (file menu) 6895
exporting 1835, 4224, 6894–6895, 6972, 

6976–6977, 7003, 7006, 7013, 
7019, 7027–7028, 7030, 7033, 
7038, 7058, 7061–7062, 7076, 
7078–7079, 7083

3D DWF 7013
3DS files 6972
Adobe Illustrator files 6976
animation 4224
ASCII files 6977
bones 7061
DWG files 7003
DXF files 7006
export (file menu) 6894
FBX 7019
HTR/HTR2 7058
IGES files 7027
m3g files 7030, 7033, 7038

MTL 7078
OBJ 7079
objects 6895
selected objects 6895
Shockwave 3D files 7061–7062
stereolithography 7076
STL files 7076
texture coordinates 1835
to IGES 7028
UVs 1835
VRML97 files 7083
W3D files 7061–7062

exporting materials 5185
expose transform 2532

helper object 2532
exposetm 2532

helper object 2532
exposure control 6535, 6538, 6540, 

6544, 6552
automatic 6535
linear 6538
logarithmic 6540
mr photographic 6544
pseudo color 6552

exposure controls 6532
expression controller 3080, 3086
expression evaluator 38
expression techniques 299
extended parameters rollout

(materials) 5312
extended primitives 383, 385, 389, 393, 

396, 399, 403, 405, 409, 411, 
414, 418, 423, 426

C-Ext 414
capsule 403
chamfer box 393
chamfer cylinder 396
gengon 411
hedra 385
hose 426
L-Ext 409
L-Extrusion 409
oil tank 399
prism 423
ringwave 418
spindle 405
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torus knot 389
extended shapes 580, 583, 585, 587, 589

angle 585
channel 583
tee 587
wide flange 589
wrectangle 580

extended splines 542
extents 2738, 7919

scene extents 7919
zoom extents (particle view) 2738

extents (glossary) 7773
external event (video post) 6630
external reference 7978
external reference, AutoCAD

(glossary) 7977
extraction tolerance 4511
extras dope sheet toolbar 3507

Track View 3507
extras toolbar 7290
extrude 1377, 1381, 1968, 2019, 2362

editable mesh edges 2019
extrude modifier 1377
extrude surface (NURBS) 2362
faces 1381
faces and polygons 2019
patches 1968

extrude edges dialog 2142
extrude polygons along spline

dialog 2139
extrude polygons dialog 2141
extrude vertices dialog 2142
extruded shapes 409, 414
eyedropper tool 5264

F

f-curves 4058, 4394
f-stop 6061, 6087
face - definition 7774
face extrude modifier 1381
face/edge thresholds (optimize

modifier) 1515
faces 2014, 2019

assigning to smoothing groups 2014
beveling and extruding 2019

creating 2019
dividing 2019
tessellating 2019

faceted (glossary) 7774
facial animation 4579
facial expression 1474
fade filter (video post) 6637
fade in/out (lights) 5065
falloff 4600, 4636, 4646, 5051, 5716, 

7415, 7811
falloff map 5716
glossary 7811
light falloff 7415

family elements 6843
from Revit 6843
rendering properties 6843

fast adaptive antialiaser 5427
fast view display mode 7611
favorite location dialog 6952
favorites 6952, 7657

asset browser 6952
HTML help viewer 7657

FBX 7019
exporting 7019
importing 7019

FBX files 4224
feedback about the documentation 11, 

7650
fence selection region 194
fetch (edit menu) 204
FFD soft bodies 3966
FFD(box) space warp 2678
FFD(cyl) space warp 2685
FFDs 1395, 2678, 2685, 4054, 4587, 

7775
and physique 4587
FFD select modifier 1395
FFD(box) space warp 2678
FFD(cylinder) space warp 2685

FGM files 7775
field of view 7389, 7776

flyout 7389
glossary 7776

field-of-view 7390
field-of-view button 7390

fields (glossary) 7777
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FIG (figure) files 4097, 4253, 4511
saving and loading 4097

FIG files 4261, 4264, 4876
loading 4264
saving 4261

figure mode 4054, 4253, 4339, 4343, 
7778

figure structure 4511
file corruption 7663
file formats 4220, 4876
file i/o path configuration 7524
file link 6772, 6774, 6777, 6793–6794, 

6799, 6806, 6813–6814, 7701
advanced settings 6799
basic settings 6794
basics 6772
excluding layers 6813
file link settings dialog 6793, 6806
including layers 6813
presets 6794, 6799
tips for using 6777
working with drawing files 6774
xref resolution 6814

file menu 6715–6718, 6723–6724, 6726–
6727, 6732, 6755, 6854, 6859, 
6866, 6873, 6876, 6892, 6894–
6895, 6918–6920, 6923, 6926, 
7259

archive 6918
exit 6926
export 6894
export selected 6895
file properties 6920
import 6892
load animation 6873
merge 6854
merge animation 6859
new 6716
open 6718
open recent 6723
replace 6866
reset 6717
save 6723
save animation 6876
save as 6724
save copy as 6726

save selected 6727
summary info 6919
view image file 6923
XRef objects 6732
XRef scene 6755

file output 6473
file properties 6920
file types 4222, 4230, 4253, 4467, 4496, 

4502–4503, 4511, 4574, 4590, 
6152, 7727, 7737–7738, 7749, 
7841, 7894

.mfe file 4467
BIP 4222, 7727
BVH 7737, 7841
CAL 4511
CSM 4502, 7738, 7749, 7841
CWS 6152
FIG 4253, 4511
MNM 4496, 4502
MOC 4503, 4511
PHY 4574, 4590, 7894
STP 4230

file-handling commands 6715
files 44, 4461, 6939, 7541, 7608

backup and saving 7541
compressed 7541
finding 6939
incremental saves 7541
managing 44
mismatched units 7608
motion flow editor 4461
preferences settings 7541
recent in file menu 7541

fillet 606, 1396, 2308, 2423, 7779
and editable splines 606
fillet curve 2308
fillet surface 2423
fillet/chamfer modifier 1396
glossary 7779

film grain effect 6476
filter color mapping 5376
filter color/filter opacity (glossary) 7780
filtering 3548, 3637, 3703–3704, 4058, 

4511
euler tracks (Track View) 3548
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motion capture and marker
data 4511

trackgroups 3703–3704
tracks in motion mixer 3637

filtering bitmaps 7781
filtering character animation 7781
filters 148, 176–177, 3507–3508, 3548, 

6083, 6096, 6620, 7315, 7347, 
7545, 7914

add filter event (video post) 6620
caustics 6096
creating custom 148
edit filter event (video post) 6620
environment backgrounds

(viewports) 7545
euler tracks (Track View) 3548
filter (track bar) 7315
filter combinations dialog 177
filtering selections 176
filters button (Track View) 3507
filters dialog (Track View) 3508
key 7347
sampling 7914

filters panel 4421
final gather map (FGM file) 7775
final gather rollout 6104
final gathering 6072, 6104, 6106, 7782

environment map as light
source 6106

final step update script (particle
flow) 2756

find target test (particle flow) 2892
finding errors 4401
finding, next/previous key 4289
fine-tuning envelopes 4556
fingers option 4077
fins (bones) 831, 849
fire environment effect 6494
first vertex 606, 7785
fit 4636, 4666
fit (deformation) 754
fit to existing 4511
fix ambient utility 6944
fix panel 4416
fix vertices constraint 3986

fixed 4477
transition editor 4477

fixed width text button 7536
fixed window 528
fixing errors 4058, 4401, 4416
fixing motion errors 4421
fixing problems 7663
flag properties dialog (Material

Editor) 5684
flag with black 7560
flat mirror map 5774, 6048, 7786
flatten footsteps 4511
flatten mapping 1803, 1821
flatten sides 2019
flex modifier 1401, 1418
flexibility (neck and spine) 4077
flip normals 340, 2014
float controllers 3039
float limit controller 3106
floaters 171, 845, 874, 7217, 7458

bone tools 845
display floaters 7458
Schematic View display floater 7217
selection floaters 171
transform type-in 874

floating 7761
floating bones 4541, 4597
flows (particle flow) 2875–2876, 7787

empty flow 2875
glossary 7787
standard flow 2876

fluorescence (glossary) 7788
flyouts 38, 175, 891, 904, 938, 5254, 

5908, 7352, 7381, 7387, 7389, 
7395, 7398, 7409, 7419, 7536, 
7789

align 938
arc rotate 7395
default tangent types 7352
dolly camera/target 7398
dolly light/target 7409
field of view 7389
flyout (glossary) 7789
material ID channel 5254
orbit/pan light 7419
quick render 5908
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select and scale 891
selection region 175
timing preferences 7536
use center 904
zoom extents 7387
zoom extents all 7381

focus plane 6061
fog 7099

VRML97 helper 7099
fog environment effect 6507
folder 4461

motion flow editor 4461
foliage 433, 439
follow object 3347, 7789

binding to 3347
glossary 7789

follow/bank utility 3719
foot states 4052, 4253, 4306, 7790
footcandle 7813
footstep 4098, 4107, 4110, 4118, 4153, 

4351, 4375, 7790
adaptation 4351
animation (glossary) 7790
animation workflow 4098
converting to freeform 4153
creation 4110
edge selection 4375
editing 4351
keys 4118
leg states 4118
timing (gait parameters) 4107

footstep creation 4052, 4253, 4352, 
4355, 4365, 4369

create multiple footsteps
(jump) 4369

create multiple footsteps (run) 4365
footstep operations 4355

footstep extraction 4495, 4511
using motion-capture filtering 4495

footstep keys 4118
body horizontal 4118
body turning/rotation 4118
body vertical 4118

footstep method 4052
footstep mode 4253, 4351
footstep operations rollout 4253, 4355

footsteps 4093, 4107, 4109–4110, 4114, 
4121–4122, 4147, 4149, 4372, 
4375

activating 4114
airborne period 4149
appending 4110
bending path 4121
convert to 4372
creating 4110
creating automatically 4109
creating multiple 4109
deleting 4121
display 4093
editing in time 4122
editing placement 4121
footstep mode dialog 4375
freeform period between 4149
moving and rotating 4121
saving 4147
selecting in Dope Sheet mode 4122
selecting in viewports 4121
timing 4122
timing gait parameters 4107

footsteps method 7790
force operator (particle flow) 2867
force space warps 2610, 2615, 2619, 

2624, 2629, 2635, 2640, 2643, 
2646

displace 2646
drag 2624
gravity 2640
motor 2615
path follow 2635
PBomb 2629
push 2610
vortex 2619
wind 2643

forward kinematics 3279, 3299, 4288, 
7791

and IK 3299
manipulating hierarchies with 3279

forward kinematics and bipeds 7791
FOV 7390

field-of-view button 7390
fps 2493
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fracture 3934, 3940
tips 3940

fragmentation (particle flow) 2723
frame 4477

transition editor 4477
frame rate 2766, 3024, 7359, 7791

and emit start/stop values (particle
flow) 2766

frames (snapping) 3530
frames per second 7629
free area light 4967
free camera 5116
free directional light 4936
free key defaults 4289
free lights 4930, 4936, 4963

direct 4936
directional 4936
linear 4963
spot 4930

free-form deformation (FFD) 1395, 
2678, 2685

box 2678
cylinder 2685
select modifier 1395

freeform 4052, 4149, 4153, 4185, 4372
animation 4185
convert to 4372
converting to footsteps 4153
inserting period between

footsteps 4149
method 4052
setting period in footstep

animations 4149
freeform animation 4154, 4379, 7792
freeform method 7792
freeze 122, 152, 7458, 7793

freeze rollout (display panel) 122
freeze/unfreeze (glossary) 7793
freezing/unfreezing objects 152, 

7458
freeze non-selected curves (Track

View) 3589
frequently asked questions 4033

reactor 4033
frizz animation 1057, 1099

hair and fur modifier 1057, 1099

frizz parameters rollout 1099
hair and fur modifier 1099

from z level 4511
full screen 7382
function curve editor 3441, 3495
function curves 3573, 3578, 3580, 4058, 

4394, 4401, 7794
add keys mode 3578
glossary 7794
show tangents 3580
Track View 3573

funnel-like objects 2619
fuse vertices 606, 618, 627
fusing (glossary) 7794
FX files 7794

G

G-buffer 7560
layers (rendering preferences) 7560

gait pattern 7797
gait type 7797
game engine - edit normals 1284
gamma correction (glossary) 7551, 7798
gamma preferences 7550
garment maker 1258

troubleshooting and error
codes 1258

garment maker modifier 1172, 1228, 
1243

user interface 1243
using 1172

general parameters (lights) 5035
general parameters rollout 1084

hair and fur modifier 1084
general preferences settings 7536
general settings rollout 6197

render to texture 6197
generate colors 4268
gengon 411
geographic location dialog 5033
geometric primitives 7799
geometric/deformable space

warps 2678, 2685, 2695, 2700, 
2703, 2707

bomb 2707
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conform 2703
FFD(box) 2678
FFD(cyl) 2685
ripple 2700
wave 2695

geometry 321, 345, 348, 383, 502, 516, 
638, 715, 1175, 6818, 6821, 
6958, 6960

AutoCAD 6818, 6821
compound objects 638
doors 502
effect on cloth 1175
extended primitives 383
file formats 6958
geometric primitives 345
importing 6960
loft object 715
standard primitives 348
types of 321
windows 516

geometry parameters rollout 4732
geometry rollout 1968, 4836

patch 1968
GeoSphere 361
get material 5245
getting started 17, 19
ghost 4477

transition editor 4477
ghosts 7545

ghost before/after current
frame 7545

ghost in wireframe 7545
GI (global illumination) 5976
GIF files 7126
gizmo 867, 3750, 6560, 6562, 6565, 

6567, 7570, 7800
box atmospheric apparatus 6562
cylinder atmospheric

apparatus 6565
gizmo/center (glossary) 7800
preferences 7570
sphere atmospheric apparatus 6567
tracker 3750
types of 6560
using transform gizmos 867

gizmos rollout 1600

glare shader (mental ray) 5825
global and local exclude/include dialog

(for raytraced maps and
materials) 5425

global clip 4724, 4845
global clip controller 4836, 7803
global event (particle flow) 7801
global illumination 5976, 5996, 6072, 

6096, 7782
global illumination (mental ray) 6044
global lighting (rendered

environment) 6486
global motion clip 4724
global raytracer settings dialog 6030
global settings and defaults for bitmap

proxies dialog 6912
global shadow parameters (Track

View) 3454
global viewport rendering setting 114
glossary 7697
glossiness mapping 5372, 7803
glow 6398

render effect 6398
go to rotation test 2903
go to settings 5261, 7323, 7355, 7357–

7358
Material Editor 5261
time 7323, 7355, 7357–7358

goal (and IK chain) 3307
goniometric diagrams 5014
grab viewport 85
gradients 2853, 5673, 5678, 6700, 6702, 

6704, 6707
gradient map 5673
gradient mapping 2853
gradient ramp map 5678
lens effects gradient colors (video

post) 6707
lens effects gradient options (video

post) 6702
lens effects gradient types (video

post) 6704
lens effects gradients (Video

Post) 6700
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graph editors menu 3427, 3608–3610, 
7193, 7219–7220, 7278

delete schematic view 7220
delete Track View 3609
new schematic view 7193, 7219
new Track View 3608
saved schematic views 7193, 7220
saved Track View 3610
Track View 3609
Track View - curve editor 3427
Track View - dope sheet 3427

graphics driver setup dialog 7582
GravAccel (gravitational

acceleration) 4075, 4139, 4336, 
7804

gravity 4139, 7804
computation 4139

gravity space warp 2640
green 4606, 4672

line 4606
rigid vertices 4672

grid 2514
autogrid 2514

grid and snap settings 2577–2578, 2585, 
2587, 2592, 2595, 7327, 7545

grid nudge distance 7545
grid setting display 7327
home grid settings 2592
options 2587
snap override 2585
snaps 2578
user grids settings 2595

grid method 6142
grid method, raytrace acceleration 7905
grids 1979, 2019, 2506, 2510–2511, 

2538, 2564–2566, 2577, 7805
activating 2565–2566
align to view 2566
aligning to 2019
and resolution of patch model

surface 1979
grid and snap settings 2577
grid helper object 2538
show home grid 2564
using 2506, 2510
viewing 2511

ground plane (and collision
detection) 4164

group 4474
script 4474

group menu 221–226, 232, 7262
attach 226
close 224
detach 225
explode 225
group 222
open 223
ungroup 224

groups 224–225, 234, 343, 4544, 7262
and attaching physique 4544
and selection sets 7262
closing nested groups 224
detach from 234
explode 225
smoothing 343
using 7262

grow 1632
growth objects 1051

hair and fur modifier 1051
guide hairs 1051, 1070

hair and fur modifier 1051, 1070

H

hair 1070, 1073, 5076, 6389, 6391
brush for styling 1073
compositing method 6389
cutting 1073
light attributes 5076
shadows 6391
styling 1070
styling rollout 1070

hair and fur 1050, 1056, 6386, 6388
and lighting 1056, 6386
components 1050
rendering options 6388

hair and fur modifier 1049, 1051, 1053, 
1057–1059, 1061, 1070, 1082, 
1084, 1091, 1098–1099, 1104, 
1107, 1109, 1116

animation 1057, 1099, 1109
display rollout 1116
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dynamics 1057, 1099, 1109
dynamics rollout 1109
frizz animation 1057, 1099
frizz parameters rollout 1099
general parameters rollout 1084
growth objects 1051
guide hairs 1051, 1070
instanced hair 1061
kink parameters rollout 1104
material parameters rollout 1091
mr parameters rollout 1098
multi strand parameters

rollout 1107
quad menu 1082
selection rollout 1059
splines 1051
styling hair 1053, 1070
styling rollout 1070
surfaces 1051
tools rollout 1061
user interface 1058

hair and fur render effect 6386
hair and fur render element 6163
hair light attributes 5076
handle display size 7546
hardware display 114

with maps 114
without maps 114

hardware requirements 6259
HD IK solver 3307, 3346, 3357, 3410–

3411, 3414, 3416, 3418
HD solver 3418
HD Solver 3347, 3349, 3360, 3364, 

3366, 3410–3411, 3414, 3416
HDR file format 7126
HDRI files 7126
head object 234
head object (glossary) 7806
hedra 385
height map (baking) 6177
height map displacement shader (mental

ray) 5828
height option 4077, 4343
helix 574
help 7647–7648, 7652, 7657

about HTML help 7648

contents 7648
favorites tab 7657
index 7648
search 7648
searching for help topics 7652

help menu 7281
helper object 7806
helpers 235, 2503, 2526, 2530–2532, 

2538, 2544, 2546, 2549, 2551–
2552, 2556, 2559, 3831, 5157, 
6560, 7093

atmospheric apparatus 6560
camera match 5157
compass 2551
cone angle 2552
dummy 2531
expose transform 2532
exposetm 2532
grid 2538
luminaire 235
manipulators 2552
plane angle 2556
point 2544
protractor 2549
reactor 3831
slider 2559
standard 2530
tape 2546
VRML97 7093

HI IK solver 3307, 3316, 3321, 3331, 
3336, 3340, 3342

IK display options rollout 3340
IK solver properties rollout 3336
IK solver rollout 3331
sliding and rotational joints 3342

HI Solver 3336
hide 120, 4672, 7806
hide attached nodes 4594
hide by category 119
hide reference geometry 1561
hide/show all 4268
hiding and unhiding 119–120, 154, 

156, 606, 1968
by category 119, 156
by selection 154
edges 1968
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editable spline vertices 606
hide rollout 120

hierarchical linkage 7806
hierarchical subdivision surfaces 1420
hierarchies 3256, 3260, 3267, 3275, 

3277, 7806
hierarchical linkage (glossary) 7806
joint limits 3267
navigating 3277
terminology 3256
using multiple 3260
viewing 3275

hierarchy of biped objects (Track
View) 4154

hierarchy panel 3397, 3399, 3409, 3424, 
7453

commands 3397
IK 3409
link info rollouts 3424
pivot 3399

hierarchy right-click menu (Track
View) 3461

hierarchy window (Track View) 3591–
3592

placing selected objects 3591
selecting by name 3592

high dynamic range images 7126, 7141
high-resolution rendering 6293
highlights 5353, 5355, 5357–5358, 7935

anisotropic 5353
Blinn 5355
metal 5357
multi-layer 5358
Oren-Nayar-Blinn 5355
Phong 5355
specular color 7935

hinge constraint 3892
hinge polygons from edge dialog 2143
history list 6723, 6923, 7199
history-dependent IK solver 3307
history-independent IK solver 3307, 

3316
hold (edit menu) 204
home grid 58, 2507, 2592, 7808

glossary 7808
settings 2592

using 2507
views based on the world coordinate

axes 58
hopping (dynamics of) 4139
horizon (glossary) 7809
horizontal (move key) 3575
horizontal bezier handle control 3580
horizontal text in vertical toolbar 7536
hose 426
hosts file 6132
hot (glossary) 7810
hot keys 1807, 2758, 3447, 4389, 4598, 

4730, 7645
hotspot 5051, 7411, 7811
how many 4359, 4365, 4369
how to (NURBS) 2180, 2186, 2188

fix objects 2186
improve performance 2188
make things 2180

how tos 4877
HSDS modifier 1172, 1176, 1420, 1428
HSV (glossary) 7908
HTML help viewer 7650, 7652, 7657–

7659
favorites tab 7657
keyboard shortcuts 7659
right-click menus 7659
searching in 7652
toolbar 7658
using 7650

HTR/HTR2 7054, 7058
exporting 7058
importing 7054

hue/saturation/value (glossary) 7908

I

i-drop Indicator 6957
IAM files 7008

importing 7008
ICB targa files (glossary) 7162
icons 3810, 7516, 7531

color scheme 7516
path for additional 7531
reactor 3810
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ID 5252
material ID channel 5252

IES 4969, 4973, 5017
IES sky 4973
IES sun 4969

IFL files 5885, 6923, 7131, 7134, 7136
and view file command 5885, 6923
IFL manager utility 7136
image file list control dialog 7134

IGES 7020, 7022–7023, 7025, 7027–
7028, 7812

and NURBS surfaces 7020
export/import log file 7022–7023, 

7027
exporting to 7028
file translation 7020
glossary 7812
history 7020
IGES import dialog 7023
import table to 3ds Max 7025
log files 7022
overview 7020
temporary files 7023

ignore animation range 3520
ignore backfacing 1990, 2019, 2033
IK 3011, 3299, 3302, 3316, 3383, 7568, 

7813
and control objects 3299
and set key 3011
animating with interactive IK 3383
IK joints 3302
IK solution (glossary) 7813
overlapping chains 3316
preferences 7568

IK blend 4294, 7812
IK constraints 4181, 4185
IK limb solver 3307, 3368
IK object 4288
IK only option 4335
IK rollouts 3331, 3340, 3379, 3409–

3410, 3421, 3423
auto termination 3423
display options 3340
IK solver rollout 3331
inverse kinematics 3421
object parameters 3410

spline IK solver rollouts 3379
IK solvers 3307, 3316, 3331, 3346, 3368
illegal video colors 5236
illuminance 7813
image alpha filter (video post) 6638
image file formats 7116
image file list 7134, 7136

IFL control dialog 7134
IFL manager utility 7136

image filter event (video post) 6620
image input event (video post) 6613
image input options (video post) 6617
image layer event (video post) 6623
image motion blur (glossary) 7814
image output event (video post) 6627
image sequence 5885
images (2D) 7116
import 6859, 6892, 7023, 7025, 7073

animations 6859
file menu 6892
IGES files 7023, 7025
import options 7073
merge animation 6859

importing 47, 2226, 4224, 4496, 6969, 
6971, 6974–6975, 6979, 7006, 
7008, 7019, 7023, 7044, 7054, 
7056, 7073, 7082

3DS files 6969
Adobe Illustrator 88 files 6975
and attaching 3ds Max objects 2226
animation 4224
DDF 7044
DEM Models 7044
DWG and DXF files 6979
DXF files 7006
FBX 7019
HTR/HTR2 7054
IAM files 7008
IGES files 7023
IPT files 7008
landXML 7044
marker file 4496
motion-capture file 4496
PRJ files 6971
scenes 47
SHP files 6974
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STL files 7073
TRC 7056
VRML files 7082

importing geometry 6960
merge or replace scene 6960

importing motion-capture data 4231
IMSQ files 7138
in 7352

tangent 7352
in place mode 4240–4241, 4253, 7816

using to adjust keyframes 4241
include new bones 4600
include/exclude lights 4917
including layers 6813
incremental saves 53, 7541
independent 7020, 7816
index of refraction 5312, 5387, 5397, 

5437, 5716, 5799
indirect illumination 6096, 7894
influence 171, 4547, 4606, 4656, 6754, 

6857, 7816
areas of and envelopes 4547

influenced vertices 4666
inherit rollout 3425
inheritance 3296
initial graphics exchange specification

(IGES) 7020, 7812
initial pose 4600, 4602, 4636, 4656, 

4666, 4672, 7817
initializing 6300, 7703

and ActiveShade 7703
manager program 6300
server program 6300

initializing physique 4544, 7817
ink 'n paint material 5580
inline (VRML VRML97 helpers) 7115
inner envelope 4636
inner/outer bounds 4547
input devices for motion capture 3721
inputs (particle flow) 7817
insert 241, 243, 602, 627, 2745, 3558, 

4606, 4656, 4666, 6859
actions, events (particle view) 2745
bulge angle 4606, 4656
control points 4606
cross section slice 4606

insert animation 241
insert character 243
insert tracks dialog 6859
time (Track View) 3558
tracks 6859
vertices 602, 627

insert keys 3537
inset polygons dialog 2145
inside 4646
installing 6272

3ds Max (for network
rendering) 6272

installing network services 6302
instance duplicate maps utility 5869
instanced hair 1061

hair and fur modifier 1061
instanced modifiers 1040
instanced objects 6842–6844

AutoCAD 6842
rendering properties 6843–6844

instances 955, 2825, 3567, 3571, 5232, 
5269, 7818

glossary 7818
make unique 3567, 3571
of maps 5269
overview 955
propagating materials 5232
propagation 5232
shape instance operator (particle

flow) 2825
instances in motion mixer 7819
integration steps (particle flow) 2755
intensity (light) 4898, 4904
intensity mapping 5439
intensity/color/attenuation

parameters 5065
intensity/color/distribution rollout 5077
interactive IK 3383
interactive manipulation mode 2039
interactive redraw 4656, 4666
interactive rendering 5910, 5917–5918, 

7966
interactive reshade 5910, 5919
interactive update (Track View) 3479
internet 6928, 6950, 6956

access 6956
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connection 6928
internet download dialog 6950

interparticle collision 2937
interpolation 4109, 4359, 4365, 4369, 

7820
stride 4109

intersection 7545
introduction 132, 160, 2152, 2713, 

3299, 3803, 3811, 6381, 7647
dynamics 3811
inverse kinematics 3299
NURBS modeling 2152
object selection 132
particle flow 2713
physics 3811
reactor 3803
rendering effects 6381
sub-object selection 160
to this help 7647

introduction to character studio 4049
inventor files 7008

importing 7008
inverse kinematics 3299, 3302, 3305, 

3349, 3421, 4288, 7568, 7820
controlling precision 3349
glossary 7820
introduction 3299
methods 3305
preferences settings 7568
rollout 3421
terminology 3302

inverse kinematics with bipeds 7821
invert selection 190
IOR 5312, 5387, 5397, 5437, 5716, 5799
IPT files 7008

importing 7008
iso curves 2318
iso line (glossary) 7822
isolate selection tool 159
isometric views 61
isotropic light distribution 5007
iteration setting (HD IK solver) 3349

J

jambs 433

jitter (antialiasing control) 6083, 7914, 
7918

job archives 6231, 6296, 6311, 6321, 
6342

job archives dialog 6342
manager 6311
network job assignment 6296
network rendering 6231
queue monitor 6321

job dialogs (network rendering) 6279, 
6340

job settings (network rendering) 6334
join dialogs (NURBS) 2456, 2458
join to previous ik key option 4294
joint intersections 4568, 4574, 4594

parameters 4568, 4574
joint intersections rollout 4653
joint rotation data (in BVH files) 4495
joints 3267, 3355, 3357, 3360, 3390, 

3393, 3396, 3414, 3416, 3418
activating joint axes 3393
joint limits (hierarchies) 3267
joint parameters 3390, 3416
joint precedence 3357, 3360, 3414
joint resistance and spring

back 3355
limiting joint action 3396
path 3390
rotational 3390
setting joint precedence 3357
setting joint resistance 3355
setting parameters 3390
sliding 3390
sliding and rotational 3418
surface 3390
using default joint precedence 3360

JPEG files (glossary) 7139
JSR-184 7030, 7033, 7038, 7040, 7042

editing parameters 7033
export/import files 7030, 7033, 

7038
log files 7040
m3g player 7042
texture parameters 7038

JSR-184 player 7042
jump 4253, 4352
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jumping 4107, 4139
dynamics of 4139
parameters 4107

K

KBD files 7490, 7513
keep apart operator 2815
key filters 3594, 7347
key info 3052, 3056, 3063, 3207

Bezier controllers 3063
key info rollouts 3052, 3056
master track key info dialog 3207

key info rollout 4288
key interpolation 4052
key mode 7358
key modes (links) 3290
key reduction 4495, 4511

settings 4511
using motion-capture filtering 4495

key tangents toolbar 3495
key tools toolbar 3495
keyable icons 3486
keyboard 346, 7251, 7490

additional commands 7251
creating primitives from 346
keyboard entry rollout 346
keyboard panel (customize UI) 7490

keyboard shortcuts 1807, 2758, 3447, 
4389, 4598, 4730, 7490, 7645–
7646, 7659

HTML help viewer 7659
override toggle 7646

keyframe interpolation 3054
keyframe mode 7823

glossary 7823
keyframe vertices constraint 3987
keyframes 4126, 4241

adapting to edits 4126
adjusting with in place mode 4241

keyframing 4052
the biped 4052

keyframing tools 4301
keys 3054, 3126, 3431, 3489, 3529–

3530, 3532, 3536–3537, 3540, 
3543, 3545, 3547, 3562, 3575, 

3601, 3603, 4273, 4385, 7315, 
7352, 7358, 7824

adding 3540
aligning 3532
colors in Biped 4273, 4385
create out of range 3489
create out-of-range 3545
default tangent types 7352
delete 3431, 3530
editing 3529
glossary 7824
interpolating 3054
key mode 7358
key properties (track bar) 7315
key statistics (Track View) 3603
key time display (Track View) 3601
master track 3126
moving 3536, 3575
moving a group of 3537
moving horizontal and vertical (Track

View) 3575
randomize 3489
randomize utility 3543
reducing 3562
select 3431
select by time 3489, 3547
soft selection manager 3489

keys (setting) 4192
keys menu 3475

Track View 3475
keys windows (Track View) 3433
kinematic chains 3302, 7825
kink parameters rollout 1104

hair and fur modifier 1104
knot (glossary) 7825
Kodak Cineon 7120

L

L-Ext 409
L-Extrusion 409
l-type stair 473
landXML importer 7044
landXML/DEM model import

dialog 7046
Large BSP method 6141
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lasso selection region 195
lateral ratio 3659
lathe 1430, 2365

lathe modifier 1430
lathe surface (NURBS) 2365

lattice modifier 1435
lattice parameters rollout 4839
launch script (glossary) 7825
layer controller dialog 3088
layer defaults 7536
layer list 7245
layer manager 7227
layer properties 3104
layer properties dialog 7237
layer track 3626
layers 245–246, 4322, 6623, 6782, 6812–

6813, 7224, 7227, 7237, 7245, 
7826

AutoCAD and 3ds Max 6812
excluding in file linking 6813
from AutoCAD 6782
from Revit 6782
glossary 7826
including in file linking 6813
layer event (video post) 6623
layer list button 7245
layer manager 7227
layer properties dialog 7237
select dialog 6813

layers toolbar 7246–7247, 7289
add selection to current layer 7247
create new layer 7246
select objects in current layer 7247
set current layer to selection's

layer 7247
layout (viewports) 65, 7617
layout menu (Schematic View) 7202
layout mode 7826

glossary 7826
leg link 4343
leg states 4118
legacy DWG import 6998
length 4355, 4477

transition editor 4477

lens effects 6392, 6398, 6405, 6414, 
6422, 6429, 6436, 6443, 6461, 
6471–6473, 6476, 6481, 6700

auto secondary 6422
blur 6461
brightness and contrast 6471
color balance 6472
depth of field 6481
file output 6473
film grain effect 6476
glow 6398
gradients 6700
manual secondary 6429
ray 6414
ring 6405
star 6436
streak 6443

lens effects (video post) 6647–6648, 
6654, 6656–6657, 6659–6660, 
6662, 6664, 6666–6667, 6670, 
6673, 6676, 6680, 6682, 6685, 
6689, 6693, 6698, 6702, 6704, 
6707

animating properties 6647
automatic secondary flare

parameters 6659
flare 6648
flare glow parameters 6656
flare inferno parameters 6667
flare preferences 6654
flare ray parameters 6662
flare ring parameters 6657
flare star parameters 6664
flare streak parameters 6666
focus 6670
glow 6673
glow inferno 6682
glow preferences 6680
glow properties 6676
gradient colors 6707
gradient options 6702
gradient types 6704
highlight 6685
highlight geometry 6693
highlight preferences 6698
highlight properties 6689
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manual secondary flare
parameters 6660

lens effects filters (video post) 6639
lens size (cameras) 5123
level of detail 2494, 7103

utility 2494
VRML97 helpers (LOD) 7103

lift 4118, 4253, 4306, 7827
leg state 4118

lift dynamics 4139
light distribution 5007–5009, 5011

diffuse 5008
isotropic 5007
spotlight 5009
web 5011

light include/exclude tool 4917
light lister 4920
light map 7827
light painting rollout (radiosity) 6014
light parameters 5060, 5063

mental ray indirect illumination
rollout 5060

mental ray light shader rollout 5063
light shader rollout 5063
light shaders 5063

mental ray 5063
light tracer 5962, 5965
light viewports 61, 79, 7407
lighting 1056, 4904, 4906, 5035, 5043, 

6386
exclude/include dialog 5043
general parameters 5035
guidelines 4906
hair and fur 1056, 6386
in 3ds Max 4904

lighting analysis 6028, 6552, 7151
lighting analysis dialog 6028
lighting data exporter utility 6559
lighting exclusion 2724
lighting map (baking) 6176
lighting parameters rollout 6163
lighting texture element rollout 6163
lightmap shader 5598
lights 30, 111, 4891, 4893–4895, 4898, 

4904, 4910, 4916–4917, 4920, 
4925, 4927, 4930, 4933, 4936, 

4939, 4951, 4955, 4958, 4960, 
4963, 4965, 4967, 4990, 4993, 
5000, 5055, 5072, 5074, 5095, 
5172, 7409, 7411, 7413, 7415, 
7417, 7419

add default lights to scene 111
advanced effects rollout 5055
and atmospheres 5074
and effects 5074
and materials 5172
and shading 5172
and shadows 4904
animating 4916
atmospheres and effects for 5072
dolly 7409
free area 4967
free direct 4936
free directional 4936
free linear 4963
free point 4958
free spotlight 4930
light falloff 7415
light include/exclude tool 4917
light lister 4920
mental ray shadow maps 5095
mr sky 4990
mr sky portal 5000
mr sun 4993
name and color rollout 4893
omni 4939
orbit/pan 7419
photometric lights 4951
placing 30
positioning 4910
properties of 4898
roll 7413
standard 4925
target area 4965
target direct 4933
target directional 4933
target linear 4960
target point 4955
target spotlight 4927
truck 7417
types of 4891, 4951
using 4894
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viewport controls 7411, 7415
working with 4895

lights name and color rollout 4893
Lightscape 7048, 7050

export 7048
import 7050

Lightscape import 7052
Lightscape Materials utility 7052

lightscape material 5579
Lightscape Materials utility 7052
limit controller 3106
limiting animation ranges 3106
limiting joint action 3396
line 551
linear arrays (creating) 989
linear controller 3118
linear dashpot 3858
linear exposure control 6538
linear light rollout 5081
link 4094, 4294, 4544, 4563, 4590, 

4594, 4600, 4627, 4636, 4644, 
4646, 4656, 4666, 4672, 7913

biped hand to an object 4294
blending 4594
envelopes list (left side) 4627
length 4600
length as basis for envelope

creation 4544
linking drawing files 7913
linking objects to biped 4094
name 4672
scale 4563, 4646
sub-object 4644
to root attach node 4590

link constraint 3233
link rollouts 129, 3424–3425

link info inherit 3425
link info locks 3424

link settings rollout 4646
link sub-object level 4646, 4653

joint intersections rollout 4653
link settings rollout 4646

linkage, hierarchical 7806
linked objects 6793, 6806, 6816, 6825, 

6839
assigning materials to 6825, 6839

conversion settings 6793, 6806
selecting when file linking 6816

linked XForm modifier 1440
linking 3247, 3250, 3260, 3267, 3346

and unlinking objects 3267
animatable parameters 3247, 3250
bones to follow objects 3346
end effectors to parent 3346
strategy 3260

links 3267–3268, 3279, 3290, 3296–
3297, 4088, 4161, 4164, 4544, 
4547, 4563, 4600, 4602, 7829

adding and deleting 3290
adjusting parameters 4563
and joint settings 4600, 4602
and pivots 3279
animating links 3290
blending between 4544, 4547
changing link inheritance 3296
displaying 3267
link inheritance (selected)

utility 3297
main toolbar 3268
moving 4161
parameters 4563
radial scale parameters 4563
rotating 4164
scaling 4088
setting parameters 4563
sliding parameters 4563
twist parameters 4563

lip sync 1474
list 176, 180, 897, 3120, 7245

layers 7245
list controller 3120
named selection sets 180
selection filter 176
transformation axis coordinate

system 897
list views (Schematic View) 7205
listener 7469, 7829

listener window (glossary) 7829
MAXScript listener 7469

load 4253, 4440, 4503, 4511, 4590, 4621
.mfe file 4440
buffer only 4503, 4511

8028 | Index



file option 4253
marker name file 4503
motion capture file 4503
motion flow editor 4440
parameters 4511
specification 4590, 4621

load animation 6873
load custom UI scheme 7515
load envelopes 1624
load/save presets rollout (PArray) 2999
loading 4097, 4222, 4230, 4264

BIP files 4264
biped figure files 4097
biped step files 4230
FIG files 4264
motion files 4222
STP files 4264

loading animation 6870
local 6897

working folder 6897
local biped curve 4401
local center during animate 7564
local coordinate system (glossary) 7830
local euler XYZ rotation controller 3123
local event (particle flow) 7831
local illumination 5976
locate vertical center of mass keys 4270
lock 243, 3294, 3532, 7324, 7329, 7481

character 243
lock selection 3532
lock time tag 7329
lock UI layout 7481
locking object transforms 3294
selection lock 7324

lock assignments 4559, 4672
lock com keying 4270
lock selection 3532, 7324

status bar 7324
Track View 3532

locks rollout 3424
LOD 2494, 2499, 7103

level of detail utility 2494
thresholds 2499
VRML97 helpers 7103

loft object 715, 718–719, 725, 727, 746–
747, 749, 752, 754, 756, 763–764

creation method rollout 718
deform bevel 752
deform fit 754
deform scale 746
deform teeter 749
deform twist 747
deformation dialog 756
path commands 763
path parameters rollout 725
shape commands 764
skin parameters rollout 727
surface parameters rollout 719

lofting 536, 7831
glossary 7831
shapes 536

log file 6132, 7832
log files 6304, 7022

IGES 7022
network rendering 6304

logarithmic exposure control 6540
logging properties dialog 6304
LogLUV format (TIFF files) 6559
look at controller 3124
look at object (particle flow) 7832
look-at constraint 3238
loop 1632
looping 3524, 3560–3561, 4496, 4511, 

6634
animation 3524
animation (Track View) 3560–3561
loop event (video post) 6634

low res environment background 7545
low-polygon modeling 2492
lower bound 4666
LS colors 1118
LS colors modifier 1118
LS mesh modifier 1442
LTLI files 7833
lume shaders 5807
lumen 7833
LumeTools shaders 5807
luminaire helper object 235
luminance 7833
luminous flux (glossary) 7833
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luminous intensity (glossary) 7833
LUT preferences 7550
lux 7813
LZF files 7833
LZG files 7834
LZH files 7834
LZO files 7834
LZV files 7834

M

m3g files 7030
m3g player 7042
macro recorder (MAXScript) 7471
macros 7531

path for additional 7531
MACUtilities 3740
main toolbar 7284
main window 36
make absolute 7522
make controller/object unique (Track

View) 3523
make curve on surface dialog 2444
make loft dialog 2460
make material copy 5250
make point curve dialog 2462
make point dialog 2461
make preview 5238, 6220
make relative 7522
make selected same size (video

post) 6607
make unique 1023, 1040, 2735, 2745, 

3571, 5250, 7446
Material Editor 5250
particle view 2735, 2745

manage scene states 7185
manage scene states dialog 7188
manager 7296

brush presets 7296
manager (network rendering) 6248, 

6259, 6300, 6308, 6311
manager menu (queue monitor) 6332
managers (transform) 879
managing 44, 6345, 6713

files 44
jobs in the queue 6345

scenes and projects 6713
manipulator 2552
manipulator helper objects 2552, 2556, 

2559
cone angle 2552
plane angle 2556
slider 2559

manipulators 2529
built-in 2529
select and manipulate 2529

manual secondary flares 6429
manual update (envelopes) 4636
map animation 6880, 6882, 6885–6886

map track to track rollout 6885
motion mapping parameters

rollout 6882
retargeting rollout 6886

map channel info dialog 5858
map shortcut button 5193
map track to track rollout 6885
mapped material 7837

glossary 7837
mapping 1821, 1823, 1844, 2853, 5183, 

5363, 5365, 5367–5370, 5372–
5373, 5375–5377, 5379, 5381–
5382, 5385, 5387, 5392, 5446, 
6276, 7839

ambient color 5363
anisotropy 5377
bump 5382
coordinates (glossary) 7839
cutout 5446
diffuse color 5365
diffuse level 5367
diffuse roughness 5368
displacement 5392
filter color 5376
flatten 1821
glossiness 5372
map network drive dialog 6276
mapping coordinates 5183
mapping operator (particle

flow) 2853
metalness 5381
normal 1823
opacity 5375
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orientation 5379
reflection 5385
refraction 5387
self-illumination 5373
shininess 5372
shininess strength 5370
specular color 5369
specular level 5370
unfold 1844

mapping biped motion 4224
maps 114, 2932, 5055, 5178, 5197, 

5214, 5255, 5265, 5318, 5446, 
5605, 5619, 5647, 5649, 5673, 
5678, 5687, 5690, 5698, 5701, 
5708, 5716, 5722, 5724, 5728, 
5730, 5732, 5734, 5737, 5739, 
5741, 5743, 5745, 5747, 5756–
5757, 5759, 5761, 5765–5767, 
5769, 5771, 5773–5774, 5780, 
5792, 5799, 5804–5805, 5807, 
5810, 5814–5815, 5820, 5823, 
5828, 5830–5832, 5840–5841, 
5844, 5846, 6132, 6182, 6926, 
7827, 7835–7836, 7840, 7844, 
7901

”other” (in the material/map
browser) 5774, 5780, 
5792, 5799, 5804–5805, 
5807, 5810, 5814–5815, 
5820, 5823, 5828, 5830–
5832, 5840–5841, 5844, 5846

2D 5619
3D 5698
camera map per pixel 5846
cellular 5701
checker 5647
color modifier 5766
combustion 5649
composite 5757
compositor maps 5756
custom 3ds Max mental ray

shaders 5804, 5810, 5814–
5815, 5820, 5823, 5828, 
5830–5832, 5840–5841, 5844

cutout mapping 5446
deleting 5197

dent 5708
displaying in viewports 114
dragging and dropping 5214
falloff 5716
flat mirror 5774
glossary 7840
gradient 5673
gradient ramp 5678
hierarchy (glossary) 7844
light map 7827
lume shaders 5807
map bias (glossary) 7835
map channel (glossary) 7836
map types 5605
mapped materials 2932, 5255
maps rollout 5318
marble 5722
mask 5759
mental ray shaders 5805
mix 5761
noise 5724
normal bump 5844, 6182
output 5767
particle age 5728
particle MBlur 5730
Perlin marble 5732
planet 5734
procedural 7901
projected 5055
raytrace 5780
reflect/refract 5792
reflection and refraction 5773
RGB multiply 5765
RGB tint 5769
show in viewport 5255
smoke 5737
speckle 5739
splat 5741
stucco 5743
swirl 5687
thin wall refraction 5799
tiles 5690
to enhance material 5178
transparency 5446
type button (Material Editor) 5265
vertex color 5771
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waves 5745
wood 5747

MapScaler object-space modifier 1443
MapScaler world-space modifier 1120
marble map 5722
marker data 4495, 7841
marker display dialog 4521
marker files 4496, 4503, 7738, 7841

importing 4496
name files 4496

marker name file dialog 4496
market-specific defaults 7486
marking a contact object (particle

flow) 2832
mask map 5759
mask viewport to safe region 7545
master block parameters dialog (block

controller) 3205
master clip 4724
master motion clip 4724, 7841
master object 1004
master point controller 3126, 3207
material 5603

xref material 5603
material assignment 6846

blocks 6846
material attach options dialog (Boolean

objects) 701
Material Editor 5188, 5222, 5225, 5239, 

5252, 5265, 5318, 5327, 5554, 
5634

bitmap 5634
dynamics properties rollout 5327
maps rollout 5318
material ID channel 5252
menu bar 5225
morpher material 5554
options dialog 5239
tools 5222
type button 5265

material ID 627, 686, 1959, 2014, 2031, 
2845–2846, 7842

and attaching objects 2031
and Booleans 686
and editable meshes 2014
and editable patches 1959

and editable splines 627
and particles 2845
changing (particle flow) 2846
glossary 7842

material ID channel 5252, 5254
flyout 5254
Material Editor 5252

material operators 2841, 2844, 2846
dynamic 2846
frequency 2844
static 2841

material parameters rollout 1091
hair and fur modifier 1091

material propagation 5232
material shaders rollout 5449

mental ray material 5449
material to shader 5830
material xml exporter utility 5185
material/map browser 5194
material/map navigator 5262
materialbyelement modifier 1448
materials 27, 602, 2019, 2031, 2278, 

2729, 2839, 2929, 2932, 2935, 
3011, 5163–5164, 5166, 5168, 
5171, 5174, 5178, 5182, 5184–
5185, 5188–5189, 5197, 5214, 
5232, 5244–5245, 5247–5248, 
5250, 5252, 5260, 5264–5265, 
5283, 5299, 5395, 5449, 5458, 
5522, 5529, 5534, 5536, 5538, 
5544, 5546, 5549, 5552, 5554, 
5559, 5565, 5568, 5570, 5572, 
5579–5580, 5596, 6048, 6825–
6826, 6837, 6839, 6844, 6846, 
6850, 7844–7845

adding to library 5184
advanced lighting override 5572
and attaching objects 2031
and blocks 6844
and particle array 2929
and particle system events 2729
and particle systems 2932, 2935
and set key 3011
and styles 6850
animating 5265
applying in particle flow 2839
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applying to an object 5182
applying to objects 5188
arch & design (mental ray) 5458
Architectural Desktop 6826
assign to selection 5248
assigning 6825, 6839
AutoCAD Architecture 6825
blend 5546
blocks 6846
car paint (mental ray) 5522
changing 6826, 6839
combined when attaching

objects/splines 602, 2019
components 5171
composite 5549
compound materials 5544
copying 5188
default material settings 5250
deleting 5197
designing 5164
DGS material (mental ray) 5529
DirectX 9 shader 5596
double-sided 5552
dragging and dropping 5214
exporting 5185
get 5245
getting from library 5188
glass (mental ray) 5534
glossary 7845
hierarchy (glossary) 7844
ID channel 5252
ink 'n paint 5580
lightscape 5579
loading from scene 5188
make copy 5250
material blending (morpher

material) 5554
material name field 5264
material properties rollout

(NURBS) 2278
matte/shadow 5538
mental ray 5449
morpher 5554
multi/sub-object 5559
name 5166, 5189
pick from object 5264

propagation 5232
put to library 5252
put to scene 5247
raytrace 5395
Revit 6837, 6839
saving 5184, 5188
scene 5247
select by 5244
shell 5570
shellac 5565
show end result 5260
SSS materials (mental ray) 5536
standard 5299
subsurface scattering (SSS) materials

(mental ray) 5536
top-bottom 5568
type 5168, 5283
type button (Material Editor) 5265
types of 5283
updating 5247
using 27
using maps to enhance 5178

matte object (glossary) 7846
matte parameters rollout 6164
matte texture element rollout 6164
matte/shadow material 5538
max clips 3710
MAX file finder utility 6939
MAX files and Autodesk VIZ 6961
max object 3626

add to motion mixer 3626
max objects to mix dialog 3698
maximum angular/positional deviation

for a track 4511
maximum concurrent assignments

(network rendering) 6311
MAXScript 14, 2723, 2874, 2911, 7281, 

7309, 7468–7469, 7472, 7574, 
7847

about MAXScript 14
and particle flow 2874, 2911
command-line 7472
glossary 7847
listener 7469
MAXScript listener 7469
menu 7281, 7468
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mini listener 7309
open MAXScript 7469
preferences settings 7574
run script 7469
visual MAXScript utility 7472

MAXScript debugger dialog 7472
MAXScript menu 7281, 7468–7469, 

7471
macro recorder 7471
MAXScript listener 7469
new script 7469
open script 7469
run script 7469

maxstart.cui file 38, 50
maxstart.max file 50
measure distance 2529
measuring 2526, 2546, 2597
melt modifier 1452
memory management 6947
memory use 6141–6142
mental ray 262, 5000, 5449, 5458, 5493, 

5507, 5522, 5529, 5534, 5536, 
6132, 6140, 6544

add/edit DBR host dialog 6140
arch & design material 5458, 5493, 

5507
car paint material and shader 5522
DGS material 5529
distributed bucket rendering 6140
distributed bucket rendering

rollout 6132
glass material 5534
material 5449
object properties 262
photographic exposure control 6544
satellite processors 6140
satellites 6132
sky portal 5000
subsurface scattering materials 5536

mental ray Connection rollout 5289
mental ray indirect illumination

rollout 5060
mental ray light shader rollout 5063
mental ray material 5449, 5457

advanced shaders rollout 5457
material shaders rollout 5449

mental ray materials 5448
mental ray messages 6132
mental ray renderer 262, 5095, 5448, 

6039, 6050, 6053, 6055, 6076, 
6079–6080, 6130, 7579, 7775, 
7782, 7848, 7887, 7894

contour shading 6080
diagnostic tools 6130
displacement shading 6079
feature enhancements 6050
FGM file 7775
final gather map 7775
materials 5448
messages window 6055
MI files 7848
object properties 262
PASS file 7887
photon map 7894
preferences 7579
processing panel 6053
shadow map rollout 5095
volume shading 6076

mental ray shaders 4995, 5289, 5522, 
5801, 5803–5805, 5809–5810, 
5814–5815, 5820, 5823, 5825, 
5828, 5830–5833, 5838, 5840–
5841, 5843–5844

3D displacement 5810
bump shader 5814
car paint shader 5522
connect parameter to shader

dialog 5809
custom 3ds Max shaders 5804
dgs material shader 5815
dielectric material shader 5820
environment shader 5823
glare 5825
height map displacement 5828
material to shader 5830
mr physical sky 4995
shader list 5831
third-party shaders 5803
uv coordinate 5840
uv generator 5832
uv generator parameters

rollout 5833
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uv generator shaders rollout 5838
XYZ coordinate 5844
XYZ generator 5841
XYZ generator parameters

rollout 5841
XYZ generator shaders rollout 5843

menu bar 2732, 3470, 5225
curve editor 3470
dope sheet 3470
Material Editor 5225
particle view 2732
Track View 3470

menus 2732, 3471, 3809, 5205, 7201, 
7257, 7259–7263, 7270, 7275, 
7278–7279, 7281, 7468, 7501

animation 7275
controller 3471
create 7263
customize 7279
edit 7260
file 7259
graph editors 7278
group 7262
help 7281
material editor copy and paste 5205
MAXScript 7281, 7468
menu bar 7257
menus panel (customize UI) 7501
modifiers 7270
particle view 2732
reactor 3809, 7275
rendering 7278
Schematic View 7201
tools 7261
views 7262

merge 47, 1732, 5274, 5276, 6752, 
6854, 6858–6859

animation (file menu) 6859
custom sections 1732
insert tracks command 6859
merge dialogs 5274, 5276, 6752, 

6854, 6858
scenes 47
shapes 1732

merge from file 1732
sweep modifier 1732

merge xref controller 3194
merging characters 4226
mesh 1455, 1460, 1636, 1648, 1657, 

1751, 1990, 1993
editable mesh 1990
mesh select modifier 1455
meshsmooth modifier 1460
skin morph modifier 1636
skin wrap modifier 1648
skin wrap patch modifier 1657
turbosmooth modifier 1751
working with mesh

sub-objects 1993
mesh - definition 7847
mesh conversion 2872
mesh density, and cloth 1176
mesh editing 1874
mesh object (as Physique skin) 4524
mesh size (reducing) 4577
mesher object 767
meshing parameters rollout

(radiosity) 6008
meshsmooth modifier 1460
MeshSmooth modifier and cloth 1172
meshsmooth selection dialog 2145
messages 6132
meta-operators 2856

cache 2856
metaballs 674, 7847
metal bump shader 5600
metal highlights 5357
metal shader 5331
metalness mapping 5381
methods (IK) 3305
MFE files 3717, 4220, 4461, 4876

folder 4461
MI file 6122, 6132
MI files 7848
Microsoft TCP/IP properties dialog 6264
middle button pan/zoom (viewports

preferences) 7545
MIDI time slider control (animation

preferences) 7564, 7600
mini listener (MAXScript) 7309
mini Track View (track bar) 7315
minimum key spacing 4511
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mirror 627, 911, 996, 1471, 2301, 2358, 
3416, 4209, 4301, 4636, 4656, 
4666

main toolbar 911
mirror curve (NURBS) 2301
mirror dialog 911
mirror modifier 1471
mirror surface (NURBS) 2358
mirroring joint parameters 3416
mirroring objects 996
splines 627

mirror dialog 911
mirror parameters rollout 1600
mirror selected cross section 4606
mirrored link 4556

copying envelope settings to 4556
mirrored UVs 6195
mirroring 7848
mirroring motion 4209
missing external files dialog 6926
missing map coordinates dialog 5618
missing XRef paths dialog 6772
MIX files 4252, 4876
mix map 5761
mix menu 3673
mixdown 3663
mixer 3717, 4229

and BIP files 4229
load mix 3717
mode 3717
rollout 3717
save mix 3717

mixer clip source options dialog 3681
mixer transition editor dialog 3687, 

3691
biped object 3687
non-biped object 3691

MNM file 7849
MNM files 4220, 4496, 4502–4503, 4876
MNU files 7496, 7501, 7513
mobile gaming 7030, 7033

editing JSR-184 parameters 7033
exporting JSR-184 files 7030

MOC files 4503, 4511
modal (glossary) 7849

mode 4426, 4464
motion flow 4426, 4464

modeless (glossary) 7849
modeling 26, 1696

objects 26, 1696
modes 3471, 3717, 4134, 4240, 4253, 

4339, 4351, 4496
in place 4240
mixer 3717
rubber band 4134
talent figure 4496
Track View 3471

modes menu 3471
curve editor and dope sheet 3471

modifier list 7425
modifier sets menu 7449
modifier stack 1020, 1023, 1032, 7427, 

7440, 7851
collapsing 1023
editing 1023
glossary 7851
modifier stack rollout 1020
right-click menu 7440
using 1020
using at sub-object level 1032

modifier-based space warps 2711
modifiers 1001, 1011, 1016, 1034, 1040, 

1043–1045, 1047, 1049, 1118, 
1120, 1123, 1129, 1132–1133, 
1136, 1139, 1142, 1150, 1154, 
1160, 1178, 1228, 1259, 1267, 
1269, 1274, 1283–1284, 1293, 
1377, 1381, 1395–1396, 1401, 
1420, 1428, 1430, 1435, 1440, 
1442–1443, 1448, 1452, 1455, 
1460, 1471, 1474, 1493, 1501, 
1509, 1512–1513, 1520, 1525, 
1528, 1533, 1541, 1550, 1556, 
1558, 1561, 1563, 1567–1568, 
1570, 1574, 1576, 1580, 1583, 
1587–1588, 1596, 1600, 1636, 
1648, 1657–1658, 1665, 1668, 
1670, 1673, 1676, 1678, 1682, 
1691, 1696, 1707, 1709, 1728, 
1730, 1735, 1740, 1743, 1746, 
1751, 1756, 1759, 1761, 1765, 
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1769, 1871–1872, 1876, 1911, 
1918, 3012, 3523, 3950, 3961, 
3972, 5160, 6820, 6827, 6841, 
7852, 7951

affect region 1133
and AutoCAD object

transforms 6820
and set key 3012
and transforms 1016
attribute holder 1136
bend 1139
bevel 1142
bevel profile 1150
camera correction 5160
camera map 1044, 1154
cap holes 1160
cloth 1178
conversion 1756, 1759, 1761
CrossSection 1259
delete mesh 1267
delete patch 1267
delete spline 1269
displace 1274
displace mesh (world space) 1045
displace NURBS (world space) 1047
edit mesh 1283
edit normals 1284
edit poly modifier 1293
extrude 1377
face extrude 1381
FFD 1395
fillet/chamfer 1396
flex 1401
free-form deformation 1395
garment maker 1228
glossary 7852
hair and fur 1049
HSDS 1420, 1428
instanced 1034, 1040
lathe 1430
lattice 1435
linked XForm 1440
list of 1011
LS colors (world space) 1118
LS mesh 1442
make controller unique 3523

MapScaler (object space) 1443
MapScaler (world space) 1120
materialbyelement 1448
melt 1452
mesh select 1455
meshsmooth 1460
mirror 1471
morpher 1474
multires 1493
noise 1501
normal 1509
normalize spline 1512
NSurf sel 1513
object space 1132
patch select 1520
PatchDeform 1123, 1525
PathDeform 1123, 1528
point cache 1129, 1533
poly select 1541
preserve 1550
projection 1556, 1558, 1561, 1563, 

1567–1568, 1570
projection holder 1574
push 1574
reactor cloth 3950
reactor rope 3972
reactor soft body 3961
relax 1576
renderable spline 1580
ripple 1583
select by channel 1587
shell 1588
skew 1596
skin 1600
skin morph 1636
skin wrap 1648
skin wrap patch 1657
slice 1658
smooth 1665
spherify 1668
spline IK control modifier 1670
spline select 1673
squeeze 1676
STL check 1678
stretch 1682
substitute 1691
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surface 1696
surface mapper (world space) 1129
SurfDeform 1132, 1707
sweep 1709, 1728, 1730
symmetry 1735
taper 1740
tessellate 1743
topology dependent 7951
trim/extend 1746
turbosmooth 1751
turn to mesh 1756
turn to patch 1759
turn to poly 1761
turn-to modifiers 1756, 1759, 1761
twist 1765
unwrap UVW 1769
UVW map 6827, 6841
UVW mapping add 1871
UVW mapping clear 1871
UVW mapping paste 1872
UVW Xform 6827, 6841
UVW XForm 1872
vertexpaint 1876
volume select 1911
wave 1918
world space 1043
WSM 1043

modifiers menu 1044, 1120, 1129, 1132–
1133, 1139, 1154, 1160, 1259, 
1267, 1269–1270, 1274, 1283, 
1377, 1381, 1396, 1430, 1435, 
1440, 1448, 1455, 1460, 1471, 
1501, 1509, 1512, 1515, 1520, 
1525, 1528, 1533, 1550, 1574, 
1576, 1583, 1596, 1658, 1665, 
1668, 1673, 1676, 1678, 1688, 
1696, 1707, 1709, 1728, 1730, 
1735, 1740, 1743, 1746, 1765, 
1872, 1874, 1876, 1911, 1918, 
2190, 7270

animation modifiers 1132, 1440, 
1525, 1528, 1707

cache tools 1533

mesh editing 1160, 1267, 1283, 
1377, 1381, 1509, 1515, 
1665, 1678, 1735, 1743, 
1874, 1876

nurbs editing 1132, 1270, 1707, 
2190

parametric deformers 1133, 1139, 
1274, 1435, 1471, 1501, 
1550, 1574, 1576, 1583, 
1596, 1658, 1668, 1676, 
1740, 1765, 1918

patch/spline editing 1259, 1267, 
1269, 1396, 1430, 1512, 
1696, 1709, 1728, 1730, 1746

radiosity modifiers 1129, 1688
selection modifiers 1455, 1520, 

1673, 1911
subdivision surfaces 1460, 1688
surface 1270, 1448
UV coordinates 1044, 1120, 1129, 

1154, 1872
modify child keys 3483
modify child keys (Track View) 3445
modify panel 1016, 7425
modify subtree (Track View) 3445, 3482
modifying 317, 1029, 1034, 2159

at sub-object level 1029
multiple objects 1034
NURBS models 2159
objects (basics) 317

module info report (queue
monitor) 6332

morph 641, 1474, 3044, 5554, 7853
morph controllers 3044
morpher material 5554
morpher modifier 1474
morphing (glossary) 7853

motion 4209, 4224, 4229
combining BIP files 4229
mapping 4224
mirroring 4209

Motion Analysis 3740, 7054, 7056, 7058
motion blending 7853
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motion blur 2726, 2846, 2932, 5148, 
6059, 6087, 6114, 6479, 7814, 
7867, 7919

and particle flow 2846
motion capture 3128, 3721, 4231, 4493, 

4496, 4500, 4503, 4511, 4520, 
7855

batch file conversion dialog 4520
buffer 4496, 4503, 4511
conversion parameters dialog 4511
converting data from buffer 4503
file 4511
importing files 4496
introduction to importing 4231
rollout 4496, 4503

motion clip 4845, 7855
motion clips 4856

Track View pick dialog 4856
motion clips panel 4846
motion damper 2624
motion editing 4401
motion files 4220, 4222, 7856

information saved in 4222
loading motion files 4222
samples 4222

motion flow 3621, 4059, 4222, 4229, 
4253, 4426–4427, 4431, 4436, 
4447, 4452, 4455, 4464, 4467–
4468, 4474, 4486, 4490, 7856

and BIP files 4229
BIP file location 4222
clip properties dialog 4468
compare with motion mixer 3621
editor file 4467
graph 4427, 4431, 4467–4468
mode 4253, 4426, 4436, 4464, 

4467, 4474
optimize transition 4490
random motion 4447
random motion flow 4455, 4486
rollout 4467
script 4426–4427, 4474
shared 4486
shared motion flow 4455, 4486
transition 4431
unified motion 4452

workflow 4464
motion flow editor 4440, 4461, 7856

append 4440
files 4461
load 4440
save 4440

motion flow graph 4490
optimize 4490

motion flow mode 4253
motion fow scripts 7856
motion mapping parameters

rollout 6882
motion mixer 3620–3621, 3626, 3630, 

3635, 3637, 3644, 3646, 3652, 
3659, 3663, 3671–3672, 3697–
3698, 3702–3703, 3706, 3710, 
3714

adding bipeds 3626
adding max objects 3626
adding tracks 3626
adjusting balance 3659
clip timing 3644
cloning clips 3635
compare with motion flow 3621
editor 3706
export animation 3663
filtering biped parts 3703
how to use 3621
importing clips 3630
menus 3672
moving clips 3635
named selections 3702
optimize transition 3697
preferences 3714
replacing clips 3635
reservoir 3710
toolbar 3698
trackgroups 3637
transitions 3646
user interface 3671
weight curve 3652

motion panel 3046, 3051–3052, 3056, 
3350, 4246, 7455

motion parameters rollout 4732
motion synthesis 4712, 4836, 7857

global clip controller 4836
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motionclip parameters dialog 4855
motor 3924
motor space warp 2615
mounting a directory (network

rendering) 6276
mouse sensitivity 7545
MOV files 7140
move 888, 4118, 4253, 4306, 4468

clip 4468
leg state 4118

move keys (Track View) 3536, 3575
curve editor 3575
dope sheet 3536
edit keys 3536
function curves 3575

moved pivot 4294
movie window (camera tracker) 3750
moving 30, 2743, 3023, 3536–3537, 

4134, 4161, 4384, 4916, 7355, 
7357–7358

actions, events (particle flow) 2743
cameras 30
center of mass 4134
keys 3536–3537
keys (biped) 4384
lights 30, 4916
links 4161
through time 3023
to first frame 7355
to last frame 7357
to next frame 7357
to previous frame 7355
to transform keyframes 7358

moving biped keys 4384
MPEG files 7140
mr parameters rollout 1098

hair and fur modifier 1098
mr photographic exposure control 6544
mr physical sky shader 4995
mr sky portal 5000
MSP files 7858
MTL 7078

exporting 7078
mtl files (wavefront) 7077
multi strand parameters rollout 1107

hair and fur modifier 1107

multi-layer basic parameters 5332
multi-layer highlights 5358
multi-level shader 5377
multi-pass parameters (cameras) 5143, 

5148
depth of field 5143
motion blur 5148

multi-pass rendering effects 6036
multi-pass rendering effects

(cameras) 5141
multi-threading 7560
multi-view 6846

blocks 6846
multi/sub-object material 1678, 2935, 

5559
multicurve trim surface 2419
multiple biped links 4172

selecting and rotating 4172
multiple instanced objects 2724
multiplicity (glossary) 7858
multiplier (glossary) 7859
multiplier curve 3583–3585, 7860

applying 3583
deleting 3584
enable toggle 3585
glossary 7860

multiplier out-of-range types (Track
View) 3587

multires modifier 1493
multiresolution adaptive

antialiaser 5429
multisided blend surface 2417
multithreading and rendering 7563
MVBlocks 6846

N

N blend surface 2417
n links 4600, 4672
N links 7860
name 7423

object name 7423
name and color rollout 4893, 7423

for lights 4893
named selection sets 146, 180–181, 1032

8040 | Index



names 3592, 5166
material 5166
selecting by (Track View) 3592

naming layers 7224
naming materials 5189
natural light 4906
navigating 55, 79, 3256, 3277, 6229, 

6849, 7378
3D space 55
blocks 6849
camera and light views 79
hierarchies 3256, 3277
rendered panorama 6229
viewports 7378

navigating the workbench 4397
navigator (material/map) 5262
NavInfo (VRML97 helpers) 7098
neck link 4343
negative filter (video post) 6640
nested expressions (HTML help

viewer) 7652
net render control (common parameters

rollout) 6042
network 6897

working folder 6897
network plug-in configuration 7533
network rendering 6231, 6233, 6246, 

6248, 6253, 6259, 6261, 6270, 
6272, 6279, 6289, 6291, 6296, 
6300, 6302, 6304, 6308, 6311, 
6315, 6319, 6321, 6334, 6342, 
6349, 7861–7862, 7907

advanced settings 6296
Backburner 6231
configuration 6233
email notification 6291
error messages 6253
glossary 7861
how it works 6246
installing 3ds Max for 6272
installing network services 6302
job archives 6342
job dependencies 6289
job dialogs 6279
job handling 6296
job settings 6334

log files 6304
manager 6308, 6311, 7861
monitor.exe 6259
per-job timeouts 6296
pre-render MAXScript 6296
pre-render scripts 6231
queue monitor 6321
rendering queue 6321
server 6300, 6315, 6319
server (glossary) 7862
server.exe 6259
set up 6233
setting up 6261
single computer 6349
starting 6248
TCP post number 6296
troubleshooting 6253
user account 6270

network services - installing 6302
never degrade 129, 252, 7463
new 3608, 6596, 6716, 7219, 7469

new command (file menu) 6716
new Schematic View 7219
new script 7469
new sequence (video post) 6596
new Track View 3608

new feature 115, 129, 252, 1207, 1213, 
1224, 1294, 1318, 1364, 1533, 
1573, 1771, 2039, 2051, 2107, 
3402, 3702, 3704, 4333, 4340, 
4349, 4911, 4983, 5000, 5473, 
5479, 5825, 6201, 6207, 6544, 
7123, 7171, 7463, 7492, 7568, 
7630, 7648

new preset 6809
new settings preset dialog 6809
new Track View 3608
newton (glossary) 7862
next frame 7357
next key 7357
next key-previous key 4289
next transition 4477

transition 4477
next/previous 4636, 4656
next/previous key 4289
NGon 565
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no blending 4600, 4672
no footsteps 4511
no key reduction 4511
node (glossary) 7862
node track (glossary) 7862
noise 1501, 1506, 3140, 5631, 5673, 

5678, 5724, 6507, 6521
and terrain effects 1506
noise controller 3140
noise map 5724
noise modifier 1501
noise rollout (2D) 5631
noise threshold 5673, 5678, 5724, 

6507, 6521
non-biped object 3691, 3695

mixer transition editor 3691
pick nodes dialog (motion

mixer) 3695
non-vertical jambs 433
nonrelational NURBS surfaces 2220
nonscaling object size 7545
normal bump map 5844
normal bump maps 6182, 6184

troubleshooting 6184
normal mapping 1803, 1823
normal projected curve 2320
normalize spline modifier 1512
normalized 4672
normals 339–340, 945, 1284, 1509, 

1990, 2520, 3399
adjusting 339
aligning 945, 2520, 3399
editing 1284
flipping 340
normal modifier 1509
scaling vertex and face 1990
unifying 340
viewing and changing 340

normals map (baking) 6177
note keys 3526
note track 3526, 3528
notes 2856, 2871

adding 2856, 2871
notes operator 2871

notes dialog (parameter collector) 297
NSurf sel modifier 1513

nth serial numbering 7560
NTSC 7560, 7863
numbers 4054, 4268

of links that can affect a vertex 4054
show/hide all 4268

numeric calculator 38
numerical expression evaluator 38
NURBS 2152, 2155, 2162, 2172, 2175–

2176, 2180, 2186, 2188–2189, 
2192, 2196, 2201, 2208, 2252, 
2293–2294, 2296, 2299, 2301, 
2304, 2318, 2346, 2348, 2355, 
2358, 2362, 2365, 2374, 2378, 
2380, 2429–2430, 2432, 2435, 
2466, 2468–2469, 4054, 7864

and animation 2175
and modifiers 2172
animation tips 2189
blend curve 2296
blend surface 2348
cap surface 2378
chamfer curve 2304
concepts 2176
creating models 2180
curve approximation 2468
curve fit 2293
curve point 2432
curve sub-objects 2252
CV curve 2208
CV surface 2196
definition 2176
extrude surface 2362
fixing problems with models 2186
glossary 7864
improving performance 2188
introduction 2152
lathe surface 2365
mirror curve 2301
mirror surface 2358
offset curve 2299
offset surface 2355
point 2429
point curve 2201
point point 2430
point surface 2192
ruled surface 2374
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sub-object clone options
dialog 2466

surf point 2435
surface approximation 2469
tips 2180, 2189
transform curve 2294
transform surface 2346
U and V iso curves 2318
U loft surface 2380
using toolbox to create

sub-objects 2162
working with models 2155

NURBS curve/surface 2449
detach dialog 2449

NURBS curves 2199, 2217, 2308, 7864
creating from splines 2217
fillet 2308
glossary 7864

NURBS models 2153–2155, 2159, 2164, 
2169, 2221, 7865

creating 2154
creating sub-objects 2159
dependent sub-objects 2169
display controls for 2221
glossary 7865
modifying 2159
objects and sub-objects 2153
overview 2155
sub-object selection 2164
working with 2155

NURBS surfaces 2190, 2219, 2224, 2469, 
7020, 7865

and IGES 7020
creating from geometric

primitives 2219
display line parameters 2224
glossary 7865
making rigid imported surfaces

independent 7020
surface approximation 2469

NURMS 1460, 2001

O

OBJ 7079
exporting 7079

obj files (wavefront) 7077
object bounding box 4600
object color dialog 327
object data flow 1004
object display 117
object fragmentation (particle

flow) 2723
object instance 7866
object motion blur (glossary) 7867
object motion inheritance rollout

(PArray) 2990
object parameters rollout 3410–3411, 

3414, 3416, 3418
copying/pasting/mirroring joint

parameters 3416
position/orientation/bind to

follow 3411
precedence 3414
sliding and rotational joints 3418

object properties 245–246, 257, 262, 
264, 1219, 6044

advanced lighting panel 257
cloth 1219
edit menu 245
general panel 246
mental ray panel 262
user defined panel 264

object selection (introduction) 132
object space 7868
object space (biped) 7869
object space modifiers 7870
object transforms 3293–3294
object-layer relationships 7224
object-space modifier 1132, 1443

MapScaler 1443
object/delegate associations dialog 4755
objects 26, 131–132, 152, 167, 245–246, 

317, 323, 327, 686, 774, 792, 
844, 888–889, 891, 955, 958, 
981, 1034, 2516, 2529, 3347, 
3523, 4294, 4910, 5244, 6895, 
7866

aligning 2516
arraying 981
binding 3347
color 327
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combining 686, 774, 792
copies/instances/references 955
creating 323
exporting 6895
freezing and unfreezing 152
glossary 7866
make controller unique (Track

View) 3523
modeling 26
modifying multiple objects 1034
object properties 245–246
select and manipulate 2529
select and move 888
select and rotate 889, 891
selecting 131–132, 167
selecting by material 5244
techniques for cloning 958
using as bones 844

objects to bake rollout 6199
obsolete file alert 6723, 7541
obstacle avoidance 4699
obstacle parameters rollout 4840
obstacle-avoidance behavior 7869
odd/even 7560
offset 2299, 2355, 2430

offset curve 2299
offset point 2430
offset surface 2355

offset/absolute coordinate display 7327
oiltank (extended primitive object) 399
omni light 4939, 7871
omnidirectional light 7871
omniflector 2650, 2661, 2664, 7871
on selected objects/on all objects 4521
on/off controller 3142
once time frame 2759
online help 7650

using HTML help viewer 7650
online reference 7647, 7650, 7652

introduction 7647
searching in 7652
using HTML help viewer 7650

only extract footsteps within
tolerance 4511

opacity 5346, 5375, 7872
falloff (glossary) 7872

mapping 5375
open 223, 231, 2750, 5642, 6597, 6718, 

6721, 7469
assembly 231
file (file menu) 6718
from vault 6721
group (group menu) 223
new bitmap file 5642
particle view dialog 2750
script (MAXScript menu) 7469
video post sequence 6597

open assembly 231
open dialog 4264
open from vault 6721
open physique file 4590
open physique file button 4574
open recent 6723
OpenEXR files 7141–7142, 7147

format 7141
opening 7147
saving 7142

OpenGL driver 7582, 7588
opening screen 50
operands 686, 774, 792, 7873
operator icon 7874
operators 2759, 2761, 2764, 2767–2768, 

2770, 2773, 2781, 2783, 2785, 
2791, 2796, 2806, 2815, 2821–
2822, 2825, 2832, 2841, 2844, 
2846, 2853, 2864, 2867, 2871–
2872, 2874–2876, 7873

birth 2764
birth script 2767
delete 2768
display 2864
empty flow 2875
force 2867
glossary 7873
keep apart 2815
mapping 2853
material dynamic 2846
material frequency 2844
material static 2841
notes 2871
operator time frames 2759
position icon 2770

8044 | Index



position object 2773
render 2872
rotation 2781
scale 2785
script 2874
shape 2821
shape facing 2822
shape instance 2825
shape mark 2832
speed 2791
speed by icon 2796
speed by surface 2806
spin 2783
standard flow 2876

opposite tracks 4270
optical markers 7875
optimizations rollout 5097
optimize 1493, 3697, 4490

geometry 1493
mesh 1493
motion flow 4490
motion mixer 3697
transition 3697, 4490

optimize modifier 1515
optimize transition 4477

transition editor 4477
optimizing performance (particle

flow) 2723
options 2587, 5239, 7545, 7560, 7564

grid and snap 2587
Material Editor 5239
rendering 7560
viewports 7545

options menu 3479
Track View 3479

options menu (particle view) 2739
options menus (Schematic View) 7203, 

7206
orbit/pan 5138, 7404, 7419

camera 5138, 7404
light 7419

Oren-Nayar-Blinn basic parameters
rollout 5333

Oren-Nayar-Blinn highlights 5355
organic surfaces 1696

orientation 859, 3244, 5379
changing 859
constraint 3244
mapping 5379

orientation bar 4606, 4656
orientation behavior 4791, 7875
origin (glossary) 7876
origin point helper 6799
origin slider 7536
ortho snapping mode 2573
orthographic view 7878
orthographic views 61
out 7352

tangent 7352
out-of-range 3524, 3545, 3585, 3587, 

7878
keys (Track View) 3545
types 3524, 3585, 3587, 7878

outdoor lighting 5965
outer envelope 4636
outline 627
output image event (video post) 6627
output map 5612, 5767
output rollout 5612, 6204
outputs (particle flow) 7879
outside 4646
overlap 4600
overlapping IK chains 3316
overlapping vertices and editable rollout

(for object and sub-objects) 590
overlays 6757, 6766

xref scenes 6757, 6766
overshoot (glossary) 7881
overview 1163, 1165, 1228, 4054, 4063

cloth 1163
clothing and pattern design 1165
garment maker modifier 1228
physique 4054
workflow 4063

overview of 3ds Max 17

P

pack UVs dialog 1825
paint (vertexpaint modifier) 1876
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paint deformation rollout 1908, 2125
brush options 1908

paint selection region 196
paint weights 1908
paintbox 1886

vertexpaint modfier 1886
painter options 1908
PAL 7560, 7882
palette 1902

vertexpaint modifier 1902
paletted 7560
pan 73, 2738, 2748, 3603, 7393

panning views 73
particle view 2738, 2748
Track View 3603
viewport controls 7393

pan view 7393
panels 1016, 5996, 6383, 7423, 7425, 

7453, 7455, 7457, 7490, 7492, 
7496, 7501, 7505, 7922

create 7423
customize UI 7490, 7492, 7496, 

7501, 7505
display 7457
hierarchy 7453
modify (command panel) 1016, 

7425
motion 7455
render scene 5996, 6383
scripted utility 7922

panorama exporter 6225–6226, 6229
render setup dialog 6226
viewer 6229

pants (cloth) 1165
parallel projection 61
parameter (glossary) 7884
parameter animation 2725
parameter collector 285, 294

menu bar 294
parameter collector menu bar 294
parameter collector notes dialog 297
parameter curve out-of-range types (Track

View) 3524
parameter editor 267
parameter space (glossary) 7882
parameter wiring 221, 3247, 3250

parameters 267, 285, 294, 297, 3247, 
3410

custom attributes 267
HD Solver 3410
notes 297
parameter collector 285
parameter collector menu bar 294
parameter editor 267
wiring 3247

parameters panel (particle view) 2739, 
7882

display of 2739
glossary 7882

parameters rollout 1600
parametric (glossary) 7884
parametric stride length 4359, 4365, 

4369
parametric stride width 4359, 4365, 

4369
parent overlap 4636
PArray 2964, 2967, 2973, 2978, 2987, 

2990–2991, 2993, 2999
partial blending 4565, 4636
particle age map 2726, 2846, 5728
particle collision 2937
particle deflector 2669, 2673, 2676

deflector 2676
SDeflector 2669
UDeflector 2673

particle emission 2767
particle flow 2713–2714, 2720, 2749, 

2758
frequently asked questions 2720
introduction 2713–2714
keyboard shortcuts 2758
source 2749

particle generation 2767
particle level 7886
particle MBlur map 2726, 5730
particle motion blur 2726
particle motion damper 2624
particle rotation 2781, 2783

rotation operator 2781
spin operator 2783

particle system 2745, 2875–2876, 7887
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particle systems 2924, 2926, 2938, 2943, 
2947, 2951, 2957, 2964, 5730, 
7887

blizzard 2951
creating 2926
glossary 7887
overview 2924
PArray 2964
particle MBlur map 5730
PCloud 2957
snow 2943
spray 2938
super spray 2947

particle tests 2877, 2879, 2881, 2885, 
2892, 2903, 2908, 2911–2912, 
2917, 2920–2922

age 2879
collision 2881
collision spawn 2885
find target 2892
go to rotation 2903
scale 2908
script 2911
send out 2912
spawn 2912
speed 2917
split amount 2920
split selected 2921
split source 2922

particle view 2714, 2730, 2732, 2741, 
2750

depot 2730
description panel 2730
display tools 2730
event display 2741
introduction 2714, 2730
menu bar 2732
open 2750
parameters panel 2730

particles 2717, 2722, 2725, 2727–2728, 
2754, 2764, 2766–2768, 2770, 
2773, 2781, 2783, 2785, 2791, 
2796–2797, 2806, 2815, 2821–
2822, 2825, 2832, 2841, 2844, 
2846, 2853, 2856, 2864, 2872, 
2881, 2885, 2908, 2926, 2928, 

2932, 2973, 2978, 2993, 5728, 
7885, 7934

along a path 2797
and age 2768
and binding to space warps 2725
and deflector space warps 2881, 

2885
and materials 2841, 2844, 2846
and particle flow 2717
and stretch 2727
appearance when selected 2754
caching 2856
creating particle systems 2926
direction 2728, 2791, 2796, 2806, 

2815, 2822, 2825
display in viewports 2864
emission 2764
emission rate 2767
generation 2764
geometry type 2821–2822, 2825
leaving a mark 2832
limiting life span 2768
mapping 2853
MBlur map 2846
motion blur 2846
number of 2722, 2766
orientation 2781
parent particle 7885
particle age map 5728
particle diagram 7885
particle emitter 2928
particle generation rollout

(PArray) 2973
particle motion blur 2932
particle spawn rollout (PArray) 2993
particle type rollout (PArray) 2978
positioning 2770, 2773
rendered as 2872
rotation 2781
scaling 2785
size 2821
spawn particles 7934
speed 2728, 2791, 2796, 2806, 2815
spinning 2783
synchronize animated bitmap

textures 2725
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testing particle scale 2908
unexpected spawning 2727
viewport display 2864

PASS file 7887
mental ray renderer 7887

paste 4656, 4666, 5205
a material, map, bitmap, or

color 5205
paste controller (Track View) 3514
paste footsteps 4355
paste from buffer 4503
paste layer 3088, 3090
paste posture 4301
paste posture opposite 4301
paste selected cs 4606
paste skin data dialog 3798
paste tangent handles 606
paste time/track (Track View) 3555
paste-pos tolerance 1627
pasting 4203
pasting joint parameters 3416
patch (glossary) 7888
patch grids 1982, 1984, 1987

quad patch 1984
tri patch 1987

patch select modifier 1520
patch surfaces 1696, 1935, 1982

copying 1935
deleting 1935

patch-based objects 7888
PatchDeform 1123, 1525

object-space modifier 1525
world-space modifier 1123

path 4461
motion flow 4461

path constraint 2797, 3222
and particles 2797

path follow behavior 4696, 4795, 7890
path follow space warp 2635
path joints 3393, 3396
PathDeform 1123, 1528

object-space modifier 1528
world-space modifier 1123

paths 44, 725, 763, 2635, 2725, 2797, 
5138, 6764, 6772, 6799, 7520, 
7523–7524, 7527, 7529, 7532, 
7888

and AutoCAD xrefs 6799
and particles 2725, 2797
and XRefs 6764, 6772
configuring paths 44
configuring system paths 7523, 

7532
configuring user paths 7520, 7524, 

7527, 7529
glossary 7888
moving a camera along 5138
path commands (loft objects) 763
path follow space warp 2635
path parameters rollout 725

pattern background 5234
pattern design (cloth) 1165
PBomb space warp 2629
PCloud particle system 2957
PDynaFlect space warp 2656
pelt map parameters dialog 1826
per-bitmap resolution for bitmap proxies

dialog 6912
per-pixel camera map 5846
per-pixel camera projection 5846
percent snap 2571
perform footstep extraction 4511
performance 70, 1910, 2188, 4238, 

4577, 6096, 6141–6142, 7677, 
7905

and biped's motion
previewing 4238

and weight painting 1910
controlling display performance 70
improving in NURBS 2188
optimizing with physique 4577
while running 3ds Max 7677

performance optimization (particle
flow) 2723

period 7890
Perlin marble map 5732
perspective 5136, 7384, 7400, 7891

and orthographic viewport
controls 7384
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glossary 7891
matching 5136
viewport control 7400

perspective view 61
phases of leg motion 7892
Phong highlights 5355
Phong shader 5330, 5334
photometric lights 30, 4891, 4951, 

4953, 4955, 4958, 4960, 4963, 
4965, 4967, 4990, 4993, 5014, 
5017, 5019–5020, 5081–5083

area light sampling rollout 5082
common lamp values 5020
data file 5017, 5019, 5083
example of photometric data

file 5019
free area light 4967
free linear light 4963
free point light 4958
IES standard file format 5017
linear light rollout 5081
mr sky light 4990
mr sun light 4993
photometric webs 5014
preset lights 4953
target area light 4965
target linear light 4960
target point light 4955
web 5014
web parameters 5083

photometry 7892
photon map 7894
photon maps 6072, 6096
PHY files 4574, 4590, 4876, 7894
physical scale 6535, 6538, 6540, 6552
physique 4054, 4522, 4535, 4542, 4544, 

4574, 4586–4587, 4589, 4598, 
4625, 4629, 4631, 4633, 4644, 
4646, 4653, 7895

and changing geometry 4587
and FFDs 4587
and groups 4544
and other modifiers 4586
applying 4544
blending envelope display 4625, 

4633

bulge angle display 4629
deformation spline 4054, 4644
getting started with 4522
initializing 4544
joint intersections rollout 4653
keyboard shortcuts 4598
link settings rollout 4646
overview 4054
reinitializing settings 4574
saving settings 4574
storing settings in PHY files 4574
tendon display 4631
user interface 4589

Physique 4622, 4625
initialization 4622, 4625

physique initialization dialog 4544, 
4600

physique level of detail rollout 4594
physique load specification dialog 4590, 

4621
physique rollout 4590
Physique sub-objects 4635
PIC file format 7126
PIC files 6559, 7151
pick material from object 5264
pick nodes dialog 3695
pick object 169
pinch 4666
pinch bias 4666
ping-pong (playback direction

setting) 7356
pivot 3270, 3399, 3402, 3406

adjust pivot rollout 3399
adjust transform rollout 3406
adjusting 3270
alternative 3402
resetting 3270
working 3402

pivot door 510
pivot point 3399
pivot points 905, 1034, 4294, 7895

glossary 7895
use pivot point center 905
using 1034

pivot selection dialog 4296
pivoted window 530
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pivots 3279
and links 3279

pivots (IK extensions) 4194
pixel 7896
pixel data (rendered frame

window) 5889
place highlight 948, 4910
planar 884, 1455, 1990, 2019

constraints 884
make edges 2019
make vertices 2019
threshold 1455, 1990

plane 380, 3923
plane angle manipulator 2556
planet map 5734
plant 4118, 4253, 4306, 7896

leg state 4118
planted key defaults 4289
plate match 5950
plate match/MAX R2.5 antialiasing 1154
play selected 7355
playback 2857, 4093, 4253

real-time 2857
playback speed 3024
playing 5238, 5266, 7355

animated material previews 5266
animation 7355
preview 5238

plug-ins 7482, 7532–7533, 7536, 7896
color selector (general

preferences) 7536
glossary 7896
plug-in manager 7482
sharing over a network 7533
system path configuration 7532

plugin.ini file 50
PMAP file 7897
PNG file (glossary) 7152
point 2165, 2429, 2544, 4511, 7897

glossary 7897
helper object 2544
sub-object 2165, 2429

point cache modifiers 1129, 1533
point curve 2201, 2290, 2332, 7898

glossary 7898
on surface 2332

sub-object 2290
point point 2430
point surface 2192, 2344, 7899

glossary 7899
sub-object 2344

point-path constraint 3918
point-point constraint 3898
point3 XYZ controller 3074
polar snapping mode 2575
poly select modifier 1541
polygon - definition 7774
polygon count 2493, 7629
polyhedra 385
POmniFlect space warp 2650
ponytails 4343
pose 4308

copying and pasting 4308
pose adjustment 4511
poses 4203, 4524, 4571, 7899

adding 4571
copying between bipeds 4203
reference 4524

posing bipeds 4079
position 859, 3041, 3565

changing 859
controlling 3041
ranges (Track View) 3565

position constraint 3229
position data (in CSM files) 4495
position operators 2770, 2773

position icon 2770
position object 2773

position ranges (Track View) 3565
position XYZ controller 3144
position/orientation/bind to follow

object 3411
position/rotation threshold (IK) 3349
position/rotation/scale (PRS) 3051, 3146

controller (Track View) 3146
parameters (motion panel) 3051

positional markers 7899
posture 4308

copying and pasting 4308
postures 4203
power 4606, 4656
pre-calculating particle motion 2722
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pre-render scripts 6231, 6279, 6365
advanced settings 6231
command-line rendering 6365
network rendering 6279

precedence 3360, 3362, 3364, 3414, 
7900

child-to-parent 3360
glossary 7900
parent-to-child 3362
setting manually 3364

precedence, and keyboard
shortcuts 7646

precision and drawing aids 2501
preferences 3714, 6948, 7207, 7534, 

7536–7537, 7541, 7545, 7550, 
7560, 7564, 7568, 7570, 7574, 
7578–7579, 7600, 7631, 7641

accuracy 7536
animation 7564
asset browser 6948
files 7541
gamma 7550
general settings 7536
gizmos 7570
inverse kinematics 7568
MAXScript preferences 7574
mental ray renderer 7579
MIDI time slider control 7600
motion mixer 3714
preference settings dialog 7536
radiosity settings 7578
reference cooordinate system 7537
rendering 7560
Schematic View 7207
strokes 7631, 7641
sub-materials 7536
texture coordinates 7541
viewports 7545

preferences (display) 4243
premultiplied alpha (glossary) 7162, 

7900
preserve map channels dialog 2146
preserve modifier 1550
preset lights 4953
preset rendering options 5922
preset views 61

presets 5922, 6603, 6809, 7293
brush 7293
configure (video post) 6603
rendering 5922

preview 5238, 5266, 6220
animated material previews 5266
make 5238
play 5238
renderings 6220
save 5238

preview and animation rollout 4007
preview selection 1318, 2051
preview window 4022
previewing 4238, 4545, 7069

biped motion 4238
motion 4545
Shockwave 3D files 7069
W3D files 7069

previous frame 7355
previous key 7355
previous link/next link 4606, 4666
previous transition 4477

transition 4477
primitives 346, 348, 383

creating with keyboard 346
extended 383
standard 348

print size wizard 5925
priority of actions (particle flow) 2729
priority rollout 4826
prism 423
prismatic constraint 3905
PRJ files 6971, 7698
problems 7663
problems caused by unit settings 7681
ProBoolean 774
procedural maps 5708, 5747, 7901

dent 5708
glossary 7901
wood 5747

procedures 4877
process options rollout 6132
processing panel 6053

mental ray 6053
processing parameters rollout

(radiosity) 6001
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ProCutter 792
production render 5909
productivity 4052
profile 4656
profile view 4606
program window 36
progressive morphing 1490
project file format 6971
project folder 6728
project mapping projector 1570
project workflow in 3ds Max 19
projected window 532
projection - preferences 7545
projection holder modifier 1574
projection modifier 1556, 1558, 1561, 

1563, 1567–1568, 1570, 6182
cage rollout 1563
project mapping rollout 1570
projection rollout 1568
reference geometry rollout 1561
selection check rollout 1567
selection rollout 1558

projection options dialog 6215
projector light 5055, 7903
projectors 1570

project mapping 1570
projects - managing 6713
prompt line 7309
prop bone 4502, 7904
propagate materials to instances 5232
propagation 3659, 5232

blocks 5232
instances 5232
materials 5232
styles 5232

properties 245, 2745, 3467, 3541, 3834, 
4898, 6920, 7246, 7370

animation controllers 3467
changing layer properties 7246
controller (Track View) 3541
dialog (Track View) 3467
file menu 6920
of light 4898
particle system 2745
rigid body 3834
viewports 7370

waveform controllers 3467
properties (clips) 4427, 4468

motion flow 4468
properties rollout 4021
props 4177

using 4177
protractor helper object 2549
proximity test (particle flow) 2892
ProxSensor (VRML97 helpers) 7096
proxy object 6770

XRef object 6770
proxy object rollout 6770

XRef object 6770
PRS 3051, 3146

PRS controller (Track View) 3146
PRS parameters 3051

PS files 7124
PSD file (glossary) 7153
pseudo alpha compositor (video

post) 6709
pseudo alpha filter (video post) 6641
pseudo color exposure control 6552
publish Shockwave 7061
publishing to 7013

3D DWF 7013
pull 4666
pull bias 4666
pull/pinch/stretch options

(tendons) 4666
push 1574, 2610

modifier 1574
space warp 2610

put material to scene 5247
put to library 5252, 5276
pyramid 374

Q

QOP files 7507, 7513
quad menu 7220

Schematic View 7220
quad menus 1082, 2160, 3492, 3810, 

7300, 7304, 7306, 7496, 7507
animation 7306
hair and fur modifier 1082
reactor 3810
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quad meshing 799
quad patch 1984
quadruped 4199

animating a 4199
quads panel (customize UI) 7496
quadtree 7904
quaternion rotation 4215, 4276
quaternion/tcb 4215
quaternions 3076
queue 6321, 6339, 6343–6345, 6573

rendering 6321, 6339, 6343–6345
video post 6573

queue manager 7905
queue monitor 6321, 6332, 6340, 6342, 

7905
client (glossary) 7905
job archives 6342
module info report 6332
report generator 6340

queue monitor job settings 6334
quick align 944
quick render 5908–5909

ActiveShade 5909
flyout 5908
production 5909

quick start (batch rendering) 6348
quickslice 1368, 2111
QuickTime movies 7140

R

radial dialogs 6453, 6455, 6458
density 6453
falloff 6455
size 6458

radial scale 4563, 4636, 4646
parameters (links) 4563

radiance file format 7126
radiance map 7126
radiance picture files 7151
radiosity 4904, 4940, 5441, 5962, 5976, 

5986, 5989, 5994, 5996, 6001, 
6008, 6014, 6017, 6027–6028, 
7578

and animation 5994
and architectural materials 5441

choosing radiosity 5962
controls 5996
how it works 5986
light painting rollout 6014
lighting analysis 6028
lighting analysis dialog 6028
meshing parameters rollout 6008
preferences settings 7578
processing parameters rollout 6001
rendering parameters rollout 6017
skylight 4940
statistics rollout 6027
workflows 5989

radiosity solution 5976, 5986
radius 4666
rag doll constraint 3871
railing 433, 447
RAM player 7166, 7170
random motion 4447, 4484

create 4447, 4484
motion flow 4447
script 4447, 4484
transition 4447

random placement difficulty dialog 4754
randomize keys 3489
randomize keys utility (Track View) 3543
range bar (video post) 6604
ranges 3564–3565, 3567

editing 3564
positioning 3565
realigning with keys 3567
recoupling 3567

ranges toolbar 3506
Track View - dope sheet 3506

ray 6414
render effect 6414

ray tracing 6044, 6118
ray-traced 6057–6058, 6114, 7928

reflections and refractions 6057
shadows 6058, 6114, 7928

ray-traced shadows 5100, 7906–7907
glossary 7907
parameters 5100
ray-trace bias (glossary) 7906

RAYHOSTS file 6132, 7907
specifying name and path 6132
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raytrace 5395, 5397, 5406, 5411, 5414, 
5421, 5423, 5425, 5427, 5780, 
5785, 5787, 5789, 6030

acceleration parameters 5423
adaptive antialiaser dialogs 5427
attenuation rollout 5785
basic material extensions

rollout 5787
basic parameters rollout 5397
dynamics properties rollout 5421
extended parameters rollout 5406
global settings 6030
map 5780
map and material 5425
maps rollout 5414
material 5395
messages 6030
raytracer controls rollout 5411
refractive material extensions

rollout 5789
raytrace acceleration 6118, 6141–6142, 

7905
parameters for BSP method 6141
parameters for Grid method 6142
parameters for Large BSP

method 6141
raytrace map 6048
raytrace material 6044, 6048
raytracer parameters rollout 5781
raytracing acceleration parameters

dialog 5423
re-attachment 4602
reaction controllers 3148, 3153
reaction manager 3153

dialog 3153
reaction manager dialog 3153
reactor 3803, 3808–3810, 3818–3819, 

3832, 3843, 3845, 3848, 3853, 
3858, 3862, 3867–3868, 3871, 
3892, 3898, 3905, 3911, 3918, 
3923–3924, 3926, 3934, 3942, 
3947, 3949–3950, 3957, 3960–
3961, 3966, 3969, 3972, 3977, 
3980–3981, 3983, 3996–3997, 
4001, 4005–4007, 4009, 4013, 

4015, 4018, 4021–4022, 4026, 
4033, 4037

analyze world 4018
angular dashpot 3862
car-wheel constraint 3911
cloth 3949
cloth collection 3957
cloth modifier 3950
collisions rollout 4013
compound rigid bodies 3843
constraint solver 3868
constraints 3848
cooperative constraints 3867
create animation 4007
deformable bodies 3947
deformable constraints 3983
deforming mesh collection 3981
deforming meshes 3980
display rollout 4015
FFD soft bodies 3966
fracture 3934
frequently asked questions 4033
gravity 4009
hinge constraint 3892
icons 3810
introduction 3803
linear dashpot 3858
menu 3809
motor 3924
plane 3923
point-path constraint 3918
point-point constraint 3898
preview 4022
preview and animation rollout 4007
prismatic constraint 3905
properties rollout 4021
quad menu 3810
rag doll constraint 3871
rag doll script 4026
real-time preview 4022
reduce keys 4018
rigid bodies 3832
rigid body collection 3845
rope collection 3977
rope modifier 3972
ropes 3972
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scale 3818
scripts 4026
setup scripts 4026
simple constraints 3853
soft bodies 3960
soft body collection 3969
soft body modifier 3961
solver 4006
special features 3819
spring 3853
storing and accessing

collisions 3942
toolbar 3808
toy car 3926
troubleshooting 4037
utilities 4018
utility 4005
utils rollout 4018
water 3996
water space warp 3997
wind 4001
world rollout 4009

reactor helpers 3831
reactor menu 7275
real time (glossary) 7908
real-time playback 2857, 4545
real-time preview 4022
real-world map size 5609
real-world mapping 5609
reassign globally 4594
reassigning vertices 4559
rebuild dialogs 2463–2465

CV curve 2463
CV surface 2464
texture surface 2465

recorder (MacroRecorder) 7471
recouple ranges (Track View) 3567
recovered file 53
rectangle 555
rectangular area light 4948
rectangular region 7392
rectangular selection region 192
recursion depth 6031
red 4606, 4672

deformable vertices 4672
line 4606

red/green/blue (glossary) 7908
redefine 4474

script 4474
redo 87, 203
redraw all views 114
reduce keys (Track View) 3562
reduce mesh resolution 1493
reducing mesh size 4577
reference biped 4322
reference coordinate system 881, 897, 

7537
preferences 7537
specifying 881

reference objects 2825, 7910
reference pose 4524
references 955, 3571, 6729, 7910

glossary 7910
overview 955
using XRefs 6729

refine 606, 618, 2176, 7910
editable spline segments 618
editable spline vertices 606
glossary 7910
refining curves and surfaces

(concept) 2176
reflect/refract map 5792, 6048
reflectance display 5228
reflection maps 5385, 5773
reflections 6057
refraction maps 5387, 5773
refractions 6057
refresh content 7341

communication center 7341
refresh viewport display 114
regathering 5996
region 143, 175, 192–196, 198, 2738, 

7392, 7626
selection 143, 175, 192–196
selection method (edit menu) 198
selection preferences 7626
zoom region (particle view) 2738
zoom region (viewport

control) 7392
region net render 6293
reinitialize 7911
reinitialize (physique) 4574, 4590, 4602
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reinitialize selected links 4563, 4646
relative scale 4672
relative snap 2568, 2578
relax dialog 2148
relax mesh 1968
relax modifier 1576
relax tool dialog 1831
relaxing texture coordinates 1831
remap locally 4594
remove 3528, 3584

ease or multiplier curve (Track
View) 3584

note track (Track View) 3528
remove from link 4559, 4672
remove from track set 3596
remove note track 3528
rename objects tool 266
rename preview 6224
rename settings preset dialog 6811
render 2872, 5277, 5771, 5879, 5892, 

5898, 5901, 5909, 5917–5918, 
5922, 5929, 5941, 5950, 6143–
6144, 6169, 6486, 7161

ActiveShade 5909, 5917–5918
blowup 5901
common parameters rollout 5929
default scanline 5950
dialogs 5277, 5879, 5892, 7161
presets 5922
render operator (particle flow) 2872
render scene 5879, 5898
render type list (main toolbar) 5901
rendered output 6486
rendering elements separately 6144
scripts rollout 5941
selected objects 5901
to texture 6169
vertex coloring 5771
VUE files 6143

render bounding box/selected
dialog 5907

render effects 3454, 6381, 6383, 6386, 
6392, 6398, 6405, 6414, 6422, 
6429, 6436, 6443, 6461, 6471–
6473, 6476, 6479, 6481

hair and fur 6386

render elements 6144, 6157–6158, 
6163, 6165

hair and fur 6163
velocity 6165

render scene dialog 5879, 5929, 5946, 
5962

advanced lighting panel 5962
common panel 5929
render panel 5879
renderer panel 5946

render shortcuts toolbar 7291
render to texture 6169, 6174, 6181–

6182, 6199, 6204, 6209, 6211, 
6213, 6215

normal bump mapping 6182
render to texture dialog 6195, 6197, 

6199, 6204, 6209, 6211, 6213, 
6215

add texture elements dialog 6213
automatic mapping rollout 6211
baked material rollout 6209
general settings rollout 6197
objects to bake rollout 6199
output rollout 6204
projection options dialog 6215

render UVs dialog 1835
render UVW Template 1835
renderable spline modifier 1580
rendered frame window 5885
rendered output 6229
renderer 5938

configure preset dialog 5938
renderer panel 5946

render scene dialog 5946
renderers 5945, 5950, 6143, 6225, 7918, 

7966
interactive 7966
panorama exporter 6225
photorealistic 7918
scanline 7918
viewport 7966

rendering 34, 536, 831, 2872, 5135, 
5877, 5897, 5922, 5939, 6042, 
6044, 6059, 6157, 6169, 6174, 
6181, 6246, 6345, 6347–6349, 
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6359, 6361, 6365, 6378, 7290, 
7560, 7563, 7611

and multithreading 7563
batch 6347–6349, 6359
bones 831
command line 6361, 6365, 6378
commands 5897
don't alias against background 7560
elements separately 6157
email notification 5939
large images 7563
on multiprocessor systems 7563
portions of scene 5135
preferences settings 7560
presets 5922
reactor toolbar 7290
render farms 6246
render operator (particle flow) 2872
rendering method 7611
rendering queue 6345
scene 34
shapes 536
to texture 6169, 6174, 6181
with caustics (mental ray) 6044
with global illumination (mental

ray) 6044
with motion blur 6059
with shadow maps 6059

rendering algorithms rollout 6118
rendering commands 5925

render last 5925
rendering effects 5141

multi-pass (cameras) 5141
rendering for print 6293
rendering menu 5188, 5194, 5425, 

5898, 5917–5918, 5924–5925, 
5962, 5996, 6028, 6030, 6195, 
6382, 6484, 6486, 6571, 7166, 
7278

ActiveShade floater 5917
ActiveShade viewport 5918
advanced lighting 5962
effects 6382
environment 6484, 6486
lighting analysis 6028
Material Editor 5188

material/map browser 5194
print size wizard 5925
radiosity 5996
RAM player 7166
raytrace global exclude 5425
raytrace settings 6030
render 5898
render scene 5898
render to texture 6195
show last rendering 5924
video post 6571

rendering parameters rollout
(radiosity) 6017

rendering properties 6843–6844
family elements 6843
instanced objects 6843–6844

rendering queue 6321
renderingmenu 6225

panoramic exporter 6225
reparameterize dialog 2465
repathing 6896
repeat last 1363
repel behavior 4799, 7911
replace (file menu) 6866
replace clip 3681
replace dialogs 5280, 6866
replace keys 3575
replacing scenes 47
report generation (network

rendering) 6340
requirements 11, 3748, 6259

for camera tracking 3748
for network rendering 6259
system (see Installation Guide) 11

rescale world units utility 2599
reservoir 3667, 3710
reservoir file groups dialog 3685
reset 103, 886, 3293, 5250, 6717

reset background transform (viewport
image) 103

reset material settings to
default 5250

reset XForm (transform) utility 886, 
3293

reset position 6820
reset tangents 606
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reshade 5910, 5919
resizing arms 4090
resolution 4606, 4656, 4666, 7911

glossary 7911
resolve externally referenced file

dialog 6814
resource collector utility 6942
resource information dialog 6955
respect animation range 3521
restore 88, 7564

active view (views menu) 88
to default settings (animation

controllers) 7564
restrict to axis buttons 884
restrict to x 884
restrict to xy plane 884
restrict to y 884
restrict to yz plane 884
restrict to z 884
restrict to zx plane 884
restructure biped to match file 4253, 

4503
retarget 4322
retargeting rollout 6886
reverse knees (creating characters

with) 4164
reverse time (Track View) 3557
revert to startup UI layout 7519
reviewing and editing strokes 7638
Revit 190, 6827–6828, 6832, 6835, 6837

files 6827
materials 6837
objects 6828
select families or types 190
select similar 190
settings 6832
workflow 6835

Revit material 6841
3ds Max objects 6841

RGB (glossary) 7908
RGB files 7161
RGB maps 5765, 5769

multiply 5765
tint 5769

right-click menus 185, 1474, 2160, 
2578, 2745, 3014, 3461, 3492, 

3618, 5205, 5212, 6747, 6750, 
7220, 7300, 7304, 7306, 7370, 
7440, 7479, 7545, 7659

additional quad menus 7304
animation 7306
customize display 7479
display option 7545
display preference setting 7545
event display (particle view) 2745
HTML help viewer 7659
material editor copy and paste 5205
modifier stack 7440
morpher modifier 1474
named selection sets 185
NURBS 2160
sample slot 5212
Schematic View selection 7220
snaps 2578
spinner 3014
Track View 3461, 3492
Track View toolbar 3618
viewports 7370
XRef entities list (XRef object

dialog) 6750
XRef files list (XRef object

dialog) 6747
rigid bodies 3832–3834, 3843, 3845, 

3848, 3934, 3942
basics 3833
collection 3845
compound 3843
constraints 3848
fracture 3934
properties 3834
storing and accessing

collisions 3942
rigid envelopes 4054, 4547, 4561, 4594, 

4600, 4636
rigid surfaces (NURBS) 2172
ring 1632, 6405

render effect 6405
ring array 853
ringwave 418
ripple 1583, 2700

modifier 1583
space warp 2700
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RLA files 7156
RMAT materials 6826

in 3ds Max 6826
roll angle manipulator 5042
roll viewport controls 7401, 7413

camera 7401
light 7413

rollout 4278, 6132
distributed bucket rendering 6132
twist poses 4278

rollouts 38, 2125, 2967, 2973, 2978, 
2987, 2990–2991, 2993, 2999, 
3399, 3402, 3409, 3421, 5310, 
5318

adjust pivot rollout 3399
inverse kinematics 3421
maps 5318
materials 5310
paint deformation 2125
PArray rollouts 2967, 2973, 2978, 

2987, 2990–2991, 2993, 2999
working pivot 3402

root name 4077, 4343
ropes 3972, 3977

collection 3977
modifier 3972

rotate 889
rotating 73, 905, 2019, 2781, 4164, 

4172, 4916
curling fingers 905
editable mesh edges 2019
elbows and knees 4164
hierarchy 905
lights 4916
links 4164
multiple biped links 4172
multiple linked objects 905
particles 2781
spine 4164
views 73

rotation 2781, 2903, 2987, 3396, 3418, 
7545

and collision rollout (PArray) 2987
go to rotation test 2903
increment (viewport

preference) 7545

rotation operator 2781
rotational joints 3396, 3418

rotoscoping (glossary) 7912
roughness 5350
roughness mapping 5368
RPF files 7159
RPS files 5922
rubber band mode 4090, 4134, 4253
rubber-band mode 7912
rubber-banding 4090

arms and legs 4090
ruled surface sub-object 2374
run 4253, 4352
run footstep 4352, 4365
run script 7469
running 4107, 4139, 4240

dynamics of 4139
in place 4240
parameters 4107

RVT link 7913

S

safe frames 7373, 7619, 7965
safe video threshold 5236
sample object 5232, 5235–5236, 5238

preview 5238
UV tiling 5235
video color check 5236

sample range (glossary) 7914
sample rate 6083
sample slot 5166, 5208, 5212, 5233–

5234, 5239, 5248, 5250, 5634
active 5248
adding bitmap 5634
and material name 5166
background 5234
backlight 5233
cool 5250
default 5250
display adjustment 5239
hot 5250
right-click menu 5212

sample type 5232
cube 5232
cylinder 5232
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sphere 5232
sample UV tiling 5235
samples 4222

animations 4222
motion files 4222

samples threshold (motion
capture) 3721

sampling 6083, 7914
filters 6083
sampling quality rollout 6083
thresholds 6083

satellites 6132
save 4440

.mfe file 4440
motion flow editor 4440

save animation 6876
save as dialog 4261
save commands 88, 204, 243, 5238, 

6598, 6723–6724, 6726–6727, 
7516

hold 204
save (file menu) 6723
save active view (views menu) 88
save as (file menu) 6724
save character 243
save copy as (file menu) 6726
save custom UI scheme 7516
save preview (Material Editor) 5238
save selected (file menu) 6727
save sequence (video post) 6598
scene/settings in buffer 204

save copy as 6726
save custom UI scheme 7516
save file 4253
save parameters 4511
save physique file 4590
save reservoir items dialog 3712
save segment 4253
save talent figure structure 4503
save talent pose adjustment 4503
saved schematic views 7220
saving 4097, 4222, 4230, 4261, 4574, 

5184, 5188, 6723, 7536, 7541
backup on save 7541
BIP files 4222, 4261
biped figure files 4097

biped step files 4230
compressed file 7541
FIG files 4261
files from previous versions 6723
material 5184
materials 5188
physique data 4574
STP files 4261
thumbnail image 7541
UI configuration on exit 7536

saving animation 6870
scale 891, 3818, 4253, 4306, 4355, 

4511, 4602, 4656, 7918
a biped 4602
factor 4511
in reactor 3818
stride 4253, 7918
tail keys 4306

scale operator (particle flow) 2785
scale synchronization between AutoCAD

and 3ds Max 6783
scale test (particle flow) 2908
scale values (Track View) 3577
scale weight 1632
scaling 746, 859, 892–893, 1990, 2785, 

3171, 3538, 3559, 3576–3577, 
4088, 4090, 4139, 4343, 4563, 
4576, 4579, 7560

a biped 4343
a node 4563
and system units 4576
arm 4090
changing 859
characters 4579
deformation 746
face and vertex normals 1990
function curves 3576
height 4139
keys (Track View) 3538, 3576
links 4088
particles 2785
rendering preferences 7560
scale XYZ controller 3171
time (Track View) 3559
values (Track View Curve

Editor) 3577
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scaling objects 891
scanline renderer 5950, 7918
scanline rendering 6118
scatter 647
scatter objects dialog 4742
scene event (video post) 6607
scene explorer 7171, 7173–7177

adding columns 7175
column chooser 7175
customizing 7177
deleting objects 7174
editing a value 7176
editing multiple items 7176
editing object hierarchies 7175
linking and unlinking objects 7175
procedures 7173
rearranging columns 7176
removing columns 7175
renaming an object 7176
selecting objects 7173
sorting 7175
syncing selection 7174
using 7173

scene extents 7919
scene motion blur (glossary) 7919
scene state 7185, 7188

camera properties 7185
camera transforms 7185
delete 7188
environment 7185
layer assignments 7185
layer properties 7185
light properties 7185
light transforms 7185
materials 7185
object properties 7185
rename 7188
restore 7188
save 7188
selected parts 7185

scenegraph 7063
scenes 25, 33–34, 47, 53, 6713

animating 33
archiving 53
backing up 53
importing 47

managing 6713
merging 47
rendering 34
replacing 47

scheduling server activity 6346
Schematic View 151, 7193, 7197, 7201, 

7205, 7207, 7213, 7217, 7219–
7220, 7370, 7921

delete Schematic View 7220
display floater 7217
displaying in viewport 7370
glossary 7921
list views 7205
menus 7201
new Schematic View 7219
preferences dialog 7207
right-click menu (selection) 7220
saved schematic views 7220
Schematic View window 7193
selecting with 151
toolbars 7213
using 7197

screen 7382
script 3173, 4426, 4447, 4455, 4484, 

4486, 7921–7922
and scripting definitions 7921–7922
motion flow 4426
random motion 4447, 4484
script controller (Track View) 3173
shared motion flow 4455, 4486

script rollout (particle flow) 2756
script wiring 2745, 2816
scripted behavior 4801, 7922
scripting 2767, 2816, 2868, 2874, 2911

birth operator 2767
script operator 2874
script test 2911
script wiring (particle flow) 2816, 

2868
scripts 2723, 4436, 7472, 7531

and controlling particles 2723
debugging 7472
define script 4436
path for additional 7531
start frame 4436
start position x 4436
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start position y 4436
start position z 4436
start rotation 4436

scripts group 4474
clip mode 4474
copy 4474
create 4474
cut 4474
define script 4474
delete script 4474
go to frame 4474
group 4474
paste 4474
random motion 4474
redefine 4474
start frame 4474
start position x 4474
start position y 4474
start position z 4474
start rotation 4474
unified motion 4474

scripts in motion flow 7922
scripts rollout 5941
scrolling panels/toolbars 38
SDeflector space warp 2669
SDynaFlect space warp 2663
searching 6939, 7652

defining search terms 7652
for files 6939
for help topics 7652
using nested expressions 7652

section 576
section view 4606
sections 4656, 4666
seed value (glossary) 7922
seek behavior 4696, 4802, 7923
segment (glossary) 7923
segments 4606
segments shadow mode 6114
select 98, 167, 169, 171, 189–190, 894, 

2529, 3268, 3547, 3552, 4172, 
4427, 4468, 4559, 4570, 4606, 
4656, 4672, 5642, 6264, 6813, 
6816

and rotate control points 4606
and scale control points 4606

and translate cross section 4606
by link 4559, 4672
clip/transition 4427, 4468
multiple biped links 4172
nearest bulge angle 4570, 4606, 

4656
select all (edit menu) 189
select and link button 3268
select and manipulate 2529
select background image dialog 98
select bitmap image file dialog 5642
select from scene dialog 169
select invert (edit menu) 190
select keys by time (Track

View) 3547
select layers dialog 6813
select linked objects dialog 6816
select network protocol dialog 6264
select none (edit menu) 189
select object (main toolbar) 167
select parent 169
select similar 190
select space warp 169
select time (Track View) 3552
selection floater 171

select and move 888
select and non-uniform scale 893
select and rotate 889
select and scale 891
select and squash 894
select and transform buttons 888–889, 

891–894
move 888
non-uniform scale 893
rotate 889
scale flyout 891
squash 894
uniform scale 892

select and uniform scale 892
select behavior type dialog 4773
select bitmap image file dialog 5642
select button 4559
select by 169, 190–192, 618, 627, 1959, 

2001, 2014, 2468, 3547, 3592, 
5244

color 191
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layer 192
material 5244
material ID 618, 627, 1959, 2014, 

2468
name 169, 3592
name (button) 169
name (edit menu) 191
select similar 190
smoothing group 1959, 2014
time (Track View) 3547
vertex color 2001

select by channel modifier 1587
select by name 146, 169
select delegates dialog 4774
select emitter objects dialog 2777
select from scene dialog 169
select keys 3431
select keys by time 3489
select menu (particle view) 2736
select menu (Schematic View) 7202
select objects dialog 169
select objects in current layer 7247
select parent 169
select pivot 4294
select region 195–196, 199–201

crossing 200
lasso 195
paint 196
window 199
window/crossing 201

select scale rotate control points 4606
select similar 190
select space warp 169
select time (Track View) 3552
select tool (particle view) 2736
selected deformable/rigid envelope

areas 4636
selecting 131–132, 140, 143, 146, 148, 

150–151, 590, 606, 618, 627, 
1959, 1993, 2014, 2019, 2743, 
2753–2754, 3275, 3552, 5035, 
5244, 6849

actions, events (particle flow) 2743
and blocks 6849
basics 140
by ID 618, 627, 1959, 2014

by material 5244
by name 146
by particle event 2754
by particle ID 2754
by region 143
hierarchies 3275
mesh sub-objects 1993
named selection sets 146
objects 131–132, 140
open editable mesh edges 2019
particles 2753
selection filters 148
shadow type 5035
shape sub-objects 590
successive vertices 606
time 3552
with Schematic View 151
with Track View 150

selecting workbench tracks 4399, 4407
selection (particle view) 2736
selection center (use center flyout) 907
selection commands 165
selection filter (main toolbar) 176
selection floater (tools menu) 171
selection information 1319, 2053
selection list 7347
selection lock toggle 7324
selection region 175, 192–196
selection rollout 1059, 1308, 2043

edit poly modifier 1308
editable poly 2043
hair and fur modifier 1059

selection sets 146, 176, 180, 1040
selection statistics 2493
self-illumination 5328, 5330–5333, 5344
self-illumination (glossary) 7924
self-illumination mapping 5373
send out test 2912
separate tracks options 4158, 4336, 4379
separating particles 2815
server setup and managing (network

rendering) 6248, 6259, 6300, 
6319, 6344

server window (network rendering) 6315
set all 4511
set as skin pose 244
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set bulge angle 4606, 4656
set current layer to selection's layer 7247
set free key 4289
set key 3010, 4192, 4289, 4301, 7347
set lowest starting foot height to

Z=0 4253
set multiple keys 4306
set parents 4301
set planted key 4289
set project folder 6728
set sliding key 4289
set start frames dialog 4830
set twist pose 4278
set weight 1632
setting keys 4192
setting up 25, 6261, 6272–6273, 6300

directories 6273
for network rendering 6261
manager and server programs 6300
rendering software 6272
TCP/IP (network rendering) 6261
your scenes 25

settings 6832, 7336
communication center 7336
Revit 6832

setup rollout 4739
setup rollout (particle view) 2750
SGI image file formats (glossary) 7161
shade selected (views menu) 107
shaded viewports 117
shader basic parameters rollout 5301
shader list 5831
shaders 4995, 5297, 5301, 5303, 5328, 

5330–5335, 5339, 5377, 5522, 
5801, 5803–5805, 5807, 5830–
5831, 7925

car paint (mental ray) 5522
custom 3ds Max 5804
DirectX 5297
for standard materials 7925
lume 5807
LumeTools 5807
mental ray 5801, 5804–5805, 5830–

5831, 7925
mental ray (third party) 5803
mr physical sky 4995

viewport 5297
shading and lights 5172
shading type 5168–5169
shading, cartoon 5580
shadow (center of mass) 4075, 4247
shadow maps 5095, 5102, 7927

mental ray 5095
shadow parameters (lights) 5047
shadow types 5035, 5965
shadows 6058–6059, 6114, 7928, 7978

shadow maps 6059, 6114, 7928, 
7978

shadow modes 6114
shadows rollout 6114

shadows and rendering 5037
shadows from hair 6391
shadows map (baking) 6176
shape check utility 541
shape commands (loft objects) 764
shape operators (particle flow) 2821–

2822, 2825, 2832
shape 2821
shape facing 2822
shape instance 2825
shape mark 2832

shape sub-objects 590
cloning selections 590
selecting 590

shape-file format 6974
ShapeMerge object 681
shapes 536, 576, 1330, 2066, 7929

creating from edges 1330, 2066
lofting 536
rendering 536

shared 4486
motion flow 4486

shared motion flow 4455, 4486
create 4455, 4486
dialog 4455, 4486
script 4455, 4486

sharing 5232
materials 5232

sharing a directory (network
rendering) 6275

sharing plug-ins with a network 7533
shell material 5570
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shell modifier 1588
shellac material 5565
shift+clone 958, 968, 970, 972, 975, 977

animating 977
using 958, 968, 970, 975

shifting 4134
center of mass 4134

shininess 5436
shininess and shininess strength 5370, 

5372, 7803
shirt (cloth) 1165
Shockwave 3D files 7061–7062, 7069, 

7071
analyzing 7071
exporting 7061–7062
previewing 7069

shortcuts 2758, 4389, 4598, 4730, 7645
Biped 4389
Crowd 4730
particle flow 2758
Physique 4598

shortcuts - default keyboard 1807, 3447
Track View 3447
unwrap UVW 1807

show 103–105, 108, 1022, 2564, 3580, 
3603, 5255, 5260, 5924, 7319, 
7480, 7545, 7965

show curves button 7319
show dependencies (views

menu) 108
show end result (Material

Editor) 5260
show end result (modifier

stack) 1022
show frame numbers (viewports

preference) 7545
show ghosting (views menu) 104
show home grid (views menu) 2564
show key times (views menu) 105
show last rendering (rendering

menu) 5924
show map in viewport (Material

Editor) 5255
show safe frame 7965
show selected key statistics (Track

View) 3603

show tangents (Track View) 3580
show UI 7480
show vertices as dots (viewports

preference) 7545
transform gizmo 103

show buffer 4496, 4503
to show original motion 4496
trajectory 4503

show entire trajectory 4268
show graph 4467

motion flow 4467
show hardware map in viewport 5255
show icon control 4945, 4948
show map in viewport 5255
show markers 4503, 4521
show prop markers 4521
show recognized markers 4521
show safe frame 7619
show selected key statistics (Track

View) 3603
show standard map in viewport 5255
show statistics 2493
show tangents (Track View) 3580
show time 4268
show unrecognized markers 4521
show/hide all 4268
SHP files 6974, 7931
shrink 1632
shutter speed 6087
sibling 5261

go forward 5261
go to 5261

sides 4656
simple additive compositor (video

post) 6710
simple constraints 3853
simple shadow mode 6114
simple wipe compositor (video

post) 6711
simple wipe filter (video post) 6642
simulation, cloth 1163
single-axis constraints 884
size 2751, 2785

of particle view icons 2751
of particle view logo 2751
or particles 2785
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size of grid square 7327
size test (particle flow) 2908
skeletal deformation tool 1600
skeletons 4052, 4054, 4533, 4540

and physique 4533
structure 4054
used with physique 4540

sketch tool dialog 1839
sketch UVWs 1802
skew modifier 1596
skin 1617, 4522, 4524, 4563, 4577, 4594

attaching to skeleton 4522
creating 4524
defined 4522
deformable 4522
mesh 4577
optimizing 4577
rigid 4522
save/load envelopes 1617
save/load vertex weights 1617
sliding 4594
sliding parameters 4563
valid types 4524

skin modifier 1600, 1634, 1908
paint weights 1908
weight table 1634

skin morph modifier 1636
skin parameters rollout (loft objects) 727
skin pose commands 244
skin pose mode 244
skin utilities 3798
skin wrap modifier 1648
skin wrap patch modifier 1657
skirt (cloth) 1165
sky 4973, 4990, 4995, 5000

IES sky light 4973
mr physical sky 4995
mr sky 4990
mr sky portal 5000

sky portal 5000
skylight 4940

radiosity 4940
skylight (glossary) 7931
slave controller 3067
slave parameters dialog (block

controller) 3209

sleeves (cloth) 1165
slice 1658, 2019

editable mesh edges 2019
editable mesh vertices 2019
modifier 1658

slide keys 3537
slider manipulator 2559
slider, time/frame 7312
sliding 4500, 4511, 4563, 4646, 7932

angle 4511
distance 4511
footsteps 4500, 7932
parameters (links) 4563

sliding and rotational joints (HI IK
solver) 3342

sliding angle 4511
sliding distance 4511
sliding door 512
sliding joints 3393, 3396, 3418
sliding key defaults 4289
sliding window 534
smart scale 891
smart select 167, 175
smoke map 5737
smooth 4600
smooth modifier 1665
smooth rotation controller 3178
smooth twist mode 4284
smoothing groups 339, 343, 1959, 2014, 

6794, 7933
assigning faces to 2014
assigning patches to 1959
viewing and changing 339, 343

smoothing rollout 4832
SMPTE (glossary) 7933
snap frames (Track View) 3530
snap options 2523
snap set key 4322
snaps 2033, 2522–2523, 2567–2568, 

2577, 2585, 2587
2D/2.5D/3D 2568
and cuts 2033
grid and snap settings 2577
options/settings 2523, 2587
setting standard 2522
snap commands 2567
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snap override 2585
snaps toggle 2570–2572

angle 2570
percent 2571
spinner 2572

snaps toolbar 7292
snapshot 979

cloning objects over time 979
snow 2943
soft bodies 3960–3961, 3966, 3969

collection 3969
FFD soft bodies 3966
modifier 3961

soft selection 3476
soft selection manager 3489
soft selection rollout 1908

brush options 1908
soft selection rollouts 1926, 2275
software display driver 7582, 7586
software requirements 6259
solve rollout 4822
solver plane 3368
SOmniFlect space warp 2661
sort shadow mode 6114
sound 3198, 3468, 7101, 7564

options dialog (Track View) 3468
sound plug-in (animation

preference) 7564
threshold 3198
VRML97 helpers 7101

source clip 4477
transition editor 4477

source file selection 4520
source icon (particle flow) 2749
source outputs (particle flow) 7879
space warp (vector field) 4838
space warp behavior 4804, 7933
space warps 2603, 2609–2610, 2615, 

2619, 2624, 2629, 2635, 2640, 
2643, 2646, 2650, 2656, 2661, 
2663–2664, 2666, 2669, 2673, 
2676, 2678, 2685, 2695, 2700, 
2703, 2707, 2711, 3997, 7934

binding to 2609
bomb 2707
conform 2703

deflector 2676
displace 2646
drag 2624
FFD(box) 2678
FFD(cyl) 2685
glossary 7934
gravity 2640
modifier-based 2711
motor 2615
path follow 2635
PBomb 2629
PDynaFlect 2656
POmniFlect 2650
push 2610
reactor water 3997
ripple 2700
SDeflector 2669
SDynaFlect 2663
SOmniFlect 2661
UDeflector 2673
UDynaFlect 2666
UOmniFlect 2664
vortex 2619
wave 2695
wind 2643

spacing tool 925, 998
spawned particles 2935
spawning particles 2885, 2912, 7934
special controls 38
special user account (network

rendering) 6270
special-purpose controllers 3037
specification 7093, 7812
specify conversion parameters once

option 4520
specify parameters for each file

option 4520
specifying 881, 3034

default controller values 3034
default controllers 3034
reference coordinate system 881

speckle map 5739
specular 5332, 5369–5370, 7935

color 7935
color mapping 5369
level mapping 5370
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specular highlight 5332
specular highlights 5353, 5355, 5357–

5358
anisotropic 5353
Blinn 5355
metal 5357
multi-layer 5358
Oren-Nayar-Blinn 5355
Phong 5355

specular map (baking) 6176
speed 4359, 4365, 4369
speed operators (particle flow) 2791, 

2796, 2806, 2815
keep apart 2815
speed 2791
speed by icon 2796
speed by surface 2806

speed test (particle flow) 2917
speed vary behavior 4805, 7936
sphere 356, 6567

object 356
SphereGizmo helper 6567

spherical area omni light 4945
spherical deflector 2669
spherify modifier 1668
spin operator (particle flow) 2783
spindle 405
spine 4077

flexibility 4077
spine link 4343
spinner right-click menu 3014
spinners 38, 2572, 7536

spinner precision 7536
spinner snap 2572, 7536

spiral stair 480
splash screen 50
splash.bmp file 50
splat map 5741
spline dynamics 4052, 4098, 4336, 7937
spline IK 1670, 3369, 3376, 3379

animating with spline IK
solver 3369

control modifier 1670, 3369
spline IK solver dialog 3376
spline IK solver rollouts 3379

spline select modifier 1673

spline-based deformation in
physique 4542

splines 542, 551, 555, 557, 559–560, 
564–565, 567, 569, 574, 590, 
602, 606, 618, 627, 1696, 4540, 
7937

adding 618, 627
arc 560
attach 606, 627
circle 557
cleaning up segments 627
copying (outline) 627
deleting 627
donut 564
editable splines 590, 602, 606, 618, 

627
ellipse 559
explode 627
glossary 7937
helix 574
line 551
making coincident 1696
mirror 627
NGon 565
rectangle 555
star 567
text 569
used with physique 4540

split mesh 2019
split scan lines 6293
split tests (particle flow) 2920–2922

split amount 2920
split selected 2921
split source 2922

splitting particle stream 2920–2922
spotlights 5009, 5051

parameters 5051
spotlight distribution (photometric

lights) 5009
spray 2938
spring 3853
spring back - setting (IK) 3355
spring controller 3179
spring dynamics object 821
spring options (flex modifier) 1418
squash 894
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squeeze modifier 1676
SSS materials (mental ray) 5536
stack 1020, 1023, 1032, 7851
stack updates 4586, 4594
stack. modifier stack 7427
stairs 433, 471, 473, 480, 488, 495

l-type 473
spiral 480
straight 488
u-type 495

standard display 114
with maps 114
without maps 114

standard flow operator 2876
standard helpers 2530–2532, 2538, 

2544, 2546, 2549, 2551
compass 2551
dummy 2531
expose transform 2532
exposetm 2532
grid 2538
point 2544
protractor 2549
tape 2546

standard lights 4891, 4925, 4940
skylight 4940

standard material 5299
standard materials 7925

shaders (glossary) 7925
standard primitives 348, 350, 353, 356, 

361, 364, 367, 371, 374, 377, 380
box 350
cone 353
cylinder 364
GeoSphere 361
plane 380
pyramid 374
sphere 356
teapot 377
torus 371
tube 367

standard snaps 2522
standard user grids 2538
star 567, 6436

lens effects 6436
starfield filter (video post) 6643

start after last footstep 4359, 4365, 4369
start at current frame 4359, 4365, 4369
start frame 4474, 4477

scripts 4474
transition editor 4477

start left 4359, 4365, 4369
start position x 4474

scripts 4474
start position y 4474

scripts 4474
start position z 4474

scripts 4474
start right 4359, 4365, 4369
start rotation 4474

scripts 4474
starting 6248

manager and server (network
rendering) 6248

network rendering 6248
startup files 50
startup layout - return to 7519
startup screen 50
startup script (glossary) 7938
startup scripts 7531

path for additional 7531
startup.ms file 50
state dialog 4779
state filters 4306
state panel 4849
state transition dialog 4780
statistics 7629
statistics rollout (radiosity) 6027
status bar controls 3590, 6575, 7308, 

7312
main window 7308, 7312
Track View 3590
video post 6575

step files 4230, 4253
step update scripts (particle flow) 2756
steps 590, 1968

and editable patch 1968
and editable spline 590

stereolithography (STL) 7073
stick 4511
stick figures 4477

transition editor 4477
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stitch tool dialog 1841
stitch UVWs 1802
STL 1678, 7073, 7076

exporting files 7076
importing files 7073
STL check modifier 1678

stop animation playback 7355
STP files 4147, 4220, 4230, 4261, 4264, 

4876
loading 4264
saving 4147, 4261

straight stair 488
Strauss basic parameters rollout 5335
streak 6443

render effect 6443
strength 4636
stretch 4563, 4646, 4666
stretch bias 4666
stretch modifier 1682
stretcher 1826
strokes 7545, 7631, 7634, 7638, 7641, 

7643
defining 7634
preferences 7631, 7641
reviewing and editing strokes 7638
viewport preferences 7545

structure rollout 4339, 4343
stucco map 5743
styles 5232, 6850

and Architectural Desktop
objects 6850

propagation 5232
styling hair 1053, 1070

hair and fur modifier 1053, 1070
styling rollout 1070

hair and fur modifier 1070
sub-object 160, 1029, 1032, 1993, 2164, 

2229, 2304, 5216, 7940
chamfer curve (NURBS) 2304
common controls 2229
glossary 7940
material assignment 5216
selection 160, 1029, 1032, 1993, 

2164
sub-objects 4635

Physique 4635

subanim controller 4174
subdivide 1968, 2019, 2033
subdivide modifier 1688
subdivide modifier (world space) 1129
subdivision displacement rollout 2123

editable poly 2123
subdivision surface rollout 2118

editable poly 2118
subdivision surfaces 1420, 1926
substeps 3816
substitute modifier 1691
subsurface scattering (SSS) materials

(mental ray) 5536
subtractive opacity (glossary) 7941
subtree - modifying (Track View) 3482
summary info 6919
sun 4969
sunlight 5024
sunlight (glossary) 7942
super black 7560, 7942
super spray 2947
superimposed material 5565
supersampling 5285, 7942
support period 7943
surf point 2435
surface approximation 2469, 2479–2481
surface arrive behavior 4807, 7943
surface constraint 3219
surface follow behavior 4811, 7943
surface joints 3393, 3396
surfaces 627, 719, 1129, 1132, 1259, 

1696, 1707, 1959, 1998, 2001, 
2007, 2014, 2156, 2190, 2313, 
2316, 2336–2337, 2435, 2441, 
2469, 2480–2481, 2491

NURBS surfaces 2190
surface approximation

(NURBS) 2469, 2480–
2481, 2491

surface deform (SurfDeform) 1132
surface edge curve 2336
surface mapper (world space) 1129
surface modifier 1259, 1696
surface offset curve 2316
surface parameters (loft objects) 719
surface point 2435
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surface properties rollout (editable
objects) 627, 1959, 1998, 
2001, 2007, 2014

surface sub-objects - creating 2337
surface tools 1259, 1696
surface trimming 2156
surface-curve intersection

point 2441
surface-surface intersection

curve 2313
SurfDeform modifiers 1707

SurfDeform modifiers 1132, 1707
swap 5269–5270, 6600

colors 5270
events (video post) 6600
maps 5269

sweep modifier 1709, 1728, 1730, 1732
extract 1730
merge from file 1732
pick shape 1728

swirl map 5687
swivel angle 3321, 3368
symmetrical tracks 4270
symmetry modifier 1735
synchronizing animated bitmap with the

scene 5267
synthesis control dialog 4724
synthesis dialog 4724, 4845–4846, 4849, 

4852
motion clips panel 4845–4846
state panel 4849
synthesis panel 4852

synthesis panel 4852
synthesis/synthesize 7943
system paths 7531
system unit 7606, 7608

setup dialog 7606
units mismatch dialog 7608

system units and scaling 4576
systems 831, 853, 5024

bones 831
daylight 5024
ring array 853
sunlight 5024

T

tags (time) 7328–7329
tails 4077

adding 4077
talent definition area 4511
talent figure mode 4496, 4503, 7944
tangent handles 606
tangent types 3054
tangents 3063, 3582, 7944

glossary 7944
locking 3582
type of 3063

tape helper object 2546
taper modifier 1740
targa files (glossary) 7162, 7900
target 2892, 4927, 4933, 4955, 4958, 

4960, 4965, 7398
and particles 2892
camera 7398
lights 4927, 4933, 4955, 4958, 

4960, 4965
target area light 4965
target camera 5118
target direct light 4933
target directional light 4933
target distance 6061
target linear light 4960
target map slot 6181
target objects - look at controller 3124
target point light 4955
TCB 3183, 4289, 7945

controllers 3183
glossary 7945

TCB (biped) 7944
tcb rotation 4164

controller 4164
TCP/IP protocol 6261, 6264
teapot 377
techniques 958, 2180

cloning objects 958
NURBS 2180

tee 587
teeter deformation 749
temp 7531

path for 7531
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temporary 204, 7023
buffer 204
IGES files 7023

tendon display options dialog 4631
tendons 4522, 4571–4572, 4594, 4600, 

4602, 4666, 7946
adding 4572
adjusting 4666
and fixed attach points 4666
attach points 4666
attached links 4666
attaching to another link 4572
attaching to link 4572
boundary conditions 4666
creating 4572
cross sections 4666
deleting 4572
inserting 4572
overview 4571
using 4572
workflow 4666

tendons sub-object 4631
tension/continuity/bias 4289, 4644
tension/continuity/bias (glossary) 7945
tension/continuity/bias in biped 7946
terminating chains 3366
terminators 3302
terminology (inverse kinematics) 3302
terrain 703, 1506, 7947

creating effects with noise
modifier 1506

glossary 7947
tessellate 1743, 2019, 2149, 2646

and displace space warp 2646
faces 2019
tessellate modifier 1743
tessellate selection dialog 2149

test outputs (particle flow) 7879
test time frames 2759
tests (particle flow) 2877, 2879, 2881, 

2885, 2892, 2903, 2908, 2911–
2912, 2917, 2920–2922, 7948

acceleration 2917
age 2879
circular travel 2917
collision 2881

collision spawn 2885
distance from target 2892
find target 2892
go to rotation 2903
scale 2908
script 2911
send out 2912
size 2908
spawn 2912
speed 2917
split amount 2920
split selected 2921
split source 2922
time 2879
velocity 2917

texel 7948
text 569
texture 6169, 6174, 6181

baked elements 6174
baking 6169
rendering to 6169, 6174, 6181
target map slot 6181

texture baking - shell material 5570
textures 1769, 1788, 2189, 2278, 6195, 

6969, 7611
and animated NURBS models 2189
and imported mask bitmaps 6969
and material properties 2278
and NURBS models 2189
baking 6195
disable texture map display 7611
pick texture option (edit UVWs

dialog) 1788
pinning 1769

TGA files (glossary) 7162
thin wall refraction map 5799, 6048
three-DOF limb 4278
threshold 343, 606, 1455, 1515, 1665, 

1696, 1788, 1845, 1990, 2007, 
2019, 2494, 3198, 3349–3350, 
3562, 3721, 3760, 5236, 5285, 
5429, 5673, 5678, 5724, 5741, 
5743, 5780, 6507, 6521, 6990, 
7073, 7560, 7568

adaptive control 5429, 5780
and HD IK solver 3350
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color 5741, 5743
edge visibility 2007
error (camera tracker) 3760
explode angle 2019
LOD 2494
motion capture samples 3721
noise 5673, 5678, 5724, 6507, 6521
optimize 1515
planar 1455, 1990
position/rotation (IK) 3349
reduce keys 3562
safe video 5236
sound 3198
super black 7560
supersampling 5285
use secondary (IK) 7568
weld 606, 1696, 1788, 1845, 2019, 

6990, 7073
thumbnails 6718, 7541

open file 6718
viewport image 7541

ticks (glossary) 7948
TIFF files 6559, 7164
tile/mirror (glossary) 7949
tiles map 5690
time 2721, 3019, 3021–3023, 3447, 

3532, 3551–3555, 3557–3559, 
4289, 7312, 7328–7329, 7331, 
7359

controlling 3019
copy (Track View) 3555
cutting 3554
deleting 3553
editing 3551
fitting into 3559
in particle flow 2721
insert (Track View) 3558
moving through 3023
paste (Track View) 3555
removing 3558
rescaling active time segment 3022
reverse (Track View) 3557
scale (Track View) 3559
selecting 3552
setting time segments 3021
specifying active time segment 3021

time configuration button 7359
time ruler (Track View) 3447
time slider 3447, 3532, 7312
time tags 7328–7329, 7331

time controls 7342
time frames 2759
time in the air 4139
time menu, Track View 3478
time paste (Track View) 3555
time reverse (Track View) 3557
time ruler (Track View) 3447
time steps 3814
time to next footstep 4359, 4365, 4369
time warps 3655
TimeSensor (VRML97 helpers) 7107
timing parameters 4352
tips 1998, 2017, 2180, 2189, 4921, 

5124, 5161, 5441, 5930, 5995, 
6777, 7090, 7228, 7315, 7355, 
7401, 7446

adjusting radiosity 5441
animation and textures

(NURBS) 2189
camera correction 5161
copying keys between frames 7315
flipping face normals 2017
magnifying camera

adjustment 7401
maintaining consistent camera lens

size 5124
NURBS 2180
output size and rendering

speed 5930
playing animations in all

viewports 7355
propagating layer properties 7228
radiosity and walkthroughs 5995
selecting faces to hide 1998
testing radiosity 5995
textures (NURBS) 2189
turning off material

propagation 7446
updating information in light

lister 4921
using file link manager 6777
VRML97 7090
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toes option 4077
toggles 83, 201, 2570–2572, 3007, 3585, 

5232, 7324, 7358, 7382, 7646
adaptive degradation 83
angle snap 2570
animation mode 3007
auto key mode 3007
auto material propagation 5232
enable ease or multiplier curve 3585
full screen 7382
key mode 7358
maximize viewport 7382
percent snap 2571
selection lock 7324
shortcut keys 7646
spinner snap 2572
window/crossing 201

toggling 2742
events (particle view) 2742
operators (particle view) 2742

toggling dialogs 7253
tolerance 4511
tone mapping 6532, 6535, 6538, 6540, 

6544, 6552
automatic exposure control 6535
exposure controls 6532
linear exposure control 6538
logarithmic exposure control 6540
mr photographic exposure

control 6544
pseudo color exposure control 6552

toolbars 3495, 3501, 3505–3507, 3808, 
6596, 7213, 7283–7284, 7288–
7293, 7479, 7492, 7511, 7516, 
7658, 7683

axis constraints 7288
brush presets 7293
controller toolbar 3505
curve editor 3495
displaying toolbars 7479
dope sheet 3501
extras 7290
extras dope sheet toolbar 3507
HTML help viewer 7658
icon scheme 7516
layers 7289

main 7284
ranges toolbar 3506
reactor 3808, 7290
render shortcuts 7291
Schematic View 7213
snaps 7292
toolbars panel (customize UI) 7492
troubleshooting when missing 7683
video post 6596

toolbox (NURBS) 2162
tools 266, 2492, 2502, 5222

for low-polygon modeling 2492
Material Editor 5222
precision 2502
rename objects 266

tools menu 85, 159, 171, 266, 338, 911, 
925, 933, 938, 944–945, 948, 950–
951, 2529, 4920, 5152, 7171, 
7261, 7458

align 938
align camera 950
align to view 951
camera match 5152
clone and align tool 933
color clipboard 338
display floater 7458
floaters 7458
grab viewport 85
isolate selection 159
light lister 4920
measure distance 2529
mirror 911
new scene explorer 7171
normal align 945
open explorer 7171
place highlight 948
quick align 944
rename objects 266
saved scene explorers 7171
selection floater 171
spacing tool 925

tools rollout 1061
hair and fur modifier 1061

tooltips 2744, 7309
tooltips in viewports 7536

preferences 7536
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toon shader 5580
top/bottom material 5568
topology (glossary) 7950
topology dependent modifier 7951
torus 371
torus knot 389
total statistics 2493
touch 4118, 4253, 4306, 7951

leg state 4118
touch dynamics 4139
TouchSensor (VRML97 helpers) 7105
toy car 3926
trace depth 6096, 6118, 7894
track 3526, 3528, 3555, 7954

copying 3555
glossary 7954
note 3526, 3528

track bar 7315
track selection 4270, 4495

using motion-capture filtering 4495
track selection in workbench 4407
track selection rollout 4158
track set list 3495, 3501
track sets editor 3596
track sets list 3594
Track View 150, 3211, 3427, 3431, 

3433, 3441, 3447, 3454, 3468, 
3470–3471, 3475, 3478–3479, 
3488–3489, 3505–3507, 3515, 
3541–3543, 3545, 3547–3548, 
3555, 3590–3591, 3601–3609, 
3611, 4133, 4154, 4375, 4379, 
4385, 4856, 7952

assign controller 3515
biped colored keys 4385
concepts 3431
controller menu 3471
controller toolbar 3505
controller window 3433, 3454
curve editor 3427, 3441
curves menu 3478
customization 3611
delete Track View 3609
dope sheet 3427
editing biped keys 4133
extras dope sheet toolbar 3507

glossary 7952
hierarchy 3454
hierarchy icons (glossary) 7952
hierarchy of biped objects 4154
key time display 3601
keys menu 3475
keys window 3433
menu bar 3470
modes menu 3471
new Track View 3608
opening 4154
Options menu 3479
pan 3603
pasting time 3555
pick dialog 4856
pick dialog (block controller) 3211
properties 3541
ranges toolbar 3506
selecting with 150
shortcuts 3447
sound options 3468
status bar/view controls 3590
time menu 3478
tracks menu 3475
utilities 3542–3543, 3545, 3547–

3548
utilities menu 3489
value display 3602
view menu 3488
working with 3431
workspace 3433
zoom 3606
zoom horizontal extents 3604
zoom region 3607
zoom selected object 3591
zoom value extents 3605

Track View utilities 3549
current value editor 3549

tracker gizmo 3750
trackgroup 3703–3704

filter 3703–3704
trackgroup filter dialog 3676, 3703–3704
trackgroups 3637, 3659, 3676

adjusting balance 3659
creating and filtering 3637
menu 3676
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tracks 3626, 3677, 4308, 4399
adding to motion mixer 3626
copying and pasting 4308
menu 3677
selecting workbench 4399

tracks menu, Track View 3475
trajectories 3046, 4093, 4241, 4289, 

7955
display 4093, 4241
glossary 7955
motion panel 3046

trajectories (biped) 7956
trajectories,displaying 4289
trajectory key editing 4212
transform coordinates and coordinate

center 896, 908
transform gizmo 7956
transform gizmos 103, 867, 7570

preferences 7570
show transform gizmo 103
using 867

transform script controller 3186
transform tools 909
transform type-in 874, 7327
transformation axis coordinate system

list 897
transforms 859, 863, 877, 879, 887, 909, 

1016, 1993, 2294, 2346, 3016, 
3293–3294, 3424, 4551, 4910, 
6820, 7712, 7958

adjusting 3293
and envelopes 4551
and light objects 4910
and mesh sub-objects 1993
and modifiers 1016
animating 877
applying 859
commands 887
controllers (glossary) 7712
curve 2294
curve sub-object 2294
glossary 7958
locking 3294
locking axes 3424
managers 879
resetting AutoCAD objects 6820

surface 2346
surface sub-object 2346
transform tools 909
using 863
viewing and copying keys 3016

transition 3646, 3697, 4431, 4444, 
4447, 4474, 4490

clip 4474
create 4431
create all 4431
customize 4444
edit 4431, 4444, 4474
focus 3646
motion mixer 3646
optimize 3646, 3697
optimize transition 4490
random motion 4447

transition editor 3687, 3691, 4431, 4477
angle 4477
ease in 4477
ease out 4477
fixed 4477
frame 4477
length 4477
mixer (biped object) 3687
mixer (non-biped object) 3691
optimize 4477
probability 4477
rolling 4477
start frame 4477

transition optimization dialog 3697, 
4490

motion mixer 3697
transition track 3626, 3646

motion mixer 3646
transitions 3680, 4780

menu 3680
state transition dialog 4780

translate only 6132
translation file (specifying name and

path) 6132
translator options rollout 6122
translucency 5351, 5436, 7959

glossary 7959
translucent highlights 5361
translucent shader 5339
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transmittance display 5228
transparency 5436
TRC 3740, 7056

convert into CSM 3740, 7056
importing 7056

tri patch 1987
triangle count 2493, 7629
triangle pelvis 4077, 4343

and physique 4077
trigonometric functions 309
trim clips 3644

motion mixer 3644
trim overlapping segments 627
trim/extend modifier 1746
troubleshooting 1258, 3774, 4037, 

5152, 6184, 6253, 6577, 7663, 
7667, 7677, 7681, 7683, 7690

3ds Max 7663
assertion failed errors 7663
basic troubleshooting start

point 7690
Boolean objects 7667
camera match 5152
camera tracker 3774
creases or ridges in Boolean

objects 7667
Direct3D failed to initialize

message 7690
Direct3D reports a memory

warning 7690
dual monitor configuration 7690
garment maker errors 1258
large font problems 7683
lost dialogs 7683
merging corrupt files 7663
missing command panel 7683
missing gizmos 7683
multiple or missing buttons on

toolbars 7683
network rendering 6253
normal bump maps 6184
objects disappear when the camera

gets close 7681
reactor 4037
remember back up files 7663
slow file opening 7677

slow response to open or drag
dialogs 7677

slow startup time 7677
sluggish command response 7677
spanning across monitors 7690
splines and Boolean

operations 7667
tips for successful Boolean

operations 7667
unit scale and movement resolution

relationship 7681
video post 6577
viewport transparency 7690

truck camera 7403
truck light 7417
true/false, setting test results (particle

view) 2742
truecolor 7560, 7960
tube 367
turbosmooth modifier 1751
turn to mesh modifier 1756
turn to patch modifier 1759
turn to poly modifier 1761
turning on/off 2745, 2750

actions, events (particle view) 2745
particle system 2750

tweens 3003
twist 747, 1765, 4278, 4646

deformation 747
modifier 1765

twist individual mode 4284
twist links 4097, 4343
twist links mode 4172, 4284, 7960
twist parameters (links) 4563
twist poses 4097
two-DOF limb 4278
two-point perspective 5160
two-sided 7614
type-in weights 4672
types of 810, 863, 2603

dynamics objects 810
space warps 2603
transforms 863
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U

U and V iso curves 2318
U loft surface and sub-object 2380
u-type stair 495
UDeflector space warp 2673
UDynaFlect space warp 2666
UI 7279, 7475, 7480–7481, 7489, 7513, 

7515–7516, 7519, 7610, 7617
customizing 7513

UI files 7513
unbinding 606, 3347, 3410

objects 3347, 3410
vertices 606

UNC 7961
understanding 3620, 4058–4059, 4061, 

4394
crowds 4061
motion flow 4059
motion mixer 3620
workbench 4058, 4394

understanding crowd behaviors 4691
undo 38, 87, 203
undo levels 7536
unexpected particle spawning 2727
unfold mapping 1803, 1844
unfreezing objects 152, 7458
ungroup 224
unhide 120, 7806
unhide all 4672
unified motion 4452

create 4452
uniform scale 892
unify normals 340, 6794
units 2504, 6718, 6783, 7326, 7536, 

7601, 7606, 7608, 7681
and display of mouse position 7326
automatic unit conversion 6718
file load units mismatch 7608
mismatch 7608
setup 7601
synchronizing between

programs 6783
system setup 7606
troubleshooting problems

with 7681

unit scale preference 7536
using 2504

universal deflector 2673
universal naming convention

(UNC) 7961
unlink selection 3269
unlock 243

character 243
unlock assignments 4672
unlock interior edges (of selected

patches) 1935
unwrap UVW 1769, 1771, 1788, 1803, 

1807, 1825, 1831, 1845
automatic mapping 1803
Edit UVWs dialog 1788
multiple instanced modifiers 1771
multiple objects 1771
options dialog 1845
pack UVs dialog 1825
relax tool dialog 1831

UOmniFlect space warp 2664
up vector 4511
update 102, 115, 2722, 2740, 2832, 

5281, 7545, 7703
ActiveShade 7703
background image 102
background while playing 7545
during spinner drag 115
particle shape 2832
scene materials 5281
update types (particle flow) 2740

upper bound 4666
use center flyout 904–905, 907–908

use pivot point center 905
use selection center 907
use transform coordinate center 908

use dual planes (viewport
preference) 7545

use key reduction 4511
use large toolbar buttons

preference 7536
use pivot point center 905
use pivot points 1034
use planes (viewport preference) 7545
use secondary threshold (IK) 7568
use selection center 907
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use soft select 3476
use transform coordinate center 908
UseEnvironAlpha setting 7768
user account - network rendering 6270
user grids 2538, 2595
user interface 1058, 1185, 1243, 7251, 

7257, 7475, 7683
cloth modifier 1185
customizing 7475
garment maker modifier 1243
hair and fur modifier 1058
introduction 7251
menu bar 7257
problems and recovery 7683

user reference 7647
user views 61
user-defined object properties 264
using 27, 49, 71, 146, 148, 319, 536, 

863, 867, 884, 968, 1016, 1020, 
1032, 2162, 2504, 2506–2507, 
2510, 2929, 2932, 2935, 2937, 
3007, 3288, 3360, 4172, 4181, 
4210, 4241, 4712, 4894, 5134–
5136, 5178, 6231, 6277, 6308, 
6315, 6332, 6340, 6349, 7197, 
7262, 7647, 7650

asset browser 49
auto key button 3007
axis constraints 884
batch rendering 6349
bend links mode 4172
bipeds with crowd delegates 4712
clipping planes to exclude

geometry 5135
configure paths 6277
create panel 319
default joint precedence 3360
dummy objects 3288
grid objects 2510
grids 2506
groups 7262
help 7647
home grid 2507
horizon to match perspective 5136
HTML help viewer 7650
IK keyframe parameters 4181

in place mode to adjust
keyframes 4241

interparticle collision 2937
layers 4210
lights 4894
mapped materials with Particle

Systems 2932
maps to enhance a material 5178
materials 27
materials with particle array 2929
modifier stack 1020
modifier stack at sub-object

level 1032
modify panel 1016
move and rotate to aim 5134
multi/sub-object materials with

particle systems 2935
multiple computers 6231
named selection sets 146
network manager window 6308
network server window 6315
NURBS toolbox to create

sub-objects 2162
online reference 7647
queue monitor module info

report 6332
queue monitor report

generator 6340
Schematic View 7197
select by name 146
selection filters 148
shapes 536
shift+clone 968
spawned particles 2935
standard view navigation 71
transform gizmos 867
transforms 863
transforms to aim a camera 5134
units 2504

using crowds 4686, 4696
behaviors 4696
crowd helper 4686
delegate helper 4686

using props 4177
using the track sets list 3594

Index | 8079



utilities 338, 541, 886, 1931, 2480, 
2494, 2597, 2599, 3297, 3489, 
3542–3543, 3545, 3547–3548, 
3718–3719, 3721, 3740, 3742, 
3775, 3798, 5152, 5185, 5188, 
5849, 5858, 5864, 5869, 6225, 
6559, 6928, 6939, 6942, 6944, 
7052, 7136, 7281, 7465, 7468, 
7472, 7643

3ds Max file finder 6939
animation 3718
asset browser 6928
assign vertex colors 5849
camera match 5152
camera tracker 3742
channel info 5858
clean multimaterial 5864
collapse 1931
color clipboard 338
create out-of-range keys (Track

View) 3545
dialog 7465
dynamics 3775
filter selected euler tracks (Track

View) 3548
fix ambient 6944
follow/bank 3719
IFL manager 7136
instance duplicate maps 5869
level of detail 2494
lighting data exporter 6559
Lightscape Materials 7052
link inheritance (selected) 3297
LOD 2494
MACUtilities 3740
material xml exporter 5185
MAXScript 7281, 7468
measure 2597
motion capture 3721
panorama exporter 6225
randomize keys (Track View) 3543
rescale world units 2599
reset XForm (transform) 886
resource collector 6942
select keys by time (Track

View) 3547

shape check 541
skin utilities 3798
strokes 7643
surface approximation 2480
Track View 3542
utilities menu, Track View 3489
UVW remove utility 5188
visual MAXScript 7472

utils rollout 4018
UV 2390, 5183, 5235

coordinates 5183
loft surface 2390
sample UV tiling 5235

uv coordinate shader (mental ray) 5840
uv generator shader (mental ray) 5832
uv generator shader parameters rollout

(mental ray) 5833
uv generator shaders rollout (mental

ray) 5838
UVW 1799, 1872, 5183, 5188, 6827, 

6841, 7962
coordinates 5183
coordinates (glossary) 7962
edit UVWs dialog menu bar 1799
mapping in AutoCAD Architecture

objects 6827
mapping in Revit objects 6841
remove utility 5188
XForm modifier 1872

UVW mapping add modifier 1871
UVW mapping clear modifier 1871
UVW mapping paste modifier 1872

V

v command-line option 7257
value display 3602
Vault 6896, 6900

setting working folder 6900
VDA targa files (glossary) 7162
vector 312, 1954, 1968, 2324, 7964

editable patch handle
sub-object 1954

handles and editable patch vertex
sub-objects 1968

introduction 312
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vector handles (glossary) 7964
vector projected curve 2324

vector field 7963
vector field space warp 4838–4840, 7963

create method rollout 4839
lattice parameters rollout 4839
obstacle parameters rollout 4840

velocity element parameters
rollout 6165

velocity interpolation 7965
verbosity (messages) 6132
versioning 6896
vertex 4559, 4600, 4602, 4672

operations 4672
settings 4600, 4602
vertex sub-object 4672

vertex - definition 7965
vertex alpha 1880
vertex color 1876, 5771

rendering 5771
vertex color map 5771
vertex count 2493, 7629
vertex display size 7546
vertex illumination 1880
vertex normals (scaling) 1990
vertex to link assignment 4622

initialization 4622
vertex type 1947
vertex weld modifier 1874
vertex-link assignments 4600, 4602
vertexpaint modifier 1876, 1886, 1900, 

1902, 1908
adjust color dialog 1900
brush options 1908
color palette 1902
paintbox 1886
palette 1902

vertical (move key) 3575
vertical motion 4139

dynamics of 4139
vertices 602, 606, 618, 627, 765, 1321, 

1876, 2001, 2019, 2055, 4559
adding 606, 618
align 2019
attach/detach 2019
breaking 2019

changing type 4559
checking assignments 4559
checking for alignment in loft

objects 765
choosing type 4559
creating 2019
deleting 606, 2019
inserting 602, 627
make planar 2019
making rigid 4559
manually assigning deformable

blended 4559
manually overriding

assignments 4559
painting 1876
reassigning manually 4559
removing deformable 4559
selecting by color 1321, 2055
slice 2019
weld 2001, 2019
working with 4559

video color check 5236
video driver and display problems 7690
video post 6571, 6573, 6575, 6577, 

6580, 6596–6598, 6600–6601, 
6603–6607, 6613, 6617, 6623, 
6627, 6630, 6634, 6636–6643, 
6647–6648, 6654, 6656–6657, 
6659–6660, 6662, 6664, 6666–
6667, 6670, 6673, 6676, 6680, 
6682, 6685, 6689, 6693, 6698, 
6702, 6704, 6707–6711

abut 6607
add external event 6630
add image input event 6613
add layer event 6623
add loop event 6634
add output event 6627
add scene event 6607
align left 6605
align right 6606
alpha compositor 6708
alpha filter 6638
animating lens effects 6647
automatic secondary flare

parameters 6659
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common procedures 6580
composite image sequences 6580
composite scene over image

sequence 6580
configure presets 6603
contrast filter 6636
create animation from still

images 6580
create starfield 6580
cross fade compositor 6708
edit current event 6598
edit external event 6630
edit image input event 6613
edit layer event 6623
edit loop event 6634
edit output event 6627
edit range bar 6604
edit scene event 6607
execute sequence 6601
fade filter 6637
flare glow parameters 6656
flare inferno parameters 6667
flare lens effect 6648
flare preferences 6654
flare ray parameters 6662
flare ring parameters 6657
flare star parameters 6664
flare streak parameters 6666
focus lens effect 6670
glow inferno 6682
glow lens effect 6673
glow preferences 6680
glow properties 6676
highlight geometry 6693
highlight lens effect 6685
highlight preferences 6698
highlight properties 6689
image input event 6617
image input options 6617
join two animations 6580
lens effects 6647
lens effects filters 6639
lens effects gradient colors 6707
lens effects gradient options 6702
lens effects gradient types 6704
make an object glow 6580

make same size 6607
manual secondary flare

parameters 6660
negative filter 6640
new sequence 6596
open sequence 6597
pseudo alpha compositor 6709
pseudo alpha filter 6641
queue 6573
render in reverse 6580
resize images 6580
save sequence 6598
simple additive compositor 6710
simple cross fade 6580
simple wipe compositor 6711
simple wipe filter 6642
starfield filter 6643
status bar 6575
swap events 6600
switch views 6580
toolbar 6596
troubleshooting 6577
view controls 6575

video post compositors 6708–6711
alpha compositor 6708
cross fade compositor 6708
pseudo alpha compositor 6709
simple additive compositor 6710
simple wipe compositor 6711

video post filters 6636–6643, 6647–
6648, 6654, 6656–6657, 6659–
6660, 6662, 6664, 6666–6667, 
6670, 6673, 6676, 6680, 6682, 
6685, 6689, 6693, 6698, 6702, 
6704, 6707

alpha filter 6638
animating lens effects 6647
automatic secondary flare

parameters 6659
contrast filter 6636
fade filter 6637
flare glow parameters 6656
flare inferno parameters 6667
flare lens effect 6648
flare preferences 6654
flare ray parameters 6662
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flare ring parameters 6657
flare star parameters 6664
flare streak parameters 6666
focus lens effect 6670
glow inferno 6682
glow lens effect 6673
glow preferences 6680
glow properties 6676
highlight geometry 6693
highlight lens effect 6685
highlight preferences 6698
highlight properties 6689
lens effects 6639, 6647
lens effects gradient colors 6707
lens effects gradient options 6702
lens effects gradient types 6704
manuarl secondary flare

parameters 6660
negative filter 6640
pseudo alpha filter 6641
simple wipe filter 6642
starfield filter 6643

video safe frame (glossary) 7965
view 61, 71, 951, 6224, 6923

align to view button 951
axonometric views 61
camera views 61
light views 61
navigation 71
perspective views 61
preset 61
view file dialog 6923
view image file (file menu) 6923
view preview (rendering

menu) 6224
view change 87
view controls 6575

video post 6575
view image file 6923
view menu 3488

Track View 3488
view menu (Schematic View) 7204
view samples 7914
view steps 1979
view-handling commands 86

viewing 55, 340, 343, 2511, 3016, 5135, 
6339

3D space 55
and changing normals 340
grid objects 2511
jobs in the queue 6339
portions of scene 5135
servers in the queue 6339
smoothing 343
the queue 6339
transform keys 3016

viewing sample biped animations 4222
viewport clipping 5135, 7370, 7611
viewport configuration 7610–7611, 

7617, 7619, 7622, 7626, 7630
adaptive degradation 7622
layout 7617
lighting and shadows 7630
regions 7626
rendering method 7611
safe frames 7619
viewport configuration dialog 7610

viewport controls 7378
viewport display, particles 2864
viewport navigation 75, 7383

walkthrough 75, 7383
viewport properties menu 7370
viewport renderer (glossary) 7966
viewport rendering 7611
viewport shaders 5297, 5598, 5600

lightmap 5598
metal bump 5600

viewport shading 7611
viewports 56, 65, 68, 85, 89, 114, 4911, 

5297, 7262, 7309, 7312, 7370, 
7378, 7384, 7397, 7407, 7427, 
7475, 7536, 7545, 7582, 7585, 
7610, 7617, 7966

and display of modifier effect 7427
arc rotate snap angle

preference 7545
background 89
configuring 7610
controlling rendering 68
create snapshot of 85
DirectX manager rollout 5297
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displaying maps in 114
general concepts 56
grab 85
layout 7617
navigating 7378
preferences 7545, 7582, 7585
previewing shadows 4911
prompt line 7309
redraw all views 114
reset layout 7475
right-click menu 7370
setting layout 65
status line 7312
tooltips preference 7536
viewport controls 7378, 7384, 

7397, 7407
viewport renderer (glossary) 7966
views menu commands and 7262

views menu 87–88, 102–105, 107–108, 
110–111, 114–116, 2564, 7262, 
7622

adaptive degradation toggle 7622
add default lights to scene 111
create camera from view 110
diagnose video hardware 115
expert mode 116
grids 2564
redraw all views 114
reset background transform 103
restore active view 88
save active view 88
shade selected 107
show dependencies 108
show ghosting 104
show key times 105
show transform gizmo 103
undo/redo 87
update background image 102
update during spinner drag 115
viewport image 102–103

virtual viewport 7626
visibility tracks 3520, 3533
visible after/before 4334
visible/invisible 2007
visual MAXScript utility 7472

VIZ files 6961
linked geometry 6961
VIZBlock 6961

VIZ Render files 6964, 6967
Linked Geometry 6967

VIZBlock 7967
VIZBlocks 6816

selecting when file linking 6816
volume fog environment effect 6512
volume light environment effect 6521
volume select modifier 1911
volume shading 6076

mental ray 6076
vortex space warp 2619
voxel 5423
voxel size 6142
VPX files 7967
VRML format 7082
VRML97 7083, 7089–7090, 7093–7094, 

7096, 7098–7099, 7101, 7103, 
7105, 7107, 7109, 7112, 7114–
7115

exporting to 7083, 7089
helpers 7093–7094, 7096, 7098–

7099, 7101, 7103, 7105, 
7107, 7109, 7112, 7114–7115

specification 7093
VST targa files (glossary) 7162
VUE file 6143, 7967

glossary 7967
renderer 6143

W

W3D files 7061–7062, 7069, 7071
analyzing 7071
exporting 7061–7062
previewing 7069

walk 4253, 4352, 4359
footstep 4352, 4359

walking gait 7970
walking parameters 4107
walkthrough button 75
walkthrough flyout 7383
walkthrough navigation 75, 7383

8084 | Index



wall 433, 456, 466
editing wall objects 466

wall behaviors 4814, 4817, 7970
repel 4814, 7970
seek 4817, 7970

wall seek behavior 4696
wander behavior 4820, 7971
warning messages 7541
water 3996–3997, 3999

rendering 3999
space warp 3997

wave 1918, 3190
wave modifier 1918
waveform controller 3190

wave space warp 2695
wavefront files (obj, mtl) 7077
Wavefront material files 7078
Wavefront object files 7079
waves map 5745
web distribution 5011, 5014
web distribution (photometric

lights) 5083
web parameters rollout 5083
web site 6928

getting content from 6928
week schedule dialog 6346
weight 1600, 1627, 4565, 4606, 4656, 

4672
assignments (Skin modifier) 1627
assignments (vertex) 4565
vertices (Skin modifier) 1600

weight table 1634
weight tool dialog 1627
weighted vertices 4054, 4636
weld 606, 1696, 1788, 1845, 1874, 

2001, 2019, 6990, 7073
editable mesh edges 2019
editable mesh vertices 2001, 2019
threshold 606, 1696, 1788, 1845, 

2019, 6990, 7073
vertices 606

weld vertices/edges dialog 2150
what you should know to use character

studio 4051
white paper, swivel angle and HI IK

solver 3321

wide flange 589
width 4355
wind 4001
wind space warp 2643
window/crossing toggle 201
windows 36, 433, 516, 523, 526, 528, 

530, 532, 534, 5208
3ds Max 36
awning 523
casement 526
fixed 528
pivoted 530
projected 532
sample preview 5208
sliding 534

wire editor 3250
wire parameters 299, 3247, 3250

expression techniques 299
wireframe color 7423
wireframes 104, 117, 7973
wiring 2746

particle view 2746
wiring (particle flow) 2746, 7971
wiring parameters 3247
wiring tests to events (particle

view) 2741
wood map 5747
workbench 4058, 4394, 4397, 4400–

4401, 4407, 4410, 4416, 4421, 
7749

analyze panel 4410
analyzing curves 4400
animation 4401
curve view 7749
filters panel 4421
fix panel 4416
fixing curves 4401
navigating 4397
select panel 4407

workflow 4063, 4069, 4098, 4464, 4496, 
4544, 4568, 4666, 4877, 6835, 
7974

and biped 4069
applying physique 4544
creating bulges 4568
footstep animation 4098
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in character studio 4063
motion capture 4496
motion flow 4464
procedures in this reference 4877
Revit 6835
tendons 4666

workflows 19, 1300, 2039, 2165, 5164, 
5989, 7347

designing materials 5164
edit poly 1300
editable poly 2039
project workflow in 3ds Max 19
radiosity 5989
set key 7347
sub-object selection (NURBS) 2165

working folder 6897, 6900
working pivot rollout 3402
working with 4394, 4680

crowd animation 4680
workbench 4394

working with AutoCAD, AutoCAD
Architecture and Revit
files 6817

working with biped 4069
working with crowd animation 4680
working with drawing files 6774
world axis 861
world coordinate system (glossary) 7975
world rollout 4009
world space 4294, 7976
world space (biped) 7977
world-space modifier 1043–1045, 1047, 

1118, 1120, 1123, 1129, 1132, 
7977

camera map 1044
displace mesh 1045
displace NURBS 1047
glossary 7977
LS colors 1118
MapScaler 1120
PatchDeform 1123
PathDeform 1123
subdivide 1129
surface mapper 1129
SurfDeform 1132

wrap cursor near spinner 7536

wrectangle 580
WSM modifier 1043–1045, 1047, 1118, 

1120, 1123, 1129, 1132
camera map 1044
displace mesh 1045
displace NURBS 1047
MapScaler 1120
PatchDeform 1123
PathDeform 1123
subdivide 1129
surface mapper 1129
SurfDeform 1132

X

XAF files 3621, 3630, 3635, 3637, 3644, 
3646, 6870

adding to motion mixer 3630
adjust time in motion mixer 3644
adjusting in motion mixer 3635
combining with mixer 3621
filtering in motion mixer 3637
transitions in motion mixer 3646

XLI files 7022–7023
XLO files 7022, 7027
XMM files 6870
xref 3194, 4219

add offset 3194
xref biped 4219
xref controller 3041, 3194
xref ik chain 3299
xref material 5603
XRef object 6770

proxy object 6770
XRef objects dialog 6737, 6747, 6750

entities list right-click menu 6750
files list right-click menu 6747
XRef objects dialog 6737

xref scenes 6757, 6766
overlays 6757, 6766

Xrefs 6799, 6814, 7977
glossary 7977
resolving in file linking 6814
resolving paths 6799
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XRefs 47, 6729, 6732, 6737, 6752, 6755, 
6764, 6769, 6772, 7529, 7978

and paths 6764, 6772
glossary 7978
scenes 6764
user path configuration 7529
using XRefs 47
XRef merge dialog 6752
XRef objects 6729, 6732, 6737, 6769
XRef scenes 6729, 6755

XYZ controllers 3074, 3076, 3123, 3144, 
3171

XYZ coordinate shader (mental
ray) 5844

XYZ generator shader (mental
ray) 5841, 5843

xyz position 4293

Y

YUV file (glossary) 7166

Z

z element parameters rollout 6167
zero all 4284
zero twist 4284

zoom 73, 2738–2739, 2748, 3591, 3604–
3607, 7381, 7385–7387, 7545

about mouse point
(preference) 7545

no zoom (particle view) 2739
region zoom (particle view) 2748
zoom 7385
zoom (particle view) 2738, 2748
zoom (Track View) 3606
zoom all 7386
zoom extents (particle view) 2738
zoom extents all/all selected 7381
zoom extents/extents selected 7387
zoom horizontal extents/extents keys

(Track View) 3604
zoom region (particle view) 2738
zoom region (Track View) 3607
zoom selected object (Track

View) 3591
zoom value extents (Track

View) 3605
zooming views 73

zoom selected object option (Track
View) 4154

zoom value extents (Track View) 3605
zoom value extents range (Track

View) 3605
ZT file 7978
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